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Introduction
2019-03-29

Introduction
Getting Started

Idea & Overall design: Tom N1MM
Overall programming: Tom N1MM

Programming: John K3CT, Nick NA3M, Rick N2AMG, Steve N2IC, Terry AB5K, Andy KU7T
Documentation/Help: Larry K8UT, Pete N4ZR, Rich VE3KI, Thomas PA1M

N1MM Logger logo artist: Julio, LU5MT
Testing and proposals: N1MMLoggerPlus.Groups.IO group members – Thanks!!!

Getting Started is intended to guide the new user of N1MM Logger+, or a user making the transition from N1MM Logger
classic, in chronological order to the point where he/she has a correctly installed version of N1MM Logger+ with basic logging
functionality.

N1MM Manual
The Manual section will provide in-depth information for configuring and operating N1MM Logger+, beyond what is covered in
Getting Started. The information in the Manual is arranged by topic areas.

Appendices
The purpose of the Appendices section is to provide a location for information not directly related to supporting the N1MM
Logger+ software – but still information that users will find useful.

PC Requirements

Minimum Hardware Requirements

N1MM Logger+ incorporates the latest multi-threading technology, and will take full advantage of multi-core CPUs. It’s difficult
to set an absolute minimum configuration that will work under all circumstances. A single-core 1.6 GHz processor is probably
the minimum required, but the CPU requirements depend quite heavily on which program options, modes, etc. are selected,
so this may not be adequate depending on how you use the program. The program itself does not require a large amount of
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memory, but the more memory you have, the more smoothly Windows multitasking works. Memory is especially important
when the CPU is a single core.

The recommended minimum graphical resolution is 1024 by 768 (SVGA), or 1366 x 768 (720P) for wide-screen monitors, with
many hams running higher resolutions and dual screens. At vertical resolutions of less than 768 pixels, like many netbooks,
several of the larger windows will not fit entirely on the screen.

Radio control can be done through serial ports or through a USB-to-serial adapter. CW keying, FSK RTTY and PTT can be
done through serial or parallel ports, through a USB-to-serial adapter, or through K1EL’s Winkeyer (an excellent solution which
offloads CW processing entirely). For FSK RTTY, an extra serial port is needed. For AFSK, PSK31 and other modes requiring
audio interfacing, the same methods described for phone interfacing can be applied.

SO2R “boxes” may be controlled through a hardware LPT port under 32-bit operating systems or 64-bit operating systems.
Alternatively, the MicroHam USB SO2R Control Protocol and the K1XM Open Two Radio Support Protocol are both
supported, for use with devices that accommodate them.

USB-to-serial converters and USB interface devices are supported through virtual serial ports provided by their associated
driver software. USB-to-LPT converters cannot be used for either SO2R control or CW/PTT functions, except for the PIEXX
SO2RXLAT (which is specifically designed for this purpose).

For more information see the Interfacing section.

Supported Operating Systems

Windows 11 32/64 – preferred
Windows 10 32/64 – preferred
Windows 8.1 32/64
Windows 7 32/64 – Microsoft support ends 2020-01-14. Not recommended. You may need to install .Net 4.6.2 in order
for N1MM to work
Windows Vista 32/64 – not recommended 
Windows XP SP3 – support ends January 31, 2021. Versions after that date will not work on XP. No fixes will be issued
for the last XP version.

Linux and other Operating Systems will not be natively supported. OM2LT has done a great job documenting how to get
N1MM+ running on Linux using wine. See Contesting with N1MM on Linux

Windows XP and Vista startup errors

If you are still using Windows XP or Vista, you may see error messages (“404 error” or “unable to connect to server”)
every time you start up the program. These error messages appear because you are using an operating system that
does not support current web site security. Microsoft does not provide SSL encryption support for modern websites
for XP & Vista, so the https connection to the N1MM+ web site to check for updates does not work. If your browser
has been updated to allow you to connect to modern web sites, you will be able to download the latest update
through your browser and update the program manually, but the automatic version check performed by the program
at startup will still fail.

Unsupported operating systems are more vulnerable to attack by malware, because malware authors who find
vulnerabilities know that those vulnerabilities are not going to be fixed. That leaves your system potentially open to
being co-opted by malware to act as a bot and attack other systems. Do yourself and everyone else a favor and
upgrade to a supported operating system.
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Downloading the Software
2019-03-29

Downloading the Software
Download site

Download links:

Full Install: >Downloads >Program Files >Full Install
Latest Update: >Downloads >Program Files >N1MMplus Latest Updates

After downloading the full installer and the most recent update from these two locations, follow the instructions for installing
the program at https://n1mmwp.hamdocs.com/getting-started/installing-and-upgrading-n1mm-logger/#first-time-installation-
instructions .

To download a brief video tutorial on downloading and installing the N1MM Logger+. Note that the website Downloads menu
option has changed since this video was recorded, but the installation instructions are still accurate

Download and watch video of the download and install process HERE

Full Installer

Installing N1MM Logger+ for the first time requires that you download two files – the Full Installer and the Latest Update. The
Full Installer file will change infrequently, whereas the Latest Update file changes often, generally once per week.

Locate the Full Installer file on the download site under the menu selection >Downloads >Program Files >Full Install Info >Full
Install File. Save the file, named N1MM Logger+ FullInstaller [version number].exe, to your download directory or the
desktop of your PC.

Latest Update

Locate the Latest Update file on the download site under the menu selection >Downloads >Program Files >Latest Update Info
>Latest Update Files. Look for the most recent file (the one with the highest version number – you can click on the heading of
the Name column to reverse the sort order, or click on the heading of the Modified column to organize the list in date order, if
necessary clicking twice to put the most recent file at the top). Save the file to the same location where you saved the Full
Install file. (Exception: if the version number on the Full Install file is the same as the version number on the Latest Update,
there is no need to install the Latest Update over the Full Install.)

You only need to do one Full Install!
Full Installers are not posted very often. If the first part of the current version number (the part before the second .) is
the same on the latest Full Installer as it is on your already-installed copy of the program, you do NOT need to run a
new Full Installer. To update the program, just download and install the Latest Update.



You only need one Latest Update file!
Each Latest Update file includes the improvements and fixes from all of the preceding files. It is only necessary to
download and install one Latest Update file — usually the most recent — to create a completely up-to-date version of
N1MM Logger.



Filename Convention for Latest Updates
The syntax for naming Latest Update files is N1MM Logger+ Update [version number].exe. The version number is in
the format x.yy.zzzz, where x is a major revision number (likely to change only rarely), yy is the major version number
(which also changes only rarely), and zzzz is the minor version number (which changes with every version).
Changes to the major version number yy indicate that there has been a change in the system files needed to support
the program. Update installers whose yy is different from the installed version’s yy will not install over the existing
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version. Therefore any time yy changes, users will have to download a new Full Installer program with the new yy
number and go through the Full Install process before updating. On the other hand, if the yy number on the current
Full Installer is the same as the yy number on your already-installed copy of the program, you do not need to do a
new Full Install; just download and run the latest update installer. The minor version number zzzz changes every time
a member of the development team makes changes to the program. New update installers are not created every
time this happens; therefore, there may be gaps in the zzzz numbers. This is not a problem; unless there is a specific
reason to revert to an older version, just install the latest update (the one with the highest zzzz number).
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Downloading Digital Software
2019-03-29

Downloading and Configuring Digital
Software
Need-to-Know about Setting Up for Digital Modes

In order to communicate in digital modes (RTTY, PSK, or other sound card digital modes), N1MM Logger+ can either use a
computer sound card or an external device called a “terminal unit” or a multi-mode TNC. Terminal units and TNCs are
relatively rare nowadays, and most digital communications now use a computer sound card.

The Logger uses the sound card for digital modes via a separate process called the “digital engine”. One digital engine,
MMVARI, is pre-loaded when N1MM Logger+ is first installed. MMVARI can do RTTY, PSK31, PSK63, and a few other digital
modes that are not often used in contests. The Logger also supports several other digital engines, including MMTTY, 2Tone,
Fldigi, WSJT-X or JTDX, but these engines are not pre-installed; they must be downloaded and installed separately. MMTTY
and 2Tone can only be used for RTTY, whereas Fldigi supports a wide range of digital modes, most of which are not used for
contesting. N1MM Logger+ can also use either of the WSJT-X and JTDX programs to make and log contacts in FT8 and other
modes supported by these programs.

Configuring a digital engine is done within N1MM Logger+ in a few places, including the Configurer (Config >Configure
Mode Control, Audio, Other) as well as in the Digital Interface window. The digital engines (MMVARI, MMTTY, 2Tone, Fldigi,
WSJT-X and JTDX) also have their own configuration menus that need to be set up. If you are familiar with digital modes and
are moving to the Logger from some other program, you might want to proceed directly to the setup instructions in the sub-
sections below. If you are new to digital modes, you can find more information on RTTY and PSK in the General RTTY and
PSK Information page in the manual. RTTY is particularly complex for someone coming to it for the first time; there is an
excellent introduction to RTTY on AA5AU’s web pages that is recommended reading for anyone starting out in RTTY.

A few notes about hardware connections for sound card digital modes (using MMTTY, 2Tone, MMVARI, Fldigi or WSJT-
X/JTDX) follow. These depend on the radio, the sound card and the interface (if any) in use, and it is impossible to cover all of
the possibilities in detail, but the following general comments apply:

First, you must have some means of connecting the radio’s audio output to the sound card’s input. The ideal connection would
be from a fixed-level (“line out”) output on the radio to a “line in” input on the sound card. If your radio has one receiver, this
will probably use the left channel of the sound card; with dual receivers, the second receiver may use the right channel. If your
sound card does not have a line level input, you may need to use a microphone input, and in this case you may need an
attenuator to reduce the line level output from the radio to the lower level needed for the microphone level input on the sound
card.

To transmit, there must be some means to convey modulation from the computer to the radio. For FSK RTTY, this is an on-off
keying signal, which is normally generated by a serial port connected to the radio’s FSK keying input through a simple keying
circuit. This serial port cannot be the same port that is used for radio control or for a Winkeyer or other serial device. If it is a
standard USB-to-serial adapter, FSK from MMTTY will require the EXTFSK or EXTFSK64 plugin. If you are using MMVARI for
RTTY using FSK keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK or EXTFSK64 for USB-to-serial
adapters) in the Configurer under the Digital Modes tab). Fldigi can only do FSK keying with the help of an external circuit that
converts the audio signals from these programs into an on-off keying signal.

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), there must be a connection from the sound card’s
output (“line out”, or speaker or headphone output) to the radio’s audio input. If the only audio input on the radio is a
microphone input, you may need attenuation to reduce the level to avoid overdriving the transmitter.

You also need some means to control TX/RX switching (PTT). The most common method is to use hardware PTT control from
a serial or parallel port via a simple keying circuit. Hardware PTT can be controlled either from the digital “engine” (MMTTY,
MMVARI, Fldigi, WSJT-X or JTDX), or from N1MM Logger+ itself (this method can be used with any digital engine, including
WSJT-X and JTDX). To use serial port PTT from the digital engine, you must use a different port from the one that is used by
the Logger for radio control. If you have a serial port set up for FSK keying, you can use a control line (RTS or DTR) on this
same port for PTT control from the digital engine.
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If, as is often the case, you do not have a separate serial or parallel port available for PTT in digital modes, you can control
PTT directly from the Logger. For example, if your radio control interface supports PTT using RTS or DTR on the radio control
serial port, you can configure the Logger to use this method. If no method of hardware PTT control is available and if your
radio supports PTT via radio command, you can use software PTT control from the Logger. Warning: Using both software and
hardware PTT control at the same time can cause problems; it is recommended that you do not use both methods in parallel.

As an alternative to hardware and software PTT control, you may be able to use VOX. This does not work with all radios, it
cannot be used for FSK RTTY, and setting of audio levels and VOX triggering levels can be tricky, but some users have found
this to be the simplest method of PTT control, since it does not require any additional hardware connections. Some external
interfaces (e.g. SignaLink) perform a VOX function external to the radio, i.e. they generate a hardware PTT signal based on
the presence of an audio signal without any connection to a serial port on the computer. If you are using such an interface, or
VOX within the radio, you do not configure any PTT in the Logger or in the digital engine, as PTT control in these cases is
external to the software.

Setting up N1MM Logger+ for Digital Modes

First, make sure you are familiar with basic operation of N1MM Logger+ in CW and SSB. It’s not a good idea to try to use the
program in digital modes if you aren’t familiar with at least the basic operation of the program. For FT8 and similar modes, it is
recommended that you become familiar with operating these modes running the WSJT-X or JTDX program on its own before
attempting interoperation with N1MM+, as the operation in these modes is done from within the JT-mode program rather than
directly within N1MM+ as for the older digital modes.

Once you are ready to begin, decide which digital engine(s) you want to use – an external TU/TNC, MMTTY, 2Tone, MMVARI,
Fldigi, WSJT-X or JTDX. One of these (MMVARI) is built in to the Logger, but the others all will need to be downloaded. For
the keyboard-to-keyboard modes (RTTY, PSK31, etc.), each digital engine used by the Logger stores its configuration
information in the directory the engine is run from (this does not apply to WSJT-X and JTDX). For that reason, you should
create a separate directory for each copy, separate from the directory you use when you run it stand-alone or from some other
logging program. If you use more than one copy of a digital engine (for example, for SO2V or SO2R, or for additional RX-only
windows), you need a separate directory for each copy. For more detailed information, check out the sections on Downloading
and Installing MMTTY, 2Tone and fldigi in the manual

After these preliminaries, start N1MM Logger+ and open the Configurer (Config > Configure Ports, Audio, Mode Control,
Other). Make sure the Hardware tab is selected (this is the tab the Configurer starts up in by default).

The following paragraphs deal with setup for digital modes like RTTY and PSK modes. For the setup for operating with WSJT-
X or JTDX, see the manual documentation for the WSJT Decode List window.

In what follows, it is assumed that you already have radio control, CW keying and PTT control configured and working, and
what you are trying to do is add in the capability for digital modes.

In many cases, especially if you are planning to use AFSK, you will already have PTT control configured from the Logger. If
the same method you use in other modes is acceptable for digital modes, you don’t need to do anything special about PTT for
digital modes. If you are planning to use FSK for RTTY, you will be setting up a serial port for FSK keying from within the
digital engine, and you can use that same serial port for PTT control in RTTY. If you are using VOX (or an external VOX such
as a SignaLink), you do not need to configure PTT control in the Configurer.

All that being said, there are two cases where you need to do something about PTT control for digital modes in the Configurer.
The first is if you plan to use MMVARI as your digital engine, and you want to use a control line from a serial port for PTT
control. In that case, you must designate that serial port in the Configurer, check the Digital check box for that port, set the
appropriate control line (DTR or RTS) for PTT, and set the DigWndNr to 1 (or 2, for the second DI window in SO2R/SO2V).
The second case occurs if you are using a single serial port interface for both CW/PTT keying in CW/SSB, and also for FSK
keying in RTTY. In that case you must check both the Digital and CW/Other check boxes for that port, configure DTR and
RTS for CW/SSB, and set the DigWndNr to 1 (2 for the second DI window in SO2R and SO2V).

Next, you need to select the Digital Modes tab in the Configurer. First, set the TU Type to Soundcard (unless you happen to
be using a hardware TU/TNC). If your main digital engine is MMTTY or 2Tone, then under DI-1 MMTTY Setup, select AFSK or
FSK as appropriate for your setup and set the MMTTY Path to point to the copy of MMTTY.exe or 2Tone.exe you will be using
with the Logger. If you will be doing SO2V or SO2R, repeat for a separate copy of the digital engine under DI-2 MMTTY
Setup. If you will be using Fldigi, there are separate places to enter the paths to Fldigi.exe. For all of these, it is recommended
that you do not try typing in the path directly. Instead, click on the Select button, which opens a standard Windows file Open
dialog window, and then navigate till you find the desired .exe file and select it.

Once the paths to the digital engines are set up, select the Mode Control tab in the Configurer. On the right side, beside
RTTY, set the Mode sent to radio – this should be RTTY if you are using FSK, but if you are using AFSK, it should be either
AFSK (if your radio offers a separate mode for AFSK RTTY), LSB (for most radios with MMTTY or 2Tone), or USB (for Fldigi).
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This completes the basic steps in the N1MM Logger+ Configurer. For more detailed explanation of the various options
available, see the Configurer section of the manual.

Back in the main Entry window, if you have not already done so, choose a contest type that allows digital modes (i.e. not a
CW- or SSB-only contest), and set the Mode Category in the Contest Setup window to one that includes RTTY or Digital
(don’t choose SSB+CW – that’s for CW+SSB only; choose SSB+CW+DIG instead). Type RTTY into the call sign box and
press Enter. This should open the Digital Interface window. If it does not, use the Window > Digital Interface menu item to
open the Digital Interface window (in SO2R/SO2V, each Entry window has its own Digital Interface window that opens from
that Entry window’s menu). If your preferred digital engine does not open (e.g. if you see the MMVARI window when you
wanted MMTTY), then in the Digital Interface window use the Interface menu item to switch to the digital engine you want to
use (use the MMTTY menu setting for both MMTTY and 2Tone).

Select the Setup > Settings menu item in the Digital Interface window. Under Preferred RTTY Interface, select your preferred
digital engine. Under Alignment Frequency, enter your preferred Mark audio frequency (e.g. 2125 Hz). If you are using
MMTTY, then under MMTTY Window Settings, select either Normal or Control Menus, in order to have easy access to the
MMTTY setup window. When you have completed the setup in the Digital Setup window, click on Save Configuration.

There are a host of other options in the Digital Interface and Digital Setup windows. A complete reference manual for the
menu options in the DI window, the Digital Setup window and the main DI window is here.

You’re not done yet. Now you have to complete the configuration inside the digital engine itself. This is especially important for
FSK, since the configuration of the FSK port is carried out inside the digital engine, not in the N1MM Logger+ program. There
are separate chapters in the manual for MMTTY, MMVARI, Fldigi, and TNCs/TUs. There are too many possibilities to cover
here, so consult the chapter(s) appropriate to your situation and complete the setup as described there. For instructions on
configuring WSJT-X for interoperation with N1MM+, see the WSJT Decode List window section of the manual.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/setup/digital-modes/
https://n1mmwp.hamdocs.com/setup/digital-modes/#configure-mmtty
https://n1mmwp.hamdocs.com/setup/digital-modes/#setting-up-the-digital-interface
https://n1mmwp.hamdocs.com/setup/digital-modes/#fldigi-initial-configuration
https://n1mmwp.hamdocs.com/setup/digital-modes/#setting-up-the-tnc-in-the-configurer
https://n1mmwp.hamdocs.com/setup/wsjt-x-decode-list-window/#within-wsjt-x


12

Installing and Upgrading N1MM Logger+
2019-03-29

Installing and Upgrading N1MM Logger+
First-Time Installation Instructions
Please Note – These instructions apply both for first-time users and for experienced users of N1MM Logger Classic starting
out with N1MM Logger+. Note that you can leave N1MM Logger Classic on your PC, and even continue to run it alternatively
with N1MM Logger+. Just don’t try to run the two simultaneously.

Installing

N1MM Logger+ has adopted the Windows convention for file locations, so you should be able to install program files in the
default locations provided by the Installer. N1MM Logger+ is a 32-bit application which works equally well on either 32-bit or
64-bit versions of Windows. In 32-bit systems, the program files are installed at C:\Program Files\N1MM Logger+. In 64-bit
versions of Windows, N1MM Logger+ program files are installed at C:\Program Files (x86)\N1MM Logger+. In both types of
systems, all user and data files used by the program will be installed elsewhere, i.e. not in the same location as the program
files.

The user/data files must not be in the C:\Program Files or C:\Program Files (x86) path. By default, if you are not using a cloud
backup system like OneDrive the user data files location will be on your hard drive in your Documents folder, in a sub-folder
titled N1MM Logger+. Unless you are using a cloud backup system like OneDrive, we recommend accepting the
default locations, and installing for a single Windows logon. If you have to have more than one, your options are
here.

If you are using a cloud backup system like OneDrive, the user data files location must not be in the cloud or in a location that
is automatically backed up to the cloud. In this situation the installation instructions must be modified; see the section below
titled “N1MM Logger+ and OneDrive”.

When the installer first creates the user data files area, it also creates a number of sub-folders where the program expects to
find data files for various purposes. Here are the contents of the user data/user files folder when it is first created:

This folder is important, because the program looks in these sub-folders for support files that it needs – things like your stored
message files, call history files, and so on. When created or modified by N1MM Logger+, files are placed in their correct
folders, but if you want to move files from your N1MM Classic installation, you need to move them to the appropriate
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Document folder. Any .wav files used for SSB contests should be stored in the Wav folder; if you use the {OPERATOR} macro
for wave files in individual operators’ voices, those wave files should be stored under sub-folders within the Wav folder titled
with the operator’s callsign.

Be sure not to delete the four files below the folders.

During a Full Install, the installer downloads so-called “prerequisite” files from the Internet. For this reason, please
be sure you are connected to the Internet when doing a Full Install. Also, make sure that other programs that might
be using system components that are part of the install (such as digital mode programs) are not running when you
do the Full Install.

N1MM Logger+ and OneDrive

If you use OneDrive or a similar cloud backup system, the installation instructions must be modified to avoid corruption of
database files that can result if an automated cloud backup operation takes place while the program is running. If you are
installing N1MM Logger+ on a computer that has already been configured to use OneDrive (or Google Drive or Dropbox) to
backup the Documents folder contents, the installer will refuse to set up your user data files area within the OneDrive (or
equivalent) directory path. At the point in the installation where the user files area is being set up, you must choose a location
on your hard drive that is not within the OneDrive path, and that is also not protected by the operating system (i.e. is not within
the Program Files or Program Files (x86) paths). We suggest that you choose a location such as C:\N1MM Logger+, or
C:\HamRadio\N1MM Logger+ as the location for your user data files.

Does this mean that you cannot backup your N1MM Logger+ data files? Not at all, in fact we recommend that you use some
kind of backup strategy for these files, but unfortunately an automated backup system is not suitable. Whatever strategy you
choose, you must ensure that it never attempts to backup the user files area while the N1MM Logger+ program is running, as
this can cause corruption of the database files. The N1MM Logger+ program must be shut down before backing up the user
files, whether the backup is to the cloud, to another disk drive or other storage medium, or to another networked computer.
You can even use the OneDrive cloud storage to store backups in if you wish; just make sure not to let OneDrive do the
backups automatically, because sooner or later one of those automated backups will happen while the Logger is running and
corrupt your log database.

What to do if Windows Update moves your files into OneDrive

Even after you have successfully installed N1MM Logger+ with the user files area in your Documents folder on your
hard drive, and perhaps have even been using it successfully for some time, OneDrive can still impact your
installation. This is because of Microsoft’s strategy of aggressively moving user storage into OneDrive. If the user
account that you use to log in to your computer is a Microsoft account, Windows Update may quietly move all of your
Documents, Photos and similar file areas into OneDrive, possibly including your N1MM Logger+ user files area. The
first time N1MM Logger+ is started after the update, you may see an error message indicating that the program was
unable to open your log database. If this happens to you, your best recourse is to reinstall N1MM Logger+ with a new
user data files area that is outside OneDrive, as follows:

Download the latest Full Installer and the latest program update installer from the N1MM Logger+ web site.
Run the Full Installer. It will install the program files into C:\Program Files\N1MM Logger+ or C:\Program
Files (x86)\N1MM Logger+; this is fine, OneDrive does not affect this part of the installation.
When the Full Installer asks you where to install the user files area, choose some place that is outside the
OneDrive path and also outside the Program Files path; for example, C:\N1MM Logger+ .
Once the Full Installer has completed, do not run the program yet. Before attempting to start N1MM Logger+,
first find where Windows Update has moved your previous user files. The path may be similar to the path that
you originally set up during your earlier installation, except that OneDrive may appear as part of the
pathname. Once you have found that location, copy the entire contents of the old N1MM Logger+ folder,
including subfolders, into the new folder that was just created by the Full Installer. Then rename the old user
file folder, for example from N1MM Logger+ to Old N1MM Logger+. This will serve as a reminder to you that
the old folder is not the correct place to download new files to (UDC files, Call History files, function key
message files, etc.). Once you have been successfully using the program with the new location for a while,
and if you are sure that all the files you might want in future (including old database files and old logs) are
safely stored in the new user files folder or elsewhere, you can delete the Old N1MM Logger+ folder and its
subfolders to reduce the chances of confusion.
Now run the updater program for the latest update to bring your installation up to date. You should now be
back in business.
The file paths used by the program are relative to the main user files area. If there is any doubt about the
location of the main user files area, you can use the Help > Open Explorer on User Files Directory menu
item in the program to find the folder that the program uses (along with its subfolders) for all of its data and
user files.
Copying the entire user files area en masse should preserve all of the relative file links in the program. One
exception might be entries in the recently opened log list at the bottom of the File menu if those recently open
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Avoiding Security Problems During Installation

Security settings in Windows or in anti-malware software on your computer may interfere with the ability to download and run
installation programs such as the N1MM+ Full Installer and Latest Update installers. If Windows refuses to download an
installer, check the Windows Settings > Update & Security > Windows Security > App & browser control > Reputation-based
protection settings. If Reputation-based protection is turned on, your browser might refuse to download installer files, or it
might download them but block them from being run. If your browser refuses to download the installer file, turn Reputation-
based protection off and try again.

If the installer file downloads successfully but a Windows Defender SmartScreen window labeled “Windows protected your
PC” appears when you try to run it, look for a “Run anyway” button on that screen. You may need to click on a “More info” link
to make this button appear. If there is no “Run anyway” button, or more generally if the installer program simply does not run
when you try to execute it (with or without a SmartScreen window), you can right-click on the installer file in Explorer (probably
in your Downloads folder) and look for a button called “Unblock” near the lower right corner under the General tab, with an
explanation that reads “This file came from another computer and might be blocked to help protect this computer.” Click on the
“Unblock” button to unblock the file and enable it to be run.

N1MM Logger+ uses a number of .dll and .ocx files – for example, inpout32.dll is used as its interface to LPT ports, and
n1mmv5wav.ocx powers the audio recording and playback functions. Various security provisions in Windows, as well as
various after-market security software, can prevent the installation or registration of these files.

A few simple steps can work around these problems. First, download the Full Installer and Latest Update installers to a regular
(non-temporary) directory on your hard drive. Then when you run the Full Install, right-click on the filename and select “Run as
Administrator”. This may be necessary even if your User account has Administrator privileges.

Once you run the Full and Latest Update installers as an Administrator, the needed .dll and .ocx files should all be properly
registered. If you are using the parallel (LPT) port for CW, PTT or antenna selection, you will also need to run the program
itself for the first time by right-clicking and selecting “Run as Administrator”, so that some internal file-shuffling can take place.
This should not be necessary thereafter – just run as usual from a desktop icon or shortcut.

Windows Settings that may affect program operation

There are some default settings in Windows that can affect the way the program operates. To avoid problems, it is suggested
that you change these settings. Note that these changes are in Windows, not in N1MM Logger+.

The first has to do with USB hubs (ports). The Windows default behavior for USB hubs is to shut them down to save power
after a period of inactivity. Unfortunately, the only activity Windows appears to be aware of is keyboard or mouse activity. A
USB port that is being used for something else, such as a USB-to-serial adapter, looks to Windows as if it is inactive, and
Windows can shut that USB hub down after a few minutes. This will cause the port to stop working, and if you go into the
Configurer to make changes, the program will be unable to open the port when you exit the Configurer.

The solution to this comes in two steps, but first, be sure that the USB device you’re having trouble with is connected to
its port. Now open Device Manager, expand the section on Universal Serial Bus controllers, and then open each entry
labelled either “Generic USB Hub”, “USB Root Hub” or “USB 3.0 eXtensible Host Controller” (or something similar), open its
Properties dialog, select the Power Management tab, and uncheck the check box called “Allow the computer to turn off this
device to save power”.

The second involves Power Options on the Control Panel. You will not necessarily find all of these settings on every system,
but every system running N1MM Logger+ or any other real-time logging software should be set to minimize Windows “power
saving”.

Open the Control Panel and select Power Options. One of the “Plans” will be “High Performance” – select it. Then click
“Change plan settings” and set “put the computer to sleep” to “never”. If found, also select “Change advanced power settings”
and set “Sleep | “Hibernate after” to “Never” and “Allow hybrid sleep” to “Off”. In “USB Settings” set “USB selective suspend
setting” to “Disabled” and under “PCI Express” set “Link State Power Management” to “Off”. Also set “Wireless adapter
Settings” to “Maximum Performance”.

These settings should prevent the computer from going to sleep, shutting down USB ports and disabling the network interface
when it is plugged in – when you want to keep background tasks running.

logs were in database files other than the currently open database file. If there are any such links in your File
menu, you may be forced to use the File > Open Database and File > Open Log in Database menu items
instead of jumping directly to that log from the bottom part of the File menu. This problem will quickly right
itself as new entries are added to the list with updated path information, displacing the old ones with outdated
path information.
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There is a third setting that may require attention in Windows 10 and 11. In the Windows Settings app, select Privacy, and
then among the functions on the left side of the window, select Microphone. An option should appear called “Let apps use my
microphone”. Set this option to On. Starting with the Spring 2018 update of Windows 10, Windows interprets this option to
apply to all sound card inputs, not just to the microphone input on the default sound card. If this option is set to Off, neither
N1MM Logger+ nor any of the other programs it uses to decode digital modes, etc. will be allowed access to any sound card
inputs.

Connecting or disconnecting a sound card device while another sound card device is in active use can cause the active sound
card to stop working and/or to change its position in the list of sound card devices in programs like MMTTY. Correcting this
may require going into the setup for the program that uses the sound card and re-configuring the sound card(s) in that
program.

If you have a monitor that includes a sound card device connected to the computer via an HDMI cable, when the monitor goes
into screen saver mode the sound card may also be disabled. Even if you are not using that particular sound card, other
sound cards connected to that computer may suddenly stop working or become unavailable. If this happens to you, to prevent
it from happening again you can either disable screen saver mode on that monitor, or disable the monitor’s built-in sound card
device.

Here is another tip that has nothing to do with power management or sound cards, and does not actually affect program
operation, but may have an impact on your ability to find some of the N1MM Logger+ files. In Windows Explorer, under the
Tools option, select Folder Options. Click on the View tab, and look down the list for a check box called “Hide extensions for
known file types”. The default for this option is checked, requiring you to identify file types by their icons alone. If you leave it
at the default, you may have trouble finding files referred to either in the documentation or by people giving help instructions
on the user group. If there are files with similar file names except for different extensions, you may have trouble telling which is
which. Unchecking this option will make the full file names visible in Windows Explorer, which will make debugging problems
much easier.

Regarding Windows time settings, you do not have to set your computer to UTC in order to get UTC times in your log, though
you can of course do so. If you set your computer to your correct time zone including the correct DST setting, set the
computer’s time to match your local time, Windows and N1MM Logger+ between them will take care of the rest.

You can even operate straight through the daylight savings time switch in March or November (e.g. during Sweepstakes CW)
and while you will see your computer’s time display change by an hour at 2 am if you look closely, N1MM Logger+ will not skip
a beat; it will log all of your contacts with the correct UTC time.

Beginning the Installation

These instructions are specifically for the first installation on a computer. See the section below on Installing the Latest Update
for instructions on subsequent updates.

Download the Full Install from the Files area on the n1mmplus website.

The full installer will be a file with a name in the form N1MM Logger+ FullInstaller x.yy.zzzz.exe . While you are in the
Downloads area of the web site, also take a look at the Latest Updates here. If there is an update file with a zzzz version
number that is higher than the zzzz number on the full installer file, download that file as well. As soon as the full installer has
completed, you will want to run the update installer to bring the installed program up to the currently supported version.

Before starting the install process, if you are running other programs that use the same system components (including digital-
mode programs like 2Tone and WinWarbler), shut those programs down. Now run the full installer program. Windows will give
you the standard installation prompt asking whether you want to allow the program to make changes – answer “Yes”. You
should then see the following welcome dialog:

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/downloads/latest-updates


16

Click on Next. You will be asked to agree to a straightforward freeware license:

Click on Next. You will be given a choice of files to install. At the time of initial release, there is only one option, but at some
future date other optional components may be added, and this dialog will be where you choose the options to be installed:
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N1MM Logger+ requires two separate installation locations. One is for the program itself, plus support files that are never
changed except by the update installer. The other location is for all files that may be written to either by the program during
operation or by the user, to store user-defined preferences and support information; these include the databases, ini files,
error logs, function key message files, call history files, country files, super check partial files, wav files, qso recordings, user-
defined contest (UDC) files, and so on and so on.

The first location, for the program itself, defaults to C:\Program Files\N1MM Logger+ on 32-bit systems, or C:\Program
Files(x86)\N1MM Logger+ on 64-bit systems. For almost all users, this default location is suitable and should not be
changed. The dialog window in which this location is specified looks like this:

The second location, for user-modifiable or program-modifiable files, defaults to a location inside your Documents folder. In
Windows Vista, Windows 7 and newer systems, this is at C:\Users\[Your Windows Username]\Documents\N1MM Logger+
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(in Windows XP SP3, this would be C:\Documents and Settings\[Your Windows Username]\My Documents\N1MM
Logger+). For a typical single-user system, this default is appropriate, and even on multiple-user systems it is suggested that
you accept the default for the initial install.

When you click Install, the Full Installer will

Install all needed files on your computer to run N1MM Logger+
Update your system files where needed

You will find that certain parts of the Full Installer installation routine take quite a long time. The installation program has not
failed, so just let it run to completion. Subsequent updates are much faster. Once the installation has completed, you should
see the following window:

Do Not Install to a Cloud Server or Cloud Backup!
If you are using some kind of cloud backup, such as DropBox, Google Drive or OneDrive in Windows 10 or 11, you
should not install the user files area in the cloud, nor even in a location that is synced to the cloud, because the
syncing operation has been observed to corrupt the program’s database files. Make sure that the location where
the installer places the user files area is on your local drive (there should not be a OneDrive, GoogleDrive or
Dropbox anywhere in the path name), but do not use a location inside the Program Files or Program Files (x86)
path. If necessary, you can create a new folder at the top level of the directory tree (e.g. C:\HamRadio) into which
you can direct the installer to place the user files area.
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Do Not Overwrite Newer System Files

When running the Full Installer your computer may report that certain system files are already installed on your system and
are newer than the ones you are trying to install. If it asks if you want to replace a newer, existing file with an older file in the
Full Install, select ‘No’. You do not want to overwrite newer system files.

After you click on the Next button, you will see the following window:

The installation process requires that the computer be rebooted in order to finalize the installation of some system files (you
should be familiar with this from Windows Update and from other program installation processes). This only happens with the
Full Installer, not on incremental updates. Leave the “Finish and reboot the computer” check box checked and click on Finish.
You will be prompted one more time to confirm:
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After the computer reboots, if this is the first time N1MM Logger+ has been installed on your computer, the installer will ask
you to set up an initial empty database and enter your station information into that database. If the installer asks you to browse
for the folder in which user files will be placed, make sure that this is the same folder that was specified as the User Files
folder earlier in the installation process:

The next dialog will ask you to create a new database. You will notice that this dialog also offers the option of converting an
existing N1MM Logger Classic mdb database. Because there is a possibility that an existing database may have minor
problems that don’t stop it from working in Classic but may cause the conversion routines to stumble, it is strongly suggested
that at this point you create a new database. There is a menu option in Logger+ to convert Classic databases to Plus which
you can use later, but on the initial install it is safest to ensure that you have a known-good new empty database to work from.

If this is a new install, you should not see a warning message that suggests that your ini file may be corrupted and you should
copy from a .bak file, but if you do see such a message on a new full install, just ignore it and select the option to create a new
database.
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Choose the “Create new N1MM Logger+ database” option and click on OK. You will be presented with a new file dialog in
which you can specify the name of the new database; the default file name is ham.s3db . You can change the “ham” to
something else, but do not change the filename extension. Do not delete any of the three files that were placed there by the
Installer; the program needs these files in addition to the new database you are creating.

Finally, the program will present you with the Edit Station Information dialog:
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Fill in the information in this dialog. At an absolute minimum, you will need to fill in the Call box and the ARRL Section box.

The Call box contains the station callsign that will be used for all contest logs in this database; this is the callsign that is output
in every QSO line in exported Cabrillo files. It is also the callsign that is inserted into function key messages using the
{MYCALL} and * macros.

The ARRL Section box contains the ARRL/RAC section for stations in the US, US possessions and Canada; all other stations
must fill in this box with the letters DX . This box is used in many contests, not just ARRL contests, so even if you don’t plan to
enter any ARRL contests you should fill it in.

If you want the program to display correct beam headings to stations you work, you should also fill in the Grid Square box with
the correct grid square for the location you are operating from. Doing so will automatically fill in your Latitude and Longitude;
alternatively you can fill in the Lat and Long and the program will compute your Grid Square.

The name and address boxes are output in the header of Cabrillo files, so it is recommended that these be filled in as well.
Note that this is your mailing address, not necessarily the address from which you operate.

The Club box denotes the club towards which your scores will be counted in club competitions in those contests that support
this.

Once your station information has been entered and stored in the database, the initial installation process is complete.

Installing the Latest Update

After you have completed the initial install, you should go back to the n1mmplus web site and find the update file for the latest
version you find there. The updated version installer will have a file name in the form N1MM Logger+ Update x.yy.zzzz.exe . If
the version number zzzz is different from (higher than) the version number of the full (or your most recent) install, you should
download this file, start it, and follow its simple steps (essentially the same as the first few steps of the full install process) to
get fully up to date. The update will take a much shorter time to install than the full install did.

Note that updates are cumulative; you do not need to install all of the updates you find on the web site, just the latest one.
During the initial beta testing phase, new update installers will be uploaded frequently (probably daily, at least initially). Always
make sure you have the latest update installed before reporting bugs or problems.
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There may also be new full installer versions uploaded frequently during beta testing. If there is a new full installer with a
newer version number than the one you originally installed, but the first part of the version number (the x.yy part) is the same
as before, you do NOT need to download or run this newer full installer. Just download the update with the new version
number and run it. The only time you need to run a new full installer after the first time is when the first part of the version
number (x.yy) changes.

Using the Program the First Time
Edit Station Information

The first thing to do after starting the program is to enter your station information if you have not already done so. This dialog
will open automatically with your first launch of N1MM Logger+. For subsequent changes, select Change Your Station Data
from the Config menu in the Entry window.

Your Station Data dialog will be similar to this one. Note: a “dialog” is simply a window in which you can enter
information. The term is often used interchangeably with “window”.

 A Note on N1MM Logger+ Version Numbers
The version number for N1MM Logger+ releases contains three components x.yy.zzzz (as in 0.18.3241). The first
component, x, denotes major program revisions or status changes (e.g. “production” vs. “beta”) and is not expected
to change often. The second component, yy, denotes a major update level. When you are doing updates, the “yy” in
the update installer must agree with the “yy” in the already-installed version. If yy has been changed, you will have to
go through the Full Installation process again with a new Full Installer before you can install updates with the new yy
version number. The third number, zzzz, is the minor update number. This number may change as often as several
times in a single day as members of the development team make changes. There will not be a new update installer
created every time this number changes, so don’t be surprised if the numbers on consecutive updates differ by more
than 1. Changes at this level are always cumulative, i.e. you don’t need to worry about intermediate updates, just
download and install the latest update (highest minor update number) over the existing program, as long as the
major update level is the same.
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The information in this dialog is self-explanatory, but it is very important that it be accurate. The ARRL Section is used to
distinguish between in-state and out-of-state status for QSO parties, and between W/VE and DX in a number of ARRL
contests. CQ and ITU zones are essential for some contests. Your full mailing address is inserted in the Cabrillo file header,
and tells contest organizers where to send your certificate. In order for the program to calculate accurate beam headings, you
will need to put your longitude and latitude into the appropriate textboxes; you can do this simply by entering your grid square
into the grid square box.

Also make sure that you enter your call as the station call sign, as this will be the call sign that appears in every QSO line in
your Cabrillo files. Don’t leave any example entries that may be in these fields at start-up.

Many of the textboxes in this dialog are used when creating contests or during contests.

ARRL Section and State textboxes are used in some contests and QSO parties to determine if you are in or outside a
state or province. US and Canadian stations should enter their ARRL/RAC section abbreviation here. Non-US/VE
stations should enter “DX” here.
Latitude and Longitude are used to calculate the distance and bearing to another station/country (for HF contests)
For VHF contests (those with VHF in the contest name) the Grid Square textbox (4 or 6 digit) in the Station dialog is
used to determine bearings, rather than latitude and longitude.
Contents of the Latitude and Longitude textboxes update when the Grid Square textbox is changed and vice versa.
Club normally has to be spelled out completely in order for it to be accepted by contest organizers in contests with a
club competition, so for example enter Yankee Clipper Contest Club rather than YCCC.

Adding N1MM Users
This seemingly innocuous title actually addresses an area in which there are fairly significant changes from N1MM Logger
Classic, in particular because of the adoption of Windows user file storage standards, described above. Because user files are
linked to the log-on username currently in use, User A’s files – not just databases, but all the types of files stored in the user
files folder – will not be seen when User B logs onto the computer under a different Windows user name, or by using the
Windows “Switch User” command. There are a number of ways of dealing with this:

1. RECOMMENDED METHOD: Use one Windows logon identity for all operators, and use the OPON (Ctrl+O) function to
identify the operator for any given operation. This way all of the user files will be shared, except for the .wav files used
for stored phone messages, which will follow the operator’s callsign. Operators can set up individual Window layouts
with the Tools > Save Window Positions and Restore Window Positions functions. If desired, operators can also set up
their own databases and switch manually from the File menu. This is the method that will be most familiar to users of
N1MM Logger Classic.

2. Use individual Windows logon identities for each operator. When the new operator runs N1MM Logger+ for the first
time, it will create a new user files area for the Logger in that user’s Documents folder. During the process, it will ask
the user to create a new database and enter the station data. Once this has been done, each operator is free to edit
anything in their personal user files area to suit. This “individual login” method will result in different station callsigns,
different databases, different contests, different Function Keys, different …everythings – except for the N1MM+
program itself. The individual operator will not have access to any of the databases created by other operators under
separate logons. In effect, each user will have their own independent copy of the Logger, except that all of them will
always have the same version of the program.

3. Use a shared document folder for user files for all logon identities. This method can be combined with the previous one.
You can do this by creating a copy of the initial user file area in the first user’s Documents folder in a publicly-accessible
location. In Windows 7, 8 and 8.1, one possible location to do this would be a folder in a location outside all user file
areas, such as at C:\HamRadio\N1MM Logger+. Another possible location could be in the Public files area (if it has
been enabled) at C:\Users\Public\Documents\N1MMLogger+. In Windows XP, the equivalent would be C:\Documents
and Settings\All Users\N1MMLogger+. Once this user file area has been created, all users on that computer will have
access to it. Each user can then set up a second desktop icon for the program that uses a command-line option to
allow the program to use a user file area that is different from the initial user-specific area. With a setup like this, users
can choose either to use their own individual file areas or to use the shared user file area simply by choosing which
desktop icon to run the program from. This is described in more detail in this part of the manual.

Subsequent Installation of the Latest Update of the Software

Update philosophy

Many of us are used to always being “one version behind” in the software we use, in order to avoid bugs that may have been
introduced in the latest version. But because N1MM Logger+ is updated frequently, the opposite is true. You are always
encouraged to use the latest version — in general, bug reports and feature requests should only be made after checking to
make sure the latest version does not already include the bug fix or feature that you want, and also after checking the user
group to see whether the request has already been made by someone else (please refrain from “me too” posts and requests).
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When it is started, the Logger checks the web site for new versions. If a new version has been released since the last time the
program was run, the program will offer to download and install the newer version. It is not necessary to accept the offer,
although it is recommended that you do so. This check will only be done once per new version, i.e. if you do not accept the
offer to download and install a new version, you will not be informed again about that version. The next offer to update will be
displayed only after an even newer version has been made available.

An e-mail will also be sent out periodically to announce new versions (updates) of the program to the groups.io reflector
members. If you wish to do an update manually, download only the Latest Update installer. Use the link contained in the
announcement e-mail to the group, or open THIS WEB PAGE and select the update you want. If you have not updated for a
while, you do not need to install any of the intermediate versions – just go right to the latest. The only exception might be
updates that are marked as “Experimental” or otherwise explicitly marked as not for general use. These are very rare.

The Latest Update installer contains the latest .exes and other necessary files. Run this installer and it will quickly overwrite
any old versions in the program directory.

Note that it is usually not necessary to run a new Full Installer. The only time this is necessary is when the major version
number (the x.yy part of the x.yy.zzzz version number) changes. If the only change in version numbers is in the minor version
number (the zzzz part), simply runnning the latest Update installer is all you need to do to upgrade to the latest version.

If you attempt to run an update installer whose major revision number is different from the previously-installed version on your
computer (e.g. if the installed version number on your computer is 0.18.zzzz and the version number of the new update
installer is 0.19.zzzz), you will see a message similar to the following:

If you see this message, download the latest Full installer and install it. You do not need to uninstall the previous version; the
new full installer will overwrite any old versions that need to be updated. After the full installer has run, you will be asked to
restart your computer in order to complete the process of updating system files; this only happens with the full installer, not
with normal updates using the latest Update installer. After the full install has completed and your computer has been
restarted, you may proceed to install the latest update if its minor revision number is different from the minor revision number
of the full installer you just ran.

Manually Installing a Latest Update

If you encounter an error when attempting to automatically install a Latest Update, you will need to get the file the old-
fashioned way. To update manually:

Go to the website
Navigate to >Downloads >Program Files >Latest Update Files
Right-click and Download the most recent “Latest Update” exe file
Execute that EXE file locally from Windows File Explorer

Thereafter the Updates will resume automatic notifications.

Moving N1MM Logger+ to a New Computer
The easiest and best approach is simply to run the Full Installer and Latest Update to install the program on the new
computer. Now copy your N1MM Logger+ user files folder and subfolders from the old machine to the user files location on
the new one. Overwrite any “starter” versions of files and folders that are already there. (Note: on each computer, the user
files folder can be found by running N1MM+ and using the Help > Open Explorer on User Files Directory menu item.)

We recommend deleting or renaming your old N1MMLogger.ini file, so that the program will create a new one. You can try
keeping the old .ini file, but you will probably find that your old .ini file won’t work properly, because port numbers, port
addresses, sound card numbers and other hardware-related items in the .ini file will probably be different on the new machine.
It is a lot easier to make those changes in the Configurer than using Notepad and editing the old.ini file.
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Moving Data from an N1MM Logger Classic Installation to N1MM Logger+
As mentioned above, N1MM Logger+ stores all user-created data, including databases, Function key message files, .wav
files, Call History files, and User Defined Contest files in the N1MM Logger+ user files folder. You will need to copy each type
of file to the appropriate folder from wherever you were storing them in N1MM Logger Classic.

Since N1MM Logger+ uses an entirely different database scheme, there is an option on the File menu in the Entry window to
import and convert databases for use with N1MM Logger+. Click on Convert N1MM database to N1MM Logger+, select your
old database, and a converted version will be placed in the right folder, ready for use. This only applies to databases, though –
configuration information that was stored in N1MM Logger.ini cannot be converted automatically. You will have to configure
these items using the N1MM Logger+ Configurer. Some other supporting files, such as function key message (.mc) files, User
Defined Contest (.udc) files, Call History files, etc. will work directly; you can simply copy them from our N1MM Logger Classic
program folder and copy them into the appropriate subfolder in the N1MM Logger+ user files area.

Converting Old N1MM Logger Classic Databases

There have been various changes to the N1MM Logger Classic database structure over the years. N1MM Logger Classic
contained code to update its databases automatically if an older database was opened with a newer version of the code. This
automatic upgrading code was not incorporated in the database conversion routines in N1MM Logger+. The only database
format supported in the conversion routines is that used in N1MM Logger Classic version 14.0.0 (and newer).
Therefore, if you wish to convert a database that was created in an older version of N1MM Logger Classic and that has never
been opened by a program version 14.0.0 or newer, you need to perform the conversion in two steps: 1. Open the database in
N1MM Logger Classic version 14.0.0 or newer and then close N1MM Logger Classic (this will automatically update the
database structure); and 2. Use the N1MM Logger+ File menu option mentioned above to convert the updated database to
the .s3db format used by N1MM Logger+.

Another common situation – you have more than one database in Classic, and you want to save them all together in
one N1MM+ database. This detailed explanation from Rich, VE3KI:

For safety, first shut down N1MM+ and make a backup copy of your existing N1MM+ database. It’s in the Databases subfolder
of your N1MM+ user files folder, with the name you gave it when you converted it. The file extension will be s3db – for
example, ham.s3db or Contests2014.s3db, or whatever you called it.s3db. There will also be some other s3db files in the
same folder – just leave them alone.

Start up N1MM Classic. Open the Classic database you want to convert. Do the following steps for each contest in that
database: Open the contest and do an export to ADIF. Do not try to short cut by exporting all the contests at once. Each
contest has to be exported separately so that it will have the correct Contest_ID in its ADIF file, and so it can be imported
separately into its own contest instance in the N1MM+ database.

Now close Classic and open N1MM+. Create a new contest in your database for the first one you exported from Classic. The
contest type must be the same as it was in Classic. Set the start date and time correctly for that contest so you can tell
contests of the same type apart in the new database. Once the contest is set up correctly, do a File > Import from the ADIF
file. Use Tools > Rescore Current Contest to update the score for that contest. Repeat these steps for each of the other
contests you exported. All of your contests should now be in the one N1MM+ database.

Uninstalling the Program
If you are thinking of uninstalling and reinstalling the program in order to fix a problem you have encountered, you should
know that this is rarely the solution. The majority of problems encountered by users are configuration problems that are not
resolved by uninstalling and reinstalling. If the problem is a configuration problem, uninstalling and reinstalling in the same
location will not fix it. Instead, LOOK HERE for suggestions for other, less drastic methods.

However … if you really want to uninstall N1MM Logger+ entirely, including any registry entries, the best way is to navigate to
the program directory and find the program cleverly titled Uninstall.exe. with the N1MM Logger+ icon. Run the uninstaller and
follow any prompts you see. Note that this will not remove your user files in the N1MM Logger+ user files folder. If you want to
remove all traces of the program, you will need to remove this folder manually using Windows Explorer and the [Delete]
button.
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Interfacing Basics
2019-03-29

Interfacing Basics
Operating without an Interface – Manual Mode
There are many reasons why you could find yourself operating in manual mode. Maybe you’re just getting started and have
not had time to install and configure an interface? Perhaps your radio does not support PC integration, or you have a
computer but it lacks the necessary I/O ports to connect a radio? Or maybe you’re operating from a short-term portable
location and don’t have the time or equipment to connect the radio to the computer? Whatever the reason, there are special
keystrokes that you need to enter in the Entry Window to inform N1MM Loggger+ of the band and mode that you are
operating.

Set your frequency by typing it into the Callsign textbox and hitting Enter. If you want the log to only indicate the band, and not
specific frequency information, enter the frequency of the bottom of the band in kHz (note that some contest administrators
request that manual frequency entries always be bottom of band). If you want the log to include the actual frequency, enter the
complete frequency in kHz. For example 14025.1 (or 14025,1 if your computer uses comma as the decimal separator). The
new frequency will appear in the title bar of the Entry window.

Enter mode changes similarly. Recognized entries are CW, RTTY, PSK and SSB, USB or LSB. If you enter SSB, the program
will substitute the customary sideband (e.g., LSB on 40-160) USB and LSB can be used to enter the opposite sideband,
should you ever need to. The mode to be recorded in the log is displayed in the title bar of the Entry window.

For more details about these commands, see the Entry Window Text Commands in the manual.

Basic Radio Control Interfacing
Regardless of whether you want to operate phone, CW or digital modes, the most useful and important interface is the one
between your computer, N1MM Logger+ and your radio. Fortunately, virtually all modern radios incorporate a serial port to
enable them to swap information and commands with the computer.

A first step is to look up your transceiver in the manual section titled Supported Radios. Assuming you find your radio there,
look for any specific settings or peculiarities that need to be addressed and make a note of them.

USB has largely both RS-232 serial ports and LPT parallel ports. If your radio has a standard RS-232 serial port, once you
have purchased a USB-to-serial adapter and installed the drivers for it, N1MM logger can work with your radio just fine. If your
radio uses either Icom’s CI-V standard or another non-RS-232 serial port, you’ll need an appropriate converter cable to get
from either USB or RS-232 to your radio.

Some USB adapters, particularly those using a Prolific chip-set, are erratic with some programs, particularly programs written
in Visual Basic (like N1MM Logger Classic). If you encounter quirky performance or an 8020 error, that may be why. See USB
Interface Devices for a full rundown on user experience with various specific adapters.

Many radios now have USB ports. If yours is one of these, check the Supported Radios entry for your radio (and the radio
manual) to find USB interfacing details.

See this earlier section for information on avoiding problems with USB ports going to sleep.

Once you have the hardware hooked up between your computer and your radio, start N1MM Logger+ and open the Config
menu in the Entry window. Choose Configure Ports, Mode Control, Audio, Other. Ignore all the other stuff for now.

That brings up the following, rather intimidating dialog. Don’t worry, we’ll walk you through the part you need now.
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You may want to select SO1V if this is your first experience with N1MM. SO1V allows N1MM to control VFO A in your
transceiver. If you are an experienced contester and understand how to operate in split mode (for example, working DX on 40
meter sideband), and especially if you have a radio with dual receivers, you may want to select SO2V. It allows N1MM to
simultaneously control both VFO A and VFO B in your transceiver. If you are an advanced contester, whose station is
configured with TWO transceivers (one for running contacts and the other for searching for new multipliers), then you will want
to select SO2R.One of the advances in N1MM+ is that you can use any COM port numbered 1-99. Click the drop-down arrow
to the right of the Port column, and you will see all the serial ports, hardware or USB/virtual, that are active on your PC. Select
the one that is connected to your radio. Now click the drop-down arrow to the right of the Radio column, and select your
specific radio model. Virtually all Kenwood models use the one common radio configuration, while Yaesu and Icom radios are
generally designated by the specific model number – refer to the manual under supported radios for more information. Icom
radios also require a Radio Address (Hex Code) – that’s in the same place.

Now click the “Set” button next to the port you have chosen.
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That will bring up this dialog, with connection details. Normally, N1MM Logger chooses the parameters in the first two rows for
you, and does a good job. You might want to verify them with your radio manual, just in case. Radio/VFO number should be 1,
so that your main VFO will be displayed in the main (first) entry window. The rest of the stuff on this dialog is not important
right now, so just click OK to get back to the previous dialog, and then OK again to return to the Entry Window.

If all is well (you did turn your radio on, right?), when that big multi-tabbed dialog closes and the Entry Window reappears, the
title bar of the Entry Window will display the radio’s frequency and mode. It’s magic. The “+0.00” simply means that RIT is
turned on, but set to zero (no offset)

Now that you have radio control, you can do a lot of neat things, but one of the most basic is that you will never again have to
worry about accidentally logging QSOs on the wrong band or mode.

Interfacing for Phone, CW and PTT
Of course, controlling your radio through a serial port isn’t the only way to interface N1MM Logger+ and your radio – in fact,
long before there were computer-controllable radios, the pioneering logging software authors developed several standards for
CW and PTT interfacing, using either serial or LPT (printer) ports.
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We’ll start, though, with a discussion of phone interfacing, on the theory that this will be of most interest to new users. Once
you’re interfaced, you will be able to store voice messages and play them back through your radio, to save your voice during
phone contests.

Phone Interfacing

This topic is covered in introductory form here, and in more detail in two parts of the manual. This rather awkward organization
is necessary because N1MM Logger+ is transitioning from Classic’s audio function setup, on the Audio tab of the Configurer,
to a new improved option currently on the Config menu, Logger+ Audio.

The Audio tab version works with all versions of the Windows operating system from Windows XP forward. Logger+ Audio
works with Windows Vista and thereafter. If you check Logger+ Audio on the Config menu, and you are running an operating
system after XP, the Audio tab on the Configurer will not be visible. If you are running Windows XP, the Config menu option is
disabled.

Interface Hardware

Of course, you can always use one of the many commercial audio interfaces designed primarily for digital modes. However, if
you have a sound card that permits feeding microphone input through it to the line output (most do), and has a mixer that will
allow you to independently set the level of the microphone, .wav playback and internally-generated audio (such as for AFSK),
you really don’t need an interface at all. On SSB, simply plug your microphone into the sound card mike input. Cable the
sound card’s Line Out to the Line In or Phone Patch input of your transceiver, and you’re done.

You may encounter hum, resulting from difference in AC potential between the chassis of your computer and that of your
transceiver. In that case, a 600-ohm isolation transformer in the cable between sound card and transceiver is a likely cure.
Another approach is to bond the transceiver and computer chassis together with a heavy wire. Many people do both.

If you absolutely must feed the audio output of your sound card into the microphone jack of your transceiver, the level will be
far too high. In that case, a simple 10:1 resistive voltage divider is the solution, placed in the audio cable before the
microphone jack.

Trouble-shooting phone interfacing

The following discussion is cribbed almost verbatim from audio trouble-shooting notes by David Robbins, K1TTT. If any
mistakes have crept in, blame the manual team, not him. It assumes that you’re running Windows XP, using the Configurer’s
Audio tab, and all the screenshots below are from that version.

To begin with, make sure you close Windows Media Player, RealPlayer, Audacity, or any other sound playback/recording
program you may have open. Start N1MM Logger. On the Config menu, open “Configure Ports, Mode Control, Audio, Other”,
also known as the Configurer.

Now select the Audio tab:
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Select option 1 “Only use Radio 1 Output Device. Output on both channels.”

Choosing from the drop-down list at the upper left in “Tx Sound Card Setup”, make sure that the Radio 1 Output Device is
correct for your sound card. Typically, the name will appear as “Speakers” with the name of the associated sound device in
parentheses. You can select Default as your Output Device, if you have set it as that in Windows, but depending on your
version of Windows that may prevent you from muting your microphone while stored voice messages are playing.

If you make an explicit choice of Output Device, you’ll be presented with options under Select Port to Mute. Select
Microphone. Then make sure that the Message Recording Device (sound card) is correct (typically the same as your Output
Device), and that the Message Recording Port is set to Microphone. Make sure the Recording Sample Rate and the
Recording Bits numbers are set to values supported by your sound card.

Now OK out to save these settings, and close N1MM Logger. It’s time to test.

Plug your microphone directly into the microphone jack on your sound card. Plug your headset directly into its speaker output.
Open the Windows Volume Control. It should come up with a set of sliders. In Windows XP, they look like this:
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Or this, in Windows 7, after you finally drill down through the options on the Control Panel, under Sound”:

In Windows XP, you may have to go into Options>Properties to check the box to let you see the microphone volume control
and those for other sound sources. Under Options>Properties, click the ‘Recording’ radio button, and make sure the
microphone is checked on the list of controls:

Sound Cards are weird
Unfortunately, sound card manufacturers have added a dazzling number of bells and whistles the past few years,
including software-configurable input and output ports and other gadgets that affect recording. We have to leave you
a little on your own here. The important thing is to find the microphone recording volume control, make sure it is
selected, and that the level is about 50 percent.
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In Windows XP, make sure the Microphone slider is at mid-range and that there is a check in the Select box. If you are using a
typical ham microphone, such as a Heil, and you have the “Advanced” button, click on it and select Mic Boost if that option is
available, because it provides a 20-30 dB preamp. Now OK out.

Now, when you talk in the microphone, you should be able to hear yourself in the headset. If you can’t, then something is
wrong with your settings, hardware or drivers. Try playing existing .wav files using the Windows Control Panel’s Sounds
option. Recheck volume and mute settings, check that the microphone is plugged into the right jack, try a different
microphone, try a different headset. DO NOT PASS THIS POINT UNTIL YOU CAN HEAR YOURSELF!

Now open Windows Sound Recorder, which is usually found in the Accessories category in your program list. DO NOT open
Audacity, any of the audio tools that came with your sound card, or your other favorite tool. Some of them play with the mixer
settings and we don’t want that now that they are set. These are for QWindows XP and Windows 7, respectively.
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Click the Record or Start Recording button in Sound Recorder, and speak a few words into the microphone. You should see
the level indicator deflect in time with your voice. Now press Stop. Press the Play button and you should hear what you just
said. If you don’t there is something wrong with your hardware or drivers. Check recording control settings, adjust volume,
make sure the microphone is selected as the recording source, and get that 8 year old back to help again! DO NOT PASS
THIS POINT UNTIL YOU CAN RECORD AND PLAY. If Windows Sound Recorder doesn’t work, then N1MM likely won’t work
and since N1MM is much more complicated it is harder to troubleshoot.

If it’s working OK, now close the Sound Recorder and start N1MM Logger. Put the program in Run mode (Alt+U or click in the
Running box) and your radio on USB or LSB, and make sure that the Entry Window’s title bar specifies either USB or LSB (if
you don’t have a radio connected, type the appropriate mode in the callsign box and hit [Enter]).

Right-click on any of the message buttons in the entry window. That will bring up the Function Key message editor:
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Don’t be intimidated – we’re just going to use this screen to set up a single function key to send a single message, so we can
check out the entire flow from pressing a Function Key to having an audio message properly sent to your radio. The filenames
and remarks you see in the editor now are the default filenames that are put into the table when you first install MM. If this is
not your first time using N1MM Logger, these may not be the first ones you see. For the full story on the message editor, see
this page in the manual.

For test purposes, we are just going to use one message, in the slot for Run F1. This is the message that will be sent when
the program is in Run mode and F1 is pressed. This is intended to be the location for your CQ Message. If the editor shows
“F1 CQ,CQ.wav” in the first row of the Run Messages section, then you’re ready to go. Just close the window with the X in its
upper right.

XXXX

The Difference Between “Save” and “Export”
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Now, make sure you are in Run mode – that is, that the Run checkbox in the Entry Window is checked. Now watch the bottom
line of the Entry Window (called the Status Line) and press Ctrl+Shift+F1. You should see:

One important thing to note here. If you have not entered your callsign under change Station Data on the Config menu, you
will not see your callsign in the status line. This is important – stop, go do that, and then repeat this step.

If you speak into the microphone at this point, whatever you say will be recorded in the file CQ.WAV under
WAV\your_callsign… Press Ctrl+Shift+F1 again (or ESC) to stop the recording, and look for this report in the same place:

Now press F1. You should hear what you just recorded in the speaker. If you don’t, make sure you’re still in Run mode and
look for an error message in the Status Line. We suggest using the Ctrl+Shift+Fx process to record within N1MM Logger, at
least until you get truly comfortable with audio files, because a lot of the problems people run into are a result of recording with
diofferent programs, or in filenames that are different than the program expects to see.

Now that you’ve got things working, you need to program at least the first few function keys. It’s best to follow the order in the
example above, at least for F1-F8, because a little later, when we talk about ESM (Enter Sends Messages) mode, the order is
important. Be sure that each Function Key message line begins with the Function Key number, a brief label (like CQ), a
comma, and the content of the message

There is a critical difference between the “Save” and “Export” buttons in the bottom frame of the Function Key
Message Editor. If you click “Save”, the currently-displayed contents (including any changes you have made) are
saved in your current database, for use the next time you press a function key. They are also written to the file-
name shown in the upper frame of the editor. To save a change on the fly and get back quickly to using the
program, all you need to do is click Save and then X in the upper corner to leave the editor and return to the Entry
Window. However, if you want to retain the file that was loaded into the editor in its original form – as you might
want to with the default files, for example – then you must first click Export, select a filename in the Save Macros
to File dialog that opens, and then click Save. Then, you must click Save in the Function Key message editor
to load the edited function keys into the current database.
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OK, so now you have everything you need to play “canned” audio messages on the air. If you’re content to use VOX to switch
your transmitter, and you’re not interested in CW, then you can stop here, for now.

CW Keying and PTT Control

In its simplest form, CW is sent and PTT is controlled by switching lines on a COM or LPT port. This technique allows the
simplest possible interface, but one is required. Here’s a block diagram of the COM port setup. For LPT port keying, a USB
adapter will not work. Your computer must have a hardware LPT port:

Please note that only a very few radios permit CW and PTT via their built-in serial ports. The rest require that the interface be
plugged into the CW key jack on the transceiver. The exceptions to this are covered under Supported Radios.

The interface can be anything from the simplest – one resistor and one transistor – to one of the many units on the market that
handle both CW and various digital modes.

Let’s assume you’re going to use this method to start with. Begin by opening the Config menu to the Ports, other dialog:

Unsupported Methods of CW Keying
N1MM Logger+ supports several methods of CW keying, but two are not supported. The first of these unsupported
methods is CW by audio tone, or MCW, as is done by software such as FLDIGI. The reason for this is that if it is
not set up carefully, this method can produce unnecessarily wide signals, or even in some cases two closely-
spaced signals from one transmitter.

The second unsupported method involves sending ASCII characters to the radio, which then converts them to CW.
Only a few radios have this capability, and in most or all of these the resulting CW operation is far less suited to
contest use than the Logger’s own. N1MM Logger+ does not support this method directly, although it is possible
for users to use this capability by means of radio control macro commands incorporated into function key
messages, provided they are willing to accept some loss of functionality as compared with the directly supported
methods.

A full discussion of interfacing is in the Interfacing section of the manual.
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For this example, our CW port will be on the second port we configure (the first port, COM6, will be used for radio control).
let’s choose COM2 as our CW/PTT port. After selecting COM2 from the pull-down list of available ports, put a check in the
CW/Other box and you’ll notice that the Set button is no longer greyed. Click on it, and open the dialog for that port:
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You can configure the DTR pin as either CW or PTT. Click the down arrow and you’ll see the list of possibilities:

Highlight the one you want, depending on your interface. Now do the same with the RTS pin:

You can use either signal line (DTR or RTS) for either function (CW or PTT); just make sure your choice matches up with the
way the hardware is wired up.

Set the Radio Nr to 1. The PTT Delay setting is to protect the relays in an amplifier by making sure that the T/R relay is closed
before the program starts sending CW. The default value of 30 ms. is fine even if you don’t have an amplifier.

OK, now to interface to the rig. The very simplest interface imaginable will work just fine for either the CW or PTT functions
with any modern radio; again, there are many commercial options, but here’s the Radio Shack parts solution:

Using Winkey/Winkeyer for CW
K1EL’s Winkey/Winkeyer devices have become very popular with N1MM Logger+ users. The chips are built into a
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number of interfaces. The stand-alone Winkeyer USB will key two radios and provide PTT functions for both on all
bands, simplifying changing modes considerably.

Follow the instructions that come with your interface in setting up CW keying. For the stand-alone unit, You’ll need to
determine which port your Winkeyer is listening on, and then check its CW/Other box. Finally, click the Set button
and check the Winkey box. That’s all there is to it. Do NOT try to configure DTR or RTS for a Winkeyer; checking the
Winkey check box automatically sets these to the correct settings for the Winkeyer.

You will probably also need to review (and likely change) settings on the Winkey tab of N1MM Logger+’s Configurer
(Config>Ports, Other). One important one with many transceivers is the Lead Time parameter, needed to prevent
Winkey from starting to send CW before your transceiver is ready to make RF. A setting of 2 (20 mS.) is usually
plenty; more can make manual keying difficult.
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Setting up for a Contest
2019-03-29

Setting up for a Contest
Preparing for a Particular Contest
Now that you have set up the hardware interfaces to your radio, including radio control (often called CAT), PTT, CW, etc., let’s
move on to setting up for a particular contest.

Note that the first database the program creates is named ham.s3db by default – you can have as many databases as you
want, and name them what you want. Some people prefer to create a database for every contest, while others create one for
a period of time, like every year. If you want to create a new database, for example “2020.s3db”, just click Files to drop down
the menu, and then click on “New Database”.

That will open a standard file creation dialog in your N1MM Logger+ databases directory (inside the User files area):
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Name your new database and click Save. You’ll be switched to the new database and ready to go.

Back to the Files menu again. This time click “New Log in Database: XXXXXX” A new dialog opens, called the Contest Setup
Dialog.
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This dialog has two important aids to completing it properly, the buttons labeled “Show Rules” and “Show Setup”. Show Rules
takes you (via Internet) to the sponsor’s web page, while Show Setup takes you (again via Internet) to the N1MM website’s
Contest Setup page, located in this section of the manual. Typically, the latter will give you what you need to fill in the Contest
Setup dialog.

The first thing to do is to click on the downward-pointing arrow in the Log Type field. That will open a list of abbreviated contest
names. You can use your mouse to scroll through the list, or type the first letter of the contest to jump to the right general area.
Once you have found the contest you want and highlighted it, click back in the original field and the drop-down list will close.

When you set up a new contest, the Start Date defaults to the Saturday (usually) following the current date. This can be useful
if you have several versions of a given contest in your database. Year to year, dates of contests change, but the day of the
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week usually remains the same. For this reason, the program assumes that the contest will actually start on the correct
day of the week (and time of day) following the date when the new contest was set up. For example, if you set up a new
contest on Wednesday, and that contest normally starts at 0000Z on Saturday, the program assumes that 0000Z on the
following Saturday will be the actual start time, for purposes of computing time on or off the air, and for displaying any goals
you have set in the Info window.

To avoid confusion, it is best to set up the log you will actually use within a week before the start of the contest. You can
always use a practice version earlier. So long as it is in the same database, you’ll be able to set goals, set up your function
keys and other associated files, and all of this will be available for use when you set up the “real” log. Just create a new log for
that contest with the correct starting date and time and you’re ready to go. You can delete the practice log or not, as you
prefer.

Next, fill in the information in the next few fields, denoting the class and category you intend to enter in the contest. In each
case, you have drop-down lists available. “Overlay category” refers to contests like WPX, which have both regular classes and
categories like Rookie or “Tri-bander plus wires”. In most cases, “N”, for not applicable, is the answer you want there.

Beginning in 2011, some contests adopted the Cabrillo 3.0 standard for their log submissions, while others continued to
require Cabrillo 2.0. The new standard (embraced by the ARRL, IARU and some others) required a different breakdown of
information in the Contest Setup dialog. The one shown above is for Cabrillo 3.0. Both dialogs are self-explanatory, but you
can find more information on the Contest Setup dialog for Cabrillo 3.0 here.

Next comes the most important part of this dialog, the Sent Exchange field. This field specifies what will be entered in your
Cabrillo file as your sent exchange and what is inserted in the {EXCH} macro in your function key definitions:

For many contests, the program guesses what you will want, based on the contest type and the contents of your Station
Information dialog. For example, in this case, since the CQWW contest uses CQ zones as the exchange, it has already
entered the zone, based on the zone already entered in my Station Information. Of course, this can be overridden if it is
incorrect. Note the “Omit RST” warning – do not include 59 or 599 in the sent exchange. If the contest you choose has serial
numbers, like WPX or the NA Sprint, then you need to put “001” at the start of the Sent Exchange field, separated from what
follows by a single space if there is more to the exchange. Hence, for WPX, the Sent Exchange would read 001. An important
exception is the ARRL Sweepstakes. The serial number is assumed for this contest only, so for example N4ZR’s Sent
Exchange for SS would read B 54 WV. More information on the Sent Exchange for individual contests is in the Supported
Contests section of the manual.

Once you have filled in the Sent Exchange, you’re done for now. Just Click OK and hit Enter.

Trying It Out
So really, that’s all you need to operate contests with N1MM Logger controlling your radio – the Entry Window, the Check
Window, the Log Window and the Bandmap.

For the purpose of this guide, we’ll assume that you’re operating in the CQWW SSB contest. In that case, the Entry window
will look like this:
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I’m assuming that you’re going to operate phone to start, so I have typed in USB in the call-sign field, and hit [Enter] I have left
the default frequency (20M phone) in place, but if I wanted to show another band, I need only type a frequency (in KHz) in that
band (like 21200, for example) in the call-sign field and hit [Enter] to change bands.

When I’ve done these things, I then type a call-sign in the call-sign field. Even before I look at the Check window, I see that the
call sign is color-coded green. This means that it is both a new contact and a double multiplier (in this case, both the new
country of Martinique and the new Zone 8). If I had already worked Zone 8 on this band, then the call sign would be color-
coded red, signifying just a new country. If both the country and zone had been worked before, but the station has not, then
the color code would be blue. If it is a dupe, the call sign will be coded grey, and the warning “Dupe!” appears to the right of
the entry fields. There is also a column of band buttons to the left, all of which are also colored green in this example,
indicating that this station would also be a double multiplier on each of the other bands. The beam heading is displayed below,
as are the country, its zone and continent (which affects points per QSO).

So, you call him, and he answers. At this point, just hit [Space] to fill in the expected signal reports and move the cursor to the
Zone field. N1MM Logger uses the [Space] bar as a “smart tab.” The idea is that it will skip fields you are unlikely to want to
change and move immediately to the one you may need to. Note, too, that the zone is highlighted. This means that if you
need to change it … for example, if FM5BH really was in Zone 9 (he isn’t) – you would just type “9” and the “8” would be
replaced.

Ok, but suppose he gives you a “57” report instead of “59”. No problem – you just use the [Tab] key twice, and the cursor will
be on the second digit of the received signal report, ready for you to type over. The [Tab] and Shift+Tab work just as you’d
expect in Windows, moving forward or backward one field. Here’s how it looks:

If you need to correct the call-sign, use the [Space] bar to get you quickly there and edit as necessary. Then, once everything
is as you want it (and the QSO is done), all you do is hit [Enter] , and the QSO will be logged.
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One thing that trips everyone up at least once is that the program checks to make sure that you have entered everything, and
that everything is correctly formatted. For example, if you accidentally fat-finger the zone number, like “89”, the program won’t
let you enter the QSO. This can be disconcerting at first – you get an error message in the status line, like this:

If the program has blocked you from logging the QSO, just use the [Space] bar to move to the appropriate field, correct it, and
hit Enter to log. If you absolutely can’t figure out what the correction should be (for instance, with an ARRL section in
Sweepstakes), you can hit Ctrl+Alt+Enter to bypass the exchange checking and log the QSO “as is”. or you can just press
Enter again, which will give you the following warning dialog and allow you to log the contact despite the error:

Just in case you want to put a note in the log, when you use Ctrl+Alt+Enter to log an invalid contact, a note window opens.
Type whatever note you want and Hit Enter, or just hit Enter to skip it and get back to the contest.

Suppose you miscopied a call sign, or he didn’t really come back to your call, so you now have a mistake in your log. If you
need to delete the QSO altogether, just hit Ctrl+D. The program will ask you if you really want to move the QSO to a Deleted
QSOs file. Just hit [Enter] to do so, or type N for No.

If you need to edit the QSO, hit Ctrl+Q, and put the program in QuickEdit mode:
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You’ll notice the words QuickEdit above the call-sign field. You can move through the fields as before and make your
corrections. Then hit Enter and the QSO will be corrected in the log, or else hit [Esc] to get back to normal logging mode and
cancel any changes. Be careful not to leave the program in QuickEdit mode for your next QSO, or you’ll screw up two QSOs
at once!

As you log more QSOs, you’ll note that the call-sign of your last previous QSO will appear in the space right above the call-
sign field. This area, called the Call-Frame, will be very important once you have interfaced the program with your radio, but
for the moment it is just a reminder of who that last guy was.

Remember

Remember, unless you have interfaced your radio, each time you change bands, you need to enter the frequency of
that band in the call-sign field, and, if you change modes, enter that there too. For example, if you switch to 40M CW,
you would need to enter 7000 and then enter CW (separately) before you begin logging QSOs on that band.
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Operating a Contest
2019-03-29

Operating a Contest
Before the Contest
This section addresses, in a brief and informal way, steps that you should take to get ready for a contest season and for each
contest. It is worth reading. Where appropriate, links are included to point you to more extensive information.

Update Your Data Files

Make sure you have imported the latest wl_cty.dat file and downloaded the latest Super Check Partial (master.scp) file prior
to the contest. Menu options for doing this may be found on the Tools menu of the Entry window.

If you are using a Call History file, import that into the database also and make sure Call History Lookup is on. More
information about Call History can be found in this section.Load the function key definition file that you plan to use into the
database too. If you make any changes during testing, export your function keys to make sure your changes are saved. An
explanation of how to create function key definitions is found HERE, with additional information specific to phone function key
messages HERE. Sample Function Key files for the major contests can be found in the >Downloads >Function Key Files
folders for CW, SSB, and Digital modes . Click here to watch videos about downloading and configuring your data files.

If you’re going to be operating in a remote location without Internet access, go to the >Downloads >Documentation Downloads
(PDF) folder for a PDF version of the manual. Store a local copy of the documentation in case you need to reference it when
disconnected from the website.

Test

Today, the program supports CW, SSB and multiple digital modes, close to 300 contests, and a wide variety of radios and
ancillary equipment. Contest rules change all the time, and organizers often forget to let logging software developers know. If
this were a conventional software project, any sane programmer would declare it “untestable.”

Since its early days, the N1MM Logger project has relied on users to do most of the testing. Rapidly releasing relatively small
updates, with the option of retreating a version or two if necessary, makes this a relatively low-risk approach, so long as
users test each one enough in advance of the next contest they want to get into.

If you are planning to operate in a contest a couple weeks from now, load the latest update NOW, create a contest “instance”
as outlined here, sit down with your radio, computer, DX cluster connection, keyers, and whatever else you use, and simulate
logging a dozen contacts as if you were running (enter a make-believe call, type and hit function keys as fast as you can).
Then log a few more in S&P mode. Make sure your messages and macros work as expected, make sure you can record and
playback SSB messages on the fly, make sure the multipliers you think should be counted are scored right, log some contacts
that shouldn’t be multipliers or points and make sure they are handled properly. If operating Assisted, grab some spots, make
some spots, check the color-coding of spots against the contest rules. Make detailed notes of problems, if any.

A lot of problems are the result of a local issue – hardware settings, user options or the like. Do take the time to check the
documentation first, but then don’t hesitate to ask for help on the N1MM reflector. 4000 users and the N1MM team are there to
help. With thanks to David Robbins K1TTT, from whose input this section was adopted.

During the Contest

Making Contest QSOs

Make sure you have your CW or SSB or digital function key definitions set up the way you want, set up as outlined in Before
the Contest.

Now let’s begin. There are several ways to make and log a contest QSO with N1MM Logger+, depending on how much you
want to automate the process. The details are the same for either phone or CW. The 4 main ways you can use the stored
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messages are listed here in ascending order of speed and convenience.

1. One key at a time – press a function key when you want to send the associated message. Use the [Space] bar to move
your cursor. When you have everything filled in, press [Enter], and the QSO will be logged. Done this way, a typical Run (CQ)
QSO would look like this:

1. F1 (CQ)
2. Station answers – copy call in callsign box
3. Say his callsign (phone) or press F5 to send it (CW)
4. Press F2 to send the exchange (either a stored voice message or CW)
5. Press [Space] to move the cursor to the exchange field
6. Type in the received exchange
7. Press F3 to send your acknowledgment
8. Press [Enter] to log the QSO

2. Semi-CT Style – CT was the DOS logging program that pretty much started all this. It used the following convention to
save keystrokes:

Enter the callsign of the station calling you. Press the [Ins] key to send his call and your exchange (CW), or speak his call and
then press [Ins]. Once you have copied his exchange, press F3 (TU) and [Enter] to Log. If you are calling other stations
(Search and Pounce, or S&P), you would first press F4 to send your call, and when the station responds follow the sequence
as above.

3. Early N1MM style – Enter the callsign of the station calling you. Press the [;] key to send his call and your exchange. Copy
his exchange and press the “[‘] (right next to ; on US keyboards). The program sends the F3 (TU) message and logs the QSO.
In S&P, you would hit F4 first, then [;] and then [‘].

This saves some keystrokes, but there’s an easier way. A couple of decades ago, N6TR developed the idea of making TR Log
“modal.” By that, he meant that the program would behave differently depending on whether you were in Run or S&P mode.
Making this distinction let him massively simplify and shorten the sequence of keystrokes required to complete a QSO.

4. Enter Sends Messages – N1MM Logger has now evolved N6TR’s invention into what is called Enter Sends Messages, or
ESM for short. You’ll find a full explanation of this mode in this section.

In short, ESM enables you to enter a callsign and then step through the remaining steps in logging a QSO, simply by hitting
the Enter key. The program anticipates what you’ll want to do next, moves the cursor, and highlights what canned message
will be sent if you press Enter the next time. Note that if you wish, you can still press individual function keys at any time, to
send a repeat or otherwise bypass ESM.

Once you’ve used ESM, we think you’ll never go back to the old way again.

Bugs Encountered During a Contest

When a bug was missed during testing and comes out during the contest please report it on the reflector right after the contest
or, during the contest if it is a show stopper. Tom and the developers participate in many contests but they also read the mail
during contests and can suggest work-arounds or sometimes bring out a new version. In addition, there are many other hams
available there who can help.

Rather than writing down problems during the contest, try the following:

1. Use Ctrl+N to write a Note that will be attached as a comment to the QSO
2. At the end of the contest, use the menu option >View >Notes to see all the notes you have made during the contest

After the Contest

First, a Word on Protecting Your Data

After almost every contest, we hear from a new user (or sometimes even an experienced one) who is afraid he or she has lost
the log from the contest just completed. Fortunately, it is usually not true, but here are a few things to remember:

Backup – this is just as important with logging software as with any other computer application. Data not backed up can
be data lost if something happens to your hardware or you make a mistake while manipulating the log database if you
haven’t backed it up. N1MM Logger+ stores all your QSO data in a file with the extension .s3db. The name of the file
is whatever name you assigned to it when you first set up the program. There are other databases also used by the
program – N1MM Admin.s3db, N1MM Packet Spots.s3db, and Do_Not_Use_Or_Erase.s3db, but all the QSO data are
in that first one. The easiest way to do really secure backup is to use a free backup program such as Syncback SE to
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back up your active QSO database to a USB “thumb drive.” Any such drive you can buy today is plenty big enough, dirt
cheap, and safe from virtually anything short of a ball peen hammer.

Save A Copy – Before you do anything, even if you just want to peek into your QSO database with an SQLite viewer,
save a copy manually to a safe location. You are, after all, only human; we all can make mistakes, so it’s wise to do
what you can to protect yourself against them.

Transaction TRN Files – During normal operation N1MM Logger+ saves the information about each QSO in a simple
text file. These files are stored in a sub-folder in the Databases folder in the user files area and can be used to recover
in the event the database file is corrupted.

Here’s an explanation of how you can use those files to recover your data quickly, during a contest, or at your leisure if
you haven’t done one of the two steps suggested above:

The transaction log is created for each contest you log to
The file is closed after each transaction and reopened to force the data to be written to disk
To keep things simple and foolproof, you are not allowed to change the name of the transaction log
The name is used to make sure you are loading it properly, and to prevent mixing logs of two contests. Example
name: ‘CQWWCW – 2005-09-19 – 14.TRN’ i.e.: Contest name – date log created – an internal index number
To Recover your log, you MUST import the transaction log into a NEW (empty) database and a NEW contest
log. See THIS LINK
The new contest log must be the same contest as the contest from the transaction file (Example: if restoring
CQWPXCW, the new contest must also be CQWPXCW). Why? To prevent a user recovering from a database
problem making the problem worse. This will prevent any issues from duplicate contacts and a number of other
problems
As you load the transaction log, a new transaction log is automatically made with the transactions in the first log.
Thus you should never have to merge logs. You always use the last one

Editing Individual QSOs

The easiest way to edit a QSO is by double-clicking in the Log window on the data you want to change. In rare cases, you
may need to select the QSO in the Log Window and right-click. Select “Edit Contact.” The Edit Contact Window will appear –
for full details see the explanation here.

Sometimes you may need to recover a QSO that you deleted by mistake during the contest. When a QSO is deleted, it is not
completely removed from the database; instead, it is moved into a special log called DELETEDQS, from which it can be
recovered as follows:

First, export the contest log to ADIF (File > Export > Export ADIF to file > Export ADIF to file…). Open that ADIF file with
Notepad and look for an entry that looks like < CONTEST_ID:nn > contest-name in each QSO record. Take a note of
what nn and contest-name are – you will need to use them in the next step. Keep that Notepad window open.
Open the DELETEDQS log from inside N1MM+ (File > Open Log in Database… – it will be the bottom log entry on the
list), find the QSO in question, right-click on it and select Copy > Copy ADIF string (Copy is near the bottom of the
popup menu). Then you can paste that into the Notepad window with the main contest log ADIF file in it. Edit the <
CONTEST_ID:8 > DELETEDQS field in the recovered QSO record to change it to match the other QSOs in the file.
Save the file.
In N1MM+, create a new database (File > New Database…). In that new database, create a new contest log of the
correct type. The start date and time won’t be right, but you can edit those to change them to the actual contest date.
Now import the edited ADIF file into the log (File > Import > Import ADIF from File…), and use the Tools > Rescore
Current Contest menu item to recalculate the score.

Entering Multiple QSOs After the Contest

Computer trouble? Made a paper log during (part of) the contest? The program has some nice features that will allow rapid
QSO entry. You can either enter the time for each QSO, or there are features to let you set the date and time via interpolation.
(Remember, exact QSO times are not critical for contest sponsors, just within reason).

Crackdown on Post-Contest Logging Changes
Contest sponsors are cracking down on post-contest log “massaging” that uses resources you access after the
contest is over. The CQWW Contest Committee has recently been particularly explicit about this, saying that
“the…Committee considers it unsportsmanlike to ‘clean’ your log post-contest using data sources such as
recordings, call sign databases, etc.” This kind of restriction is not intended to apply to post-contest log changes
that are based on things you noted during the contest, such as problems with the CTY.DAT file, bad abbreviations
for counties, states or provinces, etc. If you caught it during the contest, you should feel free to fix it afterward.
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Type frequency band (4 or 5 digit numeric frequency, e.g. 7000, 14000) in the call-sign textbox of the Entry window and
hit Enter. Then type the mode (CW, USB, LSB, etc.) and hit Enter.
Enter calls and exchanges, and log them, as long as they are on the same band. Don’t worry about date and time right
now.
When you need to change bands, enter the new frequency band and continue.

Change Time/Date for a Single Hand-Entered QSO

Updating the date and/or time of a single QSO is best done by double-clicking on the time stamp for that QSO and then using
the date-time box that appears to edit the date and time. Alternatively, you can use the Edit Contact option in the right-click
menu associated with the Log Window and edit the date and/or time in the Edit Contact window.

Change Time for Multiple Hand-Entered QSOs

This method can be used to interpolate approximate times for a series of contacts. This time interpolation feature is most
useful if you have a bunch of QSOs to enter. If you have one or two QSOs whose times need changing it is easier to do it by
editing in the Log

In the Log window, single-click the first QSO whose time and date you want to change. to highlight the row
With mouse over the Log window, right click
Select >Set Start Interpolation Time Row
Enter the new timestamp for the first QSO, and click [OK]
Now, click on the last QSO whose time/date you want to change, to highlight the row
With mouse over Log window, right click
Select >Set Stop Interpolation Time Row
Enter desired time for that last QSO, and click [OK]

Change All QSO Times/Dates by a Fixed Amount

This will fix a log where all QSOs are off by a fixed amount of time (for example, when the times are correct but the dates are
wrong by one or more days because the QSOs were entered after the contest).

Right click in the Log window
Select >Change timestamps of the entire log by a fixed amount
A dialog box will open, and enter offset time (+ or -) in minutes

The date will automatically adjust if the offset rolls a QSO into a different day. Time is entered in minutes, and can be negative
time to go backwards. (You might need a calculator to determine the offset minutes if your date was off by many days,
months, or years). For example, entering +1440 will shift a complete day forward; -2880 two days back.

Make a Copy of Your Log
Make a backup copy of your log database. You cannot (automatically) reverse the time interpolation process below.
You have been warned!



Changing QSO Time and Date
The utility will average out and interpolate the time for each QSO in the group of QSOs you have selected.
Remember there is no “undo” feature. If you have a large gap in time in your hand log, enter the first batch of
QSOs, and do the interpolation. Then enter the second group of QSOs and do a 2nd interpolation.



Single Computer Mode Only
If you have more than one computer networked in N1MM+, this feature does not work. The option is disabled
whenever Networked Computer Mode is on.



Back Up Your Log Database
While you could easily recover from a mistake during the following adjustment by performing another offset, it is still
a good idea to play safe.
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How to Create Cabrillo Files

To submit your log, you need to export it from the database in the proper format. Cabrillo is used by all major contests.

Select File >Generate Cabrillo File.
Make sure that your Station information (Config >Change Your Station Data), and overall contest setup are correct (in
the Contest Setup dialog, reached through File >Open Log in Database …). For example, is your entry class correct?
Your power classification? Whether Assisted or not? Are your State and ARRL Section both entered correctly in your
station data?
Did you put the right information in the Sent Exchange field, and nothing else? For example, when the exchange in a
contest is 5NN WV, it may be tempting to put the whole thing in the Sent Exchange. That will screw up the Cabrillo file
with multiple signal reports for each QSO, so get in the habit of putting the signal report in your stored messages, not in
this field.
A Cabrillo file will be created named your_call.LOG. By default this is placed in the ExportFiles sub-folder in the N1MM
Logger+ user files directory, but you are given the options of choosing a different name and/or of saving the file
anywhere else you wish.

It is a good idea to rescore your log (Tools >Rescore Current Contest) before generating the Cabrillo file.

How to Merge Contest Logs

If you ran a multi-op station but did not network your logging computers, you will need to combine the logs from each
computer into a single log submission for the contest sponsors.

Using N1MM Logger+ and ADIF Files to Merge Logs

This merge method is the most automated and should require no manual log editing, but will only succeed if the contest types
in each logging computer were identical. If the contest types were not identical, it may be possible to recover with the help of a
text editor and some detective work, but it will likely not be easy. It’s better by far to avoid this situation by using the identical
contest types during the contest.

1. Examine the logs to ensure that the contest types are identical in each computer: >File >Open Log in Database
2. Export an ADIF file from each logging computer: >File >Export >Export ADIF to file. Assign a unique name to each

ADIF file to distinguish it from others when importing. Before continuing, guarantee that the contest types from each
computer were identical by opening each ADIF file with a text editor (like Notepad) and looking for the ADIF expression
CONTEST_ID. They should all be the same length and contest name. For example: < CONTEST_ID:14 > ARRL-
FIELD-DAY

3. Copy all exported ADIF files to the computer that will create the merged log
4. Launch N1MM Logger+ in the merge computer. If the merge computer is one of the ones that was used during the

contest, you will need to create a new database for the merged log: >File >New Database. Now in the new database or
on the new computer, create a new contest log for the merged records: >File >New Log in Database. Be careful to
make the contest type identical to the contest type that was used during the contest

5. Import the extracted ADIF files one after another into the new contest log: >File >Import >Import ADIF from file
6. Use >Tools >Rescore Current Contest to rescore the contest
7. Extract the new, merged contest log for submission to the contest sponsor: >File >Generate Cabrillo File

Using Excel and Cabrillo Files to Merge Logs

In some circumstances, it might be easier to combine logs outside N1MM Logger+ by importing the Cabrillo files into a
spreadsheet program like Excel. As with the ADIF method, this works best if the contest types are identical, or at least use the
same Cabrillo format (i.e. similar contest exchanges, same columns).

1. Create a Cabrillo file from each log: >File >Generate Cabrillo file. Assign a unique name to each log file to distinguish it
from others when importing

2. Copy all exported Cabrillo log files to the computer that will create the merged log
3. Combine the QSO records from each Cabrillo log into a single text file using a text editor (like Notepad). Open each

Cabrillo file, and copy only the QSO records – leave out the header information in the beginning and END-OF-LOG
statement at the end. Paste this QSO information into a new text document (a .TXT file) with the QSOs from every log.

4. Launch Excel in the merge computer, and import the combined .TXT file into a spreadsheet. In Excel: >File >Open, set
file type for TXT, and select the merged QSO log file. In the Excel text import wizard, declare the original data type as
fixed width. In the Data Preview dialog window, adjust the field delimiters as necessary to begin each Excel column at
the beginning of a log field. Press [Finish]. Examine the QSO columns in the spreadsheet to ensure that your import
was successful

5. Select the entire spreadsheet using your mouse or [Ctrl]A, then sort the spreadsheet by date and time: >Data >Sort,
column D (date), and column E (time)

6. Export the sorted log data to a space-delimited file: >File >Save as >FORMATTED TEXT (Space Delimited) .PRN
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7. Using an editor, copy/paste the Cabrillo header information and END-OF-LOG statement from one of the original
Cabrillo logs into the sorted data file. Rename this file as a .LOG file type and submit it to the contest sponsor.

How to Print the Log

There is no specific option for printing a log directly. However, if you Click on Export on the File menu, there’s a variety of
options that can be used to create a file that you can then print a copy of:

The most likely reason for wanting a printed log is for awards submissions or archiving. Because N1MM Logger+ is not
intended as a general-purpose logging program, it does not offer award tracking functions. However the ADIF file option will
give you a file that can be readily imported into any popular general logger. If you just want something for a notebook, the
Generic export will give you a text file that can be printed from Notepad.

How to Get Statistics

From the View menu item in the Entry window, choose Statistics. This tool allows you to select any two data points of interest.
For example, you can select hours for the Row and Zones for the Column, and the program will display a table of how many
QSOs in which zones were worked in which clock hours. This is a lot easier to use than it is to explain in words, so give it a
try.
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Learning Your Way Around
2019-03-29

Learning Your Way Around
Take a few minutes to learn your way around the four windows that you need to make your first contest QSOs with N1MM
Logger+. Additional information about each window will be found in the window-specific pages linked to HERE.

The Entry Window

Let’s get a little terminology out of the way first. The top blue part of this (or any) window is called the Title Bar. Each of the
places where you can type information is called a textbox. The Title Bar displays the current frequency, mode (if one has been
selected), and which radio it is (nominally, Radio A). You will have to enter a mode before you begin to operate, and a band
and/or mode each time you change either. Simply type a frequency in KHz (3500, 7000, etc.) in the Call-Sign textbox (to the
far left) and hit Enter; then type a mode (CW, USB, LSB) there, hit Enter again, and you’re set.

The Entry Window is your main starting place for everything you do with N1MM Logger+. The first row is a standard Windows-
style menu, and we’ll be using it in a minute. Take a moment and explore the various drop down menu choices, but don’t
change anything right now.

Below the menu is a set of entry textboxes. This row is where you log your contest QSOs. The left-most textbox is the Call-
Sign textbox. You always enter the call-sign of the station you are working into this textbox.

The rest of the data entry textboxes are titled above them – depending on how you have resized the window, the titles may not
line up perfectly with the entry textboxes, but they are always in the same sequence as those textboxes. Depending upon the
specific contest and the required contest exchange, the number of textboxes and the titles may be different from what you see
here. The example Entry Window shown above would be used during the CQ WW Contest. This contest requires that a call
sign, sent and received signal reports and the CQ Zone be logged for each contact

For now, you can ignore the ‘Run’ and ‘S&P’ buttons, as well as the colored dots alongside them. These control one of the
most important features of N1MM Logger+ – it distinguishes between Run and Search and Pounce modes, providing different
features for each. However, these aren’t really relevant until you get into sending stored CW and phone messages, which are
covered later. The rest of the buttons in the Entry Window are related to this and to other advanced capabilities.

If you want to save space on your screen, you can reduce the size of the Entry Window, like this. Right-click in an empty part
of the window and uncheck the options for items you do not wish to have displayed.
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There are two more useful features of the Entry Window. The box in the lower left corner, called the Status Line, provides a lot
of useful program status information. For example, if you enter a call sign, the Status Line will tell you what country it
represents. If you have chosen to show bearing information in the right-click menu, it will also show you the distance and
bearing above the status line, like this.

To the right of the Status Line is the progress box, where you can keep track of your QSOs and multipliers without having
another window open, and to its right is a running score.

If you press the backslash “\” key (and the program is in SO2V or SO2R mode), the program opens a second, almost-identical
entry window. The only difference is that it will have a “B” instead of the “A” in the title bar of the first entry window, and it may
well have a different frequency and/or mode as well. But if you pop up the second Entry Window by mistake, and want to get
rid of it, you simply close it by clicking the big red X.

When you first open the program, it will be in SO2V (Single Operator Two VFOs) mode. The idea is this – most modern
transceivers have two VFOs, or a main VFO and a sub-VFO. There will be circumstances – during a contest on 40 meter
SSB, for example – when you will want to receive on one frequency and transmit on another, widely-separated one.

For the moment, you should probably change to SO1V (Single Operator One VFO) mode. Select the Config menu, and under
the dropdown menu, select Configure Ports, Telnet Address, Other and then click on the SO1V button. This will prevent the
second Entry Window from opening.
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The Entry Window is the nerve center of N1MM Logger+. The program returns focus to this window automatically in many
situations.

Program Menu Descriptions

The manual contains detailed information about the Entry Window’s menu choices:

File
Edit
View
Tools
Config
Window
Help
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The Check Window

OK, another important window – the Check window. You open it by clicking on Check in the Entry window’s Windows menu.

This window is used to display the results of checking a call sign against any or all of the following: your log; a master list of
calls, variously called the master.scp or Super Check Partial file; call signs that have been spotted and received in the Telnet
window; and call signs in a user-defined file called the Call History file. A Super Check Partial file is provided when you install
the program, and the process of updating is covered in the Tools Menu section of the manual page on the Entry window.

First things first, though. When you type a call sign in the Entry Window, the Check window displays whether a match was
found or not in the various selected sources. Call signs that differ from the one you have typed in by only one letter have the
different letter highlighted in red, while similar call signs that are longer than the one you have typed in have the additional
characters highlighted in green:

In this example, all four possible sources have been selected. You are in the process of typing DL5AXX into the Entry Window,
and so far you have typed DL5AX. This exact call sign (DL5AX) was found in the master.scp file, and therefore it is displayed
in bold-face italic font at the top of the master.scp pane. It is blue, indicating that you have not worked this call sign and it
would be a valid QSO in the contest. Note in the left (log) pane that DL5AXX already appears in your log. A number of other
call signs that differ from DL5AX in only one character were also found in the master.scp file.

If you keep on typing until the entire call sign has been entered, you will see:
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Now the station’s call appears in grey, meaning that it would be a dupe.There is much more on the Check window here.

The Log Window

To begin with, click on Log in the Entry window’s Windows menu. That will open a Log window on the screen, like this:

First, you should notice that the title bar of the Log Window gives the current date and exact time, the name of the contest,
and the database in use. As you log QSOs, they will appear in the log. One is logged one above just to indicate how it looks.
You’ll note that each column has a fixed label – these labels change between contests. CQWW is a 2-multiplier contest, so the
log shows columns for two multipliers: M1, which is the CQ zone, and M2, which is the country. The check mark in each
multiplier column simply means that it is the first station for that multiplier on that band.

If you click on any column heading, the entire log is sorted by that attribute – for example, if you click on the “Call” heading,
the log will be sorted by call sign. Click on the MM-DD HH:MM heading to switch back to the normal chronological order.

A further nice touch – if you click a second time on the column heading, for example the “Call”, the sort order switches from
Ascending to Descending, so that all your “Z” QSOs come first, and your “As” last. Same goes for the date/time heading –
normally, you’ll want to leave the Log Window in ascending chronological order, so that each QSO you log appears
immediately at the bottom of the list.

The Log window has two “panes”; the one above the grey bar is the normal log, while the one below the line is to show you
previous QSOs with a station each time you type its call into the Entry Window. This makes it very easy to see quickly all the
information about previous QSOs with a station, e.g. for that special someone who drops by and asks, “What was the serial
number you gave me yesterday?”

Check out this section of the manual for more details.
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Like all windows in N1MM Logger+, the Log window is resizable, as are the individual log columns – to resize the whole
window, use your mouse to drag the lower right corner, and to resize a column grab the between-column divider and drag it
right or left. You can move any window around the screen by dragging its title bar. Also, you can change the font size in the
Log window by clicking on the font sizer buttons at the top right.

The Bandmap

With an interfaced radio, you will find it useful to open a Bandmap window. Click
Window, then select Bandmap, and the Bandmap corresponding to your entry
window will be displayed.

In the example at left, I have filled the Bandmap with spots from a packet cluster,
just to illustrate how spots are displayed. The stuff in the top bar is pretty self-
explanatory. The SH/DX button, when mouse-clicked, sends that request to the
cluster (which you don’t know how to set up yet). The button labelled Wide toggles
filters in your radio, though you may have to set it up first (the process is
explained in the manual). In any case, clicking on it switches TO the filter mode
shown. The button labelled CQ will QSY the radio to your last CQ frequency, if
there is one on this band. The RIT, XIT and CW are clickable. Clicking on RIT will
turn RIT on and the label will turn red; ditto for XIT. The number between RIT and
XIT is the RIT/XIT offset. The CW indicates the radio’s mode; you can click on it to
change modes on the radio. The four buttons below those are user-programmable
buttons, typically used to control radio functions such as filters, noise blanker
settings, AGC settings and so on.

The color-coding of spots in the Bandmap is the same as in the Entry Window, so
each of those red calls represents a new multiplier in the contest. Spots that came
from a CW Skimmer on the Reverse Beacon Network are marked with a #. If a
spot was newly spotted within the last two minutes, the word “New” will appear
beside it. You can change the font size in the Bandmap window using the font
sizer up/down arrows at the top right of the bandmap.

If you want, you can mouse over a spot, and the program will tell you more about
it in a “tooltip” (unless tooltips have been disabled in the “Skins, Colors and Fonts”
window).

The information about the spot includes the frequency, who spotted it, how long ago the spot was posted, and spot comments
(the comments on this spot came from a CW Skimmer). The second line in the tooltip, telling you how closely you are tuned to
the spot, only appears if the radio is tuned to a frequency close to the spot.

In a busy contest, certain parts of the band can get pretty crowded with spots. Pressing the numeric keypad “+” key will zoom
the Bandmap in and spread the spots out, like this:
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Pressing the numeric keypad “-” key will have the opposite effect. You can also zoom the Bandmap using the up and down
arrow buttons in the lower right corner of the Bandmap window.

Another useful thing about the Bandmap: If you single-click on a spot, your radio will automatically be sent to that spot. If,
instead, you click on the frequency scale (anywhere within the width of the frequency hash marks), the radio will go to that
frequency. There are also keyboard shortcuts that will move your radio from spot to spot up and down the band. More on this
later.

When you single-click on a spot, something else useful happens – the call-sign of that station is copied to the Call-Frame of
the Entry window, like this. This is done this way so that if you discover that the station on that frequency isn’t ON5KQ after all,
you can just type in the correct call. This does happen now and then with packet spots.

However, let’s assume it’s correct. In that case, all you have to do is call the station, get him to answer you, and hit [space].
Here’s what happens – the call sign is pulled down into the Call-sign field, and the QSO is all set for logging, once you
complete the exchange.
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Another good thing can happen on the band-map when you complete a QSO and tune off the frequency – the spot’s color
code turns to grey, so that you know at a glance that you have worked the station already, and won’t waste time when you
come back to that frequency again.

To turn on this feature, click Config, and then, in the dropdown menu, click on the two items checked called “QSYing wipes the
call & Spots QSO in Bandmap (S&P)” and “Show Non-Workable Spots in Bandmap” (see below). You need them both
because grey spots are regarded as non-workable, and they will disappear unless Show non-workable spots is checked. If
you hear a station and type in his call sign, but you don’t work him and tune off his frequency, his call sign will appear in the
appropriate color to denote whether he’s a new multiplier or simply a valid QSO; either way you know to go back and work him
later, if he’s still there.
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By the way, even if you never plan to use packet spots, the Bandmap is a very useful window. As you S&P your way up and
down the band, each station you’ve worked will be marked with a grey self-spot, so you can skip by them the next time even if
you have no packet spots.

You may be wondering how to move quickly up and down the Bandmap, hitting only the workable spots, or those that
represent multipliers. This might be a good time to introduce another very useful section of the Manual. N1MM Logger+
makes extensive use of “hot-keys” to largely or entirely eliminate the use of the mouse during contest operations. There is a
very useful section in the manual titled Key Assignments (Keyboard Shortcuts) which explains each and every such key
combination. For example, under “Active Radio/Bandmap Key Assignments” it lists:

Jump to Spots Note: If you are operating single mode, your mode won’t change when jumping between spots.

Ctrl+Down Arrow – Get next spot higher in frequency.
Ctrl+Up Arrow – Get next spot lower in frequency.
Alt+Ctrl+Down Arrow – Get next spot higher in frequency that is a multiplier.
Alt+Ctrl+Up Arrow – Get next spot lower in frequency that is a multiplier

Try these and see – with a full Bandmap and these keystrokes, it is easy to work 100+ search and pounce QSOs per hour,
something that used to be regarded as impossible.

As we’re finishing up this introduction to the Bandmap, it might be a good idea to offer another general hint when you’re
exploring the program. Be sure to right-click on each new window (other than the Entry Window), to see what options involving
that window might be available to you. Each of these options is explained in the section of the manual dealing with that
window.

If you do this with the Bandmap, you’ll see this right-click menu:
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Of the choices here, Telnet Filters is perhaps the most useful. Click there and set the timeout interval in minutes – both self-
spots and spots from packet will disappear after however many minutes you choose. Note that you can also set the two
Config options mentioned above from this window as well.
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The Reset Radios command in the right-click menu is also useful in case you lose control of your radio for some reason. Click
it, and the program resets the connection.Check here for much more.

Logging Essentials

This listing pulls together a dozen (or so) keyboard commands that are essential in N1MM Logger. It was originally prepared
to help a club planning first-time use of the program on Field Day

General

Esc : stop, exit, abort, back out of whatever you are doing

Logging

Spacebar or Tab : move between exchange elements
Enter : log a completed valid QSO
Ctrl+Alt+Enter : log an incomplete/invalid QSO with a note in the log
Ctrl+N : add a note to the log
Ctrl+O : to enter the operator’s name or call sign (or type OPON in call sign field) – optional, use to keep track of who
was operating when
Alt+W : wipe whatever is entered so far (Alt+W again to undo the wipe)

Changing logged contacts

Ctrl+D : delete last QSO from log
Ctrl+Q : Quick Edit last QSO

while in Quick Edit (blue background), use Ctrl+Q to go to earlier QSO in log, or Ctrl+A to go to later one
Enter to accept changes, Esc to abort and return to logging

Changing current frequency & mode

To change modes, type CW or SSB or RTTY or PSK into Entry window, hit Enter – or, if your radio is interfaced for
radio control, just change modes on the radio
To change frequency, type the frequency in kHz into the Entry window, hit Enter – or, if your radio is interfaced for radio
control, change frequency on the radio

CW/SSB/Digital (needs CW keying interface/voice keyer/Digital interface respectively)
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Alt+U : switch between Run & S&P mode and messages
F1 : send CQ message and switch to Run mode
F4 : send your own call sign (S&P)
; key or Ins : send his call sign + exchange message (F5 + F2)
‘ key : send TU and log QSO (F3 + Enter)
= key : re-send last function-key message
Alt+K : edit current function-key message buttons
Ctrl+K : ad lib keyboard CW/digital text (use Enter or Esc or Ctrl+K to end)
PgUp/PgDn : CW speed up/down
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Finding Help
2019-03-29

Finding Help
The On-Line Manual
This WordPress-based manual is maintained in real-time by volunteer authors who make changes to this document as the
program changes. If you are reading the >N1MM Manual on the web, you are reading the absolute latest version of the N1MM
Logger+ manual. It may lag announced program changes by a few days, but hopefully not more than that.

Off-Line PDF Files
However, you may need to access the N1MM Logger+ manual from a location without Internet access; or you may prefer
using Adobe Reader to view and search the manuals.

There are two methods for local storage of the documentation in Adobe PDF format.

Automatically download the latest PDF file from within the program by selecting >Tools >Download Latest N1MM
Logger pdf manual. This method will automatically locate the file on the website and save the file to the SupportFiles
subfolder in your N1MM+ user files folder.
Manually download the latest PDF file from the website by selecting >Download >Documentation Download(PDF). With
this method, you may save the file to any location, but the recommended directory would be the SupportFiles subfolder
in the N1MM+ user files folder.

N1MM Logger Discussion Forum
You will find that the N1MM Forum is the most active and helpful resource for gettings answers to your questions about
N1MM+. Refer to the >Support >N1MM Forum section for registration and participation information.

In Case of Problems
When something goes wrong, it seems as if the first reaction of many users is to uninstall and reinstall the program. This is
almost never the recommended response. The vast majority of problems are due to either a corrupted settings file (n1mm
logger.ini) or a corrupted database file, and uninstalling and reinstalling will not fix either of these, unless you take the
additional drastic step of deleting your user file area. Usually you can achieve the same result just by deleting a single file (the
n1mm logger.ini file) without going through the hassle of uninstalling and reinstalling.

The first step to take in case of a problem that prevents you from using the program is to shut down the program, navigate to
the N1MM Logger+ user files folder, and rename the n1mm logger.ini file, for example by appending .sav to the end of the file
name. Restarting the program will cause it to start from scratch, as if this were a new installation, which means any errors that
had crept into the configuration file will be wiped out. If you have put a lot of effort into configuring the program, you might
want to try restarting from a known-good backup ini file. You can create such a backup yourself, but the program also creates
its own backups. Look here for information on how to use one of these automatic backup files.

If you start from a brand-new ini file, you will see a message giving you three options: Convert existing .mdb database (used
only for converting from N1MM Logger Classic to N1MM Logger+ – it’s highly unlikely that you will need to choose this option);
Create new N1MM Logger+ database; and Open Existing N1MM Logger+ database. If you have a known-good database file,
you can use the third option to open it, but the safest option is the second one (create a new database file). If creating a new
database file turns out to have been an unnecessary step, you can always use the File > Open Database… menu item to
return to your original database.

Opening the PDF Manual from within N1MM+
When you download the n1mmplus.pdf file to your SupportFiles subfolder – using either of the methods described
above – that file can now be easily opened from within the program by selecting >Help >N1MM Logger Manual.
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Sometimes the problem is caused by a corrupted database file. There may be an error message naming the offending file with
some cryptic additional information, such as “database disk image is malformed”. If so, close the program, navigate to the
Databases subfolder in the N1MM+ user files folder, find the offending file and rename it (by appending something to the file
name). Then restart the program. If the corrupted file was your log database, you will see a message giving you three options:
Convert existing .mdb database (used only for converting from N1MM Logger Classic to N1MM Logger+ – it’s highly unlikely
that you will need to choose this option); Create new N1MM Logger+ database; and Open Existing N1MM Logger+ database.
If you have multiple log databases and you know that one of them other than the one that caused the error message is good,
you can use the third option and choose the good database file, but in most cases, the second option will be the one you
want. You will need to give the new database a different file name from the one with the problem.

Often, renaming the ini file/restoring a backup and/or creating a new database/opening a known-good database will resolve
the problem. If it doesn’t (for example, if you have encountered a bug in the program – yes, they do exist – or if you need help
in using some feature of the program), then the N1MM+ Discussion Forum at groups.io is where to go for help.

Sometimes the program will issue a “Run-Time Error Message” with a long debug trail. If you see one of these, or if you
encounter a serious error that can’t be resolved by any of the techniques described above, then the development team
requests that you file a bug report on the web site. You will need to register a user name and password and log in to the web
site to do this.
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Software Setup
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Software Setup
Initial Installation
Downloading and installing the program is described in detail in the Getting Started section of this manual, at Downloading the
Software and Installing the Software. The purpose of this section of the manual is to document advanced methods for setting
up the program for multiple independent configurations. Users of basic single-user installations who do not need more than
one configuration will not need to use the methods described in this section, and should consult the Getting Started section
instead.

Comments on the Transition from N1MM Logger Classic

The file structure is changed in N1MM+ as compared with N1MM Logger Classic. The program itself is now installed under
C:\Program Files in 32-bit Windows systems, or C:\Program Files (x86) in 64-bit Windows systems, but none of the files it
writes to are stored there. All user files (databases, ini files, error logs, mc files, wav files, ADIF files, Cabrillo files, UDC files,
call history files, etc.) are stored in dedicated subfolders in a Logger+ user files area, which by default is installed inside your
personal Documents folder. The installer offers the capability to change either of these locations, but it is recommended that
you do not do so; just accept the defaults (exception: if your Documents folder is automatically backed up using OneDrive or a
similar system, you may need to install the user files area somewhere outside the reach of that backup system in order to
avoid corruption of database files).

Digital engine files (MMTTY, 2Tone, Fldigi) have not been rewritten, and still need to be stored outside the C:\Program Files
and C:\Program Files (x86) paths in Windows Vista, 7, 8, 10 and 11, just as they did with Logger Classic. One solution is to
leave them where they were with Logger Classic (e.g. under C:\Hamradio\MMTTY or C:\MMTTY or …); a second solution is
to create a new folder inside your N1MM Logger+ user files folder for digital engines. Either way works.

Your existing message files from N1MM Logger Classic will work. A partial exception is SSB message files, where the default
location for wav files has changed; you can either keep the old mc files and bury your wav files one level deeper in the wav
folder (i.e. create a wav subfolder within the wav folder that was created during the install, and put any operator-specific
folders within that second-level wav folder), or you can remove the leading wav\ from filenames in the old mc file. Either way
works.

Call history files and UDC (User Defined Contest) files should also transfer over without a problem. However, the Logger’s ini
file(s) will not transfer (you will have to redo your hardware configuration), and we recommend that you go with the Telnet
cluster list supplied with N1MM+. It has recently been augmented and revalidated.

Multiple Call Signs

If you use the Logger with more than one call sign, you should set up a separate database for each call sign. This includes call
signs that have a modifier prefix or suffix (like W1ABC/3, or ZL/G4ABC), as well as club call signs, call signs of guest
operators who use their own call sign during a contest, or the call sign of a multi-operator station where your computer is
used. In each database, make sure that the call sign in the Call box in the Station Information dialog window (from the Config
> Change your Station Data… menu item) is the actual call sign used when that database is open. The call sign from this
dialog window is what is sent using the {MYCALL} and * macros, and it is also the sent call sign that appears in every QSO:

Do not try to install multiple copies of the program

There should never be more than one copy of the program installed in a single operating system. The program and
its installer use Windows Registry entries that only allow for one copy of the program. There are mechanisms to
support multiple call signs, multiple hardware configurations, and even multiple Windows user accounts from a single
program installation. See the sections below for information on these.
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line in the Cabrillo file. For log-checking purposes, this needs to be the call sign that was sent over the air, not the operator’s
call sign (to change the operator’s call sign in the log, use the OPON command or Ctrl+O ; to change it in the Cabrillo file,
change the contents of the Operators box in the Contest Setup window for that contest).

If you already use more than one database with the same call sign, you should take note that when you create a new
database (from the File > New Database… menu item), the station information is carried over from the database that was
open at the time you created the new database. Therefore if you want to create multiple databases with one of your alternate
call signs, you should first switch to an existing database that uses that call sign before creating the new database, in order to
avoid having to re-enter the station information in the new database.

If the only thing that changes between databases is the call sign and related information in the Station Information dialog,
using separate databases is all you need to do. If you also change hardware configurations for different call signs, you might
want to use the Multiple ini Files capability described in the next section.

 The use of call signs in ADIF, Cabrillo and N1MM Logger+
There are as many as three different ways call signs are used: as station identification on the air, as identification of
the operator, and to identify the station owner. The first two of these are used by N1MM Logger+ and appear in
different places in the Cabrillo file. The third one normally does not appear in Cabrillo files, although there is a way to
add it to the OPERATORS: line in the header. All three can appear in ADIF files, but the Logger only exports the first
two to ADIF.

The most important one is the station call sign, i.e. the call sign that the station identifies with over the air. This is the
STATION_CALLSIGN field in ADIF. It is the call sign that appears as the sent call sign in every QSO: line in the
Cabrillo file, as well as in the CALLSIGN: line in the Cabrillo header. In N1MM Logger+, this is the call sign that is
entered in the top (Call) box in the Station Information dialog (Config > Change Your Station Data…). It is the call
sign that is sent when you use the {MYCALL} or * macro in function key messages. It is only stored in one place in a
database, because it is supposed to be the same for every QSO in that database. It does not change between
contests in a database.

If you use more than one station call sign (e.g. your own and a club or secondary call sign), you should use separate
databases, one for each station call sign that is used on the air as station identification. You can create new
databases using the File > New Database… menu item, and set up the station call sign and other station-related
data in the Station Information dialog at the time you create each database.

Note, by the way, that the file name of the database is immaterial. The file name is only the name that Windows uses
to find the file. It has no effect on the contents of the file, nor on the Cabrillo and ADIF files that you export. The file
name does not have to be a call sign. You can use a call sign as the file name if you want, in order to make it easy
for you to remember what the database is used for, but that is entirely optional.

The OPERATOR field in ADIF files is the call sign of the operator who operated the station during that QSO. It is
most often used in multi-ops, but it can also be used when a single op uses a club call sign or secondary call sign. In
N1MM Logger+ it is stored separately with every QSO in the database, to allow for changing operators in multi-ops. It
can be changed using the OPON command, Ctrl+O, or the Config > Change Operator Callsign Stored in Log
menu item.

If you never change the operator call sign in the Logger, it will be the same as the station call sign, and you don’t
need to think about it. However, if you ever use one of these methods to change the operator’s call sign, it will be
remembered from then on for subsequent QSOs, even from one contest to the next. If you use a station call sign at a
multi-op and have the operators enter their individual operator call signs whenever the operator changes, then for the
next contest using that same database the Operator field in all your QSOs will still be the call sign of the last person
who operated during the multi-op, unless you change it at the end of the multi-op or at the beginning of the new
contest.

The operator field in the log is not output to Cabrillo, except perhaps in the OPERATORS: line in the header. After a
contest, if you want to you can use the Update Ops from Log button in the Contest Setup dialog to collect all of the
operator call signs that are stored with QSOs in that log and place them in the Operators box, or you can just type
them into the box by hand.

The third call sign that appears in some ADIF files is the station owner’s call sign (OWNER_CALLSIGN). This is only
rarely used, either by a guest operator at another station using their own callsign as the station callsign and wanting
to identify the host station, or from a club station, or in situations where a club call sign is used as the station call sign
and the operation takes place at one of the members’ stations. N1MM Logger+ does not export this field to ADIF, but
some general-purpose logging programs do. The owner’s call sign can be added to a Cabrillo file in the
OPERATORS: line in the header by placing the @ character in front of the owner’s call sign as one of the operators.

For example, if VE3KI were to operate using the VA3RAC club call sign from VE3FU’s home station, he would use a
database with VA3RAC as the station call sign. Before the contest he would use Ctrl+O to enter VE3KI as the
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Multiple INI Files

Previous users of N1MM Logger Classic may be familiar with a capability to start the program with alternative .ini files, for
example for different configurations for different radios, different modes, etc. A similar capability exists in Logger+. You can
use alternative .ini files for different screen layouts and skins, different hardware, or even as an alternative method for calling
up different databases in place of using the File > Open database… menu item.

The following instructions assume you did a standard install, with the program files stored in C:\Program Files (x86)\N1MM
Logger+\, and the modifiable (user) files in Documents\N1MM Logger+\. Step-by-step instructions follow for making two new
shortcuts called Radio1 and Radio2 (you can, of course, call them something else), using new ini files called Radio1.ini and
Radio2.ini . If you want only one new shortcut, or three, the process is the same with the obvious changes to accommodate
the number you want.

First, in File Explorer navigate to your C:\Program Files (x86)\ folder. If yours is a 32-bit system, and there is no C:\Program
Files (x86)\ folder, then go to C:\Program Files\ instead. Either way, inside that folder find the N1MM Logger+ subfolder and
open it. Find the file called N1MM Logger.net.exe, right-click on it and select “Create shortcut” from the pop-up menu. In
Windows versions after XP, a small window will open up that says “Windows can’t create a shortcut here. Do you want the
shortcut to be placed on the desktop instead?”. Click on Yes – the desktop is where you want the shortcut anyway. That will
create a new shortcut on your desktop called N1MMLogger.net.exe – Shortcut. Right-click on this shortcut and select
“Rename” from the pop-up menu. Change the name to Radio1 (or whatever you want to call this shortcut).

For a second desktop shortcut, repeat the entire process in the previous paragraph, except when you rename the second new
shortcut, call it Radio2 (or whatever you want to call it, as long as it’s not the same as the first one or any other shortcut on
your desktop).

Next, in File Explorer navigate to your Documents\N1MM Logger+\ folder where your user files are kept (Note: if there is
more than one N1MM Logger+ folder in your system or if the user files area has been moved at any time, the one you want is
the one pointed to by the Help > Open Explorer on User Files Directory menu item). Find the file called N1MM Logger.ini,
right-click on it and select “Copy” from the pop-up menu. Right-click somewhere else in the File Explorer window (the part
where all the files and folders are displayed) and select “Paste” from the pop-up menu. This should create a new file called
N1MM Logger – Copy.ini (or possibly N1MM Logger – Copy (1).ini if there is already another file with the first name). Right-
click on this file and select “Rename” from the pop-up menu. Change the name to Radio1.ini (or whatever you want to call it).

Again, for a second shortcut you would repeat the entire process in the previous paragraph, and name the second new file
Radio2.ini (or whatever you want to call it).

Now, back on the desktop, right-click on the Radio1 shortcut and select “Properties” from the pop-up menu. A dialog window
should open with the shortcut properties pane visible, and the name of the program in the Target: box highlighted in blue. It
should look something like this:

operator’s call sign. He would enter VE3KI @VE3FU in the Operators field in the contest setup dialog in order to
output that information to the OPERATORS: line in the Cabrillo file. The Cabrillo header would contain the line
CALLSIGN: VA3RAC, and every QSO: line in the Cabrillo file would have VA3RAC as the sent call sign. The ADIF
file exported by the Logger would contain the fields < STATION_CALLSIGN:6 > VA3RAC and < OPERATOR:5 >
VE3KI in every QSO record, but the owner’s call sign (VE3FU) would not appear in the ADIF file.
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In that Target box, move the mouse cursor just to the right of the rightmost “, but still inside the text box, and left-click. That
should turn the blue highlighting off and leave the mouse cursor just to the right of the ” (you can use the right arrow key to
move the cursor there if you didn’t quite get it where you want it). Type a single space, then Ini=Radio1.ini . If the name you
chose for the ini file had a space in it, then surround either the file name alone or the whole argument in quotation marks, e.g.
Ini=”Radio 1.ini” or “Ini=Radio 1.ini”. Do not leave any spaces immediately before or after the = sign. Click on OK. The
screen shot below shows an example where the desktop shortcut is called IC-7800 and the ini file is called IC-7800.ini .
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Once more, for a second shortcut you would repeat the process in the previous paragraph with the Radio2 shortcut except
now the argument should read Ini=Radio2.ini (or whatever you called it).

When you start the program using the Radio1 shortcut the first time, the configuration will be the same as it was before, but
now you can make changes (different radio, different COM ports, etc.) that will only apply to the Radio1 shortcut. Ditto for
Radio2. Note that although the configurations can be different, both configurations can still point to the same database or to
different databases – that’s your choice. You can change databases from the File > Open Database… menu item, but that
only changes the remembered database for the current desktop shortcut and ini file, not for the other one(s). If both
configurations point to the same database, then any new contests or new QSOs you add to the database from one desktop
shortcut will also be there with the other one, since they are using the same database. When you first start the program from a
shortcut, the contest log that was last used from that shortcut will be the one that is opened, regardless of whether or not other
contest logs in the same database had been created and/or opened from another shortcut.

Multiple Users on a Single Computer

N1MM Logger+ stores the station call sign and some related data in the same database file where the QSOs are stored. If you
are happy with an overall configuration but want to use multiple station call signs (e.g. a club callsign or a special event
callsign instead of your own), you can simply create a different database for each call sign, and you can probably skip the rest
of this section.
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On the other hand, if you want completely different user file environments for different setups, you might want to set up
separate user file areas for each configuration. Or, if you install N1MM Logger+ on a computer that is used by different users
and you want a means to protect each user’s files from the other users, you may want to learn how to set up N1MM Logger+
for multiple different configurations on the same computer under different user accounts.

First, you need to decide whether you will restrict the changes from one configuration to another to those that are controlled
from the N1MM Logger.ini file (in a nutshell, hardware configuration items that are set up in the Configurer, window layouts,
and the initial choice of which database and contest log the program starts up in), or whether you want more extensive
differences between configurations. For most users, the former capability, which existed in N1MM Logger Classic, will be
enough. This capability is described in the previous section, on Multiple ini files.

In the most complex setups, you may wish to set the program up for different users who will be using different Windows user
accounts, or for different user file environments for different program and hardware configurations. If only one Windows user
account is used, either by multiple users or by a single user using different program configurations, you can create multiple
N1MM Logger+ user files folders within the same parent folder. If multiple Windows user accounts are involved, each user can
have their own independent Logger+ user files area stored in their own personal Documents folder. In this scenario, each
Logger+ user file area will only be accessible to that particular user. In either case, any changes that are made in one Logger+
user file area will not be reflected in other user file areas. This includes everything from hardware configuration changes to
logging of individual QSOs. If you want to use multiple Windows user accounts but allow all users to share a single Logger+
user file area, for example in order to log QSOs to a single shared contest log, there is also a way to do this. You can place
the Logger+ user file area in the Windows Public Documents folder instead of in an individual user’s Documents folder, so that
all user accounts on that computer will have access to that user file area and can share the data in it, and then create desktop
icons that can be used to direct the program to use the Public user files area instead of the one in their own Documents folder.
Note that if there is more than one user files area in your system, the one the program is currently using will be the one that is
pointed to by the Help > Open Explorer on User Files Directory menu item.

Regardless of how many user accounts you may run the program from, the program itself is only installed once. The
installation is a normal one. The program installation, both for the initial install and for subsequent updates, should be done
from a user account that has administrative privileges on that computer.

The program files will be installed to the program files area (normally C:\Program Files\N1MM Logger+ on a 32-bit system,
or C:\Program Files(x86)\N1MM Logger+ on a 64-bit system). The Logger’s user file area will usually be the file area you
want to use with the first or main configuration, and by default this is normally located in your Documents folder. In Windows
7 or 8 this would be C:\Users\[username]\Documents\N1MM Logger+ where [username] is the user name you log into
Windows with. In Windows XP SP3, the corresponding location would be C:\Documents and Settings\[username]\My
Documents\N1MM Logger+. In computers where OneDrive is, has been or is likely to be active, the original installation of the
user files area might have been to a different location, such as C:\HamRadio\N1MM Logger.

Now, for the second configuration, create a new folder in a location that the user of the second configuration will have access
to. If that user is you, you might simply create another folder in your Documents folder and give it a name that reflects the
new configuration. If that user is someone else who is using a different user name to log in to Windows on your computer, it
might be a new folder in that user’s personal Documents folder, either called N1MM Logger+ (so it will be called up from the
default desktop or Start Menu icon) or named otherwise for use with a customized desktop icon.

Now you need a way to tell N1MM Logger+ which user file area to use. The original N1MM Logger+ desktop icon created
during program installation will start the program using the configuration and database files in the original user files area when
the program is run from the account that was used to install the Logger, or from the assumed default location in the local
Documents folder when it is run from a different account. If you want to use a customized file area, you need a way to tell the
program to use the new user files area you just created instead of the default.

While logged into the Windows account from which the program will be used, use Windows File Explorer to find the
N1MMLogger.net.exe file in the N1MM Logger+ program folder, right-click on the file in Windows Explorer and select “Copy”,
then right-click on an empty area of the desktop and select “Paste Shortcut”. This should create a new shortcut on that user’s
desktop.

Rename the new shortcut to differentiate it from the original short cut. To do this, right-click on the new shortcut, select
Rename, and type the new name reflecting the new configuration you will use it with into the space just below the icon.

Now right-click on the icon once more, and select Properties from the pop-up menu. You should see a dialog that looks
something like this:
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Mouse-click to the right of the highlighted program name in the Target text box, type one space, then the keyword UserDir=
and the full pathname to the new folder between quotation marks, e.g. either UserDir=”C:\Users\[username]\Documents\
[new folder name]” or “UserDir=C:\Users\[username]\Documents\[new folder name]” (Windows 7 or 8 – in Windows XP
SP3, this would be “UserDir=C:\Documents and Settings\[username]\My Documents\[new folder name]”). There must
be no spaces between the UserDir and the =, or between the = and the folder name. In the screen shot below, I have copied
that same pathname (without the UserDir= keyword) into the “Start in” text box; the Target text box is not wide enough to show
its entire contents:
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Click on OK to exit the Properties dialog. The new shortcut will now start the program up using the user files from the new
folder instead of from the original N1MM Logger+ user files area. The first time it is run, if the new user files area is empty the
program will create a new set of user files from scratch, just as it did in the original installation. Open the program from the
new shortcut, enter any changes in call sign and related data into the Station Information dialog (Config > Change Your
Station Data), use the File > New Database menu item to create a new database in the new Databases folder to hold contest
logs using the new configuration, and proceed to the Configurer to do the hardware setup. You can copy other user files
(function key message files, call history files, etc.) from the original user file area to the corresponding places in the new user
file area to save time in setting them up.

From this point on, you can use the original N1MM Logger+ desktop icon to call up the program using the first configuration,
and the new desktop icon to call up the program using the second configuration. In effect, you now have two virtual copies of
the program. You can run either virtual copy, but only one at a time – you can’t have two copies running simultaneously in the
same computer.

You can configure each of these virtual program copies independently; any new contest logs you create in one copy will not
be visible to the other copy, and any changes you make to the configuration, databases, window locations and layout, skins,
and so on in one copy will not have any effect on the other copy. Because of this, if you add new hardware that requires you to
make changes in the Configurer, you will have to make those changes in both places. If you want to share user data, such as
function key messages or call history files, you can make changes in one place and copy the changed files into the
corresponding location(s) in the other user file area.

Note that if you have two configurations that are used from different Windows accounts, users in one Windows account will
have no access to the files in the user areas under other Windows accounts. If you would like the ability to easily share files
among users by copying them back and forth between different N1MM Logger+ user file areas, you might want to consider
placing the user file areas in the Windows Public Documents folder. All users on the computer can have direct (no password)
access to this folder (on some systems, public folder sharing may need to be enabled from the Control Panel to make this
possible). By creating customized program icons on each account’s own desktop, you can set things up so that users in
multiple accounts can run the program using the same shared user file area. Of course, for security reasons this might be the
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exact opposite of what you want, i.e. you might want to isolate user file areas from one another so users cannot inadvertently
or maliciously change each other’s user files. In that case, one way to copy files between users would be to use the Public
Documents folder as a file transfer location, while keeping the actual user files areas hidden from each other under different
Windows user accounts.
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The Configurer
2019-04-13

The Configurer
Hardware Tab
The Configurer is our name for the tabbed dialog that appears when you click Config on the Entry Window top menu, and then
choose Configure Ports, Mode Control, Audio, Other. The Configurer has many tabs with program settings influencing all
aspects of the behavior of the program. Be careful in setting up items on the different tabs, to be sure that you understand that
the option you are choosing is what you want.

Configurer settings are remembered by the program in the N1MM Logger.ini file, which is in the N1MM Logger+ user files
area. Function key definitions, telnet clusters, call history, and country information are not saved in the .ini file, but in the
database that was in use when you loaded them. That means, for example, that function key definitions loaded or modified
when you are using one database will only appear in that database. You will need to export them from that database and load
them into another database before they would show up there. The N1MM Logger.ini file contains the name of the database
file you were last using, which the program will load when it is started, as well as the name of the current contest and other
recently-opened contests.

If you have not unchecked “Hide extensions for known file types” in Windows Explorer Options, you will not see N1MM
Logger.ini. You will see “N1MM Logger” with a Type of “Configuration Settings”.
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The Configurer – Hardware Tab

The Hardware tab is used to set up your radios, packet interfaces, telnet connections, CW/PTT/digital ports and the interfaces
to other devices, such as SO2R controllers, multi-purpose interfaces, and keyers, if they require serial or parallel ports. Set the
values appropriate to your station. If you do not have one of the items listed connected to a port, make sure the port selection
is ‘None’ and the check boxes are not checked for that port.

Hardware setup options

The program supports up to 8 serial ports, each of which can be anywhere in the range COM1-COM99, and 3 parallel ports
(LPT1 – LPT3).
Set up each port depending on what equipment is connected and enter the appropriate information.

A more detailed explanation of each of the controls on this window follows.

Port – for each device that is to be connected via a COM port, the COM port number is selected in this column from a
pull-down list:
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This example screen shot shows a case in which three COM ports are being used. COM6 is used for radio control of an
Elecraft K3. COM2 is being used for a Winkeyer for CW keying. COM10 is connected to a TNC or terminal unit for RTTY. The
radio has two receivers and the program is configured for SO2V (Single Operator, 2 VFOs) with two Entry windows, one for
each VFO/receiver.

This list displays all of the COM ports the program was able to open. In this example, COM1, COM2, COM5 and
COM10 were found by the program when the Configurer window was opened. These ports might include real serial
ports, USB-to-serial adapters, and/or virtual serial ports created by software drivers (e.g. microHam Router, LP-Bridge,
etc.)
COM6 also appears on the example list above, but with an asterisk beside it. The asterisk indicates that this port was
previously configured at this position in the N1MM Logger.ini file, but when the Configurer was opened, the program
was unable to open the port. This could be the result of a USB-to-serial adapter being unplugged, or as the result of
other software that had previously created a virtual serial port but that was not running at the time the Configurer was
opened

If this asterisked device is left configured for COM6, after exiting the Configurer the program will issue a warning
that it was unable to open the port. The function that should be provided by this port will be unavailable. This can
be corrected by connecting the USB adapter or creating the software virtual port in the other software, then
reopening and closing the Configurer
If a different COM port is selected from the list, the missing COM port denoted by the asterisk will disappear from
the pull-down list

One of the options in the list of ports is TCP. This is used for radios that support radio control via TCP (Ethernet) – to
use this you will need an Ethernet cable from the radio’s LAN port to your router (or an Ethernet switch or Wifi access
point that connects to your LAN). If TCP is selected, enter the IP address and TCP port used by the radio in the box in
the IP Addr:Port column. Consult your radio’s documentation to find out how to determine the IP address and port
number

Radio – The pull-down list in the box in this column can be used to select a radio that is to be interfaced with the
program using this port for radio control, i.e. control of the radio’s frequency and mode. A maximum of two radios can
be connected. Select ‘None’ if this port is not being used for radio control. If you have only one radio connected,
only one of the boxes in this column should be configured to anything other than “None”
Digital – Checking this box means this port is used for digital communication (MMTTY/MMVARI/Fldigi engine or TNC).
This box cannot be checked if this port is used for radio control. Conversely, if this box is checked the pull-down list in
the Radio column is disabled. Not all ports used for digital communication are configured here; check this box only if
one of the following conditions is met:

Use this to indicate a port that is used for a TU or TNC for RTTY
Use it to indicate a port that is used for PTT from MMVARI in digital modes. This is not necessary with the
external digital engines (MMTTY, 2Tone and Fldigi), only with MMVARI
Use it to indicate a port that will be time-shared between digital and non-digital modes. This could be, for
example, a port that is used for serial port CW keying when the operating mode is CW, and for FSK and/or PTT
keying when the operating mode is RTTY. The CW/Other box will also be checked for such a time-shared port

If the only time the port is used is in digital modes from MMTTY, 2Tone or Fldigi, it is not necessary to
check this check box; simply configure the port directly within the digital engine without setting it up in the
Configurer
If you control PTT from the radio control port or from a Winkeyer, do not check the Digital box for that port
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If you are using a port for FSK keying with MMTTY or MMVARI via the EXTFSK or EXTFSK64 add-in, the
port cannot be time-shared, and therefore you would not check the Digital box for this port

CW/Other – Check this box if this port is used for hardware-keyed CW or PTT, a Winkeyer, a footswitch, a DVK or an
SO2R controller. You do not need to check this box to enable PTT via radio control commands; this is done using a
check box in the port setup dialog instead. The CW/Other selection may be made in combination with a Radio or Digital
selection provided the uses are compatible (e.g. keying CW on the DTR control line can be compatible with radio
control on the same port if your hardware interface supports it). In addition to the serial ports, the CW/Other box can
also be selected for one or more parallel ports (LPT1/2/3) to be used for CW or PTT keying or for other types of device
control

Details – Click on the Set button in this column to open a window with a set of controls that depends on what is
selected in the preceding columns (Radio, Digital, Packet, CW/Other). To the right of the details column is a summary
of the detailed settings. See below for details.
IP Addr:Port – This is only used for radios using TCP instead of a serial port for radio control, or being controlled via a
TCP-to-serial adapter. Enter TCP for the port number in the Port column, and enter the radio’s IP address and TCP
port number in the box in the IP Addr:Port column.

The radio buttons in the upper right are used to fit the program to your desired mode of operation.

SO1V – Single Operator 1 VFO
This mode is used with a single Entry window, and is the normal operating mode for a single-receiver radio. In
SO1V mode, the backslash, Pause, Ctrl+Right-arrow, grave accent(`) and Ctrl+Alt+K keys are disabled to
prevent opening the second Entry window. If the second Entry window and/or Bandmap window were open
when the Configurer was opened, they will be closed when exiting the Configurer after selecting SO1V

SO2V – Single Operator 2 VFO (one radio, using both VFOs)
Permits using two separate Entry windows, one for each VFO; the full SO2V functionality is usable only with
radios that have dual receivers

SO2R – Single Operator 2 Radios
Permits using two separate Entry windows, one for each radio

Set Button Examples

Some examples of the dialog box that appears when you click on the Set button are given here.

Configuring a Port for a Winkeyer
To configure a port for a Winkeyer, first select the port used by the Winkeyer in the left-most column of the Hardware
tab. Then check the CW/Other box in that same row. finally, click the Set button and check the Winkeyer box in the
dialog that appears. Apart from possibly the Radio Nr box, you do not need to change anything else in this dialog; the
defaults are designed to work with a Winkeyer.



Use ONLY ONE method of PTT or CW keying
Note that having multiple ports configured for CW or PTT can cause problems; for example, having two methods of
PTT control operating at the same time can result in the radio failing to switch to transmit, or worse, locking up in
transmit at the end of a function key message. This is particularly a problem with some radios when one of the
methods is PTT via radio command and the other method is a hardware keying method. Pick one method of CW
keying and one method of PTT control, check the CW/Other box for the port or ports you need for them and
complete the port configuration using the Set button, and make sure CW/Other is not checked for ports that you are
not currently using. Note that the PTT output from a Winkeyer is active in SSB and RTTY as well as in CW, i.e. if you
are using this output from the Winkeyer, you do not need a separate method for PTT for SSB or RTTY. For digital
modes, do not configure PTT control from the digital engine (MMTTY or Fldigi) if you have PTT control operating
from the main N1MM Logger program.
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Radio Control Port

For a port selected for radio control:

Speed – The speed of the serial port (check the manual of your radio)
Parity – The parity used (check the manual of your radio)
Data Bits – The number of data bits used (check the manual of your radio)
Stop Bits – The number of stop bits used (check the manual of your radio)
DTR – The following selections can be made for DTR (pin 4 on DB9 connector):

PTT – used for keying the radio
CW – used for sending CW to the radio

Note: The PTT and CW selections require either a keying circuit between DTR and the radio’s PTT input
or CW key jack, or a transceiver that can accept direct switching on the DTR line on its radio control port
(such as an Elecraft K3). The CW/Other check box for this port in the main Configurer window must be
checked to enable PTT or CW switching via DTR

Always on – DTR is always ‘high’
Always off – DTR is always ‘low’
Handshake – DTR is used for handshaking

RTS – The same selections as for DTR can be made for RTS (pin 7 on DB9 connector):
PTT – used for keying the radio
CW – used for sending CW to the radio

Note: The PTT and CW selections require either a keying circuit between RTS and the radio’s PTT input
or CW key jack, or a transceiver that can accept direct switching on the RTS line on its radio control port
(such as an Elecraft K3). The CW/Other check box for this port in the main Configurer window must be
checked to enable PTT or CW switching via RTS

Always on – RTS is always ‘high’
Always off – RTS is always ‘low’
Handshake – RTS is used for handshaking

When both RTS and DTR are set to PTT they will both be keyed for PTT with the set PTT delay
When using a self-powered interface for radio control, set DTR and/or RTS to Always On to supply power
to the interface

Icom Addr (hex) – The hex address for the radio. Enter without the “H” i.e. 26 not 26H. This field is only shown when
an Icom is the selected radio
Radio Nr – The radio controlled from this port:

In SO1V (one radio, one VFO used) Radio Nr = 1
In SO2V (one radio, two VFOs) Radio Nr = 1
In SO2R select the radio (1 or 2) that will be controlled from this port

PTT Delay (msec) – This box only appears if DTR or RTS is set to PTT. It is used to configure a delay between the
time the PTT signal is switched and CW sending starts, in order to prevent hot-switching
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Enable Both Hardware & Software PTT – This check box allows both hardware and software PTT control methods to
be used. USE WITH CAUTION. With some radios, using software and hardware PTT control at the same time can lead
to problems such as the radio hanging up in transmit at the end of CW or RTTY messages
Allow ext. interrupts – Allow external interrupts from this port (DSR – pin 6), e.g. from a footswitch. An interrupt on this
line will bring focus to the Entry window and stop a CQ in progress. See FootSwitch settings below
PTT via Radio Command Digital Mode – If this check box is checked, a software radio command will be used to
control PTT in digital modes
PTT via Radio Command SSB Mode – If this check box is checked, a software radio command will be used to control
PTT in SSB modes
PTT via Radio Command CW Mode – If this check box is checked, a software radio command will be used to control
PTT in CW mode

By using these check boxes selectively, you can choose to control PTT in some modes and not others (e.g.
controlling PTT in digital modes for FSK RTTY while using VOX for SSB and QSK for CW)

FootSwitch – It is possible to connect a separate footswitch to each serial or parallel port. A pull-up resistor is needed
(see the Interfacing section of the manual for detailed instructions). Multiple footswitches (one per serial or parallel port)
can be used with different settings for each footswitch.
If the interface allows it to be broken out separately, the DSR input (pin 6 on a 9-pin serial port) can be used for one of
the following options. The external interrupts box on the radio control port should NOT be checked for most
applications. It causes additional code to be executed that may affect the radio control operation. For all footswitch
options except “First One Wins”, the DSR input should be low (0V or negative) when the footswitch is not pressed and
pulled high (greater than 3V) when the footswitch is pressed. The footswitch operates on the “active” radio. The
RadioNr box selection is not used (ignored) for the footswitch.

None – No footswitch on this serial port
ESM Enter – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as
pressing Enter key in ESM mode
Typing Focus – Pressing Footswitch (DSR input transitions from a low to a high) will switch typing focus
Switch Radios – Pressing Footswitch (DSR input transitions from a low to a high) will switch the radios (in
SO2R)
Normal – Pressing the footswitch (DSR input transitions from a low to a high) will behave if it was connected to
the PTT of the active radio transmitter (radio with TX focus or red dot).
F1 – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as pressing
function key F1
F2 – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as pressing
function key F2
F3 – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as pressing
function key F3
F4 – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as pressing
function key F4
F11 – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as pressing
function key F11
F12 – Pressing Footswitch (DSR input transitions from a low to a high) will cause the same action as pressing
function key F12
Band lockout – Implemented mostly for multi user stations to block a second signal on the same band/mode. It
may be useful for single users as well. This mode should allow you to control PTT for both radios (in case of
SO2R) in different modes (SSB/CW). The advantage of using it (compared to a foot switch directly connected to
the radio) is that it stops AutoCQ and Dueling CQ’s. Multiple footswitches are supported but a Band Lockout and
a First One Wins footswitch can not be used on the same computer.
First One Wins – This selection is intended for multi stations that want to prevent other transmitters from
beginning a transmission. The computer needs to have network mode enabled. The DSR input is active when
low (0V or negative) and intended to be connected to an open collector PTT line of the partner station. Before
the station begins a transmission, the state of the DSR input is checked. If low (meaning that the partner station
is transmitting), the station will not transmit. Note that the DSR sense is the reverse of the footswitch
options above. Pull DSR high (greater than 3V) with a resistor and connect the DSR input to the active low
open-collector PTT of the partner station. If more than one station needs to be interlocked, add a GE diode in
series with the open collector PTT line creating a wire-OR circuit. Multiple footswitches are supported but a Band
Lockout and a First One Wins footswitch can not be used on the same computer.
Esc – This selection executes the Esc key press code when the DSR input transitions from a low to a high.

Radio Polling Rate – use this to change the rate at which the radio is polled – Normal, 50% Slower or 100% Slower.
The 50% Slower setting increases the time between polls to 1.5 times normal, and the 100% Slower setting increases
the time between polls to 2 times normal.
Help – used to display Help for the Configurer from the on-line manual
OK – save the settings and exit this dialog window
Cancel – exit this window without saving the settings
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CW/Other Serial Port

For a port whose CW/Other check box is checked:

DTR – The following selections can be made for DTR (pin 4 on DB9 connector):
PTT – used for keying the radio
CW – used for sending CW to the radio

Note: The PTT and CW selections require a keying circuit between DTR and the radio’s PTT input or CW
key jack. The CW/Other check box for this port in the main Configurer window must be checked to enable
PTT or CW switching via DTR

Always on – DTR is always ‘high’
Always off – DTR is always ‘low’
Handshake – DTR is used for handshaking

RTS – The same selections as for DTR can be made for RTS (pin 7 on DB9 connector):
PTT – used for keying the radio
CW – used for sending CW to the radio

Note: The PTT and CW selections require a keying circuit between RTS and the radio’s PTT input or CW
key jack. The CW/Other check box for this port in the main Configurer window must be checked to enable
PTT or CW switching via RTS

Always on – RTS is always ‘high’
Always off – RTS is always ‘low’
Handshake – RTS is used for handshaking

Radio Nr – The radio that this port is used with:
In SO1V (one radio, one VFO used) Radio Nr = 1
In SO2V (one radio, two VFOs) Radio Nr = 1
In SO2R select the radio (1 or 2) that this port is used with

PTT Delay (msec) – This box is used to configure a delay between the time the PTT signal is switched and CW
sending starts, in order to prevent hot-switching an amplifier, for example
Allow ext. interrupts – Allow external interrupts from this port (DSR – pin 6), e.g. from a footswitch. An interrupt on this
line will bring focus to the Entry window and stop a CQ in progress
Winkey – Select when using a Winkeyer. Speed, Parity, Data bits, Stop bits or Handshake settings do not have to be
adjusted; they are fixed and set by the program. Settings for the keyer are made on the Winkeyer tab in the
Configurer. If you select Winkeyer, DO NOT set DTR to CW.

Note: Only one Winkeyer is supported, but a single Winkeyer can key two radios
Two Radio Protocol – Support for an SO2R controller using a COM port. This provides USB-only SO2R control (no
LPT port required). Protocol used may be either the microHam proprietary protocol (MK2R) or OTRSP (Open Two
Radio Switching Protocol)

More info in the chapter on supported hardware
FootSwitch – It is possible to connect a separate footswitch to each serial or parallel port. A pull-up resistor is needed
(see the Interfacing section of the manual for instructions). Multiple footswitches (one per serial or parallel port) can be
used with different settings for each footswitch.
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Pin 6 on the serial port can be used for one of the following options (if external interrupts are enabled on this port). The
footswitch operates on the “active” radio. The RadioNr box selection is not used (ignored) for the footswitch.

None – No footswitch on this serial port
ESM Enter – Pressing Footswitch will cause the same action as pressing Enter key in ESM mode
Typing Focus – Pressing Footswitch will switch typing focus
Switch Radios – Pressing Footswitch will switch the radios (in SO2R)
Normal – Pressing the footswitch will behave if it was connected to the PTT of the active transmitter and is
automatically connected to the proper (active) radio.When the footswitch is released the focus will be set to main
Entry window
F1 – Pressing Footswitch will cause the same action as pressing function key F1
F2 – Pressing Footswitch will cause the same action as pressing function key F2
F3 – Pressing Footswitch will cause the same action as pressing function key F3
F4 – Pressing Footswitch will cause the same action as pressing function key F4
F11 – Pressing Footswitch will cause the same action as pressing function key F11
F12 – Pressing Footswitch will cause the same action as pressing function key F12
Band lockout – Implemented mostly for multi user stations to block a second signal on the same band/mode. It
may be useful for single users as well. This mode should allow you to control PTT for both radios (in case of
SO2R) in different modes (SSB/CW). The advantage of using it (compared to a foot switch directly connected to
the radio) is that it stops AutoCQ and Dueling CQ’s. Multiple footswitches are supported but a Band Lockout and
a First One Wins footswitch can not be used on the same computer
First One Wins – This mode is intended for multi stations that want to prevent other transmitters from beginning
a transmission. The COM port DSR input is active when low (0V or negative) and intended to be connected to
an open collector PTT line of the partner station. Note that the DSR sense is the reverse of the footswitch
options above. Pull DSR high (greater than 3V) with a resistor and connect the DSR input to the active low open-
collector PTT of the partner station. If more than one station needs to be interlocked, add a diode in series with
the open collector PTT line creating a wire-OR circuit. Before the station begins a transmission, the state of the
DSR input is checked. If low (the partner station is transmitting), the current station will not transmit. Multiple
footswitches are supported but a Band Lockout and a First One Wins footswitch can not be used on the same
computer.

Help – used to display Help for the Configurer from the on-line manual
OK – save the settings and exit this dialog window
Cancel – exit this window without saving the settings

Digital Serial Port

For a COM port for which the Digital check box has been checked, either in order to use a TNC or to time-share the port:

DTR – The following selections can be made for DTR (pin 4 on DB9 connector); if the port is time-shared, these
selections will only apply in non-digital modes:

PTT – used for keying the radio
CW – used for sending CW to the radio
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Note: The PTT and CW selections require a keying circuit between DTR and the radio’s PTT input or CW
key jack. The CW/Other check box for this port in the main Configurer window must be checked to enable
PTT or CW switching via DTR

Always on – DTR is always ‘high’
Always off – DTR is always ‘low’
Handshake – DTR is used for handshaking

RTS – The same selections as for DTR can be made for RTS (pin 7 on DB9 connector); if the port is time-shared,
these selections will only apply in non-digital modes

PTT – used for keying the radio
CW – used for sending CW to the radio

Note: The PTT and CW selections require a keying circuit between RTS and the radio’s PTT input or CW
key jack. The CW/Other check box for this port in the main Configurer window must be checked to enable
PTT or CW switching via RTS

Always on – RTS is always ‘high’
Always off – RTS is always ‘low’
Handshake – RTS is used for handshaking

Radio Nr – The radio this port is used with:
In SO1V (one radio, one VFO used) Radio Nr = 1
In SO2V (one radio, two VFOs) Radio Nr = 1
In SO2R select the radio (1 or 2) that this port is used with

Dig Wnd Nr – This MUST be set to indicate which Digital Interface window uses this port. If it is set to 0, the port will
not be used in digital modes

If only one DI window is used (e.g. SO1V), select 1
If two DI windows are used, select the DI window number this port will be used for

Allow ext. interrupts – Allow external interrupts from this port (DSR – pin 6), e.g. from a footswitch. An interrupt on this
line will bring focus to the Entry window and stop a CQ in progress; non-digital modes only
FootSwitch – It is possible to connect a separate footswitch to each serial or parallel port. A pull-up resistor is needed
(see the Interfacing section of the manual for instructions). Multiple footswitches (one per serial or parallel port) can be
used with different settings for each one.
Pin 6 on the serial port can be used for one of the following options (if the interface allows this line to be broken out and
external interrupts are enabled on this port). The footswitch operates on the “active” radio. The RadioNr box selection is
not used (ignored) for the footswitch.

None – No footswitch
ESM Enter – Pressing Footswitch will cause the same action as pressing Enter key in ESM mode
Typing Focus – Pressing Footswitch will switch typing focus
Switch Radios – Pressing Footswitch will switch the radios (in SO2R)
Normal – Pressing the footswitch will behave if it was connected to the PTT of the active transmitter and is
automatically connected to the proper (active) radio. When the footswitch is released the focus will be set to
main Entry window
F1 – Pressing Footswitch will cause the same action as pressing function key F1
F2 – Pressing Footswitch will cause the same action as pressing function key F2
F3 – Pressing Footswitch will cause the same action as pressing function key F3
F4 – Pressing Footswitch will cause the same action as pressing function key F4
F11 – Pressing Footswitch will cause the same action as pressing function key F11
F12 – Pressing Footswitch will cause the same action as pressing function key F12
Band lockout – Implemented mostly for multi user stations to block a second signal on the same band/mode. It
may be useful for single users as well. This mode should allow you to control PTT for both radios (in case of
SO2R) in different modes (SSB/CW). The advantage of using it (compared to a footswitch directly connected to
the radio) is that it stops AutoCQ and Dueling CQ’s. Multiple footswitches are supported but a Band Lockout and
a First One Wins footswitch can not be used on the same computer
First One Wins – This mode is intended for multi stations that want to prevent other transmitters from beginning
a transmission. The COM port DSR input is active when low (0V or negative) and intended to be connected to
an open collector PTT line of the partner station. Note that the DSR sense is the reverse of the footswitch
options above. Pull DSR high (greater than 3V) with a resistor and connect the DSR input to the active low open-
collector PTT of the partner station. If more than one station needs to be interlocked, add a diode in series with
the open collector PTT line creating a wire-OR circuit. Before the station begins a transmission, the state of the
DRS input is checked. If low (the partner station is transmitting), the current station will not transmit. Multiple
footswitches are supported but a Band Lockout and a First One Wins footswitch can not be used on the same
computer.

Help – used to display Help for the Configurer from the on-line manual
OK – save the settings and exit this dialog window
Cancel – exit this window without saving the settings
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Parallel (LPT) Port

For an LPT port:

Pin 17 – always used for CW keying; greyed out because it cannot be changed
Pin 16 – used for PTT, except when an external DVK is used; greyed out because it cannot be changed
Radio Nr – The radio that this port is used with:

In SO1V (one radio, one VFO used) Radio Nr = 1
In SO2V (one radio, two VFOs) Radio Nr = 1
In SO2R without an automatically controlled SO2R box, select the radio (1 or 2) that this port is used with

If using an LPT SO2R box, set the Radio Nr for the first LPT port to Both. Pin 14 will be used to select the
radio for CW, PTT, etc.
If using band data lines with this setup, band data for the first radio is routed to the first LPT port (Radio
Nr = Both) and band data for the second radio is routed to the second LPT port (Radio Nr = 2)

PTT Delay (msec) – This box is used to configure a delay between the time the PTT signal is switched and CW
sending starts, in order to prevent hot-switching an amplifier, for example
Allow ext. interrupts – Allow external interrupts from pin 15, e.g. from a footswitch. An interrupt on this line will bring
focus to the Entry window and stop a CQ in progress
DVK – DVK interface for MK2R, W9XT & other external DVKs. See this page for detailed information, pinouts, and
limitations

When DVK is selected, Antenna selection via the LPT port is disabled (the DVK pins and the antenna pins on
the LPT port overlap)
When using an external DVK, all of the Run and S&P SSB function keys should be set to empty.wav and not left
blank
microHAM MK2R: if DVK is checked, N1MM Logger will use the DVK in Router instead of its own DVK support

FootSwitch – It is possible to connect a separate footswitch to each serial or parallel port. A pull-up resistor is needed
between the footswitch input (pin 15 on the parallel port) and +5 VDC (see the Interfacing section of the manual for
instructions). Multiple footswitches (one per port) can be used with different settings for each one.
Pin 15 on the parallel port can be used for one of the following options. The footswitch operates on the “active” radio.
The RadioNr box selection is not used (ignored) for the footswitch.

None – No footswitch
ESM Enter – Pressing Footswitch will cause the same action as pressing Enter key in ESM mode
Typing Focus – Pressing Footswitch will switch typing focus

LPT Port Numbers with N1MM
SO2R and LPT CW, the LOWEST numbered port must have the CW output set to BOTH if it is used with a
conventional LPT SO2R box (DXD, KK1L, N6BV, etc.) or microHAM MK2R/MK2R+ in LPT (Classic auto control)
mode, The LPT with CW, PTT and the TX/RX/Split controls must be connected to the SO2R controller. If N1MM is
configured for CW on TWO LPT ports (first port: Radio=1, second port Radio=2) then CW will be present only on the
port representing the radio with transmit focus.
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Switch Radios – Pressing Footswitch will switch the radios (in SO2R)
Normal – Pressing the footswitch will behave if it was connected to the PTT of the active transmitter and is
automatically connected to the proper (active) radio.When the footswitch is released the focus will be set to main
Entry window
F1 – Pressing Footswitch will cause the same action as pressing function key F1
F2 – Pressing Footswitch will cause the same action as pressing function key F2
F3 – Pressing Footswitch will cause the same action as pressing function key F3
F4 – Pressing Footswitch will cause the same action as pressing function key F4
F11 – Pressing Footswitch will cause the same action as pressing function key F11
F12 – Pressing Footswitch will cause the same action as pressing function key F12
Band lockout – Implemented mostly for multi user stations to block a second signal on the same band/mode. It
may be useful for single users as well. This mode should allow you to control PTT for both radios (in case of
SO2R) in different modes (SSB/CW). The advantage of using it (compared to a footswitch directly connected to
the radio) is that it stops AutoCQ and Dueling CQ’s. Multiple footswitches are supported but a Band Lockout and
a First One Wins footswitch can not be used on the same computer
First One Wins – This mode is intended for multi stations that want to prevent other transmitters from beginning
a transmission. The input is active when low (0V or negative) and intended to be connected to an open collector
PTT line of the partner station. Note that the sense is the reverse of the footswitch options above. Pull pin 15
high (greater than 3V) with a resistor and connect the input to the active low open-collector PTT of the partner
station. If more than one station needs to be interlocked, add a diode in series with the open collector PTT line
creating a wire-OR circuit. Before the station begins a transmission, the state of the input is checked. If low (the
partner station is transmitting), the current station will not transmit. Multiple footswitches are supported but a
Band Lockout and a First One Wins footswitch can not be used on the same computer.

CW/PTT Port Addr – specify port address (Required!)
The initial default address in this box, if there is one, may not be correct in some computers or for some add-in
cards; if the port does not work, check the port’s properties in Device Manager to determine the correct address.
There is more information on this topic in the Interfacing chapter

Help – used to display Help for the Configurer from the on-line manual
OK – save the settings and exit this dialog window
Cancel – exit this window without saving the settings

Additional signals are also present on the parallel port. See the Interfacing chapter for more detailed info.

PTT Options

Originally, Push-to-Talk (PTT) was actually a copyrighted term, describing how operators of one company’s radios could press
a button on their microphones to switch from Receive to Transmit. Over the years, however, it has come to denote any form of
transmit/receive switching external to the radio. It could be as simple as a microphone button or a footswitch working directly
with the radio, or as sophisticated as control by a logging program.

N1MM Logger+ provides several options. As described above, you should pick only one of these options:

PTT via serial or parallel port – This option uses the RTS or DTR lines on a serial port or pin 16 on an LPT port. This
more-or-less standard method usually requires a simple one-transistor interface to switch the radio. USB-to-serial
adapters can be used for this function; ordinary USB-to parallel (printer) adapters will not work, because they lack the
ability to control individual lines in the parallel interface – the one exception is the SO2RXLAT interface developed by
PIEXX.
PTT via Winkeyer – If a Winkeyer, a keyer that emulates the Winkeyer, or an interface incorporating a Winkeyer chip is
used, its PTT output can be used in all modes to control transmit/receive switching.
PTT via radio command – For radios that support it, this option eliminates any need for external hardware other than a
serial port cable or a serial to USB converter. Check your radio manual for details.

Warning: At the moment, there is no provision for both controlling radio PTT via radio command and simultaneously
introducing a delay before the Logger begins to send a stored message, so if you need to protect external equipment
(see below) you should not use this option.

PTT Delay

This is an important aspect of PTT operation. Some amplifiers are slower than many radios, so if the radio begins to transmit
as soon as PTT is asserted, it may result in hot-switching of the amplifier’s internal transmit/receive relays, which can result in
damage. In addition, for VHF operation, preamplifiers located at the antenna may need to be properly sequenced to avoid
damage from transmitted RF.

In the case of PTT via serial or parallel port, this delay is set in the Configurer, on the Hardware tab, when configuring a
port for PTT. Note that for a serial port, you will only see this option if you have first selected PTT on either RTS or
DTR.
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For Winkeyer PTT, set this delay (called lead-time in Winkeyer parlance) on the Winkeyer tab of the Configurer. This
affects both hand-sent CW and stored messages. You will probably find that any value over 20 milliseconds (probably
enough for most amps) throws off your hand-sent keying.

Other Information

Under 32 and 64 bit bit Windows operating systems, using the parallel and serial ports for PTT and CW keying requires a
special dll called inpout32.dll. This dll is installed with the Logger, but if the file is not installed for some reason, information on
finding and installing it can be found in the Installation chapter.

Function Keys Tab

Function key operation is controlled from this tab.

Function Keys Field Descriptions

Send leading zeros in serial numbers – Serial numbers, which are sent either using the # macro or the {EXCH}
macro (if the Sent Exchange box in the Contest Setup contains 001), may be sent either with or without leading zeros
(e.g. 003 or just 3), depending on whether this option is checked or not. In CW, the “cut numbers” option can be used to
send the leading zeros as T or O instead of 0. The leading zeros option does not affect numbers other than serial
numbers
Send cut numbers – In CW this causes serial numbers to be sent using the Cut Number Style set at the bottom of the
dialog. Ctrl+G can be used to toggle this option while operating. The new status after toggling will be shown in the
status line at the bottom of the entry window. Numbers other than serial numbers will not be affected by this option. The
cut numbers option does not apply to SSB or digital modes
Send corrected call before end of QSO – If the callsign in the callsign box is changed (corrected) after answering a
call and sending your exchange but before the contact has been logged, then the corrected callsign (from the callsign
box) will be sent by the End of QSO Key (or any other action that triggers it, such as the ; key, or the Enter key in ESM)
before the End of QSO message, e.g. ‘PA1M TU DE N1MM’ instead of ‘TU DE N1MM’. If F3 is not pressed until after
the contact has already been logged, the corrected callsign will not be sent.
Send partial calls – CW only. When sending a corrected call using the previous option, only the corrected part will be
sent (prefix or suffix). If not checked the whole call will be sent.
AutoHotKey file – Type here the name of any AutoHotKey script(.ahk) file that you wish to have started and stopped
when N1MM Logger+ is started and stopped. To use this feature, AutoHotKey must be installed on your computer.
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Download it at this page.
AutoHotKey scripts are very useful for keyboard remapping. Examples can be found in the Third Party Software
section of the manual. If you put this file in the Support Files sub-folder of your N1MM Logger+ user files folder,
then you need only name the file itself; alternatively you can use the entire path to a script file anywhere on your
computer.

Use CW contest word spacing – This setting changes the spacing between words in your CW, where “N1MM 599 5”
is 3 words. Default is 6 bits for “contest spacing”. When box is not checked, 7 bits between words is used, which is
“normal spacing”
Stop sending CQ when callsign is changed – Typing a character in the callsign field will stop a (repeated) CQ
ESM sends your call once in S&P, then ready to copy received exchange – This is often called the “Big Gun / Little
Pistol switch” . When selected and in Enter Sends Message mode the cursor moves to the Exchange field when there
is something in the Callsign field and Enter is pressed (so it does not keep the cursor in the callsign field). If you don’t
usually get a station on the first call then deselect this option. Read more about Big Gun \ Little Pistol operation
under((ESM+-+Enter+Sends+Message|ESM)).
Work dupes when running – This determines what is sent when a dupe calls you and you press Enter in ESM.
Normally you DO want to work dupes, so this box would normally be checked. See the chapter Off topic for a
discussion
String to use on cw between his call key and exchange key (default is one space) – Just as it says. Example ‘ ur ‘
Keycode of Ins Key Substitute – Enter the number for the Ins Key substitute (to send the other station’s callsign plus
your exchange) as mapped below in this configurer dialog. Defaults to 186, the ; character. The program can
automatically enter the keycode in this field . Place the cursor in the keycode field and press the key you want to
substitute, it will put the correct keycode in. 186 is an extended key code. Not all keyboards map keys the same way.
Note that you can’t use a Shift, Ctrl, Alt etc. key. I would not advise using a key like Numeric + that is already in use. It
may or may not work. In this case Numeric +, does NOT work
Keycode of TU/Log Key Substitute – Enter the number for the TU/Log Key substitute (to combine sending the TU
key and logging the contact) as mapped below in this configurer dialog. Defaults to 222, the ‘ character. The program
can automatically enter the keycode in this field . Place the cursor in the keycode field and press the key you want to
substitute, it will put the correct keycode in. 222 is an extended key code. Not all keyboards map keys the same way.
Note that you can’t use a Shift, Ctrl, Alt etc. key. I would not advise using a key like Numeric + that is already in use. It
may or may not work. This particular case (Numeric +) does NOT work
Cut Number Style – the following cut number styles can be chosen:

T1234567890 (leading T) – leading 0 will be replaced with a T. So 007 will become TT7 and 030 will become
T30
O1234567890 (leading O) – leading 0 will be replaced with an O. So 007 will become OO7 and 030 will become
O30
T123456789T (all T) – all zeros will be replaced with a T. So 007 will become TT7 and 030 will become T3T
O123456789O (all O) – all zeros will be replaced with an O. So 007 will become OO7 and 030 will become O3O
T12345678NT (TN) – all zeros will be replaced with a T, all nines with an N. So 097 will become TN7 and 090
will become TNT
O12345678NO (ON) – all zeros will be replaced with an O, all nines with an N. So 097 will become ON7 and 090
will become ONO
TA2345678NT (TAN) – all zeros will be replaced with a T, all nines with an N, all ones with an A. So 091 will
become TNA and 190 will become ANT
TA234E678NT (TAEN) – all zeros will be replaced with a T, all nines with an N, all ones with an A, all fives with
an E. So 091 will become TNA and 1590 will become AENT
TAU34E67DNT – the zero, one, two, five, eight, nine will be replaced with a T, A, U, E, D, N respectively

Remapping Function Keys

Select which function keys to send messages. Each type of message has a combo box for you to set the appropriate function
key. If the program is sending the wrong message check here first. The only restriction is that a key must mean the same thing
in Running and in S&P. Function keys do not have to be unique for a selected message. There is little reason to do so
although if you want it can be done. For the following messages a function key can be selected

CQ Key – defaults to F1
Exchange Key – defaults to F2
End of QSO Key – defaults to F3
His Call Key – defaults to F5
My Call Key – defaults to F4
QSO B4 Key – defaults to F6 (can be disabled)
Again Key – defaults to F8 (can be disabled)
Next Call Key – defaults to Disabled
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ESM
mode

Work dupes
when
running

Mo
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QSO
B4
key

Agai
n
key

Action Result action

On don’t work
dupes

Ru
n

Disabl
ed F-key DUPE callsign entered Send AGN message when Enter pressed

On don’t work
dupes

Ru
n

Disabl
ed

Disa
bled DUPE callsign entered

Send the EXCH when Enter is pressed,
station will be worked and logged with Enter,
Enter

On don’t work
dupes

S&
P

Disabl
ed F-key DUPE callsign entered Pressing Enter does nothing, no blue buttons

in the Entry window

On don’t work
dupes

S&
P

Disabl
ed

Disa
bled DUPE callsign entered Pressing Enter does nothing, no blue buttons

in the Entry window

On work dupes Ru
n – Disa

bled

DUPE callsign entered.
Mistake with received
QSO data

Send EXCH when Enter is pressed

On don’t work
dupes

Ru
n – Disa

bled
Mistake with received
QSO data Send EXCH when Enter is pressed

On – S&
P – Disa

bled
Mistake with received
QSO data

Send EXCH when Enter is pressed. After the
user corrects the entry, it will log and not send
anything

Digital Modes Tab
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The Digital modes tab is used to set up the interfacing to external Controllers (TNCs), or to digital engines
(MMTTY/MMVARI/Fldigi/2Tone) for sound card digital modes.

In SO1V mode, there is only one Digital Interface window, DI-1. In SO2V and SO2R modes, there are two Digital Interface
windows, DI-1 and DI-2. Each DI window is associated with one of the two Entry windows. Each DI window is opened from the
Window > Digital Interface menu item in the corresponding Entry window. The Digital Modes tab in the Configurer is used to
configure both Digital Interface windows.

Digital Modes Field Descriptions

Digital Interface 1 / 2
TU type

None
Soundcard – use this selection for MMTTY, 2Tone, MMVARI or Fldigi sound card software
Other – use this selection for a TNC or TU such as a PK-232 or KAM
Dxp38 – for the HAL DXP-38 TU
TinyFSK – for the K0SM TinyFSK interface
Winkey – for the K1EL Winkeyer version 3.1 or later interface

Note: in order to enable the Winkey interface, you also need to check the Enable RTTY Mode
using Winkey check box under the Winkey tab, and set the Winkey port up under the Hardware
tab if you haven’t already done so for CW

Port, Speed, Parity, Data Bits, Stop Bits, Flow Control – Used when Other, Dxp38 or TinyFSK is selected, to
set the parameters for the COM port used to communicate with the TNC or TU (e.g. 9600 baud, N, 8, 1, no flow
control for the DXP-38 or TinyFSK)

DI-1 MMTTY Mode | DI-2 MMTTY mode
Use the MMTTY section for 2Tone as well as MMTTY
When using MMTTY, select whether AFSK or FSK is being used
The serial port MMTTY will use for PTT and FSK has to be set in the MMTTY Setup. More information in
the MMTTY support chapter
When using a TinyFSK for FSK transmitting, you will still need a sound card interface for receiving; even though
you are actually going to transmit using FSK, you configure the sound card interface for AFSK

DI-1 MMTTY Path | DI-2 MMTTY Path
The path to the MMTTY (or 2Tone) engine goes here including the file name of the program
The path and file name can be selected using the Select buttons
The two instances of MMTTY should be in two separate folders. You must do this if you want the MMTTY
settings in the two instances to be different (e.g. left vs. right channel, different sound cards, etc.)

DI-1 Fldigi Path | DI-2 Fldigi Path
The path to the Fldigi engine goes here including the file name of the program
The path and file name can be selected using the Select buttons

DI-1 MMVARI RTTY Mode | DI-2 MMVARI RTTY Mode
When using MMVARI for RTTY, select whether AFSK or FSK is being used
If AFSK is selected the serial port (if any) with a check in the Digital check box and with Dig Wnd Nr
corresponding to the DI window number will get passed to MMVARI when the DI window is opened, so that
MMVARI can use it for PTT control
If FSK is selected, the port to be used for PTT control is not passed to MMVARI. It must be defined in the
FSK8250, EXTFSK or EXTFSK64 setup window

DI-1 MMVARI FSKPort | DI-2 MMVARI FSKPort
WARNING: You must use the Windows “Run as administrator” option when starting N1MM+ if you want to use
FSK with MMVARI. Running MMVARI in FSK without using “Run as administrator” will result in a program
hangup or crash when the FSK8250/EXTFSK/EXTFSK64 plugin tries to write to its configuration file
Choose FSK8250 if you are using a true serial port or a device that can simulate a serial port and handle 5-bit
codes at 45.45 baud (this does not include most consumer-grade USB-to-serial adapters, but it does include
some commercial interfaces, such as interfaces specifically designed to support FSK RTTY)

When MMVARI is opened for FSK RTTY, a small window labelled FSK8250/16550 1.03 will open, or
appear on the Windows Task bar. In this window you select the COM port number and the signal line to
be used for PTT (RTS or DTR). FSK keying will be done on the TxD line. If this is a USB device that
simulates a serial port, check Limiting speed in the MMTTY setup. You can use the _ box at the top right
to minimize this window after completing the setup

Choose EXTFSK if you are using a regular USB-to-serial adapter
When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK 1.05a will open, or appear on
the Windows Task bar. In this window you select the COM port number and the signal lines to be used for
FSK keying (normally TxD) and PTT (RTS or DTR). You can use the _ box at the top right to minimize this
window after completing the setup

On high-performance multi-core systems only, you may choose EXTFSK64 instead of EXTFSK. EXTFSK64
uses a more accurate timing mechanism than EXTFSK, but this mechanism uses significant CPU resources.
EXTFSK64 is not appropriate for use on XP based systems or hardware running older dual-core Intel/AMD
CPUs or Atom based CPUs. On systems that are capable of supporting it, EXTFSK64 can key FSK at speeds
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other than 45.45 baud, and it can also key FSK from LPT ports as well as USB-to-serial adapters.
See http://www.qsl.net/ja7ude/extfsk/indexe.html for more detailed information on EXTFSK64

When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK64 will open, or appear on the
Windows Task bar. In this window you select the COM or LPT port number and the signal lines to be used
for FSK keying (normally TxD) and PTT (RTS or DTR). You can use the _ box at the top right to minimize
this window after completing the setup

Path to WSJT/JTDX (version 1.0.7845 and earlier only – in version 1.0.7860 and later, these options have been moved
to the WSJT/JTDX Setup tab):

The upper box contains the path to the WSJT (or JTDX) program that will be used from within N1MM+ for WSJT
modes like FT4 and FT8. When the Window > Load WSJT/JTDX menu item is used in the Entry Window, the
entry in this box tells the program where to find the WSJT or JTDX program. Use the Select button to change
the path.

To the right of the Select button is a box in which additional command-line parameters may be set for
WSJT. In most installations, this box is not used.

The lower box can be used for running WSJT-X from Radio 2 in SO2R.
Detailed information on setting up and operating with WSJT-X or JTDX is found in the manual page for the
WSJT Decode List window.

Other Tab

The Other tab is used to set up default values and select special modes and functions.

Other Tab Field descriptions

DVK Letters File Path – This is where you specify the sub-path (relative to the Wav\LettersFiles subdirectory in the
N1MM Logger+ User Files area) where the program will look for individual letter and number files for voicing of call
signs and serial numbers in SSB. You can use {OPERATOR}\ in this file path, in which case each operator (specified
using OPON or Ctrl+O) will have their own separate letters file subdirectory within the wav\LettersFiles directory
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Primary CW Speed Step – The primary speed step is used with PgUp/PgDn keys or the speed adjust buttons in the
Entry Window
Secondary CW Speed – The secondary speed step is used when Shift+PgUp/PgDn is
pressed. Alt+PgUp/PgDn adjusts the CW speed of the inactive radio/VFO in SO2R/SO2V mode
Repeat time in millisecs – Specify the CQ repeat interval in the Entry window (Auto-CQ). The default value is 1.8
seconds. Enter a value in seconds or milliseconds. The maximum value is 32767. This is the same as Ctrl+R or ‘Config
| Set CQ repeat time’ in the Entry Window
Default # Spots in – The number of spots returned by the SH/DX command in the bandmap window. The default value
is 30 spots. The number of returned spots for the SH/DX command in the Telnet window is not affected by this value
and has to be changed in the Telnet Options window

SSB Tuning Tolerance (Hz) – SSB mode: Clicking on or next to a station in the bandmap window will put the call on
the callsign frame (if the callsign field is empty) of the Entry window. This value gives the maximum frequency distance
to the call on the bandmap when it will be put on the callsign frame. The value has to be between 0 and 20000 (20
kHz). The default value is 300
CW Tuning Tolerance (Hz) – CW mode: Clicking on or next to a station in the bandmap window will put the call in the
callsign frame (if the callsign field is empty) of the Entry window. This value gives the maximum frequency distance to
the call on the bandmap when it will be put on the callsign frame. The value has to be between 0 and 20000 (20 kHz).
The default value is 300
RTTY Tuning Tolerance – RTTY mode: Clicking on or next to a station in the bandmap window will put the call on the
callsign frame (if the callsign field is empty) of the Entry window. This value gives the maximum frequency distance (in
Hz) to the call on the bandmap when it will be put on the callsign frame. The value has to be between 0 and 20000 (20
kHz). The default value is 300
CW Weight – Adjusts the CW weight (between 30-70% limits). The default value is 50. This weight command works not
only for serial or LPT port CW but also for Winkeyer

SSB Up/Down Arrow Incr – This value gives the frequency jump amount (in kHz) of the up/down arrow keys, or by
spinning the mouse wheel, in SSB . Set to 0.00 to disable

NB. Never make this smaller than the smallest step your radio can make in SSB. Older Icom rigs are known to
have a smallest step of 100 Hz which is quite big. When the step is made smaller than the minimum step size
the Up/Down Arrows don’t seem to work. Also controls the amount of each frequency change when tuning the
RIT on radios that support doing so from the computer

CW Up/Down Arrow Incr – This value gives the frequency jump amount of the up/down arrow keys, or by spinning the
mouse wheel, in CW and digital modes. Set to 0.00 to disable

NB. Never make this smaller than the smallest step your radio can make in CW. Most rigs have a smallest step
in the order of 10 Hz. When the step is made smaller than the minimum step size the Up/Down Arrows don’t
seem to work. Also controls the amount of each frequency change when tuning the RIT on radios that support
doing so from the computer.

PgUp/PgDn Incr (kHz) – This value gives the frequency jump amount for the {PGUP} {PGDN} macros (Note: the PgUp
and PgDn keys are not used for this; the {PGUP} and {PGDN} macros must be used in function key macros. These
macro names are holdovers from early versions of N1MM Logger Classic)
Clear automatically populated exchange on callsign change – When selected, if the callsign in the Entry window is
changed by the operator, this option clears the contents of exchange fields in the Entry window that were populated
(filled in) from a Call History file, from previous QSOs in the contest, or from a Telnet spot. Does not affect exchange
data that have been manually filled in
Per Operator Function Key Messages – This feature is intended for multi-operator situations where it is desirable to
enable different function key messages depending on which operator has logged on the program (with Ctrl+O or the
text command OPON [Callsign]).

When the Per Operator Function Key Messages option is not checked, the function key message file specified
on the Associated Files tab of the Contest Setup dialog will be used by all operators. Any operator can modify
the file that is in use through the Function Key Editor.

If a specific Associated File is not defined, then the Default message file for that mode will be used.
When the Per Operator Function Key Messages option is checked:

If the Station callsign is the same as the Operator callsign, the main function key message associated
with the contest is selected, as above. Only the Station callsign operator can edit this function key
message file; any edits performed by other operators affect only their personal copy of the message file.
If the Station callsign and the Operator callsign are different, the current Associated Function Key
Message file is copied into an operator sub-directory during the first OPON or Ctrl+O by that operator.
The operator directory files are then loaded each subsequent time that operator signs on using OPON or
Ctrl+O. The station callsign operator should verify that the associated function key message files are
correct prior to allowing operators with different callsigns to log on, otherwise any errors in the master set
will have to be corrected individually by every other operator who signs on.
It is not necessary to create the operator directories yourself. The program code will create the necessary
sub-directories and the operator directory when needed. The operator directory is a sub-directory of the
directory where the base function key message files are stored (e.g. C:\Users\[Station
Login]\FunctionKeyMessages\), named with the call sign or name used in the Ctrl+O or OPON command.
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If you want to reset and delete the operator directories, uncheck (disable) the Per Operator Function Key
Message option first.
If a base associated function key message file cannot be found, the Default [mode] message file is used
to create one.

MorseRunner Mode – checking this option enables a simulated contest using an integrated MorseRunner module.
This integrated version uses the N1MM+ Entry and Log windows in place of the MorseRunner windows that you would
see if you were using MorseRunner as a standalone program.

When you select MorseRunner Mode and exit the Configurer, a temporary dialog window will appear, allowing
you to customize the MorseRunner parameters. CQWW and CQ WPX contests are currently supported. If an
unsupported contest log is open at the time you exit the Configurer, a warning message will be displayed and
MorseRunner Mode will not be started.
If this is the first time you have selected MorseRunner Mode, N1MM Logger+ will automatically download the
MorseRunner program and callsign database (mr_db.txt) from the N1MM Logger server (Internet connection
required).
If MorseRunner Mode was enabled the last time N1MM+ was closed, and if a supported contest is open when it
is restarted, you will be prompted to ask whether you want to enable or disable MorseRunner Mode for the
current session. If an unsupported contest is opened, MorseRunner Mode will be disabled.
MorseRunner can only use your default sound device. If you have N1MM Logger configured for SO1V or SO2V,
a single instance of MorseRunner will be started and both audio channels will be the same. If you are using
SO2R, two instances of MorseRunner will be started, with each “radio” using a separate audio channel.
The audio level for MorseRunner is set using the standard Windows audio level controls. The sidetone audio
level can be changed using Ctrl-Alt-PageUp and Ctrl-Alt-PageDown. The sidetone can be completely muted
using the “Mute when sending” check box before starting MorseRunner.
The audio frequency of stations you are working can be changed using the up and down arrow keys (simulated
RIT).
The audio frequency of the sidetone for “transmitted” messages can be changed using the Shift+Alt+PgUp/PgDn
keys.
When MorseRunner is started, you should hear “band noise”. To begin your session, use the F1 key or button
(or Enter key in Run mode with ESM mode enabled) to send CQ. After a few CQ’s you will hear stations
answering.
The CW messages that are sent in MorseRunner mode are fixed inside the MorseRunner program, i.e. they do
not reflect any customization you may have done to your function key messages.
Note that currently only the CQWW CW and CQ WPX CW simulated contests are supported. You must select a
CQWWCW or CQWPXCW log in N1MM Logger+ to use MorseRunner Mode (it is recommended that you create
a new log for this purpose rather than using an existing log).

Show text cursor position in inactive EntryWindow – Used in SO2R and SO2V. When this option is checked, there
will be an indicator in the inactive Entry Window of where the text entry cursor for that window will be when and if
keyboard focus is changed to that window. Unlike the cursor in the active Entry Window, this indicator does not blink.
Overwrite serial number in Entry Window – When this option is checked (default), when the cursor moves to the
exchange box in a serial number contest, the entire serial number will be selected ready to be overtyped. If you don’t
want this behavior, you can uncheck this option, which will place the cursor at the end of the serial number instead of
selecting the entire number.
Mute mic on supported radios – Mute the microphone during transmit. Normally used to enter audio via a radio input
other than the microphone. Default is to not mute

For use only with the Logger’s own digital voice keyer (wav files). Do not check this option if you are using a
DVR in the radio or an external DVK
Supported radios are: Tentec Orion and Elecraft K3
Tentec Orion: If “Mute” is checked, it causes the Orion’s mic input to be muted and the Aux input to un-mute
during voice keyer events

Check for new program versions – At program startup, check for a new version and if one is available, offer to
download and install it. If you choose not to download a newer program version when prompted, you will not be
prompted again for that program version.
CC Cabrillo to logs@supercheckpartial.com – enables an Email button in the popup menu that appears when you
generate a Cabrillo file that will automatically send a copy of the Cabrillo file to the supercheckpartial.com web site for
use in creating the master.scp files. Requires an email client program to be configured to send emails.
Dual-EntryWindow Frequency Tuning Indicator – Enables a visual indication when the frequency of a radio has
changed. Makes it easier to see which radio has QSYed in SO2V or SO2R.

Use Reverse CW Radio 1 – When selecting CW send a command to Radio 1 to use Reverse CW (CW-R)
Use Reverse CW Radio 2 – (SO2R only) When selecting CW on Radio 2 use Reverse CW (CW-R)
Disable stereo key in SO1V mode – When checked (default), this option disables the ~ (stereo) key in SO1V mode (it
has no effect in SO2V or SO2R). Unchecking this option allows using the stereo key to turn on the subreceiver even
though the program is in SO1V mode.
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Winkey Tab

The Winkeyer tab is used to control functions of a K1EL Winkeyer chip. (or 100% compatible clone). Winkeyer is designed by
K1EL and G3WGV. It is only active when the Winkeyer box has been checked on a serial port, and that port (whether
real or virtual), has been connected either to a stand-alone keyer or to a device that embeds the Winkeyer chip, such
as various MicroHAM and RigExpert products. Consult your unit’s manual along with the Winkeyer chip manual for
more information on these settings.

To set up a port for a Winkeyer (or for a device that embeds a Winkeyer chip), select the COM port number that Windows has
assigned to the Winkeyer, check the CW/Other check box for that port, click on the Set button, and check the WinKey check
box. You do not need to change any of the other settings on the port setup dialog.

Winkeyer is fed ASCII characters from N1MM Logger (via COM or USB Ports), and converts the ASCII to timed CW. The pot
speed range is from a minimum of 10 wpm to a maximum of 55 wpm. Winkeyer can also be used to control PTT. Winkeyer
PTT can be used on modes other than CW. Note: This only works for Winkeyer versions 10, and 21 and greater.

Normally only the KEY1 and PTT1 outputs on a Winkeyer 2 or later are used. There is no provision for selecting KEY2 or
PTT2 outputs instead, with two exceptions. The first exception applies in SO2R, where there is a capability to use KEY2 and
PTT2 from the second Entry window for the second radio – see the Use 2nd output option below. The second exception
relates to the option with a Winkeyer 3.1 of using any of the four outputs for FSK keying in RTTY – see the Select Winkey
RTTY Keying Port option below.

Winkeyer Field Descriptions

Keying Mode – Select the keying mode. Choices are: Iambic A, Iambic B, Ultimatic and Semi-Automatic. The default is
Iambic B
Autospace – Select when the autospace feature should be used. When using the paddles to send, if a pause of longer
than one ‘dit’ time is detected, THREE dit times of pause will be inserted before the next character. See the manual for
more information
Pot is wired with two leads – This option applies to Winkey version 1 only. Select when the potentiometer on the
board is wired only with two instead of three wires. Under normal operation, leave unchecked. Unless you’ve built the
keyer yourself, or your keyer vendor recommends this, leave unchecked
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Pin 5 Function – Valid only for Winkey version 1. Select the function of pin 5. Unless your keyer’s manual tells you
otherwise, the default of PTT is likely what you want here. The Winkeyer manual is also a good reference. The choices
are:

PTT (default)
Sidetone
2nd CW (second output, do not use for SO2R – see below))
None

Sidetone Frequency – Select the Winkeyer’s sidetone frequency. The default sidetone frequency is 469 Hz
Reverse Paddles – Reverse the left and right paddle
Winkey Speed Pot Control – Three options:

Ignore Winkey Speed Pot (when N1MM+ is running)
Use Winkey Speed Pot (matches the N1MM+ speed to the pot setting)
Use Winkey Speed Pot for Paddle and Keyboard CW only (enables QRS for manual CW)

Lead Time – Set the lead time value in 10ms Increments (up to 2.55 seconds). This value reflects the amount of time
that the Winkeyer PTT will be asserted BEFORE keying commences

If when sending CW you are missing the first dot or dash, or if paddle-sent CW doesn’t seem responsive (again,
missing the first character) set this to at least 10 mSec
NOTE that this field denotes 10 mSec intervals — ‘1’ in this box means 10 mSec
If Pin 5 function is set to PTT, set this value to at least 1 (10 mSec)

Tail Time – Sets the tail time in 10 mSec Increments (up to 2.55 SECONDS). This value reflects the amount of time
that the Winkeyer PTT line will be held after keying stops. Tail Time = 1 results in a tail time equivalent to sending one
extra dit (Winkeyer v2.2; 10 msec in earlier versions of Winkeyer). Tail Time = 2 adds 10 msec to that, Tail Time = 3
adds another 10 msec, and so on. If Tail Time is set to zero, then Hang Time is used instead
First Character Extension – Sets the extension time in 10 mSec steps (up to 2.55 seconds). Normally ONLY used
with older, slower-keying rigs at speeds above 25 wpm, this setting will add time to the first element sent to help with
the lack of T/R speed of those rigs. This value is usually set by experimentation. See the Winkeyer manual for more
information on setting this value
Keying Compensation – Normally only used with high speed (>30 wpm) QSK operation. Adds time (in 1 mSec
increments) to both dashes and dots to adjust for rig switching delays (however slight). See the Winkeyer manual for
more information
Hang Time – Provides a CW speed-dependent means of holding PTT during CW sending from the paddle. Hang Time
can be used to set a CW-speed dependent delay of 1, 1.33, 1.67 or 2 letterspaces (not dit spaces) after the last paddle
closure. The Hang Time setting always applies to paddle-sent CW. For computer-sent CW, Hang Time is only used if
Tail Time is set to zero. See the Winkeyer datasheet for more detailed information
Winkeyer 2

Sidetone – Gives a sidetone when sending CW (both when using a paddle and from computer input)
Paddle only sidetone – Gives a sidetone only when sending by paddle
Use 2nd output – The Winkeyer 2 has two sets of keying outputs, but normally only the KEY1 and PTT1
outputs are used. However, in SO2R, if the “Use 2nd output” option is checked, then when the transmit focus is
in the second radio Entry window, CW and PTT will be switched to the KEY2 and PTT2 outputs. This is
convenient for minimal CW SO2R, because no additional hardware is needed to switch CW and PTT between
radios. You’ll still need to do something about the received audio switching, though. Select this option for SO2R
operation using both outputs. In SO2V or SO1R, this option does not support CW operation from the second set
of outputs, but it can be used for RTTY operation with a Winkeyer version 3.1 or later using an output connector
other than KEY1 (see below)

Enable RTTY Mode using Winkey – (Winkeyer version 3.1 or later only) Check this option and select Winkey as the
TU Type under the Digital Modes tab to use the Winkeyer for RTTY FSK keying

Select Winkey RTTY Keying Port (only visible if Enable RTTY Mode using Winkey is checked) – use this to
select one of the other Winkey outputs (PTT1, KEY2 or PTT2) for RTTY. The Use 2nd output check box must
also be checked to enable KEY2 or PTT2

Setting CW Speed and Weight in Winkeyer
Speed setting is done just as with other keying methods. The PgUp and PgDn keys will increase or decrease the
speed (default is 2 WPM steps). You can also overwrite the value in the speed window, or use its up/down arrows.
Shift+PgUp/PgDn increases or decreases the speed by a larger amount (default is 4 WPM). Both step size values
are user programmable and can be set using the Configurer’s Other tab.

If the option to ignore the speed pot has not been selected, setting the speed using the speed control pot changes
BOTH the paddle speed and the N1MM sending speed. Setting the speed using the entry window changes both the
paddle sending speed and N1MM sending speed but ONLY UNTIL the next time the speed pot is adjusted, i.e. the
absolute position of the speed pot then overrides any changes made in the entry window.

CW weight for Winkeyer can be set on the Other tab, but is not usually changed from the 50% default.
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Mode Control Tab

The mode control tab determines how (and whether)the mode will be controlled on the connected radio, whether the
program sets the mode when changing frequency or not, and what mode it changes it to. This dialog also gives you control
over the mode used when contacts are logged.

Mode logged vs. Radio mode
In an ideal world, the mode in the log, the radio’s mode and the mode in the software would all be the same. For traditional
voice and keyed CW modes (CW, USB, LSB, AM, FM) this actually holds true. With the obvious exception of radios that do
not support all of these modes, there is a one-to-one correspondence between the names of the modes on the radios, in the
software and in the log. If these were the only modes that existed, it would always be possible to change modes on the radio
and have the software follow (or vice versa) without risk of confusion or error, and there would be no need for mode control
configuration settings.

However, when digital modes are brought into the picture this one-to-one correspondence breaks down. Any SSB-capable
radio can be used for digital modes using a sound card, even if the radio itself does not have any native digital modes. This
results in a many-to-one relationship (many different modes in the log can map to a single mode on the radio). In the case of
RTTY, some radios have a native RTTY mode using FSK keying, and when it exists, this mode is uniquely associated with
RTTY and not with any other digital mode in the log. However, the reverse is not true; depending on the hardware
configuration and the operator’s choice, RTTY in the log may correspond with either RTTY or SSB on the radio. In the case of
some radios, there may also be an additional mode or modes in the radio tailored either specifically for AFSK RTTY or for
sound-card digital modes generally. Radio manufacturers use a bewildering and inconsistent variety of names for these
modes.

For information about mode control for your specific radio, go to Supported Radios . In particular, for the
correspondence between the mode names used in the right-hand side of the Mode Control window in the Configurer and the
names used by the radio’s manufacturer, see the Digital Mode Mapping table. See the text box below called “Digital Mode
Selection” for more details.

Because of this breakdown in the one-to-one correspondence, a radio-first priority system cannot be imposed in all situations
– once digital modes are involved, setting the mode on the radio does not always uniquely identify the mode that should be
logged. Instead, the primary rule is “software first”. Setting the mode in the software always controls what the radio does. You
can select the mode in the software simply by typing the name of the mode (CW, SSB, USB, LSB, AM, FM, RTTY, PSK) into
the entry window in the callsign box and pressing the Enter key. Provided the mode you have chosen is supported by the
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contest (this is determined by the Mode category in the contest setup window), the software and the radio will switch to the
mode you have commanded, and that is the mode that will be logged, When the MMVARI or Fldigi digital engine is used, the
specific digital mode logged will depend on what mode has been selected within the digital engine. Since not all radios use the
same radio mode for digital modes, there are settings in the right side of the mode control configuration window that determine
which radio mode is used for each of RTTY and PSK.

Automated Mode Switching 
Despite the lack of a complete one-to-one correspondence between the modes in the log and in the radio, there are many
situations where some degree of automated mode switching is possible, based either on the radio’s mode or on the frequency,
and within the limits imposed by the current contest setup (i.e. what modes are supported within the current contest). The
settings that control whether this kind of automation is used, and on what basis, are in the left side of the mode control
window.

One of these options is to use the band map. You may be able to use this within a single mixed-mode contest where the
modes are kept well-separated in frequency. Unfortunately, this doesn’t work in all situations. During major CW contests, for
example, CW may be used pretty much throughout the normal digital sub-band. On the other hand, during a major RTTY
contest you may find RTTY being used on frequencies that would normally be considered to be CW frequencies. For this
reason, using the band map to determine the mode is not a foolproof set-and-forget option. Depending on the modes
supported by your radio and the nature of the particular contest(s) you are operating in, you may need to choose one of the
other options.

Digital Mode Behavior is Different
There is a difference in mode control behavior between the situation where the DI window and digital engine window are open
and the situation where they are closed. This is due to the way serial ports are used by the digital engines and by the Logger.
The digital engines are separate processes from the rest of the Logger, and a single serial port cannot be shared between two
processes. Since serial ports can be a scarce resource in a complex contest station, the Logger allows time-sharing of serial
ports between digital (FSK & PTT) and non-digital (CW & PTT) uses. It does this by switching the ports between the
processes depending on whether the DI window is open or not. When the DI window is opened, serial ports that have the
Digital box checked in the Configurer are closed by the Logger so that they can be opened by the digital engine. When the DI
window is closed, these ports are released so that the Logger can open them for use in other modes.

Thus, whether the DI window is open or closed can make a significant difference to the hardware configuration. Whenever a
serial port is time-shared between the Logger and a digital engine, that port cannot be used for PTT or CW keying in non-
digital modes while the DI window is open.

In order to support the wide range of possible hardware configurations in a hardware-independent fashion, mode control in the
Logger depends on whether the DI window is open or not. When the DI window is closed, radio-first mode control works
between non-digital modes, but switching the radio mode to (or through) a digital mode or tuning the radio’s frequency into (or
through) a digital band segment does not open the DI window and switch the software to digital mode. To switch into a digital
mode, the DI window must be opened from the software. This can be done by using the Entry window to select RTTY or PSK
mode in a contest that supports digital modes, or by using the Window > Digital Interface menu item.

Once the DI window is open, changing modes on the radio does not close the DI window and the software does not switch out
of digital mode, which means that radio mode-driven mode control does not work when the DI window is open. Mode changes
in this state must be performed from the software. If the software is commanded from the Entry window to use a non-digital
mode, the DI engine is closed by the software in order to free up any time-shared ports for the Logger to use.

Mode Control Field Descriptions

Mode recorded in log – Set how to determine the mode that will be entered in the log
Use radio mode (default) – if the DI Window is not open, the mode is determined from the radio’s mode setting.
If the DI Window is open, the mode used depends only on the digital engine and not on the mode received from
the radio, as follows:

In digital modes, the mode in the log will be RTTY if using the MMTTY or 2Tone engine or a TNC
When using the MMVARI or Fldigi engine, the mode will be as selected in the MMVARI or Fldigi window
(digital modes only for Fldigi)

Follow band plan – the program will use the mode the bandplan gives for the frequency. For CW and Phone,
this affects both what is entered in the log and what happens when you click on a spot in the Bandmap or the
Available Mults and Qs window, but does not switch the radio automatically to a digital mode if you click within a
digital band segment.
Use contest mode or bandplan – In a single-mode contest, that mode is both logged and sent to the radio. If
the contest is mixed mode (e.g. the Russian DX Contest) the bandplan is followed as above.
Use contest or radio mode – In a single-mode contest, that mode is both logged and sent to the radio. In a
mixed mode contest, the radio’s mode is used.
Always: – always log the mode selected here (CW, SSB, RTTY, PSK31, PSK63, PSK125) regardless of the
mode set on the radio.
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Mode sent to radio – Select how to determine the mode sent to the radio
This applies only for digital modes, including FT8/FT4, PSK31/PSK63, and RTTY. See the note below for details
The row called RTTY is for RTTY only, since RTTY often uses a different mode in the radio from other digital
modes.
The row called DIGI (starting with version 1.0.7937; it was previously called PSK) is for all digital modes other
than RTTY, including FT4/FT8 as well as PSK31/PSK63, etc.
If your radio has a special mode(s) for sound card digital modes, the mode labels in the pull-down list probably
won’t match the mode names in your radio. See the text box below.

Always use packet spot mode check box:
If this box is checked, then clicking on a spot in the Bandmap (or jumping to a Bandmap spot using the keyboard) may change
the mode of the radio, depending on whether the spot notes describe the mode or on the sub-band settings in the Bandmap
window, and on whether the Mode Category in the Contest Setup dialog includes the packet spot mode as determined either
by the spot notes or by the band plan settings. In a single-mode contest, you probably do not want to change the radio’s mode
as a result of clicking on a spot, and so this option should not be checked. In a multi-mode contest or for general logging, you
might want to allow the packet spot mode to change the mode of the radio, but in this case it is important to set the CW,
Digital and SSB sub-band limits appropriately in the Bandmap window, otherwise spots without spot notes (e.g. many
human-generated spots) may cause the radio’s mode to change in an unwanted manner.

Be careful when using the Follow band plan option
When you use the “Follow band plan” option for the Mode recorded in the log, it is imperative that the sub bands be
set correctly in the Bandmap window, as the program will log contacts using the mode from the band plan as
configured in the Bandmap window regardless of the mode you were actually using. Failing to set the sub band limits
appropriately in the Bandmap window is a frequent cause of logging errors.



Digital Mode Selection
Every radio seems to have a different range of choices and names for digital modes. Some radios have no modes
specialized for digital modes, some have only one digital mode for FSK RTTY (for sound-card digital modes, you use
USB or LSB), some add to this a separate mode intended for sound-card digital modes like AFSK RTTY, PSK31 and
FT8, and some radios have three separate digital modes for FSK RTTY, AFSK RTTY, and other sound-card digital
modes like PSK31 and FT8. There may also be two versions of each of these, one “normal” and one “reverse”
(opposite sideband). Every manufacturer uses different names for these specialized modes.

For simplicity, N1MM Logger has its own radio-independent terminology. The Logger uses RTTY for the radio mode
normally used for FSK RTTY (which is usually but not always called FSK or RTTY on the radio). If the radio has a
mode that is designated for AFSK RTTY, the Logger calls it AFSK (your radio manufacturer may have a different
name for this, such as LSB-D or PKT-LSB). AFSK-R is the “reverse” of this AFSK mode, i.e. on the upper sideband
instead of LSB (and might be called USB-D or PKT-USB on the radio). If there is a mode intended for sound card
data modes that is different from the AFSK-R mode (such as the DATA A mode in the Elecraft K3/K3S), it will be
called PSK in the Logger. Not all radios have all of these modes, so not all choices will necessarily be available,
depending on what radio(s) is/are configured.

The translation between the mode name used on the radio and the mode name used in N1MM Logger is described
at Click here to see the table

For RTTY, if you are using FSK, you should normally select RTTY. If you are using AFSK, you should normally select
AFSK or LSB/USB, depending on whether your radio offers a specialized AFSK mode or not.

For other digital modes (including PSK and WSJT modes), the choice would normally be one of: PSK (if available,
e.g. Elecraft K3/K3S), AFSK-R (on some radios, e.g. IC-7300), or USB (older radios that do not have a dedicated
mode for sound card digital modes).
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Antennas Tab

N1MM Antenna/Rotor configuration in the Configurer >Antenna tab

The Antennas Tab defines how antennas can be selected by the program, if you have appropriate hardware, and also controls
the rotor program. The example above illustrates the features of this tab.

The program uses a variety of antenna-related interfacing options, depending on your hardware and preferences. For
example, antenna selection can be controlled by using a band decoder in conjunction with BCD values 0-15 on a real LPT
port. Note that USB-to-parallel adapters do not work in this or other parallel port interfacing functions, because they do not
allow program control of individual pins on the port.

Antenna selection can also be controlled by one of two serial port protocols, the proprietary MicroHam protocol and the Open
Two Radio Switching Protocol (OTRSP). Rotators can be controlled either by using the N1MM Rotor Program, or by various
third-party software packages that make use of UDP broadcasts sent by N1MM Logger+.

Tip
Unlike most transceivers and some logging software, N1MM does not map prescribed bands to its antenna output
value. Instead, N1MM maps antennas to outputs ranging from 0 to 63. You can still map bands, but the antenna
approach is much more powerful. It supports multiple antennas per band, stacks, and multiple bands per antenna.
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Antennas Tab Column Descriptions

Code – The code which will be presented on the LPT port as binary coded decimal output, using pins 9, 8, 7 and 2. It is
also the code sent to an OTRSP device, in the OTRSP AUX message.

The codes themselves are pre-determined, ranging from 0 to 63. Note that if you are using an LPT port with
BCD output, the maximum represented values are from 0- 15 (4 bits). In the example above, no antenna for
Code O is defined – this is because in that case that code is used to select automatic operation from the front
panel of the remote antenna switch.
Each row in this table, and thus each code, represents ONE ANTENNA, although it can support more than one
band. For example, one code can select a tri-bander that is defined for 10, 15, and 20 meters.
Most stations will use a Band Decoder to receive the code sent from N1MM and translate that single code into
activation commands for remote antenna switches. Google search for “ham radio band decoders” to see the list
of many available devices.

Antenna -Text to describe the antenna. This text will appear on the status bar of the Entry window when you change
bands or switch antennas for a given band. Use Alt+F9 to toggle through all the antennas defined for the current band.
This text listing the current selected antenna will appear in the center-right side of the N1MM Entry Window.
Bands – The bands on which this antenna will be selected

List bands in MHz. The valid band text list is: 1.8, 3.5, 5, 7, 10, 14, 18, 21, 24, 28, 50, 70, 144, 222, 420, 902,
1240, 2300, 3300, 5650, 10000, 24000, 47000, 76000, 142000, 241000. If the antenna supports more than one
band, separated bands by commas. See the screenshot above with dual band dipoles on antennas 30/40
meters and 80/160 meters. Note that the first antenna in the table will always be selected when changing to a
band. Press Alt+F9 to select other antennas that are defined for the same band. In the screenshot above, a
station on 40 meters would use Alt+F9 to toggle between the dipole and vertical antenna.
An antenna may be used on any number of bands

Rotor Description – enter the description as defined in setting up the rotor program. It must be exactly the same in
both places, because these names make the connection between the two programs.

More than one rotor can be selected (separate using commas), for example to turn a stack where more than one
rotor is involved.

Offset – This offset is added to the rotor position to determine the antenna position. This is useful for antennas that are
mounted at 90 degrees for pattern interference reasons, or for antennas that have simply turned some in the wind over
the winter. The offset can also be entered for the selected rotor in the rotor program
Bidirectional – Check this box if the antenna can be set bidirectional (0 = not bidirectional, 1 = bidirectional) (For
example: dipoles and Steppir beams)
Sector – For stationary (non rotating) antennas. Describes the compass headings of the antenna’s transmitted pattern,
separated by a dash. For example: 45-90. Define an omni-directional antenna as 0-360. N1MM will automatically
recognize a bi-directional antenna as covering the defined sector and its opposite direction. See option description
“Auto-Select Antenna Based on Azimuth to Station” below.

Options in the Antenna Dialog Window

Start N1MM Rotor Program – Start the N1MM Rotor program automatically from the N1MM Logger+ main program.
You will need to stop it manually
Display Rotors Used By This Station –
Display Rotors Responding From Network –
Auto-Select Antenna Based on Azimuth to Station – Selects an antenna (Code) based on the antenna that 1)
matches the band and 2) matches the direction to the location of the station entered in the Entry Windows callsign field.
For stations with multiple stationary antennas aimed at different targets (For example: Europe, South America, Asia),
the selected antenna will be that which falls in the transmit pattern of antennas for that band. If there is no directional
match, N1MM will simply choose the first antenna listed for a band.
HINT: Define a catch-all antenna with sector 0-360 as the last listed antenna for a band. If no stationary antenna
supports the azimuth to a station, N1MM will defer to the default 0-360 antenna. Example 1: Big Gun station has 20
meter stationary antennas for EU and SA, and a rotatable beam for other directions. Define the rotatable beam after the
other 20 meter antennas with a Sector = 0-360. Example 2: Little Pistol station has a bi-directional 40 meter dipole
that favors North-South, and a vertical for other directions. Define the dipole as 120-240, and the vertical as 0-360.
Example 3: Low-band station has an omni-directional vertical on 160 meters and four receive beverages for North
(325-45), South (135-225), East (45-135) and West (225-325). Define four “antennas” for 160 meters, and use your
band decoder to select the vertical plus the corresponding directional beverage.

To view a short video that describes the difference between alt+F9 and Sector-Based antenna switching, click HERE

See the screen shot above and the Field Descriptions below. You can have multiple antennas for a band and use Alt-
F9 to cycle through them.
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The selected Antenna is highlighted in the Entry Window when changed

Score Reporting Tab

In N1MM Logger+, the Real-Time Score Reporting function has been integrated with the rest of the program. Instead of
checking a box on the Other tab of the Configurer to start it, it now has its own tab in the Configurer.

Following, left to right, are the options you will need to set up to use it.

Report Real-Time Score to Server– this checkbox is checked to start reporting real-time scores. It will stay selected
until you uncheck it.
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Exclude band breakdown – if you feel that for competitive reasons you don’t want to disclose your band breakdown,
revealing your band-change strategy, check this box.
Include real time QSO data for real time scoring – this will send QSO data to the real-time scoring website
(experimental: performs log cross-checking in real time).
Score Reporting Server – The server name is editable. One of the entries in the pulldown list is “score distributor
server”. For most users, this is the appropriate choice, as it forwards reported scores to all online scoreboards. If the
“Include real time QSO data …” checkbox is checked and the contest is one of the ones supported by the real-time
scoring website, QSO data will be forwarded to that website for cross-checking in addition to the regular score reporting
to the scoreboard websites.
Score Reporting Username and Score Reporting Password – For security reasons, the score reporting web sites
require that you register your callsign and password. Once you have done so, enter them in the textboxes provided.
Update Interval – Adjustable from 2 minutes to 60 minutes.

To be sure that your scores are being sent, check just above the lower text pane in the Info window. Each time a score is sent
and acknowledged by the server, you’ll see a notification there.

Broadcast Data Tab

External UDP broadcasts contain data communicated to other application programs running either on the same computer or
on a different networked computer. The use that is made of the broadcast data depends on the capabilities of the receiving
application program. Some examples include the sending of score data to an online score reporting website, bearing data to a
rotor control program, and contact data to a general-purpose logging program (either for logging purposes or to facilitate
lookup of other data available to that program). The data contents of these broadcasts are described in detail in the
Appendices > External UDP Broadcasts page.
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To enable external UDP broadcasts, before December 2015 some lines needed to be added manually to the N1MM Logger.ini
file, This editing function has now been incorporated in the External Broadcasts tab of the Configurer, shown above. If you had
been using External Broadcasts before this change, the contents of your existing External Broadcast section should be
reflected on the tab. For example, if you have IsBroadcastContact=True is in your existing ini file, then the Contact box on the
tab should be checked.

To set up your UDP broadcasts, you need to decide which broadcasts to enable, by checking the relevant box, and then fill in
the IP addresses and UDP ports to which you want each broadcast to go. Typically, UDP broadcasts are used to communicate
with other programs, so begin by reviewing the documentation of the program you want to communicate with, to learn what
port it wishes to receive data on. In most cases, the port number will be 12060, the default.

In filling in the IP Addresses and Port numbers for each broadcast, you need to put in the 4-part IP address, separated from
the port number by a colon. Each IP/Port pair is separated from the next by a single space, as shown in the example on the
tab.

You can start with IP address 127.0.0.1 (the PC you are running N1MM+ on) and add other PCs’ IP addresses. For each
receiving computer, separate the address and a port number with a colon (:), as in the illustration.

Typically, home networks are all one “sub-net.” Most home networks use either 192.168.0 or 192.168.1 to designate their
“sub-net”, plus a 3-digit number in the last section that identifies the specific computer. Usually, these numbers are
automatically assigned by the router through something called DHCP, though you may have the option to fix them in the router
software., and doing so will help to avoid confusion later .

You can send UDP broadcasts to all the IP addresses in the subnet by specifying 255 for the last section, or “octet”. For
example, 192.168.1.255 will send to all computers that are in the 192.168.1 subnet. Be sure you only use 255 in the last
section or octet, because if you put that number in one of the earlier/higher-order sections, you will risk broadcasting
to the internet. While eventually the packets will be discarded by the internet, it will not endear you to your ISP.

Broadcast Data Details
When properly configured, N1MM Logger+ sends external UDP packets to other applications. Details about those packets can
be found in the >Appendices >External UDP Broadcasts section of this documentation.

All Computers

This command is useful only in Networked Computer mode. When checked, together with Contact, at any station on the
network, that station will rebroadcast every contact that it receives to the UDP port specified. The XML format is the same as
for Contact.

Exercise caution when using this feature. Multiple, misconfigured stations with All Computers checked could result
in a circular network path.

Spots
N1MM Logger+ sends external UDP packets about spots (including spots generated internally as well as spots received from
telnet clusters) to other applications. Details about these packets can be found in the >Appendices >External UDP Broadcasts
section of this documentation.

Log data input from other programs

Note: In version 1.0.7860 and later, these settings have been moved from the Broadcast Data tab to a new WSJT/JTDX
Setup tab in the Configurer.

N1MM+ can accept log data from other programs, either using UDP packets (JTAlert, WSJT-X, JTDX), or TCP packets
(JTDX). To enable this in N1MM+ version 1.0.7845 or earlier, you need to check the Enable box in one of the two labelled
sections near the bottom of the window. You may also need to do some configuration setup in the sending program, WSJT-X
or JTDX (JTAlert does not need to be specially configured). If both programs are running on the same computer, the default IP
address and port number should work, but if necessary for more complicated setups, the IP address and port number can be
changed here.

If WSJT-X or JTDX is to be called up from the Window > Load WSJT/JTDX menu item in the Entry Window, then the upper
Enable check box must be checked, and the port must be set to 2237 (unless the port has been changed in the WSJT-X
settings). In the WSJT-X Settings window under the Reporting tab, in the area called “UDP Server”, the “Accept UDP
Requests” check box must be checked.

If the JT-modes program is to be run independently rather than called up from the Window menu, as is required by JTAlert and
some WSJT “clone” programs that cannot be called up directly from the Entry Window’s Window > Load WSJT/JTDX menu
(because they do not support the UDP server method that N1MM+ uses for this), then it may be necessary to change the port
number to 2333 (depending on the program). In WSJT-X, there is a :Secondary UDP Server” area (formerly called “N1MM
Logger+ Broadcasts”) at the bottom of the Settings window under the Reporting tab. When using WSJT-X from inside

3/4/25, 5:37 PM N1MM Logger+ Documentation



107

N1MM+, this area is not used (the Enable button in this area should be unchecked), but when WSJT-X (or other similar
program) is run independently, the Enable button may need to be checked and the port number in the N1MM+ Configurer
changed to match the port number in this area.

For more information on setting up and operating with WSJT-X or JTDX, see the >Window >WSJT Decode List page in this
manual.

Audio Tab
This tab is no longer available in current versions of the Logger. It exists only in the older Windows XP version of the program.

Introduction to Audio & Sound Cards

JTAlert cannot be used with Window > Load WSJT/JTDX
Note that if you are calling WSJT-X or JTDX up from within N1MM+, you cannot use JTAlert at the same time. This is
because it uses the same UDP port that N1MM+ uses, and the port cannot be shared.



Two Audio Methods
If you have checked the “Use Logger+ audio” menu item in the Entry window’s Config menu (not available in
Windows XP), the “Audio” tab will not appear in the Configurer. In its place, use the “Logger+ Audio Setup” menu
item in the Config menu to set up Logger+ audio.



Before We Start
Any time you change the Default sound card in your Windows Control Panel while N1MM Logger+ is running,
you must shut N1MM Logger+ down and re-start it. Otherwise, the program and the operating system may be on
“different pages”, and it can cause audio functions not to work or to work strangely. Moreover, any time that you
change the Windows Default sound card, you will have to come back to this tab and reset your audio options. You
can imagine how we found this out!
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Users of N1MM Logger Classic may recall when we deleted the QSO recording function from this tab in favor of a separate
recorder, QSOrder by K3IT. QSO recording is configured there, and not in the Configurer. Currently, the Audio tab in the
Configurer only controls settings that are used for playback of stored voice messages and for recording those messages. This
includes on-the-fly re-recording, such as might be required in contests for split SSB operation on 40 meters, for example.

If you are setting up this tab for the first time, a good beginning is to familiarize yourself with your computer’s sound card(s). At
the same time, you can assure yourself that all of your computer’s audio settings are correct for recording from your
microphone and playing back to your radio’s audio input (microphone or line). A step-by step procedure for doing so is in
the Interfacing section of Getting Started. A much more detailed treatment of the use of stored messages in SSB contests
is here.

Audio Output

1 – Only use Radio 1 Output Device, Output on both channels
One radio and one sound card, to play stored messages, record or re-record messages and mute the
microphone when playing stored messages.
Use this setting with two radios if you are using separate sound cards for the two radios.

2 – Two Radio, Output left channel on left radio, right channel on right radio
Use this setting if you are using a single sound card to play stored message files to two separate radios in SO2R
(one channel for each radio)

Tx Sound Card Setup

This is where it gets a little messy, largely because of differences in the way Windows XP handles sound cards, versus the
way they are managed in Vista, 7 and later. Let’s look at that a bit.

In Windows XP,

Select Radio 1 Output Device – Select the sound card to use for sending stored messages (.wav files) on Radio 1.

In Windows Vista and later operating systems, the pull-down list shows output (playback) ports available on the computer,
including those on multiple sound cards if more than one is available.

If there is a CODEC built in to Radio 1, choose that (CODEC is used here and elsewhere in this manual as a synonym for
sound card). If not, choose the Line Out or Speaker Out port on the sound card that is connected to Radio 1’s audio input.

In Windows XP, the pull-down list shows sound cards available on the computer; choose the built-in radio CODEC in Radio 1
or the sound card whose Line Out or Speaker Out port is connected to Radio 1’s audio input.

Select Radio 2 Output Device – Same as for Radio 1.

CODEC

Built-in sound card capability is just starting to appear in new-generation transceivers.

Radio 1 Output Device is an Internal Radio Codec – Check this box if you are using a CODEC built into Radio 1
instead of a separate sound card
Radio 2 Output Device is an Internal Radio Codec – Check this box if you are using a CODEC built into Radio 2
instead of a separate sound card

Select Port to Mute

Typically, this is used to mute the microphone during stored message playback, so you would select Microphone from the
drop-down list. The two options are for Radio 1 and 2, left to right

Select Message Recording Device

Select the sound card to use for recording stored messages for later playback on either radio. In Windows Vista and newer
versions, the pull-down list displays playbackports available on the computer. Choose a port that is on the sound card that

Running Windows XP?
If your computer is using Windows XP SP3, then this audio setup is the only one available to you. If you are using a
later operating system, you have the option of using either this setup or a new Logger+ audio configuration dialog,
which is found on the Config menu of the Entry window. If you check the option on the Config menu, you will note
that the Audio tab on the Configurer will no longer be visible, and you will need to use the Audio configuration dialog
which is on the Config menu. Conversely, if you are using XP, the Config menu entries will disappear. Full details on
the newer Logger+ audio will be found in the description of these menu items.
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you will be using to record SSB messages. In Windows XP, select the sound card that will be used to record SSB messages.

You may ask what playback ports have to do with recording – we’ll just have to ask you to trust us on this one. you must select
a device in order for recording ports to appear (see below).

Select Message Recording Port

Having selected the sound card device, use this pull-down list to select the recording port you will use on the selected sound
card device to record SSB messages. This is normally the microphone input

Recording Bits and Sample Rate

Recording Bits – this setting determines how your sound card digitizes analog audio levels – generally, the lower the
bit rate the smaller the file but also the lower the fidelity
Recording Sample Rate – This setting determines how your sound card digitizes analog audio__ frequencies. Select
the sample rate to record. The lower the rate the smaller the files but audio quality will be less.
Max Recording Length – Upper limit on the length of a recorded message, in seconds.

WSJT/JTDX Setup Tab
Starting in version 1.0.7860, settings related to WSJT and JTDX that were formerly under the Digital Modes tab and
Broadcast Data tab have been moved to a new WSJT/JTDX Setup tab in the Configurer:

Not All Sound Cards are Created Equal
The Configurer lets you pick parameters that your sound card may not support. If you choose a parameter that is not
supported by your card, you should see Error 4 in the status line of your Entry Window when you try to play back a
message, but under some circumstances, this may not happen. Our best advice is to verify that sample rates match
and test before the contest starts.

This can be tricky. Even though playback rate is not specified, some sound cards permit playback only of .wav files
recorded at a given sample rate, such as 44.1 or 48 KHz. Make sure your recording parameters match those, or you
will not hear any output from your recordings (don’t ask how we know).
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The top part of this page is where you set up the UDP port addresses for communicating with WSJT-X or JTDX. The IP
address is the IP address of the computer on which WSJT-X or JTDX is being run. In the most common situation where that is
the same computer on which N1MM+ is running, the IP address is the internal loopback address 127.0.0.1. Starting with
N1MM+ version 1.0.9600.0, support for multicast addresses (224.0.0.x or 239.x.x.x) has been included. This allows other
programs such as JTAlert and GridTracker to communicate with WSJT-X in parallel with N1MM+. The same multicast IP
address must be used in all of the intercommunicating programs (e.g. 224.0.0.1 for Radio 1, or in SO2R configurations,
224.0.0.2 for Radio 2).

In the normal configuration, when WSJT-X or JTDX is run from within N1MM+, the default port number is 2237. If you are in
SO2R mode and using WSJT-X or JTDX from the second Entry window (EW1), you need to configure a different UDP port
number for Radio #2 (EW2) (the suggested port number is 2239) – this port number will also need to be entered in the
settings for WSJT-X or JTDX for the second Entry window, since the default 2237 will not be correct for this copy.

If you are using a JT-mode program that does not support the communications method used between N1MM+ and WSJT-X or
JTDX and therefore cannot be called up from the N1MM+ Load WSJT/JTDX menu item, you may still be able to send log data
from that program to N1MM+ on another UDP port (usually port 2333). If you are using one of these programs, set the UDP
port for Radio #1 in the top part of this window to 2333 and ignore the other settings on this window.

If you are using JTDX, it needs to use a TCP port in addition to the UDP port. The settings for this are in the next part of the
window (you can ignore these settings if you are using WSJT-X). When running an external program, such as JTDX, using
TCP on the same computer as N1MM+, the IP Address will typically be the loopback address (127.0.0.1). When running an
external program using TCP on a different computer than N1MM+, the IP Address will be the address of the internet interface
on the computer running N1MM+, such as 192.168.1.101. The default TCP port for JTDX is 52001. In SO2R, the suggested
TCP port for the Radio 2 copy of JTDX is 52006, and the port number in the JTDX settings for the second Entry window
(EW2) will need to be changed to correspond.

The next part of this window is where the path to the WSJT-X or JTDX program is entered in order to enable the program to
be called from the N1MM+ Windows menu. The recommended way to enter this path is to click on the Select button and then
navigate in the File Open dialog window to the location of the wsjtx.exe or jtdx.exe program and click on the Open button. As
illustrated in the screen shot, SO2R stations can make both paths the same. There is also a box on the right side of the
window where other command line parameters may be entered; this is optional and in the majority of cases will not be used.
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At the bottom of the page are two check boxes to enable automatic startup of the WSJT Decode List window when WSJT-X or
JTDX is started up from the N1MM+ Window > Load WSJT/JTDX menu item. The second check box is only used for SO2R.

For instructions on using WSJT-X or JTDX together with the WSJT Decode List window, see the WSJT Decode List Window
section of the manual.
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Contest Setup Dialog
2019-04-08

Contest Setup Dialog
The Contest Setup Dialog – Basics
Open the Contest Setup Dialog window from the File menu of the Entry Window. Click on either File >New Log in Database or
File >Open Log in Database. Note that both of these choices include the name of the database that will contain this log.

Databases versus Logs
Before starting your first contest, you should understand how N1MM Logger+ stores contests and contacts. The two key terms
are Databases and Logs. As an analogy, think of your PC’s hard disk as a large room containing computer stuff. Into this
room, N1MM Logger+ places File Cabinets (Databases) and within those File cabinets, N1MM Logger+ adds individual
Folders (Logs). For each contest that you operate, you will add a new Log to hold the contacts for that contest. Your large
room with computer stuff can hold as many File Cabinets (Databases) and as many Folders (Logs) as you want – until, of
course, your hard drive is full.

Continuing our File Cabinet and Folder analogy, there are many methods by which you can arrange your file cabinets
(Databases). Here are some examples:

DATABASE PER CONTEST TYPE – Some hams prefer to create a Database for each major contest type. The
Databases folder in your N1MM Logger+ user files area might contain databases (>File >New Database) named
CQWW.s3db, ARRLDX.s3db, ARRL160.s3db and CQWPX.s3db. When setting up each contest, you >File >Open
Database corresponding to the contest to be operated, then >File >New Log in Database for that particular contest.
One of these databases could contain CW, Phone, and RTTY logs from 2017, 2018, and 2019… for that particular
contest. You might want to add a database like MISCELLANEOUS.s3db for the smaller contests or contests that you
only plan to operate a couple of times.
DATABASE PER CALENDAR YEAR – Some hams create a new Database each year. At the beginning of each year,
you >File >New Database to create a database named. For example, K8UT_2016.s3db, K8UT_2017.s3db or
K8UT_20186.s3db. In each database would be the contest logs for every contest you operated during that year. When
setting up each contest, you would >File >Open Database for the correct year, then >File >New Log in Database for a
particular contest. This method of database naming would contain all contests (CQ WW, ARRL DX, CQ WPX…)
worked during each year.
DATABASE PER EACH CONTEST – Some hams create a new Database each time they operate a contest. The
Databases folder in your N1MM Logger+ user files area would contain lots of databases – one for each contest that
you operate. When setting up each contest, you would >File >New Database, and then within that database you would
>File >New Log. Although some hams find this the easiest method to understand, managing all of those files after
many years may become a problem.
DATABASE FOR EACH DIFFERENT CALL SIGN – If you use more than one call sign (including club call signs as
well as call signs with modifier suffixes or prefixes, such as W1ABC/3 or ZL/G4ABC), then you should create a
separate database for each new call sign. The call sign used over the air is stored in the Call field in the Station
Information dialog, and this is what controls the sent call sign field in each line of the Cabrillo file as well as the call sign
sent by the {MYCALL} and * macros.

These aren’t your only Database/Log options, but perhaps one of them matches the way your brain works. How about
organizing your logs by mode: CW.s3db, PHONE.s3db, DIGITAL.s3db? N1MM Logger+ can do any of these – choose the

There Are Contests, and Then There Are Contests
As it is generally used in ham radio, the word “contest” refers to a competitive operating event of some kind. As the
term is used in N1MM Logger+, it can refer either to such an event or to a specific occurrence of a particular event,
for which you have set up a log. You can have an unlimited number of CQWWCW “contests” (distinct contest logs) in
a single database – it might be better to call them “contest instances”, but it is probably too late to find and correct
every use of the term according to its meaning in context. In virtually all cases, what is meant will be obvious from
context.
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method that provides the easiest way for you to create new logs before the contest and find your old logs after the contest.

What Else is In a Database?

In addition to your QSOs, there are a number of tables in the database that contain data that may, and probably will, vary from
one contest to the next. These include such things as multiplier lists for particular contests, assigned function key definitions
for CW, SSB and digital modes, the contents of the last wl_cty.dat file that you loaded, and a Call History table (if one has
been loaded).

Why should you care? For several reasons:

If you modify the function key definitions while operating, that modification applies only to the current database. Each
database only has space for one set of function keys for each mode, one Call history file, one set of Telnet buttons, and a
pointer to one master.scp file in the program directory.
When you switch to another database, those definitions (and in particular, any changes you made) are left behind. That’s why
the program provides for exporting function key definitions (among other things) to text files, which can then be loaded into the
database as needed. You can label these text files in a contest-specific way so that it will be easy to find when you set up for
the next time.
Master.scp files may change from contest to contest, too. You don’t have to load them into the database, but you do have to
make sure that you have pointed to the appropriate file for each contest. That is one reason for the Associated Files tab in the
Contest Setup dialog – so that when you switch contests, the files you need (or pointers to them) are automatically loaded.
The same thing applies to Call History files. One common error that Call History users often make is to forget to load the
appropriate file into the database. They set up a contest and find they are getting the wrong information about stations they
work because the Call History table still contains data that is appropriate for a different contest.

The takeaway is this – when you change contests within a database, or change databases, your function keys, master.scp file,
Call History file, and Telnet buttons will still be those from the last contest you worked using that database, UNLESS you have
identified the appropriate files on the Associated Files tab while setting up the new contest.

N1MM Logger+ uses SQLite as its database engine, and uses one database for storing contest logs and other databases for
storing administrative data. What this means is that in addition to the databases that contain your contest logs, there are also
other databases in the same Windows \databases directory that the program uses for other purposes. If you don’t know what
a database file is used for, don’t delete it. Also, do not try to open the file called “Do_Not_Use_Or_Erase.s3db”. Just leave it
alone, like the file name says.

Create a New Contest Log
After verifying that you’ve opened that desired active database, create a new contest log in that database by selecting >File
>New Log in Database. This opens the Contest Setup dialog window.

The dialog window will open with the name of the most recent contest highlighted in the list.

Click the downward-pointing arrow to the right of the current contest name (called the “handle”) to open a list of all supported
contests.
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You can search alphabetically by pressing the first letter of a contest’s short name, and then scrolling to find the right
one, or else repeatedly pressing the first letter until you get there.

A list of supported contests can be found on the website in the Supported Contests List . Click in the web page Sponsor Link
column to check the sponsor’s latest rules. Click in the Setup Link column to navigate directly to specific N1MM+ setup
information on the Contest Setup Instructions page.

Start Date

The Start Date distinguishes between multiple versions or instances of a given contest in your database. Always enter the
correct start date for each contest log so that you will be able to differentiate between multiple logs of the same contest that
are stored in the same database.

When you create a new contest log, the program estimates a Start Date by looking forward from today’s date to the
next day of the week on which the program expects that the contest will start, and the correct start time. This may (or
NOT!) be the actual start date of the contest. Year to year, dates of contests change, but the day of the week usually
remains the same. In the example above, a new CQWWSSB contest was created during the week of April 14. The
program defaulted the start date and time to 0000Z on the following Saturday, April 19 (which is the right day –
Saturday – but is not, of course, the correct date for the actual CQWWSSB contest).
To edit the Start Date (and time, if necessary), single-click on the date in the Start Date box.

To avoid confusion, it is easiest to set up the log you will actually use within a week before the start of the contest, or else to
change the Start Date for that log to the correct date for the contest. If you want to practice ahead of time, you can set up a
practice version of the contest with a different start date and/or time. As long as it is in the same database, you’ll be able to set
goals, set up your function keys and other associated files, and all of this will be remembered when you set up the “real” log.
Just delete the practice log (or leave it in the database – no harm done, except for a bit of wasted space) and you’re ready to
go.

Showing the Long Name of the Contest
Sometimes it is difficult to choose a contest based solely on its short contest acronym. Contests have longer display
names that will show in a tool tip if you use the up/down cursor keys to scroll through the list of contests. This can
make it easier to decide which contest type to select.



Looking for a User Defined Contest?
There are more than 250 User Defined Contest definitions available from the website that do not automatically appear in
this dialog window. Refer to the Setup User Defined Contests instructions .


Unexpected Side Effects of the Wrong Start Date
In addition to distinguishing between multiple instances of a contest, the Start Date also affects calculation of on-off
times and contest goals. If you set the Start Date to the wrong day of the week, then for purposes of computing time
on or off the air and for displaying any goals you have set in the Info window the program will assume the contest
starts at the time and day of the week of the Start Date you entered.
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Open an Existing Contest Log
To open an existing contest log in the currently selected database. Select >File >Open Log in Database. Note that the
textbox is captioned “Select Existing Log.”

The title line of the Contest Setup Dialog window will display the name of the current database, below which will be a
list of all the contest logs in that database
The contest logs will be listed in reverse chronologic order by Start Date (newest at the top, oldest at the bottom)
The contest log that is currently open in N1MM will be highlighted
Contest-specific changes can be made in the Contest and Associated Files tabs. More information in the paragraphs
below.

When you highlight a contest log in the list, the number of contacts in that log is displayed in the Contest tab below the list
box, over to the right just above the box that says “State for Log Type QSOPARTY”. You can use this to tell whether this is a
new contest log that hasn’t been used yet, or maybe a test log that you created in order to log a few dummy contacts and
check out the operation and setup, versus a real contest log with a large number of contacts in it.

You may wish to delete a test log with only dummy contacts in it, or perhaps a log that you set up in anticipation of a contest
and then never actually logged any contacts in. To delete a contest, highlight (single-click) the contest in the contest pane, as
shown above, so it is selected. Then press the <Delete> key. For example, the CQWWCW contest in the screen shot above is
selected and can be deleted by pressing the Delete key.

Contest-Specific Information
Below the contest selection area is a section where you define your entry in this particular running of the contest. This is
further divisible into Categories, Sent Exchange, Operators and Soapbox Comments

Of these, the first is Categories – are you single op or multi-op, high or low power, and so on. Depending on the contest you
will see one of two lists of categories to be chosen. This is because some contest organizers (the ARRL and IARU in
particular) have adopted the Cabrillo 3.0 format for contest entries, while the others continue to accept Cabrillo 2.0. The
Cabrillo file headers are different, requiring different lists.

These lists may seem a bit daunting at first, but remember a couple of things. You can always change your selections before
the contest if things don’t come up as you expect them to, or after the contest if you have trouble getting the contest organizer
to accept your Cabrillo entry. As a last resort, you can use a text editor on the header of the Cabrillo file.

Don’t Make This Mistake!
Deleting a contest permanently removes the contest and all of its QSOs from the database; you won’t be able to
recover them. By contrast, if you delete individual QSOs from a contest log, they are not really deleted, just moved
from the contest they were logged in to the DELETEDQS contest where you can still get at them if you need to. But if
you remove an entire contest, those contest QSOs are gone, gone, gone!
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Always check these entry categories. Some of the defaults may not be correct for your entry in the new contest you are
setting up.

Contest Tab

Operator Category

Make a choice for your situation. Choices in Cabrillo 2.0 contests are:

SINGLE-OP
SINGLE-OP-ASSISTED
MULTI-ONE

In CQWW and some other contests, you will be asked whether this station is a Run or a Mult station
MULTI-TWO

An identifier is needed for Station 1 and Station 2 that must be specified when setting up initially in this category.
Each time the program is loaded or the contest changed, the program will ask you to specify Station 1 or 2

MULTI-MULTI
SCHOOL-CLUB
CHECKLOG
SINGLE-OP-PORTABLE
ROVER

If your entry is in this class, selecting Rover will enable some useful additional functions.
MULTI-UNLIMITED
MULTI-LIMITED
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Band Category

Make a choice for your situation. Choices are:

ALL
160M
80M
40M
20M
15M
10M
LIMITED
CHECKLOG

Power Category

Make a choice for your situation. Choices are:

HIGH
LOW
QRP
MEDIUM

Mode Category

Make a choice for your situation. Choices are:

CW
SSB
RTTY
PSK
MIXED – both CW and SSB are allowed in this contest. The band buttons in the Entry window will show one column
each for CW and SSB
DIGITAL = no CW & SSB, just RTTY and/or PSK (defined by the contest)
MIXED+DIG = CW & SSB & Digital all allowed

Overlay Category

Used in relatively few contests. In Cabrillo 3.0 contests, only N/A, TB-WIRES, NOVICE-TECH, OVER-50 and ROOKIE are
valid. Choices are:

N/A (default)
ROOKIE
BAND-LIMITED
TB-WIRES (tri-bander and wires)
OVER-50
HQ
NOVICE-TECH
EXPERT – The EXPERT overlay category in contests where it exists must be selected for the 5 minute band change
counter to be inactive for SINGLE-OP stations.

In CQ WPX CW and CQ WPX SSB, category overlay may be any combination of ROOKIE, BAND-LIMITED, or TB-WIRES. In
STEW PERRY, the category overlay may be OVER-50. In IARU-HF and RSGBBERU, the category overlay may be HQ. In
PACC the category overlay may be NOVICE-TECH.

The following items are required by Cabrillo 3.0

Station Category

Choices are:

FIXED
MOBILE
PORTABLE
ROVER
EXPEDITION
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HQ
SCHOOL

Assisted Category

ASSISTED
NON-ASSISTED

Xmitter Category

ONE
TWO
LIMITED
UNLIMITED
SWL

Time Category

N/A
6-HOURS
12-HOURS
24-HOURS

Assisted Category

Xmitter Category
Time Category

Sent Exchange

The primary purpose of this entry is to determine what will be exported to Cabrillo files as your sent exchange. It does
not necessarily determine what will be sent from your function key messages, unless you choose to use the {EXCH}
macro in your exchange messages
Sent exchanges are defined for each contest. Look in the Supported Contest Setup instructions for guidance. Usually a
serial number, zone, state etc
Do not put 59, 599, or RS(T) information in the Exchange field

If the Exchange is a serial number

Enter either the expression 001 or a single # character in the Sent Exchange box in the Contest Setup dialog. Note that
001 is not a program macro and will not work correctly in function key messages – the only place it should be used is in
the Sent Exchange box

Starting with a Serial Number other than Zero

Some contests which have more parts/sessions there is the need to start a next session with the next number given in
the previous part. So how not to start with 001?
There are two workarounds:

Start second part as a separate contest and make the first QSO with number 001 and log it, then correct (Ctrl+Y)
to proper sent number
Start second part as a separate contest, enter fake QSO, open QSO in EDIT window, change SENT number
from 001 to last number you sent in the previous part of the contest, save changes, et voila, it’s done. When a
couple of real contacts have been entered, delete the fake QSO

Using a Serial Number Server

N1MM logger supports a single sequence of serial numbers for SO2R, MS, M2 and MM.

No RST in the Exchange
Do not put a signal report in the sent exchange. It will cause incorrect Cabrillo output. Typically, the program will warn
you if you make this mistake.
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The serial number is reserved in S&P mode when the cursor leaves the callsign field or the Exchange key (F2 default) is sent
either through spacing, tabbing, hitting Enter in ESM or pressing the Exchange Function Key. This is needed so you can enter
calls to check for dupes while not reserving a serial number

The serial number is reserved and displayed in Run mode as soon as you enter a letter in the call-sign field. This is because
on SSB people frequently talk before they type, and they need to see the serial number displayed earlier.

In SO2R and SO2V, typing Alt+W (wipe) after a serial number has been reserved or clearing the entry window through QSY
will “un-reserve” that number.

Because of the way the serial number server works, there are a few cautions:

Serial numbers issued by the second radio may be out of time sequence with those issued by the main one. This
occurs because certain program actions cause a serial number to be reserved for the use of a station, and if that
station does not use that number until after the other station has made several QSOs, when the log is viewed in
chronological order the serial number will appear to be out of order. I don’t think there is anything to be done about this
For similar reasons, depending on operator actions at one or the other station, such as shutting down the program
while a number is reserved, there may be some gaps (numbers not issued) when reviewing the final log
The most important aspects of serial numbering are that the serial sent to a station be correctly logged, and that there
be no duplicate serial numbers sent; the intent is always to meet both these criteria
Sometimes it’s possible a number will be skipped when given out but not used (example: QSO not made after all or
deleted). Contest committees do accept this behavior!
The maximum sent number to give is 32767. The maximum received number is 99999

Addendum by Steve, N2IC

Let me say a few words about the way serial numbers are “reserved” in N1MM Logger. For the sake of this discussion, I’ll
assume that ESM is being used.

When you enter a callsign in the Entry Window, and hit the Enter or Space key, a serial number is reserved and locked-in to
that QSO. If it turns out that the QSO is not completed and logged, that serial number is “lost”, and will be not used for a
subsequent QSO.

This gets to be especially interesting with SO2R and SO2V. Let’s say you are running on Radio 1, and search-and-pouncing
on Radio 2. You enter a call on Radio 2, and hit the Enter key, reserving a serial number on Radio 2. You get beaten out on
Radio 2, and go back to running stations on Radio 1, advancing the serial number beyond the number reserved on Radio 2. A
few minutes pass, and you finally work the station on Radio 2. Your log now appears to have non-sequential serial numbers. If
you never work that station on Radio 2, the reserved serial number on Radio 2 is lost, and will not be used for any subsequent
QSO.

I can’t speak for all contest sponsors, but for Sweepstakes and CW/SSB WPX, this is not an issue. There is no problem for
these log adjudicators if your serial numbers are out-of-sequence, or if there are missing serial numbers in your log. Your log
will be correctly processed. In addition, the N1MM Logger Summary window reports the correct number of successfully
completed QSO’s.

In summary, stop fretting about out-of-sequence or missing serial numbers. The software is working as designed

Operators

Enter here all the operators’ callsigns
Update Ops from Log – If you have been using Ctrl+O or OPON to enter operator callsigns in the log, clicking the
button ‘Update Ops from Log’ will transfer all operators from the contest log to the Operators field

Soapbox comments

Your comments on the contest, results, propagation etc., for inclusion in your Cabrillo submission. This text is cleared
when selecting a new contest.

What Do Sponsors Look For?
Most sponsors are more interested in serial number accuracy than in serial number time order. If you think about it, it
is impossible to guarantee the order of serial numbers in a two radio situation. This assumes that you always log the
time when the QSO is added to the log, which is the right time from a rules point of view. i.e. end of contact.
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Section Lists

When operating a state QSO Party, select the State from the drop-down list. If in doubt, click on the Import Section List
button to make sure you have the most current list of county abbreviations:

These selection buttons are only shown when the contest has a section list (like QSO parties)
In the example above the state QSO party for CA (California) has been selected
The Edit Section List button is used to edit the list

This function edits the section table in the current database. It does NOT edit the section text file. If you want to
export your section file after editing, use the File export menu link in the upper left corner of the Edit Section List
dialog

The Import Section List button is used to import a new list from a file. Section list files are stored in the SupportFiles
folder in your N1MM Logger+ User files area, or in a subfolder of the SupportFiles folder
There may be two section lists, for in-state or in-country and for other entrants. You will be prompted to import both
section lists if more than one exists
The appropriate section list is used to determine multipliers (States, Provinces etc.) for the contest, which will be shown
in the Multiplier window
The name of the list is hardcoded and will be shown while importing the file
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Associated Files Tab

For each of the following Associated Files, the Change and Clear buttons have the same function – the Change button allows
you to select or change the file to be used. The Clear button lets you clear the filename if you don’t wish to load one.

Function key files are stored in the FunctionKeyMessages folder within your N1MM Logger+ User files area. You can create
subfolders within this folder, but you cannot load or save function key files from the program into a folder that is outside this
folder. You cannot clear the function key file entirely; if you are not using a contest-specific function key file, or for modes that
are not included in the contest, just set the file to the mode-specific Default Messages.mc file (as in the example above for the
SSB and Digital message files).

CW Function Key Filename – Select the CW function keys to use with this contest
SSB Function Key Filename – Select the SSB function keys to use with this contest
Digital Function Key Filename – Select the Digital Interface function keys to use with this contest from the Entry
Window (Note that there may be additional function keys that can be defined within the Digital Interface window.)

Change Button checks for new files on the website
The [Change] button will check the website for Function Key and Call History files with a filename that matches the
contest name. When there is a match, the program will open a dialog window asking if you want to download and
assign that file to this contest. To prevent you from harm – for example, overwriting a Function Key .MC file that you
customized with personal preferences – any existing file of the same name will be archived with a .BAK designation.
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Master.scp Filename – Select the master.scp file for this contest type. Normally this will be the Default file, but some
contests may use a restricted version. Use the Change button to select a different file, or the Default button to return to
the default. Master.scp files are stored in the SupportFiles folder (or a subfolder of that folder) within the N1MM
Logger+ User files area
Call History Filename – You can select a Call History file to be loaded for use with this contest. This is entirely
optional. See the manual section on Call History Lookup for details. If you want to use a Call History file, don’t forget
to turn on Call History Lookup on the Config menu. Call History files are stored in the CallHistoryFiles folder (or a
subfolder of that folder) within the N1MM Logger+ User files area
Goal Filename – You can select an optional Goals file to be loaded for use with this contest. The Goals file is used for
the Goals area in the Info window. Goals files are stored in the GoalFiles folder (or a subfolder of that folder) within the
N1MM Logger+ User files area

Download the latest Country (wl_cty.dat) and Super Check Partial (master.scp) files before each contest
Be sure always to load the most recent supporting files before each contest. Both of these files can be downloaded
and installed from the Entry Window’s >Tools menu (an Internet connection is required). The program will warn you if
you open a database whose CTY table is older than the wl_cty.dat file in your N1MM Logger program directory.
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Key Assignments – Keyboard Shortcuts
2019-03-29

Key Assignments – Keyboard Shortcuts
Key Assignments Short List
Key Assignments Short List

Table of Shortcut Keys by Operating Mode (RUN vs S&P)
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Running keys S&P keys

F1 = CQ Shift+F1 = Call CQ and switch to run

; or insert = Send call and report Alt+U= Toggle S&P/Run. Set CQ-frequency for
pass

‘ = Send TU message and enter in log Alt+Q = Return to CQ-frequency

Alt+R = Enable CQ repeat Ctrl+Up/Dn arrow = Grab next qso from bandmap

Ctrl+R = Set repeat time Ctrl+Alt+Up/Dn arrow = Grab next mult from
bandmap

Esc = Stop sending, stop repeat –

General keys Radio control

Ctrl+O = Set operator call (or OPON in Callsign field) Alt+F10 = Swap VFOs

Ctrl+N = Add note to log Alt+Q = Return to CQ frequency

Ctrl+W or Alt+W = Wipe entry fields. Release a reserved serial
number. Ctrl+W is irreversible, Alt+W can be reversed by typing it
again

Alt+F8 = Return to last frequency

SPACE or TAB = Move between logging fields. Space skips past the
RST fields, Tab moves through them Ctrl+PgUp/PgDn = Up/Down a band

ENTER = Log it (see ESM mode) Type CW/USB/LSB/RTTY = Change mode, Type
frequency in KHz = Change frequency or band

Ctrl+Q/A = Quick edit previous or next call Ctrl+S = Set radio into split Ctrl+Alt+S – Toggle
split mode

Ctrl+D = Delete last qso. Asks for confirmation Ctrl+Enter = Set split frequency

Alt+H = Show help Alt+F7 = Set split frequency or offset to specified
frequency

Alt+K = Edit message buttons Alt+’ = Toggle between the wide and narrow filters

Ctrl+Alt+Enter = Log a not accepted qso (invalid exchange, usually) Alt+F12 – Copy frequency and mode to other
radio/VFO. Some radio-specific differences.

– Backslash ( \ ) = Change Receive (RX) focus
(VFO/Radio)

DX Spots and Band Map ESM Mode

Mouse wheel = Zoom in/out bandmap Ctrl+M = Turn on/off

Keypad +/- = Zoom in/out bandmap Insert or ; = Send call and exchange

Alt+D = Remove spot showing in the call frame or call textbox Enter = Send TU and log it

Alt+P = Send spot Enter = Start CQ again…

Ctrl+P = Send spot with comment Alt+Enter = Log without sending anything

Ctrl+Tab = Toggle to/from packet window Multi-User Mode

Alt+O = Store contact in the Bandmap Alt+Z = Set pass frequency (broadcast to all
computers)

Alt+Q = Jumps to the CQ frequency on this band –
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SO2R Specific radios / Rotor control

Backslash ( \ ) – Two radios = Change Receive (RX) focus FT-1000MP + FT1000D + some Icom Dual Watch
radios Alt+F12= Dual Receive toggle

Pause = Swap both Transmit and Receive/Keyboard focus –

Ctrl+Enter = Send next ESM state on alternate radio TenTec Orion Alt+F12 = Toggle Main/left
Sub/Right and Active in both ears.

Ctrl+F1 to F12 = Send message on alternate radio –

Ctrl+B = Dueling CQ’s Rotor control for the callsign in the Entry
window

` (Back-quote) = Toggle Stereo/Mono ( LPT pin 5) Alt+J – Turn rotor to bearing

Alt+L – Turn rotor to long path bearing –

– Ctrl+Alt+J – Stop turning the rotor

Table of Shortcut Keys by Transmit Mode

CW SSB RTTY VHF

Page Up = speed up Ctrl+Shift+F1 =Record
CQ Alt+G = Grab call from stack Alt+minus = Toggle

grids

Page Down = speed down Ctrl+Shift+F* =Record F-
key message Alt+T = RX/TX toggle Ctrl+E = Send

message to stations

= = send last Fkey again NB. Same keys again to
stop recording Ctrl+Arrows = Swaps DI –

Shift +Fx = send opposite mode
Fx Same Same Same

Ctrl+K = toggle CW window – Ctrl+K = toggle manual window Alt+Z = Set pass
frequency

Esc = Stop sending immediately
and close window – Esc = Stop sending immediately

and close window –

Note: The keys below work from all main windows

General Key Assignments
Space – The spacebar will jump from field to field filling in defaults like the callsign from the call-frame, 59/599, and
information from previous contacts with this station. Skips over signal report fields. SPACE IS THE PREFERRED TAB
CHARACTER.
Tab – Jump to the next entry field in the Entry Window, including signal report fields (the “S” digit in signal report fields
is highlighted to enable quick overtyping, e.g. to change 599 to 579, etc.)
Shift+Tab – Jump to the previous entry field in the Entry Window.
Alt+H – open Internet help. Most windows have contest-specific help accessible from their right-click menus.
Ctrl+Tab – Toggle between the Entry window and the Packet window.
Alt+F9 – toggle through all the antennas defined for the current band. The selected antenna will show in the lower-left
corner of the status pane.
Alt+F4 – Quit the program. If two Entry windows (SO2R) the program will not exit. You are being asked if you are sure.
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Active Radio/Bandmap Control Key Assignments

Jump to Spots

Note: If you are operating single mode, your mode won’t change when jumping between spots.

Ctrl+Down Arrow – Get next spot higher in frequency.
Ctrl+Up Arrow – Get next spot lower in frequency.
Ctrl+Alt+Down Arrow – Get next spot higher in frequency that is a multiplier.
Ctrl+Alt+Up Arrow – Get next spot lower in frequency that is a multiplier.
Shift+Alt+Up Arrow – Get next spot lower in frequency that is self-spotted.
Shift+Alt+Down Arrow – Get next spot higher in frequency that is self-spotted.

Jump to CQ Frequencies

Alt+Q – Jumps to the last CQ frequency on this band (active bandmap) and will clear all textboxes in the Entry
Window.
Shift+Alt+Q – Jumps to the last CQ frequency on other band (non-active bandmap).
Ctrl+Alt+Q – Jumps to your last used CQ frequency on any band and tune active bandmap to that frequency.
Alt+F8 – Return to your previous frequency (you can use this to “undo” Alt+Q).

Tune the Radio

Ctrl+Page Up – Go up one band. WARC bands are skipped while logging for a contest.
Ctrl+Page Down – Go down one band. WARC bands are skipped while logging for a contest.
Up Arrow – Tune radio down 100 Hz on SSB, 20 Hz on CW (adjustable in the configurer).

FT-1000MP, FT-890, FT-920, FT-990 and FT-1000 and many other radios
In S&P – pressing the up/down arrows will turn off RIT and tune your main VFO.
In Running mode – it will turn on your RIT and tune the RIT.

Down Arrow – Tune radio up 100 Hz on SSB, 20 Hz on CW (adjustable).
See Up Arrow information above

Mouse wheel – With the mouse in the Entry Window, QSY the radio using the same increment as the Up/Down arrow
keys

Alt+Mouse wheel – With the mouse in the Entry Window, QSY to the next round-number frequency rounded off
to 1 kHz
Ctrl+Mouse wheel – With the mouse in the Entry Window, QSY to the next round-number frequency rounded
off to 10 kHz
Ctrl+Alt+Mouse wheel – With the mouse in the Entry Window, QSY to the next round-number frequency
rounded off to 100 kHz

Alt+F7 – Set split frequency or offset from current frequency for the active radio. When hitting Enter or click OK with
nothing on the line split will be cleared. Press ESC or click Cancel to exit. More information about working split can be
found in the Single Operator Split Operation chapter.
Ctrl+Enter – Entering a frequency or offset in the callsign field and entered with Ctrl+Enter will set a split frequency.
Alt+S – When your rig is in the split mode, Alt+S will reset the RX frequency back to your transmit frequency, but the
split mode is preserved. “Reset RX frequency when running split” is associated with Alt+S. When invoked, the program
will automatically do an Alt+S as you log each QSO. Operates on VFO-A only!
Ctrl+S – Set radio to split operation, if not in split mode already.
Ctrl+Alt+S – Toggle Split mode on the radio. ‘Split’ will be shown in the Entry window.
Alt+F5 – Swap radio frequency, mode, and callsigns between VFOs (SO2V) or radios (SO2R). In SO2R, the receive
focus changes to the non-active radio.
Alt+F6 – SO2R only command. Identical to Alt+F5 except the receive focus does not change.
Alt+F8 – Jump to your last frequency.
Alt+’ (Alt+singlequote) – toggle between the wide and narrow filter for the selected mode (SSB, CW and Digi modes).
Ctrl+Alt+D – Allows the SO2V user to enable CQ repeat, call CQ on VFOA, and tune the sub-receiver (VFOB)
between CQ’s. Currently, this feature is only enabled for the K3, IC756, IC756Pro, IC756Pro2, IC756Pro3, IC7800, and
IC7600.

If “Sub Receiver Always On” is ON and the Sub RX is ON, turn “Sub Receiver Always On” to OFF and leave the
Sub RX ON
If “Sub Receiver Always On” is ON and the Sub RX is OFF, turn “Sub Receiver Always On” to OFF and leave the
Sub RX OFF
If “Sub Receiver Always On” is OFF and the Sub RX is ON, turn “Sub Receiver Always On” to ON and leave the
Sub RX ON
If “Sub Receiver Always On” is OFF and the Sub RX is OFF, turn both ON
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Change Keyboard & Radio Focus

Ctrl+Left arrow – Move both TX and RX/Keyboard focus to VFO A or in SO2R to left radio
Ctrl+Right arrow – Move both TX and RX/Keyboard focus to VFO B or in SO2R to right radio
Alt+F10 – Swap between VFOs when using one radio (VFO A-B). On Icom 756 and 7800 toggle between Main and
Sub frequencies.

Command is disabled during SO2R for Icom radios that lack a swap VFO CAT command. This is because the
program is unaware of Icom VFO B frequency in SO2R mode.

Pause – Swap radios and match keyboard to radio.
Backslash ( \ ) – Move RX focus and launches a second Entry Window if only one Entry window is open (not
supported for SO1V).

SO2V – One radio – 2 VFOs – Moves RX focus between the 2 VFOs on the radio.
SO2R – Two radios – Moves RX focus between the 2 radios.

Other Nifty Tricks

Numeric keypad + (plus) – Zoom in the bandmap which has KEYBOARD focus to show fewer stations (less
bandwidth).

You can also zoom in by using the mouse wheel when the mouse is over the Bandmap window
Numeric keypad – (minus) – Zoom out the bandmap which has KEYBOARD focus to show more stations (more
bandwidth).

You can also zoom out by using the mouse wheel when the mouse is over the Bandmap window
Ctrl+T – Turn on the radio and send continuous CW (tune). Ctrl+T again or the Escape key ends the transmission.
Alt+F12 – Most radios use this command to copy frequency and mode to other radio/VFO.

A few radios use Alt+F12 for specific features and then mostly swaps MAIN and SUB using the CAT radio
command
FT-1000MP + FT1000D + Elecraft K3 + Icom IC-756 series, IC-781 ,IC-775 and IC-7800 only

Dual Receive toggle. NB. Only turn Dual Receive on/off from the keyboard so it stays in sync with the
program.

TenTec Orion
Toggle between Main/left Sub/Right and Active in both ears.

` (backquote or grave accent)
SO2R mode,Toggle Stereo/Mono ( LPT pin 5). If MK2R or OTRSP is enabled send stereo commands to the
external SO2R controller.
SO2V mode, some radios containing Dual Rx have specific functions assigned to this key. See the Supported
Radios section for the specifics.
SO1V mode, some radios containing Dual Rx have specific functions assigned to this key – such as enabled the
Sub-Receiver. Otherwise this key is disabled in SO1V.
Backquote (grave accent) can be found on US keyboard as the unshifted tilde ~

= (equal key) – Will send the last message key (F1-F12) again.
Alt+F11 – Disable/Enable the switching between RUN and S&P. In a networked environment with more than one RUN
station on the same band, the switch to S&P must be disabled. This is also used during DXpeditions to stay in Run
mode all the time and not jump inadvertently to S&P mode when you QSY a small amount and don’t call CQ. This
behavior can be toggled using the Alt+F11 key and the state will be indicated in the Entry window status bar. Look for
“Run/S&P auto-toggle disabled” or “S&P and Run Mode enabled”.

Non-Active Radio/Bandmap Control Key Assignments

Jump Non-Active Radio to Spots

Ctrl+Shift+Down Arrow – Get next spot higher in frequency and will skip over CQ-Frequency when radios/VFOs are
on the same band. Proper keystroke operation is radio dependent. Disabled for SO1V.
Ctrl+Shift+Up Arrow – Get next spot lower in frequency and will skip over CQ-Frequency when radios/VFOs are on
the same band. Proper keystroke operation is radio dependent. Disabled for SO1V.
Shift+Ctrl+Alt+Down Arrow – Get next spot higher in frequency that is a multiplier. If you are operating single mode,
your mode won’t change when jumping between spots. Disabled for SO1V.
Shift+Ctrl+Alt+Up Arrow – Get next spot lower in frequency that is a multiplier. If you are operating single mode, your
mode won’t change when jumping between spots. Disabled for SO1V.
Shift+Alt+Q – Jumps to your last CQ frequency on the inactive VFO/radio.

Tune the Non-Active Radio

Ctrl+Shift+Page Up – Go up one band.
Ctrl+Shift+Page Down – Go down one band.
Shift + Numeric keypad + (plus) – Zoom in the inactive bandmap
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Shift + Numeric keypad – (minus) – Zoom out the inactive bandmap

Logging Key Assignments
Enter

Log contact, when ‘Enter sends message’ is off in config menu.
Sends message when ‘Enter sends message’ is on in config menu. The send messages depend on the field
values i.e. in which field the cursor is in the Entry Window. Check the highlighted keys.

Space – Preferred character to move sequentially through Entry Window fields .
Jumps from callsign to Exchange field or vice versa.
Other fields’ default values will be filled in
If there is a call on the callsign frame and if the callsign field is empty, the call from the frame will be placed in the
callsign textbox.

Alt+Enter – Send End of QSO message key and log the contact. In ESM it just logs the contact (nothing sent).
Insert or ; – Sends His Call key followed by the Exchange key.
‘ – Send End of QSO message and enter in log .
Alt+W (reversible) or Ctrl+W (irreversible)

Wipe Out Entry Fields, clear information about the current contact in this window
(Alt+W only) If nothing new has been typed in since a previous wipe operation and all of the entry fields are still
blank, Alt+W restores the last wiped contact (“unwipe” function), unless the original wipe was done using Ctrl+W
(irreversible wipe)
Serial number contests: Release the previously-reserved serial number

Ctrl+Shift+W – Wipe out other window’s contact information.
Ctrl+Alt+Enter – Log a not accepted ‘invalid’ qso (invalid exchange etc.). It will prompt for a comment. Use ‘View |
Notes’ to find the QSO for later correction.

When no comment is entered “Forced QSO” will be added to the comment field.
Ctrl+Y – Edit last contact.
Ctrl+D – Delete the last contact.
Alt+O – Store contact in the bandmap.
Alt+M – Mark this frequency in the bandmap as being in use.
Alt+D – Removes the spot from the bandmap which is on the callsign frame or in the callsign field in the Entry window
when S&P or CQ-frequency when Running.
Ctrl+F – Find the callsign entered in the callsign field in the log. Pressing Ctrl+F again will find the next instance.
Ctrl+M – Enable/disable ‘Enter sends message’ mode.
Ctrl+N – Add a note/comment to your last or current contact.
Ctrl+Q – Quick Edit mode, go back one qso in the log. Enter logs and Escape discards the changes made. No content
checking!
Ctrl+A – Quick Edit mode, go forward one qso in the log. Enter logs and Escape discards the changes made. No
content checking!
Ctrl+U – Increase the number in the exchange field by 1.
Alt+U – Toggles “Running’ box”. When running is checked, the behavior of Enter Sends Messages mode changes
appropriately. Additionally contacts are logged as being part of a run.
Alt+K – Change the contents of the Packet/CW/SSB/Digital message buttons.
Alt+Y – Will “yank” the first call from the Check window in the Entry window callsign field.
Ctl+G – Cut number mode toggle.
Ctrl+Alt+G – to stack additional callsigns in all modes. Same as the macro {STACKANOTHER}
Ctrl+Alt+M – Toggle between Run/Mult (Multi-1) or Run1/Run2 (Multi-2)
Ctrl+Shift+M – Used to set the Autosend threshold. Autosend will start sending the callsign before you have finished
copying a full callsign. i.e. starting after a certain number of characters has been typed AFTER the last number in the
callsign. The minimum threshold is 1. Zero will turn off the feature. Only when in RUN mode.

The Autosend rules are:
Find the first letter in the call
Find the last number after the first letter
Find the Nth letter after step 2
For example: Threshold set to 2

W4WYP would start sending at Y
S57AD would start sending at D
KH6/WA4WYP would start sending at Y (using the “/” rule as well)
WA4WYP/4 would start at Y (/4 will not be looked at)

WYP, WWYP and WAWYP do not meet the criteria for autosend to begin.
Prefixes like KH6/ are ignored and do not themselves trigger the autosend threshold.
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Key Send function key(s) Action(s)

Insert His Call Key & Exchange Key Send his call followed by the Exchange.

; His Call Key & Exchange Key Send His call followed by the Exchange.

Alt+Enter – Log the contact.

‘ End of QSO Key & Log contact Send the End of QSO message and log the contact.

Callsign/Exchange Editing Features
Space Bar – Moves cursor to the last position the cursor was in prior to leaving the Callsign or Exchange fields.
Ctrl+Space Bar – When the cursor is in the callsign box, pressing Ctrl+Spacebar will cycle the selection among the
three part of the callsign – alphanumeric prefix, number, and alphabetic suffix. This makes correcting errors in the
callsign easier by allowing you to focus on the part of the callsign that needs correcting.
Tab – Move to the next field.
Shift+Tab – Move to the previous field.
Home – Moves cursor to beginning of the field it’s in.
End – Moves cursor to end of the field it’s in.
Question mark (?) – Sends a ?, and will cause the ? to be highlighted when you reenter the field . E.g. N?MM will
send what is typed, but automatically highlight the ? so you can replace it. A double ?, as in DL?K?A will highlight all
text in between and including the ? marks. The first keystroke entered will replace all three characters.
Left/Right Arrow – Moves cursor to left or right one position within the field it’s in.
Backspace – Delete character to the left.
Delete – Delete character to the right.
Shift+Home – Will highlight from the cursor insertion point to the home (beginning) of the textbox.
Shift+End – Will highlight from the cursor insertion point to the end of the textbox.
Shift+arrow key – Will highlight as you press the keys. When you type the first character, it will delete the highlighted
character.
Ctrl+C/Ctrl+Insert – Copy to clipboard
Ctrl+V/Shift+Insert – Paste from clipboard

Message Key Assignments
There are two sets of messages stored for F1 through F12, one for Running mode and one for Search and Pounce mode.
However, you can send the message from the opposite mode by pressing Shift+Fx. The assignments below apply to both
modes.

Below is a table of the function keys with their associated default messages. Note that the CQ key always switches the
program to Running mode regardless of which mode it was in at the time. All of the keys named in the table are used by ESM.
The His Call key, Exchange key and End of QSO key are called up by logging key shortcuts (Insert or ; key and’ key)
regardless of whether the Enter Sends Messages (ESM) feature is used or not. The function keys can be remapped to others
on the Function Keys tab in the Configurer, but be very careful in doing so, because if you do, you may disrupt the
functioning of the Enter Sends Messages (ESM) feature.Default Function Keys

F1 CQ key F2 Exchange key F3 End of QSO key F4 My Call key

F5 His Call Key F6 QSO B4 Key F7 – F8 Again Key

F9 – F10 – F11 – F12 –

Esc – Stop sending CW or wav. file.
Ctrl+R – Set CQ repeat time in seconds or milliseconds (Example: 1.8 or 1800)
Alt+R – Toggles repeat mode. Hit Esc or begin entering a callsign to stop repeat temporarily

VHF OPS:
Note that you can use the above copy/paste tools to facilitate moving stations from band to band. Just highlight the
current callsign using Shift+Home/End and copy using Ctl+C. Log the Q, then move to the next band to work the
station. Use Ctl+V to insert his callsign into the callsign textbox. If you then move him to a third band, you can skip
the copy step, as the callsign is already in your paste buffer.
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Shift+Fx – Sends the contents of the function key definition for the opposite mode. If you are in Run mode and press
Shift+Fx, the program sends S&P Fx. The reverse is also true.
Ctrl+Shift+Fx – Record SSB message for the selected function key. Pressing Ctrl+Shift+Fx again stops the recording.
Fx can be F1 to F12 in either the Run or S&P lists of function key definitions. Make sure that the program is in the
correct mode (either Run or S&P), and that you have filled in filenames in rows Filenames must be entered in at least
the first 12 function key slots (right-click on the message buttons in the Entry window to edit); if names are only in the
first 12, then the program will play those messages when the corresponding function keys are pressed, regardless of
whether you are in Run or S&P mode.
Ctrl+Alt+Fx – Record external DVK memories 1 to 4, only on the W9XT card or other DVKs that emulate it

CW Key Assignments
PgUp/PgDn – Adjust CW speed Up/Down active radio using Primary CW Speed Step (Other tab in Configurer).
Shift+PgUp/PgDn – Adjust CW speed Up/Down active radio/VFO using Secondary CW Speed Step (Other tab in
Configurer) in SO2R/SO2V mode.
Alt+PgUp/PgDn – Adjust CW speed Up/Down inactive radio/VFO using Primary CW Speed Step (Other tab in
Configurer) in SO2R/SO2V mode. Note: The active radio is the Entry window with the red dot.
Ctrl+K – This will open the CW window to send manual CW. Pressing Ctrl+K again will close the window

Pressing Ctrl+K or Enter within the CW window closes the CW window and any remaining characters in the
buffer will be sent
Pressing Escape closes the CW window and stops sending immediately. No remaining characters in the buffer
will be sent

Ctrl+Alt+R – Toggle CW Reverse/No Reverse.

Enter Sends Message Mode (ESM)
Ctrl+M – Toggle ‘Enter Sends Message’ mode
Alt+Enter – Log without sending anything
Ctrl+Alt+Enter – Log even if exchange is invalid or missing

Note: ESM is affected by two options in the Configurer under the Function Keys tab:

the “ESM sends your call once in S&P, then ready to copy received exchange” check box (sometimes called the “Big
Gun” option)
the “Work dupes when running” check box (recommended)

ESM Mode Enter Key Actions
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Callsign field Exchange
field In Run, Enter sends Is S&P, Enter sends

Empty Empty CQ (F1) My Call (F4)

New Call (1st time) Empty or
invalid His Call + Exch(F5 + F2) My Call (F4)

New Call (repeat) Empty or
invalid Again? (F8) My Call (F4)

New Call (repeat) – ESM sends call once…
checked

Empty or
invalid Again? (F8) Again? (F8)

New Call (before sending exchange) Valid His Call + Exch(F5 + F2) Exchange +
Log(F2 + Log It)

New Call (after sending exchange) Valid End QSO +
Log(F3 + Log It) Log(Log It)

Duplicate Call Empty or
invalid QSO B4 (F6) do nothing

Duplicate Call (before sending exchange) Valid His Call + Exch(F5 + F2) Exchange +
Log(F2 + Log It)

Duplicate Call (after sending exchange) Valid End QSO +
Log(F3 + Log It) Log(Log It)

Dupe (1st time) – Work Dupes checked Empty or
invalid His Call + Exch(F5 + F2) do nothing

Dupe (repeat) – Work Dupes checked Empty or
invalid Again? (F8) do nothing

Dupe (before sending exchange) – Work Dupes
checked Valid His Call + Exch (F5 + F2) Exchange +

Log(F2 + Log It)

Dupe (after sending exchange) – Work Dupes
checked Valid End QSO + Log

(F3 + Log It) Log(Log It)

Telnet Key Assignments
Alt+P – Spot the callsign of the last station logged or the one currently in the callsign textbox in the format DX CALL
Frequency, without comment unless one has been specified on the Spot Comment tab of the Telnet window.
Ctrl+P – Spot the callsign of the last station logged or the one currently in the callsign textbox. You will be prompted for
a comment. Hit ESC,click “Cancel” or click the red X to exit the comment window without spotting. If you do not enter a
comment, and one has been specified on the Spot Comment tab, it will be sent when you click OK. If you specify a
comment, it will be sent along with the one specified on the Spot Comment tab.
Left-click – Tune the active radio to the frequency of the spot.
Shift+Left-click – Tune the inactive radio to the frequency of the spot.
SH/DX – Entered in Entry window Callsign field will be passed through to active Packet window for processing.

Available Window Key Assignments
Left-click – Mostly tunes the active radio to the frequency of the spot. Behavior depends on SO1V, SO2V or SO2R and
on options in the right-click menu in the Available window.
Shift+Left-click – Mostly tunes the inactive radio to the frequency of the spot. Behavior depends on SO1V, SO2V or
SO2R and on Available window right-click options.
Double click – Go to the frequency with the active VFO.
Alt+A – Starting with the top row of the window’s lower pane, grabs the callsign there and transfers it to the call-frame
of the entry window. Repeating steps down through the spots one at a time and transfers the next one to the call-
frame. Color of the transferred spot changes to black.
Shift+Alt+A – Same, except that it starts with the current row, and repeated keypresses step up through the spots.

3/4/25, 5:37 PM N1MM Logger+ Documentation



132

SO2R Key Assignments
Ctrl+Enter – Send next ESM state on alternate radio (assuming ESM turned on).
Ctrl+F1 to F12 – Send Fn message on alternate radio.
Ctrl+Left Arrow – In SO2R move both Transmit and Receive/Keyboard focus to left radio, or in SO2V move both TX
and RX/Keyboard focus to VFO A.
Ctrl+Right Arrow – In SO2R move both Transmit and Receive/Keyboard focus to right radio, or in SO2V move both
TX and RX/Keyboard focus to VFO B.
Pause – Move both TX and RX Keyboard focus to other radio (or other VFO in SO2V). If TX and RX focus are split
when you hit pause, TX focus will move to where the RX focus is.
Ctrl+B – Dueling CQ’s will send CQ (without delay) alternately on each radio. If Dueling CQ’s is turned on, both radios
become run radios. Dueling SSB and CW CQ’s are supported too.
Grave accent, backquote, or unshifted tilde key (~) Toggle STEREO mode on/off, or toggle Auto/PTT modes with
modified DXD . Notes: On US keyboards, the key we are talking about is the key just to the left of the number 1 key.
Ctrl+I – Toggle SO2R Mode (Soundcard). Toggle through the SO2R modes supported by the program. Only operative
in ‘$5SO2R’ when N1MM logger controls the audio, not when using an external SO2R controller.
Ctrl+PgUp/Down – When changing band using Ctrl+PgUp/Down will skip the other radio’s band.

THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!
Ctrl+Shift+K – FocusOther, Another method of automated focus control. Forces entry focus to non-transmitting radio,
with entry focus returning to the transmitting radio as soon as it reverts to receive. Disabled in SO1V mode.
Ctrl+Shift+L – Toggle CTRLFx Macro. This macro allows the user to send on the other radio (RTTY and CW only).

RTTY Key Assignments
Alt+T – Toggle TX – RX
Alt+G – Grab callsign
Ctrl+K – Toggle TX/RX, and displays the CW/Digital Keyboard window to send manual information using the keyboard
Ctrl+Arrows – Swaps from one active DI to the other DI. DI1 will follow entry window 1. DI2 will follow entry window 2
Esc – Stop sending

Gridsquare Key Assignments (VHF and up)
Alt+equal (=) – Search entered info from both the Callsign field and the Gridsquare field in the call history table.

The results will be shown in the Check window.
Alt+minus (-) – Toggle between the two call history grid squares in the grid square call history field.

When no grids are found in the call history there is nothing to toggle.

Rotator Key Assignments
Alt+J – Turn rotor to bearing for the callsign in the Entry window or to the callsign in the callframe (when callsign field is
empty).
Alt+L – Turn rotator to long path bearing for the callsign in the Entry window.
Ctrl+Alt+J – Stop turning the rotator when turning and no bearing in callsign field in Entry window.

Window Key Assignments
Ctrl+Tab – Toggles between the Entry window and Packet window.
Ctrl+K – Display the CW/Digital Keyboard window to send manual information using the keyboard.
Ctrl+L – Display the Log window (toggles between open and minimized).

Lookup Table Edit
Ctrl+D – to delete a row in the table or use the right click menu
Scroll Lock – the Scroll Lock key selects the current row for editing

QTC Keys (for WAE contests)
Ctrl+Z – in CW/SSB, enters or leaves QTC mode; in RTTY, cycles through Send, Receive and QTC Off

If Ctrl+Z is pressed before the QSO with the station has been logged, logs the QSO
Enter – logs the next QTC (receiving), or sends the next QTC in the batch (sending)
F3 (End of QSO Key) – sends the TU message and exits QTC mode
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Alt+W – wipes the current row
Esc – terminates sending (CW or RTTY), or if the program is not currently sending, exists the QTC window (same as
the Cancel button)
Alt+Enter, Keypad + (plus) key (sending QTCs only) – re-sends the last sent string
Alt+Enter, Alt+Tab, Alt+Space (receiving QTCs only) – force-logs the current QTC; overrides error-checking
Ctrl+A (receiving QTCs only) – removes the last blank line of received QTCs and reduces the count in the QTC header

Used, for example, when the number in the header was copied incorrectly and fewer QTCs are received than
expected

Alt+A (receiving QTCs only) – adds a new QTC line (if fewer than 10) and increases the count in the QTC header
As above, when more QTCs are received than expected

1, 2, 3 (sending QTCs only) – if pressed while the Agn button is highlighted, resends the time(1), call(2) or serial
number(3) from the previous QTC
Shift+1, Shift+2, Shift+3 (receiving QTCs only) – asks for a repeat of the time(1), call(2) or serial number(3)

Key Mapping
N1MM+ has the ability to map keystrokes to one or more other keystrokes and actions. This capability is accessed from the
Entry Window via the Tools > Keyboard Key Remapper menu item. When selected, this menu item will open a Key
Remapper window that allows one to choose a key to remap and the keystrokes/actions to be performed in response to
pressing that key.

The screen shot above is the key mapper user interface. You may enter mappings here, or you can edit them with Notepad.
Note that the user interface saves the updated set of mappings to [opcall].map after editing, on op change, and at program
completion, so be careful that you don’t overlay changes or have your edited changes overlaid. Creating and editing map files
in Notepad as well as copying maps from one operator call to another are best done while the N1MM+ program is not running,
in order to avoid problems with overlaid changes.

To add a new key mapping in this window, click on the Add/Append button, then press the key (including Shift, Ctrl or Alt
modifier(s)) that you want to use. In the bottom of the window, a listbox will appear together with three checkboxes for Shift,
Ctrl and Alt. You can use these to choose a target key in the listbox in combination with the selected checkbox(es) to be
executed. Alternatively, you can simply type the desired key, key combination or text to be sent directly into the listbox.

Notes on creating key maps:
Simple, one-to-one maps can be created by selecting the key to be mapped followed by choosing the name of
the key to map to. Specify the modifiers – Alt, Ctl or Shift that corresponds to the N1MM+ hotkey that you want
to substitute for with the new key
You can map a single hotkey to a sequence of target keystrokes. Multiple key mappings for a key are separated
by the Pipe symbol: “|”, as in the NumPadPlus example in the screenshot above, which will send Alt+Y followed
by the Return key.
Text and/or program macros may be entered instead of key combinations. Use the same format as in function
key messages, e.g.

{Wipe} will wipe the entry window fields
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PREC? will send ‘prec?’ in CW mode
assist.wav will play the assist.wav file in SSB
{CAT1HEX FEFE94E0271001FD} will turn on the scope on an Icom IC7300
“/P” will insert the characters ‘/P’ at the insertion point (cursor) in whichever textbox currently has focus
“https://www.wm7d.net/” will open the web page wm7d.net
“notepad.exe C:\contestnotes.txt” will open the file C:\contestnotes.txt using Notepad

Quoted strings, as in the last three bullets above, can be used wherever macros can be used. Depending on the
contents of the quoted string, it may: insert text at the Windows text cursor; open the default browser on a
specified web page; or execute a .bat or .exe command. See the description of Quoted Strings on the Function
Keys, Messages and Macros page.
Note that when entering text to be sent in CW, text that is identical to a key name cannot be used. If you want to
define a key mapping to send the single character R, you will need to add a space (or a half-space character ~)
either before or after the R.
The map will be built by the Remapper using some syntax rules. There are four modifiers, Alt+, Ctl+, Shift+ and
Other+. The first three refer to the keys used to modify a keystroke. The Other+ modifier indicates to the
remapper that this command is to be executed by the Other Entry Window (SO2R or SO2V).
All hotkeys “mapped to” are processed by the Entry Window where the user types the key to be remapped. If
you press a mapped key while the 2nd Entry Window has focus, it will be processed by that window. The Other+
modifier is used when you want to cause the other Entry Window to process the action.
Two wait macros are provided. These are used where delays are required. The keyboards are unlocked during
these macros, so if you type something else while a map is waiting, you may disturb the map you are running.

{Wait} will wait until sending is stopped. In SO2R/SO2V it checks for sending on either radio.
{Wait nnn} will wait for nnn milliseconds to execute the next action in the map.

It is possible to manually edit the key maps. A menu item & button are provided for this purpose. Note that you
can add comment lines to your maps by prefixing a line with something that is not a key name. “!!” is the
suggested comment marker, as in the above screenshot.
Focus is normally returned to the EW from which the keystroke was received. In SO2R and SO2V, if Pause is
used in a mapping focus will switch to the other EW (assuming, of course, that there are no additional
keystrokes that change focus, like Ctrl+RightArrow or Ctrl+LeftArrow).
Bandmap button hotkeys have been difficult to use because they require a four-key combination to invoke. You
can specify a bandmap button as the target by checking all three checkboxes (Shift, Ctrl and Alt) and choosing
the digit or letter corresponding to the desired button (0 for the first button, 1 for the second, …, 9 for the tenth
button, A for the 11th button, …, Z for the 36th bandmap button). Note that in SO2R and SO2V, there are
separate sets of buttons for each bandmap window. You will need to use the Other+ modifier to invoke a
bandmap button from the non-active radio’s or VFO’s bandmap window.
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Function Keys, Messages and Macros
2019-03-29

Function Keys, Messages and Macros
Definitions and Fundamentals
One of the things that differentiates contest logging programs from general-purpose loggers is the ability to send stored
messages, to save energy during long contests. N1MM Logger can send stored messages in CW, SSB and digital contests.
These messages can incorporate macros, short-form statements which perform program tasks automatically.

It will help you to follow the discussion below if you first understand, in general terms, how N1MM Logger’s message-sending
capabilities are organized. The architecture consists of three primary components: Function Key Files, Messages, and Macros

Function Key Files are text files with a .mc extension that can be edited with a text editor (Notepad) or the program’s
internal Function Key Editor

Each row of text in a Function Key file is either a Comment or a Message
Comments begin with a pound sign “#” in the first column, and help to explain the purpose of surrounding
Messages. Comments are black text in the Function Key Editor

Messages are lines of text in a Function Key file that do not begin with a pound sign “#” in the first column
Messages begin with a label (text that will appear on the keys in the Entry Window), followed by comma “,”,
followed by the message itself. If there is no comma, the message part will be considered to be empty
Messages can contain ordinary text, macros, or – in messages for phone contests – WAV filenames (names of
wav files supplied by the user containing recorded voice messages)
The label is arbitrary – it does not determine which function key corresponds with the message. It may be helpful
to the operator to start the label with the name of the function key, but this is purely for the operator’s
convenience
The association between messages and function keys is determined solely by the position of the message in the
file, not by the contents of the label
The first 12 message lines are called Run Messages. They are assigned, in sequence, to the keyboard Function
Keys F1 – F12 when you are in Run mode. Run Messages are blue text in the Function Key Editor
The next 12 message lines (13 – 24) are called Search and Pounce Messages. They are also assigned, in
sequence, to the keyboard Function Keys F1 – F12, but only when you are in Search and Pounce mode. Search
and Pounce Messages are green text in the Function Key Editor

Macros are special text expressions surrounded by curly braces “{…}”
There are also a few single-character macros: !, *, #, @
Macros can either trigger a program action or expand to a string of text to be transmitted in CW or digital modes

Three default Function Key message files are included with the program, one for each mode: SSB Default Messages.mc”,
“CW Default Messages.mc, and Digi Default Messages.mc. These are assigned automatically when you open a new contest
(>File >New Log in database), as indicated on the Associated Files tab of the Contest Setup Dialog. You can edit the
messages in the default files, export the messages to a new .mc file, or load different messages from an existing .mc file (for
example, a .mc file that you download from the website’s >File >Sample Function Key Files gallery). We’ll get further into this
below.

A Macro is Not a Message
Early in the use of computers for amateur radio contesting, the term “macro” was used to denote any stored
message. We follow a different convention – for us, the term Macro means a message component that either triggers
a program action or expands to a string of text to be transmitted in CW or digital modes. The use of the .mc filename
extension for our Function Key message files is a left-over from those days. Don’t be misled.



The CQ Function Key (F1) is Special
F1 is normally used as the CQ function key. If you use F1 for some purpose other than sending a CQ you are likely
to run into surprises.
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The Function Key Message Editor
The Function Key Message Editor is the key tool for managing your Function Key messages. It provides the best way for
assigning, managing and editing Function Key Message files using a Notepad-like editing window. You can import and export
function key message files, edit them, and save them.

The easiest way to open the Function Key Message Editor is by typing Alt+K in the Entry Window, or by simply right-clicking
on the message buttons in the Entry Window. The editor will display the message file associated with the current program
mode (CW, SSB or digital). If you want to open the message files associated with the other modes, select >Config >Change
CW/SSB/Digital Function Key Definitions and select the desired mode.

The Function Key Editor dialog window:

When the CQ function key is invoked, the program will switch automatically into Run mode regardless of
whether it was in Run mode or S&P mode to begin with
The current frequency will be remembered as the CQ frequency
Changing frequency on the radio away from the CQ frequency will automatically switch the program back into
S&P mode (unless configured otherwise)
Depending on configuration options, changing frequency on the radio to the last-used CQ frequency may
automatically switch the program into Run mode
Switching between Run and S&P modes changes which message definitions will be used (1-12 for Run, 13-24
for S&P)

All of the above work seamlessly and well when you use F1 to send your CQ message, but can give unexpected
results if you use F1 for some other purpose.



Important Change for Those Transitioning from N1MM Classic
N1MM Logger Classic found its wav files assuming the starting directory was the N1MM Logger program directory.
Typically users would place their wav files in a sub-directory of the N1MM Logger program directory called wav. To
call up a wav file in this sub-directory, you would specify the file name in the form wav\filename.wav (or wav\
{OPERATOR}\filename.wav if you were using operator-specific files) in your function key messages.

N1MM Logger Plus finds its wav files assuming the starting directory is the wav sub-directory created by the installer
inside the N1MM Logger+ user files directory (*not* the program files directory). To call up a wav file in this sub-
directory, you specify the file name in your function key messages as filename.wav, i.e. without the leading wav\ (or if
you are using the {OPERATOR} macro, as {OPERATOR}\filename.wav, again without the leading wav\). If you edit
your message files by removing the leading wav\ on file names in messages, you will be able to access wav files you
have placed in the wav sub-directory.

Alternatively, if you wanted to continue to use the same message files you used with Classic without editing them to
remove all those leading wav\’s, you could create a new wav sub-sub-directory inside the wav sub-directory in the
N1MM Logger+ user files directory (for example, if the user files area were at the default location, these wav files
would be located at Documents\N1MM Logger+\wav\wav\filename.wav, or Documents\N1MM Logger+\wav\wav\
{OPERATOR}\filename.wav – note the two levels of wav\ in the path name), and once you have placed your wav files
in that new sub-directory (or in operator-specific sub-directories under that wav\wav sub-directory if you are using the
{OPERATOR} macro), you could call those wav files up using your old function key message files.



Unknown Operating Mode?
If right-clicking on a message button or pressing Alt+K results in an error message to the effect that the function key
editor cannot be opened because the operating mode is not set, or if the function key editor opens up but the
messages you see are for the wrong mode, you must first set the operating mode (CW, SSB or digital) before
opening the function key editor. You do this by typing the mode (CW, SSB, RTTY or PSK) into the call sign box and
pressing Enter. Once you have done this, right-clicking on a message button or pressing Alt+K will open the function
key editor with the messages for the mode you entered.
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The Save and Cancel Buttons

Save assigns the messages to the current contest and saves them to the file indicated in the title bar of the Function
Key Editor. If you want to save those changes to a different file, use Export. Note: It is easy to change a default
function key file without meaning to, if you forget that it is the file in the title bar and Save a modified version. If
you do this, use the Sample Function Keys function below to retrieve the defaults, and then save them to the
original file name.
Cancel closes the editing window without saving. If you have made any changes, or imported a file, the program will
ask you whether you want to save the changes. Answer Yes and the editor assigns the messages to the current contest
and saves them to the file indicated in the title bar of the Function Key Editor. Answer No and the editor just closes,
abandoning any changes you may have made.

3/4/25, 5:37 PM N1MM Logger+ Documentation



138

The File Menu

Copy these Messages to the Clipboard places the entire contents of the editor on the clipboard
Delete These Messages and insert Starter Message Text if you want to revert to the standard messages for the
current mode, this option will copy them into the editor in place of the messages that were there, retaining the original
filename. You will be asked if you wish to save your changes. OK makes the changes in the database and in the open
.mc file; Cancel reverts to the previous message set.
Import and Assign a Different Function Key (.MC) file to this Contest assigns a file that you choose to this contest.
It is entered on the Associated Files tab and will be automatically opened whenever you open this or another instance
of this contest.
Save these Messages to a Different Function Key (.MC) filename opens a dialog where you can copy the current
contents of the Function Key Message Editor to an .MC file of a different name.

The Edit or Right-click Menu

If you select the drop-down menu item >Edit, or right-click in the Function Key Message Editor Window, you’ll see a short
menu. Three of the choices – cut, copy and paste – are the familiar Notepad editing commands and should need no
explanation.

Insert wav filename selection does what its name implies. Click on it and you will be asked to select an existing wav
filename from the N1MM Logger+\Wav directory. Select a Wav file, and its filename will be inserted at the location of

Starter Messages
There has been a significant change in the way Default [mode]Message text is handled.

A set of Default .mc files is loaded in the FunctionKeyMessages subfolder in the N1MM+ user files folder at program
installation. If you wish, you may modify these to your heart’s content, changing them to fit each contest, or you may
create and save contest-specific .mc files. Note, though, that if you start with a Default CW file, for example, make
changes in the Function Key Editor, and Save them, they will be saved under that filename.

If you wish to restore the original Default messages, you can do the following:

Click on “Import and Assign a Different Function Key File” on the File menu, and select the Default [mode]
Messages.mc file you wish to revert.
Click on “Delete these Messages and Insert Starter Message Text” (also on the File Menu).
Click the Save button in the Function Key Editor, to save the Starter messages to the database and to the
Default [mode] Messages.mc file, effectively recreating it in original form. If you exit without clicking Save, you
will be prompted to decide whether you want to save the changes or not.
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your cursor. The intended use of this function is to make it easy to construct complex SSB messages, combining
macros and filenames.

Function Key Message File Contents
Refer to the previous Fundamentals section and the Function Key Editor Dialog window screenshot for the following
explanations

N1MM Logger accommodates up to 24 messages for each mode (CW, SSB and Digital), each divided into two sets of 12, one
for Run mode, the other for Search and Pounce (S&P). (For more information on Run vs. S&P and other features of function
key usage, see the Entry Window chapter section on Function Keys). This means that your Function Key message files can
have as many as 24 active lines, plus an unlimited number of Comment lines

Comment Line – any line that begins with a pound sign “#”

Comment Example: #This is a comment line

Message Line – any line that does not begin with a pound sign “#”

Simple Message Example: F1 CQ, CQ
Message lines have two elements – a Label and the Message itself. The Label is separated from the Message with a
comma “,”. In this example, the label is “F1 CQ” and the transmitted message is “CQ”

Simple Message Example with a Macro: F1 CQ, CQ de {MYCALL}
In this example, the transmitted message is “CQ de” followed by my callsign, which the program will retrieve from the
>Config >Change Your Station Data “Call” dialog

Message Example with multiple Macro: F2 Exch,! {SENTRST} {EXCH} de {MYCALL}
In this example of a contest exchange, the transmitted message begins with the other station’s callsign “!”, followed by
an RST report “SENTRST”, followed by the contest exchange (which could be an incrementing contact number, a state,
a CQ zone, or any number of parameters based on the contest and the contents of the Sent Exchange box in the
Contest Setup dialog), followed by “de”, and finally my callsign

In message files, # starts a comment line. Any line not starting with # is used as a function key definition, regardless of
whether it looks like one or not.

Each active (non-comment) line contains a button label (appears on the button in the Entry window), then a comma, then the
contents. If you want to put an ampersand in a label (as in S&P), you must type in two ampersands (as in S&&P).

The label is arbitrary. It is suggested that you put the fkey name (F1, F2, etc.) and a very brief description in the label, because
this makes the button labels in the EW act as visible documentation for the fkeys even if you never use the mouse. However,
putting F3 in a label DOES NOT automatically mean that this message will go into F3.

The association between lines in the mc file and the function keys is strictly positional. The first non-comment line (starting
with any character other than #) is the F1 message regardless of what the label says. The second line is the F2 message. And
so on.

There are up to 24 active lines in a file. The first 12 are for Run mode, the second 12 are for S&P. If there are fewer than 12
active lines, function keys after the last one will be empty, and S&P keys will be identical to Run. If there are exactly 12 active
lines, S&P will be identical to Run. If there are between 12 and 24 active lines, the S&P lines after the last one will be identical
to their Run counterparts. So for example, if there are 15 active lines, the first 12 are Run F1-F12. The next 3 are S&P F1-F3,
and S&P F4-F12 will be identical to Run F4-F12.

There may not be any skipped lines in the file. If you leave a line out, all the following lines will effectively be shifted up by one.

Message Content Limitations

Label length is limited to 29 characters, though you would never want to use that many

Databases and Function Key Assignments
Each database remembers your preferred Function Key file for a particular contest. For example, if you assign
CQWWCW.MC to the CQ Worldwide CW contest in 2014, the database will remember your preference and also
automatically assign the same file to the CQ Worldwide CW 2015 contest. However, if you open a new database for
your logs, that memory is lost and you will begin with the default assignment of CW Default Messages.MC.
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Message total length is limited to 255 characters
Message line count is usually 24 – 12 for Run and 12 for Search & Pounce. However, if you do not assign S&P
messages the program will automatically substitute the Run messages in their place. For example if your S&P
messages for F9 – F12 are identical to those in Run, you can leave those lines out of the file. But be careful, because
you cannot have any gaps in the sequential numbering of the S&P messages. Blank lines are counted as message
lines!
The association between messages and function keys is strictly positional. The message in the first non-comment line
will be sent by F1 in Run mode, regardless of what the label says; the message in the second line will be sent by F2 in
Run mode; the message in the 13th line will be sent by F1 in S&P mode; and so on

Function Key Examples

There are sample function key files on the web site under >Downloads >Category listing >Function Key files for SSB, CW and
Digital operation. Open the category for the mode in which you are interested download the selected files. To use them, you
can name these files when you set up for a new contest, or you can import them into the function key editor. You can examine
them either in the function key editor or simply from a text editor like Notepad.

The program comes preloaded with standard generic function key message files for all three modes, called CW Default
Messages.mc, SSB Default Messages.mc and Digi Default Messages.mc . These work for contests with simple exchanges
(like CQ WW or CQ WPX), and basically for all SSB contests.

If you are using the Default Messages.mc file for a given mode and use the function key editor to make changes, those
changes will be permanent, i.e. they will apply to all future contests where you use that file. Therefore if you make changes for
a particular contest but you don’t want those changes to apply to other contests, you should use a contest-specific mc file
instead of the generic default file. You can create or download contest-specific files and use the Associated Files tab in the
Contest Setup dialog to name the file you want to use for that contest. Once you have done that, future contests of the same
type will automatically use the same message files as the previous contest of that type.

SSB

SSB files contain wav file names. These wav files must be supplied by the user. Normally they are recorded in the operator’s
own voice, to avoid confusion caused by using different voices in “live” vs. recorded transmissions. They are assumed to be in
the wav subdirectory of the N1MM Logger+ user files area. (Note: If you have moved the user files area during a reinstall,
perhaps to avoid problems with OneDrive, there may be more than one N1MM Logger+ folder in your system; the one to use
for your user files, including wav files, is the one that is pointed to from the Help > Open Explorer on User Files Directory
menu item.) If an {OPERATOR}\ macro appears in the file name, the file will be found in a sub-subdirectory named with the
current operator’s call sign. It is possible for !, # and @ macros to appear as well, but only if a complete set of individual wav
files for each letter and number is found in the wav\LettersFiles sub-subdirectory (or a sub-sub-subdirectory named in the
Configurer under the Other tab, DVK Letters File Path box). There is one sample SSB file on the web site
(SSB_Default_Messages.mc). The differences between different contests are mainly in the contents of the recorded wav files,
not in the contents of the function key messages.

Basic example file illustrating the use of the {OPERATOR} macro:

F1 CQ,{OPERATOR}\CQ.wav
F2 Exch,{OPERATOR}\Exchange.wav
F3 TNX,{OPERATOR}\Thanks.wav
F4 {MYCALL},{OPERATOR}\Mycall.WAV
F5 His Call,empty.wav
F6 Spare,empty.wav
F7 QRZ?,{OPERATOR}\QRZ.wav
F8 Agn?,{OPERATOR}\AllAgain.wav
F9 Exchg?,{OPERATOR}\Exchange query.wav
F10 Spare,empty.wav
F11 Spare,empty.wav
F12 Wipe,{WIPE}
F1 CQ,{OPERATOR}\CQ.wav
F2 S&P Exch,{OPERATOR}\S&P Exchange.wav
F3 Spare,empty.wav

Sample Function Key Files
In addition to the three default message files that install with the program, there are also a large number of Sample
Function Key files available for download on the website. The advantage of these sample files, over the default files,
is that they have been customized for the major contests and can be used without further modification.
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F4 {MYCALL},{OPERATOR}\Mycall.WAV
F5 His Call,empty.wav
F6 {MYCALL},{OPERATOR}\Mycall.wav
F7 Rpt Exch,{OPERATOR}\Repeat Exchange.wav
F8 Agn?,{OPERATOR}\AllAgain.wav
F9 Spare,empty.wav
F10 Spare,empty.wav
F11 Spare,empty.wav
F12 Wipe,{WIPE}

Make sure your wav directory contains a subdirectory named with your call sign, and that that directory contains all of the
filenames listed in the file except for “empty.wav”, which is installed with the program.

Example: Wav subdirectory for operator callsign N1MM

CW

CW files contain the actual text that is to be sent in Morse code, possibly intermixed with substitution macros (like {MYCALL},
!, #, {EXCH}) and control macros (like {WIPE}, {CLEARRIT}). Note that if the {EXCH} macro is used, you must enter the
correct exchange in the Sent Exchange box in the Contest Setup dialog – consult the Contest Setup instructions for the
contest. There are CW files on the web site in the Sample Function Key Files gallery for most major contest types.

Generic CW example

F1 Cq,cq test {MYCALL} {MYCALL} test
F2 Exch, {SENTRSTCUT} {EXCH}
F3 Tu,tu {MYCALL} test
F4 {MYCALL},{MYCALL}
F5 His Call,!
F6 Repeat, {SENTRSTCUT} {EXCH} {EXCH}
F7 Empty,
F8 Agn?,agn?
F9 Nr?,nr?
F10 Call?,cl?
F11 Empty,
F12 Wipe,{WIPE}
F1 Qrl?,qrl? de {MYCALL}
F2 Exch,{SENTRSTCUT} {EXCH}
F3 Tu,tu
F4 {MYCALL},{MYCALL}
F5 His Call,!
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F6 Repeat,{SENTRSTCUT} {EXCH} {EXCH}
F7 Empty,
F8 Agn?,agn?
F9 Nr?,nr?
F10 Call?,cl?
F11 Empty,
F12 Wipe,{WIPE}

Sprint CW examples

Whether you operate the NA Sprint or not, these examples will illustrate the use of various macros in combination with text in
function key definitions.

Sprint CW Example #1

This Function key set is based on a set posted by Kenny, K2KW:

F1 CQ,* * NA
F2 Exch, * {EXCH}
F3 TU,EE{S&P}
F4 {MYCALL},*
F5 His Call,!
F6 QSO B4,B4 E E
F7 ?,?
F8 Agn,AGN
F9,
F10,
F11,
F12,
F1 CQ,* * NA
F2 Exch,! {EXCH} *
F3 TU,EE{RUN}
F4{MYCALL},*
F5 His Call,!
F6 QSO B4,B4 E E
F7 ?,?
F8 Agn,AGN
F9,
F10,
F11,
F12,

Running Message Notes

For F2, there is a space before the *; E.G. “[space] * {EXCH}”
For F3, “EE” is there to confirm the QSO. You could easily use “TU”.
After the “EE” is sent on the F3 message, the {S&P} macro puts you into the S&P mode. Then just hit your UP/DOWN
arrow to QSY.
Personally I have F6 programmed as {EXCH} to send a repeat on the exchange

S&P Message Notes

Note the difference in the sequence for the F2 message compared to the Running F2 message
For the F3 message, the {RUN} macro puts you in the running mode, ready to work a tail ender and send him the
correct QSO sequence
Personally I have F6 programmed as {EXCH} to send a repeat on the exchange

Sprint CW Example #2

This function key set is based on one posted by Pete, N4ZR:

F1 CQ,* * NA{CLEARRIT}
F2 Exch, * {EXCH}|
F3 TU,E~E {CLEARRIT}
F4 {MYCALL},*
F5 His Call,!
F6 QSO B4,B4 *
F7 Rpt Exch,{EXCH}
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F8 ?,?
F9,
F10,
F11,
F12,
F1 CQ,* * NA{CLEARRIT}
F2 Exch,! {EXCH} * {RUN}
F3 NR,#
F4 {MYCALL},*
F5 His Call,!
F6 Name,PETE
F7 State,WV
F8 ?,?
F9,
F10,
F11,
F12,

Note two things about this set:

1. The {RUN} macro is in S&P F2, not F3. This worked great for me – when I pressed Enter to send the S&P exchange, the
exchange was sent, the QSO was logged, and the mode changed to {RUN} with the cursor in the call sign box. Therefore I did
not have to press F3 to get from S&P to Run. The main problem with this is that if anyone asks for a repeat of the serial
number, the Run keys are already active, so you have to either remember how to get the serial number from the S&P set
(Shift+F3), or else just use the paddle, which is what I did.

2. There is no {S&P} macro in this set. At the end of a Run QSO, you switch to S&P mode by just QSYing. This also worked
OK for me; since you are going to have to QSY anyway, there seems to be no real need to force a change to S&P mode. I
also had the “QSYing wipes the call & spots QSO in bandmap” option selected, which may have helped ensure that the cursor
was in the right place after QSYing by wiping the entry window. Of course I did not actually have the band map open, and I
just ignored any call signs that showed up in the frame in the entry window.

Sprint CW Example #3

Customizing N1MM Logger for the North American CW Sprint by Steve, N2IC

I’m not going to try to explain how to operate the Sprint – for this, there is an excellent writeup at:
http://www.kkn.net/~n2ic/sprint.html
What I will do is describe how to get the most out of N1MM Logger in the Sprint. My operation is SO2R, and my configuration
is optimized for that mode. However,I’m sure you SO1R guys will pick up a few tricks from what I have done for SO2R.The
most important thing is to get your options, windows and function keys setup correctly before the Sprint starts.

The Options…

Start up N1MM Logger+, and create a new SPRINTCW contest.

In the Config menu, select the following options:

Enter sends message (ESM)
QSYing wipes the call & spots QSO in bandmap
Do not automatically switch to run on CQ frequency
Show non-workable spots
SO2R->Toggle CTRLFx Macro

Note: SO2R->Focus on Other Radio is NOT turned on

The Windows…these are the only windows I have on my screen and all fit nicely on my small monitor

Entry Window (one for each radio)
Visible Dupesheet (one for each radio)
Info
Log
Score Summary
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The Visible Dupesheet is really nice once you get used to it. To see if a station is a dupe, you just scan the dupesheet with
your eyes, rather than frantically type a call into the Entry Window. You can change the font size in the Visible Dupesheet by
dragging it wider, so that there is white space past right-most column. Then right-click in the white space for a choice of a
small font or a large font.

Notice that I do NOT have the “Available Mults & Q’s” window open. Open the Bandmap window, but size it to a very small
size. It’s needs to be open, even though it is of no use in Sprint.
Open the Telnet window. Select the Filters tab. Change the Bandmap DX spot timeout to 1 minute. That’s right….1 minute.
Press Update. Now close the Telnet window. Don’t reopen it. It is of no value in Sprint, but it is important to change the
bandmap DX spot timeout value to 1 minute. This controls how long calls stay on the bandmap and the appearance of calls in
the “on deck” frame of the Entry Window. We’re obviously not using packet in the Sprint.

Function Keys ….

Here are my function key definitions. I’ll explain a few that aren’t obvious.

F1 CQ,{JUMPRX}cq na cq na * na
F2 Exch,* # steve nm
F3 TU,{CLEARRIT}T{END}{CONDJUMP}{STOPTX}
F4 (MYCALL},*
F5 His Call,!
F6 QSO B4,! QSO B4 * NA
F7 Other Short,{CTRLF10}
F8 Other Long,{CTRLF11}
F9 Go S&P,{S&P}
F10 CQ,CQ NA * * NA {RUN}
F11 Long CQ,CQ NA CQ NA * * NA {RUN}
F12 – ,-
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F1 S&P CQ,{JUMPRX}CQ NA CQ NA * NA
F2 S&P Exch,! # STEVE NM {RUN}
F3 S&P TU,TU
F4 S&P{MYCALL},
F5 S&P His Call,!
F6 S&P Name,-
F7 S&P Other Short,{CTRLF10}
F8 S&P Other Long,{CTRLF11}
F9 Go Run,{RUN}
F10 CQ,CQ NA * * NA {RUN}
F11 Long CQ,CQ NA CQ NA * * NA {RUN}
F12 -,-,

With the CQ F3 key, my “thank you” message is sent. When you QSY, you will automatically be changed to the S&P mode. Do
not include the {S&P} macro here -it will cause the last station worked to get “stuck” in the on-call fame of the Entry Window.

With the S&P F2 key, as soon as I send my exchange, it immediately switches to Run mode.
I can also force myself into Run and S&P modes with the F9 key.

The F7 and F8 keys send CQ’s on the “other” radio. This is very useful when the other station is sending his exchange, and
you are going to lose the frequency (i.e. it will become “his” frequency). You can send a CQ on the other radio, while he is
sending his exchange. Then, when he finishes sending his exchange and you need to send your “thank you” message to
finish the QSO, all you have to do is hit Enter, which will stop the CQ on the other radio, and send your CQ F3 message on
the active radio. However, you had better be ready to copy a new caller on the “other” radio. You also need to be sharp with
the Pause key to jump between the two radios when this happens. The {CONDJUMP} macro in the Run F3 message will
move your entry focus to the “other” radio, so that you will be ready to copy a new caller.

When I’m CQing on the active radio, but simultaneously doing S&P on the other radio, and hear a new station, I can just hit
the Enter key. This will stop the CQ, and send my call on the other radio.

One thing you need to do is keep an eye on where your transmit and receive focus is (the red and green dots on the Entry
Window). When you’re doing SO2R in the Sprint, there will be times where your focus is not where you might expect it, or
want it. Always be ready with the \ and Pause keys to jump between radios. Yes, this takes lots of practice, and you will make
mistakes. The Thursday night NCCC Sprints are good practice for this.

73 and see you in the Sprint !
Steve, N2IC

CW Messages Deep Dive

From the Config menu, you can select Change CW/SSB/Digital Function Key Definitions, and then Change CW Function Key
Definitions, or you can simply right-click on one of the 12 function key buttons in the Entry window. That will bring up this
window:
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What it is displaying is the default function key message file that is now shipped with N1MM Logger+. There is much more on
the Function Key Message Editor here, but for the moment, let’s use what we find already in place.

Going down from the top, note the macro {MYCALL}. An alternative to this is the single-character macro *. Either one denotes
your callsign, from the Station Data window. This is a text macro. There are two types of macros, text macros and action
macros – text macros substitute a string of text for the macro, while action macros perform some program action. Both are
often used in combination with regular text in a message, as shown here – when you press the function key or click the on-
screen F1 button, the program will send CQ TEST N4ZR N4ZR TEST (substituting your call for the asterisk). There’s a table of
the many recognized Macros in the chapter by that name in the manual but for now let’s go on.

Conventionally, F2 is used for your contest exchange. The sample file uses the {EXCH} macro, which is a text macro that
substitutes whatever you put in the Sent Exchange part of your Contest Setup. Say, for example, we were setting up for a
contest where the exchange is signal report, your name and your state. When N4ZR sets up the contest, he puts PETE WV in
the Sent Exchange. Now when he presses or clicks F2, the program will send PETE WV.

You do not need to use the {EXCH} macro; it is merely a convenience. You can always hard-wire the exchange directly into
the message definition (use # for serial numbers).
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Also in Run F2 is the macro {SENTRSTCUT}. Many of us just put 5NN explicitly in F2, but this macro is a little cleverer. It
sends the signal report (nominally 599, but can be modified from the Entry window on a per-QSO basis) using N instead of 9
(CW only).

One fine point – you might think of putting the 5NN in your Sent Exchange in the Contest Setup dialog – after all, everyone’s
599, right? Well, don’t, because it will screw up your Cabrillo log. Just resign yourself to putting 5NN or {SENTRSTCUT} in
your function key messages wherever you want it sent.

The next handy trick to notice is in Run F5, where ! is used. That always denotes the other station’s call, grabbed from the
Entry Window

A final tip – most macros are in the form of {WORD}, where “word” is the macro (the main exceptions are *, ! and #, which do
not appear inside curly brackets). The curly brackets around the macro name are necessary so that the program knows it’s
time to substitute something or take some action. It is awfully easy to type a square bracket or common parenthesis instead of
the curly bracket, so look carefully.

From now on, if you want to change the content of any message buttons, just right-click in the area of the buttons, and the
editor we just left will reappear.

OK – you’ve hooked up your interface, so now you’re ready to send some canned CW. As explained above, you can either hit
the function key F1, or click on the F1 button. Either way, the program will switch your radio from Receive to Transmit
(assuming you have PTT connected – you can also use VOX or break-in, of course) send the message, and then go back to
Receive again.

RTTY

Digital file messages generally begin with {TX} and end with {RX}, except for program control macros.

The way the keys below are designed, they will work in many RTTY contests without any changes. Whether these particular
ones suit your situation will depend on your antennas, your power, QTH, etc.; but maybe these will give you some ideas to
work with:

F1 CQ,{TX} CQ TEST * * CQ {RX}
F2 EXCH,{TX} 599 {EXCH} ! {RX}
F3 TU,{TX}{ENTERLF} ! TU * QRZ? {RX}
F4 {MYCALL},{TX} * {RX}
F5 His Call,{TX}{ENTERLF}! {RX}
F6 QSO B4, {TX} QSO B4 * CQ {RX}
F7 Rpt Exch,{TX} {EXCH} {EXCH} {EXCH} {RX}
F8,{TX} AGN AGN * {RX}
F9,
F10,
F11,
F12,
F1 CQ,{TX} CQ TEST * * CQ {RX}
F2 EXCH,{TX}{ENTERLF} ! TU 599 {EXCH} {EXCH} {RX}
F3 TU,{TX} ! TU {RX}
F4 Call Him,{TX} * * {RX}
F5 1×1,{TX} ! * {RX}
F6 0x1,{TX} * {RX}
F7 Rpt Exch,{TX} {EXCH} {EXCH} {EXCH} {EXCH} {RX}
F8 Agn,{TX} AGN AGN {RX}
F9,
F10,
F11,
F12,

If the contest exchange includes an RST, you can use the {SENTRST} macro to send the signal report from the Snt box in the
Entry window in place of 599 in the exchange message.

General RTTY example

When using the above keys it is assumed that ESM is on. The Run mode keys F5, F6 and F7 are not very useful when you
are S&Ping, this is why I put those keys to better use by programming them differently from the Run mode keys.
Note also that you can use up to 24 additional buttons (mouse only, no keyboard access) on the digital interface window. For
example, you can set up 0x1, 0x2, 0x3 and 0x4 calls, single, double and triple exchanges, separate requests for his zone and
state and repeats for your zone only and for your state only, and so on.
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Example RTTY where the time is part of the exchange (like BARTG)

In the following table only the keys that are different from the general example above are shown:

F2 Exch,{TX}599 {EXCH} {EXCH} {TIME2} {TIME2} ! {RX}
F7 Rpt Exch,{TX} 599 {EXCH} {EXCH} {TIME2} {TIME2} {RX}

Per-Operator Function Key Files
There is an option, selectable under the Other tab in the Configurer, which allows individual operators in a multi-operator
station to each have their own function key message files. This gives different operators the capability to have function key
message files tailored to their individual preferences. The function key file for all operators is based on the function key
message filename specified under the Associated Files tab in the contest setup window. The master function key file is edited
when the OPERATOR is set to the station call sign.

In phone contests it is not necessary to use this option simply to change the voice in recorded messages (see the description
of the {OPERATOR} macro in the next section on SSB function key messages instead). However, by using individual per-
operator function key files, it is possible for one operator to use a function key message file that includes ! and # macros for
voicing of call signs and serial numbers using pre-recorded letters and numbers, while another operator can use a function
key message file that does not include these macros, and speak call signs and serial numbers into the microphone. In CW
and digital modes, by using this option different operators can tailor their function key messages to match their individual
preferences.

When this option is enabled, changing operators using the OPON or Ctrl+O command will switch the function key message
file currently in use to that operator’s personal function key message file. These operator-specific files are stored in a sub-
directory of the main function key messages directory. The first time an operator whose call sign is different from the station
call sign signs on using Ctrl+O or OPON, the personal function key message file for that operator is initialized from the
“master” file specified under the Associated Files tab in the contest setup window. Subsequently, that operator can make
changes to the file using the Function Key Message Editor without having any effect on other operators’ function key message
files, thus enabling each operator to have their own individual files. The “master” file specified under the Associated Files tab
can be edited only by the operator whose call sign is the same as the station call sign. See the description of Per-Operator
Function Key Messages under the Other tab in the Configurer section of the manual for more information on how this is
implemented.

If an operator changes the function key message filename specified under the Associated Files tab in the contest
setup window during the contest, all operators will be assigned new message files based on the new filename as
they OPON.

Special Measures for SSB Function Keys
CW and RTTY messages are quite straightforward. SSB messages, however, require additional instruction.

The SSB Default Message.mc file, as shown in the Function Key Editor

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/setup/the-configurer/#other-tab


149

This screenshot shows the default SSB function keys, as supplied with the program initially. You’ll note that the F5-His Call
message as-delivered is a single space character. If you are using character-by-character voicing of call signs, you can use
the “!” macro character (without leading or trailing spaces) as the F5 message. This is the macro that is used to tell the
program to voice a callsign by putting together letter and number files, so it would not normally be used. If you are not voicing
call-signs or serial numbers (see below), you should not have the “!” macro in your SSB definitions. The same goes for the
“#”, “*”, and “@” macros. Instead of the “*” or {MYCALL} macro, use an explicit filename like mycall.wav.

The Wav files referenced in the message file must be supplied by the user. For use with this file, they must be placed in the
N1MM+ user Wav\ directory path. In the case where a station has multiple operators, use the {Operator} macro in the function
key wav file path as shown above. Then place each operator’s Wav files in an operator callsign subdirectory. N1MM
Logger+\Wav\[operator]\. For example, K3CT’s Wav files when operating at N1MM’s station would be located in N1MM
Logger+\Wav\K3CT\ .

Use the CTRL+O or OPON command to change the operator and tell the program to switch to that operator’s Wav files.

Playing Multiple Wav Files

To play more than one wav file with a function key, separate the wav file strings with a comma.
F1 CQ,{OPERATOR}\Cq.wav,{OPERATOR}\Cq.wav

The {Operator} Macro

As you probably noticed above, there is an {OPERATOR} macro in the path for each of the .wav message files. The purpose
of this is to enable you to change the stored message files to match the operator currently on duty (in a multi-op or guest op
situation), so that the voice used in the stored message files will be the same as the live operator’s voice when using the
microphone. For example, if a set of messages (such as CQ.wav) are stored in the Wav\N1XYZ subfolder, then if N1XYZ is
the operator and the message refers to {OPERATOR}\CQ.wav, the program will send his stored CQ.wav file when that key is
pressed. The same is true for stored letters and numbers, used in voicing callsigns and serial numbers, except that those are
stored in the path which is identified on the Other tab of the Configurer. The default letters wav file path is: {Operator}\.
Therefore, if your callsign is “N1XYZ”, the letter and number files should be placed in the wav\LettersFiles\N1XYZ\
subfolder in the N1MM+ user files area .

The current operator is displayed in the title bar of the Info window, and also in large blue letters inside that window, to the
right. It is pre-filled with the callsign in the Station Data. To change the operator, just press Ctrl+O and enter the desired call-
sign.

Even if you operate alone, and never need to change operators, we recommend you leave the {OPERATOR} macros in place
and put the wav files in folders with your callsign as the title. That will make it easy to add a guest op, and in the meantime the
substitution for {OPERATOR} will be provided from the Station Data page.
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Recording on the Fly

If you need to record or re-record a function key file in a hurry, you can do so from inside the program, so long as the Function
Key message calls only a single .wav file. This method also assumes that the microphone is connected to the radio via the
sound card (either permanently, or temporarily while you are making the recording). Despite the limitations, this is still very
useful, particularly for split operation in SSB contests where you want to specify a listening frequency that changes often.

The key sequence to start and stop on-the-fly recording is Ctrl+Shift+Fkey, in either Run or S&P mode.
When you start on-the-fly recording, a message will appear in the status line of the Entry window. If all is well, it will read “start
recording:[file path and name]. Press Ctrl+Shift+Fkey after you have finished recording, and the status line will read “recording
saved: [file path and name]. If you get an error message, and the Entry window is not large enough to read the whole thing,
simply stretch it horizontally until you can.

If you invoke a .wav file that is not found (for example, by having the wrong .wav file or an incorrect path in the .mc file), you’ll
be warned in the same place. To trouble-shoot path problems, you may have to stretch the Entry window horizontally, because
there is only limited space for the message in the status line.

Voicing Call-signs, Serial Numbers and Frequencies

The option of voicing call signs, serial numbers and frequencies character-by-character appears to be growing in popularity
among SSB contesters. One operator, to protect the sleep of his wife and young children, even created such a complete set of
voicing files that he could operate an entire Sweepstakes without a microphone.

When voicing is used, the !, # and @ macros can be used in SSB messages, and the program will send the individual letter
and number files that make up the call name or number that is to be sent, or if a complete or partial callsign is recorded as a
wav file, it will use that as all or part of what it sends. The individual letters, numbers, special characters and callsigns/callsign
fragments used for voicing are stored in the location defined in the letters file path on the Other tab of the Configurer . Again, if
you wish to have more than one operator, you will want to insert the {OPERATOR} macro in the letters file path in the
Configurer, and then record in a subdirectory named with the operator’s call-sign, so that Ctrl+O can be used to tell the
program which operator’s letter files to use.

Function key messages that use voicing may have more than one wav file or macro in them. Use commas to separate the
individual wav file names and macros within a message. For example, to send 59 followed by a serial number, you could
program your F2 exchange key as follows:
F2 Exch,fivenine.wav,#
where fivenine.wav is a wave file containing “five nine”. The # macro is separated from the wav file name with a comma.

Note: If you do not want to use voicing, be sure that your Run F5 key is programmed to a single space, not “!”.

Simple Voicing

This technique is used for voicing call-signs, as the simplest way of voicing serial numbers, for giving your listening frequency
when operating split, and for voicing the {SENTRST}, {ROVERQTH} and {COUNTYLINE} macros. The operator must record
files for the letters A-Z, the numerals 0-9, and a few special characters – query.wav for the “?” character, stroke.wav for the
slash indicator used with reciprocal operating callsigns, portable operation, etc. (which you denote in your log using the “/” or
slash character), and point.wav to voice the decimal point (in a frequency, for example). You can optionally also record a file
called strokep.wav for the “/P” (portable) indicator (e.g. to send “stroke portable”, instead of “stroke papa” with the separate
stroke.wav and P.wav files). When the ! macro is included in a function key definition, and the key is pressed, the program
substitutes a sequence of .wav files for the number or callsign. N1MM is parsed into N.wav+1.wav+M.wav+M.wav. The # and
@ macros work the same way for serial numbers and frequency, respectively.

When voicing callsigns or serial numbers the software looks in the user programmable “Letters Wav File Path” for all files. This
path is set in Config, Other tab and it allows the user to select the directory to use below Wav\LettersFiles. The default path is:
{OPERATOR}\ meaning it will look for files in Wav\LettersFiles\[OperatorCallsign].

If the Entry window callsign exists as a “callsign”.wav or a character group fragment (two or more characters/numbers) in this
directory, the character group wav file is played when voicing the callsign. If any unvoiced remaining characters exist, they will
be voiced as individual letter wav files. When defining function key wav file names, use file names that will not appear in
callsigns (use something like CQ_RUN.wav instead of CQ.wav, otherwise a callsign like WZ9CQY will be voiced with your
complete CQ message between the WZ9 and the Y!).

Advanced Voicing

This technique is used to voice serial numbers in a way that is considered to be more intelligible than a simple string of
numbers. The theory is that “One hundred twenty three” will likely be more easily understood than “one two three”, because of
the redundancy added by the “place markers.”
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In order to implement advanced voicing, you will need to record the following wav files. These files must be stored in the user
programmable “Letters Wav File Path” (Config, Other tab). The letters file path may contain the {Operator} macro, which is
essential if you have more than one operator. Example: If the path in the Configurer is {OPERATOR}\, the letter and number
files will be in the Wav\LettersFiles\{Operator}\ subfolder in the N1MM+ user files folder (which you can find using the Help >
Open Explorer on User Files Directory menu item in the main Entry window).

0.wav through 19.wav (20 files)
20.wav through 90.wav (only the even tens intervals) (8 files)
HUNDRED.wav and THOUSAND.wav

When you try to voice a number for the first time after program start, the program checks to see whether all the needed files
for advanced voicing are present. The outcome of the check is displayed in the bottom section of the Info window, so be sure
to open it. If one or more are missing, serial numbers will be voiced using the simple voicing method. The same check is also
made when changing operators (with Ctrl+O).

A complete table showing the files voiced for each number can be found in the files section HERE, in the file called “Advanced
voicing of serial numbers.txt”/ There is one further variation – if you have Logger set to use leading zeros, then one or two
leading 0.wav files are voiced before the number, as appropriate. We do not recommend using leading zeros with Advanced
Voicing. As you can imagine, “zero eleven” is probably not an improvement in intelligibility over “eleven” or “zero one one.”

A good way to get natural-sounding numbers is to record full compound numbers, like “one hundred ten” or “two thousand four
hundred and thirteen” with a program like Audacity (see below), and then use it to cut up the recording into the various
components you need. This will help you get a natural intonation pattern, making your voiced numbers easier to understand.
For example, numbers like “thirteen” are generally only at the end of compound numbers, and will typically be voiced naturally
with a falling intonation.

Recording Letters and Numbers

This is the hardest part of voicing. A more natural-sounding output will be much easier for other stations to understand, a
particularly important point with serial numbers. The question of how to reduce the robotic sound is a complicated one, as
users of the phone companies’ 411 service will appreciate.

The program-induced lag between numbers is very brief, so the real tricks are:

trimming the individual voice files so that they have as little “dead air” as possible before and after the letter or number.
adjusting the speed, intonation and audio level of the individual number files so that they go together as naturally as
possible.

The best single tool we have found so far for this purpose is the freeware Audacity audio editor. It incorporates a variety of
excellent tools for trimming, equalizing levels, and so on. A lot will always depend on how much time the individual op is willing
to devote.

When recording with Audacity, be sure to “Export as .WAV” using the default file creation settings; these work fine with N1MM
Logger, while some of its other .wav file options will not.

Here’s a tip some people have found to be helpful. This may or may not work for you.

Do not record individual letters and numbers. Instead, record callsign-like strings, such as AB1CD, EF2GH and so on.
Try to speak at the same speed you would during a contest. Then use Audacity (or whatever editor you favor) to cut the
recording apart, trim off any dead time, and equalize the levels. You can even use the Change Tempo tool (under
Effects) to speed up your recorded letters and numbers to sound more natural while retaining your voice’s pitch and
other characteristics – amazing!

Processing All Recordings with Audacity

Audacity is capable of processing files in bulk using “Macros” (formerly called “Chains” in older versions of Audacity). If you
are using callsign voicing you may find this capability helpful. Macros are created and run from the Audacity Tools menu. You
can select multiple files to process. The macro shown below does the following:

Removes high frequencies
Removes low frequencies
Normalizes the levels
Truncates silence (watch out for silence between syllables/words)
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Should I Use Voicing?

This remains controversial. Is the saving in energy during a contest worth the potential loss in intelligibility? You can potentially
operate an entire contest using “search and pounce”, without ever having to say a word yourself. On one hand, when you are
running, voicing the other station’s call-sign is pretty safe, since he knows who he is, and needs only to be confident that
you’re calling him. On the other hand, some operators feel that the loss of the “human touch” may deter casual contesters
from calling in.

From an intelligibility standpoint, voicing serial numbers is less attractive. In poor conditions, the “robotic” quality may make
copy harder, particularly for non-English-speakers. The jury is still out on this one as well.

Macros
One of the great strengths of N1MM Logger+ is its ability to send stored messages during contest QSOs, and to embed
macros in those messages. Macros are so called because they either expand to a given text string, for CW and digital modes,
or execute some program function. An example of the first is the {EXCH} macro, which expands to the exchange which you
entered in the Contest Setup Dialog’s Sent Exchange field – for example, if you enter John CT, that is what will be sent
whenever the {EXCH} macro is encountered.
The second (program control) type of macro is much more complex and more powerful. These macros can switch the
program from RUN mode to S&P mode, an essential attribute during NA Sprint; set or clear your transceiver’s RIT function; or
a myriad of other possibilities. In the sections that follow, you will find a comprehensive list of all the macros available in
N1MM Logger+, as well as useful examples of how stored messages can be structured for efficient operating.

General Macro Commands

General macros can be used in all the places mentioned above.

* Send this station’s callsign
* (asterisk) sends the station callsign as registered in the >Config >Station Info dialog. Same as the {MYCALL} macro.

! Send the callsign entered in the Callsign field
! (exclamation mark) sends the callsign entered in the Callsign field of the Entry window, or if that field is empty the last call
logged. Use this macro rather than {CALL} if you wish to have the Send Corrected Call function work correctly.

# Send serial number for this QSO
# (pound sign or octothorp) sends serial number for this QSO, or if there is no call sign in the Entry window, the serial number
for the previous QSO. When voicing numbers, Configurer, Other tab, “DVK Letters Path” is used for the location of the wav
files. Typically this will contain {Operator}\ so operator specific wav files will be played.

@ To voice the current receive frequency
@ (at sign) voices the current receive frequency, if you have recorded files for individual letters and numbers. Configurer,
Other tab, “DVK Letters Path” is used for the location of the wav files. Typically this will contain {Operator}\ so operator specific
wav files will be played. The frequency will be voiced to the nearest 100 Hz, dropping .0 if receiving on an even KHz
frequency. This capability can be used to avoid having to rerecord CQ messages on 40m split. Here is an example:
{operator}\CQ Listening.wav,@,{operator}\AndThisFreq.wav

{CALL} Send the previous or uncorrected call from the Callsign field of the Entry window
{CALL} Sends the call in the Callsign field of the Entry window as it was at the time the message started, or (if that field is
empty) the last call logged. Note: This will send the call as it was when the message STARTED. Use the ! macro instead to
use the Send Corrected Call function. Do not use the {CALL} macro in F5 (HisCall key) if you use ESM; instead, use the !
macro in F5. This is critically important if you ever hit [ENTER} in ESM before you have finished typing the call-sign, because
if you do, the characters entered after you hit [ENTER} will not be sent unless you use ! . Likewise, if you use the [INS] or ; key
to send the exchange, make sure you use ! in F5 and not {CALL}.

3/4/25, 5:37 PM N1MM Logger+ Documentation



153

{CHNAME} Sends the Name in the Call History file
{CHNAME} If a Call history file is loaded into the current database, and a callsign is entered for which a name is present in the
file, then this macro will send that name. Call History lookup does not have to be enabled for this macro to function.

{CLUSTER} Cluster callsign from Station info dialog
{CLUSTER} Cluster callsign from Station info dialog. See examples

{COMMENT} to add string to a QSO
{COMMENT} to comment field of current or last QSO

{CQ} Switches to Run mode
{CQ} Switches to Run mode

{END} Stores all macro text after the {END} macro string and executes it
To use the {END} macro, the function key must send a message. If nothing is sent, the {END} macro is ignored. The {END}
macro stores all macro text after the {END} macro string and executes it after CW, SSB or DIGI messages are sent. One use
of the {END} macro is to send CAT commands to the radio(s) after a transmission ends. All QSO message text placed after
the {END} macro command is not sent.

{END} Macro Examples
The {END} macro signals the program that the remaining {} commands are to be executed when the program returns from
sending the CW, SSB or DIGI messages. Here is an example:

Message: F1 {STEREOOFF}CQ TEST *{END}{STEREOON}
Whenever the F1 key is pressed, the stereo bit on the LPT port will be set to OFF. CQ will be sent via the current mode, and
after the message is complete, the stereo bit on the LPT port will be turned back on. Thus, one can listen to just the second
radio while the CQ is being sent, then listen to both radios after it is finished.

{EXCH} Sent Exchange
{EXCH} Sent Exchange, using the contents of the Sent Exchange box in the Contest Setup dialog. This macro is for
convenience, and works in many (but not all) contests. It is always possible (and in some contests necessary) to hard-wire the
contest-specific exchange into exchange messages instead of using the {EXCH} macro. When the sent exchange includes a
serial number (001 or # in the Sent Exchange box), the number sent will be for the current QSO if there is a call sign in the
entry window, or for the previous QSO if there is no call sign in the entry window.

{FORCELOG} Forces the program to log a contact
{FORCELOG} Same effect as Ctrl+Alt+Enter, but does not ask for a note to be entered. Note that force-logged contacts with
invalid exchanges can result in incorrect score calculations.

{FORCELOGNOTE} Forces the program to log a contact but with a note
{FORCELOGNOTE} Same as {FORCELOG} but asks whether you want to enter a note to explain the forced entry

{FREQ} Frequency from the contact in the Entry window
{FREQ} Frequency from the contact in the Entry window. Substitutes “R” for decimal on CW

{FREQUP}, {FREQDN} Change the radio frequency, typically after a contact is completed
Change the frequency by the increment in Configurer->Other. Used after the {END} macro.

{FREQROUND} Frequency from the contact in the Entry window
{FREQROUND} Frequency from the contact in the Entry window, rounded to the nearest kHz

{GRID} Gridsquare from Station info dialog
{GRID} Gridsquare from Station info dialog

More to send after the {END} macro?

Only macros that do not involve sending messages are executed when they are placed after the {END} macro. For
example, if you put {MYCALL} or “5NN” after the {END} macro, they will be ignored. Why? Well, the message is over,
there is nothing more to send. Conversely, all macros that only trigger program functions (don’t send messages) are
executed before any messages are sent, unless they appear after an {END} macro. Macros that do not involve
sending messages are only executed after the message is sent when they are placed after the {END} macro. For
example, if you put {MYCALL} or “5NN” after the {END} macro, they will be ignored. Why? Well the message is over,
there is nothing more to send. Conversely, all macros that only trigger program functions (don’t send messages) are
executed before any messages are sent, unless they appear after an {END} macro.
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{GRIDSQUARE} Gridsquare from grid textbox (contact in Entry window)
{GRIDSQUARE} Gridsquare from grid textbox (contact in Entry window)

{GRIDBEARING} Bearing between own gridsquare and grid textbox
{GRIDBEARING} Bearing between own gridsquare and grid textbox (contact in Entry window)

{REVGRIDBEARING} Reverse bearing between own gridsquare and grid in textbox
{REVGRIDBEARING} Reverse bearing between own gridsquare and grid textbox (contact in Entry window)

{KMGRIGDISTANCE} Distance in kilometer between own gridsquare and grid textbox
{KMGRIGDISTANCE} Distance in kilometer between own gridsquare and grid textbox (contact in Entry window)

{LOG} Logs the current contact. Same as the Log It button in the Entry Window
{LOG} Logs the current contact. Same as the Log IT button in the Entry Window. Digital: Put the {LOG} macro after the {RX}
macro.

{SwapContests} Wipes the current contact, changes to the next-to-last contest log and (un)wipes the contact.
{SwapContests} should be placed in a function key or bandmap button. When pressed it will switch to the next-to-last contest
preserving the QSO data partially entered. {SwapContests3} will switch among the last three contests. {SwapContests4} will
cycle through the last four contest logs.

{LASTCALL} Call of last station logged
{LASTCALL} Call of last station logged

{LASTEXCH} Exchange of last station logged
{LASTEXCH} Exchange of last station logged. For ROPOCO and LZOPEN only. It does NOT work for other contests!

{MYCALL} My Call from Station info dialog
{MYCALL} My Call from Station info dialog, same as *

{NAME} Sends the name as entered in the Entry Window name field
{NAME} Sends the name as entered in the Entry window name field for specific contests. (Example: TARA) or when no Entry
window name field, searches the name in the call history table

{NAMEANDSPACE} Sends the name as entered in the Entry Window name field
{NAMEANDSPACE} Sends the name as entered in the Entry window name field (Example: TARA) or when no Entry window
name field, searches the name in the call history table and adds a space behind it

{OTHERFREQ} Is replaced by the frequency of the non-active radio
{OTHERFREQ} Is replaced by the frequency of the non-active radio. Used for passing stations to other bands. Substitutes “R”
for decimal on CW

{OTHERFREQROUND} Is replaced by the frequency of the non-active radio to the nearest kHz
{OTHERFREQROUND} Is replaced by the frequency of the non-active radio, rounded to the nearest kHz. Used for passing
stations to other bands.

{OTRSP XXXX} Sends a command to an OTRSP device
{OTRSP XXXX} Used to send a command to an OTRSP (Open Two-Radio Switching Protocol) device. XXXX can be any
command known to the OTRSP device

{OTRSP RX} Sends the OTRSP RX command to the OTRSP device
{OTRSP RX} Sends the OTRSP RX command to the OTRSP device to activate RX corresponding to the currently active
radio.

{OTRSPOTHER RX} Sends the OTRSP RX command to the OTRSP device
{OTRSPOTHER RX} Sends the OTRSP RX command to the OTRSP device to activate RX corresponding to the currently
inactive radio. For example, if Radio 1 currently has keyboard focus and the {OTRSPOTHER RX} macro is invoked, the
OTRSP RX2 command is sent to the OTRSP device, but keyboard focus remains on Radio 1.

{PGDN} Change frequency up
{PGDN} Change frequency up equal to amount set under ‘PgUp/PgDn Incr (kHz)’ ‘in the Configurer under the ‘Other tab’. Can
be used after the {END} macro, as in NA Sprint function-key messages

{PGUP} Change frequency down
{PGUP} Change frequency down equal to amount set under ‘PgUp/PgDn Incr (kHz)’ ‘in the Configurer under the ‘Other tab’.
Can be used after the {END} macro, as in NA Sprint function-key messages

{PREVNR} Sends the QSO # of the last logged QSO
{PREVNR} Sends the QSO # of the last logged QSO
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{DIGQTCR} Opens the QTC Receive window
{DIGQTCR} WAE contest only. Open the QTC Receive window

{DIGQTCS} Opens the QTC Send window
{DIGQTCS} WAE contest only. Open the QTC Send window

{QTC} Sends the TU message after a block of QTCs has been completed
{QTC} WAE contest only. In CW, can be used in the TU message sent after a block of QTCs has been completed. In RTTY,
used in the Send All Heading SQTC message for the QTC block number (see the Config > WAE > Open QTC setup area in
the Entry Window)

{LRMHZ} Frequency Left Radio/VFO-A in MHz
{LRMHZ} Frequency Left Radio/VFO-A in MHz. Example: 28 when on 28.1234 MHz

{RRMHZ} Frequency Right Radio/VFO-B in MHz
{RRMHZ} Frequency Right Radio/VFO-B in MHz. Example: 14 when on 14.1235 MHz

{RUN} Switches to RUNning mode
{RUN} Switches into Running mode

{S&P} Switches to S&P mode
{S&P} Switches to S&P mode

{SPACE} Equivalent to pressing the spacebar key
{SPACE} Equivalent to pressing the spacebar key. Useful in non-ESM mode for auto-filling the exchange. For example: F2
exchange, 5nn 4{END}{SPACE}

{SPOTME} Send a self spot to the connected cluster
{SPOTME} Spot yourself in ARRL contests (and other contests that allow self-spotting, upon request from the contest
sponsor). Only works in RUN mode. Will not spot you on the same frequency (within the tuning tolerance set in the Configurer
under the Other tab) more often than every 10 minutes.

{STEREOOFF} Sets stereo audio OFF
{STEREOOFF} Stereo audio will be set to OFF

{STEREOON} Sets stereo audio ON
{STEREOON} Stereo audio will be set to ON

{TIMESTAMP} Date and Time from the contact in the Entry Window
{TIMESTAMP} Date and Time from the contact in the Entry Window

{TX} Keys PTT from a function key
{TX} CW/SSB: when sent in a function key will key ptt. Use Esc to turn off. This is a manual PTT from the keyboard. RTTY:
Check out the Digital macros below. Note: This does not appear to work with some radio/interface combinations.

{CLEARRIT} Reset the RIT to zero
{CLEARRIT} Reset the RIT to zero. Could be used in the message that confirms the contact, usually F3, or in the CQ
message (usually F1). Use the RIT when the station is calling, and when the contact is logged the RIT clears (using F3). Note:
Will only work for radios that support that function. Most ICOM radios do not. Consult the radio’s manual.

{CTRL-A}…{CTRL-Z} Sends Ctrl+A character to TNC
{CTRL-A}…{CTRL-Z} Sends Ctrl+A character to TNC. All characters from the alphabet can be used (A to Z). Not valid in
MMTTY and PSK. See examples

{ENTER} Sends ENTER character to TNC
{ENTER} Sends ENTER to TNC

{ENTERLF} Sends Return/Line Feed characters to the TNC
{ENTERLF} Sends Return/Line Feed to the TNC. Try this if {ENTER} doesn’t seem to work

{ESC} Sends Escape character to TNC
{ESC} Sends Escape character to TNC. Not valid in MMTTY and PSK. See examples

{DATE} Short date in Windows format
{DATE} Short date in Windows format as set in Regional settings

{DATE1} Date in Nordlink-TF/WA8DED format
{DATE1} Date in Nordlink-TF/WA8DED format (dd.mm.yy)- format: 26.02.99
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{SENTRST} Sends the RST as entered in Entry window Snt field
{SENTRST} Sends the RST sent as entered in Entry window Snt field. Do not expect the RST to be correct if the Snt box is
not populated. In voice modes, if voicing serial numbers and callsign, can be used to send the report from the Snt field. In CW
and digi, if there is no Snt field in the Entry window, this macro and the following space will be removed from the sent
message.

{SENTRSTCUT} Sends the RST of the current contact using cut format
{SENTRSTCUT} Sends the RST of the current contact using cut format. The most common use is to send the number 9 as
the character N (note that this is not useful in RTTY, as 5NN takes longer to send than 599 in RTTY). If the callsign box is
blank, the current contact mode is not set. Therefore, do not expect the sent RST to be correct if the callsign box is blank. If
you want to send exchanges with a blank callsign box, remove this macro and insert 5NN in the appropriate function key
message. In CW and digi, if there is no Snt field in the Entry window, this macro and the following space will be removed from
the sent message.

{TIME} Time in Windows format
{TIME} Time in Windows format as set in Regional settings

{TIME1} Time in Nordlink-TF/WA8DED format
{TIME1} Time in Nordlink-TF/WA8DED format (hh:mm:ss)- format: 17:36:55

{TIME2} Short GMT time (hhmm) format
{TIME2} Short GMT time (hhmm)- format: 1736 – Information on how this macro works in digital contests can be found at:
Time2 – How it works in the Contest Setup Instructions for digital mode contests.

{DAYTIME} Date in TAPR DayTime format
{DAYTIME} Date in TAPR DayTime format – format: 1907291736

{DATEGMT} Date and GMT time
{DATEGMT} Date and GMT time in Windows format (as set in Windows Regional settings)

{TIMEGMT} GMT time
{TIMEGMT} GMT time – format: 17:36:55

{F1} – {F12} Sends function keys F1 through F12
{F1} – {F12} Sends text assigned to function keys F1 through F12

{SOCALLSTACK} Enables single operator callsign stacking
{SOCALLSTACK} This macro enables single operator callsign stacking. When in RUN mode, this macro gives the operator
the ability to stack and retrieve a single callsign when multiple stations are calling. The stacked callsign does not need to be a
full call and it can contain a “?”. Single operator call stacking can be used in SO1V/2V or SO2R mode, in both entry windows,
and with/without ESM. When in RUN mode, {SOCALLSTACK} will move a call or partial call and place it in the callsign frame
and bandmap. If a stacked call exists on the call frame, the callsigns will be exchanged. If the callsign contains a question
mark (“?”), the cursor will highlight the question mark when the text is popped off the stack. If the callsign does not contain a
question mark, the cursor is placed at the beginning of the callsign upon return to the entry window. Using the existing
command ALT+D, it is possible to delete a stacked call from the bandmap and call frame without popping it off the stack with
when the callsign entry window is blank. {SOCALLSTACK} will also pop the call off the stack if ESM replaced the stacked call
with the string CQ-Frequency. When this occurs, the stacked call will be visible in the bandmap. Callsigns stacked by
{SOCALLSTACK} can be popped off the stack by pressing the space bar when the CQ-Frequency literal is on the call frame.
{SOCALLSTACK} in effect only stacks one other call. To stack multiple calls, use {STACKANOTHER}. More info and
examples in the chapter: Single Operator Call Stacking.

{STACKANOTHER} Stacks additional callsigns
{STACKANOTHER} Macro to stack additional callsigns in all modes. Equivalent to the key combination CTRL+ALT+G. More
info and examples in the chapter: Single Operator Call Stacking. Also used in multi-operator call stacking or Partner Mode.

{CLRSTACK} Clears the call stack
{CLRSTACK} Clears the call stack

{LOGTHENPOP} Logs the current station and starts a QSO with a stacked callsign in Run mode
{LOGTHENPOP} RUN mode only. Intended for use with the call stacking feature. It logs the current station, sending
corrections if enabled, pops the next call off the stack, and starts the next contact. The macro can be used with or without
ESM. If you are using ESM, the “Next Call” key (Configurer, Function Keys tab) should be set to point to the message
containing the {LOGTHENPOP} macro. If there is a callsign on the stack, ESM will automatically send the “Next Call” key in
place of the normal “End of QSO” key . The suggested “Next Call” key message is: {LOGTHENPOP} TU NW {F5}{F2} (Note:
Do NOT use ! in place of {F5}, and in contests with serial numbers, do NOT use # in the {LOGTHENPOP} message). In CW, if
{LOGTHENPOP} can not pop a call off the stack and the logged callsign was changed, send corrected call if enabled and the
TU message. More info and examples in the chapter: Single Operator Call Stacking.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/manual-operating/single-operator-contesting/#single-operator-call-stacking
https://n1mmwp.hamdocs.com/manual-operating/single-operator-contesting/#single-operator-call-stacking
https://n1mmwp.hamdocs.com/manual-operating/multiple-computer-and-multiple-op-contesting/#partner-mode-and-call-stacking
https://n1mmwp.hamdocs.com/manual-operating/single-operator-contesting/#single-operator-call-stacking


157

{LOGTHENNEXT} Non-automated version of {LOGTHENPOP}

{LOGTHENNEXT} works the same way as {LOGTHENPOP}, except that if {LOGTHENNEXT} is used in the ESM Next key,
the ESM Next key automation will be disabled and to perform the functionality the operator will have to press the function key
instead of using the Enter key.

{ROVERQTH} Sends the Rover QTH
{ROVERQTH} Sends the Rover QTH. Check out the chapter: Setup QSO Parties – CW and SSB – for more information on
Rover support. If voicing is used for serial numbers and callsigns, will voice the Rover QTH.

{POPPREVNEEDEDQ} Recalls the previous call & grid/exchange and places them in the entry window textboxes
{POPPREVNEEDEDQ} Cycles through the QSOs recently logged and places the call, grid/exchange in the entry window.
Useful in VHF contests where you are moving one or more stations from band to band. The currently popped QSO is
highlighted in the log window.

{POPNEXTNEEDEDQ} Operates the same as {POPPREVNEEDEDQ} but in the other direction
{POPNEXTNEEDEDQ} See {POPPREVNEEDEDQ}

{VARYMSG1} {VARYMSG2} A method for sending alternating function key messages VARYMSG VARYMSG2
{VARYMSG1} {VARYMSG2} These macros can be used in all modes. They allow the user to control how often an alternate
form of a function key message is sent instead of the primary form. There are two such macros (VARYMSG1 and
VARYMSG2); each can be used only once in a given Function Key set. The form of the macro is {VARYMSGn&Primary
Message&Alternate Message&How Often to Send Alternate&}. Substitute the form of the message you want to send most
often for Primary Message. Substitute the message you want to send at intervals for Alternate Message. Finally, specify how
often you want to send the Alternate message in “How Often to Send Alternate”. A “0” in the “How Often to Send Alternate”
field sends the Primary Message every time. A “1” in the “How Often to Send Alternate” field sends the Alternate Message
every time. Placing a number, N, greater than 1, in the “How Often to Send Alternate” field sends the Alternate Message every
Nth time.
Examples:
To send a varying CQ message in CW, in the CQ Key definition for the Run F1 function key,
{VARYMSG1 &CQ * *&CQ CQ * *&3&} will send a slightly longer CQ every 3rd time.
To send a varying TU message in SSB, in the Run F3 TU Key definition,
{VARYMSG2 &TU.wav&TUMYCALL.wav&2&} will send the TU.wav recorded message after a completed QSO, and send the
TUMYCALL.wav recorded message containing a longer thank you message (with your call sign in phonetics, for example)
only after every 2nd QSO.

Any function key text before or after the {VARYMSGn} macro string is preserved. So, RTTY users may place the {TX} {RX}
macros before and after the {VARYMSGn} macro string. The primary and alternate {VARYMSGn} fields may contain other
macros but the two {VARYMSGn} macros may not be nested.

{CTRLHOME} – Force the cursor into the callsign box
{CTRLHOME} forces the cursor into the callsign box and selects the text in the callsign box, regardless of where the cursor
(keyboard entry point) was when the message was invoked. Can be used in the CQ (F1) and/or TU (F3) messages to avoid
accidentally typing callsigns into the exchange box.

CATHEX and CATASC Radio Hex Macro Commands

{CAT1HEX} {CAT2HEX} Sends hex commands to radios 1 and 2
The {CAT1HEX} and {CAT2HEX} macros can be used to send commands to radio # 1 (CAT1HEX) or radio # 2 (CAT2HEX)
requiring hex data input. The macro name must be followed by the radio hex data and closing terminator }. An example is
shown below. There must be two hex characters per byte including zero (zero is entered as 00). Spaces are allowed
anywhere in the hex command string to make entry and verification easier.
You can not place more than one CAT1HEX or CAT2HEX macro in a function key message but the message can contain one
of each macro. The exception to this rule is when the {END} macro is used. More than one radio command can be sent to the
radio by placing a \ character between the radio commands. Spaces are allowed around the \ character. Multiple radio
commands are broken into separate radio commands and sent to the radio using internal command pacing.
Depending on the computer speed and the number of commands in the string, the use of these macros may delay the
operation of the program during sending of CW or other program operation. There are no precautions which prevent the use
of these macros while the radio is transmitting. If the user wants to switch an antenna port safely, use the {ANTRX#TOGGLE}
macros which contain a TX inhibit.
An example of an Icom command is: {CAT1HEX FEFE66E01C0102FD \ FE FE 66 E0 1C 01 02 FD }

{CAT1ASC} {CAT2ASC} Sends ASCII commands to radios 1 and 2
The {CAT1ASC} and {CAT2ASC} macros can be used to send commands to radio # 1 (CAT1ASC) or radio # 2 (CAT2ASC)
requiring ASCII data input. The macro name must be followed by the radio ASCII data and closing terminator }. An example is
shown below. All leading spaces before the radio command portion begins are removed and not sent to the radio. All other
spaces in the command are sent to the radio.
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You can not place more than one CAT1ASC or CAT2ASC macro in a function key message but the message can contain one
of each macro. The exception to this rule is when the {END} macro is used. More than one radio command can be sent to the
radio by either placing a \ character between the radio commands or by concatenating them together. Spaces before or after
the \ character are sent to the radio. Multiple radio commands using the \ separator are broken into individual radio commands
and sent to the radio using internal command pacing.
Special characters may be included in the radio command string by delimiting the two character hex value with < >. The
leading < and trailing > characters are not sent to the radio. Spaces are not allowed inside the < > characters. If the ASCII
radio command requires you to use characters that are interpreted by the Logger as macros (*, !, #), then in order to hide the
character from the Logger’s macro processing and send it to the radio, it must be encoded using this hex notation (replace *
with <2A>, ! with <21> , and # with <23>).
Depending on the computer speed and the number of commands in the string, the use of these macros may delay the
operation of the program during sending of CW or other program operation. There are no precautions which prevent the use
of these macros while the radio is transmitting. If the user wants to switch an antenna port safely, use the {ANTRX#TOGGLE}
macros which contain a TX inhibit.
Examples of several forms of this command are: {CAT1ASC PB1;\PB2;} {CAT1ASC PB1;PB2;} {CAT1ASC P<42>1;PB2;} .
You may place a space between the macro name and the radio CAT command to improve readability. All leading spaces after
the CAT1ASC macro command name are removed. As an example of the use of hex notation, this command contains a
macro character {CAT1ASC *UM0} and will not work correctly; the correct form using hex notation would be {CAT1ASC
<2A>UM0} . If the radio command needed to be terminated with a CR (Orion), the command would be {CAT1ASC
<2A>UM0<0D>}

CATAHEX, CATIHEX, CATACTHEX, CATAASC, CATIASC, CATACTASC Macro Commands

{CATA1HEX} {CATA2HEX} {CATACTHEX} {CATA1ASC} {CATA2ASC} {CATACTASC} Sends commands to the active
radio
The {CATA1HEX} {CATA2HEX} {CATA1ASC} {CATA2ASC} macros send commands to the active radio, sending ASCII or HEX
commands to the specified active radio (1 or 2, depending on the number in the macro name) in SO2R mode (or VFO in
SO2V). These are used for commands that should only be sent to the active radio (the radio with transmit focus), not to the
inactive radio. These radio specific commands can be used by SO2R users that do not have identical radios. These macros
follow the same syntax as the CAT1HEX and CAT1ASC macros.

The F-key macro text passes through a routine that removes CAT macros for radio(s) that do not qualify based on
Active/Inactive status. This allows one F-key string to be used for multiple purposes.

An example of a Pro3 macro string that switches DualWatch and the Rx antenna based on the radio activity is shown below.
{catA1hex fefe6ee0 12 00 00fd}{catI1hex fefe6ee0 12 00 01fd}{catA2hex fefe6ee0 07 c0 fd}{catI2hex fefe6ee0 07 c1 fd}.

The {CATACTASC} and {CATACTHEX} macros can be used if both radios accept the same CAT commands (e.g. identical
radios), eliminating the need to use pairs of {CATA1ASC}{CATA2ASC} or {CATA1HEX}{CATA2HEX} macros.

Macro: {CATACTASC} This macro sends the ASCII command to the currently active radio. Both radios must be able to accept
the same command; if the two radios require different commands, use paired {CATA1ASC} and {CATA2ASC} macros

Macro: {CATACTHEX} This macro sends the HEX command to the currently active radio. Both radios must be able to accept
the same command; if the two radios require different commands, use paired {CATA1HEX} and {CATA2HEX} macros

{CATI1HEX} {CATI2HEX} {CATI1ASC} {CATI2ASC} Sends commands to the inactive radio
The {CATI1HEX} {CATI2HEX} {CATI1ASC} {CATI2ASC} macros send ASCII or HEX commands to either inactive radio (i.e.
the radio that does not have transmit focus) in SO2R mode (or VFO in SO2V) mode. These macros follow the same syntax as
the CAT1HEX and CAT1ASC macros.
The F-key macro text passes through a routine that removes CAT macros for radio(s) that do not qualify based on
Active/Inactive status. This allows one F-key string to be used for multiple purposes.
An example of a Pro3 macro string that switches DualWatch and the Rx antenna based on the radio activity is shown below.
{catA1hex fefe6ee0 12 00 00fd}{catI1hex fefe6ee0 12 00 01fd}{catA2hex fefe6ee0 07 c0 fd}{catI2hex fefe6ee0 07 c1 fd}

CATDELAY Macro Command

{CATDELAY} Suspends the entire program for a specified time
The {CATDELAY} macro suspends the entire program operation to allow CAT commands to be received and executed by the
radio possibly before a transmission begins. The need for this macro is dependent on the computer speed, radio interface
rate, and radio type. The form of the CATDELAY macro is {CATDELAY N} where “N” is a user programmable delay in 50ms
increments. The value of N is internally limited to 20 which would be a delay of 1 second. Note that the program delay is
added after all CatMacro radio commands are sent to the radio no matter where the {CATDELAY} text appears in the function
key message text.
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Antenna and Rotator Control Macro Commands

{AUXANTSEL} Sends an antenna activation command in a UDP RadioInfo packet
{auxantsel nn} sends a UDP broadcast packet containing the antenna number (“Code” column) and name (“Antenna” column)
of an antenna listed in the >Configurer >Antenna table. Activation of the antenna and display of the name are the
responsibility of an external antenna controller/band decoder application. See appendix External UDP Broadcasts

{ANTRX1TOGGLE} {ANTRX2TOGGLE} {ANTRX3TOGGLE} {ANTRX4TOGGLE} Switches antenna ports
The {ANTRX1TOGGLE} {ANTRX2TOGGLE} {ANTRX3TOGGLE} {ANTRX4TOGGLE} macros can be used to switch between
antenna ports and toggle the receive antenna input on some radios when the program is not transmitting. Some radio models
have multiple inputs but lack the CI-V command to control the port so the functionality of these macros is radio dependent.
When the {ANTRX#TOGGLE} macro is executed, the numbered antenna port is selected. If the same antenna port macro
executed again and the radio is equipped, the receive antenna will be toggled on and off with each macro execution. If the
antenna port is switched to another port, the current setting of the RX antenna is stored and used when this antenna is
selected again. If only one radio antenna port is used it is only necessary to assign that {ANTRX#TOGGLE} macro to a F-key
to toggle the RX antenna on/off quickly.

{TURNROTOR} Turns the rotator (shortpath)
{TURNROTOR} Turns the rotator to the direction based on the calculated direction

{LONGPATH} Turns the rotator in the longpath direction
{LONGPATH} Turns the rotator to the calculated longpath direction

{STOPROTOR} Stops the rotator
{STOPROTOR} Stops turning the rotator. Note that per the manual some functions are not supported for all rotator brands

CW Macro Commands

CW macros are only substituted when used in substitutions for CW buttons.

CW Program Control and Prosign Macros

Macro keyword Substituted by

< Increment CW speed by 2 wpm.

> Decrement CW speed by 2 wpm.

~ Send half space character. See examples

] SK prosign      . . . _ . _

[ AS prosign      . _ . . .

+ AR prosign      . _ . _ .

= BT prosign      _ . . . _

CW Punctuation Macros

Macro keyword Substituted by Macro keyword Substituted by

? . . _ _ . . / _ . . _ .

, _ _ . . _ _ . . _ . _ . _

CW Macro Examples

Send the call entered in the callsign field

Macro: !
Send his call. The callsign entered in the callsign entry field will be sent by the program via the serial or parallel
port

Send CQ with your call sent as a macro substitution
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Macro: cq~test~de~*
The time between the words is a half space (~).
The * will be replaced with the callsign from the Station dialog {MYCALL}

Send part of exchange faster (report sent 6 wpm faster)

Macro: <<<5nn>>>{EXCH}
The report 5nn is sent 6 wpm faster than the exchange ( <<< >>> ).
It is not necessary to return the CW speed back the original speed at the end of the function key message.

SSB Macro Commands

SSB macros are only substituted when used in substitutions for SSB messages. SSB wav file names can be concatenated
using a comma.

{OPERATOR} Used to specify different wav files for each operator, to prevent confusion caused by having recorded wav files
in a different voice than the operator’s voice using the microphone.
See examples

SSB Macro Examples

Send the call entered in the callsign field
Macro: !

Send his call. The callsign entered in the callsign entry field will be sent by the soundcard. The location of
the letter and number files used to make up his call sign is set up in the Configurer under the Files tab. All
of the WAV files for the letters/numbers etc. must be present in that folder. See here

Let each operator have his own WAV files
Wave file name, e.g.: {OPERATOR}\cq.wav

If you specify WAV files like: {OPERATOR}\cq.wav , then as you change operators in a multi-operator
contest station, the WAV files will change as well. Each operator will have to create a full set of wav files.
Note that the WAV directory syntax indicates a subdirectory under the Wav sub-directory in the N1MM
Logger+ user files directory. You can also fully qualify the file name, as in: “C:\Users\
[yourWindowslogonusername]\Documents\N1MM Logger+\wav\{OPERATOR}\cq.wav”
The {OPERATOR} macro can be concatenated with other characters; for example, if you really wanted to,
you could use: {OPERATOR}CQ.wav and keep separately-named files in the same directory:

N1MMCQ.wav
PA1MCQ.wav

Play exchange with operators voice: {OPERATOR}\5905.wav
{OPERATOR} is a string substitution that is only implemented for SSB messages

SO2V/SO2R Macro Commands

SO2V/SO2R macros are only substituted when SO2V or SO2R is selected. The {CTRLFx} macros work only in SO2R mode,
because their functionality is not useful in SO2V.

{ACTIVEAUDIOTOGGLE} Toggles AF gain muting and unmuting of the AF gain on the active radio. This works only on radios
that support this capability via the radio control port

{INACTIVEAUDIOTOGGLE} Toggles AF gain muting and unmuting of the AF gain on the inactive radio. This works only on
radios that support this capability via the radio control port.

{ACTIVEAUDIOON} Unmutes audio on the active radio. This works only on radios that support this capability via the radio
control port.

{ACTIVEAUDIOOFF} Mutes audio on the active radio
{INACTIVEAUDIOON} Unmutes audio on the inactive radio

Improving CW Readability
Some calls have letter combinations where it’s hard for to copy correctly. E.g. 6Y2A is often copied as BY2A. To help
make your call easier to copy, go to Config >Change Packet/CW/SSB/Digital Message Buttons >Change CW
Buttons, and try changing the default F1 and/or F4 message where * is used for your call. In this example, 6Y2A
changes F4 from * to: > 6 < ~ Y2A.
Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional half space is added between
the 6 and Y. Try other combinations of the greater than symbol “>”, less than symbol “<“, or tilde “~” to make your call
easier to copy.
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{INACTIVEAUDIOOFF} Mutes audio on the inactive radio
{OTHERBAND} Sends the band of the other (inactive) VFO/radio (e.g. 80)

{OTHERMHZ} Sends the frequency of the other (inactive) VFO/radio in MHz (e.g. 3.5 and 3R5 in CW)

{OTHERFREQCUT} CW only. Sends last digits of the frequency of the other (inactive) VFO/radio as cut numbers. Uses the
cut number style selected in Configurer

{JUMPRX} Changes the RX focus to the other input window. If only one input window is shown the second window will be
opened

{JUMPRXTX} Changes both the RX and TX focus to the other input window. If only one input window is shown the second
window will be opened

{WIPE} Wipes the focus window. If the entry boxes are all empty, restores the last wiped contact (“unwipe”)

{CTRLFX} Sends on the other radio. SO2R only. Works with RTTY and CW. Thus a CW Button might look like: “tu
EXCH{CTRLF9}” where F9 on the other radio is set to send a CQ. It is important to note that via hotkey Ctrl+Shift+L will turn
this feature on or off. When off the CTRLFn macro is ignored. Entry focus moves to the other radio only when the callsign field
on the current radio is empty.

{CONDJUMP} Shifts focus and sends CW message when not split. When RX and TX focus are split between two radios, and
the user hits the Enter key, TX focus is first moved to the radio with RX focus. The CW message is sent. After the CW
message has been completed, TX and RX focus are both moved to the other radio. When RX and TX focus are not split
between radios, and the user hits the Enter key, the CW message is sent. When the CW message has been completed, TX
and RX focus remain unchanged. Typical usage in Sprint is: Run F3: TU {END} {CONDJUMP}

{QSYCQ} QSY to the last focus radio CQ frequency.
{STOPTX} Forces PTT to be released. In specialized SO2R scenarios. Rarely needed, and not for SO1R use.

Multi-User Macro Commands

Multi-User macros are only substituted when in Multi-User mode.

{MESSAGE} Sends a message (via function key) to other connected computers over the network. Explained in the next
section.

{PASS NAME} Substitutes the computer name for NAME. Pass frequency to the computer name on the network. The
computer names are listed in the Network window. The Pass frequency is rounded to the nearest kHz.

{PASS 1800}…{PASS 241000000} Inserts pass frequency for first connected computer found on the designated band. Valid
frequency values are every band in kHz 1800 through 241000000 (example: PASS 1800).

{PASSMSG NAME} Substitutes the computer name for NAME. Passes last QSO information to the computer name on the
network. The computer names are listed in the Network window.

{PASSMSG 1800}… {PASSMSG 28000} Passes last QSO information to the first connected computer found on the
designated band. Valid frequency values are every band in kHz 1800 through 28000 (example: PASSMSG 1800).

{MESSAGE} Macro Examples

The {MESSAGE} macro sends a message (via a function key) to other connected stations over the network. The info
will be shown in big red letters in the Info window from the receiving station(s). Place the name of the station directly
after the {MESSAGE} macro if you want to send the message to one specific station. If you don’t want to send to a
specific station, put “- ” in front of the message.

F8 Pass station {MESSAGE} BobsPC {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} {GRIDBEARING}deg.
{KMGRIDDISTANCE} km

Message sent to the station named “BobsPC” with info about the station in the callsign field. This is a macro which
could be used in a contest where a station is sent from one band to another

F8 Pass station {MESSAGE} – {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} {GRIDBEARING}deg.
{KMGRIDDISTANCE} km

Message sent to all connected stations with info about the station in the callsign field
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{LASTPASSEDFREQ} Sends the pass frequency for the station most recently alerted to expect a pass. Typical use case
would be to right-click on the band button for the band you want to pass the other station to, then send a function key
message containing the {LASTPASSEDFREQ} macro to tell the other station what frequency you want him to QSY to. The
right-click on the band button sends a message to the operator for that band, telling him the call sign of the station being
passed, and the {LASTPASSEDFREQ} macro is replaced by the pass frequency for the station he is being passed to. If the
frequency includes a non-zero fractional part (rounded to one digit), an R is sent in place of the decimal point. If there is more
than one station on the selected band, the Run station is selected if there is one, otherwise the first station on that band that
has a pass frequency set is selected. Note that if the last frequency passed has not changed (e.g. the station being passed to
is running and was passed to before), it is not necessary to right-click on the band button to reset the pass frequency.

Digital Macro Commands

The following substitutions will be made when sending function key.
In the Digital interface the macros below can be used but also all other macros shown under general macros.

{TX} Start transmission in the digital interface. Needed at the beginning of every Digital message.

{RX} Switch to receive in the digital interface. Needed at the end of every Digital message.

{CLRRX} Clear the RX window. Can be used either alone or after an {END} macro.

{CLRTX} Clear the TX window.

{SCQ} Resume CQ (placed at the end of TU message)

{GRAB} Grab first callsign from grab callsign window.

{DELALL} Delete all entries from grab callsign window.

{DELTOP} Delete top entry from grab callsign window.

{DELSEL} Delete highlighted entry from grab callsign window.

_ (underscore) MMTTY only – send idle tone.

^ Send the ! character (! sends the other station’s call; use ^ to put a ! character in a message)

{FILE:xxxx} Send a textfile. xxxxx is replaced by the name of the text file, which must be in the FunctionKeyMessages
subdirectory in the N1MM Logger+ user files area. The macro works any place in a message string. If the text file only
contains one line it does not add CR to end of line. When the text file contains multiple lines the CR from the last line will be
removed so the following text will be on the same line (use an {ENTER} macro if you wish to separate the following text from
the end of the file). Multiple {FILE:xxxx} macros are allowed in one message string

{LDIGFQ} Left Digital Interface frequency

{RDIGFQ} Right Digital Interface frequency

{PREVTIME} Send the time that was sent for the previous contact (for ANARTS and BARTG and similar contests; used for
sending time in response to a request for a fill after the contact has been logged)

{ALIGN} Move signal into bandpass range. Does the same as Align Buttons on Digital Interfaces and the PSK Engine

{PROFILE0} MMTTY only. Reset to HAM default definitions for RTTY mark, space, width

{PROFILE1} … {PROFILE8} MMTTY only. {PROFILE1} through {PROFILE8} in the function keys at the start of a CQ or S&P
macro will change MMTTY’s profile. This way it is possible to have one profile for CQing and another one for S&P or however
you want to set them up

{Hxxxx} HAL DXP38 only. The DXP-38 commands are in the form of Hex bytes that look like $80 $EA. This macro
substitution takes the text string in the form of {Hxxxx} (such as {H80EA}) and converts this to the appropriate command that
should be sent to the TU. See the RTTY chapter for more HAL DXP38 info

{DI1} … {DI24} Send text assigned to the digital message keys DI-1 to DI-24 in the Digital Interface window

{LOGTHENGRAB} Run Mode only. Log the current contact and grab the top callsign from the Grab window of the DI. If the
grab window is empty, logs the current contact and then switches to the TU key message instead of continuing with the rest of
the message containing {LOGTHENGRAB}. The suggested function key message using this macro is: {LOGTHENGRAB} TU
NW {F5}{F2} (Note: Do NOT use ! in place of {F5}, and in contests with serial numbers, do NOT use # in the
{LOGTHENGRAB} message).See the documentation in the Digital Call Stacking section
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$ WAE contest only. Used in the Agn RQTC message to send the QTC number when asking for a repeat of a single QTC (see
the Config > WAE > Open QTC setup area > RTTY Setup menu item in the Entry Window)

{ALT-T} Same as keyboard Alt+T – toggle TX/RX state

{ALT-Q} Same as keyboard Alt+Q – return to CQ frequency

{ENABLEAFC} Turn AFC on

{DISABLEAFC} Turn AFC off

{ENABLENET} Turn NET on (not applicable in FSK)

{DISABLENET} Turn NET off

Maessage: {TX}{ENTER} ! {LOGTHENGRAB} TU NW {F5}{F2}{RX}
Log the contact, grab a call from the Grab box and give an exchange to the next station. If the Grab box is empty, this macro
will log the contact and just send the TU message instead.

Message: {TX}{ENTER} ! {LOGTHENPOP} TU NW {F5}{F2}{RX}
Log the contact, pull the next callsign from the call stack and send the exchange to him (see Single Operator Call Stacking). If
you want to stack another station that has called you, just Alt-Click on the call in the RX window and it will be placed on the
call stack where you can get it with this macro.

Example Macros for the PK-232 (Digital Interface window)

Button text Macro

Abort {CTRL-C}R{ENTER}TC{ENTER}

TX X{ENTER}

RX {CTRL-D}

Band Up RB U{ENTER}

RxReverse RXREV T{ENTER}

Example Function Key Messages for the PK-232 (Entry window)

Mode Button text Message

Running F1 CQ X{ENTER}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ{CTRL-D}

Running F2 Exch X{ENTER} ! UR 599 {EXCH} 599 {EXCH} BK{CTRL-D}

Running F3 Tnx/Qrz X{ENTER} ! TU GL DE {MYCALL} QRZ{CTRL-D}

S&P F1 {MYCALL} X{ENTER}! DE {MYCALL} {MYCALL}{CTRL-D}

S&P F2 Exch X{ENTER}! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{CTRL-D}

Always use {TX} and {RX} together
Use {TX} and {RX} together in your macros. Otherwise, {TX} alone in a macro will cause the radio to remain in
transmit until you press an RX button or the ESC key



3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/setup/function-keys/tiki-index.php?page=Single+Operator+Call+Stacking


164

Example Macros for the KAM

Button text Macro

Abort {CTRL-C}R RTTY {ENTER}

TX {CTRL-C}T

RX {CTRL-C}E

Example Macros for the SCS PTC (Digital Interface window)

Button text Macro

Abort {ESC}CLR{ENTER}{CTRL-D}{ENTER}

TX/RX {CTRL-Y}

RX-Reverse {ESC}TR 1{ENTER}

RX-Norm {ESC}TR 0{ENTER}

45 Baud {ESC}BAU 45{ENTER}

75 Baud {ESC}BAU 75{ENTER}

Command mode {ESC}Q{ENTER}

– – – – – –

RTTY {ESC}Q{ENTER}BAU{ENTER}

PSK31 {ESC}Q{ENTER}PSKT{ENTER}

Example Function Key Messages for the SCS PTC (Entry window)

Mode Button text Message

Running F1 CQ {CTRL-Y}CQ TEST DE * * * k{ENTER}{CTRL-Y}

Running F2 Exch {CTRL-Y}! HI 599 {EXCH} {EXCH} K{CTRL-Y}

Running F3 CFM {CTRL-Y}! QSL TU DE * QRZ? K{CTRL-Y}

S&P F1 {MYCALL} {CTRL-Y}! DE * * K{CTRL-Y}

S&P F2 Exch {CTRL-Y}DE * TU 599 {EXCH} {EXCH} GL DE *{CTRL-Y}
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Example Function Key Messages for MMTTY (Entry window)

Mode Button text Message

Running F1 CQ {TX} CQ CQ CQ TEST {MYCALL} {MYCALL} CQ {RX}

Running F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} {RX}

Running F3 Tnx/Qrz {TX} ! TU {MYCALL} QRZ {RX}

S&P F1 {MYCALL} {TX} ! {MYCALL} {MYCALL}{RX}

S&P F2 Exch {TX} ! 599 {EXCH} 599 {EXCH} {MYCALL}{RX}

Send CQ
on new line F1 CQ {TX}{ENTERLF} CQ {MYCALL}{RX}

Packet/Telnet Macro Commands

Packet/Telnet macros are only substituted when used in the packet/telnet buttons.

Macros for use in packet/telnet buttons

{WAIT} Wait 5 seconds (fixed value)

Macros for use in ‘Comment For All Spots’ (in Telnet/Packet window)

{GRIDSQUARE} Gridsquare from grid textbox in Entry window

{MODE} Mode used in Entry window during contact

{QTH} QTH from section/qth textbox in Entry window

{ZONE} Zone for state/province/section/oblast/other textbox in Entry window

Quoted Strings
Surrounding characters with double quotes will cause function keys or mapped keys to send those keys for processing by the
textbox where the insertion point (cursor) is currently located, e.g. “/P” will cause “/P” to be appended to the callsign if the
insertion point is at the end of the callsign textbox. If you want to use this when the insertion point is not at the desired
position, you will first need to move the insertion point to the desired position before executing the keystroke that invokes the
quoted string.

If a quoted string starts with “http” or “https” the default browser will be opened on the url specified.

If a quoted string starts with the name of a .exe or .bat file, the string will be executed as a Windows command; for example,
“notepad.exe C:\contestnotes.txt” will open the Notepad program on the file C:\contestnotes.txt. The name of the .exe or .bat
file must not contain any spaces (the program looks for either “.bat” or “.exe” immediately before the first space character, if
any, in the quoted string).

Quoted strings can be used wherever macros can be used. They are handled like macros, but are processed after all macro
substitutions have been completed. Once any macro substitutions have been performed and any quoted strings have been
extracted and processed, what remains is sent as a CW or wav file message.

ESM – Enter Sends Message
ESM Overview

This section provides a step-by-step introduction to ESM. Try it, and we can almost guarantee you’ll like it.

The first step is to turn it on. Open the Config menu in the Entry Window, and select ESM
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Now close the menu and enter any call in the entry window. We’re assuming that you are doing S&P.

What’s different? Take a look at the F4 button. The highlight means that if you press [Enter] at this point, the F4 message will
be sent (which is what you want – your call). Press [Enter], your call is sent, but the cursor remains in the callsign field, and F4
is still highlighted. If he doesn’t answer the first time, just press [Enter] again. If he answers you, hit [Space], and the cursor
will move to the Exchange box. You are not ready to send your exchange to him yet, because you have not yet copied his
exchange, so now F8 (Agn?) is highlighted. Type in the exchange you receive from him, and look!
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Now F2 is highlighted. That means that the next time you hit [Enter], the program sends F2 and logs the QSO.

So instead of an 8 step process to work an S&P QSO, you have either 3 or 4:

1. Enter the callsign
2. Press [Enter]
3. (optional) If he doesn’t answer, press [Enter] when it’s time to call him again; if he does, press [Space] and copy his

exchange
4. Press [Enter] again to send your exchange to him and log the QSO.

But suppose you’re Running (Calling CQ)? The first thing to do is tell the program. You do that by checking the box next to the
word “Run”, either with your mouse or by hitting [Alt]+U. Now your Entry Window looks a bit different:

What is this “Big Gun” switch?
What’s described above is the default behavior in S&P ESM, which assumes you won’t get answers every time (or
even most times) you call somebody. If you’re louder than that, you may want to change the behavior. Go to the
Configurer (the first option on the Config menu), click it, choose the Function Key tab, and look for the option “ESM
sends your call once, then ready to copy S&P exchange.” Check that, and the behavior changes. Enter now sends
your call once, and the cursor then moves to the Exchange textbox. At the same time, the Function Key highlight
moves to F8 Agn. Type in his exchange, and the highlight moves to F2 Exchange. Press Enter, and your exchange is
sent to him. If you already have a valid exchange in the Exchange textbox, whether you type it or it is pre-filled, the
highlight will move directly to F2 instead of going to F8. Once F2 is sent, the QSO is logged, and the highlight moves
back to F4, ready to call the next station.



Big Gun Tip
One little trick to use with the Big Gun switch on is to program your call in F8 instead of “again”. This way, when you
don’t get the guy on the first call, hit Enter again to repeatedly send your call until he answers (and the cursor is
always in the right place when he does answer). 73 de Ted W4NZ
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Note the highlight is now on F1, because the first thing in most Run QSOs is a CQ. Press [Enter] and the program will send
F1.

Now someone answers. Type in his callsign and the window changes.

You’re starting to get the hang of this – the highlights mean that when you hit [Enter] the program will send F5 followed by F2
(on CW – on phone you would speak the callsign and then press [Enter] to send your exchange).

Once you have done that, the window changes again.
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Now the highlights tell you that you have copied a legitimate exchange (in this case the program has supplied it from the
callsign), and that the next [Enter] will send your F3 message and log the QSO.

So, type a callsign, hit [Enter] 3 times, and you’ve logged a QSO. Pretty slick!

Now suppose you’re like me and you fat-finger copying the exchange, so that you have nonsense in the Exchange box, like
this. In that case, the program reminds you:

If you hit [Enter] with an incorrect exchange, the program will send the F8 message and request a repeat. Alternatively, if you
see your mistake and correct it, the screen changes again to show the “F3 and Log It” highlights. Just press [Enter], the
program sends the F3 message, logs the QSO, and you’re done.

Once you’ve used ESM, I predict you’ll never go back to the old way again.

F1 Call CQ – A special Function Key that switches to Run Mode automatically
The developers have reserved F1 as the “Call CQ” key. Pressing it while in Search and Pounce mode will switch you
to Run mode. Although we do not recommend changing it, there are at least two ways to redefine F1: modify the
ESM function key assignment table (see below) or use the {S&P} macro at the end of your F1 definition to force the
program back to S&P mode.
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Two further refinements, and then this chapter is done. Open the Config menu again, and then open the “Configure Ports,
Telnet Address, Other” sub-menu. Click on the Function Keys tab:

In the left-hand column, note that I have checked “Send Corrected Call.” This neat feature, in Run mode, keeps track of
whether you have changed the callsign in the callsign box. For example, say you only copied “DL6A” at first, and filled in the
rest later. Eventually, you copy DL6ABC, and when you press [Enter] to send the F3 (TU message), on CW the program
sends “DL6ABC TU …” On phone, you’ll need to supply the correction.

In the right-hand column, the third checkbox is cumbersomely titled “ESM only sends your call once in S&P, then ready to
copy received exchange.” In shorthand, we call this the “Big Gun switch.” If you nearly always get stations you call the first
time, you can save a keystroke by having the cursor advance automatically to the exchange box after the first time you call. If
you often need to call again, don’t check it. If you have checked it, and need to call a station more than once, you just
press F4, regardless of where the cursor is.

ESM cursor behavior and the Digital Interface window

Because of the ability to transfer data from the DI window to the Entry window with a mouse-click, the behavior of the cursor
moving between the boxes in the Entry window is slightly different when the DI window is open than when it is closed. If you
are using ESM in CW or SSB with the DI window open and the cursor does not move between the call sign and exchange
boxes when you expect it to, try closing the DI window.

Repeating what was last sent

When in ESM mode, you sometimes need to repeat whatever you last sent, be it your call or exchange element or other
function key. The “=” key will do that. Rather than look at the Entry Window and figure out which function key to send, just
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press the equal key if you just want to send what you last sent again. Easy!

The chart below outlines the possible combinations of information in the Entry window, and what will be sent in each situation.
Note: ESM is affected by two options in the Configurer under the Function Keys tab:

the “ESM sends your call once in S&P, then ready to copy received exchange” check box (sometimes called the “Big
Gun” option)
the “Work dupes when running” check box (recommended)

ESM Mode Enter Key Actions

Callsign field Exchange
field In Run, Enter sends In S&P, Enter sends

Empty Empty CQ (F1) My Call (F4)

New Call (1st time) Empty or
invalid His Call + Exch(F5 + F2) My Call (F4)

New Call (repeat) Empty or
invalid Again? (F8) My Call (F4)

New Call (repeat) – ESM sends call once…
checked

Empty or
invalid Again? (F8) Again? (F8)

New Call (before sending exchange) Valid His Call + Exch(F5 + F2) Exchange +
Log(F2 + Log It)

New Call (after sending exchange) Valid End QSO +
Log(F3 + Log It) Log(Log It)

Duplicate Call Empty or
invalid QSO B4 (F6) do nothing

Duplicate Call (before sending exchange) Valid His Call + Exch(F5 + F2) Exchange +
Log(F2 + Log It)

Duplicate Call (after sending exchange) Valid End QSO +
Log(F3 + Log It) Log(Log It)

Dupe (1st time) – Work Dupes checked Empty or
invalid His Call + Exch(F5 + F2) do nothing

Dupe (repeat) – Work Dupes checked Empty or
invalid Again? (F8) do nothing

Dupe (before sending exchange) – Work Dupes
checked Valid His Call + Exch (F5 + F2) Exchange +

Log(F2 + Log It)

Dupe (after sending exchange) – Work Dupes
checked Valid End QSO + Log

(F3 + Log It) Log(Log It)

ESM on Phone – One Special Feature

There’s every reason, when running CW or RTTY, to use stored messages for almost every transmission. Phone is different –
you may not want to have the computer talk for you all the time.

Most operators choose to say callsigns and serial numbers themselves, rather than having the computer assemble
them from individual letters and numbers. See the next section for more discussion of these issues, and for information
on how to set up your Function Key definitions, whether you choose to let the computer do it all or not.

Caution
Don’t change the “key mappings” (below the red type on the Function Key tab of the Configurer) unless you
absolutely know what you’re doing – it can make a horrible hash out of ESM.
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In some contests like CQWW, the exchange is so short that it may be more hassle than it is worth to have the computer
voice your CQ zone.

Or… you may forget, particularly when you are running tired, and say the other station’s call and your exchange before you
realize you’ve done so.

To deal with this, N1MM Logger incorporates some additional flexibility. Here’s how it works, courtesy of the inventor, N2IC:

You are in Run mode. A station answers. You type in the callsign, and you use your live voice to send the callsign and
exchange. Now, the station you are
working is about to send his/her exchange. If, at this point, you hit the Enter key, your exchange wav file would be sent. That is
bad – you already used your live voice to send the exchange. Instead of hitting the Enter key, hit the Space bar. Now, type in
the other station’s exchange. Hit the Enter key, and the “Thanks” message will be sent, and the QSO will be logged.

In summary, the decision of whether to use the Enter key or the Space bar at that step in the logging process depends on
whether you use your live voice to send your exchange, or a wav file.

Here’s an illustrated version of how it works:

You’re running, and W8QZR calls you. You type his call into the callsign field.

Then, for whatever reason, you say his call and the exchange instead of having the computer do it. If you then hit Enter, the
program will, as it says, transmit his call and the stored exchange message. Not what you want.

Instead, you hit the Space bar.

Perfect! Now the cursor is in the Exchange field. There is nothing in the exchange field yet, so F8 (Agn?) is highlighted. Type
in his exchange.
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The highlight moves to the TU and “Log It” buttons, just where they should be. Hit Enter, and the computer will log the QSO,
send your “TU QRZ” message and be all ready for the next QSO.
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Skins, Colors and Fonts
2019-04-13

Skins, Colors and Fonts
The configuration settings for N1MM Logger Plus allow customization of most of the fonts and colors used in the program. To
access the Manage Skins, colors and Fonts dialog window, select Manage Skins, Colors and Fonts on the Entry window’s
Config menu.

Colors Tab

The Colors tab displays the current setting for 24 program colors. Clicking the [Change] button in the left column allows you to
select a different color. If you select a color different than the default skin color (read about the default color below), a [Reset]
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button will appear in the right hand. Clicking [Reset] will revert that color to the program’s default value, regardless of the skin
you are currently using.

Color settings can be grouped in three categories: Global, Shared, and Dedicated.

Global color settings affect every window in the program. Examples of Global colors are:
Background color for all program windows
Background color for program buttons
Background color for text areas of most windows

Shared color settings affect several windows in the program. Examples of Shared colors are:
Callsign colors (dupes, normal Qs, mults, double mults): Affect the colors of callsigns in the Bandmap, the Digital
Interface Receive window, and the Entry Window callsign field

In an example of extended sharing, in the Function Key Editor, Comment lines are identified by using the
callsign Dupe color, Run Message lines are the normal QSO color, and S&P Message lines are the
Double Mult color.

Callsign background colors (dupes, normal Qs, mults, double mults): control background colors in the Check
window and the Entry window Band Panel buttons.

Dedicated colors affect only one window. Examples of Dedicated colors are:
Frequency and line colors only affect the Bandmap(s)
Background color, color of normal text, and Color of My Callsign all apply only to the DI Receive window
Color of transmit indicator dot in the Entry Window – the color the normally red dot turns to when transmitting

Fonts Tab

The Fonts tab displays the current setting for five program fonts. Clicking on the font description allows you to select the font
family and default font size. If the selected font family and size are different than the default program font (read about the
default font below), a [Reset] button will appear to the right of the font description. Pressing [Reset] will revert that font to the
program’s default value, regardless of the skin you are currently using.

When making large changes to font sizes, some windows may not automatically adjust to the new sizes. It might be necessary
to close and re-open the windows for the new size to display properly.
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Entry Window Callsign
Controls the font family and size for the Entry Window fields – callsign, signal report and contest exchange
Medium – Screen Text and Tables
Controls the font family and size of warnings and special messages in the Entry, Info, and Multipliers windows
Small – most labels, Log and Network Status Window data
Controls the font family and size for notes in the lower portion of the Info Window and the grids of the Log and Network
Status Windows
Smaller – Buttons, Small Labels, Bandmap Window Callsigns
Controls the font family and size for all program buttons and tabs, notes in the upper portion of the Info Window,
summary table in the Available Mults and Qs Window, frequency and callsigns in the Bandmap, text in the Multiplier
Window. This font is used in every window of the program.
Fixed – Digital Interface, Telnet and Score Windows
Controls the font family and size for the Check Window, Telnet Window, Digital Interface Receive Window and the
Score Summary Window.

Font Sizer
Most windows have a “Font Sizer” in the upper right-hand corner. You can use this control to adjust the font of a
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The Skins Menu

Click the link at upper left.

Load Existing Skin

Skins are collections of settings that include the font family, font size, and colors. N1MM Plus includes a variety of built-in
skins (see screenshot) from which you can choose. You cannot change these built-in skins, but you can use them as a
foundation in creating customized skins.

Load Skin from File

Loads font and color settings from a .SKIN file. The files must be located in the SkinsAndLayouts subdirectory in your N1MM+
user files directory (the one pointed to by the Help > Open Explorer on User Files Directory menu item).

Load Default Skin

Self-explanatory. Gets you back to the default set of colors and fonts.

Save Current Selections as Skin File

After adjusting colors and fonts, you can save the settings in a .SKIN file, which will be stored in the SkinsAndLayouts
subdirectory in your N1MM+ user files directory.

particular window to be larger or smaller than the default. This control only changes the main font of the window.
See Show Form Font Sizers below.



Saving Your Skin

From a process perspective, you do not make Skin Changes. You make Font and Color changes. Begin by loading a
skin that resembles what you want. Then make changes to Fonts and Colors. When you settle upon a combination
that you like, select >Skins >Save current selection as a skin file.

Pressing the >Save button after making changes to Fonts and Colors will preserve the changes you have made, but
does not write those changes to a skin file. The original skin file from which you started is unaffected unless you
overwrite it with >Save current selection as a skin file.
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Other Settings

These are found in the lower frame of the dialog, and displayed along with any of the tabs

Show Form Font Sizers

Enabling this setting allows individual font sizes in specific windows, regardless of the default font size setting. When enabled,
Font Sizer controls will appear in the upper right-hand corner of the following windows: Telnet, Log, Available Mults & Qs,
Multiplier, Digital Interface, Info, Check, Score Summary, and Bandmap.

Snap Windows to Edges

Enabling this setting simplifies the task of aligning program windows adjacent to each other.

Tooltips

Tooltips display helpful hints that appear when you pause your mouse over certain locations in program windows. The option
at the bottom of the Skins, Colors and Fonts window allows you to choose between no tooltips (once you feel comfortable with
the program), “standard” tooltips (usually one line of text) and “balloon” tooltips that may be several lines. You’ll find tooltips
particularly useful in the Bandmap and Available Mults and Qs windows, where mousing over a call-sign displays the age of
the spot, who spotted it, how long ago, and anything that was in the Comment field of the spot.

Changing Font Size and Color in Windows’ Title Bars

From Tom, N1MM – 2017-04-05

N1MM+ users have posted questions and submitted feature requests to change the appearance of the title bars in the
application. Unfortunately, that is not something that Microsoft puts under application control. There are two things I found that
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you can do to improve the appearance of the title bars.

1. This is the important one. Go to Display Settings/Advanced Display Settings/Advanced sizing of text and other
items/Title bars and set the text size & bold attribute that you like. The bigger the text, the more legible it will be
(especially if bold), but the more space every window on your computer will take up.

2. To change the background color of the *inactive* windows, go to https://www.tenforums.com/tutorials/32118-change-
color-inactive-title-bar-windows-10-a.html to learn how to do it. You have to edit the registry, and be pretty facile with
hex/decimal manipulation to be successful at this one. Not recommended for most users. Again, this affects all the
windows on the system. I chose to make my idle title bars the same color as the main window color in the skin that I
use. Note that the color order is BGR, *not* RGB.
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Interfacing
2019-03-29

Interfacing
Serial, Parallel and Sound Card Interfacing

Ports Used for Interfacing

The program can interface with your radio using several ports from the computer. These ports are:

Serial port – A serial port can send CW, control PTT or communicate with your radio; with some radios you may be able
to do all three on one port. Hardware serial ports are rapidly disappearing from most computers, but if the computer has
open PCI bus slots. inexpensive serial and serial/parallel port cards are available. Alternatively, USB-to-serial adapters
may be used.
Parallel port – Parallel (LPT) port interfacing is quite flexible. In addition to controlling CW and PTT, N1MM Logger uses
the LPT port to control popular SO2R control boxes, and to send band information to a band decoder for automatic
antenna or bandpass filter switching. With one exception, USB-to-parallel adapters will not work here. Note also that
you will still need a separate virtual or hardware serial port for radio control, because radio control cannot be done from
a parallel port.
USB port – Most computers now have multiple USB ports. USB-to-serial adapters can be used to provide full serial port
capabilities, but be aware that not all such adapters (or their drivers) work well with N1MM Logger+. See USB Interface
Devices for specifics. There are also many different interface devices available that use USB port control for a full
gamut of capabilities. See the chapter Supported Hardware for more information.
Sound card – N1MM Logger+ can use your computer’s sound card to record your contest QSOs, and also to send
stored audio messages to your transmitter in response to function key presses. The sound card may be on the
computer’s motherboard, or a separate card internal to the computer, or an external sound card interfaced to the
computer with a USB cable. For these purposes, it is best to find a computer or sound card that has separate
microphone and line input jacks, as well as a line out jack. Some sound cards (particularly in laptops) now come with
only two jacks, or even with only one “combo” jack, and the input jack may not be switchable between microphone and
line levels. If this is the case, you will not be able to run your microphone through your sound card and record QSOs at
the same time.

Troubleshooting Com Port In Use Errors

Com Port In Use Error Messages – Occasionally Windows can get confused and orphan both physical and virtual
comports.  These ports are not visible to the user in Device Manager, but Windows will enumerate them causing failures when
trying to create a virtual com port where one invisibly already exists.   This procedure will in most cases allow the user to un-
hide hidden com ports in order to delete them eliminating possible com port conflicts.   Before starting, shut down your radio
and close any programs what may be using the virtual com ports, like SmartSDR CAT or other third-part applications.  

Click Start, point to All Programs, point to Accessories, and then click Command Prompt.
At a command prompt, type the following command , and then press ENTER: set
devmgr_show_nonpresent_devices=1
Type the following command a command prompt, and then press ENTER: start devmgmt.msc
Troubleshoot the devices and drivers in Device Manager.
Click Show hidden devices on the View menu in Device Manager before you can see all devices associated with the
computer.
Scroll down to the Ports section and you will be able to see all the hidden and unused COM ports. The hidden com
ports have a grayed out icon next to them.
To delete a particular port, click to highlight it and hit the Delete key on your keyboard. In the Confirm Device Removal
dialog box, click OK.
After you have deleted the unused and hidden COM ports, the list will show only those COM ports you use or may use
in the future.  Be careful not to delete com ports that are working properly.
When you finish troubleshooting, close Device Manager.
Type exit at the command prompt.
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Note that when you close the command prompt window, Window clears the devmgr_show_nonpresent_devices=1 variable
that you set in step 2 and prevents ghosted devices from being displayed when you click Show hidden devices.

Finally – if all else fails – this suggestion from Peter DF1LX: “I had this problem for some month. Nothing helped me what was
mentionened in this thread. Only using the registry editor and searching for the comx value show, that another program, which
never use any com port have a registry entry which show this com port. Deleting this registry entry and the problem was done.
I would do this as last option if the given hints are not working.”

Radio interfacing
Radio manufacturers have supplied various means for interfacing radios with computers for radio control functions. All of these
interfaces appear to the computer software like a standard RS-232 serial port, but the hardware actually used varies
considerably. At a minimum, the features supported by radio control interfaces include reading and setting operating
frequencies and modes. Most but not all radios that support radio control from a computer also supply commands for the
computer to control TX/RX switching (PTT). Newer radios support control of a wide variety of other features, such as RIT/XIT
control, switching of filters, and other functions.

The earliest radio control interfaces generally used TTL voltage levels on the radio connector which were not compatible with
RS-232 signal levels, and therefore required external radio control interface boxes to perform the level switching between TTL
(0 and +5V) and RS-232 (-12V and +12V) logic levels. These interfaces use the RS-232 TxD and RxD signal lines for data
communication, and some of them also require RTS/CTS handshaking, which can often be simulated by simply setting the
RTS line always on. These external radio control interfaces require DC power, which can either be supplied separately, or in
some cases from one of the RS-232 control lines (usually DTR or RTS), in which case the control line supplying the DC power
must be configured to be always on. At the computer end or the hardware connection, if the computer does not have serial
ports a USB-to-serial adapter can usually be substituted.

Some newer radios have true RS-232 serial ports, in which case an external level switching interface is not needed, but
otherwise these are configured similarly to the earlier TTL-level radio control ports. For the most part, these serial ports still
only support radio control data over the RxD and TxD lines, possibly supplemented by RTS/CTS handshaking, but in at least
one case (the Elecraft K3), the radio’s RS-232 port also supports direct keying of CW and PTT inputs using the DTR and RTS
control lines. Again, either a true serial port or a USB-to-serial adapter can be used at the computer end of the connection.

More recently, as serial ports on computers have become increasingly rare, some newer radios have incorporated a USB-to-
serial adapter internally, so that the hardware connection to the radio is a simple USB cable. Nevertheless, the drivers for
these USB ports still appear to the software to be standard RS-232 serial ports. In many cases, the same USB connection is
also used to drive a CODEC (“sound card”) internal to the radio, which eliminates the need for audio connections between the
computer and the radio, but from the point of view of the software, that single USB connection appears to be two separate
devices: an RS-232 serial port, and a standard computer sound card. These two devices must be configured separately,
regardless of the fact that they share a single cable.

Interfacing for PTT and CW Keying

Choosing Your PTT Method

PTT is a commonly-used abbreviation for RX/TX switching (derived from “push-to-talk” used in voice modes). N1MM Logger+
offers multiple methods for controlling PTT on your radio. Unless you use VOX, or QSK on CW, you will need to select one of
these methods, and your choice may vary depending on the mode you want to operate, your radio’s capabilities and how you
choose to use them, any existing interfaces or other PTT wiring done for use with other programs, and so on.

As a general rule, you should decide on one method for PTT at a time. You may use different PTT methods in different modes,
but in each case there should only be one method active in that mode. Having two PTT methods active simultaneously has
been known to cause problems with some radios, such as failing to return to RX at the end of a transmission

The available methods are:

Hardware PTT – uses a serial (COM) or parallel (LPT) port. The program controls the state of individual lines on the
port for PTT and CW (and in the case of the LPT port, additional functions can also be controlled from the same port).
Many recent radios offer choices for PTT keying via control lines on the virtual serial port(s) created by the USB driver
for the radio. In these radios, the radio’s menu is used to choose which port and control line to use for PTT (or “SEND”)
keying. This method is convenient when available, since no external hardware is required. When using a parallel (LPT)
port for keying, this may require a special driver (INPOUT32), which is downloaded during initial program installation
but requires an additional step to register it – see Installing the Software for specifics. Hardware PTT works with USB-
to-serial adapters, but will not work with USB-to-LPT adapters except for the Piexx SO2RXLAT. In some radios that
have multiple input connections for PTT, the choice of which connection to use may depend on the choice of the input
port you use for audio.
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Software PTT – uses software PTT (TX/RX) commands sent to the radio through the radio control port. This is probably
the easiest method to configure, but there are situations where it may not be available or advisable. In certain radios,
software PTT may not be available, or it may only work with certain choices of audio input connections to the radio. On
the other hand, for certain radios that incorporate a radio CODEC (effectively, a sound card inside the radio), if you
wish to use the CODEC either for AFSK (digital modes) or as a voice keyer for SSB, you may need to use Software
PTT. Check the Supported Radios section for your radio setup instructions. Software PTT works well with some radios,
but with some others which require a longer delay between CAT commands, it may be slower than hardware or
Winkeyer PTT. In the case of Icom radios, if a data collision occurs on the CI-V bus, the PTT may fail to actuate or hang
in transmit, requiring an ESC to return to receiving. Also, please note that N1MM Logger+ cannot control PTT for a
built-in DVK in the radio (as distinct from a CODEC that is used to send messages stored in the computer) because if
the recorded message is not sent from the computer, the program cannot know when the recorded message has
finished. Such DVKs must use VOX for this reason. Likewise, N1MM Logger+ cannot control PTT for CW sent from a
paddle connected to a keyer in the radio, since it does not know when the paddle is being used.
Winkeyer PTT – uses PTT provided by the Winkeyer CW keyer, but also works for SSB and digital modes. If a port is
set up to control a Winkeyer, PTT is automatically activated on the real-panel jacks of the Winkeyer, and it needs only
to be cabled to the appropriate jack on your radio. If you are using the original, version 10 of the K1EL Winkeyer, the
Pin 5 Function in the Configurer Winkey tab must be set to PTT (this is not necessary with newer versions of the
Winkeyer). Winkeyer PTT is the most flexible of the PTT options, particularly on CW, because you can set the inter-
character “Hang Time” separately from the end-of-message “Tail Time”. The settings are on the Winkeyer tab in the
Configurer. If you chose to use one of the other methods for PTT control, simply omit this cable.
Digital Modes PTT – To use a radio CODEC for AFSK in digital modes, with some radios PTT may need to be handled
by N1MM Logger+ using Software PTT (see above). For AFSK not using a built-in radio CODEC or for radios that do
not have this limitation, you can use any of the Logger’s other PTT options. If you are using FSK, you will normally
configure your software and hardware to use PTT on the same port as the one you are using for FSK keying. If you are
using software such as MMTTY for FSK, PTT on the FSK port is controlled by the digital software “engine” and not by
N1MM+ itself. If the only modes you use PTT in are digital modes, you may choose to configure PTT in the digital
program only (e.g. MMTTY). However, if you configure a port for PTT and/or FSK keying in your digital program and
you want to use the same COM port for PTT in non-digital modes or for CW keying, then you must check the “Digi”
check box for that port in the Hardware tab of the Configurer. This tells the Logger to close the port and hand it over to
the digital program when you switch to a digital mode. If you configure PTT entirely in N1MM+ and not in the digital
program, do not check the “Digi” check box.

For SSB or digital modes, use any of the options above. Remember, if you are using your radio’s audio CODEC, you may
need to use Software PTT and not COM or LPT hardware PTT control.

For CW, if you have a Winkeyer, if you are not using QSK or semi-breakin but want PTT control instead, then Winkeyer PTT
is recommended, because it gives you the most flexibility in setting hang and tail time. If you do not have a Winkeyer, but have
a serial or USB port, Hardware PTT can be done using a simple transistor switch connected to the appropriate line of a serial
port or a USB-to-serial adapter. CW and PTT can be handled on a single port. With some radios it may be possible to do radio
control on that port as well if the radio does not need the RTS and DTR lines to be used in a particular way for radio control
(such as handshaking on RTS/CTS, which makes the RTS line unavailable for CW or PTT keying).

Choosing Your CW Method

N1MM Logger+ offers multiple methods for keying CW on your radio.

The available methods are:

Hardware CW – uses serial (COM) or parallel (LPT) ports (usually separate from the radio control port). Software
controls the state of individual lines on the port for PTT and CW (and in the case of the LPT port, additional functions).
When using a parallel (LPT) port, this may require a driver (INPOUT32) which is installed by the Full Installer but may
require a one-time “Run as Administrator” step to register the driver. This method works with USB-to-serial adapters,
but will not work with USB-to-LPT adapters except for the Piexx SO2RXLAT. As for PTT, many recent radios with USB
ports offer the capability to choose a control line (DTR or RTS) on the (or one of the) virtual serial port(s) created by the
USB driver for the radio. This choice is convenient, since it does not require additional hardware.
Winkeyer CW – uses a K1EL Winkeyer or equivalent. This is the most-recommended method, because it is virtually
immune to timing problems that might be caused by unexpected events in the computer (such as a Windows Update,
virus checker update, or other resource-intensive activity that might be taking place behind the scenes). CW timing with
a Winkeyer is controlled externally to the computer. The Winkeyer can also be used with a paddle as a regular CW
keyer, with the advantage (over a separate keyer or the built-in keyer in some radios) that paddle and computer keying
are integrated, e.g. touching the paddle interrupts computer keying without any doubling up or garble, and paddle and
computer speeds are the same.
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CW Keying Using CAT Commands

Circuits for CW and PTT Keying

Parallel (LPT) Port for CW and PTT

This is a typical simple interface that can be used for parallel port CW and PTT keying. Separate circuits (transistors) are used
for CW and PTT.

No Support for CW Keying by CAT Command
There are a few radios (Kenwood, Elecraft, Flex) that allow sending CW via “KY” radio command messages. Some
radios that have built-in CW memories may allow those memories to be sent using CAT commands. These CAT
Command methods are not supported by the Logger team. This does not mean it won’t work at all. You can
program such radio command messages into function key messages using {CAT1ASC} macros, but apart from the
fact that this only works with certain radios, there are several other limitations to this method:

You can only put one of these CAT1ASC macro commands in each function key message.
The number of characters that can be sent in a KY command message is limited (or with some radios, fixed to
an exact specified number of characters). Note that this is the number of Morse code characters, including
spaces, that the message is converted to, not a count of the number of characters in the N1MM Logger+
command. Therefore you need to design your messages so that they will take no more than (or exactly) that
number of characters, even with the longest call sign and exchange you are likely to need during the contest.
If you exceed the length limit in a composed message, nothing might be sent.
You cannot send ad lib Morse code from the program this way, i.e. the Ctrl+K command to send keyboard CW
does not work with this method.
Editing call signs on the fly does not work with this method.
The “send corrected call sign” feature does not work with this method.
The “CW autosend” feature does not work with this method.
The CW speed using this method is controlled from the radio’s CW Speed control, not from N1MM Logger+.
The Logger’s CW speed control macros and the PgUp/PgDn keys will not work with this method.
Once the function key containing one of these messages has been pressed, you can only use the Esc key to
interrupt the message from N1MM Logger+ if the radio supports this capability via CAT command and it has
been implemented in N1MM+ for that radio. If not, you might be able to interrupt a message in progress from
the radio’s front panel controls.
If you want to use auto CQ repeat in N1MM Logger+, the repeat interval is measured from the start of one
message to the start of the next one, i.e. it includes the message as well as the time between messages.
Therefore it has to be longer than the duration of your CQ message at the slowest CW speed you use. If you
change CW speeds using the radio’s speed control, a repeat interval that is appropriate for the slowest CW
speed will likely be longer than you would like at higher speeds.



N1MM Logger+ Does Not Support CW Keying by Audio Tone
The team sometimes gets queries about why the Logger’s CW won’t work with software or interface units that feed
audio tones to a transceiver. Typically, this involves the Signalink USB interface or the software program FLDIGI.

N1MM Logger+ does not and will not support this way of generating CW. There are a couple of reasons. First, on
many transceivers, when they are in USB or LSB mode, you are precluded from using CW filters and other CW
receiving aids. Second, sound-card CW is fraught with problems, including audio noise in your CW, RF interference
to the CW tones, and the possibility of generating two or three separate CW signals due to audio harmonics. It’s just
a bad idea!

The simple interfaces described below are easily constructed at minimal cost with readily available components.
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LPT pin Function

1 Strobe

16 PTT output

17 CW output

18 Ground

For hints on diagnosing problems with a parallel port, see the note under Additional Parallel Port Interfacing just a bit further
on.

Serial (COM) Port

When a serial port is used for CW and/or PTT keying, it is the RTS and DTR lines that are used.

DB9 pin DB25 pin Function

7 4 PTT output (RTS)

4 20 CW output (DTR)

5 7 Ground

Using a transistor

The keying circuit for serial port CW or PTT keying is similar to the circuit used with a parallel port.

Equivalents for the 2N2222 are 2N3904, BC547 or BC548.
NB. It isn’t a bad idea to add a 1 kOhm resistor from base to ground, also adding a shunt capacitor of 10 nF is highly
recommended at the collector output to ground in order to prevent RF feedback to base and subsequent blocking.

CW and PTT Port Assignments
The CW and PTT lines for a radio must be on the same serial/parallel port.Example: When COM4 is the CW Port
and Radio 1 or Both is selected, PTT control for Radio 1 must also be on COM4. USB-to-serial converters are
supported, but USB-to-LPT (parallel) converters are not.
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Using an opto-Isolator (opto-coupler)

Some users prefer to use an opto-isolator rather than a transistor, in order to provide more protection for the serial port in the
event of something going wrong downstream. In that case, however, two special considerations may apply:

You may need to place a diode in series with the input of the opto-isolator, to protect it from negative voltage swings on
a standard serial port. Check the specifications of the opto-isolator you use to determine whether this is necessary.

Some opto-isolators may not pull their output “low” enough (close enough to zero volts) to switch PTT or CW on a given
transceiver. In that case, appropriate “pull-down” measures must be applied.

USB Port Keying
Not all computers have serial ports any more, or even if they do, there are not enough to control transceivers, packet, serial
CW keying etc. In this case consider a USB-to-serial port adapter. Most of them do nicely for basic radio control functions
and/or for CW and PTT keying. These devices require drivers within the computer; make sure that drivers for your operating
system are available before trying to use one of these adapters.

The timing of serial port or parallel port keying can be subject to “stuttering” caused by the CPU being unavailable to control
the port while it is busy with other tasks. For perfect CW not dependent on Windows processes the usual answer is to use a
Winkeyer by K1EL. The computer communicates with the Winkeyer using normal ASCII characters via the serial port, which
are buffered inside the Winkeyer and converted to CW there. The CW timing is thus independent of computer processing
delays. A USB/serial adapter will work fine with a Winkeyer; in fact, most Winkeyers delivered today are WKUSB keyers with a
USB-to-serial adapter built in to the keyer. Check the Winkeyer manual for more information.

In some cases PTT and CW keying may unexpectedly stop working when using a USB-to-serial converter, because Windows
has shut down the USB port to save power. Check this Windows setting:

Control Panel; System Icon,
Hardware Device Manager Tab or button.
Expand USB Serial Bus Controllers
Highlight each USB Root Hub or Generic USB Hub in turn
Double click for Properties settings, Power Management tab
Remove the check mark from ‘Allow the computer to turn off this device to save power’

The box is checked by default in most cases
Repeat for every USB Root Hub and Generic USB Hub
Reboot the computer

Another overview of serial- to-USB converters can be found at the RTTY contesting page by AA5AU at:
http://www.rttycontesting.com.

Additional Parallel Port Interfacing
If the type of CW port chosen is LPT1, LPT2 or LPT3, and a hardware LPT port is used, additional information will be present
on the chosen parallel port. In the Configurer, select the radio that corresponds with the selected port (Radio 1 or Radio 2).
The BCD data on the LPT is that of the current active radio/VFO. The band data is available on multiple LPT ports — Radio 1
on LPT1, Radio 2 on LPT2 and so on. USB-to-LPT converters are not supported.

LPT pin and Description
1 Return for PTT and CW output. This pin has limited sink capability, so you may need to buffer it
2 Band output (Least Significant Bit) set by Antenna tab in Configurer. This pin is also used to stop the message sent on the
hardware DVK.
3 NA-compatible TX focus. – Radio 1/2 Pin 3 will go to a logic LOW level (0V) when Radio 1 has TX focus and to a logic HIGH
level (5V) when Radio 2 has TX focus. (NB. LPT pin 3 is the complement of Pin 14). Set ONLY if no hardware DVK output is
selected (msg# 1).
4 NA-compatible RX focus. LPT Pin 4 will go to a logic LOW level when Radio 1 has RX focus and to a logic HIGH level when
Radio 2 has RX focus. Set ONLY if no hardware DVK output is selected (msg# 2).
5 (Shift+singlequote) to toggle for Stereo mono. LPT Pin 5 will go to a logic LOW level for mono audio and to a logic HIGH
level for stereo audio. Set ONLY if no hardware DVK output is selected (msg# 3).
6 Set ONLY if no hardware DVK output is selected (msg# 4).
7 Band output set by Antenna tab in Configurer
8 Band output set by Antenna tab in Configurer
9 Band output (Most Significant Bit) set by Antenna tab in Configurer
14 Radio select A/B (transmit focus) for DX Doubler compatibility. LPT Pin 14 will go to a HIGH level when Radio 1 has TX
focus and to a LOW level when Radio 2 has TX focus. (NB. LPT pin 14 is the complement of Pin 3)
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15 Footswitch input port
16 PTT output, high = transmit mode
17 CW output
18 – 25 Return for Band output

Diagnosing Parallel Port Problems

Will all PCI-e Parallel Port Cards Work?
As fast as technology moves, it is difficult to be categorical about this, and there has been some traffic on the reflector
suggesting that some families of LPT port chips are not compatible with the software components used by N1MM Logger+ to
control individual lines on an LPT port. Experimental results show, however, that two families of chips do work, as of February
2013: These chips are used both in single-port cards and in combination cards (2 serial and one parallel, for example), but
have only been systematically tested in the one LPT port variant.

MOSChip Semiconductors series MCS9900. This company is now owned by Asix Electronics Corporation,. and the
very latest driver can be downloaded here. Specify PCIe Bridge for the product family. These chips are used in the
SYBA SD-PEX10005 1 Port Parallel Card, available from the usual online sources.
Oxford Semiconductor OX16PC952-954. This company’s chips are used in several 1-port LPT cards, including the
StarTech.com PEX1P, which also is widely available. Originally, they were thought to be incompatible with parallel port
switching, but this does not appear to be the case (contact N4ZR for details).

Diagnosing LPT Port Issues
Recently, a number of users have encountered difficulty using PCI-e LPT ports to control band decoders, SO2R controllers,
and other devices. After a great deal of experimentation, here are a few things to try if you have trouble.

Make sure you have the correct address specified in N1MM’s Configurer. Typically, PCI-e add-in cards seem to have
I/O addresses that are not the standard ones for a given port number. For example, built-in LPT1 ports typically have
an address of 0378 for our purposes, which is the lower of the two I/O addresses given for the port in Device Manager.
On the other hand, 3 different PCI-e cards tested all have fixed I/O addresses at D000 and D010, regardless of the LPT
port number, and the correct address is the higher one – D010. When in doubt, try them both.
The first time you run N1MM Logger+ after a new installation, don’t run it from a shortcut. Instead, go into the N1MM
Logger+ program directory, right-click on the executable (.exe) file, and select “Run as Administrator”. It has been
suggested that this step may be necessary in some cases, in order for the component that drives the parallel port to be
registered properly, and it can’t hurt. This is a one-time only step.

External DVK Interfacing
When you select DVK on a parallel port, antenna selection via that port is disabled, because the DVK pins and the antenna
pins on the LPT port overlap. Following is the table of pin-outs for external DVK control:
F1 pin 3
F2 pin 4
F3 pin 5
F4 pin 6
F5 pins 4 and 6
F6 pins 4 and 5
F7 pins 4, 5, and 6.

When F1-F7 are pressed, a 100 ms. pulse is sent to the relevant pins for external DVK control.

In order to record messages on an external DVK, you will need to connect your microphone to it directly, and follow the
procedure outlined in the DVK manual; N1MM Logger+ support is limited to triggering the first 7 memories when the
corresponding Function Key (F1-7) is pressed, and stopping stored message playback when the ESC key is pressed. Some
external DVKs have as few as 4 memories, in which case only F1-F4 will trigger playback.

Band Decoder Output
Pins 9, 8, 7 and 2 can be set using the Antenna tab in the Configurer. The output on the pins will follow the selected code
which is being set up by the selected antenna.
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Sample configs

To replicate the default Top-Ten Devices behavior, you would need to set up the Antenna tab in Configurer as shown above to
the left|
It is possible to use more than one antenna per band with N1MM Logger+. With Alt+F9 it is possible to toggle between these
antennas. List the bands for each antenna with a comma separating them – e.g. 3.5,7

3/4/25, 5:37 PM N1MM Logger+ Documentation



188

Sample Config > Antenna for two stacked antennas

You will need to make appropriate provision with a diode matrix on the output of your band decoder to select the appropriate
antenna or antennas when a given code is sent from the program to the decoder. For example, if your band decoder outputs
positive voltage and you use a tri-band beam with a single coax feedline, you will need diodes to sum the three signals from
your band decoder into the one feedline.

Bearing Data

Bearing data for rotator control is currently not available on the LPT port.

Sound Card Interfacing
Of course, you can always use one of the many commercial audio interfaces designed primarily for digital modes. However, if
you have a sound card that permits feeding microphone input through it to the line output (most do), and has a mixer that will
allow you to independently set the level of the microphone, .wav playback and internally-generated audio (such as for AFSK),
you really don’t need an interface at all. On SSB, simply plug your microphone into the sound card mike input. Cable the
sound card’s Line Out to the Line In or Phone Patch input of your transceiver, and you’re done.

You may encounter hum, resulting from difference in AC potential between the chassis of your computer and that of your
transceiver. In that case, a 600-ohm isolation transformer in the cable between sound card and transceiver is the cure.
Another approach is to bond the transceiver and computer chassis together with a heavy wire. Many people do both.

If you absolutely must feed the audio output of your sound card into the microphone jack of your transceiver, the level will be
far too high. In that case, a simple 10:1 resistive voltage divider is the solution, placed in the audio cable before the
microphone jack.
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In Windows 10 and 11, starting some time in 2018, there is a Privacy setting in Windows that must be set correctly to enable
applications, including N1MM Logger+, to gain access to sound card inputs (e.g. for recording received audio or for decoding
digital modes). In the Windows Settings window, choose Privacy, then from the areas on the left side of the window, select
Microphone. An option should appear called “Let apps use my microphone”. Set this to On. Starting with the Spring 2018
release of Windows 10, Windows interprets this setting to apply to all sound card inputs, not just to the default microphone
input.

Serial and Parallel port interfacing under Windows XP/ Vista/ 7/ 8/ 10/ 11
Windows XP, Vista, 7, 8, 10 and 11 require a special dll which will be installed automatically by N1MM Logger+ to use the
parallel ports.

Exposing and Deleting Phantom Serial Ports

Unlike N1MM Logger Classic, N1MM Logger+ can support serial ports numbers up to 99. The following procedure is not likely
to be necessary, but you may still wish to use it to eliminate “phantom” (not used, but unavailable) serial ports from your
system,

Here is how to have Device Manager expose and remove invisible serial port assignments:

1. Click on the Start button and select All Programs > Accessories.
2. In Windows XP, Click on Command Prompt; in Windows Vista, 7 or newer, Right-click on Command Prompt and

select the Run as administrator menu item.
3. Type set devmgr_show_nonpresent_devices=1 and hit the Enter key.
4. Start Device Manager. There are many different ways to do this; one is to right-click on Computer (or My Computer),

select Properties, and then click on Device Manager. Another is to find Device Manager in the Control Panel.
5. In the Device Manager window, select the View > Show Hidden Devices menu item.
6. Click on the + sign next to Ports to see the full list of COM ports that have been assigned in your computer.
7. Highlight an unused port number you wish to remove from the list and then press the Delete key. Accept when asked to

confirm and continue with any more port numbers that you wish to delete.

Thanks to KK1L and N7WY for this tip.

Hooking up a Footswitch
A footswitch can be hooked up to a serial port or a parallel port. The footswitch program action is the same for both LPT and
COM ports, i.e. footswitch closure causes the action selected in the Configurer for that port.

Parallel port

If pin 14 is not used to switch radios using an external SO2R box (for example, by using the Pause key), then hooking up a
footswitch to LPT1 can be done by connecting a 10k resistor from pin 14 to pin 15. Pin 14 is normally +5V and provides pull-
up voltage for pin 15.. Then connect a normally open footswitch between pin 15 and pin 18 of LPT1. Closing the footswitch
pulls pin 15 low and performs the function selected in the configurer.

If pin 14 is being used for Radio A/Radio B control of an external SO2R box, a 5V supply with a 10k series resistor can be
used to provide the pull-up voltage for pin 15.

Serial port footswitch information (using the 9 pin connector numbers)

Connect a 10k resistor between pin 6 and pin 7. Set DTR, pin 4 to “Always On” and RTS, pin 7 to “Always Off”. Connect the
footswitch between pins 4 and pin 6.
The program action will be on footswitch closure. The footswitch wires can not be referenced or connected to ground.

Avoiding RFI and Other Common Interfacing Maladies
More often than not, reports of quirky, intermittent issues with radio control, CW and PTT interfacing, as well as hum and
distortion in sound card audio, wind up being traced back to RFI – your own signal turning up where it doesn’t belong, or to
improper grounding.

While we can’t afford the space to deal exhaustively with this topic, there are several good resources – the RFI reflector
(RFI@contesting.com), this paper by Chuck Counselman, W1HIS, and these papers by Jim Brown, K9YC
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USB Interface Devices
With the disappearance of serial and parallel ports on most new PCs, most N1MM Logger+ users are now forced to use USB
interface devices to accomplish functions formerly performed using serial and parallel ports. These include consumer-grade
USB-to-serial adapters as well as devices designed and manufactured specifically for amateur radio use. For the most part,
with the help of software drivers installed when the device is first connected to the PC, these devices are configured in N1MM
Logger+ as if they were true serial ports, with some important caveats and exceptions noted in the following sections.

A separate category of USB devices is the “USB Sound Card”, which are similar in function to on-board and bus-based sound
cards except that its interface with the PC is through a USB port. Some devices aimed at the amateur community combine
USB sound cards and USB-to-serial adapters in a single box. Some transceivers are now delivered with such USB devices
incorporated internally. Generally speaking, once the appropriate drivers have been installed, these devices are configured in
similar ways, regardless of whether they are in a transceiver or in a separate box or boxes.

 

CW issues with USB Adapters
N1MM Logger+’s serial and parallel port CW options are a simple and easy way to generate CW, but if your computer is slow,
you may find the CW is not always smooth, particularly when receiving spots from a Telnet cluster in a busy contest. If this
happens with serial keying, try using a parallel port if you have one. If you don’t, or if you want to put an end to CW issues
once and for all, the answer is K1EL’s Winkeyer USB, which handles CW and all-mode PTT by offloading these functions
from the computer entirely. It is also an excellent stand-alone keyer with 4 built-in memories.

Another issue can be poor weighting when using serial port keying. Some adapters have a lot of latency and will mangle your
CW. Usually this can be corrected by finding a better driver for the adapter. Make sure you are running the latest vendor-
provided driver for your operating system, not the one the OS picks. Some adapters allow you to set the latency in control
panel.

General Comments on USB to Serial I/O Interface Devices

There are three different problems that are often encountered by N1MM Logger+ users trying to use USB-to-Serial adapters.

The first is loss of communications due to Windows powering down one or more USB ports. This problem and the solution are
covered in this section.

The second of these problems relates to the specific chipsets and drivers used in these adapters. The market for these
adapters is dominated by two chipsets, called Prolific and FTDI. There is a potential problem with adapters using the Prolific
chipset for serial communications (in particular, for rig control) from N1MM Logger+. This problem only applies to actual serial
communications; simple on-off keying of DTR and RTS for CW and PTT keying is not affected. There are several versions of
the Prolific chipset (including counterfeit knock-offs), and also several versions of the drivers, and at least some of these
drivers are incompatible with the Microsoft library routines used by N1MM Logger, DXLab Suite, Logger32 and some other
amateur radio programs. The symptom is an error message with the error number 8020. The result is that with some
combinations of Prolific chipset and/or driver software, adapters using the Prolific chipset may not work properly for rig control
and similar purposes with N1MM Logger+. Rather than attempting to list all of the possible combinations of chipset version,
driver version and operating system in order to determine which ones work and which ones do not, our simplest advice is to
avoid using USB-to-serial adapters using the Prolific chipset for rig control, rotor control or similar serial communications
purposes.

The third problem relates to FSK RTTY keying from MMTTY. MMTTY can use a true serial port for FSK keying, by
programming the port to send 5-bit characters at 45.45 baud. Unfortunately, most single-port USB-to-serial adapters, or at
least those that are new enough to work with Windows 7, cannot go slowly enough to do 45.45 baud Baudot. Some multi-port
adapters (two or four serial ports from a single USB port, e.g. Edgeport) are capable of going slowly enough, but if there are
currently-sold single-port adapters that can do direct FSK keying, they are few and far between.

The standard solution to this is to use EXTFSK (or EXTFSK64, on systems whose CPU is capable of supporting it). EXTFSK
does all the timing internally instead of using the serial port hardware. EXTFSK is capable of keying FSK on any of the TxD,
RTS or DTR lines on any serial port or any USB-to-serial adapter, and even on a true parallel port (but *not* on USB-to-

USB-to-parallel adapters generally will not work

USB-to-parallel adapters will not work for keying CW or controlling PTT through the standard parallel port interface,
because these adapters do not permit controlling individual lines.
The only exception we are aware of is the SO2RXLAT by Piexx, which is designed specifically for this purpose.
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parallel printer adapters, which are incapable of bit-twiddling). There is a downside to using EXTFSK – the timing is less
accurate than the hardware timing from a true serial port. This may result in a slightly less readable signal under difficult
conditions.

We are not aware of any USB-to-serial adapters that will not do FSK with the help of EXTFSK or EXTFSK64, nor are we
aware of any USB-to-serial adapters that will not key CW or PTT on their DTR/RTS lines other than adapters that don’t have
any physical connections for these control lines (such as the Elecraft KXUSB which does not implement the DTR and RTS
control lines and therefore cannot use DTR or RTS).

Drivers: One key thing to never do is to allow Windows to tell you that it already has the driver for a particular device – you
should always install the driver that comes with your interface. Windows can misidentify these devices when you plug them in
and Windows will let you fail by using the driver it thinks is correct – and often Windows is dead wrong.

Generally speaking, with XP you can use most any USB to serial device (Prolific or FTDI chipsets) as long as you do not have
a conflict. When it comes to Vista or Windows 7 and newer, FTDI seems to be the only game in town for close to sure results
(Editor’s note – not all users agree with this characterization.)

Even with all of this, depending on what you have done with your computer previously, you may have problems. And again,
the point of all of this is that the problems may have nothing to do with what hardware you are trying to use. It could be
something left over by some earlier activity on your computer. That said, most installations of these devices goes well right
from the start. When they do not, it can be very frustrating.

A further technical note, posted on the N1MM Logger reflector by Joe, W4TV, concerns an easy way to tell whether a given
adapter can handle 45.5 baud RTTY:

Windows serial drivers set the data rate (baud rate divisor) with 14 bits of a “double word.” That limits the max/min range of
the driver/UART to 214:1 … and any maximum rate higher than 512K will preclude operation at 45.45 bps.

The lower rates are not a 100% guarantee of compatibility but the higher rate is a certain sign that EXTFSK or AFSK
will be required for RTTY.

Sound Interfacing and USB External Sound Cards
If you want to record your contest QSOs, or use stored messages in phone contests, you will need to interface your computer
to the audio system of your transceiver.

This requires a little thinking ahead. If you wish both to record QSOs and to use stored messages, then you will need a sound
device (be it internal or external) that has both Line and Microphone inputs, and that is capable of duplex operation – that is, it
can both record and play back at the same time. This is not a rare capability, or something found only on expensive sound
cards, but something to check in choosing which card to buy.

A more common problem, these days, seems to be sound cards – particularly those integrated into laptop computers – that
have only a single input that can be used for either Line or Microphone, but not both at the same time. In those cases your
best bet may be to get an external USB sound card. Again, it is not necessary to go high-end for this application, so long as
both criteria above are met.

Two external USB cards that have been tested with N1MM Logger are the Encore, sold by NewEgg here .for under US$20,
and the GWC, also sold by NewEgg at this URL for about the same price.. The ByteRunner UA-580 also works fine. (Thanks,
Joe W4TV for this info)

Supported Hardware
Windows and External USB Peripherals

One word of caution about external (USB) sound cards … and other USB peripherals.

Windows can only address the “USB root hub” … they are directly connected to the internal PCI bus. Windows will process
data from all “Root Hubs” in a machine in parallel. However, all of the “child” devices are like leaves on a tree, each leaf which
“grows” from the same “root” receives a time slot (generally 16 msec) in turn. If you have too many “leaves” on one root hub,
the delay can become excessive and result in communications failures (time outs) with the controlling software (Logger).

This can be particularly problematical with some software that polls every 50 to 100 msec and will timeout if a response has
not been received before the next poll interval. USB can easily handle the aggregate throughput (it will do something like 240
mb/sec) but the delays can be a problem if the software writer does not account for them.
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Be particularly aware of this issue if you use external hubs and add many devices – particularly devices like memory sticks
and “thumb drives.”

73, Joe Subich, W4TV

Green Heron Engineering Inc. – GH Everyware (rotator control)

N1MM Logger can send bearing information direct to the Green Heron GH Everyware software. N1MM Logger must be
configured to send rotor information over the network (using UDP packets). This can be done by editing the N1MM Logger.ini
file. Information regarding this is given in the supplied documentation with the Green Heron software, which is bundled with
Everyware Remote and Base hardware and not sold separately.

Please refer to the Everyware documentation for further details.

Ham Radio Solutions – EZmaster

EZ Master is an LPT port and USB Device that interfaces your PC with several devices in your shack like radios, antennas,
filters switching, microphone, headphones etc. Including PHONE, CW, RTTY, DIGITAL Mode interface and internal DVK, CW
Keyer and SO2R switching.

More information can be found on the Ham Radio Solutions website.

K1EL – Winkeyer

Winkeyer is an external keyer chip designed by K1EL and G3WGV, which combines full electronic keyer features with a serial
interface to a computer. Winkeyer is intended to interface with compatible Windows software and produce CW from ASCII
characters sent to it, avoiding CW timing problems caused by multitasking.

N1MM Logger was one of the first Windows logging program to support Winkeyer, and it has become a favorite CW solution
for N1MM Logger+ users. Serial or parallel port keying may work fine, particularly with faster computers, but using Winkeyer
can enable you to get by with a slower machine or run other programs in conjunction with N1MM Logger+, while keeping your
CW perfect. Stand-alone keyers are available, and the Winkeyer keyer chip is also used in multi-function interfaces such as
Ham Radio Solutions EZMaster, RigExpert, and several microHAM interfaces.

More information can be found on K1EL’s website.

A full explanation of setting up N1MM Logger+ to work with Winkeyer is found in the Configurer section of the N1MM Logger+
Manual.

microHAM – microKEYER

The authoritative source for information on configuring N1MM Logger to work with various microHAM products is the
microHAM web site which offers a variety of “Example Configurations”. These configurations are also accessible through the
Help menu of the microHAM Router software, under “Document Download.”

Tentec ORION + “Mute mic on supported radios”

In the Configurer dialog, Other tab, make sure that “Mute mic on supported radios” is *NOT* checked. If that is checked, the
Logger mutes the microphone and turns on the AUX input during DVK operation. By design the microKEYER routes DVK
audio to the microphone input.

ICOM CI-V Interfaces + Transceive on/off Features

How to connect microHAM devices to N1MM Logger+ together with, for example, a SteppIR antenna which needs Transceive
ON to know the radio frequency while N1MM Logger+ likes to see Transceive OFF.

connect all of the CI-V devices in parallel (tip to tip, ground to ground)
turn off Transceive in the Icom rig
turn ON “polling” in microHAM Router
turn OFF “polling” in microHAM Band Decoder

The microKEYER (Router) will poll only when the logging software is not polling (for example, Router will poll even though
N1MM Logger+ does not). The Router polls will keep data flowing on the CI-V bus to allow the SteppIR and other similar
hardware to stay “in sync.”
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The microHAM Band Decoder will provide antenna switching (including support for multiple antennas per band with the
appropriate external switch) according to your normal programming , provide drive for bandpass filters (several brands) and
can do “format conversion” which will allow a Yaesu (Quadra, FL-7000) or Icom (IC-2KL, IC-4KL, IC-PW1) solid state amplifier
to work with any other (supported Yaesu, Kenwood, Icom, or TenTec) radio.

The same capability exists with non-Icom radios.

N1MM Logger+ can’t read the RX frequency (shows as 0) – frequency shown fine in microHam router without the
Logger

N1MM Logger+ polls for slightly different data than Router (VFO A and VFO B vs. “Current operating frequency”) so Router
“times out.” Solution:

Open Router | Control | Set and uncheck “Disable router queries” .

Truncation of Messages (When Using Winkeyer Keyer)

Symptom: Sends all the macro CW messages except the last letter and then goes back to receive. The solution is to add a
space or the | character (the shifted \ character) at the end of the macro message. The | character is about 1/3 of a space.

microHAM – MK2R/MK2R+

To set up MK2R+ with N1MM using LPT control see: http://www.microham.com/Downloads/MK2R_N1MM_Setup.pdf

Q. When I load N1MM logger the message shows: “Winkeyer v2 detected, Only Winkeyer v4 and higher are supported in
N1MM.”
A. That’s a Winkeyer initialization error of some kind which shows when the MK2R+ is not switched on when N1MM logger is
started.

Q. How many serial ports are needed by MK2R to fully work
A. In any case, one only needs five ports for a fully functioning system with N1MM (Radio 1, Radio 2, PTT 1, PTT2, and
Winkeyer). Any other functions (Packet, rotor control, etc.) do not need
to be in the “first eight.” MMTTY/Digital Interface will share a port with PTT (and CW if you are not using Winkeyer) … and
MMVARI or MMTTY in AFSK mode does not require a port at all. Even if/when the SO2R control signals get mapped to serial
handshake lines or the software adds support for the microHAM control protocol (on a virtual port) one additional port will not
push most systems “over the line” – although the ability to start the block of eight other than at COM1 would provide a bit of
insurance.

73, Joe, W4TV

An example setup

microHAM Router

VOICE Audio Switching for both radios: CmCmCm

FT1000MP, Proset Plus plugged to front mic jack.

N1MM Logger (6.10.9 or higher)

Configurer >Audio tab
2 – Single Card – Two Radio, No sound card SO2R
Select Device = USB Voice CODEC
Select Input Line = Microphone
Select Line to Mute = Microhone
Recording bits = 16
Sampling rate = 22050

Ctrl+Shift+Fx to record, Fx to playback.

USB-only SO2R Support

With USB-only SO2R support using the the MicroHam SO2R protocol, an LPT port to command various SO2R functions with
the MK2R/MK2R+ is no longer needed.

Designate a virtual COM port as your MK2R control port in N1MM logger. To do this, check the CW/Other box for the port,
click on ‘Set’, and check the MK2R box on the port details dialog. Then go to the SO2R tab on the MicroHam Router, select
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Microham SO2R protocol with the “radio button”, and identify the COM port in the drop-down list just below. Finally, if you want
to use program-derived band data, on the ACC tab change the Radio 1 and Radio 2 options to “SO2R protocol controlled”. If
you want to control band decoders for two radios, you may need to wire up a new cable to get Radio 1 data from pins 6-9 on
the ACC connector, and Radio 2 data from pins 10-13.

Record-on-the fly within the program is supported using USB-only.

Suggested Port Setup by Joe, W4TV

“The MK2R/MK2R+ operates very well with six total ports (I will use A – F to avoid particular numbers):

MK2R/MK2R+ with 6 Total Ports

Port Connected device

COM A Winkeyer (it is best to assign Winkeyer to the “lowest” port to avoid loss of CW if another port is activated for CW)

COM B Radio #1 (PTT and Footswitch is optional on this port)

COM C Radio #2 (PTT and Footswitch is optional on this port)

COM D Digital #1 FSK and PTT for Radio #1 (assign Radio 1)

COM E Digital #2 FSK and PTT for Radio #2 (assign Radio 2)

COM F MK2R (protocol port)

A user who does not choose to do FSK (uses AFSK only) can survive with FOUR virtual ports as PTT can be enabled on each
of the radio ports – even with radios that normally expect “handshake” – as the MK2R does the handshaking and frees both
RTS/DTR lines for control functions.”

The COM D and COM E PTT settings (or the optional radio port PTTs) are necessary if you wish to use the built-in N1MM
Logger “DVK” with PTT (rather than VOX). This does not mean that you have to designate COM 5 and 6 on the Ports tab as
PTT – instead you can just make sure the PTT box is checked on your two FSK ports in Router. If you wish to use the MK2R’s
built-in DVK instead, you will need to check the “DVK” box on the port you are using for the MK2R.

On-the-Fly Recording from within N1MM Logger

In order to make on-the-fly recording with Ctrl+Shift+Fx work with N1MM and the MK2R+, there are a couple of unusual
requirements:

if using the MK2R SO2R protocol (USB-only), you need to use MM 7.10.9 or later
If your computer uses the Realtek or Soundmax chips for its on-board sound, then you will need temporarily to set the
USB Voice CODEC to be the default sound device in Windows and be sure to turn off all Windows sounds for the
duration, also in the Control Panel. There’s a glitch in the Realtek/Soundmax drivers that doesn’t let mic audio get
through to the MK2R+’s USB Voice CODEC (which it uses to record and play Function Key messages) unless you do
this.

RigExpert

When installing drivers for RigExpert Std or Plus, it creates 4 virtual COM Ports on your computer along with USB Audio
Codec (for its internal sound card). Some users of the RigExpert TI-5 interface have reported that the 4th virtual port, for FSK
keying, does not work with MMTTY. It is still possible to key FSK RTTY, using the 2nd virtual port (PTT/CW/SoftFSK) using the
version of EXTFSK supplied with the RigExpert, and configuring MMTTY to use EXTFSK.
Click on “Show Serial Ports” (ListRE program which comes with RigExpert software) and write down COM port numbers for
CAT and PTT/CW for future reference.
Then run your N1MM. (Make sure you are not running other logging programs at the same time to avoid port conflict).
Go to Configure and click on Configure Ports, Telnet Address, Other. Click on Hardware. You will see a selection of COM port
from COM 1 to COM 8. Select the proper COM port number for CAT (the one you memorized before), select your radio model
and in Details select the proper parameters for your radio (baud rate, etc.). Then select proper COM port number for CW/PTT
(check CW/PTT) and in the details set DTR to CW and RTS to PTT. If you are using RigExpert Plus, then you may also set a
separate COM port for Winkeyer.
If you want to use RigExpert as your Sound card (for SSB messages or RTTY) you may go to Audio (under the same
Configurer menu) and select USB Audio Codec as you Sound Device.

3/4/25, 5:37 PM N1MM Logger+ Documentation



195

Don’t forget that you can not run two programs that use the same USB Interface at the same time.
If you have older RigExpert – SD or 2.2, you still may use it with N1MM, just need to install additional driver (REAUDIO).

When RigExpert SD is used with N1MM for Voice Keying, in the Configurer’s Audio select “RigExpert” as a Device. Then
configure the Recorded wav file path in the “Files”.
The older RigExpert models,need to have REAUDIO installed. For newer RigExpert models REAUDIO is not needed “USB
Audio Codec” in the “Select Device” menu should be seleceted.

Top Ten Devices – Band Decoder and DX Doubler

To replicate the default Top Ten Devices behavior, you would need to set up Configurer >Antenna tab as shown in the
Interfacing section.

Hardware Update: ‘Both Ears on the Inactive Radio’ versus ‘Both Ears on the Active (or Run) Radio’ from
the Keyboard

I wanted to go one better and mimic the “PTT” operation of the DXD, which puts both ears on the INactive radio for aggressive
S&P, but still be able to put both ears on the Active (or Run) radio from the keyboard, to help pick up weak answers to my CQs
while HC8N is blasting on the S&P radio at S9 +40. You can do this manually by switching the DXD audio mode switch from
PTT to Auto, but I’d rather keep my hands on the keyboard.

After corresponding with George, W2VJN and Dave, N3RD, of Top Ten, and entirely thanks to them, I have it working. I also
owe a vote of thanks to Terry, N4TZ/9, whose article in September/October NCJ describes modifying the DXD to do the same
trick, but with a footswitch, and got us all thinking.

First, put the DXD jumpers (2) in their CT/Writelog/TR/MM position. This has the effect of isolating pin 5 of the LPT port. Then
put a 2N2222 open collector switch between pin 5 and the Auto terminal of S3 on the DXD (that’s the audio mode switch).
Specifically, pin 5 drives the base of the transistor through a 1K resistor connected to the high side of R22, just like the basic
CW keying interface. The emitter is grounded to the ground side of R22, and the collector is wired to the switch side of R29. I
mounted the transistor next to R22 with double-sided tape. Ugly but effective. That’s all there is to it.

 

West Mountain Radio – RIGblaster

CW and Digital Setup RIGblaster Plus

Inside the RIGblaster Plus set the following jumpers on the P5 jumper block: D9 and D12, corresponding to RTS on PTT and
DTR on KEY. Switch the port on which the RIGblaster is set from DIGITAL to OTHER. In N1MM’s configuration use DTR (pin
4) set to CW and RTS (Pin 7) set to PTT. Using this configuration, everything works properly generating CW from N1MM and
furthermore, this combination will allow the other soundcard related things to work (MMTTY, SSTV, PSK, Voice Key Express,
etc). (by David, K1TTT)

SSB Setup RIGblaster Plus

Serial port setup (configurer)
Com2 (any com port will do)
DTR: Always OFF
RTS: PTT

On the RIGblaster itself
Set the Tx/Auto switch to Auto.

Sound Volume Level
Use your soundcards volume control

DX Doubler on port other than LPT1
When using the DX Doubler on a port other than LPT1 check out the proper addresses.
73, Pete N4ZR



CW key down problem and RIGblaster Pro
When your radio in CW stays in key down position try setting DTR to CW
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With it set up this way, it correctly mutes the microphone while transmitting a wav file and the VOX works when not
transmitting a wav file.

RIGblaster Advantage

A number of our users have experienced difficulty setting up the RIGblaster Advantage to do various modes. The following is
based on information from West Mountain Radio’s support department, but any errors are ours alone.

When you load the RIGblaster driver onto your computer (we won’t document that process here, because it is well covered in
the Advantage manual), you will see a new virtual COM port and a new USB Audio Device reflected in your computer’s Device
Manager. Make note of the COM port’s number

The virtual COM port can be used for PTT using RTS), CW or FSK (using DTR) keying, and control of your radio. The USB
Audio device (called “RIGblaster Advantage Audio” in Device Manager) has both playback and record channels, and can be
specified anywhere you are asked to specify a sound card.

Control of your radio is available from the Advantage in one of two forms – an RS-232C level DB-9 connector, and a TTL level
3.5mm stereo jack. The TTL jack (labeled CTL IN/OUT) is suitable for controlling radios that use TTL-level control – such as
Icom’s CI-V remote jack and the 8-pin mini-din CAT jack found on some Yaesu models. It is not suitable for driving older
Kenwood radios which employed a “negative TTL” scheme (such as the TS-440S and TS-850). Your best bet in this case is to
buy or build an adapter to convert the Kenwood control setup to basic RS-232.

The Advantage’s RS-232 port can drive many RS-232C equipped radios with one proviso – the transceiver must not require
hardware flow control. Otherwise what happens is that the radio holds RTS high and the Advantage will be stuck in transmit.

Many Yaesu radios have a menu option “CAT RTS” which can be disabled – this will get CAT working on those radios with just
a straight serial cable between the Advantage and transceiver.

The FT-847 actually requires a null-modem cable but this is the only radio WMR knows of which does. Because the FT-847
does not require flow control this works fine with the Advantage.

Kenwood radios without the ability to disable flow control require a modified serial cable which shorts RTS/CTS at the radio
end, to fool the radio into believing flow control is active. This works in practice on most radios we have tried it with, but has
not been tested with N1MM Logger. A more elegant solution is just to use a separate USB to RS-232C adapter cable, giving
you a second virtual COM port in Windows which is dedicated just to radio control. In this configuration, the Advantage COM
port is used only for PTT and CW keying.

The Advantage has a 3-position toggle switch on the front panel to determine how PTT is handled. In the “COM” position, PTT
is under the control of the RTS line of the Advantage’s virtual COM port. The center position, “OFF”, disables PTT and CW
through the Advantage. The third option is “VOX”, which is derived from the audio signal itself in phone and data modes using
AFSK.

Remember that if N1MM is configured for PTT by radio command, the Advantage has no way of knowing this and will not go
into transmit even though the radio does. Always make sure that PTT is done by RTS if under serial port control, or use the
VOX position if using PTT via radio control.

In summary, most radios can be set up for PTT (using RTS) and CW/FSK keying (using DTR). As long as the radio has either
an 8 pin round mic jack or an RJ-45 mic jack it will work, because this is how audio and PTT get to the radio. For many radios,
CAT can be achieved with a simple cable. For radios equipped with RS-232C jacks and which insist on flow control it is
probably just simpler to use a separate USB to RS-232C cable.

Setting Up N1MM Logger with the RIGblaster Advantage

Now we get to the easy part. Go to Config > Configure Ports. Open the hardware tab.
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Select the virtual COM port number you will be using for radio control. Select your radio from the drop-down list. Click “Set”.
Do not select PTT via Radio Command. Make sure the communication parameters match between the program and your
radio (found in its manual). If you are able to use the same COM port for all functions (rig control, CW and PTT all on the
same port) and do not need the RIGblaster’s own CW/PTT interface, then set DTR to CW and RTS to PTT (if needed), check
the CW/Other box and you’re done.

To configure the RIGblaster Advantage’s COM port for CW/PTT, select the Advantage’s COM port and check its CW/Other
box. Click “Set” for the Advantage’s COM port. Set DTR on that port to CW, and RTS to PTT (if needed). Typically the radio
will require hardware PTT, radio command PTT, or the radio’s VOX to be enabled.
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Transverters

N1MM Logger+ has transverter support in the form that per bandmap an offset frequency can be set. Right click menu
bandmap and select Set transceiver offset frequency. Enter the transceiver offset frequency in kHz (minus is allowed).
Example: 116000 when using a transverter from 28 MHz to 144 MHz (144000 – 28000 = 116000). The same for other bands
(up or down). This can be set per bandmap so when using two transceivers with transverters they can each be on a different
band. The offset is saved by the program so after a restart the offset is still there.

Other Hardware Information

All by Joe Subich, W4TV

USB Soundcards

The manuals for the soundcards below (in alphabetic order) indicate they have independent microphone and stereo line
inputs.

Audigy 2NX External
Creative SoundBlaster MP3+
Turtle Beach “Audio Advantage Roadie”

The “low price option” below does not have an on-line manual but the specs on the web site show separate mic and line jacks.

Byterunner UA-580
appears to be the recommendation for those who need an external sound card (laptop, etc.).

Other Soundcards

SoundBlaster Live 24 External
The one issue with the Live 24 External is that you cannot use the mic and line inputs at the same time
(connecting the mic will disconnect the line). It will work fine for internal DVK in N1MM but you cannot “record
QSOs” and use DVK at the same time if you loop the microphone through the Live! 24 External.

External versus Internal Soundcards

There are claims that External USB soundcards work substantially better (and should be used) than internal soundcards (on
digital signals).
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Joe, W4TV: The claimed “advantage” comes from flawed tests which fail to properly set the input level to each sound device
to take maximum advantage of its dynamic range.

Except for the very worst sound cards or exceptionally noisy systems, internal sound cards have at least 60 dB of usable
dynamic range (the better 16 bit cards have 80 dB of dynamic range and 24 bit cards with high level inputs can have dynamic
ranges that approach 100 dB). If the audio from the transceiver is such that the receiver noise floor (no antenna) is six to ten
dB above the noise floor of the sound card, the software DSP (MMTTY, etc.) will be able to operate at its full capacity.
Receiver AGC, etc. will limit the receiver output to a level well below the input capacity of the soundcard. Most receivers will
not vary more than 30 to 40 dB from quiet band to S9 +40 dB receive signals. Soundcard performance is not a matter of
internal vs. external. It is a matter of careful attention to setting the proper level to allow the soundcard to function properly.

Unsupported Hardware – W5XD MultiKeyer

The W5XD MultiKeyer is not supported and there are no plans to do so. SO2R support is provided by sound cards and
Winkeyer or by other external hardware using serial and parallel ports.

N1MM Rotator Control
Rotator control by N1MM Logger is supported using

External software
N1MM Rotor (comes with N1MM logger)
PSTRotatorAZ (15 Euros/US$22 by Codrut Buda – YO3DMU)

External hardware
ARSWIN by EA4TX
ERC and ERC-M by Rene Schmidt DF9GR – PSTRotatorAZ required for ERC-M to control two rotators

Rotators can be controlled in several different ways:

Entry window:
by entering a beam heading in the callsign field and press Alt+J. The rotor will turn to the entered beam heading

Example:234 Alt+J will turn the rotor to 234 degrees
The number must be numeric, > = 0 and < = 360

using the menu items in the Tools menu
Turn Rotor Alt+J – Turn rotor to bearing for the callsign in the Entry window
Stop Rotor Ctrl+Alt+J – Stop turning the rotor when turning and no bearing in callsign field in Entry
window

using the short cut keys below:
Alt+J – Turn rotor to bearing for the callsign in the Entry window or to the callsign in the callframe (when
callsign field is empty)
Alt+L – Turn rotor to long path bearing for the callsign in the Entry window
Ctrl+Alt+J – Stop turning the rotor when turning and no bearing in callsign field in Entry window

Bandmap window: by right clicking on a spot and select: ‘Turn Rotor’
Available Mult’s and Q’s window: by right clicking on a spot and select: ‘Turn Rotor’

N1MM Rotor stand-alone program

Some remarks

If there is a call of less than three characters in the callsign field in the Entry window nothing will happen.
The status bar will show the bearing it will turn to. Example: Turning Rotor to 123 degrees
Normally the rotor will turn to the country bearing after a callsign is entered. This info comes from the country file and
mostly is the center of the country. In grid square contests however that is mostly not practical so when a grid is
entered the rotor will turn to the calculated bearing between the own grid and entered grid square.

Rotator Control Basics

N1MM Rotor has the ability to control up to 16 rotors per station, and to control rotors connected to other computers on your
LAN. Each rotator requires its own COM port, unless external interfacing software is used. N1MM Rotor leverages the
Antenna tab to define what rotators are controlled when you are on a band. N1MM Rotor can even rotate a stack with one
command. N1MM Rotor is an external program which can be used from within N1MM Logger or as a stand-alone program.
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Supported Rotator Types

DCU1 – No Stop button supported.
M2 Orion – Speed shown to bottom right of status bar.
Prosistel
AlfaSpid
Yaesu
RC2800P-A
Rotor-EZ
AlfaSpid ROT2
Prosistel C
Green Heron RT-21 (use DCU-1 option or Rotor-EZ setting)

All rotators except the DCU1 support position reporting. It would be worth trying the Rotor-EZ setting with other rotators that
use the DCU-1 protocol or a superset of it, because the antenna position may be reported in the Rotor window.

Upper pane: The upper pane shows the selected rotator (as entered in the Setup under Tools) and behind the @ the current
rotator position.

Menu bar: Shows the File, Tools and Help menus.

The big digits indicate the current rotator position. When an antenna offset has been entered this will be shown in small digits
to the right of the current rotator position.
More to the right a visual indication where the rotator is pointing. The line in the circle can be dragged to turn the rotator, for
rotators that support position reporting.
The textbox is an entry field where you enter the bearing the rotator is to be turned to.
Clicking the Turn button will turn the rotator to that position, and the Stop button will stop turning the rotator at the current
position.
A reverse offset will be shown as (R) .

Status bar: Shows the speed when reported by the rotator.

The program will be brought to top when turning (unless minimized)

File Menu Selections

File
Always on Top – Select to have the program always on top
Exit – Exit the program

Tools
Setup Rotors – a dialog named ‘Rotor Setup’ will be displayed as shown below
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Set Current Antenna Offset
The offset is entered on the antennas tab of the Configurer, or can be entered for the selected rotor. This offset is
added to the rotor position to determine the antenna position, so it should be entered with a “-” sign when the
offset antenna is rotated clockwise relative to the rotator direction. This is useful for antennas that are mounted
at 90 degrees for pattern interference reasons, or for antennas that have simply turned some in the wind over
the winter

Set Current Antenna Bidirectionality
Bidirectional is for dipoles, or SteppIr’s where the user wants to reverse the antenna rather than turn it more than
180 degrees

Calibrate Rotor – Calbrate the rotator. Only when supported by the rotator like the M2 Orion. The ERC/ERC-M
hardware does calibration in firmware.
Prosistel C Config

A dialog will open where you can set the rotator stop to North or South and the delay of the characters
Set rotation limits

This feature is for owners of rotators with brakes that jam. You may enter a number which will restrict how close
the rotator will be turned to 0 or 360 degrees. If you enter 10, the limits will be 10 to 350 degrees. Note that this
can only be set for all rotators handled by an instance of the program. It didn’t seem worth adding it to the
antenna tab

A new line will be shown for every rotator that has been set up
Each line represents a rotator as entered in the setup under Tools

Button and Mouse Assignments

Manual entry field – Type a heading and press Enter or the Turn button to turn the rotator. The entered number is in
degrees.

Maximum: 450 and minimum 0. An error message will appear when entered otherwise when pressing the Turn
button.

Turn – Click to turn rotator to heading in textbox. Pressing Enter will also turn the rotator, if the entry focus is on N1MM
Rotor.
Stop Alt+S – Press to stop rotator turning. Pressing Alt+S or Escape will also stop turning the rotator.

This button is only shown when the rotator supports this feature.
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F1 – F10 – Pressing the F-keys mapped to the bearing buttons will turn the rotator to the position as shown on the
button. Right click to set the heading value.

Bearing buttons (F1 – F10)
Left mouse button click

Pressing one of the bearing buttons will turn the rotator to the position as shown on the button.
The F-keys F1 through F10 are mapped to the 10 bearing buttons.

Right mouse button click
Set Button to Current Position

The heading as entered in the manual entry field will be used to set the position.
Set Button to a Specific Heading

A dialog will appear and a heading can be entered which will used to set the position.

Only rotators that report position will be able to show the current position (also when rotating).

Sending Rotor Position Information to N1MM Logger

By default, N1MM Rotor sends position information only to the N1MM Logger main program that is running on the same
computer as N1MM Rotor. If you are using only one computer, with both N1MM Rotor and N1MM Logger running on that
computer, you can skip the rest of this section, but if N1MM Rotor is running on a different computer from N1MM Logger, you
need to read on.

If you want to send position information to copies of N1MM Logger running on other computers, you must use a text editor to
manually edit the N1MMRotor.ini file in order to tell N1MM Rotor which computers to send the information to. Look for the line
“RotorReportingIP” in the [Rotors] section; if it doesn’t exist, you will have to add it.

If all of the computers in the network are in the same subnet, i.e. they all have IP addresses that start with the same three
numbers, such as 192.168.1.xxx, then you can send position information from N1MM Rotor to all of the computers in the
network simply by setting RotorReportingIP to the broadcast IP address (last number = 255), as in:

[Rotors]
RotorReportingIP=192.168.1.255

If you only want to send position information to certain selected computers on the network, you can specify one or more
individual IP addresses, separated by spaces. For example:

[Rotors]
RotorReportingIP=127.0.0.1 192.168.1.10 192.168.1.12

This will send rotor position information from N1MM Rotor to N1MM Logger running on three computers: the same computer
that N1MM Rotor is running on, which is always denoted by 127.0.0.1 regardless of which subnet it is in, and two additional
computers whose IP addresses in this example are 192.168.1.10 and 192.168.1.12. Other computers in the network whose
addresses are not specified in the N1MMRotor.ini file will not receive the rotor position information. The IP addresses do not
all have to be in the same subnet, but of course they must all be reachable from the computer that N1MM Rotor is running in.

Using N1MM Rotor Stand-Alone

Go into the N1MM program directory with Windows Explorer and find ‘N1MMRotor.exe’. This is the N1MM Rotor program. A
shortcut on the desktop would be an easy way to start the program. All features mentioned above can be used.

Using N1MM Rotor with the Main N1MM Logger Program

Configure your rotors using the N1MM Rotor standalone program, as shown in the previous section. Verify that the rotors work
correctly.

The N1MM Logger main program has the capability to turn rotors from the Entry Windows. To configure this capability in the
N1MM Logger main program:

Setup the antenna selections in the Configurer; Tab: Antennas

N1MM logger setup dialog in >Config >Configure Ports, Antennas tab
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The alphanumeric name in entered in the Rotor Description in the Configurer Antennas tab, must be exactly the same
alphanumeric name entered in the N1MM Rotor Setup form.

The N1MM Logger main program also has the capability to display the current direction of any rotor used by the controlling
station, or any rotor in the network. To configure this capability, use the checkboxes “Display Rotors Used By This Station” and
“Display Rotors Responding From Network” in the Configurer Antennas tab. A new display form will appear for each
responding rotor:

When “Display Rotors Used By This Station” is enabled, only the rotors used by the currently active bands in the Entry
Window(s) will be displayed. When you change bands, the displayed rotors will be automatically updated.

When “Display Rotors Responding From Network” is enabled, all rotors that report their position to the computer, from any
N1MM Rotor running on the network, will be displayed.

To start N1MM Rotor automatically from within the N1MM Logger main program, use the checkbox ‘Start N1MM Rotor
Program’ in the Configurer Antennas tab.

One Rotator Per Radio – how to do it

Occasionally, we get questions about how to relate a rotator to a specific radio or VFO, in SO2R – so that when you enter a
callsign in that radio’s Entry Window, the rotator for that radio’s antennas receives the command.
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The answer is simple – On the Antennas tab of the Configurer, define the antennas for the second radio as if they were
alternative antennas for a given band, and specify the desired rotator’s COM port . Then, while the second radio’s Entry
Window is active, hit Alt+F9. You only need to do this once, each time you change bands on the second radio. See this page
for more on configuring more than one antenna for a given band.

N1MM Rotor running on another computer

Let’s assume that N1MM Rotor is on a separate computer which has IP address 192.168.1.14, and your computer, running
N1MM logger, is 192.168.1.10.

Make sure N1MM Rotor is running on the computer that has the rotor connected to it.
Network the computers together.
In the Configurer, Broadcast Data tab on the 192.168.1.10 computer

Rotor =127.0.0.1:12040 192.168.1.14:12040
Enable “Display Rotors Responding From Network” in the Antennas tab
In the Configurer, Antennas tab on the 192.168.1.10 computer, each rotor must be defined in the table
Put this in your N1MMRotor.ini file on the computer running N1MM Rotor (192.168.1.14):

[Rotors]
RotorReportingIP=127.0.0.1 192.168.1.10

Control the rotator by menus in the Tools menu. You put the direction or a callsign in the call textbox and press Alt+J
The requesting station will see a Rotor Form window open, showing the current direction of the rotator. Note that some
rotators cannot report progress.
You may need to change your firewall settings to allow rotor traffic between computers.

Turning a Stack

In the example picture above at the right the stack is on Com3 and Com4 and are turned at the same time when turning
antenna 4 (stack).
Enter 3,4 and the heading selected will be sent to the rotor program and it will tell the rotators (of whatever type) on COM3
and COM4 to turn to that azimuth. If you want to control a single antenna, you will have to switch to that single antenna using
the antenna toggle (Alt+F9) in the main program, press ALT+J and then toggle to the set of antennas that you want.

Run time error: 126

Run time error 126 could be caused by a firewall that doesn’t like a UDP message sent to 127.0.0.1 to notify the rotor program
of what window is active. If you want to use the rotor program without getting this error, you will need to figure out what
program is causing this interference. First check your firewall. If that is not it, one user found that a program called “Port
Explorer” was the cause. When “Port Explorer” was closed, the problem went away.

Rotator UDP Packet Information

Broadcasts to operate the separate Rotator Control program are sent automatically when the user selects >Tools >Turn Rotor
(alt+J), and do not require configuration settings or modifications to the N1MM Logger.ini file. The broadcasts are always sent
on port 12040. Developer Note: the rotator packet lacks XML header tags and is not XML compliant. We know that and will not
fix it because we fear breaking third-party routines written years ago.

The Entry Window >Tools >Turn Rotor command produces the following UDP message on UDP port 12040:

N1MM Rotor packet

Note *: Examples of freqband encoding are 1.8, 3.5, 7, 14, 21, 28

The Entry Window >Tools >Stop Rotor (ctrl+alt+J) command produces the following UDP message on UDP port 12040:

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/setup/the-configurer/#antennas-tab


205

N1MM Rotor Stop packet

Note: the rotor may be specified with the name shown in the Rotor program setup dialog, or the number of the com port to be
controlled (e.g. “3”)

Rotor status update messages sent from the separate N1MM Rotor program on UDP port 13010 are in this format:

rotorname@rotorheading

External Rotator Hardware and Software

Rotator control is supported directly by software and/or hardware from:

ARS-USB by EA4TX
PSTRotatorAZ (15 Euros/US$22 from Codrut Buda, YO3DMU) See the links section for urls.

Start your ARS-USB or PSTRotatorAZ software before attempting to control rotators.

The ERC-M rotator controller by DF9GR offers control of an AZ-EL rotator system or two azimuth rotators using a single COM
port. However, this mode of operation is not supported by N1MMRotor at this time. You will need to use two linked instances
of PSTRotatorAz as intermediary between N1MM Logger+ and the ERC-M. Setup is a little tricky but is fully documented and
works fine.
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Localization (GUI Translation)
2020-03-18

Introduction
Normally, localization (defined for the purposes of this document as GUI translations) is enabled in an application as the result
of collaboration between developers and language experts. Developers use a series of tools provided by the software vendor
(in this case, Microsoft Visual Studio) to extract a database of strings (text) from the code. Developers then process this
database to denote which strings can be modified for translation, those which are static, and those that should never be
translated. The processed database is then converted into a simple file (e.g. Excel or .csv) containing the (typically) English
version of the strings that is sent to a language expert for translation into a target language. That file is then sent back with
translations to the development team which further processes it into a “resource file” and includes it with the application install
package.  Further work is then required to allow the user to select a language to display in the application.

This is that way that many commercial applications are localized and it works well when the application changes infrequently
and when the development team is rich enough with resources to manage the localization process. That is not the case with
N1MM+.

In thinking of a way to extend the translation functionality to the multilingual community of radio amateurs without a massive
development effort, a hybrid approach has been developed that offers some operational advantages for the users and which
removes the support burden from the development team through a self-service approach that allows N1MM+ users to share
both the effort of translation and the fruits of each other’s labors. Overall we tried to adhere to the Pareto Principle where the
users get 80% of the benefits of a fully localized application with 20% of the work.

This document has two main sections.

1. An overall description of how the process works
2. Documentation for N1MM users

How it Works
Note the following is simplified considerably for clarity to the non-software developer.

N1MM+ consists of forms and code. The forms are readily recognizable as just about any window the user interacts with.
Examples include the Entry Window, the Configuration Window and the Spectrum Display. There are approximately 48 forms
in N1MM Logger+. Each form contains a number of controls that the user interacts with. Taking the Entry Window (the primary
N1MM Logger+ form) as an example, there are text boxes where the QSO information is entered, buttons that initiate macros
and other actions, menus that allow the user to navigate through the application, and a status bar that displays informational
text to the user.

In the code, actions are taken that implement the functions of the application. Of interest to the localization process are
instructions that display informational, warning or error messages to the users (i.e. message boxes) and those that update text
displayed on the form to indicate a change in status or progress of an action, such as that displayed in the status bar.

Controls generally include a set of properties that determine how the object is displayed to the user. For example, a button has
a “text” property that contains the word(s) displayed on the button so that the user knows what it does. A menu has a similar
property that tells the user what function will be executed or form opened when an item is selected. Another common property
is a “tool tip”. These are the pop up balloons that display help information when the mouse cursor is hovered over a control
that supports tool tips and the programmer has provided such information.

Similarly, the code behind the form has a set of strings (text) that are displayed to the user under certain conditions as the
code is executed.

For translation purposes, many of these various strings are stored in a database table that identifies the form, control,
property, and string to be displayed. A function is executed for select forms (more on this later) on form open and redraw that
substitutes a translated string from this database table for the default English, assuming it is available. Otherwise the default
English is displayed. The language displayed by the application is determined by the setting of the “Language” control on the
Configuration form on the “Other” tab.

There is a toolkit supplied within the N1MM Logger+ application that is accessible via the “Config” menu. This tool performs a
number of functions related to maintenance of the database table that contains the translated text elements. The essential
processes to enable translation of controls and messages in a form consist of the following steps:
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1. Create a baseline English “placeholder” in the database that identifies the control or string and extracts the English text
associated with the appropriate properties.

2. Export the baseline English database entries for the selected form to an Excel or .CSV file.
3. The user adds a column to the right of the existing entries and translates the text field into the language they are

translating to.
4. After completion, the user imports the file back into N1MM Logger+ and indicates the language the translations are in.
5. Upon opening of the now translated form, if the current language selection has translation rows in the database table,

those translated strings will be substituted for their English counterparts.

Please note that the encoding for the text strings is UTF-8. This should handle all the Latin variants and idiomatic character
sets such as Japanese along with other Asian sets. The characters for the right-to-left languages (e.g. Hebrew, Arabic) seem
to work, but it is not known at this writing whether they are rendered properly in N1MM Logger+ without additional
programming. This needs to be tested by someone who actually knows the language(s).

Programmers seeking information on how to enable N1MM+ forms for translation can read more in the appendix titled
Translation Technical Information for Developers.

User Documentation

Installing Languages

From the Tools menu on the Entry Window, select the option Download and Install Language Pack (Internet). The following
dialog will be displayed:

This displays a list of translations that are available from the N1MM Logger+ website. Clicking on a row will enable the Load
Pack button. This will download the appropriate XML file and install it into N1MM Logger+ on your computer.

Selecting a Language

To enable a specific language for N1MM Logger+, go to Config…Configure Ports, Mode Control, Audio, Other… . On the
“Other” tab, select the desired language from the Language Combo Box. Note that the only languages available will be those
loaded into your translation database table. Before you run the translation tools (below) English may be missing as well but is
not necessary for English functionality. The default setting is English.
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Adding New Translations

GENERAL NOTE: The translation toolkit allows for the export and import of both Excel and .CSV files. In the authors opinion,
Excel is the better format owing to the power of the Excel application and file recovery should a crash occur.  Of course, not
everyone has access to Excel and thus must use the .CSV format. No recommendation is made here with respect to picking a
tool. Google search indicates many free versions are available online. 

Regardless, DO NOT USE Excel TO CREATE .CSV FILES. You will run into no end of grief as the default
settings in Excel do not allow for the export of UTF-8 characters into .CSV formats and you run the risk
of corrupting your translations.

Open the dialog in Config…Manage Translations… The Manage Translations screen will appear. Click on the Translation
Table Maint. Tab. It should look like the following:
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The list box will display ALL forms in the N1MM Logger+ application. Note that a few forms have not been enabled for
translation by the developers, but these are relatively unimportant. Select the form(s) you wish to translate and then press the
“Create English” button. This will populate the database table with all the translatable strings from those form(s).  After the tool
is finished it will display the following message:

In the “Translation Tools” section select “English” from the Language Picker combo box. Then click either “Export All” or
“Export Untranslated”.  “Export All” will allow you to export ALL of the English rows from the translation table for the select
form(s). This is where you will start on a brand new setup of a language.

“Export Untranslated” will export ONLY those English entries that DO NOT already have a translation in the selected language
present in the table. You might do this, for example, if adding translations for new controls on an updated form, or to add to a
partially completed set of translations.

Note that by picking a language other than English in the Language Picker, the tool will export entries in that language. Note
that this is useful for making changes to an existing set of translations, or to be used as a starting point to translate dialects or
otherwise similar languages.

Clicking either button will display a standard file open dialog box. The type of file that will be created is determined by the file
extension used. This can be either “.csv” for a comma separated value file or “.xlsx” for an Excel spreadsheet. I will use Excel
for the examples in this documentation. The following message will be displayed upon completion:
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The remainder of the “Translation Tools” section will be described later.

Open the file you created in the appropriate tool. Below is an example using Excel with the “Configurer” form.

DO NOT ALTER ANY ENTRIES IN COLUMNS A-I!!!! They are hidden in Excel by default by setting the width to zero. Enlarge
columns J and K so that the file looks similar to the following:

In column “K”, add your translation for the text in column “J”. This example is in Polish. Pay attention to the following rules:

Don’t delete any lines, even if the text is blank. If the control is a container that has no translatable text, the entry is still
necessary to determine the hierarchy of parent and children controls.
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If you don’t want to translate the text (say, because it is an acronym that is translated the same as English), copy the
text from column J to column K.

After you are done, the file will look like this:

IMPORTANT NOTE: If you are only translating part of a form, make sure you delete all rows from your spreadsheet
where the English column is not blank but the translated column is. Otherwise, the untranslated elements in those
form(s) will display blanks instead of valid text elements.

Click on the “Import Translation” tab. The following will be displayed:

Click on the … button to browse to the file you created in the prior step or enter the path and file name in the text box.

Under “Import Action”, select “Add Untranslated” to add ONLY the rows from your input file THAT DO NOT ALREADY EXIST
in the translation table in the target language. Select “Replace All” if you want to delete all translations for the selected forms
prior to import.  This will enable the disabled controls below.

Choose the language you have translated to.

Set the translation column to the one containing your translations (“K” in this case).
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Uncheck the “First row contains column headers” checkbox if you deleted the first row.

NOTE: Column B in the import file contains the form name for the controls being translated. When you import your file, the
value in this column is used to determine what form the control belongs to and what translations, if any, are to be deleted if
“Replace All” has been selected. You will be asked for each new form whether you are sure you want to delete the existing
translations.

The following shows the result from the above setup:

Click on the “Import” button when ready. A message will be displayed when complete:

Now go to the Entry Window and select Config…Configure Ports, Mode Control, Audio, Other… . On the “Other” tab, select
the language you just translated to from the Language Combo Box. Using the Polish example, the following should happen to
the Entry Window upon clicking OK in configure:
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Sharing Translations and Using the Translation Work of Others

To share your translation work with others, click on the Translation Table Maint. Tab and select the forms you wish to share
with others. Choose the language you have translated in the language picker. Click on the Export for Distribution button.

This will open a standard file open dialog box and allow you to pick a location and name for your export file. Note that this file
is ONLY in XML format. Click OK and the file is created.

Users of the file do not need to use any of the functionality described above to enable translations for the forms and language
saved in the distribution file. Use the … button to select the file to be imported and then click on the Import button. Then go to
the Configure Ports…Other tab and select the language just imported. The windows translated in the imported file will then be
displayed in that language.

Below illustrates a user import:

Please note that only translation team members might need to use this function. General users should use the fully automated
Download and Install Language Pack function described previously.
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Empty Translation Table

The Empty Translation Table does just what it says. It clears the translation table of ALL entries, both translated and English.
Don’t use it if you do not have copies of your translation work saved as Excel or .csv files.

Google Translate

This functionality was originally included to assist developers in creating test translations. It may or may not be useful to
translators as a tool for getting started. Select the desired forms and choose either Refresh All or Add Untranslated from the
Behavior drop down box. Refresh All will delete any existing translations for the selected form(s) and language while Add
Untranslated will use Google only to translate English text elements that are not yet translated.

Some notes regarding this function:

It is unsupported.
It uses undocumented functionality from the Google Translate website that bypasses the need for any additional
Google software to be installed on the client computer.
Because of this, it has a quota of about 500 translations before the user is temporarily denied access. Access is
restored after about an hour. If you use the “Add Untranslated” behavior after receiving this error, it will restart where
the error occurred.
Translations are terminated at the first period in the text element being translated. Thus multi-sentence text elements
will only have the first sentence translated.

Diagnostics Tab

The diagnostics tab is used to check the integrity of the translation table. It will show translations for GUI objects that do not or
no longer exist in the application and English objects that have not been translated into the selected language. Note that this
is driven by the forms selected on the Translation Table Maint. tab. It is intended mainly as a developer tool but there is no
harm to be done by accessing it. It does not use any existing English placeholders for comparison purposes. Rather, it
performs a complete new scan of the forms selected and uses that for the comparison baseline.

Edit Translations

The Edit Translations tab displays the translations database in a grid control that offers a limited ability for the user to edit text.
Initially clicking the tab will display the entire database in the grid control. Three filters are available to limit the display to a
particular language, form, and control. The funnel icons are used to apply and remove the filters, respectively. The form is
illustrated below:
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The only column that can be clicked in and edited is the one labelled “Text” and only non-English rows are allowed to be
edited.  You will get an error message and the text will be restored to its state prior to editing if you try. The purpose of this
function is to allow for minor “tweaks” to a handful of control translations without the need to perform a full export & import
process.

Clicking the “Remove Filter” button will also refresh the screen.
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Call History and Reverse Call History Lookup
2019-04-12

Call History and Reverse Call
History Lookup
Call History
Call History Lookup is a feature that can be used to pre-fill the exchange during a contest to save typing, or to display user
comments or notes for specific call-signs. The sources of Call History data can be files from other sources, previous contest
logs, or hand-generated data files of your own.  Your club may generate Call history files for Sweepstakes, for example, or you
may choose to generate your own from last year’s log.  You might choose to harvest names and call-signs from your general
log, so that you can recognize people by name on the air.

Before using the Call History Lookup feature, Call History Lookup must be enabled on the Entry Window’s Config menu
(exception: the UserText field – see below), and  the user must import a text file or files containing comma-or semicolon-
separated data.

A fairly large number of contest-specific Call History text files may be found in the Call history Files section of the Files menu
on this web site. For many of us, these will be the preferred source of data for the Call History Lookup function.

You can also build a Call History text file from your previous year’s log. Simply open the old log, optionally click > Tools >
Clear Call History to empty the Call History database table, then click Update with Current Log. To save the Call History text
file, use the Export >Export Call History option on the Entry window’s Files menu, and give the exported file an easy-to-find
filename.

And, of course, you can always load Call history text files into the database directly from the Call History Files user directory.

If you want to draw on multiple logs for the same contest, or indeed combine multiple Call History files into a single database
table, you can do so simply by going to File >Import >Import Call History and holding down the Ctrl key while you click multiple
text files.

The Call History data is not stored in the same database as the QSO data. The Call History table remains until it is
replaced with another set of data. A Call History text file (or multiple files) can be imported manually, or associated
with a specific contest on the Associated Files tab of the Contest Setup dialog. As you can imagine, it is easy to
forget that you have the wrong call history table in the database, left over from last weekend. We recommend that
users add the contest name to the Call History data files as explained in the “Identifying the Call History Lookup Data
Contests” section below.

When a callsign is typed into the Entry window and the focus is moved into the Exchange box, either by pressing the Space
bar, or if Enter Sends Messages (ESM) mode is enabled, by pressing Enter, the Call History database table is searched. If the
callsign is found, the associated Call History data is displayed on the “beam heading” line in the Entry window. If the contest
exchange fields are blank, the data retrieved from the database are also used to pre-fill any relevant  exchange field(s) in the
Entry window.

Where are the PreAssembled Call History Files? A fairly large number of contest-specific Call History text files
may be found the >Downloads >File Explorer >Call History Files of the website. For many of us, these will be
the preferred source of data for the Call History Lookup function.



Cursor Movement Triggers the Call Lookup
The event that triggers the Call History lookup is the movement of the cursor from the call sign box to the exchange
box in the Entry window. In ESM mode, there are some situations in which pressing Enter does not cause the cursor
to move to the exchange box, and in those cases a Call History lookup will not be invoked by pressing Enter. In
particular, in S&P mode if the “ESM sends your call once in S&P …” option is not selected, pressing Enter to send
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If “Show User Information” is checked on the Entry window’s right-click menu, data from the Call History table is displayed on
the User Data line. Even if Call history Lookup is not enabled, data from the User Text field of the table is still displayed on the
User Data line, below the Bearing line.

Here are some Entry window examples. The first shows the Entry window with both the exchange data and user data (his
QTH, in this case) displayed.

In VHF contests, the grid square from the Call History table is used to calculate the beam heading reported in the Bandmap.

The Call History Text File

This section describes the layout of the default Call history text file and the database table into which the Call history is
imported.

The Call History Text File can be created by any text editor – Notepad is fine. The file is comma- or semicolon-delimited, which
means that the items of data are in specific locations. The default structure, also reflected in the database table, is:

Call, Name, Loc1, Loc2, Sect, State, CK, BirthDate, Exch1, Misc, Power, CqZone, ITUZone, UserText, LastUpdateNote.
This order is fixed, and if you use the default order, then you must include a comma in each record in the input text file for
each field, even if the field is empty. Here’s an example:

the F4 message will leave the cursor still in the callsign box, so a Call History lookup will not be performed; pressing
the Space bar will move the cursor into the exchange box and cause a Call History lookup.
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N9RV,,,,06,,-1,1900-01-01,,,,Log update edit fields

As you can see, the file has a number of empty fields before we come to “06”, which is the ITU zone number, and is put in the
Sect field, because this contest draws from the Sect field to prefill the station’s zone.

Downloading Call History Text Files

Pre-assembled Call History text files are available on the website. Look in >Downloads >Category Menu >Call History Files.
Download the file to the CallHistoryFiles subfolder in your N1MM+ user files directory (the one pointed to by the Help > Open
Explorer on User Files Directory menu item)..

Call History Import Directives

You can move or exclude columns of data, map ARRL section to State, map State to ARRL section, or truncate a six character
grid square to four characters. This is accomplished with the use of import directive commands, which are surrounded  with
“!!” , to tell the program that they are instructions, not data. When an import directive command is read, the import routine
follows that instruction until another import directive command is read or all data is imported. Import directive commands can
be repeated if the data structure or field order changes in the data.

Here is a list of the import directive commands that can be used in a Call History text file:

  !!Order!! – defines the order of the comma separated input data that follow
  !!MapStateToSect!! – populate empty Sect field from the State information
  !!FourCharGridSq!! – truncates 6 character grid squares to 4 character grid squares
  !!AppendUserText!! – append additional user text into the UserText field (default)
  !!NoAppendUserText!! – do not append user text into the UserText field, new data replaces prior
  !!Validate50State!! – ignore all state data that isn’t one of the 50 states
!!NoLoc2AltGrid!! – do not move the existing Loc1 grid into Loc2 for an alternate grid location
!!MapOnSection!! – map GTE, ONN, ONE, ONS to ON section
!!ValidateArrlSection!! – remove any section that is not an ARRL section (includes VI, PR) Can be used to remove ON

Every exported Call History text file lists the import directives, the field names, and the maximum size. Here are the Call
History field names along with the maximum size. The import routine will truncate any field that exceeds the maximum,
discard any CK value that is not a number, and discard any Birthdate that is not a date. If an  !!Order!! input directive is not
read during file import, the routine expects the data to be in this comma separated order:

  Call(15), Name(20), Loc1(6), Loc2(6), Sect(8), State(8), CK(#), Birthdate(date), Exch1(12), Misc(15), Power(8), CqZone(#),
ITUZone(#), UserText(60)

Here’s an example of Call History data that will import without an import directive:

K3CT, JOHN , , , ,PA , , ,NHA, , N1MM Program Developer

As you can see, each comma denotes a field.  Successive commas mean empty fields. Spaces can be added to make it
easier to count the number of commas. If this single line file was imported into the Call History database and the Call History
Look Up option is enabled, the Entry window for the PA QSO Party would appear like this when the callsign K3CT was
entered and spacebar pressed (or if ESM mode is enabled, when Enter is pressed):
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As you can imagine, making sure you have the right number of commas between actual data in the text file can be a problem. 
Fortunately, the !!Order!! command offers a simple solution. For example, you create a text file that looks like this:
!!Order!!, Call, Name, CK, Sect
N4ZR, Pete ,54 ,WV
N3OC, Brian, 67, MDC

When you load it into the Call History database, the data will be put in their proper places in the Call History table, and when
you operate in Sweepstakes, for example, with Call History Lookup enabled, the program will pre-fill the check and section in
the Exchange field, and will display the name and all the other data in the Bearing line of the Exchange Window.  This
redundancy is deliberate, because if you set out to edit the Exchange and then realize that the pre-filled data were correct,
they are there for ready reference.

What this change has done is to make it much easier to generate Call History text files for importing into the Call History
database. For example, you could generate a file that contains calls, names, checks and sections for everyone you worked
last year in Sweepstakes, and by writing the correct !!Order!! line, like this:
!!Order!!,Call,Name,CK,Sect

The !!Order!! import directive can also be used to ignore columns of data. For instance, if the data file contains additional
columns as shown below:
DD3JN, 70 23, GERD, JO42AI,JO31OE
PA1M, 144 70, Carel, JO33FE, JO33II

The second column can be ignored with the import directive prior to the data.
!!Order!!, Call,, Name, Loc1, Loc2
DD3JN, 70 23, GERD, JO42AI,JO31OE
PA1M, 144 70, Carel, JO33FE, JO33II

Alternately, the second column of data can be placed in the UserText field with the following import directive:
!!Order!!,Call,UserText,Name,Loc1,Loc2
DD3JN, 70 23, GERD, JO42AI,JO31OE
PA1M, 144 70, Carel, JO33FE, JO33II

The Supported Contests section of this manual may include the Call History field(s) used for exchange information. If the field
information is not listed in this section follow this procedure to determine which Call History field to populate.

Open a new contest log.
Log some dummy QSO’s that contain the exchanges of interest.
Click Tools, Clear Call History then Update with Current Log.
Export the Call History (File, Export, Export Call History) and examine the exported QSO text.
Place the exchange data in the populated call history field. The coding of some contests is complex. It is not unusual to
find that contests that store information in fields for points calculation, determining multipliers, or exporting Cabrillo.
Therefore, it may not be necessary to populate all of the Call History fields.

If your Call History file import doesn’t function correctly, review the import directive(s) to make sure they match the field
names. For example, you must use Sect, not sec or Sec, and Ck, not Check. Field name case is not important. All of these
field names will import data into the Sect field: Sect, SECT, sect, sEcT, SeCt. If problems continue, post a message on the
N1MM Logger email reflector asking the other users for help.

Associating Call History File with a Contest

If you want to have a specific Call History Lookup file loaded and enabled whenever you start that contest, add the filename to
the Associated Files tab for the contest log. From that point forward, whenever this contest is opened in any database, the
specified Call History Lookup file will be imported.

When you click on the Change button for the Call History Filename, if your computer is connected to the Internet the program
will look up the Call History files for that contest on the N1MM Logger+ web site and offer to update the current file with the
latest one from the website. If you do not accept the offer to update the file, the program will then open a standard Open File
dialog to the CallHistoryFiles folder in your N1MM+ user files area so as to allow you to choose your own Call History file
instead of using a downloaded one.

Identifying the Call History Lookup Data Contests

If you add the short contest name (the one in the Contest Setup dialog) to the Call History text file as a comment (preceded by
a “#”) the program will automatically enable or disable Call History Lookup when the contest log is opened or Call History data
is imported. When the Call History Lookup options has been changed a short message will appear in the Entry Window
indicating the action.
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The loaded Call History Lookup data can be identified for use in more than one contest by adding multiple contest name
comments as shown in the example below (omit the quotation marks):
“#NAQPCW”
“# naqpssb”
For QSO parties, the state abbreviation is required after the contest name. Notice the space before the state. Example:
“# QSOParty PA”

– The “#” must be the first character on the line. Adding one or more spaces after the “#” is allowed.
– Only one contest name per line is allowed.
– Duplicate contest associations are ignored.
– The contest name may be upper, lower, or mixed case.
– The contest names are validated. If the validation fails, the contest association is ignored.
– The user can turn Call History lookup On or Off manually. The association is not checked at program start.
– The contest association identifiers are exported with a Call History file export.

Related Menu Options

>Config >Enable Call History Lookup
Check to enable Call History Lookup.

>File >Import  >Import Call History
Select the file(s) to be imported.  All information in the Call History table in the Admin database is erased, and
the imported information from the file is substituted.

>Tools >Update Call History with Current Log
Update the call history table in memory and the Admin database with the QSOs from the current log. Contacts
will be added when new or updated when already in the call history table. For the 2 grid fields the behavior is a
bit different. When both grid fields are filled and a new third grid has been logged, the second grid (oldest) will be
removed, and replaced by the contents of the first field. The new grid will be added to the first position. The
same change in position will happen when only the first grid is filled and a new grid has to be added from the log.
A 4 digit grid will be overwritten by a 6 digit grid when the first 4 characters are the same. Changes made with
this option are only temporary; to store a permanent copy of the call history table including the changes, you
need to use the File > Export > Export Call History menu item described below.

> Tools > Clear Call History then Update with Current Log
As above, except clears the call history table before adding contacts from the current log. Can be used to start a
new Call History table.

>File >Export >Export Call History
Exports the information in the Call History table. It is very important, particularly if you have changed the Call
History table, to re-export the data as a Call History text file.  Otherwise, any changes will be lost.  You are
given the opportunity to rename the text file so that, for example, a 2008 SS file can be renamed 2009 SS, to
indicate that it has been updated.

You can import any Call History file that you formerly used without an !!Order!! directive.  When you export a Call History text
file, the program fills in the commas that are necessary to fit the default order, as well as -1 for each empty CK and 1900-01-
01 for each empty Birthdate.  This is necessary to ensure compatibility with your old Call History files.

Reverse Call History Lookup
In addition to the regular Call History lookup, where you type a call sign into the Entry window and the program pre-fills the
exchange based on the data in the Call History file, there is also a Reverse Call History lookup feature, where you can enter
an exchange into the Entry window and the program will search the log and the Call History file for callsigns that correspond
with that exchange. This does not work in all contests (for example, it makes no sense for serial numbers and it doesn’t work
for Sweepstakes because of the complicated exchange). If the Call History lookup option is selected, the Reverse lookup
feature will search the Call History file as well as the log.

The Reverse lookup feature is enabled using a pop-up (right-click) menu item in the Check window. If the Reverse lookup
feature is not available for that contest, the menu item will be greyed out. Once the Reverse lookup feature has been enabled,
you can type an exchange, or a partial exchange, in the exchange box in the Entry window, and if the number of characters
typed in is equal to or greater than the threshold (which you can set with another pop-up menu item), the program will search
in the log and the Call History table for callsigns whose exchange matches the typed-in exchange. Up to 100 matching
callsigns will be displayed in the Check window. Once you have determined which of the matching callsigns is the correct one,
you can click on it in the Check window and the callsign and exchange will be transferred into the Entry window.

If there was a full or partial call sign entered into the callsign box in the Entry window before entering the exchange, only call
signs from the log or Call History file that match the partial call sign in the Entry window will be displayed in the Check window,
and they will appear below the regular matching callsigns that were filled in from the log and the SCP file.
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You can also control whether the matches for the partial exchange can be found anywhere in the exchange field in the log and
Call History file, or if the match must begin with the first character (that is, whether BC will match all of AABCD, ABC, BC,
BCDE, etc. or whether it will only match BC, BCDE, etc.). Limiting the match to the first characters and/or increasing the
threshold for the number of characters matched will result in faster lookups and smaller numbers of matching callsigns found.

The Names Must Match
Both for prefilling the exchange and for reverse lookup, the name of the field in which the data is stored in the Call
History file must match the name of the field that is used in that particular contest. For example, if the state/province
is part of the exchange, depending on the contest that part of the exchange might match the State, Sect or Exch1
field in the Call History file. You can use the !!Order!! directive to ensure that data in the Call History file is associated
with the appropriate field name for the contest.

For example, if you have a Call History file for the NAQP that looks like this:

!!Order!!,Call,Name,State
K3CT,John,PA

then to use this same data file in a state QSO Party, you might have to change the first line of the file
to!!Order!!,Call,Name,Exch1while leaving the rest of the data unchanged.You can determine which fields are used
in a given contest type by creating a dummy instance of the contest, entering some typical fake contacts, using the
Tools > Clear Call History then Update with Current Log menu item, exporting the Call History file to a temporary text
file, and then examining that file with a text editor to see which field names are used for which exchange fields in that
contest type. For some contest types, you may find the same exchange data in two fields in the Call History file. In
such cases you may have to experiment to determine which of the fields is/are used for reverse lookup.
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The Available Mults and Qs Window
2019-04-13

The Available Mults and Qs Window
The Available Mults and Qs window presents a clickable list of spotted stations that can be filtered and sorted in various ways.
Clicking on a spot in this window QSYs the radio to the spotted frequency. This window is most useful when spots are being
received from a Telnet DX cluster (e.g. in a multi-operator setup, in Assisted or Unlimited class, or in contests that allow spots
to be used in the single-operator class).

The Available Mults and Qs window looks like this.

Spots in the Available Mults & Qs window come either from the Telnet window, or from callsigns stored in the Bandmap
window using either the Store button in the Entry window or the “QSYing Wipes the Call …” menu item in the Config menu.
Spots coming from the DX cluster system via the Telnet window may be filtered in a variety of ways and in a variety of places
– look here for a detailed description of spot flow and filtering.

Key Features
The Header – The header shows the number of Available Multipliers and QSO’s. (Example 4 Mults 12 Qs)
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The Summary Panel – the table in the center of the window header indicates how many new QSOs and new
multipliers are currently available on each of the contest bands. The bands with the most multipliers and QSOs
available is highlighted in red.
The Mults/Mults&Qs Button – clicking this button toggles between showing both Qs and Mults and only Mults in the
lower pane of the Window (also known as the Spots listbox). It is color-coded with standard N1MM coding for Mults and
Qs to remind you of which is which at 3 AM on Sunday. Its color and caption always reflect your current choice, not the
one that will be invoked when you click it.
The Bands & Modes Button – Clicking this button opens a Bands/Modes menu which looks in general like the
Bands/Modes tab of the Telnet window, but which only affects the contents of the lower pane of the Available window.
Options which are not available in the current contest are greyed out.

If you check the Focus Radio box, the spots listbox will only display spots that are on the band to which the focus radio
or VFO is set. If you change the focus to another radio or VFO, the spots listbox will switch to displaying only those
spots. The non-focus radio or VFO selection is disabled when SO1V is selected
If you check Contest under Modes, only those spots that fit the contest modes will be displayed in the Available
window’s spots listbox.

Spot Listbox
The list box (the lower section of the window) shows spots received via Telnet. There are 7 columns, nominally in this order:
Call, Frequency, Dir (bearing), Mode, SNR (Signal-to-noise ratio) for Skimmer spots, Time (hhmmZ) and Spotter.

You can click and drag the column headings to any order you want, and narrow the window to reduce its size and hide
columns you don’t care about.
You can size the columns by dragging the right edge of the column title. Columns that appear to be missing will show
with a very light colored double bar. Grab the right side and drag.
Left-licking on a column title will sort the column, and clicking again will reverse the sort order. The primary sort column
and direction is indicated with a “^” or “v”.
Shift-left-clicking on a column title will set that column as a secondary sort column, or if it is already selected, reverse
the sort order. The secondary sort column and direction is indicated with “^^” or “vv”.
An indicator of split spots appears next to frequency.
Spots coming from a local Skimmer are shown with a (!) to the right of the frequency, and those from a non-local
Skimmer or the RBN (other than your spots, if you are a contributor) are tagged with with (#). A sunrise/sunset indicator
is shown to the right of the bearing where applicable, as an aid to determining which spots may either be “perishable”
or particularly suited to a gray-line QSO.
Spots are colored by default as follows:

Green – double multiplier
Red – single multiplier
Blue – valid QSO

Spots are synchronized between the Available Mults & Qs window and the Bandmap window. Spots may be deleted
individually in the Available Mults & Qs window, or either individually or en masse in the Bandmap window.
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The colors may be changed in Manage Skins, Colors and Fonts, on the Entry window’s Config menu.

Right-Click Menu

Delete Spot – If you right-click on a spot in the spot listbox, the right-click menu will come up, and the “Delete spot”
option will not be greyed out. Click it to delete the selected spot. Do not left-click the call first. Deleting a spot in this
window also deletes it from the Bandmap window, and vice versa. If you want to delete multiple spots en masse, you
must do so in the Bandmap window.

Blacklist callsign/Blacklist spotter__ – Right-click on a spot, and click either option to get rid of either a persistent
busted spot (e.g., EK3LR) or a problem spotter. Blacklisting persists across contests – to edit, import or export
blacklisted spots see the Telnet Window, Filters tab, Blacklisted Spotters, Edit, Import or Export.
Set Band & Mode Filter Options – Opens the same dialog as the Bands & Modes button on the window header.
Show Qs & Mults – Replicates the toggling function of the Mults & Qs button on the window header.
SO2R Focus Follows Spot – When enabled, when you click on a spot, and you are not currently transmitting, the
Entry focus will move to the Entry Window of that spot.
Advanced SO2V VFO Selection (Radio Dependent) – ((Single Operator Two VFO Operation
(SO2V)|#Advanced_SO2V_for_Radios_with_Separate_Sub-Receivers|the chapter on SO2V operation)) for details.
Works on radios with separate sub-receivers.
Enable Right-click QSY on Spot – (SO2V and SO2R only) Right-clicking on a spot QSYs the non-focus VFO or radio
to the spot without changing the Entry Window focus.
Turn Rotor – turns the rotator for the Entry window that has the entry focus to the bearing for the station in the call-
frame or call-sign textbox
Summary Panel Band Selection – Allows you to customize the Summary Panel for any desired mix of HF, VHF and
microwave bands.
Show Summary Panel – uncheck this option to reduce the size of the Available window by hiding the Summary Panel
Help – Internet connection required – displays this section of the manual

Deleting Spots – Another Way
If your mouse has a clickable scroll wheel, you can also delete spots by clicking on the callsign with it
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The Bandmap Window
2019-04-13

The Bandmap Window
Your Bandmap window will be similar to this one.

Key Features

The Bandmap window represents a VFO or a radio. There are three scenarios: one radio with 1 VFO displayed (SO1V); one
radio with 2 VFOs displayed (SO2V); or two radios with one VFO shown for each radio (SO2R). Bandmaps can be zoomed
down to just a few KHz or up to the entire band.

With one radio in SO1V mode, only one bandmap can be displayed. With one radio in SO2V mode, two bandmaps may be
displayed, one for each Entry window. Each bandmap represents one VFO. With two radios the operation is exactly the same,
except that each bandmap represents one of the radios.
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To switch the Entry or RX Focus from one bandmap to the other, Press “\”. To switch both the Transmit and Entry/RX Focuses,
press “Pause”.

The Bandmap window includes the following basic features:

Current receiving frequency is denoted by a blue arrow. If split, the current transmit frequency is denoted by a red
arrow. At the point of each arrow is a graphic depiction of whether the radio is currently in a wide or narrow filter setting
for its current mode.

In this example, the radio is in the CW band. The dark blue and red bands are a notional (not actual) representation of the CW
filter bandwidth, while the light blue represents the tuning tolerance set in the Configurer. If you tune the VFO outside that
range, any call-sign captured into the Entry window’s call-frame or brought into the Entry window’s call-sign textbox will be
erased. If you have elected to set the Config menu option “QSYing wipes the call and spots QSO in bandmap,” the station you
did not work is spotted in boldface as a reminder to come back to it.

The up/down arrows in the upper right control the size of text in the window, independent of the global setting for the
rest of the program.
In the title bar, the first line of smaller type shows the name of the connected radio, and the VFO or radio denoted by
the Bandmap. Immediately below in larger type is the receiving frequency and below that, in smaller type, is the
transmit frequency if different (when Split). To the right are three clickable buttons. The first sends SH/DX to the Telnet
cluster to which you’re connected. The second toggles between wide and narrow filter settings, always displaying the
one that is currently selected. Clicking on the third (labeled “CQ”) will jump your radio’s VFO to the last frequency on
which you called CQ on the current band. The text “CQ-Frequency” is shown on the Bandmap on the frequency where
you last went into Run mode, and used as the target for this function.
Below the three buttons are text prompts to remind you that RIT or XIT are on (by turning red), report the amount of the
RIT or XIT offset, and remind you what mode the radio is in. Each of these is clickable to turn the function off or on, or
to step through the available modes – see Clickable Text Messages below.
In the bottom line of the header are four (or more, up to 36) programmable message or radio control buttons. Right-
click on any of them, and an editing dialog will appear, in which you can edit the contents of existing buttons, or add
new buttons simply by adding new lines to the list:

Choosing the Direction of the Frequency Display

Frequencies in the Bandmap window may be displayed either increasing from top to bottom (with the lowest
frequency at the top as in the screenshot above), or from bottom to top (with the lowest frequency at the bottom).
There is an entry in the right-click menu to choose the direction. However, there is an interaction with the Spectrum
Display window that affects this. If the Spectrum Display window is open in the horizontal (“Column”) orientation,
frequencies in the Bandmap window will be displayed with the lowest frequency at the bottom regardless of the
setting of this option in the Bandmap window. In order to view the Bandmap window with the lowest frequency at the
top, the Spectrum Display window must either be closed or in the vertical (“Bar”) orientation, and the direction option
in the right-click menu must be unchecked.

The reason for this is that the direction is forced by the program to be consistent between the Bandmap window and
the Spectrum Display window. The direction in the Spectrum Display window can be changed when that window is in
the vertical orientation, but not when it is oriented horizontally, and therefore only one direction is available in the
Bandmap window when the Spectrum Display window is oriented horizontally.
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The buttons appear in groups (rows), four buttons per row. In SO2R or SO2V, there is a separate set of buttons for
each bandmap window (Radio 1 and Radio2, or VFO A and VFO B).
Once they have been programmed, the buttons in the bandmap window (or in SO2R/SO2V, the bandmap window for
the radio or VFO that has keyboard focus) can be accessed from the keyboard using Ctrl+Alt+Shift+0 through
Ctrl+Alt+Shift+Z key combinations (or by using AutoHotKey or an external programmable keypad programmed to send
those key combinations). The button in the upper left corner is button 0. Button 9 is the third row, second column. The
tenth button is the third row, third column (button “A”). The next button (third row, fourth column) is button “B”. Etc.
The string to send is in the format of a function key message or a radio control macro (e.g. CAT1ASC or CAT1HEX
macro). Enter a label into the button label column and a CW/SSB/Digi message or a radio control macro in the same
format you would use in a function key message, including the curly braces. into the “String to send” column. Now
clicking on this button will send the selected command to the radio. You can use “|” to set up commands and labels to
toggle between the information on either side of the button. For an Icom 7300, here are some radio control examples:

Scope on|Scope off {CAT1HEX FEFE94E0271001FD}|{CAT1HEX FEFE94E0271000FD}
100w|50w|20w {CAT1HEX FEFE94E0140A0255FD}|{CAT1HEX FEFE94E0140A0128FD}|{CAT1HEX
FEFE94E0140A0051FD}
IP+ on|IP+ off {CAT1HEX FEFE94E01a0701FD}|{CAT1HEX FEFE94E01A0700FD}
NR On|NR Off {CAT1HEX FEFE94E0164001FD}|{CAT1HEX FEFE94E0164000FD}
NB On |NB Off {CAT1HEX FEFE94E0162201FD}|{CAT1HEX FEFE94E0162200FD}
AF 20|AF 40|AF 60 {CAT1HEX FEFE94E014010051FD}|{CAT1HEX FEFE94E014010102FD}|{CAT1HEX
FEFE94E014010153FD}
Mon On|Mon Off {CAT1HEX FEFE94E0164501FD}|{CAT1HEX FEFE94E0164500FD}
Fast|Mid|Slow {CAT1HEX FEFE94E0161201FD}|{CAT1HEX FEFE94E0161202FD}|{CAT1HEX
FEFE94E0161203FD}
Vox On|Vox Off {CAT1HEX FEFE94E0164601FD}|{CAT1HEX FEFE94E0164600FD}
No Sp|Split {CAT1HEX FEFE94E00F00FD}|{CAT1HEX FEFE94E00F01FD}
VFOA {CAT1HEX FEFE94E00700FD}
VFOB {CAT1HEX FEFE94E00701FD}
A=B {CAT1HEX FEFE94E007A0FD}
A/B {CAT1HEX FEFE94E007B0FD}
CW {CAT1HEX FEFE94E0010302FD}
LSB {CAT1HEX FEFE94E0010002FD}
USB {CAT1HEX FEFE94E0010102FD}
0 dB|20 dB {CAT1HEX FEFE94E01100FD}|{CAT1HEX FEFE94E01120FD}
Vox|PTT {CAT1HEX FEFE94E0164601FD}|{CAT1HEX FEFE94E0164600FD}
ClearIt {ClearRIT}{CAT1HEX FEFE94E0210100FD}
Run {RUN}
S&&P {S&P}
No Pre|Pre 1|Pre 2 {CAT1HEX FEFE94E0160200FD}|{CAT1HEX FEFE94E0160201FD}|{CAT1HEX
FEFE94E0160202FD}

You can mouse over any call-sign on the Bandmap and a tool-tip will appear briefly, telling you when the station was
spotted, by whom, and anything else about the spot. In addition, when a spot is less than three minutes old NEW will
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be placed behind the call and bearing on the Bandmap. When the spot includes split frequency information, the
station’s receiving (QSX) frequency will be shown behind the bearing. Splits are shown as 3 digits on HF. The bearing
to a station is shown only for stations outside your own country, with exceptions for USA and Canada.
Spots of stations close to their sunrise/sunset time are marked with a sunrise/sunset indicator “¤”.
CW Skimmer spots are marked with “#” in spotter’s call-sign as skimmer spot in the bandmaps (see picture at right
above). If you are the spotter, then the spots are marked with a “!”.

Colors of the Incoming Spots

Blue: Will be a good QSO, not a multiplier
Red: Single Multiplier Example: CQWW – QSO is either zone or country multiplier (one multiplier)
Green: Double or better Multiplier Example: CQWW – QSO is a zone and a country multiplier (two multipliers)
Gray: Dupe
Bold – This is a self-spotted call. In this context “self spotted” means that the user typed in the call, not that the spot
came from the spotting network.

Note– A different set of color codes is provided for the WAE contests, to assist with QTCs. Read about it here.

Display and Adjustment of Band Plans in Background of Bandmap Frequency Scale

The band plans (mode-based sub band limits) in the Bandmap window are important for other parts of the program besides
the Bandmap window itself. These limits determine what mode the program assigns to incoming spots in the Telnet window if
those spots do not contain the mode in the spot notes. This in turn can affect how the spots are filtered and whether or not
they are passed from the Telnet window to the Bandmap and Available Mults & Qs window. Also, if the “Follow band plan”
option has been chosen in the Configurer under the Mode Control tab, the mode that contacts are logged in will depend on the
frequency. For these reasons it is important to understand how to set the sub band limits appropriately for the type of contest
you are entering. The appropriate sub band limits can vary depending on the contest (DX vs. domestic, SSB vx. CW vs. digital
vs. mixed mode). Inappropriate choice of the sub band limits is a frequent cause of logging errors.
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The illustration above depicts the new feature in N1MM Logger+ for displaying and modifying band plans. This is an
alternative to the procedure provided on the Config menu of the Entry window. Note: This is not real – there is no digital
sub-band inside the SSB portion of the band. It only illustrates all of the options.

There are some considerations to be aware of before you begin.

You can only designate CW and digital band plan segments. It is assumed that anything not designated for one of
those modes is SSB territory.
You can only designate one band segment per mode, but by understanding the rules of precedence used by the
program you should be able to handle this. For example, SSB is defined as not CW and not digital, so there is no need
to set SSB limits.

To set the band plans from the Bandmap window, right-click on a frequency number in the Bandmap. That will bring up the
following menu:

Instead of using this method, you may prefer to use “Change Band Plan” in the Entry Window, Config menu.

Note that you click on the frequency you want to set, and then click in the sub-menu to set it. For example, if you want to set
the digital sub-band minimum frequency on 40 meters for a major RTTY contest, you might click on “7020” and then click “Set
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as Digi sub band min freq”.

The “Set” options are self-explanatory. Options that are not available on a given band or frequency are greyed out.
The “Remove” option is for CW contests, when many CW operators migrate into what are normally digital sub-bands.
To prevent these being logged as RTTY, you can remove the digital sub-bands and re-establish them after the contest.

Keyboard Shortcuts

Numeric keypad + key – Zoom In on the Bandmap associated with the Entry window that has entry focus.
Numeric keypad – key – Zoom out on the Bandmap associated with the Entry window that has entry focus.
Shift – Numeric keypad + key – In SO2V or SO2R, zoom in on the Bandmap associated with the Entry window that
does not have entry focus.
Shift – Numeric keypad – key – Zoom out on the Bandmap associated with the Entry window that does not have entry
focus.

Jumping to Spots on the active radio or VFO (the one with the Entry focus)

Ctrl+Down Arrow – Jump to next spot higher in frequency.
Ctrl+Up Arrow – Jump to next spot lower in frequency.
Ctrl+Alt+Down Arrow – Jump to next spot higher in frequency that is a multiplier.
Ctrl+Alt+Up Arrow – Jump to next spot lower in frequency that is a multiplier.

Jumping to Spots on non active radio/VFO

Ctrl+Shift+Down Arrow – Jump to next spot higher in frequency on the inactive radio/VFO. This will skip over CQ-
Frequency when radios or VFOs are on the same band. Proper keystroke operation is radio dependent. Disabled for
SO1V.
Ctrl+Shift+Up Arrow – Jump to next spot lower in frequency on the inactive radio/VFO. This will skip over CQ-
Frequency when radios/VFOs are on the same band. Proper keystroke operation is radio dependent. Disabled for
SO1V.
Shift+Ctrl+Alt+Down Arrow – Jump to next spot higher in frequency on the inactive radio/VFO that is a multiplier. If
you are operating single mode, your mode won’t change when jumping between spots. Disabled for SO1V.
Shift+Ctrl+Alt+Up Arrow – Jump to next spot lower in frequency on the inactive radio/VFO that is a multiplier. If you
are operating single mode, your mode won’t change when jumping between spots. Disabled for SO1V.
Shift+Alt+Q – Jumps to your last CQ frequency on the inactive VFO/radio. Disabled for SO1V.

Clickable Text Messages

These are found below the radio frequency at the top of the Bandmap.

RIT Offset (already 0.00 in the illustration) – Click this label to clear the RIT offset.
RIT – Click this label to toggle the RIT on and off.
XIT – Click this label to toggle the XIT on and off.
CW/USB/LSB/RTTY/PSK/AFSK/AM/FM – Click this label to toggle from USB/LSB (band-specific) through RTTY to
CW/PSK/AFSK/AM/FM (radio dependent).

Mouse Actions

Click on frequency – Moves the active VFO/radio to that frequency.
Shift+Click on frequency (SO2R only) in inactive Bandmap – Tune the non-active radio without changing window focus.
Allows you to be active and sending on one radio and change the frequency on the non-active radio without changing
Entry window focus.
Shift+Click on bandmap callsign (SO2R only) in inactive Bandmap – Same as Shift+Click on Frequency with the
addition that the callsign is placed in the non-active radio’s Entry window call-frame.
Click on call – Jump to that frequency and place the call in the Entry window call-frame. When the call-sign field is
empty, hit Space to copy the call-sign from the Entry window call-frame to the call-sign textbox.
Double-Click on call – Jump to that frequency, place call in the Entry window call-frame and the call-sign textbox,
replacing anything that was previously there.
Click on or to the left of the vertical frequency scale – Jump to that frequency.
Click frequency label – Jump to that frequency.
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Right Click call – Display the right-click menu for the selected call (see Right-Click menu below).
The selected call will be shown in italic font and underlined when the right-click menu is open

Right Click anywhere else – Display the right-click menu with some options grayed out which are call related.

Right-click Menu Options

If you right click in the Bandmap window the right-click menu will appear. If you do not click on a particular spot, certain
options will be grayed out.
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Remove Selected Spot – equivalent to Alt+D with the spot callsign in the call-frame; removes the selected spot.
Grayed-out when not right-clicking on a particular spot.

Deleting Spots – Another Way
If your mouse has a clickable scroll wheel, you can also delete spots from the Bandmap simply by clicking on them
with it.
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Blacklist callsign – if you click on this option with a callsign selected and the Filter Blacklisted Spot Calls option in
the Filters tab of the Telnet window’s right-click menu is enabled, subsequent spots of that callsign will not be displayed
on the Bandmap or in the Available window. Used to get rid of busted spots that recur often, such as LW3LPL. To edit
the list of blacklisted spots, or to remove a call from the list, use the Edit option on the filter tab.
Blacklist spotter – designed in particular for use when an RBN station is feeding spots that are badly off-frequency
(due to I/Q image problems) or otherwise defective. Could also be used for the occasional harasser on traditional DX
clusters. Again, this feature is enabled/disabled in the Filters tab of the Telnet window’s right-click menu; the blacklist
can also be edited from that tab.
Zoom In (Numeric Pad + or use the mouse wheel with the mouse over the Bandmap window) – Show a smaller
frequency range on the Bandmap that has entry/RX focus; spreads frequency markers and spotted call signs farther
apart.
Zoom Out (Numeric Pad – or use the mouse wheel with the mouse over the Bandmap window) – Show a larger
frequency range on the Bandmap that has entry/RX focus; brings frequency markers and spotted call signs closer
together.
Disable Mouse Wheel

Go to Bottom Of Band – Go to the bottom of this SSB/CW subband.
Go to Top of Band – Go to the top of this SSB/CW subband.
Remove Spectrum Scope Spots, This Band – Remove self-spots that originated from signals above the threshold in
the Spectrum Display window
Remove Spots, This Band Only, Leave Self Spots
Remove Spots, This Band Only
Remove Spots, ALL Bands, Leave Self Spots
Remove Spots, ALL BANDS
Turn Rotor – Turn the rotor to point to the heading of the callsign in the spots
Show Last 10 Spots – click this option (which is gray unless a callsign has been clicked on) and the cluster will be
asked for the last 10 spots of that station. These are displayed in the Telnet window.
Show QRZ – requests address information from the DX cluster for the selected callsign
Show Station – sends the SH/STA [callsign] command to the DX cluster
Show QSL/Packet – sends the SH/QSL [callsign] command to the DX cluster
Show Sunrise/Sunset – sends the SH/SUN [callsign] command to the DX cluster
Set Transceiver Offset Frequency – This is for transverter support. The offset is saved when the program closes and
read again when opened. Remember to enter the frequency of the transceiver and not that of the transverter when
going into split mode (Alt+F7). Information how to fill in this table (which frequencies to enter and how to calculate the
IF frequency) can be found in the VHF and Up Contesting chapter.

Set Transceiver Timeout Time – Sets the time interval after which, if no communication with a radio is occurring, the
program will alert you. The value is set for each radio (default is 15 seconds). Entering a value of zero will disable the
timeout function. Entering a negative number will set the time out value to 15 seconds. Entering a number that is too
large for the program variable will set the timeout to the program maximum. The positive minimum is 5 seconds.
Set Transceiver Filter Codes – This setting controls what is sent to your radio when you click the “Wide/Narrow”
button at the top of the Bandmap to toggle between wide and narrow filters. If no value is set, then the program uses
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the default values set for your radio.

You will be prompted for the wide or narrow string to set the filters. For Kenwood, it’s pretty easy. You just look up in your
manual the string you want and enter it. For other radios, like FT-1000MP, it’s harder. You must enter a series of space-
delimited codes in DECIMAL. Therefore, when an FT-1000MP filter code of 0 0 0 0 8C is required, you must enter 0 0 0 0 140
(8C hex).
To reset to the default values in the program enter a space and press the OK button. It is possible to use {CR} in the filter
codes which will be replaced with the return character. These selection are disabled when manual radio is selected (i.e. no
radio selected).

CW Wide
CW Narrow
SSB Wide
SSB Narrow
Digi Wide
Digi Narrow

Find a Callsign (use Alt-F8 to Return) – This option allows you to search for a particular callsign in the bandmap.
Searches from current frequency up to find each instance.
Bring to Foreground When Made Active – This brings the active bandmap to the foreground. If you don’t have
enough monitor space, you can place Bandmaps on top of one another, and when you move the entry focus between
Entry windows, the active bandmap will be shown hiding the non-active bandmap.
Reset Radios – Allow manual reset of all attached radios. When contact with a radio is lost the dialog below will appear
at the bottom of the Bandmap window. The “Radio Problem” popup will disappear after a few seconds, but the “Reset
Radio” button will remain until communications with the radio has been restarted. Once any physical problem (such as
a disconnected cable) has been corrected, you can click on the “Reset Radio” button or right-click on the bandmap and
choose “Reset Radios” from the right-click menu to restart the connection.

Show Network Station Names – When in networked computer mode, show the frequency that another networked
station is on (if within the range of the bandmap display)
Telnet Bands/Modes – opens the Bands/Modes tab of the Telnet window so you can adjust which bands and modes
will be displayed on Bandmaps and in the Available Mults & Qs window.
Telnet Filters – opens the Filters tab of the Telnet window so you can adjust which spots will be displayed on
Bandmaps and in the Available Mults & Qs window.
Show Lowest Freq at Bottom – This option may be used to change the direction of frequencies in the Bandmap
window (lowest frequency at the top versus lowest frequency at the bottom), provided that the Spectrum Display
window is not open in the horizontal (“Column”) orientation. If the Spectrum Display window is opened in the horizontal
orientation, this option will be greyed out and frequencies in the Bandmap window will be displayed with the lowest
frequency at the bottom regardless of the previous setting of this option. In order to view the Bandmap window with the
lowest frequency at the top, the Spectrum Display window must either be closed or in the vertical (“Bar”) orientation,
and this option in the Bandmap window right-click menu must be unchecked.
Set Spot Timeout – Set the length of time spots will remain on the bandmap before timing out and disappearing
(unless re-spotted)
Show Telnet History – Shows the Telnet history of any station on the bandmap. Select the station by right-clicking on it
and then clicking on this option.
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Show My Call Spot History – Shows the recent Telnet history for spots of your station.
Help – Show the help file for this window.

When the cluster to which you are connected is a DXSpider cluster, select ‘Format for DX Spider cluster’ on the Other tab in
the Configurer.

Hovering with the mouse over a spot

Hovering with the mouse over a spot in the Bandmap gives the following info about the spotted station:

Exact frequency sent by spotter.
Call-sign of spotter.
The time in minutes since the station was placed on the DX cluster network.
Comments sent with the spot.
The notation “Self Spotted” indicates that you spotted the station.

Hovering with the mouse over the blue arrow marking your receiving frequency – shows the exact frequency and tuning
tolerance.

Example Bandmap Usage

by Tom, N1MM

In Search & Pounce (S&P) the call-frame will show you each spotted station as you come within “tuning tolerance” (user
settable) of that station. I’m terrible at remembering whether I worked a station and on what frequency. With worked stations in
the bandmap, the program will tell you that they are not workable again. You can tune by them more quickly. The same feature
is useful in contests with unworkable stations.

In a contest like CQ WPX, with (basically) no value multipliers, here is how I use the Bandmap. Whenever I can’t get a run
going I start S&P on a band with a lot of unworked stations (use the available window). I use Ctrl+Up and Ctrl+Down arrow to
go to the next station. If that station is at the beginning of a QSO, I move to the next one. If the QSO is near the end, I wait
and work the station. Then I move on. If I reach the top of the band, I start coming back down the band, working the ones I
missed on the way up. If there is no station at a frequency, that’s my new running frequency!

In contests with valuable multipliers, you should use Ctrl+Alt up/down to get the multipliers first, then go back and get the
QSOs.

If the rate drops fairly low, sweep the band using your VFO. That is where the old calls in the bandmap come in useful. If you
copy a call, but it seems like it is going to take a long time to work him, tune to the next guy. If you have “QSYing wipes the call
& spots QSO in bandmap” turned on, the call will be spotted in bold, so you can Ctrl+Up/Ctrl+Down to him later.
Remember: if a call is in the callframe, space will load it into the call textbox.

If all this seems very unfamiliar, you haven’t read the Key Assignments help (and/or the Key Assignments Shortlist).
Reading that single item is your single best time investment in using this program.

Spots and the time shown
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When you hover with the mouse over a spot in the bandmap, it will show the relative age of a spot in minutes. The time shown
here depends on the spot format. There are two formats for spots. One is for current spots, one is for SH/DX spots. Some
clusters allow to show old spots in the current spot format. The program handles the two types of spots differently.

Current spots go into the bandmap with the computer’s local (converted to UTC) time. This is to remove variations in
cluster times and order the spots into the time they were received.
Old spots are logged with the originating cluster’s time with the provision that it cannot be later than the current local
(UTC) time.

With AR-Cluster you can display old spots with SH/DX or SH/FDX. It is recommended to use SH/DX, as it will be recognized
as an old spot. Other cluster software may have similar capabilities.

Red lines indicating US license frequencies

On the bandmap there are red lines to indicate extra, advanced and general portions of each band. Since US hams can
operate only in their section and the sections of lower class licenses, it is in your interest to operate some in the higher
portions of each band. Otherwise there are some US hams you will not ever be able to work.

The lines can be found on:

SSB: 3775, 3850, 7225, 14175, 14225, 21225 and 21300.
CW: 3525, 7025, 14025 and 21025.
No lines on 160 and 10 meters.
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The Check Window
2019-04-13

The Check Window
Key Features
The N1MM Logger+ Check window is the latest evolution of the Super Check Partial idea originated by K1EA in the CT
logging program. It combines up to four separate sources for checking the validity of an entered or spotted call-sign. Its
system of color-coding helps the operator determine if the call-sign as copied is correct, and, if not, where the error
probably lies.

When first opened, before a partial or complete callsign is visible in either the callframe or the call-sign textbox of the Entry
window, the default Check window looks like this:

The four upper panes, left to right, will contain results derived from comparison with your current log; with a Master.scp data
file downloaded on the Tools menu of the Entry window; with Telnet spots received by the program, and with a Call History file,
if one has been loaded. The numbers immediately below the grey pane titles reflect the size of the files under comparison, at
the moment the check window was opened. The log and Telnet totals will continue to grow for as long as the underlying
database tables continue to grow, but will not be seen again until you re-start the program.

The bottom pane is for Reverse Call History Lookup, discussed below.

You do not have to display results from all these sources, or from the reverse lookup window. A right-click menu lets you
uncheck any panes you do not wish to see:
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The other choices on this menu will be discussed below.

When you enter a call-sign in the Entry window’s call-sign textbox, beginning with the third character, or a call-sign is
transferred into the call-frame from the Bandmap, the Check window will begin trying to check it against the selected
sources of information. The check results are displayed as below, using “YT1” as an example:

Note the green highlights – given the first 3 characters, the Check window is telling you that there are matches with those
characters, and that any of the callsigns with one or two green-highlighted characters could be correct, based on what has
been found in the various call-sign files.

Now enter another character, making the possible call-sign YT1E. The Check window changes:
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In the first row, the bold and italicized callsign reflects a perfect match in the master file. “YT1A” with the “A” highlighted in red
means that an imperfect match was found in the current log – you may actually have heard YT1A rather than YT1E, since the
station has already been logged once in the contest.

There is another list of suggested call-signs in the master file pane. The first, with the green highlight, means that “YT1E”
matched a call in the master file, but only in part. The full call found in that file is YT1ET, so the “T” is highlighted in green. But
there are other possibilities, if you miscopied one of the characters. Each of the characters that would have to be changed is
highlighted in red.

Special Telnet Features
Because of uncertainty about the quality of Telnet spots, a spot will only appear in the Telnet section if:

It has been spotted at least 3 times or
It has been spotted with a Q or V spot-quality tag on AR Cluster version 6.
If the Save Spots checkbox on the Filters tab of the Telnet window is checked, this check of Telnet spots will be
retrospective to the beginning of the current contest. If it is not checked, the retrospective check is limited to the Packet
Spot Timeout interval set either on the Filters tab or on the Bandmap’s right-click menu.

Reverse Call History Lookup
In contests where this feature is supported you may enter a sought-for multiplier (for example, a rare county in a QSO party) in
the Exchange textbox of the Entry window. The call-signs of any stations with that multiplier in either the current log or the Call
History file will then be displayed in the bottom pane of the Check window. A full description of the Reverse Call History
Lookup feature may be found here.
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Right-Click Menu

The right-click menu contains user-selected options for the Check window, along with some actions that can be taken “on the
fly.” It is opened by clicking in the text area of the Check window (not in the header).

Hide this pane – used to get rid of a pane in the Check window quickly. Right-click in the target pane and click this
option to hide it.
Proportional width this pane – This feature can be used to make one section of the Check window larger than others.
Right-click in the pane you want to enlarge, select this option, and enter a number in the pop-up dialog that appears.
Panes are all the same width by default, so entering “2” will make the target pane twice as wide as the others, “3” will
make it three times as wide, and so on. This choice remains in effect until the Check window is closed and reopened.
The next five checkable options determine which panes appear in the Check window. If you are not running Assisted,
for example, there is no reason to display the Telnet pane; if you have not loaded a Call History file, you can hide that
pane, and so on.
Sorting: Favor end-character differences – Used to determine how much weight to give the last character in an
entered call sign. This will help determine how high up the listing of possible calls a call sign with a /P, for example,
might appear.
Yank: configuration – The hot-key Alt+Y can be used to “yank” a call sign from the Check window into the call sign
textbox of the Entry window, replacing what is currently there. Clicking this option on the right-click menu opens a sub-
menu:

This sub-menu determines the panes in which call signs will be selected for yanking and the order in which those panes are
selected with consecutive yanks. In this example, with LMT entered as the Yank order, the Log, Master and Telnet panes will
supply the call signs to be yanked. The first Alt+Y will yank the first call in the top row in the Log pane. Subsequent Alt+Ys will
step through the calls in the top row in that pane, and then do the same in the Master file pane, and then in the Telnet pane.
After the first row in all the panes has been exhausted, the next Alt+Y will yank the first call in the second row in the Log pane
and proceed through the second row in the three panes in the order specified, and so on.

The Mouse and the Check Window

Yank: allow dupes– As the name suggests, checking this option will allow you to yank call signs which are in your log
and reported as dupes.
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Set Reverse Lookup Threshold – opens a sub-menu where you can select how many characters must be entered in
the Exchange field before the Reverse Lookup occurs. When using a very large Call History file or operating in a QSO
party such as 7QP where the first two letters of each multiplier only denote the state, increasing the threshold above
the default “2” may help to speed up delivery of meaningful results.

The Mouse and the Check Window
Many contesters prefer not to use the mouse, and for them Alt+Y is the solution. For those who prefer to use the mouse,
though, all they need to do is click anywhere in a callsign in the Check window, and the callsign will be pasted into the Callsign
Textbox of the Entry Window.
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The CW Reader Window
2019-04-13

The CW Reader Window
The Logger’s CW Reader is receive-only. The CW reader engine cannot be used to transmit CW; to transmit CW, you must
configure some other method in the Logger (serial or parallel port keying, or a Winkeyer, for example).

CW Reader Setup
The first time you open the CW Reader window, or any time the window is opened with no CW reader engine selected in the
setup, the following dialog will be displayed:

After clicking on OK in the above window, or at any time thereafter by selecting the Setup menu in the main CW Reader
window, the following setup window will be displayed:
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N1MM Logger+ supports three different CW reader programs, or “engines”.

The first, Fldigi by W1HKJ, is also one of the digital engines that is supported by the Logger for digital modes. Fldigi is not
automatically installed with N1MM Logger+; if you want to use it, you must download and install it. Once fldigi has been
downloaded (and optionally configured for digital mode operation – see the Digital – Fldigi for Sound Card Modes chapter), it
can also be used as a receive-only CW reader (N1MM Logger+ does not support transmitting CW from fldigi). Click on the
Enable check box for Fldigi and set up the location of the fldigi.exe file you are using as a CW reader. You should create a
separate folder for the fldigi CW reader and copy fldigi.exe from the main fldigi installation folder into this separate folder. You
may wish to use a separate copy of fldigi for CW from the N1MM+ digital modes copy as well; that way, the configuration
setups for fldigi for CW and for digital modes can be saved separately. Both of these copies of fldigi should be outside the
Program Files or Program Files(x86) paths in Windows Vista or later, in order to enable the configuration files to be saved.
Although you can run fldigi stand-alone from a location in the Program Files path, any copy of fldigi that is run from N1MM
Logger+ in Windows Vista or newer must not be located in a protected Program Files path. When you first install fldigi, you do
not need to do the original installation of fldigi outside the Program Files path. Simply install in the default location, create a
new location outside the Program Files path, and copy the fldigi.exe file from the original installed location into the new
location. The first time it is run from the Logger, fldigi will create the other files it needs in the new location.
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The second supported CW reader program is CwGet by UA9OV. This is a shareware program that can be downloaded from
the www.dxsoft.com web site. It may be used either unregistered (free), or registered (requires a fee to be paid to the author).
The unregistered version does not save configuration information between runs, which means that you will have to perform
the setup (primarily selection of the sound card to be used) each time the CwGet engine is started. In either case, after
downloading and installing CwGet you can select it in the CW Reader setup window by checking the Enable check box for
CW Get and entering the path to the program. It is also possible to select command line settings for CwGet in the setup
window. Unlike fldigi, CwGet may be run from the default installation location even if that location is in C:\Program Files or
C:\Program Files(x86). You do not need to make a separate copy of CwGet outside the Program Files path.

The third supported CW reader type is an external TNC that is capable of decoding Morse code. You set up the COM port
communications parameters for the TNC in the bottom part of the window.

Once the CW reader engine has been selected, click on Save to save the selection and exit the Setup window. This will open
one or two new windows: the CW reader engine window (if you are using fldigi or CwGet) and the CW Reader text window
(see next section). There will be further configuration required in the CW reader engine window the first time it is used (or
every time if you are using an unregistered copy of CwGet), in order to select the sound card that is used for decoding. The
fldigi configuration window may open the first time you use it; if it does, the first part of the configuration information that is
needed for the CW Reader engine is the sound card setup. You also need to ensure that rig control and PTT control are both
disabled in fldigi. The first time fldigi is used as a CW reader engine, it may start up in a digital mode and you may need to
change its operating mode to CW.

Since N1MM Logger+ supports two Entry windows (for two VFOs in SO2V, or for two radios in SO2R), it also supports two
CW Reader windows. The CW Reader window corresponding to each Entry window is opened from the Window > CW
Reader menu item in that Entry window. In order to save separate configurations for the fldigi engines in the two CW Reader
windows, you will need to use two separate copies of fldigi, one for each CW Reader window. If you want to use CwGet in
both Entry windows, it should be a registered copy.
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Both CW Reader software engines (fldigi and CwGet) use a sound card for decoding. If your radio has a built-in USB audio
codec you would normally use that for audio input. If it does not, you would need an audio cable connection between the
radio’s audio output and a sound card input. The radio output can from a speaker or headphone output, or a line output if a
separate output (possibly labelled for digital modes) is available. The sound card can be a motherboard sound card or a
separate sound card, either internal or external. If possible, the input used should be a line-level input. If the only input
available is a microphone input, you may need to supply an attenuator (resistive voltage divider) between the high-level output
from the radio and the low-level microphone input on the sound card. In Windows 10 and 11, starting with the Spring 2018
update of Windows 10, you may need to adjust a Windows privacy setting (Windows Settings > Privacy > Microphone) called
“Let apps use my microphone”. This option must be turned On to give programs like the CW Reader software engines access
to sound card inputs, and the program using the sound card (CwGet or fldigi) would need to be included in the list of apps
authorized to use the “microphone”.

If you are using a TNC as the CW Reader engine, the audio connections will be between the radio and the TNC, and there will
be a serial port connection between the TNC and the computer.

Note that older versions of fldigi only use the left channel on input; for that reason, in most SO2V installations these older
versions of fldigi can only be used from Entry Window 1. Starting with fldigi version 3.22.06, fldigi is now capable of using
either sound card channel for input. In any copy of fldigi that you want to use with the right channel of the sound card, use the
Configure > Sound Card menu item in the fldigi window to open the fldigi configuration window. Select the Right channel tab,
and near the bottom under Receive Usage, check the Reverse Left/Right channels check box to switch fldigi to use the right
channel on receive. Click on Save to save the configuration change, and then close the configuration window.

Recent versions of fldigi may default to requiring confirmation from the user before you shut them down. If that shutdown is
initiated by shutting down N1MM Logger+, instead of by shutting down the CW Reader window and engine first, this can result
in fldigi continuing to run after the Logger has shut down. This can cause problems the next time you start up the Logger. To
prevent this from happening, you need to make a change in the fldigi configuration file. In each folder that fldigi is run from,
find the file called fldigi_def.xml. (Note: this file is created the first time fldigi is run from this location, i.e. it will not exist until
after you have run that copy of fldigi at least once). Right-click on the file name, select Open with… and then select Notepad
or WordPad as the program to open the file with. Look for a line that reads < CONFIRMEXIT > 0 < /CONFIRMEXIT > or <
CONFIRMEXIT > 1 < /CONFIRMEXIT >. If you see a 1 between the two keywords, change it to a 0 and save the file. Repeat
this for every copy of fldigi you use from within N1MM Logger+ (CW Reader 1, CW Reader 2, DI1, DI2, and any digital RX-
only windows you use fldigi in).

If you choose to use CwGet as the engine, note that if you use an unregistered copy of CwGet, that unregistered copy will
only transfer decoded text to the first CW Reader window. In most SO2R or SO2V installations CwGet will have to be
registered if you want to use it from both Entry windows. Also, unregistered copies of CwGet will not save their configuration
data, meaning you will have to set up the sound card parameters every time you start CwGet; registered copies will save their
configuration data and remember it between sessions. The configuration data is stored in an ini file in the N1MM Logger+ user
files area (the same location as the N1MM Logger.ini file). It will be called CWGET1.INI (Entry Window 1) or CWGET2.INI
(Entry Window 2 in SO2R or SO2V).

CW Reader Operation

The CW Reader window is where decoded received text appears. If the scrolling method selected in the Digital Interface
Setup window is “scrolling”, then as new incoming text is decoded, older text is scrolled off the top of the screen. If the
scrolling method selected for the Digital Interface is “non-scrolling”, then text does not move, but incoming text overwrites
previous text on the current line; the current line where incoming text is displayed is indicated by underlining, and moves down
the window one line at a time, jumping back to the top of the window once the bottom line is filled. You can stop scrolling
temporarily by clicking on the green bar at the left of the window; the green bar will turn yellow and the text will stop scrolling
so you can copy it without having to follow it up the screen or catch it before new incoming text overwrites it. When you click
on the yellow bar to resume normal scrolling, the bar will turn green, text that was decoded while scrolling was stopped will be
sent to the window, and then normal operation will resume.

3/4/25, 5:37 PM N1MM Logger+ Documentation



247

You can click on call signs and exchanges in the text window; depending on where the focus is in the Entry window, this will
automatically transfer the text that was clicked on into the call sign or exchange box in the Entry window. This operation is
similar to the way the Digital Interface window is used in RTTY and PSK31.

There are two menu items in the CW Reader window. The first one, Setup, opens the setup window to enable you to change
the CW reader engine. The second one, Clear RX, simply clears the received text window.

In order for the CW reader engine to work, the signal you wish to copy must be tuned in correctly. The CW reader engine has
tuning aids (either a waterfall or a spectrum display in Fldigi, and a spectrum display in CwGet) to help you tune signals
accurately. You can fine tune by clicking in the spectrum display, but be aware that fine tuning in the CW reader engine will
have no effect on your transmitted signal’s frequency. If you wish to transmit on the same frequency as you are receiving on,
your best bet is to set the CW reader engine’s audio frequency to be the same as your transmitter’s sidetone frequency, and
then tune signals using the transceiver’s tuning knob (not by clicking in the spectrum display or waterfall).

Software decoding of CW (Morse code) has its limitations. The signal to be copied must be fairly strong (at normal CW
speeds, the human ear can decode CW at lower signal-to-noise ratios than software can) and clear of QRM and QRN (heavy
QRM or QRN can render the CW undecodeable). The sent CW timing must also be accurate (e.g. machine-sent CW). On a
good machine-sent signal such as ARRL CW bulletins, software copy can be nearly perfect. On the other hand, sloppy hand-
keyed CW can result in errors ranging from poor spacing (v e 3 k i instead of ve3ki) to a complete failure to copy (nothing but
Es and Ts displayed, as the reader software triggers on individual dits and dahs).
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The Entry Window
2019-04-12

The Entry Window
Key Features
The Entry window is the main program window; it’s the “central control panel” for the program. Your entry window will be
similar to this one:

Which Entry window textbox has the entry focus?

Versions 1.0.5108 and after include a change to how Entry Window textboxes are highlighted to show you which has the entry
focus. This is active in SO1V, SO2V and SO2R.

What inspired this change is that Win 10 is particularly bad at visual cues to show you which window is active. In Win 10, if the
title bar is grayed, then the window is inactive. Problem is, some windows don’t have titles. Sigh. It’s probably possible to
change this with the OS, but I doubt many will do it, thus the change.

Beginning with version 1.0.5108, the Skins, Colors and Fonts Window will allow you to choose the old method of indicating
focus, and two choices for background highlighting 
corresponding to the two colors you have chosen for the Log window grid. It is important that your mult and dupe foreground
colors are easily visible on the background that you choose. The default color scheme is pretty reasonable in this regard.

What is different in the new scheme is that only the textbox with focus, in the window with focus, will have a white background.
The white textbox will always tell you where the next character you type will go. If neither Entry window has focus, then all the
textboxes in both will show with a colored background. If you are working in another application, then you will need to use your
mouse to bring focus back to N1MM+.

There is a bonus to this change. We spent a lot of time trying to get focus back to the Entry Windows in a sensible way when
you use the other windows in N1MM+. With the EW textboxes flashing white/color, this focus behavior is made much more
obvious. I would ask that you not complain about the focus movement behavior for a week or two because it has not changed

Customizable Skins, Colors and Fonts
Note that while the colors and font sizes displayed here and in other screenshots mimic the original N1MM Logger
Classic, Logger Plus provides for extensive customization of colors and fonts in every window, part of an effort to
improve accessibility.
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with the “colorization”. Once you have acclimated to the new version, then it would be a good time to point out whatever
inconsistencies there may be in the focus behavior.

Finally, in working on this improvement, I ran across this feature of Windows: http://www.howtogeek.com/194095/how-to-
change-the-blinking-windows-keyboard-cursor-thickness/

It allows you to change the thickness of the cursor. I changed mine to 2. It’s much more visible without being obstructive.

Right-click Menu

In addition, this right-click menu is provided. 

The first 5 choices affect the size of the entry window. Uncheck them to remove things in the window that you do not need. 

“Show User Information”, if selected, will display Call History User Text.

The 6th option, “Band Button Left Click Enabled“, is on by default, but may be turned off. In a multi-op station, it may be
helpful to turn off the left-click band change to prevent accidentally changing bands.

If you click on the 7th option, “Change Band Panel Display”, this dialog will appear.

Click the Default button to display the traditional contest bands (HF or V/UHF depending on contest), or all HF bands except
60M when using the DX general logging “contest.” Check individual bands to display only those bands. Note that if you select
a single band contest on either HF or VHF, the Band Panel will continue to display the full list until you check the bands you
want to have displayed.
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The 8th menu item is “Show GMT Time”. This causes a GMT (UTC) clock to be displayed in the upper right corner of the
Entry window.

The 9th menu item is “Display Sent CW in SO1R and SO2V“. When checked, this causes sent CW characters to be echoed
in the status line at the bottom of the Entry window. In SO2R, this option is always on.

Display of Check status

If the Check window is open and an exact match to the entered call-sign is found, a check will appear in the right end of the
call-sign text box. The check is colored to match the call-sign color and reflect multiplier status – by default, the colors are
green for double, red for single, blue for no multiplier but a workable station for QSO credit. A “?” appears if no match is found,
unless you opt to turn that option off in the View Menu of the Entry window.

Band Panel

To the left of the Call-sign textbox, there is one column of band buttons in the Band Panel for each permitted mode in
the current contest. As a callsign is entered the buttons are colored displaying the mult-status. Using the default colors,
green=”double mult”, red=”single mult”, blue=”no mult – valid qso”, and grey=”dupe or non-workable”). To change the
default color choices – see the Skins, Colors and Fonts window, reached from the Config menu, to change these color
codes throughout the program.
The Band Panel modes are determined by the Mode Category set in the Contest Setup Dialog (File > New Log or
Open Log), not by the mode of the radio or one entered in the call-sign textbox (\”CW\”, \”USB\”, etc.).
Left click on a mode/band button to move the program to that mode and band; an attached radio will follow, to the last
frequency you used on that band. The rounded rectangular box around “15 CW” in the illustration above is an indicator
of that radio’s current band and mode, which may be useful during rapid band changes.
To change the bands and modes displayed in the Band Panel, right-click on a blank area of the Entry Window and
choose “Change Band Panel Display…”
When not in Networked Computer mode, if you right click on a mode/band button, your radio will QSY to that band and
mode, to the last frequency you used on that band, and the callsign of the last station you logged will be locally spotted
(not sent out to the Internet). This feature is primarily intended for VHF contests where you may want to move a
station to many band/mode combinations in quick succession.
When in Networked Computer mode with a callsign in the Callsign textbox, if you right-click on a band/mode button,
the callsign and frequency of the station you are working will be passed to the networked computer on that band. An
Info window message will be sent to the recipient station, and the passed callsign will be placed on the recipient
station’s Bandmap on its specified Pass frequency.

Action Button Row

Esc:Stop – Immediately ends transmission of a stored message (all modes)
Wipe (Alt+W, Ctrl+W)– Clears information about the current contact. You can also program this into a Function Key,
using the {WIPE} macro, for one-keystroke operation. A second press will restore the information that was wiped out.
Log It (Enter) – Writes this contact to the log. Disabled when in Quick Edit mode. If you have not filled in all needed
exchange information, you will be prompted before logging will occur. You can use Ctrl+Alt+Enter to circumvent this
\”editing\” function and log whatever you have entered, for correction later.
Edit – Pops up the full Edit window to edit the last contact. Use Ctrl+Q (Quick Edit) as a convenient alternative. Greyed
out when in Quick Edit mode.
Mark (Alt+M) – Marks the current frequency in the Bandmap as being in use. Used when you don’t want to take time to
enter the call of the station using the frequency.
Store (Alt+O) – Spots on the Bandmap the call-sign you have entered in the Call-sign textbox. It will be shown in bold
because it is self spotted. The Telnet Filter tab option \”QSYing wipes the call and spots QSO in Bandmap\” is an easier
way to do this, whether you have worked the station or not.
Spot It (Alt+P) – Spots either the callsign in the callsign textbox or the last QSO logged, if Telnet is active. See this
section for more information.
QRZ – Performs a lookup on QRZ.com of the call-sign in the Call-sign textbox, if your computer is connected to the
Internet.

Function Key Panel

F1 through F12 – Sends the associated CW/Digital text or .wav file, and executes any macros stored in the message.
Right click on the buttons to open the Function Key Editor. Running and S&P modes each have 12 stored messages.
Press Shift+F1 through F12 to send the Run message when in S&P mode, or vice versa.

Run/S&P (radio buttons) (Alt+U)

Switch between Run and S&P mode. This also switches between the Run (first 12) and S&P (second 12) messages in the .mc
file (unless the second 12 messages are not present in the .mc file).

CW speed (PgUp/PgDn)
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The textbox shows the current CW speed. Either PgUp/PgDn or clicking the up/down arrows alongside the speed will
change the speed. Only visible when CW mode is selected. The interval in WPM is set on the Other tab in
the Configurer. Additional keystroke combinations for changing speed by a larger (secondary) interval may be seen
under Key Assignments.

Entry and Transmit Focus – The Red and Green dots (“LEDs”)

On the Entry Window below the left end of the Call-sign textbox you will see either a green or a red dot (LED), or both. The
LEDs are visual aids that help you keep track of what is happening on each VFO/radio, particularly when operating SO2V or
SO2R. This is part of N1MM’s continuing philosophy of letting the operator easily know what’s happening at any given time.

Green dot/LED – This VFO/radio has Entry focus – also known elsewhere in this manual as RX (Receive) focus or Keyboard
focus. This means that any information entered by keyboard goes in that window, including function keys. Depending on your
SO2R switching setup, it may also denote which radio you are hearing in your headphones.

Red dot/LED – This VFO/radio has the Transmit focus. When actively transmitting, the red LED turns to orange (default) or
another color defined in the Manage Skins, Colors and Fonts window, reached from the Config menu. Note that the Transmit
focus does not necessarily tell you which radio will transmit next; this depends on whether transmitting is initiated from the
keyboard or by some other method. For example, if the red LED is in Entry window A, but the green LED is in Entry window B,
pressing F1 will send CQ on radio/vfo B, because it has the Entry or Keyboard focus; the red LED will move to that window
before transmitting starts, and remain in the active transmit color for the duration of the CQ before returning to the darker red
color. On the other hand, if transmitting is initiated without using the keyboard (e.g. from an external paddle or footswitch), the
transmit focus will not move.

The following table explains how certain keystrokes and mouse-clicks move the LEDs from one entry window to the other

Action Starting condition First keystroke Subsequent keystrokes

Back-slash Both in one Entry window RX focus to other Entry
window

Toggle RX focus between Entry
windows

One in each Entry window RX focus to other Entry Window Toggle –

Pause Both in one Entry window Both to other Entry
window Toggle both

One in each Entry window Both to Entry window with
Transmit focus Toggle both –

Mouse click (anywhere but
buttons) N/A RX to clicked window N/A

Ctrl+left arrow Both in one Entry window Both to VFO/Radio A Nil

One in each Entry window Both to VFO/Radio A Nil –

Ctrl+right arrow Both in one Entry window Both to VFO/Radio B Nil

One in each Entry window Both to VFO/Radio B Nil –

The Ignore Winkey Speed Pot setting
When using a Winkeyer, if you do not check “Ignore Winkey Speed Pot” on the Winkey tab in the Configurer, the
program’s starting CW speed will be set by the Winkeyer speed knob. If you check that box, the program will start at
the last CW speed used.



Messages Based on Radio/VFO with Entry Focus
When using function keys to transmit either CW or stored voice messages, the message will be sent on the radio or
VFO that has the Entry focus, not the one that has the Transmit focus. When you press the function key, the red LED
denoting Transmit focus first switches to the Entry window that has the Entry (Keyboard) focus, and then the
message is transmitted. On the other hand, when using either manual CW or phone, messages will be sent on the
radio or VFO that has the red LED, so if you grab the microphone or paddle, that’s what you’ll get. After a while, it
becomes second nature – we promise!
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Repeat CQ

Alt+R – Toggles between Repeat CQ and normal CQ modes. The message “CQ Repeat is on/off” appears in the Status Bar
with each Alt+R entered. 
Ctrl+R – opens a dialog for setting the repeat interval (in seconds).

When you first press F1 after selecting repeat CQs, an icon will appear in the Entry window, like this.

As long as the icon is visible, the CQ will repeat at the repeat interval. If you interrupt with a call-sign or the ESC key, it will
disappear.

Bearing and Call History Information

If they are enabled in the right click menu, the two lines below the buttons will display useful information.

The Bearing line displays short and long path beam headings and short-path distance to the station whose call-sign is
entered in the Call sign textbox. Call history information for the entered call sign also appears in this line when Call History
Lookup has been enabled on the Config menu.

If there is information in the UserText field in the call history for the entered call sign, it will be displayed in blue font in the
following User Information line.

The Status Bar

The Status Bar is the bottom line of the Entry window is always displayed. It is divided into three panes

Left pane – Information
After entering a call-sign – Country, Zone, Continent
Otherwise – Program messages (error messages, results from commands such as CW speed changes, or
recording of .wav messages. You may need to widen the Entry Window temporarily to display full file paths and
other long messages.

Middle pane – QSOs /multipliers (/zone) depending on the selected contest.
Right pane – Current score

Callsign & Exchange Box Editing

Space Bar – moves cursor between the Call-sign and Exchange textboxes. The cursor will always return to the
position it was in when last in that textbox.
Tab – Moves to the next textbox.
Shift+Tab – moves to the previous textbox.
Home – moves cursor to beginning of the current textbox.
End – moves cursor to end of the current textbox.
Question mark (?) – In the Call-sign textbox, sends “?”. The “?” will be highlighted (selected) when the cursor returns
to the textbox. For example, entering N?MM in the Call-sign textbox will send what is typed, and automatically highlight
the “?” when you space back to it, so you can easily replace it. A double “?”, as in DL?K?A will highlights all text in
between and including the “?” marks, and the first keystroke entered will replace all three characters.
Left/Right Arrow – moves cursor to left or right one position within a textbox.
Backspace – deletes character to the left of the cursor position.
Delete – deletes character to the right of the cursor position.
Shift+Home – highlights from the cursor position to the beginning of the current textbox, so that you can easily replace
all the highlighted text. You can use Ctrl+Insert or Ctrl+C to copy the highlighted text to the clipboard, and then use
Shift+Insert or Ctrl+V to paste the text from the clipboard, for example to copy the same call sign into the call sign box
on a new band. This is the easiest way to enter the same call sign repeatedly when passing a station from band to
band.
Shift+End – highlights from the cursor position to the end of the textbox, as above.
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Shift+arrow key – highlights as you press the arrow keys in either direction. When you type the first new character, it
replaces all the highlighted characters.

Callsign Box Text Commands

While N1MM Logger+ does not make extensive use of text commands (as CT did and Win-Test still does), there are a few that
may prove useful.

In each case, the command is typed into the Call-sign textbox of the Entry window, and executed when Enter or
Ctrl+Enter is pressed.

Mode Changes – Enter CW, USB, LSB, SSB, AM, FM, SSTV, RTTY, PSK31, PSK63, PSK125, PSK250, DIGITAL, FT8
or FT4, and the program (together with your radio, if one is connected) switches to the requested mode for logging
contacts. This is particularly useful Manual Operation, when you have not connected a radio, but wish to change the
mode recorded in your log. For SSB, the switch will be to the conventional sideband (e.g., USB on the higher bands, or
LSB on 40M and down). If you need to be on the opposite sideband for some reason, enter USB or LSB as needed.
Frequency Changes– Enter a full frequency in kHz (e.g., 14025.1 , or 14025,1 if your computer uses comma as the
decimal separator) and the program moves to that frequency.

Type a partial frequency relative to the current lower band edge (e.g. 025.1) and the program goes to that
frequency relative to the band edge.
Type a desired shift (in kHz) with a + or – sign (e.g. +2, -3) to QSY by the selected amount (i.e. up 2 kHz or
down 3 kHz).Type a zero (0) and the VFO will QSY to the bottom of the band. If your radio is interfaced for radio
control, its frequency will follow the program.
Type a freqeuncy with a leading forward slash “/”, the frequency will change in the opposite VFO/Radio.
Type a frequency, but execute with Ctrl+Enter, and the program (and radio, if connected) goes into split mode
and uses the frequency you entered as the transmit frequency. For full information on split operation, see this
chapter.
LIGHT command – For UHF contests. Sets the frequency to 400000000000khz

WIPELOG command – Wipes the Log and deletes any “practice” QSOs from a log before you begin actual operation.
In single-computer stations it may be as easy simply to create another instance of the contest from the Contest Setup
dialog. In networked computer stations such as multi-ops, use of WIPELOG is helpful for ensuring that the logs
maintained on each computer will be consistent with one another. It is important that every computer on the network
performs the WIPELOG command before any contacts are made. Any spare computers should be set up for the
contest, and the WIPELOG command executed, before they are connected to the network.
TOUR command – A very few contests allow for multiple sessions in which you can work the same station in every
session for QSO credit. You can enter TOUR into the Entry window in place of a call sign to reset dupe checking at any
time before or during the contest. This command has 2 required parameters that are entered into the Sent RST field,
separated by a forward slash “/”. The first parameter is the time when the current session begins (GMT) and the second
parameter is the duration of the session. The format for both parameters is hhmm. For example, 1200/30 means the
session starts at 1200Z and has a duration of 30 minutes. The minimum value for the duration parameter is 5 (5
minutes). If the TOUR command is entered without any parameters, the current values of the start time and duration
will be displayed. The default values are 0000/00.

At the beginning of each session the start time and duration will be displayed in the status field at the bottom of
the Entry Window. After the first QSO has been logged during the new session you should see the Multiplier
window reset and dupes will be reset for this new session as well.
Most of the contests supported by the Logger do not need this command but some (mostly Russian and
Ukrainian) have it built into the contest module and do not require it entered manually.
If you are planning on using TOUR command with other contests, keep in mind that settings for it will be lost
when the Logger is restarted. If the Snt (sent RST) field is not displayed in the Entry window, you will not be able
to use this command.

OPON – a Multi-OP command is the equivalent of Ctrl+O, and opens a sub-window for a new operator to “sign on.” The
operator is saved in the log with each contact for later display and analysis (for example, using the View > Statistics
menu item and selecting Operator as the row or column to be displayed).

The operator currently “ON” is displayed in large blue letters in the Info window. QSO-specific operator
information is not included in the Cabrillo file (it is included in ADIF exports), but the “Update Ops from Log”
button in the Contest Setup Dialog can be used to create a list of operators to be included in the Cabrillo header.
OPON determines what will be returned by the {OPERATOR} macro, which can be used in SSB function key
message files to invoke individual wav files in each operator’s voice.
OPON saves the window positions & skin of the prior operator before loading the window positions and skin of
the current operator.

Keyboard Shortcuts
Check out the Key Assignments page in Keyboard Shortcuts for a listing of all available “hot-key” assignments in the
program.
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Encourage your operators to OPON the relief operator’s call to help ensure that you can track who makes the
most Qs, mults and errors! If operators customize the color and/or window sizes, it helps them to remember to
OPON when the “wrong” window layout is in front of them.

BONUS command – For QSO Party contests. Opens a window to enter bonus station callsigns if the QSO party has
bonus callsigns
VERSION command – displays the version of the country file in use

Mobile/Rover/VHF Commands

ROVERQTH command – for use in QSO parties with Mobile/Rover/VHF operations. Opens a pop-up window into
which you enter your current or planned county abbreviation, in the form specified by the contest organizer. See the
section on Mobile/Rover Support.
COUNTYLINE command – for use when operating from a county line in QSO parties. Opens a pop-up window into
which you enter the county abbreviations, separated by a comma. After you exit this window, check the title bar of the
Entry window to ensure the correct counties are listed.

BEACONS command – This command will load a user-prepared file called Beacons.txt from the N1MM Logger+
document directory (which sub-folder?) unto the database.

The purpose of the Beacons command is to permit users to display beacons on their Bandmaps for much longer
than the normal packet timeout, as a reminder to listen for those stations periodically. In the sample above, the
beacons will continue to be displayed for 60 hours after the command is invoked. Note that unlike the other Entry
window text commands, this one pops up a file selection dialog as soon as the last letter is typed; no Enter is
required, other than to exit the dialog and load the file once it has been selected.
The Bonus file format is:

The purpose of the Beacons command is to permit users to display beacons on their Bandmaps for much longer than
the normal packet timeout, as a reminder to listen for those stations periodically. In the sample above, the beacons will
continue to be displayed for 60 hours after the command is invoked. Note that unlike the other Entry window text
commands, this one pops up a file selection dialog as soon as the last letter is typed; no Enter is required, other than to
exit the dialog and load the file once it has been selected.

Dual Entry Windows

The program can have two Entry windows, one for each VFO (SO2V) or for each radio (SO2R). Select these, or SO1R, in
the Configurer.

The master Entry window, which is always open, is linked to VFO-A or radio 1. 
The second Entry window is linked to VFO-B (SO2V) or radio 2(SO2R). The second Entry window is automatically opened
when SO2V or SO2R is selected. If it is closed for any reason, it can be reopened by typing “\” (backslash) anywhere in any of
the Logger+’s active windows, except for the Telnet window.

If two Entry windows take up too much screen space, you can right-click on either window and reduce its size by omitting lines
of content, such as the row of Action buttons. you’ll note that in the VFO-B example below, some lines have been omitted. You
can also position the second Entry window over the first Entry window. Typing “\” (as above) will bring the one that has been
hidden to the front, with Entry focus.

The Entry Window examples below reflect a typical setup: VFO-A is now assigned to running, and VFO(B) is assigned to S&P.

1
2
3
4
5
6
7
8

# Hours to stay in bandmap (mostly > 24 or > 48)
60
# call beacon;frequency;locator;comment
OZ7IGY/B;144471,1;JO55WM;
PI7CIS/B;144416,2;JO22DC;Should always be heard
DL0PR/B;144486,3;JO44JH;Switches power!
GB3VHF/B;144430.4;JO01DH;QRG with a .
ON0VHF/B;144418,5;JO20;4 digit grid
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All of the Entry window features that are available to the single radio operator also work in SO2R/SO2V. For example, when
tuning the band with the S&P VFO, spots that are in the bandmap are automatically inserted into the relevant call-frame
(above the Call-sign textbox) when you tune across the frequency of the spot. Hitting the space bar (or Enter, in ESM) will pull
the call-sign from the call-frame into the Call-sign textbox. Then if a station calls you on the run radio, toggling back and forth
between Entry Windows with the \ key will keep the information in each Entry Window until the respective stations are logged.

CW speed adjustments with PgUp/PgDn keys or the mouse apply to the active Entry window, i.e. the one that has transmit
focus (red/orange dot). To change the CW speed in the inactive Entry window, use Alt+PgUp/PgDn.

The second Entry window will be opened when a call is clicked in the second bandmap, if it is not already open.

More SO2R info can be found in the SO2R section of the manual.

SO2V – Two VFOs, Two Entry Windows, Two BandMaps
In SO2V (one radio – two VFOs = ‘normal’ operation) QSOs made on VFO-A have to be entered in the standard
(first) Entry window. Making a QSO on VFO-B (transmitting and receiving on VFO-B) has to be done by using the
second (VFO) Entry window. So when using both bandmaps, both Entry windows are needed to make QSOs on both
VFOs. However, when operating split, the program transmits on VFO-A, and only the master Entry window needs to
be open. If both are open in SO2V the second entry window displays the receive frequency.
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Call-sign Colors

There are two places where a call-sign can be shown in the Entry window , in the Call-sign field and in the Call-frame. The
default colors for the call-sign text are consistent with other places throughout (such as the Band Panel and Available Mults
and Qs windows), and are described below:

Red Single Multiplier Example: CQWW – qso is either zone or country multiplier (one multipliers)

Gre
en Double or better Multiplier Example: CQWW – qso is a zone and a country multiplier (two multipliers)

Blu
e New contact

Gra
y

Dupe contact or an unworkable station in a non-workable country. This means that you don’t need this station
because he is a dupe or you are not even ‘allowed’ to work him in this contest according the contest rules.

Alternative colors may be used by specifying them in the Manage Skins, Colors and Fonts window, reached from the Config
menu.

Entry Window Shortcut Keys

Clicking on the Exchange textbox will have the same effect as pressing Space when the cursor is in the call-sign
textbox.
The frequency, emission mode (e.g. CW, USB) and radio name are shown on the Entry window title bar.
When tuning the band, if a station on the Bandmap is within the tuning tolerance, its call will be placed in the Entry
window’s call-frame. When the call-sign textbox is empty, pressing the space bar will copy the call-sign from the call-
frame to the call-sign textbox.
Ctrl+P – Spot the station entered in the call-sign field to the active Telnet cluster, if any. You will be prompted for a
comment. If no station is entered in the call-sign field, the last logged station this session will be spotted. Macros are
accepted in the comment sen
Alt+R – Toggles Repeat CQ. You can stop repeat CQing by beginning to enter a call-sign, or by hitting Escape. After
you complete manual input, if you press F1, Repeat CQ will resume. Press Alt+R again to exit this mode.

Ctrl+R sets the period of repeat in seconds or milliseconds.
A ‘R’ will be shown in the red TX status LED when repeat mode is on.

The repeat timer for CW and SSB is for the interval from when you stop sending CQ until CQ resumes.
Repeat CQ is not available when using an external DVK, because there is no indication of when a
message has ended.

When using a radio with internal voice or CW message memories, the repeat timer can be used together with a
CAT macro in the relevant function key. Note: The repeat interval is measured from the start of one message to
the start of the next one, i.e. it includes the message as well as the time between messages. Therefore it has to
be longer than the duration of your CQ message at the slowest CW speed you use. If you change CW speeds
using the radio’s speed control, a repeat interval that is appropriate for the slowest CW speed will likely be
longer than you would like at higher speeds.

Ctrl+Shift+Fx – Record SSB message for the assigned function key. Pressing Ctrl+Shift+Fx again stops the recording.
Fx can be F1 to F12, either Run or S&P mode.
Ctrl+Alt+Fx – Record external DVK memory 1 to 4. Fx can be F1 to F4. An external DVK has to be connected and
configured on an LPT port.
Enter sends messages – An entire normal contact can be completed with the Enter key. More information is given in
the Using Stored Messages chapter under ESM (Enter Sends Messages)

Ctrl+Q – enters Quick Edit mode. When you are in QuickEdit mode, the background of the Entry window textboxes are
colored light blue. “QuickEdit” is also shown in the callframe.

There is no check of the exchange against the contest rules, as is done when the QSO is entered normally. So check
thoroughly what you change.
If you have multiple filters or a crystal filter and DSP, Alt+’ (Alt+single quote) toggles between a wide and narrow filter
for the selected mode (SSB, CW or Digital). This hot-key will work whether you have changed your filter codes or not.
Filter codes can be set in the the bandmap right click menu.
A warning message will be shown if user tunes away before logging a qso in the Entry window.
Force logging – The program tries to help you by validating what you copy as the Exchange, but if it is balking and you
don;’t want to stop to figure it out, you can force logging with Ctrl+Alt+Enter. A small Note window will pop up, pre-filled
with the words “Forced QSO”. You can type over to remind yourself later what you copied, or simply hit Enter to log the
default note.
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Function Keys

General

Function keys F1-F12 are used for sending stored messages. The use of stored messages is covered in detail in another
section. This section deals with the generic behavior of the Function keys.

The Function keys can be stacked. This means you can press several Function keys in close succession, and the contents
will be sent in full in the selected order, with a space between. For example, you could press F4 to re-send your call (if you
think the other station did not get it right) and immediately press F2 to send the exchange. The program will send the two
messages seamlessly.

When hovering with the mouse over a Function key button the text to be sent is shown.

Run mode and S+P mode

If the Run radio button is selected, you will see the Run messages, and vice versa. Pressing Shift and a Function key sends
the message stored in that key in the opposite mode (Run if S&P, and vice versa)

When you press Shift alone, the labels will change to those from the other mode (if different). This will help you decide if you
want to send one of those messages by holding the Shift and pressing a Function key.

When you call CQ on a frequency, the marker CQ-Frequency is placed at that frequency on the Bandmap. Thereafter, if you
are in S&P mode and you tune within the tuning tolerance of the marker, the program will switch automatically to Run mode.
Clicking on the ‘CQ-frequency’ in the Bandmap also will place the program in Run mode again.

Note that when in Search and Pounce mode, you can switch to Run mode by pressing F1 to send what is called the S&P CQ
message. That will send the S&P F1 message (for example, “QRL?”) and switch the program to Run mode.

Alt + F11
Normally when you are on your CQ-frequency you will be in Run mode and QSYing will switch to S&P mode. Press
Alt+F11 to disable this automatic mode change, and again to re-enable it. A message in the Entry window status bar
will indicate what the current state is. When on a DXpedition this behavior can be very useful.
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Entry Window Menus

File Menu Selections

New log in database

Create a new contest log in the current database. More info here.

Open log in database

Open an existing log in the current database. More info here.

New Database

Create a new log database. Change the proposed name (ham.s3db) into a meaningful name for the use or contents of this
new database. Until you change to another database (see Open Database below), this database will be opened by default at
startup of the program.

Open Database

Open an existing log database. Select from databases already created.

Convert N1MM Database to N1MM+

This option is intended for use after you install N1MM+ but before you delete N1MM Classic from your computer. Because
N1MM+ uses SQLite, in order to access an old database (.mdb file) you need to do two things. First, open the old database in
N1MM Classic (any version 14.0.0 or after – if your only copy of N1MM Classic is older than 14.0.0, you can find an updated
version on the web site at >Downloads > File Explorer > All Downloads > Program Files > N1MM Classic Archive). Then close
it, close N1MM Classic and open N1MM+, select Convert…(this option) in N1MM+, and navigate to your N1MM Classic
program directory. Select the database you want to convert, and hit Open. You will be asked for the name you want to give it
under N1MM+, and when you hit Enter the database will be converted and placed in the Databases subfolder in your N1MM+
user files folder (the one pointed to by the Help > Open Explorer on User Files Directory menu item).

Copy This Contest to Another Database
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Copy the current contest log to another database. If the target database does not exist, you should create it first, using the
New Database command. The original database is not changed, nor does the program start using the new database unless
Open Database is subsequently used to open it.

Copy All Contests to Another Database

Copies all contests in the current database to another database. After selecting the database you wish to copy to, the
following dialog appears:

Cancel exits without doing anything.

DX will copy all QSOs from all contests in the current database (except for deleted QSOs) to the DX contest in the target
database.

Separate will create new contests in the target database with the same properties as the contests in the source and copy all
QSO’s to those new contests. The sole exception to this are QSO’s in the DX contest. They will be copied to the DX contest in
the target if it exists. If not, it will be created.

Generate Cabrillo File

Invites you to name your Cabrillo file for the current contest, double-checks your sent exchange, creates the file, and opens it
in Notepad for you to check before you send it in.

Once created, the Cabrillo file can be edited using Notepad or any text editor. Make sure that the Station information (Config >
Change Your Station Data) and Contest Setup (File > Open Log in Database) are correct before creating this file. Be sure to
enter the correct Sent Exchange in the Contest Setup dialog, or else your Cabrillo file will be wrong.

Double-check your entry class before generating the Cabrillo file. The defaults may well not be appropriate for your entry in
this particular contest. The program defaults to Single Op Assisted as your class, and you may not want that. For Multi-op
stations select the correct Operator Category in the Contest Setup window. This generates the correct numbers for each
station; in Multi-single, the station number field (the last digit in each line) identifies the Mult and Run station.

It is a good idea to rescore the contest (Tools>Rescore Current Contest) before submitting and check to be sure that the
header of the Cabrillo file is correct before submitting the log. Some contest organizers use non-standard operator categories
(i.e. not in the official Cabrillo specification); in these contests you will have to edit the category by hand to make it agree with
the organizer’s requirements.

Note that if your radio was not interfaced to the program when contacts were logged, those contacts will be exported with
bottom-of-band frequencies (e.g. 14000), whereas if you used an interfaced radio, the exact frequencies will be exported in
the Cabrillo file.

Why Copy A Contest to Another Database?
There are many reasons why you might want to copy contests from one database to another. Many users have
created databases organized by year, by contest type, and so on. This option makes that easy.Some users,
particularly those whose CPU or PC memory capacity is limited, have found that they get improved program
performance by using a database that has only one contest (or relatively few QSOs) in it. If you start off using a
database with many contests already in it, you can always create a new database and then copy the QSOs you have
already made to it.



Digital Mode Designators
Note: The Cabrillo standard only supports one mode designator for digital modes: RY. In some digital or mixed-mode
contests, PSK and RTTY may be considered separate modes, and the contest organizers may specify additional
non-standard designators such as PK. The Logger’s Cabrillo mode export string for PSK is “PK” unless the contest
considers RTTY and PSK to be a single digital mode. When this occurs the mode export string is “RY”. Because the
use of these mode designators is non-standard, you should always check with the organizer’s file specification and if
necessary, edit the Cabrillo file to meet the organizer’s requirements.
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Import

Import ADIF from File

=**Import ADIF from file… – Load the data from an ADIF file into the current database. The Contest Name in the ADIF
file must match the contest name in the current database.

If the ADIF file contains tags that are not used by the N1MM Logger+ program, they are ignored. This is often the case when
the ADIF file is generated by a different program. To view the N1MM Logger+ ADIF tags open a contest of the same type, log
one or more dummy QSO(s), then export the ADIF file. Compare the Contest Name and QSO tags for the important QSO
elements. Note that ADIF files for WAE contest logs do not contain QTCs, only QSOs, and therefore you cannot transfer WAE
logs including QTCs between databases using ADIF files. See the FAQ for more information.

The imported contacts are not scored during the import process. It is necessary to do a rescore (Tools > Rescore Current
Contest) after the import in order to have the points and multiplier status of the newly imported contacts recorded and included
in the calculated contest score.

Import Call History

Import Call History… – Call history files (typically with the extension .ch or .txt) are used to suggest exchange
elements based on past experience with the current station. Importing a call history file will overwrite the call history
table in memory where it is used by the program. See this full explanation
Import State and Province Abbreviations… – Import the state and province abbreviations used in many contest
modules. This is done automatically when changing databases, but may be worth trying if you have trouble in a contest
(particularly a QSO Party) with the program not recognizing certain county, state or province abbreviations. Do a
rescore after executing this menu item, when QSOs have already been logged.

Recover QSOs from a Transaction (TRN) Log File

As each QSO is entered into a contest log, N1MM+ automatically adds an entry in a transaction log (also known as a
transaction file). These files are created automatically, stored in the Databases\TransactionLogFiles sub-directory within the
N1MM Logger+ User files area, and have the filename suffix TRN. These files are used as follows: During normal operation
N1MM Logger+ saves the information about each QSO in a simple text file. These files can be used to recover an individual
contest log in the event the database file is corrupted. Here’s an explanation of how you can use those files to recover your
data quickly, during a contest, or at your leisure later:

The transaction log is created for each new contest log ( >File >New Log in Database )
To keep things simple and foolproof, you are not allowed to change the filename of the transaction log
The transaction filename is used to make sure you are loading it properly, and to prevent mixing logs of two contests.
Example name: ‘ham.s3db – CQWWCW – 2005-09-19 – 14.TRN’ i.e.: Database filename – contest name – contest

Date & Time Conflicts in a Database
A single N1MM Logger+ log database cannot contain QSO’s with identical time stamps (time and date), regardless of
whether they are in the same or different contest logs in that database. If the contacts contained in the ADIF already
exist somewhere in the current database, you have two choices.

If you import the contacts back into the same database, the program will adjust the times on all of the contacts to
prevent exact duplicates. It does this by adding one second to the seconds field in the logged time (it changes 59 to
00 without changing the minutes field, which doesn’t change the times that will be exported to Cabrillo). If you import
into a different contest log, that one-second (or 59-second) error will generally be immaterial – but if you import an
ADIF file back into the same contest log it was exported from, that will create duplicates for every contact imported,
and removing those duplicate contacts will be a very tedious job. The program issues a warning message to remind
you about this.

To preserve the logged times exactly and avoid this one-second (or 59-second) error, you will have to create a new
database and a new log of the same type in that database and import into that new log.
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start date – and an internal N1MM+ tracking number. Select the TRN file that matches the datbase name, and contest
name, and constest start date to ensure that you are recovering the correct TRN file.
To Recover your log, you MUST import the transaction log into a NEW (empty) database and a NEW contest
log.
The new contest log must be the same contest type as the contest from the transaction file (Example: if restoring
CQWPXCW, the new contest must also be CQWPXCW)

EXAMPLE: Step -by- Step recovery of the ARRL 160 Meter contest log

1. Launch N1MM
2. Create a new, empty database in N1MM: >File >New Database. For example, “ARRL160_recovery”
3. Create a new ARRL160 contest in the new ARRL160_recovery database: >File >New Log in Database, select

“ARRL160” from the drop-down list
4. Import the TRN file contents into this new contest in the new database: >File >Import >Recover QSOs from a

Transaction Log… and select the corresponding log from the Databases\TransactionLogFile subdirectory.

Export

ADIF Export Sub-menu

Export ADIF to file… – Create an ADIF file. This file can be used to export the current contest, for import into a
logging program or another contest program (horrors!). Deleted QSOs are not exported; select the ‘DELETEDQS’
contest to export these.

Note: QTCs in WAE contest logs are not exported in ADIF files, because there is no provision for QTCs in the ADIF
specification.

Export ADIF to file by date… – Create an ADIF file from the currently-selected contest, starting from the date set. The
first time you use this function the default date will be 1900-01-01 (yyyy-mm-dd). The second time the suggested date
and time will be the last time you exported with this option. You can always over-write the date/time if you want. This
function is especially useful when you want to export into a (general) logging program to do award tracking etc.

Deleted QSOs are not exported; select the ‘DELETEDQS’ contest to export these.

NOTE: After Recovering a Transaction Log File
After successfully recovering to the new Log in the new Database, N1MM+ automatically creates a new transaction
file for this log. If you should need to recover again, perform another recovery from this new TRN file – which will
contain all previously recovered contacts as well as any new contacts.



Filename Tip
Whenever the “Save File” window prompts for a filename, the default is {your callsign}.txt (the callsign comes from
the Station Information dialog). “/” and some other common characters are not accepted by Windows, so if your
contest call sign was N1MM/P, use something like “N1MM_P.txt” instead.
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Export ADIF to file by date from ALL contests… – Create an ADIF file from all QSOs in all contests starting from the
date set. The first time you use this function the default date will be 1900-01-01 (yyyy-mm-dd). The second time the
suggested date and time will be the last time you exported with this option. You can always over-write the date/time if
you want. This function is especially useful when you want to export into a (general) logging program to do award
tracking etc. Note, however, that contest-related items (the contest name, and fields generated from the contest
exchange) might not be exported with the expected ADIF tags. If you want these contest-specific items to be exported
correctly, export your contest logs individually instead of using this option.

Deleted QSOs are not exported; select the ‘DELETEDQS’ contest to export these.

Export ADIF to file by Multi-User Station Name – Create an ADIF file from all QSOs from one station in a Multi User
environment when you are currently logging DX. Otherwise, it exports only from the contest you are logging in. A station
name has to be supplied from the Network Status window, after which you will be asked for a filename.

Note: When using ADIF export and the contest name contains “RTTY” or “JARTS” the export mode is set to “RTTY” even
when the log file shows otherwise (i.e. LSB).

Export to File (Generic)
Export to File (Generic), order by QSO Time (normal)… – Creates a generic file named call-sign.txt from the
contest log ordered by time (and not by band). In some cases this will be the file requested by the contest
manager. This file can also be used to import into a spreadsheet or database program, or your logging program
if it can’t import ADIF format. The exported file can be edited with a text editor like Notepad.
Export to File (Generic), order by Band… – Creates a generic file named call-sign.txt from the contest log
ordered by band, per band ordered by time. In some cases this is the file requested by the contest manager, for
example in VHF and up contests.

Export EDI to file by band… – Create an EDI (REG1TEST) file. This is a regular file format used for VHF contests in
Europe. A separate file will be created for each band with QSOs made on it.
Print Score Summary to File… – Print the contents of the Score Summary window to a text file with the default
name call-sign.SUM Example: N1MM.SUM. This can also be done by right-clicking the Score Summary window.
Export Call History… – Exports the information from the Call History database table in volatile memory into a text file
for permanent storage. If you have used the Update Call History options in the Tools menu and you want to store the
updated file, you will need to use this menu item to save the changes. The Call History file is a text file, so you can
make changes to it using a text editor like Notepad.
Export Function Keys to file – Export the contents of the function keys to file (*.mc). Exported function key definitions
can be imported using the Function Key Editor

SSB Function Keys… – Export the SSB function keys.
CW Function Keys… – Export the CW function keys.
Digital Function Keys… – Export the Digital function keys (the Entry window keys, not the extra keys from the
Digital Interface).

Contest List

At the bottom of the File Menu is a list of the last 9 contests you have had open, along with the databases they are contained
in. This provides a very convenient way to switch between contests when you want to participate in more than one
simultaneously. You can open the File menu and use your mouse to select the contest you want to work next, or you can hit
Alt+F, which opens the File menu, and then hit the number (1-9) corresponding with the contest you want.

ADIF file compatibility when importing into other logging programs
When a contest exchange uses an ADIF field that is not included in N1MM+’s contest database, the N1MM+ ADIF
Export will define that exchange with an ADIF custom tag like < APP_N1MM_EXCHANGE1:2 > 1D. To import into a
general logging program that is expecting standard ADIF tags, you will need to use a text editor with Global Search &
Replace to change the custom tag to a standard tag. For example, in Field Day, ADIF exports the CLASS exchange
as < APP_N1MM_EXCHANGE1:2 > 1D. You would need to globally replace all “APP_N1MM_EXCHANGE1” with
“CLASS” for a successful import of that field.
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The contest you currently have open will always be numbered “1”, and the next previous will be numbered “2”, so if you want
to toggle between just two contests, all you need to do is set them up and then Hit Alt+F, then 2, to jump back and forth.

Edit Menu Selections

Wipe Out Entry Fields Ctrl+W – Clear information from the current contact (equal to Alt+W).
Edit Last Contact Ctrl+Y – Open a dialog to allow all fields for the last contact in the log to be modified.
Add a Note to Last/Current Contact Ctrl+N – Add a note to the current contact in the Entry window, or the last QSO
logged when no call-sign is shown in the Entry window.
Edit Current Contact – Open a dialog to allow all fields for the current contact (still in the Entry window) to be
modified. Double clicking in the Log window on a field with user-supplied data will open in-line editing of that particular
item. See the Log Window below for more details on this.
Quick Edit – Quickly edit QSOs already in the log. If the text boxes in the Entry window are colored blue, you are
in Quick Edit mode. Quick Edit (Ctrl+Q) always starts with the last QSO in the log. The call-sign and any exchange
elements are displayed in the Entry window, with the legend “QuickEdit” in the call-frame. Correct any errors and hit
Enter, or hit Esc to exit quick Edit mode. Once you are in Quick Edit mode, hitting Ctrl+A moves forward one QSO,
while hitting Ctrl+Q moves backward (in time) one QSO.
Quick Edit Previous Contacts (Forward) Ctrl+A– Quickly edit the QSOs worked before in the log. Ctrl+Q moves
back one QSO, Ctrl+A moves forward one QSO.
Increase Received NR by 1 Ctrl+U – Increase the number in the exchange field by 1. You will find this useful during
serial number contests when you are in a pileup and you need to keep incrementing the DX station’s serial number
because you can’t get him in the log…
Find/Find Again Ctrl+F – Find the call-sign entered in the call-sign field in the log. Pressing Ctrl+F again will find the
next instance.

Note to Blind Operators
Press Ctlr+F as many times as you need to, then press Ctrl+Y (yank) to edit the last QSO you found.

3/4/25, 5:37 PM N1MM Logger+ Documentation



264

View Menu Selections

Max Rates – Shows the best 1-minute, 10-minute and 60-minute rates achieved in the current contest. File > Copy
these messages to the Clipboard is self-explanatory, and appears for all of the View functions below..
Off Times (see also real-time off time counters in Info Window) – Shows off times. Lists each off period that complies
with the contest rules, or each off-time of 30 minutes or more if the contest rules do not specify. Each off period shows
when it began and ended, and the duration. Total on and off time is also given. Time between the start of the contest
and the first logged QSO is counted as off time, as is time between the last QSO and the end of the contest.
N1MM+ calculates on and off times the same way the contest scorers do. Operating time includes any clock minute
during which a contact is logged, as well as idle clock minutes that do not qualify as off time. Off time during the contest
requires 30 (or 60, depending on the contest rules) consecutive full clock minutes during which no contacts are logged.
In effect, the off time clock starts at the beginning of the clock minute after the last logged QSO and continues until the
beginning of the clock minute before the next logged QSO, and if there are not enough such consecutive minutes to
meet the contest rules for off times, that time interval counts as operating time. Full clock minutes at the beginning and
end of the contest during which no contact is logged qualify as off time and do not count towards the operating time.
Runs – Shows all runs. The program counts consecutive QSOs in run mode until an S&P QSO or band change. Off
times do not break a run if you resume in Run mode on the same band.
Notes – displays all contacts with notes.
Statistics – Show statistics for the selected contest. Many choices available. See the Statistics Window section.

Show Last 10 Spots – Show the last 10 DX cluster spots for the call in the call-sign field or call-frame. Telnet cluster
connection required. Format may not be compatible with some cluster nodes.
Show Station – Show the station information for the call in the call-sign field or call-frame. Telnet cluster connection
required
Show QSL/Telnet – Show the QSL information for the call in the call-sign field or call-frame. Telnet cluster connection
required.
Show Sunrise/Sunset – Show the Sunrise/Sunset information for the call in the call-sign field or call-frame. Telnet
cluster connection required.
SH/DX Current Call or Spot – Shows DX information from the current call in the call-sign field or spot. Telnet cluster
connection required.

Show QRZ (Internet) – Show the information that QRZ.com has for this call using your browser. An Internet connection
is required. present.

Inactive Menu Choices
All greyed-out ‘Show’ items below become active when valid call-sign information is entered in the call-sign textbox
or the call-frame. Some formats may not be compatible with all current cluster command sets.
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Show Google (Internet) – Show the information that Google.com has for this call using your browser. An Internet
connection is required.
Show ? on Unmatched Calls – When the Check window is open and a call-sign is entered in the call-sign textbox, a
“?” will appear following the call-sign if no matching call-sign was found in the Check window’s sources. Uncheck the
option if you do not wish this to happen.

Tools Menu Selections

Rescore Current Contest – Rescores the current contest. This is required before submitting a log if anything has
changed, such as a cty.dat or .sec file, or if you have edited or imported any QSOs. It rechecks QSO points and
multipliers and makes any corrections needed
Rescore last N Hours – Rescores the last N hours for the current contest. It may be run at any time but is rather slow.
Download and Install Latest Check Partial file (Master.scp)(Internet) – Opens your web browser to download the
latest version of the check partial file. Select the file to download and save it in the SupportFiles subfolder of the N1MM
Logger+ user files folder.
Toggle Tune (CW mode) Ctrl+T – Switches the radio into CW mode and using the CW keying interface, keys the
transmitter. PTT is asserted. To stop tuning, press the Esc key or Ctrl+T again. After tuning ends and PTT is released,
the radio returns to the original mode.
Download latest N1MM Logger+ pdf manual (Internet) – Downloads a pdf version of the manual that can be opened
from the Help > N1MM Logger Manual menu item.
Download and install latest country file (wl_cty.dat)(Internet) – Downloads and installs the latest wl_cty.dat file in
the correct location (Internet connection required).
Download and install language pack (Internet) – Downloads and installs language packs containing menus, button
captions and other text displayed by the program in languages other than English. See
https://n1mmwp.hamdocs.com/setup/localization/ for information on this feature.
Import country list from downloaded file (Internet) – This option is retained for contests that use a non-standard
cty.dat file that is not on the standard country file website.
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Add call to country – Specify a country for the call-sign in the call-sign textbox in the Entry window. If no call-sign is
entered this menu item will be grayed out. This is a quick way during the heat of a contest to add a country temporarily,
until the next time you import wl_cty.dat. Making changes permanent requires editing the country file (wl_cty.dat) to be
imported.
Tune to beacon for this band (20-10M) – This will change the radio’s mode to CW and tune to the NCDXF beacon on
the current band, if that band is 20, 15 or 10 meters. The station currently transmitting and the power steps are
displayed in the status bar of the Entry window that has the Entry focus (green LED). Short Path and Long Path
bearings to the beacon are shown. See this website for current information on the beacon program.
Update Call History with Current Log – Update the current call history table in memory and the Admin database with
the QSOs from the current log file. Information associated with a call-sign will be added, or updated if already in the call
history table. For VHF contest, in particular, where two Maidenhead grid fields are provided, the behavior is a bit
different. When both grid fields are filled and a new, third grid has been logged, the oldest grid will be removed, and
replaced by the grid from the first field. The new grid will be added in the first position. The same change in position will
happen when only the first grid field is filled and a new grid is added from the log. A 4-digit grid will be overwritten by a
6-digit grid when the first 4 characters are the same, adding precision to the entry.
Clear Call History then Update with Current Log – As above, except clears the call history table before adding
contacts from the current log. Can be used to start a new call history file.

Keyboard Key Remapper – Opens the Key Remapper window. This can be used to map keyboard keys or key
combinations, including numeric keypad and special function keys, to be used for various purposes: as an easier-to-
use hotkey for some other keystroke combination; as a hotkey that triggers a combination of several other hotkeys in
succession; as an additional message key similar to the regular function keys; to insert user-specified text at the current
location of the insertion point (cursor); to execute one or more N1MM+ program macros; to open a browser on a
specified web page; or to execute a Windows console (command-line) .EXE or .BAT command. Consult the
documentation for this feature on the keyboard shortcuts page in the manual.
Turn Rotor Alt+J – Turn rotor to bearing for the call-sign in the Entry window or to the call-sign in the callframe (when
call-sign field is empty).

Alt+L will turn the beam to the proper bearing for long path
Stop Rotor Ctrl+Alt+J – Stop turning the rotator.

Telnet Window Tools – Opens the Filters tab of the Telnet Window.
Program Execution Logging (Diagnostics folder) – There are several different execution tracing options, all of which
export to the Diagnostics folder, and may prove useful to the developers in tracking down performance and other
problems. We recommend that you click Disable All on the sub-menu unless you are encountering serious delays or
other execution anomalies and are directed by a developer to use this option.
Save Window Positions – Save the current window positions to the .ini file.

Window positions are automatically saved when the program is closed.
Window positions are saved per operator. Use Ctrl+O to enter the call of the operator, and click ”Save Window
Positions’. The next time that operator signs on (using Ctrl+O), the window setup will be adjusted to the saved
layout.

Saving an Updated Call History file

After you have done this, the modified Call History table is only in volatile memory (which will disappear as soon as
the program is shut down) and the Admin database (where it may be overwritten the next time a contest log is
opened or a Call History file is imported). To save the table into a stored Call History text file for future use, you must
export the table to a file using the File > Export > Export Call History menu item. Call History files are normally stored
in the CallHistoryFiles subdirectory in the N1MM Logger+ user files directory.

If you want to have a specific Call History Lookup file loaded and enabled whenever you start a contest of that type,
you can name that file as the Call History file under the Associated Files tab in the contest setup window with that
contest type selected.

In order to prevent a previously-loaded Call History file from being used in other contests for which it is not suitable
(different exchange), you should add the short contest name (the one in the Contest Setup dialog) to the Call History
text file as a comment (preceded by a “#”. You can use the same file for more than one contest, by putting in multiple
contest names. Example (omit the quotation marks):

“#NAQPCW” 
“#NAQPSSB”

For QSO parties, the state abbreviation is required after the contest name. Example:”#QSOParty PA”



Note –More info about rotator control can be found in the Supported Hardware chapter under Rotator control.
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Restore Window Positions – Restore from the .ini file the most recent saved window positions. The screen will update
immediately

Window positions are restored per operator (when saved first by the operator). Use Ctrl+O to select Operator
and press ‘Restore Window Positions’. The windows will change to their new positions immediately. This enables
easy reconfiguration of the screen when changing operators at a multi-op.

Check for New Program Version and Install – Useful if you have elected not to install a new version when the
chance was automatically offered, and now want to remedy your “grievous error.”
System Information – Produces a file containing diagnostic information about your computer and your N1MM Logger+
files that can be used by a developer to diagnose and resolve problems. Use this when requested to do so by a
developer in response to a bug report.

Config Menu Selections

Many of the selections after the Configurer can also be invoked in other ways, such as hot-keys or from other windows.

Configure Ports, Mode Control, Winkey, etc. – Also called Configurer.

This a very important dialog which determines many aspects of the program’s external interfaces and operation. Go here for
detailed documentation of this dialog.

Change Your Station Data

Modify overall Station information – name, call, address, state, latitude, longitude, etc. The call-sign and location information
entered here is very important for most contests, It determines what country, state or province you are in, which may in turn
affect the required exchange, scoring, which stations may be worked for contest credit, etc. See this section for more
discussion.
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Logger+ Audio Setup

For users with Windows Vista or later operating systems, this is where you set up your audio options for the new Logger+
Audio functions, including playback and on-the-fly recording of user-supplied recorded voice messages. If you are running
Windows XP, you will not see this option. For Windows XP users, audio is configured in the Audio tab in the Configurer (this
tab is not available for users of newer versions of Windows running updated versions of the Logger).

Manage Translations

See translations.

The Monitor tab

This tab opens whenever you open the Logger+ Audio Setup

The left-hand slider (“Set”) sets the output level going to your radio. You will want to set this so that your radio indicates the
correct microphone level and amount of compression. When playing a .wav file, the narrow “Wav” bar-graph displays the
relative level of the peaks of the recording being played. The wide “Output” bargraph displays the peaks of the output going to
your radio. The two are independent; if the Wav file bargraph shows relatively low peaks, you may want to re-record it to
improve the signal-to-noise ratio.

The right-hand slider sets the record level for “on-the-fly” recording, and the narrow bargraph just to its right displays the
relative sound level that is being recorded.

When you close N1MM+, the soundcard(s) output level(s) and microphone input(s) levels are returned to the previous
settings.

When there are multiple wav files, such as when voicing call signs and serial numbers from individual number/letter files, the
default behavior is to send the files one after the other. Some users have reported unacceptably long delays between sending
successive wav files when using multiple wav files. For such cases, there is a “Concatenate All *.Wav Files Before Playing”
option. This option assembles the entire message to be sent by concatenating the individual wav files into a single temporary
wav file before sending it, instead of sending the files one after the other. Unlike the default case, changes made to the call
sign in the Entry window on the fly after message sending has started will not be reflected in the output when using this option.
Also, all wav files must have been made with identical sample rates and bit resolutions. If you experience long delays between
letters and numbers that cannot be accounted for by extra “dead air” recorded at the beginning and/or end of your
letter/number files, you can try using this option to see whether it removes the delays.

The “Test” button will play a pre-recorded message, so that you can test your playback setup without having to record
something first.

The lower pane of this tab reports each stored message that is sent, which can be helpful for debugging.

The Playback tab
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In the first options box, the first choice uses a single soundcard for SO1V/SO2V. The other 3 are all for SO2R – Single
Soundcard Mono (where an external controller is used to route the audio between radios), SO2R Single Soundcard L/R (using
one channel for each radio), and SO2R Two Soundcards Mono, where each soundcard is connected to one radio.

In the second options box, select the Playback device that will feed audio to your radio. The set of possibilities displayed is
dependent on your specific computer configuration.

A growing number of radios have internal “sound cards”, called CODECS. If you have one of these and wish to use it as the
sound card for that radio, check the box and also check the “PTT via Radio Command SSB Mode” check box in the
Configurer setup for the radio control port. Of course, you cannot use a single radio CODEC for more than its own radio, so
the first option needs to be set to match.

Digital-mode users: Note that if your radio has an internal CODEC that you want to use for transmitting in digital modes
including AFSK RTTY, you need to check this check box regardless of whether or not you use N1MM+’s audio functions in
phone modes. Also, check the “PTT via Radio Command Digital Mode” check box in the Configurer setup for the radio control
port.

The lower pane of this tab shows interactions between N1MM+ and windows audio functions.

The Message Recording tab

This tab will vary with your choices on the Playback tab. If you choose two-soundcard SO2R you will need to choose inputs for
each card to enable on-the-fly re-recording of stored messages

The Sample Rate options are 8000 and 12000, and are set here for on-the-fly recording only.

The lower pane will report the beginning and end of each on-the-fly recording event.
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Your microphone will be muted during playback if you check that option.

The Announcements tab

This tab is used to set up audible announcements for dupes and for errors logging QSOs. These announcements are useful to
users with visual impairments.

Either or both announcements can be disabled and the enabled/disabled state is saved per Operator. The user must provide
the two wav files which could be a voice message or error tone. Note: There are some contests that require the exchange to
be known before DUPE status can be determined. Playback audio level is adjusted from the Windows audio panel.

Enter Sends Message (ESM mode)

Ctrl+M toggles this mode on and off – first introduced by N6TR in TRLog, and much improved in N1MM Logger. The program
anticipates the needed sequence of messages to complete a QSO in either Run or Search & Pounce mode, and sends each
one in turn by simply hitting Enter. See ESM for further details.

ESM by Mode

When ESM is enabled, controls whether it is disabled by mode. By default, it is enabled for all modes. The fly-out submenu
allows you to choose which modes it is enabled for. The settings are remembered.

Automatically Spot New S&P QSOs (auto-spotting)

Spot a new contact when you log it. This setting is not sticky after re-launching the N1MM logger.

If this option is checked, a contact is automatically spotted when:

You complete the QSO in S&P mode
AND the spot is not already on your Bandmap or Available Mults & Qs window at the same frequency (+/- the tuning
tolerance)
AND the spot had not recently been posted by another station

The Spot Comment tab on the Telnet window allows the user to specify a comment for spots, including elements of the log
entry for the spotted call, such as Zone or Exchange.

QSYing wipes the call & spots QSO in bandmap
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Very useful for S&P. If you enter a station’s call in the Entry window, and then tune off for any reason (he doesn’t answer your
call, or…) the call is shown bold in the Bandmap. These ‘spots’ are not sent out on Telnet. The setting of this feature remains
as it was across program restarts.

All bandmap features work on these ‘spotted’ stations so they are easy accessible if needed. Self-spotted stations are easily
recognized because they are shown in bold.

If you are using the Available Mults & Qs window rather than the Bandmap, when you QSY off a station without working it, it is
automatically moved to the top of the listing, with your call indicated as the spotter

This option is also available on the Filters tab of the Telnet window.

Grab Focus From Other Apps When Radio Is Tuned

Brings N1MM+ to the front over any other app when you tune a radio that is interfaced with the program.

Do not automatically switch to Run on CQ-frequency

When selected and you QSY back to an old Run frequency, the mode stays in S&P. F1 and Alt+Q continue to switch to Run
mode. This is most useful in Sprint-like contests, where you QSY frequently and want to avoid unexpected switches to Run
mode

Show Non-workable Spots and Dupes in Bandmap

This option is also found on the Filters tab of the Telnet window. When checked, this option displays all previously worked
(dupe) call-signs, as well as stations that don’t count in the current contest, in grey on the bandmap. When navigating the
bandmap with hot-keys (Ctrl+Up/Dn, for example), grey calls are ignored. Its use is highly recommended to avoid wasting time
on non-workable stations when S&P, even if operating unassisted.

Reset Rx freq to TX when QSO is logged (RUN and split)

When using the main VFO to transmit and the other to receive (split mode) after each logged QSO the RX frequency will be
made equal to the TX (main VFO) frequency. It resets after every RUNNING QSO. Using a radio with VFOs A and B, this
feature is there to let you use the main frequency control as an RIT. With Main/Sub radios like the Icom 756/7800 series you
can not RX on SUB without receiving on both VFOs. In this case put RX on Main and TX on SUB for Alt+S to work.

Sub Receiver Always On

Yaesu FT-1000 series, Icom IC-756 series, IC-781, IC-775, IC-7800, Elecraft K3 with subRX only: Selects the mode for Dual
Receive toggle (Alt+F12).

When selected –
Yaesu FT-1000 series: The sub receiver will be left on (blinking green RX led)
Icom IC-756 series, IC-781, IC-775 and IC-7800 only: Dual watch is not turned off when you switch from SUB to
Main with Ctrl+Left Arrow or PAUSE
Elecraft K3: The sub receiver will be left on

Not selected – The sub receiver will switched off (RX led off)

CQ Repeat – Alt+R

Toggle for repeat CQing. With Winkeyer, beginning to enter a call-sign in the Entry Window terminates the CQ, but the
program remains in CQ repeat mode. The function is automatically turned off when no longer on the CQ-frequency and the
mode changed to S&P.

Set CQ repeat time – Ctrl+R

Specify the repeat interval (CW or SSB with sound card) in seconds. The default value is 1.8 seconds.

CW / PH AutoSend Threshold – Ctrl+Shift+M

Start sending the call-sign after a certain number of characters typed AFTER the last number in the call-sign. The minimum
threshold is 1. 0 will turn off the feature. Only works when in RUN mode, not in S&P. More info in the Logging Key
Assignments section.

Enable Call History Lookup

When enabled, Call History Lookup can be used to pre-fill the exchange during a contest to save typing, or to display user
comments or notes for specific call-signs. Reverse Call History Lookup uses the same Call History file to find stations whose
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exchanges fit what you have entered in the Exchange field. It is enabled by the same Config menu entry. Follow the links
above for the full story.

Change CW/SSB/Digital Message Buttons – Alt+K

Change the contents of the CW/SSB/Digital Function Key messages). The maximum length of text in each CW, SSB and
RTTY button is 255 characters. Alt+K will access the relevant list of definitions, depending on the mode you are in, or you can
right-click in the button area to get there. See the discussion of the Function Key Editor here.

Change CW Function Key Definitions – Change the contents of the CW messages.
Change SSB Function Key Definitions – Change the contents of the SSB messages (.wav files).
Change Digital Function Key Definitions – Change the contents of the Digital messages.

Change Band Plan

Band plans play important roles in a number of places in the program. They can affect the mode contacts are logged in, the
mode that is assigned to incoming Telnet spots, and whether or not those spots are displayed in the Bandmap and Available
Mults & Qs window. The usage of modes in some frequency segments depends on the contest. For example, frequencies in
the 7040-7070 kHz segment of 40 meters might be used for SSB (DX stations operating split in a DX phone contest), digital
modes (in a RTTY DX contest), or for CW (in a CW contest or a domestic North American contest). There is no one size fits all
setting, and even for a single operator the choice of where to place the sub band limits can depend on the contest. Therefore
it is important to be able to adjust the band plan. This section describes one method; alternatively, there is a graphically-based
method that can be used from the Bandmap window.

The sub-menu offers the choice of CW or digital bandplan tables which can be edited and saved. You can only designate one
CW and one digital band segment per band.

By definition, digital segments override cw segments, and both override SSB segments. That means that unless a band
segment is designated for CW or digital modes, it will be shown as SSB.

For example, on 40 meters, you can enter a CW segment of 7000-7100 KHz, and a digital segment of 7040-7050. The
resulting bandmap markings will look like this:

Manage Skins, Colors and Fonts

Changes in Band Plan ManagementN1MM Logger+ has adopted a new approach to designating and displaying
CW, digital and SSB band plans. You can now adjust the sub-bands that are displayed for any individual band
through right-clicking on frequency labels (e.g. “7045”) in the relevant Bandmap. See this link for details.



3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/setup/function-keys/#the-function-key-message-editor
https://n1mmwp.hamdocs.com/manual-windows/bandmap-window/#display-and-adjustment-of-band-plans-in-background-of-bandmap-frequency-scale


273

See the Skins, Colors and Fonts Window.

Change Operator Call-sign Stored in Log (Ctrl+O)

This function is used mostly in multi-operator situations, to change the operator callsign stored in the log and to call up a
preferred window configuration when a new operator takes over.

Change Exchange Abbreviations

The idea here is to hedge against having people send you abbreviations during contest that are not the same as those
recognized by the contest organizers. We’ve all had people send us “ALA” when they meant “AL” or ALTA when they meant
“AB”. The problem is particularly bad in QSO parties. Put the non-standard abbreviation in the “Abbreviation” column, with the
correct one in the Section Column. Click on the Section heading to sort by the standard abbreviation, so you can see various
alternatives that you have entered.

SO2R

More info about Single Operator Two Radio operation of the program can be found in the SO2R chapter.

Dueling CQ’s (Ctrl+B) – SO2R feature that alternates sending CQ on each radio in turn, listening on one while
transmitting on the other. Supported for both CW and SSB.

Changing either radio in frequency more than 200 Hz will terminate Dueling CQ.
Set Dueling CQ Repeat Time (msec) – Adjusts time in milliseconds after CQ ends on one radio before it starts on the
other (default 100 msec).
Set Radio Swap Transmit Tail Time (msec) – Time delay after a radio has stopped transmitting, before initiating
transmission on another band. Typically used to interrupt a CQ on one radio to S&P on the other radio.
Set Radio Swap Transmit Lead Time (msec) – Time delay when swapping radios, whether or not the radio is
transmitting. Typically used to allow station accessories to detect that the active radio has been changed.
Focus on Other Radio (Ctrl+Shift+K) – FocusOther, See FocusOther. A method of focus control preferred by many
contesters. When FocusOther is active, the RX focus is automatically shifted between the “Run” radio and the “S&P”
radio, depending on whether the Run radio is transmitting. When the Run radio is transmitting, RX focus is shifted to
the S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run radio, unless an unworked
callsign has been entered in the S&P entry window. This allows a callsign to be entered in the S&P radio Entry Window
while CQ is being sent on the Run radio.
FocusOther Always Swap – Used in conjunction with Focus on Other Radio. Focus always switches to the other radio
when one radio is transmitting, and always switches back to the original radio when transmission is completed.
Toggle CTRLFx Macro (Ctrl+Shift+L) – This enables/disables the use of {CTRLFx} in function key macros. When
enabled and present in one of the function key definitions, the {CTRLFx} macro executes Fx (Function key definition x)
on the opposite radio. An example is TU{CTRLF1} in Radio 2’s F3 slot, which sends TU and then sends the other
radio’s F1, used to get quickly back to the Run radio and call CQ after finishing an S&P QSO on Radio 2.
Toggle Stereo/OTRSP Macro (Ctrl+~) – Can be used to enable/disable all {STEREOOFF}/{STEREOON} and
{OTRSP RX}/{OTRSPOTHER RX} macros temporarily. Used to disable stereo switching if only one EntryWindow is
being used temporarily.
Two Keyboards – Enables the use of two keyboards, one for each Entry window. Plug in two keyboards before starting
N1MM Logger+. The first keyboard you type in after starting the program will control the left (Radio 1) Entry Window.
The other keyboard will control the right (Radio 2) Entry Window. The pause key is disabled, since you no longer need
to be able to switch Entry windows from a single keyboard. The \ key moves keyboard focus to the Entry Window
associated with that keyboard without actually sending any keyboard commands to that window. Note that the use of
keyboard remapping software, such as AutoHotKey, may not work correctly with two keyboard operation.
TX Lockout (Digital) – Select a lockout option (digital modes only).

Multi-TX – This is the default setting. Start CQ on radio A, next a CQ on radio B, both are active (no lockout)
First one wins – Start CQ on radio A, pause, start CQ on radio B. The radio B CQ is ignored since radio A is
already active, so if you press a F-key for the second radio while radio A is transmitting, the radio B F-key is
ignored.
Last one wins – Start CQ on radio A (CQ starts), pause, start CQ on radio B. The CQ on radio A will be aborted
and the CQ on radio B will start, so if you press a F-key for the second radio while radio A is transmitting, the
radio A transmission is interrupted and radio B transmits.

WAE – Special commands for the WAE DX contest only

There’s No Substitute for A Hardware Lockout

Software lockouts are inherently less reliable than hardware systems, because of the vagaries of networking, RFI,
etc. We urge you not to rely solely on software lockouts to prevent rule violations or hardware damage.
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Toggle WAE QTC mode – Ctrl+Z – Toggle the WAE QTC mode between QSO and sending/receiving QTCs.
See WAE contest setup instructions (WAE RTTY instructions).
WAE Received QTC Confirmation – Can be used to enter the WAE confirmation string or .WAV file (CW/SSB only).
See the Open QTC Window Setup Area menu item for more comprehensive QTC setup options
Max QTC Number for callsign colors in Band Map – opens a dialog box to allow you to set the number of QTCs to
be used for displaying the special colors in the bandmap for stations with QTCs remaining
Ctrl-Z sends QTC? automatically (EU stations, Run mode only) – When this option is checked, pressing Ctrl+Z
while in Run mode automatically sends QTC? and puts the program into QTC mode (CW only, EU stations only).
Open QTC Window Setup Area – Opens a dialog window in which you can change various settings for QTCs. This
window has three tabs, one for CW, one for SSB and one for RTTY.

CW Setup – checkboxes for a series of options applicable to EU stations receiving QTCs, plus a box where you
can customize the TU message on exit. Check any of the check boxes that you wish to activate; if the option is
not checked, the default action will be selected.

In CW when moving out of Serial QTC window Send CFM String and move to next line bypassing
CFM button.
In CW when moving from QTC header send QRV string and move to first QTC entry line.
In CW pressing Hdr Agn clears the QTC Header Window.
In CW pressing Agn clears all QTC textboxes for that row.
TU message to send on Exit – Can be used by either EU or non-EU stations to set the message to send
at the end of a block of QTCs. The {QTC} macro may be used to send the QTC block number from the
header in the TU message. If the TU message is left at the default (“Not Set”), the normal F3 TU message
will be sent when exiting the QTC window

SSB Setup – selection boxes containing the locations of wav files the program will look for wav files to be used
for QRV, Confirm, Again? and TU voice keyer messages by EU stations receiving QTCs. The Logger+ audio
method must be used, i.e. these files will not work if the legacy audio method from Logger Classic is used. There
are three boxes to the right of each path name. The first one is green or red depending on whether the file was
found or not. The second box is a button labelled R, which you can use to start recording. The R will change to S
while recording is active; click on the S to terminate recording. The third box is a button labelled P; press this
button to play the wav file (for testing).
RTTY Setup – boxes containing the messages that will be sent during the QTC process by both receiving
(RQTC) and sending (SQTC) stations. Note that you do not need {TX} and {RX} macros in these messages

RQTC Messages:
RX Ready
All Agn
Agn – the $ macro is used in this message to send the number of the QTC whose Agn? button (in
the RQTC window) was pressed
Save QTC – the message to send when the QTCs have all been received and recorded

SQTC Messages:
RU QRV
Send All Heading – the {QTC} macro is used in this message to send the header number, e.g.
26/10
Send All Ending – message to send after the block of QTCs has been sent
Save QTC – message to send after the QTCs have been acknowledged
QTC Spacing – normally {ENTER}, but some users may need {ENTERLF}

Default Number of QTCs to Send – sets the maximum number of QTCs that will be sent in a QTC
package (normally 10)

Clear INI file settings

Option to clear out the ‘N1MM logger.ini’ file. Generally, it will be preferable to rename the existing .ini file to something like
N1MM Logger.old, so that you can retrieve your settings if you need them to re-configure.

SO2V Dual Receive

Repeating CQ Ends With VFOB Window Entry – When this option is selected, entering anything into the VFO B
Entry window will stop a repeating CQ in the VFO A Entry window.
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Window Menu Selections

Available Mult’s and Q’s – Display the Available Mult’s and Q’s window. More info in the Available Mults and Qs
Window chapter
Bandmap – Display the Bandmap window. In SO2R/SO2V each Entry window has its own Bandmap window. More
info in the Bandmap Window chapter
Check – Display the Check window. More info in the Check Window chapter
CW Key Ctrl+K – Display the CW Key window. Pressing Ctrl+K again or Enter will close the window but will continue
sending the message. Pressing Escape will stop sending the message. The windows is multiline (for pasting in text)
and can be resized. The font type and size is the same as used in the Entry Window

CW Reader – Display the CW Reader window.
Digital Interface – Display the Digital Interface window – see the Digital Modes chapter
Entry Window – Displays the Entry window
Gray Line – Opens the Grayline window. More info in the Grayline Window chapter.
Info – Display the Info window. More info in the Info Window chapter
Log Ctrl+L – Display the Log window (toggles between open and minimized). More info in the Log Window chapter
Move Multipliers – Display the Move Multipliers window. For every call sign in the spot table and every band/mode
selected using the Select Band & Mode button, displays the multiplier status of that call sign and indicates with
background shading which band that station was spotted on. The multiplier status depends on the program’s ability to
determine the multiplier status solely from the spot information. It is not updated when a contact is logged, deleted, or
spotted, but only when the Refresh button is used. A left-click on a call sign will QSY the radio to the first spotted band.
If a station is spotted multiple times, repeated clicks will QSY to the next spot on the line. In SO2R or SO2V, if a radio or
VFO is already on the spot band, that radio/VFO will be used, otherwise the active focus radio will be used, or
Shift+Click will QSY the other radio. A mouse wheel click will delete the line.
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Multipliers – Click to display the Multipliers sub-menu
Countries – Country multipliers are displayed
Grid Squares – Grid square multipliers are displayed
Grid Field Map – (for WW-DIGI contest) A world map with overlaid field multipliers on the current band is
displayed

The first time this option is used, the world map underlay will be downloaded from the Internet.
Subsequently the downloaded map will be used

Grid Square Map – A schematic map of grid square multipliers on the current band is displayed
The “map” is a matrix of grid squares, centered on a grid square that can be selected via a right-click
menu choice

Sections/states – Section or state multipliers are displayed
Zones – Zone multipliers are displayed
Counties/Other – County multipliers (or other multipliers in some contests) are displayed
Additional Counties – (usually greyed out) Displays county multipliers for another QSO Party contest on the
same weekend (AZ/NV/PA QSO Parties)

Network Status – Display the network status window – see the Network Status Window chapter
Rotor Windows – Opens the rotor windows (only if rotor windows are selected to be displayed in the Configurer under
the Antennas tab) – see the Rotator Control chapter
Talk to Another Station Ctrl+E – If networking is enabled, opens the network Talk window – see the Network Status
Window chapter
Score Summary – Display the score summary window. More info in the Score Summary Window chapter
Spectrum Display – Display the Spectrum Display window More info in the Spectrum Display Window chapter
Telnet – Display the Telnet window. More info in the Telnet Window chapter
Visible Dupesheet – Display the Visible Dupesheet window. More info in the Visible Dupesheet Window chapter
WSJT Decode List – Display the WSJT Decode List window. More info in the WSJT Decode List chapter
Load WSJT/JTDX – When the link to the WSJT-X or JTDX program has been entered into the Configurer under the
Digital Modes tab, this menu item opens the WSJT-X or JTDX program for use in making JT-mode (e.g. FT8) contacts.
More info on using these programs with N1MM+ will be found in the WSJT Decode List chapter

Ctrl+Tab can be used to rotate focus among open windows in a round-robin fashion. 
Ctrl+Shift while clicking on the name of an already opened window will move it to to the upper left corner of the screen. This
is useful for windows that have been lost.
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Help Menu Selections

EntryWindow Specific Help – Shows the Entry Window page of the on-line manual. Requires an active Internet
connection
Manual Index – Shows the full index of the on-line manual. Requires an active Internet connection
Supported Contests & Setup – Shows the Supported Contests chapter of the on-line manual. Requires an active
Internet connection
Key Assignments – Shows the Key Assignments list from the on-line manual. Requires an active Internet connection
Revision History & Latest Update Download – Shows the Latest Update section of the Files Menu on the web site.
Requires an active Internet connection
N1MM Logger Manual (User installed *pdf required) – Read the manual off-line. There is a link on the Tools menu
that will download this file – be sure you download it into the Support Files folder in the N1MM Logger+ user files area.
Requires Adobe Reader or another .pdf reader
Contest rules for this contest– Go to the web site from the contest sponsor on the Internet where the rules can be
found. Requires an active Internet connection
WA7BNM Contest Calendar – Go to WA7BNM’s contest calendar site on the Internet. Requires an active Internet
connection
User Questions & Discussion Group – Go to the groups.io Discussion Group page on the Internet. Requires an
active Internet connection
Bug Report Form – Go to the form on the N1MM Logger web site. Please note, this is not the place to report
difficulties such as installation or setup problems – far better to use the groups.io group for that. Requires an
active Internet connection
Feature Request Form – Go to the form on the N1MM Logger web site. Requires an active Internet connection
View Error Log for Debugging – View the latest ‘Errorlog.txt’ file generated by the program. The program creates and
updates the contents of this file when the program generates an error. This could be used to help pinpointing a problem
in the program
Open Explorer on User Files Directory – Open the Windows File Explorer to display the N1MM Logger+ User Files
directory. If there is more than one N1MM Logger+ folder in your system (for example, as a result of dealing with
OneDrive), this menu item will point you to the one that the program is using
Report Score to 3830– Go to the 3830 score reporting site on the Internet. Requires an active Internet connection
About Vx.yy.zzzz – Show the About Dialog
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The Grayline Window
2019-04-13

The Grayline Window

Setup Menu Selections

Show Sun – Select or de-select showing the current position of the sun on the Grayline map
Show Equator – Show or hide the Equator on the map
Show Meridian – Show or hide the Greenwich Meridian
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Show Home Location – Will show a red dot on your location as set in N1MM+ and explained in Installing the
Software.
Number of Spots to Display – Select 0, 50, 100, 150 or 200 most recent spots to be displayed on the map.
Clear All Spots – self-explanatory
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The Info Window
2019-04-13

The Info Window
The illustration below is a typical Info window with all options enabled in the right-click menu, also shown.

To open the Info window, select “Info” on the Window menu of the Entry window
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Key Features

The title bar shows the station call sign (from the Station Data table) and the default Sent Exchange for the current
contest. The operator’s call sign is shown in blue on the right side of the window. If another operator signs on using
Ctrl+O or the OPON text command, that call sign will replace the previous one.
The sent exchange is shown in the title bar. The next QSO number will be shown on the title bar if it is a serial number
contest. Example: Exch: 59 002
The content of the window, other than the long-term and short-term rate displays, is selectable from the right-click
menu.

The first line is the spot that is in the call-frame of the Entry window, including any comment.
The second line provides country information, including long and short-path headings, as well as short path
distance to the country of the call-frame spot.
The third line provides sunrise and sunset times in UTC at the DX location, plus his local time
The fourth line displays the last WWV message received from the connected Telnet node. There were none
when this screenshot was taken.

Below the information lines are two graphs for rates (and if selected from the right-click menu, goals). The left-hand one
shows near-term rates. Left to right, these are the rate for the last 10 QSOs, the last 100 QSOs, the last hour, and the
interval since the start of the current clock hour. The right-hand graph displays hourly rates for five intervals, selected
from the right-click menu to be either 20, 30 or 60-minute moving averages. Each vertical line represents one such
interval – the rightmost edge is the current interval, which may not have been completed at any given moment
When “Message Window” is selected from the right-click menu, there is an open area in the bottom part of the window
for messages from the program. One important use is for notification when you are spotted on the DX Cluster network,
and by whom. It is also the place, in a multi-op, where the program reports any difference in entry category between
computers on the network (multi-single versus multi-two, for example).

One of the right-click menu options (“Show RBN Spots of this Station”) opens a browser window displaying recent spots for
the station call sign on the Reverse Beacon Network (RBN). This can be a useful indicator of whether and where your signal is
being heard in CW and RTTY modes; it is of no use in phone contests. If you are connected to a DX cluster node that carries
RBN spots and the Message window area is displayed, spots of your call sign are displayed in the message window as they
arrive, whereas the “Show RBN Spots of this Station” option shows the last 25 (or 50 or 100) spots of your call sign recorded
by the RBN in a browser window regardless of whether you are connected to a cluster node or not.

Note that with the advent of the RBN, the sheer number of spots received and listed in the Available Window and on the
Bandmaps within the spot timeout period may exceed the computer’s capacity to process them. The program monitors CPU
utilization, and when it approaches a dangerous level, automatically trims a small number of the oldest spots. When this takes
place, you will see an advisory message in this section of the window, so that you can decide if you wish to make any changes
in your DX cluster filtering or other variables.

QSO Timers and Counters

When “Show QSO Timers” is checked in the right-click menu, the Info window also displays, under the current operator’s
callsign, a number of useful indicators. These include:

– A timer to indicate off time for contests where there are minimum limits on off times, or to display the time elapsed since the
last contact was made as a supplement to the goals charts. Right-clicking on the time in this box will open a pop-up menu in
which you can choose what is displayed in this timer. The available options include:

Display Off Time (full clock minutes with no QSO’s) – off time timer for rules compliance
Current Interval Count Down Timer – counts down in hours and minutes from the beginning of the clock minute
after the last QSO was logged, starting at the off time limit and counting down towards zero
Current Interval Count Up Timer – counts up in hours and minutes from the clock minute after the last QSO was
logged, starting at 0:00
Cumulative Contest Off Time – adds the durations of off times that were long enough to qualify under the contest
rules. If the current off time is not yet long enough to qualify, it is not included in the total. Note that the Start date
and time for the contest in the Contest Setup dialog must be correct for the cumulative off time to be calculated
correctly.

Time Since Last QSO (not for off time rule compliance) – counts the minutes and seconds since the last QSO was
logged

All Computers Radios – the time since the last QSO was logged from any station in the network
Both Radios (SO2R), VFO A/B (SO1V/2V) – the time since the last QSO was logged from this station
Left Radio (SO2R), VFO A (SO2V) – the time since the last QSO was logged from the left/VFO A Entry window
Right Radio (SO2R), VFO B (SO2V) – the time since the last QSO was logged from the right/VFO B Entry
window

When an off time option is selected, the frame for this timer includes, besides the words “Off Time”, an arrow (^ or v) indicating
whether the timer is counting up or down, and the minimum duration (in minutes) for off times for that contest and category.
The timer is in hours and minutes; the background will change to light green once the minimum time has been reached.
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– In some contests and entry categories, there is a second timer or counter display to help you comply with contest rules for
band changes when there are band change time limits or counters. If there is a band change time limit, this timer appears
below the QSO timer, and counts down in minutes and seconds from the beginning of the clock minute after the first QSO
logged on a new band. The band change timer does not start until the first band change of the contest. The background color
changes to pale green once the required time limit has been reached and the counter has reached 0:00.

If the contest and category has a limit on the number of band changes per hour, there is a band change counter which
appears to the right of the QSO timer (you may have to make the Info window wider to see it). This band change counter has
a “stop light” (red/yellow/green) colored background, to warn the operator when nearing or exceeding the allowed number of
band changes in the current clock hour.

– There may also be a mult-run indicator that displays MULT or RUN in the Multi-One category or “1” or “2” in the Multi-Two
category. This indicator is below the band change counter, to the right of the band change timer. The Multiplier or Run status
for this station can be toggled with the key combination Ctrl+Alt+M.

Contest Goals

Here are some other key things to remember about N1MM Logger+ goals:

Editing and Exporting Goals

Right-click in the Info window, and click on Edit and Export Goals. That opens the following dialog:

You’ll note that the hour is stored in the form “dhh” where “d” is __the day of the contest and “hh” is the beginning of the hour,
in clock time, not in terms of the hour in the contest. Hence, for example, “222” denotes the second day of the contest and the
hour beginning at 2200Z. In the example, the goals were derived from an ARRL November Sweepstakes, which runs until
0300Z on the third day.

You can edit this table just as you would any other table in an N1MM Logger+ database. Be careful with the “hour” column
until you are comfortable with the convention. When you have made your changes, you can either export to a goals file in text
format, which will be placed in Documents\N1MMLogger+\GoalFiles, or simply OK out of the dialog, in which case the
changes are saved to the Admin database’s Goals table.

How Active Goals are Stored
In N1MM Logger+, goals are stored in a table in the Admin database. Only one set of goals can be active at any
time, and regardless of the contest you open, they remain active until replaced. However, if you have defined a
goal file on the Associated Files tab for a given contest, that goal file will be loaded whenever you start a new
instance of that contest. For example if you define CQWW goals.txt as an Associated File in one instance of
CQWWCW, that goal file will be loaded any time you open any instance of that contest.
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Goal Files

This is the Goal file format:

You can create a Goal file with a text editor and import it into the database using the Import Goals function (see below). Be
sure that you use a straight text editor for this, such as Notepad. Word processing programs can insert special codes that
N1MM+ does not understand.

Note that you do not need to enter anything for those hours when you do not plan to operate, but you do need the header just
as it appears here.

Importing Goals

Click on Import Goals, and this submenu will appear. You can import goals from a prior contest log or a .txt file in the GoalFiles
Document directory

Set Your Start Time

Be sure to set the contest start time (in the Contest Setup dialog) to the correct value for any contest in which you
intend to use goals. As you can imagine, this is important to ensure that the appropriate goal is displayed for the
appropriate hour of the contest.
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Typically, you will want to import goals from all bands, but if you plan to enter a contest single-band, you can set goals
for that band only by clicking the appropriate radio button.
Click on the “Text File” button, and a dialog opens showing you all the goal files in the GoalFiles document folder.
Select one, open it, and the contents are transferred to the database.
Click on “Log” and something new happens. This window opens:

Select the database you want to get your goals from, and click “Open”.

Now this dialog opens:
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Select the contest from which you want to derive your new goals, and OK out. Once imported you can edit the goals as
outlined above, and optionally export them to a Goals file.

Importing Goals (Developer notes)

For the goal import files:

All import blank lines are ignored.
All import lines beginning with a # in the first character position is considered a comment line and is ignored.
The Goals hour is defined as the hour of the day, not the hour of the contest. This is to make it easy to align goals with
GMT time when the contest doesn’t start at 00:00gmt.
Before the contest start, the Goals will be set to the contest first hour goal.
The Goals are set to zero if Info window charts display 96 hours after the start of the contest.
If the user Right Clicks on a QSO in the Log Window and selects the option to display Rates & Goals in the Info
Window, the Charts will update with the Goals as if it occurred during the contest.
If the database doesn’t contain goals, a default goal of 50 is used.
If an error occurs during the selecting the goal, a a goal of 50 is used.
File formats accepted:
The View, Statistics text file (*.TXT or *.txt) can be used as a goal import file. All bands or one band can be selected
during import. Opened in an editor it has this format:

The Goals import file can be a .TXT or *.txt file hand generated space(s) or tab delimited, repeated spaces or tabs are
OK. Examples are:

The Goals import file can be a *.CSV or *.csv hand generated file, comma separated, repeated spaces or tabs are OK,
only one comma in the line is allowed

The Goals import can also be the *.TXT file exported from Edit, Goals window.

1
2
3
4
5

Day        Hr  1.8   3.5     7   14   21   28   Tot  Accum 
2010-11-27 00    0    70   146    5    0    0   221    221   
2010-11-27 01    0   116   119    0    0    0   235    456   
2010-11-27 02   71    27   128    0    0    0   226    682   
Total       0  306   867  2088 2156 1763  542  7722   7722

1
2
3

0  100
1  111
2  222 

1
2
3

0, 100
1, 111
2, 222

1
2
3
4

Type=GOAL  SubType=
     100     350
     101     337
     102     321
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The Log Window
2019-04-13

The Log Window
In addition to the Entry window, the Log window is the one other window that always opens when you first start the program,
regardless of whether you had it open or not the last time the program was shut down. The title bar always displays the
currently selected contest and the database file name. If the boxes in the Entry window don’t look right for the contest
exchange, check the name of the contest in the title bar of the Log window to see whether you have the wrong contest
selected.

Your Log window will be similar to this one:

The top pane above the double line separator bar is the log.
The bottom pane shows the contacts in your log that match the partial or full call entered in the Entry window.
By default the separator bar is set at a percentage of window size., but you can move it with the mouse. When
shrinking the window vertically, both sections get smaller. After resizing the window, decide how much space to allocate
to dupes by setting the separator bar.
The title bar gives date and time (in UTC), the selected contest and the name of the current database.
To resize the text in the log, click on the resizer arrows at the upper right corner of the window.
There are options for modifying the width of individual columns, to be found on the Right-Click Menu (see below). You
can also resize them by click-and-drag of the invisible dividers between the header items in the header row.
You can change the order of the columns by clicking on a column heading and dragging it left or right to the desired
location.
Click on the heading of any column to sort the log by that column. Click the header of the datestamp column (“MM-DD
HH:MM”) to return to normal log order.
When a Multi operator mode (Multi-One, Multi-Two, Multi-Multi) is selected, the “Op” and R# columns appear in the log,
and the radio number and operator call-sign are shown for each QSO.
If a contact has been marked as an X-QSO using the right-click menu, the callsign will be marked with a red “X” icon.

Editing the Log

Double-click any user-entered field in a QSO record to edit it; type the correction and hit Enter to save it. This can be done in
either the upper or lower panes of the Log window, to facilitate correcting earlier QSOs with a station when you need
to.

Program generated fields, such as QSO points, cannot be edited.
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If you want to edit the sent serial number in a QSO, you will note that up/down arrows are displayed, on the assumption
that you probably are just off by one. Click the appropriate arrow and hit Enter, or type the correction if you need to.
If you want to edit the timestamp (date and time) of a QSO, first make sure that the date/time column is no wider than it
needs to be. You can accomplish this, if there is white space to the right of the time, by right-clicking in the Log window
and selecting “Auto Set Column Widths.” Now double-click on the time, and you’ll see the time in
hours:minutes:seconds format, with the hours selected and a calendar icon with down arrow at the right end. If you
need to enter a new hour, do so, and then hit Tab or Enter to exit. If you need to change the minutes, click on them with
your mouse to select them, enter the new value, and hit Tab or Enter to finish editing. If you need to change the date,
click on the down arrow next to the calendar icon, click on the date to change to, and hit Tab or Enter to exit.
The Log window displays the RX frequency. If you want to change the TX frequency use the right click – Edit Contact
option.

Marking Multipliers

The check-marks denote whether a given QSO accounted for one or more multipliers. They are provided by the program
based on the received exchange, callsign, and built-in data resources, such as the wl_ct.dat file. They cannot be edited.

Serial Numbers

In a serial number contest the serial numbers in the log window will be displayed without any leading zeros even when zeros
are entered before the number (001 becomes 1, and so on).

Warning of Possible Errors

When a station is worked on multiple bands or modes with varying exchanges (zones 14 and 15, for example), this will be
highlighted in red in the lower pane. The red highlight color indicates that there is a strong likelihood of an error.

Calls with no match in the master.scp file and zones that don’t match the country file will also be highlighted. The highlighting
for no match in SCP file is the same color as the highlighted buttons in ESM, yellow/orange by default. This color can be
changed in Config > Manage Skins, Colors and Fonts – it is the background color for highlighting text (the first entry in that
dialog). This is usually not an error; the highlight is just a reminder to take a second look to make sure you typed the call sign
in correctly. The highlighting for zones that don’t match the country file is in green, and like the orange highlight, it is just a
reminder, in this case to look to make sure you did not enter the zone incorrectly.

These highlights only last for the duration of the contest. After the contest is over, the highlighting will disappear in order not to
facilitate log washing after the contest.

Keyboard Shortcuts

Delete (Ctrl+D) – Delete the last contact in the log.
QuickEdit (Ctrl+Q) – Moves the last QSO in the log into the Entry window, and signals the mode with “QuickEdit” in
the call-frame. You can tab or space through the window, make the changes you need, and then hit Enter to save them.
Hit Esc to exit QuickEdit without making changes, or Ctrl+Q again while in this mode to switch to the next previous
QSO.

Right-click Menu

Right-click in one of the rows in the upper pane – not in the title bar – and the following menu will appear.

Editing QSOs does not update your score
When you edit one or more QSOs in the Log window, that might result in a change in the multiplier status of that
QSO and/or in your claimed score. The score is not recalculated automatically when you edit QSOs, so you can end
up with incorrect multiplier counts and claimed scores. To correct your claimed score after performing edits in the Log
window, use the Tools > Rescore Current Contest menu item in the main Entry window.
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Edit Contact – Opens a dialog to edit the selected contact – the one on which you click to open the right-click menu.
Items which cannot be edited are greyed-out. This is mainly retained for those who have become accustomed to editing
their log this way in N1MM Logger Classic.
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You can move up and down the log with the large black arrows.

Delete Contact – Asks whether you want to delete the selected contact.
Play Contact – Used to play back the selected QSO if recorded using the qsorder.exe program by K3IT (see
References, Third Party Software). This selection will be greyed out if there is no recording. Contact audio will play on
your default sound player. Make sure you don’t have the sound player connected to your radio’s audio input.
Jump to This Frequency – Moves a connected radio to the frequency of the selected QSO. This can be useful in S&P
mode if you look at the log after a couple of QSOs and discover a discrepancy that you need to ask the running station
about.
www.qrz.com – Opens QRZ.COM’s record for the call-sign in the selected QSO.
Change timestamps of the entire log by a fixed amount – Useful when you discover your clock has been off since
yesterday.

Change Operator – Changes the operator credited with the selected QSO.
Change mode – Changes the mode of the selected QSO.
Change RX and TX Frequency – Allows you to enter a replacement frequency for that entered in the log for the
selected QSO. Can be useful with a non-interfaced radio, if you discover that you forgot to log a band change.
Change Station Name – can be used to change the station name of the PC that made the QSO.
Change X-QSO Status – used to mark (or unmark) the QSO as an X-QSO, which will not be given credit in your log
but which can be used in log checking to validate the other station’s QSO. Used to remove an invalid contact from your
log (e.g. a QSO that violates an off-time or band change limit) without penalizing the other station. QSOs that have
been marked as X-QSOs are indicated in the Log window, and will be denoted in the Cabrillo file with X-QSO: instead
of QSO:.
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Show rates to this QSO in Info window – If the Info window is open, displays QSO rate up to the selected QSO.
Set Start Interpolation Time and Row – Used to adjust times in the log, often when entering contacts manually after
the contest. An example of how to use this can be found in the After the contest chapter. This option is grayed out when
networking is turned on.
Set Stop Interpolation Time and Row – As above. After setting the start time and row, the end time and row can be
selected, and then times on intervening rows will be interpolated between the start and end times. Not available in
multi-computer mode.
Rescore from this point on – Rescore from the selected QSO forward
Auto-set Column Widths – A quick way to make sure column widths will suffice for the entire log, while minimizing the
size of the log window. This option sets column widths based on contents, not the width of the headings, so some
headings may be truncated in contests with short exchanges, for example.
Delete custom column widths – Restores the default values, as defined by the length of the headings.
Show Mode – Option whether to show a Mode column in the log – may be useful to help minimize the size of the Log
window on a crowded screen in a single-mode contest.
Select All – Select all the QSOs in the log for Copy to the Clipboard.
Copy – Copies the selected QSO(s) to the Clipboard as either an ADIF string or a Generic string (used in European
VHF contests).
Help – Opens the manual page on the Log window (Internet connection required)

Changing more than one QSO at a time
You can also make the five types of changes above in more than one QSO at a time. Click the first log entry you
want to change. Then either Shift+Click on the last QSO in a consecutive group, or Ctrl+Click on multiple non-
consecutive QSOs. The highlighting for which lines are selected is very subtle in the default color scheme, so
be careful.

When you have selected all the QSOs you want, right-click one of them to bring up the right-click menu, select the
action you want, and fill in the replacement value. Hit Enter, and you’ll see a pop-up, asking you whether you really
want to make this change in X QSOs. You can cancel at this point if you are not absolutely sure.
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The Move Multipliers Window
2019-09-15

The Move Multipliers Window

Move Multipliers – The Move Multipliers link on the Window menu of the entry Window will display this window. For every call
sign in the spot table and every band/mode selected using the Select Band & Mode button, displays the multiplier status of
that call sign and indicates with background shading which band that station was spotted on. The multiplier status depends on
the program’s ability to determine the multiplier status solely from the spot information. It is not updated when a contact is
logged, deleted, or spotted, but only when the Refresh button is used. A left-click on a call sign will QSY the radio to the first
spotted band. If a station is spotted multiple times, repeated clicks will QSY to the next spot on the line. In SO2R or SO2V, if a
radio or VFO is already on the spot band, that radio/VFO will be used, otherwise the active focus radio will be used, or
Shift+Click will QSY the other radio. A mouse wheel click will delete the line.
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The Multipliers Window
2019-04-13

The Multipliers Window
The Multipliers window is opened from the Entry window’s Window menu. Clicking on the “Multipliers” selection opens a sub-
menu from which you can choose one of seven multiplier displays. Which of these displays is relevant or useful depends on
the contest.

Choosing Countries, in a CQWW log, displays a chart like this:
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Key Features

The drop-down menu gives seven choices, each of which is tailored to meet needs in certain contests. Whichever you pick,
there are some key common features.

Color-Coding

The color blocks displayed are, by default, blue for a band where the mult has already been worked (but a valid QSO is
available), red meaning that a station is available for a single multiplier on that band, and green meaning a double multiplier
QSO is available on that band, in those contests that have them. These colors may be changed to meet special needs
through the Manage Skins, Colors, and Fonts editor on the Config menu of the entry window.

Decisions by the program about whether a multiplier is available on a given band are based on callsigns, and for those
contests in which multipliers are determined by the content of the exchange, the color-coding may not be accurate. A multiplier
block remains on the chart until the underlying spot has expired under the current bandmap spot timeout setting. Open a
Bandmap along with the Multipliers window, set a short timeout, and you will be able to see this happen.

Tailoring Mult Lists for Particular Contests

Users will often want to tailor one of the seven available multiplier lists to a particular contest or QSO Party; for example, in
WAE, non-European competitors will only want to keep track of European country multipliers.

As a first step in this direction, the seven check boxes across the top right of the Countries multiplier window permit you to
limit the display to a single continent. Only one can be displayed at a time, but once you leave the “All” display, you will
discover that you have some flexibility in the way that the columns of multipliers are arranged, to help you make best use of
your screen space. This varies from one type of multiplier to another – for example, the States/Sections window must be
displayed as a wide rectangle to group 10 US call areas and the Canadian sections in logical order.

Gerald, VE1DT has done considerable work on defining the other tailoring possibilities, and much of what follows is based on
his efforts.

My Multipliers Window Looks Funny
If your Multipliers window is empty or incomplete, right-click and look on the right-click menu for the option “Show
Only Worked & Expected to be Worked Mults.” If it is checked, then The multiplier window will only show mults that
have been worked, ones that you have included in an expected mult list, and mults that have been spotted. Uncheck
it, and the Multipliers window will show all possible spots, worked or not.
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Options for doing this are found in the right-click menu reached from any of the multiplier lists. Depending on the contest and
the window, some of these entries may be greyed out.

Show Only Worked & Expected to Be Worked Mults – Checking this option limits the mults displayed to those specified by
one of the methods below.
Edit Expected Multiplier List – Clicking this option opens the following dialog

You can use this dialog to edit the list of expected multipliers, one at a time. For example, if you are editing the countries to be
displayed, you’ll need to enter the country prefixes one line at a time, in upper case exactly as they are shown in the
Multipliers window. For example, you need to enter “CE0X” not “CE0/X”. If you enter specific bands, note that they are
specified by frequency in MHz, not by wavelength in meters. Here’s a simple example:
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Click OK to save the list, and if you check the “Show Only” option described above, the Multiplier window will look like this:

Similarly-limited multiplier displays can be generated by the same process in the Zones display. Before the “Show Only” option
is checked, this display may look like this:
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The reason for the 91 zone lines in this example is to cover both CQ and ITU zones. In the CQWW contests, the display will
only show the 40 CQ zones. In the ITU list, zones 76-91 are sea zones and you may wish to eliminate them from the display.

Hand editing – you can use the Edit Expected Multiplier List dialog to enter each of the 75 land zones and list all six
bands for each zone, in order to limit the display to only those 75 zones. After creating the list, you can use the File >
Export menu item in the edit window to export the list to a file.
Create a list of the zone/band combinations worked in the current log using the Export Mults & Bands from this
Contest menu item. This will create a file of those combinations that appear in the log, which can later be imported
using the next method.
Imported file – after having created a file by either of the first two methods, you can use the File > Import menu item in
the Edit Expected Multiplier List dialog to import the list. The list is a simple text file, so you can use a text editor
instead of the edit window to make changes before importing the file.

Mouse-over

Mousing over any prefix will display information about it – the name of the country, its continent and zone, long and short-path
bearings, and the distance

Resizing

The Multipliers window may be reduced in size, in case your screen real-estate is too limited to show the whole thing. If you
shrink it right-to-left or left-to-right, a horizontal scroll bar will appear to remind you that there is more information to be seen.
Vertically, down-sizing causes the chart to be rearranged, so that a vertical scroll-bar is not necessary.

Clicking on Multipliers

Left-clicking on a block that is colored to denote either a single or double multiplier will QSY VFOA or Radio A to the
frequency of the station that you can work for that multiplier. Blocks denoting stations that would be valid QSOs but not
multipliers are not clickable.

The program will first look for multipliers that match on this band. If their are no mults that match on this band, then it
will look on all band for the latest mult spotted.
The program searches through all spots regardless of the filter settings for the mult window. If, for example, you do not
want to jump to SSB spots in a cw contest, filter out those spots using the Telnet window filters. You might want to
move a SSB station however, so consider that possibility.

Right-clicking on a multiplier block or elsewhere in the open Multipliers window (other than the title bar)opens the right-click
menu.
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Right-Click Menu – multiplier-specific options

Some of the options are keyed to the particular multiplier block clicked, and will be greyed out if you click elsewhere. To
Show Calls Worked and Spots Available, you will need to right-click one of the band blocks, not the prefix.
Show Calls Worked and Spots Available will display a list of all stations already worked for the multiplier, regardless
of band, whether the box you clicked is green, blue, red or empty. It will also display a list of spots currently available for
the multiplier on a new band or mode.
Show Countries – If you are showing a chart of zones worked (in CQWW, for example), this option can be clicked to
show the country prefixes that count for the zone on which you right-clicked.
Turn Antenna – if rotator control is enabled, clicking on this option will turn the antenna to the short-path direction of
the multiplier from your QTH.
Set Rover QTH – If Rover mode is enabled, the RoverQTH county or grid square can be set using this option.

Other Right-Click Options

Set Bands and Modes to be Displayed – opens a dialog that looks very much like the Telnet and Available windows’
Bands and Modes dialogs. The purpose of this option is to control the boxes that appear beside each multiplier. For
example, you might use it to eliminate the boxes for a band(s) for which you do not have an antenna, or to limit the
display to only a single box for the band of a single-band entry. Note that this operates on the display boxes, not on the
spots themselves. In a contest in which there are no per-band multipliers (e.g. ARRL Sweepstakes or ARRL RTTY),
and in which there is only one box per multiplier, using this option will have no effect on which multipliers are spotted
and displayed.
Set Grid Square Map Center (grid square map only) – On the grid square map (which is not really a map, since there
is no geographical information displayed, only grid square designators), you can choose which grid square to center the
display on. This is functionally equivalent to scrolling the display left/right/up/down.
Show Beam Heading to Grid Center (grid square and grid field maps only) – Right-clicking on a grid or field square in
the map will display a beam heading to the center of that grid square or field.
Help – will take you via the Internet to this section of the manual.

In contests with separate grid square or grid field multipliers for each band, the Grid Square or Grid Field map will display
multipliers for the current band only. In SO2R or SO2V, the current band follows Entry Window keyboard focus (e.g. pressing
the \ key to switch EW focus will change the band displayed in the map).
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The Network Status Window
2019-04-13

The Network Status Window

The N1MM+ network scheme also simplifies and automates the network setup. So long as each computer on the network is
running in the same subnet, with the same version of N1MM Logger, and the same contest and multi-operator class in the
Contest Setup, the network will be set up automatically.

Tabs

Whenever you open the Network Status window, it comes up in the Stations tab.

The Stations Tab

As you can see above, this tab contains all the basic information about each station in the network:

Computer – This is the name assigned to the computer in Windows
IP Address – on the local area network
Pass – The pass frequency (to which other stations on the network can pass new mults). Each station can set or
change this frequency for itself manually (on the Actions tab) and all stations can then see the new frequency.

Turning on Networked Computer Mode
If you open the Network Status window without enabling networking, you will see a framed warning: “Networked
Computer Mode is off – Click here to turn on.” Do as it says (actually, click anywhere in the main body of the
window), and the other computer(s) in the network will appear. If you turn on networking by accident with no other
computers in the network, you can turn it back off using the “Stop Networking” button under the “Actions” tab.



All computers in the network must run the same version
When Networked Computer Mode is on, all of the computers in the network must be running the same version of
N1MM+. Run-time errors may result if computers running different versions of the program are networked. Also, the
country file in all of the computers should be the same, the station callsign in the Station Information dialog in all of
the computers should be the same, and the selected contest log in all of the computers should be for the same
contest type.
The computer names on the networked computers must all be different. Do not attempt to network two computers
with the same name (each computer’s name can be changed from its Windows settings window or the Windows
Control Panel).
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Run – Whether each station is in Run or S&P mode
10/100 – What its current QSO rate is (last 10 and last 100 QSOs)
Freq – What frequency it is currently on.
Op – Who is operating (as set by OPON or Ctrl+O)
Msg – What, if anything, that station has just done, such as pressing a function key
Send/Receive – normally reads “OK” unless there is a problem with the network.
Master – Permits checking to select one station on the network as the master. Check one to determine which connects
to the Internet for cluster spots and time synchronization.
Band – Note that if you sort on band, you will also sort on Run/S&P as the secondary sort. This may be useful for very
large multi-ops where the station name does not indicate the band.
R/M – Run/Mult indicator for each station (Multi-Single: 1 for Run, 2 for Mult). Indicates Run1/Run2 for Multi-2.

A (((*))) in the title bar of the Network Status window means that your computer just broadcasted its IP address, usually in the
process of establishing a connection to the network. When connection is established, the title bar will reflect the number of
stations in the network.

The red highlight on the Messages tab means that there is a network message waiting there that has not yet been read. In
most cases, it is normal administrative traffic, such as a connect request from another station on the network. The red
highlight may also be seen on the computer name during the connection process, usually accompanied by a red highlight in
the Send or Receive column. These will disappear when a good connection is established.

Right-Click Menu

The right-click menu on the Stations tab opens a menu of powerful functions that most multi-op operators will find important in
real time. The rationale for placing it here is that most operators will keep this tab on-screen, since it contains so much
important operational information. Each of these functions requires right-clicking on the line entry of a computer other
than the current one, to identify the affected computer and open the right-click menu.

Pass current/last QSO – If you right-click on a computer to which you wish to pass your current or last QSO
(assuming that the station just worked has agreed to QSY), and then click this option, a Talk message will be sent to
the Info window of the target computer, telling the other operator who to expect and on what frequency. If that
computer’s Pass Frequency is set to zero, then the Message will show the receiving computer’s frequency at that time.
Talk – A right-click on any computer in the network, followed by a click on this option, will open the Talk sub-window
with that computer’s name already entered.Talk messages appear in the Info window of the receiving computer.
Show connection log – Right-click on a computer and then on this option, and a log of communications events
between your computer and the one selected will be displayed as an aid to trouble-shooting.

Keeping Computer Clocks in Sync
In order to keep all of the clocks on a network in sync, either all computers must be running accurate time
synchronization programs (like those used for computers running WSJT mode programs), or else all “slaves” – all
computers other than the one designated as “master” – must be run as Administrator (by right-clicking on the desktop
icon and selecting “Run as administrator” from the pop-up menu). The master computer will be responsible for
ensuring that times are correct on all computers in the network.
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Target for call stacking – The intended use of this feature is for large multi-ops that have more than one radio on a
given band, to permit the “helper” operator to identify and queue stations for the run operator to work. If the two
computers are on the same frequency (+/- a small tolerance), a right-click on the target computer turns on call stacking.
Thereafter, any callsign that the “helper” op enters in his Entry window will appear in the call-frame of the target
computer’s Entry window. The run operator only needs to hit [Space] to pull the call down into the call-sign textbox,
ready to work. There is a checkbox on the Options tab which, if selected, will clear the sending computer’s
Entry window if the target computer works the station that has been stacked.
Close and Open connection – These options are used to open and close connections between the current computer
and the one you right-clicked on.
Prevent automatic reconnect attempts – used when trouble-shooting the network to stop the selected computer from
sending reconnect requests every thirty seconds.
Set station as master for telnet and time sync – Another way to set any given computer on the network as the
Master for receiving DX cluster spots and performing time synchronization. Note that time synchronization requires that
N1MM Logger+ be run as Administrator on the receiving computer(s).
Auto-set column widths – used to adjust the format of the Stations display to the minimum required to display the
information currently present on-screen
Call for Help – Sends an audio request for assistance to the computer you clicked on, together with a text message in
the receiving computer’s Info window.
Stop Networking (not recommended during contest) – self-explanatory.
Help – when Internet access is available, displays the appropriate section in the User Manual.

What, Another Right-Click Menu?

There is a second right-click menu associated with this tab. It is made visible when you right-clink on the column headings row
of the tab (“Computer”, “IP Address”, etc.) . It allows you to select which columns on the Stations tab you want to display, in
the event that you want to minimize required screen space while still monitoring network activity.

Adjusting the Stations Tab’s Format

If you put your cursor between column headings in that row and move it rightward almost to the next column to the right, you’ll
see that it changes to a standard Windows “change width” character (a vertical line with horizontal arrows facing away from it).
You can drag that marker right to increase the width of the column to its left, or left to decrease the width of that column.

It is possible using this control to make the heading of a column disappear altogether. If you do that and want to recover, right-
click in the body of the tab, and select “Auto-Set Column Widths” to get back to the full set of minimum-width headings.

You can also reorder the columns, by clicking on a column heading itself and dragging it where you want it. Be a little cautious
in doing this, though, because there is no command for automatically restoring column order to the original – you’ll have to do
that manually or by erasing the NetworkStatus.ini file in SystemFiles directory.
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The Resynchronize tab

Normally every computer has a copy of every QSO in the log. If all computers stay connected at all times, new QSOs entered
on one computer are broadcast to the other computers in the network so that every computer always has a complete copy of
the log.

If it is necessary to edit or delete a QSO, the computer that the QSO was initially logged from must be used to perform the
change. Other computers do not have permission to change the QSO. Any such change made at the originating computer will
be reflected on all computers that are connected to the network at the time the change is made.

If a computer becomes disconnected from the network, you can continue to log contacts on it. When the computer rejoins the
network, all QSOs made on that computer will automatically be sent to the other computers, and all new QSOs made on the
other computers will be copied to the rejoining computer. This process is called resynchronization (resync for short).

Resynchronization of newly added QSOs is automatic. However, if changes (edits or deletions) are made to previously
existing QSOs while a computer is disconnected from the network, those changes will not be applied during the automatic
resync process. In other words, the automatic resync when a computer reconnects to the network only updates new QSOs; it
does not update QSOs that were already in the log. Because of this, if network communications have been interrupted during
the contest it is a good idea to perform an additional manual resync at the end of the contest in order to ensure that all the
logs are identical, and that is the purpose of this tab.

A manual resync operation initiated from this tab requests each other computer in the network to update the requesting
station’s copies of all QSOs that were originally logged at the other computer in order to take into account the effects of any
changes (edits or deletions) that were made during network outages.

The “Contest” button will resynchronize from the start of the contest. This is for resyncing during or within a few hours
after the contest ends. If resyncing logs later than this, use the Last # hours option below. The resync time period will
be displayed in the Info window. If it doesn’t cover the contest time period, use the Last # hours option below. If
“Resync All Stations” is unchecked, only one station will be resynced by all other computers.
The “Last” button and the textbox next to it are used to resync for a shorter period when you know when the problem
occurred or when resyncing logs greater than a few hours after the contest. The number of hours is backwards from the
current time. If “Resync All Stations” is unchecked, only one station will be resynced by all other computers.
The “Since” button works the same way but by resync start date and time rather than duration.
The “Resync All Stations” checkbox syncs each log with all others simultaneously. Use this after the contest is over to
ensure that all logs are identical. This can be a resource-intensive process; in order to avoid disrupting operations at
other computers, do not use it during the contest while any computers are still being used to log new contacts. If this is
unchecked, only one computer will be resynced.
The “Rescore When Done” checkbox rescores the contest after the resync is complete on this computer, or all
computers if Resync All is selected
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The Rescore tab

This tab controls rescoring the log on the local computer, recalculating QSO points and multipliers, in order to take into
account the effects of any changes (edits or deletions) on the final score. This is recommended practice at the end of a
contest, before a Cabrillo file is generated for sending to the contest sponsor. The buttons are the same as those on the left-
hand side of the Resynchronize tab, and are used similarly .

The Options tab

Left to right and top to bottom, following is a description of the radio buttons and checkboxes on this tab.

Run1 and Run2/Mult radio buttons – These buttons are greyed out except in the case of the Multi-Single and Multi-2
classes, in which case you can click the radio button to designate the current computer as Run or Mult (Multi-Single) or
Run 1 or 2 (Multi-2)
Log QSOs at all Stations – By default this is checked. It ensures that all QSOs logged at any station are broadcast to
all other stations in the network so that the logs in all computers contain all of the QSOs, not just the QSOs made at
that particular station
Don’t work non-mults – This box is checked by default if you are entered in the multi-single class in contests where
the current station is the Mult station and must not work non-multipliers. When checked, this will block the station from
working non-mults. Function key messages will not be sent to a non-multiplier station
Wipe callsign when logged by stack target – Use in conjunction with call stacking. If your partner logs the callsign
that you stacked, your callsign textbox will automatically be cleared so you can stack another
Trace Networked Computer messages – a trouble-shooting tool that logs messages between computers on the
network to a file titled MultiUserMessages.txt
Block my transmitter with M1 & M2 contest rules – For multi-single and multi-two stations. In multi-single in contests
(like ARRL contests) that only allow a single transmitter at a time in multi-single, this will block transmitting while
another networked station is transmitting. In multi-single in contests (like CQ WW) that allow a multiplier transmitter and
if there is more than one Run or Mult station, if another station with the same Run/Mult selection is transmitting this will
block transmitting to comply with the contest rules about simultaneous transmitters. In multi-two with more than one
Run1 or Run2 station, if another station with the same Run1/Run2 selection is transmitting this will block transmitting to
comply with contest rules about simultaneous transmitters

At most one of the three “Block” choices can be selected. The “Block” and “Stop” selections do not have to be
the same in all stations in the network. Blocking using this option is entirely dependent on reliable low-latency
computer networking, and does not work on stations that are transmitting using radio control commands (such
as by invoking CW or SSB memories in the radio). Grayed out in single-operator categories
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Block my transmitter only if another station is transmitting on same band. No M1/M2 rules – Regardless of the
transmitter class, if another station is transmitting on the same band, this will block transmitting to prevent two
transmissions on the same band at the same time while still allowing simultaneous transmitting on different bands

At most one of the three “Block” choices can be selected. The “Block” and “Stop” selections do not have to be
the same in all stations in the network. Blocking using this option is entirely dependent on reliable low-latency
computer networking, and does not work on stations that are transmitting using radio control commands (such
as by invoking CW or SSB memories in the radio). Grayed out in single-operator categories

Block my transmitter only if another station is transmitting on same band and mode. No M1/M2 rules –
Regardless of the transmitter class, if another station is transmitting on the same band and mode, this will block
transmitting to prevent two transmissions on the same band and mode at the same time. Unlike the previous option,
this option will allow simultaneous transmitting in different modes on the same band

At most one of the three “Block” choices can be selected. The “Block” and “Stop” selections do not have to be
the same in all stations in the network. Blocking using this option is entirely dependent on reliable low-latency
computer networking, and does not work on stations that are transmitting using radio control commands (such
as by invoking CW or SSB memories in the radio). Grayed out in single-operator categories

Stop my station from transmitting to prevent other station block – This option and the following option are
available only when one of the above three “Block” options is selected. Only one (or none) of the two “Stop” options
may be selected. Converts the chosen “Block” option from “First one wins” to “Last one wins”, i.e. choosing this option
allows another station to stop (interrupt) an ongoing transmission on this station in order to allow the other station to
transmit without being blocked

Stations using only a “Block” option without selecting a “Stop” option can be blocked by one another and by
stations not using any of the “Block” options, but will not be blocked by stations using a “Stop” option

Stop my station from transmitting to prevent other station block. CQ only – This option and the preceding option
are available only when one of the three “Block” options is selected. Only one (or none) of the two “Stop” options may
be selected. This is similar to the preceding option, except that it will only interrupt a CQ message

The intent of this option is to allow an ongoing QSO from this station to be completed without interrupting
messages such as exchange messages that have already been started, but to allow this station’s CQ messages
to be interrupted while they are being sent

Allow Direct Telnet Connection (appears only on non-Master computers) – if this check box is checked, the Telnet
window will allow this computer to connect directly to a telnet cluster node; if it is unchecked (default), this computer will
receive its cluster spots only from the Master station, not directly from a separate Telnet connection

If this check box is checked and if the Master computer is sending telnet spots (next option), this computer may
receive spots from two sources, namely the Master computer and a telnet cluster node this computer is
connected to directly

Do Not Send Telnet Spots to Other Stations in Network (appears only on the Master computer) – this option
complements the previous option by telling the Master computer not to send spots to other computers; if this option is
checked, the other computers will have to use the previous option and connect directly to telnet cluster nodes if they
wish to receive cluster spots

The Actions Tab

Talk (Ctl+E) – opens a sub-window, in which you can send or receive talk messages to/from the other station(s) on the
network.
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The first of these two illustrations is an empty Talk window. By default, Talk messages are sent to all stations, denoted by the
asterisk. If you enter a computer name in place of the asterisk, followed by a space and the text of a message, the message
will be sent only to that station. That computer name then becomes the default address for Talk messages from you until
replaced. Note: you must enter the computer name exactly as shown in the left-most column of the Stations tab, except that
whatever case you enter will be changed to all upper-case to conform with the Microsoft standard.

The upper pane is now where talk messages are received, as in the second illustration. Messages in red have been received,
and are also displayed in the bottom pane of the Info window, Ctrl+E can now be used to toggle the Talk window between full
size and minimized to the lower left corner of your screen.

The first time you receive a Talk message while the Talk window is open but minimized, you will notice a new icon in the right-
hand end of the Windows taskbar, with a message balloon above it. The icon will remain there until the Talk window is closed.
This is in addition to the N1MM+ logo you will see over to the left, which is present any time the program is open. Thereafter,
each time a new talk message comes in while the Talk window is minimized, a message balloon will appear above the new
icon, as illustrated below. The message balloon is displayed for 5 seconds and then disappears.

If you want to send a message only to a particular station, right-clicking on that station’s line on the Stations tab and then
selecting “Talk” will relieve you of having to fill in the computer name. Other operation is as above.

Set Your Pass Frequency – enter the frequency you want other stations on the network to pass stations to. It will
appear on all stations’ Stations tab.
Stop Networking – Self explanatory – strongly discouraged during a contest.
Force Time Sync – Self-explanatory
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Edit Computer Addresses – N1MM Logger+ networking is automatic within a single subnet, which is usually the case
in local area networks. However, if you want to network across a Wide Area Network, or in rare instances where your
network involves more than one subnet, auto-configuration will not work. In that case you will need to fill in computer
addresses in this table exactly as assigned by the network(s). For WAN networking you must enter the external IP
addresses of each LAN and also port numbers for all the computers you wish to connect to, in the format
XXX.XXX.XXX.XXX:port number}. Separate port numbers are needed for computers outside the local network, in order
to permit operators to set up forwarding through their router firewalls to the right computer. If going subnet-to-subnet,
you do not need to enter port numbers and the IP addresses would be the internal IP address. Here’s an example in
the WAN case, such as would be needed for a distributed IARU HQ “station”. Note that the Hostnames are the Netbios
(computer) names of the computers being networked. In this example illustration, for clarity the computer Netbios
names have been reassigned in the illustration to denote the various bands:

Please refer to your router help file for instructions on setting up port forwarding. Here is a sample Netgear Port
forwarding setup. In this example, the site has two N1MM+ instances running on 192.168.1.7 and 192.168.1.8. The
router will receive TCP connections coming in on port 12071 and 12070, but both connections will be sent to 12070 on
their respective computers. 13064 is a spectrum UDP port being forwarded to 192.168.1.7
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Reset Serial Numbers at All Stations – only for use when you have screwed up. Sets the serial numbers on all
computers to the highest value in any of the logs, plus 1, so you can start a new serial number sequence without
duplicate numbers. This does not change the serial numbers of QSOs that are already logged.

The Messages Tab

Displays networking messages

Networking Across a Wide Area Network (WAN)

N1MM+’s automatic network detection and configuration feature requires that all logging stations be connected to the same
local area network (LAN) with the same subnet address. There are two options for configuring contest stations that are remote
and not on the same LAN. The first option involves manually entering the IP addresses of every station. The second option
uses a virtual private network (VPN) to simulate LAN addressing of the contest stations. Both options work, but you may find
that the VPN option is easier to implement and manage. Although this is not a product endorsement, the N1MM Development
Team members have documented the deployment of a Distributed Multi-Op Network with a Hamachi VPN in a step-by-step
guide that you will find in the Additional Support Files gallery of the Download section of the website. In addition to Hamachi,
N1MM+ users have been successful using other VPN products, including the free SoftEther VPN software. You will find their
VPN descriptions in the same Additional Support Files gallery.

Troubleshooting

Check first:
All computers have different Netbios (computer) names and they are all 15 characters or less
All computers are running the same version of N1MM+. Please use the latest version
All computers have the same time with 2 seconds or you are running all the non-master computers in admin
mode so they can set the time when the master requests it.
All computers have the same copy of Master.SCP and wl_cty.dat

Computers don’t connect at all, or connect in one direction only
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If computers are not on the same subnet, they will not automatically connect. Enter their Netbios names and ip
addresses in the computer addresses table – see Actions Tab to access. Note that you may specify NetBios
names in the 2nd column if they are recognized by your network. You may also specify DNS names there as
well.
Start without a computer address table – make sure you do not have any entries in it. If you need entries, make
sure they are correct. – see Actions Tab to access
Make sure each computer is allowed to connect to other computers by Windows firewall or any other firewall. It
may be quicker to turn off the firewall and test. If that solves the problem (like one-way communication), then
figure out how to put N1MM+ into the firewall exception list and restart the firewall. We do not recommend
running your computer without a firewall
If a computer has more than one network connection, try disabling the one that you are not using.
Turn off your antivirus program temporarily to see if that is blocking the connections. Don’t forget to turn it back
on.

Remote computers don’t connect
N1MM+ receives data on port 12070. Routers must translate the port being SENT from remote computers to the
particular computer on the network. If you SEND on port 12071 to computer Bob, the router must route 12071 as
12070 to Bob. You will need to route as many ports in your router as there are computers running N1MM+ at that
location.

Recovering from a Broken Logging Computer

What do you do if one of your computers no longer works?

DO NOT ADD ANOTHER COMPUTER WITH THE SAME NAME!

If you do not replace it on the network

1. Each computer will have a copy of the QSOs logged by the broken computer. If they all agree on the number of QSOs,
then you should be fine. If not, you will need to compare the lists from each one and determine which QSOs are
missing.

If you replace it on the network

1. Locate a running network computer whose log includes the QSOs from the broken logging computer. SHUT THE
PROGRAM DOWN on this computer.

2. Copy that computer’s database_name.S3DB, database_name.s3db-wal and database_name.s3db-shm database files
(the last two are temporary files that usually do not exist) to a network drive, diskette or flash drive.

3. Copy the database_name.S3DB* database files from the temporary medium to the replacement computer’s \database
directory

4. Configure the replacement computer and N1MM Logger and begin logging. Any new QSOs will be identified by the
replacement computer’s name, which MUST NOT be the same as the broken machine’s name.

5. Restart the source computer and resume logging

NOTE:
Each computer is the “book of record” for the QSOs logged on that computer, even though all QSOs are normally
logged on every computer for redundancy. Resync simply compares what your computer’s log shows for QSOs by a particular
computer (as identified by its network name) to what that computer has in its log. If there is a difference, the computer that
logged the QSO sends the updated QSOs to the requesting computer. If a QSO is deleted or removed from the log in the
computer that “owns” the QSO (as identified by the computer’s name), the Resync operation will delete that QSO from the
logs in the other computers.

Therefore, if the problem was with the database on the “broken” computer, DO NOT create a new database (or a new contest
within the existing database) on the problem computer in order to resolve the problem. That will cause all the QSOs that were
formerly logged on that computer to disappear from ALL of the logs. Likewise, DO NOT swap in a new computer with the
same name and a new empty log, as that will have the same effect. To avoid this, make sure the name of the new computer is
different from the name of the broken computer (the computer name can be changed in Windows if necessary to avoid
duplication).

The best way to avoid all this is to keep a spare computer (with its own unique network name) up and running
N1MM+ on the network. You can then just swap it in for the broken one. The QSOs from the broken computer will still
be in the logs in all the other computers.
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The Score Window
2019-04-13

The Score Window
The Score window is automatically formatted to display the components of the score (such as QSOs, zones, and country
multipliers) in the current contest.

The Score window has an independent font resizer – the up/down arrows in the upper right corner – and is now resizeable. If
you reduce its size so that not all the contents can be seen on-screen at once, scroll bars will appear to allow you to see parts
of interest without re-sizing.

The Rescore button in the lower right corner does the same thing as the Tools > Rescore Current Contest menu item in the
Entry window; it rechecks points and multipliers and recalculates the score.

With a right mouse click, a menu will appear

Copy all – Copy all info to the Windows Clipboard.
Print to file – Print the score summary to a file.
Help – Show the user manual section for this window (Internet required).
Display Contest Name – Display the name of the current contest at the top of the window
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The Spectrum Display Window
2019-04-13

The Spectrum Display Window
Spectrum Display Window – If your red dots don’t line up with signals, adjust the noise floor. Then use Shift+up/down
to jump from signal to signal! If you are having trouble finding a CQ frequency, press the CQ Button!
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The Spectrum Display Window can display spectrum data in 6 ways:

1. Using a vendor-provided ExtIO dll and N1MM SDR Server
2. Via CAT data from radios that support it (newer Icoms)
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3. Via an ExtIO dll provided by the SDR vendor
4. Directly reading IQ data provided by the radio (IC-7610 only)
5. Using level data sent from another source (Flex radios, N1MM spectrum windows, Waterfall Bandmap program).
6. Via Airspy’s Spyserver program.

What is unique about the N1MM+ Spectrum Window is its ability to identify signals and allow the user to jump to those via
keystroke as well as compare them to local and RBN spots to identify unspotted and already worked signals.

Supported Radios & Interfaces

N1MM SDR Server – For radios with Extio dll support – THIS IS THE PREFERRED METHOD FOR SDRPlay and Airspy
HF+/Discovery SDRs

Download the correct ExtIO dll from your SDR vendor’s site and place in the N1MM+ *Program Install* directory. This
usually C:\Program Files (x86)\N1MM Logger+. Download:

Airspy HF+/Discovery: from https://airspy.com/download/
SDRPlay: from

https://www.sdrplay.com/downloads/ and
https://github.com/SDRplay/ExtIO_SDRplay/releases/tag/4.0

DO NOT DOWNLOAD THE TCP EXTIO plugin. That is the wrong one.
Start N1MM+ and open a Spectrum Window.
Open the Spectrum Dialog (gear icon). Select N1MM SDR Server
Select the dll and let the source name default to the dll name.
You can only run one program at a time using the output of an SDR. Don’t try to run SDR# or SDRuno and the N1MM+
spectrum display at the same time.
SDRPlay Tips:
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Download and install HDSDR.
Place the ExtIOfor your SDR in the HDSDR program directory.
Click the SDR Device button in HDSDR
Change the options below
Set the IF Mode to Low IF
Set the IF Bandwidth to its minimum value (usually 200 kHz)
Adjust the gain control(s) for a reasonable amount of “grass” at the bottom of the spectrum display. You will have
to close the SDR UI to see the level. You will likely need to repeat these steps.
Exit both the SDR ExtIO UI and HDSDR
In the geari icon settings dialog, set the Freq Bins to 16384. This is a good start at providing high resolution at
minimum cpu utilization. You want about 50 Hz/bin as shown in the box that shows resolution, signal count and
bandwidth.

Airspy Tips:
Close N1MM+
Start N1MMSDRServer.exe in: “C:\Program Files (x86)\N1MM Logger+\N1MMSDRServer.exe” as
ADMINISTRATOR
Press the start button for the Airspy dll
Open the SDR UI with the button from the SDR Server application
Check the title bar of the Airspy SDR UI. If the firmware version number is not the latest available, first upgrade
your firmware. You can download the firmware on the Airspy site. The instructions are in the readme.txt file of the
download
Set the sample rate to 192000 (you must be running as ADMIN for this to be saved). This will result in minimum
CPU utilization but slower signal response. For faster signal response use the 912000 sample rate. You will
need to adjust your Freq bins higher to 64k or so if you choose this value for sample rate.
Close the SDR UI with the button from the SDR Server application
Close the SDR Server application
Open N1MM+
In the gear icon settings dialog, set the Freq Bins to 8192. This provides high resolution at minimum cpu
utilization. You want about 50 Hz/bin as shown in the box that shows resolution, signal count and bandwidth. If it
is higher than 23, the sample rate steps above probably failed.

You may run N1MM SDR Server on a different computer. To do this, change the SDR Server Connection Address to
the address of the computer running SDR Server. You will need to start the server manually.
You can serve more than one N1MM+ SDR display on different computers. Only the first computer will be able to
change the SDR frequency.
N1MM SDR Server supports multiple SDRs, but only with ExtIO dlls that recognize different SDRs. You cannot rename
a dll to accomplish this. It is the internals of the dll that recognizes a particular SDR. A workaround to this problem is to
run SDR Server on mulitple computers. You’ll need to put the ip address of the 2nd computer in the Connect tab of the
associated spectrum display window.
Airspy server can be used as a way to run a second Airspy on the same computer.
Always Open/Close the SDR UI by pressing the button in the N1MM SDR Server program. (SDR Server shows in your
task bar with a spectrum display icon)

Airspy HF+ Dual Port / Airspy HF+ Discovery

Download the correct ExtIO dll from https://airspy.com/download/ and place in the N1MM+ *Program Install* directory.
This usually C:\Program Files (x86)\N1MM Logger+.
Start N1MM+ and open a Spectrum Window. Right-click and set the source to “I/Q via ExtIO.dll”
Select the correct dll in the gear icon settings dialog.
You can only run one program at a time using the output of an SDR. Don’t try to run SDR# and N1MM+ spectrum at the
same time.
Tips:

In the gear icon settings dialog, open the SDR UI via the Open button
Set the sample rate to 192000. If you can’t set this to 192000, you may not be running the latest Airspy firmware.
Close the SDR UI by pressing the Close button in the gear icon settings dialog.
Then set the Freq Bins to 8192. This provides high resolution at minimum cpu utilization.

If you need two Airspy HF+ spectrums, one must be via Spyserver (see next section).

Airspy HF+ via Spyserver (this is distinct from SDR Server above)

No other Airspy models are supported. Can be used with any transceiver.

This method of connection is NOT RECOMMENDED. Support ends 2024-01-31

SDR Server is the preferred way to support this device. See the SDR Server section above.
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Download SDR# software to downloads from https://airspy.com/download/
Create a new directory SDR# on your C drive (i.e. C:\SDR#) or in your N1MM+ *program* install directory (typically,
C:\Program Files (x86)\N1MM Logger+\SDR#).
Copy all the files from the downloaded SDR# to the new directory. If you want to start the server manually, you can put
it wherever you want.
Important: Change the device_type= in spyserver.config to AirspyHF+
Important: Change the device_sample_rate = 768000 (Do not use the default)
Change fft_fps= to 6. This improves cpu consumption
Start N1MM+ and open a spectrum window
Right-click and set the Source for the spectrum window to Airspy HF+
If there are bugs in setup, closing the program and restarting at this point may clear them. I need to fix them, but you
probably want to get on with using it at this point.
There is code included for local Airspy servers to suppress the spectrum & waterfall displays for 200 msec after the
associated radio stops transmitting. It will also suppress the display if a very strong signal is present on the transmit
frequency.
To add a second Airspy HF+ you will need to:

Specify the airspy serial number that you want to serve in spyserver.config. That should show up in the window
that runs when you start it.You may have to connect them one at a time to figure this out.
Change the bind port from 5555 to 5556 (or whatever)and bind to that port in the 2nd spectrum window gear
icon settings dialog.
You will need to start a second copy of spyserver manually with the different ini file.

SDRPlay

Install SDR Uno to accomplish installation of the device.
Download the correct ExtIO dll from https://www.sdrplay.com/downloads/ . and place in the N1MM+ *Program Install*
directory. This usually C:\Program Files (x86)\N1MM Logger+
Start N1MM+ and open a Spectrum Window. Right-click and set the source to “I/Q via ExtIO.dll”
Select the correct dll in the gear icon settings dialog.
You can only run one program at a time using the output of an SDR. Don’t try to run SDRUno and N1MM+ spectrum at
the same time.
Start N1MM+ in: “C:\Program Files (x86)\N1MM Logger+\N1MM Logger+.exe” as ADMINISTRATOR if you need to
change the parameters below.
SDRPlay Tips:

Open the SDR UI with the button from the IQ tab.
Set the IF Mode to Low IF
Set the IF Bandwidth to its minimum value (usually 200 kHz)
Adjust the gain control(s) for a reasonable amount of “grass” at the bottom of the spectrum display.
Close the SDR UI by pressing the button on the IQ tab.

If you need two SDRPlay spectrums, at least one must be supported via the Waterfall Bandmap program.

IC7610 using native FTDI interface

Download the correct Icom HDSDR installer. This will install the USB driver. Install it with the radio disconnected.
Install a second USB cable from the second USB port on the rear of the IC7610 to your computer. Start N1MM+ and
open a Spectrum Window.
Copy FTD3XX.dll and FTD3XX_NET.dll to the PROGRAM install directory (typically, C:\Program Files (x86)\N1MM
Logger+)
Right-click and set the source to “IC7610 I/Q via FTDI.dll”
Note that the IQ tab dll combox will hide any IC7610 Extio dlls. They are no longer needed. This connection allows
choosing of main/sub rx by selecting the Associated radio. The ExtIO.dll version did not.
The Freq Bins selection will determine the resolution of the display. Higher numbers use more CPU and produce finer
resolution. Use the minimum for the lowest resolution you plan to use. 65536 is a good place to start and will give you
30 Hz resolution.
You may open two instances of the IC7610 I/Q via FTDI.dll with associated radios of 1 & 2. These correspond to main
and sub receivers. In order for this to work, you will need Dual Watch to be on. Note that this configuration overloads
the radio to the point where the touch screen does not reliably work. Turn off Dual Watch and touchscreen operation
will resume. Another way of getting both receivers to display a spectrum is to use the CAT spectrum of the radio on one
of the receivers.

This method of connection is NOT RECOMMENDED

SDR Server is the preferred way to support this device. See the SDR Server section above.
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Other SDR Radios via SDR Vendor Provided ExtIO*.dll (as SDR adjunct to any transceiver)

This connection approach is being discontinued on 2024-01-31
SDR Server is the preferred way to support these devices. See above.
Download the correct ExtIO dll from the vendor website and place in the N1MM+ *Program Install* directory. This
usually C:\Program Files (x86)\N1MM Logger+. (Some radios, like the IC-7610 require addtional files. Read the radio’s
documentation for using HDSDR with the radio and emulate the install instructions, but put in the N1MM Logger+
directory.)
Start N1MM+ and open a Spectrum Window. Right-click and set the source to “I/Q via ExtIO.dll”
Select the correct dll in the gear icon settings dialog.
Tested radios include: SDRPlay RSP1, RSP1A, RSP2, RSPDuo, Airspy HF+, Icom IC-7610.
A link to the Airspy HF+ extio dll can be found in Airspy HF+ page in the “Supported Software” section.
Be sure to install the driver for the SDR if required. SDRPlay would need you to install SDRUno to install the USB
driver.
You can only run one program at a time using the output of an SDR. Don’t try to run a program like SDRUno and
N1MM+ spectrum at the same time.
Other radios may need the “Reverse I/Q” checkbox checked if the spectrum moves in the wrong direction. Notify the
team and we will include the Radio to select I/Q properly. We will need to know the ExtIO*.dll name for your radio.
I don’t plan to support any other radios at this point. Why? Two reasons. SDRs are very idiosyncratic in how they work.
Each seems to have its own set of issues. I don’t have all these radios to debug (and I don’t want to have them). The
second reason is that owners usually just say something like “I tried the spectrum window with my Toothgnasher
SuperSDR and it doesn’t work. What gives?” There is not a lot to go on to debug that. You might want to report what
settings you used, and the actual symptoms.

Icom IC-705, IC-7300, IC-7850/51, IC-7610, IC-9700

Must use the USB cable virtual COM port for radio control. Unplug the CI-V cable.
Set Right-Click Radio source to Radio 1 or Radio 2 as appropriate
Must have the radio menu CI-V USB Port set to Unlink from [Remote}
Must have the radio and program baud rate set to 115200 baud.
After the program and the radio is set to 115200 baud, exit the program and restart.
Note that the preferred method for supporting the IC-7610 is via the native FTDI interface (see above).

Flex 6300/6400/6400M/6500/6600/6600M/6700 Radios

These radios are supported via CAT and UDP – requires SmartSDR V2.0 or later software.

If a supported Flex radio is detected, N1MM+ will send commands to the radio to start and stop the spectrum. It will
send your local IP address and port 13064 to the radio. Note that the program can get confused if there is more than
one local IP address in the computer, e.g. a NIC connected directly to the Flex separately from the NIC or WiFi adapter
connected to the LAN. Therefore, do not connect your Flex directly to the computer via Ethernet. Connect the Flex to
the radio via your router so that the network adapter connected to the LAN is the only one active in the computer.
The Spectrum Window should automatically find the Flex spectrum feed if it is already sending it. Otherwise, start the
Flex and do the following

Start a new Spectrum window and select “For all other radios, source named…” as the source. The Flex should
already be transmitting its identifying information, so when you go to choose the source, pick the source you
want from the drop-down list

Resolution in the N1MM+ spectrum display will be dependent on the zoom level of the Flex panadapter. Bear in mind
that the precision of the signal marking is dependent on the zoom level & consequent bin/pixel size. Something
between 20 and 50 Hz per pixel would be a good place to start

Elecraft K3/K3S/KX3 plus software/hardware:

Win4K3Suite ( https://va2fsq.com/ ) software plus hardware as described below:
K3S, or K3 with KXV3, plus LP-PAN or SoftRock II Lite, plus stereo sound card – connect LP-PAN or
SoftRock to IF Out, set right-click spectrum source to “For all other radios, source named “Win4K3Suite”. See
Win4K3Suite documentation for Win4K3Suite software setup
K3S, or K3 with KXV3, plus SDRPlay (RSP1 or RSP2) – connect SDRPlay to IF out, see Win4K3Suite
documentation
KX3 plus stereo sound card – see Win4K3Suite documentation
KX2 plus SDRPlay (RSP1 or RSP2) plus an external transmit/receive switch – see Win4K3Suite
documentation

Waterfall Bandmap program ( https://groups.io/g/waterfallbandmap ) plus hardware as described below:
K3S, or K3 with KXV3, plus LP-PAN or SoftRock, plus stereo sound card:
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Connect LP-PAN or SoftRock to IF Out. Put the WB program in Sound Card mode, Offset with LP-PAN is
approx. -6000 (varies with mode, roofing filter offset, SHIFT control settings). If traces move the wrong
direction in the waterfall when tuning, check (or uncheck) Swap I&Q. Swap I&Q checked/unchecked
setting for 6m is opposite to the setting for HF. Set right-click spectrum source to “For all other radios,
source named “Waterfall Bandmap”

K3S, or K3 with KXV3, plus ExtIO-capable SDR (including SDRPlay):
Put the WB program in ExtIO mode (ExtIO dll must be in the WB program directory)

RF-based: Connect SDR to a splitter in a jumper between RX Ant Out and RX Ant In – RX Ant
must be selected in the K3. Offset zero, SDR at IF check box unchecked . Set right-click spectrum
source to “For all other radios, source named “Waterfall Bandmap”
IF-based: Connect SDR directly to IF Out. Check the SDR at IF check box, set IF to 8215, Offset to
zero as a starting point, but offset varies with mode, roofing filter offset, SHIFT control settings.
May need to check Swap I&Q if traces move in the wrong direction when tuning – 6m and HF will
be opposite settings for this, and offset settings may also differ between 6m and HF. Set right-click
spectrum source to “For all other radios, source named “Waterfall Bandmap”

KX3 plus stereo sound card:
Connect KX3’s I/Q output to the sound card. Make sure the box to the right of the Start button reads
“Sound card based SDR”. Select the sound card connected to the I/Q output to be the Input device. The
offset should be set to zero. If traces move the wrong direction in the waterfall when tuning, check (or
uncheck) Swap I&Q . Set right-click spectrum source to “For all other radios, source named “Waterfall
Bandmap”

Elecraft K4 native spectrum:

Make sure you are running the latest version of the K4 firmware. External spectrum data is not available from earlier
versions
In the Configurer one of the options in the list of ports is TCP. This is used by the K4 to support radio control
via TCP (Ethernet). When TCP is selected, enter the IP address and TCP port used by the radio in the box in the IP
Addr:Port column. The radio’s IP Address can be found in the K4’s configuration menu under “IP Address”
You may connect to your K4 using TCP as described above. If you choose to connect to the K4 via a virtual com port,
you must include the ip:port in the provided space in the configurer. The spectrum level data is sent on the next higher
TCP port and the program will automatically acquire it. The default port for the K4 is 9200. You do not need to enter the
K4 spectrum port, just the control port
To create a spectrum window, choose Window/Spectrum and right click. Select “Spectrum Source” and “For all other
radios, source named:”. You should see “Radio 1 Port A”. Choose it for VFO A. If you are SO2V, you will also see
“Radio 2 Port B”
The +/- and center buttons work for this configuration.
The K4 spectrum is currently only supported as Radio 1
It would be worthwhile to make the K4’s address a static address in your router so that it does not change over time.

For those who own Win4YaesuSuite

In addition to generic SDR solutions, for those who own Win4YaesuSuite (http://yaesu.va2fsq.com/) software, plus hardware
as described below:

LP-PAN plus stereo sound card (FTDX5000 or FTDX3000 only) – connect LP-PAN to IF Out, see Win4YaesuSuite
documentation for software setup
SDRPlay (RSP1 or RSP2) – connect SDRPlay to RX out or IF out (depends on radio model), see Win4YaesuSuite
documentation for hardware and software setup

Waterfall Bandmap Software

https://groups.io/g/waterfallbandmap

SDRPlay, FunCubeProPlus, HackRF, LP-PAN, SDR-IQ, RTLSDR, SoftRock, etc. – SDRs and panadapters that
produce I/Q output either via ExtIO.DLL or via a sound card can be used together with almost any transceiver using
the Waterfall Bandmap software program
The SDR may be connected to an antenna, to an RX Ant output on some transceivers, or to an IF output on
transceivers that have an IF output. Note that if the SDR is connected directly to an antenna, an external TX/RX switch
may be required to protect the SDR against RF from the transmitter.
Start the Waterfall Bandmap program after starting the N1MM+ program but before starting the N1MM+ Spectrum
Display window. Configure Waterfall Bandmap according to the Waterfall Bandmap program documentation.
The Spectrum Window should automatically find the spectrum feed if Waterfall Bandmap is already sending it.
Otherwise, start Waterfall Bandmap and do the following

Start a new Spectrum window and select “For all other radios, source named…” as the source. Waterfall
Bandmap should already be transmitting its identifying information, so when you go to choose the source, pick
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Waterfall Bandmap from the drop-down list (if the list does not already contain Waterfall Bandmap, type it in)
If you find “smearing” of the blue spectrum lines while tuning, use the right-click option “Reduce spectrum smearing
while tuning” to clear spectrum data each time the frequency is changed. This is needed because the source is getting
the radio frequency information after the spectrum window gets it.
RF or IF > SDR/panadapter > Waterfall Bandmap > N1MM+ Spectrum Window
SDRPlay

In Waterfall Bandmap, after choosing the SDRplay ExtIO dll in the text box at the top of the window, select
Configure and set the SDRPlay’s IF Mode to Low IF and the IF Bandwidth to 200 kHz. Adjust the LNA & gain
controls to limit the amount of noise generated when strong signals are present. The noise will appear as traces
in the waterfall, but there are no signals there. The traces will occur coincident with the strong signal transmitting
and will occur at various places in the spectrum. The SDRPlay has very high gain to work with short, inefficient
antennas, but you don’t need that much gain with a beam or full size dipole.
Use a USB 3.0 controller for the SDRPlay. If you find that mouse & keyboad operation is affected, you may want
to put the mouse & keyboard on the same or different USB 3.0 hub. You will have to experiment. In addition,
USB 3.0 devices can emit 2.4 gHz interference which may affect your wireless mouse or keyboard.
Use the zoom control in Waterfall Bandmap to set the zoom level as shown in the box on the left hand side of
the spectrum window to about 40 Hz/pixel or less for CW & RTTY and to about 100 Hz/pixel for SSB. Higher
numbers will result in poor signal detection accuracy.

KE9NS PowerSDR

Supports the Spectrum Window as of version 2.8.0.43 (6/29/17)

http://ke9ns.com/flexpage.html

Start PowerSDR before starting N1MM+
The Spectrum Window should automatically find the spectrum feed if it is already sending it. Otherwise, start
PowerSDR and do the following

Start a new Spectrum window and select “For all other radios, source named” as the source. The radio should
already be transmitting its identifying information, so when you go to choose the source, pick the source you
want from the drop-down list

CW Skimmer version 2.0

http://www.dxatlas.com/cwskimmer/

In CW Skimmer’s Settings window, select the Network tab and check the “Send Spectrum via UDP” box to send
spectrum data to the N1MM+ spectrum window. Set the Source Name to “CW Skimmer”, the Destination Address to
127.0.0.1 (unless CW Skimmer and N1MM+ are in different computers), and the Destination Port to 13064.
In the Spectrum window, select “For all other radios, source named” as the source and pick “CW Skimmer” from the
drop-down list (or type it in if it is not already there).

Other vendors TBD

Start the source before starting the N1MM+ spectrum window
The Spectrum Window should automatically find the spectrum feed if it is already sending it. Otherwise, do the
following

Start a new Spectrum window and select “For all other radios, source named” as the source. The source should
already be transmitting its identifying information, so when you go to choose the source, pick the source you
want from the drop-down list

Users have reported success with these SDRs & their associated Extio dll:
Hack RF One & ??.dll
QS1R

Layout

Spectrum Pane

The spectrum is displayed in the top or right-hand pane, depending on the orientation you choose. Since the option
defaults to “Auto” the orientation will change depending on the dimensions of the spectrum window

Waterfall Pane

The Waterfall pane, when the show waterfall option is selected will appear at the bottom or left of the spectrum pane.
Note that in portrait (or bar-chart) mode, the waterfall moves from right to left so that one can see the start and stop of
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sending and potentially read cw for sources that refresh at a rapid enough rate.

Spectrum Source, Source Options, General Options Panes

Click the gear icon to access

This dialog is accessed by clicking on the gear icon button at the top right (just below the font sizer arrows) to open or
close it

Spectrum Source Pane
Choose one of the sources. The requirements for these are described at the beginning of the Spectrum
Window help pages.

Source Options Pane
This pane shows options relevant to the selection made in the Spectrum Source pane.
ExtIO.dll name is the name of the hardware vendor provided dll to be loaded by N1MM SDR Server
External Source Name is the name that N1MM SDR Server or an External source identifies it’s spectrum
data with. Once a source starts sending its data, the combo box includes sources that are currently being
heard. For N1MM SDR Server, the source name defaults to the extio.dll name.
SDR Server refers to the local or remote N1MM SDR Server running and serving up spectrum data. The
default port for Radio 1 is 13065. The default port for Radio 2 is 13066.
Note that N1MM SDR Server can be running on a different computer, but must be started manually. If it
runs remote you must ensure that the port specified above can send UDP to the server. In addition, you
must ensure that the server can send UDP to port 13064 on the receiving N1MM Logger+ computer
Frequency bins refers to the number of I/Q samples to be processed. The higher the number of samples,
the more sensitive the SDR display is and the narrower the range of frequencies displayed. This interacts
with your SDRs sample rate.
Sample rate is the SDR’s reported sample rate

General Options Pane
Display bins affects the kHz displayed in the spectrum. More bins use more CPU.
Choose Radio 1 or Radio 2 depending on which radio (or vfo) you want to control this spectrum
Spectrum Orientation is best left on Auto. If your spectrum is wider than it is tall, it will display a horizontal
spectrum. Otherwise, it will display a vertical spectrum. This option can override that default.
Show these Spots: Telnet spots and local spots can be displayed on the spectrum display. This combo
box allows you to select which categories of spots you want to see.
Show only spots you can hear: The program tests each spot to see if there is a detected signal, as
indicated by red signal markers within the user defined tuning tolerance for the mode. If no signal is
found, the spot is suppressed
Show red signal markers: The program inspects the signal levels shown on the screen and if a signal
rises above the mouse-wheel defined signal threshold (blue dashed line) it marks each signal at the
bottom of the spectrum display. This control allows you to choose additional criteria for which red makers
to show relating whether a signal is unknown (no spots within tuning tolerance), and whether a signal is a
mult, Q or non-workable.

Simple Setup Guide for Spectrum Window

General Settings

Keep noise level low: Adjust the radio’s menu setting (ref level) to keep (“grass” level) low in the spectrum display
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Automatic spectrum scope: For supported Icom and Flex radios, the spectrum scope is turned on startup and turned
off on exit
Opening the first spectrum window: Go to the “Windows: menu in the Entry Window “Windows” to open the
Spectrum Window.
Opening additional windows: Right-click in the Spectrum Window to create additional windows

Controls Overview

With focus set on the Entry Window, Shift+up moves the frequency to the next signal up in display. Shift+down moves
the frequency to the next signal down in the display.

If you use the spectrum display in the vertical (bar chart) orientation, there is a right-click menu option to change
the whether low frequencies display at the top or bottom. The bandmap(s) are changed to match.

Show signals shows all the signals the window has identified on the frequency axis using your multiplier background
color. These signals are also counted in the box that shows the noise floor and pixel width in Hz.
Shift+up/down  *skips* signals that are within tuning tolerance of dupes and non-workables, depending on the options
you have chosen in the setup pane.
Shift+up/down stops at the low and high frequencies in the spectrum. If you are using center mode, the spectrum re-
centers on the low or high edge frequencies as appropriate
Use the up/down keys to fine-tune signals. If the tone is too high, press the down key. Use the up key for signals too
low in tone (depends on the sideband in use, i.e. CW-R is opposite to CW).
Sig (db) is level of signal as shown on the display, relative to ref and includes the preamp level
Snap to sig – when checked jumps to the nearest signal when you click on the chart. (within 2 kHz). No effect when
clicking on the waterfall.
The noise floor threshold is adjustable with the mouse wheel.
Signal count is the number of “signals” found above the noise floor reference. Roughly equivalent to how many times
your cursor stops traversing the screen. The count includes non-workable spots.
To mark signals that you don’t want to work, use the Mark button (Alt+M to mark, Alt+D to remove)
The Static Sensitivity slider should be adjusted until large static crashes light up the “Static Sensitivity” label
Left single click on the spot label QSYs your Rx & Tx to the frequency of that spot – including split. If you have the
noise floor, source level and static sensitivity set properly, you will find that clicking on the spectrum will usually tune the
signal more accurately than a cw spot. Note that you must have “snap to signal” turned on for this effect.
+/- zooms the spectrum in/out. Not all SDR sources support this function. If not supported, the +/- boxes are hidden.
These zoom boxes appear under the threshold/sigs/Hz box.
Alt+Q returns to your CQ frequency. Alt+F8 returns to your last frequency
The CQ button displays up to five recommended CQ frequencies. These represent the frequencies with least signal
content above the signal threshold. This level is computed with a 60 second decay time constant. It changes to Clr after
being pressed. If pressed again, the markers disappear. Pressing a function key also removes the markers. While the
markers are present the Shift+Up/Down keystrokes jumps from one candidate CQ frequency to another in frequency
order. The numbers indicate the rank of the frequencies from 1-5.
Right-click on the CQ button jumps to the next available CQ frequency above the current frequency.
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CQ Frequencies

Mouse (see also the Strange and Mysterious Mouse Wheel, below)

Left click set sradio receive frequency and snap to closest signal if check box is checked
Ctl+left click sets split frequency to that frequency. Snap to signal is ignored

The Strange and Mysterious Mouse Wheel

The mouse wheel is used for a number of functions in the Spectrum Window. Lets look at them by pane:

Spectrum Pane
When the mouse is over the main portion of the spectrum, the mouse wheel controls the noise floor. You will see
the blue dashed line move up and down
With Icom radios, holding down the Ctl key while moving the mouse wheel in the main portion of the spectrum
window controls the REF level of the radio’s spectrum
With the N1MM SDR Server, Airspy HF+ and SDRPlay, holding down the Ctl key while moving the mouse wheel
in the main portion of the spectrum window controls the level of the spectrum. Scrolling all the way down sets the
level to Automatic
With the Airspy HF+, moving the mousewheel when the cursor is over the frequency scale and the Airspy
scrolling mode is Fixed, shifts the spectrum frequency
When the mouse is over the contrast slider, it controls the color of the Waterfall in the pane below. Yeah, I know
it belongs in the Waterfall pane, but it flickered badly. You’ll like it better where it is
When the mouse is over the static sensitivity slider, it controls how much static is detected and discarded. Static
does not show in the waterfall
When the mouse is over the main portion of the spectrum window, Ctrl+Shift+Mouse Wheel controls the dB
range displayed.
When the mouse is over the + or – zoom boxes, the mouse wheel zooms the display to its limits

Waterfall Pane
When double vertical bars are displayed, and the mouse is in the Waterfall pane, moving the mouse wheel tunes
the radio. Adjust the CW/SSB/Digi tuning values in Configurer/Other tab to your liking and the speed of your
radio’s CAT. The frequency as you tune shows in the lower part of the Waterfall. Note that this is the radio
reporting back the frequency, so depending on the radio there may be a little lag or a whole lot. If you press Ctl
or Shift while turning the mouse wheel, the radio makes larger frequency jumps, just like it does in the Entry
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Window. The main purpose of this tuning is to allow you to fine tune a signal after clicking on its trace in the
Waterfall

The Right-Click Menu

Spectrum Right-Click Menu

Right-click opens a context menu
Windows – lets you choose between spectrum windows that have been configured

Open a new window – to create a new spectrum window
Permanently Delete this window – close this window and delete its configuration. It will no longer show in the
spectrum window list. For use when you have created multiple spectrum windows
Spectrum Source – Sources heard by the software will be shown as choices. Until a source name shows up in
that drop-down menu, it will not display, or will be greyed out, as it is not bes
Relay Options – allows you to provide the spectrum displayed in this window to another N1MM Logger+ user.

Do not relay this spectrum (default)
Broadcast on IP ports(s)… – Enter list of IP addresses: data is sent to the user specified IP & port. The
only port that N1MM+ will listen on is 13064, so only use another port to provide port forwarding with a
router at another site
Name of this source – the name which the other N1MM Logger+ user will use to access this spectrum
source

Reverse frequency scale in bar chart mode – if you check this option, the low frequency of the spectrum will
be at the top, matching the way the band map is oriented
Show Waterfall – controls whether the waterfall is displayed. When the waterfall is displayed the current radio
frequency will appear in the waterfall pane. When it is not displayed, the current frequency appears in the
spectrum pane
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Show Noise Floor as Line – This is effective only in column (landscape) chart mode. Instead of columns, the
instantaneous signal values will be shown as a line and the (decaying) average values that exceed the noise
floor will show as a filled line series
Snap to Signal – When on, clicking on the spectrum will jump to the nearest signal center rather than to the
precise point which you click. It will look +/- 2 kHz for a signal
Show Stats – shows information that the window has collection about the currently displayed spectrum. It will
remain for 25 seconds, or click on the X to hide it
Signal Decay Speed – Controls how fast the blue signal indicator lines decay. For SSB, if you set the signal
decay speed to fast, it will find signals more accurately, but skip signals not transmitting at that instant. Use fast
for SSB and crowded conditions, slow for quiet bands.
Round SSB Sigs to nearest 0.5 kHz – experimental option to help with regular dxing. This is not expected to
be useful in a contest. Non-sticky to prevent its inadvertent use during a contest
Only Jump to Signals Heard in the Last Second – Shift+up/down will ignore any signals that are not currently
transmitting (experimental)
Toggle Background Color – to toggle to higher contrast backgrounds – both white & black. Black background
is the most readable.
Allow Setting Fixed Edges (Icom only) – If the spectrum source is an Icom radio, you can force the displayed
spectrum not to extend outside of the amateur band. Greyed out for other spectrum sources
Scrolling Options – Not available for all spectrum sources; greyed out when not available. For other sources,
bandwidth and scrolling options are controlled by the spectrum data source (for example, by the application
program that is providing the spectrum data to N1MM+). When this option is available, it offers four submenu
choices:

Center Mode – Centers the spectrum display on the current frequency, i.e. the spectrum bandpass
moves as the frequency is changed. The center button is hidden in this mode.
Fixed Mode (with scrolling) – The spectrum display range stays fixed, centered on the initial frequency,
except that if the frequency is moved outside the currently displayed bandpass, the center jumps by an
amount equal to the displayed bandwidth so that the current frequency is inside the displayed bandpass.
Fixed Mode – The spectrum display range stays fixed and does not move when the frequency is
changed. Set the frequency with the center button or the “Set fixed frequency” right click menu. (See
below.)
Respect Mode Subbands – Restricts the display to show only the subband for the current mode (from
the Bandmap window settings)

Set fixed frequency – Allows you to set the frequency for “Fixed mode above”. This is useful for monitoring a
band that you are not yet operating on.
Show Instantaneous Signal Levels – Hides/shows the noise that does not peak above the signal threshold (blue
dashed) line. Makes the display less distracting.

Remove this spot – does what it says, but is only enabled when you hover over a spot in the spectrum panel of
the window.
Reset Radios – Sends the commands to reinitialize the radios connected to the program (similar to the same
option in the Bandmap window). This will often restart the spectrum display on a supported radio.
Help – link to this documentation

Colors

White is the instantaneous signal level as shown in white on the radio (black on light color skins)
Blue is a “decaying” representation of the signal *similar* to that on the radio
The green line is the current Rx frequency
The horizontal blue line is a measure of the noise floor above which signals are found
The vertical red line, if shown, is the tx frequency when split

Operation

* Adjust the REF level on your radio (or equivalent in your source) and the mouse-wheel noise floor to the point
where the number of signals counted drops suddenly from a high number to a reasonable one. The noise floor is
adjustable in 0.2 dB steps from 0-1 dB and in 1 dB steps thereafter. Check that you don’t have the noise floor too
high by tuning for a weak signal

Use the mouse wheel in the chart area to adjust the noise floor. You will see the number of sigs change as you scroll
the blue line. If a blue or white signal is above the floor, Shift-up/down will jump to that signal. The noise floor value and
# of signals detected are shown in the box near the dB scale.
Also shown in the little noise floor/signal box is the number of Hz represented by one pixel of incoming data. Note that
to see all the incoming pixels, you need to make the graph area of the spectrum window greater than the number of
pixels. The number of Hz per pixel affects how many signals can be found. If you have a source generating pixels
greater than 100 Hz apart you may lose the ability of the program to find some signals as they are not represented in
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the source data stream. The size of the spectrum window does NOT affect the finding of signals. That is always done
with the incoming source data, not the data as displayed
If you are short on screen space, Ctl-up/down does not need the old bandmap to be open to work. You can use this one
instead
Turn off “snap to spot” if you find it is interfering with you clicking on signals. You don’t need it if you are zoomed way in
as you would often be in center mode
For DX split operation, use Ctl+click to set the Tx frequency to the point where you think the dx op will answer the next
caller. That might be the frequency of the last station that worked him or it might be higher or lower
Pro Tip: Try setting your up/down tuning increments in Config/Config Ports…/Other to match your preferred zoom level
for your spectrum as seen in the left-hand box in the spectrum display. For example, if you like CW resolution at 42
Hz/pixel choose .021 as your up/down increment. For SSB and 105 Hz/pixel, you might choose .0525 as your
increment. By choosing multiples, you will minimize jitter in the waterfall display that results from imprecise changes in
tuning. Doing this only helps when using the up/down keys to tune or the mouse wheel equivalent.

Relaying and Port Forwarding

The Spectrum Display window can forward the data it receives to another spectrum display window. The other spectrum
window can be running in the original instance of N1MM+ or in N1MM+ running on any computer that is reachable via UDP
packets. The forwarding computer only sends its spectrum display data: band, frequency, signal strength, display name,
scaling factor. The destination instance of N1MM+ is responsible for display settings, the noise floor, and capturing packet
spots.

Step 1. Preparing the source instance of N1MM+ to forward its Spectrum Display window

Using your mouse, right-click in the Spectrum Display window to be forwarded
From the right-click menu, select > Relay options > Name of this source
Enter a unique name for this Spectrum Display window. For example, “20M Radio”

Step 2. Preparing and launching the destination Spectrum Display window

Choose one (or more!) of the following options

Option1. Local Forwarding to a second Spectrum Display in the same instance of N1MM+ (you have only one
computer)

Using your mouse, right-click in the Spectrum Display window to be forwarded (the source window)
From the right-click menu, select > Relay options > Broadcast on IP/port(s)
Enter an IP address of 127.0.0.1
To open the second spectrum display, right-click in the source spectrum display
From the right-click menu, select > Windows > Open a new window
In that new window, right-click and select > Spectrum Source > Source named
Choose the source name that you assigned in the first step of this process. In our example “20M Radio”

Option 2. Forward a spectrum to another computer on the same LAN (you have more than one computer)
Using your mouse, right-click in the Spectrum Display window to be forwarded (the source window)
From the right-click menu, select > Relay options > Broadcast on IP/port(s)
Enter the IP address of the destination computer. For example 192.168.1.123. You can run IPCONFIG in a cmd
window to determine the destination computer’s IP address
If N1MM+ is already running on the destination computer, close and re-launch N1MM+
To open a spectrum display window on the destination computer, from the drop-down N1MM+ menu on the
destination computer select > Window > Spectrum Display
In the destination computer’s spectrum display, right-click and select > Spectrum Source > Source named
Choose the source name that you assigned in the first step of this process. In our example “20M Radio”

Option 3. Forwarding to remote instance of N1MM+ (you have more than one site)
Using your mouse, right-click in the Spectrum Display window to be forwarded (the source window)
From the right-click menu, select > Relay options > Broadcast on IP/port(s)
Enter the IP address of the remote destination computer. For example 71.233.1.123. From a browser on the
remote destination computer, entering “my ip address” will tell you your external IP address
Set up port forwarding on the router of the remote computer LAN to route incoming port 13064 to 13064 on the
destination computer
If N1MM+ is already running on the remote destination computer, close and re-launch N1MM+
To open a spectrum display window on the remote destination computer, from the N1MM+ drop-down menu on
the destination computer select > Window > Spectrum Display
In the remote destination computer’s spectrum display, right-click and select > Spectrum Source > Source
named
Choose the source name that you assigned in the first step of this process. In our example “20M Radio”

Option 4. Forwarding to 2nd remote instance of N1MM+ (you have more than one computer at a remote site)
Using your mouse, right-click in the Spectrum Display window to be forwarded (the source window)
From the right-click menu, select > Relay options > Broadcast on IP/port(s)
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Enter the IP address of the second destination computer and specify a different port. For example
71.233.1.321:13900. (cannot be any port currently in use)
Set up port forwarding on the router of the remote computer LAN to route that new incoming port to port 13064
on the second destination computer
If N1MM+ is already running on the second destination computer, close and re-launch N1MM+
To open a spectrum display window on the second destination computer, from the N1MM+ drop-down menu on
the destination computer select > Window > Spectrum Display
In the second destination computer’s spectrum display, right-click and select > Spectrum Source > Source
named
Choose the source name that you assigned in the first step of this process. In our example “20M Radio”

Note that Broadcast on IP/Port can be a comma separated list of IP addresses. For example:
192.168.1.1,79.235.146.132:13064,29.235.146.132:13900 (separate with a comma, but no spaces)

Netgear Routing Example
In the example above, external port 13064 is being routed to port 13064 on the computer with IP address 192.168.1.7 on the
LAN. (Line 3 “Spectrum”). This menu is accessed from Netgear’s Advanced/Advanced Setup/Port Forwarding & Port
Triggering selection.

Frequency & Mode Forwarding

If you want one instance of N1MM+ (e.g. a “slave” instance on a computer that is the source for spectrum data but
that is not directly controlling the transceiver) to follow another N1MM+ instance’s frequency & mode (the “master”
instance that is interfaced to the transceiver), you can forward the master instance’s broadcast data (in the
Configurer broadcast tab) to the slave computer’s IP address, port 13064. You will have to open this port on the
destination computer’s network router if the destination is at a remote site or just using a different router.
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Notes

With most SDRs, if you feed a narrower bandwidth slice to the spectrum display, less noise will be sent as well. Try to
use wide bandwidths only on quiet bands where you want to scan the whole band for new signals
Gaps will appear at the beginning and end of the center mode spectrum display if you are not currently tuned to a
whole kHz frequency. This is normal
If your radio is turned off or not configured properly, you may need to close the spectrum display or perhaps close the
program and reopen to get the display to work
We are focusing on CW and RTTY operation. You can play with other modes, but bear in mind little work has been put
into making the window play nice with them
In SO2V only, the second VFO will be shown with a line in your skin’s highlight color
Use Fast signal decay for SSB signal detection. Slow signal decay can be used with CW & RTTY to keep signals on
the screen longer.
If you detest the tool tips, you can turn them off at the bottom of Config/Manage Skins, Colors and Fonts
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SDR Block Diagram
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This picture represents non-I/Q support.
For I/Q supported radios (SDRPlay, Airspy HF+ via ExtIO, IC7610 via FTDI), the FFT occurs within N1MM+.

SDR Block Diagram in SO2R Station

(Thanks to N6TV for the use of his diagram.)

Note: You need to set both radios to listen on the Rx antenna in order for the SDR to receive signals from the transmit antenna
during receive. Rx in is where you normally put a receive antenna input. Rx out is connected to the transmit antenna when the
radio is receiving.

If you want to allow for a receive antenna in the above configuration, connect the common port of a two position coax switch to
the common port of the power splitter. Connect one of the switched ports to Rx Out and one to the receive antenna.

3/4/25, 5:37 PM N1MM Logger+ Documentation



328

The Statistics Window
2019-04-13

The Statistics Window
The Statistics window can be found under View > Statistics in the Entry Window. New in N1MM Logger+ is provision of
graphical as well as tabular presentation of data. Select either by clicking the tabs at the top of the screen.

Or you can present the same data in graphical form. Be forewarned, this is not a PJ2T log – that call is just an example.
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The graphical representation really comes into its own when the data are more complex. For example, if you want to know at
a glance which bands were most productive when, graph hours versus bands.

Typing with the Statistics Window open
During a contest, if you are checking Statistics and a station comes back, just start typing. The statistics window will
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General

The Statistics window allows you to select almost all database fields from a contest for display in tabular form by row and
column, or in graphical form. The following table explores the options and their usefulness in various contexts.

Fields Row Column Remarks

Band Y Y –

Operator Y Y compare operators. Only useful when running Multi-operator

Hour Y N –

RadioNr Y Y only useful when using more than one radio

Mode Y Y useful in mixed contests

CountryPrefix Y N worked number of stations per country or mode

Zone Y Y –

Section Y Y used in many domestic or local contests – may equate to province, oblast, ARRL section,
etc., depending on the contest

CK Y N 2 digit number used in Sweepstakes, formally denoting the year first licensed

Prec Y Y Precedence used in Sweepstakes to denote class of entry

Points Y Y –

Mult1 Y Y multiplier, or first multiplier in contests with more than one

Mult2 Y Y Second multiplier in contests with more than one

Mult3 Y Y Third multiplier where applicable

WPXPrefix Y N prefix as determined by WPX rules

GridSquare Y Y 4-character of grid square

Run1Run2 Y Y useful when doing SO2R

MiscText Y N Contest specific information

ContactType Y Y Blank = qso, “D” = dupe, “N” = non-workable or zero-point station (same country in
CQWW, for example)”

IsRunQSO Y Y To find out how many QSOs were made while running, rather than S&P.

Day Y Y first or second day of the contest

Mode & Band Y Y –

Exchange1 Y Y Use in some contests (like WAE to show QTCs)

go to the background and every typed character will go to the Entry window.

Old Contest Data
Old contests may not have valid values in fields that have been added since the contact was logged. The number of
contacts shown on screen and printed on the summary sheet are without dupe contacts.
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File Menu

Copy All – Copy the contents of the window to the Clipboard, either as text or as a graphic
Print – Print the statistics table to a printer. Font can be set by user. Also prints graph displays if supported by your
printer
Print to File – Print the statistics table to a file. This function is greyed out when a graph is being displayed.

Example Statistics

Try these examples with an old log:

Row Column Usage Description

Country Prefix Band Always QSOs per country per band

Hour Operator Multi User QSOs per hour per operator

Band Operator Multi User QSOs per band per operator

Grid Square Band Grid contests QSOs per gridsquare per band

Band Exchange1 WAE and some other Show RQTC and SQTC info
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The Telnet Window
2019-04-13

The Telnet Window
Your Telnet window will be similar to this one, with six tabs.

The textbox labeled “Type:” is where you can input any text commands to send to the cluster. For example, typing “bye”
without the quotes and hitting Enter will disconnect you from most clusters.
The “Reconnect” button will re-establish your connection to the cluster shown on the label of the first tab (see below).
Note that if you change clusters under the “Clusters” tab, you must use the “Connect” button under that tab to establish
a connection with the new cluster before using the “Reconnect” button.
A font sizer is at the upper right, just below the “X” to close the window. Click the up or down arrows to change the size
of the text in the text pane below.
The text pane is where all messages from the Telnet cluster will appear. Click in the text pane to temporarily halt
scrolling; move the mouse cursor out of the text pane to restart it.
All incoming information from the connected DX cluster is displayed in the text area of the Telnet window. They are
color-coded by mode – defaults are blue for CW, magenta for digital, and black for SSB. Spots forwarded to the
Bandmaps and Available Mults & Qs window are filtered as provided on the Filters tab. Spots that are filtered out (not
forwarded) are greyed out in the text area.

Split information given in the spot comment will be recognized and forwarded to the Bandmaps and Available window. When
such a spot is selected the transceiver will go into split mode (if applicable). The program recognizes: UP, U, DOWN, DN, D
and the word QSX. Examples: QSX 3.838, QSX 4, UP 5, DOWN 2, U 5, D4, U4, DN4, UP4, DOWN4, QSX7144 etc.

Telnet Window Tabs
There are six tabs above the text pane, which is displayed by default and also tied to the left-most tab, which always displays
the call-sign of the currently-selected cluster.
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Current Connection Tab

The first tab displays the name of the Telnet cluster node to which you are connected, and opens the lower pane so that you
can see the flow of spots from the node. Except as noted, any changes made on the other tabs take effect when you switch
back to this tab.

Clusters Tab

Telnet Window, Clusters Tab

Choosing a Cluster

The Clusters tab is used to select a cluster from two sources:

The Live Cluster list contains the names of clusters that N1MM+ users have recently reported as exhibiting acceptable
availability and performance. The names of the clusters will be sorted alphabetically by continent. If you only want to see
names of clusters reported by users on your continent, click the [__ only] checkbox. You can read more about the Live Cluster
list HERE.

The Stored Cluster list contains a static collection of cluster names, some of which may no longer be available. The Edit List
button opens a new edit window where you can make changes to the list and customize it to your preferences. You can also
import or export the list of clusters from/to a file using the File menu in the edit window. By default, these files are stored in the
ExportFiles folder in the N1MM Logger+ user files area.

Cluster Keep Alive interval (minutes) – sends ” ” <cr> to the cluster every N minutes to prevent cluster from assuming you
are no longer using it.

Also on the tab:

A checkbox to tell the program to automatically log on to the selected cluster whenever the Telnet window is open.
A checkbox to format some commands properly when you are connecting to a DXSpider cluster.
A “Logon with” field, where you fill in the callsign the cluster is expecting to see at logon.
A “Show Telnet Buttons” checkbox. Uncheck it to reduce the size of the Telnet window as much as possible, saving
screen space.

Use the Stored Cluster List as “My Favorite Clusters”
The default Stored Cluster list contains 251 sites – some of which are unavailable and many that you will never use.
After identifying your favorite cluster(s), delete the surplus sites in the list so that you can quickly select only the ones
you prefer.
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A “Connect” button that will send the logon sequence to the selected cluster and return you to the Telnet window’s
Current Connection tab. When changing clusters, you must use this button to change the cluster, at which time the
name of the cluster displayed in the Current Connection tab will change.

Problems Connecting to a Cluster Site

If you cannot connect to a cluster check the following:

Edit the clusters list and make sure that the domain name of the cluster is correct.
Edit the clusters list and make sure the port of the cluster is correct and it is separated from the domain name by a
colon (:), e.g. k1ttt.net:7300
When changing clusters, use the “Connect” button under this tab to make the initial connection to the new cluster; until
you have done this, the “Reconnect” button on the Current Connection window will continue to point to the previous
cluster.
Disable your anti-virus software and (re)install the latest update. Test the connection. Re-enable your anti-virus
software.
Check your software firewall to make sure N1MM Logger+.exe is allowed to connect externally.
Check your hardware firewall to make sure that connecting to port 23 (default) or port nnnn (as specified in the cluster
list) is allowed.
Try testing using the Windows Telnet program to connect. For Windows 10 or 11, you can enable Telnet by going to
Programs and Features, Turn Windows Features on or off, select Telnet client and press OK.
Connect via Telnet by issuing the following command in the Windows command box next to the Windows button: Telnet
, e.g. Telnet dxc.w9pa.net 7373 If this connects, it means that you have the wrong dns or port, or that something in your
machine is blocking N1MM Logger+ from connecting.

Connecting to Telnet from a multi-computer network

If you are using N1MM Logger+’s networking to connect multiple computers together in a network, only one of the computers
in the network (the one designated as “Master”) connects to a Telnet cluster. The other, non-Master computers need to have
their Telnet windows open to receive spots from the Master computer, but they do not connect directly to a Telnet cluster.

Importing a Downloaded Cluster List

A more recent cluster list is maintained on the the N1MM Logger website under >Additional Support Files. To replace
N1MM+’s default cluster list with a downloaded list:

On the website, navigate to >Downloads >Category Menu >Additional Support Files
Download the latest cluster .txt file, placing the file in your Documents \N1MM Logger+ \ExportFiles folder
Open the Telnet Window, select the Clusters tab, and click the Edit List button
When the Edit List dialog window opens, click on >File >Import and select the file you have just downloaded.

Bands/Modes Tab

The Bands/Modes tab allows you to select which bands and modes will be passed through to the Bandmap(s) and Available
Mults & Qs window. Select bands individually or select groups of bands with the large buttons across the top (“HF”, “VHF”,
etc.). Select mode(s) individually, by clicking the “All” button, or by checking “Contest” to pass only the mode(s) valid in the
current contest. The “Reset All Defaults” button will check every band and mode.
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Note that if any of the check boxes in the mode column is/are checked, spots for that or those modes are the only ones that
will make it through the filter. The sub-bands set up in the Bandmap window for CW, Digital and SSB can have a major effect
on this, too. Any spot that does not have its mode mentioned explicitly in the spot notes will be assigned a mode based on its
frequency relative to the Bandmap window band plans, and spots that have been assigned a mode that is not checked will not
be passed through. If spots do not seem to be getting passed from the Telnet window to the Bandmap and Available windows,
check the sub-band definitions in the bandmap as well as the mode and band check boxes in this window.

Filters Tab

The Filters tab provides another set of filters, as well as checkboxes for a few related options.
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Set the desired Bandmap timeout for DX spots by entering time in minutes. Note that spots originating from CW
Skimmers, such as RBN spots, will automatically time out after 20 minutes, or the spot timeout value, whichever is less.

Save Spots

The “Save Spots” checkbox is a new feature, added to solve an issue with packet spot processing that caused the spots
database (Spots.s3db in the Databases folder) to grow too large and impact program performance. If you are experiencing
symptoms of this, check the size of your Spots database. If it is more than a few MB, that may be why.

The “Save Spots” box is unchecked by default, and if left that way, the Spots database is not used at all. The advantage is
very low performance impact from Telnet use. The drawbacks are that when you restart N1MM Logger+, the Bandmap will be
empty. The check for Telnet spots in the Check window will not be active, and the “Spotted” option in the Multiplier window will
not work.

If the box is checked, N1MM+ now honors the Bandmap timeout value set on this tab. For example, if you set the timeout
value at 20 minutes, the Spots database will only retain spots for the last 20 minutes. When you restart NL+, the Bandmap will
only display spots for the last 20 minutes, and the Check and Multiplier windows will only use spots from the last 20 minutes.
The developers are aware that the latter is a slight drawback, and may look at other options after the high contest season is
over.

Show non-workable spots and QSYing wipes call and puts it in the bandmap

These options have the same effects as the corresponding entries in the Config menu in the Entry window. “Show non-
workable spots” will display duplicate or zero-point call signs so you know to tune past those frequencies instead of having to
stop and listen to determine whether the station is workable. The “QSYing wipes” option automates the adding of spots to the
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bandmap when you are S&Ping. If you enter a call sign in the Entry window and then tune away, perhaps because the pileup
is too large at the moment, the call sign will be placed in the bandmap, marked with its multiplier color status, so you can
easily tune back to it later (or avoid that frequency if it is a dupe). If you work a station and then tune away, and if “Show non-
workable spots” is selected, the worked call sign will be placed in the bandmap in grey as an indication that the station on that
frequency has been worked. By default these spots to the bandmap are local only, i.e. they are not sent to the spotting
network unless you have also selected the Config > Spot All S&P QSOs option in the Entry window.

Show only spots that are in call history

This option can be used to limit the spots displayed in the bandmap to call signs that are in the currently loaded call history
file. This might be useful in an event where you are only interested in working certain stations, such as members of a club.
However, if this option has been selected and a different call history file is loaded (for example, by changing to a different
contest), it can result in wanted spots not appearing in the bandmap because the call signs don’t happen to be in the current
call history file. If you are not seeing spots in the bandmap, try unchecking this option to see if it is the cause of the lack of
spots.

Randomize incoming spot frequencies

Automatically adds or subtracts a small amount from the received spot frequency, so as to improve your chances of breaking
a “packet pileup” when you click on a spot.

Spot origin filtering

If you only want to see spots originating (i.e. the spotter’s location) in certain countries or areas, you can use the Filter by
Prefix area to limit the spots to those from your own country, continent or specific call area(s) using the check boxes in the top
row, and/or by entering country or call area prefixes in the text box in the second row, separated by spaces. Beware: if
anything is checked in this section, the *only* spots that will make it through the filters are those that meet the prefix, country
or continent criteria you have checked or entered into the list.

The filtering capabilities of the cluster node are usually more powerful and flexible. Using them also reduces telnet
traffic and the processing load on your computer’s CPU by limiting the number of spots sent to your computer from
the cluster node. Generally, we recommend that you use the spot filtering at your chosen Telnet cluster where
possible.

Spotter and spotted station blacklisting

You can “blacklist” either specified spotters or specified stations spotted, or both. The Edit, Import or Exportbuttons allow you
to create and edit lists of stations whose spots you do not want to see, while the Clear buttons allow you to clear the list and
start over. In both cases, the feature is enabled by a check box, i.e. you can create a list but only enable it in certain contests
or at certain times. This filtering acts in addition to filtering by origin, or by bands and modes, i.e. the various filters are
cumulative.

Preferred Spotters

When enabled, this command permits listing 1 to 3 spotters whose spots you wish to have highlighted in all windows where
spots appear. Enter the preferred spotters’ callsigns in the box, separated by spaces. This is particularly designed to highlight
a local Skimmer if you have one.

As an added touch, the three preferred spotters can each include variations on the base callsign. Hence, listing WZ7I will also
highlight WZ7I-2, WZ7I/3, etc.

Spot Comment Tab

This tab lets you specify a comment for each spot you make (such as “WPX”) and add log data fields to the fixed comment.
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Band Plans Tab

The Band Plans tab formerly permitted setting limits for mode segments within band plans. This function has now been moved
to the Bandmap window, and is accessed by right-clicking on a frequency label (e.g. “7045”) in the Bandmap window.

Nevertheless, even though this function is no longer carried out from the Telnet window, the choice of sub band limits in the
Bandmap window can have a significant effect on telnet spot processing. Spots that do not have a mode designated in the
spot notes will be assigned a mode based on those sub band limits, regardless of whether the Bandmap window is actually
open or not. If the sub band limits are not set appropriately, this can result in incorrect modes being assigned to spots, which
can in turn affect how those spots are filtered and processed, and whether or not the spots are displayed in the Bandmap and
Available Mults & Qs window. The sub band limits are not set based on FCC regulations, as new US licensees might expect.
The appropriate sub band limits vary depending on the nature of the contest (CW vs. SSB vs. digital vs. mixed mode,
domestic vs. DX contest). It is up to the user to set the limits in the Bandmap window according to the patterns of usage in the
current contest.

For example, in a DX phone contest you might need to set the top of the 40 meter CW sub band very low in the band in order
to ensure that spots of DX stations operating split, transmitting below 7100 kHz and listening higher in the band, show up on
the bandmap and in the Available window. On the other hand, if you leave this same setting in place for a CW contest, that
could result in CW spots being missed because the program assigns unlabeled spots of CW signals to SSB. To prevent this,
you will need to manage the location of the CW vs. SSB sub band limit in order to ensure that it is consistent with the current
situation.

If you want to use spots for a digital contest, you may need to define digital sub bands for each band in the Bandmap window.
On 40 meters, the appropriate location of the digital sub band will depend on whether the contest is a DX contest or a
domestic North American contest. After the digital contest is over, if you don’t remove or adjust the digital sub band, some CW
spots might get missed because the program assigns a digital mode to them based on the sub band limits in the Bandmap
window.

Sending Stored Commands to the Cluster
Across the bottom of the Telnet window are twelve buttons which can be individually programmed with stored messages to be
sent to the Telnet node. Right-click in the button area to bring up the editor.
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Different button sets can be saved and recalled for use with the File menu at the upper left. By default the text files containing
sets of button messages are stored in the FunctionKeyMessages folder in the N1MM Logger+ user files area.

You can also use one or multiple buttons to store a quick-connect command to connect to a specific telnet cluster. The syntax
expects a ‘{CONN} node’. Example: Assuming you have added a cluster with the name RBN to the list of clusters, you can
assign it to a button by adding ‘{CONN} RBN’ to a button value.

Mouse Clicks

When the you left- or right-click in the text area, scrolling is stopped. A right-click on a callsign brings up a small menu

Click on “Jump to this spot” to send the active radio to the spot frequency. This option is mainly retained for nostalgia. It makes
far better sense to click in the Bandmap or the Available window while maintaining the Telnet window minimized, once you
have the filters, bands and modes set up as you want them.

Multi-User Setup
When running in networked computer mode, only the Master station has to be connected to the DX-cluster. The master station
will relay all information to and from the connected computers to the cluster node.

CW Skimmer and the Reverse Beacon Network (RBN)
CW Skimmer version 1.1 and up has a built in Telnet server which allows N1MM Logger to receive spots from it. Add an entry
to your Telnet list with the address: 127.0.0.1:7300 if you are running Skimmer on the same machine as N1MM Logger. If
running on a different PC on the same network, use that machine’s internal IP address in the same format.

The Reverse Beacon Network’s Telnet relay servers make all of the RBN’s Telnet spots available to users worldwide. Because
of the huge volume of spots on a major contest weekend – at least fifty times as many as the conventional cluster network –
we highly recommend that you connect to a “retail” server and use the node’s filtering capabilities to manage the quantity
actually sent to you.

Spots originating from CW Skimmers, such as RBN spots, will automatically time out after 20 minutes, or the spot timeout
value, whichever is less.
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Because of the high volume of spots, the RBN uses specially-designed relay servers on its Telnet nodes, which are internally
streamlined. A side-effect is that these nodes do not respond to user commands. This is another good reason to
connect to a “retail” cluster that handles both RBN and traditional spots. You can find a list at this site .

Local Skimmer spots can be merged with spots from conventional DX clusters using software such as WintelnetX or CC User,
freeware by K1TTT and VE7CC respectively. Skimmer spots are distinguished from regular spots by the addition of unique
markers. In the Bandmaps, Skimmer or RBN spots are identified with “#” after the callsign and bearing; spots from your own
Skimmer, identified by the callsign set in your Station Data), are marked with “!”

Spot Filtering
There are three levels of spot filtering available. The first and most powerful of these using whatever filtering capabilities are
built into the node. The second is established by the Band/Modes and filters tabs of the Telnet window. A third is set by the
Available Mults & Qs window’s Bands and Modes button. The latter only affects what is seen in that window.

AR Cluster V6’s Skimmer Spot Quality Filtering

Because of the large volume of spots generated by the RBN, even at very high accuracy rates (over 99 percent), a large
number of busted spots have been noticed. Toward the end of major contests, these may be a significant problem for serious
competitors. In addition, calibration and image errors are occasionally encountered due to hardware and software issues.

CT1BOH has developed and AB5K has implemented DX cluster-based evaluation of spot quality, in an effort to reduce the
number of bad spots seen on the RBN. This nice piece of work was implemented in Version 6 of AR Cluster. AB5K.net was
the first node offering this feature, and many more now have it too. You can find an exhaustive list at this web site.

The evaluation is subdivided into 3 categories:

Validation – When a callsign is first spotted on a given frequency, it is tagged with a “?” in the last column of the
Comment field of the spot. When two or more other RBN nodes agree on the spot, the tag on each subsequent spot
becomes “V”
Frequency – After a station has been spotted on a given frequency, if it is then spotted on another frequency the spot is
tagged as above, but with a “Q”, for QSY? Again, once the move is confirmed, subsequent spots are tagged with V. The
idea here is to catch I/Q image spots, spots sent by badly-calibrated Skimmers or spots inadvertently sent on the wrong
band.
Busted Spots – This is the real high point of the Quality Tags. The algorithm uses some sophisticated measures of the
“resemblance” between the busted spot and the real one, and will tell you both what spots are busted and what the real
call is, based on other spots at or very near the same frequency.

Here is a brief snapshot of one minute of RBN plus traditional spot flow.
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You can see that the node software picked up two busted spots, and also was skeptical about others until they were repeated.
There are no QSY spots in this sampling, but if there had been, you would have seen the “Q” tag.

When you first connect to an AR Cluster, make sure it is sending RBN spots as well as traditional ones by commanding it to
“set dx filter”. Once RBN spots are flowing, you can set any other filters you want to, such as limiting spots to stations in your
geographic area. Then all you have to do is send “set DX extension skimmerquality”, and the Quality Tags will start to appear
at the right end of the Comment field.

Some operators will prefer to filter out certain of these spots. Most likely candidate for this treatment are spots tagged with “B”,
but you can filter out “?” or “Q” spots too, and the node will not send spots of those stations to you until they are confirmed
(and tagged V). Here’s a partial list:

Set DX filter Skimbusted – only send me those spots that are marked as busted, together with the node’s identification of the
correct spot)

Set Dx Filter NOT Skimbusted – don’t send me any spots that are tagged as B

Set DX filter NOT SKimQSY – don’t send me any Q spots until they are verified

Set DX filter Skimvalid – only send me spots that have been tagged with a V

These and other Skimmer-related filtering commands are found in the AR Cluster V6 manual, for example at the NC7J
website in the section called “Set DX Filter”.

One of the neat things about AR Cluster V6 is that you can create complex filters to show you exactly what you want. For
example:

SET DX FILTER {MYCALL} OR (spotterstate=MD OR spotterstate=PA OR spotterstate=VA OR spotterstate=WV)

This filter will tell me whenever I am spotted anywhere in the world, and otherwise will show me all spots, both traditional and
RBN, made by stations in the states around my QTH.

Abbreviating ARC V6 filter commands
While N1MM Logger+’s Telnet buttons will accommodate fairly long commands, stringing together a lot of “state=” or
“cty=”, or “ state < > ” or “ cty < > ” commands could be too much. Fortunately, there is an abbreviated syntax. The
“[entity]=/ < > ” filters can be abbreviated as follows:state=[MD,VA,WV,PA] or CTY=[K,VE,KP4]
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You could add some Quality Tag-specific filters – for example:

SET DX FILTER call={MYCALL} OR NOT skimbusted and (spotterstate=md OR spotterstate=pa OR spotterstate=va
OR spotterstate=WV)

This filter will work the same as that above, but also will not show me any spots that the cluster evaluates as busted.

Here’s another filter that lays on some more complexity, written by CT1BOH and recently published on CQ-Contest:

Set DX Filter (skimValid OR not skimmer or ((SkimQsy OR SkimUnknown) AND (cty < > K AND cont < > EU )))

This filter shows human spots, Skimmer spots appraised as V(alid), and Q and ? spots from outside Europe and the USA. It
filters out Q(new frequency?) and ? (not yet valid) spots from the US and Europe, on the theory that it’s less important to jump
on those first.

So that’s the story – whether you choose to filter at the cluster node, or see everything coming in and make your own
decisions, Quality Tags can be a very useful tool. Congratulations to CT1BOH and AB5K for their achievement.

Using Filters

Many operators will prefer to make their own judgments, rather than using filters. There are some advantages to this,
probably. For example, a rare multiplier spotted initially by only one RBN node would carry a “?” tag until two more confirm the
spot. Waiting for it to come through a Skimvalid filter could result in your being twentieth in the pileup instead of first or
second. Late in a big contest, a large multi-op will have worked many of the stations on each band. A lot of busts will seem to
be valid, but operators may want to make that judgment quickly for themselves rather than relying on the node. The next
section shows how you can use N1MM features to make this approach easier.

N1MM Logger has two main ways of initiating S&P QSOs, by using either the Available Mults and Qs window or the
Bandmap(s). Of the two, the Bandmaps are the easiest way to work with Quality Tags, simply because the Available window
scrolls so quickly when receiving spots from the RBN. Just mouse over the callsign on the Bandmap that you wonder about,
and the full spot, including the Quality Tag, will appear in a tooltip. This makes it really quick and easy to skim over the
bandmap and dismiss the busted ones with Alt+D Here’s an example

In this example, if you had worked EA1FAI a couple of minutes before, when you saw EA1FAE pop up, you moused over him,
and he was revealed as a busted spot. Alternatively, you can click on a call to select him for a possible QSO, and if the tooltip
reveals he’s a bust, you just hit Alt+D and move on.

Spot Flow in N1MM Logger+
The following diagram may help you visualize how Telnet spots flow through N1MM Logger+
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There are several layers of filtering in the spot flow. An important point to remember is that filters act to remove spots from the
stream, and they are cumulative. Once certain types of spots have been removed at one stage of spot flow, there is no way to
restore them at a later stage.

The first layer is at the cluster node itself. Cluster nodes generally supply a variety of ways to filter the spots that they send to
you. These filters are set and cleared by sending commands to the cluster node, either programmed into the buttons in the
main Telnet window or by typing the desired command(s) into the text box at the top of the window and sending them to the
cluster node (using the Enter key). In addition to filtering by band and mode, there may be filters offered that allow filtering by
the spotted station’s continent, country, state or zone, and/or by the spotting station’s continent, country, state or zone. There
may be other capabilities as well (such as the skimmer quality filters mentioned above). There are several different software
programs used by cluster nodes (AR Cluster, CC Cluster, DX Spider, and so on), and one of the main ways these software
programs differ from one another is in the way they implement filters and filter commands. Consult the user manual for the
software used by the cluster node you are connecting to.

The Telnet window is the point where spots internal to the program (from the Store button in the Entry window, or from the
“QSYing wipes…” option) are added to the spot stream. These local spots are forwarded to the Bandmap, Spectrum Display
and Available Mults & Qs windows, but are not sent to the cluster. The Telnet window also provides the first layer of filtering
within N1MM+. These filters are local to the computer they are applied in, i.e. they do not affect other computers receiving
spots from the master computer in a networked setup. They are not as sophisticated as the ones at some cluster nodes, but
they are easier and quicker to change on the fly. The choice of whether to display non-workable spots (including dupes) is
also made at this stage in the spot flow.

The Available Mults & Qs window has an additional layer of filtering. One main use for this is to restrict the display in the
Available window to the current band automatically without having to go into the Telnet window to reset filters there every time
you change bands.

In the Spectrum Display window, in addition to choosing whether to display non-workable spots you can also choose whether
or not to display spotted callsigns at frequencies where there is no signal visible in the spectrum trace.
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Spot Filter Tips
The Available window band/mode settings only affect what is displayed in the Available window’s spot list. Spots flow
to them through the band/mode and filter tabs of the Telnet window, and so must be the same as, or more restrictive
than, those settings. If you discover that certain band or mode choices are greyed out, take a look at your Telnet
window settings. Also, check to make sure that the sub band limits in the Bandmap window are set appropriately.
Inappropriate choices for the sub band limits can result in spots being assigned to the wrong mode and being greyed
out as a result.

In networked-computer mode, spots flowing to the Networked Computers are not affected by any filter settings in the
Master Station. Networked Stations’ spots arrive unfiltered, in order to let the operators at those stations set their own
filters in N1MM Logger+.
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The Visible Dupesheet Window
2019-04-13

The Visible Dupesheet Window
Example Visible Dupesheet

The Visible Dupesheet is a quick way to determine if a station is a dupe without having to enter the callsign in the program.
The calls already worked will be indexed much like a paper dupesheet that is organized by call area and suffix. The Visible
Dupesheet is especially useful for short, high speed contests like the NA Sprint. It is closely patterned on the Visible
Dupesheet used by TR Log.

Each VFO/Radio/Bandmap has its own Visible Dupesheet. The VFO/Radio A sheet displays all of the contacts for the
band VFO/Radio A is on. VFO/Radio B does the same for whatever your VFO B/Radio is set to even if you don’t (or
cannot) use VFO B
The columns signify call areas. If a call area exceeds the number of calls that will fit it will overlap into an adjacent
column with some dash lines to differentiate
Each call area is sorted by suffix
To see the dupe sheet for any band, set your radio to that band
To check for a dupe, first look for the call area column, then look up the suffix, then the prefix
If you don’t want both windows open, close one, position the other where you want it and then use Tools > Save
Window Positions. The next time you start the program only one window will open
Unless you can copy RTTY in your head, you do not need the Visible Dupesheet for RTTY contests. Obviously RTTY
calls will tell you they are dupes or not as soon as they print
The Visible Dupesheet can hold a maximum of 800 stations per band. Going above this limit will give a warning .
Depending on computer speed and configuration, users may experience noticeable delays when using the Visible
Dupe Sheet with logs containing more than 300 calls. Performance with 600 callsigns is acceptable with a 2.6 GHz
computer running only Logger
Font size is set here. The Visible Dupesheet uses the last (Fixed) font.
There are no menus in this dialog

What is the Usefulness of the Visible Dupesheet?

By Steve, N2IC
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First, let me say what this feature is not: It is NOT intended to be a step towards paper (or electronic) dupe sheet submission.
A paper dupe sheet is an obsolete artifact of the pre-computer logging era.

Now, I’ll be perfectly honest about the utility of the Visible Dupesheet. I have been a user of TRLog for many years, as well as
a fan of the NA Sprint contest. To do very well in an extremely fast-paced contest, like the NA Sprint, you have to minimize the
amount of non-productive time. Any time you are not actually making a QSO is non-productive time. As you tune around a
band, looking for new stations to work, you need a really fast way to determine if a station that you hear is a dupe. The fastest
way to do this is to use only your brain. Some contesters have an amazing ability to keep their dupesheet completely “in their
head”. For the rest of us, we typically reach for the keyboard and type the call into the entry window. As soon as you do this,
N1MM Logger+ instantly tells you whether it’s a dupe. Excellent. However, some of the NA Sprint operators who use TRLog
have found an even faster way to check for a dupe – using TRLog’s Visible Dupesheet feature. As you tune the band, you
keep your eyes focused on the Visible Dupesheet. It becomes second nature to scan the Visible Dupesheet. When you hear a
non-dupe that you want to call, you don’t even have to enter the call in the Entry Window, yet. Just hit the Enter key. If he/she
comes back to you, you now have time to enter his/her call and exchange.

Obviously, in a contest where you work many, many stations on each band, this feature won’t work – it takes too long to scan
the Visible Dupesheet when it is crowded with calls. However, this is not the case with the NA Sprint. The winners work no
more than 150 stations per band, making the Visible Dupesheet an ideal way to dupe check.
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The WSJT Decode List Window
2019-04-13

The WSJT Decode List Window
The WSJT Decode List provides a bi-directional interface between the Band Activity Panel in WSJT-X or JTDX and N1MM+’s
contest log. Since these modes are quite different in several ways from traditional digital modes (as well as CW and SSB),
and since the actual operating in these modes is done from the WSJT-X or JTDX program window, not from an N1MM+
window as in other modes, it is recommended that users familiarize themselves with the WSJT-mode program in non-contest
situations before trying to set up and operate in contests with N1MM+.

Key Feat ures

QSO initiation, auto-sequencing, and logging from within the WSJT-X or JTDX program
Contact logging in both the WSJT-X or JTDX log and the N1MM+ contest database
Callsign prioritization (normal, mult, double mult) based on contest contacts in the N1MM+ log
Dupe callsign warnings based on contest rules (bands, modes) and existing contacts in the N1MM+ log
All rig control functions are carried out by N1MM+ on WSJT-X’s or JTDX’s behalf, eliminating the need for configuration
changes when changing modes between WSJT and traditional modes
Support for SO2R in WSJT modes

Configuring the WSJT Decode List Window

Within N1MM+

There are several places in the Configurer that need to be set up for WSJT-X interoperation with N1MM+. These include the
Mode Control page and the WSJT/JTDX Setup page in the Configurer window (note: in versions 1.0.7645 and earlier, the
settings that are now on the WSJT/JTDX page were on the Broadcast Data page and the Digital Modes page). You also
need to ensure that the Contest Setup is configured to include Digital modes (otherwise digital mode contacts will not be
given points credit).

To enable logging from WSJT-X to N1MM+, configure per the following settings on the Configurer’s > WSJT/JTDX Setup
page.
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In the normal single-computer configuration, the IP address will be 127.0.0.1 and the port number must match between WSJT-
X and N1MM+ (the recommended default port number is 2237 – in SO2R, the port number for Radio 2 should be changed to
2239 in both programs). If N1MM+ and WSJT-X are running on different computers, the IP address entered in each program
must be the IP address of the other computer. If you are using the multicast IP address feature in order to allow sharing of the
communications with other programs such as JTAlert and GridTracker, a multicast IP address starting with 224 or 239 must be
used in all of the intercommunicating programs (the suggested multicast address is 224.0.0.1, or in SO2R for Radio 2,
224.0.0.2). When using a multicast address, start WSJT-X from N1MM+ before starting other programs that will use the same
address, as the WSJT-X server needs to be running before the other applications can communicate via that address.

To enable logging from JTDX to N1MM+, in addition to configuring the UDP port as for WSJT-X above, you also need to
configure the TCP port for JTDX logging to use port 52001 and check the Enable box in the “JTDX / Others TCP Settings”
area.

In order to allow N1MM+ to call up the WSJT-X or JTDX program, you must also enter the location of the WSJT-X or JTDX
program. Rather than attempting to type in the path to the WSJT-X or JTDX program manually, it is recommended that you
use the Select button. Clicking on this button opens a standard Windows Open File dialog window, in which you can navigate
to the location of the executable program (wsjtx.exe or jtdx.exe) and select it to fill in the box automatically. Note that although
the button in this window says “Open”, clicking on this button does not open the file or start the program; it merely enters the
path to the program into the configuration file for later use.

The bottom section on this page implements the Auto Load feature for the Decode List window. If the Enable check box is
checked, calling up the WSJT-X or JTDX program from the Window > Load WSJT/JTDX menu item will also automatically
open the Decode List window as well (recommended).

Starting with version 1.0.7860, N1MM+ supports running two copies of WSJT-X or JTDX in SO2R (but not in SO2V). There
are boxes on the WSJT/JTDX Setup page in the Configurer for entering the port number(s) and program location for the
second radio. The UDP/TCP port number(s) for the second radio are different from the UDP/TCP port number(s) for the first
radio, and will need to be changed in the settings for the Radio #2 (EW2) instance of the WSJT-X or JTDX program. You can
use the same copy of the WSJT-X or JTDX program .exe file from both radios, even though they will use different settings;
each one will store its settings in a different location.

In SO2R, both Entry Windows do not need to be in the same mode. In a mixed mode contest, you could, for example use one
radio for WSJT modes and the other radio for CW/SSB/RTTY/PSK. Or, you could use both radios for WSJT modes on
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different bands, taking care never to transmit in the same (odd/even) time slot with both radios if you are entering a contest in
the Single-Operator category.

When you are using WSJT-X or JTDX, the radio should be in the same mode as you would use for PSK or other sound card
digital modes. N1MM+ uses the settings under the Mode Control tab in the Configurer to control the mode used by the radio.
Still in the Configurer, on the > Mode Control page, on the right-hand side under Mode sent to radio, you need to set the
mode in the DIGI row (called the PSK row in versions prior to 1.0.7937) correctly for your radio. The modes that appear in the
pull-down lists on this page may not match the mode names used in your radio. The correct choice might be PSK (e.g.
Elecraft K3/K3S or IC-7600/7700/7800 series), or AFSK-R (e.g. IC-7300, Flex, recent Yaesu or Kenwood radios), or if your
older radio does not have a separate Data mode for digital modes, it might be USB. Consult the Digital Mode Mapping table
in the Supported Radios chapter of this manual for the mapping between mode names in your radio and the mode names that
appear in the pull-down list on the Mode Control page of the Configurer. If you are unable to determine which mode setting to
use, you can leave the choice set at “No change”, in which case you will have to set the correct mode on the radio manually
yourself.

If you are using a USB audio codec that is internal to the radio, use the “Config > Logger+ Audio Setup…” menu item to open
the Audio Setup & Monitor window. Select the Playback tab, set the sound card choice to the radio’s USB audio codec, and
(important!) check the “Internal Radio Codec” checkbox. Also, in the Configurer, set the PTT control to use CAT commands by
opening the port setup for the radio control port and checking the “PTT via Radio Command Digital Mode” checkbox. If your
radio has menu commands for selecting the audio source, make sure the radio’s audio source in data modes is set to the
internal audio codec.
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Within WSJT-X/JTDX

First, if you have made custom changes to the WSJT-X or JTDX settings and wish to retain those same settings when running
together with N1MM+, you might want to follow the procedure described in the colored text box at the end of this section
before starting to configure the special instance of the program that is used with N1MM+.

You must make the WSJT-X (JTDX) configuration changes described below from WSJT-X (JTDX) after it has been called
from within N1MM+, not after it has been started stand-alone. The stand-alone configuration settings do not apply when
WSJT-X/JTDX is run from within N1MM+. Changes you make in one instance of the program (stand-alone, from N1MM+ for
Radio 1 or from N1MM+ for Radio 2 in SO2R) will not apply to any of the others.

You can tell which instance of WSJT-X you are operating from or making changes in by looking at the title bar of the main
WSJT-X window. If it says WSJT-X – ForEW1, this is the copy that is running from the N1MM+ Entry Window 1. If it says
WSJT-X – ForEW2, this is the copy that is running from Entry Window 2 (SO2R setups only). If it just says WSJT-X, that is a
stand-alone copy. Each of these three copies has its own separate file area where configuration files and the WSJT log files
are stored.

After starting WSJT-X or JTDX from N1MM+, configure per the following settings on the > File > Settings page in the UDP
Server panel under the Reporting tab:

Make sure the correct contest mode is selected
Note that for duplicate and multiplier information to be recorded and transferred correctly, the correct contest must be
selected in the N1MM+ Contest Setup window, the Mode Category in this window must include digital modes, and
the program must be in Digital logging mode (the easiest way to do this is to type FT8 or FT4 into the call sign box in
the Entry window and press Enter).

Note that the contest Mode category in the contest setup dialog window must contain DIGITAL. If the contest mode
is RTTY, contacts in other modes (including FT8 and FT4) will be assigned zero points. After changing RTTY to
DIGITAL or SSB+CW to SSB+CW+DIGITAL in the contest setup window to correct this, you may need to use the
Tools > Rescore Current Contest menu item to rescore any FT8 or FT4 QSOs that had not originally been
assigned the correct score.
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In the “Logging” area, the upper two check boxes control how logging in WSJT-X is controlled. Most users will likely want one
or the other checked – i.e. either have the program prompt the user to log the QSO at the end of the QSO sequence, or else
do the logging automatically. If neither one is checked, you must remember to click on the “Log QSO” button at the end of
every QSO, and it is very easy to forget to do this, in which case the contact will not be logged.

In the “UDP Server” area, the “Accept UDP requests” check box must be checked in order for the WSJT Decode List window
to work. This enables the passing of duplicate/multiplier information from N1MM+ to WSJT-X or JTDX, as well as allowing
WSJT-X/JTDX to use N1MM+ for rig control if it is called up from the N1MM+ Window menu.

The “UDP Server” address and port number must be coordinated with the values used in the N1MM+ Configurer. In the most
common single-computer configuration, the address would be 127.0.0.1 and the port number would be 2237 (2239 for Radio 2
in SO2R). If you are using the multicast IP address feature, the suggested address in all of the intercommunicating programs
would be 224.0.0.1 (or for Radio 2 in SO2R, 224.0.0.2).

In JTDX, there is another TCP port that needs to be set up in the “External logbook connection” area. For SO1R or for the first
radio in SO2R, the default TCP port is 52001. For the second radio in SO2R, this would be changed to correspond with the
setting in the N1MM+ Configurer’s WSJT/JTDX Setup tab (suggested 52006).

In WSJT-X, do not check the Enable check box in the “Secondary UDP Server” (WSJT-X version 2.1.0) or “N1MM Logger+
Broadcasts” (WSJT-X version 2.0.1) area. This is not used when WSJT-X is run from inside N1MM+.

In order to enable N1MM+ to perform rig control when you call up WSJT-X or JTDX from the Window > Load WSJT/JTDX
menu item, under the Radio tab in WSJT-X or JTDX change the rig control method to “DX Lab Suite Commander”.:
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Note that you do not actually run DXLab Suite’s Commander program; N1MM+ uses the same method as Commander to
communicate with WSJT-X or JTDX, so the same Rig setting can be used in WSJT-X/JTDX. Choose your PTT Method,
radio’s Mode and Split Operation method depending on your radio.

Second radio settings for SO2R

For SO2R, in the setup for the Radio #2 (EW2) copy of WSJT-X or JTDX, immediately below the Rig: box, you will
see a text box called “Network Server”. Enter the following into this text box: 127.0.0.1:52004 . You do not need to
enter anything in this box for SO1R, or for Radio #1 in SO2R, only for Radio #2 in SO2R.



Do not try to run DXLab Suite Commander

Do not let the instruction to set the Rig type in WSJT-X to “DX Lab Suite Commander” fool you into trying to run
Commander at the same time as N1MM+. When WSJT-X/JTDX is run from inside N1MM+, the programs use the
same UDP port that is used by Commander. If both N1MM+ and Commander were running and both using this port,
their messages would interfere with one another, leading to failures of rig control in WSJT-X/JTDX and/or failures of
communication with the Decode List window. Also, N1MM+ and Commander both want to control the radio via the
same radio control COM port, which is not permitted by the operating system.
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If you choose CAT as the PTT method, what that really does is tell WSJT-X or JTDX that N1MM+ will be handling PTT control.
You must have a method of PTT control configured in the N1MM+ Configurer for this to work. You can check the “PTT via
Radio Command Digital Mode” check box in the setup window for the radio control port in the Configurer, or configure a serial
port in the Configurer for PTT control, or if you are using a Winkeyer, connect a PTT cable from the Winkeyer’s PTT output to
the rig’s PTT input jack. Any of these will work with the CAT PTT method selected in WSJT-X/JTDX when it is run from inside
N1MM+. If you are using a SignaLink to perform the PTT function, or if you are using the rig’s own VOX function, select VOX
as the PTT method in WSJT-X/JTDX.

The Mode section in the WSJT-X and JTDX setup is used to tell the program which mode to put the radio in while operating in
JT modes. If your radio has a special radio mode for sound-card data operating modes that you want to use, make sure to
select the Data/Pkt setting in the setup here. You must also ensure that the N1MM+ Mode Control is set properly for your
radio as described in the previous section. Consult the Digital Mode Mapping table for the correct mode setting for your
radio. For older radios that do not have a data mode, you might need to choose USB in order to put the radio into USB mode.
If you are unable to determine the correct settings for N1MM+ Mode Control, you can choose None in WSJT-X. If you do this,
then it will be up to you to verify that the radio is in the correct mode, and if not, select the correct mode on the radio before
starting to use WSJT-X each time.

The Split Operation pane in the WSJT-X and JTDX setup controls how WSJT-X/JTDX handles audio frequencies outside the
“ideal” 1500-2000 Hz range. If either Rig or Fake It is chosen, then if an audio frequency outside that range is chosen,
whenever WSJT-X/JTDX commands N1MM+ to put the rig into transmit, it will also request that N1MM+ QSY the radio by a
multiple of 500 Hz so as to put the audio frequency back into the “ideal” range. This avoids problems with audio harmonics or
with reduced audio gain in other parts of the bandpass. If Rig is chosen, the QSY will be done using the rig’s split operation
capability; if Fake It is chosen, the main VFO will be QSYed every time you switch between transmit and receive. With some
rigs, there may be an objectionable delay or other problems when switching to transmit with the Rig setting chosen; if this
happens to you, try using the Fake It setting instead. If you choose None, the radio will not change frequency between
transmit and receive, and you may need to restrict your choice of the transmit audio frequency in the waterfall to avoid
problems that may occur near the edges of your transmitter’s bandpass.

There is another setting under the General tab in the WSJT-X/JTDX Settings window that is not strictly speaking necessary,
but that will have an effect on operating, and that is the “Double-click on call sets Tx enable” check box. When this is checked,
either clicking or double-clicking on a call sign in the Decode List window will immediately enable transmit from WSJT-X. We
recommend you test both with and without this option to see which you prefer. You might also want to check some of the other
options, depending on your operating preferences.

WSJT-X/JTDX Configuration when run from inside N1MM+

The first time you open WSJT-X or JTDX from N1MM+ you may notice that all of the WSJT-X/JTDX settings have
been restored to default values – for example, your call sign and grid square may not be entered under the General
tab. If you want to avoid having to manually re-enter all of your preferred settings (other than the ones described
above), there is an optional way to transfer them over from your stand-alone setup to the setup within N1MM+.

In WSJT-X, use the File > Open log directory menu item to open a Windows File Explorer window open to the
directory where WSJT-X stores its settings. If you do this from the stand-alone version of WSJT-X, this will be
C:\Users\[yourusername]\Appdata\Local\WSJT-X. If you do it from WSJT-X after it has been called up from within
N1MM+, the directory will be C:\Users\[yourusername]\Appdata\Local\WSJT-X – ForEW1 (or ForEW2 for the copy of
WSJT-X called up for the second radio in SO2R). You can navigate to the …\WSJT-X directory, find the file called
WSJT-X.ini, copy it and paste the copy into the …\WSJT-X – ForEW1 directory. Then rename the copy to WSJT-X –
ForEW1.ini (after deleting or renaming any existing file with that file name). If you had already made the configuration
setting changes described earlier on this page, you will have to make them again. From now on the two
configurations will be independent; changes made to one will not affect the other.

In JTDX, the same procedure applies, except that the path names and file names will say JTDX instead of WSJT-X.
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Configuration for a Specific Contest (WSJT-X only)

For general non-contest logging, do not check the “Special operating activity” checkbox,
For most contests, check the “Special operating activity” checkbox, the radio button adjacent to the contest that you
intend to operate, and in some cases the Exchange box at the right, as follows:

For the FT Roundup – W/VE stations should insert their two character state/province abbreviation. DX stations
should use the expression “DX”, which will enable sequential serial number exchanges.
For the ARRL Field Day – Enter the exchange information describing your station configuration (e.g. 1D EMA –
see ARRL instructions).
For the WW Digi contest at the end of August, use the NA VHF Contest setting (during pre-contest testing, you
can leave the “Special operating activity” check box unchecked and use normal non-contest mode; the WW Digi
contest exchange is compatible with the normal non-contest mode in WSJT-X).

Note that when you are operating in contest mode, WSJT-X will use only a subset of the regular
messages, and this may confuse other operators who are operating in non-contest modes. For this
reason, it is best not to use the contest mode outside of the contest and pre-contest test sessions.
If during the contest you are called by someone who is in non-contest mode while you are in contest
mode, the other station will not receive some of the messages it is expecting and its auto-sequencing may
not work correctly. In such situations you may have to initiate sending of the missing message directly
instead of relying on auto-sequencing, in order to complete the contact with the non-contest station. Use
the “Now” buttons or the “Next” selectors in the lower right part of the WSJT-X window for this purpose.
When one of the contest modes is selected, WSJT-X will open a third log window. This window is for
information only; you can minimize it to the Task Bar to free up screen space, but do not close it.

Setup Checklist

1. Make sure rig control, including PTT, is working in N1MM+ for other modes
2. Set the UDP address and port in the Configurer under the WSJT/JTDX Setup tab (for 99% of users, the default values

will be correct; if not, consult the detailed instructions above)
2a. (this particular step is for JTDX only, not for WSJT-X) Set the TCP address in the Configurer

3. Set the path to WSJT-X or JTDX in the Configurer
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4. Under the Mode Control tab in the Configurer, set the “Mode sent to radio” for DIGI according to the radio type (AFSK-
R for IC-7300/Flex/recent Yaesu/Kenwood, PSK for K3/K3S or IC-7600/7800 series, USB for radios with no special
mode setting for sound-card digital modes). If you do not wish N1MM+ to select the mode automatically, you can use
“No change”, in which case you will be responsible for changing the rig mode manually every time you change
operating modes

5. If you are using a USB audio codec internal to the radio, then in N1MM+ use the Config > Logger+ Audio Setup…
menu item to open the Audio Setup window. Under the Playback tab in that window, select the USB audio codec as the
sound card and check the “Internal Radio Codec” checkbox. If your radio has menu commands for selecting the audio
source, make sure the radio’s audio source in data modes is set to the internal audio codec. If you wish to use CAT
commands for PTT, then in the port setup for the radio control Com port in the Configurer, check the “PTT via Radio
Command Digital Mode” checkbox.

6. Set up the desired contest in N1MM+, and in the contest setup dialog make sure the Mode category includes DIGITAL
7. Now use the Window > Load WSJT/JTDX menu item to start WSJT-X or JTDX
8. After starting WSJT-X/JTDX from N1MM+, in its Settings > Radio window the Rig must be set to “DX Lab Suite

Commander” (the actual DXLab Suite Commander program does not have to be installed on your computer, and if it is
installed, it must *not* be running; N1MM+ takes its place)

9. Set WSJT-X’s PTT method to CAT in order to have N1MM+ handle PTT, regardless of what actual method N1MM+
uses

10. Set the Mode in WSJT-X to Data/Pkt in order to have N1MM+ control the rig’s mode according to the setting in the
Configurer under the Mode Control tab

11. Set Split Operation in WSJT-X to Rig or Fake It, unless there is no rig control in N1MM+ (“Manual Radio”)
12. Under Reporting, set the UDP Server to Accept UDP requests

12a. (this particular step is for JTDX only; not for WSJT-X) Set the TCP address in External logbook connection area
13. (WSJT-X only) Under the Advanced tab in the Settings window, choose the Contest mode applicable to the contest and

configure the sent exchange for contest types that require it (FD, RTTY RU)
14. If the WSJT Decode List window is not already open, open it from the Window > WSJT Decode List menu item
15. Log contacts in WSJT-X/JTDX, *not* in the N1MM+ Entry window

Launching WSJT Decode List

To start WSJT-X or JTDX from within N1MM+, use the N1MM+ > Window > Load WSJT/JTDX menu item (last one in the list)
to start WSJT-X/JTDX, as configured under the WSJT/JTDX Setup tab in the Configurer. In addition to the WSJT-X or JTDX
windows, there will also be a small N1MM+ window that opens:

The green box near the left of this window indicates that communications between the two programs is working. The WSJT
Decode List window must be open for this to happen. If this box either stays red or turns red during an operating session while
the Decode List window is open, that indicates that the communications has stopped working. If this happens, try closing this
window and WSJT-X/JTDX and then restarting it from the N1MM+ Window > Load WSJT/JTDX menu item. If that does not
resolve the issue, there is probably a configuration error in one or both programs that will need to be fixed.

When WSJT-X or JTDX opens, two new windows will appear (three, if WSJT-X is in contest mode). One of those, called the
Wide Graph window, is a waterfall window, which you use to help select audio operating frequencies. The other is the main
WSJT-X/JTDX operating window – you will do all of your operating from this window and the Decode List window, and not
from the N1MM+ Entry window. This includes changing frequency and operating mode (between FT8 and FT4, for example).
If WSJT-X is in contest mode, there will be a third contest log window opened in WSJT-X. This window is informational; you
can minimize it to the Windows Task Bar to free up screen space, but do not close it.

If you have checked the Auto Load check box on the WSJT/JTDX Setup page, the Decode List window will open automatically
at the same time as the WSJT-X or JTDX program. If you have not checked this option, you can open the WSJT Decode List
from the N1MM+ > Window > WSJT Decode List menu choice:
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Opening the WSJT Decode List window, whether automatically when WSJT-X or JTDX is loaded or manually from the
Window menu item, will automatically initiate the UDP Server communications between WSJT-X/JTDX and N1MM+ for the
transfer of duplicate/worked/multiplier status from N1MM+ to WSJT-X or JTDX. Once the window has been opened, you will
do all of your operating from the main WSJT-X or JTDX window plus the Decode List window, and not from the N1MM Entry
Window. In fact you can even minimize (but do not close) the WSJT Decode List window and just use the main WSJT-X/JTDX
window. You can hide the N1MM+ Entry window behind another window and minimize other N1MM+ windows to the Windows
Task Bar if you need to to free up screen space while you are operating WSJT-X/JTDX.
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Log contacts in WSJT-X or JTDX, not in N1MM+

If something (such as anti-malware software, or a configuration error in one or the other of the programs) prevents
the transfer of logging information, you need to fix that. For example, you may need to configure a firewall in your
anti-malware program to permit N1MM+ and WSJT-X/JTDX to use the UDP or TCP ports they need to use to
communicate with each other. DO NOT try to bypass the automated logging by entering exchange data directly into
the N1MM+ Entry window and pressing Enter to log it. Doing so may result in incorrect information being logged.
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Using WSJT Decode List

General

With the WSJT Decode List enabled, a list of up to 30 recent callsigns will be displayed with row colors indicating each
callsign’s contest priority (by default, these will be grey for dupe or zero points, blue for workable but not a multiplier, red for
new multipliers). Callsigns in the corresponding WSJT-X/JTDX Band Activity panel will reflect those same contest color
priorities as a background color. The only callsigns that are marked are callsigns of stations calling CQ. Callsigns of stations
with QSOs in progress are not marked and do not appear in the WSJT Decode List.

While not shown in the screen shot above, there is additional information in the Decode List window, including time stamps for
when the CQ message was sent, SNR numbers from WSJT-X/JTDX, and even points value for the QSO in the WWDIGI
contest. Different time cycles will be indicated in the window by different background color shading to help you determine
whether the CQ that station sent was in the current cycle or a previous cycle.

To initiate a contact with a listed station, you may either click or double-click on a callsign in the Logger’s WSJT Decode List
window, or you may double-click on the callsign in the WSJT-X or JTDX Band Activity or RX Frequency window. This will
transfer the call sign and grid square information to WSJT-X, and if WSJT-X’s “Double-click on call sets Tx enable” setting
option is checked, it will start to transmit on the next valid time slot. Note that if you click or double-click on an “old” callsign,
i.e. one that was sending CQ during the 15-second (FT8 – 7.5 seconds in FT4) sequence before the most recent one, WSJT-
X/JTDX will not start transmitting until the correct time slot for calling that station (e.g. in FT8, if the other station called CQ on
an “even” time slot starting at 0 seconds or 30 seconds, WSJT-X/JTDX will only call that station on an “odd” time slot starting
at 15 seconds or 45 seconds).

When you click or double-click on a callsign, either in the WSJT Decode List window or in the WSJT-X/JTDX Band Activity
window, that call sign will also appear in the N1MM+ Entry window. This is not part of the logging process. Do not enter the
exchange into the Entry window. Simply complete the QSO in WSJT-X or JTDX, up to and including the point where the QSO
is logged. If you have not chosen the “Log automatically” option in WSJT-X/JTDX, you will need to mouse click in WSJT-
X/JTDX’s Log Contact window to log the contact. After completing and logging a contact in WSJT-X or JTDX, that contact will
be logged in the WSJT-X or JTDX ADIF log and the N1MM+ contest database simultaneously.

3/4/25, 5:37 PM N1MM Logger+ Documentation



359

Do not type anything into the Entry window or any other N1MM+ window; in fact, it is possible to operate in FT8 or FT4 with
all of the N1MM+ windows minimized to the Windows Task Bar and still have all of your FT8/FT4 QSOs recorded in the
N1MM+ log. It is not actually necessary that the WSJT Decode List window in N1MM+ be visible (although you may prefer to
use it for choosing stations to work); it can be minimized to the Task Bar and will still carry out its function of relaying
dupe/multiplier status to WSJT-X or JTDX.

Since all of the logging activity is carried out in WSJT-X, operators should familiarize themselves with features of WSJT-X that
can be used to help complete QSOs. This is particularly important when the basic auto-sequencing process runs into trouble,
as commonly happens in situations with high QRM levels such as contests. Operators should familiarize themselves with the
“Log QSO” button, and with the use of non-standard message sequences with the help of the “Next” and “Now” columns to the
right of the standard messages (message tab 1 in WSJT-X). This may be facilitated by associating the function keys F1-F6
with the standard messages using the “Alternate F1-F6 bindings” check box under the General tab in the WSJT-X Settings
window. For a more in-depth discussion of some contest logging issues with WSJT-X, see
https://physics.princeton.edu/pulsar/k1jt/NCJ_FT4_FT8_Contesting.pdf.

When a callsign is listed in the WSJT-X or JTDX DX Call field, the Decode List interface will persistently copy that callsign into
the N1MM+ Entry Window callsign field (for example, the call will stubbornly reappear after using [Wipe] to clear the N1MM+
Entry window). After you have completed a QSO in WSJT-X and it has been safely logged, you can use the Esc key in WSJT-
X to clear the DX Call field while still running WSJT-X. This will clear the callsign field in the Entry window as well. If you are
entering a contest that allows multiple modes, having WSJT-X or JTDX put calls into the Entry window, or having it clear the
Entry window, is definitely not something you want to have happen while you are using a non-WSJT mode (RTTY, CW, SSB,
PSK). Therefore, you should always close the WSJT Decode List window and shut down WSJT-X/JTDX before changing to a
non-WSJT mode.

To change modes from a WSJT mode to a “normal” N1MM+ mode (CW, SSB, RTTY, PSK31/PSK63), first clear the DX Call
box in WSJT-X or JTDX (the Esc key will do this), then close WSJT-X or JTDX. If this does not close the WSJT Decode List
window, close it as well. Type the name of the new mode into the call sign box in the N1MM+ Entry window and press Enter.
Now QSY to the frequency you want to operate the new mode in (for example, by typing the frequency into the Entry window)
and carry on operating in that mode. To switch from that mode back to FT8 or FT4, either use the > Window > Load
WSJT/JTDX menu item, or just type FT8 or FT4 into the Entry window. Then, if the Decode List window does not open
automatically, use the > Window > WSJT Decode List menu item to open the WSJT Decode List window.

The filter menu

The options on the filter menu can be used to further include or exclude WSJT messages in the decode list. This can be used
to limit messages to only those containing a specific string, such as a contest name when the band segment used also has
non-contest operators on the air, or to include various “73” messages for tail end calling. Note that string filters take
precedence over “73” messages meaning that if you choose to limit CQ messages to only those containing, for example, “FD”
or “WW” the 73 messages will not be displayed unless the entered filter string is also present in the message. This is highly
unlikely in practice.

Note that the string “Filter” at the top of the menu will change in color to red if any filter settings are enabled. Filter settings are
persistent in versions created after June 13, 2022.

Filter menu
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Filter string entry

Choosing “Set filter string” will open the filter string entry window. Enter the text that must be present in the CQ message to be
displayed in the decode list. To cancel the filtering, reopen the window and click on “Cancel”.

To include “73” messages to facilitate tail-ending, choose the “Include 73” option. The submenu that opens will allow you to to
select or deselect messages containing “73”, “RR73”, or “RRR”. This sub menu will stay open and not close until you click
anywhere outside the menu.

Not shown above is a menu item called “Clear all”. This clears all filter settings.

WSJT Decode List FAQs

Rig Control – Can both WSJT-X and N1MM+ control the radio?

Yes, if you are calling up WSJT-X from within N1MM+ using the > Window > Load WSJT/JTDX menu item and N1MM+ and
WSJT-X have both been configured appropriately. When you do this, N1MM+ handles rig control on behalf of WSJT-X, using
the same technique as is used by the DXLab Suite Commander program (which is why WSJT-X is configured to use “DX Lab
Suite Commander” as its rig control method). If you change modes from the WSJT-X/JTDX Mode menu, or if you change
bands or frequencies in WSJT-X/JTDX (just below the Band Activity list), WSJT-X/JTDX will change the frequency in the radio
via N1MM+.

Generally speaking, the radio mode you use for WSJT-X will be the same as the radio mode you would use for PSK or other
sound card digital modes. If the Mode sent to radio is not set up correctly under the Mode Control tab in the Configurer,
N1MM+ may put the radio into the wrong mode when using WSJT-X. If this happens to you and you are unable to determine
the correct settings to use in the Configurer, you can try setting the Mode under the Radio tab in the WSJT-X Settings window
to None, and then make sure you switch the radio into the correct mode manually before starting to use WSJT-X.

If you have some method of sharing rig control, such as one of the Win4K3Suite/Win4YaesuSuite/Win4IcomSuite programs,
or SmartSDR with a Flex radio, then perhaps you may be able to use a stand-alone copy of WSJT-X or JTDX concurrently
with N1MM+, including the Decode List window, without loading WSJT-X/JTDX from within N1MM+. However, detailed setup
instructions for doing this are beyond the scope of this document, and there is no guarantee that it will continue to work with
future versions of either program.

No Rig Control – Does it work without rig control?

It is possible to use WSJT-X without any rig control at all, but this requires some careful attention to detail when changing
bands. You will need to change bands manually in both programs every time you change bands on the rig. Checking for
duplicates and multipliers will not work correctly if the N1MM+ program is not set to the band you are operating on. Operating
without rig control also means that some of WSJT-X’s features, notably the “Split” or “Fake It” techniques used to keep the
sound card audio in the 1500-2000 Hz “sweet spot”, as well as the automatic choice of operating frequency depending on the
mode selection, will not work.

My radio does not go into transmit when I try to transmit from WSJT-X. What causes this and how can I fix it?

There are several possibilities.

First, if you have configured WSJT-X to use CAT for PTT control, you must have a method of rig control configured separately
and working in N1MM+. The simplest such method may be to use VOX, if that works with your radio. Next simplest is to check
the “PTT via Radio Command Digital Mode” option in the setup for the rig control port in N1MM+, again assuming your radio
supports this. In extremis, you can configure WSJT-X to use RTS or DTR for PTT on a a separate serial port interface that is
not used by N1MM+, but in most such cases it would be preferable to configure that serial port for PTT in the N1MM+
Configurer rather than in WSJT-X.
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Second, if you have configured WSJT-X’s Mode control to use Data/Pkt mode on the radio, you must ensure that the Mode
Control setting in the N1MM+ Configurer is set appropriately for your radio. With some radios, if the wrong mode is selected
here, PTT may stop working. A test for this problem is to set WSJT-X’s Mode control to None, and then set the mode on the
radio manually to the correct mode for sound card digital communications.

If PTT works intermittently, or very slowly (e.g. takes several seconds), the culprit might be the Split Operation setting in
WSJT-X/JTDX. With some radios, the “Rig” setting seems to require a lot of handshaking between the two programs that
delays the start of each transmit cycle. With some other radios, it seems to be the “Fake It” setting that takes more time. You
might find that “Fake It” works more reliably than “Rig”, or vice versa, depending on your radio.

My radio is changing frequency when WSJT-X transmits. What gives?

This is by design, and is controlled by the “Split Operation” section in the WSJT-X/JTDX Settings window. The basic idea is to
try to keep the audio frequency used in the sound card during transmit within the “ideal” 1500-2000 Hz window. This avoids
potential problems with the radio’s transmit filtering, which may roll off at low and high audio frequencies, and is also intended
to minimize the chances of audio harmonics of a low-audio-frequency signal being transmitted, by ensuring that any such
audio harmonics are outside the transmit filter’s passband.

When “Split Operation” is set to “Fake It”, the program achieves this goal by simultaneously changing the rig’s frequency and
the sound card audio frequency in opposite directions by the same amount (always a multiple of 500 Hz), so that the audio
frequency used in the sound card is within the “ideal” range. When the program goes back to receive, the rig is QSYed back to
the original frequency so that received signals appear at the same places in the waterfall.

If “Split Operation” is set to “Rig”, instead of changing the rig’s main VFO frequency, the program uses the rig’s second VFO
and Split capability to achieve the same result. With some radios, this method appears to involve more handshaking between
the rig, N1MM+ and WSJT-X/JTDX, which makes this method paradoxically slower or less reliable than the brute-force “Fake
It” method, which is why we suggest switching from “Rig” to “Fake It” if you are having problems using the “Rig” setting (or vice
versa, if the “Fake It” setting is the one that seems to be having problems).

Compatibility with DXLab Suite Commander – Can I run Commander at the same time?

No. The Decode List window uses the same UDP port as Commander to communicate with WSJT-X/JTDX. If both programs
are running, their messages will interfere with each other, leading to failures of rig control in WSJT-X/JTDX and failures of
communication between the Decode List window and WSJT-X/JTDX. This is in addition to any errors that might occur as a
result of having Commander and N1MM+ both trying to open the radio control port at the same time.

Compatibility with JTAlert – Can I run JTAlert at the same time?

Yes, by using the multicast IP address feature in N1MM+ versions since 1.0.9600.0. The same multicast IP address (e.g.
224.0.0.1) must be used in all of the programs that are sharing the communications. Start WSJT-X from N1MM+ before
starting other applications that use the same multicast IP address, in order to ensure that the WSJT-X server is running before
the other applications start. Note that if you enable both the WSJT-X logging interface to N1MM+ and the JTAlert logging
interface,, your contacts will be double-logged into the N1MM+ contest database.

WSJT-X/JTDX seems to have lost all of my personalized settings after I set it up in N1MM+ – How can I restore them?

The settings in the instance of WSJT-X or JTDX run from within N1MM+ are entirely separate from the settings in the stand-
alone instance. If you have set up personalized settings in the Settings window, or adjusted the gain and threshold settings in
the WSJT-X/JTDX waterfall window, these will not be automatically carried over into the N1MM+ instance. The N1MM+
instance will start up with default settings.

If you have a lot of personalized settings and would like to avoid having to reset them all individually, you can copy the settings
from the stand-alone instance into the N1MM+ instance by copying the WSJT-X.ini (or JTDX.ini) file from the log directory
used stand-alone into the log directory used from the N1MM+ instance. This is described in more detail at the end of the
WSJT-X/JTDX Setup section.

Copying the setup file from the stand-alone instance into the N1MM+ instance’s log directory will overwrite the special settings
needed for interoperation with N1MM+. You will need to redo the settings changes in the Radio, Reporting and Advanced tabs
in the Settings window as described in the WSJT-X/JTDX Setup section. If at any time during this process you get a Rig
Control error message from WSJT-X/JTDX asking whether you want to reconfigure the rig control interface, click on OK and
then do (or redo) the changes under the Radio and Reporting tabs as described in that section.

Supported Contests – Does this only work with specific contests or can I use it with my general log?

You can use the WSJT Decode List with your general DX or VHFDX log or with one of the contests supported by WSJT-X.
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For general logging, use WSJT-X or JTDX in normal non-contest mode and use either the DX log or the VHFDX log in
N1MM+ (the VHFDX log displays grid squares, the DX log does not; you can use the VHFDX log on HF, in which case you
may want to change the Band Panel display using the right-click menu in the Entry window). Make sure the Mode category in
the Contest Setup window for your DX or VHFDX log is set to SSB+CW+DIGITAL. If you leave it at the default SSB+CW,
digital mode contacts made from WSJT-X may not be logged correctly, and the dupe checking will be wrong.

For contest logging, if the contest exchange sequence is different from the normal non-contest exchange sequence in WSJT-
X, you will need to set the contest mode in WSJT-X under the Advanced tab in the Settings window. Check the check box
called “Special operating activity” and then select the applicable contest and if necessary, fill in the contest exchange box.
WSJT-X only supports a select few contest exchange types: NA VHF (for ARRL and CQ VHF contests with a 4-character grid
square exchange); EU VHF (for European VHF contests with a 6-character grid square and serial number exchange); ARRL
Field Day with its unique exchange; RTTY Roundup (for ARRL RTTY and similar contests with W/VE state/province code for
W/VE stations and serial number for DX stations); and the WW Digi contest (4-character grid square exchange).

In N1MM+, open a contest log of the appropriate contest type, make sure the Mode category includes DIGITAL, and in the
Entry window, put N1MM+ into WSJT-X/JTDX mode (e.g. by typing FT8 or FT4 into the call sign box and pressing Enter).

Callsign Colors – What do the callsign colors mean?

The callsign colors displayed by WSJT Decode List and transferred as background colors to callsigns in the Band Activity
window in WSJT-X/JTDX are derived from your N1MM+ settings found in the > Config > Manage Skins, Colors, and Fonts
> Colors window under 3. Callsign Background Colors. By default those colors are:

Grey = dupe or non-workable (zero-point contact)
Blue = normal (new contact but not a new multiplier)
Red = new multiplier
Green = double multiplier (not applicable in contests supported by WSJT-X at this time, but may apply in future)

These background colors are separate from the background colors used in WSJT-X/JTDX itself. Those colors apply to the
entire line, and are selectable from the WSJT-X/JTDX Settings window under the Colours tab. The multiplier colors from
N1MM+ apply to the callsign only, not to the rest of the line.

Serial Numbers – Will serial numbers from the two programs be in sequence?

In a word, no. If you make some contacts from N1MM+ (in RTTY, for example) and some contacts from WSJT-X (in FT8, for
example), the serial number sequences from the two programs will not be in sequence. There is no way for WSJT-X to know
what serial numbers you have used in N1MM+, so it will issue its own serial numbers independently of what N1MM+ does and
vice versa. Don’t try to edit serial numbers after the fact to make the sequence look pretty – just accept whatever the two
programs generate. Contest managers will accept this; what matters most is that your log reflects accurately what your
software actually sent.

What do I need to do to switch between CW/SSB/RTTY and FT8?

Once N1MM+ and WSJT-X/JTDX have been configured correctly, you can switch from CW/SSB/RTTY to JT modes simply by
typing either FT8 or FT4 into the Entry window’s call sign box and pressing Enter. Alternatively, you can use the N1MM+ Entry
Window’s > Window > Load WSJT/JTDX menu item. Doing either of these will not automatically change the frequency or the
WSJT-X/JTDX operating mode. Use the Mode menu in the WSJT-X/JTDX menu to select the operating mode. If this does not
automatically tune the radio to the desired dial frequency, use the frequency selector in the WSJT-X/JTDX operating window
to choose the dial frequency you wish to operate on.

To change modes from WSJT-X/JTDX to CW/SSB/RTTY/PSK, you must first clear the DX Call box in WSJT-X/JTDX and then
close the WSJT-X/JTDX window. Once that action has completed, you can switch modes by using a Band Panel button, or if
that does not work, by typing CW, SSB, USB, LSB, FM, RTTY or PSK31 (as appropriate) into the Entry window’s call sign box
and pressing the Enter key. This should automatically close the Decode List window; if that window does not close
automatically, close it using the X in the top right corner of the window. If the radio’s frequency does not change to an
appropriate frequency for the mode you want to use, type the desired frequency in kHz into the call sign box and press Enter.
From this point on, normal operation in N1MM+ should resume.

In JT modes, make sure the rig’s IF filtering is appropriate for FT8/FT4 (wide), and using the frequency selector in WSJT-X,
tune the radio to a frequency where contest FT8 or FT4 QSOs are taking place (on the HF bands, the regular non-contest FT8
frequencies are generally not good places to try to make contest QSOs – you can add contest frequencies to the frequency
list in the WSJT-X Settings window to make this easier).

Note that if you leave WSJT-X running with the WSJT Decode List window active while you are trying to make CW/SSB/RTTY
contacts using the same Entry window, WSJT-X will take control of the N1MM+ Entry window and you may be unable to log
contacts. WSJT-X is persistent in sending the characters from its DX Call field into N1MM+’s Entry Window callsign field. Even
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if DX Call is empty (blank) it sends a blank to N1MM+ – wiping out anything you may try to enter in N1MM+. You must close
the WSJT Decode List window and the WSJT-X program when operating from N1MM+. Conversely, you must do all of your
FT8 and FT4 operating from WSJT-X. Do not try to enter anything into the N1MM+ Entry window while WSJT-X is active and
the WSJT Decode List window is open.

If N1MM+ is configured for SO2R, you can use the above technique to change modes for either radio. Alternatively, in a multi-
mode contest you could have one radio set up for WSJT modes and use the other radio for CW/SSB/RTTY/PSK modes.
WSJT-X would maintain control over the Entry window for its radio, but the other Entry window would operate normally in
other modes. Since N1MM+ does not normally allow both radios in SO2R to be on the same band, when changing modes
while remaining on the same band you might have to QSY the inactive radio to a different band.

Why are my FT8 and FT4 contacts being scored with zero points?

If your FT8 and FT4 contacts are being assigned zero points in the Log and Score Summary windows, it is likely that you have
selected the wrong Mode category in the N1MM+ contest setup. Use the File > Open Log in Database… menu item to open
the contest setup dialog window, and change the Mode category from RTTY to DIGITAL (ARRL RTTY contest), or from
SSB+CW to SSB+CW+DIGITAL (VHF contests, general DX logging).

The logging interface into N1MM+ does not refresh the contest score when you change the contest category. Use the > Tools
> Rescore Current Contest menu item to rescore previously-logged QSOs, and the score should be accurate thereafter (as
long as you don’t change contest settings again).
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Supported Contests List
2019-03-29

Supported Contests List
Types of Contests in the List
DX, DXpedition, general = General Contest Logging (all modes)

hf cw&ssb = Supported HF Contests – CW and SSB. All contests are supported ‘both’ sides unless specifically mentioned.

qso party =QSO Parties (CW/SSB)

United States
The QSO parties listed below are supported by N1MM Logger+.
Select: QSOPARTY and select the correct state in the dropdown box which will appear.
The QSO parties use a configuration file named ‘QSOparty.sec’ with the used sections per QSO party.
See the QSO Party Setup Instructions for more information on QSO parties in general and some specifics.
There are some scoring anomalies with some of the QSO parties.

Canada =Province and Sponsor Link
Other QSO Parties = MARAC

vhf = Supported VHF CW and SSB Contests. All contests are supported ‘both’ sides unless specifically mentioned.

digital, rtty & psk = Supported RTTY, PSK, and other digital mode Contests

udc = Supported User Defined Contests (UDC). See the installation and setup instructions for UDCs HERE.

The Supported Contests Tables

DX, DXpedition, and General Purpose Contests

Name
Setup Link

Spons
or

Rules
Comments / Description

DX – Sent RST. Received RST fields. Name and Comment field

DXPEDITI
ON – Only has Sent and Received RST fields

DXSERIAL – Sent and received RST. Nr fields and a Comment field for Generic Serial number contests. Default
multipliers and points.

DXSATELL
IT – Only three fields: Call. Grid and Satellite

VHFDX – Sent RST. Received RST fields. Grid and Comment field

VHFSERIA
L – Sent and received RST. Nr fields and Grid fields. For generic VHF serial number contests.

Comments possible.

How to Find Your Contest in These Tables
These tables can be overwhelming when looking for a contest and not quite sure of its name. If you know a word
that is likely to apply to your contest, use your browser’s search feature (usually invoked with <crtl>+F) to find that
word/expression somewhere on this page.
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HF – SSB and CW Contests

Name
Setup
Link

Spo
nsor
Rule

s
Comments / Description

9ACW RUL
ES Croatian CW Contest. CW only; 3rd full weekend in December

AGCW RUL
ES AGCW Happy New Year. Happy New Year

ALLASI
ACW

RUL
ES All Asian DX contest CW. CW – Third Saturday of June (48 hours)

ALLASI
ASSB

RUL
ES All Asian DX contest SSB. SSB – First Saturday of September (48 hours)

APSCW RUL
ES Asia-Pacific Sprint Contest CW. In Spring. Summer. Fall (2 hours)

APSSS
B

RUL
ES Asia-Pacific Sprint Contest SSB. In Spring. Summer. Fall (2 hours)

ARCI RUL
ES

ARCI QRP Contests. This contest supports 7 ARCI QRP contests plus several other QRP contests with
similar exchanges

ARCI RUL
ES

Michigan QRP Contest. This contest supports 4 Michigan QRP contests. Select ARCI contest (same
rules)

ARIDX RUL
ES Italian Radio International DX Contest. Per version 4.0.63

ARRL10
M

RUL
ES ARRL 10 Meter contest. –

ARRL16
0

RUL
ES ARRL 160-meter contest. –

ARRLD
XCW

RUL
ES ARRL International DX contest CW. –

ARRLD
XSSB

RUL
ES ARRL International DX contest Phone

ARRL-
SCR

RUL
ES ARRL School Club Roundup. 5-day events in mid-February and mid-October

ASRUC
HAMP

RUL
ES Asiatic Russia Championship. January. 6 hours. 160-40 meters. SSB/CW

BALTIC RUL
ES

Lithuation Radio Sports Federation contest. Every year the next to last weekend in May – one week
before WPX CW Contest

BFRRC
W n/a Belarus (only) CW Championship. For Belarus stations only

BFRRS
SB n/a Belarus (only) SSB Championship. For Belarus stations only

BSCI RUL
ES Black Sea Cup International. First full weekend in February

CNCW RUL
ES CNCW Spanish contest. Local Spanish CW contest
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Name
Setup
Link

Spo
nsor
Rule

s
Comments / Description

CQ160C
W

RUL
ES CQ World-Wide 160 Meter DX Contest – CW

CQ160S
SB

RUL
ES CQ World-Wide 160 Meter DX Contest – Phone

CQM RUL
ES CQ-M International DX contest. Second weekend of May

CQMMD
X

RUL
ES CQMM DX Contest. International Manchester Mineira contest by CWJF – 3rd full weekend of April

CQSAS
SB n/a CQ South America SSB Contest (inactive). South America. Second full weekend in October

CQWPX
CW

RUL
ES CQ World Wide WPX contest – CW

CQWPX
SSB

RUL
ES CQ World Wide WPX contest – Phone

CQWW
CW

RUL
ES CQ World Wide DX contest – CW. CW – Last full weekend of November (48 hours)

CQWW
SSB

RUL
ES CQ World Wide DX contest – SSB. SSB – Last full weekend of October (48 hours)

CWOPS RUL
ES CWops Mini-CWT Test. Several 1-hour contests each week

CWOPS
OPEN

RUL
ES CWops CW Open. in late August or early September

DARC1
0M

RUL
ES German Amateur Radio Club. DARC 10 meter contest. 2nd full weekend in January

DIGCW RUL
ES

German Amateur Radio Club. CW: Second weekend in April. Also for short contests in June and
October

DIGSSB RUL
ES

German Amateur Radio Club. SSB: Second weekend in March. also for short contests in June and
October

DZCUP RUL
ES Russian UA1DZ Memorial Cup. For English text select on top Translate to English

ECLIPS
E

RUL
ES Solar Eclipse QSO Party (2017, 2023, 2024). Includes digital modes as well as CW, SSB

EQSO n/a Elecraft QSO Party (inactive). Despite the name. handled as a separate contest

EUAS-
CHAMP

RUL
ES EurAsia Contest. EurAsia HamRadio Championship Contest

EUHFC RUL
ES

European (only) HF Championship. EU -to- EU station contacts. First Saturday in August (12:00 – 23:59
UTC)

EUSCW n/a European Sprint (inactive). In April and October. both modes. 4 hours

EUSSS
B n/a European Sprint (inactive). In April and October. both modes. 4 hours

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQ160CW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQ160CW
https://cq160.com/
https://cq160.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQ160SSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQ160SSB
https://cq160.com/
https://cq160.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQM
https://cqm.srr.ru/en-rules/
https://cqm.srr.ru/en-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQMMDX
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQMMDX
http://www.cqmmdx.com/rules/
http://www.cqmmdx.com/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQSASSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQSASSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQWPXCW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQWPXCW
https://www.cqwpx.com/
https://www.cqwpx.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQWPXSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQWPXSSB
https://www.cqwpx.com/
https://www.cqwpx.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQWWCW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#CQWWCW
https://cqww.com/
https://cqww.com/
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https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#DIGCW
https://diplom-interessen-gruppe.info/downloads/dig-qso-party/
https://diplom-interessen-gruppe.info/downloads/dig-qso-party/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#DIGSSB
https://diplom-interessen-gruppe.info/downloads/dig-qso-party/
https://diplom-interessen-gruppe.info/downloads/dig-qso-party/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#DZCUP
https://www.qrz.ru/contest/detail/543.html/
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FD RUL
ES ARRL Field Day contest. See ARRL Field Day Setup instructions.

FDGOT
A

RUL
ES ARRL Field Day GOTA station log. See FDGOTA setup instructions

FDREG
1 n/a International Amateur Radio Union. Varying rules for Belgium. Germany. United Kingdom (SSB and

CW). Netherlands. Switzerland. Ireland (only CW). Italy. Slovenia (S5) and Russia (UA. UA2. UA9)

FOCBW
QP

RUL
ES First Class Operators Club QSO Party. First Class Operators Club (FOC) QSO Party

FOCCW RUL
ES

First Class Operators Club Marathon. First Class Operators Club (FOC) Marathon. First full weekend in
February

GACW RUL
ES GACW WW South America CW DX contest. Second weekend in June. CW only

GCUP RUL
ES Yuri Gagarin International DX Contest. April; CW. HF plus satellites

HADX RUL
ES Hungarian Amateur Radio DX contest. 3rd full weekend in January

HAMSPI
RCW

RUL
ES Ham Spirit CW

HAMSPI
RSSB

RUL
ES Ham Spirit SSB

HELVET
IA

RUL
ES Helvetia Contest

HOLYLA
ND

RUL
ES Holyland contest

HSCCW RUL
ES High Speed CW Contest -HSC CW

IARU RUL
ES

International Amateur Radio Union HF Contest. International Amateur Radio Union – The second full
weekend of July

IOTA RUL
ES RSGB Islands On The Air Contest

JADOM
ESTIC n/a Japan (only) domestic contest. Generic support for Japanese domestic contests

JIDXCW RUL
ES Japan International DX Contest. CW: 2nd full weekend of April Sat. 0700 UTC – Sun. 1300 UTC

JIDXSS
B

RUL
ES Japan International DX Contest. SSB: 2nd full weekend of November Sat. 0700 UTC – Sun. 1300 UTC

JTDX n/a Mongolian DX Contest. Third weekend in November. CW or SSB (inactive)

KINGEA
CW

RUL
ES King of Spain contest – CW

KINGEA
SSB

RUL
ES King of Spain contest – SSB
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LOTWC
W n/a Logbook Of The World contest – CW (inactive)

LOTWS
SB n/a Logbook Of The World contest – SSB (inactive)

LZDX RUL
ES

Bulgarian Federation DX contest. The weekend before the last full weekend of November (weekend
before CQWW CW)

LZOPE
N n/a Bulgarian Federation Open and LZ Sprint contests. For all three contests. LZ Open and both sprint

contests (40/80 meter)

MINITE
STCW

RUL
ES Minitest CW Test. CW:Almost every Wednesday 1800-1900Z

NAQPC
W

RUL
ES North American QSO Parties – CW. CW: Second full weekend in January. First full weekend in August

NAQPS
SB

RUL
ES North American QSO Parties – SSB. SSB: Third full weekend in January. Third full weekend in August

NAVAL RUL
ES International Naval Contest

NRAUC
W

RUL
ES Nordic Radio Amateur Union-Baltic contest – CW. 2nd full weekend in January

NRAUS
SB

RUL
ES Nordic Radio Amateur Union-Baltic contest – SSB. 2nd full weekend in January

NRRLVI
NTER

RUL
ES Norwegian RRL Winter Contest. March. Rules in Norwegian

OCEANI
ACW

RUL
ES Oceania contest – CW. CW: Second weekend in October

OCEANI
ASSB

RUL
ES Oceania contest – SSB. SSB: First weekend in October

OKOMD
X

RUL
ES

Czech and Slovak Republics DX contest (CW version only). Second full weekend in November
The OK/OM DX SSB contest in April now has the same rules. See the UDC_OKOMDXSSB contest type
in the list of UDC contests.

PABEKE
RCW

RUL
ES

Netherlands – PA-beker – CW. Second full weekend in November
Local Dutch CW and SSB contest

PABEKE
RSSB

RUL
ES

Netherlands – PA-beker – SSB. Second full weekend in November
Local Dutch CW and SSB contest

PACC RUL
ES Netherlands – PACC contest. First full weekend of February

PORTU
GAL

RUL
ES Portugal Day Contest. Second Saturday of June

QCWAQ
SO

RUL
ES

Quarter Century Wireless Association – QCWA QSO Party. Despite the name. treated as a separate
contest

RAC RUL
ES RAC Canada Day Contest / RAC Canada Winter Contest. Both contests have the same rules
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RAEM RUL
ES Russian Amateur Radio Union – RAEM Contest (E.T.Krenkel contest). Fourth full weekend of December

RCCCU
P

RUL
ES Russian Contest Club Cup. First weekend in May

RDAC RUL
ES Russian District Award Contest

REFCW RUL
ES French REF DX contest. CW: last weekend of January

REFSS
B

RUL
ES French REF DX contest. SSB: last weekend of February

RFCCW RUL
ES

Cup of the Russian Federation – CW. Internal Russian contest in January – see also RTTY version
below

RFCHA
MP

RUL
ES Russion Federation (only) RF Championship. For English text select on top Translate to English

RFCSS
B

RUL
ES

Cup of the Russian Federation – SSB. Internal Russian contest in January – see also RTTY version
below

ROPOC
O

RUL
ES RSGB ROPOCO. Now ROLO(cator) RSGB contest

RRCW RUL
ES ARRL Rookie Roundup – CW. SSB in April. RTTY in August. CW in December

RRSSB RUL
ES ARRL Rookie Roundup – SSB. SSB in April. RTTY in August. CW in December

RRTC RUL
ES Russian Radiosport Team Championship. Third Saturday in July

RRTCT RUL
ES Russian Radiosport Team Championship. Third Saturday in July

RSGB1
60CW

RUL
ES

RSGB 160 Meter CW contests. CW only. In RSGB1st160CW in February and RSGB2nd160CW in
November

RSGB2
128 n/a RSGB 21/28 MHz contest (inactive)

RSGB8
0MCC

RUL
ES RSGB 80 Meter Club Championship

RSGBA
FS-C

RUL
ES RSGB Affiliated Societies Contests – CW

RSGBA
FS-S

RUL
ES RSGB Affiliated Societies Contests – SSB

RSGBB
ERU

RUL
ES RSGB Commonwealth Contest. British Commonwealth stations only

RSGBC
LUB

RUL
ES RSGB Club Calls contest
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https://www.qrz.ru/contest/detail/24.html
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https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGB160CW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGB160CW
https://www.rsgbcc.org/hf/rules/2020/r160m.shtml
https://www.rsgbcc.org/hf/rules/2020/r160m.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGB2128
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGB2128
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGB80MCC
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGB80MCC
https://www.rsgbcc.org/hf/rules/2020/r80mcc.shtml
https://www.rsgbcc.org/hf/rules/2020/r80mcc.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBAFS-C
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBAFS-C
https://www.rsgbcc.org/hf/rules/2020/rafs.shtml
https://www.rsgbcc.org/hf/rules/2020/rafs.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBAFS-S
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBAFS-S
https://www.rsgbcc.org/hf/rules/2020/rafs.shtml
https://www.rsgbcc.org/hf/rules/2020/rafs.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBBERU
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBBERU
https://www.rsgbcc.org/hf/rules/2020/rberu.shtml
https://www.rsgbcc.org/hf/rules/2020/rberu.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBCLUB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBCLUB
https://www.rsgbcc.org/hf/rules/2019/rclubcalls.shtml
https://www.rsgbcc.org/hf/rules/2019/rclubcalls.shtml
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RSGBD
X

RUL
ES RSGB DX contest

RSGBL
P

RUL
ES RSGB Low Power Contest

RUSSIA
NDX

RUL
ES Russian DX

RUSYL
OM

RUL
ES Russian YL/OM contest. in Russian

SACCW RUL
ES Scandinavian Activity Contest – SAC – CW. Scandinavian Activity Contest

SACSS
B

RUL
ES Scandinavian Activity Contest – SAC – SSB. Scandinavian Activity Contest

SAMOV
AR

RUL
ES Samovar CW Contest – 3rd full weekend of April

SPDX RUL
ES Polish Amateur Radio – SP DX contest. First full weekend of April (15:00-15:00 GMT)

SPRINT
CW

RUL
ES

North American Sprint – CW. CW: First Sunday in February. Sunday following first Monday in
September

SPRINT
LADD

RUL
ES NS Sprint and Sprint Ladder. Northern CA Contest Club. Both contests are weekly. CW only. see setup

SPRINT
NS

RUL
ES NS Sprint and Sprint Ladder. Northern CA Contest Club. Both contests are weekly. CW only. see setup

SPRINT
SSB

RUL
ES

North American Sprint – SSB. SSB: Sunday of first full weekend in February. Second Sunday following
first Monday in September

SSCW RUL
ES ARRL November Sweepstakes CW

SSSSB RUL
ES ARRL November Sweepstakes SSB

STEWP
ERRY

RUL
ES Stew Perry Topband Distance Challenge. Last full weekend of December

SYLRA RUL
ES Scandinavian YL – SYLRA contest

TRCDX RUL
ES Bulgaria. Thracian Rose Club – TRC DX Contest

UBACW RUL
ES

Belgium Amateur Radio – UBA DX Contest – CWSB. SSB: last weekend of January
CW: last weekend of February

UBAON RUL
ES

Belgium Amateur Radio – UBA ON contest. Last Sunday September: 6 m Phone/CW
First Sunday October: HF – 80 m SSB
Second Sunday October: HF – 80 m CW
Third Sunday October: 2 m Phone/CW

UBASP
RING

RUL
ES

Belgium Amateur Radio – UBA Spring. Second Sunday March: HF – 80m CW
Third Sunday March: VHF-6m Phone/CW
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https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBDX
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBDX
https://www.rsgbcc.org/hf/rules/2020/rOctoberDX.shtml
https://www.rsgbcc.org/hf/rules/2020/rOctoberDX.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBLP
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RSGBLP
https://www.rsgbcc.org/hf/rules/2020/rqrp.shtml
https://www.rsgbcc.org/hf/rules/2020/rqrp.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RUSSIANDX
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RUSSIANDX
http://www.rdxc.org/asp/pages/rulesg.asp
http://www.rdxc.org/asp/pages/rulesg.asp
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RUSYLOM
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#RUSYLOM
http://radio.ru/
http://radio.ru/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SACCW
https://www.sactest.net/blog/
https://www.sactest.net/blog/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SACSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SACSSB
https://www.sactest.net/blog/
https://www.sactest.net/blog/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SAMOVAR
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SAMOVAR
http://www.samovar-contest.ru/en/rules.html
http://www.samovar-contest.ru/en/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPDX
https://spdxcontest.pzk.org.pl/
https://spdxcontest.pzk.org.pl/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTCW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTCW
https://ncjweb.com/Sprint-Rules.pdf
https://ncjweb.com/Sprint-Rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTLADD
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTLADD
https://www.ncccsprint.com/rules.html
https://www.ncccsprint.com/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTNS
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTNS
https://www.ncccsprint.com/rules.html
https://www.ncccsprint.com/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SPRINTSSB
https://ssbsprint.com/rules/
https://ssbsprint.com/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SSCW
http://www.arrl.org/sweepstakes
http://www.arrl.org/sweepstakes
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SSSSB
http://www.arrl.org/sweepstakes
http://www.arrl.org/sweepstakes
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#STEWPERRY
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#STEWPERRY
https://www.kkn.net/stew/
https://www.kkn.net/stew/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#SYLRA
https://www.sylra.is/
https://www.sylra.is/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#TRCDX
https://trcdx.org/contest-calendar/
https://trcdx.org/contest-calendar/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBACW
https://www.uba.be/en/hf/contest-rules/uba-dx-contest-rules/
https://www.uba.be/en/hf/contest-rules/uba-dx-contest-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBAON
https://www.uba.be/en/hf/contest-rules/on-contest/
https://www.uba.be/en/hf/contest-rules/on-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBASPRING
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBASPRING
https://www.uba.be/en/hf/contest-rules/spring-contest/
https://www.uba.be/en/hf/contest-rules/spring-contest/
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Fourth Sunday March: VHF-2m Phone/CW
First Sunday April: HF – 80m SSB

UBASS
B

RUL
ES

Belgium Amateur Radio – UBA DX Contest CW/SSB. SSB: last weekend of January
CW: last weekend of February

UBAWI
NTER

RUL
ES Belgium Amateur Radio – UBA Low Band Winter Contest. 160. 80 and 40 meters

UKEIDX
CW

RUL
ES United Kingdom and Ireland -UK / EI DX – CW

UKEIDX
SSB

RUL
ES United Kingdom and Ireland -UK / EI DX – SSB

UKRAIN
DX

RUL
ES Ukrainian DX contest. First full weekend of November

UKRCH
CW n/a Ukrainian Championship – CW

UKRCH
SSB n/a Ukrainian Championship – SSB

UNDX RUL
ES Kazakhstan Federation of Radiosport – UN DX contest. Open Kazakhstan Championship

WAECW RUL
ES Worked All Europe DX Contest – CW.

WAESS
B

RUL
ES Worked All Europe DX Contest – SSB.

WAG RUL
ES Worked All Germany contest. October. third full weekend

WFD RUL
ES Winter Field Day

WRTC RUL
ES

World Radiosport Team Championship. for on-site participants in World Radiosport Team Championship
held every 4 years – others use IARU

WWPM
C

RUL
ES

World Wide Peace Messenger Contest. 1200UTC Saturday to 1200 UTC Sunday. every second
weekend of January

XMAS RUL
ES German Amateur Radio Club. DARC Weihnachtswettbewerb – XMAS contest

YOHFD
X

RUL
ES Romanian HF DX contest, end of August

YV RUL
ES Independence of Venezuela Contest. First full weekend in July

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBASSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBASSB
https://www.uba.be/en/hf/contest-rules/uba-dx-contest-rules/
https://www.uba.be/en/hf/contest-rules/uba-dx-contest-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBAWINTER
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UBAWINTER
https://www.uba.be/en/hf/contest-rules/low-band-winter-contest/
https://www.uba.be/en/hf/contest-rules/low-band-winter-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKEIDXCW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKEIDXCW
https://www.ukeicc.com/dx-contest-rules.php/
https://www.ukeicc.com/dx-contest-rules.php/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKEIDXSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKEIDXSSB
https://www.ukeicc.com/dx-contest-rules.php/
https://www.ukeicc.com/dx-contest-rules.php/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKRAINDX
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKRAINDX
https://urdxc.org/
https://urdxc.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKRCHCW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKRCHCW
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKRCHSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UKRCHSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#UNDX
https://un-dx.ucoz.com/index/un_contest/0-6/
https://un-dx.ucoz.com/index/un_contest/0-6/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WAECW
https://www.waedc.de/
https://www.waedc.de/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WAESSB
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WAESSB
https://www.waedc.de/
https://www.waedc.de/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WAG
https://www.darc.de/der-club/referate/conteste/worked-all-germany-contest/en/rules/
https://www.darc.de/der-club/referate/conteste/worked-all-germany-contest/en/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WFD
https://winterfieldday.com/rules.php
https://winterfieldday.com/rules.php
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WRTC
https://wrtc.info/
https://wrtc.info/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WWPMC
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#WWPMC
http://www.s59dcd.si/index.php/sl/ww-pmc/ww-pmc-contest-rules
http://www.s59dcd.si/index.php/sl/ww-pmc/ww-pmc-contest-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#XMAS
https://www.darc.de/der-club/referate/conteste/weihnachtswettbewerb/en/
https://www.darc.de/der-club/referate/conteste/weihnachtswettbewerb/en/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#YOHFDX
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#YOHFDX
https://www.yodx.ro/en/
https://www.yodx.ro/en/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/#YV
http://www.radioclubvenezolano.org/
http://www.radioclubvenezolano.org/


373

QSO Parties

Name
Setup Link

Sponso
r

Rules
Comments / Description

QSOP_7QP RULES 7th Call Area – 7QP. For 7-area stations only. Others use the IN7QPNE QSO Party contest

QSOP_AK n/a Alaska – AK (inactive)

QSOP_AL RULES Alabama – AL

QSOP_AR RULES Arkansas – AR

QSOP_AZ RULES Arizona – AZ

QSOP_BC RULES British Columbia – BC

QSOP_CA RULES California – CA

QSOP_CO RULES Colorado – CO

QSOP_CT n/a Connecticut – CT. Inactive. See New England Contest NEWE

QSOP_DE RULES Delaware – DE. For Delaware in-state stations only. Others use the IN7QPNE QSO Party
contest

QSOP_GA RULES Georgia – GA

QSOP_HI RULES Hawaii – HI

QSOP_IA RULES Iowa – IA

QSOP_ID RULES Idaho – ID

QSOP_IL RULES Illinois – IL

QSOP_IN RULES Indiana – IN. For Indiana in-state stations only. Others use the IN7QPNE QSO Party contest

QSOP_IN7QP
E n/a Combined multi-state QSO Party contest. See 7QP, DE, IN and NEWE for rules for each

individual contest.

QSOP_KS RULES Kansas – KS

QSOP_KY RULES Kentucky – KY

QSOP_LA RULES Louisiana – LA

QSOP_MARA
C_ RULES MARAC County Hunters Contest

QSOP_MCC n/a Maritime QSO Party – MCC (inactive)

QSOP_MD RULES Maryland DC – MD

QSOP_MI RULES Michigan – MI

QSOP_MN RULES Minnesota – MN

QSOP_MO RULES Missouri – MO

QSOP_MT n/a Montana – MT (inactive)

QSOP_NC RULES North Carolina – NC

QSOP_ND RULES North Dakota – ND
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https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IN7QPE
http://7qp.org/new/Page.asp?content=rules
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_AK
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_AL
https://www.alabamaqsoparty.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_AR
http://www.arkqp.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_AZ
https://www.azqp.org/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_BC
https://www.orcadxcc.org/bcqp.html
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_CA
https://www.cqp.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_CO
http://ppraa.org/coqp
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_CT
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_DE
https://www.fsarc.org/qsoparty/rules.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_GA
https://gaqsoparty.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_HI
https://www.hawaiiqsoparty.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IA
http://www.w0yl.com/IAQP
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_ID
http://www.pocatelloarc.org/idahoqsoparty/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IL
http://www.w9awe.org/ILQP.html
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IN7QPE
http://www.hdxcc.org/inqp/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IN7QPE
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IN7QPE
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_KS
https://www.ksqsoparty.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_KY
http://www.kyqsoparty.org/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_LA
https://laqp.louisianacontestclub.org/laqso-rules-htm/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_LA
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_LA
http://www.marac.org/contests.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_MCC
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_MD
https://mdcqsoparty.w3vpr.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_MI
https://www.miqp.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_MN
https://www.w0aa.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_MO
http://www.w0ma.org/index.php/missouri-qso-party
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_MT
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NC
https://www.ncqsoparty.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_ND
http://ndarrlsec.com/ND20-rules.pdf
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QSOP_NE RULES Nebraska – NE

QSOP_NEWE RULES New England – NEWE. For New England stations only; Others use the IN7QPNE QSO Party
contest

QSOP_NH RULES New Hampshire – NH

QSOP_NJ RULES New Jersey – NJ

QSOP_NM RULES New Mexico – NM

QSOP_NV RULES Nevada – NV

QSOP_NY RULES New York – NY

QSOP_OH RULES Ohio – OH

QSOP_OK RULES Oklahoma – OK

QSOP_ON RULES Ontario – ON. Bonus points for county activation by rovers/mobiles are not calculated.

QSOP_OR n/a Oregon – OR (inactive – replaced by 7QP)

QSOP_PA RULES Pennsylvania – PA

QSOP_SC RULES South Carolina – SC

QSOP_SD RULES South Dakota – SD

QSOP_TN RULES Tennessee – TN

QSOP_TX RULES Texas – TX

QSOP_VA RULES Virginia – VA

QSOP_VT RULES Vermont – VT

QSOP_WA RULES Washington Salmon Run – WA

QSOP_WI RULES Wisconsin – WI. The 1.5 power multiplier is not supported. The score is stored as an integer.

QSOP_WV RULES West Virginia – WV

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NE
http://www.nebraskaqsoparty.org/rules.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_IN7QPE
https://www.neqp.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NH
http://www.w1wqm.org/nhqso/NEW_HAMPSHIRE_QSO_PARTY_RULES.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NJ
http://www.k2td-bcrc.org/njqp/njqp_rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NM
http://www.newmexicoqsoparty.org/wp/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NV
http://nvqso.com/contest-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_NY
https://www.nyqp.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_OH
https://www.ohqp.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_OK
http://k5cm.com/okqp.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_ON
http://www.va3cco.com/oqp/index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_OR
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_PA
https://www.paqso.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_SC
http://scqso.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_SD
https://www.sdqsoparty.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_TN
https://www.tnqp.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_TX
https://txqp.net/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_VA
https://www.qsl.net/sterling/VA_QSO_Party/QSOParty.htm/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_VT
https://vtqsoparty.westriverradio.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_WA
http://salmonrun.wwdxc.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_WI
http://www.warac.org/wqp/wqp.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/#QSOP_WV
https://www.qsl.net/wvsarc/wvqp/wvqp.html
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UHF / VHF Contests

Name
Setup Link
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r

Rules
Comments / Description

ARRL10GHz RULES ARRL 10 GHz & Up. Over two weekends. in August and September. See setup

ARRL222 RULES ARRL222. ARRL UHF August – ARRL 222 and Up

ARRLVHFJA
N RULES ARRL January VHF Sweepstakes. ARRL_January_VHF_Sweepstakes

ARRLVHFJU
N RULES ARRL June VHF QSO Party. ARRL_June_VHF_QSO_Party

ARRLVHFSE
P RULES ARRL September VHF QSO Party. ARRL_September_VHF_QSO_Party

CQWWVHF RULES CQ World Wide VHF Contest. July – 50 MHz and 144 MHz only

DDFM50 RULES French Amateur Radio. REF Departments contest 50 MHz

REGIOVHF RULES VRZA – Nederlandse Locator Contest. WANLC – Dutch contest. every month NB selecteer:
REGIOVHF

UKSMG RULES UKSMG sporadic-E competition.

VHFDZCUP RULES VHF UA1DZ Cup. Russian VHF contest

VHFHELV26 RULES VHF/UHF Helvetia 26 contest. Swiss VHF and up contest

VHFHGOB RULES VHF HG OB contest. Hungarian VHF contest

VHFNAC RULES Nordic Amateur Radio. NRAU Activity Contest

VHFREG1 RULES IARU Region 1 50 MHz contest. Only 50 MHz – June

VHFREG1 RULES IARU Region 1 144 MHz September. Only 144 MHz – September

VHFREG1 RULES IARU Region 1 UHF/Microwaves October. UHF and Microwaves – October

VHFREG1 n/a Other Region 1 VHF and up contests. VHF and up – March. May. July

VHFREG1 RULES Marconi Memorial VHF CW contest 144 MHz / 50 MHz. November
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https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRL10GHz
https://www.arrl.org/10-ghz-up/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRL222
https://www.arrl.org/222-mhz-and-up-distance-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRLVHFJAN
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRLVHFJAN
http://www.arrl.org/january-vhf
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRLVHFJUN
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRLVHFJUN
http://www.arrl.org/june-vhf/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRLVHFSEP
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#ARRLVHFSEP
https://www.arrl.org/contest-calendar/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#CQWWVHF
https://www.cqww-vhf.com/rules.htm/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#DDFM50
https://concours.r-e-f.org/reglements/actuels/reg_ddfm50_fr_201703.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#REGIOVHF
https://www.vrza.nl/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#UKSMG
https://www.uksmg.org/contest/summer-contest-rules.php/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFDZCUP
http://www.tularadio.ru/ua1dz/en/rules.htm/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFHELV26
https://www.uska.ch/amateurfunkpraxis/contest/schweizer-contest-uhfvhf/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFHGOB
http://www.mrasz.org/ha-contest/international-vhf-uhf-and-shf-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFNAC
https://vushf.dk/contest/rules/nac-open/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFREG1
https://www.iaru-r1.org/wp-content/uploads/2019/08/contest-rules-2.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFREG1
https://www.iaru-r1.org/wp-content/uploads/2019/08/contest-rules-2.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFREG1
https://www.iaru-r1.org/wp-content/uploads/2019/08/contest-rules-2.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFREG1
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/#VHFREG1
https://www.rsgbcc.org/cgi-bin/contest_rules.pl?year=2018&contest=144marconi
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Digital, RTTY, and PSK Contests

Name
Setup Link

Spon
sor

Rules
Comments / Description

FTROUND
UP

RULE
S

FT Roundup (formerly 10 Meter RTTY Contest (AA5AU / W0YK)). First full weekend of December
(contest rules same as ARRL RTTY Roundup)

ANATOLR
TTY n/a Anatolian RTTY contest (discontinued). Third full weekend in May

ARRLIDC RULE
S

ARRL International Digital Contest (June). First full weekend in June. All digital modes except for
RTTY.

ARRLRTT
Y

RULE
S ARRL RTTY Roundup (January). First full weekend of January (not on January 1)

BAR75RTT
YS

RULE
S BARTG Sprint75 contest (April. 75 baud RTTY. April. September (4 hours each)

BARTGRT
TYS

RULE
S BARTG RTTY Sprint contest (January). Fourth full weekend of January

BARTGSR
TTY

RULE
S BARTG HF RTTY contest (formerly Spring RTTY Contest). Third full weekend in March

CISDXRTT
Y n/a CIS DX RTTY contest (discontinued). QPSK63 in 2009/2010. Third full weekend of September

CQWPXRT
TY

RULE
S CQ World Wide WPX – RTTY. Second full weekend of February

CQWWRT
TY

RULE
S CQ World Wide DX – RTTY. Last full weekend of September (48 hours)

DARCRTT
Y

RULE
S DARC RTTY Jan, Apr, Jul, Oct. use XMAS Module

DLDXRTT
Y

RULE
S German DL-DX RTTY contest. First full weekend of July

DMCRTTY n/a Digital Modes Club Contest (discontinued). Third full weekend of July

DRCGWW
RTTY

RULE
S German WW RTTY contest

EAPSK RULE
S Spanish Radio Union. EA PSK63 contest. Second full weekend of March

EARTTY RULE
S Spanish Radio Union. EA RTTY contest. First full weekend of April

EPCPSK6
3QP n/a EPC PSK63 QSO party (discontinued). PSK63. Third full weekend of November

EPCRUDX n/a EPC RU DX Contest (discontinued). March BPSK63

EPCWWD
X n/a EPC PSK World Wide DX (discontinued). PSK63. First weekend in February

EUPSKDX RULE
S European PSK DX contest. PSK63. Third full weekend of May

FTROUND
UP

RULE
S FT Roundup contest. (formerly 10 Meter RTTY)
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https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#ft-roundup
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#ft-roundup
https://www.rttycontesting.com/ft-roundup/rules/
https://www.rttycontesting.com/ft-roundup/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#ANATOLRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#ANATOLRTTY
https://n1mmwp.hamdocs.com/manual-supported/contests-setup/setup-digital-contests/#arrl-international-digital-contest
http://www.arrl.org/arrl-digital-contest
http://www.arrl.org/arrl-digital-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#ARRLRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#ARRLRTTY
https://www.arrl.org/rtty-roundup/
https://www.arrl.org/rtty-roundup/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#BAR75RTTYS
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#BAR75RTTYS
http://s3.spanglefish.com/s/7850/documents/contests/sprint75/rules/current/bartg%20sprint%2075%20rules.pdf
http://s3.spanglefish.com/s/7850/documents/contests/sprint75/rules/current/bartg%20sprint%2075%20rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#BARTGRTTYS
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#BARTGRTTYS
http://s3.spanglefish.com/s/7850/documents/contests/sprint/rules/current/bartg%20sprint%20rules%202017.pdf
http://s3.spanglefish.com/s/7850/documents/contests/sprint/rules/current/bartg%20sprint%20rules%202017.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#BARTGSRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#BARTGSRTTY
http://s3.spanglefish.com/s/7850/documents/contests/hf/rules/current/bartg%20hf%20rules%20issued%202017-02-10.pdf
http://s3.spanglefish.com/s/7850/documents/contests/hf/rules/current/bartg%20hf%20rules%20issued%202017-02-10.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#CISDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#CISDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#CQWPXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#CQWPXRTTY
https://www.cqwpxrtty.com/rules.htm/
https://www.cqwpxrtty.com/rules.htm/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#CQWWRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#CQWWRTTY
https://www.cqwwrtty.com/rules.htm/
https://www.cqwwrtty.com/rules.htm/
https://www.darc.de/der-club/referate/conteste/rtty-kurz/darc-rtty-contest-english-version/darc-rtty-rules/
https://www.darc.de/der-club/referate/conteste/rtty-kurz/darc-rtty-contest-english-version/darc-rtty-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#DLDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#DLDXRTTY
https://drcg.de/
https://drcg.de/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#DMCRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#DRCGWWRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#DRCGWWRTTY
https://drcg.de/
https://drcg.de/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EAPSK
https://concursos.ure.es/en/eapsk63/bases/
https://concursos.ure.es/en/eapsk63/bases/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EARTTY
https://concursos.ure.es/en/eartty/bases/
https://concursos.ure.es/en/eartty/bases/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EPCPSK63QP
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EPCPSK63QP
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EPCRUDX
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EPCWWDX
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EPCWWDX
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#EUPSKDX
https://eupsk.club/eupskdx/eupskdxrules.pdf
https://eupsk.club/eupskdx/eupskdxrules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#FTROUNDUP
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#FTROUNDUP
https://www.rttycontesting.com/ft-roundup/
https://www.rttycontesting.com/ft-roundup/
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Name
Setup Link

Spon
sor

Rules
Comments / Description

JARTSWW
RTY

RULE
S Japan Amateur Radio Telegraphy. Third full weekend in October

JTDXRTTY n/a Mongolian RTTY (discontinued). Second full weekend in January

LOTWRTT
Y n/a LOTW RTTY contest. Contest discontinued.

MAKRORT
TY

RULE
S Makrothen RTTY contest. Second full weekend in October

NAQPRTT
Y

RULE
S

North American QSO Parties (NAQP) – RTTY. Last full weekend in February. Third full weekend in
August

OKDXRTT
Y

RULE
S Czech Amateur Radio. OK DX RTTY contest. Third full weekend in December

RFCDIGI RULE
S Russian Federation Digital contest (SRR DIGI CUP). Second weekend of September

RRRTTY RULE
S ARRL Rookie Roundup RTTY (April. Third Sunday of August

RUCUPRT
TY

RULE
S Do not use – use RFCDIGI instead.

RUSDXRT
TY

RULE
S Russian WW RTTY contest. RTTY. First Saturday of September

RUS-WW-
DIG

RULE
S Russian WW Digital. First weekend in October

RUS-WW-
MM

RULE
S Russian WW MultiMode. Dates variable.

RUS-WW-
PSK

RULE
S Russian WW PSK Contest. Russian WorldWide PSK. Third weekend in February

SARTGNY
RTY

RULE
S Scandinavian Amateur Radio. SARTG New Year RTTY. January 1st

SARTGRT
TY

RULE
S Quick PSK63 contest. PSK63. Uses SARTG rules. First Saturday of September

SARTGRT
TY

RULE
S Scandinavian Amateur Radio. SARTG WW RTTY. Third weekend in August

SCCRTTY n/a Slovenia Contest Club SCC RTTY Championship. (discontinued – replaced by WW-DIGI FT4/8
Contest). (Use for RYOPSWW) Last full weekend in August

SPDXRTT
Y

RULE
S Polish Amateur Radio. SP DX RTTY contest. 4th full weekend of April

SPRINTRT
TY

RULE
S

North American Sprint – RTTY. Sunday of second full weekend in March. Sunday of second full
weekend in October

TARAGRID n/a TARA Grid Dip contest (discontinued). RTTY and PSK. First Saturday of August

TARAPSK n/a TARA PSK Rumble (discontinued). PSK31. First Saturday of October

TARAPSK n/a TARA Skirmish (discontinued). Digital. Third Saturday of April
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https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#JARTSWWRTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#JARTSWWRTY
http://jarts.jp/rules2019.html
http://jarts.jp/rules2019.html
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#JTDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#LOTWRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#LOTWRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#MAKRORTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#MAKRORTTY
https://www.pl259.org/makrothen/makrothen-rules/
https://www.pl259.org/makrothen/makrothen-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#NAQPRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#NAQPRTTY
https://ncjweb.com/NAQP-Rules.pdf
https://ncjweb.com/NAQP-Rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#OKDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#OKDXRTTY
http://okrtty.crk.cz/index.php?page=english
http://okrtty.crk.cz/index.php?page=english
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RFCDIGI
https://www.qrz.ru/contest/detail.phtml?id=86/
https://www.qrz.ru/contest/detail/86.html
https://www.qrz.ru/contest/detail/86.html
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RRRTTY
https://www.arrl.org/rookie-roundup/
https://www.arrl.org/rookie-roundup/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUCUPRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUCUPRTTY
https://www.qrz.ru/contest/detail/86.html
https://www.qrz.ru/contest/detail/86.html
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUSDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUSDXRTTY
https://www.qrz.ru/contest/detail/93.html
https://www.qrz.ru/contest/detail/93.html
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUS-WW-DIG
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUS-WW-DIG
http://www.rdrclub.ru/rdrc-news/russian-ww-digital-contest/51-rus-ww-digi-rules
http://www.rdrclub.ru/rdrc-news/russian-ww-digital-contest/51-rus-ww-digi-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUS-WW-MM
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUS-WW-MM
http://www.rdrclub.ru/news-radio/russian-ww-mm-contest/159-rus-ww-multimode-contest
http://www.rdrclub.ru/news-radio/russian-ww-mm-contest/159-rus-ww-multimode-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUS-WW-PSK
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#RUS-WW-PSK
http://www.rdrclub.ru/russian-ww-psk-contest/49-rus-ww-psk-rules
http://www.rdrclub.ru/russian-ww-psk-contest/49-rus-ww-psk-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SARTGNYRTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SARTGNYRTY
http://www.sartg.com/contest/nyrules.htm
http://www.sartg.com/contest/nyrules.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SARTGRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SARTGRTTY
http://www.sartg.com/contest/wwrules.htm
http://www.sartg.com/contest/wwrules.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SARTGRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SARTGRTTY
http://www.sartg.com/contest/wwrules.htm
http://www.sartg.com/contest/wwrules.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SCCRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SPDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SPDXRTTY
https://pkrvg.org/strona,spdxrttyen.html
https://pkrvg.org/strona,spdxrttyen.html
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SPRINTRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#SPRINTRTTY
http://ncjweb.com/Sprint-Rules.pdf
http://ncjweb.com/Sprint-Rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#TARAGRID
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#TARAPSK
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#TARAPSK
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Name
Setup Link

Spon
sor

Rules
Comments / Description

TARARTT
Y n/a TARA RTTY Melee (discontinued). RTTY. First Saturday of December

UKDXRTT
Y n/a United Kingdom DX Contest – RTTY (discontinued). Second full weekend of July

UKRAINDI
GI

RULE
S Ukrainian DX DIGI contest. RTTY 75 baud and PSK63. Fourth full weekend of June

UKRAIND
X

RULE
S Ukrainian DX Classic RTTY contest. DX Classic RTTY. Third weekend of June

UKRAINRT
TY

RULE
S Ukrainian DX Classic RTTY contest. DX Classic RTTY. Third weekend of June

UKRCHRT
TY n/a Ukrainian RTTY Championship. FOR UKRAINIAN STATION ONLY. Third weekend of April

UKRTTYO
PEN

RULE
S Ukrainian Open RTTY Championship. First full weekend of March

VOLTARTT
Y

RULE
S Volta RTTY contest. Second full weekend in May

WAERTTY RULE
S Worked All Europe. Second full weekend in November

WWDIGI RULE
S WW Digi FT8/FT4 Contest. Last full weekend in August.

XERTTY RULE
S XE RTTY (FMRE) Contest. First full weekend in February.

UDC – User Defined Contests

My Contest Isn’t Here. What Can I Do?
If the contest is not currently supported by the program there are four options:

Use the ‘User Defined Contest Editor’ to create a new contest template.
This capability is under continuous development and may undergo further change. See the User Defined
Contest Editor section.

Find another contest with a similar exchange and similar rules. If the only difference is in the scoring, you can run
the contest and create the Cabrillo file, then edit the Cabrillo file to change the contest name. You can either score the
contest manually after the contest, or enter a claimed score of zero and let the contest sponsor calculate the multipliers
and points
Use a ‘general’ contest like DXSERIAL, DX, etc. Run the contest and do the log creation after the contest using
Notepad or a similar text editor. When Cabrillo is the requested log format, create the Cabrillo log and update the
header. The contest sponsor will calculate the multipliers and points. This is the easy way to go for many small, mostly
local, contests
Submit a Feature Request for the contest to become a supported contest

Whenever someone requests support for a particular contest, it would be good to have an indication of the
number of entries the contest received during the previous year’s running. This is not to suggest that there is a
threshold below which contests will not be supported, but that knowing this is helpful in prioritizing for the people
who do the work. In the past we have had requests to support contests that had fewer than 10 entries the
previous year
Since the programmers do not have unlimited time to respond to last-minute requests, set yourself a target date
(for example, a minimum of three months prior to the next running of the contest) to allow time for programming
and proper testing
It is part of the nature of the N1MM Logger+ project that users, and particularly those users requesting support
for a particular contest, are the people who are relied upon to test and be sure the contest module does what it is
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https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#TARARTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#TARARTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKDXRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRAINDIGI
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRAINDIGI
http://www.izmail-dx.com/
http://www.izmail-dx.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRAINDX
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRAINDX
http://urdxc.org/rtty/rules.php?english
http://urdxc.org/rtty/rules.php?english
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRAINRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRAINRTTY
https://urdxc.org/rtty/
https://urdxc.org/rtty/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRCHRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRCHRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRTTYOPEN
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#UKRTTYOPEN
http://krs.ho.ua/openrtty/
http://krs.ho.ua/openrtty/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#VOLTARTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#VOLTARTTY
http://www.contestvolta.com/rules.pdf
http://www.contestvolta.com/rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/#WAERTTY
https://www.darc.de/der-club/referate/conteste/worked-all-europe-dx-contest/en/#c576/
https://www.darc.de/der-club/referate/conteste/worked-all-europe-dx-contest/en/#c576/
https://n1mmwp.hamdocs.com/manual-supported/contests-setup/setup-digital-contests/#ww-digi-contest
https://ww-digi.com/rules/
https://ww-digi.com/rules/
https://n1mmwp.hamdocs.com/manual-supported/contests-setup/setup-digital-contests/#xe-rtty-contest
https://n1mmwp.hamdocs.com/manual-supported/contests-setup/setup-digital-contests/#xe-rtty-contest
http://www.rtty.fmre.mx/FMRE_RTTY_International_contest/Rules.html
http://www.rtty.fmre.mx/FMRE_RTTY_International_contest/Rules.html
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supposed to do. It is particularly important to test far enough in advance of the running of a contest so that any
problems can be identified and fixed. Users will do well to check each contest as it is coming up, to make sure
that any rule changes are reported to the programmers in time for changes to be made.

If you identify bugs or propose contest-specific features during the running of a contest, don’t expect an immediate
response. Contest-specific things are on a calendar to be addressed before the next running. Of course, defects in Cabrillo
output are an exception, since they need to be fixed in time for score submission and can be done in the weeks after the
contest.
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Name
Setup Link

Spo
nsor
Rule

s
Comments / Description

UDC_070T
PRTTY

RUL
ES PODXS Triple Play Low Band Sprint.

UDC_070V
SRTTY

RUL
ES PODXS Valentine Sprint Contest.

UDC_13CO
LONIES

RUL
ES

13 Colonies Event. 1-7 July
For ‘Hunters’ – SESs use DX Module

UDC_1WAT
TGAME_VH
F

RUL
ES The 1 Watt Game. (Ignore ‘VHF’) Last Sunday March.

UDC_1MAY
_AGCW

RUL
ES Activity Group CW QRP-QRP Party. 1st May

UDC_4SQR
P

RUL
ES 4 States QRP Group SSS. 2nd Sun every month.

UDC_6M_
WMRTTY

RUL
ES UKSMG Winter Marathon.

UDC_A1AW
T

RUL
ES A1 Club Weekly Test.

UDC_ACHA
MPCW

RUL
ES Asian Russia Champion. Third Saturday of January

UDC_AC-
SPRING

RUL
ES ARKTIKA-SPRING.

UDC_AEGE
ANRTTY

RUL
ES AEGEAN RTTY Contest.

UDC_AGB RUL
ES Activity Group of Belarus Contests.

UDC_AGB_
RTTY

RUL
ES AGB NEMIGA/PARTY.

UDC_AGBP
ARTY

RUL
ES AGB Party.

UDC_AGC
W-NTCQP

RUL
ES AGCW-NTC-QSO-PARTY. 2nd Weekend October.

UDC_AGC
W-YL-CWP

RUL
ES AGCW YL CW Party.

UDC_AKQP
_RTTY n/a ALASKA QSO Party.

UDC_ALAR
A

RUL
ES Australian Ladies Amateur Radio Assc Contest last weekend August

UDC_ANZA
C-DAY

RUL
ES ANZAC DAY Contest. April

UDC_AMR
ALLY

RUL
ES AM Rally. First Sat. February
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#070TPRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#070TPRTTY
https://www.podxs070.com/o7o-club-sponsored-contests/triple-play-low-band-sprint
https://www.podxs070.com/o7o-club-sponsored-contests/triple-play-low-band-sprint
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#070VSRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#070VSRTTY
https://www.podxs070.com/o7o-club-sponsored-contests/valentine-sprint
https://www.podxs070.com/o7o-club-sponsored-contests/valentine-sprint
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#13COLONIES
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#13COLONIES
http://13colonies.us/
http://13colonies.us/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#1WATTGAME_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#1WATTGAME_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#1WATTGAME_VHF
https://www.facebook.com/groups/2258002451130198/posts/3184312265165874/
https://www.facebook.com/groups/2258002451130198/posts/3184312265165874/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#1MAY_AGCW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#1MAY_AGCW
http://alt.agcw.de/index.php/en/contests-and-cw-activities/qrp-qrp-party
http://alt.agcw.de/index.php/en/contests-and-cw-activities/qrp-qrp-party
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#4SQRP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#4SQRP
http://www.4sqrp.com/SSS/sss_rules.pdf
http://www.4sqrp.com/SSS/sss_rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#6M_WMRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#6M_WMRTTY
http://uksmg.org/winter-marathon-contest-rules.php
http://uksmg.org/winter-marathon-contest-rules.php
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#A1AWT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#A1AWT
https://a1club.org/contest/awt/AWTen.pdf
https://a1club.org/contest/awt/AWTen.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ACHAMPCW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ACHAMPCW
https://qrz.ru/contest/detail/64.html/
https://qrz.ru/contest/detail/64.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AC-SPRING
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AC-SPRING
https://qrz.ru/contest/detail/351.html/
https://qrz.ru/contest/detail/351.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AEGEANRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AEGEANRTTY
https://www.aegeandxgroup.gr/rtty.html
https://www.aegeandxgroup.gr/rtty.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGB
http://ev5agb.com/contest/contests.htm
http://ev5agb.com/contest/contests.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGB_RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGB_RTTY
http://www.ev5agb.com/contest/agb_nemiga.htm
http://www.ev5agb.com/contest/agb_nemiga.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGBPARTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGBPARTY
http://www.ev5agb.com/contest/agb_party.htm
http://www.ev5agb.com/contest/agb_party.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGCW-NTCQP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGCW-NTCQP
https://www.agcw.de/agcw-ntc-freundschafts-qso-party/77648/
https://www.agcw.de/agcw-ntc-freundschafts-qso-party/77648/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGCW-YL-CWP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AGCW-YL-CWP
https://agcw.org/index.php/en/contests-and-cw-activities/yl-cw-party/
https://agcw.org/index.php/en/contests-and-cw-activities/yl-cw-party/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AKQP_RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AKQP_RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ALARA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ALARA
https://www.alara.org.au/
https://www.alara.org.au/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ANZAC-DAY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ANZAC-DAY
https://www.cqcontest.info/anzac-day-contest
https://www.cqcontest.info/anzac-day-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AMRALLY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AMRALLY
http://www.amrally.com/
http://www.amrally.com/
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Name
Setup Link

Spo
nsor
Rule

s
Comments / Description

UDC_AMSA
T_FD

RUL
ES AMSAT FIELD DAY 4th Wkend June

UDC_ARCK
_MORSE

RUL
ES ARCK Morse Sings. 3rd Weekend January

UDC_LU7M
C

RUL
ES Argentina 4OM Contest. 2nd Sat October.

UDC_ARI_
BASFER n/a ARI BASSO FERRARESE Contest. 3rd Weekend December

UDC_ARI_
EME

RUL
ES ARI EME 2nd Weekend April, Last Weekend Sept

UDC_ARI_
SEZIONI

RUL
ES ARI SEZIONI. 2nd Saturday June

UDC_ARIR
TTY

RUL
ES Amateur Radio Italy 80/40m. Italian internal. 2nd weekend Dec.

UDC_ARKT
IKAPR

RUL
ES Arktika Polar Radioman.

UDC_ARRL
EMEVHF

RUL
ES ARRL-EME.

UDC_ARRL
_VOTA

RUL
ES ARRL Volunteers On The Air. All 2023

UDC_ARRR
TTY

RUL
ES ARR-Portugese PSK63. 3rd Weekend June

UDC_AUTU
MN SPRINT n/a Michurinsk Contest Group Autumn Sprint. 2nd Friday in October

UDC_BATA
VIA_FT8

RUL
ES Batavia FT8 Contest. First Weekend in August

UDC_BB_IT
ALIA

RUL
ES Bande Basse Italia Contest. Italian internal. 2nd Weekend January

UDC_BCC_
MSC

RUL
ES Bavarian Contest Club – Meteor Scatter Contest.

UDC_BCCP
ARTY

RUL
ES Bavarian Contest Club QSO Party

UDC_BDM
WWRTTY n/a Belgian Data Modes WW Contest.

UDC_BELG
O_RTTY

RUL
ES Belgorod Open Championship.

UDC_BRAI
LEICUP

RUL
ES Brailei Cup Contest. 4th Monday May

UDC_BRAZ
_IRTTY n/a Brazil Independance Day Contest.
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AMSAT_FD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AMSAT_FD
http://www.amsat.org/
http://www.amsat.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARCK_MORSE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARCK_MORSE
https://www.qrz.ru/contest/detail/235.html
https://www.qrz.ru/contest/detail/235.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LU7MC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LU7MC
https://www.lu4aa.org/wp/concurso-nacional-40m/
https://www.lu4aa.org/wp/concurso-nacional-40m/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARI_BASFER
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARI_BASFER
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARI_EME
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARI_EME
https://contests.arrl.org/ContestRules/EME-Rules.pdf
https://contests.arrl.org/ContestRules/EME-Rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARI_SEZIONI
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARI_SEZIONI
http://www.ari.it/contest-hf/contest-sezioni.html
http://www.ari.it/contest-hf/contest-sezioni.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARIRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARIRTTY
https://www.qsl.net/contest_ari/
https://www.qsl.net/contest_ari/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARKTIKAPR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARKTIKAPR
https://www.ua9qcq.com/
https://www.ua9qcq.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARRLEMEVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARRLEMEVHF
https://www.arrl.org/eme-contest/
https://www.arrl.org/eme-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARRL_VOTA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARRL_VOTA
http://www.arrl.org/volunteers-on-the-air
http://www.arrl.org/volunteers-on-the-air
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARRRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ARRRTTY
http://ct1arr.org/concursos/concurso-de-bpsk63/
http://ct1arr.org/concursos/concurso-de-bpsk63/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AUTUMN%20SPRINT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#AUTUMN%20SPRINT
https://n1mmwp.hamdocs.com/manual-supported/contests-setup/setup-udc-contests/#BATAVIA_FT8
https://n1mmwp.hamdocs.com/manual-supported/contests-setup/setup-udc-contests/#BATAVIA_FT8
https://batavia-ft8.com/
https://batavia-ft8.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BB_ITALIA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BB_ITALIA
http://www.mdxc.org/cqbbi/regolamento/
http://www.mdxc.org/cqbbi/regolamento/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BCC_MSC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BCC_MSC
http://www.bavarian-contest-club.de/
http://www.bavarian-contest-club.de/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BCCPARTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BCCPARTY
http://www.bavarian-contest-club.de/contest/
http://www.bavarian-contest-club.de/contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BDMWWRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BDMWWRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BELGO_RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BELGO_RTTY
https://www.qrz.ru/contest/detail/138.html
https://www.qrz.ru/contest/detail/138.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BRAILEICUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BRAILEICUP
https://www.radioamator.ro/
https://www.radioamator.ro/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BRAZ_IRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BRAZ_IRTTY
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Name
Setup Link

Spo
nsor
Rule

s
Comments / Description

UDC_BUCU
RESTI

RUL
ES Bucharest-HF-Contest.

UDC_BY_W
APC_BY

RUL
ES Worked All China Provinces. – Chinese stations 3rd Weekend April

UDC_BY_W
APC_DX

RUL
ES Worked All China Provinces – Non-Chinese stations

UDC_CAVT
EST

RUL
ES OK/OM CAV Contest. Every 28th September.

UDC_CAHF n/a Campeonato Argentino de HF

UDC_CARP
ATHIAN

RUL
ES Carpathian Sprint Contest. Every last Thursday each quarter.

UDC_CBJ RUL
ES Contest Battle of Jenipapo. Last Weekend April

UDC_CBNR
BRASIL

RUL
ES Battle of Riachuelo Contest

UDC_CE_
WPX

RUL
ES CHILE-WPX Contest. 3rd Weekend in September

UDC_CHER
-CUP

RUL
ES Chernozem Region Open Cup. Last Friday in December

UDC_CHER
NIGOV

RUL
ES CHERNIGOV. Cup Chernigov CW

UDC_COM
MENT n/a Comment, a UDC sample

UDC_CQW
E

RUL
ES CQ Western Electric Contest 2nd Weekend November

UDC_CQW
S

RUL
ES CQ World Scouts. 2nd Saturday April.

UDC_CSAV
HF n/a CSA-VHF.

UDC_CT_Q
RP

RUL
ES CT_QRP.

UDC_CUCA
LAMBE n/a Cuban District Contest. CUCALAMBE

UDC_CWO
PS10

RUL
ES CWOPS 10th Anniversary.

UDC_DARC
_EASTER

RUL
ES Deutschland Easter Contest.

UDC_DARC
_FT4

RUL
ES DARC FT4 Contest. 2nd Tues Feb. May, Aug. Nov.

UDC_DARC
-HSW

RUL
ES DARC HSW Contest. Last Saturday in August.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BUCURESTI
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BUCURESTI
https://yo3test201x.blogspot.com/
https://yo3test201x.blogspot.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BY_WAPC_BY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BY_WAPC_BY
http://www.mulandxc.com/index/match
http://www.mulandxc.com/index/match
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BY_WAPC_DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#BY_WAPC_DX
http://www.mulandxc.com/index/match
http://www.mulandxc.com/index/match
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CAVTEST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CAVTEST
https://contest.ok5cav.cz/
https://contest.ok5cav.cz/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CAHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CARPATHIAN
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CARPATHIAN
http://sprint.srv.if.ua/en/
http://sprint.srv.if.ua/en/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CBJ
https://hampass.org/cbjdx
https://hampass.org/cbjdx
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CBNRBRASIL
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CBNRBRASIL
https://gcen.org.br/regulamento/
https://gcen.org.br/regulamento/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CE_WPX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CE_WPX
https://chilecontest.com/
https://chilecontest.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CHER-CUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CHER-CUP
https://www.cqtest.ru/rules
https://www.cqtest.ru/rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CHERNIGOV
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CHERNIGOV
https://www.qrz.ru/contest/detail/239.html/
https://www.qrz.ru/contest/detail/239.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#COMMENT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#COMMENT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CQWE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CQWE
https://cqwe.cboh.org/rules.html
https://cqwe.cboh.org/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CQWS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CQWS
https://contestbr.org/
https://contestbr.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CSAVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CSAVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CT_QRP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CT_QRP
https://ctqrpclub.webs.com/ct-qrp-contest
https://ctqrpclub.webs.com/ct-qrp-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CUCALAMBE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CUCALAMBE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CWOPS10
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#CWOPS10
https://cwops.org/cwops-10th-anniversary-celebration/
https://cwops.org/cwops-10th-anniversary-celebration/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC_EASTER
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC_EASTER
https://www.darc.de/en/der-club/referate/conteste/darc-ostercontest/regeln/
https://www.darc.de/en/der-club/referate/conteste/darc-ostercontest/regeln/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC_FT4
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC_FT4
https://www.darc.de/der-club/referate/conteste/ft4-contest/ft4-rules/
https://www.darc.de/der-club/referate/conteste/ft4-contest/ft4-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC-HSW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC-HSW
https://www.darc.de/der-club/distrikte/w/hsw/#c280134
https://www.darc.de/der-club/distrikte/w/hsw/#c280134
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Setup Link
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nsor
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s
Comments / Description

UDC_DARC
_X

RUL
ES

DARC Thuringen Contest 3rd Weekend September
DARC Ruhr Contest 4th Weekend September

UDC_DARC
FOA

RUL
ES DARC Funktag on Air. 3rd Weekend April

UDC_DIG RUL
ES DIG QSO Party. SSB – 2nd Weekend March, CW – 2nd Weekend April.

UDC_DIG_
PA

RUL
ES DIG Club of Nederlands Contest. DIG_PA Contest – 4th Mon March/Sept

UDC_DL_D
TC

RUL
ES DL – German Telegraphy Contest. held 3rd October

UDC_DNIE
PERTTY

RUL
ES DNIEPER CUP League of Amateur Radio of Ukraine. 3 rounds/modes 1st Saturday October

UDC_DOYL
S

RUL
ES The Day of YLs Contest.

UDC_DU3M
Y_MEM

RUL
ES DU3MY Memorial. 3rd Weekend August

UDC_EACN
F

RUL
ES CONCURSO NACIONAL FONIA.

UDC_EAC
WMeet

RUL
ES EA CW MEET. Every 2nd Thurs except holidays.

UDC_EAQR
P

RUL
ES EA QRP Contest. 3rd Weekend April

UDC_EARS
VHF n/a 50RS VHF.

UDC_EASU
FF29 n/a Spanish Internal Suffixes. Suffixes XXIX National Last Sunday in January

UDC_EPCF
R

RUL
ES EPC French DX Contest.

UDC_EPC-
UKR-DX

RUL
ES EPC Ukrainian DX.

UDC_ESEN
IN

RUL
ES ESENIN Russia Contest. 1st Friday in October

UDC_ES-
LL-KV

RUL
ES Estonion Lyhilaine Karikovoistlused

UDC_ESOP
ENHF

RUL
ES ESTONIAN OPEN HF. 3rd Saturday in April

UDC_EUC
W160

RUL
ES EUCW ON5ME-160 Contest. Normally 1st Saturday in January

UDC_EUC
WFP n/a EUCW Fraternizing Party. – Discontinued

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC_X
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARC_X
https://www.darc.de/der-club/distrikte/x/thueringencontest/
https://www.darc.de/der-club/distrikte/x/thueringencontest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARCFOA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DARCFOA
https://www.darc.de/der-club/referate/conteste/funktag-on-the-air-contest-2021/
https://www.darc.de/der-club/referate/conteste/funktag-on-the-air-contest-2021/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DIG
https://diplom-interessen-gruppe.info/downloads/dig-qso-party-en/
https://diplom-interessen-gruppe.info/downloads/dig-qso-party-en/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DIG_PA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DIG_PA
http://www.dig-pa.com/
http://www.dig-pa.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DL_DTC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DL_DTC
https://www.agcw.org/index.php/en/contests-and-cw-activities/german-telegraphy-contest-dtc
https://www.agcw.org/index.php/en/contests-and-cw-activities/german-telegraphy-contest-dtc
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DNIEPERTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DNIEPERTTY
https://www.qrz.ru/contest/detail/250.html
https://www.qrz.ru/contest/detail/250.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DOYLS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DOYLS
https://ka1uln.blogspot.com/p/the-day-of-yls.html
https://ka1uln.blogspot.com/p/the-day-of-yls.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DU3MY_MEM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DU3MY_MEM
https://www.dx3h.org/2021-du3my-contest-rules
https://www.dx3h.org/2021-du3my-contest-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EACNF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EACNF
https://radioclubsevilla.com/?page_id=7
https://radioclubsevilla.com/?page_id=7
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EACWMeet
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EACWMeet
https://www.eacwspain.es/eacwmeeting/
https://www.eacwspain.es/eacwmeeting/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EAQRP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EAQRP
http://www.eaqrp.com/index.php/actividades/concurso
http://www.eaqrp.com/index.php/actividades/concurso
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EARSVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EARSVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EASUFF29
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EASUFF29
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EPCFR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EPCFR
http://epc.francophone.free.fr/
http://epc.francophone.free.fr/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EPC-UKR-DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EPC-UKR-DX
https://epc-ukraina.ucoz.com/
https://epc-ukraina.ucoz.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ESENIN
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ESENIN
https://www.qrz.ru/contest/detail/259.html
https://www.qrz.ru/contest/detail/259.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ES-LL-KV
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ES-LL-KV
https://www.erau.ee/et/69-tavakuelastajad-artiklid/356-es-ll-voistlused
https://www.erau.ee/et/69-tavakuelastajad-artiklid/356-es-ll-voistlused
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ESOPENHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ESOPENHF
https://esopen.eu/
https://esopen.eu/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EUCW160
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EUCW160
https://www.eucw.org/eu160.html
https://www.eucw.org/eu160.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EUCWFP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EUCWFP
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UDC_EU_D
XC

RUL
ES EU DX Club Contest. First Weekend February.

UDC_FELD
HELLCLUB

RUL
ES Feld Hell Club Monthly Sprints and others.

UDC_FGUP
2011

RUL
ES FGUP 2011.

UDC_FINN
DOM

RUL
ES Finland Domestic Events.

UDC_FIRA
C

RUL
ES FIRAC Contest. 2nd Sunday March and November.

UDC_FISTS
SPR

RUL
ES Fists Sprints. All Fists Sprints

UDC_FLAV
ORRTTY

RUL
ES PODXS070 PSK 31 Flavors.

UDC_FLSP
OTA

RUL
ES Florida Parks on the Air.

UDC_FLTO
TBBS

RUL
ES Flight of the Bumblebees.

UDC_FOC_
MDQP

RUL
ES FOC Memorial Day QSO Party. 1-2 November

UDC_DFCF RUL
ES French National Castle Day. 3rd Sun May

UDC_DMF RUL
ES French National Mills Day. June

UDC_FRAP
R_10M

RUL
ES FRAPR 10m Contest. Last Weekend July.

UDC_FRPH
F

RUL
ES Brazilian Farroupilha Contest.

UDC_G3ZQ
SMEM

RUL
ES Fists G3ZQS Memorial Contest – can be used for Fists Sprints

UDC_GEDE
BAGE

RUL
ES GEDEBAGE Indonesian DX Contest. 1st Friday in December

UDC_GENE
RIC n/a GENERIC – a UDC Sample.

UDC_GENE
RIC2 n/a GENERIC2 – a UDC Sample.

UDC_GENE
RRTTY n/a GENERIC RTTY – Sample DIGI UDC file.

UDC_GRID
CHASE

RUL
ES ARRL International Grid Chase.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EU_DXC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#EU_DXC
https://eudxcc.altervista.org/eu-dx-contest/
https://eudxcc.altervista.org/eu-dx-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FELDHELLCLUB
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FELDHELLCLUB
https://sites.google.com/site/feldhellclub/Home
https://sites.google.com/site/feldhellclub/Home
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FGUP2011
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FGUP2011
https://www.qrz.ru/contest/detail/239.html/
https://www.qrz.ru/contest/detail/239.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FINNDOM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FINNDOM
https://www.sral.fi/kilpailut/
https://www.sral.fi/kilpailut/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FIRAC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FIRAC
https://www.firac.de/html/contest.html
https://www.firac.de/html/contest.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FISTSSPR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FISTSSPR
https://www.fistsna.org/operating.html
https://www.fistsna.org/operating.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FLAVORRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FLAVORRTTY
https://www.podxs070.com/o7o-club-sponsored-contests/31-flavors
https://www.podxs070.com/o7o-club-sponsored-contests/31-flavors
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FLSPOTA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FLSPOTA
https://flspota.org/rules/
https://flspota.org/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FLTOTBBS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FLTOTBBS
http://arsqrp.blogspot.com/
http://arsqrp.blogspot.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FOC_MDQP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FOC_MDQP
https://www.g4foc.org/memorial-day-qso-party/
https://www.g4foc.org/memorial-day-qso-party/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DFCF
https://dfcf-dcf.pagesperso-orange.fr/jecregle.html
https://dfcf-dcf.pagesperso-orange.fr/jecregle.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#DMF
http://dmf.r-e-f.org/reglements/jnm.html
http://dmf.r-e-f.org/reglements/jnm.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FRAPR_10M
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FRAPR_10M
https://www.frapr.org/concursos/
https://www.frapr.org/concursos/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FRPHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FRPHF
https://labre-rs.org.br/wp-content/uploads/2020/08/RegulamentoHFFRP2020.pdf
https://labre-rs.org.br/wp-content/uploads/2020/08/RegulamentoHFFRP2020.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#G3ZQSMEM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#G3ZQSMEM
https://www.fistsna.org/operating.html
https://www.fistsna.org/operating.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GEDEBAGE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GEDEBAGE
http://olkb.or.id/gedebage-contest
http://olkb.or.id/gedebage-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GENERIC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GENERIC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GENERIC2
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GENERIC2
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GENERRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GENERRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GRIDCHASE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#GRIDCHASE
http://www.arrl.org/news/announcing-the-arrl-international-grid-chase
http://www.arrl.org/news/announcing-the-arrl-international-grid-chase
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UDC_HA_N
Champ

RUL
ES Hungarian National Championship. 2nd full weekend January.

UDC_HA3N
S

RUL
ES HA3NS Memorial Contest. 1st Friday in June

UDC_HAM
CATION

RUL
ES 2021 HamCation QSO Party. 2nd Weekend February.

UDC_HAM
VENT_QP n/a Hamvention QSO Party, May 16 2020 (HVQP)

UDC_HARC
QSOP

RUL
ES Halifax Amateur Radio Club 90th anniversary QSO Party.

UDC_HESS
ENCONTES
T

RUL
ES Hessen Contest. 3rd Weekend May

UDC_HINA
33RTTY

RUL
ES

Japan Ladies Radio Society – Hina 33 Contest. JLRS Hina 33 Contest held on 2nd March. (Can be
used for JLRS Party, see UBAPSK63-Read-Me for starting with high Serial Nr.)

UDC_HPM1
50

RUL
ES Hiram Percy Maxim 150th Birthday. August 31 – September 8. 2019

UDC_ICWC
_MST

RUL
ES

International CW Council Medium Speed Test. Every Monday 1300-1400Z and 1900-2000Z Every
Tuesday:  0300-0400Z

UDC_IG_W
W_RTTY

RUL
ES Interest Group RTTY Contest 2nd Full weekend April

UDC_ILLW-
2010

RUL
ES International Lighthouse Week 2010.

UDC_INDE
XAQSOP

RUL
ES INDEXA Worldwide QSO Party. First Saturday Sept.

UDC_IPA_R
C

RUL
ES International Police Association Radio Club Contest. First Weekend November

UDC_IRTS8
0M

RUL
ES Irish Radio Transmitters Society 80M. IRTS80M See Website

UDC_IRTS
CQIR

RUL
ES Irish Radio Transmitters Society CQIR. See Evening Counties Rules

UDC_IOC RUL
ES Istra Open Contest. 3rd Sunday May

UDC_JAKA
RTA n/a Indonesian Jakarta DX 40M DX Contest

UDC_JOTA-
JOTI

RUL
ES Jamboree On The Air. 2nd Weekend Oct.

UDC_JLRS
PARTY

RUL
ES JLRS Party Contest. Last weekend Sept/1st weekend Oct.

UDC_JWFD RUL
ES Jock White Memorial Field Day. Last full weekend in February

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HA_NChamp
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HA_NChamp
https://rhob.mrasz.hu/rh-ob-kiiras
https://rhob.mrasz.hu/rh-ob-kiiras
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HA3NS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HA3NS
https://radioamator.honlapepites.hu/?p=1280
https://radioamator.honlapepites.hu/?p=1280
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HAMCATION
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HAMCATION
http://www.hamcation.com/
http://www.hamcation.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HAMVENT_QP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HAMVENT_QP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HARCQSOP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HARCQSOP
http://www.halifax-arc.org/
http://www.halifax-arc.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UDC_HESSENCONTEST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UDC_HESSENCONTEST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UDC_HESSENCONTEST
https://www.darc.de/der-club/distrikte/f/hessencontest/
https://www.darc.de/der-club/distrikte/f/hessencontest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HINA33RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HINA33RTTY
https://www.jarl.com/jlrs/
https://www.jarl.com/jlrs/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HPM150
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#HPM150
https://www.arrl.org/news/arrl-announces-happy-150-hiram-percy-maxim-birthday-celebration/
https://www.arrl.org/news/arrl-announces-happy-150-hiram-percy-maxim-birthday-celebration/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MST_MST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MST_MST
https://internationalcwcouncil.org/mst-contest/
https://internationalcwcouncil.org/mst-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IG_WW_RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IG_WW_RTTY
https://igry.webs.com/
https://igry.webs.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ILLW-2010
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ILLW-2010
https://illw.net/
https://illw.net/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#INDEXAQSOP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#INDEXAQSOP
https://indexaqsoparty.com/
https://indexaqsoparty.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IPA_RC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IPA_RC
https://www.iparc.de/
https://www.iparc.de/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IRTS80M
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IRTS80M
https://www.irts.ie/cgi/st.cgi?test_calendar
https://www.irts.ie/cgi/st.cgi?test_calendar
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IRTSCQIR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IRTSCQIR
https://www.irts.ie/cgi/st.cgi?test_calendar
https://www.irts.ie/cgi/st.cgi?test_calendar
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#IOC
http://www.hamradio.hr/index.php?option=com_content&task=view&id=1511&Itemid=629
http://www.hamradio.hr/index.php?option=com_content&task=view&id=1511&Itemid=629
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JAKARTA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JAKARTA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JOTA-JOTI
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JOTA-JOTI
https://radiosportnorge.no/jota/
https://radiosportnorge.no/jota/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JLRSPARTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JLRSPARTY
https://www.jarl.com/jlrs
https://www.jarl.com/jlrs
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#JWFD
https://nzart.org.nz/amateur-radio-activities/contests/jwfd/
https://nzart.org.nz/amateur-radio-activities/contests/jwfd/
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UDC_K1US
NSST

RUL
ES K1USN CW Slow Speed (con)Test

UDC_K1US
NSSTOP

RUL
ES K1USN CW Slow Speed (con)Test Open. 2nd Friday Sept.

UDC_KANA
GAWA n/a Kanagawa.

UDC_KANH
AM

RUL
ES Kanham Contest. 1st Weekend June. Read the rules.

UDC_KCJ RUL
ES Keymens Club of Japan. KCJ (outdated)

UDC_KCJ_
DX

RUL
ES Keymens Club of Japan DX Stations. 3rd Weekend August

UDC_KCJ_
JA

RUL
ES Keymens Club of Japan JA Stations.

UDC_KCJ_
TB_DX

RUL
ES Keymens Club of Japan Top Band Contest. 2nd Weekend February.

UDC_KOMI
_RUHR

RUL
ES Komi Ruhr Qso Party. SEE the rules. 2nd Saturday October.

UDC_KTKU
P

RUL
ES KT Serbian Cup.

UDC_KTSC
WC

RUL
ES Serbian CW Club Short Wave Contest

UDC_LABR
E_DX

RUL
ES Labre DX Contest. 3rd Weekend July

UDC_LABR
E_RSDG

RUL
ES LABRE-RS DIGI Contest.

UDC_MK_P
ARTY

RUL
ES Latvian Mechanical Key Party. Held Feb, May, Oct and Dec

UDC_LCL-
2010 n/a Lighthouse Christmas Lights 2010.

UDC_LSL2
010

RUL
ES Lighthouse Spring Lites 2010.

UDC_LYCU
P

RUL
ES Lithuanian Cup Contest 3rd Saturday in June.

UDC_LOAN
O_MCD

RUL
ES Replaced with Marconiqpd.

UDC_LYWA
L

RUL
ES Lithuanian WAL Contest . 1st Saturday in June

UDC_MA-
CHAMP

RUL
ES Moscow-Championship.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#K1USNSST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#K1USNSST
http://www.k1usn.com/sst.html
http://www.k1usn.com/sst.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#K1USNSSTOP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#K1USNSSTOP
http://www.k1usn.com/
http://www.k1usn.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KANAGAWA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KANAGAWA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KANHAM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KANHAM
http://www.jarl.gr.jp/kanhamcontest
http://www.jarl.gr.jp/kanhamcontest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ
https://kcj-cw.com/e_index.htm
https://kcj-cw.com/e_index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ_DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ_DX
https://kcj-cw.com/e_index.htm
https://kcj-cw.com/e_index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ_JA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ_JA
https://kcj-cw.com/e_index.htm
https://kcj-cw.com/e_index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ_TB_DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KCJ_TB_DX
https://kcj-cw.com/j_index.htm
https://kcj-cw.com/j_index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KOMI_RUHR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KOMI_RUHR
https://www.qrz.ru/contest/detail/181.html
https://www.qrz.ru/contest/detail/181.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KTKUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KTKUP
http://www.yu1srs.org.rs/
http://www.yu1srs.org.rs/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KTSCWC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#KTSCWC
http://www.yu1srs.org.rs/
http://www.yu1srs.org.rs/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LABRE_DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LABRE_DX
https://www.labre.org.br/contest/en/regulamento/
https://www.labre.org.br/contest/en/regulamento/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LABRE_RSDG
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LABRE_RSDG
https://hampass.org/digi-contest
https://hampass.org/digi-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MK_PARTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MK_PARTY
https://yl3jd.fizioikskile.lv/mkey/
https://yl3jd.fizioikskile.lv/mkey/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LCL-2010
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LCL-2010
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LSL2010
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LSL2010
https://arlhs.com/events/spring-lights-qso-party/
https://arlhs.com/events/spring-lights-qso-party/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LYCUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LYCUP
http://www.lrsf.lt/en/ly-cup-rules/
http://www.lrsf.lt/en/ly-cup-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LOANO_MCD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LOANO_MCD
http://www.ariloano.it/marconiclub/
http://www.ariloano.it/marconiclub/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LYWAL
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#LYWAL
http://www.qrz.lt/walcontest/rulesen.htm
http://www.qrz.lt/walcontest/rulesen.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MA-CHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MA-CHAMP
https://www.qrz.ru/contest/detail/349.html
https://www.qrz.ru/contest/detail/349.html
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UDC_MAR
CONIQPD N/A Marconi Club QSO Party Day. 1st Sat. January.

UDC_MAR
CONIMEM

RUL
ES Marconi Memorial Contest. 1st Wkend July

UDC_MLOT
A

RUL
ES Masonic Lodges On The Air. September

UDC_MEM
ORY

RUL
ES Memory Lives Forever Contest. 3rd Weekend December.

UDC_MM RUL
ES Maidenhead Mayhem. 4th weekend March/3rd Sat July

UDC_MOO
NRTTY

RUL
ES MOON CONTEST.

UDC_MRAI RUL
ES Memorial DL6RAI. 3rd Weekend May

UDC_MULA
NDXC

RUL
ES MULAN WAP- variation of Worked All China Provences. New version – WAPC.zip

UDC_MVP_
UKW

RUL
ES DL Mecklenburg Vorpommern Contest. 3rd Saturday March

UDC_NAQ
CC

RUL
ES North American QRP CW Club Sprints. 15 sessions through the year

UDC_NAUR
YZDX n/a NAURYZ Central Asia Spring Holiday . Nearest Saturday to the holiday

UDC_NCC
C_FT4

RUL
ES NCCC FT4 Sprint. Thursday

UDC_NDG
BRASIL n/a Natal Digital Group PSK125 . Natal Digital Group DIGITAL Contest.

UDC_NRLC n/a NRL Cup Russian Internal Contest.

UDC_NRRL
TELEFO

RUL
ES Norway Radio Relay League TELEFONITEST.

UDC_NTC_
JAN_AP

RUL
ES NTC Anniversary Party. 31st January.

UDC_NTC_
QP

RUL
ES NTC Qso Party. Every third Thursday.

UDC_NZ_S
SC

RUL
ES NZ Sangster Shield Contest

UDC_NZAR
T

RUL
ES New Zealand Amateur Radio Tx WWll Memorial. 80M. NZ_VHFRTTY.udc for VHF-EHF

UDC_OBLA
ST n/a Russian OBLAST Contest.

UDC_OH-
PARKS

RUL
ES OHIO State Parks.
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MARCONIQPD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MARCONIQPD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MARCONIMEM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MARCONIMEM
http://www.arifano.it/
http://www.arifano.it/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MLOTA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MLOTA
http://cqmorelight.com/rules
http://cqmorelight.com/rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MEMORY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MEMORY
https://www.qrz.ru/contest/detail/83.html
https://www.qrz.ru/contest/detail/83.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MM
https://w9et.com/rules.html
https://w9et.com/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MOONRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MOONRTTY
https://ok2vbz.waypoint.cz/mc/en/conditions/
https://ok2vbz.waypoint.cz/mc/en/conditions/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MRAI
https://www.bavarian-contest-club.de/2024/04/mrai-dl6rai-memorial-contest/
https://www.bavarian-contest-club.de/2024/04/mrai-dl6rai-memorial-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MULANDXC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MULANDXC
http://www.mulandxc.com/index/match
http://www.mulandxc.com/index/match
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MVP_UKW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#MVP_UKW
https://www.amateurfunk-mvp.de/inhalte/contest.php
https://www.amateurfunk-mvp.de/inhalte/contest.php
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NAQCC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NAQCC
http://naqcc.info/sprint_rules.html
http://naqcc.info/sprint_rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NAURYZDX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NAURYZDX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NCCC_FT4
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NCCC_FT4
https://www.ncccsprint.com/ft4ns.html
https://www.ncccsprint.com/ft4ns.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NDGBRASIL
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NDGBRASIL
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NRLC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NRRLTELEFO
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NRRLTELEFO
https://nrrl.no/tema/konkurranser/nrrl-telefonitest/
https://nrrl.no/tema/konkurranser/nrrl-telefonitest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NTC_JAN_AP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NTC_JAN_AP
https://pi4ntc.nl/ntcap
https://pi4ntc.nl/ntcap
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NTC_QP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NTC_QP
https://www.agcw.de/ntc-qso-party/54803/
https://www.agcw.de/ntc-qso-party/54803/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NZ_SSC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NZ_SSC
https://www.nzart.org.nz/activities/contests/sangster-shield
https://www.nzart.org.nz/activities/contests/sangster-shield
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NZART
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#NZART
https://www.nzart.org.nz/activities/contests/memorial-contest
https://www.nzart.org.nz/activities/contests/memorial-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OBLAST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OBLAST
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OH-PARKS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OH-PARKS
http://ospota.org/
http://ospota.org/
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UDC_OK1
WC

RUL
ES OK1WC Memorial Contest.

UDC_OKO
MDXSSB

RUL
ES OKOM DX SSB Contest (Note: rules are now the same for CW event.)

UDC_OKO
MHOLPO

RUL
ES OK/OM HOLINESS CUP CHALLENGE (Holicky Pohar) Last Sat April

UDC_OLDN
EWYEAR

RUL
ES Old New Year Contest.

UDC_OMA
C

RUL
ES OMAC.

UDC_OMIS
SQSOP

RUL
ES OMISS QSO Party

UDC_OST
M-QP

RUL
ES Open Season Ten Meter Qso Party. 1st Thur Jun 48hrs

UDC_OQR
P

RUL
ES Original QRP.

UDC_OZAC
TIV n/a OZ ACTIV Contest.

UDC_OZCH
RVHF n/a OZCHR-VHF.

UDC_OZ-
EDR_JUL-
NYT

n/a OZ-EDR_JUL NYT Contest. July Contest

UDC_PACC
DIGI

RUL
ES PACC DIGI FT8 & RTTY 3rd Sunday April

UDC_PADA
NG_DX n/a Indonesian Padang DX Contest.

UDC_POTA RUL
ES Parks On The Air

UDC_PARL n/a Spanish Provinces PARLA.

UDC_PCC RUL
ES Pro CW/DIGI Contests (PCC).

UDC_PGAT
EST-DX

RUL
ES Polish PGA Contest – DX Stations.

UDC_PGAT
EST-SP

RUL
ES Polish PGA Contest – SP Stations.

UDC_PHO
NEFRAY

RUL
ES Phone Fray.

UDC_PN_Q
UICKCW n/a PN QUICK CW Contest.
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OK1WC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OK1WC
http://www.memorial-ok1wc.cz/index.php?page=rules2l
http://www.memorial-ok1wc.cz/index.php?page=rules2l
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OKOMDXSSB
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OKOMDXSSB
http://okomdx.crk.cz/
http://okomdx.crk.cz/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OKOMHOLPO
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OKOMHOLPO
https://www.ok1khl.com/view.php?cisloclanku=2022020101
https://www.ok1khl.com/view.php?cisloclanku=2022020101
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OLDNEWYEAR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OLDNEWYEAR
http://www.radio.ru/cq/contest/rule-results/index7.shtml
http://www.radio.ru/cq/contest/rule-results/index7.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OMAC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OMAC
http://www.kv.szr.sk/
http://www.kv.szr.sk/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OMISSQSOP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OMISSQSOP
https://www.omiss.net/Facelift/qsoparty.php
https://www.omiss.net/Facelift/qsoparty.php
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OSTM-QP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OSTM-QP
https://www.ten-ten.org/oseason/oseason.html
https://www.ten-ten.org/oseason/oseason.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OQRP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OQRP
http://www.qrpcc.de/contestrules/oqrpr.html
http://www.qrpcc.de/contestrules/oqrpr.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZACTIV
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZACTIV
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZCHRVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZCHRVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZ-EDR_JUL-NYT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZ-EDR_JUL-NYT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#OZ-EDR_JUL-NYT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PACCDIGI
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PACCDIGI
https://www.veron.nl/vereniging/commissies-en-werkgroepen/traffic-bureau/hf-contesten/paccdigi-rules/#top
https://www.veron.nl/vereniging/commissies-en-werkgroepen/traffic-bureau/hf-contesten/paccdigi-rules/#top
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PADANG_DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PADANG_DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POTA
https://parksontheair.com/
https://parksontheair.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PARL
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PCC
http://www.procontestclub.ro/
http://www.procontestclub.ro/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PGATEST-DX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PGATEST-DX
https://pga-zawody.pzk.pl/articles.php?article_id=20
https://pga-zawody.pzk.pl/articles.php?article_id=20
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PGATEST-SP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PGATEST-SP
https://pga-zawody.pzk.pl/articles.php?article_id=20
https://pga-zawody.pzk.pl/articles.php?article_id=20
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PHONEFRAY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PHONEFRAY
http://www.perluma.com/Phone_Fray_Contest_Rules.pdf
http://www.perluma.com/Phone_Fray_Contest_Rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PN_QUICKCW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PN_QUICKCW
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UDC_PND RUL
ES Portuguese Navy Day Contest.

UDC_PODX
S_TDW

RUL
ES PODXS Three Day Weekend Contest.

UDC_PODX
S1RTTY

RUL
ES PODXS 070 Contests: PSK FEST. JAY HUDAK Mem.. PUMPKIN SPRINT. and Firecracker.

UDC_PODX
S2RTTY

RUL
ES PODXS 070 St. Patrick’s Day Contest.

UDC_POP_
YTHCUP

RUL
ES Popov Youth Cup Contest.

UDC_POP
OVMEMOR

RUL
ES Popov Memorial.

UDC_POP
OVVHF

RUL
ES POPOV-VHF.

UDC_PRIM
OR_HFC

RUL
ES Primorsky HF Contest.

UDC_PW_1
44_70

RUL
ES Practical Wireless 144 and 70Mhz.

UDC_QO-
100

RUL
ES QO-100 Every Saturday.

UDC_QRP-
AFIELD

RUL
ES QRP-AFIELD Contest. 3rd Saturday September

UDC_QRP
HFRTTY

RUL
ES QRP HF RTTY Contest.

UDC_R3A_
CDRTTY

RUL
ES R3A Cup Digi Contest.

UDC_R3E-
SC

RUL
ES R3E-SC.

UDC_R3L_
HF_CUP

RUL
ES R3L – Smolensk HF Cup

UDC_R4CC
HAMP

RUL
ES R4C Champ.

UDC_R4W-
CHAMP

RUL
ES R4W (Udmurtia. Russia) Open Championship

UDC_R6HC
HAMP

RUL
ES R6H Champ.

UDC_R6U-
CHAMP

RUL
ES Championship of Astrahan oblast.

UDC_R9S-
CHAMP

RUL
ES R9S Champ. Orenburg Downy Shawl Contest. 2nd Friday February.
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PND
https://www.nra.pt/
https://www.nra.pt/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PODXS_TDW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PODXS_TDW
https://www.podxs070.com/o7o-club-sponsored-contests/three-day-weekend
https://www.podxs070.com/o7o-club-sponsored-contests/three-day-weekend
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PODXS1RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PODXS1RTTY
https://www.podxs070.com/o7o-club-sponsored-contests/general-contest-rules
https://www.podxs070.com/o7o-club-sponsored-contests/general-contest-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PODXS2RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PODXS2RTTY
https://www.podxs070.com/o7o-club-sponsored-contests/saint-patrick-s-day-contest
https://www.podxs070.com/o7o-club-sponsored-contests/saint-patrick-s-day-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POP_YTHCUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POP_YTHCUP
https://www.qrz.ru/contest/detail/119.html/
https://www.qrz.ru/contest/detail/119.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POPOVMEMOR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POPOVMEMOR
https://www.qrz.ru/contest/detail/236.html
https://www.qrz.ru/contest/detail/236.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POPOVVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#POPOVVHF
https://www.qrz.ru/contest/detail/198.html
https://www.qrz.ru/contest/detail/198.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PRIMOR_HFC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PRIMOR_HFC
https://www.qrz.ru/contest/detail/187.html/
https://www.qrz.ru/contest/detail/187.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PW_144_70
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#PW_144_70
http://www.pwcontest.org.uk/
http://www.pwcontest.org.uk/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#QO-100
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#QO-100
https://qo100dx.club/sprint
https://qo100dx.club/sprint
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#QRP-AFIELD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#QRP-AFIELD
https://www.newenglandqrp.org/qrp-afield-2018/
https://www.newenglandqrp.org/qrp-afield-2018/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#QRPHFRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#QRPHFRTTY
https://wwqrprtty.jimdo.com/rule/
https://wwqrprtty.jimdo.com/rule/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R3A_CDRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R3A_CDRTTY
https://www.qrz.ru/contest/detail/356.html
https://www.qrz.ru/contest/detail/356.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R3E-SC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R3E-SC
https://www.qrz.ru/contest/detail/239.html/
https://www.qrz.ru/contest/detail/239.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R3L_HF_CUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R3L_HF_CUP
https://www.qrz.ru/contest/detail/230.html
https://www.qrz.ru/contest/detail/230.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R4CCHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R4CCHAMP
https://www.qrz.ru/contest/detail/55.html/
https://www.qrz.ru/contest/detail/55.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R4W-CHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R4W-CHAMP
https://www.qrz.ru/contest/detail/132.html/
https://www.qrz.ru/contest/detail/132.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R6HCHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R6HCHAMP
https://www.qrz.ru/contest/detail/113.html/
https://www.qrz.ru/contest/detail/113.html/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R6U-CHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R6U-CHAMP
https://www.qrz.ru/contest/detail/309.html
https://www.qrz.ru/contest/detail/309.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R9S-CHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#R9S-CHAMP
http://www.ua9qcq.com/
http://www.ua9qcq.com/
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UDC_SPRI
NTRCRM n/a Radio Club Region Murcia Sprint

UDC_RCA_
TQP

RUL
ES Radio Club of America Transatlantic QSO Party. 13th November

UDC_RAND
OMGRAM

RUL
ES RANDOMGRAM.

UDC_RCW
C_RPX

RUL
ES Russian CW Club RPX Contest. 2nd Weekend September

UDC_RCW
C4

RUL
ES Russian CW Club 4 Seasons.

UDC_RCW
CMINI

RUL
ES Russian CW Club MiniTest.

UDC_RAHU
LL_VHF

RUL
ES Ross A Hull Memorial. All January

UDC_REGI
ON-NR n/a REGION-NR.

UDC_RSGB
_40QP

RUL
ES RSGB 40m QSO Party. RSGB 40m QSO Party (inactive)

UDC_RSGB
_FT4

RUL
ES RSGB FT4 Contest Series.

UDC_RSGB
FT4IAD

RUL
ES RSGB FT4 International Activity Day. 1st Saturday April

UDC_RSGB
HOPEQP

RUL
ES RSGB HOPE QSO Party (Use for RSGB GOTA4C series)

UDC_RSGB
UKAC

RUL
ES RSGB UKAC (VHF) Contest

UDC_RTC_
PARTY n/a Deutschland RTC Party Contest.

UDC_RUSS
IAN160

RUL
ES RUSSIAN 160.

UDC_RYO_
WS_VHF

RUL
ES RTTY OPS Weekend Sprint. Bands- 80-10m

UDC_RY_O
P_WDS

RUL
ES RTTY OPS WeekDAY Sprint. Friday 0145-0215

UDC_SA10
M

RUL
ES South America 10Mtr.

UDC_SAC
W

RUL
ES South America CW 3rd weekend Nov

UDC_SALM
ON-RUN

RUL
ES SALMON-RUN.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SPRINTRCRM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SPRINTRCRM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCA_TQP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCA_TQP
https://www.radioclubofamerica.org/content.aspx?page_id=22&club_id=500767&module_id=475160
https://www.radioclubofamerica.org/content.aspx?page_id=22&club_id=500767&module_id=475160
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RANDOMGRAM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RANDOMGRAM
https://groups.io/g/RandomGram
https://groups.io/g/RandomGram
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCWC_RPX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCWC_RPX
https://www.qrz.ru/contest/detail/663.html
https://www.qrz.ru/contest/detail/663.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCWC4
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCWC4
https://www.qrz.ru/contest/detail/307.html
https://www.qrz.ru/contest/detail/307.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCWCMINI
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RCWCMINI
https://www.qrz.ru/contest/detail/301.html
https://www.qrz.ru/contest/detail/301.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RAHULL_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RAHULL_VHF
https://www.wia.org.au/members/contests/rosshull/
https://www.wia.org.au/members/contests/rosshull/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#REGION-NR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#REGION-NR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGB_40QP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGB_40QP
https://www.rsgbcc.org/hf
https://www.rsgbcc.org/hf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGB_FT4
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGB_FT4
https://www.rsgbcc.org/hf/
https://www.rsgbcc.org/hf/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGBFT4IAD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGBFT4IAD
https://www.rsgbcc.org/hf/
https://www.rsgbcc.org/hf/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGBHOPEQP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGBHOPEQP
https://www.rsgbcc.org/hf/rules/2020/rhqp.shtml
https://www.rsgbcc.org/hf/rules/2020/rhqp.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGBHOPEQP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RSGBHOPEQP
https://www.rsgbcc.org/vhf/
https://www.rsgbcc.org/vhf/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RTC_PARTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RTC_PARTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RUSSIAN160
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RUSSIAN160
http://www.radio.ru/cq/contest/rule-results/index11.shtml
http://www.radio.ru/cq/contest/rule-results/index11.shtml
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RYO_WS_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RYO_WS_VHF
https://rttyops.wordpress.com/
https://rttyops.wordpress.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RY_OP_WDS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#RY_OP_WDS
https://radiosport.world/wrt.html
https://radiosport.world/wrt.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SA10M
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SA10M
http://www.sa10m.com.ar/
http://www.sa10m.com.ar/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SACW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SACW
https://sacw.cwsp.com.br/
https://sacw.cwsp.com.br/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SALMON-RUN
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SALMON-RUN
http://salmonrun.wwdxc.org/rules/
http://salmonrun.wwdxc.org/rules/
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UDC_SARA RUL
ES SARA Spring Sprint.

UDC_SARA
_OM

RUL
ES SARA Spring Sprint for OM Stations.

UDC_SARL RUL
ES Several South Africa Relay League Contests. See Read_Me file in SARL.zip

UDC_SASQ
UATCHS

RUL
ES Sasquatch Stomp. 1st Friday April

UDC_SCAG RUL
ES SCAG SPRINT.

UDC_SDXC RUL
ES Scottish DX Contest.

UDC_SEAN
ETRTTY n/a Seanet Contest.

UDC_SEA_
PAC-QP

RUL
ES Sea-Pac QP

UDC_SKEE
TER

RUL
ES New Jersey NJQRP Skeeter Contest.

UDC_SKIR
MRTTY

RUL
ES TARA SKIRMISH.

UDC_SKME
M

RUL
ES Silent Key Memorial Contest. 1st November.

UDC_SLTE
STEN

RUL
ES Swedish SL Contest. 2nd Sat. May and November

UDC_SM_
MT

RUL
ES Swedish Monthly Test.

UDC_SE_V
HF_SPR

RUL
ES South East V/UHF Sprints.

UDC_SP_O
TC

RUL
ES Polish Old Timers Club. 4th Weekend January?

UDC_SMIR
K

RUL
ES Six Metre International Radio Klub Contest. SMIRK

UDC_SP_P
K

RUL
ES Zawody SP-PK.

UDC_SPEP
C_RTTY

RUL
ES SP WW EPC BPSK63 Contest.

UDC_SRRJ
R n/a SRR JR.

UDC_SSA_
MT

RUL
ES SSA MT events.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SARA
http://www.cq.sk/download/ss_10_rules.pdf
http://www.cq.sk/download/ss_10_rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SARA_OM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SARA_OM
http://www.cq.sk/download/ss_10_rules.pdf
http://www.cq.sk/download/ss_10_rules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SARL
http://www.sarl.org.za/public/contests/contestrules.asp
http://www.sarl.org.za/public/contests/contestrules.asp
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SASQUATCHS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SASQUATCHS
https://www.pnwqrp.org/sasquatch-stomp
https://www.pnwqrp.org/sasquatch-stomp
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SCAG
https://www.scag.se/prov/index.htm
https://www.scag.se/prov/index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SDXC
https://scottishdxc.wixsite.com/contest/
https://scottishdxc.wixsite.com/contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SEANETRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SEANETRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SeaPac_QP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SeaPac_QP
https://www.seapac.org/
https://www.seapac.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SKEETER
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SKEETER
https://www.qsl.net/w2lj/
https://www.qsl.net/w2lj/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SKIRMRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SKIRMRTTY
https://www.n2ty.org/seasons/tara_dpx_rules.html
https://www.n2ty.org/seasons/tara_dpx_rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SKMEM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SKMEM
http://www.skmc.hu/en/rules.html
http://www.skmc.hu/en/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SLTESTEN
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SLTESTEN
https://www.fro.se/_project/_media/FRODOK/FRODOK%20Publik/Amat%C3%B6rradio/regler-sl-testen.pdf
https://www.fro.se/_project/_media/FRODOK/FRODOK%20Publik/Amat%C3%B6rradio/regler-sl-testen.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SM_MT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SM_MT
https://sk3bg.se/contest/mt.htm
https://sk3bg.se/contest/mt.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SE_VHF_SPR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SE_VHF_SPR
https://svhfs.org/2022VHFSprintRules.pdf
https://svhfs.org/2022VHFSprintRules.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SP_OTC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SP_OTC
https://logsp.pzk.org.pl/?page=contest&id=1397
https://logsp.pzk.org.pl/?page=contest&id=1397
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SMIRK
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SMIRK
http://www.smirk.org/contest.html
http://www.smirk.org/contest.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SP_PK
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SP_PK
https://ot18.pzk.org.pl/?page_id=631
https://ot18.pzk.org.pl/?page_id=631
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SPEPC_RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SPEPC_RTTY
https://epc-sp.pl/
https://epc-sp.pl/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SRRJR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SRRJR
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SSA_MT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SSA_MT
https://sk3bg.se/contest/mt.htm
https://sk3bg.se/contest/mt.htm
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UDC_SSA_
JT

RUL
ES SSA Christmas Contest. 25th December.

UDC_SWL n/a International 2010.

UDC_TNPO
TA

RUL
ES Tennessee Parks on the Air.

UDC_TENT
ENRTTY

RUL
ES TenTen QSO Party (10-10) USE FOR ALL MODES, not just RTTY

UDC_TENT
EN

RUL
ES TenTen QSO Party – Phone, CW (uses UDC_TENTENRTTY .UDC contest file!)

UDC_TESL
A_VHF

RUL
ES Tesla HF Memorial Contest. 2nd Weekend in March.

UDC_TRIAT
HRTTY n/a SV Triathlon Contest.

UDC_TX_P
ARKS

RUL
ES Texas Parks On The Air.

UDC_TISZA
_CUP

RUL
ES TISZA Cup International Radio Contest. 1st Weekend June.

UDC_TRUE
BLUEDX

RUL
ES True Blue Ultra DX Marathon. 1st Jan to 31st Dec.

UDC_UBAP
SK63

RUL
ES UBA PSK63 Prefix Contest. 2nd Weekend in January

UDC_UFT_
HF

RUL
ES Union of France Telegraphy HF Contest. First Weekend in December Discontinued?

UDC_UFT_
MEET

RUL
ES UFT Meet. First Weekend in December.

UDC_UFT_
QRP

RUL
ES Union of France Telegraphy QRP Contest. Last Weekend in June

UDC_UFT_
YL_CW

RUL
ES Union of France Telegraphy YL-CW Contest.

UDC_UKDX
63RTTY n/a UK DXC BPSK63 2nd Weekend in January Replaced by UBA PSK63.

UDC_UKEI
80_VHF

RUL
ES UKEICC 80m Contests

UDC_
UKEISS_V
HF

RUL
ES UKEICC Summer Series

UDC_UR5I
OK_MEM

RUL
ES Alexander Savenkov Memorial.

UDC_URAL
CUP

RUL
ES URAL CUP.

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SSA_JT
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SSA_JT
https://hfcontest.ssa.se/ssa-jt/
https://hfcontest.ssa.se/ssa-jt/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#SWL
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TN_POTA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TN_POTA
http://www.tnpota.com/
http://www.tnpota.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TENTENRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TENTENRTTY
https://www.ten-ten.org/index.php/activity/2013-07-22-20-26-48/qso-party-rules
https://www.ten-ten.org/index.php/activity/2013-07-22-20-26-48/qso-party-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TENTENRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TENTENRTTY
https://www.ten-ten.org/index.php/activity/2013-07-22-20-26-48/qso-party-rules
https://www.ten-ten.org/index.php/activity/2013-07-22-20-26-48/qso-party-rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TESLA_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TESLA_VHF
http://radiosport.yu1srs.org.rs/HFTeslaMemorial/
http://radiosport.yu1srs.org.rs/HFTeslaMemorial/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TRIATHRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TRIATHRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TX_PARKS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TX_PARKS
https://www.tspota.org/
https://www.tspota.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TIZA_CUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TIZA_CUP
http://www.tiszacup.eu/
http://www.tiszacup.eu/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TRUEBLUEDX
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#TRUEBLUEDX
https://www.tbdxc.net/marathon
https://www.tbdxc.net/marathon
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UBAPSK63
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UBAPSK63
https://www.uba.be/en/hf/contest-rules/uba-psk63-prefix-contest
https://www.uba.be/en/hf/contest-rules/uba-psk63-prefix-contest
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_HF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_HF
http://www.uft.net/articles.php?lng=fr&pg=116&mnuid=105&tconfig=0
http://www.uft.net/articles.php?lng=fr&pg=116&mnuid=105&tconfig=0
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_MEET
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_MEET
https://www.uft.net/activites-et-concours/rencontres-uft/
https://www.uft.net/activites-et-concours/rencontres-uft/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_QRP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_QRP
http://www.uft.net/articles.php?lng=fr&pg=628&mnuid=105&tconfig=0/
http://www.uft.net/articles.php?lng=fr&pg=628&mnuid=105&tconfig=0/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_YL_CW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UFT_YL_CW
http://www.uft.net/articles.php?lng=fr&pg=118&mnuid=105&tconfig=0
http://www.uft.net/articles.php?lng=fr&pg=118&mnuid=105&tconfig=0
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKDX63RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKDX63RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKEI80_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKEI80_VHF
https://www.ukeicc.com/
https://www.ukeicc.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKEISS_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKEISS_VHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UKEISS_VHF
https://ukeicc.com/
https://ukeicc.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UR5IOK_MEM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UR5IOK_MEM
http://ua9qcq.com/en/contestinfo.php?lang=en&t_id=220&mo=12&Year=2015
http://ua9qcq.com/en/contestinfo.php?lang=en&t_id=220&mo=12&Year=2015
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#URALCUP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#URALCUP
https://www.qrz.ru/contest/detail.phtml?id=112/
https://www.qrz.ru/contest/detail.phtml?id=112/
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Name
Setup Link

Spo
nsor
Rule

s
Comments / Description

UDC_URC
DXRTTY

RUL
ES URC DX RTTY. 1st Friday October.

UDC_USI_
QPRTTY

RUL
ES USi W/VE Islands Qso Party.

UDC_UT5E
UVHF

RUL
ES UT5EU-MEMORIAL-VHF.

UDC_FT8-
ACTVTY

RUL
ES

VHF-UHF FT8 Activity. Every first Wednesday of each month for the 2m band (144.174 MHz). Every
second Wednesday of each month for the 70cm band (432.174 MHz). Every third Wednesday of
each month for the 23 cm band.

UDC_VHF9
02UP

RUL
ES 902UP or MICROWAVE Sprint

UDC_VHF_
AGCW

RUL
ES AGCW VHF-UHF Contests.

UDC_VHF_
ARAM50

RUL
ES VHF_ARAM 50MHZ 4th SAT July

UDC_VHF_
DFRTTY

RUL
ES DigiFest – digital mixed modes contest. First weekend June.

UDC_VHF_
NAMSS

RUL
ES NA Meteor Scatter Sprint. 2nd Friday August.

UDC_VHF_
PAUL4

RUL
ES RSGB UKAC (VHF).

UDC_VHF_
UHF_TA

RUL
ES Turkish VHF/UHF Contest.

UDC_VHFA
RAU_SA

RUL
ES Araucaria VHF Contest.

UDC_VHFG
RIDS n/a VHF GRIDS. VHF GRIDS

UDC_VHFR
2RTTY

RUL
ES HF Region 2 RTTY Contest.

UDC_VHFR
SGB

RUL
ES RSGB VHF Contests. see VHF_RSGB_Read_Me.txt in VHFRSGB.zip

UDC_VHFS
PRING

RUL
ES VHF-SPRING. VHF-SPRING

UDC_VIDO
VDAN

RUL
ES YU VIDOVDAN Contest. 4th Weekend June.

UDC_VOLG
OGRAD

RUL
ES Volgograd Championship. 2nd Friday November.

UDC_VKSH
IRES

RUL
ES Worked all VKSHIRES. Sat&Sun Weekend prior to 2nd Monday in June.

UDC_VMTR
OPHY

RUL
ES Vytautas Magnus trophy.
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#URDXCRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#URDXCRTTY
https://unicomradio.com/urc-dx-rtty-contest/
https://unicomradio.com/urc-dx-rtty-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#USI_QPRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#USI_QPRTTY
https://usislands.org/qso-party-rules/
https://usislands.org/qso-party-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UT5EUVHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#UT5EUVHF
https://blrci.ucoz.ru/news/polozhenie_o_sorevnovanijakh_na_ukv_im_v_chalapko_2011_goda/2011-05-10-68/
https://blrci.ucoz.ru/news/polozhenie_o_sorevnovanijakh_na_ukv_im_v_chalapko_2011_goda/2011-05-10-68/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FT8-ACTVTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#FT8-ACTVTY
http://www.ft8activity.eu/index.php/en/
http://www.ft8activity.eu/index.php/en/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF902UP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF902UP
https://sites.google.com/site/springvhfupsprints/home
https://sites.google.com/site/springvhfupsprints/home
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_AGCW
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_AGCW
https://www.agcw.org/index.php/en/contests-and-cw-activities/vhf-uhf-contest/
https://www.agcw.org/index.php/en/contests-and-cw-activities/vhf-uhf-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_ARAM50
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_ARAM50
https://www.aram.pt/?pagina=eventos&subpg=concurso50MHz
https://www.aram.pt/?pagina=eventos&subpg=concurso50MHz
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_DFRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_DFRTTY
https://rigexpert.com/digifest/rules/
https://rigexpert.com/digifest/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_NAMSS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_NAMSS
https://kv5w.com/2022/07/24/na-meteor-scatter-sprint-digital-rules/
https://kv5w.com/2022/07/24/na-meteor-scatter-sprint-digital-rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_PAUL4
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_PAUL4
https://www.rsgbcc.org/vhf/
https://www.rsgbcc.org/vhf/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_UHF_TA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHF_UHF_TA
http://trac.org.tr/amatorun-kosesi/ta-vhf-uhf-contest-en
http://trac.org.tr/amatorun-kosesi/ta-vhf-uhf-contest-en
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFARAU_SA
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFARAU_SA
https://www.avhfc.com/rules/en.pdf
https://www.avhfc.com/rules/en.pdf
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFGRIDS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFGRIDS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFR2RTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFR2RTTY
https://concursoareag.lu4aa.org/
https://concursoareag.lu4aa.org/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFRSGB
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFRSGB
https://www.rsgbcc.org/vhf/rules/20rules/frameindex.html
https://www.rsgbcc.org/vhf/rules/20rules/frameindex.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFSPRING
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VHFSPRING
http://sites.google.com/site/springvhfupsprints/home
http://sites.google.com/site/springvhfupsprints/home
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VIDOVDAN
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VIDOVDAN
http://www.radiosport.yu1srs.org.rs/
http://www.radiosport.yu1srs.org.rs/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VOLGOGRAD
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VOLGOGRAD
https://www.qrz.ru/contest/detail/38.html
https://www.qrz.ru/contest/detail/38.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VKSHIRES
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VKSHIRES
http://www.wia.org.au/members/contests/wavks/
http://www.wia.org.au/members/contests/wavks/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VMTROPHY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VMTROPHY
https://www.qrz.ru/contest/detail/188.html
https://www.qrz.ru/contest/detail/188.html
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Setup Link
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s
Comments / Description

UDC_VU_D
X_VU

RUL
ES VU International DX Contest.

UDC_VU_H
IMA_VU

RUL
ES VU Himalaya Contest.

UDC_VUSU
MMRTTY

RUL
ES VU Summer Contest.

UDC_WAB RUL
ES Worked All Britain Contests.

UDC_WAL RUL
ES Workes All Lithuania. 1st Saturday June

UDC_WES
M

RUL
ES WSEM minitest.

UDC_WFD
A2RTTY n/a

Winter Field Day. If you have previously downloaded this UDC file, delete it from your
UserDefinedContests folder and use the built-in WFD contest type instead. See “Setup HF SSB –
CW Contests, WFD“

UDC_WI-
PARKS

RUL
ES Wisconsin Park on the Air.

UDC_WIA_
VK_DAY

RUL
ES WIA Australia Day Contest. Annually 26th Jan.

UDC_WIA_
RDC

RUL
ES WIA Remembrance Day Contest. 2nd Weekend August.

UDC_WIA_
VHFUHF

RUL
ES WIA VHF/UHF Contest. January/November

UDC_WLO
TARTTY n/a World Lighthouse OTA.

UDC_WOR
LDARDCH

RUL
ES World Amateur Radio Day Contests 18th April

UDC_WRT RUL
ES Weekly RTTY Test

UDC_WWA RUL
ES World Wide Activity all January 2025

UDC_WWP
DX_vHF

RUL
ES WWPDX Contest. Last weekend Feb.

UDC_WW_
SSB_AC

RUL
ES WW SSB Activity Contest. Every Tuesday.

UDC_YACH
AMP n/a YACHAMP.

UDC_YBDX
C

RUL
ES

Indonesian DX Contest. Indonesian DX Contest. For non-YB stations. SSB 2nd Weekend January.
RTTY 2nd Weekend March.

UDC_YBDX
CYB

RUL
ES

Indonesian DX Contest. Indonesian DX Contest. YB stations only. SSB 2nd Weekend January. RTTY
2nd Weekend March.
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VU_DX_VU
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VU_DX_VU
https://arsi.info/contests/
https://arsi.info/contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VU_HIMA_VU
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VU_HIMA_VU
https://arsi.info/himalayan/
https://arsi.info/himalayan/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VUSUMMRTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#VUSUMMRTTY
https://arsi.info/contests/
https://arsi.info/contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WAB
https://wab.intermip.net/Contest%20Rules.php/
https://wab.intermip.net/Contest%20Rules.php/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WAL
http://www.qrz.lt/walcontest/rulesen.htm
http://www.qrz.lt/walcontest/rulesen.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WESM
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WESM
http://minitest.narod.ru/
http://minitest.narod.ru/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WI-PARKS
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WI-PARKS
https://www.wipota.com/
https://www.wipota.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WIA_VK_DAY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WIA_VK_DAY
https://www.wia.org.au/members/contests/about/
https://www.wia.org.au/members/contests/about/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WIA_RDC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WIA_RDC
http://www.wia.org.au/
http://www.wia.org.au/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WIA_VHFUHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WIA_VHFUHF
https://www.wia.org.au/members/contests/vhfuhf/
https://www.wia.org.au/members/contests/vhfuhf/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WLOTARTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WLOTARTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WORLDARDCH
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WORLDARDCH
https://mrasz.org/ha-contest/world-amateur-radio-day-contest-hf
https://mrasz.org/ha-contest/world-amateur-radio-day-contest-hf
https://radiosport.world/wrt.html
https://radiosport.world/wrt.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WWA
https://hamaward.cloud/wwa/rules
https://hamaward.cloud/wwa/rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WWPDX_vHF
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WWPDX_vHF
https://wwpatagonia-arg-dx.com.ar/
https://wwpatagonia-arg-dx.com.ar/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WW_SSB_AC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#WW_SSB_AC
https://wwsac.com/rules.html
https://wwsac.com/rules.html
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YACHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YACHAMP
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXC
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXC
https://www.ybdxcontest.com/
https://www.ybdxcontest.com/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXCYB
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXCYB
https://ybdxcontest.com/indonesian-rules/
https://ybdxcontest.com/indonesian-rules/
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Comments / Description

UDC_YBDX
PI-FT8

RUL
ES Indonesian DXing Passion Islands FT8 Contest. 3rd Weekend October.

UDC_YBDX
PISSB

RUL
ES Indonesian DX PI SSB Contest. 1st Weekend April.

UDC_YLOM RUL
ES YL-OM Contest.

UDC_YO_C
N_US

RUL
ES FRR CN US Contest..

UDC_YOTA RUL
ES YOTA Contest. Held May, July and December.

UDC_YORT
TY

RUL
ES YO PSK31 Contest.

UDC_YV_C
ARABOBO

RUL
ES Battle of Carabobo Contest.

UDC_ZOM
BIE

RUL
ES ZOMBIE Shuffle. ZOMBIE Shuffle – Day before Halloween
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https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXPI_FT8
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXPI_FT8
https://contest.ybdxpi.net/rules/
https://contest.ybdxpi.net/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXPISSB
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YBDXPISSB
https://contest.ybdxpi.net/ssb/rules/
https://contest.ybdxpi.net/ssb/rules/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YLOM
https://ylrl.org/wp/yl-om-contest/
https://ylrl.org/wp/yl-om-contest/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YO_CN_US
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YO_CN_US
http://www.hamradio.ro/
http://www.hamradio.ro/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YOTA
https://www.ham-yota.com/contest/#rules
https://www.ham-yota.com/contest/#rules
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YORTTY
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YORTTY
http://www.yo5crq.ro/index.htm
http://www.yo5crq.ro/index.htm
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YV_CARABOBO
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#YV_CARABOBO
http://www.radioclubvalenciaac.org.ve/?page_id=242
http://www.radioclubvalenciaac.org.ve/?page_id=242
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ZOMBIE
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/#ZOMBIE
http://www.zianet.com/qrp/ZOMBIE/pg.html
http://www.zianet.com/qrp/ZOMBIE/pg.html
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Supported Contests Setup
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Supported Contests Setup
When a contest has a specific mode (SSB, CW or RTTY) then the Mode Category is automatically changed to that mode. So
when you select CQWWSSB for the CQ World Wide SSB contest the Mode Category will be set by the program to SSB. You
can change this but that will give wrong Cabrillo output and maybe even erroneous behavior of the program, so don’t!!
If the selected contest doesn’t have a specific mode the program will set the Mode Category to MIXED.
If the radio is interfaced, its mode will be changed. The frequency is not changed; it is up to the user to ensure that the radio is
tuned to the correct part of the band.

This is a contest program, but for general logging you can use DX as the selected contest. Dupes are allowed and an
exchange is not necessary.
To import a contest into your regular logging program use ADIF export (and ADIF import in your general logging program).

When going through the possible contests you will see a “contest” DELETEDQS.
This is not actually a contest. QSOs deleted from other contests will be put in here by the program. This is especially
important for multi-user support.

The maximum received serial number is 99999 (for serial number contests). Check out info about the serial number server in
the Contest Setup Dialog chapter .

Select from one of the Following:

Setup DX, DXpedition, and General Purpose Contests
Setup HF – CW & SSB Contests
Setup QSO Parties
Setup VHF and UHF Contests
Setup Digital, RTTY, and PSK Contests
Setup User-Defined Contests

Read the Contest Instructions!
Always read the instructions from the contest committee prior to the contest. Then you know how to set up the
program, what exchange to give and what to expect in return, which hours to operate etc.
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https://n1mmwp.hamdocs.com/tiki-index.php?page=The+Contest+Setup+Dialog
https://n1mmwp.hamdocs.com/contests-setup/setup-dx-contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-hf-contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-qsop-contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-uhf-contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-digital-contests/
https://n1mmwp.hamdocs.com/contests-setup/setup-udc-contests/
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Setup DX, DXpedition, and General Purpose Contests
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DX, DXpedition, and General Purpose Contests

Generic Contest Types

DX Log

Window: Select Log type

Log Type: DX
Mode Category: MIXED if you want to log both SSB and CW contacts, MIXED+DIG to add digital modes as well

For general or DX logging.

Entered QSOs in General log (or DX log) don’t need to have an exchange
Dupes are shown by the word Dupe! but the qso can be logged

DXpedition

Window: Select Log type

Log Type: DXPEDITION
Mode Category: MIXED if you want to log both SSB and CW contacts, MIXED+DIG to add digital modes as well

For DXpedition logging

Entered QSOs in the DXPEDITION log don’t need to have an exchange
Dupes are shown by the word Dupe! but the QSO can be logged

DX Serial

Window: Select Log type

Log Type: DXSERIAL
Mode Category: MIXED if you want to log both SSB and CW contacts, MIXED+DIG to add digital modes as well

For general Serial Number contest logging

Entered QSOs in DXSERIAL don’t need to have an comment
Dupes are shown by the word Dupe! but the QSO can be logged
‘Standard’ points calculation; 1 point per qso, DXCC countries are counted

All other kind of multiplier and point calculations have to be done by hand
This for all not supported serial number contests

Read the Contest Instructions!
Always
read the instructions from the contest committee prior to the contest.
Then you know how to set up the program, what exchange to give and what
to expect in return, which hours to operate etc.



Working with split VFOs on a DXpedition – Rx on VFOa, Tx on VFOb
Most DXpedition operators will leave VFOb on a stationary transmit frequency while tuning the pile-up with VFOa in
receive. For optimal results in N1MM+ perform the following three actions: Set >Config >Hardware for SO2V (Single
Op 2 VFO) operation. Place the program and the radio in Split mode by typing ctrl+S. Disable Run/S&P auto-toggle
by pressing alt+F11.
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DX Satellite

Window: Select Log type

Log Type: DXSATELLIT
Mode Category: MIXED if you want to log both SSB and CW contacts, MIXED+DIG to add digital modes as well

For Satellite logging.

Entered QSOs in the DXSATELLIT log don’t have an exchange and don’t need to have a grid
When a grid is entered it needs to be 4 or 6 characters long
Dupes are shown by the word Dupe! but the QSO can be logged

VHF DX

Window: Select Log type

Log Type: VHFDX
Mode Category: MIXED if you want to log both SSB and CW contacts, MIXED+DIG to add digital modes as well

For VHF and up logging.

Entered QSOs in VHFDX don’t need to have a grid
When a grid is entered it needs to be 4 or 6 characters long
Dupes are shown by the word Dupe! but the qso can be logged
Bearing info is shown in the log window and saved in the Misc field
Distance info is shown in km in the log window and saved in the Points field

VHF Serial

Window: Select Log type

Log Type: VHFSERIAL
Mode Category: MIXED if you want to log both SSB and CW contacts, MIXED+DIG to add digital modes as well

Comments need to be added using Ctrl+N. There is no room left in the Entry Window to add a separate field. Comments will
be shown in the log window and added to the Cabrillo and generic output reports

For VHF and up logging

Entered QSOs in VHFSERIAL don’t need to have a grid
When a grid is entered it needs to be 4 or 6 characters long
Dupes are shown by the word Dupe! but the QSO can be logged
Bearing info is shown in the log window and saved in the Misc field
Distance info is shown in km in the log window and saved in the Points field

Deleted QSOs
DELETEDQS “contest”

QSOs which are deleted from other logs using ‘Edit Contact’ are moved to this ‘contest’.
This is especially important for multi-user support. The moved QSOs can be exported.
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Setup HF – SSB and CW Contests
2020-03-23

Setup HF Contests – CW and SSB
9A CW contest

The 9A (Croatian) CW contest is a CW only contest.

Window: Select Log type
Log Type: 9ACW
Mode Category: CW
Sent Exchange: 001

AGCW

CW-only, on New Year’s Day

Window: Select Log Type
Log Type: AGCW
Mode Category:CW
Sent Exchange: 001 + AGCW Member Nr.

All Asian CW

All Asian SSB

The All Asian contest can be used by Asian stations and DX stations.

Window: Select Log type
CW

Log Type: ALLASIACW
Sent Exchange:Your age Example: 34

XYL and YL stations may give 00
SSB

Log Type: ALLASIASSB
Sent Exchange:Your age Example: 34

XYL and YL stations may give 00

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an Asian
station or a non-Asian station.

Asia Pacific Sprint CW

Asia Pacific Sprint SSB

The Asia-Pacific Sprint contest can be used by Asia-Pacific stations and DX stations.

Window: Select Log type
CW

Log Type: APSCW
Sent Exchange:001

SSB
Log Type: APSSSB
Sent Exchange:001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an Asia-
Pacific station or a DX station.

Asiatic Russia Championship

For Asiatic Russian stations only.
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Exchange consists of 2-digit location (one-digit lat/one-digit long rounded up to nearest 10 degrees e.g. 59N 81E > 69)
plus serial number

Use 001 for Sent Exchange, incorporate location in F2 message e.g. “69 {EXCH}”

ARCI QRP Contests & Michigan QRP Contest

The ARCI contest supports 7 ARCI QRP Contests. The Michigan QRP Contest has almost the same rules. Several other QRP
contests use the same exchange type, although the scoring may be different.

Window: Select Log type
Log Type: ARCI
Mode Category:

CW
for Spring QSO party ; HootOwl Sprint ; Summer Homebrew Sprint ; Fall Qso Party ; Holiday
Spirits ; Michigan QRP Contest

SSB
for Winter Fireside

MIXED
for Topband Sprint

Sent Exchange:
First Part

State abbreviation for USA stations. Example: CT
Province abbreviation for VE stations. Example: ONT
Country abbreviation for non US or VE stations. Example: DL

Second Part
ARCI number for ARCI members
Sent power for non-ARCI members

Log Window: Mult = DXCC Mult2 = Section (State or Province) Example: CT
Power is recognized by containing a non numeric character. Example: 100W is power, 100 is a member number
There is a check on provinces and states, no check on countries. The program will give a proposal for the country
prefix if non VE or K
No calculations made for power multi or Bonus Points, this has to be done by the operator after the contest on the
summary sheets
Select CW, SSB or MIXED as ‘mode Category ‘to have the multiplier window work correctly
The program allows stations to work each other in the contests in both modes, even when only CW or SSB is allowed
according the rules. We assume the operator knows the rules and follows them…

ARI International DX Contest

The ARI International DX contest can be configured for Italian stations and DX stations.

Window: Select Log type
Log Type: ARIDX
Sent Exchange:

001 for non-Italian stations
Your Province for Italian stations

Call History: ARIDX (Thanks to UR7QM for 2019 version)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an Italian
station or a DX station.

ARRL 10 Meter contest

The ARRL 10M contest can be used by K/VE stations and DX stations.

Window: Select Log type
Log Type: ARRL10M
Sent Exchange:

Your state/province – for K/VE stations Example: NY
001 – for DX stations (non K/VE)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a W, KH6, KL7, VE station.

All non-28 MHz spots are marked as unworkable.
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ARRL 160 Meter contest

The ARRL 160M contest can be used by K/VE stations and DX stations.

Window: Select Log type
Log Type: ARRL160 (not ARRL160M if shown)
Mode Category: CW
Sent Exchange:

ARRL/RAC section – for ARRL/RAC stations Example: VI
DX stations should enter their prefix or “DX” here. By this contest’s rules, DX stations only send a report,
no further exchange, but this is needed nonetheless to ensure a correct Cabrillo file for submission to the
contest sponsors. This means that DX stations should not use the {EXCH} macro in their messages for
this contest, so if you are using the default CW messages, they will need to be edited.

The callsign in the Station Information dialog (>Config >Change Your Station Data >Call) determines if you are a DX station or
an ARRL/RAC station.
The ARRL/RAC sections can be found at http://www.arrl.org/contests/sections.abv.html

The contest module accepts ITU regions: R1, R2 or R3 for /MM and /AM stations.

All non-160 meter spots are marked as unworkable.

ARRL Field Day contest

The ARRL Field Day contest can only be used by US (K, KL and KH) & Canada stations (i.e. there are more FD contests
outside the US & Canada which are not covered by this contest type – see FDREG1).

Window: Select Log type
Log Type: FD (or FDGOTA for the GOTA station)
Sent Exchange:

Your Class Your section
Call History File: FDGOTA.txt for both FD and FDGOTA log types

Here is word from Dan Henderson from the ARRL contest branch on using Cabrillo for your log submission.

Field Day is not included in the Cabrillo format. It has no way to mark/indicate power sources, GOTA station callsigns, bonus
points, NTS traffic messages, etc. Also, Field Day only requires Dupe Sheets, not full logs. It is perfectly acceptable to include
the Cabrillo log in lieu of the Dupe Sheets, but Field Day must have a completely filled out Summary sheet that includes all
necessary information. This can be done with a “reasonable facsimile” electronically. However, since “proofs of bonus” (i.e.
copies of letters to newspapers, visitor logs, photos, etc) are abundantly provided, most people find it easier to do Field Day
via the regular mail – and use a combined system of part-electronic added to the paper summaries. Anything received
electronically for Field Day will be receipted but we may have to manually follow up if we can’t get the basic required
information from the email.

73, Dan Henderson, N1ND

The Exchange Window will show you valid Exchanges

Make sure you enable the Exchange pane in the Check window for FD. As you type section exchange the pane will
display matches to the characters typed.

ALT+Y (yank) can be used one or more times to pull the matching exchanges into the Entry Window.

John, K3CT



Changing from HF to VHF (and back)

ARRL Field Day is unusual because it includes both HF and VHF bands. Switching bands with Ctrl+ PgUp/Dn won’t
work for band changes across the HF/VHF divide, but you can operate, dupe and log on the right band by one of two
methods:

if your radio is interfaced, just change bands on the radio and your log will follow.
If your radio is not interfaced, just type an appropriate frequency in kHz (such as 50125 for 6 meters) in the
Entry window’s callsign field) and press Enter.
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ARRL Field Day GOTA Station

Window: Select Log type
Log Type: FDGOTA
Sent Exchange:

Your Class + Your section
Call History File: FDGOTA.txt for both FD and FDGOTA log types

Here is a GOTA station logging tip from Jim, VE7FO:

Q: I always have a problem with the FD GOTA log. Besides just logging the QSO, I also need to ID the operator, the operator’s
age and the GOTA coach. This has always been difficult to reconstruct after the fact. Anybody else seen this?

A: Just give the GOTA coach the following responsibilities: When a new op comes on have him hit CTRL-O and enter his call
or name followed by a space and his age. This gets two of the vital pieces of info into the log. Require the coach to keep a log
of his on and off times at the GOTA position; or you could add the coach’s call at the end of the CTRL-O stuff too. You’ll have
to increase the width of the operator column in the log in order to see all this.

ARRL International DX contest CW / SSB

Window: Select Log type
CW

Log Type:ARRLDXCW
Mode Category: CW
Sent Exchange: Your state/province – for K/VE stations Example: NY
Sent Exchange: Power – for DX stations (non K/VE) Example: 200

SSB
Log Type:ARRLDXSSB
Mode Category: SSB

Sent Exchange: Your state/province – for K/VE stations Example: NY
Sent Exchange: Power – for DX stations (non K/VE) Example: 200

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX stations
or a W/VE station.&&&
The default power for DX stations is:

100 Watts – Default
200 Watts – For the following countries: UA, UA2, UA9, UK, UN, UR, R1FJ, R1MV
400 Watts – For the following countries: G, GM, GI, GD, GM, GM/s, GW
500 Watts – For the following countries: I, IS, IT9

Use the Space bar when the cursor is in the callsign field to have the ‘Power’ field filled with the default power. The default
power will only be entered when the Power filed is empty. If you type another power level, it will replace the default power that

In either case, the default band buttons in the Entry window will continue to display HF bands, but the Available
window and Bandmaps will display spots for the band you have selected. Or, you can change the band panel buttons
from the right-click menu in the Entry window, and then use the band panel buttons for whatever bands you have
selected.

Using FT8 on Field Day

Users planning to operate the FT8 (or related) mode with WSJT-X on Field Day should read about the WSJT-X to
N1MM+ interface in the manual section on the WSJT Decode List window. Remember to set the Mode category in
the Contest Setup to SSB+CW+DIGITAL.



Networking and the GOTA station

If you are networking multiple computers for Field Day and you also have a GOTA station, do not network the GOTA
station with the other stations. The GOTA station uses a different callsign, and its contacts are not included in the
main FD log. Networking the GOTA station’s logging computer with the rest of the network will result in incorrect
logging at both stations.
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the program put in there.

Some stations use K or KW for 1000 watts in the exchange. You don’t have to enter 1000, just type K. The log checking
software from the contest committee will understand.

Call History for DX stations: When Call History is selected and a file is imported with US callsigns and States, the bandmap
will be checked against the log and the call history and colored for mults when needed. So incoming spots will be colored
when they are a qso, dupe or mult and found in the log or call history.

ARRL November Sweepstakes CW

ARRL November Sweepstakes SSB

Window: Select Log type
CW

Log Type: SSCW
Mode Category: CW
Sent Exchange box: Precedence, Check (year first licensed), and ARRL/RAC section (and in this order!).
Example: B 70 EMA (make sure there is no leading space, and only one space character each
between the precedence and check and the check and section) (NOTE: This is not what you should
send over the air or in your F2 exchange messages; it’s what you must enter into the Sent Exchange box
in the Contest Setup window in order to create a valid Cabrillo file)

F5 key: !
F2 key: Right click on the CW message buttons and change F2 to, for example:
# B * 70 EMA (change the B, 70 and EMA to your own precedence, check and section). The # and
* will be automatically converted on the fly to the serial number and your call sign to create a valid
Sweepstakes exchange

If you have separate Run and S&P buttons, you will have to do this for both of them.

SSB
Log Type: SSSSB
Mode Category: SSB
Sent Exchange box: Precedence, Check (year first licensed), and ARRL/RAC section, separated by single
spaces (and in this order with no leading space before the precedence!). Example: B 70 EMA (do not put in
any extra space characters) (NOTE: This is not what you should send over the air; it’s what you must enter
into the Sent Exchange box in the Contest Setup dialog window in order to create a valid Cabrillo file)

F5 key: Normally empty; use ! only if you have pre-recorded letter and number wav files in the
wav\LettersFiles sub-directory for voicing of call signs
F2 key: Normally, most users should plan on saying callsigns and serial numbers and then pressing F2
for the rest of a pre-recorded exchange message, beginning with your precedence, then your call sign,
your check (year licensed) and your section. If you are using voicing of call signs and serial numbers, the
F2 message would start with # followed by the pre-recorded message for the rest of the exchange

We do not recommend starting out using voicing of serial numbers in SSB contests, because experience has shown that
serial numbers enunciated as “one two three one”, no matter how skillfully recorded, are never as easily understood as “one

Don’t put a serial number in the Sent Exchange box in the Contest Setup window

Sweepstakes is unlike most other serial number contests in that it does not require you to enter “001” (or #) in the
Sent Exchange box in the Contest Setup dialog window. In fact, you must NOT do that. The ONLY things you put in
the Sent Exchange box are your Precedence, Check and Section, separated by single spaces and without any
leading or trailing spaces. This is required in order to produce a valid Cabrillo file.



Don’t use the {EXCH} macro in your Sweepstakes exchange messages

The standard default function key message (.mc) file that you use in other contests will not work for Sweepstakes.
Do not use the {EXCH} macro in your Sweepstakes exchange messages. Instead, program the full exchange
explicitly in your Exchange messages: # [Your Precedence] * [Your Check] [Your Section], as in # A * 78 WMA . Make
sure to include the # (serial number) and * (or {MYCALL}) macros as well as your precedence, check and section at
the proper places in the exchange.



3/4/25, 5:37 PM N1MM Logger+ Documentation



404

thousand two hundred thirty one.” However, once you have experience with using simple SSB messages, if you want to go to
the next step and explore advanced voicing of serial numbers or callsigns, click here.

Example of playing WAV files using ESM.

Put a single space in the message column of the F5 line of the SSB function key table.

Speak the callsign of the station you’re working and the serial number and press Enter. Your exchange.wav file should be
something like “Bravo N1MM Check 61 Connecticut”

Entering Received Exchanges

Entering the received exchange is different in Sweepstakes than for any other contest because SS uses a five part exchange
(nr, prec, call, ck, section). After you enter the call and move to the Exchange window (either by ESM or by pressing the space
bar or Tab key) you can enter all five in one window, and the program will do its best to interpret what you enter. Use spaces to
separate exchange elements except for the serial number and precedence, which should be entered without a space
between them.

If you use a Call History file in Sweepstakes (don’t forget to check Call History Lookup on the Config menu), when you enter a
callsign that is in the file and press the Space bar, it will prefill the Check (CK) and Section (SEC) for you and position the
cursor one space behind the prefilled information. Assuming the prefilled information is correct (always verify this!), all you
need to do is type the Serial Number and Precedence as a joined pair as you copy them. They look like they are in the wrong
order, but look above the Exchange textbox for the line of small black type. You’ll see it in the correct order as it will be entered
in your log.

You do not need to type the call again unless you had it wrong the first time, in which case you can type it into the exchange
box to the right of what is already there and you’ll see the program magically correct it (again in the small black type). If the
program thinks there may be a problem, it tries to signal that by changing the type color to blue, so be aware of that. If
something is screwed up, the best option is to simply enter the correct information at the end (new information will override the
previous information). You should never have to wipe, or highlight and hit Delete. Another option would be to backspace to the
point where the exchange (or partial exchange) looks right again, and then re-enter the rest of the information.

There are a couple of important rules. You must always enter the Serial Number and Precedence as a single element – e.g.
“23B” not “23 B”. This is how the program tells a check from a serial number. Otherwise, you should put a space between
elements. This is probably a good habit to get into, because when you need to correct something you have copied (see below)
you’ll need to do this.

Correcting what you copied

This is where N1MM Logger+ gives you a real advantage in Sweepstakes. The basic idea is that you never have to tab to the
Callsign field or backspace in the Exchange field to make corrections. The basic rule is simply to type your correction at the
end of the Exchange string you have already copied. This includes callsigns.

You can confuse the parser (the routine that generates the black type above the Exchange window); it needs a bit of help to
tell check numbers and serial numbers apart. Here are easy rules you can apply to help with proper parsing:

When you are correcting a Callsign in the Exchange field, make sure you set it off with spaces.
If you need to enter or correct a Serial Number, always enter it with the Precedence, without a space between – e.g
“99B”, not “99 B”. You may also enter the Check and Section as another “couplet” – e.g., “54WV” instead of “54 WV”. If
you do this, we don’t think you will be able to make the parser get it wrong.

ARRL Rookie Roundup

Rookies (operators licensed 3 years or less) work everyone; non-rookies work only rookies. Rookie status is determined by
the 2-digit licensing year as entered in the Sent Exchange field of the Contest Setup Window (reached by File > New Log in
Database or Open Log in Database). BOB 08 WV in the Sent Exchange field tells the program Bob’s a rookie; BOB 54 WV
tells it he’s not.

You do not need any special suffix on rookie calls (do not use /ROK. This is a rule change since the first running). Rookies are
encouraged to call “CQ Rookie Roundup” on phone and “CQ RR” on CW and digital modes. Non-rookies should call “CQ
Rookies” on phone and “CQ R” on CW or digital modes. A sample CW function key definition (message) file is here, in the file
called “RRCW.mc” in the Function Key Files – CW subfolder. The messages are set for Rookies, non-rookies will need to
change the CQ RR to CQ R.

Log the exchange in order — name, 2-digit year, and state. Check the space immediately above the exchange field, where the
program will indicate how it has “parsed” the exchange, and correct if necessary. 4-digit years should not be sent or logged – it
will only cause confusion
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Score summaries are due within 72 hours of the end of the contest – 2359 Wednesday evening UTC, or 1859 EST. Use the
“Submit your score” link under “Score submission” at the ARRL web page for the RR. ARRL says logs are not required or
accepted.

Window: Contest Setup
Make sure that you have entered your 2-digit licensing year in the Sent Exchange field.

Select Log Type
Log Type: RRSSB, RRRTTY, RRCW (pick the appropriate one)
Sent Exchange: Name, two-digit check (year first licensed), and State or Canadian Province, Mexican call area
(XE1-4), or DC (examples: PETE 54 WV, BOB 67 XE1, MARY 09 NU, ANN 10 DX

ARRL School Club Roundup

The station categories in this contest are different from those in the Cabrillo specification. You can choose a station category
from the pull-down list, but you will have to edit it after the contest to read CLASS-I, CLASS-C, CLASS-S-EL, CLASS-S-JH,
CLASS-S-HS or CLASS-S-UN according to the category of your station.

Window: Contest Setup
Select Log Type

Log Type: ARRL-SCR
Sent Exchange: Category (I, C or S for Individual, Club (non-school) or School class) and QTH (2-letter
state/province abbreviation in W/VE, DX for other locations)

Asia Pacific Sprint Contest CW

Asia Pacific Sprint Contest SSB

Window: Select Log type
CW

Log Type: APSCW
Mode Category: CW (spring and fall)
Sent Exchange: 001

SSB
Log Type: APSSSB
Mode Category: SSB (summer)
Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX stations
or an Asia-Pacific station.

Baltic Contest

The Baltic contest can be configured for stations from the Baltic countries (ES, YL, LY) and DX stations.

Window: Select Log type
Log Type: BALTIC
Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a Baltic station.

Black Sea Cup International

Window: Select Log type
Log Type: BSCI
Mode Category: MIXED
Sent Exchange: ITU Zone

HQ stations: IARU society abbreviation
BSCC members: membership number, e.g. BS17

CNCW Spanish contest

The CNCW contest (EA CW NATIONAL CONTEST) is only for Spanish stations operating inside the national territory.

Window: Select Log type
Log Type: CNCW
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Mode Category: CW
Sent Exchange: Spanish Province letters Example: SG

CQ M International DX contest

Window: Select Log type
Log Type: CQM
Mode Category: Select what category you enter (SSB, CW or Mixed)
Sent Exchange: 001

CQSA SSB Contest

This contest uses the Cabrillo 3.0 log file format so be careful to check the Contest Setup Window (File > Open
Contest) to make sure you have filled in appropriate entry class, etc.

CQ 160 Meter DX contest CW

CQ 160 Meter DX contest SSB

Window: Select Log type
CW

Log Type: CQ160CW
Mode Category: CW

SSB
Log Type: CQ160SSB
Mode Category: SSB
Sent Exchange:

Your state/province – for K/VE stations Example: NY
Your CQ zone – for DX stations (non K/VE)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX stations
or a W/VE station.

All non-160 meter spots are marked as unworkable. Spots are marked with state from call history lookup as mults (if needed)
in Bandmap and Available windows.

CQ World Wide DX contest CW

CQ World Wide DX contest SSB

Window: Select Log type
CW

Log Type: CQWWCW
Mode Category: CW
Sent Exchange: Your zone Example: 14

SSB
Log Type: CQWWSSB
Mode Category: SSB
Sent Exchange: Your zone Example: 14

The default zone values for US (K,N,W,A) stations are

Special country file needed

The CQM contest uses a special country list. In order to score properly, you need to import that country list into the
database you will be using. First download the file by selecting the >Files >Additional Support Files menu item on the
N1MM Logger+ web site and copying the file Cty-CQM.dat to your N1MM Logger+ user directory. Then, from the
Tools menu in the N1MM Logger+ program, select Import Country List from Downloaded File, and select the special
Cty-CQM.dat file. Import it, and you’re good to go.

After the contest, don’t forget to re-import the wl_cty.dat file to restore the normal country list.

If you discover after the contest that you skipped this step, just be sure to submit your log in Cabrillo format, and the
organizers will re-score it for you. Alternatively, you can import this special country list and re-score the contest (Tools
> Rescore), but if you do that be sure to back up the database first, just in case.
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Zone 3 – If number in callsign is 6 or 7
Zone 4 – If number in callsign is 5 or 8 or 9 or 0
Zone 5 – If number in callsign is 1 or 2 or 3 or 4

The default zone values for Canadian (VE) stations are
Zone 1 – If callsign starts with: VY1
Zone 2 – If callsign starts with: VE2, VO2
Zone 3 – If callsign starts with: VE7, VC7
Zone 4 – If callsign starts with: VE3, VE4, VE5, VE6, VA3
Zone 5 – If callsign starts with: VO1, VE1, XJ1, VY2

Press the Space bar when the cursor is in the ‘Callsign’ field to have the ‘Zone’ field filled with the default value
The default zone will be selected, so that if you type another zone, it will replace the numbers that the program put in
there
For US users, Ctrl+Up/Ctrl+Dn doesn’t stop at US stations
US spots are not grayed out for Canadian users
Don’t show and count own countries as workable in the Bandmaps and the Available window
A new zone will be shown in red in the Entry window
Band changes

In multi-single, there is a 10-minute band change timer for both Run and Mult stations
In multi-two, there is a limit of 8 band changes per station per hour. The band change counter is reset to 0 on
first contact after the top of the hour

The program will look up the zone if the call has been changed, provided no zone was typed by the user

CQ World Wide WPX contest CW

CQ World Wide WPX contest SSB

Window: Select Log type
CW

Log Type: CQWPXCW
Mode Category: CW
Sent Exchange: 001

SSB
Log Type: CQWPXSSB
Mode Category: SSB
Sent Exchange: 001

Multi-Single and Multi-Two entries have a single set of serial numbers across all bands; per the rules, in multi-single a
single sequence of serial numbers is generated regardless of band.
Band changes (per hour)

The allowed band changes are 10 for Multi-single and 8 for Multi-two
The band change counter is reset to 0 on first contact after the top of the hour

CIS contest – CW / SSB

The Commonwealth of Independent States Contest where everybody can work everybody for QSO and multiplier credit.

Window: Select Log type
Log Type:

CW: CISCW
SSB: CISSSB

Sent Exchange:
CIS stations: CIS area code Example for Moscow City: RU11
Non-CIS stations: 001

Cup of the Russian Federation RFC contest CW

Cup of the Russian Federation RFC contest SSB

The RFC Contest is an internal Russian contest only between Russian stations.

Window: Select Log type
Log Type:

CW: RFCCW
SSB: RFCSSB

Sent Exchange:Grid Example: 115
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CWops Mini CWT

Several 1-hour mini-contests each week. Each 1-hour segment is a separate contest.

Every Wednesday at 1300 – 1400z (favoring Asia/Pacific); 1900 – 2000z (favoring Europe/Africa); and 0300 – 0400z –
Thursday (Wednesday evening in US/Canada).

Window: Select Log type
Log Type: CWOPS
Mode Category: CW
Sent Exchange:

Name and membership number (members – e.g. Fred 1234)
Name and state/province/country (non-members – e.g. Wilma NY)

Call history lookup for member numbers in the Sect or Exch1 field of the call history file is supported.

CWops CW Open

Annual event – three, four hour contests (0000-0359Z, 1200-1559Z and 2000-2359Z). In late August or early September

Window: Select Log type
Log Type: CWOPSOPEN
Mode Category: CW
Sent Exchange box:

001 and name (e.g. 001 JOHN)

DARC 10 Meter contest

Window: Select Log type
Log Type: DARC10M
Mode Category: MIXED or CW (depends on the entry class)
Sent Exchange:

In the contest setup dialog window, Sent Exchange field, put only #

DL stations: (in your Function Key definition, put {SENTRST} {EXCH} DOK or NM )
DARC members send: RST + # + DOK (Example: 599 092 A12)
non-DARC members send: RST + # + NM (NM stand for non-member)

Foreign stations send: RST + # (in your Function Key definition, put {SENTRST} {EXCH} )

Call history lookup for DOK’s is supported. Make a text file with Call and DOK and import this in the program. See the chapter
Before the Contest for information how to use Call History and how to create the text file. During the contest “Call History
Lookup” has to be enabled under the Config menu. When a station (which is in the Callhistory lookup table) is entered,
pressing SPACE when the cursor is in the callsign field will enter the DOK in the section field.

The contest manager from the DARC 10 meter contest approved and will accept the files made by N1MM Logger+ and likes
to receive:

File How to make… Exported

Log file >File >Export >Export to File (Generic) >Generic File Output sorted by time [callsign].txt

Summary sheet >File >Export >Print Score Summary to File [callsign].sum

Send the “Generic File Output sorted by time” as a txt-File named with your call like DL8WAA.TXT
Don’t forget your used own call, category and if you are a DL station: own sent DOK. This can be put in the Email or
sent in the Cabrillo file.

DARC Weihnachtswettbewerb XMAS contest

The DARC Weihnachtswettbewerb is a contest on December 26 from 08.30-10.59 UTC between any station on 40 and 80
meters.
The DARC contest manager for the Xmas contest accepts the standard generic file as log together with the summary sheet..

Window: Select Log type
Log Type: XMAS
Mode Category: MIXED
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Sent Exchange:
DL stations:001 + DOK Example: 001 A12
Non-DL stations: 001

During the contest info about suspicious DOK’s are shown in the info bar and written to the Notes filed.&&&
After the contest check >View >Notes for the following situations:

“DL station non DARC member” – no DOK is given (DL station who is not a DARC member)
“DL station with DOK length 1” – DOK length is only one
“DOK with only numbers” – no letters in DOK

DIG contest CW

DIG contest Phone

Window: Select Log type
Log Type:

CW: DIGCW
SSB: DIGSSB
Sent Exchange: anything as it is not being used (DIG members could enter their DIG number here)

Elecraft QSO Party

Window: Select Log type
Log Type: EQSO
Mode Category: Mixed
Exchange: State/Province/Country, Rig code + Rig serial number, or Power (non-elecraft rigs)

e.g. K3 serial #1234 would send 31234

European Sprint CW

European Sprint SSB

Window: Select Log type
CW

Log Type: EUSCW
Mode Category: CW
Sent Exchange: Serialnumber & Operator name Example: 001 Tom

SSB
Log Type: EUSSSB
Mode Category: SSB
Sent Exchange: Serialnumber & Operator name Example: 001 Tom

Example: The Exchange key (F2) can look like this: de * # {Exch} where “#” is current QSO Number and “{Exch}” is the
Operator name.

EU HF Championship

Window: Select Log type
Log Type: EUHFC
Sent Exchange: Last two digits of the year of operator’s first official amateur radio license Example: 82 (for 1982)

Field Day Region 1

The Region I field day contest can be configured for Region 1 stations and DX stations. Supported are the rules for stations in
Belgium, Germany, United Kingdom (**), Netherlands, Switzerland, Ireland (only CW), Italy, Slovenia (S5) and Russia (UA,
UA2, UA9).

Window: Select Log type
Log Type: FDREG1
Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call) determines if you are a Region 1
supported station or not and if you are /P etc. or not..
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N1MM Logger+ checks whether the callsign used is a portable or a fixed station by checking the callsign in the Station dialog
under config! So using a /P, /M etc there could make a difference in scoring!

United Kingdom: The ModeCategory selects the CW or the SSB version of the contest. The rules between the CW and the
SSB version are very different.

First Class Operators Club (FOC) Marathon – members only

Window: Select Log type
Log Type: FOCCW
Sent Exchange:membership number

The calculation of bonus points for working the same station on 5 (10 additional points) or on 6 bands (an extra 5 points) is not
supported by the program.

Martin/OK1RR and John/G3WGV have posted contest routines to rescore the contest from a Cabrillo file to a fully correct
(including the 5/6 band bonuses).

First Class Operators Club (FOC) QSO Party

Window: Select Log type
Log Type: FOCBWQP
Sent Exchange:

FOC members: Name and FOC Number
Non-members: Name

GACW WWSA CW DX contest

The GACW WWSA CW DX contest can used by South American stations and DX stations.

Window: Select Log type
Log Type: GACW
Mode Category: CW
Sent Exchange: Your zone Example: 14

The rules are almost equal to the CQWW contests.
Default zones for US (K,N,W,A) and Canadian (VE) stations apply

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a SA station
or a DX station.

Gagarin Cup

Window: Select Log Type
Log Type: GCUP
Mode Category: CW
Sent Exchange: Your ITU zone (not CQ zone e.g., 8 rather than 5 for eastern USA)

In order to have the Special Event stations appear in red in the Bandmap and Available windows, you will need to load the
Call History file for this contest.

Special country file needed
The Gagarin Cup contest uses a special country list. In order to score properly, you need to import that country list
into the database you will be using. First download the file by selecting the >Files >Additional Support Files menu on
the N1MM Logger+ web page and copying the file Cty-CQM.dat to your N1MM Logger+ user directory. Then, from
the Tools menu in the N1MM Logger+ program, select Import Country List from Downloaded File, and select the
special Cty-CQM.dat file. Import it, and you’re good to go.

After the contest, don’t forget to re-import the wl_cty.dat file to restore the normal country list.

If you discover after the contest that you skipped this step, just be sure to submit your log in Cabrillo format, and the
organizers will re-score it for you. Alternatively, you can import this special country list and re-score the contest (Tools
> Rescore), but if you do that be sure to back up the database first, just in case.
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HA DX Contest

The Hungarian DX Contest can be configured for HA stations and DX stations.

Window: Select Log type
Log Type: HADX
Sent Exchange:

non-HA stations: 001
HA stations

HADXC members: HADXC membership number Example: 101
Other HA stations: two letters county code. Example: GY

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a HA station
or a DX station.

Ham Spirit CW/SSB

Ham Spirit Contest – CW (last weekend of October) and SSB (last weekend of November)

NOTE: unusual exchange format. Be sure to read the contest description and rules HERE:

Log Type: HAMSPIRCW or HAMSPIRSSB
Sent Exchange: ITU zone and your grid field (the first two characters of your Maidenhead grid square), with no space
between them.
Examples: 27JN, 28JN, 42MM, 42MN, 32NO, 32OO.
NOTE: there is also a signal report in the on-air exchange, but do not enter one in the Sent Exchange box in the
contest setup window.

Operating Notes:

This is a contest where the Multipliers/Grid Field window can be used. There is a caveat: the first worked station from a
particular field will color that field blue but then all others from the same field but a different ITU zone will not be displayed in
this window as new multipliers (the field will stay blue, since there is already at least one contact logged from that field).  For
multiplier identification it will be better to use the AMQ or Bandmap windows.

The multiplier color scheme in the Bandmap and Entry windows is unusual and may be confusing. Stations from a new ITU
zone (as determined by the logger using the wl_cty.dat file) will display in red color while the field is unknown. Once the field is
known as well, the callsign will display in green color. Stations from an ITU zone that is already in the log will display in blue
color as long as the field is unknown, since they might not be a new multiplier. Once the field is known, if it is a new field/zone
combination and therefore known to be a new multiplier, the callsign will display in green color.

A Call History File is available for this contest. Download by selecting Update on the Associated Files tab during contest setup.
The CH file has 75,000+ callsigns but in 2022 this is the first time it will be used, so users are encouraged to check their
information for accuracy and report errors to Claude VE2FK.

Helvetia Contest

The Helvetia Contest can be configured for HB stations and DX stations.

Window: Select Log type
Log Type: HELVETIA
Sent Exchange:

001 for non-HB stations
001 Your Canton Example: ZH for HB-station

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a HB station.

High Speed CW Contest

The HSC CW contest can be configured for members and non-members.

Window: Select Log type
Log Type: HSCCW
Mode Category: CW
Sent Exchange:

Non-members: NM
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Members: HSC-Membershipnumber

Holyland Contest

The Holyland Contest can be configured for 4X stations and DX stations.

Window: Select Log type
Log Type: HOLYLAND
Sent Exchange:

001 for non-4X stations
Your Area Example: E15RH

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a 4X station.

IARU Radiosporting Contest HF

Window: Select Log type
Log Type: IARU
Mode Category: CW or SSB or MIXED
Sent Exchange: IARU member society abbreviation for IARU member society HQ stations and IARU
International Secretariat club station

AC for IARU Administrative Council
“R1,” “R2,” and “R3” for the three IARU regional Executive committees
ITU zone for all other stations Example: 27

The zone is prefilled while typing the callsign to allow multipliers to be shown while typing the callsign.

Call history lookup for HQ multipliers is supported. Correct format is: W1AW,,,,ARRL,,,

If Call History Lookup is enabled, and a Call History file containing HQ multipliers has been loaded, then when an HQ
multiplier or partial HQ multiplier (at least two letters) is entered into the exchange field and there is no call sign in the
call sign field, the Check window will display all call signs in the Call History file with that same HQ multiplier in the
Reverse Call Lookup pane

The call signs can be clicked on with the mouse to transfer one of them to the call sign window
If there is a partial call sign in the call sign field, possibly using wild cards for missing characters, the list of call
signs displayed will be limited to those matching the partial call sign

IOTA Islands On The Air Contest

Window: Select Log type
Log Type: IOTA
Sent Exchange:001 NA123 (default exchange) Be sure to delete the “NA123” from the Sent Exchange field
in the Contest Setup dialog if you are not an island station, because otherwise the program’s scoring
will be incorrect.

Your own IOTA reference must be in the form XXYYY where XX = letters and YYY = numbers.

NB: The syntax for the sent IOTA reference must be in the form XXYYY where XX = letters and YYY = numbers. Example:
001 EU001 and not 001 EUTT1 or 001 EU1. If you wish to transmit your exchange with cut numbers or without leading zeros
in the IOTA reference, you will have to hard-code your desired exchange in your exchange messages instead of using the
{EXCH} macro

The received IOTA reference does not need the dash (-) when logged. Example: Enter EU123 in the IOTA field, not EU-
123. The Cabrillo output will have the – added automatically
The IOTA contest has many multipliers and therefore the program will only show worked IOTA references and add a
new IOTA reference when a new multiplier is worked. In the Multiplier window, choose the “Sect” tab

If Call History Lookup is enabled, and a Call History file containing IOTA references has been loaded, then when
an IOTA reference or partial IOTA reference is entered into the exchange field and there is no call sign in the call
sign field, the Check window will display all call signs in the Call History file with that same IOTA reference in the
Reverse Call History pane
The call signs can be clicked on with the mouse to transfer one of them to the call sign window
If there is a partial call sign in the call sign field, possibly using wild cards for missing characters, the list of call
signs displayed will be limited to those matching the partial call sign

If your Call History file contains a list of country prefixes and island codes for those DXCC countries that are entirely on
islands (e.g. G, VK), then entering a call sign from one of these countries will automatically pre-fill the IOTA reference
field with the most common IOTA code for that country (see the IOTA Call History.txt file distributed with the program –
country references are at the end of the file)
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Since in many cases there is more than one IOTA reference for the same country, you must be prepared to
override this code; when the cursor is moved to the IOTA field, the second (numerical) part of the IOTA reference
code is highlighted to make it easy to override the default number

Note for multi-operator stations:

The IOTA contest allows multi-operator stations to use two radios, one of which is only allowed to work new multipliers.
This is similar to the Multi-Single category in the CQ WW contest; note that in this contest, the two stations are allowed
to transmit simultaneously

If you wish to make use of two radios, in the contest setup window choose the MULTI-ONE category (Operator
category MULTI-OP and Transmitter category ONE). Select Networked-Computer Mode on both computers (see
the Network Status Window section of the manual).

At the multiplier-only station, when prompted to choose Run or Mult, choose Mult. In the Network Status
Window under the Options tab, choose Run2/Mult, and check the “Don’t work non-mults” check box.
If you wish to allow simultaneous transmitting at both stations, in the Network Status Window under the
Options tab check the “Block my transmitter only if other station transmitting on same band and mode
(multi-one)” option. This will allow both transmitters to operate simultaneously. This option is not “sticky”,
i.e. you will have to check it every time you restart the program, otherwise your radio will be blocked from
transmitting whenever the other radio is transmitting. WARNING: DO NOT rely on the software lockout
to protect your radios – the lockout is intended only to facilitate compliance with contest rules, and
should not be relied upon to protect against damage

International Naval Contest

Window: Select Log type
Log Type: NAVAL
Sent Exchange:

Club+Membership number for Naval Club member, e.g. PN007
001 for non-Naval Club member

2009 contest rules: are here.

2010 dates: 8 / 9 May – CW and SSB, 15/16 May – PSK and RTTY;

JA domestic contests

This is a general contest class for Japanese domestic contests and only for use by JA stations.

Window: Select Log type
Log Type: JAdomestic
Sent Exchange: Section + class Example: 25M or 10L

General rules:

Japanese stations may only work Japanese stations
Example exchange numbers in ALL JA contest with assuming as follows.

I am in Osaka with 100W output and another party is in Tokyo with 10W.’ send:59925M receive:59910L
I am in Okinawa with 1KW output and another party is in Sapporo in JA8 with 50W. send:59947H
receive:599106M

Dupe and multiplier examples
20 mtr JE1CKA 10H SSB 1 point + multiplier
20 mtr JE1CKA 10H CW 0 points dupe, no multiplier
20 mtr JE1CKA 10H SSB 0 points dupe, no multiplier

Same station should counts for 1 point only once on each band regardless of mode.
The multiplier counts once on each band regardless of mode.
When the SentExchange does not end on H, L, M or P then there is no Powercode check.

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a JA station.

JIDX CW Contest

JIDX SSB Contest

This JIDX contest contest can be configured for Japanese stations and DX stations.

Window: Select Log type
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CW
Log Type: JIDXCW
Mode Category: CW
Sent Exchange:

non-JA stations: CQ Zone number Example: 14 (01 to 40)
JA stations: Your Prefecture Example: 34 (01 to 50)

SSB
Log Type: JIDXSSB
Mode Category: SSB
Sent Exchange:

non-JA stations: CQ Zone number Example: 14 (01 to 40)
JA stations: Your Prefecture Example: 34 (01 to 50)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a JA or a DX
station.

JT DX Contest

Window: Select Log Type
Log Type: JTDX
Mode Category: CW or SSB, select one only
Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)

King of Spain Contest – CW

King of Spain Contest – SSB

The King of Spain contest can be configured for EA stations and DX stations.

Window: Select Log type
CW

Log Type: KINGEACW
Mode Category: CW
Sent Exchange:

non-EA stations: 001
EA stations:Your Province Example: AV

SSB
Log Type: KINGEASSB
Mode Category: SSB
Sent Exchange:

non-EA stations: 001
EA stations:Your Province Example: AV

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a EA station.

Logbook of the World Contest CW

Logbook of the World Contest SSB

Window: Select Log type
Log Type:

CW: LOTWCW for the Digital part of the contest (LOTWRTTY)
SSB: LOTWSSB

Sent Exchange:
For North American stations: State/Province abbreviation Example: CT
For non North American stations: Countryprefix

LZ DX Contest

The LZDX contest can be configured for LZ stations and DX stations.

Window: Select Log type
Log Type: LZDX
Sent Exchange:
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non-LZ stations: ITU zone
LZ stations:Your District abbreviation Example: BU

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a LZ station.

LZ Open and LZ Sprint Contests

Supports all three versions of the contest (LZ Open contest, LZ Open 40 meter Sprint contest and LZ Open 80 meter Sprint
contest)

Window: Select Log type
Log Type: LZOPEN
Sent Exchange: 001
Select LZOPEN contest. The Sent Exchange in the “contest selection window” is 001 or #.
Your F2 exchange message should be: {EXCH}{LASTEXCH} or #{LASTEXCH}
Since it is required, the program will always send leading zeros for this contest. Unchecking the leading zeros
box in Configurer will have no effect
When a callsign is in the Entry Window, the Info Window displays the time since you last worked the station
If you have a radio interface enabled, the bandmap colors of the callsigns will update when you can work the
station again for points

Set the Bandmap Packet Spot Timeout greater than 30 minutes
Do not enter received cut letters into the exchange box. They will not be converted to numbers
Read the contest rules
Submit the contest results with the Cabrillo output

The 30 minute time period is computed per the organizers instructions. That is to ignore the seconds of the logged QSO when
computing the 30 minute interval. The 30 minute interval is computed from the last QSO on the current band so it is not
recommended to log a contact that will not produce any points.

LZ Open and LZ Sprint contests display the sent exchange on the Entry Window status line. This addition expects that the
{LASTEXCH} macro is used as required by these contests.

Manchester Mineira Contest

The Manchester Mineira Contest by CWJF is the major CW contest in South America. Since 2011 this contest is now open to
stations anywhere in the world. Held annually on 3rd full weekend of April.

Window: Select Log type
Log Type: CQMMDX
Mode Category: CW
Sent Exchange:

Regular Participants:  (Not CWJF Members, or QRP, or YL or Group), must send only: RST + Continent
(eg, 599 EU, 599 SA, 599 AF).
CWJF Members: RST + Continent + M ( eg, 599 SAM, 599 EUM )
QRP Stations: RST + Continent + Q ( eg, 599 EUQ, 599 NAQ – even if you are a Member or YL )
YL Stations: RST + Continent + Y ( eg, 599 OCY, 599 AFY – even if you are a Member or QRP)
Multi-Operator, Clubs or Groups: RST + Continent + C ( eg, 599 NAC, 599 EUC )

Michigan QRP Contest

See the ARCI contest which uses almost the same rules.

Supported are: January CW Contest ; Memorial Day CW Sprint ; July 4th CW Sprint ; Labor Day CW Sprint

MiniTest CW Test

Almost every week on Wednesday at 18 GMT and lasts only one hour. It has 6 time periods
(10 minute each). Band: 3520 – 3570 kHz, mode: CW, exchange: RST+serial.
Every QSO gives 1 point, multiplier: the number of unique calls during this hour of the contest. Classes: 1- club station, 2 –
SO, A- power > 100 W, B – power < = 100 W, 3 – SWL. The results can be submitted at 19.00 GMT on 3720 KHz (SSB) or on
3541 KHz (CW).
The submitted information (QSO number, multiplier, class) will look like this: “125 36 A”. The results are published here:
http://www.minitest.narod.ru/2009/2009.htm
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NA Sprint CW

NA Sprint SSB

Window: Select Log type
Log Type:

CW: SPRINTCW
SSB: SPRINTSSB

Sent Exchange: 001 Tom CT
Serial number, your name and your location (state, province or country) Example: PA1M DE N1MM 123
TOM CT K

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a North
American station or a non-North American station.

Example function keys can be found in the Example Function Keys chapter
Check out the Macros chapter. The {PGUP} and {PGDN} macros are useful in the Sprint.

By Tom – W4BQF: Open config – Confiigure Ports…. – Other. Under the ‘Other’ tab, look at the right-most
column, where you will see “CW Up/Down Arrow” and “PgUp/PgDown”. These can be configured to QSY.
Configure the Up/Down Arrow keys to QSY, say 2 kHz each time you press your keyboard up or down arrow
keys. Configure PgUp/Down to QSY ‘x’ kHz, and then use {PGUP} or {PGDN} as a macro assigned to any of the
function keys. Example: F10 Freq UP, {PGDN} {run} F11 Freq DN, {PGUP}{run}
In my case “PgUp/Down” will move my frequency 5.5 kHz and the “CW UP/Down Arrow” keys set to QSY 1.5
kHz. A little tricky because {PGDN} actually moves you UP in frequency, but it works very well.

N1MM Logger Sprint Survival Tips – Version 1.8, by N2IC

I thought I would share what I have learned about customizing N1MM Logger for this contest.

I’m not going to try to explain how to operate the Sprint – for this, there is an excellent writeup by Tree, N6TR here.

What I will do is describe how to get the most out of N1MM Logger in the Sprint. My operation is SO2R, and my configuration
is optimized for that mode. However, I’m sure you SO1R guys will pick up a few tricks from what I have done for SO2R.

The most important thing is to get your options, windows and function keys set up correctly before the Sprint starts.

The Options…

I assume that your radio(s) are interfaced to N1MM Logger, so that N1MM Logger will automatically track the frequency of
each radio. If you do not have interfaced radios, this configuration and function key assignment will not work correctly for the
Sprint.

In the Config menu, select the following options:
– Enter sends message (ESM)
– QSYing wipes the call & spots QSO in bandmap
– Do Not Automatically Switch to Run on CQ Frequency
– Show non-workable spots
– SO2R->Toggle CTRLFx Macro

The “Toggle CTRLFx Macro” can also be toggled using Ctrl+Shift+L. This is handy if you need to turn off {CTRLFx} during the
contest.

The Windows…

These are the only windows I have on my screen:
– Entry Window (one for each radio)
– Visible Dupesheet (one for each radio)
– Info
– Log
– Score Summary

They all fit nicely on my small monitor. My screen layout is shown at http://www.kkn.net/~n2ic/sprint.bmp .

The Visible Dupesheet is really nice once you get used to it. To see if a station is a dupe, you just scan the dupesheet with
your eyes, rather than frantically type a call into the Entry Window.

Open a Bandmap window. Right click and select “Set Spot Timeout”. Change the spot timeout to 1 minute. That’s right….1
minute. Hit OK. Now close the Bandmap window. Don’t reopen it. It is of no value in Sprint, but it is important to change the
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packet spot timeout value to 1 minute. It controls how long calls stay on the bandmap and the appearance of calls in the “on
deck” frame of the Entry Window.

Notice that I do NOT have the “Available Mults & Q’s” nor the Bandmap windows open.

Function Keys ….

Here are my function key definitions. I’ll explain a few that aren’t obvious:

With the Run F3 key, my “thank you” message is sent. When you QSY, you will automatically be changed to S&P mode. Do
not include the {S&P} macro here – it will cause the last station worked to get “stuck” in the on-call frame of the Entry Window.

With the S&P F2 key, as soon as I send my exchange, it immediately switches to Run mode.

I can also force myself into Run and S&P modes with the F9 key.

The F7 and F8 keys send CQ’s on the “other” radio. This is very useful when the other station is sending his exchange, and
you are going to lose the frequency (i.e. it will become “his” frequency). You can send a CQ on the other radio, while he is
sending his exchange. Then, when he finishes sending his exchange and you need to send your “thank you” message to
finish the QSO, all you have to do is hit Enter, which will stop the CQ on the other radio, and send your Run F3 message on
the active radio. After the “thank you” message is sent, the {CONDJUMP} macro in the Run F3 message will move your entry
focus to the “other” radio, so that you will be ready to copy a new caller on the radio you were CQing on.

When I’m CQing on the active radio, but simultaneously doing S&P on the other radio, and hear a new station, I can hit the
Enter key. This will stop the CQ, and send my call on the other radio.

One thing you need to do is keep an eye on where your transmit and receive focus is (the red and green dots on the Entry
Window). When you’re doing SO2R in the Sprint, there will be times where your focus is not where you might expect it, or
want it. Always be ready with the \ and Pause keys to jump between radios. Yes, this takes lots of practice, and you will make
mistakes. The Thursday night NCCC Sprints are good practice for this.

NA Sprint CW by Kenny, K2KW

North American Sprint CW is just a few hours away, and thought I would take a moment to help others get their CW messages
ready. Your messages may differ slightly from mine, but I just wanted to highlight what’s happening on the F2 and F3
messages which are the key setup items for Sprint. The F2 exchange is set up to give you the correct sequence for this
contest using ESM, and the exchange sequence varies based on if you are Calling CQ, or you answered someone while S&P.
F3 is used to confirm the message, and change your state from S&P to Running, or Running to S&P. The {RUN} and S&P}
macros are inserted at the end of the F3 message, and will automatically change your state, and thus exchange sequence.

I have also changed the Up/Down Arrow to move 1.5 kHz, giving you an “instant QSY” per the rules. You may choose to use a
wider QSY increment, but the goal was to offer you an idea for QSYing so you can abide by the rules.

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

F1 CQ,{JUMPRX}cq na cq na * na
F2 Exch,* # steve nm
F3 TU,{CLEARRIT}t{END}{CONDJUMP}{STOPTX}
F4 {MYCALL},*
F5 Call,!
F6 QSO B4,qso b4 *
F7 Other Short,{CTRLF10}
F8 Other Long,{CTRLF11}
F9 GoS&&P,{S&P}
F10,cq na * * na {RUN}
F11 Long CQ,cq na cq na * * na {RUN}
F12,-
F1 S&&P CQ,{JUMPRX}cq na cq na * na
F2 S&&P Exch,! # steve nm * {RUN}
F3 S&&P tu,tu
F4 S&&P,*
F5 S&&P his call,!
F6 S&&P,-
F7 S&&P Other Short,{CTRLF10}
F8 S&&P Other Long,{CTRLF11}
F9 GoRun,{RUN}
F10,cq na * * na {RUN}
F11 Long CQ,cq na cq na * * na {RUN}
F12,-
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If you are not aware of the uniqueness of the Sprint exchange and QSY rule, check out: http://n6tr.jzap.com/sprint.html and
http://www.ncjweb.com/sprintrules.php

73 and CU in the contest,

Set the Exchange:
>File >Choose Which Contest to Log >Sent Exchange

# yourname yourstate
Example: # KEN CA

Set QSY distance:
In the >Config >Configurer >Other window, change the CW Up/Down Arrow Incr = 1.5

That gives me an instant QSY somewhat greater than the minimum QSY required after you leave a
frequency. Any value over 1 kHz is recommended

SprintNS and Sprint Ladder

Window: Contest Setup

These contests are identical except for the dupe rule that is incorporated. SPRINTNS does not allow no in-band dupes, while
SPRINTLADD allows dupes with one intervening QSO.

Log Type:
SPRINTNS, SPRINTLADD

Sent Exchange: 001 Tom CT
Serial number, your name and your location (state, province or country) Example: PA1M DE N1MM 123 TOM CT
K

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a North
American station or a non-North American station.

See NA Sprint above for more information (rules for the NS Sprint and Sprint Ladder are derived from but slightly different
than NA Sprint, so be advised!).

NAQP North American QSO Parties CW

NAQP North American QSO Parties SSB

Window: Select Log type
CW

Log Type: NAQPCW
Operator Category: SINGLE-OP or MULTI-TWO

For Multi-Two see the extra info below!
Mode Category: CW
Sent Exchange:

For North American stations – Operator name and station location (state, province, or country)
Example: Tom CT
For non-North American stations – Operator name only Example: Thomas

SSB
Log Type: NAQPSSB
Operator Category: SINGLE-OP or MULTI-TWO

For Multi-Two see the extra info below!
Mode Category: SSB
Sent Exchange:

For North American stations – Operator name and station location (state, province, or country)
Example: Tom CT
For non-North American stations – Operator name only Example: Thomas

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a North
American station or a non-North American station. Contest rules require the Multi-Operator stations use a single name
throughout the entire contest.

Note: There are two multipliers in this contest with identical exchange abbreviations: Hawaii (HI) and Dominican Republic (HI).
The program scores these correctly despite the ambiguity, i.e. if you work them both on the same band you will get credit for
both multipliers (one in each multiplier column in the Log and Score Summary windows).
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NRAU Baltic Contest

This contest is only for stations from the following countries: ES, JW, JX, LA, LY, OH, OH0, OX, OY, OZ, SM, TF, and YL

Window: Select Log type
Log Type:

CW: NRAUCW
SSB: NRAUSSB

Sent Exchange: Section Example: AA

When a station is logged the following checks are made:

Is the logged station from a valid country ( ES, JW, JX, LA, LY, OH, OH0, OX, OY, OZ, SM, TF, and YL)
Is the entered section a valid section (from NRAU.sec)
A warning is given when a qso is made an another band than 7 or 3,5 MHz. A note is made with the logged qso.

Oceania Contest – CW

Oceania Contest – SSB

Supported are the CW and SSB version of the contest

Window: Select Log type
Log Type:

CW: OCEANIACW
SSB: OCEANIASSB

Sent Exchange: 001

Note: The rules have special instructions for not complete portable callsigns so a prefix can not be deduced normally. Adding
numbers like the rules state is not supported and should be done by editing the log file (afterwards). Example: N8BJQ/PA
would be PA but is not a valid prefix and should become PA0 (add the zero).

OK OM DX contest

Note: This contest type is for the OK/OM DX CW contest only. The OK/OM DX SSB contest has different rules and is
supported as a UDC. Do not use the OKOMDX contest type for the SSB contest.

The OK-OM DX contest can be configured for OK/OM stations and DX stations.

Window: Select Log type
Log Type: OKOMDX
Mode Category: CW (it is a CW only contest)
Sent Exchange:

Non-OK/OM stations: 001
OK/OM stations: district abbreviation Example: BPZ

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an OK/OM
station or a DX station.

PA Beker Contest – CW

PA Beker Contest – SSB

The PA-beker contest is a local Dutch contest on 40 and 80 meters. The text below is in Dutch.

Window: Select Log type
Log Type:

CW: PABEKERCW
SSB: PABEKERSSB

Sent Exchange:
QSL regio Voorbeeld: 27 (en niet R27)

QSL regio ingeven en invoeren zonder R dus 27 en geen R27
Log, Entry en Score summary geven de juiste scores.
De multiplier window (Ctrl+J) geeft onder ‘Sect’ de gewerkte QSL regios alleen daar wordt de eigen regio wel getoond
indien gewerkt.
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Er zit geen beperking op banden (dus let op dat je op 40 en 80 meter logt).
In te zenden log bestanden:

File How to make… Exported

Log file >File >Export >Export to File (Generic) [callsign].txt

Summary sheet >File >Export >Print Score Summary to File [callsign].sum

PACC Contest

The PACC contest can be configured for PA stations and DX stations.

Window: Select Log type
Log Type: PACC
Sent Exchange:

Non-PA stations: 001
PA stations: Your province Example:DR

PA stations ONLY (i.e. not stations outside the Netherlands) have to import an adapted CTY.DAT file for the PACC contest so
the right multipliers will be used. In the ‘Entry window’ go to ‘Tools’, and select ‘Import country list from downloaded file’. This
adapted country file can be downloaded from the N1MM website, under ‘Files’, select in the menu: ‘Additional Support Files’.
Don’t forget importing the original CTY.DAT file again when entering other after the PACC contests.

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a PA station.

The PACC contest committee approved and will accept the files made by N1MM logger and likes to receive:

File How to make… Exported

Cabrillo Log file >File >Generate Cabrillo File [callsign].log

Portugal Day Contest

The Portugal Day contest can be used for Portuguese stations (CT, CT3 or CU) and DX stations.

Window: Select Log type
Log Type: PORTUGAL
Operator setting MUST be: SINGLE-OP
Exchange:

District or Autonome Region for Portuguese stations
001 for DX stations (serialnumber)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Portuguese
station or DX.

QCWA QSO Party

Window: Select Log type
Log Type: QCWAQSO
Mode Category: Mixed
Exchange: Year licensed, Name, Chapter (or state/province/country)

The unique scoring for operating within 50 miles of the special events station and the one QSO rule for your home
chapter are not supported.

PA stations: Vergeet niet in de cabrillo log file te vermelden de klasse waarin je mee doet en de afdeling voor het
afdelingsklassement!
PA stations kunnen tijdens de PACC contest op 160 meter gelijktijdig meedoen aan de RSGB 1.8 MHz CW contest in
de avonduren. N1MM accepeteert na het volgnummer ook de districtscode. Voorbeeld: 599 123AA (NB, geen spatie
tussen het ontvangen volgnummer en de district code)
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RAC Canada Day Contest / RAC Canada Winter Contest

Both contests are supported with the same set of rules. These RAC contests can be used both for VE stations and DX
stations.

Window: Select Log type
Log Type: RAC
Exchange:

Province or territory for stations in Canada
001 for VE0 stations and stations outside Canada (serialnumber)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are from Canada,
VE0 or outside Canada.

The 6m and 2m bands are included in the RAC contest. You can use the “Change Band Panel Display” item in the right-click
pop-up menu in the Entry window to add these two bands to the band panel buttons and enable switching to them using the
Ctrl+PgUp/PgDn keys, provided the radio, if one is interfaced, is capable of switching to those bands. If you are using two (or
more) radios, one of which is interfaced to the computer, then you should configure N1MM+ for SO2R and log each contact in
the Entry window associated with the particular radio that is used for the contact.

RAEM CW Contest

The RAEM Contest is CW only and has no multipliers, only points. These points are calculated based on QSO points and
distance between the stations (based on exchanged coordinates). Extra points are added for polar stations. Extra bonus
points for RAEM memorial stations are not added because the call RAEM has no number is will not be accepted by the
program. Use RAEM99 or so and update the log and score (300 additional points) after the contest. 10 band changes per
hour are permitted, and a band change counter is activated when this contest is selected.

Window: Select Log type
Log Type: RAEM
Mode Category: CW (it is a CW only contest)
Sent Exchange: 001 & Coordinates Example: 001 53N6O

The own coordinates is the second token in Sent Exchange without spaces (one ‘word’)

Coordinate rules: These rules apply for the ‘Sent Exchange’ and also when entering a coordinate in the Entry Window.

Own coordinates: Second token in Sent Exchange without spaces (one ‘word’)
First part is the Longitude with at the end N or S Example: 53N
Second part is the Latitude with at the end W or O (not E) Example: 6O
As a total this makes: 53N6O

Log and rescore: To generate the log use the Generic log file and the Score summary. Always rescore and check the log. If a
qso has 1 point then the Received exchange is not correct. If there are QSOs who have gotten 2 points then your Sent
Exchange is not correct. Update your Sent Exchange in the contest setup and rescore. Check again.

Call History: The call history can be used but… the coordinates have to be entered in the Name field of the Call History table.
This is the only field which is capable of handling all different coordinates 1N2W but also 67N169O

REF Contest CW

REF Contest SSB

The REFContest can be configured for stations in REF countries and DX stations.

Window: Select Log type
Log Type:

CW: REFCW
SSB: REFSSB

Sent Exchange:
For DX stations: 001
For stations in REF countries – Department (F and TK) or Prefix (all other REF countries)

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a station in a REF country.
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RF Championship

The RF Championship is a contest for stations of the Russian Federation only.

Window: Select Log type
Log Type: RFCHAMP
Mode Category: Select mode used in contest (CW, SSB)
Sent Exchange: 001

Please add the zone to sent in the Function keys. The points are calculated based on your callsign and the callsign received.

RSGB 160 Meter CW Contests

The RSGB 1.8MHz CW Contests can be configured for RSGB stations and DX stations.

Window: Select Log type
Log Type: In February: RSGB1ST160CW, in November: RSBG2nd160CW
Mode Category: CW (it is a CW only contest)
Sent Exchange:

For DX stations: 001
For stations in the UK – 001 & District Example: 001 ZE

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are in the UK or
not.

Serial numbers must be logged from UK stations.
There is no check by the program if a serial number is entered for non-UK stations. This because there are often several other
EU contests going on at the same time and an entrant in those may not sent a serial number just an area code like DR
(PACC) or a French department like 78. If a non UK station sends a serial number it must be logged in the received serial nr
field, if it sends a code like DR is must be logged in the districts field.

RSGB 21/28 MHz Contest

The RSGB 21/28 MHz CW Contests can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGB2128
Sent Exchange: 001

RSGB 80 Meter Club Championship

The RSGB 80 Meter Club Championship can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGB80MCC
Sent Exchange: 001

RSGB Affiliated Societies Team Contests AFS – CW

RSGB Affiliated Societies Team Contests AFS – SSB

The RSGB Affiliated Societies Team Contests can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type:

CW: RSGBAFS-C
SSB: RSGBAFS-S

Sent Exchange: 001

RSGB Club Calls Contest

The RSGB Club Calls contest can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGBCLUB
Sent Exchange: 59(9) plus Serial Number starting at 001
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If you are not sent an exchange, log a zero

In addition, on SSB send: “Club HQ”, “Club Member” or “No Club”. On CW the equivalent abbreviations to be sent are: HQ,
CM or NC  (using N1MM+ log H, C or N). Club HQ & Club Member stations also send their four-letter Club Name
abbreviation.

RSGB Commonwealth Contest

Window: Select Log type
Log Type: RSGBBERU
Mode Category: CW
Exchange: 001 (HQ stations enter 001 HQ in this box, with a single space between the 001 and the HQ)

This contest is for British Commonwealth stations only. See https://www.rsgbcc.org/hf/information/codes.shtml for a list of
Commonwealth call areas (CCAs). The callsign in the Station Information dialog (Config >Change Your Station Data >Call)
determines whether you are in the Commonwealth or not.

The rules have been changed for 2025. As compared with previous years: G, GD, GI, GJ, GM, GU and GW are now
considered separate CCAs; contacts with stations in another continent are now worth 10 points instead of 5; antenna
restrictions have been removed; and self-spotting is permitted.

There are no multipliers in this contest. Contacts with Commonwealth stations outside your own Commonwealth Call Area
(CCA) are worth 5 QSO points if in your continent, 10 points if in a different continent. Contacts within your own call area
(other than with an HQ station, if any) or with non-Commonwealth stations are worth zero points. Contacts between two non-
HQ stations in the 7 UK&CD CCAs (G, GD, GI, GJ, GM, GU and GW) are worth zero points. There are 20 bonus points for
each of the first 3 regular (non-HQ station) contacts on each band in each CCA (25 points instead of 5 points, or 30 points
instead of 10 points). HQ stations send HQ after the serial number in the exchange (enter HQ in the HQ block in the entry
window when you work one of these), and contacts with these stations are worth 25 or 30 points (5 or 10 points plus a 20
point bonus).

You can work three non-HQ bonus stations in each CCA on each band for 25 (same continent) or 30 (DX continent) points
each; any additional contacts with non-HQ stations in that CCA are worth 5 or 10 points each (HQ stations are always worth
25 or 30 points). You can work HQ stations in your own call area for QSO and bonus points. HQ stations can work all CCAs
including their own.

Bonus stations (HQ stations, and the first three non-HQ contacts in a CCA other than your own) are shown in red in the Entry
window; other Commonwealth stations are in blue. Non-Commonwealth stations and stations in your own CCA are shown in
grey (including HQ stations in your CCA until the HQ box in the Entry window is filled in). If you wish to work and log a zero-
point QSO anyway, use Ctrl+Alt+Enter to force-log the contact.

To have the Multiplier window show only Commonwealth Call Areas, go to the Files > Additional Support Files on this web site
and download file cty_cc_2025.dat into the SupportFiles subfolder in your N1MM Logger+ user files folder, then use the
Logger’s Tools > Import country list from downloaded file menu item to import this list into the database. You will have to
close and reopen the Multiplier window for this change to take effect. The Multiplier window only shows whether at least one
station has been worked in that CCA; it does not indicate whether bonus points are available. Beware: outside of operating
during this contest, using this special cty file can cause very undesirable behaviour. Remember to reload the normal
wl_cty.dat file into the database after the contest is over!

Unless you are using a contest-specific Call History file containing only Commonwealth Contest HQ station call signs with the
Section field set to HQ, Call History Lookup should be turned off in this contest to prevent state/section information for other
contests from prefilling the HQ box.

HQ stations are recorded in the “Sect” column in the log. Call areas are recorded in the “Exch” column. In the Score Summary
window, the “Cty” column indicates the number of bonus-point QSOs (first three QSOs in a CCA), and the “Sec” column
indicates the number of HQ stations worked.

After the contest, review your Cabrillo file header using a text editor and compare it against the RSGB Cabrillo instructions.
The RSGB uses some non-standard fields in its Cabrillo file headers, so you may need to make some changes (e.g. for some
of the special entry categories in this contest).

RSGB SSB Field Day & RSGB National Field Day

The Region I field day contest can be configured for RSGB and DX stations.

Window: Select Log type
Log Type: FDREG1
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Mode Category: The ModeCategory selects the CW or the SSB version of the contest. The rules between the
CW and the SSB version are very different..

CW for the CW Field day contest
SSB for the SSB Field day contest

Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a RSGB
station or not and if you are /P etc. or not..

N1MM Logger+ checks whether the callsign used is a portable or a fixed station by checking the callsign in the Station dialog
under config ! So using a /P, /M etc there could make a difference in scoring!

RSGB Low Power Field Day

The RSGB Low Power Field Day can be configured for RSGB stations and DX stations

Window: Select Log type
Log Type: RSGBLP
Mode Category: CW (it is a CW only contest)
Sent Exchange: 001 Power Example: 001 2W5

RSGB ROPOCO

The RSGB ROPOCO (re-named ROLO) is an RSGB contest and open to all stations.

Window: Select Log type
Log Type: ROPOCO
Mode Category: CW/SSB (SSB April, CW October)
Sent Exchange: First contact your full Locator (taken from station info) then last Locator received.

NOTE. Use the macro {LASTEXCH} to send the postcode from the previous qso. Example F2 key: <<< 5nn >>> {LASTEXCH}

Russian District Award Contest

The Russian District Award contest can be configured for Russian stations and DX stations.

Window: Select Log type
Log Type: RDAC
Sent Exchange:

Non-Russian stations: 001
Russian stations: District code by RDA list (for example TB02)

Call History exchange field: Exch1

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Russian
station or a DX station.

Russian Cup (RCCCUP)

The Russian Contest Club’s “Cup” contest. First weekend in May

Window: Select Log type
Log Type: RCCCUP
MODES: CW & SSB
Sent Exchange:

Non-Russian stations: RS(T) and ITU ZOne
Russian stations: RS(T) + RCC + membership number (see RULES website)

Russian DX Contest

The Russian DX contest can be configured for Russian stations and DX stations.

Window: Select Log type
Log Type: RUSSIANDX
Sent Exchange:

Non-Russian stations: 001
Russian stations: Your oblast code (two letters)
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The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Russian
station or a DX station.
Example: Default RU1A would have SP, in the call hisotry RU1A could be added so it will give the correct exception LO.
When a station is found in Call history it will use the section/oblast from it. IIf not found in Call history it will use the default
oblast.

Example Call history

RA1AR,,,, LO

RU1A,,,,LO

RU6FA,,,,KM

Log submission notes:

‘CATEGORY-OVERLAY’. In the RDXC you can submit one log and have it scored as two single band entries. Like operating
10m during day time and 160m at night. Now, this is particular to this contest and you need to submit your log like this:

CATEGORY-OVERLAY: [operator-cat] [band-cat] [power-cat] [mode-cat] The category overlay of the log submission when
appropriate. In RDXC, two single band entries are allowed from one participant. In this case, one entry must be listed under
CATEGORY tag, the other one under CATEGORY-OVERLAY, such as:

CATEGORY: SINGLE-OP 80M HIGH MIXED
CATEGORY-OVERLAY: SINGLE-OP 15M HIGH MIXED

Russian Radiosport Team Championship

Window: Select Log type
Log Type:

RRTCT (invited teams)
RRTC (everyone else)

Sent Exchange:
three-letter code (teams)
ITU zone (others)

Russian YL/OM Contest

Window: Select Log type
Log Type: RUSYLOM
Sent Exchange:

73 for male stations (OM)
88 for female stations (YL)

YL stations (female) may only work OM stations (male) and vice versa.

SAC Contest CW

SAC Contest SSB

The Scandinavian Activity Contest can be configured for Scandinavian stations and DX stations.

Window: Select Log type
CW

Log Type: SACCW
Sent Exchange: 001

SSB
Log Type: SACSSB
Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a
Scandinavian station or a DX station.

Spanish Towns Contest

The Spanish Towns contest can be configured for EA stations and DX stations.
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Window: Select Log type
Log Type: CME
Mode Category: SSB
Sent Exchange:

non-EA stations: 001
EA stations: Your INE code Example: 18145

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX station
or a EA station.

SAMOVAR CW Contest

Window: Select Log type

Log Type: SAMOVAR
Mode: CW
Sent Exchange:

Contest Zone* and Serial number
IMPORTANT#1 = Contest Zone is NOT ITU zone. See list below
IMPORTANT#2: See rules about new Distributed category

Zone distribution for Russian stations is the same as in the Russian HF Championship:
1st – Arkhangelsk, Vologda, Leningrad, Murmansk, Novgorod, Pskov, Kaliningrad regions, Republic of Karelia, the city of
Saint-
Petersburg, Nenets AO;
2nd – All areas of the Central Federal district, Nizhni Novgorod, Kirov, Penza, Samara, Saratov, Ulyanovsk regions, Republic
of
Mari El, Mordovia, Tatarstan, Udmurtia and Chuvashia. All areas of The Southern Federal district, The North-Caucasian
Federal
district, The Crimean district;
3rd – The Republic Of Bashkortostan, Republic Of Komi, Kurgan, Sverdlovsk, Tyumen, Chelyabinsk, Orenburg regions, The
Perm
territory;
4th – Khanty-Mansiysk, Yamalo-Nenets autonomous district, Omsk, Tomsk, Novosibirsk, Kemerovo regions, Altai territory,
Republic of
Altai, Krasnoyarsk territory, Republic Of Tyva (Tuva), The Republic Of Khakassia;
5th – The Republic of Buryatia, Irkutsk, Zabaikalsky krai;
6th – The Khabarovsk territory, Republic of Sakha (Yakutia), The Sakhalin region, The Primorsky krai, The Jewish
autonomous
region;
7th – Magadan, Kamchatka regions.

Foreign participants’ zone distribution as in the list below:
Zone 1 – stations in WAZ 14, 15
Zone 2 – stations in WAZ 16, 20, part of WAZ 21 (EK, 4J, 4L)
Zone 3 – stations in WAZ 17, rest of WAZ 21, 33, 34
Zone 4 – stations in WAZ 22
Zone 5 – stations in WAZ 23
Zone 6 – stations in WAZ 24, 25, 26, 27
Zone 7 – rest of the world.

Foreign participants’ zone distribution as in the list below:
Zone 1 – stations in WAZ 14, 15
Zone 2 – stations in WAZ 16, 20, part of WAZ 21 (EK, 4J, 4L)
Zone 3 – stations in WAZ 17, rest of WAZ 21, 33, 34
Zone 4 – stations in WAZ 22
Zone 5 – stations in WAZ 23
Zone 6 – stations in WAZ 24, 25, 26, 27
Zone 7 – rest of the world.

Solar Eclipse QSO Party

The Solar Eclipse QSO Party allows CW, SSB and Digital modes. Active during solar eclipses in 2017, 2023, 2024.

Window: Select Log type
Log Type: ECLIPSE
Mode Category: SSB+CW+DIGITAL if you want to use all modes
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Sent Exchange: 6-character Grid Square (e.g. FN20VR)

SPDX Contest

The SPDX contest can be configured for Polish stations and DX stations.

Window: Select Log type
Log Type: SPDX
Multi-Op set Operator Category = MULTI-ONE
Sent Exchange:

001 for non-SP stations
Your province Example: B for Lubuskie

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Polish
station or a DX station.
The band and mode change counter is shown in the Info window.

Stew Perry Topband Distance Challenge

The Stew Perry contest is CW only.

Window: Select Log type
Log Type: STEWPERRY
Power category:

HIGH when > 100 Watt
LOW when 10 – 100 Watt
QRP when less than 10 Watt

Sent Exchange:
Your four character grid Example: JO33

The point calculation in the log is multiplied by a power multiplier for each qso point value. This factor depends on the selected
Power category chosen. HIGH is multiplied by a factor 1, LOW by a factor 2 and QRP by a factor 4.

Scandinavian Young Ladies Radio Association SYLRA

Window: Select Log Type
Log Type:SYLRA
Mode: Mixed+Dig
Sent Exchange: 88 for YLs, 73 for OMs

UA1DZ Memorial Cup

The UA1DZ Memorial Cup can be used by St.-Petersburg and Leningrad region stations and DX stations.

Window: Select Log type
Log Type: DZCUP
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-St.-Petersburg and Leningrad region stations: Grid Square e.g. EL98
For St.-Petersburg and Leningrad region stations: RDA (administrative area)

UBA Contest CW

UBA Contest SSB

The UBA DX Contest can be configured for ON stations and DX stations.

Window: Select Log type
Log Type:

CW: UBACW
SSB: UBASSB

Mode Category: CW
Sent Exchange:

For non-ON stations:001
For ON stations: 001 + Your province Example: 001 OV
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The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an ON station
or a DX station.

Log submitting for non Belgian stations:

Before submitting your log look at this page from Franki, ON5ZO

The information tells how to update the category in the Cabrillo file so you are placed in the right category.
The UBA contest manager approved and will accept the Cabrillo output made by N1MM Logger+.

IMPORTANT NOTE quoted from the rules as found on the UBA website, regarding log submission:

Log submission info from UBA: The UBA likes to receive a Cabrillo file

Special Setup for Belgian participants:

How to include your province abbreviation in the Cabrillo output?
This MUST be done for both SSB and CW contests! Go to Config > Change your Station Data > State field: fill in the
abbreviation for your province (OV, VB etc). It is VERY IMPORTANT to do this, as it will determine what you have sent in the
log (Cabrillo output), and it is needed by the UBA Contest Team. The official abbreviation (2 letters) for the Belgian Provinces
is to be found on the UBA site, under the rules for HF contests.
Non-Belgian participants can leave this field ‘as is’, it is only used for Belgian contesters.

How to send your province abbreviation after the serial number in CW?
When you have selected to begin a new log for the UBA DX CW contest, you must change the F2 button message to send
your province.
This is done like this; go to: Config > Change Packet /CW/SSB/Digital Message buttons > Change CW buttons In the right
column, second row, there is: <<< 5nn >>> {EXCH} This means the incrementing serial number. Now you have to add your
province abbreviation, preceded by a slash (/). It should look like this: <<< 5nn >>> {EXCH}/OV or <<< 5nn >>> {EXCH}/AN

WARNING: Never change the ‘001’ as the Sent Exchange value in the Select Log Type window, as the software will no longer
send serial numbers!!!

UBA ON Contest

The UBA ON Contests (4 in total) can be configured for ON stations and DX stations.

Window: Select Log type
Log Type: UBAON
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-ON stations:001
For ON stations – Serial + Your UBA gewest Example: 001 AAA

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an ON station
or a DX station.

UBA Spring

The UBA Spring contest (4 in total) can be configured for ON stations and DX stations.

Window: Select Log type
Log Type: UBASPRING
Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-ON stations: 001
For ON stations – Serial + Your UBA gewest Example: 001 AAA

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an ON station
or a DX station.

UBA Low Band Winter

The UBA Low Band Winter contest (4 in total) can be configured for ON stations and DX stations.

Window: Select Log type
Log Type: UBAWINTER
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Mode Category: Select mode used (CW, Mixed, SSB)
Sent Exchange:

For non-ON stations:001
For ON stations – Your UBA gewest Example: AAA

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an ON station
or a DX station.

UK/EI DX CW

UK/EI DX SSB

Window: Select Log type
Log Type: UKEIDXCW or UKEIDXSSB
Mode Category: Select mode used (CW, SSB)
Sent Exchange: (Macro “001”: N1MM replaces the 001 with the correct sequential serial number)

For non-UK/EI stations: 001
For UK/EI stations: 001 followed by YOUR District code (NOTE: no space following the 001 macro)

e.g. 001BM District codes can be found in the rules HERE

Ukrainian Championship CW

Ukrainian Championship SSB

The Ukrainian Championship is run on CW, SSB and RTTY.(for Ukrainian stations only)

Window: Select Log Type
Log Type: UKRCHCW, UKRCHSSB, UKRCHRTTY
Sent Exchange: two-letter district designator, plus serial number – e.g., KV 001

Ukrainian DX contest

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations.

Window: Select Log type
Log Type: UKRAINDX
Mode Category: MIXED
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

Note: Countries are counted per band for SSB, CW and RTTY, because RTTY is in a separate contest module they won’t be
counted correct when a station makes next to SSB and CW also RTTY q’s or the other way around…

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an Ukrainian
station or a non-Ukrainian station.

UN DX Contest

Kazakhstan Open Championship

Window: Select log type
Log Type: UNDX
Mode Category: Mixed
Sent Exchange:

District code for Kazakhstan stations Example: L17
001 for non-Kazakhstan stations

Independence of Venezuela Contest (YV)

Window: Select Log type
Log Type: YV
Sent Exchange: 001

The YV call areas are shown in the Multiplier window, choose the tab “Sect”.
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WAEDC Contest CW

WAEDC Contest SSB

The WAEDC Contest can be configured for European stations and non-European stations.

Window: Select Log type
Log Type:

CW: WAECW
SSB: WAESSB

Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a European
station or a non-European station.

Introduction to WAE DX CW/SSB – based on an article originally written by Franki, ON5ZO

WAE has something no other contest has, that you’ll either love or hate – the exchange of information on past contacts in the
contest, or QTC. Except in WAE RTTY, a QTC is a piece of traffic that can only be sent from stations outside EU to EU
stations. EU stations will beg to get them. Why? Simply because for both sides each QTC is added to the QSO total. If N1MM
makes a QSO with ON5ZO, then they both get 1 point for the QSO. If they decide to exchange 10 QTCs during this QSO,
they each earn 11 points, 1 QSO + 10 QTCs. If, after the contest, ON5ZO made 300 QSOs, during which he got 500 QTCs,
his total count will be 800, multiplied by the number of multipliers.

Each QTC has three main parts – time, call and received serial number of a QSO from the DX (non-European) station’s log.
Suppose that N1MM logged ON5ZO at 0123UTC, and ON5ZO gave ‘012’ as his serial number. Later in the contest, N1MM
can send the QTC to 9A7P, for example.: He would send 0123 ON5ZO 012.

The rules say that a DX station can only send a total of 10 QTCs to a EU station, and that previous QSOs with the receiving
station cannot be included in the batch of QTCs sent. Each QSO can only be sent once as a QTC, so a DX station can never
have more QTCs sent than QSOs logged. A EU station however, can have many more QTCs than QSOs, as each non-
duplicate QSO can yield up to 10 QTCs.

A DX station can choose to send 10 QTCs to a single recipient during a single QSO, or piecemeal. In addition, QTCs do not
have to be exchanged only during a non-dupe QSO. Suppose that early in the contest, ON5ZO is running, and N1MM calls on
20m. They have a regular QSO and exchange serial numbers. ON5ZO asks ‘QTC?’ but N1MM wants to make some QSOs
first, so he declines. Towards the end of the contest, N1MM is running on 20m and ON5ZO finds him, ON5ZO sees that
N1MM is a dupe because they QSO’d at the beginning of the contest. However, they didn’t pass QTCs, so ON5ZO asks
‘QTC? de ON5ZO’. N1MM sees that they have worked but indeed: there were no QTCs sent then, and N1MM is now eager to
send 10 of his QSOs as QTCs. They do it, and both go away happy. The second QSO doesn’t count, of course, but the QTCs
do.

Each set of QTCs must be numbered. The sending station initiates the series of QTCs with a “batch” number like ‘QTC 11/10’,
which means that it is the 11th batch sent by the DX station, and there will be 10 QTCs in the batch.

All this sounds terribly complicated, doesn’t it?. Fortunately, N1MM Logger takes care of all the clerical work. Let’s look at how
it works in detail, starting with

WAE from Europe (ON5ZO as an example)

After completing the QSO, where both stations exchange serial numbers, ON5ZO goes into QTC mode by pressing Ctrl+Z. In
CW, the program can be set up so that this triggers the program to send ‘QTC?’ to ask the other station if he wants to send
QTCs. This is controlled by a menu option “Config > WAE > Ctrl+Z sends QTC? automatically (EU stations, Run mode only)”
in the Entry window. In SSB, he might uncheck this option and ask the other station “Do you have QTCs for me?” before
pressing Ctrl+Z. Either way, pressing Ctrl+Z opens a Receive QTC window like the one below:
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The cursor starts in the QTC header field, and ON5ZO logs the QTC batch number sent by the other station, such as ’12/10′.
If he only types the batch number without the forward slash and count, the program will assume the count is 10. ON5ZO then
hits Space, which sends QRV in CW and moves the cursor to the first QTC window. In SSB he can tell the other station he is
ready by using the microphone, or he can record a wav file to be sent at this point (see the Entry window “Config > WAE >
Open QTC Window Setup area” menu item). Each time he copies a part of the QTC, he presses Space to move into the next
box. If he doesn’t copy the QTC, he can click on the numbered “Agn” button for that QTC to ask the other station to send it
again. If he only wants a repeat of one part of the QTC, he can use the Shift+1, Shift+2 or Shift+3 key to ask for a repeat of
the time, call or serial number. When the QTC is received and logged, he presses Enter or clicks on the “Cfm” button and the
program logs the QTC and sends a confirmation message, so that the other station knows ON5ZO got it OK and he can start
transmitting the next QTC.
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When the series of QTCs is copied, ON5ZO presses the Exit button or F3, the program sends a TU message and closes the
QTC window, returning to normal QSO mode. There are options in the “Config > WAE > Open QTC Window Setup area” for
customizing the actions at various points in the process (CW), or the messages to be sent using the internal voice keyer
(SSB) at various points.

Sometimes when conditions are poor or deteriorating or QRM is getting heavier, it is not possible to complete a batch of
QTCs. If you want to start the batch over again, you can use the Clear button to clear the window and start fresh. Or, if you
click on the Cancel button or press the Esc key, the QTC process is aborted. Note that both Clear and Cancel leave any QTCs
that have already been logged still in the log. Depending on the circumstances, you can either leave those QTCs in the log, or
if necessary (for example, if you start over and find you have duplicated some QTCs in the log) you can delete individual
QTCs in the Log window.

You can use Alt+W to wipe the current line, or Ctrl+Q to place the Entry window into Quick Edit mode to edit a QSO or QTC.
Normally the program will prevent you from logging an invalid QTC (non-number in the time or serial number fields, or an
invalid call sign). Whenever the Agn button is highlighted, you can override this validity checking and force-log the QTC using
Alt+Enter, Alt+Space or Alt+Tab.

Sometimes the number of QTCs in the header was miscopied, and the number of QTCs actually received is smaller or larger
than the number originally expected. You can use Ctrl+A to remove the last blank line from the QTC window and reduce the
count in the QTC header (and in logged QTCs in that batch) by 1. Or, you can use Alt+A to add a new blank line and increase
the count in the header and the log (up to a maximum of 10).

Note: Sometimes DX stations don’t repeat the two digits representing the hour in the time part of the QTC. They just send the
minutes, because the hour is the same for a bunch of QSOs. For example, the DX station might send ‘1134’ for the time of the
first QTC, but then send 35 and 36 for the next two.

When copying QTCs at 36 wpm or faster, you don’t have the time to do anything but type what you copy. If you copy two
numbers, and the next character is a letter, you usually know you need to press Space and begin typing the callsign. N1MM
Logger will automatically add the two hour digits to your log. This doesn’t work so well with number prefixes like 5B or 4Z
unless the sending station is careful with his spacing, and we’d welcome suggestions on a better approach.

The QTC process works in either Run or S&P mode. The same keystroke, Ctrl+Z, turns it on and off (in case you need to
abort QTC mode).

WAE from the DX (non-Europe) side

The process is even easier from the non-European (DX) side. If you want to send QTCs, you simply press Ctrl+Z. If you’ve
forgotten to log the QSO first, Ctrl+Z will do it for you. A pop-up window opens, asking you how many QTCs you want to send
to the EU station:
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The pop-up defaults to the maximum number you can send that station, but if you want to send fewer, you can just type in the
new number over the old one. When you exit from the pop-up by hitting Enter or pressing OK, the QTC header is sent to the
other station, and a QTC window opens up, populated with all the information you need to send:

Once the other station indicates he’s ready, usually with ‘QRV’ in CW, you can press Enter to send each QTC in turn, waiting
for the other station to acknowledge after each QTC. The following screen shot shows the window after the 5th QTC has been
sent – note that the highlight is on the “Snd 6” button, because that is the one that will be sent if you press Enter at this point:
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If he asks for a repeat, you can press the = key, Alt+Enter, or + key, or you can click on the “Snd” button for the previous QTC,
i.e. the one that was not yet received and acknowledged. If he asks for a repeat of only part of the QTC, you can right-click on
one of the three parts to re-send it, or you can press the 1, 2 or 3 keys to re-send just the time, call sign or serial number
respectively. Once all of the QTCs have been sent and the European station acknowledges the QTC batch, you click on the
Exit button to end the batch and log the sent QTCs. The Clear and Cancel buttons work the same way as for a station in EU.

Both sides

There are a number of setup options available to customize QTC operation, including the messages sent at various points in
the process. These are found in the main Entry window’s Config > WAE menu – see the manual section on the Entry window
for details.

After you enter the callsign of the other station in the entry window, a new line in red type will appear below the buttons in the
Entry Window to tell you the QTC status.
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This line will appear regardless of whether you have worked the station yet or not. The left-most number tells you how many
QTCs you have already exchanged with that station. The next number tells you how many QTCs you still have available to
send to that station (up to the maximum of 10), and the last number tells you the total number of unsent QTCs in your log.

The Entry Window and the Bandmap window contain visual cues about the QTC status of stations spotted in the bandmap. A
special color scheme for spotted call signs has been implemented, as follows (colors are configurable – these are the
defaults):
RED: the station is a new multiplier on this band (single multiplier color, the same as in other contests)
GREEN: this is a new station on this band, and you can also exchange QTCs with him (you have not yet exchanged 10 QTCs
with this station) (in other contests, this is the double multiplier color, but there are no double mults in WAE)
BLUE: this is a new station on this band, but you have no more QTC’s available that can be exchanged with this station (you
have already exchanged 10 QTCs, or else you are both EU stations or both DX stations, so you cannot exchange QTCs)
(normal QSO color in other contests)
BLACK: this station is a dupe on this band, but you still could exchange QTCs with him for QTC points (this color is the “Color
of a QTC callsign in the WAE contest” color in the Manage Skins, Colors and Fonts window)
GREY: dupe, and there are no QTC that can be exchanged – this station is non-workable for any kind of credit, so just pass
him by (the same as in other contests)

One final item to be aware of: If you export your contest log to ADIF after the contest, the ADIF file will not contain QTCs, only
QSOs. This is not a problem if you are exporting for purposes of a general logging program, QSLing, etc., but if you want to
transfer a WAE contest log between databases or between computers, you cannot use ADIF files to do this unless there are
no QTCs in the log. To transfer a complete WAE log between copies of N1MM Logger+ on two computers, you must either
copy the entire database between the computers, or else you must copy the TRN file for the WAE contest to the second
computer and then import it into a new empty N1MM+ database on the second computer.

WAG Contest

The WAG contest is for German stations and non German stations.

Window: Select Log type
Log Type: WAG
Sent Exchange:

non-DL stations: 001
DL stations:

DARC member:DOK (example: V11)
non-DARC member:001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a German
station or a non-German station.

Non DL stations may only give a number.
DL stations give a DOK (DARC members) or a number (non DARC members)
For stations not giving an exchange put 000 in the exchange field

– minimal DOK length is 2
– 0 is allowed to be entered

Note: When updating a DOK in the log window you have to update not only the Exchange but also the Section by hand….only
when the qso is in the Entry window the program strips the Section (V) from the Exchange (V11) automatically.

Winter Field Day – WFD

Last full weekend in January. Exchange: Category + State/Section/DX

Contest setup dialog – Sent exchange = class and category
Example1: a five transmitter outdoor station in West Texas is “5O WTX”
Example2: a one transmitter home station in Michigan is “1H MI”
NOTE: No signal reports (RST) required
See the rules for more details

World Wide Iron Ham Contest

Window: Select Log type
Log Type: WWIH
Sent Exchange: RS/RST and CQ Zone
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Note: The contest allows CW, SSB and RTTY, but there are specific limitations on how often a station may change modes.
See the rules for complete details.

World Wide Peace Messenger Contest

The Peace Messenger Contest can be configured for Peace Messenger Contest stations and non Peace Messengerstations

Window: Select Log type
Log Type: WWPMC
Mode Category: CW, SSB or Mixed
Sent Exchange PMC station: 001 PMC abbreviation Example: 001 ABI
Sent Exchange non PMC station: 001 NON Example: 001 NON

WRTC Contest

The World Radiosport Team Championship (WRTC) contest is fully supported for use by on-site participant teams only (all
others should use the IARU contest type)

Window: Select Log type
Log Type: WRTC
Sent Exchange: ITU zone

The WRTC follows the rules for the IARU contest (please check above) with some additional WRTC specific changes below.

Check Partial is disabled from master.scp for this contest only.

YO HF DX Contest

The YO HF DX contest can be used by Romanian stations and non Romanian stations.

Window: Select Log type
Log Type: YOHFDX
Sent Exchange:

non-YO stations: 001
YO stations: Romanian county abbreviation (two letters) Example: AR

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Romanian
station or a non-Romanian station.
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Setup QSO Parties
2020-03-23

Setup QSO Parties – CW and SSB
The program supports many US and Canadian QSO parties. Depending on the complexity of the rules, there may be minor
scoring anomalies. For example, some QSO parties offer bonus points to rovers or mobile stations for activating multiple
counties; these bonus points may not be included in the score calculated by the program.

It is very important for proper operation of the program in QSO parties that the program “know” whether you are an in-
area (state or province) or out-of-area participant. All QSO parties require different program operation and scoring rules
for in-area and out-of-area participants.

The program determines which you are from the ARRL Section that you have entered in the Station Data dialog (under the
Config menu). When creating a new log for a QSO party, a message box will inform you whether the program thinks you are
an in-state, or out-of-state participant, based on your ARRL section, so that you can correct things if anything is wrong.

Creating a QSO Party Log: >File >New Log in Database

Non-US/VE stations should enter “DX” in the ARRL SECTION field. If you enter an ARRL section with a non-US/VE callsign,
you will be warned to correct your Station Data before continuing.
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N1MM Logger+ offers enhanced support for county-line operations, whether you are the in-state Rover on a county
line or an out-of-state station wanting an easy way to log a QSO with a county-line rover. Full details are in the
Mobile/Rover Support section below.

Window: Select Log type
Log Type: QSOPARTY

After selecting QSO Party, a list box shows up in the right-hand part of the contest selection dialog box,
with buttons below it for importing and editing the section list. Click on the down arrow to choose the QSO
Party you want (example image shows Hawaii HI) . When in doubt, do the import, to make sure you pick
up any changes in the official abbreviations since the last running.
Example: The entry in the list of QSO Parties for the New England QSO Party is “NEWE” (“NE” is for the
Nebraska QSO Party). Most of the entries in this list are states or provinces, except for the 7QP (7th call
area), NEWE (New England), MAQP (Mid-Atlantic) and MARAC (county hunter contest) entries as well as
the special IN7QPNE entry described below.

Mode Category: MIXED
Sent Exchange:

The exchange depends on the QSO party. Most use county for in-area participants and state for those out of the
area. Some use serial numbers as well.
Inside the selected State/Province – See contest instructions
Outside the selected State/Province – See contest instructions
if you need to send a serial number, enter 001 and the abbreviation for your location in the Sent Exchange field,
to automatically increment the serial number for each QSO.

QSO Party Bonus Station Support – A few state QSO parties have “bonus stations”, which you can work for extra point
credit. When the state party has bonus station(s), the program will display the bonus station callsign list on program
start and upon exiting the contest dialog.

This list of bonus stations can be modified by the user by entering the command BONUS + Enter in the Entry Window callsign
box.This will pop up a window where you can enter a revised list.

Each callsign, and each variation (CALL, CALL/M, CALL/CTY) must be on the list in order to get credit for the bonus
station(s).

Note: The program does not store bonus station callsign changes, so if there are changes, you will need to re-enter the
complete list each time you re-start the program or change logs to that QSO party. You can’t simply enter the changes.

To view the QSO’s logged, enter the bonus station callsign in the Entry window and look at the lower portion of the Log
window. To view the number of bonus stations counted in the score, export the Score Summary to a file.

Simple Call History Procedure – The steps for generating a Call History file from a previous QSO party are as follows:
Open last year’s QSO party contest log.

Help Keep Your Favorite QSO Party up to Date

You can help keep N1MM Logger up to date for your favorite QSO Party by notifying the N1MM team of and changes
in scoring, bonus stations, etc. Just post the changes in the N1MM Reflector, or send a Feature Request. Obviously,
earlier is better.
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Click Tools, Clear Call History then Update with Current Log
Click File, Export Call History and export the data into a file.
Using NotePad add any new stations to the end of this file. The UserText field will allow you to make personal
notes for specific callsigns. This display line appears below the Bearing information line. Make the height of the
Entry Window taller to enable the display of this information.
Open the new QSO party contest log for the current year. Associating the saved call history file with this state
party is possible using the Associated Files tab. Alternately, click on File, Import Call History after the contest is
open.
Click on Config and place a checkmark in front of Call History Lookup.

The call history data is stored in the database. If you open a different contest and have Call History Lookup enabled,
the program will use this data. So uncheck this option after the contest.

Users can combine exported call history files from several years. The recommended editor is NotePad. Some editors
place non-ACSII characters in the file and this will cause import issues. Place the oldest contest at the top of the
merged file. The import routine will merge the data and deal with duplicate entries. You can look at the result by
exporting the call history and viewing it with NotePad.

Modifying and Importing the QSO Party County Abbreviations

It is not expected that users will need to manually update or edit the county abbreviation list. It is easy to make a change that
will effect the program operation or eliminate secondary information stored in other database fields during QSO logging. This
is especially true for the 7QP, IN, IN7QPNE, NEWE, and PA QSO parties. Please report any changes made by the QSO party
sponsors to the development team several weeks prior to the contest.

The county abbreviations stored in the database can be edited by opening the contest dialog (File, Open Log in Database)
and select ‘Edit Section List’. A sample edit window is shown below. The modification will remain in the current database until
the developers make a change to any QSO party county abbreviation.

To revert back to the original county and state abbreviation list provided by the developers, manually import the original files
into the database with this procedure. Open the contest dialog (File, Open Log in Database) and select ‘Import Section List’. It
is not recommended that the user edit the state and county files provided by the developers.

CA QSO party

The Multi-Single replacement operator, first transmission, timer rule is not implemented but the standard 10 minute band
change timer is displayed.

PA QSO party

For in-state stations, the first EPA and WPA county worked will count both the county and the section multiplier in the score.
Likewise, the first DXCC station worked counts as the single DX multiplier. See the information in the general section above
for working bonus stations and county line stations. It it not necessary to include a Dupe Sheet with the contest submission
when N1MM Logger is used for the PA QSO Party logging.
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Same weekend: 7QP, Indiana QSO Party, New England QSO Party (NEWE), Delaware QSO Party

Four QSO parties (the 7QP (7th Call Area QSO Party), Indiana QSO Party, Delaware QSO Party and New England QSO
Party) that are all on the same weekend have agreed to coordinate such that all four can be logged in a single contest log.
The program software allows users to log stations active in all four QSO parties and automatically determines the state
multiplier from the received exchange (other contest county exchange). Log the exact exchange that is received, and after the
contests are over send the same Cabrillo output file to all four contest sponsors.

If you are an “in-state” user of one of these QSO parties, select the appropriate state party option in the QSO party contest
selector (7QP, IN, NEWE or DE). If you are “out-of-state” for all four contests this weekend, select the IN7QPNE option in the
dropdown state selector. The instructions are the same: log the exchange that you receive and send the same Cabrillo file
without editing to all four sponsors. All sponsors re-calculate the score of all submissions.

For county-line operators, N1MM supports the 7QP shorthand compound county exchanges when both counties are in the
same state (e.g.,”ORDES/JEF”), as well as the regular (longer) compound exchange when the counties are in different states
(e.g., “IDFRA/UTCAC”). In either case the program will log a separate QSO for each county in the compound exchange. See
the section below on QSO Party County Line Operation for more details on making and logging county-line contacts. Note that
if you are logging a compound county-line exchange, you must do it at the time the contact is initially logged. Do not enter an
ordinary single-county exchange and then edit the QSO and force the exchange to be of the form: “ORDES/JEF” or
“IDFRA/UTCAC”. Doing this will cause database errors and the program will not be able to score or rescore correctly.

Rover, Mobile, and County Line Support

N1MM Logger supports Rover/Mobile and County Line operation and for QSO party contests, the software contains features
allowing the home station to quickly log the County Line station.

Rover/Mobile Operation

N1MM logger supports Rover or Mobile operation in the ARRL VHF contests and all QSO parties. It gives a Rover entrant a
quick, easy way of changing counties, re-programming F-key messages in one step, and produce a single composite log for
the entire event.

Rover mode is enabled when one of these selections is made in the Contest Setup dialog Station Category = Rover, Mobile,
Rover-Limited, or Rover-Unlimited. Rover mode is also enabled if the Contest selection is QSOPARTY and Station Category =
Expedition. The option that appears in the Contest Setup dialog will depend on the Cabrillo version requested by the sponsor.
When Rover mode is enabled, the Entry Window title bar will include the RoverQTH as shown in the snapshot below.

The operating location or RoverQTH can be set:

in the Station Data window, RoverQTH box. This box will automatically update when you use any of the other methods
of setting RoverQTH below.
by right clicking on the county or grid in the Multiplier window and selecting “Set RoverQTH”
by typing CTRL+H
or by typing ROVERQTH in the Entry Window callsign box and pressing Enter. This opens a window to input the county
designator, typically 3 or 4 characters.

If the RoverQTH is typed when a QSO party is selected, one of the approved county abbreviations must be entered. When the
RoverQTH is changed, the Entry Window title bar is updated and the Station Data, RoverQTH box is updated. This saves the
RoverQTH for program restart.
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The {ROVERQTH} macro, when placed in your F-key messages will always send the current RoverQTH string. If, for
example, your F2 key is defined as “5NN{ROVERQTH}”, the macro will substitute the RoverQTH operating location in place of
{ROVERQTH}. The operating location will also appear in the Log window for each QSO. If the {COUNTYLINE} macro
(explained below) is included in the F-key message it will be ignored when the program is in rover mode. This allows a station
to operate as a rover and county line station during the same QSO party without editing the F-key messages.

RoverQTH can be 10 characters long but most Cabrillo output is limited to five or six characters.

When a new ROVERQTH is set in the Entry window, the program checks with the list of accepted county designators for the
current QSO party. If for some reason an unlisted county designator is required, it can be entered in the RoverQTH Field of
your Station Data page.

QSO Party County Line Operation

County line operation is popular with in-state operators in QSO parties because you can give out more than one county
designator from a single location. The out-of-state operators receive two or more counties – often rare ones – in a single QSO,
and earn multiplier credit for each county. If the QSO party exchanges serial numbers, be sure to read the QSO party rules to
determine if the county line QSO’s need to be logged with incrementing serial numbers.

Logging QSO Party County Line Stations

Regardless of whether you are an in-state or out-of-state participant, if you work a county-line station, simply log it using the
DAD/JEF/WAL format in the Exchange field. Separate QSOs will appear in your log, one for each county.

If the QSO party exchanges serial numbers, the same received serial number will be used when logging the separate QSO’s.
If the sending station sends a different serial number for each QSO you can Quick Edit the QSO and change the received
serial number. It is also acceptable to manually log indivdual QSO’s without the compound exchange (DAD/JEF/WAL) entry.

If you are logging a compound county-line exchange, you must do it at the time the contact is initially logged. Do not enter an
ordinary single-county exchange and then edit the QSO and force the exchange to be of the form: “DAD/JEF/WAL”. Doing this
will cause database errors and the program will not be able to score or rescore correctly. If you have logged a single county
exchange and discover that the station you worked is on a county line, enter a new separate contact for each additional
county instead of editing the first contact to use the compound county-line exchange.

A limitation of county line logging with the multiple county exchange is that the ‘same callsign’ can not be logged again on any
band or mode until the computer clock advances beyond the time stamp of the last logged QSO. This will unlikely be an issue
for home stations, and only rarely for county-line stations.

Operating From a County Line

Begin by selecting Operator Category = Rover or Station Category = Rover or Mobile in the Contest Setup dialog. The county
line mode is enabled by entering the word COUNTYLINE in the callsign field of the Entry window and pressing Enter. A pop-up
box will appear, asking you to enter the county abbreviations, separated by commas. If the QSO party exchanges serial
numbers, a prompt will appear asking if the serial numbers of the subsequent logged QSO’s should be incremented. The
answer to this is dependent on the QSO party rules. The simplest operation for everyone involved is no incrementing serial
numbers for county line QSOs. There is additional information about the selection to increment serial numbers below but
when the entry is complete, the counties will appear in the title bar of the Entry window so you can be sure they will be right in
the log.
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You must enter the full county abbreviations specified by the contest sponsors. In multi-state QSO parties, shortcuts omitting
state are not allowed. If you can’t remember the abbreviations, Windows > Multipliers > Other selection will display a complete
list for the current QSO party. Unlike your RoverQTH, which becomes part of your Station Data page, in County Line mode
you will need to re-enter the string of counties if you restart the program.

The use of stored messages is simplified with the use of the {COUNTYLINE} macro which sends the string of counties
separated with a “/” character. Simply use the {COUNTYLINE} macro in place of the {EXCH} macro normally used in Run F2
and S&P F2. If the {ROVERQTH} macro (explained above) is included in the F-key message it will be ignored when the
program is in county line mode. This allows a station to operate as a rover and county line station during the same QSO party
without editing the F-key messages.

Now you’re ready to go. Each time you work a station from a county line, the program will transmit all the county abbreviations
you have entered, separated by a “/” – for example, “DAD/JEF/WAL”. It will also enter a QSO in the log for each county line
county listed under the Rover QTH column in the Log window. A Log window example is shown below operating from the
DAD/JEF/WAL county line. Three stations were logged W1AW – CT, W4ZZ-BAK, and another county line station W4AAA at
LEO/PAS/WAL producing 15 logged contacts.
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If you work a county-line station, you log it by simply by entering the received county abbreviations separated by a “/”, as
explained in the next section below. The logged result will be separate logged QSOs, one for each county combination. As can
be seen in the screen shot, the logged times differ by a few seconds, but this small difference will not be visible in the Cabrillo
file, since the seconds digits are not displayed in the Cabrillo format.

If incrementing sent serial numbers was selected when entering the county line counties, the following information is
important. The program uses a serial number reservation system to insure that serial number does not change after it is
reserved by a VFO, radio, or multi-user station. If a county line station chooses incrementing serial numbers and reserves a
serial number on more than one VFO, radio, or multI-user station at the same time, the logged county line serial numbers will
not be in sequential order. If the QSO party sponsor requires incrementing county line serial numbers and that they be in
sequential order, the county line operation will be limited to one station, radio, and VFO. Contact the QSO party sponsor for
the expectations of the sent and received county line QSO serial numbers.

One limitation of county line logging is that the ‘same callsign’ can not be logged again on any band or mode until the
computer clock advances beyond the time stamp of the last logged QSO. This will only be a concern when moving a station to
another band or mode, operating from more than two county lines, and working another county line station.
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Setup UHF and VHF Contests
2020-03-23

Setup VHF and Up Contests – CW and SSB
In VHF and up contest it is the norm to give accurate signal reports. Use the Tab to go from the callsign filed to the signal
report fields. You will note that it highlights the strength to allow quick modification of that.

ARRL 10GHz and Up

Window: Select Log type
Log Type: ARRL10GHz
Sent Exchange: Your six character grid Example: JO33ab

Be sure to read the official contest rules: http://www.arrl.org/10-ghz-up. Stations are encouraged to operate from
more than a single location, which is referred to within the N1MM+ program as a “Rover.” So although the contest
rules never mention the word “Rover,” these N1MM+ setup instructions use Rover as its method for identifying a
portable station.

The contest takes place over two weekends in August and September. Select >File >New Log in Database
“ARRL10GHZ.” Use that same log for both weekends to ensure proper score and DUPE tracking
To display the UHF/SHF bands in the Entry Window, open the new ARRL10GHz log. If the UHF/SHF bands that you
intend to operate are not listed in the Entry Window (EW), right-click in the EW, select >Change Band Panel Display,
and enable/disable the desired bands
To change bands, click on the desired band in the EW Band Panel Display or enter the new frequency (value in kHz)
into the EW callsign field
To automatically send your grid square in CW or digital modes

Fixed stations (and all non-Rovers) use the standard {EXCH} macro in F1-F12 messages
Portable stations (Rovers) use the special {ROVERQTH} macro in F1-F12 messages

Portable stations (Rovers) – every time you change locations (and before logging any contacts) the operator should
use the ctrl+H command or type “ROVERQTH” in the Entry Window callsign field to designate the new grid square

NOTE 1: If you made contest QSOs in the first weekend, not using N1MM+, you can enter those contacts manually into a new
N1MM+ contest log before the second weekend (date and time should be corrected manually). This will help to avoid DUPE
contacts during the second part of the contest.
NOTE 2: N1MM+ is unable to calculate Off Times correctly because N1MM+ determines off times based on QSOs logged and
the contest rules require that you take listening times into account. Also the rules specify local time for Start and End of
contest which is very unusual.

Portable Stations Pre-Contest Location Test

When creating the new ARRL10GHz Log (and before logging any contacts), stations should select “Rover” as the
Station category in the >File >Open Log in Database >Category >Station field of the dialog window
If you know your initial portable start-point for the contest, enter that initial 6 character grid location in N1MM+’s >Config
>Change Your Station Data >Rover QTH field. This Rover QTH field will be updated throughout the contest each time
you adjust your location with a ctrl+H command or by typing “ROVERQTH” in the Entry Window Callsign field
Portable stations should do a preliminary check of all their planned locations by entering them one-after-another before
the contest by using ctrl+H or “ROVERQTH” in Entry Window. The current Rover QTH will always be listed at the top of
the Entry Window

Feature – All QSOs in a Grid are Displayed
When a grid is entered but no call, all QSOs with that grid will show in the lower part of log window

Logging Digital Mode Contacts
N1MM+ supports a few digital modes: RTTY, PSK31 and PSK63 via the Digital Interface window. “JT” modes such
as FT8, MSK144, FT4, etc. are supported via the WSJT-to-N1MM+ interface described in the manual under the
WSJT Decode List window. Remember to set the Mode category in the Contest Setup dialog to SSB+CW+DIGITAL
to enable scoring of digital modes. Other modes can also be entered by entering the contact in one of the supported
modes (such as SSB) and then editing the mode in the Log window. You will need to do a Tools > Rescore Contest
operation to correct the score after doing any editing in the Log window.
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As each new portable location is entered, N1MM+ will check for compliance with the contest’s 16km rule. If the
proposed new location is within 16km, the following popup error message will appear:

PORTABLE STATION NOTE: After checking all of your proposed portable locations, write them down on a piece of paper.
N1MM+ does not store that information. When finished with testing the proposed locations, re-enter your initial portable start-
point in N1MM+’s >Config >Change Your Station Data >Rover QTH field.

ARRL222 and Up

August UHF Contest (aka “222 MHz and Up Distance Contest”)

Window: Select Log type
Log Type: ARRL-222
Sent Exchange: Your six character grid Example: JO33ab

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

Scoring is correct for fixed and Rover stations except for Rule 3.2. Currently Rule 3.2 is not implemented in N1MM for a fixed
station working a rover in multiple 6-digit grids all within the same 4-digit grid on the same band. The contact that has the
longest distance and highest calculated score should be used for scoring, with the other contacts given zero points. Instead all
contacts are given the score and the final score will be higher than it should be. (Nick NA3M, 2019-08-01)

ARRL January VHF Sweepstakes

Window: Select Log type
Log Type: ARRLVHFJAN
Sent Exchange: Your four character grid Example: JO33
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Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

ARRL June VHF QSO Party

Window: Select Log type
Log Type: ARRLVHFJUN
Sent Exchange: Your four character grid Example: JO33

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

ARRL September VHF QSO Party

Window: Select Log type
Log Type: ARRLVHFSEP
Sent Exchange: Your four character grid Example: JO33

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.

Stations can be logged more than once from a different grid without being a dupe (for Rover stations).

Dupe check on first 4 characters of grid.

The score for Rover stations is not being calculated by the program!

CQ WW VHF Contest

Window: Select Log type
Log Type: CQWWVHF
Sent Exchange: Your four character grid Example: JO33

Exchange of signal report is optional.

Rover stations can be logged more than once from a different grid without being a dupe.

Dupe check on first 4 characters of grid.

The score for Rover stations is not calculated by the program.

A Reverse Call History Lookup feature has been implemented for this contest
If Call History Lookup is enabled, and a Call History file containing grid squares has been loaded, then when a
grid square or partial grid square (at least two characters) is entered into the exchange field and there is no call
sign in the call sign field, the Check window will display all call signs in the Call History file with that same grid
square
The call signs are entered in magenta color, and can be clicked on with the mouse to transfer one of them to the
call sign window
If there is a partial call sign in the call sign field, possibly using wild cards for missing characters, the list of call
signs displayed will be limited to those matching the partial call sign

IARU Region 1 contesting – 50 MHz, VHF, UHF/Microwaves

Region 1 contesting uses a serial number and gridsquare as exchange. The points per qso is the calculated distance between
your sent gridsquare and the received gridsquare.

Station Information (‘Config | Change Your Station data’)
Grid Square: [gridsquare] Example: JO33fd
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This grid square is used in calculating the distance between the stations (and is part of the exchange)
Window: Select Log type (‘File | Choose Which Contest to Log’)

Log Type: VHFREG1
Sent Exchange: 001 [gridsquare]

Example: 001 JO33fd
The sent exchange is not used by this specific contest otherwise the use in the macros for the function
keys.

This contest type has the possibility to use the CallHist table in which information can be stored which can be easy to have
during a qso like name and gridsquares used in previous contests. This specific contest type uses the Name, Locator1 and
Locator2 fields from the CallHist table. Entering any information in this table is not necessary for the contest module to work
but can be very handy. For this to work information has to be imported in the Call History table (‘File | Import | Import Call
History’), also this feature has to be enabled to work (‘Config | Call History Lookup’).

When a callsign is entered and the SPACE or TAB key is pressed the program will check next to the normal things like
dupe check the following:

Check the log if the callsign is known and if already worked the gridsquare is entered from the log in the Entry
Window grid square exchange field.
If not found in the log file it will check the CallHist table. If the callsign is found it will place the content from
Locator1 in the Entry Window grid square exchange field. The callsign is ‘normalized’ before searching in the
CallHist table which means that /P, /A, /2 etc. will be removed before searching. Information in the CallHist table
should be in its normalized form.

Information from the CallHist table i.e. Locator1, Locator2 and the name field will be shown below the function keys.
Normally this feature is not turned on (it gives a very short delay while searching the table), to turn it on select:’Config |
Call History Lookup’
Note: Any information already typed in the grid square exchange will not be overwritten by the log file or CallHist table
search. So first entering a grid square and afterwards a callsign is possible without overwriting the already entered grid
square information. A callsign already worked will be shown in the bottom pane of the log window and marked with the
dupe message. If the station is not worked before and is present in the CallHist table, this information will always be
shown below the function keys.
More information about importing information in the CallHist table can be found in chapter VHF and Up contesting. A zip
file with an import file for the ‘Call history’ lookup function and a ready master file with known calls can be downloaded
from the N1MM website, select ‘Other Files’ under ‘Downloads’. Don’t forget to turn on the lookup function under
‘Config | Call History Lookup’
More information about VHF related contesting and features can be found in chapter VHF and Up contesting

A QSO can not be entered when

The serial number is missing
Warning: “Missing Serial Number!”

The grid length is not 6
Warning: – “6 character grid required!”

The grid format is not correct.
Warning: – “Wrong format grid. Format = AA##AA”

These checks will (only) be done: when trying to log the qso (mostly by pressing Enter)

How VHFREG1 looks for a known grid square

Look in the log if the station has been worked before (on any band)
If found show the grid and calculate distance and bearing

If not found look for the call sign in the ‘call history’ table including any /P /3 etc when applicable.
If found show the grid and calculate distance and bearing

If not found look for the call sign in the ‘call history’ table with the /P /3 etc removed (normalized callsign)
If found show the grid and calculate distance and bearing

If not found add the ‘big grid’ from the country when known by VHFREG1
If found show ‘big grid’ (no calculations done)
If not show nothing in grid square field

The check will (only) be done: When space is pressed and the cursor is in Callsign field

Bearing and distance calculations

When space is pressed and the cursor is in Callsign field
When trying to log the qso (mostly by pressing Enter)
The grid square length has to be 4 or 6 digits.
Bearing info is shown in the log window and saved in the Misc field.
Distance info is shown in km in the log window and saved in the Points field.
Use Rescore to have the bearing and distance (re)calculated.
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Check Grid with country

When a grid is entered the program will check if the ‘big grid’ is a possible grid for the entered callsign.
Example: A Dutch station is always in JO.

When the callsign is entered with /MM the check will not be done.
The check will (only) be done:

When space is pressed and the cursor is in Callsign field
When trying to log the qso (mostly by pressing Enter)

Add ‘big grid’ to 4 digit grid (if last 4 digits entered)

When a 4 digit grid is entered the program checks if these are the last four characters from a 6 digit grid. If so it will add
the ‘big grid’ from the country (for a Dutch station it will add JO).
The check will (only) be done:

When space is pressed and the cursor is in Callsign field
When trying to log the qso (mostly by pressing Enter)

Add ‘big grid’ when no grid is found (from log or ‘call history’ table)

When a station is entered in the callsign pressing SPACE will search the ‘call history’ table. When the entered callsign is not
found the program will try to add the ‘big grid’ who belongs to that country. If more grids are possible it uses the grid which
occupies the most space in the country (IO in England) or is the easiest workable grid from Western Europe (JP for Norway,
most south grid. The Netherlands will always give JO because this is the only grid possible for PA.

The check will (only) be done:
When space is pressed and the cursor is in Callsign field

For DL stations: The German contest manager hat informiert dass er die Logeinsendungen von N1MM gerne akzeptiert. Wie
immer akzeptiert er den postalischen Versand des Logs, jedoch auch Email ist möglich, lediglich müssen die Daten druckfähig
sein.
Vorab also einige Hinweis:

1. Jedes Log muß mit dem Generic-File-Output als TXT-Format sortiert nach Zeit abgespeichert werden und als
Bezeichnung “CALLBAND.TXT” lauten. Also DH5HV2m.txt zum Beispiel für einen Contest unter DH5HV auf 2m.

2. Bei der Einsendung mehrerer Bänder sollte man diesbezüglich den Generic-File erstellen mit “sorted by Band” und
dann mit einem Editor kurz bearbeiten, sodass man als Beispiel eine 2m-Datei, eine 70cm-Datei, eine 23cm-Datei, etc.
hat. Auch hier natürlich dann DH5HV2m.txt und DH5HV70cm.txt und DH5HV23cm.txt erstellen bzw. benennen.

3. Und wie bisher auch üblich wird für jedes Band ein seperates Deckblatt benötigt, was nur komplett ausgefüllt gewertet
werden kann. Man findet dies unter http://www.darc.de/referate/ukw-funksport/index.html ganz unten als PDF-
oder DOC-File.

Marconi CW contest

The Marconi CW contest is CW only. For settings see the VHF Region 1 contest.

Window: Select Log type
Select: Log Type: VHFREG1

NAC Activity Contest

As there is no serial number needed in the NAC contest exchange serial numbers are not shown and not added to the EDI
output (opposed to VHFREG1).
In the EDI output the scoring, bonus and multipliers are calculated. The grid locator from the station information is used in the
calculations. Also the antennas, heights etc. are taken from this dialog.
For more settings and possibilities see the VHF Region 1 contest.

Window: Select Log type
Select: Log Type: VHFNAC
Sent Exchange: Nothing specific needed but the 6 digit grid would be fine to used it in the Sent Exchange
macros.

REF Departments contest 50 Mhz

Window: Select Log type
Log Type: DDFM50
Sent Exchange: Serial Number + Your four character grid Example: 001 JO33
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VHF/UHF Helvetia 26 contest

Window: Select Log type
Log Type: VHFHELV26
Sent Exchange: 001

Local Swiss VHF/UHF and up contest. Uses almost the same rules as VHFREG1 but with an added field for Swiss stations for
exchanging Cantons which are also multipliers for the contest All features mentioned above for VHFREG1 can be used in this
contest. Use in the Multiplier sheet the Sect tab to view the worked Cantons (select VHF and auto).

VHF HG OB contest

OBSOLETE – see UDC contest for local Hungarian VHF contest information

VHF UA1DZ Cup

Window: Select Log type
Log Type: VHFDZCUP
Sent Exchange: 001 gridsquare Example: 001 KO94BD

Russian VHF contest. Exchange is RST + serial number + grid square.

VRZA – Nederlandse Locator Contest – WANLC

Window: Select Log type
Log Type: REGIOVHF (is dus nu de WANLC contest)
Sent Exchange: 001

Only for Dutch stations.

Noot: Deze contest kent een aantal mogelijkheden om extra multipliers te halen middels een soort ‘Rover’ stations. Dit wordt
niet ondersteund door het programma en deze stations worden een DUPE! Ofwel: De multipliers en punten voor /M en /P
stations gewerkt voor een tweede keer worden NIET door het programma automatisch bepaald. Deze dupes dus WEL loggen
en achteraf de score en multiplier aanpassen op ‘generic log’ en de ‘summery sheet’.

Cabrillo output wordt ondersteund (File, Export, Cabrillo).

Voor stations in de secties B en J (Single Operator / Mixed mode)
– Selecteer SINGLE-OP-ASSISTED (onder File, Choose Which Contest to Log, Operator Category) voor een doorlopende
nummering over de banden heen!

YU DX Contest

Window: Select Log Type
Log Type: YUDX
Sent Exchange: your ITU zone. (remember also to put RST in your exchange messages)

UKSMG sporadic-E competition

Window: Select Log type
Log Type: UKSMG
Sent Exchange: Your six character grid (Example: IO75UU) and your UKSMG membership number, if any.

Your function key exchange messages should also include an RST and serial number (#), but you do not put these in the Sent
Exchange box in the setup.

Only the 6 meter band is shown in the Multiplier window.
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Setup Digital, RTTY, and PSK Contests
2020-03-23

Setup Digital Contests – RTTY and PSK
When doing RTTY and PSK contests always check the Mode tab in Configurer for correct settings!

{TIME2} – how it works

The time will be set if

You have a call sign in the Entry Window
The contents of the database field that holds the time is empty for that callsign, and one of the following conditions is
met:

F2 is pressed or sent
Insert is pressed and the code that is run from the insert key sends the contents of the F2 macro
{TIME2} is contained in the macro string that is sent

If you do not have a call in the Entry Window or the database field is not empty, the {TIME2} macro will be replaced by the
Last Sent Time. So if you have not sent the time and you are trying the macro out you will see 0000 printed on the screen. But
if 0512 was the last time sent then that is what the {TIME2} macro will send. {TIME2} stays locked until the contact is logged
or the callsign wiped.

10 Meter RTTY (AA5AU / W0YK)

This contest is no longer active. It has been replaced by the FT Roundup contest, which uses the same rules (same rules as
the ARRL RTTY Roundup).

ANARTS WW RTTY contest

The last running of this contest was in June 2009. It has been replaced by the DRCG-WW Long Distance contest
(DRCGWWRTTY).

ANATOLIAN RTTY contest

Window: Select Log Type
Log Type: ANATOLRTTY
Sent Exchange: 001

ARRL International Digital Contest

Window: Select Log type
Log Type: ARRLIDC
Mode Category: DIGITAL
Sent Exchange: your grid square. Example: FN31

For this contest, the exchange has been chosen to be compatible with the normal non-contest exchange in FT8. For WSJT
modes using WSJT-X, you can either choose the NA VHF Contest type or the WW Digi Contest type under the Advanced tab
in the WSJT-X Settings window, or you can leave the “Special operating activity” check box unchecked and use the full normal
message sequence. If you use the normal message sequence or if you are using JTDX, do not skip the normal grid square
(Tx1) message in an attempt to save time, as that will result in an invalid contest exchange (you must send your grid square).
Using the NA VHF or WW Digi Contest type in WSJT-X will ensure that the correct exchange is sent and logged.

Note: In this contest you may use any digital mode(s) except for RTTY, including FT8 and FT4 modes. For PSK31
and other non-WSJT digital modes, you can use MMVARI or fldigi as the digital engine, with no special setup
required. For FT8, FT4 and other WSJT modes, you must use WSJT-X or JTDX as the digital program. See the
WSJT Decode List window documentation for setup instructions for using WSJT-X or JTDX with N1MM+. Note that
all logging in these modes must be done in the WSJT-X or JTDX program; do not enter call sign or exchange data
directly into N1MM+.
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ARRL Rookie Roundup RTTY

To create the Rookie Roundup log in your database:
Select >File >New log in database

Window: Select Log Type
Log Type: RRRTTY
Sent Exchange: [your name] space [two digit year licensed] space [US state/Canadian province/Mexican call
area] or “DX”

Examples:
JOHN 68 OH (non-rookie station, John, licensed in 1968, from Ohio)
JOSE 10 XE1 (rookie station, JOSE, licensed in 2010, from Mexican XE1 call area)
JEAN 09 DX (rookie station, Jean, licensed in 2009, from “DX” – outside of North America)

Any licensed ham can run the ARRL Rookie Roundup RTTY, but scoring and log submission is limited to Rookie stations
licensed within the last 3 years.

Score summaries are due within 72 hours of the end of the contest – 2359 Wednesday evening UTC, or 1859 EST. Use the
“Submit your score” link under “Score Submission” at the ARRL web page for the RR. ARRL says logs are not required or
accepted.

Calling CQ

Use your standard callsign during the contest – no special suffix (do not use /ROK. This is a rule change since the first
running). Rookies are encouraged to call “CQ RR”; non-rookies should call “CQ R.” RTTY Rookies might want to
download and use a Sample Macro file created specifically for the RRRTTY contest. See the website under >Files
>Sample Macros files “ARRL RRRTTY.MC.” The macros are set for Rookies, non-rookies will need to change the CQ
RR to CQ R.

Contest Exchange

Your name, year licensed (last two digits, example: 09), state/province abbreviation – for K/VE/XE stations (example:
NY) or “DX” for other stations. The two digit year in your Sent Exchange automatically determines your status as a
Rookie or a non-Rookie station. The 2 digit year in the Received Exchange determines the status of the station you are
working. Do not use 4 digit years, it will only cause confusion for both Rookies and logging software.

ARRL RTTY Roundup

The ARRL RTTY Roundup can be used by K/VE stations and DX stations.

Window: Select Log Type
Log Type: ARRLRTTY
Contest Exchange: K/VE stations – signal report and state/province. Others (DX stations) – signal report and
serial number
Sent Exchange in Contest Setup dialog window:

Your state/province – for K/VE stations Example: NY
001 – for DX stations (non K/VE)

Sample Function Key file available: see the file called ARRLRTTY.mc in the Function Key Files – Digital
subfolder in the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX stations
or a W/VE station.

Note: US stations who work US “/MM” stations are also allowed to log serial numbers.

If you are using both RTTY and FT8/FT4 in the same contest, as allowed by the ARRL RTTY Roundup rules prior to 2023, you
will find that the serial number sequences for ARRL and FT8/FT4 are independent. This is because N1MM+ and WSJT-X
have separate serial number generators and neither one is aware of the serial numbers the other one has issued. This is not a

Using FT8 in the ARRL RTTY RoundUp

Contesters planning to operate the FT8 mode with WSJT-X in this contest (allowed before 2023) should read about
the WSJT-X to N1MM+ interface in the manual section on the WSJT Decode List window.
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problem; the contest managers will not penalize you for this. The important thing is that the serial number listed in the Cabrillo
file is the same as the serial number actually sent during the QSO.

If you are using this contest type for the FT Roundup, which uses the same rules, you should change the CONTEST: line in
the Cabrillo header from ARRL-RTTY to FT8-RU.

BARTG Spring RTTY contest

Window: Select Log type
Log Type: BARTGSRTTY
Sent Exchange in the Contest Setup dialog window: 001

Sample Function Key file available: see the file called BARTGSRTTY.mc in the Function Key Files – Digital subfolder in
the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

Be careful not to confuse this contest with the BARTG RTTY Sprint contest.

The actual sent exchange includes a signal report, serial number and the UTC time. Program this into your Exchange
messages using the {TIME2} macro, e.g.: {TX} 599 {EXCH} {TIME2} {RX}, or {TX} 599 # {TIME2} {RX}.

Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.

Added EXPERT to list of overlay categories choices. The EXPERT overlay category must be selected for the 5 minute band
change counter to not be active for SINGLE-OP

BARTG RTTY Sprint contest

Window: Select Log type
Log Type: BARTGRTTYS
Sent Exchange:001

Sample Function Key file available: see the file called BARTGRTTYS.mc in the Function Key Files – Digital subfolder in
the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

Be careful not to confuse this contest with the BARTG Spring RTTY contest (BARTGRTTYS versus BARTGSRTTY).

Note that there is no signal report in the sent exchange, just a serial number.

Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.
Added EXPERT to list of overlay categories choices. The EXPERT overlay category must be selected for the 5 minute band
change counter to not be active for SINGLE-OP.

BARTG Sprint75 RTTY contest

Window: Select Log type
Log Type: BAR75RTTYS
Sent Exchange:001

This contest type is used for the BARTG 75 baud sprints in April and September. For information on setting up MMTTY and
N1MM Logger for 75 baud RTTY, see the section on Using MMTTY for 75 baud RTTY at the end of the Using MMTTY section
in the Digital Modes chapter.

CQ World Wide DX contest – RTTY

Window: Select Log type
Log Type: CQWWRTTY
Mode Category: RTTY
Sent Exchange:

North American/Canadian stations – Your zone plus the STATE or PROVINCE Example: 05 NY

Testing the {TIME2} macro

If you test out the Exchange message using the {TIME2} macro without first entering a call sign into the Entry
window, the Exchange message will send “0000”. This is expected, and it does not mean there is something wrong
with your Exchange message. The time sent by the {TIME2} macro will be initialized only after a valid call sign has
been entered into the call sign box and the cursor has been moved into the exchange box.
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NB For cabrillo log submission the order must be: Zone first, then state (or province) with no
leading spaces, and ONLY ONE space between the zone and the state.

Other stations – Your zone Example: 14

The default zone values for US (A,K,N,W) stations before the state is known are

Zone 3 – If number in callsign is 6 or 7
Zone 4 – If number in callsign is 5 or 8 or 9 or 0
Zone 5 – If number in callsign is 1 or 2 or 3 or 4

The default zone values for Canadian (VE) stations are

Zone 1 – If callsign starts with: VE8, VY1
Zone 2 – If callsign starts with: VO2, VY0
Zone 3 – If callsign starts with: VE7
Zone 4 – If callsign starts with: VE3, VE4, VE5, VE6
Zone 5 – If callsign starts with: VE1, VE2, VE9, VO1, VY2

Press the Space bar when the cursor is in the Callsign field to have the Zone field filled with the default value and move
the cursor to the state/province field for W/VE call signs, or directly to the zone field for DX call signs.
The province code is pre-filled for Canadian stations based on the call sign prefix.
The state field for US stations is pre-filled if you have worked that station on another band, or if you are using a Call
History file.
Once the state has been entered either by pre-fill or by the user based on the received exchange, the zone will be
recalculated if the default zone based on the number in the callsign was wrong.
When typing the section and the entered section is new the call sign will be shown in RED. The Available window will
also show if a section multiplier is needed on other bands
When pressing Space and the entered callsign is not US or VE, the cursor will skip the state/section field.
When submitting your log to the contest robot make sure you have in the Sent Exchange the correct order: Zone first,
then state (or province).

Cabrillo output
The Cabrillo file must be in the order zone, state because that’s how the official Cabrillo template for CQ WW RTTY is defined.
However, this has *nothing* to do with how you operate during the contest, it only applies to the post-contest log submission.
During the contest, you can send in either order; all the rules say is you must send both.

CQ World Wide WPX contest – RTTY

Window: Select Log type
Log Type: CQWPXRTTY
Mode Category: RTTY
Sent Exchange: 001 (set Send Leading Zeroes in Configurer >Function Keys)

Sample Function Key file available: see the file called CQWPXRTTY.mc in the Function Key Files – Digital subfolder in
the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

CIS contest – RTTY

The Commonwealth of Independent States Contest where everybody can work everybody for QSO and multiplier credit.

Window: Select Log type
Log Type: CISDXRTTY
Sent Exchange:

CIS stations: CIS area code Example for Moscow City: RU11
Non-CIS stations: 001

Call History in CQWWRTTY

If you like to use Call History Lookup and you plan to use a generic call history file that contains state information for
W stations, you should be aware of a potential problem with call signs from AK and HI. If you invoke a call history
lookup for a call sign in AK or HI, the call sign is in the file, and there is an entry for the state for that call sign in the
file, the state/province field in the Entry window will be pre-filled, even though under the rules for this contest the
state field should be blank. This in turn may lead to an error in logging the contact; you may have to edit that entry in
the log to remove the unwanted state code. You can avoid this by removing the state codes from the call history file
for call signs in AK and HI, or more simply by turning Call History Lookup off for this contest.
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DL DX RTTY contest

Window: Select Log type
Log Type: DLDXRTTY
Mode Category: RTTY
Sent Exchange: 001

DMC RTTY contest

Window: Select Log type
Log Type: DMCRTTY
Mode Category: RTTY
Sent Exchange: 001

DRCG-WW Long Distance RTTY contest

This contest replaced the ANARTS RTTY contest.

Window: Select Log type
Log Type: DRCGWWRTTY
Mode Category: RTTY
Sent Exchange: Zone Example: 14

Sample Function Key file available: see the file called DRCGWWRTTY.mc in the Function Key Files – Digital subfolder
in the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

The actual sent exchange includes a signal report and your CQ zone

See contest sponsor website for new contest times and bandchange restrictions.

EA PSK31 contest

Window: Select Log type
Log Type: EAPSK
Mode Category: PSK
Sent Exchange:

For Spanish stations – Province Example: AL
For non-Spanish stations – Serialnumber Example: 0001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Spanish
station or a non-Spanish station.

EA RTTY contest

Window: Select Log type
Log Type: EARTTY
Mode Category: RTTY
Sent Exchange:

For Spanish stations – Province Example: AL
For non-Spanish stations – Serialnumber Example: 0001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Spanish
station or a non-Spanish station.

EPC PSK63 QSO party

Window: Select Log type
Log Type: EPCPSK63QP
Sent Exchange:

EPC member stations: EPC membership number Example: EPC0001
Non-EPC member stations: 001

EPC PSK World Wide DX contest

Window: Select Log type
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Log Type: EPCWWDX
Sent Exchange:

EPC member stations: EPC membership number Example: EPC0001
Non-EPC member stations:

EU PSK DX contest

Window: Select Log type
Log Type: EUPSKDX
Sent Exchange: Non-EU stations send signal report plus 001 – EU stations send signal report plus EU Area
Code. The EU Areas List can be downloaded at https://eupsk.club/documents/euareas.xls

FT Roundup

This contest has replaced the former 10m RTTY contest sponsored by AA5AU and W0YK. It uses the same rules as the
ARRL RTTY contest.

Window: Select Log Type
Log Type: FTROUNDUP

Contest Exchange: K/VE stations – signal report and state/province. Others (DX stations) – signal report
and serial number
Sent Exchange in Contest Setup dialog window:

Your state/province – for K/VE stations Example: NY
001 – for DX stations (non K/VE)

The contest messages are set up in the WSJT-X Settings window under the Advanced tab. Check the check box called
“Special operating activity: Generation of FT4, FT8, and MSK144 messages”, select the “RTTY Roundup messages”
option, and enter your state or province (for W/VE stations), or DX for stations outside W/VE in the “RTTY RU Exch:”
box. For DX stations, WSJT-X will automatically send serial numbers instead of “DX”.

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a DX stations
or a W/VE station. This plus the contents of the Sent Exchange box are important for Cabrillo file generation, but have no
impact on the exchange sent by WSJT-X, which must be set up in the WSJT-X Settings window as described above.

JARTS WW RTTY contest

Window: Select Log type
Log Type: JARTSWWRTY
Sent Exchange:Your age Example: 34

XYL and YL stations may give 00
Multi-operator stations must send the callsign owner’s age
Multi-operator Club stations must send 99 as a operator age.

JT RTTY DX Contest

Window: Select Log Type
Log Type: JTDXRTTY
Mode Category: RTTY
Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)

Makrothen RTTY Contest

Window: Select Log type
Log Type: MAKRORTTY
Mode Category: RTTY
Sent Exchange: 4 digit grid Example: JO33

Logbook of the World Contest – RTTY/Digital

Window: Select Log type
Log Type:

LOTWRTTY
Sent Exchange:

For North American stations: State/Province abbreviation Example: CT
For non North American stations: Countryprefix
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NA Sprint RTTY

Window: Select Log type
Log Type: SPRINTRTTY
Mode Category: RTTY
Sent Exchange: 001 Tom CT

Serial number, your name and your location (state, province or country) Example: PA1M DE N1MM 123
TOM CT K

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a North
American station or a non-North American station.

The Sprint QSY rule calls for a different strategy in function key messages than is usual in other contests. The exchange in the
Sprints must include both call signs, but although the rules do not require a specific order, there is a conventional order that is
used by experienced Sprinters to make things flow more smoothly.

By convention, the Running station (the one who called CQ, or the one who was on the same frequency during the previous
QSO) sends his exchange in the format:
HISCALL MYCALL NUMBER NAME STATE
He does not put his own call sign at the end of the message. This exchange format with no call sign at the end is a signal to
others tuning across the frequency that the QSO is not over yet, and also that this station will not be staying on the frequency
after the QSO is over.

The S&Ping station (the one who answered the QSO or who is newest on the frequency) uses a different format:
HISCALL NUMBER NAME STATE MYCALL
Unlike the common practice in other contests, he does not repeat the other station’s call sign at the end of the message. His
own call sign at the end of the message is a signal to others tuning across the frequency that he is the one who will be holding
the frequency, so he is the one they should call once the Running station’s TU message has completed.

The Running station also uses a different TU (F3) message than he would in a normal contest. The Running station should
not put his own call sign in his TU message, because that causes instant confusion about who will be staying on the
frequency. Some people send the other station’s call sign followed by TU, but the most efficient format is simply to send only
TU or RR and nothing else. The shorter this message, the more quickly the next station can call and start the next QSO.

See http://n1mmwp.hamdocs.com/wp-content/uploads/attachments/RTTY-Sprinting-Part1.pdf for a detailed explanation of
how this works.

North American QSO Parties RTTY – NAQP

Window: Select Log type
Log Type: NAQPRTTY
Operator Category: SINGLE-OP or MULTI-TWO

For Multi-Two see the extra info below!
Mode Category: RTTY
Sent Exchange:

For North American stations – Operator name and station location (state, province, or country) Example:
Tom CT
For non-North American stations – Operator name only Example: Thomas

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a North
American station or a non-North American station.

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the NAME (not Call) of the operator. This
name set with Ctrl+O will be used in the Cabrillo file. So from the Sent Exchange only the state is being used but the name is
needed. (Example: Tom CT).

OK DX RTTY Contest

Window: Select Log type
Log Type: OKDXRTTY
Mode Category: RTTY
Sent Exchange: CQ zone
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Quick PSK63 Contest

The contest uses the same rules as the SARTG WW RTTY contest so select that contest (SARTGRTTY).
After the contest the Cabrillo output has to be updated (take SARTG WW out and replace with Quick PSK63)

Russian Federation Digital (SRR DIGI CUP) contest

Window: Select Log type
Log Type: RFCDIGI
Mode Category: RTTY
Sent Exchange: 001 xxnn (where xxnn is your grid square locator)

Russian WW Digi Contest (RUS-WW-DIG)

Window: Select Log type

Log Type: RUS-WW-DIG
Mode Category: RTTY, PSK
Exchange:

Russian stations: Two-letter oblast code, e.g. MA
Others: 001

Russian WW MM Contest (RUS-WW-MM)

Window: Select Log type

Log Type: RUS-WW-MM
Mode Category:
Exchange:

Russian stations: Two-letter oblast code, e.g. MA
Others: 001

Russian WW PSK Contest (RUS-WW-PSK)

Window: Select Log type
Log Type: RUS-WW-PSK
Mode Category: PSK
Exchange:

Russian stations: Two-letter oblast code, e.g. MA
Others: 001

Russian DX RTTY contest

Window: Select Log type
Log Type: RUSDXRTTY
Mode Category: RTTY
Sent Exchange:

Non-Russian stations: 001 or # (to generate serial numbers)
Russian stations: Your oblast code (two letters)

The callsign in the Station Information dialog ( Config, Change Your Station Data, Call ) determines if you are a Russian
station or a DX station.

SARTG New Year RTTY Contest

Window: Select Log type
Log Type: SARTGNYRTY
Mode Category: RTTY
Sent Exchange: 001 Name
Soap Box Comments: “Happy New Year” in your native language

Add “Happy New Year” in your native language to the Function Key macro. Do not add it to the Sent Exchange. If you
do, the Cabrillo output and General Log output may not be correct.
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Logging an exchange with spaces is not supported and logging of the Happy New Year greating is *not* required. If you want
to record the Happy New Year greeting it can be added *without* spaces after the name preceeded by a “/”. Example:
Jim/HappyNewYear. If added, the Cabrillo output generator will remove the “/” and everything that follows when generating the
output file.

The sponsor informed the developers that as of December 21, 2013 they will accept Cabrillo 3.0 formated logs. It is necessary
to follow the Sent Exchange & Soap Box instructions above to export a Cabrillo file. The Happy New Year message that you
sent will appear in the Cabrillo Soap Box Comment.

SARTG WW RTTY Contest

Window: Select Log type
Log Type: SARTGRTTY
Mode Category: RTTY
Sent Exchange: 001

Sample Function Key file available: see the file called SARTGRTTY.mc in the Function Key Files – Digital subfolder in
the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

SCC RTTY Championship

Window: Select Log type
Log Type: SCCRTTY
Mode Category: RTTY
Sent Exchange: four-digit number of the year the amateur radio license was FIRST officially issued (e.g. 1983)
to the operator.

The score Summary window only shows your total score and the number of mults you have worked per band. There is no
breakdown by points. In SCC there is one extra column of mults but that had to be there as the way things are setup to
calculate the first multiplier (different years). Thus the name of the second mult is “N/A” . The only way to do a breakdown on
points is to go through your log and manually do it.

SP DX RTTY contest

Window: Select Log type
Log Type: SPDXRTTY
Mode Category: RTTY
Sent Exchange:

001 for non-SP stations
Your province Example: B for Lubuskie

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Polish
station or a DX station.

TARA Grid Dip contest

Window: Select Log type
Log Type: TARAGRID
Mode Category: RTTY or PSK
Sent Exchange: name + 4 digit grid locator Example: Tom FN12

TARA PSK Rumble

Window: Select Log type
Log Type: TARAPSK
Mode Category: PSK
Sent Exchange: Name and Call Area Example: Tom W1

TARA RTTY Melee

Window: Select Log type
Log Type: TARARTTY
Mode Category: RTTY
Sent Exchange:

State for USA stations Example: CT

3/4/25, 5:37 PM N1MM Logger+ Documentation



459

Province for Canadian stations Example: NB
001 for all other stations (serial number)

TARA Skirmish

Window: Select Log type
Log Type: TARAPSK, or SKIRMRTTY (SKIRMRTTY requires that you download the SKIRMRTTY.udc user-
defined contest file)
Mode Category: DIGITAL
Sent Exchange: Name and Prefix Example: Tom N1

Note: Download the SKIRMRTTY.udc file into your UserDefinedContests folder and use SKIRMRTTY. If you do not want to
use the udc file, the TARAPSK contest will also work for the Skirmish, but the scoring of multipliers will not be correct. Use the
Tara on-line log submission page and enter the correct prefix multiplier count there. If you use more than one digital mode
during the contest, submit a separate entry for each mode as per the contest rules.

Ukrainian DX Classic RTTY contest

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian stations, or you can use the
UKRAINRTTY contest type.

Window: Select Log type
Log Type: UKRAINDX (use this contest Log Type for the Ukrainian DX Classic RTTY contest)
Mode Category: RTTY (NOTE: this contest will default to phone. You need to manually reset for RTTY!)
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

Sample Function Key file available: see the file called UKRAINDX.mc in the Function Key Files – Digital subfolder in
the >Downloads >File Explorer >Sample Function Key Files folder on the N1MM+ web site

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an Ukrainian
station or a non-Ukrainian station.

Ukrainian Open RTTY Contest

Window: Select Log type
Log Type: UKRRTTYOPEN
Mode Category: RTTY
Exchange: 2-letter province code + 3-digit serial number

Ukrainian RTTY contest

Window: Select Log type
Log Type: UKRAINRTTY
Mode Category: RTTY
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an Ukrainian
station or a non-Ukrainian station.

Ukrainian DX DIGI Contest

75 baud RTTY and PSK63 modes

Window: Select Log type
Log Type: UKRAINDIGI
Sent Exchange:

Oblast for Ukrainian stations Example: CH
001 for non-Ukrainian stations

United Kingdom DX contest RTTY

The UK DX contest can be configured for UK stations and non-UK stations.
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Window: Select Log type
Log Type: UKDXRTTY
Sent Exchange:

Area code for UK stations Example: BS
001 for non-UK stations

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an UK station
or a non-UK station.

VOLTA RTTY Contest

Window: Select Log type
Log Type: VOLTARTTY
Mode Category: RTTY
Sent Exchange: RST + QSO number + Your CQ Zone. Example: 599 001 15

The four Band Multiplier count for this contest is displayed on info window.

WAEDC RTTY contest

The WAEDC RTTY Contest can be configured for European stations and non-European stations.

Window: Select Log type
Log Type: WAERTTY
Sent Exchange: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are an European
station or a non-European station.

Making QSOs in WAE RTTY:

To start with, a QSO in WAE is just like a QSO in CQ WPX or SARTG, and I would suggest using a similar function-key set.
The special feature of WAE is QTCs, which are reports of previous QSOs that can be exchanged for additional points.

In CW and SSB WAE, QTCs can only be sent from non-EU to EU, but in RTTY there are many more possibilities. QTCs can
be sent in either direction between any two continents (not with a station in the same continent).

In N1MM Logger+, the user interface for QTCs in RTTY is very similar to that in CW/SSB. The Logger has features to
automate the sending and receiving of QTCs. There is also information in the Entry and Bandmap windows to tell you whether
the rules permit you to exchange QTCs with another station. In the bottom part of the Entry window, while you are in QSO with
a station information about the number of QTCs you have available to exchange with him is displayed. In the following
example, the three numbers in red after “QTCs” mean that you have not exchanged any QTCs with this station yet (0), you
have 10 QTCs available to send to him, and you have 22 total unsent QTCs in your log.
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The Bandmap and Entry windows contain visual cues about the QTC status of stations spotted in the Bandmap or entered
into the Entry window. A special color scheme for spotted call signs has been implemented, as follows:
RED: the station is a new multiplier on this band (same as in other contests)
GREEN: this is a new station on this band, and you can also exchange QTCs with him (you are on different continents and
you have not yet exchanged 10 QTCs)
BLUE: this is a new station on this band, but you have no more QTC room available (same continent, or you have already
exchanged 10 QTCs)
BLACK: this station is a dupe on this band, but you still could exchange QTCs with him for QTC points
GREY: dupe, and there is no QTC room either – this station is non-workable for any kind of credit, so just pass him by
Note that this special color scheme only applies to the Bandmap and Entry windows; the colors in the Digital Interface and
Available Mults and Qs windows use the normal color scheme, the same as in other contests.

OK, let’s look at the process. First, let’s suppose you are CQing. If you have a good run going and you are getting new
multipliers calling in, you may decide you don’t want to break your rhythm for QTCs. As long as there are people waiting to
work you when you CQ, you may decide you will be best off adding to your QSO and multiplier counts rather than adding a
quick 10 QTCs, which increases your net QSO+QTC point count but does nothing for your multiplier points.

However, especially later in the contest, you might want to pick up your score with some QTCs, as you will probably be able to
exchange a batch of 10 QTCs more quickly than you could work 10 more QSOs, and the odds of finding a new multiplier may
be much lower than earlier in the contest. In fact, you can even call someone who is a dupe just so you can exchange QTCs;
the extra QSO will not count for points, but the QTCs will.

First, let’s look at the case where you do not have many unsent QTCs to send (that’s previous QSOs that you have not
already sent as QTCs). In this case, if you work someone who has a good clear signal (you won’t want to do this with
someone you have trouble copying) and you have not yet exchanged QTCs with him, you may want to receive some.

Start by asking him if he has any QTCs for you (“QSL TNX. ANY QTCS FOR ME?”). If he says yes, press Ctrl+Z once. That
gets you to the RQTC window for receiving QTCs.

After you tell him you are ready with the RX Ready button, he will send you a message whose first line is something like
“QTC: 22/10 QTC: 22/10”. The first number is the group number (the 22nd group he has sent), the second is the number of
QTCs in the group (maximum 10, and especially in RTTY it is most efficient to send only large groups). If you click on this in
the RX window, it should transfer to the RQTC window for recording in your log. If the incoming data is garbled so you cannot
copy it, you can click on the “Hdr Agn” button to ask for the header to be sent again.

The heart of his message will be a set of up to 10 QTCs. Each QTC contains three elements: the time, the call sign, and the
serial number. Each time you receive a QTC, left-click on it and the entire QTC should transfer into the corresponding panes
in the RQTC window. You can also enter or edit elements by hand, or you can right-click on a single element and then left-
click in the box where you want it to go. After you have received all the QTCs in the group, it may help to click on the green
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bar at the left of the RX window so you can freeze the RX window, scroll back and complete or fix any missing or garbled
elements. Remember to click on the yellow bar when you are done so you can receive again.

After he has sent the batch of QTCs to you, you may need him to repeat some of the information. There are buttons in the
RQTC window for asking for repeats for individual QTCs (“Agn #1”, etc.) or for the whole series (“All Agn”). Once you have
them all, press the “Save” button, which will send an acknowledgement message to him and log the QTCs, and then you can
start CQing again.

There is a series of buttons labeled “S” (for “Skip”) to the right of the “Agn” buttons. If, while you are receiving a set of QTCs,
one of them is so badly munged by a noise hit that there is nothing useful to click on to fill the boxes, you can click on the “S”
button for that QTC to leave the boxes for that QTC empty and continue with the rest of the QTCs. After the entire set has
been sent, you can then click on the corresponding “Agn” button to ask for a repeat of that individual QTC so you can fill in the
missing data. By doing this you preserve the correct order of the QTCs as sent.

Suppose instead that you do have a bunch of unsent QTCs ready to go. Then what you may want to do at the end of a QSO
with a station with a good clear signal (if you have trouble copying someone’s signal, you probably will not want to try QTCs
with him) is to ask if he wants to receive QTCs (“QSL TNX. DO YOU WANT QTCS?”). If he says yes, press Ctrl+Z twice to get
to the SQTC window.
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This window starts out pre-filled with all the information you need to send – as you can see, sending QTCs is quite a bit easier
than receiving them! The buttons in this window should be self-explanatory. The “Send Hdr” button is what you use to send the
QTC batch number (e.g. QTC: 2/10), and once the other station has acknowledged that, the “Send All” button is what you use
to send the batch. After the batch has been sent, if he asks for a repeat of #3, 7 and 9 you can resend them by pressing Snd
#3, Snd #7 and Snd #9. Once he acknowledges them all, press Save and go back to CQing.

If you get into the wrong QTC window by mistake, you can either press Cancel or press Ctrl+Z once or twice until the QTC
window closes. Note also that if you aren’t able to exchange QTCs with a station (you’re on the same continent, or you have
already filled your quota of 10), the QTC window will not open. If you are able to receive QTCs but don’t have any QTCs to
send, the RQTC window will open, but the SQTC window will not.

S&Ping works much the same. The color coding in the Bandmap window can let you know whether you will be able to
exchange QTCs even before you start a QSO, or once you are in QSO the detailed QTC status is visible in the Entry window.
Often you will let the running station decide if he wants to do QTCs or not, depending on how well his run is going, but
sometimes you may want to initiate the process yourself, as described above.

If the other station wants to send QTCs to you, you can either reply “SRI QRU” (not quite correct, but he will get the message)
or you can press Ctrl+Z once to get the RQTC window and press the RX Ready button to tell him you are ready, then receive
QTCs the same as described above. If he asks you whether you have QTCs for him, you have three options: press Ctrl+Z
twice and press the R U QRV button to give him the cue to get ready; send “SRI QRU”; or send a message telling him you
don’t have any but are willing to receive some (“SRI QRU. ANY QTCS FOR ME?”).

Most of the basic QTC messages are sent by buttons in the SQTC and RQTC windows. You can program the messages in
these buttons either by using the Setup button in the QTC window, or from the Config > WAE > Open QTC Window setup
area menu item in the Entry window, using the third tab (“RTTY Setup”).

There are a few additional messages you may want to program into the buttons at the bottom of the Digital Interface window,
such as:
{TX} QSL TNX. GOT ANY QTCS FOR ME? {RX}
{TX} QSL TNX. DO YOU WANT QTCS? {RX}
{TX} SRI QRU {RX}
{TX} SRI QRU. ANY QTCS FOR ME? {RX}

You may think of more – that’s OK, there are up to 24 clickable message buttons in the Digital Interface window. I often find
myself changing them on the fly during a contest. You can get to the programming window by right-clicking on the button you
want to change.

QTC Lines on the frame are broken up into separate boxes. This was done to allow error checking of any data that is
input by hand and clicking on data in RX window.
If you click on data or enter data in the QTC windows if the routines detect bad data it will flag that data in red. So when
you are receiving QTCs and you get one that is garbled, Click on it anyway and it will get placed into the QTC area.
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The boxes for that QTC will turn red.
Upon completion of the sending QTC’s all you have to do is look at the QTC window and it will tell you by the red colors
what QTC you need to RX again. You press the AGN # button and it sends your message out. At the same time your
message is going out the QTC line is cleared. Now when the station sends the repeat of the QTC you requested and
you click on it and it will then be placed into that blank line that was just cleared.
When saving QTC if any of the data still hasn’t been corrected it will send the received ok message but if there is an
error in the Time or the Callsign the program will let you save the QTC and not care about it. But if there is an error in
the serial number (If it contains anything besides a number) it will not let you save it. The reason for this is in the
program the serial number needs to be a certain type of variable(numeric) and if it is not a numeric variable it will not
save it. So the flow of it if there is an error in the serial section and you press Save is:

A. Sends the confirm string you have setup
B. Tells you on the entry window there is a Format error
C. Waits for you to fix it.
D. So now you would have to scroll back to see what was sent of take out the extra letter your finger hit then hit save.
By doing it this way you are not slowing down the other station

The program will not save info into the log until the bad data is fixed. Once fixed just click Save again and it will save
the data without sending the received message. A warning message is given in the Entry window status bar.
Sometimes a call sign reported in a QTC will not pass the call sign recognition routines and the QTC will be displayed
in red. If it was a special call sign, not a copying error, and you want to log it anyway, you can “force-log” the QTC by
Ctrl+clicking on the Save button
To select whole lines of received QTC just place the cursor over the line and left click.
To select individual QTC sections place the cursor over the item you want to select and right click on it. After the data is
selected place the cursor over the text box you want the data to go into and left click it will be placed into it.
When pressing Ctrl+Z to switch modes the program will display the total QTC sent and received from the station being
worked.
When pressing Ctrl+Z to switch modes if you have reached the MAX amount of QTC the QTC window will close and
give a warning message in Entry windows status bar.
When left clicking on a Received QTC line will split data on ” “,”/”,”-” separators if the routines can’t split the data it will
not copy the data over. You will have to click each item separate or hand type it in.
Selecting of individual QTC items can be done by right clicking on item. Left clicking on the box where the data to be
placed places text.
Ctrl+Z cycles through QSO, receive QTC and send QTC modes. After you enter a callsign in the entry window pressing
Ctrl+Z will cycle through the RQCT and SQTC modes. If you are receiving QTC press Ctrl+Z once and as the QTC
appears in the digital window just click on it one time and it will transfer over to the QTC entry window. To send a QTC
press Ctrl+Z one more time and it will show you all the QTCs you have available to send.
The status line in the Info window shows the total QTC Sent and Received from the station being worked.
Upon entering a callsign in the entry window and pressing the spacebar, the number of total QTC’s exchanged with that
callsign and the Total of all unsent QTC is displayed on the entry window so you should be able to keep track easier of
what your QTC numbers are
If you work a station that is on your same continent and try to send them QTC or try to receive QTC from them the
program will tell you you can not do that. Press Enter and move on……
On the WAE Tab located in the settings area will allow you to set the maximum number of QTC you want to send.
Whatever this setting is set to is the number that will send unless you do not have that many QTC to send. This
defaults to 10.
The total unsent QTC’s is displayed along with # of QTC’s exchanged with current callsign on the Entry window
Continent is checked when sending and receiving QTC’s
Default number of QTC to send can be entered on the Tab WAE RTTY configuration under Settings in the menu from
the DI interface.
The number of QTC sent and total QTC available is shown in the Entry window upon Entering Callsign
Hover mode is disabled if the QTC window is open
The number of CR’s between QTC’s sent is configurable (Setup QTC)
Placing a QTC into the QTC window is possible by clicking in line of QTC boxes where you want QTC to be placed into.
When tuning in the bandmap the Entry Window will show the QTC status of the tuned callsign; the color in the
Bandmap window also shows the status
Warning: In this contest it is allowed to log a contact with a zero serial number (such as a non-contest DXpedition you
work during the contest). Therefore the normal ESM flow is altered; F8 (Agn?) is not highlighted when the exchange
box is empty during a QSO. In a normal QSO where you receive a serial number, you have to be careful not to hit Enter
too soon and forget to log the received serial number; make sure to enter the serial number before you hit Enter to
finish the QSO!

For those who are familiar with WAE CW/SSB, note that although the QTC user interface in N1MM Logger+ is similar, there
are fundamental differences in the contest rules between the RTTY and the SSB/CW version of the contest:

1. Everyone can work everyone, so DX can work DX and EU can work EU
2. Everyone can both send and receive QTCs, however they can only be exchanged between stations in a different continent
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How do I know how many QTCs I can receive from a station or how do I know the number to send to them?

The program will do all this for you in a number of ways…

The first number that is displayed on the entry window by the QTCs title is the total number of QTC’s you have
exchanged with that station. If it says 8 then you can either receive or send 2 more
When you press Ctrl+Z to switch to RQTC mode the program already knows how many QTC you can receive and will
only enable that many entry points on the QTC frame
When you press Ctrl+Z to switch to SQTC mode the program will either set the maximum number you want to send or
however many QTC’s you are still allowed to send to that station. (Whichever is smaller)

One final note: If you export your contest log to ADIF after the contest, the ADIF file will not contain QTCs, only QSOs. This is
not a problem if you are exporting for purposes of a general logging program, QSLing, etc., but if you want to transfer a WAE
contest log between databases or between computers, you cannot use ADIF files to do this unless there are no QTCs in the
log. To transfer a complete WAE log between copies of N1MM Logger+ on two computers, you must either copy the entire
database between the computers, or else you must copy the TRN file for the WAE contest to the second computer and then
import it into a new empty N1MM+ database on the second computer.

WW-DIGI Contest

Window: Select Log type
Log Type: WWDIGI
Mode Category: DIGITAL
Sent Exchange: your grid square. Example: FN31

For this contest, the exchange has been chosen to be compatible with the normal non-contest exchange in FT8. In WSJT-X,
you can either choose the NA VHF Contest type or the WW Digi Contest type under the Advanced tab in the WSJT-X Settings
window, or you can leave the “Special operating activity” check box unchecked and use the full normal message sequence. If
you use the normal message sequence, do not skip the normal grid square (Tx1) message in an attempt to save time, as that
will result in an invalid contest exchange (you must send your grid square). Using the NA VHF or WW Digi Contest type will
ensure that the correct exchange is sent and logged.

XE RTTY Contest

Window: Select Log type
Log Type: XERTTY
Mode Category: RTTY
Sent Exchange:

Mexico: State. Example: AGS
Non-Mexico: 001

The callsign in the Station Information dialog ( >Config >Change Your Station Data >Call ) determines if you are a Mexican
station or a non-Mexican station.

Note: This contest is for FT8 and FT4 modes. You must use WSJT-X or JTDX as the digital program for these
modes. See the WSJT Decode List window documentation for setup instructions for using WSJT-X or JTDX with
N1MM+. Note that all logging must be done in the WSJT-X or JTDX program; do not enter call sign or exchange data
directly into N1MM+.
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Setup User Defined Contests
2020-03-23

Setup User Defined Contests (UDC)
The User Defined Contests listed below have been developed by users of N1MM Logger+, and should work as described
although they are not officially supported by N1MM Logger+.
There are probably additional details within the .UDC file regarding contest setup and exchange. Use a text editor to examine
the file after downloading from the >Files >User Defined Contests gallery. Be advised that there are known scoring anomalies
with some of the UDC contests.

Installation Instructions for a User Defined Contest (UDC)

User Defined Contests are not distributed with the program installer, either Full or Latest Update

A list of available User Defined Contests is located on the Supported Contests List page (enter udc in the search
window).
The UDC files themselves are found on the N1MM Logger+ website, located under >Downloads >Category Listing
>User Defined Contests
To enable a UDC contest and select it in the contest configuration dialog window

1. Locate the desired UDC file on the website in >Downloads >Category Listing >User Defined Contests page
(Note: for some UDCs, the file is a Zip archive file that contains the UDC and other files)

2. Download the .UDC or .zip file to your computer’s hard drive in the UserDefinedContests directory in the N1MM
Logger+ user files area, which is normally located at C:/Users/username/Documents/N1MM
Logger+/UserDefinedContests. (Note: If you have moved the user files area during program installation or a
reinstall, perhaps to avoid problems with OneDrive, there may be more than one N1MM Logger+ folder in your
system; the one to download files to is the one that is pointed to from the Help > Open Explorer on User Files
Directory menu item.) If the file is a zip file, open it from Windows File Explorer and extract all of the files it
contains directly into the UserDefinedContests directory (not into a subdirectory, as Windows may offer to do);
after you do this, the UDC file should be visible in the contents of the directory. If there is a readme file, read it
and follow the instructions there (for example, it may tell you to move a .sec file to your SupportFiles directory)

3. Restart N1MM Logger+
4. Within N1MM Logger+, select >File >New Log in Database.
5. Find and choose the UDC contest name you downloaded (without the .UDC file suffix). It will be included in

alphabetic order among the list of all other supported contest names. NOTE: if you do not see the contest in that
list, use a text editor (Notepad) to open the UDC file. Find the “Name =” statement (around line 10 of the file)
which defines the actual contest name. In some instances the Name= statement may not match the Windows
.UDC file name.

6. If the contest files include a companion section list (.sec) file, you need to move/copy the .sec file to the
SupportFiles subfolder in the N1MM+ user files folder (the one pointed to by the Help > Open Explorer on
User Files Directory menu item). Then, launch N1MM+ and the >File >Open Log in Database contest dialog
window will display the “Import Section List” button. Click on that button to import the section list for this
particular contest. A list of available User Defined Contests is located on the Supported Contests List page (enter
udc in the search window).

1 Watt Game

The 1 Watt Game. Exch: RST+Power+FullLocator. Score: Distance between stations/power. Enter QSO score in ‘Score’ Field.

Filename: 1WATTGAME_VHF.udc

4 States QRP Group SSS

Exchange: Member send RS(T)+S/P/C+MemberNr – Not Member send RS(T)+S/P/C+power.

Filename: 4sqrp.udc

13 COLONIES Event

1-7 July. Exchange: RS(T)+State/Prov/Country

Read the Read_Me file
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FileName: 13COLONIES.udc in 13COLONIES.zip

50RS VHF

50MHz RASE DX Sprint

See the UDC file for more details
Filename: EARSVHF.udc

A1 AWT

A1 Club Weekly Test. Exchange:RST+Name. Callsigns are Mult once.

Filename: A1AWT.udc

ACHAMPCW

Asiatic Russia (UA9) Championship CW

See the UDC file for more details
Filename: ACHAMPCW.UDC

Activity Group CW – DL QRP-QRP Party

Held 1st May each year. (1MAY_AGCW)

Exchange: RST + Serial Nr + Category
See the rules for more details.
Filename: 1MAY_AGCW.udc

AGCW-NTC QSO Party.

AGCW-NTC QSO Party. Exchange: RST+Name/NM,  RST/Name/AGCWxxxx, RST/Name/NTCxxxx or 
RST/Name/AGCWxxxx/NTCxxxx.

Filename:AGCW-NTCQP.udc

Alexander Savenkov Memorial

Alexander Savenkov Memorial

See the rules for more details.
Filename: UR5IOK_MEM udc

AM Rally

AM Rally. Exchange:Name+City/Town+S/P/C+Station details

See the rules for more details. If you need a space in City/Town, use ?
Filename: AMRALLY.udc

AMSAT FIELD DAY

AMSAT_FD. Exchange: Satellite, FD-Class, ARRLSection, Grid – per mode/grid/satellite. If likely to change your Grid, setup
as Rover or Mobile.

Filename: AMSAT_FD.udc

ANZAC DAY

ANZAC DAY. Exchange: RS(T)+SerialNr/Grid(FT8)*WPX/band.

Filename:
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ANZAC-DAY.udc for VK&ZL Region SO/M1 stations
ANZACDAYDX.udc for NON VK&ZL Region SO/M1 stations
ANZACDAYM2.udc for VK&ZL Region M2 stations
ANZACDYDX2.udc for NON VK&ZL Region M2 stations

ARI-EME

U/VHF-ARI-EME  Exchange:RS(T)

Not perfect, but useful. Watch the Log Window to avoid analogue dupes.

Filename: ARI_EME.udc

ARKTIKA-SPRING

ARKTIKA-SPRING contest file

See the UDC file for more details
Filename: AC-SPRING.UDC + AC-SPRING.sec

AEGEAN RTTY Contest

Generic – RST and Serial Nr. Runs OK with a fixed amount of points per qso.
Select log type: AEGEANRTTY

See the UDC file for more details
Filename: AEGEANRTTY.udc

AGB

AGB-NEMIGA Contest. Third Friday of September (16 Sep 2011) 2100 – 2400 UT

See the UDC file for more details
Filename: AGB.udc

AGB NYSB/NEMIGA/PARTY

AGB NEMIGA, Allows RY and PSK modes. Select “MIXED+DIG” for “Mode Category”
Exchange: RS(T) + Serial Nr and AGB Member Nr (if a member)
Complete Contest name in log.

See the UDC file for more details
Filename: AGB_RTTY.UDC

AGB Party

AGB-PARTY (Activity Group of Belarus) Contest. Third Friday of December (16 Dec 2011) 2100 – 2400 UT

See the UDC file for more details
Filename: AGBPARTY.UDC

AGCW YL CW Party

AGCW YL Party. 1st Tuesday in March.

Exchange: YLs: RST + serial number starting at 001 /YL/name. Example: 579024/YL/Rosel. OMs: RST + serial number
starting at 001/name. Example: 589019/Otto
Filename: AGCW-YLCWP-yl.udc or AGCW-YLCWP-om.udc. Do NOT put both files in your UDC folder.

AGCW VHF – UHF Contests

Held quarterly.
Exchange: RS(T) + Serial Nr + Category + Full Locator

See VHF_AGCW.txt
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Filename: VHF_AGCW.udc in VHF_AGCW.zip

ALARA Contest

ALARA Contest. Exch: Member, RS(T)+SerNr+ALARA+Name. NonMember-YL, RS(T)+SerNr+YL+Name. OM,
RS(T)+SerNr+OM+Name

Filename: ALARA_YL.udc or ALARA_OM.udc in ALARA.zip

Alaska QSO Party

If using SSB/CW plus Digital, Select MIXED+DIG in the Contest Setup Window. Enter QSO points on logging line.
Select file name: AKQP_RTTY
Exchange: Serial Nr, Name and Grid Square

See the UDC file for more details
Filename: AKQP_RTTY.UDC

Araucaria VHF Contest

World wide VHF contest.
Exchange: RS(T) and 6 character Locator

See the rules for more details, follow directions after the contest to work out your claimed score.
Filename: VHFARAU_SA.udc

ARCK Morse Sings

Exchange: RST+ARCK#ARCK or RST+SerNr+RDA or RST+SerNr.

See the rules for full details/ Read the Read_Me file.

File Name. ARCK_MORSE.zip

ARGENTINA 40M Contest

LU 40M Contest Exchange: RS+ 2digit year licensed. 1 pt x Year.

Filename: LU7MC.zip

ARI BASSO FERRARESE Contest

Exchange: RS(T)+Serial# Wildcard stations will send op name.

See the rules for more details.
Filename: ARI_BASFER.udc

ARI RTTY 80/40m

(Set up for Italian domestic) ARI 80/40m RTTY Contest
Select file name: ARIRTTY
Exchange: Your Area Code

See the UDC file for more details
Filename: ARIRTTY.UDC

ARI SEZIONI Contest

ARI SEZIONI Contest

See the Read_Me file
Filename:ARI_SEZIONI.zip
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ARKTIKA Polar Radioman

Exchange: RST + Arktika Club Member Number e.g. 599 AC999. Non-members send RST + Serial Number. Club member
numbers are mults, once only.

See ARKTIKA_read-me.txt
Filename: ARKTIKAPR.zip.

ARRL-EME

VHF/UHF only, optional signal report, 4 character grid as exchange, dupes are not allowed on same band CW, SSB, FM and
Digi modes.

See the UDC file for more details
Filename: ARRL_EME.udc

ARRL International Grid Chase

RS(T)(optional) 4 Character Grid

See ARRL Web for full details
Filename: GRIDCHRTTY.udc in GRIDCHASE.zip

ARRL Volunteers On The Air

Exchange: RS(T). Special Stns RS(T)+I.D. e.g. 59 MEM.

Filename: ARRL_VOTA.udc

ARR PSK63

ARR PSK63 contest. discontinued.
Select log type: ARR_RTTY. Exchange RST and Serial. Multipliers are DXCC and “CT” Callsigns.

See the UDC file for more details
Filename: ARR_RTTY.udc

Balkan HF Contest

CW/SSB Exchange:RS(T)+SerialNr. Mults – Balkan WPX Prefix

See the rules for more details
Filename: BALKAN_HF.udc

Bande Basse Italia Contest

Italian internal contest

See the Read-Me file
Filename:BB_ITALIA udc in BB_Italia.zip

Batavia FT8 Contest

See the Read-Me file

Filename: BAT_FT8_YB.udc or BAT_FT8_DX.udc in BATAVIA_FT8.zip

Battle of Riachuelo Contest

See the rules

Battle of Riachuelo Contest

See the Read-Me file
Filename:CBNRBRASIL.zip
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Bavarian Contest Club Meteor Scatter Contest

Exchange: RST. In Exch Field, for ‘IARU’ procedure qsos, type ‘C’ for CW or ‘D’ for Data, leave blank for ‘BCC’ procedure
qsos.

Filename: BCC_MSC.udc

Bavarian Contest Club QSO Party (BCCPARTY)

Filename: BCC-QSO-Party.udc
Run logger and open new log for BCCPARTY contest
Import Call History file BCC-Members.txt
In the Config menu Enable CallHistory Lookup

Belgian Data Modes WW Contest

Belgian Data Modes WW Contest. If using AFSK, Select DIGITAL in the Contest Setup Window.

See the UDC file for more details
Filename: BDMWWRTTY.udc

Belgorod Open Champion Contest

Belgorod Open Champion Contest, Select MIXED+DIG in Contest Setup Window

See the rules for more details
Filename: BELGO_RTTY.udc in BELGOROD.zip

Brailei Cup

Brailei Cup Contest. Exchange: RS(T)+Nr+YO County. WAIT – under development

Number is Nr in call + age.

READ the Read-Me file.

Filename: Braileicup.zip

Brazil Independance Day Contest

Brazilian Independance Day PSK31 Contest. Select DIGITAL in Setup Window. v1.0.1,

See the UDC file for more details
Filename: BRAZ_IRTTY.udc

Brazilian Farroupilha Contest (FRPHF)

See the UDC file and the sponsors website for more details
Filename: FRPHF.zip

Bucuresti Contest

Now FT4 only, RST+SerialNr, no Mults. Set mode to DIGITAL. Use WSJT RTTY RU. xGeneric, Serial # and YO District or
Country WEB Identifier (e.g. Belgium=BE, Sweden=SE) as exchange.
If using Mixed modes, select MIXED+DIG in the Contest Setup Dialogue.x

See Bucuresti_Read_Me.txt file for more details (In Bucuresti.zip)
Filename: BUCUR-FT4.udc

CA HF

Central America contest. Exchange RST and Serial. Provinces and DXCC are mulpliers.

See the Rules for more details
Filename: CAHF.udc
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Carpathian Sprint

Carpathian Sprint. Exchange: SerNr+Previous SerNr (001 000 for first QSO). QSY after calling CQ exchange, repeat QSO OK
after 10 minutes.

Filename: Carpathian.udc

CAV Contest

OK/OM CAV Contest. Exchange: Members – RST+CAVxxx, non-members – RST+SerialNr.

Filename: CAVMEMBER.udc for members, CAVTEST.udc for non-members in CAVTEST.zip

CHILE-WPX Contest.

Exchange: RS(T)+ChileRegion/CQZone. Points vary, Mults CE – CE Region, DXCC and CQZn, DX – CE Prefix and CE
Region.

Filename: CE_WPX.zip

Championship of Astrahan oblast

Russian internal contest

See the UDC file for more details
Filename: R6U-Champ.udc

Chernozem Region Open Cup

Exchange: RS(T)+(CCR)RDA/Age

Filename: CHER-CUP.udc

CONCURSO NACIONAL FONIA

Spanish National Phone Contest (RADIO CLUB SEVILLA)

See the UDC file for more details
Filename: EACNF.UDC in CNF.zip

Contest Battle of JENIPAPO

Exchange: RS(T)+CQZone Mults WPXPrefix Band/Mode.

Filename: CBJ.udc

CQ WE

CQ Western Electric Contest. Ignore RTTY in the UDC name – use for all modes. Contact Employees, Retired Employees or
other Amateurs. Exchange Name, WE Locator and years of service. Non-employees give number of CQ WE Contests entered
(1 if current is the first, can be 1-6) If using all modes, be sure to select ‘MIXED+DIG’ on contest set-up page.

See the Read-Me file and the rules for full details.
Filename: CQWE_RTTY.udc in CQWE.zip

CSA-VHF

South American VHF contest

See the UDC file for more details
Filename: CSA-VHF.udc

CQ World Scouts

Exchange: RS(T)+Class
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Filename: CQWS.udc

CT QRP Club Contest

Exchange: RST + A(<1W) or B(qrp) + M, if a member of CT QRP Club. Held 1st May.

Filename: CT_QRP.udc

CUCALAMBE Contest

National Cuban contest \Cucalambe
Select log type: CUCALAMBE
Exchange: AREA Code
Import Section file (CUCALAMBE.sec required in N1MM Logger+ SupportFiles folder)

See the UDC file for more details.
Filename: CUCALAMBE.udc + CUCALAMBE.sec

Cup Chernigov CW

Chernigov Stations Exchange: RST+URDA

Others Exchange: RST+Serial Nr

Filename:
Chernigov Stations: CHERNI_CR.udc
Others: CHERNI_DX.udc
Send and Log leading zeros. Read – Chernigov_Read-Me.txt – Files in Cup_Chernigov.zip

CWOPS 10th Anniversary Celebration

CWOPS10

See the UDC file for more details
Contest name in Contest Setup Dialog: CWO10
Filename: CWOPS10_UDC.ZIP

DARC FT4 Contest

Exchange; 4 Character Grid. 1point*Prefix.

Filename: DARC_FT4.udc

DARC Thuringen Contest.

Exchange: DARC Members RS(T)+DOK Others RS(T)+SerNr

For DARC Ruhrgebiets – Exchange RS(T)+DOK/NM

Filename: DARC Members – DARC_X_DL.udc in DARC_X.zip

Filename: Others – DARC_X.udc

Filename: for DARC Ruhrgebiets – DARC_L.zip

DARC Funktag on Air

Exchange: RS(T)+DOK/NM non-DL send RS(T)+SerNr.

Filename: DARCFOA.zip

DARC HSW Contest

DARC HSW Contest.

Exchange: RS(T)+SerNr+DOK/NM non-DL -RS(T)+SerNr.
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Filename: DARC_HSW.udc in DARC-HSW.zip

DEUTSCHLAND EASTER CONTEST

Deutschland Easter Contest.
Exchange: RS(T) + DOK/NM. Non-DL RS(T)+Serial Nr.

Filename: DARC_EASTER.zip

DigiFest

Digifest Contest. Exchange: RSQ and Locator(4 digits) Locator is mult (once only). Work Station each band and mode. Note1
– In the ‘Set up Contest Window’ Set the Mode Category to ‘DIGITAL’. Note2 – not all digital modes allowed in the contest are
supported in MMVARI, most are in FLDIGI.

See the UDC file for more details
Filename: VHF_DFRTTY.UDC

DIG QSO Party

 Exchange: RS(T)+Member# or only RS(T).

Filename: DIG.udc

DIG_PA Contest

DIG_PA Contest
Select log type: DIG_PA
Exchange: RS(T) and Member Number or just RS(T) if not a member.

See UDC file for more details.
Filename: DIG-PA.udc

DL DTC Contest

German Telegraphy Contest, held 3rd October.
Select log type: DL – DTCDL.udc non-DL – DTCDX.udc
Exchange: RST and LDK, non DL only RST

Filename: DL-DTC.zip

DNIEPER CUP

DNIEPER CUP. Send and receive two-letter AREA + Serial Nr. Set Mode to SSB+CW+DIGITAL in Contest Setup Window.
v1.0.3
Select file name: DNIEPERTTY.
Sent Exchange: Serial Nr -must be first and a two letter Area or District or County Code. Set your Macro to send AREA then
SerNr

Filename: DNIEPERTTY.UDC

Days of Young Ladies Contest

Work same station each band and mode. If using all modes (CW, RY & SSB.) select SSB+CW+DIGITAL when setting up.

Exchange:RS(T) + YL or OM.

Filename: DOYLS_OM.udc, DOYLS_YL.udc in DOYLS.zip

See the Read-Me file

DU3MY Memorial Contest

Exchange: Exchange: RS(T)+DU Zip Code, Non-DU send RS(T)+0000
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Filename: DU3MY.udc in DU3MY_MEM.zip

EA QRP Contest

Exchange: RST + Category + M (if a member)

See the Read-Me file and rules for more details
Filename: EA_QRP.udc in EAQRP.zip

EA CW MEET

Exchange; RST+EACW#+Name/Name+Prov/Name+DXC.

Filename: EACWMeet.udc

EPC French DX Contest

EPC French DX Contest. Select log type: See Read-Me.txt in EPCFR.zip. Exchange Call, RST, Dpt. Nr. or Serial Nr.
After the contest, edit CATEGORY-OPERATOR: SOAB-HP, SOAB-LP, MOAB-HP in log (see rules).

See the Read_Me file for more details. N1MM+ v4698 or later.
Filename: EPCFR.zip

EPC Ukrainian DX

Set of files for EPC Ukraine DX Contest (for participants outside of Ukraine). See the post on 11/29/2011 in N1MMLogger-
Digital@yahoogroups.com for installation instructions

See the UDC file for more details
Filename: EPCUkrDX_FOR_DX.zip

Esenin Russia Contest

Esenin Russia contest. SSB/CW 80+40M. Mults are Russian Regions and DXCC. Band and Mode restrictions.

Exchange: RS(T) + Serial Nr

File Name: ESENIN udc

ES OPEN HF

ES Open HF Championship

See the Read_me.txt file for more details
Filename: ES_OPEN_DX.udc or ES_OPEN_ES.udc

EUCW Fraternizing Party

EUCW Fraternizing Party. Whatever is entered in Comment (Club Name) is a multiplier.
Select log type: EUCWFP
Exchange: Your name, (Club name), Member Nr. or NM

See the UDC file for more details
Filename: EUCWFP.udc

EUCW ON5ME-160

EUCW ON5ME-160 Party. Whatever is entered in Comment (Club Name) is a multiplier.
Select log type: EUCW160
Exchange: Your name, (Club name), Member Nr. or NM

See rules for more details.
Filename: EUCW160.udc
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European Union DX Contest

Sponsored by the European DX Contest Club

Select log type EU_DXC

Exch: RS(T), EU Region I.D. or ITU Zone for non-European stations.

Filename: EU_DXC.udc in EUDXC.zip
See EUDXC-ReadMe.txt in EUDXC.zip for more details

FELD HELL CLUB

Monthly Sprints. See the Read-Me file.

See the rules for more details.
Filename: FELDHELLCLUB.zip

FGUP 2011

“Generic” contest, RS(T) and Serial Nr Exchange, All Callsigns are Multipliers.

See the UDC file for more details
Filename: FGUP-2011.UDC

FIRAC Contest

Exchange: Members send; RS(T) + Serial Nr + F, Non Members send; RS(T) + Serial Nr.

Filename: FIRAC.udc

First Space Flight Cup

Exch: RS(T)+SerialNr. (CW, SSB, PSK63) DXCC and OBLASTs are Mults. 80m-20m.

Filename: F_S_F_CUP.udc

Fists Sprints

All Fists Sprint Contests. Exchange RST, Name, Fists Member Nr – non members leave blank, S/P/C.

Filename: FISTSSPR.udc

Flight of the Bumblebees

Flight of the Bumblebees contest.
Select file name: FLTOTBBS
Exchange: State/Province/DXCC Entity and Power or Bumblebee Nr.

See the UDC file for more details
Filename: FLTOTBBS.udc

Florida Parks on the Air

Florida Parks on the Air

See the rules and the Read-Me file.

Filename: FLSPOTA.zip

FOC Memorial Day QSO Party

Exchange: RST+QTH+NAME+SK C/S+COMMENT.

Filename: FOC_MDQP.udc
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FRAPR 10M Contest

Exchange: RS(T)+Power. KP4FRA, 10pts, KP4, 5pts, Others 3pts.

Filename: FRAPR_10M.udc

French National Castle Day

Exchange:RS(T)+CastleRef/Fdept/SerialNr. Mults-Castles(x10)+Dept+DXCC

Filename:DFCF.zip

French Mills On The Air

Exchange:RS(T)+MillRef/Fdept/SerialNr. Mults-Mills(x10)+Dept+DXCC

Filename: DMF.zip

FRR CN US Contest

SEE YO_ CN_US.zip 30 minute sessions. First Exchange: Serial Nr and 3 digit Nr made up from Nr in Callsign and op age.
e.g. YO9xx sends 001 959, if he rcvd 001 345, his next sent Exch would be 002 345 etc. CW – 1st and 2nd Monday March,
SSB – 1st and 2nd Monday October.

See the rules
Filename: YO_CN_US.zip

G3ZQS Memorial Contest

Fists G3ZQS Memorial Contest, can be used for Fists Sprints.
Exchange: RST, State/Prov/DXCC, Name, and Fist# or Power

See the UDC file for more details.
Filename: G3ZQSMEM.udc

GEDEBAGE

Generic, RS(T) + Serial Nr. WPX Prefix Mult.

Filename: GEDEBAGE.udc

GENERIC

Template for Serial # and State(Prov) as exchange. One multiplier – Section

See the UDC file for more details
Filename: Generic.udc

GENERIC2

Template for Serial # and State(Prov) as exchange. 2 multipliers: Section and Country

See the UDC file for more details
Filename: Generic2.udc

GENERIC RTTY

Generic, Serial # and State(Prov) as exchange

See the UDC file for more details
Filename: GenericRTTY.udc

HA National Championship OB

Exchange: RS(T) + Serial Nr. Start a new contest for each mode.
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See the Read_Me file for more details
Filename: HA_NChamp zip

HA3NS Memorial Contest

Exchange RST and HACWG Member Nr or NM

See the UDC file for more details
Filename: HA3NS.udc

HamCation QSO Party

Exchange: RS(T)+Name+State/Prov/DXc+Temperature.

See the Rules and the Read_Me file. Place all files in their correct folders, enable Call History if necessary.

Filename: Hamcation.udc in Hamcation.zip

Hamvention QSO Party (HVQP)

Modes: CW and Phone
Saturday, May 16, 2020
12 hours – 12:00utc to 24:00utc (8am-8pm EST)
Exchange: RST signal report and year of first Dayton Hamvention attendance. If you have never attended Hamvention
send “2020.”
Multiplier: +10 points for working DARA club station W8BI
See the UDC file for more details
Filename: HAMVENT_QP.UDC — click HERE

Halifax Amateur Radio Club 90th anniversary QSO Party.

Exchange: RS(T)+S/P/C 1pt*S/P/C.

Filename: HARCQSOP.udc

Hessen Contest

Exchange; DL – HF RS(T)+DOK/NM,  VHF RS(T)+DOK/NM+Locator, Non-DL RS(T)+NM – NM+Locator. 3rd Weekend May.
tnx dl3fcg

Filename: HF Hessen-HF.udc. VHF Hessen-VHF.udc – in HESSENCONTEST.zip. See the Read-Me file.

HF Region 2 RTTY Contest

Exchange: Full Locator

See the Read Me file for more details.
Filename: VHFR2RTTY.zip

HINA33

JLRS Hina 33 Contest. Multi Band, CW&SSB Contest. No RTTY, work once each band.
Exchange: YLs send RS(T) and YL, OMs send RS(T) only.

Filename: HINA33RTTY.udc

Hiram Percy Maxim 150th Birthday (HPM150)

See the UDC file for more details
Set the >Contest >Exchange to your ARRL section! (MI, ON, WTX…)
Filename: HPM150.zip
August 31 through September 8, 2019
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ICWC-Medium Speed Test

ICWC MST Every Monday 1300-1400 and 1900-2000UTC, Tuesday 0300-0400Z.  Exchange: Serial Nr+Name.

Filename: ICWC_MST.udc

INDEXA QSO Party

INDEXA Worldwide QSO Party. Exchange:RS(T)+N/M/O+S/P/C Non member 1pt, Member 3pts, Officers 25pts. Mults S/P/C

See the rules for more details.

Filename: INDEXAQSOP.udc

Interest Group RTTY Contest

Exchange: RST+Year first licenced. 1Pt*Year licenced.

See the rules for more details.

Filename: IG_WW_RTTY.udc

International 2010

SWL template, both Callsigns, RS(T) and Serial numbers are logged

See the UDC file for more details
Filename: SWL.udc

International Lighthouse Week 2010

International Lighthouse Week (Serial#, Name, Member# as applicable, Lighthouse# as applicable, State(Prov), as exchange)

See the UDC file for more details
Filename: ILLW-2010.udc

Indonesian DX Contest

Indonesian DX Contest for DX (NON-Indonesian stations) Work anyone.

Exchange: RS+Serial Nr. YB Prefixes and Country multipliers. Remember to set for correct Mode when setting up.
Filename: YBDXC.udc

Indonesian DX Contest

Indonesian DX Contest for YB (Indonesian stations) Work anyone. Remember to set for correct Mode when setting up.

Exchange: RS+Serial Nr. World Prefixes and Country multipliers
Filename: YBDXCYB.udc

Indonesian JAKARTA DX Contest

Indonesian JAKARTA DX Contest, 40M only, SSB only, work anyone, 2nd weekend in May.

Exchange: RS + Serial Nr. WPX and DXCC multipliers.
Filename: JAKARTA.udc

Invalid Section Errors?
To verify valid sections, HPM150 UDC relies upon the section list from the Winter Field Day contest: WinterFD.sec.
That file is included in the HPM150.ZIP file. After unZIPping the file you need to move/copy the WinterFD.sec file to
the SupportFiles subfolder in the N1MM+ user files folder (the one pointed to by the Help > Open Explorer on
User Files Directory menu item). Then, launch N1MM+ and the >File >Open Log in Database contest dialog
window will display the “Import Section List” button. Click on that button to import the valid section list.
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Indonesian Padang DX Contest

Indonesian Padang DX Contest, 40M only, SSB only. 3rd Weekend December.

Exchange: RS + Serial Nr
Filename: PADANG_DX.udc

International Police Association Radio Club Contest

International Police Association Radio Club Contest, open to all.

Exchange: RS(T)+Ser Nr. +(if Member) IPA + State/Country Prefix (e.g. IPAFL or IPAG)
Filename: IPA_RC.udc

IRTS80M

IRTS 80 Metres Counties Contest. CW/SSB, 80m only, Serial # and County as exchange

See the UDC file for more details
Filename: IRTS80M.udc

IRTS CQIR

IRTS CQIR Contest
Select File name: IRTSCQIR
Exchange: Irish – Serial and County Code, Others – only Serial

See the UDC file for more details
Filename: IRTSCQIR.udc

Istra Open Contest

Exchange: RS(T)+4Grid. 1point*4Grid

Filename: IOC.udc

Italian Naval Old Rhythmers Club

Exchange :Members RST+NavalNr, Non-members RST+SerialNr.

Filenames: INORCM.udc (member) INORCN.udc (non-member)

JLRS Party Contest

Exchange:RS(T)+M or Y, OM RS(T) only. Mults – WPX. See the Read-Me file.

Filename: JLRSPARTY.zip

Jamboree on the Air

Exchange: Name/Age/JamPuz. Make contact Band and Modes, CW,FM,SSB,FT8&RTTY. 1point/qso. Mults –
DXCC+JamPuz.

Filename: JOTA-JOTI.udc

JW-FD

JOCK WHITE MEMORIAL FIELD DAY (NZART). 80/40m, SSB/CW, Report/Serial #/Branch # as exchange, 1 hour sessions

See the UDC file for more details
Filename: JWFD.udc

K1USNSST

K1USN CW Slow Speed (con)Test.
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Exchange: Name + State/Province/DXc

Filename: K1USNSST.udc

K1USNSSTOP

K1USN CW Slow Speed (con)Test Open. Exchange: Name + State/Province/DXc

Filename: K1USNSSTOP.udc

Kanagawa

Internal JA contest

See the UDC file for more details
Filename: kanagawa.udc you also require kanagawa.sec

Kanham Contest

Read the rules

Filename: KANHAM.zip

KCJ

KCJ(Keymen’s Club of Japan) contest. Version for the rest of the world (not JA), Prefecture as exchange

See the UDC file for more details (outdated)
Filename: KCJ.udc

Keymens Club of Japan

KCJ (Keymen’s Club of Japan Contest).
Select file type: KCJ_JA or KCJ_DX as appropriate.
Exchange: JA – RST+Prefecture or District Code, Others, RST+CQ Zone.
See KCJ-DX.UDC for Non-JA entrants. v1.0.2; KCJ_JA.UDC for JA entrants.

Don’t forget the Section file. KCJ.sec
Filename: KCJ_DX.udc or KCJ_JA.udc

Keymens Club of Japan Top Band Contest

KCJ (Keymen’s Club of Japan Top Band Contest).
Select file type: KCJ_TB_JA or KCJ_TB_DX as appropriate.
Exchange: JA – RST+Prefecture or District Code, Others, RST+CQ Zone.
See KCJ_TB_DX.UDC for Non-JA entrants. KCJ_TB_JA.UDC for JA (Z25) entrants.

Don’t forget the Section file. KCJ.sec (link above)

Filename: KCJ_TB_DX.udc or KCJ_TB_JA.udc

KOMI RUHR Qso Party

Exchange: RS(T)+Komi RDA/Ruhr DOK/SerialNr. See KOMI_RUHR_Read-Me.txt. 2nd Saturday October.

Filename: KOMI_RUHR.zip

KT Serbia Cup

KT Serbia Cup Contest. Exchange: RS(T)+SerNr(+YU Region I.D.) 3rd Weekend Sept.

See KTKUP.txt in KTKUP.zip
Filename: KTKUP.udc or KTKUP_YU.udc
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LABRE_DX Contest

Labre DX Contest. Exchange: RS(T)+PYstate/Continent. various points x PY states+DXCC band and mode. v10294 required.

Filename: LABRE_DX.zip

LABRE-RS DIGI Contest

Exchange: 4 character Grid. 1pt + 1pt RIO Grande stations(e.g. PY3x)2, Must load LABRE-RS_cty.dat. Mults Large Square.

Filename: LABRE_RSDG.ZIP

Latvian Mechanical Key Party

Exchange: RST+Age+Category – (B (bug), C (cootie/side swiper) or S (straight)).

Filename: MK_PARTY.udc

Lighthouse Christmas Lights 2010

Lighthouse Christmas Lights 2010

See the UDC file for more details
Filename: LCL-2010.udc

Lighthouse Spring Lites 2010

Lighthouse Spring Lites 2010,

See the UDC file for more details
Filename: LightHouseEvent.udc

Lithuanian Cup Contest

Lithuanian Cup Contest
Select file type: LYxxCUP (on-site) – LYCUP others
Exchange: RS(T)+Serial Nr.

See the Read-Me file for more details
Filename: LYCUP.zip

Loano MCD Qso Party

Loano MCD Qso Party. Exchange:RST+MemberNr/SerialNr. replaced with Marconiqpd.

Uses a Bonus.txt file. See the Read-me file.

Filename: Loano_MCD.zip

LY WAL Contest

LY WAL Contest (Worked All Lithuania)
Select file type: LYWAL
Exchange: LY – WAL Area, Others, DX

See the UDC file for more details
Filename: LYWAL.udc you will also need LYWAL.sec

Marconi Club QSO Party Day

Exchange: RST+MC+#/SerialNr

When setting up, click the ‘Import Section File’ button.
No button – check you have put the section file in the correct folder.
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Filename: MARCONIQPD.zip

See the Read-Me file.

Marconi Memorial Contest

Marconi Memorial Contest. Generic, RST+Serial NR Exchange, CQWW-type Country Prefix as Multiplier

See the UDC file for more details
Filename: MARCONIMEM.udc

Memory Lives Forever Contest

Memory Lives Forever Contest. RS(T) and Op Age MAY Also Send and Rcv S.K. Callsign & Age. e.g. 559 79 G8FW 88 as
exchange.

Filename: MEMORY.udc

Michurinsk Contest Group Autumn Sprint

Autumn Sprint. CW and SSB. Exchange RS(T)+Serial Nr. Mults are DXCC and Oblasts

See the Rules
Filename: AUTUMN_SPR.udc

Masonic Lodges On The Air

Exchange:Lodge(State+Nr)or State/DX e.g. OH248 or TX or DX tnx, n9fn

Filename: MLOTA.udc

Maidenhead Mayhem

Exchange: Your four character grid square.

Filename: MM.udc

MOON CONTEST

MOON CONTEST
Select file type: VHFMUNRTTY
Exchange: Serial Nr + 6 Character Locator + Name of QTH
Note =Use for all – restrict Band to suit.

See the UDC file for more details
Filename: VHFMUNRTTY.udc

Moscow-Championship

Moscow Championship. Oblast(Rus) and Serial # as exchange. Oblast and every Moscow (MA) callsign is multiplier

See the UDC file for more details
Filename: Moskwa_Champ.udc

Memorial Contest-DL6RAI

DL6RAI Memorial Contest. Exchange: RS(T) + Year of first QSO with Ben(2digits)/NQ/4char Locator FT modes.

Filename: MRAI.zip

MULAN WAP

Worked All China Provinces (MULAN DX) Contest. 80,40,20,15,10m SSB/CW,Province/SerialNr

See the Read-Me file for more details
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Filename: WAPC_BY.udc

Mecklenburg Vorpommern Contest

Exchange: RS(T)+SerNr(+DOK/NM)(+Locator (VHF))

Filename: MVP_UKW.udc

NA Meteor Scatter Sprint

Exchange: RST+4Char Grid. Points by band per Km x Band Factor.

Filename: VHF_NAMSS.udc

Natal Digital Group PSK125

Now a DIGITAL Contest

See the Rules and Read-Me file
Filename: NDGPSKRTTY.zip

NCCC FT4 Sprint

NCCC_FT4 Sprint. Exchange:4 Character GRID. 1point*Grid/Band

Filename: NCCC_FT4.udc

North American QRP CW Club Sprints.

Exchange: RST, State/Province/DXCC and Member Nr. or Power (include the ‘W’)

See the rules for more details.
Filename: NAQCC.udc

NAURYZDX – Central Asia Nauryz Contest

Exch: RS(T)+Oblast or ITU Zone.

See the UDC file for more details
Filename: NAURYZDX.ZIP

New Jersey NJQRP Skeeter Hunt Contest

Exchange: RST, S/P/C or NPOTA Designator(for 2016 only), Skeeter number/Power.

Filename: SKEETER.udc

NRL Cup

(Russian internal contest).

See the UDC file for more details
Filename: NRLC.UDC

NRRL TELEFONITEST

NRRL (Norsk Radio RelÃƒÆ’Ã†â€™Ãƒâ€šÃ‚Â¦ Liga) TELEFONITEST
(Internal Norwegian Contest)

See the UDC file for more details
Filename: NRRLTELE.udc don’t forget NRRLTEL.sec

NTC Anniversary Party

NTC Anniversary Party.  Exchange: RST+Name+NTC#/NM.
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Filename: NTC_JAN_AP.udc

NTC Qso Party

NTC QSO Party. Exchange:RST+Name+NTC#/NM +any comment.

Filename: NTC_QP.udc

NZ Sangster Shield Contest

Exchange: RST+SerNr(+NZ stns Branch#)

Filename: NZ_SSC_NZ.udc for NZ Stations, NZ_SSC_DX.udc for non-NZ Stations, in; NZ_SSC.zip

NZART WW11 Memorial and VHF and up Contests.

See the Read_Me file
Filename: NZART.zip

OBLAST

Use as a template – serial # and Oblast(Rus) as exchange. Oblast is multiplier

See the UDC file for more details
Filename: Oblast.udc

OH Domestic Events, Easter, Sainio, Summer, Autumn and Xmas.

Exchange: RS(T) Serial Nr. and County Code.

See the ReadMe.txt file.
Filename: FINNdom.zip

OH-PARKS

OHIO State parks are multipliers. 1 point per every QSO

See the UDC file for more details
Filename: OH-Parks.udc – download/copy this file to the UserDefinedContests subfolder in your N1MM+ user files
folder (the one pointed to by the Help > Open Explorer on User Files Directory menu item)
Section filename: OH-PARKS.sec – download/copy this file to the SupportFiles subfolder in the N1MM+ user files
folder.

OK-OM DX SSB

OK-OM DX SSB Contest. (Note: OK/OM DX CW contest now has same rules – use these files for both events). (2024)

OK-OM Stations send RS(T) + County Code, Others send RS(T) + Serial Nr. CQWW and County Codes are Mults. When
setting up, be careful to choose the correct Contest option – see below.

See OKOM DX SSB.txt in OKOM DX SSB.zip
Filename: OKOMDXS.udc (OKOM DX SSB/CW Contest OKOM Station) or OKOMDXS_DX.udc (OKOM DX Contest
(NON-OK/OM Stn) do not extract both udc files.

OK1WC Memorial

OK1WC Memorial Contest. Callsign last letter is Multiplier.

Exchange: RS(T)+Serial Nr
Filename: OK1WC.udc

OK/OM HOLINESS CUP CHALLENGE

(Holicky Pohar) Exchange:RS(T)+DistrictCode 1pt*DistCode. OK/OM Stns only.
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Filename: OKOMHOLPO.udc

Old New Year

RS(T) and NR (Age of OP. plus Years of Experience) as exchange
Select file name: OLDNEWYEAR
Exchange: Serial Nr and (Total of your Age + Number of Years YOU have held Licence).

See the UDC file for more details
Filename: OLDNEWYEAR.udc

OM Activity Contest

OM Activity Contest. Callsign last letter is Mult. (tnx OM4TQ)

Exchange: RS(T)+Serial Nr
Filename: OMAC.udc

OMISS QSO Party

OMISS QSOP. Exchange: RS+S/P/DX+OMISS#

See the Rules and Read-Me file.

Filename: OMISSQSOP.udc in OMISSQSOP.zip

Original QRP

O R I G I N A L – Q R P – C O N T E S T. Serial # and Category (VLP, QRP or MP) as exchange

See the UDC file for more details
Filename: OQRP.udc

Open Season Ten Meter Qso Party

Exchange: Name+S/P/C+All Club Member# (1010-070-EPC) e.g. Don TX 10000-900-900) Enter number of club Nrs in
‘Points’ Field (1,2 or 3).

Filename: OSTM-QP.udc

OZ-EDR_JUL-NYT.zip

Danish EDR JUL and NYT Events.

OZ ACTIV Contest

(Danish Internal Contest?)
OZ Activity Contest (Serial # and Post Code (first digit) as exchange)

See the UDC file for more details
Filename: OZACTIV.udc

OZCHR-VHF

OZCHR-VHF (Russian VHF contest).VHF bands only, 6 char. GriqSquare as exchange, dupes are not allowed on same band
different modes

See the UDC file for more details
Filename: OZCHR_OCHN.udc

Parks On The Air

Parks on the Air. Records RS(T) + opName + POTARef (as x-xxxx) and if new POTA. v1.0.5 Treat a 2fer as a Rover.

Filename: POTA.udc (original) alternative POTA-ve3fp.udc
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PACC DIGI

PACC Digi Contest. FT8 & RTTY. Exchange:  PA Stations (RST)+2 Character Province,  non-PA Stations (RST)+SerialNr.  PA
3points, Others 1point. Mults PA Provinces – band and mode.

Filename: PACCDIGI.zip

PARLA

PARLA(EA) CW CONTEST

See the UDC file for more details
Filename: PARL.UDC

Pro CW Contest

CW or Digi.  Exch: RST+SerNr+/M – if a member of any CW/DIGI Club.  CW 1st Weekend December, Digi 2nd Weekend
January.

See the rules for more details
Filename: PCC_MEM.udc (members) PCC_NM.udc (non-members) in PCC.zip. See the Read-Me file.

Phone Fray

Weekly Phone contest. Exchange: Name + S/P/C Name only for non-NA stations.

Filename: PHONEFRAY.udc

PN QUICK CW Contest

Short Portuguese CW Contest. Members send PN Number, Others send Serial Nr.

See the Read-me file for more information.
Filename: PN_QUICKCW.udc or PNMQUICKCW.udc (in zip file)

Portuguese Navy Day Contest

Naval Clubs Members send RS(T)+Club I.D.+#, others send RS(T)+SerialNr. PN Club Members are not mults now, but the
Section file is still required to score correctly.

Download PND.zip
Filename: PND_M_RTTY.udc or PND_NMRTTY.udc

PODXS 070 Contests

Use for several PODXS070 Club contests. Exchange Call, RST and State/Province or DXCC Entity. Use for PSK Festival, Jay
Hudak Memorial, Pumpkin Sprint and Firecracker

See the UDC file for more details
Filename: PODXS1RTTY.udc

PODXS 070 St. Patrick’s Day Contest

Use for PODXS070 Club St. Patrick’s Day Contest. Exchange Call, Name, State/Province or DXCC Entity and Member Nr.

See the rules for more details
Filename: PODXS2RTTY.udc

PODXS Triple Play Low Band Sprint

PODXS070 Club Triple Play Low Band Sprint. Select log type: 070TPRTTY. Exchange Call, RST and State/Province/DXCC
Entity.

See the PODXS Website for more details
Filename: 070TPRTTY.udc
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PODXS Three Day Weekend Contest

PODXS 070 Club Three Day Weekend Contest. First Friday after Memorial Day. Exchange Member# or 0000.

See the PODXS Website for more details and PODXS_TDW-ReadMe.txt in PODXS_TDW.zip
Filename: PODXS_TDW.udc in the zip file.

PODXS Valentine Sprint Contest

PODXS070 Club Valentine Sprint. Select log type: 070VSRTTY. Exchange Call, Name, OM/YL and State/Province/DXCC
Entity.
After the contest, edit “YL”s to 2 points. Complete Contest name in log.

See the UDC file for more details
Filename: 070VSRTTY.udc

POPOV YOUTH CUP

POPOV YOUTH CUP

Exchange: RS + Serial Nr + Last Serial Nr received (as LZ Open – start with 001 000)
Filename: POP_YTHCUP.udc

Popov Memorial

POPOV MEMORIAL CONTEST – RS(T) and NR (Years of Experience) as exchange

See the UDC file for more details
Filename: PopovMemorial.udc

POPOV-VHF

(Russian internal VHF contest). 2M only, serial # and GriqSquare as exchange, dupes are not allowed on same band CW,
SSB and FM modes

See the UDC file for more details
Filename: Popov_Cup_VHF.udc

Primorsky HF Contest

See the UDC file for more details
Filename: PRIMOR_HFC.udc

PSK 31 Flavors

31 FLAVORS CONTEST (PODXS). Former name – FLAVORSPSK.udc,
Select file type: FLAVORRTTY
Exchange: State/Province or DXCC Entity + 070 member number/Name, if not member

See the UDC file for more details
Filename: FLAVORRTTY.udc

PW 144 and 70Mhz

PW 144 and 70Mhz.
Select file name: PW_144_70
Exchange: Locator. 4 Character Square

See the UDC file for more details
Filename: PW_144_70.UDC

QO-100

Exchange: 4Grid only. 1point – Mults 4Grid+DXCC once.
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Filename: QO-100.udc

QRP-AFIELD Contest

QRP-AFIELD Contest, Exchange: RS(T)+S/P/C+NEQRP#/Power. Scores as qrp, fixed.

Filename: QRP-AFIELD.udc

QRP HF RTTY

QRP HF RTTY Contest.
Exchange: RST and CQ Zone

See the UDC file for more details
Filename: QRPHFRTTY.UDC

R3A Cup Digi

R3A Cup Digital Contest
Exchange: RST and Oblast or Serial Nr

See the Read Me file in R3A_CDRTTY.zip
Filename: R3A_CDRTTY.udc

R3E SC

Russian internal contest See the UDC file for more details

Filename: R3E-SC.UDC

R3L_HF_CUP – Smolensk HF Cup

See the UDC file for more details
Filename: R3L_HF_CUP.udc

R4C Champ

Russian internal contest

See the UDC file for more details
Filename: R4C_SA.udc for R4C Stations R4C-Champ.UDC for Non-SA.

R4W (Udmurtia, Russia) Open Championship

Russian internal contest

See the UDC file for more details
Filename: r4w-champ.udc

R6H Champ

Russian internal contest

See the UDC file for more details
Filename: R6H-Champ.UDC

R9S Champ

Exchange:SerialNr+RDA/4character Grid.

v9440 required.

Filename:R9S-CHAMP.udc
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Radio Club Region Murcia Sprint

Exchange: RS+EA Municipality (example MU)+Full Locator/SerialNr+Full Locator.

See the ReadMe file.

Filename: SprintRCRM.zip

Radio Club of America Transatlantic QSO Party

Exchange:RS(T)+RCA/S/P/CQZone.

Filename: RCA_TQP.udc

RANDOMGRAM

Exchange: Send/Receive RST+random groups (5 characters). Earn extra Pts recording other exchanges.

Filename: RANDOMGRAM.udc

RCWC 4 Seasons

Russian 4 Seasons Contests

See the Read_Me file for more details
Filename: RCWC4.zip

RCWC MINITEST

Filename; RCWC_MINIm.udc for Members, RCWC_MINI.udc for non-members
Exchange: RST+CMxxx or Serial Nr. Uses Call History Multipliers. See the Read-Me file.

RCWC RPX Contest

Russian CW Club RPX Contest. Exchange; RST+SerNr.

See the rules for more details
Filename: RCWC_RPX.udc

REGION-NR

Russian internal contest

See the UDC file for more details
Filename: REGION-NR.udc

Ross A Hull Memorial

Exchange: RS(T)+SerNr+Full Locator. 1pt/100km. Band Mults. All January.

Filename: RAHULL_VHF.udc

RSGB 40m QSO Party

RSGB 40m QSO Party. Exchange; RS + Name (Please keep to 8 characters or less)

Filename: RSGB_40QP.udc

RSGB FT4 Contest Series

A series of short duration events to allow entrants to experience the latest machine-generated contest mode. As this series is
experimental, there are likely to be changes as we develop experience with this mode, so please check the rules prior to each
event

Exchange; Report only.
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Filename; RSGB_FT4.udc (in RSGB_FT4.zip)

RSGB HOPE QSO Party

A series of short QSO party style weekday contests. (Use for RSGB GOTA4C series, edit Contest name in Cabrillo file)

Anyone works Anyone. Exchange – CW& SSB RS(T)+SerNr. – FT4  Signal report+4-Character Locator.  Points vary Band &
Continent.  Mults – DXCC/Grid .

See the Read-Me file.

Filename: RSGBHOPEQP.zip

RSGB FT4 International Activity Day

Anyone works Anyone. Exchange: RST only.

Filename: RSGBFT4IAD.udc

RSGB UKAC (VHF)

RSGB UKAC (VHF). VHF+ only, Points per Km and UK GridSquare multiplier

See the UDC file for more details
Filename: VHF_Paul4.UDC

RSGB VHF Contests

One Generic, Exchange RS(T), Serial Nr and Full Locator. 1 Point/Kilometer. No Multipliers.  For Christmas Cumulatives 2021-
use ‘M4’ file.

See VHF_RSGB_ReadMe.txt in VHFRSGB.zip for other RSGB VHF Contests covered.
Filename: VHFRSGB.zip

RTC_PARTY

DL RTC Party. Exchange: RST (+Member Nr) + 4 Character Grid

See the rules for full details
Filename: RTC_PARTY.udc

RUSSIAN160

RUSSIAN 160 m contest (Contest Board will calculate points)

See the UDC file for more details
Filename: RUSSIAN160.UDC

RTTY OPS Weekend / Weekday Sprint

Every Sat. 1600-1959. 80-10m. / Every Friday 0145-0215

Exchange: BOTH C/S+SerialNr+(Nick)Name+Full Locator. / Name+State or Ctry Prefix

Filename: RYO_WS_VHF.udc

For WEEKDAY Sprints: RY_OP_WDS.udc

South America CW Contest

Exchange: RST+(non-member)IARU Zn/(member)M/QRP/YL

Filename: SACW.udc
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Serbian CW Club Short Wave Contest

Exchange: RST+SerialNr/MemberNr(Mxx) 
Filename: KTSCWC_MEM.udc for Members. KTSCWC_NM for non-members.
See the Read-Me file. Files in KTSCWC.zip

SM Monthly Test

SM Monthly Contest. Exchange: RS(T) + Serial Nr + Full Locator.

See the rules for full details
Filename: SM_MT.udc

South America 10 Meter

South America 10 Mtr. Exchange: RS + CQ Zone.

See the rules for more details.
Filename: SA10M.zip

SALMON-RUN

This contest is published for learning purposes only. WA QSO party (aka Salmon Run) is fully supported by the logger

See the UDC file for more details
Filename: Salmon_Run.udc

SARA Spring Sprint

SARA Spring Sprint. Exchange: RST, Locator and Class, Locator and WPXprefix are Mults
Select file name: SARA
Exchange: Your Locator and Class of entry.

See the UDC file for more details
Filename: SARA.UDC

SARA Spring Sprint (OM)

SARA Spring Sprint (for OM stations). Exchange: RST, Locator and Class, Locator and WPXprefix are Mults
Select file name: SARAOM
Exchange: Your Locator and Class of entry.

See the UDC file for more details
Filename: SARAOM.udc

SARL Contests

Several SARL Contests. See the Read_ME file in SARL.zip

Filename: SARL.zip

Sasquatch Stomp

Exchange: RST+S/P/C+SS#or last 3 of zip or rst rcv/Name. Work same Stn after 1hr(same band) Work with Caps Lock on.

Filename: SASQUATCHS.udc

SCAG SPRINT

SCAG Sprint Cup
Select file name: SCAG
Exchange: Name + Member (SCAG Club) Nr or NM

See the UDC file for more details
Filename: SCAG.udc
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Seanet Contest

Seanet Contest , RST + Serial as exchange, DXCC Countries as Multipliers.
Seanet Countries use SEANETRTTY.UDC; Non Seanet countries use SEANETRTTY2.UDC (Rename to SEANETRTTY.udc
after copying to N1MM\UDC folder)

See the UDC file for more details
Filename: SEANETRTTY.udc

SDXC

Scottish DX Contest, RS(T) + GM Area Code or Serial Nr. GM Area Codes and WAE Countries as Mults.

See the ReadMe file in zip file
Filename: SDXC.zip

Sea-Pac QSO Party

Sea-Pac QSO Party. Exchange: RS(T)+S/P/C+Name. See rules for log instructions.

Filename: SeaPac_QP.udc

SKMEM

Silent Key Memorial Contest. Exchange RST+ a Silent Key Callsign.

Filename: SKMEM.udc

SL Testen

Swedish SL Contest. Exchange: RS(T)+SerNr+Locator.

Read the Read-Me file.

Filename: SLTESTEN.zip

SMIRK

Six Meter International Radio Klub contest. Exchange: SMIRK number, if the station worked has one, and grid

See the UDC file for more details
Filename: SMIRK.udc

South East VHF Sprints

South East V/UHF Sprints. Exchange: 4 Grid or 6 Locator.

Filename: SE_VHF_SPR.udc

SP OLD TIMERS CLUB

Exchange: RS(T) + Number of years held license + OT if OTC club member.

Filename: SP_OTC.udc

SP PGA Contest DX

Polish PGA-Test, Non-SP Stations”,

See the UDC file for more details
Filename: PGATEST-DX.udc

SP PGA Contest SP

Polish PGA-Test, for Polish Stations”,
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See the UDC file for more details
Filename: PGATEST-SP.udc

SP_PK Contest

Zawody SP-PK Exchange RS(T) + Skrót powiatu albo skrót wojewódzwa i powiatu dla stacji z woj/SerNr.

Filename: SP_PK.udc in SP_PK.zip

SSA Monthly Test

SM Monthly Contest. Exchange: RS(T) + Serial Nr + Full Locator.

See the rules for full details
Filename: SSAMTCW.udc, SSAMTSSB.udc in SSA_MT.zip

SSA_JT Christmas Contest

Exchange: RS(T)+SerNr+5letters/word as ROLO/LZ Domestic. 2Pts no mult.

Do not put your first 5 letter message in the ‘Sent Exchange’ box, for CW send by hand, add it to the Cabrillo file. N1MM+
v1.0.9758 or later required. For CW use SSA-JT.mc

Filename: SSA_JT.udc

Suffixes XXIX National

Suffixes XXIX National (EA). RS and Province as exchange.

See the UDC file for more details
Filename: EASUFF29.zip

SP WW EPC BPSK63

SP WW EPC BPSK63 Contest.
Exchange: RST+Serial or SP Province Code. Province and DXCC are Multipliers.

See SPEPC_RTTY.text in SPEPC_RTTY.zip
Filename: SPEPC_RTTY.udc or SPEPCORTTY.udc

SRR JR

SRR (Russia) youth hams contest

See the UDC file for more details
Filename: SRRJR.UDC

SV Triathlon

Exchange: RS(T) and Serial. Entrants using all three modes select MIXED + DIG in the Contest Setup Window. Correct
claimed score – multiply ‘B3’ number by 3, then by number of multipliers, add to previous claimed score.

FIlename: TRIATHRTTY.udc Discontinued?

Swiss VHF Activity Contests

See the rules

TA VHF UHF

TA VHF UHF Contest. Exchange: RS(T) Serial Nr. (Start at 001 on each band) Full Locator. Select MIXED in the Contest
Setup Dialogue Window.

Filename: VHF_UHF_TA.udc
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TARA SKIRMISH

TARA SKIRMISH Contest. Exchange: Name and Prefix (Area locator),

See the UDC file for more details
Filename: SKIRMRTTY.udc

Tennessee Parks on the Air

Exchange:POTA/S/P/DX

Filenames: TN_POTA.udc TN_POTA.sec you need both files.

TenTen QSO Parties

Exchange: Name, State(Prov. or Country) & TenTen #/0. Use for ALL QSO parties – restrict mode to suit. After preparing
Cabrillo file, add TenTen Contest type to Cabrillo Header e.g. TENTEN-FALL-CW. Insert ‘CATEGORY-SECTION: ‘QRP, LOW
POWER, HIGH POWER, CLUB or MOBILE also add ‘QSOs WITH 10-10 NUMBERS: ‘ and ‘QSOs WITHOUT 10-10
NUMBERS: ‘.

See the ReadMe file for more details
Filename: 1010RTTY.udc in TENTEN.zip (Ignore ‘RTTY’ in the filenames.)

Tesla HF Memorial Contest

Exchange: RST, Serial Nr. and Your 4 Character Grid e.g. IO93. Scores correctly.

Filename: TESLA_VHF.udc

The Day of YLs

\Days of YLs\(YL/OM party) – Exchange: RS(T) + YL or OM. Work same station each band and mode.
Select log type DOYLSRTTY
Mode Select: If using all modes, select MIXED+DIG
Exchange: OM or YL Discontinued

See the UDC file for more details
Filename: DOYLSRTTY.udc

TISZA Cup International Radio Contest

CW only Exchange: RST+CQ Zone

Filename: TISZA_CUP.udc or TISZA_CDX.udc in TISZA_CUP.zip

True Blue Ultra DX Marathon

Exchange: RS(T)+CQ Zone

Filename: TRUEBLUEDX.udc or TRUEBLUENA.udc for NA participants.

Texas Parks On The Air

Exchange: Callsign and Park Designator, State, Province or DX Prefix

See the Read-Me file in the zip file.
Filename: TX-PARKS.udc

UBA PSK63 Prefix Contest

Exchange: RSQ and Serial Number Starting at 001. Mults are WPX Prefix

See UBAPSK63_ReadMe.
Filename: UBA63RTTY.udc in UBAPSK63.zip
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UFT HF All Band Contest

Exchange RST, Member Number or NM

Filename: UFT-HF.udc (in UFT-HF.zip)

UFT MEET

UFT Meet. Exchange: RST+MemNr/SYMNr/NM.

Filename: UFT_MEET.udc

UFT QRP Contest

Exchange: RST/QRP(QRO)/MemberNr(NM) Mults are Member Numbers.

See the Read-Me file
Filename: UFT_QRP.zip

UFT-YL-CW Contest

Exchange: YLs send; RST + Serial Nr + YL + Name, OMs send; RST + Serial Nr + Name

See the Rules for more details
Filename: UFT-YL-CW zip

UK DXC BPSK63

Exchange Real RSQ, Serial Nr. and your DXDA Number.

See UKDX63.txt in UKDX63RTTY.zip

Filename: UKDX63RTTY.udc

UKEICC 80m Contests

Exchange: Only Full Locator, e.g. IO84QI

Filename: UKEI80_VHF.udc IGNORE ‘VHF’ in the file name.

UKEICC Summer Series

Exchange: Only Full Locator.

Filename: UKEISS_VHF.udc Ignore ‘VHF’

UKSMG Winter Marathon

Exchange RS(T) and 4 Character Locator. If intending to use Data modes, select MIXED+DIG in the Contest Setup Dialogue
Window

See the Read-Me text file in the zip file.
Filename: 6M_WMRTTY.zip

URAL CUP

Ural Cup (Kubok Urala)

See the UDC file for more details
Filename: Ural_Cup.udc you require URALCUP.sec

URC DX RTTY

URC DX RTTY Contest. Exchange: RST+Territory Code. Variable Points, Mults 3 character territory.
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Filename: URCDXRY.zip

USi W/VE Islands Qso Party

USi W/VE Qso Party
If a station is going to use all three modes, in the contest set-up window select Mixed+Digi.
Island stations should start a new log for each location (to re-start Serial Nr)
Select file name: USI_QPRTTY
Exchange: Island Designator(If Island station) and/or State/Province or DXCC Entity.

See the UDC file for more details
Filename: USI_QPRTTY.udc

UT5EU-MEMORIAL-VHF

VHF only, serial # and GriqSquare as exchange, dupes are not allowed on same band CW, SSB and FM modes

See the UDC file for more details
Filename: UT5EU_Memorial_VHF.udc

VHF-UHF FT8 Activity

FT8 Activity. Exchange; C/S+4 Char Grid.

Filename: FT8-ACTVTY.udc

VHF ARAM 50 MHZ

Exchange:RS(T)+SerNr+Full Locator. Dupes are not allowed CW, SSB and FM modes.

Filename: VHF_ARAM50.udc

VHF GRIDS

Worked All Provinces of The Netherlands: Exchange RS(T), Serial NR and Grid, Dutch Stations send RS(T), Serial NR and 2
figure Province Code. Unzip the file (there will be 2 files – udc and txt), import CallHist_VHF_WAP.txt and turn Call History
Lookup on.

See the UDC file for more details
Filename: VHF_WAP.zip

902UP or MICROWAVE Sprints

Exchange: Full 6 Character Locator only.

Filename: VHF902UPSprint.udc

VHFSPRING

VHFSPRING and UP Sprints.

Exchange: 4 char. GridSquare as exchange, CW, SSB and FM modes.

Filename:SpringVHF&UpSprint.udc

VOLGOGRAD Championship

Volgograd Championship. Exchange: RS(T)+SerialNr/VG. See the Read-Me file.

Filename: VOLGOGRAD.zip

YU VIDOVDAN Contest

Exchange: RS(T)+SerNr+YU Auto Registration Letters, non-YU ‘NY’. ‘VD’ worth 3 mults. 4th Fri June.
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Filename: VIDOVDAN.zip

VU Himalayan Contest

Indian Stations send RS(T) and 2 figure State or Union Territory Code. Others RS(T) and Power
Use the correct UDC file for your location.

See VU_Read-Me.txt in VU.zip for more details.
Filename: VU_HIMA_DX.udc or VU_HIMA_VU.udc (in VU.zip)

VU International DX Contest

Indian Stations send RS(T) and 2 figure State or Union Territory Code, others RS(T) and Serial Number.
Use the correct UDC file for your location. Select log type: VU_DX_ VU=VU Stations, DX=Non-Asian Stations, ASIA=Non-VU
Stations.

See VU_Intl_Read-Me.txt in VU.zip for full details.
Filename: VU_DX_VU.udc or VU_DX_ASIA.udc or VU_DX_DX.udc

VU Summer (Internal) Contest

Exchange: RS(T) and Serial Number

Select correct Mode Category in the Contest Set up Dialogue Window, e.g. MIXED+DIG if working all three modes.
Filename: VUSUMMRTTY.udc (in VU.zip)

Vytautas Magnus trophy

Vytautas Magnus Trophy (v1.0.2) Held the first Sunday AFTER the new year. 80m and 2m. CW and Phone. Exchange RS(T),
Serial Nr and full Locator(Multipliers)

See the UDC file for more details
Filename: VMTROPHY.udc

WAB Contests

Worked All Britain Contests

See WAB ReadMe in WAB.zip
Filename: WAB.udc

Weekly RTTY Test – WRT
See WRT Rules and UDC download link here: https://radiosport.world/wrt.html

WIA Australia Day

Exch: RS(T) and Number of ‘Years held Licence’ Rules change – RS(T)+4CharGrid.

Filename: WIA_VK_DAY.udc see AX_HF_VHF.udc

WIA Remembrance Day

RS(T) and Number of ‘Years held Licence’ as exchange.

Filename: WIA_RDC.udc

WIA VHF/UHF

Exchange: RS(T)+SerNr+Full Locator.

Filename: WIA_VHFUHF.udc
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Worked All Lithuania – WAL

Exch: RS(T)+WAL Square/DX – WAL Sq and DXCC mults once.

Filename: WAL.zip

Wisconsin Parks on the Air (WI-PARKS)

Exchange: See new rules (2023)

Third Saturday in September every year
Filename: WI-SPOTA.UDC file and section list (WISPOTA.SEC) files in WI_POTA.zip

See the Read-Me file.

Winter Field Day – WFD

See “Setup HF, SSB and CW Contests – WFD” Now integral module, UDC file not required.

Worked All China Provinces DX

Worked All Provinces of China
See MULAN WAP above

Worked all VK Shires

Exchange RS(T) and VK Shire code, (DX send CQ Zone)

See VKshires_readme.txt in the zip file.
Filename: VKSHIRES.zip

World Amateur Radio Day Contest HF

Exchange: RS(T)+Age as at 1st Jan. When setting up remember to enter YOUR AGE in the ‘Sent Exchange’ box.

Filename: WORLDARDCH.udc

World Amateur Radio Day Contest VHF

Exchange: RS(T)+Age as at 1st Jan. When setting up remember to enter YOUR AGE in the ‘Sent Exchange’ box.

Filename: WORLDARDCV.udc

World Lighthouse On The Air (OTA)

World Lighthouse OTA. Exchange: RS(T) Serial Nr, plus Lighthouse Expeditions send Reference Nr (Lxxxx)

See the UDC file for more details
Filename: WLOTARTTY.udc

World Wide Activity

Held throughout January. Work the special stations each day, band and mode. No log required.

See the rules.

Filename: WWA.zip

World Wide Patagonian DX Contest

Exchange: RS(T)+4character Grid. When setting up remember to enter your Grid in the ‘Sent Exchange’ box.

Filename: WWPDX_vHF.udc
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Worldwide SSB Activity Contest

Every Tuesday. Exchange: RS+OM,YL,YOUTH,YOUTHYL

Filename:WW_SSB_AC.udc

WESM minitest

This contest is already implemented as MINITESTCW in the logger. Use this udc file for learning only. RST, Serial Nr, 80
metres only. Note=Contest is every Wednesday, 1800-1900 GMT, six periods, work each station each 10 minutes, each call is
mult once “,

See the UDC file for more details
Filename: WESM.udc

YACHAMP

YAKUTIA CHAMPIONSHIP

See the UDC file for more details
Filename: YA CHAMP.UDC

YBDXPI FT8 Contest

Exchange: Only your 4 Character Grid.

Filename: YBDXPI-FT8-YB for YB Stations, YBDXPI-FT8-DX for non-YB Stations.

YBDXPI SSB Contest

Exchange: RS+SerialNr. Points various, Mults – WPX + DXCC

Filename: YBDXPISSB.zip

YL-OM

The YL-OM Contest is scheduled (1400 UTC Feb-11-2011 thru 0200 UTC Feb-13-2011)
Exchange: Station Worked, QSO Number, RST, ARRL/RAC Section or DX Country”,

See the UDC file for more details
Filename: YLOM.udc

YO DIGI

YO DIGI, (YO internal contest) PSK63/RTTY, EXCH: RST+SerialNR. First Monday in September. 15 minute periods.

Filename: YODIGI.udc

YO PSK31

YO PSK31 contest. RST, Serial NR and Country ID (e.g. G) – YO send County Code as exchange
Select file name: YORTTY
Exchange: Serial Nr and Your Country Prefix – YO Stations: Serial Nr and County Code

See the UDC file for more details
Filename: YORTTY.udc

YOTA Contest

Exchange: RS(T)+Age as at 1st Jan.

Filename: YOTA.udc
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Battle of Carabobo Contest.

Exchange: RS, Serial Nr, YV Stations also send District code(Mults by band)

See the Read-Me file in YV_CARABOBO.zip
Select file name: YVBC_SSBYV.udc or YVBC_SSBDX.udc

ZOMBIE

Exchange: S/P/C + Zombie NR/Phone 3 digit area code + Name + Years held Licence. CW only.
Select file name: ZOMBIE.udc
Exchange: State/Province/Country I.D. and your Zombie Member Nr or 3 Digit phone area code and your Name and Number
of years you have held Licence.
Work out your score. (See rules)

See the UDC file for more details
Filename: ZOMBIE.udc
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Supported Radios
2019-03-29

Supported Radios
Note: Known settings for specific transceivers, as well as program features that they do not support are mentioned below as
far as we know them. Please advise us of any corrections or needed changes.

General Information
When using a home-brew self-powered interface set the handshaking to:

DTR – Always On
RTS – Always On
Like when using ICOM clone cables

All radios: Band change is not allowed while transmitting
All radios: Timeout for all radios is default set to 10 seconds (user settable). Users generally increase this value to 13 –
15 seconds.

Some radios require initialization commands for configuration. These are sent to the radio when the program
starts. Users should have the radio and interface powered prior to starting the program so this can occur. If the
radio needs to be power cycled after the program has initialized, right click in the Bandmap and select Reset
Radio to perform this initialization again.
A warning message will be displayed when no response received from the radio and the radio will be changed to
a manual radio by the program.
To restart the radio radio interface polling select in the right-click menu from the bandmap “Reset radios”
When the radio control gives a warning 10 seconds after you start the logger, then you never had radio control at
all, and you should check your hardware, and serial port settings. Consult the manual from your radio and also
read below.Some radios require initialization commands for configuration. These are sent to the radio when the
program starts. Users should have the radio and interface powered prior to starting the program so this can
occur. If the radio needs to be power cycled after the program has initialized, right click in the Bandmap and
select Reset Radio to perform this initialization again

Polling of radios while sending CW is supported for all radio except for FT-1000.
It may appear that the Up Arrow, Down Arrow, Page Up or Page Down are not working when incrementing or
decrementing the current frequency with these keys.

The VFO frequency will not change if the incremented/decremented amount is smaller than the frequency deltas
supported by your rig. This is not always well documented by the manufacturer. Icom 751 rigs for example do
support 10 Hz steps but only show 100 Hz steps on the display.
The keys mentioned above have to be set higher than the minimum step size supported by the radio.
It’s easy to test if it is the keys are working. Check the frequency while pressing the keys mentioned above. If the
frequency moves nothing has to be changed.
The default increment/decrement for CW is 10 Hz. If this doesn’t work, try changing it to 100 Hz, under the
Configurer, Other tab.
This only applies to the keys that increment/decrement the current frequency.

Memory mode – most modern radios have a kind of memory mode. In this mode, the radio will not provide the correct
polling data to the program. Memory mode is not supported; VFO mode is required.
When SO1V mode is selected, VFOB is not defined for receiving. The second Bandmap and Entry window are
automatically closed.
Sending CW characters via radio command (CAT) is not supported due to the limitations and contesting requirements.
A COM, LPT, WinKey, or similar interface built into the radio (e.g. RTS or DTR keying on the Elecraft K3) is required to
send CW.
USB and USB to COM interfaces:

Do not turn off radios while the program is running if the radio is connected via USB port. Exit the program first.
Do not unplug a USB to COM converter while the program is running. Exit the program first.
The device driver will remove the COM port from the hardware table and the program will hang then eventually
timeout. Programs written in Visual Basic and use MSCOMM control can not detect a COM port that is removed
from the hardware device table. This is a Microsoft bug.

If the radio has an internal USB sound card (“USB Audio Codec”) which you use either in voice modes or in digital
modes, then in the Logger+ Audio Setup window under the Playback tab, check the “Internal Radio Codec” check box.
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Open the Logger+ Audio Setup window from the Config > Logger+ Audio Setup… menu item. If that menu item
is grayed out, first check the Config > Use Logger+ Audio menu item.

Manual Mode – No Radio Selected
In manual mode no radio is selected and attached to the program. If possible always connect a radio using the CAT interface
or serial port. Older radios (or very new not supported radios) can still be used with the program by selecting Manual but many
functions in the program will not work as well as they could or will not work at all. When a radio is not configured, it is the
user’s responsibility to make sure the mode and band are correct when logging contacts. When no radios are selected in
Configurer, the program will attempt to set the initial operating mode and frequency in single mode contests when the program
starts or a new contest is opened. The program uses information from the contest selection and the mode tab settings in
Configurer.

Digital Mode Mapping
Below information by Rick, N2AMG and John, K3CT regarding supported Digital configurations by N1MM logger.

The mode names labelling the columns in the table below are used when setting up the “Mode sent to radio” under the Mode
Control tab in the Configurer. Failure to set the “Mode sent to radio” to the correct value can lead to the program putting the
radio into the wrong mode. These are also the mode names that are displayed at the top of the Bandmap window and in the
title bar of the Entry window.

Radio Modes Corresponding to N1MM Logger Digital Mode Designations
Column Headings = Mode names used in N1MM Logger

Radio RTTY RTTY-R AFSK AFSK-R PSK PSK-R

Flex – – DIGL DIGU – –

FT990/1000/1000MP RTTY-L RTTY-U PKT-LSB (4) – –

FT100 – – Dig(3) – – –

FT950/2000/3000/5000/9000 FSK(RTTY-
LSB)

FSK-R(RTTY-
USB) PKT-LSB PKT-USB – –

FT991 RTTY-LSB RTTY-USB DATA-
LSB

DATA-
USB – –

FT450 RTTY-L RTTY-U User-L User-U – –

FT817/857/897 – – Dig(3) – – –

FT920 Data-LSB(2) Data-USB(2) – – – –

IC7600/7610/7700/7800/7850 RTTY RTTY-R LSB-D1 USB-D1 PSK PSK-R

IC705/IC746Pro/756Pro/7200/7300/7410
/9100 RTTY RTTY-R LSB-D USB-D – –

Older Icom RTTY RTTY-R – – – –

Orion/OmniVI/OmniVII FSK – – – – –

K2 – – RTTY RTTY-R – –

K3 FSK D FSK D-R AFSK A AFSK A-
R

DATA
A

DATA A-
R

TS2000 FSK (1) – – – –

TS480/590/Other Kenwood (radio
dependent) FSK FSK-R LSB-D USB-D – –

1. radio menu selection
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2. FSK/AFSK selected by a rear panel switch
3. Radio menu programmable for RTTY, RTTY-R, PKT-L, PKT-U
4. FT990/1000/1000MP selection does not support PKT-USB

If your radio does not have an entry under AFSK or PSK, use LSB or USB (e.g.
Argonaut/Jupiter/FT840/847/890/900/757GXII). If there is an entry under AFSK-R but not under PSK, try using AFSK-R for
PSK31 and other digital modes.

Alinco
DX-77 – supported

Elecraft
Elecraft USB-serial converter issues and N1MM logger

Situation: Setting up Elecraft K3 to work with N1MM logger and simply key CW with DTR line of CAT port.
Results: CAT works fine, but every time I try to send CW there appears an error window
“CommPortDev_OnComm 4 – 2147417856”

N1MM is totally blocked and has to be killed using task manager.
Solution: Early Elecraft USB-serial converters used a Prolific chip, and the (Win2K) Prolific driver doesn’t work
correctly for CAT and DTR-CW-keying using the same port. Elecraft has since that time switched to an FTDI
USB-serial converter, and newer Elecraft USB-to-serial adapters don’t have this problem

A USB-serial converter using a FTDI-chip and the FTDI drive is working fine, CAT ok, fast CW keying,
ESC immediatly interrupts message …
All ufb now :- Tnx Thomas DK3DUA

K2

Sometimes one (1) stop bit only works (contrary to the K2 KPA100 manual saying that 2 stop bits should also work).
Setting the “Wide” and “Narrow” filter codes.

Remember to set the filter codes for both VFOs. Get the appropriate N1MM Logger screen menu prompt by left
clicking when your cursor is over the active VFO window.
Substitute this code for the complete “FL” code that comes up by default: K22;FW99991;K0; (no spaces, all
caps, include the “;”‘s) This will set the filter to “FL1” on the K2. If you put this code in the SSB “Wide” section for
the filter code, it will give you FL1 for SSB – if you put this in the CW “Wide” section, it will give you FL1 for CW.
Remember that the actual bandwidth of the filter will depend on how you have set FL1 on your K2. The same is
true when you substitute this string for the “Narrow” settings. If you want a filter other than FL1 in either mode,
just change the “1” after the 9999 to the number of the filter you want to invoke ie: 1,2,3 or 4. As an example,
K22;FW99993;K0; placed in the code section for CW “Narrow” would invoke FL3 when the switch is set to
“Narrow” and you are on CW.
Briefly, “K22” tells the K2 that this is an “extended command mode” – the “;” tells the K2 that this command is
finished – the “FW” tells the K2 that this is a command to set the filter width – the 9999 number is ignored in the
string but is necessary to include (it can be any set of four numbers between 0 and 9999 – I just picked 9999) –
the “1” is the number of the filter to invoke (1 – 4) – the “K0” (that is “K” zero) tells the K2 to go back to the
“normal command mode.”
Use the same technique to set the RTTY filters as well. Have fun es 73, Don N4HH

Please check out the feature which works great with the K2 and TS850 etc that don’t have RIT clear IF you are
Running (doesn’t work for S&P). Put the rig into split, and use VFO B as your “RIT”. Then go into Config, and turn on
“Reset RX Freq when Running Split”. Using VFO B for RIT, tune in a caller off freq, work him, and at the end of the
QSO VFO B will be set to VFO A freq. Neat feature, and specifically designed for this situation.

K3 and K3S

In the K3S (or a K3 backfitted with the KIO3B card) USB radio control and the Radio Codec are supported. Instructions
for setting up USB communications may be found under > Downloads > Additional Support Files. The file is titled
“K3RadioCodecSetup.pdf”.

Radio control issues have been reported when running other K3 utility software (such as LP-Bridge) in conjunction with
N1MM Logger. Please repeat the test with only N1MM Logger+ running without the other software before reporting a
radio control issue, in order to eliminate the other software as a possible source of the problem. Note also that when
using LP-Bridge, changes of band, mode and VFO may take longer than without LP-Bridge. During the process, it is
possible for the radio and the program to be temporarily out of sync, and you may see some apparent instability in the
band
RIT control – When in RUN mode, the Up/Dn arrow keys change the RIT frequency (if the K3’s RIT is turned on). When
in S&P mode the radio frequency is changed
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The K3 can accept PTT switching from several sources, including: a keying circuit from a serial or parallel port to the
K3’s PTT IN; PTT from a Winkeyer; RTS (pin 7) on the radio control RS232 port; using “Radio PTT via command”; or
VOX.

Do not use multiple methods of PTT control in parallel; in some cases, and depending on which version of
firmware is installed, doing so can leave a K3 stuck in transmit at the end of function-key messages. You should
not check “Radio PTT via command” if you are using RTS on the radio control port, or any other hardware PTT
connection including PTT from a WInkeyer to control PTT
Procedure for configuring RTS on the radio control RS232 port: Starting with the K3’s CONFIG:PTT-KEY set to
OFF-OFF, check the CW/Other box beside the radio control port in the Configurer and configure N1MM+ to
control PTT from RTS on the radio control port (Port setup), and then set the K3’s CONFIG:PTT-KEY to RTS-
OFF (or RTS-DTR if you are also using CW via DTR)
Warning: leaving RTS set to Always on with the K3’s CONFIG:PTT-KEY set to RTS-OFF or RTS-DTR will cause
the K3 to be permanently in transmit

If you experience issues with the radio not returning to RX when a transmission is terminated with the ESC key, try
installing firmware version 5.43 or newer. This does not solve all such problems, but it may help.

The K3 accepts CW keying on DTR (pin 4) of the same COM port you’re using to control the K3. This method can be
used when other methods (e.g. Winkeyer or a keying circuit on a separate COM or LPT port) are not available.

CW and radio control on the same COM port do not work in SO2R mode
CW on DTR does not work with some USB-to-serial adapters (e.g. Prolific chipset – may depend on the driver
version)
CW on DTR may be missing some capabilities and may have other undesired side effects – use at your own risk
Procedure: Starting with the K3’s CONFIG:PTT-KEY set to OFF-OFF, check the CW/Other box beside the radio
control port in the Configurer and configure N1MM+ to use DTR for CW on that port; set the K3’s CONFIG:PTT-
KEY to OFF-DTR (or RTS-DTR if you are also using PTT via RTS)
Warning: leaving DTR set to Always on with the K3’s CONFIG:PTT-KEY set to OFF-DTR or RTS-DTR will cause
a permanent “key-down” condition

Using the program as a voice keyer to play wav files with a K3 on SSB:
Option 1

Connect your microphone to the Mic input of the sound card and the Line Out of the sound card to the
Line In jack on the back of the K3 If you are using the internal codec in a K3S, connect the microphone to
the K3S as usual and make sure nothing is plugged into the external Line In input on the back of the K3S
Select the desired sound card output as the audio source in N1MM+, and set the sound card driver to
direct microphone input to this output (“Listen to this device” in the Windows sound card setup – some
older sound card/driver combinations may not support this, in which case you will have to use Option 2)
Select LINE IN with MENU:MIC SEL on the K3
Command Tx (or PTT or…) and adjust the K3’s MIC GAIN control (which now controls LINE IN gain) for
proper audio level; the K3’s ALC triggers at 4-5 bars on the K3’s meter, so set levels such that the meter
reaches 5-7 bars on peaks. Setting the audio level too low will result in unwanted “power hunting” (varying
power output levels) as the K3’s firmware tries to adjust its internal audio gain to achieve the power level
set with the PWR control

Option 2
Connect microphone to desired microphone connection on the K3
Select the desired microphone input with MENU:MIC SEL
Turn transmit on and set Mic Gain for normal microphone input level (the K3’s ALC meter should read 5-7
bars on peaks)
Connect sound card as described under Option 1
Temporarily select LINE IN with MENU:MIC SEL on the K3 in order to adjust the LINE IN gain while
playing a wav file from the Logger
Restore MENU:MIC SEL to the microphone input and set MENU:MIC+LINE to ON so that both audio
sources will drive the K3. The MIC GAIN control will control the microphone gain only. Line In gain can
only be set when LINE IN is the selected source via MENU:MIC SEL. Note that the microphone is always
live in this method, even when wav files are playing

Cat Macro strings used to play back Radio # 1 internal K3 CW/data messages or DVR voice keyer messages
M1 = {CAT1ASC SWT21;}
M2 = {CAT1ASC SWT31;}
M3 = {CAT1ASC SWT35;}
M4 = {CAT1ASC SWT39;}

It is not necessary to program a function key to send RX; to the radio for a DVK stop. The program code sends RX; to
the radio when the Esc key is pressed

Digital Mode Mapping for the K3/K3S
RTTY = FSK D
RTTY-R = FSK D-Rev
AFSK = AFSK A
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AFSK-R = AFSK A-Rev
PSK = DATA A
PSK-R = DATA A-Rev

Digital radio sub-modes FSK D, AFSK A and DATA A are supported
FSK D, AFSK A and DATA A are displayed in N1MM+’s Entry and Bandmap windows (and in the Configurer
under Mode Control – Mode sent to radio) as RTTY, AFSK and PSK respectively
If the current contest allows digital modes, typing RTTY into the Entry window will put the radio into the mode
selected in the Configurer’s Mode Control tab under Mode sent to radio for RTTY, which should be either RTTY
(for FSK D) or AFSK (for AFSK A)
If the current contest allows digital modes, typing PSK31 or PSK63 into the Entry window will put the radio into
the mode selected in the Configurer’s Mode Control tab under Mode sent to radio for PSK, which should be PSK
(for DATA A)
The K3’s PSK D sub-mode is not supported by N1MM+; the digital engines in N1MM+ cannot transmit PSK
using the PSK D sub-mode
The K3’s data sub-mode is stored in the firmware on a per-band basis

If VFO B and VFO A are on the same band, the data sub-mode will be the same in both VFOs
If VFO B and VFO A are on different bands, their data sub-modes can be different, but the firmware does
not provide a way to poll the K3 for the VFO B data sub-mode. N1MM Logger+ will assume that the VFO
B sub-mode is the same as in VFO A when the two VFOs are on different bands

Always adjust audio levels in AFSK A and DATA A to give 4-5 bars on the K3’s ALC meter. This allows the K3’s
firmware ALC to control power without clipping peaks and causing IMD. Use the K3’s PWR control to control
output power; do not try to control power output by adjusting the audio level. In PSK31 and other digital modes
requiring high linearity, keep the requested power setting below 50 watts (AFSK RTTY can be safely used at 100
watts)
Note that in AFSK A the K3’s dial frequency is the RTTY Mark frequency, not the suppressed carrier frequency
as it is in most radios in AFSK. Therefore the “Turn AutoTRXUpdate On/Off” option in the DI window should be
turned off when using AFSK A, the same as it would be in FSK D.

A single receiver K3 can be used in SO1V or SO2R mode. A dual receiver K3 can be used in all program modes,
including SO2V. In order to transmit from VFO B in SO2V or split mode, both VFOs must be on the same band (the K3
does not support cross-band split operation, although it is possible to receive on two separate bands simultaneously).

In a dual receiver K3, the radio’s front panel Split indicator can be misleading. What it actually means is that the
transmitter is using VFO B. In SO2V, if you use a function key while the keyboard/RX focus is in the VFO B Entry
window or if you click on a function key button in the VFO B Entry window, the radio’s Split indicator will be displayed
even though you are not actually operating split. This is because you are transmitting from VFO B. To determine
whether you are logging in split mode or not, look for the Split indicator in the Logger’s Entry window and not the
indicator on the radio’s front panel.
You can operate split from either Entry window in SO2V, but in order to transmit from the correct VFO and have the
transmit and receive frequencies logged correctly, you must enter Split mode from the program (using Ctrl+S or
Ctrl+Alt+S), and not by pressing the K3’s Split button. If you are using “reverse split” (i.e. logging the contact in the
VFO B Entry window, listening to the other station in the subreceiver on VFO B and transmitting from VFO A) the Split
indicator in the Entry window will be displayed, but the K3’s front panel Split indicator will not be displayed because the
transmitter is using VFO A.
When you change transmit focus between Entry windows, the Logger may display a Split indication temporarily in the
Entry window(s) while the program and radio status are temporarily out of sync in the process of changing. This
condition is most likely to be seen when using LP-Bridge. It should only last for a fraction of a second. If the condition
persists, check to see whether you are trying to operate in a mode the radio does not support (e.g. transmitting from
VFO B with the two VFOs on different bands is not supported by the radio).

The stereo (grave accent – ` key, at the left end of the number keys row on many keyboards) toggles Sub on and off. It
is identical to pressing the SUB radio button. To leave SUB on all the time, select Config > Sub Receiver Always On

If you have selected Diversity mode on the radio, toggling Sub off and on via ` or Alt+F12 will turn Diversity mode
off
Logger preserves diversity reception on the K3 unless RX Focus changes to vfoB at which time the subRX will
switch to vfoB (note that in diversity reception mode, both receivers are using VFO A, so full SO2V functionality
is not available without leaving diversity mode)

K3 SubRX ON/OFF control by Logger
Independent of the state of Sub Receiver Always On:

changing RX Focus to vfoB turns the subrx ON
Ctrl+Shift+Up/Dn does not change the state of the subrx
Alt+F12 or ` toggles subRX ON/OFF if RX Focus is on vfoA (action disabled if RX Focus on vfoB)

Sub Receiver Always On checked:
clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the subRX ON
changing RX Focus turns the subRX ON
if Sub Receiver Always On was unchecked and the user checks it, subRX is turned ON
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Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \ keystroke), the subRX stays
ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA (PAUSE, CTRL+Left or
vfoA Bandmap/Available window spot click ), the subRX is turned OFF
if Sub Receiver Always On was checked and the user unchecks it, subRX is turned OFF

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and the SubRX is ON, turn “Sub Receiver Always On” to OFF and leave the
SubRX ON
If “Sub Receiver Always On” is ON and the SubRX is OFF, turn “Sub Receiver Always On” to OFF and leave the
SubRX OFF
If “Sub Receiver Always On” is OFF and the SubRX is ON, turn “Sub Receiver Always On” to ON and leave the
SubRX ON
If “Sub Receiver Always On” is OFF and the SubRX is OFF, turn both ON

Alt+F12 command action:
If the subRX is OFF – check “Sub Receiver Always On” and turn the subrx ON
If the subRX is ON – uncheck “Sub Receiver Always On” and turn the subrx OFF unless RX Focus is on vfoB

It is not necessary to include the K31; command in any K3 Cat Macro. The radio is in K31 mode all the time and
sending this command just adds delay

KX3

Radio control issues have been reported when running other K3 utility software (such as LP-Bridge) in conjunction with
N1MM Logger. Please test with only N1MM Logger running before reporting a radio control issue, in order to eliminate
other software as a possible source of the problem

The KX3 can be used in SO2V mode, within the limitations of the KX3’s Dual Watch feature (e.g. VFO B must be within
15 kHz of VFO A). See the description of subreceiver control for the K3 above

The KX3 does not have an FSK keying input, so the digital engines (e.g. MMTTY) cannot transmit in FSK. To do RTTY,
put the KX3 into AFSK A mode and configure the Logger and the digital engine for AFSK

The KX3’s radio control port does not have DTR or RTS inputs, so unlike the K3 these signals cannot be used on the
radio control port to key CW or PTT

The digital engines (MMVARI and Fldigi) cannot transmit in PSK D. To do PSK, put the KX3 into DATA A mode and
configure the Logger and the digital engine for PSK

Cat Macro strings used to playback Radio # 1 internal KX3 DVK voice keyer
M1 = {CAT1ASC SWT11;SWT19;}
M2 = {CAT1ASC SWT11;SWT27;}

Cat Macro strings for other functions are listed below as examples
To tune the ATU{CAT1ASC SWT44;}
To enable VOX{CAT1ASC SWH29;}

K4

Placeholder… temporarily see settings for K3 (most of the description there also applies to the K4).

Cat Macro strings used to play back Radio # 1 internal K3 voice keyer messages:
M1 = {CAT1ASC PB1;}
M2 = {CAT1ASC PB2;}
M3 = {CAT1ASC PB3;}
M4 = {CAT1ASC PB4;}
M5 = {CAT1ASC PB5;}
M6 = {CAT1ASC PB6;}
M7 = {CAT1ASC PB7;}
M8 = {CAT1ASC PB8;}

It is not necessary to program a function key to send RX; to the radio for a DVK stop. The program code sends RX; to
the radio when the Esc key is pressed

Expert SDR
See Kenwood TS480, TS590, TS890, TS990, and TS2000
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FlexRadio
Portions of this may not be valid for the Flex-6000.
Playing Audio *.wav Files (pre-6000 series)

Transmissions made with Logger+ Audio de-energize PTT when the end of the wav file is reached. The transmit
/ virtual audio cable (VAC) path has latency. Reduce the 120ms default latency setting on the Flex SDR software
VAC1 tab to the minimum possible. This will reduce the amount of time that each on-the-fly recorded wav file will
need to contain at the end of the recording. If needed, the user can build a zero audio wav file of the correct
duration to account for the audio path latency and add it to the end of the function key message.

Flex VAC is required for digital or to send/record audio files to the radio without cables. The radio’s VOX does not
function when VAC is enabled. See the setup info onthe Flex website.
Radio control

Third party COM port mapping software is required to create a virtual COM port for radio control. See the Flex
documentation for computer and radio configuration.
Software was tested with COM port settings: 38400, N, 8, 1, DTR=Always Off, RTS=Always Off

CW sending
Depending on your computer hardware and system DPC latency, users may find that CW generated by the
N1MM Logger program or with external devices like WinKey may not be acceptable. Contact Flex Radio for CW
sending issues.

Glitches or pops in audio
Users experiencing intermittent glitches or popping sounds in the receiver audio while radio polling is enabled
should contact Flex Radio.

PowerSDR
The code was tested with public version PowerSDR 2.0.22.
There may be some interaction between the PowerSDR radio “model” and the requirements for SO2V operation.
Generally, controlling split, RX2 On/Off, or MultiRx (Non-RX2 models) from the N1MM program is recommended.

Digital Modes
Both Flex digital modes are supported. They are mapped to the N1MM Logger program selections of AFSK and
AFSK-R. Open Config, Mode Control tab, and set Mode Sent to Radio for RTTY and PSK. Most users will likely
select RTTY to AFSK and PSK to AFSK-R.
VAC does not allow the RX2 to be used with multiple Digital Interfaces. This is not a program limitation.

The Flex5000 RX2 radio selection is intended for use with the Flex 5000 with the optional RX2 receiver. The Flex radio
selection is intended for use with the Flex 1500, 3000, and the 5000 without the RX2. The Flex5000 RX2 option
implements SO2V using the RX2 for VFOB and the Flex selection implements SO2V using the MultiRx feature. There
are limitations to the tuning range of the MultiRx and how the radio reacts when it’s instructed to change to a frequency
outside of this operating range.

Flex-6000 Series

To use on the fly voice recording and playback:
Check “PTT via Radio Command SSB Mode” in the radio COM port configuration window.
Check “Internal Radio Codec” in the Playback tab of Logger+ Audio Setup.

Program Feature Set
The radio selection supports all of the standard program features including Reverse CW, Mute Mic, Audio Muting
Macros, Antenna Macros, and Advanced SO2V. The three program options SO1V, SO2V, and SO2R are
supported.

SO2V
Users are able to have a repeating CQ running on VFOA and tune the band with VFOB. Start the repeating CQ
then press the \ key to switch RX focus to the VFOB Entry window. If a station is called using the Function keys,
the TX focus will switch, the message will be sent, and the repeating CQ will not restart. Shift-F# can be used to
send a message on VFOA (example: Shift F1 to restart the CQ again). PAUSE or CTRL+Right/LeftArrow keys
can be used to switch both RX and TX focus together.
Users can program VFOB with the next Bandmap spot without changing focus using Ctrl+Shift+Up/Dn. This
allows users to program the VFOB frequency and toggle receiver 2 On/Off with various keyboard commands
when the VFOA frequency is not busy.
Receiver 2 can be programmed to be On all the time. See the Config option Sub Receiver Always On.
Receiver 2 state can be toggled with the stereo key (`) and the VFO frequencies swapped with ALT+F10. See
other features below.
If Diversity mode is enabled on the radio, toggling Sub off and on via ` or Alt+F12 will turn Diversity mode off.
Logger preserves diversity reception unless RX Focus changes to VFOB.
Receiver 2 ON/OFF control by N1MM Logger is independent of the state of Config>Sub Receiver Always On.

Changing RX Focus to VFOB turns receiver 2 ON.
Ctrl+Shift+Up/Dn does not change the state of receiver 2.
Alt+F12 or the stereo key (`) toggles receiver 2 ON/OFF if RX Focus is on VFOA (action disabled if RX
Focus on VFOB).
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Sub Receiver Always On checked:
Single clicking in any VFO Bandmap, on an Available window spot, or Ctrl+Up/Dn turns receiver 2
ON.
Changing the RX Focus turns the receiver 2 ON.
If Sub Receiver Always On is unchecked and the user checks it, receiver 2 is turned ON.

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX focus changes to VFOA ( \ keystroke), receiver 2
stays ON.
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is switched to VFOA (PAUSE,
CTRL+Left or VFOA Bandmap/Available window spot click ), receiver 2 is turned OFF.
If Sub Receiver Always On is checked and the user unchecks it, receiver 2 is turned OFF.

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and receiver 2 is ON, change “Sub Receiver Always On” to OFF and
leave receiver 2 ON.
If “Sub Receiver Always On” is ON and receiver 2 is OFF, turn “Sub Receiver Always On” to OFF and
leave the receiver 2 OFF.
If “Sub Receiver Always On” is OFF and receiver 2 is ON, turn “Sub Receiver Always On” to ON and
leave the receiver 2 ON.
If “Sub Receiver Always On” is OFF and receiver 2 is OFF, turn both ON.

Alt+F12 action is similar to the stereo (`) key, but also affects “Sub Receiver Always On” state:
If receiver 2 is OFF – check “Sub Receiver Always On” and turn receiver 2 ON.
If receiver 2 is ON – uncheck “Sub Receiver Always On” and turn receiver 2 OFF unless RX focus is on
VFOB.

SO2R (thanks to Mike Walker VA3MW)
Full duplex SO2R requires a 6600 or 6700 to take advantage of secondary antennas while transmitting, but the
same configuration can be used with the 6300, 6400 and 6500.
In SmartSDR CAT:

Set up Slice A in CAT for a com port
Set up Slice B in CAT for a 2nd unique com port

The 2 above ports can be TCP ports if you like (e.g. 127.0.0.1:60000 and 127.0.0.1:60001)
Set up OTRSP for a 3rd com port
Set up WinKeyer for a 4th com port

In SmartSDR:
Open Slice A on one panadapter
Open Slice B on a 2nd panadapter

In the N1MM+ Configurer:
Start by selecting an SO2R setup (do not use SO1V)
Set up Radio 1 for Slice A CAT control and CAT PTT for all modes using the CAT port for Slice A as set up
above
Set up Radio 2 for Slice B CAT control and CAT PTT for all modes using the CAT port for Slice B as set
up above

Using CAT PTT eliminates having to set up a 3rd com port for RS232 PTT. You do not require both
Hardware and Software PTT control

Configure OTRSP for the 3rd com port
Configure WinKey for the 4th com port

In the Logger+ Audio Setup make sure you have “Use Internal Radio Codec” checked
This is critical as it turns TX DAX on and off as required so that your N1MM voice keyer and sound card
digital modes work

This setup can be used for full-on SO2R with a 6600 or 6700, or in-band SO2V-style operating with a 6300/6400/6500
There is a document on the FlexRadio website that goes into more detail. While it is labelled for the 6700 this setup
works on all models: https://www.flexradio.com/documentation/flex-6700-so2r-configuration-n1mm/

Flex-5000A with RX2

Program Feature Set
The Flex5000 RX2 radio selection supports all of the standard program features including Reverse CW, Mute
Mic, Audio Muting Macros, Antenna Macros, and Advanced SO2V. The three program options SO1V, SO2V, and
SO2R are supported.

Playing Audio *.wav Files
Transmissions made with Logger+ Audio de-energize PTT when the end of the wav file is reached. The transmit
/ virtual audio cable (VAC) path has latency. Reduce the 120ms default latency setting on the Flex SDR software
VAC1 tab to the minimum possible. This will reduce the amount of time that each on-the-fly recorded wav file will
need to contain at the end of the recording. If needed, the user can build a zero audio wav file of the correct
duration to account for the audio path latency and add it to the end of the function key message.

SO2V
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The RX2 option is required for SO2V operation.
Users are able to have a repeating CQ running on VFOA and tune the band with VFOB. Start the repeating CQ
then press the \ key to switch RX focus to the VFOB Entry window. If a station is called using the Function keys,
the TX focus will switch, the message will be sent, and the repeating CQ will not restart. Shift-F# can be used to
send a message on VFOA (example: Shift F1 to restart the CQ again). PAUSE or CTRL+Right/LeftArrow keys
can be used to switch both RX and TX focus together.
Users can program VFOB with the next Bandmap spot without changing focus using Ctrl+Shift+Up/Dn. The state
of the RX2 is unchanged. This allows users to program the VFOB frequency and toggle the RX2 On/Off with
various keyboard commands when the VFOA frequency is not busy.
The RX2 can be programmed to be On all the time. See the Config option Sub Receiver Always On.
The RX2 state can be toggled with the stereo key (`) and the VFO frequencies swapped with ALT+F10. See
other features below.
If Diversity mode is enabled on the radio, toggling Sub off and on via ` or Alt+F12 will turn Diversity mode off.
Logger preserves diversity reception unless RX Focus changes to VFOB at which time the RX2 will switch to
VFOB.
Subrx ON/OFF control by N1MM Logger is independent of the state of Config>Sub Receiver Always On.

Changing RX Focus to VFOB turns the RX2 ON.
Ctrl+Shift+Up/Dn does not change the state of the RX2.
Alt+F12 or the stereo key (`) toggles RX2 ON/OFF if RX Focus is on VFOA (action disabled if RX Focus
on VFOB).
Sub Receiver Always On checked:

Single clicking in any VFO Bandmap, on an Available window spot, or Ctrl+Up/Dn turns the RX2
ON.
Changing the RX Focus turns the RX2 ON.
If Sub Receiver Always On is unchecked and the user checks it, the RX2 is turned ON.

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX focus changes to VFOA ( \ keystroke), the RX2 stays
ON.
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is switched to VFOA (PAUSE,
CTRL+Left or VFOA Bandmap/Available window spot click ), the RX2 is turned OFF.
If Sub Receiver Always On is checked and the user unchecks it, the RX2 is turned OFF.

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and the RX2 is ON, change “Sub Receiver Always On” to OFF and
leave the RX2 ON.
If “Sub Receiver Always On” is ON and the RX2 is OFF, turn “Sub Receiver Always On” to OFF and leave
the RX2 OFF.
If “Sub Receiver Always On” is OFF and the RX2 is ON, turn “Sub Receiver Always On” to ON and leave
the RX2 ON.
If “Sub Receiver Always On” is OFF and the Sub RX is OFF, turn both ON.

Alt+F12 action is similar to the stereo (`) key, but also affects “Sub Receiver Always On” state:
If the RX2 is OFF – check “Sub Receiver Always On” and turn the RX2 ON.
If the RX2 is ON – uncheck “Sub Receiver Always On” and turn the RX2 OFF unless RX focus is on
VFOB.

Flex-1500, Flex-3000, Flex-5000A without RX2

Program Feature Set
The Flex radio selection supports all of the standard program features including Reverse CW, Mute Mic, Audio
Muting Macros, Antenna Macros, and SO2V. The three program options SO1V, SO2V, and SO2R are supported.

Playing Audio *.wav Files
Transmissions made with Logger+ Audio de-energize PTT when the end of the wav file is reached. The transmit
/ virtual audio cable (VAC) path has latency. Reduce the 120ms default latency setting on the Flex SDR software
VAC1 tab to the minimum possible. This will reduce the amount of time that each on-the-fly recorded wav file will
need to contain at the end of the recording. If needed, the user can build a zero audio wav file of the correct
duration to account for the audio path latency and add it to the end of the function key message.

SO2V
The MultiRx is used for VFOB. Frequency and mode limitations of VFOB and how the radio responds to
frequencies outside this range are controlled by the radio.
Given this, users are able to have a repeating CQ running on VFOA and tune the band with VFOB. Start the
repeating CQ then press the \ key to switch RX focus to the VFOB Entry window. If a station is called using the
Function keys, the TX focus will switch, the message will be sent, and the repeating CQ will not restart. Shift-F#
can be used to send a message on VFOA (example: Shift F1 to reastart the CQ again). PAUSE or
CTRL+Right/LeftArrow keys can be used to switch both RX and TX focus together.
Users can program VFOB with the next Bandmap spot without changing focus using Ctrl+Shift+Up/Dn. This
allows users to program the VFOB frequency and toggle MultiRx On/Off with various keyboard commands when
the VFOA frequency is not busy.
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The MultiRx can be programmed to be On all the time. See the Config option Sub Receiver Always On.
The MultiRx state can be toggled with the stereo key (`) and the VFO frequencies swapped with ALT+F10. See
other features below.
MultiRx ON/OFF control by N1MM Logger is independent of the state of Config>Sub Receiver Always On.

Changing RX Focus to VFOB turns the MultiRx ON.
Ctrl+Shift+Up/Dn does not change the state of the MultiRx.
The stereo key (`) or Alt+F12 toggles MultiRx ON/OFF if RX Focus is on VFOA (action disabled if RX
Focus on VFOB).
Sub Receiver Always On checked:

Single clicking in any VFO Bandmap, on an Available window spot, or Ctrl+Up/Dn turns MultiRx
ON.
Changing the RX Focus turns MultiRx ON.
If Sub Receiver Always On is unchecked and the user checks it, MultiRx is turned ON.

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX focus changes to VFOA ( \ keystroke), MultiRx stays
ON.
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is switched to VFOA (PAUSE,
CTRL+Left or VFOA Bandmap/Available window spot click ), MultiRx is turned OFF.
If Sub Receiver Always On is checked and the user unchecks it, MultiRx is turned OFF.

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and MultiRx is ON, change “Sub Receiver Always On” to OFF and
leave MultiRx ON.
If “Sub Receiver Always On” is ON and MultiRx is OFF, turn “Sub Receiver Always On” to OFF and leave
MultiRx OFF.
If “Sub Receiver Always On” is OFF and MultiRx is ON, turn “Sub Receiver Always On” to ON and leave
MultiRx ON.
If “Sub Receiver Always On” is OFF and MultiRx is OFF, turn both ON.

Alt+F12 action is similar to the stereo (`) key, but also affects “Sub Receiver Always On” state:
If MultiRx is OFF – check “Sub Receiver Always On” and turn MultiRx ON.
If MultiRx is ON – uncheck “Sub Receiver Always On” and turn MultiRx OFF unless RX focus is on VFOB.

SDR-1000 and SDR-5000A (using Kenwood settings)

By: Rob AB7CF
Some setup details are not really needed but are included for completeness. One thing I notice different is in
PowerSDR Cat setup I use ID as: “PowerSDR” though it shouldn’t make a difference. Probably the most common
Vcom mistake is a failure to click Update Driver and following the procedure after making a change in Vcom
configuration..
Example: using VCom configurator using ports 4-5 defines and VAC
Check your VCom configurator to make sure you have a check box in the COM4 – COM5 pair and you have clicked
Save Configuration. MAKE SURE you click the Update Driver and follow the instructions. Close VCom configurator.
Click on Window’s Start Button, Click on ControlPanel, Click System, Click on the Hardware Tab, Click on Device
manager.
In Device manager make sure there ISN’T a yellow question mark on the entry labeled “Multi-port serial adapters.” If
there is no yellow question mark your Vcom virtual cable should be working properly. If there is an yellow question mark
there is a problem with your Vcom installation which needs attention. Assuming no problem, Close ControlPanel.
Now check PowerSDR. Open PowerSDR Setup and click on the CAT Control tab. In CAT Control make sure Enable
CAT is checked. Under PTT make sure Port 4 is selected and RTS and DTR are unchecked. Select ID as: PowerSDR.
Click Apply. Close PowerSDR Setup.
Now check N1MM. Click Config. Select “Configure Ports, Telnet Address,Other” Under Com-5 select Kenwood. Make
sure CW/PTT is unchecked. Now click Set. In the popup box the settings should be: Speed 4800, Parity: N DataBits: 8,
Stop Bits: 1 DTR (pin 4) = Handshake. RTS (pin 7) =Handshake, 1 selected in Radio/VFO. Leave the “Radio PTT via
command” check box UNCHECKED. Check the “Allow external interrupts” check box. Click Okay (twice) to back out.
Now you should be communicating with your SDR. Check that clicking a new frequency in the Panadapter changes
frequency in N1MM. With the focus in N1MM check that the keyboard up and down arrows change the PowerSDR
frequency.

Icom
General Icom Information (all Icom owners please read)

Older Icom rigs require an ICOM CT-17 CI-V interface or compatible. If your Icom radio has a USB computer interface
(IC-7200, IC-7600, etc), install the latest driver from the Icom website for the virtual COM port and audio codec.
Icom rigs use software handshaking. That means they do not use DTR and RTS. However, interfaces that get their
power from the RS232 port require you to set DTR and/or RTS to “Always On” to supply power to the interface. Check
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your interface manual to see how DTR and RTS must be set.
Set N1MM Logger and the rig to:

Address – see specific rig information below
Baud Rate – 9600 or 19200 (see specific rig maximum rates below). 1200 or 2400 baud should not be used.
When baud rates slower than 9600 baud rate is selected, the program will disable CI-V acceleration features
added for radio programming.
Data Bits – 8 bits
Parity – None
Stop Bits – 1 bit

On your rig, set:
“CI-V Transceive” to OFF – If CI-V is set to ON, the Bandmaps will not update as the VFO is turned.
“Some Icom rigs have a “4 or 5 Byte Data” or “Frequency Data Length” interface option. Set the radio to use 5
data bytes for the frequency.

Due to the limited Icom radio control, the user needs to control the radio from the keyboard. This means that the user
can not press these buttons on the radio: SPLIT (most radios), DUALWATCH, CHANGE, VFO/MEMO, A=B, A < > B, or
MAIN/SUB. Icom radios only report the VFO frequency of the active VFO. Because of this, the program will select each
VFO to read the frequency during initialization. During 2011, Icom added a firmware command to poll the radio split to
the latest firmware updatable and new radios. Those radios that are capable or reading the split have been updated in
N1MM+. See the specific radio text for the firmware revision. When using these radios with the proper firmware, users
can change the radio split by pressing the radio button and the program will track.
To set and clear split under program control, use ALT+F7 or one of the other keyboard commands. Split is correctly
set/cleared when clicking in the Bandmap or Available windows. To select VFOB (SO2V mode only), use the PAUSE,
“\”, or CTRL+Right/Left Arrow keys. In SO2V mode, the VFO is also selected with a Right or Left click on the band
buttons in the Available window.
Frequencies > 2 GHz are ignored and not sent to the radio.
For CW sending with older radios, a separate CW interface cable is needed between the radio and the computer. This
interface may be serial or parallel port or a WinKey. The CI-V cable or serial cable to the radio alone is not enough to
do CW. If your radio has a USB interface, you may be able to key CW via the same interface.
The ALT+F10 swap VFO frequency command is disabled during SO2R for Icom radios that lack a swap VFO CAT
command. This is because the program is unaware of Icom VFO B frequency in SO2R mode.
The Icom command set (CW via CAT control) is not supported. A COM (includes virtual COM ports via USB), LPT, or
WinKey is required to send CW.

The models below are supported:

IC-271 / IC-471 / IC-1271

Select IC-706 and set the radio address to hex 48 or program the default radio address in the program setup
window. Please report on program functionality.
There are several limitations caused by the lack of several CI-V commands. VFO select and split commands are
not supported. This will prevent the program from controlling the radio split and reading or programming VFOB
frequency. SO2V mode should not be attempted and VFOB’s Bandmap and Entry windows can be closed.

IC-275A/E/H using address 10 hex

The CI-V command set lacks split ON/OFF commands. This prevents the program from controlling the radio
split.

IC-375 / IC-575 (all versions)

Select IC-706 and set the radio address to hex 48 or program the default radio address in the program setup
window. Please report on program functionality.
The CI-V command set lacks split ON/OFF commands. This prevents the program from controlling the radio
split.

IC-475A/E/H using address 14 hex

The CI-V command set lacks split ON/OFF commands. This prevents the program from controlling the radio
split.
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IC-703 using address 68 hex

IC-705 using address A4 hex

This radio can not be used in SO2V mode because Icom did not provide VFO specific polling commands.
Currently they provide Selected and Unselected VFO Frequency & Mode commands.
Radio control via USB with Icom driver or CI-V interface.
To control the radio via the USB interface with baud rates above 19200, the radio menu Connectors, CI-V, CI-V
USB Port must be set to “Unlink from Remote”. Then set the menu item below this, CI-V USB Baud Rate, to the
baud rate above 19200.
The radio codec is supported. With the Icom drivers the USB cable can be used for radio control, AFSK RTTY,
PSK, recording voice messages on the fly, voice message playback, and QSO recording.
To record both sides of a CW transmission with the radio codec, enable this option in the Set Menu: Connectors,
ACC/USB AF Beep/Speech….Output = ON. The CW sidetone level changes the audio level in the recording. If
you set the CW sidetone level to zero, the recording will not contain the transmitted audio.
Detailed instructions for setting up USB communications with these radios may be found under > Downloads >
Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf” If you have questions post a message
on the Logger+ reflector.
To play an internal voice (DVK) message, program function key or Bandmap button with the CatMacro below.
Pressing the ESC key will stop a voice message. There is no need to program a STOP command. These
commands work, but they are undocumented for the IC-7300. Thus, there are no guarantees that they will work.
Be sure you are running the latest firmware update. They were tested with V1.20 of the firmware.

Voice Message1 = {CAT1Hex FE FE A4 E0 28 00 01 FD}
Voice Message2 = {CAT1Hex FE FE A4 E0 28 00 02 FD}
Voice Message3 = {CAT1Hex FE FE A4 E0 28 00 03 FD}
Voice Message4 = {CAT1Hex FE FE A4 E0 28 00 04 FD}
Voice Message5 = {CAT1Hex FE FE A4 E0 28 00 05 FD}
Voice Message6 = {CAT1Hex FE FE A4 E0 28 00 06 FD}
Voice Message7 = {CAT1Hex FE FE A4 E0 28 00 07 FD}
Voice Message8 = {CAT1Hex FE FE A4 E0 28 00 08 FD}
Stop Voice Message = {CAT1Hex FE FE A4 E0 28 00 00 FD} (programmed into the ESC key)

Note: The CatMacro command can be entered with or without spaces:
{CAT1Hex FE FE A4 E0 28 00 01 FD} or {CAT1Hex FEFEA4E0280001FD}

Digital Mode Mapping for the IC-705
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-706 using address 48 hex

This radio firmware does not include a CAT command to key the radio. This causes the radio command PTT
options to be non-functional.

IC-706MKII using address 4E hex

This radio firmware does not include a CAT command to key the radio. This causes the radio command PTT
options to be non-functional.

IC-706MKIIG using address 58 hex

This radio firmware does not include a CAT command to key the radio. This causes the radio command PTT
options to be non-functional.

IC-718 using address 5E hex

Set N1MM Logger to 19200 bps and the radio to “AT” (AuTo).
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IC-725 using address 28 hex

IC-728 using address 38 hex

IC-729 using address 3A hex

IC-735 using address 04 hex

The CI-V command set lacks split ON/OFF commands. This prevents the program from controlling the radio
split.
When the IC-735 is used with factory settings (1200 baud, transceive ON), the bandmap response of N1MM is
extremely slow. Jumpers J22 located on the PL-unit board (upper side under PA unit) allow baud-rate, address
and CI-V transceive to be changed. But.. the jumpers are not labeled and not in the order as stated in the
Service manual. In fact transceive ON/OFF is the last one (front panel toward you, starting from left) this one
should be removed to turn transceive OFF. The 2 first ones set the baud-rate (move the second one to the first
position to switch from 1200 to 9600 baud) the 3 remaining ones are the CI-V address – default 04; is with last
the last one of this group of 3 – ON.

Jumper J22 settings for 9600 baud, transceive OFF and default address 04 – from left to right with front panel toward you…

1 2 3 4 5 6

ON OFF OFF OFF ON OFF

Baud rate Baud Rate Address Address Address CI-V transceive

These settings make the 735 operable with N1MM (trx IC735 / baud rate 9600 / 8 data bits / no parity / 1 stop bit). DTR and/or
RTS are not used by the Icom CI-V (no handshake) so does not matter. However, they should be turned to “always ON” if
using an interface powered though those pins. Alternatively, they can be used for CW and PTT, for example if you are limited
by the number of COM-ports on your machine. 73′ Patrick F6IRF

IC-736 using address 40 hex

IC-737/737A using address 3C hex

The CI-V command set lacks split ON/OFF commands. This prevents the program from controlling the radio
split.

IC-738 using address 44 hex

IC-746 using address 56 hex

VFO-B is a virtual VFO as long it isn’t activated. The scale is not controlled by the VFO-B of the transceiver. It
becomes an active VFO when it is activated. The IC-746 is switched to VFO-B and set to the frequency shown in
the VFO-B bandmap.

IC-746 PRO using address 66 hex

Digital Mode Mapping for the IC-746Pro
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-751/751A using address 1C hex

There are several limitations caused by the lack of some CI-V commands. VFO select and split commands are
not supported. This will prevent the program from controlling the radio split and reading or programming VFOB
frequency. SO2V mode should not be attempted and VFOB’s Bandmap and Entry windows can be closed.

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of frequency data must be set correctly.
This is set via a DIP switch on the Icom UX-14 interface board. Using the DIP switch S1 location in the beginning of the
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manual (page 11 has the DIP switch positions reversed) set S1 to the following:
1—————–6
On – Off – Off – Off – Off – On
This will set the baud rate to 9600, the length of the frequency information to 5 bytes, and turn CI-V Transceive OFF.
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx manual for the same configuration

IC-756 using address 50 hex

Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.

IC-756 PRO using address 5C hex

Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.

IC-756 PRO II using address 64 hex

Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.
Digital Mode Mapping for the IC-756Pro

RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-756 PRO III using address 6E hex

Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.
Digital Mode Mapping for the IC-756Pro

RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-761 using address 1E hex

There are several limitations caused by the lack of some CI-V commands. VFO select and split commands are
not supported. This will prevent the program from controlling the radio split and reading or programming VFOB
frequency. SO2V mode should not be attempted and VFOB’s Bandmap and Entry windows can be closed.

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of frequency data must be set correctly.
This is set via a DIP switch inside the radio. Set the baud rate to 9600, the length of the frequency information to 5 bytes, and
turn CI-V Transceive OFF.
The manual lacks the details but it is suspected that DIP S1 should be set to the following:
1—————–6
On – Off – Off – Off – Off – On
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx manual for the same configuration.

IC-765 using address 2C hex

IC-775/775DSP using address 46 hex

The IC-775 firmware is limited and lacks commands to select Main or Sub. It is also not possible to read the
frequency of the Sub VFO without moving it into the Main VFO and polling. This is done at program start,
Configurer exit, and Reset Radios. Because of this radio limitation, the SO2V functionality is limited. This radio is
better suited for SO1V or SO2R use.
The radio firmware lacks the ability to poll the VFOB frequency. Frequency changes to the SUB made by tuning
the SUB VFO knob will not be sensed and tracked by the program in SO2V mode.
Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.

IC-781 using address 26 hex

Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.
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IC-821H using address 4C hex

The ALT+F12 radio specific command swaps MAIN and SUB using the CAT radio command.
The ALT+F10 command swaps the VFOA/B frequency and mode only in SO1V and SO2V program modes.

IC-910H using address 60 hex

The ALT+F12 radio specific command swaps MAIN and SUB using the CAT radio command.
The ALT+F10 command swaps the VFOA/B frequency and mode only in SO1V and SO2V program modes.

IC-1275A/E using address 18 hex

IC-7000 using address 70 hex

The CI-V command set lacks split ON/OFF commands. This prevents the program from setting or clearing the radio
split.

IC-7100 using address 88 hex

If using the USB interface the manual will tell you to install the Icom driver before connecting the cable to the radio. Icom
owners that connect the cable first typically have issues because Windows installs the wrong driver. If this occurs, disable the
device using Device Manager, then disconnect the USB cable, install the Icom driver, and finally reconnect the USB cable.

Set the serial port for:

Baud Rate = 19200
Parity = None
Stop Bits = 1
Data Bits = 8

IC-7200 using address 76 hex

Radio control via USB with Icom driver or CI-V interface.
The IC-7200 radio codec is supported. IC-7200 users can use the USB cable with the Icom drivers for radio
control, AFSK RTTY, PSK, voice message playback, and recording QSOs. Owners can not record messages on
the fly because the radio lacks the capability to send the MIC audio to the radio codec. In CW, only the received
portion of the QSO is recorded. This is a radio limitation.
Detailed instructions for setting up USB communications with this radio may be found under > Downloads >
Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf”

Digital Mode Mapping for the IC-7200
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-7300 using address 94 hex

This radio can not be used in SO2V mode because Icom did not provide VFO specific polling commands.
Currently they provide Selected and Unselected VFO Frequency & Mode commands.
Radio control via USB with Icom driver or CI-V interface.
To control the radio via the USB interface with baud rates above 19200, the radio menu Connectors, CI-V, CI-V
USB Port must be set to “Unlink from Remote”. Then set the menu item below this, CI-V USB Baud Rate, to the
baud rate above 19200.
The radio codec is supported. With the Icom drivers the USB cable can be used for radio control, AFSK RTTY,
PSK, recording voice messages on the fly, voice message playback, and QSO recording.
To record both sides of a CW transmission with the radio codec, enable this option in the Set Menu: Connectors,
ACC/USB AF Beep/Speech….Output = ON. The CW sidetone level changes the audio level in the recording. If
you set the CW sidetone level to zero, the recording will not contain the transmitted audio.
Detailed instructions for setting up USB communications with these radios may be found under > Downloads >
Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf” If you have questions post a message
on the Logger+ reflector.
To play an internal voice (DVK) message, program function key or Bandmap button with the CatMacro below.
Pressing the ESC key will stop a voice message. There is no need to program a STOP command. These
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commands work, but they are undocumented for the IC-7300. Thus, there are no guarantees that they will work.
Be sure you are running the latest firmware update. They were tested with V1.20 of the firmware.

Voice Message1 = {CAT1Hex FE FE 94 E0 28 00 01 FD}
Voice Message2 = {CAT1Hex FE FE 94 E0 28 00 02 FD}
Voice Message3 = {CAT1Hex FE FE 94 E0 28 00 03 FD}
Voice Message4 = {CAT1Hex FE FE 94 E0 28 00 04 FD}
Voice Message5 = {CAT1Hex FE FE 94 E0 28 00 05 FD}
Voice Message6 = {CAT1Hex FE FE 94 E0 28 00 06 FD}
Voice Message7 = {CAT1Hex FE FE 94 E0 28 00 07 FD}
Voice Message8 = {CAT1Hex FE FE 94 E0 28 00 08 FD}
Stop Voice Message = {CAT1Hex FE FE 94 E0 28 00 00 FD} (programmed into the ESC key)

Note: The CatMacro command can be entered with or without spaces:
{CAT1Hex FE FE 94 E0 28 00 01 FD} or {CAT1Hex FEFE94E0280001FD}

Digital Mode Mapping for the IC-7300
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-7400 using address 66 hex

Select the IC-746 PRO as radio.
Digital Mode Mapping for the IC-7400

RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-7410 using address 80 hex

Supports polling the radio for split status
Radio control via USB with Icom driver or CI-V interface.
The radio codec is supported. Users with the Icom drivers can use the USB cable for radio control, AFSK RTTY,
PSK, recording voice messages on the fly, voice message playback, and recording QSOs. In CW, only the
received portion of the QSO is recorded. This is a radio limitation.
Detailed instructions for setting up USB communications with these radios may be found under > Downloads >
Additional Support Files. . The file is titled “IcomUSBCodecInstructions.pdf”.

Digital Mode Mapping for the IC-7410
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-7600 using address 7A hex

Requires radio firmware that contains the get split command (firmware 1.11 or newer).
Radio control via USB with Icom driver or CI-V interface.
The IC-7600 radio codec is supported. Users with the Icom drivers can use the USB cable for radio control,
AFSK RTTY, PSK, recording voice messages on the fly, voice message playback, and recording QSOs. In CW,
only the received portion of the QSO is recorded. This is a radio limitation.
Detailed instructions for setting up USB communications with these radios may be found under > Downloads >
Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf”

Digital Mode Mapping for the IC-7600
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D1
AFSK-R = USB-D1
PSK = PSK
PSK-R = PSK-R
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IC-7610 using address 98 hex

Radio control via USB with Icom driver or CI-V interface.
To control the radio via the USB interface with baud rates above 19200, the radio menu Connectors, CI-V, CI-V USB
Port must be set to “Unlink from [[REMOTE]]”. Then set the menu item, CI-V USB Baud Rate to 115200 baud rate.
When the baud rate is set to 115200, the radio polling is faster.

Using the Icom drivers, the USB cable can be used for radio control, AFSK RTTY, PSK, recording voice
messages on the fly, voice message playback, and QSO recording.
To record both sides of a CW transmission with the radio codec, enable this option in the Set Menu: Connectors,
ACC/USB AF Beep/Speech….Output = ON. The CW sidetone level changes the audio level in the recording. If
you set the CW sidetone level to zero, the recording will not contain the transmitted audio.
IC-7610 specific instructions for single USB cable configuration can be found under > Downloads > Additional
Support Files. in a file called “IC-7610_CW_SSB_RTTY_FSK_Config.pdf”.
Generic detailed Icom instructions may be found under > Downloads > Additional Support Files. The filename is
“IcomUSBCodecInstructions.pdf”.
Tracking/Diversity: When tracking is enabled, the following behavior should be expected:

Dual Watch is enabled, split is turned OFF, and the Sub frequency is set to the Main VFO frequency.
Radio operation is expected to be Main VFO centric.
Setting a frequency or band with the software will set both VFO’s to the same frequency and mode.
Clicking on a split spot or turning ON split with Ctrl+Alt+S will disable tracking.
Turning OFF Dual Watch with ` or Alt+F12 will turn tracking OFF.

The Bandmap radio buttons can be used to quickly enable or toggle tracking. Right click and program one or two
buttons with the following values:

Track On {CAT1HEX FE FE 98 E0 16 5E 01 FD}
Track Off|Track On {CAT1HEX FE FE 98 E0 16 5E 01 FD}|{CAT1HEX FE FE 98 E0 16 5E 00 FD}

To play an internal voice (DVK) message, program function key or Bandmap button with the CatMacro below.
Pressing the ESC key will stop a voice message. There is no need to program a STOP command.

Voice Message1 = {CAT1Hex FE FE 98 E0 28 00 01 FD}
Voice Message2 = {CAT1Hex FE FE 98 E0 28 00 02 FD}
Voice Message3 = {CAT1Hex FE FE 98 E0 28 00 03 FD}
Voice Message4 = {CAT1Hex FE FE 98 E0 28 00 04 FD}
Voice Message5 = {CAT1Hex FE FE 98 E0 28 00 05 FD}
Voice Message6 = {CAT1Hex FE FE 98 E0 28 00 06 FD}
Voice Message7 = {CAT1Hex FE FE 98 E0 28 00 07 FD}
Voice Message8 = {CAT1Hex FE FE 98 E0 28 00 08 FD}
Stop Voice Message = {CAT1Hex FE FE 98 E0 28 00 00 FD} (programmed into the ESC key)

Note: The CatMacro command can be entered with or without spaces:
{CAT1Hex FE FE 98 E0 28 00 01 FD} or {CAT1Hex FEFE98E0280001FD}

Digital Mode Mapping for the IC-7610
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D1
AFSK-R = USB-D1
PSK = PSK
PSK-R = PSK-R

IC-7700 using address 74 hex

Requires radio firmware that contains the get split command (firmware 1.20 or newer).
Digital Mode Mapping for the IC-7700

RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D1
AFSK-R = USB-D1
PSK = PSK
PSK-R = PSK-R

IC-7800 using address 6A hex

Requires radio firmware 3.10 or newer.
Please see also Key Assignments (Alt+F12) and the setting ‘Sub Receiver Always On’ in the Config menu.
Digital Mode Mapping for the IC-7800

RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D1
AFSK-R = USB-D1
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PSK = PSK
PSK-R = PSK-R

IC-7850/7851

Radio control via USB with Icom driver or CI-V interface.
The radio codec is supported. Users with the Icom drivers can use the USB cable for radio control, AFSK RTTY,
PSK, recording voice messages on the fly, voice message playback, and recording QSOs.
To record both sides of a CW transmission with the radio codec, enable this option in the Set Menu, ACC menu:
USB AF Beep/Speech….Output = ON. The CW sidetone level changes the audio level in the recording. If you
set the CW sidetone level to zero, the recording will not contain the transmitted audio.
Detailed instructions for setting up USB communications with these radios may be found under > Downloads >
Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf”

Digital Mode Mapping for the IC-7850/7851
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D1
AFSK-R = USB-D1
PSK = PSK
PSK-R = PSK-R

IC-9100 using address 56 hex

Requires radio firmware that contains the get split command (firmware E1 or newer).
USB radio control and audio CODECS are supported. Detailed instructions for setting up USB communications
may be found under > Downloads > Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf”

Digital Mode Mapping for the IC-9100
RTTY = RTTY
RTTY-R = RTTY-R
AFSK = LSB-D
AFSK-R = USB-D
nothing for psk or psk-r

IC-9700

This radio can not be used in SO2V mode because Icom did not provide VFO specific polling commands. Currently
they provide Selected and Unselected VFO Frequency & Mode commands.
Radio control via USB with Icom driver or CI-V interface.
To control the radio via the USB interface with baud rates above 19200, the radio menu Connectors, CI-V, CI-V USB
Port must be set to “Unlink from Remote”. Then set the menu item below this, CI-V USB Baud Rate, to the baud rate
above 19200.
The radio codec is supported. With the Icom drivers the USB cable can be used for radio control, AFSK RTTY, PSK,
recording voice messages on the fly, voice message playback, and QSO recording.
To record both sides of a CW transmission with the radio codec, enable this option in the Set Menu: Connectors,
ACC/USB AF Beep/Speech….Output = ON. The CW sidetone level changes the audio level in the recording. If you set
the CW sidetone level to zero, the recording will not contain the transmitted audio.
Detailed instructions for setting up USB communications with these radios may be found under > Downloads >
Additional Support Files. The file is titled “IcomUSBCodecInstructions.pdf” If you have questions post a message on the
Logger+ reflector.
To play an internal voice (DVK) message, program function key or Bandmap button with the CatMacro below. Pressing
the ESC key will stop a voice message. There is no need to program a STOP command.

Voice Message1 = {CAT1Hex FE FE A2 E0 28 00 01 FD}
Voice Message2 = {CAT1Hex FE FE A2 E0 28 00 02 FD}
Voice Message3 = {CAT1Hex FE FE A2 E0 28 00 03 FD}
Voice Message4 = {CAT1Hex FE FE A2 E0 28 00 04 FD}
Voice Message5 = {CAT1Hex FE FE A2 E0 28 00 05 FD}
Voice Message6 = {CAT1Hex FE FE A2 E0 28 00 06 FD}
Voice Message7 = {CAT1Hex FE FE A2 E0 28 00 07 FD}
Voice Message8 = {CAT1Hex FE FE A2 E0 28 00 08 FD}
Stop Voice Message = {CAT1Hex FE FE A2 E0 28 00 00 FD} (programmed into the ESC key)

Note: The CatMacro command can be entered with or without spaces:
{CAT1Hex FE FE A2 E0 28 00 01 FD} or {CAT1Hex FEFEA2E0280001FD}

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/mmfiles/categories/supportfiles/
https://n1mmwp.hamdocs.com/mmfiles/categories/supportfiles/
https://n1mmwp.hamdocs.com/mmfiles/categories/supportfiles/


520

Kenwood

General Kenwood information

All models are supported
Newer models connect directly via a serial port cable or USB port. The use of the USB port requires a Kenwood
driver be installed.
If your radio has an internal USB audio codec, to use it for voice keying or for digital modes check the “Internal
Radio Codec” check box under the Playback tab in the Logger+ Audio Setup window (Config > Logger+ Audio
Setup… menu item).
Older models need the Kenwood IF-10 and/or the IF-232C interface (or compatible). Please check the radio’s
manual.

Almost any of the earlier generation Kenwood radios need some sort of level conversion, and at least
some also come without the necessary chip set. Radios like the TS-940S, TS-440S, TS-811, TS-711 need
both a chip and a level converter.
PIEXX (www.piexx.com) makes a combined level converter and chip set replacement for the TS-940, as
well as a complete replacement microprocessor for the TS-930 to provide communications.

The stock Kenwood interfaces (IF-232 for the older -x40 and -x50 series transceivers) and a bare RS-232 cable for the
more recent TS-480/570/870/2000 require handshake. Except for the TS-570. the solution is either to set RTS to
“Always on” or to “handshake”, or else to install a jumper between CTS/RTS pins at the RS-232 input of the Kenwood
interface (in the case of the -40 and -50 transceivers) or transceiver (TS-480/870/2000). The TS-570 can lock-up if RTS
is connected to CTS and requires RTS=Always On to be reliable.

Using such a jumper to over-ride hardware handshaking will free RTS for PTT in addition to DTR for CW. The
alternative to over-riding the hardware flow control is to set RTS=Always On and use DTR for PTT or CW as
necessary (DTR is not connected in the radio/interface).

RX/TX information from the radio is ignored while sending is in progress to avoid glitches in sending.
Typical Kenwood radio defaults:

Speed: 9600 Baud; Parity: N ;Databits: 8; Stopbits: 2 and “hardware handshaking” (RTS and DTR set to
“Handshake”). It is recommended by the developers to use a baud rate above 9600 baud if possible. The radio
menu and the program setup must be changed together.

When setting split both VFOs are forced in the same mode.
The Kenwood KY command set (CW via CAT control) is not supported due to significant limitations. A COM, LPT, or
WinKey is required to send CW.

TS-480

Select: Kenwood. Note that handshaking options may vary – check your manual
“AFSK” via the data jack with software PTT is supported. Check the “Digital Modes Acc Jack Radio Command
PTT” and the “Software PTT Via Radio Command – Digital” in the radio COM port setup window.

To play the internal voice message with a Logger+ CatMacro use these function key strings.
Play Message 1 = {CAT1ASC PB1;}
Play Message 2 = {CAT1ASC PB2;}
Play Message 3 = {CAT1ASC PB3;}
Stop Message = {CAT1ASC PB0;}

The TS-480 DVK stop command is sent to the radio when the ESC key is pressed.

TS-570

Select: Kenwood
9600,N,8,1,handshake,handshake. SO1V: radio/VFO = 1
Be sure the radio is programmed to operate at the same baud rate. Use 9600 baud or higher.
When using the ACC2 port on the back, you must send both the audio signal and the PTT signal to the ACC jack.
You can’t use the normal PTT connection from the MIC jack if you are inputting audio into the ACC jack.

TS-590 & TS-590D

Select: TS-590
Use the Owners Manual to access the menus for COM port speed, parity, number of databits, and stopbits. A COM port
speed of 38400 or 57600 baud is recommended.
Make sure the COM port speed set in N1MM Logger is the same as the speed in TS-590 menu item 62. After changing
the speed in menu item 62, exit the TS-590 menu and cycle the front panel power switch off/on.
When using the TS-590S radio codec as a sound card for a DVK, the live microphone has priority over the codec. This
means that if live audio is being sent from the microphone, a .wav file cannot be sent over the codec at the same time.
Starting of the .wav file will be blocked, even if the microphone VOX drops shortly thereafter. So, if you’re running, and
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using the microphone to say callsigns, but F2 to send the exchange, you have to wait until the VOX drops before
pressing F2.
To use the radio’s internal audio codec for voice keying or for digital modes, check the “Internal Radio Codec” check
box under the Playback tab in the Logger+ Audio Setup window (Config > Logger+ Audio Setup… menu item).
When using the ACC2 radio jack, there are three PTT options. PTT for digital modes (pin 9), PTT for non-digital modes
(pin 11), and software PTT (PTT via radio command by mode). The ACC2 pin 13 PTT is exactly the same as the
Remote connector pin 3 PTT. If you use Remote connector pin 3 PTT while using the internal radio codec, there will be
no RF output.
To use the ACC2 for digital modes with software PTT, check “Digital Modes Acc Jack Radio Command PTT” and the
“Software PTT Via Radio Command – Digital” in the setup window of the COM port used for radio control.
ARCP-590 or ARUA-10 are not needed when using N1MM Logger with the TS-590.
Detailed instructions for setting up USB communications with this radio may be found under > Downloads > Additional
Support Files. The file is titled “KenwoodTS-590SCodec 2011-04-02.pdf”.
Assigning these basic example macros to Function Keys will allow you to play and stop the internal DVK (voice keyer)
on radio #1. Other macro strings can be inserted to playback on radio #2 or both radios. See the Macros section of the
manual.

Message1 = {CAT1ASC PB1;}
Message2 = {CAT1ASC PB2;}
Message3 = {CAT1ASC PB3;}
Stop Playback = {CAT1ASC PB0;}
The TS-590 DVK stop command is sent to the radio when the ESC key is pressed.

TS-850

Select: Kenwood
Turn off AI on init
Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 (!)
Check out the possible communications issue below with this radio

TS-870

NOTES provided by Jim W2JC for connecting Kenwood TS-870S Transceiver to N1MM+ Logging software to provide Logging
control of the Transceiver.

One of the biggest challenges to setting this up is to get the COM port to work with the USB to 9-pin interface cable.

With no cables plugged into any USB port on the laptop, go to the Windows Control Panel / System / Hardware /
Device Manager

Look on the list for an entry called “Ports (COM & LPT).” Expand the list by pressing the “+” sign so you can see
all port assignments
Now plug the cable USB connector into the USB socket on the left side of laptop
The “Ports (COM & LPT)” entries should now include one more listing – the port assigned to the TS-870 cable
Right click on the port number assigned to the T-870 and select Properties at the bottom
Click on the “Port Settings” tab. Be sure the settings are as follows:

Bits per second = 4800; Data Bits = 8; Parity = None; Stop Bits =2; Flow Control = None
If it is necessary to change the COM port number, click the Advanced button; and use the drop-down menu at
the top to select the desired COM number
Check to make sure that the USB port does not power down when the computer is idle. For details look in the
“via USB” section of the documentation for “See “http://n1mm.hamdocs.com/tiki-index.php?
page=Serial+Parallel+and+Sound+Card+Interfacing”

DO NOT change any other settings on the “Advanced Settings” page, they should be:
Under “Miscellaneous Options” ONLY “Serial Enumerator” should be checked. The remaining settings should be 4096; 4096;
16; 0; 0;
Click OK button to exit.

Minimize the Device Manager window
Plug the other end of the USB / 9-pin interface cable into the 9-pin connector on the rear of the TS-870S, under the
power connector
If it is not already ON, turn ON the TS-870S

If it is not already open, start N1MM+ Logging software
Only the N1MM Entry Window and the Bandwidth Window need to be open at this time
In the Entry Window, click on the Config tab

Click “Configure Ports, Mode Control, Audio, Other…” at top of the menu
Click on the Hardware tab
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On the right side of the Hardware window, be sure SO1V is selected
In the top entry of the Port column, use the drop-down menu to select COM2 (or whatever COM
number was set up in the above steps)
In the top entry of the Radio column, use the drop-down menu to select “Kenwood”
In the top entry of the CW/Other column, click to show a checkmark in the box if it is not already
showing a checkmark
Click once on the Set button; a new, small window should open
Be sure all settings in this window are as shown below:

Speed = 4800; Parity = N; Data Bits = 8; Stop Bits = 2; DTR (Pin 4) = Handshake; RTS (Pin 7) = Handshake
Radio Nr = 1; Two Radio Proto = None; Foot Switch (Pin 6) = None; Radio Polling Rate = Normal

Check OK button to exit
Back on the Configurer page, click OK button to exit

In the Entry Window, the window title should show the current frequency, mode, and “Kenwood VFO A”
In the BandMap window, the top should show “Kenwood VFO A” and under that the current TS-870 radio frequency. IF
it does not, then RIGHT-click in an open area of the Bandmap Window and select “Reset Radios” (6th up from the
bottom)
Now tune the TS-870S to different frequencies and be sure that N1MM+ is displaying the correct radio frequency
At the lower right of the TS-870S tuning knob, press the UP button to change Band — be sure that N1MM+ follows and
displays the new frequency. Repeat with the UP and DOWN buttons to ensure that N1MM+ is tracking the band
changes

TS-890

Before plugging the USB cable into the rear of the radio install the Silicon Labs Virtual COM Port Driver.

Plug the USB cable into the black USB connector on the rear of the radio.

There will be two COM ports installed, one will be the standard COM port which you will select to control the radio in the
N1MM+ Configurer.  The second COM port will be the enhanced COM port which will be selected for CW and Digital modes.

There is a detailed explanation in the TS-890 manual on page 1-5 which will explain how to identify the standard and
enhanced COM port on your computer.

Use the setup instructions found at this link: https://n1mmwp.hamdocs.com/mmfiles/ts-890_ssb_cw_rtty_fsk_config-docx/

TS-950sdx

Select: Kenwood
Some (older) TS-950sdx radios drop power when polled by a logging program. It’s pretty obvious on either CW or SSB.
The problem is not the program but the ROM firmware chip. The big one one the digital board of the 950sdx.

Just replace the chip, the problem should go away. Costs about $27.00 – and very easy to install (about 10
minutes)
Order a battery if you haven’t replaced it already – it’s right next to the chip on the same board….

Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 (!)
Check out the possible communications issue below with this radio.

TS-990

Select: TS-990
Follow the Owners Manual for port speed, parity, number of databits, and stopbits
Make sure the COM port speed set in N1MM Logger is the same as the speed in TS-990 menu item 7-00 or 7-01.
Note: 57600 baud is recommended for radio control.
ARCP-590 or ARUA-10 are not needed when using N1MM Logger with the TS-990.
To play the internal voice message with a Logger+ CatMacro use these function key strings.

Play Message 1 = {CAT1ASC PB01;PB115;}
Play Message 2 = {CAT1ASC PB01;PB125;}
Play Message 3 = {CAT1ASC PB01;PB135;}
Play Message 4 = {CAT1ASC PB01;PB145;}
Play Message 5 = {CAT1ASC PB01;PB155;}
Play Message 6 = {CAT1ASC PB01;PB165;}

Stop Message = {CAT1ASC PB01;PB110;PB120;PB130;PB140;PB150;PB160;PB00;}
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The TS-990 DVK stop command above is sent to the radio when the ESC key is pressed in voice mode.

TS-50

Use Kenwood-Slow radio selection
4800, N, 8, 2, Handshake, Handshake

TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940

The radio firmware revision of some of these radios may require the use of Kenwood-Slow rather than Kenwood.

TS-2000

Use the radio selection TS-2000. It was added to allow control of RX antenna input.
Use the highest baud rate possible, something above 9600 baud. The window selections should be No Parity, 8
Databits, 1 Stopbits, DTR = Handshake, and RTS = Handshake. According to the owners manual, if 4800 baud is used,
Stopbits needs to be 2. The radio default baud rate can be changed with radio menu 56. Since hardware hand shaking
is used by the TS-2000, the serial cable needs to contain wires for the hardware flow control pins.
Do not use the radio function called “auto-mode”. This function automatically changes the radio mode and changes the
radio mode set by N1MM logger.
Radio NB: This may produce AFSK RTTY (LSB) problems when changing between the higher (USB) and lower (LSB)
bands.
Do not use the radio in memory mode, use VFO mode. The program will not function when in memory mode with the
program.
The radio control works for frequencies above 6 meters.

N1MM logger loses communication with the radio (TS-850, TS-950 etc.)

This problem is based in the radio’s firmware. Some Kenwood radios are not capable of communicating with N1MM
Logger while the VFO knob is being turned. If you turn the VFO knob smoothly and continuously, no matter how slowly,
the radio will not respond to radio polls and the link will time out. For these radios there are two choices, pause when
tuning the VFO so the radio will answer the program polling requests or increase the ‘transceiver timeout time’. The
transceiver timeout time is set by right-clicking in the Bandmap window. This is a radio firmware limitation, not a
software issue. Using Kenwood-Slow will *not* solve this firmware limitation.

TenTec

General TenTec information

The models below are supported, other models are not supported.

ARGONAUT V

Use the Argonaunt radio selection.

ARGONAUT VI

Use the Eagle radio selection. The Argonaut V and Argonaut VI radio commands are different.
This radio is NOT capable of SO2V operation. Select SO1V or SO2R program operation.
The radio firmware requires a 200ms delay after every Set-type command. Users may notice this delay when the
program is setting the frequency, mode, or split.

JUPITER

Uses 1 stopbit and DTR and RTS ‘Always on’. Do NOT check the CW check box on the port setup screen for
this com port.

OMNI-VI

The Omni VI+ the “Cde” item under menu 2 should be set to “off”. Otherwise there will be collisions between the data
sent from the rig when N1MM polls for data and the data that is being continuously sent by the radio which will cause
erratic behavior.
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In the COM port setup window for the radio, the “Icom Code” box should be set to 4. This radio uses the Icom protocol
for radio communications.

OMNI-VII

The Omni-VII does not support antenna switching in “radio” mode. It is only possible in “remote” mode. So
owners of the Omni-VII can not use the antenna switch macros.
Alt+F10 (exchange VFO) and CW-Reverse operation supported
The Omni-VII can not receive on VFOB.

Orion

Uses default 56000 Baud and 1 stopbit and hardware handshaking. Note: handshaking requires that CTS is
connected per the Orion manual.
Firmware version 1.363 or greater needed.
Note that the Orion does not support PTT on CW via computer command. This does work on SSB, but on CW,
you need to set a parallel or serial port to assert PTT for that radio. Then use a cable from that adapter to pin
three (PTT) of the aux port on the Orion. This is the black RCA Phono connector on the aux cable. By use of a Y
connector, you can parallel your footswitch and this CW PTT cable.
When using PTT and CW lines off a serial or parallel port. Be sure to go into the Orion CW menu and set “PTT in
CW as” to the value “Mox”.
Default bandwidths: CW: 300/800; SSB: 2000/2800; RTTY 250/400
Supports Digital Voice Keying (DVK) via the AUX port. Audio should be fed to the AUX port and NOT the
microphone.

When no DVK is specified the front microphone gain will normally set to 0
Microkeyer users: check out the Supported Hardware chapter regarding muting of the ORION
microphone audio input.

When a DVK is specified for that radio the microphone gain will not change (mostly fed to the front
microphone).

When up/down pressed, turn on RIT if in S&P, turn off RIT if in running mode.
Clear RIT by setting to 1 Hz not 0. Avoids turning off RIT.
Narrow SSB bandwidth set to 1990 Hz to force the use of 2.4 kHz filter in auto mode.
RIT can be changed using the up/down keys if RIT on. Note that you must turn on RIT from within the program!
Swap VFOs using Alt+F10. This will replace the contents of memories 199 and 200
Example Setup FSK/CW/SSB

In FSK or SSB mode the program uses the PTT input to key the rig.
In CW mode the program uses the PTT as the CW key.

Digital setup and MMTTY.
N1MM Config / Config Ports / Hardware Tab.

Set the CW menu choice for the interface com port to DTR (Pin 4).
MMTTY Setup / Setup MMTTY / TX Tab / Radio command button.

Checked the PTT button under DTR/RTS.
Interface information

LINE OUT (74) is fixed level output (RCA connector)
Should be fed to LINE IN on the soundcard.
Yellow phono plug on Pin 4 of the AUX I/O cable assembly
NB this is a combined output for both receivers, use the AUX I/O port for separated outputs (pin 4
and 6)

AUX I/O port (80): AUX IN (pin 1) for transmit audio from the soundcard
Should be fed to LINE OUT on the Soundcard.
The AUX gain can be set under the SSB menu
Set the AUX gain to 65 and use the computer audio setting to drive the rig to 100 watts for RTTY.

AUX port: PTT (pin 3)
A transistor switch is needed from a serial or parallel port.

Works fine for digital modes but also for recording and the voice keyer.
Switch between MIKE and AUX via the menu.

This is a summary of the SO2V features for the Orion.

The stereo (grave accent – `) key toggles Sub audio On and Off. To leave SUB audio selected all the time, select
Configurer>Sub Receiver Always On

If you are using Diversity mode on the radio, toggling Sub off and on via ` or Alt+F12 will turn Diversity mode off
Logger preserves diversity reception unless RX Focus changes to vfoB at which time the subrx will switch to
vfoB

Subrx ON/OFF control by Logger
Independent of the state of Sub Receiver Always On:
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changing RX Focus to vfoB turns the subrx ON
Ctrl+Shift+Up/Dn does not change the state of the subrx
Alt+F12 toggles subrx ON/OFF if RX Focus is on vfoA (action disabled if RX Focus on vfoB)

Sub Receiver Always On checked:
clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn turns the subrx ON
changing RX Focus turns the subrx ON
if Sub Receiver Always On was unchecked and the user checks it, subrx is turned ON

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA ( \ keystroke), the subrx stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA (PAUSE, CTRL+Left or
vfoA Bandmap/Available window spot click ), the subrx is turned OFF
if Sub Receiver Always On was checked and the user unchecks it, subrx is turned OFF

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and the Sub RX is ON, turn “Sub Receiver Always On” to OFF and leave the
Sub RX ON
If “Sub Receiver Always On” is ON and the Sub RX is OFF, turn “Sub Receiver Always On” to OFF and leave the
Sub RX OFF
If “Sub Receiver Always On” is OFF and the Sub RX is ON, turn “Sub Receiver Always On” to ON and leave the
Sub RX ON
If “Sub Receiver Always On” is OFF and the Sub RX is OFF, turn both ON

Alt+F12 command action:
If the subrx is OFF – check “Sub Receiver Always On” and turn the subrx ON
If the subrx is ON – uncheck “Sub Receiver Always On” and turn the subrx OFF unless RX Focus is on vfoB

Eagle

This radio is NOT capable of SO2V operation. Select SO1V or SO2R program operation.
The radio firmware requires a 200ms delay after every Set-type command. Users may notice this delay when the
program is setting the frequency, mode, or split.

Xiegu
G90

Similar to the IC-7100
Use CI-V address 70 hex

Yaesu

General Yaesu information

The models below are supported, other models are not supported.
Required interfaces

Recent models connect directly via a USB cable
Follow the driver installation instructions from Yaesu to install the USB driver for the COM ports
Use the “Enhanced” COM port for radio control
Use the “Standard” COM port for CW/FSK/PTT keying

Older models without an RS-232 connector may need the Yaesu FIF-232C CAT interface (or compatible).
Use hardware handshaking where possible.
Yaesu uses by default:

Speed: 38400 Baud (USB cable) or 4800 Baud (RS232 cable), Parity: N, Data bits: 8, Stop bits: 2

FT-80C

It has been reported that this radio will not transmit key CW or MIC audio while it is sending the radio polling data to the
computer. The radio polling string is fixed by the radio firmware and it requires over 800ms to send the data to the
computer at 4800 baud. This radio should only be used without radio control. Radio control operation this slow just isn’t
practical for contesting.

FTDX10

The radio menu CAT Time Out Time should be set to 1000 or higher.
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The radio menu CAT RATE must match the program radio port baud rate. The suggested baud rate is 38400.
Set the radio COM port (“Enhanced” port) to 38400, N, 8, 2, Handshake, Handshake.

FT-100(D)

The FT-100D has an internal jumper for either CAT/TUNER or LINEAR. This should be set for CAT/TUNER.
Configure the radio as FT-100, 4800, N, 8, 2, DTR=Always Off, RTS=Always Off. Reports are that the DTR=Always On,
RTS=Always On also works.
Requires a radio interface (CT-62 or after-market).
Be sure to plug the radio interface into the proper radio jack!

FTDX101D

Use these settings for the FTDX101MP as well
The radio menu CAT Time Out Time should be set to 1000 or higher.
The radio menu CAT RATE must match the program radio port baud rate. The suggested baud rate is 38400.
Set the radio COM port (“Enhanced” port) to 38400, N, 8, 2, Handshake, Handshake.
For CW keying via the USB cable, use the “Standard” port for CW/Other and set RTS to CW

In the radio menu, Mode CW, set PC Keying to RTS
Hardware PTT control is not supported by the radio using the “Standard” port
For FSK keying via the USB cable, check the Digi check box for the “Standard” port and use RTS for FSK and DTR for
PTT

In the radio menu, Mode RTTY, set RPTT Select to DTR
There are other forms of the CAT Macros for SO2R use but a basic form to play the internal radio voice memories are:

{CAT1ASC PB0#;} (where # is a number 1 – 5 for message 1 – 5
{CAT1ASC PB00;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.

See also the setup instructions submitted by Jim W7RY, which can be found in the >Download >Additional Support Files,
“FSK with N1MM and 2-Tone for the Yaesu FTdx101d”

FT-736

Not supported and probably never will be. It seems that once the radio is controlled by CAT it can’t be controlled
by hand anymore.

FT-450

The radio menu item CAT TOT should be set to 1000 and CAT RATE must match the program configuration.
When using a COM port cable that contains signaling wires (RTS & DTR), verify that the radio menu CAT RTS =
ENABLE (default) and the program radio COM port RTS to Handshake.
When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu
and set the program radio COM port RTS to Always OFF.
There are other forms of the CAT macros for SO2R use but a basic form to play the internal radio voice memory 1 & 2
and stop the message are:

{CAT1ASC PB1;}
{CAT1ASC PB2;}
{CAT1ASC PB0;}
The DVK stop command is sent to the radio when the ESC key is pressed.

Digital Mode Mapping for the FT-450
RTTY = RTTY-L
RTTY-R = RTTY-U
AFSK = User-L
AFSK-R = User-U
nothing for psk or psk-r

FT-710

The radio menu CAT-1 Time Out Time should be set to 1000 or higher.
The radio menu CAT-1 RATE must match the program radio port baud rate. The suggested baud rate is 38400.
Set the radio CAT-1 COM port (“Enhanced” port) to 38400, N, 8, 1, Always Off, Always Off.
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FT-747GX

It has been reported that this radio will not transmit key CW or MIC audio while it is sending the radio polling
data to the computer. The radio polling string is fixed by the radio firmware and it requires over 800ms to send
the data to the computer at 4800 baud. This radio should only be used without radio control. This operation just
isn’t practical for contesting.

FT-757

Select FT-757GXII as radio and disable the radio communications timeout via the bandmap menu option (set it
to 0).
The FT-757GX does NOT send anything to the computer and the radio mode can not be set by the program so
the radio control functionality will be limited.

FT-757GXII

Supported

FT-767 / FT-767GX

There are no plans to support this radio.

FT-817

19200, N, 8, 1, Handshake, Handshake. FT-817 CI-V Baud “Hi”. When using a USB/Serial adapter set DTR to ‘Always
on’ and RTS ‘Always off’.
There are some limitations in the radio control provided by Yaesu.

The best way to understand what is possible is to take few minutes and review the available CAT Commands on
page 72 of your operating manual.
VFO A/B : It is only possible to switch from one VFO to the other but there is no way to know by the program if
the radio is on VFO A or VFO B.
Narrow CW Filter : There is no CAT Command to set Filters on the radios.

FT-840

Supported

FT-847

Split operation via the program is not functional due to Yaesu radio control limitations. Split needs to be set/cleared
manually by the operator.

FT-857, FT-857D

This radio should only be used in SO1V or SO2R modes. The radio control has limitations, SO2V mode is not
supported.

FT-890

Supported

FT-891

This radio has limited radio control. It can only be used in SO1V or SO2R mode always receiving on VFOA.
The radio firmware currently does not contain a command set Split On and Off. Until this is corrected by Yaesu, all
functions relating to setting and clearing split will not function.
The radio adds two virtual COM ports. Only one of these ports can be used for radio control. Some users report that the
radio control port is distinguished by the name Enhanced USB port. Others report program errors when they try to use
the CW/PTT only virtual COM port for radio control. Make sure you use the correct COM port for radio control.
The radio menu CAT TOT should be set to 1000 or higher.
The radio menu CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400.
The radio menu CAT RTS should be set to DISABLE.
The program radio COM port should be set to 38400, N, 8, 1, DTR to Always OFF, and RTS to Always OFF.
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FT-897

The radio control provided by Yaesu is limited. This radio should only be used in SO1V or SO2R modes, SO2V mode is
not supported.
The PTT line in the DATA jack on the rear of the radio cannot be used for CW, because when it is asserted, the radio
sends a continuous key-down tone. To actuate PTT from the program using RTS or DTR, the interface must be wired to
the front-panel microphone jack’s PTT pin.

FT-897D

The radio control provided by Yaesu is limited. This radio should only be used in SO1V or SO2R modes, SO2V mode is
not supported.
The PTT line in the DATA jack on the rear of the radio cannot be used for CW, because when it is asserted, the radio
sends a continuous key-down tone. To actuate PTT from the program using RTS or DTR, the interface must be wired to
the front-panel microphone jack’s PTT pin.

FT-900

Supported

FT-920

The radio control provided by Yaesu does not include an indicator in the polling data to indicate which VFO is selected
or active. If the user changes the VFO by pressing the radio buttons, the program can not detect this change. This is a
radio limitation, not a program limitation. It is recommended to use this radio in SO1V or SO2R mode.

FT-950

The radio menu CAT TOT should be set to 1000 or higher.
The radio menu CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400 (38400,
N, 8, 2).
When using a COM port cable that contains signaling wires (RTS & DTR), verify that the radio menu CAT RTS =
ENABLE (default) and the program radio COM port RTS to Handshake.
When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu
and set the program radio COM port RTS to Always OFF.
There are other forms of the CATMacros for SO2R use but a basic form to play the internal radio voice memories are:

{CAT1ASC PB0#;} (where # is a number 1 – 5 for message 1 – 5)
{CAT1ASC PB00;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.

Digital Mode Mapping for the FT-950
RTTY = FSK(RTTY-LSB)
RTTY-R = FSK-R(RTTY-USB)
AFSK = PKT-LSB
AFSK-R = PKT-USB
nothing for psk or psk-r

FT-980

There are no plans to support this radio.

FT-990

FT-990 and early FT-1000 had a design problem in the CAT interface. It used an open emitter transistor on the serial
out line. That worked fine for TTL HIGH (+5 V) but some TTL to RS232 interfaces did not have enough load to cause
the output to go low … the interface would “float” in the undefined logic state between .3 and 3.5 volts. The solution is
to add a 1.5K Ohm resistor from “serial out” to ground. When using the ARRL handbook design the 1.5k resistor needs
to be added between pin 1 of the 7417 (which is pin 2 of the DIN) to ground.
The radio control provided by Yaesu does not include an indicator in the polling data to indicate which VFO is selected
or active. If the user changes the VFO by pressing the radio buttons, the program can not detect this change. This is a
radio limitation, not a program limitation. It is recommended to use this radio in SO1V or SO2R mode.
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FT-991 & 991A

The radio firmware has been updated several times. Be sure to install the latest firmware.
Due to the design, this radio can only be used in SO1V or SO2R modes.
Setup information and notes:

Install the Silicon Laboratory drivers onto your computer per the Yaesu website instructions.
Install a Standard USB cable between the FT-991 and your computer. If the Silicon Labs drivers were
successfully installed, you will have an enhanced port and a standard port showing in device manager. Only one
of these ports can be used for radio control. Some users report that the radio control port is distinguished by the
name Enhanced USB port. Others report program errors when they try to use the CW/PTT only virtual COM port
for radio control. Make sure you use the correct COM port for radio control.
Set the following menu items on the ft-991. Note: the menu #’s may change with future firmware updates.

012keyer typeoff
031CAT rate38400
032CAT Tot1000
033CAT rtsdisable
060PC keyingdtr
071Data PTT selrts

Select the hardware tab. Under Port, select your enhanced port. Under radio select FT-991. Click on SET and
input 38400,N,8,2 always off, always off. Select Radio NR1.

Digital Mode Mapping for the FT-991
RTTY = RTTY-LSB
RTTY-R = RTTY-USB
AFSK = DATA-LSB
AFSK-R = DATA-USB
nothing for psk or psk-r

FT-991A Radio Codec
Logger+ Audio window

Playback tab: select the radio codec device & check “Internal Radio Codec”
Message Recording tab: select the radio codec audio device

Config, FT-991A radio, Set window (baud rate window)
Check PTT via Radio Command for the mode(s) of operation
To prevent the radio codec modulator switching in digital modes, check the Do Not Reset Radio Codec
box

FT-1000(D)

Cat control will not work with FT-1000D internal software version lower than v6….most older ft1000d’s have
version v5.8… you need an update!
Older versions do have a CAT control problem. Check out the infromation with the FT-990 (above).
If the bandmap/frequency is not updating, the radio probably is in Mem/Tune mode. Deselect using the
VFO/MEM switch.

The program forces the radio at startup from Mem/Tune mode in VFO mode to avoid this problem.
For filter settings see below

FT-1000MP (Mark-V)(Field)

The program can’t send CW via the MP’s serial cable. See the help for how to build a CW interface
If the bandmap/frequency is not updating, the radio probably is in Mem/Tune mode. Deselect using the
VFO/MEM switch.

The program forces the radio at startup from Mem/Tune mode in VFO mode to avoid this problem.
The indicator should show VFO.

Use a straight serial cable
4800,N,8,2 and DTR and RTS set to “Always Off”
A big issue with the FT-1000MP is that you cannot set the radio to split with VFO-B as the RX. Well, you can, but
you cannot control whether you are listening dual, or just VFO-B from the computer. You can detect it, but not set
it. The user will have to press the main RX button to turn off the main receiver when split from VFO-B. Note that
Alt+F10 will swap VFO A & B frequencies. That is very useful in this case.
Optimum configuration for those who wish to operate AFSK and/or PSK. There will be an 85 Hz display offset
between RTTY and PSK but that is minor.
PKT is LSB with the frequency display shifted by 2.125 KHz (or other user defined offset at menu 6-4). It also
selects audio input from the PACKET jack on the rear of the radio, disables the processor and mutes the
microphone. Finally, it offsets the filters so the narrow filters are properly placed (centered as specified in menu
6-5).
Using QMB memories
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When doing a QMB RCLl press M>A until it transfers the QMB frequency to the VFO. After this it should
work as normal, but you lose the original frequency that was in VFO-A.

For filter settings see below

FT-1000 series, FT-990 and FT-920 Setting filters

Simply right-click on the bandmap and you will get a menu which includes “Set transceiver filter codes” … there are six
submenus: CW Wide, CW Narrow, SSB Wide, SSB Narrow, Digi Wide and Digi Narrow. In my case the commands for SO2V
are:

The settings below will work for the FT-1000, FT-1000D, the FT-1000MP, the FT-1000MP/MKV and the FT-
1000MP/MKV Field (or any combination of two FT-1000 “family” of rigs in SO2R).

BandWidth VFO-A (main) VFO-B (sub) Filter Remarks

2.4 kHz 0 0 0 0 140 0 0 0 128 140 SSB Wide or Digi Wide —

2.0 KHz 0 0 0 1 140 0 0 0 129 140 SSB Narrow or Digi Narrow will use 2.4 kHz on VFO-B

500 Hz 0 0 0 2 140 0 0 0 130 140 CW Wide or Digi Wide —

250 Hz 0 0 0 3 140 0 0 0 131 140 CW Narrow or Digi Narrow will use 500 Hz on VFO-B

6.0 KHz (thru) 0 0 0 4 140 0 0 0 132 140 — —

The VFO-B (sub) only supports bandwidths of 6.0 KHz, 2.4 KHz and 500 Hz.
For SO2R (two rigs) configure the two bandmaps the same.
Some notes:

“Duplicates default filter settings” is appropriate to the FT-1000 MK/V and Field only. The FT-1000/D/MP
permit more flexible filter selection.
The FT-920 does not support 2.0 KHz and 250 Hz filters … it might make more sense to revise CW and
Digi settings for 2.4/500 Hz (0 0 0 0 140 and 0 0 0 2 140) filters.
Even though the FT-920 lacks the second receiver, the FT-920 permits selecting different bandwidths for
each VFO. The CAT commands are the same as those for the second receiver in the “1000” series: 0 0 0
130 140 selects 500 Hz and 0 0 0 128 140 selects 2.4 KHz.
The FT-990 commands are the same as those for VFO A in the “1000” series of radios.

FT-2000

A user has reported communications issues when using firmware version 11.54 1.55. It’s unclear if a CAT menu has
been changed or added. The user reported no issues when using firmware 11.53 1.50.
The radio menu CAT TOT should be set to 1000 or higher.
The radio menu CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400 (38400,
N, 8, 2).
When using a COM port cable that contains signaling wires (RTS & DTR), verify that the radio menu CAT RTS =
ENABLE (default) and the program radio COM port RTS to Handshake.
When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu
and set the program radio COM port RTS to Always OFF.
The radio menu options for CW mode association to USB/LSB reverses the CW/CW-R polling response. If the
CW/CW-R display in N1MM Logger is reversed, change the radio menu options for CW to the defaults.
There are other forms of the CAT Macros for SO2R use but a basic form to play the internal radio voice memories are:

{CAT1ASC PB0#;} (where # is a number 1 – 5 for message 1 – 5)
{CAT1ASC PB00;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.

The stereo (grave accent – `) key toggles Sub RX On and Off. To leave SUB On all the time, select Configurer>Sub
Receiver Always On
Subrx ON/OFF control

Independent of the state of Sub Receiver Always On:
Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow turns the subrx ON
Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub does not change the state of the subrx
The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on VFOA. This action is disabled if RX
Focus on VFOB.

Sub Receiver Always On checked:
Clicking any VFO, Bandmap, or Available window spot or Ctrl+Up/Dn turns the subrx ON
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Changing RX Focus with \ turns the subrx ON
If Sub Receiver Always On was unchecked and the user checks it, subrx is turned ON

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA with the \ keystroke, the subrx
stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA (PAUSE, CTRL+Left or
VFOA Bandmap/Available window spot click ), the subrx is turned OFF
If Sub Receiver Always On was checked and the user unchecks it, subrx is turned OFF

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and the Sub RX is ON, turn “Sub Receiver Always On” to OFF and leave the
Sub RX ON
If “Sub Receiver Always On” is ON and the Sub RX is OFF, turn “Sub Receiver Always On” to OFF and leave the
Sub RX OFF
If “Sub Receiver Always On” is OFF and the Sub RX is ON, turn “Sub Receiver Always On” to ON and leave the
Sub RX ON
If “Sub Receiver Always On” is OFF and the Sub RX is OFF, turn both ON

Alt+F12 action is similar to the stereo (`) key, but also affects “Sub Receiver Always On” state:
If the subrx is OFF – check “Sub Receiver Always On” and turn the subrx ON
If the subrx is ON – uncheck “Sub Receiver Always On” and turn the subrx OFF unless RX Focus is on VFOB

Also see the Advanced SO2V for Radios with Separate Sub-Receivers section of this manual.

Digital Mode Mapping for the FT-2000
RTTY = FSK(RTTY-LSB)
RTTY-R = FSK-R(RTTY-USB)
AFSK = PKT-LSB
AFSK-R = PKT-USB
nothing for psk or psk-r

FTDX-1200

The radio menu settings:
CAT TOT should be set to 1000 or higher.
CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400 (38400, N, 8, 2).

There are other forms of the CATMacros for SO2R use but a basic form to play the internal radio voice memories with
the DVS-6 option are:

{CAT1ASC PB0#;} (where # is a number 1 – 5 for message 1 – 5)
{CAT1ASC PB00;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.

FTDX-3000

The radio menu settings:
CAT TOT should be set to 1000 or higher.
CAT SELECT must be set to USB if you wish to use the internal USB port for CAT control.
PC KEYING (menu 65) must be set to DTR to send CW with a COM port or with the USB port on the radio.
CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400 (38400, N, 8, 2).

When using a COM port cable that contains signaling wires (RTS & DTR), verify that the radio menu CAT RTS =
ENABLE (default) and the program radio COM port RTS to Handshake.
When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu
and set the program radio COM port RTS to Always OFF.
To use on the internal radio codec for on the fly voice recording and playback:

Check “PTT via Radio Command SSB Mode” in the radio COM port configuration window.
Check “Internal Radio Codec” in the Playback tab of Logger+ Audio Setup.

The basic CatMacro used to play the internal radio voice memories is:
{CAT1ASC PB0#;} (where # is a number 1 – 5 for message 1 – 5)
{CAT1ASC PB00;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.
See the Macros section for other vfo or radio based CATMacro.

The USB driver for the FTDX-3000 will install two virtual serial ports. One, called the “enhanced COM port”, can be
used for CAT control, while the other, the “standard COM port”, can be used for PTT, CW or FSK keying

Digital Mode Mapping for the FTDX-3000
RTTY = FSK(RTTY-LSB)
RTTY-R = FSK-R(RTTY-USB)
AFSK = PKT-LSB
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AFSK-R = PKT-USB
nothing for psk or psk-r

FTDX-5000

The radio menu CAT TOT should be set to 1000 or higher.
The radio menu CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400 (38400,
N, 8, 2).
When using a COM port cable that contains signaling wires (RTS & DTR), verify that the radio menu CAT RTS =
ENABLE (default) and the program radio COM port RTS to Handshake.
When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu
and set the program radio COM port RTS to Always OFF.
There are other forms of the CATMacros for SO2R use but a basic form to play the internal radio voice memories are:

{CAT1ASC PB0#;} (where # is a number 1 – 5 for message 1 – 5)
{CAT1ASC PB00;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.

The SCU-17 does not allow for PTT with CW when used with the FTdx5000 (the FTdx5000 uses the PTT line instead
of FSK line for CW). There are two PTT choices when using a SCU-17. Use VOX and set the semi break-in delay (vox
delay in the transceiver) for CW or enable software control of PTT (“PTT via Radio Command CW Mode”) in the radio
COM port configuration window.

The stereo (grave accent – `) key toggles Sub RX On and Off. To leave SUB On all the time, select Configurer>Sub
Receiver Always On
Subrx ON/OFF control

Independent of the state of Sub Receiver Always On:
Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow turns the subrx ON
Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub does not change the state of the subrx
The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on VFOA. This action is disabled if RX
Focus on VFOB.

Sub Receiver Always On checked:
Clicking any VFO, Bandmap, or Available window spot or Ctrl+Up/Dn turns the subrx ON
Changing RX Focus with \ turns the subrx ON
If Sub Receiver Always On was unchecked and the user checks it, subrx is turned ON

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA with the \ keystroke, the subrx
stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA (PAUSE, CTRL+Left or
VFOA Bandmap/Available window spot click ), the subrx is turned OFF
If Sub Receiver Always On was checked and the user unchecks it, subrx is turned OFF

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and the Sub RX is ON, turn “Sub Receiver Always On” to OFF and leave the
Sub RX ON
If “Sub Receiver Always On” is ON and the Sub RX is OFF, turn “Sub Receiver Always On” to OFF and leave the
Sub RX OFF
If “Sub Receiver Always On” is OFF and the Sub RX is ON, turn “Sub Receiver Always On” to ON and leave the
Sub RX ON
If “Sub Receiver Always On” is OFF and the Sub RX is OFF, turn both ON

Alt+F12 action is similar to the stereo (`) key, but also affects “Sub Receiver Always On” state:
If the subrx is OFF – check “Sub Receiver Always On” and turn the subrx ON
If the subrx is ON – uncheck “Sub Receiver Always On” and turn the subrx OFF unless RX Focus is on VFOB

Also see the Advanced SO2V for Radios with Separate Sub-Receivers section of this manual.

Digital Mode Mapping for the FTDX-5000
RTTY = FSK(RTTY-LSB)
RTTY-R = FSK-R(RTTY-USB)
AFSK = PKT-LSB
AFSK-R = PKT-USB
nothing for psk or psk-r

FTDX-9000

The radio menu CAT TOT should be set to 1000 or higher.
The radio menu CAT RATE must match the program COM port baud rate. The suggested baud rate is 38400 (38400,
N, 8, 2).
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When using a COM port cable that contains signaling wires (RTS & DTR), verify that the radio menu CAT RTS =
ENABLE (default) and the program radio COM port RTS to Handshake.
When using a COM port cable with only three wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu
and set the program radio COM port RTS to Always OFF.
There are other forms of the CATMacros for SO2R use but a basic form to play the internal radio voice memories are:

{CAT1ASC PB#;} (where # is a number 1 – 5 for message 1 – 5)
{CAT1ASC PB0;} (stop)
The DVK stop command is sent to the radio when the ESC key is pressed.

The stereo (grave accent – `) key toggles Sub RX On and Off. To leave SUB On all the time, select Configurer>Sub
Receiver Always On
Subrx ON/OFF control

Independent of the state of Sub Receiver Always On:
Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow turns the subrx ON
Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub does not change the state of the subrx
The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on VFOA. This action is disabled if RX
Focus on VFOB.

Sub Receiver Always Onchecked:
Clicking any VFO, Bandmap, or Available window spot or Ctrl+Up/Dn turns the subrx ON
Changing RX Focus with \ turns the subrx ON
If Sub Receiver Always On was unchecked and the user checks it, subrx is turned ON

Sub Receiver Always On unchecked:
If the TX & RX Focus is on VFOB and the RX Focus changes to VFOA with the \ keystroke, the subrx
stays ON
If the TX & RX Focus is initially on VFOB and then RX & TX Focus is on VFOA (PAUSE, CTRL+Left or
VFOA Bandmap/Available window spot click ), the subrx is turned OFF
If Sub Receiver Always On was checked and the user unchecks it, subrx is turned OFF

Ctrl+Alt+D command action:
If “Sub Receiver Always On” is ON and the Sub RX is ON, turn “Sub Receiver Always On” to OFF and leave the
Sub RX ON
If “Sub Receiver Always On” is ON and the Sub RX is OFF, turn “Sub Receiver Always On” to OFF and leave the
Sub RX OFF
If “Sub Receiver Always On” is OFF and the Sub RX is ON, turn “Sub Receiver Always On” to ON and leave the
Sub RX ON
If “Sub Receiver Always On” is OFF and the Sub RX is OFF, turn both ON

Alt+F12 action is similar to the stereo (`) key, but also affects “Sub Receiver Always On” state:
If the subrx is OFF – check “Sub Receiver Always On” and turn the subrx ON
If the subrx is ON – uncheck “Sub Receiver Always On” and turn the subrx OFF unless RX Focus is on VFOB

Also see the Advanced SO2V for Radios with Separate Sub-Receivers section of this manual.

Digital Mode Mapping for the FTDX-9000
RTTY = FSK(RTTY-LSB)
RTTY-R = FSK-R(RTTY-USB)
AFSK = PKT-LSB
AFSK-R = PKT-USB
nothing for psk or psk-r

Unsupported Radios
JRC JST-145 & JST-245 – These radios are unsupported because they lack commands to determine if the radio is in
split, no means to set or clear split, the VFO can not be selected, and they lack an indicator to determine which VFO is
active.

Other Models
Submit a Feature Request along with a URL for the developers information for the computer interface. Radios with
limited radio control or very long data exchanges are not well suited for this software application.
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Digital Modes
2019-03-29

Digital Modes
WSJT (FT8,FT4) versus other digital modes (RTTY, PSK)
There are two broad classes of digital modes supported by N1MM+.

The first class of digital modes comprises “conversational” keyboard-to-keyboard modes in which the two parties to a QSO
exchange messages made up of characters (letters, numbers or punctuation characters). These messages may be of
arbitrary lengths and may contain any information that can be written down in letters and numbers. There is no restriction on
when a transmission may begin, other than the usual admonition to avoid having both parties to a QSO transmitting at once.
These modes are conceptually quite similar to CW. N1MM+ implements them with the help of either a hardware interface
(TNC or TU) or more often, using “digital engine” software. This software, in conjunction with a sound card or codec, acts as a
modem to translate when transmitting between characters, either stored in message files or input from the keyboard, and the
varying frequencies that are actually transmitted, and on receive, between the received signals and the characters displayed
on the screen. The digital engine software may also display some kind of tuning aid to help users to tune signals in accurately.

The second class of digital modes is a family of modes supported by the WSJT-X program and its offshoots. The best-known
of these modes are FT8 and FT4, but there are many more. All of these modes share similar characteristics. They are all
synchronized to clock time, to within a tolerance of around 1 second; all of the FT8 signals being transmitted at any time are in
lock-step. All transmitted messages in a given mode are exactly the same length. The contents of the messages are very
limited; there are only half a dozen stereotyped message formats, and the contents must fall within narrowly-defined
categories. The full range of contest exchanges seen in CW, SSB and RTTY contests cannot be supported by WSJT-X and
similar programs. Only a few contest exchange types are supported: North American and European VHF contest exchanges,
the ARRL RTTY Roundup exchange, and the ARRL Field Day Exchange are the only contest exchanges supported.

This raises the question of why anyone would want to use these modes in contests, given the restrictions described in the
previous paragraph. The answer is that these modes are able to support communications under conditions where traditional
modes fail. The name “WSJT” stands for “Weak Signal Joe Taylor” (Joe Taylor, K1JT, is the inventor of these modes), and as
the “Weak Signal” part of that name suggests, it is possible for stations with modest power and antennas to communicate
using these modes when traditional modes fail. The FT8 mode in particular became widely popular for DXing, and demands
for the ability to use it in contests followed, particularly for popular VHF contests and Field Day.

Because of the differences in the way these modes work and are implemented, the interaction between N1MM+ and the
WSJT-X digital engine is different from the interaction with digital engines for the other digital modes. The entire conduct of
QSOs in WSJT modes is controlled by the WSJT-X program. The only role that N1MM+ plays is to perform radio control
functions on behalf of WSJT-X, and to store logged QSOs in a combined log that includes contacts made in other modes,
including CW and SSB as well as the WSJT-mode contacts. By using N1MM+ in combination with WSJT-X, users are able to
combine contacts made in all modes into a single log for dupe- and multiplier-checking.

The interaction between N1MM+ and WSJT-X is controlled through a special window in N1MM+ called the WSJT Decode List
window. Instructions on how to interface the two programs and use them in combination in contests is found in the manual
chapter on the WSJT Decode List Window.

The rest of this chapter deals only with traditional conversational digital modes (RTTY, PSK and similar digital modes).

General RTTY and PSK Information
Digital mode contesting is growing rapidly. N1MM Logger+ supports digital mode contesting, not only RTTY but also other
digital modes including the modes implemented in WSJT-X and similar programs. If you are new to digital modes, you might
want to read over this section. If you are familiar with digital modes and eager to get N1MM Logger+ working for them, you
might want to proceed directly to the Digital Setup section for keyboard-to-keyboard modes like RTTY and PSK, or to the
Decode List Window chapter for WSJT modes like FT8 and FT4.
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RTTY Information

This section contains some general information about operating in RTTY that is not directly related to N1MM Logger+. For
RTTY newbies, it is recommended that you read AA5AU’s tutorial on getting started on RTTY. If you are new to digital mode
contesting in general and RTTY in particular, the following information may also be helpful. If you are an old-timer on RTTY,
you can probably skip this section.

Before the spread of personal computers, RTTY was the most prevalent digital mode (other than CW, that is), and was done
using surplus teletype equipment – mechanical teleprinters. This equipment posed severe constraints on the RTTY mode that
are still evident today. Despite these constraints, RTTY has proven to be quite well-adapted to contesting, and it is still by far
the most common digital contesting mode.

More recently, these mechanical teleprinters have been replaced by other devices. At first these were mostly separate boxes
containing embedded microprocessors (called “terminal units”. “TUs” or “TNCs”), but now the most common device for
decoding and encoding RTTY is simply a sound card in a personal computer. N1MM Logger+ is capable of using either a
hardware terminal unit or one of several software “engines”, including MMTTY, MMVARI, Fldigi and 2Tone. Because there is
no one method, whether it be a software program or a hardware modem, that performs better than the others under all
conditions, N1MM Logger+ also supports the capability to run two or more such methods in parallel, thus gaining the
advantages of both. For example, a user might choose to use a terminal unit such as the HAL DXP-38 in parallel with one or
more copies of MMTTY using different decoding algorithms and parameters, in the hope that when conditions are marginal,
one or another of the parallel decoders will succeed even when the others are failing to decode accurately.

The most commonly used digital engine for RTTY is MMTTY. MMTTY performs very well, and offers a wide range of
adjustments and options that are not available with the other available choices. However, MMTTY does not support other
digital modes like PSK31. Amateurs who wish to use other digital modes will have to use either MMVARI or Fldigi as the digital
engine for those modes, and users who are accustomed to using one of these engines for other modes may prefer to use the
same engine for RTTY instead of switching to MMTTY. MMVARI comes pre-loaded with N1MM Logger+, whereas MMTTY,
Fldigi and 2Tone must be downloaded and installed separately.

An RTTY signal is a single carrier (like CW), but instead of being modulated on and off like CW, the transmitted power is kept
constant, and modulation is imposed by changing the frequency by a preset amount; in amateur usage, the historical practice
is to use a “shift” of 170 Hz. That is, RTTY is modulated using frequency-shift keying (FSK). The frequency shifting can be
done either within the radio in radios which support this method, or external to the radio at audio frequencies (for example, in a
computer sound card).

The first method (usually called FSK) requires an on-off keying signal to be applied to a keying input to the radio. This keying
is very similar to CW keying, except that instead of turning the carrier on and off as in CW, closing the key input shifts the
transmitter’s frequency. FSK therefore requires an on-off keying interface between the computer and the radio, and the radio
must have the internal circuitry required to perform the frequency shifting. Radios that support this FSK mode usually have
other features that assist RTTY operators, such as specialized filtering.

The second method, using audio tones fed into an SSB transmitter which converts the tones to RF in exactly the same way
that SSB converts audio voice frequencies to RF, is called Audio Frequency Shift Keying (AFSK). AFSK can be used with any
SSB transmitter. Because the optimum filtering and other settings for RTTY operation are different from those for voice
communication, some transceivers offer special AFSK or digital-mode modes, but fundamentally these specialized audio
digital modes operate in the same way as SSB.

There are never-ending arguments among amateurs as to which method is better, FSK or AFSK. If a station has been
successfully set up for other sound-card digital modes, such as PSK31, that same setup can be used for AFSK RTTY,
whereas the hardware configuration needed for FSK is unique to RTTY and cannot be used for other digital modes. However,
some radios do not support the use of narrow receiving filters in SSB mode, which makes FSK better for RTTY contesting with
those radios from an operational point of view. From a signal quality point of view, the very best AFSK setups can produce
signals that are somewhat cleaner (occupy less spectrum) than most FSK transmitters are capable of, but on the other hand,
a poorly set up AFSK station can transmit spurious signals, splatter or hum and noise. Badly configured AFSK setups are
unfortunately more common than they should be, and give AFSK a bad name. When using AFSK, care must be taken to
ensure that audio levels are set correctly; FSK does not require the same level of care.

Whether using FSK or AFSK, digital modes are harder on transmitting equipment than CW and SSB because of the higher
duty cycle (sustained periods of full-power transmitting). As a result, it is important not to overstress the transmitter. It is also
important to take steps to avoid transmitting extraneous noises or spurious signals, and to ensure that neither audio
harmonics nor intermodulation distortion (IMD) products are generated anywhere in the signal chain.

Here are some tips for RTTY setup and operation:

Hardware interfacing:

Unless your radio has a USB Codec built in (e.g. IC7200 and 7600), in order to receive RTTY you will need to connect
the audio output from your radio to the input of the sound card being used with your computer, or if you are using a
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TNC or TU, to its audio input (see the manual for your TNC/TU for details)
To transmit:

For AFSK, you need to connect the audio output from your sound card or TNC/TU to an audio input on your
radio (exception: radios with a built-in USB Codec), either directly or via a sound card interface
For FSK, you need a keying circuit from a serial port to your radio’s FSK keying input. If you are using a USB-to-
serial adapter, you will probably need to use the EXTFSK or EXTFSK64 plug-in in MMTTY
For either AFSK or FSK, you need some way to control PTT (TX/RX switching). In AFSK, VOX operation is the
simplest method with many radios, although some radios do not support the use of VOX with the line-level audio
inputs used for AFSK. Also, VOX is not possible in FSK. If you use PTT control from N1MM Logger in other
modes, the same method can be used in digital modes. Alternatively, you can control PTT from the digital engine
using a serial port with a keying circuit. In FSK, the same port can be used for both PTT and FSK
When using AFSK, make sure that all forms of audio processing, compression, speech processing, hi boost, etc.
are turned off
If you are using SSB for AFSK, MMTTY expects the radio to be in LSB on all bands, whereas Fldigi expects the
radio to be in USB on all bands. Both of these engines have means to operate on the “other” sideband, using a
“Reverse” (“Rev” or “Rv”) button
See the Interfacing chapter for url’s and tips on interfacing
Note that the character set used in RTTY does not have all ASCII characters, so some special characters can
not be printed/transmitted

Common RTTY Frequencies

Contests USA (KHz) USA (KHz) Europe/Africa (KHz) Japan (KHz)

Common Common DX frequency Common Common

1800 – 1810
1835 – 1845 1800 – 1810 1838 – 1843 1838 – 1843 –

3570 – 3600 3580 – 3600 3590 3580 – 3620 3520 – 3530

7025 – 7100 7025-7050
7080 – 7100 7040 7035 – 7045 7025 – 7040

– 10120 – 10150 – 10140 – 10150 –

14060 – 14120 14080 – 14100 – 14080 – 14100 –

– 18100 – 18110 – 18100 – 18110 –

21060 – 21150 21080 – 21100 – 21080 – 21120 –

– 24910 – 24930 – 24920 – 24930 –

28060 – 28150 28080 – 28100 – 28050 – 28150 –

General RTTY Information

There are two aspects of RTTY which are often confusing to newcomers to the mode.

The first of these is the “polarity” of the signal. In FSK, there are two frequencies, conventionally called “mark” and “space”. In
amateur RTTY, these two frequencies are almost always separated by 170 Hz, and the mark frequency is the higher of the
two RF frequencies. Someone who is transmitting with the opposite polarity is said to be transmitting “upside down”. His signal
will be gibberish at the receiving station, unless the operator there inverts his receive polarity. When first setting up for RTTY, if
you appear to be unable to decode any signals you receive, try inverting your receive polarity (in MMTTY, use the “Rev”
button; in 2Tone, use the ” < Swap > ” button; in MMVARI, switch between RTTY-L and RTTY-U settings; in Fldigi, use the “Rv”
button).

In FSK, getting the polarity right involves arranging things so that the switching conventions (does closing the keying input
result in mark or space?) match between the radio and the computer. Unfortunately, the switching conventions are not
universal. Fortunately, almost all radios affected by this have a menu item in the radio to reverse the keying polarity. Once this
option is set correctly, the radio’s transmit RTTY polarity will be correct from then on. On receive, most if not all radios in FSK
mode receive RTTY on the lower sideband. If software is used to demodulate the received signal, it must be set so that the
lower of the two audio tones is converted to mark and the upper tone to space. This is the default configuration in most
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software that supports FSK keying. Note that in FSK, the transmit and receive polarities are determined independently, i.e. it is
possible to receive correctly and yet to transmit upside down.

In AFSK, getting the polarity right involves coordination between the choice of audio frequencies generated in the sound card
and the choice of sideband on the radio. The default combination in MMTTY and 2Tone is to use lower sideband on the radio,
combined with an audio tone pair in which the mark tone is the lower of the two audio frequencies (e.g. the most common pair
is mark = 2125 Hz, space = 2295 Hz). The use of the lower sideband inverts these tones at RF to match the standard amateur
convention. Software like Fldigi that uses the opposite convention (mark tone higher than space) is used with the radio in
upper sideband. Fortunately, once the receive polarity is correct in AFSK, the transmit polarity will also be automatically
correct.

The second sometimes puzzling aspect is related to the RTTY character set. The digital code used in RTTY predates the
ASCII code used by modern computers. Instead of 8 bits, which allows for 256 different characters, the Baudot or Murray
code used in RTTY has only 5 bits. This 5-bit code only has enough different characters for 26 letters plus 6 control codes, so
to get numbers and punctuation the text has to be preceded with a special “FIGS” character (one of the 6 control codes) to get
a second set of 26 characters (10 numbers plus 16 punctuation marks). FIGS is “sticky”, so there is another special “LTRS”
character to switch back to the letters case.

Just like any other character, these FIGS and LTRS characters can be damaged by noise, QRM, QSB, etc., and if they are,
the received info is displayed wrongly until the next LTRS or FIGS character (or in some situations, the next space character)
comes along and sets things right. Sometimes the opposite happens – a text character is converted by noise into a FIGS or
LTRS code, with similar results.

The most common problem that results is numbers being printed as letters, so with a bit of experience, many RTTY operators
will get used to interpreting TOO as 599 and UE as 73. Serial numbers are slightly more difficult; PQW in the input data is
most likely 012, and so on. You can see which letter corresponds to which number by comparing the top (QWERTY) row of
letters on the keyboard with the numbers immediately above and to the left. Letters can also be printed as numbers and
punctuation; for example, CQ TEST when converted to FIGS case becomes :1 53’5 .

Various software has different ways of helping out with this. When you run MMTTY stand-alone, if you right click on a “word”
(delimited by spaces), the entire word changes to the opposite case. So, for example, VE4AEO is changed to ;3R-39 and vice
versa. N1MM’s digital window has a box titled Letters/Figs for opposite-case display, that shows text that the mouse “hovers”
over (no click necessary) in the opposite case. This requires you to move the mouse over the text that you want to convert;
the unconverted text is displayed in the MouseOver box.

There is a common feature called Unshift on Space (UOS or USOS) whose purpose is to deal with the lost {FIGS}/{LTRS}
problem. It was designed for normal text, where the majority of information is alphabetic.

MMTTY has two UOS options. One of these is a button on the MMTTY main window that affects what you see in the receive
window; the other is a setup option (under the Tx tab in the MMTTY setup) that affects what you transmit.

The receive option in the main window simply changes the receive window’s case back to {LTRS} at the beginning of every
new “word”, i.e. after a space, unless of course the new “word” starts with {FIGS}. This takes no extra time, but improves
reliability of receipt of alphabetic text.

The transmit option, on the other hand, actually transmits extra {FIGS} characters at the beginning of every numeric “word” to
try to ensure greater reliability. It does not transmit an extra “LTRS” at the beginning of every alphabetic word, because using
UOS on receive is a more efficient way to achieve the same end result.

When you are ragchewing, you should always use UOS on both receive and transmit. UOS assumes that the majority of
“words” are alphabetic, which is true of normal text.

During contests, the receive UOS option is still helpful, especially when the exchange includes letters, and it does not cost
anything. The N1MM Logger DI window’s “Letters/Figs” line can be used to deal with those cases where receive UOS
converts an intended numeric field to letters.

The transmit UOS option achieves greater reliability of numeric exchanges at the cost of some extra {FIGS} characters. If you
are concerned about the slight speed penalty it imposes, you can leave transmit UOS on and use dashes (“-“) instead of
spaces between all-numeric fields, e.g. 599-123-123 . Do not make the mistake of using dashes between alphabetic fields
though; dashes between alphabetic fields are both slower and less reliable than spaces. The downside of using dashes in this
way between numeric fields is that if the initial {FIGS} character is lost, the entire exchange will be in the wrong case, e.g.
TOOAQWEAQWE. Sending spaces with transmit UOS on costs two extra {FIGS} characters but is more reliable (our example
with an initial lost {FIGS} character becomes TOO 123 123). On the other hand, turning transmit UOS off results in 599 QWE
QWE in any receiver using UOS, even with no errors at all. A compromise among all of these possibilities is to always turn
transmit UOS on, but use a hybrid exchange: 599-123 123 (a dash instead of a space after the signal report, but spaces after
that). A single {FIGS}/{LTRS} error will not prevent at least one copy of the exchange from being decoded correctly regardless
of whether the receiving station is using UOS or not.
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PSK Information

General PSK Information

PSK31 (and its higher-speed versions, PSK63 and PSK125) is an example of a “sound-card digital mode”, i.e. a digital mode
that was made possible by the use of sound cards in PCs. The advent of sound cards in PCs made these sound-card modes
available for anyone to use with a minimum of expense. All that is needed is an SSB transceiver, an audio interface (which
can be as simple as patch cables, or can include isolation and attenuation controls) and a means of controlling PTT, unless
VOX is used.

N1MM Logger+ supports PSK31 and other sound-card digital modes using either of two digital engines: MMVARI and Fldigi.
MMVARI comes pre-loaded with the program, whereas Fldigi has to be downloaded separately. Fldigi supports a wider variety
of digital modes than MMVARI, although the majority of these modes are not used for contesting.

Conventionally, sound-card digital modes are communicated using USB, regardless of the band. Many PSK31 users set their
radio’s dial to a standard frequency (14070.0 kHz is the most common) and then look for signals anywhere within their SSB
filter bandwidth (e.g. from 250 Hz to 2750 Hz or so, which would correspond to transmitted frequencies from 14070.25 kHz to
14072.75 kHz). PSK31 signals are narrow-band, so there can be many different PSK31 signals simultaneously copyable
within the available frequency range without changing the radio’s dial setting. Tuning is often done simply by clicking on the
desired signal in the waterfall display.

PSK31 is short for “Phase Shift Keying, 31.25 baud”. There are also higher-speed versions, PSK63 (62.5 baud – seen fairly
often) and PSK125 (125 baud – not quite so common). Actually, in addition to using phase shift keying for modulation, PSK31
also uses amplitude modulation (“waveform shaping”) to minimize the bandwidth occupied by a signal. As a result of this
combination of phase and amplitude modulation, PSK31 places great requirements on the linearity of the equipment used,
from the sound card generating the signal to the transmitter, and also the receiver. The peak power of a PSK31 signal can be
approximately twice as high as the average power. If a transmitter is operated near its power handling capacity, it can clip
these peaks, resulting in “splatter”, which shows up on the waterfall as extra “tracks” in addition to the two main modulation
tracks that are normally visible. To avoid having this happen, the audio levels in the sound card and in the transmitter’s input
audio stages must be controlled to avoid reaching power levels that would result in clipping. In most transmitters, this is
equivalent to keeping the power below the level that would result in ALC action, and usually this also means powers below
approximately half the transmitter’s maximum power rating.

Standard PSK31 (sometimes also called binary phase shift keying, or BPSK31) is sideband-independent. There is a rarely-
used variation called QPSK31 (or QPSK63 for the 62.5 baud speed) that uses four phases instead of two (quadrature phase
shift keying). This allows for some error correction while still delivering the same text speed. QPSK31 is sideband-dependent,
i.e. the transmitting and receiving station must both be using the same sideband in their radios (by convention, upper
sideband).

PSK31 works well even at low powers. In fact, once the transmitted power is sufficiently high to give an acceptable level of
copy, there is no advantage to be gained by increasing power further. Unlike analog modes, where increasing power may
make your signal louder relative to QRM and therefore easier to copy, increasing the power in PSK31 does not necessarily
improve your signal’s readability. It can even degrade copy by overloading the other station’s receiver and creating splatter
within the receiver. More importantly, a very strong signal will affect the AGC in every receiver that picks it up, causing the
receiver gain to decrease and making copy of signals on other frequencies more difficult. For this reason, high-power
operation is unpopular in PSK31.

When you plan to run PSK:

Keep your macros short.
PSK is about 1/3 slower than RTTY; you can really impact your rates with wordy macros

Use lower case letters wherever possible
PSK is a varicode mode. That means that characters contain a variable number of bits, unlike ASCII characters
that have a fixed number of bits. Most lower-case PSK characters have fewer bits in them than their upper-case
equivalents, so lower-case (in general) transmits faster

Make sure all forms of speech processing and audio processing in the radio are turned off. Also, make sure any special
effects in the sound card are turned off as well
Transmitter linearity is extremely important in PSK

Keep power below 1/2 the transmitter rating to avoid clipping peaks
Avoid any visible ALC action (except in radios with ALC designed for PSK, e.g. Elecraft K3/KX3)

Common PSK and Digital Frequencies

PSK31 activity generally starts from the bottom edge of the IARU RTTY bandplan, expanding upwards as activity increases.
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Band Digital frequencies (KHz) PSK frequencies (KHz) Remarks

160 meter 1800 – 1810
1838 – 1843

1807
1838 1807 in Region 2

80 meter 3575 – 3585 3580 –

40 meter 7030 – 7040
7060 – 7085

7035
7080 7080 in Region 2

30 meter 10130 – 10145 10142 WARC, no contesting

20 meter 14065 – 14090 14070 –

17 meter 18100 – 18110 18100 WARC, no contesting

15 meter 21060 – 21090 21080 –

12 meter 24920 – 24930 24920 WARC, no contesting

10 meters 28110-28125 28120 –

WSJT modes

The WSJT-X program and offshoot or clone programs based on it (such as JTDX) implement a number of weak signal modes,
including FT8, FT4, JT65, JT9, MSK144, and several others. These are not contesting programs, and while WSJT-X does
support a limited number of contests, its support for duplicate checking, multiplier checking, and score calculation is minimal.
Since some contests (digital HF contests and VHF contests) make use of these modes, a way to integrate WSJT-X with
N1MM Logger+ has been implemented in order to enable the use of N1MM+’s contesting features while operating in these
modes.

N1MM Logger+ has the capability to interoperate with WSJT-X and similar programs so that contacts made in the WSJT-
mode program will be logged directly into the N1MM+ log. The actual operating is done in WSJT-X, but dupe checking,
multiplier checking, scoring and generation of Cabrillo files can all be done by N1MM+.

For instructions on how to set up and operate in WSJT modes with N1MM+, see the chapter on the WSJT Decode List
Window. This window controls the communications between the two programs.

Digital Overview and Features
The digital part of the N1MM logger program (including the integration with WSJT-X/JTDX) is designed, coded and maintained
by Rick Ellison, N2AMG.

After the first overview part, which should be of interest to anyone getting started using digital modes with the Logger, the
remainder of this section of the manual is a potpourri of miscellaneous ideas and suggestions on how to use the Logger in
digital modes other than the WSJT modes. If your main interest is in getting N1MM Logger+ up and running in keyboard-to-
keyboard digital modes like RTTY and PSK, after checking out the overview you might prefer to proceed directly to the Digital
Setup section. If your main interest is in WSJT modes, see the Decode List Window chapter.

Digital Overview

N1MM Logger+ supports a variety of methods to decode and transmit digital modes, including an external TNC/TU; the
MMTTY engine for RTTY (sound card on receive, either sound card AFSK or FSK keying on transmit); G3YYD’s 2Tone drop-
in replacement for MMTTY, for AFSK RTTY; the MMVARI engine for RTTY (AFSK or FSK), PSK31, PSK63, PSK125 (both
BPSK and QPSK), and MFSK16; or the Fldigi engine for a broad range of sound-card digital modes including AFSK RTTY,
PSK and many more. Regardless of which of these engines is used, the digital data streams pass to and from the engine via
the Digital Interface (DI) window. At least one DI window must be open to operate the Logger in digital modes. Depending on
your hardware configuration and operating mode, you may have either one (SO1V, SO2V) or two (SO2V, SO2R) DI windows
open. Both DI windows have full receive and transmit capabilities. It is also possible to supplement the two DI windows with up
to four additional receive-only windows each. The user can interact with the DI windows using either the keyboard or the
mouse as the primary control interface. There is a wide variety of options available to customize the operation of the digital
interface.

There is a separate set of digital modes, originally designed for weak-signal situations, and implemented in WSJT-X and other
programs based on the WSJT-X code (such as JTDX). These modes can also be used with N1MM+, but unlike RTTY and
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PSK modes, they do not use the Digital Interface window that is described here. For information on how to operate in these JT
modes, see the manual section on the WSJT Decode List window.

For RTTY, the most popular interface engine is MMTTY. MMTTY performs very well, supports both FSK and AFSK, and has a
wide variety of options and parameters that can be adjusted to tweak its performance. Many new users of N1MM Logger+ will
already be familiar with MMTTY, either from using it stand-alone as an RTTY program, or from using it from within another
contesting or general logging program. MMTTY does not come pre-installed with N1MM Logger+; it must be downloaded and
installed separately, and then the Logger can be configured to use it.

An alternative to MMTTY, using different decoding and encoding algorithms that perform better than MMTTY under some (but
not all) conditions, is 2Tone. 2Tone was written by G3YYD to be a replacement for MMTTY without requiring any changes to
the interface programming. That is, anywhere the MMTTY program is called up in N1MM Logger+, 2Tone can be used instead
simply by changing the path to the program in the configuration. Probably the most common use for 2Tone is in parallel with
MMTTY. One of the programs is used in the main Digital Interface window, and the other one is used in an additional RX-Only
window. You may choose to use MMTTY in the main window and 2Tone in the additional window (this arrangement is popular
with people using FSK), or vice versa.

MMTTY and 2Tone do not support other sound card digital modes, of which the best-known is probably PSK31. Users of
those other digital modes can choose either MMVARI or Fldigi as the digital engine for those modes. MMVARI comes pre-
loaded with N1MM Logger+, whereas Fldigi has to be downloaded and installed separately. Fldigi supports a wider variety of
modes, although most of those modes are not used for contesting. For most users, it is probably the user interface that
determines which of these two engines they prefer. Users who are accustomed to operating digital modes using one of these
engines may be more comfortable using the same engine for RTTY as well, instead of switching to MMTTY.

While MMTTY typically performs as well as or better than most of the hardware interfaces that were formerly common for
RTTY (e.g. multi-mode TNCs), there are some terminal units that can rival or exceed it in performance under some conditions.
Users who already have one of these devices may wish to consider using it with N1MM Logger+, either on its own or in
parallel with MMTTY. For most such terminal units, the user will have to program the software commands needed to control
the unit into the digital interface. An exception is the HAL DXP-38, which is supported directly without requiring user
programming.

The remainder of this section describes the operation of the DI windows, including basic operation as well as advanced
features that can help make operation easier and more efficient. A separate section describes how to set up N1MM Logger
and the DI Window for digital modes regardless of which type of digital engine is used. Engine-specific details are described in
separate sections for each of the supported engines (MMTTY, MMVARI, Fldigi and external TNCs; 2Tone is included under
MMTTY).

Making QSOs

This section explains:

How to make a Digital mode transmission
Keyboard, Insert key and Mouse Assignments
Function keys
Macros

Make a Digital Mode Transmission

Select ‘Window | Digital Interface’ and the Digital Interface will open. The Digital Interface window can be positioned
and resized on your monitor as desired
In the Entry window’s call sign box, type “RTTY” (without the quotation marks) if you want to use RTTY, or “PSK”
(without the quotation marks) if you want to use PSK or another sound-card digital mode
If an external TNC is used only the Digital Interface window is opened. When one of the sound card interfaces is
chosen an extra window will appear: MMTTY (or 2Tone), MMVARI or FLDIGI depending on which interface is selected
in the DI window’s Interface menu
Left clicking on a call will grab the callsign. Right clicking on the RX and TX windows will show a menu (this can be
changed via a menu setting)
Pressing Insert will Grab the highlighted call and sends Hiscall followed by the Exchange button
Double clicking on a call sign in the call sign box from the Digital Interface sends that call to the Entry window
A call sign is automatically highlighted if recognized by the program. Call signs are always recognized when they are
both preceded and followed by a space. There is also an option to recognize call signs buried in garbage (without a

Problems?

Check out the Digital Modes part of the Frequently Asked Questions (FAQ).
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leading or trailing space), provided that call sign is in the master.scp file

Digital Need to Know

If the call sign in the call sign field in the Entry window is equal to the call sign in the received text, the call in the Entry
window does not get placed into the Grab list.

Pressing Ctrl while single clicking on a call will force the call into the Entry window
Click in the Entry window input field you want data to go to and then hold down the Ctrl key while clicking on the
corresponding data in the RX window. It will paste to the field you clicked into
“-” separators between exchange elements are removed automatically
CQ Repeat time starts

when using a sound card engine, from when the sending stops
when using an external TNC, from when the message begins, as there is no way to tell when the TNC finishes
sending

During transmit, call signs are not grabbed from the receive window
Linefeed characters (LF) in incoming text are replaced with Carriage Return (CR) characters

Auto-CQ with a TNC To get auto-CQ to work correctly with a TNC set your repeat time to at least 9 or 10 seconds. It
may need to be longer if you have a longer CQ macro. This will stop the TNC buffer from receiving the next string
before it finishes sending the last one.
Clear the TNC Transmit Buffer It is best to add the command that your TNC uses to clear the transmit buffer to the
end of your Abort Macro. If not, the transmit buffer still holds the remaining characters that were left in the sent string
and will get sent the next time the TNC sends.
Stop Sending CQ When using a TNC turn off Config >Function Keys >Stop Sending CQ when Callsign changed. If not
every time you stop an auto-CQ and you type a callsign in the box it will send the abort string to the TNC.

Tips for Making QSOs

Callsigns and exchanges are displayed in the Digital Interface (DI) window. This information can be transferred to the Entry
window’s Callsign field and exchange fields with the mouse, or it can be typed in manually the same as you would do in CW
and SSB. Call signs recognized in the input stream are also placed in the Grab window, and can be transferred from there to
the Entry window using the Grab button, the {GRAB} macro or Alt+G on the keyboard.

Using Hover Mode

Hover Mode places the callsign in the callsign field in the Entry Window when you hold the mouse over a valid callsign.
If you use this in combination with the ‘Right click = Return NOT menu’ option, you hover over the call then right click to
plant the call and send your call; when the station comes back to you you click on the exchange to place it in the Entry
Window. Right clicking again sends TU and logs the Q. Right click, left click,right click and you’re done…

Note: Your own call is excluded from being picked up.
Hover mode is used in conjunction with the menu selection ‘Rt Click = Return NOT menu’ which will will send a
Return when right clicking in the DI RX window instead of displaying a pop up menu

The Rate Improver – Right Click = Return NOT Menu

Select from the settings menu in the Digital window “Right Click = Return NOT menu”. This setting could improve your rate
greatly as your hand never leaves the mouse except for the occasional difficult exchange. Making a qso:

While in Run mode with ESM on
Right click in the DI’s RX window to send CQ
When a station replies left click on the call
Right click sends your exchange
As he sends his exchange, left click on it
Right click again to send TU and log the QSO
Right click again sends CQ (and you’re back at the first bullet)

In S&P it does the same thing as hitting Enter to advance thru the ESM mode

Right click takes the place of hitting Enter for ESM. Most of the time while in the contest I have one hand on the mouse and
the other hand I have one finger resting on the space between the Esc and F1 keys. With that finger I can hit Esc if I have

 Staying Focus’ed

Focus is automatically returned back to the Entry window when clicking a call sign in the Receive window


3/4/25, 5:37 PM N1MM Logger+ Documentation



543

started a CQ and someone has started coming back to me. 73 Rick N2AMG

Do You Have… (what to check when it does not work)

Below are the most common mistakes made setting up or using N1MM logger in RTTY mode.

Forgetting to add {TX} and {RX} to each of the F Keys
Setting up Mode Control in the Configurer incorrectly
Incorrect settings in the Configurer under the Digital Modes tab
Forgetting to set up the Dig Wnd Nr in the Configurer under Hardware for ports that have the Digital check box checked
When using a USB codec inside the radio for AFSK transmitting, failing to check the “Internal Radio Codec” check box
under the Playback tab in the Logger+ Audio Setup window (from the Entry window’s Config menu). Note that you may
also need to check the “PTT via Radio Command Digital Mode” check box in the Configurer setup for the radio control
port

Insert Key Assignments

Mode Enter Sends Message (ESM
mode) Ins key or ; does the following:

RUN and
S&P OFF 1. Grab Callsign from call list if callsign field empty otherwise use call in

callsign field

– – 2. Prefills Exchange Boxes

– – 3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or DUPE: Sends
Nothing

– – 4. Places cursor in next exchange field (Example: Sect)

RUN ON 1. Grab Callsign from call list if callsign field empty otherwise use call in
callsign field

– – 2. Prefills Exchange Boxes

– – 3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or

– – 3. DUPE

– – — WorkDupes checked: Sends F5 (Hiscall) + F2 (Exchange)

– – — WorkDupes not checked:Sends F6(Dupe)

– – 4. Places cursor in next exchange field (Example: Sect)

– – 5. Highlights F8 button

S&P ON 1. Grab Callsign from call list if callsign field empty otherwise use call in
callsign field.

– – 2. Prefills Exchange Boxes

– – 3. NO DUPE: Sends F4 (Mycall) or

– – 3. DUPE

– – — WorkDupes checked: Sends F5 (Hiscall) + F2 (Exchange)

– – — WorkDupes not checked:Sends F6(Dupe)

– – 4. Once exchange entered INSERT sends F5-F2

– – ** Pressing INSERT again will continue to send F5-F2

– – 5. Places cursor in next exchange field (Example: Sect)
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Configuring the Entry Window Function Keys

There are separate Entry window function keys for ‘Running’ mode and ‘Search & Pounce’ mode
The function keys use the same macros for both PSK and RTTY
The function keys can be changed using the Config | Change CW/SSB/Digital Function Key Definitions | Change Digital
Function Key Definitions menu item, or more simply by right-clicking on one of the buttons
The function key editor is the same as for CW and SSB message buttons

Some tips for function key and button messages:

Text to be transmitted in digital modes must be preceded and followed by {TX} and {RX} macros
Always begin and end the actual text of your messages with a space character to separate the content of your
message from garbage characters generated by noise. If your call sign is the last thing in a message and there is no
following space, the person at the other end will not be able to tell where your call sign ends and the garbage begins
With the sole exception of consecutive all-numeric elements, where a hyphen (“-“) can optionally be used instead of a
space, always separate call signs and exchange elements from each other with single spaces
To set your messages off from previous text, you can start with a single {ENTER} instead of a space. Do not waste time
by sending more than one {ENTER}. Never end a message with {ENTER}; that causes your information to scroll
upwards on the received screen just as the other operator is trying to click on it
Don’t put in long sequences of spaces, periods or other punctuation; that just wastes time without making it any easier
to copy
Do not place any kind of punctuation immediately before or after a call sign; always set call signs apart from the rest of
the text with single spaces
Ending messages with K, KN or BK is unnecessary in RTTY; the receiving station knows that you are finished when
your carrier drops
In contests where the US state is part of the exchange, do not use DE before your call sign; that can be confused with
the exchange for Delaware. Also, do not use IN as a preposition to indicate that what follows is your QTH; that may be
interpreted as Indiana
Do not repeat unnecessarily. If signals are strong, you only need to send your exchange once; if conditions are poor,
sending your exchange twice or even three times can pay off by reducing the number of requests for repeats, but when
conditions are very good, this is unnecessary. Adjust your exchanges to suit conditions (the extra buttons in the DI
window are useful for this)
If a signal report is part of the required contest exchange, send it once and once only. Everyone knows what it is going
to be, so there is no need to repeat it. Always send the report as 599 (all-numeric), never 5NN (5NN takes more time in
RTTY than 599; 5NN is for CW only)
If you are CQing and more than one station is responding to you, it may help to put the other station’s call sign at the
end of the exchange as well as at the beginning, to take care of situations where other stations who are still calling
cover up the call sign at the beginning
In general, though, don’t send the other station’s call sign more often than is necessary to ensure he knows you are
talking to him and he has copied the call sign correctly
Don’t send your own call sign more often than necessary to ensure that the other station knows your call sign. There is
no need to send both call signs in every message; once the call signs have been exchanged correctly, subsequent
repeats don’t add anything
Don’t send the other station’s exchange back to him. If you are not sure you got it right the first time, ask for a repeat,
but once you feel you have copied it correctly, move on. Sending his exchange back puts doubt in the other station’s
mind unnecessarily, and in poor conditions he can confuse it with your own sent exchange
When responding to a CQ call, never send your exchange until after the CQing station has sent you his exchange and
you have copied it correctly. Do not include any part of your exchange in your F4 message

Message Buttons

There are 0, 8, 16 or 24 extra message buttons possible on the digital interface (DI window)
A right click on one of the message buttons brings up the Digital Setup dialog where the messages can be configured
These extra message buttons support regular macros but don’t support ‘Running’ mode and ‘Search & Pounce’ mode
If using a TNC, include in your messages the control commands needed to turn on the TNC and switch to RX
Macro key substitution is supported by the buttons in the RTTY window as well as the function keys on the Entry
window

The macros which can be used and some examples can be found in the macros reference section

There are several additional buttons for an External TNC. Please check the Digital – External TNC support chapter. Also
please check the rules for messages and macros when using MMTTY and MMVARI.
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Name Lookup

The program has the possibility to lookup the name from a station entered in the Callsign field. For this to happen the following
has to be done.

Import a callsign versus name text file
The famous ‘Friend.ini’ file used in the WF1B program can be directly imported
Also a text file using the format for Call History import can be used

Callsign [comma] Name. For example: N1MM,Tom
Select >Config >Call History Lookup
Use the {NAME} macro to have the name sent

Note: The name is looked up in the Call History table with the cursor in the callsign field and pressing the
Spacebar!

Example how to import the Friend.ini file from the WF1B program.

Select >File >Import >Import Call History
Select your ‘Friend.ini’ file by changing ‘Files of type:’ to ‘All Files (*.*)’. Otherwise only text files will be shown!
Select the ‘Open’ button. The callsigns with names from the text file will be imported
NB. Importing info in this table will delete all previous content. There is no merge option! So if there is information in it
and you only want to add info, first export this info (Select >File > Export >Export Call History) and merge the data
outside the program with a Text editor like Notepad. After this import the new merged file ‘Friend.ini’ file
The program will show in the bottom pane of the Entry Window status information during importing and afterwards the
number of imported callsigns

Output RX Data to a Text File

Sending your RX data to a text file can be done in N1MM Logger+ or in MMTTY. These files are a safety feature, as you can
go back through them for any info you missed or lost during a crash.

N1MM Logger+: Use the DI window’s Setup > Output RX Window to text file menu item. When this is checked, text
that is displayed in the main RX window will be saved to a text file in the ExportFiles directory in the N1MM Logger+
user files area. The file name will be date stamped (mmddyyyy), as in 05312012DigitalInterface1Output.txt (for DI1)
MMTTY: Doing this in MMTTY is a bit tricky. Go to the directory where the copy of MMTTY that you use with the Logger
has been installed and run that copy of MMTTY in stand-alone mode. Click on the File > Log RX file menu item and
close the program. From now on every time you start that copy of MMTTY either via the Logger or in stand-alone mode
an output text file will be created and all your info will be stored in this text file. In the directory where MMTTY is located
files will be created that have names like 131127.txt (yymmdd.txt). MMTTY creates a new file for each day. This
MMTTY file also contains lines indicating the times when MMTTY started and stopped, and the times when
transmissions from MMTTY started and stopped, which can be quite helpful

Single Operator 2 Radios (SO2R)

N1MM Logger+ also supports SO2R for RTTY. You can use any combination of either 2 MMTTY windows, 2 TNC windows or
a combination of MMTTY and a TNC for SO2R operation. Info about MMTTY soundcard setup and SO2R can be found in the
N1MM Logger+ Help file in the SO2R chapter.

Additional Receive-Only Windows for RTTY

N1MM Logger+ supports up to four additional RTTY receive-only windows for each DI window. The purpose of these windows
is to allow simultaneous use of more than one decoding algorithm on the same audio input. While it is possible, by using wide
bandwidth filters, to use the additional windows to decode different signals from the one in the main DI windows, the normal
use of the additional windows is to decode the same signal as the one in the main window, using a different decoding method
to improve the overall ability to decode signals in difficult situations.

These receive-only windows may use additional copies of MMTTY or 2Tone, configured with different “profiles” (e.g. multipath,
fluttered, different detection algorithms), or they can be used with additional TNCs or TUs. You can use any of the possible
digital interface engines in the main DI window (MMTTY, 2Tone, MMVARI, Fldigi or a TNC/TU), but regardless of which engine
is used in the main window, the additional receive-only windows can only use MMTTY, 2Tone or a hardware decoder
(MMVARI and Fldigi are not supported in these additional windows).

There are setup instructions for the additional receive-only windows here.
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Digital Setup
For information on how to set up N1MM+ and WSJT-X for operating in modes like FT8, FT4 and MSK144, see the WSJT
Decode List Window chapter. For traditional keyboard-to-keyboard modes like RTTY and PSK, see the following sections.

Quick Start RTTY Setup

First, make sure you are familiar with basic operation of N1MM Logger+ in CW and SSB. It’s not a good idea to try to use the
program in digital modes if you aren’t familiar with at least the basic operation (see the Getting Started section of the manual
for an introduction).

Next, have a quick look at the Overview section below – if you are new to digital modes, this may give you a better idea of
how things fit together, and even if you are an old hand at digital modes, it’s worth taking a few minutes to ensure you know
how to adjust sound card levels and sampling rates.

Once you are ready to begin, decide which digital engine(s) you want to use – an external TU/TNC, MMTTY, 2Tone, MMVARI
or Fldigi. One of these (MMVARI) is built in to the Logger, but the others all will need to be downloaded. Each digital engine
used by the Logger stores its configuration information in the directory the engine is run from. For that reason, you should
create a separate directory for each copy, separate from the directory you use when you run it stand-alone or from some other
logging program. These directories should not be in the C:\Program Files or C”\Program Files(x86) path; putting the program
in one of those paths prevents it from writing to its own configuration files. If you use more than one copy of a digital engine
(for example, for SO2V or SO2R, or for additional RX-only windows), you need a separate directory for each copy. For more
detailed information, check out the following sections on Downloading and Installing MMTTY/2Tone/Fldigi/GRITTY (GRITTY is
receive-only and cannot be used from the main Digital Interface window).

After these preliminaries, start N1MM Logger+ and open the Configurer (Config > Configure Ports, Audio, Mode Control,
Other). Make sure the Hardware tab is selected (this is the tab the Configurer starts up in by default).

In what follows, it is assumed that you already have radio control, CW keying and PTT control configured and working, and
what you are trying to do is add in the capability for digital modes.

In many cases, especially if you are planning to use AFSK, you will already have PTT control configured from the Logger. If
the same method you use in other modes is acceptable for digital modes, you don’t need to do anything special about PTT for
digital modes. If you are planning to use FSK for RTTY, you will be setting up a serial port for FSK keying from within the
digital engine, and you can use that same serial port for PTT control in RTTY. If you are using VOX (or an external VOX such
as a SignaLink), you do not need to configure PTT control in the Configurer.

All that being said, there are two cases where you need to do something about PTT control for digital modes in the Configurer.
The first is if you plan to use MMVARI as your digital engine, and you want to use a control line from a serial port for PTT
control. In that case, you must designate that serial port in the Configurer, check the Digital check box for that port, set the
appropriate control line (DTR or RTS) for PTT, and set the DigWndNr to 1 for most cases, or 2 for DI-2 in SO2R/SO2V. The
second case occurs if you are using a single serial port interface for both CW/PTT keying in CW/SSB, and also for FSK keying
in RTTY. In that case you must check both the Digital and CW/Other check boxes for that port, configure DTR and RTS for
CW/SSB, and set the DigWndNr (1 for SO1V or for DI-1 in SO2R/SO2V, 2 for DI-2 in SO2R/SO2V).

Next, you need to select the Digital Modes tab in the Configurer. First, set the TU Type to Soundcard (unless you happen to
be using a hardware TU/TNC). If your main digital engine is MMTTY or 2Tone, then under DI-1 MMTTY Setup, select AFSK or
FSK as appropriate for your setup and set the MMTTY Path to point to the copy of MMTTY.exe or 2Tone.exe you will be using
with the Logger. If you will be doing SO2V or SO2R, repeat for a separate copy of the digital engine under DI-2 MMTTY
Setup. If you will be using Fldigi, there are separate places to enter the paths to Fldigi.exe. For all of these, it is recommended
that you do not try typing in the path directly. Instead, click on the Select button, which opens a standard Windows file Open
dialog window, and then navigate till you find the desired .exe file and select it.

Once the paths to the digital engines are set up, select the Mode Control tab in the Configurer. On the right side, beside RTTY,
set the Mode sent to radio – this should be RTTY if you are using FSK, but if you are using AFSK, it should be either AFSK (if
your radio offers a separate mode for AFSK RTTY), LSB (for most radios with MMTTY or 2Tone), or USB (for Fldigi).

This completes the basic steps in the N1MM Logger+ Configurer. For more detailed explanation of the various options
available, see the section below titled Setting Up the Configurer.

Back in the main Entry window, if you have not already done so, choose a contest type that allows digital modes (i.e. not a
CW- or SSB-only contest), and set the Mode Category to one that includes RTTY or Digital (don’t choose MIXED – that’s for
CW+SSB only; choose MIXED+DIG instead). Type RTTY into the call sign box and press Enter. This should open the Digital
Interface window. If it does not, use the Window > Digital Interface menu item to open the Digital Interface window (in
SO2R/SO2V, each Entry window has its own Digital Interface window that opens from that Entry window’s Window menu). If
your preferred digital engine does not open (e.g. if you see the MMVARI window when you wanted MMTTY), then in the
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Digital Interface window use the Interface menu item to switch to the digital engine you want to use (use the MMTTY menu
setting for both MMTTY and 2Tone).

If you are using a codec internal to the radio for transmitting in AFSK, there is a check box in the Logger+ Audio Setup that
needs to be checked. The check box is called “Internal Radio Codec”, and it is under the Playback tab in the Logger+ Audio
Setup window that you get to from the Entry window’s Config > Logger+ Audio Setup menu item. This does not apply for FSK
keying, and it does not apply if you are using a sound card external to the radio. When this check box is checked, you should
also check the check box called “PTT via Radio Command Digital Mode” check box in the Configurer setup for the radio
control port.

Now in the Digital Interface window, select the Setup > Settings menu item. Under Preferred RTTY Interface, select your
preferred digital engine. Under Alignment Frequency, enter your preferred Mark audio frequency (e.g. 2125 Hz), after making
sure that this preferred Mark frequency is consistent with the default frequency in your digital program (e.g. the HAM setting in
MMTTY) and the default frequency in your radio. If you are using MMTTY, then under MMTTY Window Settings, select either
Normal or Control Menus, in order to have easy access to the MMTTY setup window. When you have completed the setup in
the Digital Setup window, click on Save Configuration.

There are a host of other options in the Digital Interface and Digital Setup windows. A complete reference manual for the
menu options in the DI window is in the section below titled The Digital Interface – Menu Selections, and a reference manual
for the Digital Setup window is in the section titled The Digital Interface – Setup. For a description of how to use the DI
window, see the section titled The Digital Interface – Window.

You’re not done yet. Now you have to complete the configuration inside the digital engine itself. This is especially important for
FSK, since the configuration of the FSK port is carried out inside the digital engine, not in the N1MM Logger+ program. There
are separate chapters in the manual for MMTTY, MMVARI, Fldigi, and TNCs/TUs. There are too many possibilities to cover
here, so consult the chapter(s) appropriate to your situation and complete the setup as described there.

Setup Overview

Setting up an interface requires configuring the Logger for the selected interface. Configuring has to be done within N1MM
Logger+ in a few places, including the Configurer as well as the Digital Interface window. You will also have to perform some
configuration from within your chosen digital engine.

You do not need to download or install any additional files or programs to use MMVARI or a TU/TNC. However, before you
can use MMTTY, you will have to download and install it. The same applies to 2Tone and Fldigi. This process is described in
the next two sub-sections.

A brief note about hardware connections. If you are using a TNC or TU, the hardware connections will be explained in the
documentation for the TNC. If you are doing sound card digital modes (including RTTY) using MMTTY, 2Tone, MMVARI or
Fldigi, your hardware connections will depend on the radio, the sound card and the interface (if any) in use. It is impossible to
cover all of the permutations and combinations in detail, but the following general comments apply.

First, unless the sound card (or “codec”) is built in to your radio, you must have some means of connecting the radio’s audio
output to the sound card’s input. The ideal connection would be from a fixed-level (“line out”) output on the radio to a “line in”
input on the sound card. If your radio has one receiver, this will probably use the left channel of the sound card; with dual
receivers, the second receiver may use the right channel (of course, this requires a stereo sound card; some external sound
cards, such as the SignaLink, are mono and will not support dual-channel receive; also, in Windows Vista, 7 and later, the
Windows configuration for the sound card device must be set to two channels for the sound card to work in stereo). If your
sound card does not have a line level input, you may need to use a microphone input, and in this case you may need an
attenuator to reduce the line level output from the radio to the lower level needed for the microphone level input on the sound
card.

To transmit, there must be some means to convey modulation from the computer to the radio. For FSK RTTY, this is an on-off
keying signal, which is normally generated by a serial port connected to the radio’s FSK keying input through a simple keying
circuit. This serial port cannot be the same port that is used for radio control or for a Winkeyer or other serial device. If it is a
USB-to-serial adapter, you will probably need to use MMTTY’s EXTFSK or EXTFSK64 plugin. If you are using MMVARI for
RTTY using FSK keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK or EXTFSK64 for USB-to-serial
adapters) in the Configurer under the Digital Modes tab.

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), with the exception of radios with an internal codec,
there must be a connection from the sound card’s output (“line out”, or speaker or headphone output) to the radio’s audio
input. If the only audio input on the radio is a microphone input, you may need attenuation to reduce the level to avoid
overdriving the transmitter. For radios with an internal codec, there is no need for external audio connections, but you may
need to adjust menu settings in the radio to ensure that the radio uses the internal codec as its audio source for data modes.
You will also need to check the “Internal Radio Codec” check box under the Playback tab in the Logger+ Audio Setup window
(from the Entry window’s Config > Logger+ Audio Setup… menu item), as well as the “PTT via Radio Command Digital Mode”
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check box in the Configurer setup for the radio control port, in order to tell the program that you are using the codec in the
radio.

In Windows 10 and 11, starting with the Spring 2018 update of Windows 10, there is a privacy setting that may need to be
adjusted to permit digital mode programs to gain access to sound card inputs. In the Windows Setting window, select Privacy,
and then among the functions on the left side of the window, select Microphone. An option called “Let apps use my
microphone”. This option must be set to On; if it is set to Off, Windows will block programs from gaining access to any sound
card inputs.

You also need some means to control TX/RX switching (PTT). The most common method is to use hardware PTT control from
a serial or parallel port via a simple keying circuit. Hardware PTT can be controlled either from the digital “engine” (MMTTY,
MMVARI, 2Tone or Fldigi), or from N1MM Logger+ itself. N1MM Logger+ can use the same port for PTT control that it uses for
radio control, but if you want to use serial port PTT from the digital engine instead, you must use a different port from the one
that is used by the Logger for radio control. If you have a serial port set up for FSK keying, you can use a control line (RTS or
DTR) on this same port for PTT control from the digital engine. If PTT is controlled from a digital engine rather than from the
Logger, and you use that same serial port from the Logger in other modes (e.g. for CW keying), then you must check the
Digital box for that serial port in the Configurer and make sure to indicate the appropriate Dig Wnd Nr (1 for DI1, 2 for DI2).

If you do not have a separate serial or parallel port available for PTT in digital modes, you can control PTT directly from the
Logger. For example, if your radio control interface supports PTT using RTS or DTR on the radio control serial port, you can
configure the Logger to use this method. If no method of hardware PTT control is available and if your radio supports PTT via
radio command, you can use software PTT control from the Logger. Warning: Using both software and hardware PTT control
at the same time can cause problems; do not use both methods in parallel.

As an alternative to hardware and software PTT control, you may be able to use VOX. This does not work with all radios, it
cannot be used for FSK RTTY, and setting of audio levels and VOX triggering levels can be tricky, but some users have found
this to be the simplest method of PTT control, since it does not require any additional hardware connections. Some external
interfaces (e.g. SignaLink) perform a VOX function external to the radio, i.e. they generate a hardware PTT signal based on
the presence of an audio signal without any connection to a serial port on the computer. If you are using such an interface, or
VOX within the radio, you do not configure any PTT in the Logger or in the digital engine, as PTT control in these cases is
external to the software.

If your radio has a built-in codec connected to the computer via a USB cable, you can configure the digital engine (sound card
software) to use this codec in place of a sound card in the computer. The only difference between this and a conventional
computer sound card installation is that the audio cables between the sound card and the radio are replaced by a USB cable
between the computer and the radio. This USB cable may also service one or more USB-to-serial adapters inside the radio,
for CAT control and possibly also for CW/PTT/FSK keying. Despite the fact that the codec and the serial adapter share the
same physical cable, there is no logical connection between the two devices. If the virtual serial port created by the USB
device driver is used for CAT control, it must be configured in the Logger, while the codec using the same USB cable is
configured separately in the digital engine. If there is a virtual serial port used for “hardware” keying of PTT/CW/FSK, it must
be configured in the same way as it would have been if it were a real serial port in the computer, e.g. in the Logger if it is used
for CW keying, or in the digital engine if it is used for FSK keying.

Sound Card Level Settings

On receive, to make best use of the sound card’s available dynamic range you would adjust the sound card’s recording level
control (and/or any other level controls or attenuators there might be in the receive audio path) so as to just barely avoid
overdriving or saturation on the loudest signals. In MMTTY, an input signal that is too strong will cause the word “Overflow” to
be displayed in the MMTTY spectrum window. The recording sound level should be adjusted to be just below the point where
this word is displayed on the strongest signals.

On transmit (AFSK RTTY and other digital modes), it is important to avoid setting levels high enough to cause either
appreciable audio harmonics or intermodulation distortion (IMD). The goal is to come up with a combination of settings in the
sound card playback mixer and the radio’s mic gain or line in gain setting that results in audio signals just below the point
where fast-acting ALC is triggered. On many radios, this is the point where the ALC meter just starts to move (special case:
this is not true of the Elecraft K3/K3S and KX3, where the proper audio settings are those that result in 4-5 bars displaying on
the radio’s ALC meter). With many sound cards, you should try to avoid setting the playback gain in the sound card all the way
to the maximum; the sound card’s output may not be very linear at the maximum setting. A setting somewhere in the upper
middle part of the range is ideal, provided it produces enough signal for the radio. Gain distribution is also important. A very
low level out of the sound card followed by large amounts of amplification in the radio’s audio circuits will risk picking up hum
and noise and adding them to your transmitted signal.

Sound card level adjustment should always be done using an audio frequency in the middle of the radio’s filter bandpass. This
is where both received and transmitted signals will be strongest. If level adjustment is performed using an audio frequency
near the edge of the bandpass, the resulting level settings will be too high. During operation, if a desired signal is found near
the edge of the bandpass, the Logger’s Align button can be used to retune the radio so the desired signal is placed at the
optimal point in the bandpass.
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If you are using the Windows default sound card for generating transmitted signals in digital modes, make sure to disable all
Windows sounds. Most amateurs who spend significant time in digital modes prefer to use a separate sound card. It does not
need to be a high-end audiophile sound card; digital modes like RTTY do not require anything extraordinary in the way of a
sound card. The parameter of most interest is the noise floor; the noise level in a second sound card may be lower than that in
the sound card on the computer’s motherboard, and this may help improve reception of digital signals.

If you are using a USB audio codec inside the radio as your sound card, make sure that it has not been set to be the Windows
default sound card. In this situation, the Windows default should still be set to be the sound card in the computer. There are
two reasons for this. One is that the radio’s sound card will disappear from Windows when the radio is turned off, which makes
it unsuitable as the default device. A more important reason from an amateur radio point of view is that if it is the Windows
default, it will cause Windows sounds to be transmitted by the radio instead of playing them on the computer’s speaker – not a
good idea! Also, setting one of the inputs or outputs on a sound card to be the Windows default causes Windows to disable
the other inputs or outputs on that sound card, which can lead to inability to select the desired input or output. For all of these
reasons, if at all possible you should avoid letting Windows select as its default the sound card or codec you are using for
digital modes.

Sound Card Sampling Rate

If you are using a sound card or codec, you may also need to pay some attention to the sound card sampling rate. This will be
the case either if you are using Windows Vista, 7, or later, or with any version of Windows when you are using 2Tone,
regardless of whether that is as your main digital engine or as an auxiliary decoder in one of the additional RX windows.

In Windows XP, application software programs (such as the digital engines in the Logger) are able to set the sound card
sampling rate directly. If you use two or more engines in parallel with the same card, you need to ensure that all of the engines
are using the same sampling rate. The 2Tone engine does not offer a choice of sampling rates; it always uses 12000 Hz.
Since the sampling rate for all digital engines connected to the same sound card should be the same, this means that if you
are using 2Tone and MMTTY in parallel, you should set MMTTY’s sampling rate to 12000 Hz as well.

In Windows Vista, 7, or later, application software cannot set the sampling rate directly. The hardware sampling rate is set in
the Windows Control Panel. Many sound card drivers will offer a choice between DVD (48000 Hz) and CD (44100 Hz)
sampling rates. Software that uses the sound card should have its sampling rate adjusted to an exact integer sub-multiple of
the hardware rate. If you are using 2Tone, since the software sampling rate is fixed at 12000 Hz, you would set the sound card
to an exact multiple of 12000 Hz (such as 48000 Hz, the standard DVD sampling rate). If you are not using 2Tone, you can
choose either hardware sampling rate, but whichever one you choose in the Control Panel, you should choose corresponding
rates in the sound card applications (12000 Hz corresponding with 48000 Hz, or 11025 Hz corresponding with 44100 Hz).

If the hardware and software sampling rates are incompatible (e.g. software set to 11025 Hz using a sound card set to 48000
Hz, or two different software engines, one set to 12000 Hz and the other set to 11025 Hz), you may find that the software
calculates audio frequencies incorrectly. For example, tones that the software generates using 2125/2295 Hz settings may
actually be at lower pitches with a smaller shift, and if you are using narrow filters in the radio, the filter bandpass may appear
at the wrong place in the waterfall. In AFSK, logged and spotted frequencies may also be incorrect.

In Windows Vista, 7, or later, to set the sampling rate in the sound card, open the Control Panel and find the area for Sound
settings. You can also find this by right-clicking on the little speaker icon at the right end of the Task Bar and selecting
“Recording devices”. Under the Recording tab in the Sound settings window, select the sound card device and input that you
are using for receive audio in digital modes and click on the Properties button. Select the Advanced tab, and set the sample
rate and bit depth (16 bits is good) to the desired values (e.g. 16 bit, 48000 Hz). If you are using AFSK, do the same under the
Playback tab for the sound card device and output that you are using for transmit audio.

To set the sampling rate in MMTTY, open the MMTTY Setup window, select the Misc tab, and in the lower left part of the
window set the Clock to the desired setting (e.g. 12000 Hz). To set the sampling rate in MMVARI, open the Digital Setup
Window, select the MMVARI Setup tab and the Soundcard Setup tab under that, and set the Clock Adjustment RX Freq to the
desired setting (e.g. 12000 Hz). In Fldigi, the sample rate is found in the Fldigi configuration under the Audio/Settings tab –
there are separate sample rate settings for Capture (receive) and Playback (transmit). Remember to save the configuration in
Fldigi after you make any changes.

Downloading and Installing MMTTY

MMTTY is not installed as part of the installation of N1MM Logger+. It must be downloaded and installed separately. It is
possible to use N1MM Logger+ in RTTY without using MMTTY (e.g. by only using an external TNC, or AFSK RTTY from
MMVARI). If you intend never to use MMTTY, you can skip the rest of this section. However, most RTTY users will probably
want to have the ability to use MMTTY, at least as an option. In particular, if you would like to make use of the additional RX
windows for “diversity decode”, you will most likely need to install MMTTY (unless you have several TUs/TNCs you can use
for the purpose).

If you do not have a copy of MMTTY, then before continuing with the digital setup it is recommended that you download a
copy of the MMTTY installer from the MM HamSoft website. You can find a copy of the full installer for the current version of
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MMTTY at that website. This installer file is a self-extracting executable, similar to the N1MM Logger+ installer. Download the
file to a temporary folder and then execute it in order to extract and install the actual MMTTY program. It is recommended that
you install MMTTY in its own program folder and not in the N1MM Logger program folder. By default, the installer will try to
install MMTTY to C:\Program Files\MMTTY\, but in Windows Vista, 7, or later, you should not install MMTTY in the Program
Files or Program Files(x86) path, because that will prevent MMTTY from saving its settings. Instead, tell the installer program
to install MMTTY in a different location from the default.

Note for users of Windows Vista and Windows 7 or later: User Account Control (UAC) in these versions of Windows prevents
user programs from writing configuration information into the Program Files path. Even if programs are run with Administrator
privileges, UAC may interfere with the ability to use separate configuration files for separate instances of the same program.
Therefore, it is suggested that the folder for MMTTY, as well as any folders for extra copies used in the second DI window and
the four additional RX windows, should not be in the Program Files path. It is suggested that you create a new folder outside
the Program Files path, such as C:\Ham Radio\MMTTY, and then place any individual sub-folders for separate copies of
MMTTY within that folder. Another option would be to create a DigitalEngines subfolder inside the N1MM Logger+ user files
folder (the one pointed to from the Help> OpenExplorer on User Files Directory menu item), and then create various
subfolders within DigitalEngines for copies of MMTTY, 2Tone and Fldigi that you want to use with various DI windows and RX-
only windows, as illustrated lower down in this section.

If you wish to use FSK keying from MMTTY through a USB-to-serial adapter or via an LPT port, you will also need to
download a copy of EXTFSK (from the MM HamSoft website) or EXTFSK64 (from
http://www.qsl.net/ja7ude/extfsk/indexe.html) and install the appropriate files in each folder or sub-folder from which you intend
to use MMTTY to transmit FSK using a USB adapter or LPT port.

If you already have a copy of MMTTY installed on your computer, you can use that copy from N1MM Logger+. However, if you
also use MMTTY stand-alone, it is possible that you may want (or need) to have a different setup for stand-alone use than
with N1MM Logger+ (e.g. if you use the radio control port from within MMTTY stand-alone; this is not possible when MMTTY
is used with the Logger). If you need a different setup with the Logger than the one you use stand-alone, then you should
create a separate folder for each copy (for example, you can create a sub-folder inside either the N1MM Logger+ user files
folder or the MMTTY program folder for the second copy of MMTTY). You need to copy only the MMTTY.exe and
UserProfile.ini files from the main MMTTY folder into the additional folder (plus the extfsk.dll and/or extfsk64.fsk file(s) if you
are using EXTFSK and/or EXTFSK64 for FSK keying). You can also copy MMTTY.ini, but if you don’t, MMTTY will create a
new copy of MMTTY.ini when it is run.

If you plan to use two copies of MMTTY in SO2V or SO2R mode, one for each received audio stream, you will need to create
two copies in separate folders with different configurations. In SO2V, one of these copies can be configured to use the left
channel and the other copy to use the right channel of a single stereo sound card. In SO2R, you can either use a stereo
sound card as in SO2V, or you can use two separate sound cards, one for each radio.

If you want to use MMTTY for diversity decoding in additional RX windows, you will need to create another separate sub-
folder for each additional RX window. For example, you can create sub-folders called DI1, DI2, DI1RX1, DI1RX2, DI2RX1,
DI2RX2, etc. so that you can run several copies of MMTTY simultaneously; one for each main DI window, plus up to 4
additional RX windows for each DI window. Into each of these windows, you need only copy the MMTTY.exe, MMTTY.ini and
UserPara.ini files from the main MMTTY program folder created when you first installed it. Each copy of MMTTY must then be
configured to use the appropriate sound card and channel. The “Additional RX” copies usually use the same sound card and
channel as the parent copy in the main DI window, but they can be configured to use different decoding algorithms or profiles
to give you “diversity decoding”, i.e. several different decoding methods used on the same receive audio.

A sample folder structure might be as follows (each of the bottom-level folders contains a copy of the .exe file and .ini or other
configuration files for that particular instance of the program).
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Once MMTTY has been downloaded and installed, you can proceed to use the Configurer to set up N1MM Logger+ to use it –
see here. For instructions on setting up additional RX windows, see here.

Downloading and Installing 2Tone

2Tone is not installed as part of the installation of N1MM Logger+. It must be downloaded and installed separately. You cannot
run 2Tone stand-alone. Most people who use 2Tone have already downloaded and configured MMTTY, and simply use 2Tone
as a drop-in replacement for the MMTTY engine. If you are using 2Tone in the main DI1 or DI2 window, change the MMTTY
path in the Configurer under the Digital Modes tab to point to a copy of 2Tone.exe . If you are using 2Tone in an additional RX
window, configure that window for MMTTY but change the path in the setup to point to that window’s copy of 2Tone.exe . Note
that if you are using 2Tone in more than one DI or RX window, every window you use it in must point to a different copy of
2Tone.exe, i.e. a copy that has been unzipped into a different folder. These folders must not be in the Program Files or
Program Files (x86) path.

You can find the latest version of 2Tone in the G3YYD folder in the Files area of the N1MMLoggerPlus user group at groups.io
. Download the zip file containing the latest version and unzip its contents into the folder(s) or sub-folder(s) you wish to run it
from (a separate folder for each window you wish to use it in). The first time you install 2Tone in a folder, copy the entire
contents of the zip file into the folder; when installing updated versions, you do not need to extract the ini files from the zip file
if you wish to keep using the configuration information from the previous version.

The configuration steps in N1MM Logger+ are the same for 2Tone as for MMTTY. To configure N1MM Logger to use 2Tone as
the decoder for one of the main Digital Interface windows (DI1 or DI2), follow the instructions in section 2.5 below, taking care
to ensure that the DI Path points to 2Tone.exe instead of MMTTY.exe . If you wish to configure N1MM Logger to use 2Tone as
the decoder in one of the additional RX windows, use the Setup > Add. RX Windows > Open Add. RX Window (4 Avail.)
menu item to open the additional RX window. The first time that window opens, it will display a setup window – see section 2.6
below. Set the Window Type to MMTTY, but then in the Path box change the path to point to the appropriate copy of
2Tone.exe instead of MMTTY.exe . Click on Save.

Initially the additional RX window will be in a separate window from the main DI window. If you wish to embed the additional
RX window into the DI window so that text decoded in the main and additional RX windows will appear one above the other
within the DI window, select the Setup > Add. RX Windows > Enable Attached RX Windows menu item from the DI
window’s menu bar. The separate window will be minimized to the task bar; if you want to close the additional RX window, or if
you need to change settings in its Setup window, you can open it from the task bar.

For detailed instructions on configuration settings within 2Tone itself, see the 2Tone.pdf file in the downloaded 2Tone zip file.
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Downloading and Installing Fldigi

FLdigi is not installed as part of the installation of N1MM Logger+. It must be downloaded and installed separately. It is
possible to use N1MM Logger+ in RTTY and PSK contests without using fldigi. Fldigi supports a wide range of other digital
modes, but most of these are rarely used for contesting. Fldigi can also be used as a receive-only CW decoder. If you want to
use fldigi as a CW decoder, you need to download and install it. If you intend never to use fldigi, you can skip the rest of this
section.

If you do not have a copy of fldigi and you wish to be able to use it, then before continuing with the digital setup you should
download a copy of the Fldigi installer from the W1HKJ website at http://www.w1hkj.com/ . You can find a copy of the full
installer for the current version of fldigi at that website. This file is a self-extracting executable, similar to the N1MM Logger+
installer. Download the file to a temporary folder and then execute it. It is recommended that you install fldigi in its own
program folder and not in the N1MM Logger program folder. By default, the installer will install fldigi to C:\Program Files\Fldigi-
x.xx.xx\, where x.xx.xx is the Fldigi version number. This is OK for fldigi when it is run stand-alone, but in Windows Vista, 7, or
later, a copy of fldigi that is used from within N1MM Logger+ must not be placed in the Program Files or Program Files(x86)
path. Therefore it is suggested that you create a new folder outside the Program Files path, such as C:\Ham Radio\fldigi, and
then place any individual sub-folders for separate copies of fldigi within that folder. Another option would be to create a
DigitalEngines subfolder inside the N1MM Logger+ user files folder (the one pointed to by the Help > Open Explorer on User
Files Directory menu item), and then create various subfolders within DigitalEngines for copies of MMTTY, 2Tone and fldigi
that you want to use with various DI windows and RX-only windows. Make a copy of fldigi.exe from the original fldigi program
folder and place the copy in the new folder. You do not need to copy any of the other files; that copy of fldigi will create new
configuration files the first time it is run from the Logger.

Note that older versions of fldigi only use the left channel on input; for that reason, in most SO2V installations these older
versions of fldigi can only be used from Entry Window 1. Starting with Fldigi version 3.22.06, fldigi is now capable of using
either sound card channel for input. In any copy of fldigi that you want to use with the right channel of the sound card, use the
Configure > Sound Card menu item in the fldigi window to open the fldigi configuration window. Select the Right channel tab,
and near the bottom under Receive Usage, check the Reverse Left/Right channels check box to switch fldigi to use the right
channel on RX. Click on Save to save the configuration change, and then close the configuration window.

Newer versions of fldigi may default to requiring confirmation from the user before you shut them down. If that shutdown is
initiated by shutting down N1MM Logger+, instead of by shutting down the DI windows and engines first, this can result in
fldigi continuing to run after the Logger has shut down. This will cause problems the next time you start up the Logger. To
prevent this from happening, you need to make a change in the fldigi configuration file. In each folder that fldigi is run from,
find the file called fldigi_def.xml (Note: this file is created the first time fldigi is run from this location, i.e. it will not exist until
after you have run that copy of fldigi at least once from within N1MM+). Right-click on the file name, select Open with… and
then select Notepad or Wordpad as the program to open the file with. Look for a line that reads < CONFIRMEXIT > 0 <
/CONFIRMEXIT > or < CONFIRMEXIT > 1 < /CONFIRMEXIT >. If you see a 1 between the two keywords, change it to a 0
and save the file. Repeat this for every copy of fldigi you use from within N1MM Logger+ (DI1, DI2, CW Reader 1 and/or CW
Reader 2).
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Downloading and Installing GRITTY

GRITTY is an innovative receive-only RTTY decoder by Alex VE3NEA (the author of DX Atlas, CW Skimmer and several other
amateur radio programs). Its decoding algorithm is quite different from the algorithms used by other RTTY decoders. It can be
used as one of the additional RX windows in N1MM Logger+ (see section 1.6 below) to provide additional information about
received call signs and exchanges which can sometimes enable you to copy a signal even when the decoder in the main
Digital Interface window is unable to decode the information successfully.

GRITTY is not installed as part of the installation of N1MM Logger+. It must be downloaded and installed separately. A zip file
containing the GRITTY installer can be downloaded from http://www.dxatlas.com/Download.asp . The installer is a self-
extracting executable, similar to the N1MM Logger+ installer. Download the zip file to a temporary folder and then unzip it and
execute the setup program. It is recommended that you install GRITTY in its own program folder. By default this will be in the
Program Files path. Unlike MMTTY, 2Tone and Fldigi, when GRITTY is used from N1MM Logger+ it can be run from the
program files path. GRITTY’s configuration information is stored outside the program files path, and the interface with N1MM
Logger+ creates a specially-named ini file to allow different configuration files to be used from the Logger as compared with
GRITTY run stand-alone. The name of this ini file indicates which DI window (1 for SO1V, 1 or 2 for SO2R or SO2V) and
which additional RX window number (1 through 4) the configuration applies to (for example, Config13.ini contains the GRITTY
setup for additional RX window no. 3 from the DI-1 window). You can find the location of these configuration files from the
GRITTY Help > Data Folder menu item.

GRITTY’s decoding method is based on Bayesian statistics. It performs an analysis on the received characters bit-by-bit and
develops a probabilistic model, comparing incoming text to known-good call signs, common keywords and previously-decoded
text in order to predict the most likely correct interpretation even in the presence of errors. In some situations, it can pick out
call signs from error-filled text that would appear to be garble to other decoders. Of course, it must be used with care; while it
can predict the most probable interpretation of a received string of bits and noise, this interpretation is not guaranteed to be
correct. For example, it can sometimes be tricked into decoding apparent call signs from pure band noise.

GRITTY performs best when the incoming audio is not passed through a narrow filter, e.g. by using a wide SSB filter instead
of narrow CW-style filters. When used with narrow filters, GRITTY can sometimes refuse to decode anything even when other
decoders are succeeding. When this happens, one tactic that may work is to temporarily widen the IF filter in your rig to pass
a broader range of audio frequencies. In the presence of heavy QRM such as strong nearby signals, it may be necessary to
use narrow filtering in order to prevent AGC pumping from adversely affecting the other decoders using more traditional
methods. Fortunately, once GRITTY has started to decode using a wider filter, the IF filter can often be narrowed back down
and GRITTY will continue to decode now that it has some previously-decoded text to work with.

You can find more information on setting up and using GRITTY, and on how it works, in the GRITTY Help file.
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Setting Up the Configurer

There are three tabs in the Configurer that need to be set up when configuring N1MM Logger for keyboard-to-keyboard digital
modes (like RTTY and PSK). The first is the Hardware tab, where serial ports used for digital modes are set up. If you are
using VOX or an interface that performs the VOX function externally (e.g. SignaLink), you do not need to configure a port for
digital modes under this tab.

The Digital box in the main Configurer window indicates to the Logger that this port is used for digital mode control in
certain special cases, as follows:

Use this to indicate a port that is used for an external TNC – only the Digital check box is checked for the port
Use it to indicate a port that is used for PTT control from MMVARI
It is possible to time-share a port (sequentially, not simultaneously) for both serial port CW keying (e.g. on DTR)
and for PTT and FSK using MMTTY or 2Tone for RTTY (e.g. on RTS and TxD). If you are time-sharing a port like
this, check both Digital and CW/Other for that port. When the DI window is closed, the settings in the DTR and
RTS boxes will determine how the port is used; whenever the DI window is open, it will be the settings in the
digital engine (e.g. MMTTY or 2Tone) that determine how the port is used. The figure above shows COM2 being
used by the Logger for CW keying and by MMTTY for FSK keying
If you use a serial port with MMTTY or 2Tone for FSK and/or PTT keying and you do not use that serial port in
other modes or in MMVARI, there is no need to configure that port in the Configurer; in this case, all of the setup
is done within MMTTY
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If you have checked the Digital check box, click on the Set button for the same port and select the radio number and DI
window number to be associated with the port. The figure above demonstrates an example where COM2 is being used by the
Logger for CW keying from DTR, and by MMTTY for FSK keying from VFO B (SO2V).

The Radio Nr box indicates which radio this digital interface is for in SO2R mode; in SO2V and SO1V, Radio Nr is
always = 1
The Dig Wnd Nr indicates whether this port is used for DI1 or DI2. This applies to SO2V and SO2R; in SO1V, Dig Wnd
Nr is always = 1

The next tab to be set up is the Digital Modes tab.

Be Sure to Assign a Dig Wnd Nr
You must choose a Dig Wnd Nr for each port that has the Digital box checked; otherwise the program will not
assign the port to a DI window!
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Digital Interface 1/2 (left part of window)
TU Type:

None – if you do not plan to use the DI1 or DI2 digital interface
Soundcard – for any of the sound card digital engines (MMVARI, MMTTY, 2Tone or Fldigi)
Other – use this setting for most terminal units or TNCs (e.g. for a PK-232 or KAM TNC)
Dxp38 – use this setting for the HAL DXP-38 terminal unit

Speed, Parity, Data Bits, Stop Bits, Flow:
These are only used when the TU Type is Other or Dxp38
Set these parameters appropriately for the TNC or TU (Example settings: 9600, 8, N, 1, Xon-Xoff)

DI-1/2 MMTTY Setup (upper right part of window – this area is also used for 2Tone setup)
MMTTY Mode: Select AFSK or FSK
MMTTY Path: Select path to MMTTY.EXE or 2Tone.exe, including the name of the executable file (i.e. not just
the path to the folder). Using the Select button for this purpose will open a File Open dialog that will allow you to
navigate through the file system to find the MMTTY.exe or 2Tone.exe file, which avoids the possibility of a typing
error when entering the path

The paths for the two DI windows are not the same, since each DI window runs its own copy of MMTTY
or 2Tone

SO2V/SO2R in MMTTY

You can use MMTTY with both receivers in a two-receiver setup with a single stereo sound card. You will need to
install two copies of MMTTY in two separate program folders in order to allow one copy to be configured to use the
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DI-1/2 Fldigi Setup (midle right part of window)
Fldigi Path: Select path to fldigi.exe (complete path, including the name of the executable file). Use the Select
button to simplify the task of finding the path and typing it in correctly

The paths for the two DI windows will normally be different in order to allow for different configurations
(e.g. different audio sources) in the two copies

DI-1/2 MMVARI Setup (bottom part of window)
MMVARI RTTY Mode: Select AFSK or FSK
FSKPort: (FSK only)

Choose FSK8250 if you are using a true serial port or a device that can simulate a serial port and handle
5-bit codes at low speeds (this does not include most USB-to-serial adapters, but it does include some
commercial interfaces designed to support FSK RTTY as well as some multi-port USB-to-serial adapters)

When MMVARI is opened for FSK RTTY, a small window labelled MMVARIFSK1 1.04 will open, or
appear on the Windows Task bar. In this window you select the COM port number and the signal
line to be used for PTT (RTS or DTR). FSK keying will be done on the TxD line. If this is a USB
device that simulates a serial port, check Limiting speed. You can use the _ box at the top right to
minimize this window after completing the setup
FSK8250 supports all of the RTTY speeds supported by MMVARI and the selected COM port or
device

Choose EXTFSK if you are using a regular USB-to-serial adapter
When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK 1.06 will open, or
appear on the Windows Task bar. In this window you select the COM port number and the signal
lines to be used for FSK keying (normally TxD) and PTT (RTS or DTR). You can use the _ box at
the top right to minimize this window after completing the setup
The only RTTY speed supported by EXTFSK is 45.45 baud

On high-performance multi-core systems only, you may choose EXTFSK64 instead of EXTFSK.
EXTFSK64 uses a more accurate timing mechanism than EXTFSK, but this mechanism uses significant
CPU resources. EXTFSK64 is not appropriate for use on XP based systems or hardware running older
dual-core Intel/AMD CPUs or Atom based CPUs. On systems that are capable of supporting it,
EXTFSK64 can key FSK from LPT ports as well as USB-to-serial adapters. See
http://www.qsl.net/ja7ude/extfsk/indexe.html for more detailed information on EXTFSK64

When MMVARI is opened for FSK RTTY, a small window labelled EXTFSK 2.0 will open, or appear
on the Windows Task bar. In this window you select the COM or LPT port number and the signal
lines to be used for FSK keying (normally TxD) and PTT (RTS or DTR). You can use the _ box at
the top right to minimize this window after completing the setup
EXTFSK64 can key FSK at speeds other than 45.45 baud (e.g. 75 baud)

 

left channel of the sound card and the other copy to be configured to use the right channel of the sound card.

SO2V/SO2R Shut Down Issue

When two copies of MMTTY are used in DI1 and DI2 with a different COM port for each copy for PSK/PTT keying,
you may need to close the two DI windows separately before shutting down N1MM Logger. If both DI windows are
open at the time N1MM Logger is shut down, the COM port assignments in the two copies may get confused due to
a glitch in MMTTY, which means the port assignments may be wrong the next time the Logger is started up.



SO2V/SO2R in Fldigi

Starting with FLdigi version 3.22.06, you can use Fldigi with both receivers in a two-receiver setup with a single
stereo sound card. You will need to install two copies of Fldigi in two separate program folders in order to allow one
copy to be configured to use the left channel of the sound card and the other copy to be configured to use the right
channel of the sound card on receive.



SO2V/SO2R in MMVARI

You can use MMVARI with both receivers in a two-receiver setup with a single stereo sound card. In the DI Window’s
Digital Setup dialog box under the MMVARI Setup tab, simply configure the DI1 SoundCard to use the left channel
and the DI2 SoundCard to use the right channel.
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The third tab to be set up is the Mode Control tab, which determines what mode the radio will be set to use in RTTY and PSK.

This example is for a radio or radios with separate modes for FSK, AFSK and PSK (e.g. Elecraft K3 using FSK D, AFSK A and
DATA A respectively). This particular setup uses AFSK from DI-1 (radio 1) and FSK from DI-2 (radio 2). The appropriate
choices in the list boxes under Mode sent to radio will depend on the particular radio type (see Supported radios). For FSK
RTTY, the correct choice will normally be RTTY. For AFSK RTTY, depending on the radio the appropriate choice might be
AFSK or LSB/USB (or if you are using Fldigi and your radio has an upper sideband digital audio mode, perhaps PSK). For
PSK31 and other sound card modes, the radio mode would be PSK (if available), AFSK-R (on some radios) or USB on most
radios. For more information, see the Configurer page under the Config >Mode Control tab.

Additional RX Windows for RTTY

N1MM Logger+ supports up to four additional RTTY receive-only windows for each DI window. The purpose of these windows
is to allow simultaneous use of more than one decoding algorithm on the same audio input. While it is possible, by using wide
bandwidth filters, to use the additional windows to decode different signals from the one in the main DI windows, the normal
use of the additional windows is to decode the same signal as the one in the main window, using a different decoding method
to improve the overall ability to decode signals in difficult situations.

These receive-only windows may use additional copies of MMTTY or 2Tone, configured with different “profiles” (e.g. multipath,
fluttered, different detection algorithms). Alternatively, they can be used with a copy of Fldigi or GRITTY, or with additional
TNCs or TUs. You can use any of the transmit-capable digital interface engines in the main DI window (MMTTY, 2Tone,
MMVARI, Fldigi or a TNC/TU). The additional RX windows may be configured to use either the same sound-card interface
engine as the main DI window with a different profile, or a different interface engine, including GRITTY (read-only), but not
including MMVARI (MMVARI can only be used in the main DI window).
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The receive-only windows are invoked from the DI window’s Setup > Add. RX Windows > Open Add. Rx Window (4 Avail.)
menu item – the number in the menu item indicates how many of these windows are unused and still available. The first time
one of these windows is opened, its Setup window will be displayed.

The setup information that must be entered includes the engine type (MMTTY, TNC, Dxp38, GRITTY or Fldigi – the MMTTY
setting is also used for 2Tone), the path to the copy of MMTTY/2Tone, Fldigi or GRITTY for that window (if used), and/or the
COM port information for a TNC (if used). Note that the path is the path to the .exe or executable file, not just the path to the
directory in which it is located, i.e. when you use the Select button to find the engine, you must click on the actual executable
file, then on the Open button in the File Open window. Alternatively, you can double-click on the executable file in the window.

After the setup information has been entered, click on the Save button to register the information. The additional RX window
must be closed and re-opened (it may do this automatically), and then it will be available for use. If the engine type is MMTTY,
Fldigi or GRITTY, a separate spectrum display window is also opened for the software digital engine, and can be used as a
tuning indicator. Once the additional RX window is active, you can click on call signs and exchanges in the text window to
pass them to the Entry window, the same as you can in the main DI window.
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It is possible to embed or attach a copy of the additional RX windows directly into the RX window area in the main Digital
Interface DI window, using the DI window’s Setup > Add. RX Windows > Enable Attached RX Windows menu item. Each
such attached window is denoted with its number (1, 2, 3 or 4), which is normally on a green background. If the number is
clicked on with the mouse, the background color changes to yellow and the text in that window is frozen temporarily, similarly
to the green/yellow bar on the left of the main receive window and the regular additional RX windows.

The separate additional RX window(s) is/are minimized to the task bar when the attached windows are enabled, but they may
be restored from the task bar in order to be able to change setup parameters or to close the additional RX window. The icon(s)
for the additional RX window(s) are grouped together with the icons for N1MM Logger+ on the task bar. If any of the additional
RX windows use sound card software for decoding, the spectrum display windows for those digital engines may also be
mimimized to icons on the task bar, but these will be separate from the Logger icons; note that the icon for the digital engine
(MMTTY – black crossed ellipses on a white background; 2Tone – 2T; GRITTY – green crossed ellipses; or Fldigi – miniature
waterfall) controls the display for the digital engine only, not the RX text window. In the screen shot below, as a result of
hovering the mouse over the the N1MM Logger+ icons they have been expanded to thumbnail images above the task bar.
The title of each thumbnail indicates which window will be restored if you click on that thumbnail.
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If Fldigi is used in parallel with other decoder engines, you need to be aware of the fact that fldigi assumes by default that the
radio is in USB, whereas the other decoders assume LSB. If your radio is in LSB (this includes the FSK RTTY mode in
amateur transceivers), you will need to tell fldigi to reverse its tones using the Rev button in the corresponding DI or additional
RX window. This Rev button is not accessible from the attached RX-only windows; if you have enabled attached windows, you
will need to restore the non-attached window to gain access to the Rev button for that copy of fldigi. Alternatively, if the radio is
in USB (or FSK-R, etc.), fldigi will be on the correct sideband but you will need to reverse the tones in the other decoders
using their respective reverse settings in the digital engine windows.

The Digital Interface Window
The Digital Interface window, or DI window, is nearly the same regardless of which type of interface (MMTTY, MMVARI,
FLDIGI or TNC) is being used. Its appearance (font sizes and foreground and background font colors) can be customized
using the Skins, Colors and Fonts dialog window (main Entry window, Config > Manage Skins, Colors and Fonts).

The Digital Interface is opened from the Entry window’s Window > Digital Interface menu item. If you are using two entry
windows (SO2V/SO2R), each entry window has a separate DI window associated with it – DI1 with the VFO A/Radio 1 Entry
window, and DI2 with the VFO B/Radio 2 Entry window. Each DI window is opened from its corresponding Entry window’s
menu bar. If the digital “engine” chosen in a Digital Interface window is sound card software (MMTTY, MMVARI, Fldigi or
2Tone), a separate window including a tuning display and various other digital engine-specific information will also be opened
when the Digital Interface window is opened – see the section of the manual relevant to the specific digital engine that has
been selected.

The DI window may be configured either in scrolling mode or in non-scrolling mode. Scrolling mode is the same as N1MM
Logger Classic – new text is always added below previous text (i.e. usually on the bottom line of the RX window), and
previously received lines scroll off the top of the window. Non-scrolling mode is new in N1MM Logger+ – previously received
text does not move, but stays where it was first displayed until it is overwritten with new text. The line on which incoming text
is being displayed is indicated with an underline, and this line moves steadily down the screen until it reaches the bottom, after
which the top line in the window becomes the new incoming text line. The advantage of this mode is that received call signs
and exchanges do not move, making them easier to click on.
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The Digital Interface caption displays either the offset frequency (radio’s dial frequency +/- audio frequency) or the radio’s dial
frequency, depending on what you have chosen in the Digital Setup.

TX – Indicator to show which window has transmit focus (useful when using two sessions like SO2R)
Letters/Figs – Shows the text under the mouse in reverse case (letters/figures switched)
MouseOver – Shows the text under the mouse; this is the text that would be selected by a mouse click

Top RX window – This is the receive window. Depending on the scrolling option you choose in the Digital Interface’s Setup
window, you can make this window either a scrolling window (old text scrolls off the top of the window as new lines are
inserted at the bottom), or non-scrolling (new text appears on the active line, which is underlined; each time a new line starts,
the text that was previously in the next line down is cleared and that line becomes the new current line; if the current line is at
the bottom of the RX window, the line at the top of the window is cleared and becomes the current line where new text is
entered). Some users find it easier to use a non-scrolling window where text does not move after it is entered (so incoming
newlines do not cause text to scroll up just as you want to click on it). Other users find it easier to use a scrolling window so
that new incoming text is always near the bottom of the window where they don’t have to move the mouse very far to click on
it. The Logger gives you the choice.

There are 2 ways of moving a callsign from the RX window into the callsign box in the Entry window. You can single click on a
callsign and it will transfer over to the main logging window, or, whenever a callsign is detected in the RX window it will be sent
to the callsign grab window for easy movement to the logging window by clicking the Grab button or using a function key with
a {GRAB} macro in it.

Pause bar (green/yellow bar at the left of the RX window) -By clicking on the colored bar on the left you can pause input to
the receive window to scroll back through the (last 2000 lines of) text using the scroll bars. When the window is paused the
color of the bar will turn yellow. To turn input to the window back on click in the bar again and everything that was to be printed
to the window will now enter the window. When the receive window is paused it is possible to select and copy text in the
window.

Bottom TX window – This is the transmit window, a free form typing window. In the screen shot above, it is the darker grey
area below the received text window and above all the buttons. If you click on the TX button the cursor will be placed into this
window and whatever is typed will be sent. The size is static and doesn’t change size (2 lines). For TNC users: when not
transmitting, anything typed in the TX Window will be sent to the TNC. Used to send TNC commands to change settings etc.

Callsign Textbox and Grab – When a callsign is encountered in one of the receive windows it will be placed in the Grab list
in this textbox and when you press the Grab button it will transfer the callsign over to the main Entry window. The grab callsign
window holds the last 10 callsigns seen in the RX window. The most current one is at the top and is highlighted. Dupe
callsigns will not be shown in the grab window. The Sort Order in the grab window can be selected by right-clicking; you can
choose either Last In First Out or First In First Out as the sort order

 Callsign not added to grab List

Message buttons – The Digital Interface window can display 0, 8, 16 or 24 extra message buttons for preprogrammed
messages. Configuring these message buttons is done in the Digital Interface window under ‘Setup | Settings’ or by right
clicking on them, which brings up the Digital setup dialog. The width of these message buttons dynamically adjusts in relation
to the width of the interface window

Clr RX – Clear the receive window (also possible using the right click menu, unless the Rt Click = Enter option has
been selected)
Align (MMTTY and Fldigi only) – This is used to move the signal that you are copying into the passband of your filters.
Set the frequency in the setup area. For example, if your filters are centered on 2210 Hz, RTTY signals close to the
2125/2295 Hz pair will be copied well, but signals at higher or lower frequencies may not make it through the filters. If
you click on a signal at a frequency in the waterfall that is not close to the nominal 2125/2295 pair, it may not decode
very well. After clicking on the signal, if you click on the Align button your transceiver will be retuned to line the signal up
on the configured frequency. This is essential in FSK where the transmit frequencies are fixed in the radio, and useful
also in AFSK if you want to use narrow filters

Note that when you are using the MMVARI interface engine, the Align button appears on the MMVARI window
instead of on the Digital Interface window

TX – Start the RTTY transmission, the transceiver is keyed. Will be colored Red when transmitting
RX – Stop the RTTY transmission – the transceiver changes back to receive. Will be colored Green when in receive
HAM (MMTTY only) – Restore the MMTTY frequency and shift settings to the HAM default

 Callsign not added to grab List

If the callsign in the callsign field in the Entry window is the same as the callsign in the received text, the call in the
Entry window does not get placed into the grab call list. Clicking on a callsign in the RX window to move it into the
Entry window will remove that callsign from the Grab list.
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AFC (MMTTY only) – Can be used to turn MMTTY’s AFC on or off (colored background means AFC is on)
Lock (Fldigi only) – Locks the transmit frequency at the current location. If you move the receive frequency, e.g. by
clicking elsewhere in the waterfall, the transmit frequency does not change. Used for operating split
Rev (MMTTY and Fldigi only) – In sideband-sensitive modes like RTTY, reverses the tones (e.g. opposite sideband)
Grab – Transfer the selected callsign in the Callsign textbox to the callsign field on the main Logger Entry window.
Once the callsign is filled, whatever you click on next will fill the next exchange box. When the Digital Interface is in
transmit, calls are not added to the Grab window
CLR – Clear the Grab list

Receive Window Callsign Colors

When a callsign is recognized in the receive input stream the callsign will be colored according to the same color scheme that
is used in the Bandmap Window and brought to the Grab window. Valid callsigns that are separated by spaces are always
recognized, and optionally the Search routine can be used to search for known call signs from the Master.scp file in garbage
text strings. When the search in garbage text is enabled and two calls are found in the same string, only the last one gets
highlighted. Also, if the call sign being copied contains a shorter call sign that is in the Master.scp file, using the search in
garbage feature may result in the shorter call sign being recognized instead of the longer one. The highlighted calls in text
strings are clickable.

If the “Use Generic Routines” option is chosen under Callsign Validity and Highlight in the Digital Setup, anything that looks
like a callsign will be highlighted with a color that indicates its multiplier status using the same colors as in the Bandmap and
Entry window. If the “Use Master.scp File” option is chosen, callsigns that are not in the Master.scp file will be highlighted in
yellow in addition, either by changing the background to yellow (if the multiplier color is in the foreground), or by changing the
text color to yellow (if the multiplier color is in the background). Regardless of which option is chosen, anything that passes the
check routines and looks like a callsign will be placed in the Grab window.

Mouse Assignments

Left mouse key clicking
Single clicking on a callsign grabs it and places it in the Callsign field on the Entry Window dialog
Single clicking on Exchange info etc. (not on a callsign) grabs it and places it in the Exchange field on the Entry
Window dialog. If there are two or more exchange fields, as in some contests, you must take care to ensure that
the keyboard cursor is in the exchange box corresponding to the element you are clicking on; if you click on an
exchange element while the cursor is in the wrong box, the element will be transferred to the wrong place, and if
there was something else there, it will be overwritten

Note: The callsign field must be filled first! If there is nothing in the callsign field, single clicking on
exchange info will not do anything

Double clicking on a callsign grabs it and overrides the current information in the Callsign field on the Entry
Window dialog
Ctrl+Single clicking – will force what ever you are clicking to be sent to the box containing the typing cursor in
the Entry window (You may need to click first in the Entry window, or else use the space bar, to select the box
where you want to place the new data)
Shift+Single clicking – will cause the moused over text to be Letter/Figs converted on the fly while sending to
Entry Window (only in RTTY Mode)
Alt+Single clicking – if Digital Call Stacking is enabled, will transfer the call sign being clicked on to the
Bandmap call stack (see Single Operator Call Stacking for more information)

Right mouse key clicking on RX window
Will give a menu only when the menu item ‘RT Click = Return NOT menu’ is NOT selected!

Clear RX – Clear the receive window. This receive buffer can contain a maximum of 10,000 characters
Output to Text File – Output the received text to a text file named RTTY1.txt
Help – Show the help file for this window

Right mouse key clicking on TX window
Will give a menu only when the menu item ‘RT Click = Return NOT menu’ is NOT selected!

Clear TX – Clear the transmit window
Paste – Place the TX text in the Paste buffer

Right mouse key clicking in GRAB window
Gives a menu:

Clear List – Clear the entire grab window
Clear Selected Call – Clear the selected call in the grab window
Sort Order – Choose the order in which call signs are pulled from the grab window:

Last In, First Out
First In, First Out

Keyboard Assignments

Alt+T – Toggle TX/RX, when in TX the cursor will be set to the TX window of the active interface
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Ctrl+K – Toggle TX/RX and move the cursor into the DI’s TX window to send manual information using the keyboard;
press Esc or click on the RX button to terminate manual sending
Alt+G – Grab most recent callsign from callsign textbox. Upon grabbing that callsign gets deleted from the grab list
Ctrl+Left/Right arrows – When two radios are configured in SO2R or a dual-receiver radio is used in SO2V, and two
digital windows are open, pressing Ctrl+Left arrow or Ctrl+Right arrow will swap from one active Digital Interface to the
other. Digital Interface 1 will follow VFO A/Radio 1, Digital Interface 2 will follow VFO B/Radio 2

The Digital Interface – Menu Selections

The digital interface has a menu at the top which varies slightly depending on which type of interface is selected under the
Digital Modes tab in the Configurer.

Configurer Selection: Soundcard

Setup
Settings – Opens the Digital Setup window; see the section on ‘The Digital Interface – Setup’ below
Turn AutoTRXUPdate On/Off

If your radio’s dial displays the actual transmitted frequency (i.e. the Mark frequency in FSK RTTY), you
would turn this option off
If your radio’s dial displays the suppressed carrier frequency (e.g. SSB mode), you would turn this option
on. This causes the program to add (USB) or subtract (LSB) the audio frequency from the digital engine
to/from the radio’s dial frequency so that the frequency that appears in the Entry window, the Bandmap,
the log and spotted to the DX cluster is the actual transmitted frequency, not the suppressed carrier
frequency

 

Bring to Foreground when made Active – Bring the Digital Interface and Engine to the foreground when its Entry
window has focus

This adds ability to stack Digital Interfaces and Engines and have the correct one on top when the associated
Entry window has focus

SoundCard
RX Mixer – Shows the Record control mixer dialog from the Windows operating system. Only for Windows
versions XP and earlier
TX Mixer – Shows the Play control mixer dialog from the Windows operating system. Only for Windows versions
XP and earlier

These menu items are not available when using the Fldigi engine. They are also not available in Windows
7, 8, 10, 11 and Vista

Setup MMTTY – The MMTTY setup is shown. This menu item is only visible when MMTTY is selected
AFC On/Off with CQ – If set then the AFC will turn on with CQ message or TU messages. Turning AFC on when
soliciting new callers with a CQ or QRZ message can help tune in off-frequency callers
NET On/Off with Run Change – Option to turn Net function on in S&P and off in Running mode. In S&P mode, you
normally want to transmit on the same frequency you are receiving on; in AFSK, turning NET on ensures this. In Run
mode, you normally leave NET off in order to allow the receiver to track off-frequency callers without moving your TX
frequency
Turn Hover Mode On/Off – With this option selected, when the mouse is hovered over a valid callsign the callsign is
automatically transferred to the Entry window’s callsign box without having to click on it. This option is most effective
when used in combination with the RT Click = Return NOT menu option

Note: Your own call is excluded from being picked up
RT Click = Return NOT menu – When this option is selected, a right-click in the RX window will perform the same
functions as pressing the Enter key. This is designed to work with ESM; in ESM, in a routine QSO pressing the Enter
key automatically sends the next message in the normal QSO sequence. For example, when CQing, once a callsign
has been placed in the callsign box (either by left-clicking on it or using the Hover mode option), right-clicking will send
the exchange and move the cursor to the exchange box, left-clicking on the received exchange will transfer the
exchange to the entry window and right-clicking will send the TU message and log the contact. A complete QSO can be

AutoTRXUpdate can affect other modes

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is open. If you leave the DI window
open and switch to CW or SSB, the offset will continue to be applied, and the frequencies in the Entry window,
Bandmap and your log will be incorrect. You should always close the DI window when switching from digital modes
to other modes. Also, if you are likely to want to use a non-digital mode the next time you start the program, you
should close the DI window before shutting down N1MM Logger in order to ensure that the DI window does not
cause this option to be applied the next time you start the Logger.
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performed with simply a couple of left-clicks and a couple of right-clicks. As always with ESM, you need to be aware of
the current ESM state. If the exchange data is not yet valid, or if the cursor is in the callsign box after the exchange
data has been entered, the ESM state and the resulting action may not be what you expect
With RtClicked enabled Don’t drop On-Deck Call – modifies the behavior of the above option when there is an “on-
deck” call sign in the frame above the Call Sign box in the Entry window. The defaulr behavior is that if the call sign box
is empty and there is a call sign in the frame, right-clicking in the RX window will automatically transfer the on-deck call
sign into the call sign. Checking this option turns this off, i.e. it stops the call from dropping from the on-deck spot into
the call sign box when the call sign box is empty, ESM is on and the My Call button (F4) is highlighted.
Send Text File – Send a text file. A file open dialog will appear from which the file to be sent can be selected
Output Main RX Window to Text File – When this is checked, text that is displayed in the main RX window will be
saved to a text file in the ExportFiles directory in the N1MM Logger+ user files area. The file name will be date stamped
(mmddyyyy), as in 05312012DigitalInterface1Output.txt (for DI1)
Digital Call Stacking – Used together with the {LOGTHENPOP} macro. See Single Operator Call Stacking for more
information

Enable using First In First Out – Enables the Digital Call Stacking feature. Calls are popped off the stack in the
order they were placed there
Enable using Last In First Out – Enables the Digital Call Stacking feature. Calls are popped off the stack in
reverse order, i.e. most recent first
Enable using FIFO Mults First – Enables the Digital Call Stacking feature. Calls are popped off the stack in
order of their multiplier value. In those contests where one QSO can yield 2 or 3 mults, the higher-mult calls will
be taken first. Among calls with the same multiplier value, calls are popped in FIFO order, i.e. in the order they
were placed there
Disabled – Disables the Digital Call Stacking feature

Use RX Window Callsign Pause Routines – When this option is selected, moving the mouse in the RX window over
a valid callsign while the callsign box in the Entry window is empty will cause incoming text to stop appearing and the
RX window to pause scrolling. At this point you can either click on the callsign to transfer it into the Entry window,
display any incoming text that was held back during the pause and resume scrolling, or simply move the mouse off the
callsign to display any held incoming text and resume normal scrolling. Also with this option selected, when the left
mouse button is clicked in the RX window to select text the RX window will pause until the mouse button is released
after the text has been selected, at which point the selected text will be copied to the clipboard, any held incoming text
will be displayed and normal scrolling will resume. If there is a scrollbar present in the RX window, moving the scroll bar
will cause incoming text to be paused until either text has been selected and the mouse has been released, the pause
strip at the left side of the window is clicked, or the right mouse button is clicked in the RX window
Add. RX Windows

Enable Attached RX Windows – After one or more additional RX window(s) has/have been set up using the
last submenu item below, this option can be selected in order to attach or embed small RX text displays from the
additional RX window(s) into the main DI window. When the additional RX windows are attached to the main RX
window using this option, the attached windows appear above the main RX window. The non-attached RX
windows are minimized to the task bar when the attached windows are enabled, but they may be restored from
the task bar in order to see more text than is visible in the attached window, to access the setup options, or to
close the additional RX window without closing the main DI window. The task bar icon for the additional RX
window is grouped with the main N1MM Logger icons. If the additional RX window is using a software decoder,
there will also be a separate task bar icon for the digital engine; do not confuse the two task bar icons
Open Add. RX Window (4 Avail.) – This allows you to open an auxiliary RX window for diversity decoding of
the same RTTY signal, e.g. by using a TNC in the main DI window and MMTTY or 2Tone in the auxiliary window,
or by using a different copy of MMTTY or 2Tone with a different decoding algorithm to decode the same audio
input. There are up to 4 such windows available (the remaining number available appears in the menu). Each
additional window is associated with either DI1 or DI2, depending on which DI window menu was used to open
it. There is a separate Setup dialog for each additional RX window, which is accessible from the menu bar at the
top of the additional window. The first time an additional RX window is opened, its setup dialog will automatically
be displayed. The decoder type (MMTTY, TNC or DXP38 – use MMTTY for 2Tone), and the path to the program
or the COM port information for a TNC must be filled in before the additional RX window can be used. Once all
of the additional RX windows you intend to open from either DI window have been set up and tested, you can
use the Enable Attached RX Windows option to attach the additional windows to the main DI window

Configurer Selection: OTHER

Setup
Settings – Opens the Digital Setup window; see the section on ‘The Digital Interface – Setup’ below
Turn AutoTRXUPdate On/Off

If your radio’s dial displays the actual transmitted frequency (i.e. the Mark frequency in FSK RTTY), you
would turn this option off
If your radio’s dial displays the suppressed carrier frequency (e.g. SSB mode), you would turn this option
on. This causes the program to add (USB) or subtract (LSB) the audio frequency from the digital engine
to/from the radio’s dial frequency so that the frequency that appears in the Entry window, the Bandmap,
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the log and spotted to the DX cluster is the actual transmitted frequency, not the suppressed carrier
frequency

Bring to Foreground when made Active – Bring the Digital Interface and Engine to the foreground when its Entry
window has focus

This adds ability to stack Digital Interfaces and Engines and have the correct one on top when the associated
Entry window has focus

Turn Hover Mode On/Off – With this option selected, when the mouse is hovered over a valid callsign the callsign is
automatically transferred to the Entry window’s callsign box without having to click on it. This option is most effective
when used in combination with the RT Click = Return NOT menu option

Note: Your own call is excluded from being picked up
RT Click = Return NOT menu – When this option is selected, a right-click in the RX window will perform the same
functions as pressing the Enter key. This is designed to work with ESM; in ESM, pressing the Enter key automatically
sends the next message in the normal QSO sequence. For example, when CQing, once a callsign has been placed in
the callsign box (either by left-clicking on it or using the Hover mode option), right-clicking will send the exchange and
move the cursor to the exchange box, left-clicking on the received exchange will transfer the exchange to the entry
window and right-clicking will send the TU message and log the contact. A complete QSO can be performed with simply
a couple of left-clicks and a couple of right-clicks
With RtClicked enabled Don’t drop On-Deck Call – modifies the behavior of the above option when there is an “on-
deck” call sign in the frame above the Call Sign box in the Entry window. The defaulr behavior is that if the call sign box
is empty and there is a call sign in the frame, right-clicking in the RX window will automatically transfer the on-deck call
sign into the call sign. Checking this option turns this off, i.e. it stops the call from dropping from the on-deck spot into
the call sign box when the call sign box is empty, ESM is on and the My Call button (F4) is highlighted.
Send Text File – Send a text file. A file open dialog will appear from which the file to be sent can be selected
Output Main RX Window to Text File – When this is checked, text that is displayed in the main RX window will be
saved to a text file in the ExportFiles directory in the N1MM Logger+ user files area. The file name will be date stamped
(mmddyyyy), as in 05312012DigitalInterface1Output.txt (for DI1)
Digital Call Stacking – Used together with the {LOGTHENPOP} macro. See Single Operator Call Stacking for more
information

Enable using First In First Out – Enables the Digital Call Stacking feature. Calls are popped off the stack in the
order they were placed there
Enable using Last In First Out – Enables the Digital Call Stacking feature. Calls are popped off the stack in
reverse order, i.e. most recent first
Enable using FIFO Mults First – Enables the Digital Call Stacking feature. Calls are popped off the stack in
order of their multiplier value. In those contests where one QSO can yield 2 or 3 mults, the higher-mult calls will
be taken first. Among calls with the same multiplier value, calls are popped in FIFO order, i.e. in the order they
were placed there
Disabled – Disables the Digital Call Stacking feature

Use RX Window Callsign Pause Routines – When this option is selected, moving the mouse in the RX window over
a valid callsign while the callsign box in the Entry window is empty will cause incoming text to stop appearing and the
RX window to pause scrolling. At this point you can either click on the callsign to transfer it into the Entry window,
display any incoming text that was held back during the pause and resume scrolling, or simply move the mouse off the
callsign to display any held incoming text and resume normal scrolling. Also with this option selected, when the left
mouse button is clicked in the RX window to select text the RX window will pause until the mouse button is released
after the text has been selected, at which point the selected text will be copied to the clipboard, any held incoming text
will be displayed and normal scrolling will resume. If there is a scrollbar present in the RX window, moving the scroll bar
will cause incoming text to be paused until either text has been selected and the mouse has been released, the pause
strip at the left side of the window is clicked, or the right mouse button is clicked in the RX window
Add. RX Windows

Enable Attached RX Windows – After one or more additional RX window(s) has/have been set up using the
last submenu item below, this option can be selected in order to attach or embed small RX text displays from the
additional RX window(s) into the main DI window. When the additional RX windows are attached to the main RX
window using this option, the attached windows appear above the main RX window. The non-attached RX
windows are minimized to the task bar when the attached windows are enabled, but they may be restored from
the task bar in order to see more text than is visible in the attached window, to access the setup options, or to
close the additional RX window without closing the main DI window

AutoTRXUpdate can affect other modes

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is open. If you leave the DI window
open and switch to CW or SSB, the offset will continue to be applied, and the frequencies in the Entry window,
Bandmap and your log will be incorrect. You should always close the DI window when switching from digital modes
to other modes. Also, if you are likely to want to use a non-digital mode the next time you start the program, you
should close the DI window before shutting down N1MM Logger in order to ensure that the DI window does not
cause this option to be applied the next time you start the Logger.
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Open Add. RX Window (4 Avail.) – This allows you to open an auxiliary RX window for diversity decoding of
the same RTTY signal, e.g. by using a TNC in the main DI window and MMTTY or 2Tone in the auxiliary window,
or by using a different copy of MMTTY or 2Tone with a different decoding algorithm to decode the same audio
input. There are up to 4 such windows available (the remaining number available appears in the menu). Each
additional window is associated with either DI1 or DI2, depending on which DI window menu was used to open
it. There is a separate Setup dialog for each additional RX window, which is accessible from the menu bar at the
top of the additional window. The first time an additional RX window is opened, its setup dialog will automatically
be displayed. The decoder type (MMTTY, TNC or DXP38 – use MMTTY for 2Tone), and the path to the program
or the COM port information for a TNC must be filled in before the additional RX window can be used. Once all
of the additional RX windows you intend to open from either DI window have been set up and tested, you can
use the Enable Attached RX Windows option to attach the additional windows to the main DI window

Configurer Selection: DXP38

Setup
Settings – Opens the Digital Setup window; see the section on ‘The Digital Interface – Setup’ below
Turn AutoTRXUPdate On/Off

If your radio’s dial displays the actual transmitted frequency (i.e. the Mark frequency in FSK RTTY), you
would turn this option off
If your radio’s dial displays the suppressed carrier frequency (e.g. SSB mode), you would turn this option
on. This causes the program to add (USB) or subtract (LSB) the audio frequency from the digital engine
to/from the radio’s dial frequency so that the frequency that appears in the Entry window, the Bandmap,
the log and spotted to the DX cluster is the actual transmitted frequency, not the suppressed carrier
frequency

Bring to Foreground when made Active – Bring the Digital Interface and Engine to the foreground when its Entry
window has focus

This adds ability to stack Digital Interfaces and Engines and have the correct one on top when the associated
Entry window has focus

Turn Hover Mode On/Off – With this option selected, when the mouse is hovered over a valid callsign the callsign is
automatically transferred to the Entry window’s callsign box without having to click on it. This option is most effective
when used in combination with the RT Click = Return NOT menu option

Note: Your own call is excluded from being picked up
RT Click = Return NOT menu – When this option is selected, a right-click in the RX window will perform the same
functions as pressing the Enter key. This is designed to work with ESM; in ESM, pressing the Enter key automatically
sends the next message in the normal QSO sequence. For example, when CQing, once a callsign has been placed in
the callsign box (either by left-clicking on it or using the Hover mode option), right-clicking will send the exchange and
move the cursor to the exchange box, left-clicking on the received exchange will transfer the exchange to the entry
window and right-clicking will send the TU message and log the contact. A complete QSO can be performed with simply
a couple of left-clicks and a couple of right-clicks
With RtClicked enabled Don’t drop On-Deck Call – modifies the behavior of the above option when there is an “on-
deck” call sign in the frame above the Call Sign box in the Entry window. The defaulr behavior is that if the call sign box
is empty and there is a call sign in the frame, right-clicking in the RX window will automatically transfer the on-deck call
sign into the call sign. Checking this option turns this off, i.e. it stops the call from dropping from the on-deck spot into
the call sign box when the call sign box is empty, ESM is on and the My Call button (F4) is highlighted.
Send Text File – Send a text file. A file open dialog will appear from which the file to be sent can be selected
Output Main RX Window to Text File – When this is checked, text that is displayed in the main RX window will be
saved to a text file in the ExportFiles directory in the N1MM Logger+ user files area. The file name will be date stamped
(mmddyyyy), as in 05312012DigitalInterface1Output.txt (for DI1)
Digital Call Stacking – Used together with the {LOGTHENPOP} macro. See Single Operator Call Stacking for more
information

Enable using First In First Out – Enables the Digital Call Stacking feature. Calls are popped off the stack in the
order they were placed there
Enable using Last In First Out – Enables the Digital Call Stacking feature. Calls are popped off the stack in
reverse order, i.e. most recent first

AutoTRXUpdate can affect other modes

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is open. If you leave the DI window
open and switch to CW or SSB, the offset will continue to be applied, and the frequencies in the Entry window,
Bandmap and your log will be incorrect. You should always close the DI window when switching from digital modes
to other modes. Also, if you are likely to want to use a non-digital mode the next time you start the program, you
should close the DI window before shutting down N1MM Logger in order to ensure that the DI window does not
cause this option to be applied the next time you start the Logger.
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Enable using FIFO Mults First – Enables the Digital Call Stacking feature. Calls are popped off the stack in
order of their multiplier value. In those contests where one QSO can yield 2 or 3 mults, the higher-mult calls will
be taken first. Among calls with the same multiplier value, calls are popped in FIFO order, i.e. in the order they
were placed there
Disabled – Disables the Digital Call Stacking feature

Use RX Window Callsign Pause Routines – When this option is selected, moving the mouse in the RX window over
a valid callsign while the callsign box in the Entry window is empty will cause incoming text to stop appearing and the
RX window to pause scrolling. At this point you can either click on the callsign to transfer it into the Entry window,
display any incoming text that was held back during the pause and resume scrolling, or simply move the mouse off the
callsign to display any held incoming text and resume normal scrolling. Also with this option selected, when the left
mouse button is clicked in the RX window to select text the RX window will pause until the mouse button is released
after the text has been selected, at which point the selected text will be copied to the clipboard, any held incoming text
will be displayed and normal scrolling will resume. If there is a scrollbar present in the RX window, moving the scroll bar
will cause incoming text to be paused until either text has been selected and the mouse has been released, the pause
strip at the left side of the window is clicked, or the right mouse button is clicked in the RX window
Add. RX Windows

Enable Attached RX Windows – After one or more additional RX window(s) has/have been set up using the
last submenu item below, this option can be selected in order to attach or embed small RX text displays from the
additional RX window(s) into the main DI window. When the additional RX windows are attached to the main RX
window using this option, the attached windows appear above the main RX window. The non-attached RX
windows are minimized to the task bar when the attached windows are enabled, but they may be restored from
the task bar in order to see more text than is visible in the attached window, to access the setup options, or to
close the additional RX window without closing the main DI window
Open Add. RX Window (4 Avail.) – This allows you to open an auxiliary RX window for diversity decoding of
the same RTTY signal, e.g. by using a TNC in the main DI window and MMTTY or 2Tone in the auxiliary window,
or by using a different copy of MMTTY or 2Tone with a different decoding algorithm to decode the same audio
input. There are up to 4 such windows available (the remaining number available appears in the menu). Each
additional window is associated with either DI1 or DI2, depending on which DI window menu was used to open
it. There is a separate Setup dialog for each additional RX window, which is accessible from the menu bar at the
top of the additional window. The first time an additional RX window is opened, its setup dialog will automatically
be displayed. The decoder type (MMTTY, TNC or DXP38 – use MMTTY for 2Tone), and the path to the program
or the COM port information for a TNC must be filled in before the additional RX window can be used. Once all
of the additional RX windows you intend to open from either DI window have been set up and tested, you can
use the Enable Attached RX Windows option to attach the additional windows to the main DI window

Help – Shows help file

The Digital Interface – Setup
This setup dialog is for all interface types, but some settings are only for MMTTY or MMVARI. When selecting ‘Setup |
Settings’ in the Digital Interface window a dialog like the one below will be shown. Any changes made in the setup form must
be saved by clicking the Save Settings button located on the bottom of the form. Any changes made and saved will be
changed as soon as the setup area closes.

Tab: General/MMTTY Setup

This interface has general setup information for ANY type of interface (Soundcard or external TNC) and some specific settings
for MMTTY, MMVARI and Fldigi.
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Digital Setup Window

RX Windows add to Grab window – If this option is checked, callsigns detected in the Additional RX windows will be
sent to the Grab window
Display Radio Freq and not Exact Freq in DI Caption

Check this option if you are using a radio mode that displays the actual transmitted frequency rather than the
suppressed carrier frequency (e.g. FSK RTTY)
Note that this setup option only affects the frequency that is displayed in the DI window and that is returned by
the {RDIGFQ} or {LDIGFQ} macro. To change the frequency that is sent to the Entry window and recorded in the
log, see the DI window’s Setup > Turn AutoTRXOffset On/Off menu item

Add Callsign to Bandmap on Alt+G – (MMTTY and PSK) Option to send callsign from station in callsign field (Alt+O)
when doing a grab (Alt+G)
Send Space on Callsign Mouse Click – Sends a space to advance the entry window cursor after clicking on a call
sign
(MMTTY) Send HamDefault on Run to S&P change – (MMTTY only) Ability to have Ham Default(MMTTY) sent when
going from Run to S&P to reset Mark Frequency. Select to enable
(MMTTY-MMVARI) Turn AFC Off when switching to S&P – (MMTTY and PSK) Ability to Turn AFC Off when going
from Run to S&P. Select to enable. Many people when in Running mode will leave the Net Off and turn on AFC to find
people coming back to them a little off frequency. So to turn the AFC back off when you go to S&P (without forgetting)
this setting comes in handy
Do Not add Dupes to Grab Window – Setting for adding dupes to Grab window or Not
Send Space on Using Grab – when doing a grab from the grab window it will also send a space press command to
Entry window to advance the cursor
If QSY Wipes call is checked Clear Grab Window on QSY – If QSY Wipes and Spot call is checked then Clear the
Grab window on wipe of callsign.
QSY will clear Grab Window – Changing frequency will clear the Grab window
Clear Grab Window On CQ – sending CQ will clear the Grab window
Only Grab Master.scp Calls and – Will only send calls that are found in Master.scp to the Grab window; if this is left
unchecked, anything that passes the callsign validity check routines will be sent to the Grab window

On Top Settings
MMTTY always on Top – MMTTY is always in front of all other N1MM logger windows. A restart of N1MM
logger is needed to activate this function. Minimizing the N1MM logger program will not minimize the MMTTY
engine
MMVARI always on Top – MMVARI is always in front of all other N1MM logger windows. A restart of N1MM
logger is needed to activate this function. Minimizing the N1MM logger program will not minimize the MMVARI
engine
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Fldigi always on Top – Fldigi is always in front of all other N1MM logger windows. A restart of N1MM logger is
needed to activate this function. Minimizing the N1MM logger program will not minimize the Fldigi engine

Shift Frequency Compensation – for radios which use/need Shift Frequency Compensation
Enabled – Select to enable Shift Frequency Compensation
Offset Frequency – the frequency offset

Window Scroll
Window Scroll Type – You can choose between two scrolling behaviors in the RX window:

Scrolling – New text is always added at the bottom of the RX window. Each time a new line starts,
previous text scrolls up one line to make room for the new line at the bottom of the window. The most
recent text will always be near the bottom of the window, so you don’t often need to move the mouse
away from the bottom two lines or so, but if a newline character is received just as you want to click on
something, the text you wish to click on will scroll upward
Non Scrolling – Previous text does not move when new text is added. The line where text is currently
being entered is underlined, and each time a new line starts, the line immediately below the old current
line is cleared and it becomes the new current line. If the previous current line was the bottom line of the
display, the new current line will be the top line in the display, overwriting whatever was there before. Text
does not move after it is entered, which can make it easier to click on than text in a scrolling window, but
the most recent text can be anywhere in the window

Callsign Validity and Highlight Routines
Use Generic Routines – the generic routines will highlight anything that passes the check routines (and
probably will look like a callsign), using the standard colors for multipliers, QSOs and dupes
Use these resources: – when selected, only call signs that are found in at least one of the selected resources
will be highlighted

You can select any combination of the Master.scp file, the Call History file, calls that have been spotted on
the cluster and appear in the Telnet window, and/or calls that have been logged in this contest

Use Combination of both – when selected there will be additional highlighting for callsigns that are not found in
the selected resources. If the normal highlight is foreground, the background will be changed to yellow; if the
normal highlight is background, the text color will be changed to yellow. The yellow color is not configurable
Use Search routine to find Master.scp in Garbage Text – turn checking for callsigns in garbage text in digital
modes on or off. When this is turned on, callsigns that appear in the Master.scp file will be highlighted even if
there are garbage characters before and after the call. Note that if a longer callsign is found that contains a
callsign in Master.scp, only the callsign from Master.scp will be highlighted; you will have to enter the longer call
sign by hand
Highlight Foreground Text – call sign text will be in the highlight color on the normal background
Highlight Background of Text – background color surrounding call sign will be changed to the highlight color

Alignment Frequency – frequency used by the Align button = preferred audio frequency. If you are using FSK RTTY,
be sure to set the RTTY alignment frequency corresponding to your radio’s transmit frequency (i.e. set Align frequency
to your radio’s Mark frequency in MMTTY, Mark frequency + 85 in MMVARI and Fldigi)

MMTTY – RTTY alignment frequency. This is the Mark frequency
MMVARI – Alignment frequencies for MMVARI

RTTY – RTTY alignment frequency in MMVARI
NB Add 85 to place MMVARI’s Mark Frequency on desired frequency. Example: For 2125 Mark,
enter 2210

Other – alignment frequency for other modes than RTTY (e.g. PSK)
FLdigi – Alignment frequencies for Fldigi

RTTY – RTTY alignment frequency in Fldigi
Other – alignment frequency for other modes than RTTY (e.g. PSK)

Default RTTY Interface – Select the preferred RTTY interface. Choices are: MMTTY, MMVARI, FLDIGI, TNC or DXP-
38
Default PSK Interface – Select the preferred interface for PSK (and other sound card modes). Choices are MMVARI
or FLDIGI

MMTTY Window Layout
Normal – The normal size MMTTY window is shown, including waterfall/spectrum, menu bar and control buttons
Small – The small size MMTTY window is shown, i.e. waterfall/spectrum display only
Control Menus – Shows waterfall/spectrum plus menu bar
Control Buttons – Shows waterfall/spectrum plus control buttons

Save Settings – Save the configuration changes you just made. If you want to back out without saving the changes,
click on the X in the upper right corner to close the window; the program will ask you whether you are sure you don’t
want to save the changes
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Tab: MMVARI Setup

Waterfall/Spectrum Setup
Waterfall/Spectrum/Misc Color palette – The colors that make up the color palette can be changed to
represent whatever colors you would like. The colors go from the weakest signal on the left to the strongest
signal on the right. There is a color palette setting for the Waterfall, Spectrum and for Miscellaneous colors. The
Default button changes the colors back to the default colors

AFC Search Range – This is how far in Hz the interface will track a drifting signal i.e the frequency sweeping width (+/-
Hz) for the AFC

Sense Level – specifies the S/N level (dB) for the wide AFC. When the search range is less than or equal to 50
Hz, the wide AFC does not function. The sense level is applied to all the RX channels

Digital Output Level – specifies the digital output level in the range of 0 to 32767. The default value is 16384

Use TNC Software for control – When selected N1MM logger will release the serial port for the TNC so the
soundboard in the TNC can have control. When using an external TNC the internal soundboard can be used

# of MMVARI channels – Number of MMVARI channels to use. Choices are 1, 2, 3 or 4
Note that if this is set to 1, you have the option to select the Multi-Channel Rx menu item in the MMVARI menu
bar, but when it is set to 2, 3 or 4 this option is not available

MFSK (MFSK only)
Handling Center Frequency – When selected the center frequency is used for the carrier frequency. When not
selected the base tone frequency is used for the carrier frequency
Use Metric Level Squelch – Select to use the metric level for the squelch. When not selected the S/N level is
used for the squelch

Squelch Level – This level represents the noise level where you would like the interface to start copying signals. 0
indicates an open squelch and everything will be decoded
High Pass Filter – Select ‘Use High Pass Filter’ to use the internal high pass filter for RX. Although this is unnecessary
with most soundcards, it sometimes is effective for eliminating hum in the input audio

Spectrum Lower Freq – the lower frequency to display when the Spectrum view or Waterfall is active
Spectrum Upper Freq – the upper frequency to display when the Spectrum view or Waterfall is active

CW ID
Enable – If this check box is checked (Enabled) the interface will send the string entered in the field (Enter
CWID String) in CW after every transmission. A * will be substituted by SK, + by AR and = by BT

3/4/25, 5:37 PM N1MM Logger+ Documentation



572

Save Settings – Save the configuration changes you just made. If you want to back out without saving the changes,
click on the X in the upper right corner to close the window

Soundcard Setup
DI1/DI2 MMVARI Soundcard

Input Soundcard # – Select the input soundcard to be used
Input Channel – Select the input channel. Mono, Left channel or Right channel
Output Soundcard # – Select the output soundcard to be used)

FIFO
RX – specifies the depth of the RX FIFO buffer. Valid values are 4 to 32
TX – specifies the depth of the TX FIFO buffer. Valid values are 4 to 32

Clock – Soundcard Clock adjustment
RX Freq – specifies the sampling rate
TX Offset – the offset of the TX frequency compared to the RX frequency (some sound cards have an
offset between record and playback)

Save Settings – Save the configuration changes you just made. If you want to back out without saving the changes,
click on the X in the upper right corner to close the window

Tab: Message Setup

This tab is where you can edit the message buttons that are displayed in the lower part of the DI window. In addition to
selecting this tab from the DI Setup window, you can also open this window by right-clicking on one of the buttons.

There are four separate sets of message buttons stored in the database, one for each type of digital interface (MMVARI,
MMTTY/2Tone/Fldigi, TNC and DXP38). Before importing, exporting or editing buttons you need to select the particular
message set you will be working on.
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Import – Once a message set has been selected under Digital Message Set, you can import buttons for that set from
a .mc file using the Import button
Save – You can save the current message buttons in a .mc file in the N1MM Logger+ user files area by using the Save
button

# of Messages – Select the number of message buttons to be displayed in the DI window. You can select 0, 8, 16 or 24

Digital Message Set –
Select an interface type from the drop down menu. Choices are:

MMVARI – messages for the MMVARI interface
MMTTY,Fldigi – messages for the MMTTY, 2Tone and Fldigi interfaces
Other – messages for a TNC (such as a PK-232 or KAM)
Dxp38 – messages for a DXP38

Click on the message button which is to be updated to transfer that button to the Message Setup area
The Macro buttons at the right are for TNC interfaces only. Enter the control codes that are needed to switch
your TNC between RX and TX

Only visible when Other is selected
RX – Receive macro, i.e. the command(s) your TNC needs to put it into transmit. This will become the
contents of the {RX} macro
TX – Transmit macro, i.e. the command(s) your TNC needs to put it back into receive at the end of a
message. This will become the contents of the {TX} macro
ESC – Abort macro, i.e. the command(s) your TNC needs to abort an ongoing message immediately. This
will be executed when you press the Escape key

Message Setup
Message Text – This is where the text of the message sent by the selected button is displayed and can be
edited
Message Caption – This is where the caption that will appear on that button is displayed and can be edited
Available Macros – Shows the available macros that can be used in messages. Clicking on a macro will
transfer it to the message text area
Save Message – Save the contents of the Message Text and Message Caption into the selected button

Save Settings – Save the configuration changes you just made, i.e. the entire set of 24 buttons. If you want to back out
without saving the changes, click on the X in the upper right corner to close the window

Tab: DXP-38 Setup

This tab will only show when the DXP-38 TU has been selected under the Digital Modes tab in the Configurer.
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The various settings in this window are for setting up DXP-38 parameters. Consult the DXP-38 manual for detailed
instructions on setting them up.

Save Settings – Save the configuration changes you just made. If you want to back out without saving the changes,
click on the X in the upper right corner to close the window

Digital – MMTTY for RTTY support
The MMTTY soundcard interface, which uses the MMTTY engine by Makoto Mori, JE3HHT, is the most popular method for
RTTY. Amateurs who use RTTY are indebted to Mori-san for the positive impact MMTTY has had on amateur radio RTTY.

The 2Tone soundcard interface was written by David Wicks, G3YYD, as a replacement for the MMTTY interface in programs
like N1MM Logger. It can be substituted for MMTTY as the digital engine used in any of the Logger’s DI windows or Additional
RX-only windows. The 2Tone windows are different in appearance from the MMTTY windows, but perform similar functions.
These windows are described and documented in pdf files that you download with 2Tone.

MMTTY Windows

When using MMTTY two windows will open.

the N1MM+ Digital Interface window
this is the window where received and transmitted text appears, and where the primary operating controls are
located
this window is similar for MMTTY, MMVARI, Fldigi and external Interfaces (TNCs or TUs). See the Digital
Interface section

the MMTTY engine window
the primary purpose of this window is for its tuning indicators, but you can optionally have it display some of the
MMTTY engine controls as well – but unlike the stand-alone MMTTY window, there are no text panes and no
macro buttons
there are four versions which can be selected in the Digital Interface menu under Settings.

Small version MMTTY engine window (tuning displays only):
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Normal, or Large version MMTTY engine window, including some control buttons for various MMTTY settings:

Control Menus – small window plus the menu bar (View, Option, Profiles)

Control Buttons – large window minus the menu bar

Note: In the larger windows with the control buttons, there is a TX button. However, this may or may not be operative,
depending on whether PTT is controlled from MMTTY (often the case for FSK keying, but rarely for AFSK) or from N1MM+
(such as PTT via Radio Command or from a Winkeyer). In either case, the TX button in the N1MM+ Digital Interface window
will always work if the hardware configuration is correct.

Download, Configure and Test MMTTY

Download MMTTY

Download the installer for the current release of MMTTY here
At least version 1.64 is needed; version 1.68A or later is recommended

Run the installer program and install MMTTY to your computer in its own directory
In Windows 7, 8, 10, 11 and Vista, you must install MMTTY to somewhere other than the Program Files or
Program Files(x86) directories (for example, you can create an installation folder such as C:\MMTTY or
C:\HamRadio\MMTTY)
If you are using a standard USB-to-serial adapter for FSK keying, you will probably need to use the EXTFSK
plug-in. You can find a link to EXTFSK on the MMTTY download page (near the bottom of the page). Go to the
EXTFSK page, then download the ExtFSK106.zip file from the link at the bottom of that page and unzip it into
the MMTTY program folder

Users with high-performance multi-core CPUs (typically a 2.4 GHz i5 or faster Intel based system or 2.4
GHz quad core or faster AMD based system running Windows 7, 8 or 10 or Windows 8) may be able to
use EXTFSK64 instead of EXTFSK. EXTFSK64 has improved timing relative to EXTFSK, it supports
speeds other than 45.45 baud, and it can be used with LPT ports on 64-bit systems, but its CPU
requirements are much greater than those of EXTFSK. See http://www.qsl.net/ja7ude/extfsk/indexe.html
for more information and downloads

When you run MMTTY from inside N1MM Logger+, you will likely want the MMTTY configuration to be different
from the configuration used when MMTTY is run stand-alone. MMTTY always saves its configuration data to
files within its program folder. Therefore, any copy of MMTTY that is used from within the Logger should be
stored in a different folder from the main MMTTY folder. This can be a separate sub-folder in the MMTTY
program folder (but not in the C:\Program Files or C:\Program Files(x86) path), or it can be a folder in the N1MM
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Logger+ user files area, which can be found using the Help > Open Explorer on User Files Directory (e.g., you
can create a DigitalEngines sub-folder in the Logger+ user files area and then create separate subfolders in that
folder for each copy of MMTTY you wish to run from within the Logger; one for DI-1, one for DI-2, and one for
each additional RX-only window you might want to use it in). Then copy only the following files from the main
MMTTY program folder into the new folder(s): MMTTY.exe, MMTTY.ini, UserPara.ini, and if you need it for FSK
transmitting, Extfsk.dll or Extfsk64.fsk. If you use more than one copy of MMTTY (e.g. for SO2R/SO2V, or for
additional RX-only windows), each copy must be installed in its own folder

The 2Tone engine, which can be used as a drop-in replacement for MMTTY, can be downloaded from the G3YYD
folder in the Files area of the N1MMLoggerPlus user group at groups.io, in the form of a zip file containing the 2Tone
engine together with documentation for installing and using it. Each copy of 2Tone you plan to run (from DI windows or
additional RX-only windows) must be placed in its own folder, the same as described above for MMTTY

Configure MMTTY

FSK KEYING

1. In the N1MM Logger Entry window, select >Config >Ports, Telnet Address, Other >Digital Modes tab

Select Soundcard as your Interface type
Select for the selected Digital Interface as MMTTY, Mode FSK
Select the path to your MMTTY directory (for DI-2 if you are configuring for the second DI window)

2. Still in the Configurer, select the Mode Control tab

For ‘Mode sent to radio’, in the row labelled RTTY, set the mode to RTTY. This tells the program to put the radio into
FSK RTTY mode whenever a band or mode change is commanded from the program.

3. Save and exit the Configurer

If MMTTY is already loaded you may get an error message about not being able to open port xxxx. This is not a
problem at this point; note that you can always re-initialize MMTTY by closing and re-opening the Digital Interface
window

4. Open the Digital Interface window (under the Window menu)

Select the Interface > MMTTY menu item in the DI window
Select: Option > Setup in the MMTTY window, or use the DI window’s Setup > Setup MMTTY menu item

Select the TX tab and under PTT, set the serial port that you will be using for FSK keying; if you also use this
port in other modes for CW or PTT keying, the Digital and CW/Other check boxes in the Configurer should also
be checked for this port, and the DigWndNr in the setup dialog box for that port must indicate which DI window
the port will be used with (1 or 2)

If you are using a control line other than TxD for FSK keying, you must select EXTFSK or EXTFSK64 as
the serial port and configure the port and signal line information in the EXTFSK window. If you are using a
USB-to-serial adapter, you will most likely also have to select EXTFSK or EXTFSK64 as the serial port
and configure the port and signal line information in the EXTFSK window, as most USB-to-serial adapters
are not capable of keying FSK RTTY without EXTFSK
Note that MMTTY’s Radio Command port must be set to NONE; if you use MMTTY’s Radio Command
port when running MMTTY stand-alone, you must reconfigure MMTTY not to use this port when it is run
from N1MM Logger+

Select the Misc tab in the MMTTY Setup window and check COM-TxD(FSK) for the Tx Port
If you are using a USB device to do FSK keying, click on the USB Port button and set the option to C.
Limiting Speed

Select the Sound Card tab (in MMTTY version 1.66G or later) and choose the correct sound card for Reception
(the Transmission sound card is not used in FSK) (Note: Users of newer versions of Windows should consult the
text box on sound card selection in Windows 7 in the section below on AFSK, as the same issues may apply to
sound card selection for reception in FSK.)
If you are using two copies of MMTTY to decode signals using the two channels of a stereo sound card for
different receivers (SO2V) or different radios (SO2R), select the Misc tab again and in the Source pane, select
either “Left” or “Right”, depending on which channel you want this copy of MMTTY to decode
Close the MMTTY Setup dialog
Close the Digital Interface window to have the Logger and MMTTY save the settings

Using the RIGblaster Interface for FSK with N1MM/MMTTY

The default for FSK via MMTTY is TxD. You’ll need to change the jumpers when using a RIGblaster. Also, make sure you get
MMTTY working as a standalone first. Then you should just be able to specify MMTTY (select Soundcard) in the Digital
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Interface config in N1MM and it should take off.

AFSK KEYING

1. Open the Configurer (Configure Ports, Telnet Address, Other in the Config menu).

Select the Digital Modes tab
Select Soundcard as your Interface type.
Select for the selected Digital Interface as MMTTY, Mode AFSK
Select the path to your MMTTY directory (for DI-2 if you are configuring for the second DI window)

Select the Mode Control tab
For ‘Mode sent to radio’ in the row labelled RTTY, set the mode to AFSK (for radios that have a dedicated mode
for AFSK RTTY) or LSB (for radios that do not have a special AFSK RTTY mode). For most radios, do *not* set it
to RTTY; this will put the radio into FSK RTTY mode, which will not work for AFSK. See /manual-
supported/supported-radios/#digital-mode-mapping for more information on mode mapping.

Select the ‘Hardware’ tab
You can let N1MM Logger+ control PTT, or if you don’t use PTT in other modes and want to have MMTTY
control PTT, you can configure MMTTY to control PTT from a serial port. You can time-share a serial port
between CW/PTT keying in N1MM Logger+ and PTT from MMTTY; to do this, you must place a check mark
under the Digital column beside the port that you are using for the digital port
If you are using VOX or an external VOX unit like the SignaLink interface to control PTT, you don’t need to
configure anything for it in the Logger
If you have checked the Digital box, click on the Set button and set the Dig Wnd Nr to 1 (or 2 if you are
configuring for DI-2)
If you are using 2Tone in place of MMTTY, do not check the Digital check box for your PTT port

2. Save and exit the Configurer.

3. If you are using an audio codec that is inside the radio, you will need to check the “Internal Radio Codec” check box under
the Playback tab in the Logger+ Audio Setup window, which is opened using the Config > Logger+ Audio Setup menu item. If
you forget to check this check box, N1MM+ will mute the radio codec when transmitting, which will result in nothing being
transmitted.

4. Open the Digital Interface window (under the Window menu)

Select the Interface > MMTTY menu item in the DI window
Select: Option > Setup in the MMTTY window, or use the DI window’s Setup > Setup MMTTY menu item

If you are using 2Tone rather than MMTTY, you will make the configuration settings below in the 2Tone Setup
window, which is opened from the 2Tone window
If you have chosen to have MMTTY control PTT (not applicable with 2Tone), select the TX tab and under PTT,
set the serial port that you will be using for PTT. If the port is being time-shared with other modes, this should be
the same port that you checked the Digital box for in the Configurer

Note that MMTTY’s Radio Command port must be set to NONE; if you use MMTTY’s Radio Command
port when running MMTTY stand-alone, you must reconfigure MMTTY not to use this port when it is run
from N1MM Logger

Select the Misc tab and check Sound for the Tx Port
Select the SoundCard tab (in MMTTY version 1.66G) and choose the correct sound card for both Reception and
Transmission (users of WIndows 7, Vista and newer versions should read the note below)
If you are using two copies of MMTTY to decode signals using the two channels of a stereo sound card for
different receivers (SO2V) or different radios (SO2R), select the Misc tab again and in the Source pane, select
either “Left” or “Right”, depending on which channel you want this copy of MMTTY to decode
Close the Setup dialog

Close the Digital Interface window to have the Logger and MMTTY save the settings

Sound Card Selection in Windows 7, 8, 10, 11 and Vista

In earlier versions of Windows, selecting the sound card was relatively straightforward. Windows assigned a number (or two
numbers, one for recording=receiving and one for playback=transmitting) to each sound card device when it was installed,
and that number could usually be relied upon not to change. Once you had selected the desired sound card in MMTTY, you
were finished with the sound card configuration.

Starting with Vista and continuing in Windows 7, 8, 10 and 11, Windows has made life for sound card users more complicated.
The list now enumerates each active input or output as a separate device. The list of active inputs or outputs can change
dynamically. Plugging or unplugging a cable into one of the jacks on a sound card can create or delete a new entry on the list.
Windows power management can turn a USB port off if it has not detected any keyboard activity for some time, causing any
inputs or outputs on a USB sound card on that port to be removed from the list. When the computer is restarted or
reawakened after hibernating or sleeping, the list may be reconstructed and if there have been changes since the last restart,
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the order of devices on the list may change. If you are using a radio with a built-in USB codec, turning the radio on or off may
add or remove that codec to/from the list. If any of these changes in the list results in a different number being assigned to a
device you are using in MMTTY, that device will appear to stop working and you will have to readjust the sound card
configuration in MMTTY.

If this happens to you, the way to avoid it is as follows: Immediately before the contest, make sure that every sound card or
codec that you plan to use during the period of the contest is turned on and stays on for the duration. Verify your sound card
configuration immediately before the contest and then avoid doing anything during the contest that might result in a change to
the list. Disable power management features that might result in a USB port you are using being shut off by Windows (these
include not only advanced settings including USB selective power suspend under Power Options in the Windows Control
Panel, but also power management settings for each Generic USB Hub and USB Root Hub in Device Manager). If you are
using the USB codec inside a radio, always turn on the radio before opening the DI window, and close the DI window before
turning off the radio; preferably, don’t turn the radio off during the contest. Fortunately not all of these precautions will be
necessary in every case, but you should be aware of the possibility just in case.

Another wrinkle introduced in newer versions of Windows is that with some sound cards, the default for the sound card input
in the Windows Control Panel may have been set to single channel (mono) instead of two channels (stereo). If you are
planning to use both channels of a stereo sound card to decode signals from two receivers (SO2V) or two radios (SO2R), you
may need to verify that the default recording format for that sound card input is set to two channels. This is done via the
Windows Control Panel (Sound > Recording > select the input you are using and click on Properties > Advanced)

While you are checking the default recording format for number of channels, you will likely also have the choice of setting the
sample rate and bit depth. Bit depth is not a problem (16 bits is fine), but the sample rate has become an issue in Windows 7
or later and Vista. The sampling speeds in all applications that are using the same sound card in parallel should be the same,
and they should be integer sub-multiples of the hardware sampling rate. The default sampling speed in MMTTY is 11025 Hz,
which is suitable for a sound card that is set for CD quality (44100 Hz). However, the sampling speed in 2Tone is 12000 Hz,
which is suitable for a sound card that is set for DVD quality (48000 Hz), and it is not user-adjustable. Your best bet is
probably to set the sound card’s sampling rate to 48000 Hz (DVD quality), and to change the sampling speed in MMTTY to
12000 Hz (MMTTY Setup window, Misc tab, lower left corner – it’s called “Clock”).

Finally, if at all possible make sure that the sound card you select for digital modes has not been set to be the Windows
default sound input or output device. Setting one of the inputs or outputs on a sound card to be the Windows default can
disable other inputs or outputs on that sound card, which can make it very difficult to configure those devices in digital mode
programs.

Testing MMTTY

MMTTY is also a stand-alone application, so testing can be done outside N1MM Logger+. You can use the originally-installed
copy of MMTTY for stand-alone testing. Configuration changes you make in the stand-alone copy will not be applied to the
copies that you run from inside the Logger; once you have settled on a setup item in one copy, if you want that same item to
apply in other copies you will have to use the Setup window from within each separate copy to change that item.

Dual Receiver/Dual Radio Setup

In a dual-receiver setup (SO2R or SO2V), you may wish to be able to copy two separate RTTY signals (e.g. on two separate
bands or two separate frequencies) simultaneously. To do this, you would open two Entry windows (VFO A/Radio 1 and VFO
B/Radio 2) and open the Digital Interface window from each Entry window. You can then run MMTTY (or other digital interface
engine, such as 2Tone) from each of these DI windows.

The two audio streams from the two receivers can either be decoded by two separate sound cards, or in a single stereo (two-
channel) sound card using the left and right channels for the two receivers. In either of these situations, the two copies of
MMTTY must have different configurations; in particular, each one must be configured to use a different channel of the sound
card, or a different sound card. In the case of a dual radio setup, if you are using FSK on both radios and/or if MMTTY is used
to control PTT on both radios, each copy of MMTTY would also have to have access to its own serial port for PTT & FSK. This
is also true in SO2V setups in order to enable transmitting from either VFO; even though there is only one FSK keying input to
the radio in SO2V, the two DI windows need two separate serial ports for FSK keying, both connected to the same keying
input on the radio.

These serial ports are configured in MMTTY. You must set up each copy of MMTTY to use its respective serial port by
choosing the relevant serial port in the PTT & FSK Port box under the TX tab in the MMTTY Setup window. If one or both of
these ports is time-shared with N1MM Logger+ for CW/PTT keying, then in the Configurer you must indicate this with check
marks in the Digital column (Note: in order to check two Digital mode ports in the Configurer, you must be in SO2V or SO2R
mode). You must also click on the Set button for each port in the Configurer and set the Dig Wnd Nr to 1 or 2, to indicate
which of the two DI windows that serial port will be associated with.

If the two copies of MMTTY are to use different channels of the same sound card, each copy must be configured to use its
respective channel on the sound card under the Misc tab in the MMTTY Setup window; or, if they are using different sound
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cards, each copy must be configured to use its own sound card under the SoundCard tab.

In order to support separate configurations for the two copies of MMTTY, each copy must be located in a separate folder. You
can either use the main MMTTY program folder for one copy and a separate subfolder for the other copy, or you can create
two subfolders for use by the Logger, leaving the copy in the main MMTTY program folder for stand-alone use. These
subfolders must each contain, at a minimum, a copy of the MMTTY.exe file and the UserPara.ini file from the main MMTTY
program folder. A copy of MMTTY.ini will be created the first time MMTTY is run from the folder if it was not previously present.
If you are using the EXTFSK plugin, you will need a copy of the extfsk.dll file in the folder as well (or the extfsk64.fsk file if you
are using EXTFSK64). Other files from the main MMTTY program folder are not used.

The Logger’s DI windows have an additional RX window feature as well. Up to four additional RX-only windows can be
invoked from the Setup menus in the two DI windows. They can use either hardware decoders, MMTTY or 2Tone, but the
most common use is for separate copies of MMTTY or 2Tone using different decoding algorithms or profiles on the same data
stream. Because they are receive-only, these windows do not need access to serial ports and are not configured in the
Configurer. However, to be fully useful, although they most likely will share the same sound card and channel with their parent
DI window, they do need to have separate setups from the main copy of MMTTY (e.g. to use a different decoding algorithm or
profile). Therefore, if you wish to use these additional RX-only windows with MMTTY, you will need to create additional folders,
one for each additional window, containing copies of the MMTTY.exe, MMTTY.ini and UserPara.ini files (or if your are using
2Tone in stead of MMTTY, the 2Tone.exe, MMTTY.ini and 2Tone.ini files). These additional folders do not have to be created
at the time you first install MMTTY, i.e. you don’t need to do this until you are ready to use the additional RX windows. In
Windows 7 or later and Vista, all of these folder must be outside the Program Files and Program Files(x86) paths.

Using MMTTY

Messages must begin and end with {TX} and {RX}; these macros tell MMTTY to perform PTT switching
There is no special abort macro needed for use with MMTTY; just using the ESC key will stop transmitting
The TX and RX buttons in the DI window can be used for free form typing in the TX window pane of the DI window

How to Tune RTTY

Use the VFO on your radio and dial in the peaks to match the 2 yellow lines on the spectrum
Click view and the X-Y scope to see a crossed-ellipses tuning display

If the X-Y display seems to rotate in the wrong direction, open the MMTTY Option > Setup window (or the DI’s
Setup > Setup MMTTY menu item), select the Font/Window tab and check (or uncheck) the Reverse rotation
button

Make sure you click the “HAM” button to set MMTTY to the correct mark and shift settings
The default values for the HAM setting can be changed under the Demodulator tab in the MMTTY Option >
Setup window

It’s better to turn AFC off when you are in a crowded section of the band and manually tune the signals; if you leave
AFC on, nearby strong signals may pull the tuning away from the signal you want to copy
Also in crowded sections it can be helpful to use the built-in notch and bandpass filters
If you are using AFSK, unless your radio has a specialized mode for AFSK RTTY, the conventional choice with MMTTY
is to use LSB on all bands

If you use USB, make sure you click the “Rev” button in MMTTY
If you are using FSK, you need to be aware that NET does not work, and that tuning in a received signal by clicking in
the waterfall or by allowing AFC to tune in the signal will result in your receive frequency being different from the
transmit frequency. The “HAM” button will restore the correct audio frequency in your receive decoder but without
retuning the radio. The “Align” button in the DI window can be used to retune your radio so that the received signal is
lined up with your radio’s transmit frequency

When Should I Use AFC?

Use AFC (automatic frequency control) when MMTTY should automatically track the incoming RTTY signal. The best
example of this is when you are CQing and want to tune in off-frequency callers
With AFC and NET both turned on, MMTTY will track the incoming signal and also keep your transmitter frequency
locked to the received signal when using AFSK (NET does not work in FSK)

When MMTTY is set to transmit FSK, AFC will work on receive only. When in “Running” mode, you want to keep your TX
frequency stable, but with RX AFC set on you can pick up stations who reply a bit off your frequency and copy the exchange
without losing your TX spot. Just don’t let the AFC spread get too far from where you’re transmitting.

A nice option to use is: AFC On/Off with CQ – If set then the AFC will turn on with CQ message or TU messages. This
way when Running the AFC is on and during S&P the AFC is off
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When Should I Use the NET Option: NET On/Off with Run Change

NET only operates in AFSK. If you are using FSK, your transmit frequency is fixed by your transmitter, and the NET software
feature does not work.

When in ‘Search and Pounce’ mode the program will check the NET option so that once you tune a signal in, you will
transmit on the same frequency you are receving him on (Warning: this doesn’t work in FSK)
When in ‘Running’ mode the program will uncheck the NET option, which allows your receive decoder to follow an off-
frequency caller while still leaving your transmit frequency unchanged

Why to Use “Auto Update TRX Offset w/Mark Freq.”

If you are using FSK RTTY, most radios display the actual mark frequency on the tuning dial. A few even do this in AFSK
RTTY. If your radio is like this, you don’t need to use this option. The DI window title bar may display an offset frequency (radio
dial (+/-) audio), but if this option is turned off the offset frequency will not be logged and you can ignore it.

If you are using AFSK RTTY, especially with the radio in LSB or USB mode, as well as when you are doing a sound card
digital mode like PSK (using MMVARI or Fldigi), the radio probably displays the suppressed carrier frequency on its dial. This
is different from the mark frequency. If you are using the default mark frequency of 2125 Hz, the radio’s dial display will be
2125 Hz too high (LSB) or too low (USB) as compared with the actual mark frequency. By checking this option, N1MM Logger
will perform the correction automatically and display the actual mark frequency in the Entry window and the Bandmap window,
as well as in the DI window title bar.

Using MMTTY for 75 baud RTTY

There are some RTTY contests that specify 75 baud (100 wpm) RTTY instead of the usual 45.45 baud (60 wpm) speed.
MMTTY can be used for 75 baud RTTY, but there are a few quirks:

If you use EXTFSK for FSK keying (e.g. via a standard USB-to-serial adapter), you will not be able to use this
combination for 75 baud. EXTFSK does not support 75 baud. Instead, you must reconfigure for AFSK
If your CPU is capable of running EXTFSK64, it can be used in place of EXTFSK. EXTFSK64 supports 75 baud; see
http://www.qsl.net/ja7ude/extfsk/indexe.html for information on EXTFSK64
In the MMTTY Setup window, select the Decode tab, and at the top of the window, for BaudRate select 75
If you are using MMTTY version 1.68 or newer, in the MMTTY Setup window under the Demodulator tab, in the section
labelled HAM Default, UNcheck the “Fixes 45.45 baud” check box
If you are using an older version of MMTTY, you will need to be aware of the following:

The pre-version 1.68 MMTTY HAM Default button cannot be used in 75 baud RTTY; if you press HAM, the
speed will be reset to 45.45 baud. Besides not pressing the HAM button in the MMTTY window, there are a
couple of other setup items you need to take care of:

In the DI Setup window, under the General/MMTTY Setup tab, make sure the following item is NOT
checked:

(MMTTY)Send HamDefault on Run to S&P Change (if you forget to uncheck this item, you will
be switched back to 45.45 baud every time you switch from Run to S&P)

If you are using FSK with a true serial port or with an interface that supports FSK without using EXTFSK
(e.g. a microHAM microKeyer), turn AFC off in the MMTTY window, and make sure the following item in
the DI Setup window is NOT checked:

(MMTTY – MMVARI)Turn AFC On/Off on Run Change (if you forget to uncheck this item, AFC
will pull your receive frequency off your transmit frequency and you will be unable to use the HAM
button to correct the situation)
In the DI Window’s Setup menu, UNcheck AFC On/Off with CQ (same reason)

If you are using AFSK and like to use AFC, you may continue to do so, provided you are careful to ensure
that your transmit and receive frequencies stay together. The HAM button is not available to re-align your
transmit and receive frequencies. Therefore if you are using AFC, you should have NET on as well, to
keep your transmit and receive frequencies together. (Note: NET does not work in FSK)

After the 75 baud contest is over, be sure to restore the 45.45 baud speed and any of the other configuration options
you changed for 75 baud, in order to restore normal functioning

MMVARI for PSK and Other Modes

The MMVARI Interface

The MMVARI Interface The MMVARI soundcard interface is based on the MMVARI engine by Makoto Mori, JE3HHT.

All modes from the MMVARI engine are supported including bpsk (e.g. PSK31 and PSK63), qpsk-L (LSB), qpsk-U (USB – e.g.
QPSK63), also RTTY-L (LSB), RTTY-U (USB), MFSK-L (LSB) and MFSK-U (USB) as well as non-standard modes GMSK
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(HF), FSK (V/UHF), FSK-W (V/UHF, satellite). The -L and -U variants of some of these modes are there to allow you to
choose which sideband you use on the radio. In other words, you are not restricted to using LSB for RTTY and USB for other
digital modes; you can choose to use either USB or LSB on the radio, and if you have chosen the correct mode variant in
MMVARI, it will adjust the audio tones it uses to correspond to the sideband you have chosen.

The MMVARI engine does not have to be installed separately, it is included in the N1MM Logger+ program program/update
files and is the default digital engine when loading the digital window for the first time.

The MMVARI Digital Interface Window

The Digital Interface window when using the MMVARI engine is sub-divided into several areas which will be covered from the
top down.

TX – Indicator to show which DI window the transmit is going to take place from (useful when using two DI windows for
SO2R/SO2V)
Letters/Figs – Shows the text under the mouse in the other case (FIGS/LTRS – RTTY only)
MouseOver – Shows the text which would be selected where the mouse is positioned over

Receive Windows – The MMVARI engine supports from 1 to 4 receive windows. The number of receive windows is
selected from the DI window’s Setup > Settings menu item in the Digital Settings window under the MMVARI Setup tab
(# of MMVARI Channels). All of these windows operate in the same manner and you are able to grab callsigns from any
of them and place them into the Entry window. Note that when the # of MMVARI Channels is set to 1, a different
method of multiple RX channels becomes available (see The Waterfall or Spectrum Window below)

There is a narrow green pane on the left side of each receive window. By clicking on the green pane you can pause input to
the receive window to scroll back through the (last 2000 lines of) text using the scroll bars. When the window is paused the
color of the pane will turn yellow. To turn input to the window back on click in the pane again and everything that was to be
printed to the window will now enter the window. When the receive window is paused it is possible to copy text in the window.

If you click on a callsign using your mouse it will be put into the callsign field in the Entry window.
Also, whenever a callsign is printed to any of the receive windows followed by a space it will be sent to the callsign grab
window for easy movement to the logging window by clicking the Grab button.

RTTY

MMVARI is capable of using FSK keying for RTTY (selected from the Configurer under the Digital Modes tab, using a
specialized version of EXTFSK; this also requires the Logger to be started with the “Run as Administrator” option).
Note that the “FSK” mode in the MMVARI mode box is an entirely different mode – it is NOT FSK RTTY.
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You can select any exchange info by single clicking on the sent info. This info will be transfered over to the logger Entry
window item by item after the callsign is filled in.

The top receive pane is the window used for making QSOs. Selecting another frequency for this window is done by left
clicking in the Waterfall or Spectrum window. Changing the frequency of the other three receive windows is done by moving
the numbered marker above the waterfall to the desired location. You can also use the Swap buttons in the lower part of the
Waterfall window to exchange the selected window with the top receive window.

Transmit window – This is a free form typing window. If you click on the TX button the cursor will be placed into this
window and whatever is typed will be sent. The size of this window is fixed at 2 lines
Callsign Textbox and Grab – When a callsign is encountered in one of the receive windows (followed by a space) it
will be placed in this textbox and when you press the Grab button it will transfer the callsign over to the main logger
window. The grab callsign window holds the last 10 callsigns seen in the RX window. The most current one is at the top
and is highlighted. A right click in this box brings up a menu to clear list or selected callsign. Dupe callsigns will not be
shown in the grab window

Note: If the callsign in the callsign field in the Entry window is the same as the callsign in the received text, the call in the Entry
window does not get placed into the call list.

Clr RX – Clear all receive windows
TX – Places the interface into transmit, the transceiver is keyed, and places the cursor into the TX window for input.
See the Radio Interfacing section for Parallel and Serial port info on configuring for hardware PTT
RX – This will place the interface back into receive mode after all the characters in the transmit buffer have been sent.
To abort transmit immediately without waiting for remaining characters to be sent, press the Esc key
Message buttons – These buttons on the Digital Interface are up to 24 extra preprogrammed messages. Configuring
these macros is done in the Digital Interface window under ‘Setup, Settings’ (Message Setup tab), or by right clicking
on one of the buttons, which brings up the Digital Setup window. The button widths dynamically adjust in relation to the
width of the DI window. If the caption for a button is too long to fit on the button, the button will appear blank; you can
cause the caption to appear by making the window wider, or you can edit the caption to make it shorter so it will fit
Grab – Transfer the selected callsign in the callsign text box to the callsign field on the main logger window. The cursor
advances to the exchange box ready to accept the exchange when you click on it
CLR – Clears the grab window

The MMVARI Waterfall or Spectrum Window

The MMVARI digital engine window – This window uses the MMVARI control from Makoto Mori, JE3HHT. Across the top the
title bar shows either the offset frequency (radio (+/-) audio) or the radio’s dial frequency, depending on a setup option. As you
tune your radio this will update and the numbers will change.

The screen shot here shows the window with four receive channels selected in the Digital Setup. There are cursors
corresponding to each of the receive windows. The inverted triangle cursor, filled in in light blue, is for the main receive
window. If NET is on, this is also your transmit frequency. If NET is off, there will be another inverted triangle filled in in dark
blue indicating your transmit frequency. If you have more than one receive window enabled, a cursor with a number in it (1, 2,
…) corresponds to each additional receive window. To change frequency for the main receive window you can place your
mouse pointer over a signal trace and click with your left mouse button. To change frequency for one of the other receive
windows, you can click on the numbered cursor and drag it to the desired location in the waterfall.

TX Frequency and NET in FSK RTTY



3/4/25, 5:37 PM N1MM Logger+ Documentation



583

Buttons above the waterfall
TX – Start the transmission, the transceiver is keyed and places the cursor into the TX window for input. See the
Radio Interfacing section for Parallel and Serial port info for TX/RX switching (PTT)
RX – Stops the transmission, the transceiver changes back to receive after all the characters in the transmit
buffer have been sent. To abort immediately, press the Esc key
AFC – Turns AFC on or off. Selected (white) means AFC on (Note: This button is greyed out and disabled when
the Multi-Channel RX browser feature is enabled)
NET – Turns NET on or off. Selected (white) means NET on. When NET is on the TX frequency follows the RX
frequency (this function is inoperative in FSK RTTY)
Align – This is used to move the signal under the receive indicator to the Alignment Frequency set up in the
Digital Setup window. This can be used in most sound card modes to center the received signal in your filter
bandpass, and in FSK RTTY it is used to align the received signal with your transmitter’s signal

Example: Suppose the center of the filter pass band is 2200 Hz. When clicking on a signal at about 1400 Hz the signal may be
difficult to copy unless you are using wide filters. To move the signal to the center of your filter bandpass, click Align and the
rig shifts and the spectrum frequency shifts and places the station on the frequency that was initialized in the Digital Setup
window in the Alignment Frequency area. This allows you to narrow your filter bandwidth around the selected signal. If you are
using FSK keying for RTTY and if your receive frequency is not exactly on the center frequency of your radio’s mark/space
tone pair (e.g. 2210 Hz for the standard 2125/2295 “high” tone pair), then you can use the Align button to retune your radio so
your receive and transmit frequencies will be aligned correctly.

Mode selection – Select the mode to use by clicking on this button. The Speed selections are mode dependent.
Selections are:

GMSK – MBCS experiment (HF) – Possible speed selections: 31.25, 62.5, 125, 250
not used for contests

FSK – MBCS experiment (V/UHF) – Possible speed selections: 31.25, 62.5, 125, 250
not used for contests
Do not confuse this mode with FSK RTTY – MMVARI’s “FSK” mode is not FSK RTTY. MMVARI in N1MM
Logger+ does support FSK RTTY, but this can only be selected from the Configurer, not from the
MMVARI window

FSK-W – MBCS experiment (V/UHF, satellite) – Possible speed selections: 31.25, 62.5, 125, 250
not used for contests

BPSK – MBCS experiment (HF) – Possible speed selections: 31.25, 62.5, 125, 250
for contesting purposes, BPSK and bpsk are equivalent

bpsk – Standard BPSK (e.g. PSK31) – Possible speed selections: 31.25, 62.5, 125, 250
rtty-L – BAUDOT RTTY (LSB) – Possible speed selections: 45.45, 50, 56, 75, 100, 110, 150, 200
rtty-U – BAUDOT RTTY (USB) – Possible speed selections: 45.45, 50, 56, 75, 100, 110, 150, 200

You may choose either AFSK or FSK keying method for RTTY in the Configurer under the Digital Modes
tab

mfsk-L – MFSK (LSB) – Possible speed selections: 15.625, 31.25
mfsk-U – MFSK (USB) – Possible speed selections: 15.625, 31.25
qpsk-L – QPSK (LSB) – Possible speed selections: 31.25, 62.5, 125, 250
qpsk-U – QPSK (USB) (e.g. QPSK63)- Possible speed selections: 31.25, 62.5, 125, 250

Speed selection – Select the speed to use in bps by clicking on this button. The speed to select is mode dependent as
described above
Main Channel receive frequency – audio frequency

In RTTY, MMVARI displays the center frequency, not the mark frequency as displayed in MMTTY
Main Channel transmit frequency – audio frequency
Main Channel S/N reading

The Waterfall or Spectrum Display
At the top of the waterfall offset frequency (radio (+/-) audio) labels and tick marks are displayed
Receive channel markers

Top markers (tag cursors)
1,2,… – frequency receive channel 1,2,…
N – indicates a notch filter

The light blue colored marker (inverted triangle on the waterfall) indicates the main RX frequency
The dark blue colored marker (waterfall) indicates the TX frequency if it is different from the main RX
frequency (only possible if NET is off)

Mouse key clicking
Left mouse key clicking – single clicking in the waterfall will change the main RX frequency
Right mouse key clicking – the audio frequency at the point clicked on will be shown. Also a menu will show:

Note that if you are using FSK keying in RTTY, MMVARI has no control over your transmit frequency. Your transmit
frequency in FSK RTTY is fixed by the radio. Therefore, moving the dark blue transmit indicator does not change
your actual transmit frequency in FSK RTTY. Likewise, the NET function is inoperative in FSK RTTY.
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Set notch on here – adds a new notch filter on the selected frequency indicated by a N in a yellow area.
Multiple notches can be set; you can clear an individual notch by right-clicking on the N
Delete all notches – all set notches will be removed
Set TX Carrier on here – can be used to set the TX frequency (with NET off)
Turn Off Bandpass Filter – Turns the BPF off
RX 1 (2,3) Freq Here – can be used to set the RX 1, 2, or 3 frequency here (only if the # of MMVARI
Channels is greater than 1)

The left vertical indicator shows the signal level meter (green) and the squelch level (yellow line). Biy clicking on it the squelch
level can be changed.

Receive channels below the waterfall
If you have chosen to use more than one MMVARI channel, below the waterfall the additional receive channels
will be shown. The number of additional channels below the main waterfall is one less than the total number of
MMVARI Channels set, i.e. there can be up to three additional channels (up to four MMVARI channels in total –
to display more than four channels, see the Multi-Channel RX feature below)
Mode – Select the mode to use for this receive channel
Speed – Select the speed to use for this receive channel
Receive channel frequency
Receive channel S/N value
AFC – Turns AFC on or off for the selected channel. Selected (white) means AFC on
Squelch indicator – The squelch can be adjusted by dragging the line indicator to where you want it and turning
off the squelch by dragging it all the way left
Miniature waterfall display – shows within 500 hz of the signal that that channel is on. You can click anyplace
in this miniature waterfall or drag the indicator to where you want it
Swap – Exchanges this receive window with the main receive window. While working one station, you can dial
the second station in via a second receive window and after you finish the first contact just hit swap button and
then call the other station. See below for an alternative method of multi-channel receive

Menu at the Top
BPF – Used to enable/disable an internal audio Band Pass Filter. The BPF filter has steep skirts and 80db of
rejection outside the bandpass. However, because it is in the sound card and not in the radio, it has no effect on
unwanted signals inside the radio, i.e. a strong unwanted signal inside the radio’s IF filter bandpass can still
trigger the radio’s AGC and cause gain blocking, even though the signal has been rejected in the sound card by
the BPF. You can only prevent this by selecting narrow filters in your radio

Enable/Disable BPF – turns BPF on or off
Wide 1000 Hz, Middle 500 Hz, Narrow 250 Hz, Ultra Narrow 100 Hz, Custom – filter bandwidth
settings (grayed out when the BPF is disabled)

To set Custom width after enabling the BPF, left click in the waterfall where you want the BPF
bandpass to start. Drag your mouse with the left button held down and release it where you want
the BPF bandpass to end. The waterfall display will immediately relect the chosen Bandpass. This
makes it simple to eliminate an offending station on the fly
The minimum width of the BPF that can be set is 100 Hz

The BPF can be turned off by selecting Disable BPF on the BPF menu or by right-clicking in the waterfall
and selecting Turn off bandpass filter
The BPF settings are retained when you close and reopen the digital engine window

ATC – Used to turn Automatic Timing Control (ATC) on or off. It is recommended to keep ATC on all the time for
better signal decoding

when RTTY is selected ATC is always off
in MFSK mode ATC is always on

FFT – FFT is Fast Fourier Transform, which is a method of extracting the spectrum out of a waveform. That is
the basic tool that gives the waterfall and spectrum scope displays

FFT Type – Select the FFT display method. Selections are: Spectrum, Waterfall, Sync or Wave Input
FFT Width – Select the display width (frequency range). Selections are: 250 Hz, 500 Hz, 1000 Hz, 2000
Hz, 3000 Hz or User Defined. User Defined width is set in the Digital Setup window
FFT Scale – Select the vertical scale to use. Selections are: 100 dB, 60 dB, Square Amplitude
Waterfall AGC – Turn the waterfall AGC on or off
Align after Left Click – Automates the Align process. Any time a signal is clicked on in the waterfall, an
automatic Align operation is performed to re-center the audio frequency on the Alignment Frequency you
have selected in the Digital Setup window

SHIFT – Shift selections. The choices are 170 Hz, 200 Hz, 23 Hz or User Defined
Only in RTTY-L, RTTY-U and GMSK

RTTY Demodulator – select either IIR or FFT decoder. Depending on conditions, one may decode better than
the other

Only in RTTY-L and RTTY-U
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Multi-Channel Rx – This feature is only available when the # of MMVARI Channels in the Digital Setup window
under the MMVARI Setup tab is set to 1. It is an alternative method of receiving multiple signals simultaneously
with MMVARI

Enable Multi Channel Browser – turns this feature on
When the Multi-Channel RX feature is turned on, there will be several numbered tag cursors at the top of
the waterfall, and a separate browser window will open (see below). The number of channels is user-
selectable (from 2 to 24)
Each line in the browser window shows text decoded under the corresponding numbered cursor
There is only one RX pane in the Digital Interface window, which displays text from the main RX signal
under the light blue inverted triangle cursor
You can move the main RX cursor to the position of any of the numbered tag cursors simply by clicking in
the corresponding small text window
You can use this feature to keep track of several separate signals being received. You can work each one
in turn by clicking in the corresponding numbered text window to move the main RX/TX frequency (with
NET on) to each numbered cursor position in turn (if NET is off, or you are using FSK RTTY, clicking in
the text window only moves the RX frequency but not the TX frequency)

Open/Close Multi Channel Brower – turns the feature on or off (only visible after it has been enabled)
Set Number of RX Channels – you can select from 2 to 24 channels to display in the browser window
Set AFC Search Level – Used to set the signal level (S/N ratio) used to determine whether a signal is strong
enough to activate the AFC and cause the RX frequency to move to it (can be set from 1 to 20 dB)
Set AFC Search Range – Each extra RX channel has AFC (automatic frequency control) which moves the
cursor to keep it centered on a signal if the frequency changes slightly. This menu item is used to set the
frequency range over which this feature operates (can be set from 100 to 500 Hz)
Set Spectrum Search Frequencies – Allows you to set the lower and upper limits for the browser channels.
The lower limit can be 250 Hz or higher, and the upper limit can be 2700 Hz or lower
Turn Channel Markers On – If unchecked, channel markers will not be displayed
Show Audio Frequency Only – if checked, audio frequencies will be displayed instead of RF frequencies

The Multi-Channel RX method allows you to keep track of more channels (max 24) than the older # of MMVARI Channels
method (max 4) that you set up from the Digital Setup window. The memory for each channel is limited to 80 characters. You
can click on callsigns in the callsign column of the browser window in order to transfer them to the Entry window, or in
Dxpedition mode (see below), you can click on a callsign in the browser window in either the decoded stream or the callsign
column to: move the RX cursor (and if NET is on, the TX cursor) to that channel, transfer the callsign to the Entry window, and
transfer the last 80 characters decoded in that channel into the main RX window. All channels in the browser in this method
will be in the same mode. In RTTY, clicking on the channel marker for a channel switches between normal and reverse
decoding in that channel. (For another way to do multiple receive in PSK only, you can also try the PSK Browser in Fldigi).
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Browser window in multi-channel RX

Setup menu
Set On Top – check this if you want to ensure that the browser window is always on top of other windows
Set AFC Width – set the frequency range for AFC in each browser channel
Set AFC Level – set the signal level that activates AFC
Set Squelch Level – set the squelch level in the browser
Set Channel Background Color – set the background color for the text in the browser window
Set Channel Text Color – set the color for text in the browser window
Set Channel Highlight Color – set the color for the highlighted channel
Dxpedition mode – turns Dxpedition mode on or off

With Dxpedition mode off, clicking on a channel in the browser moves the main RX cursor to the
frequency of that channel. If NET is on, the TX cursor also moves to the same frequency
With Dxpedition mode on and NET off, clicking on a callsign in either the text stream or the callsign box in
a browser channel:

Moves the main RX cursor to the frequency of that channel, leaving the TX cursor where it was
Transfers the last 80 characters from that channel into the main RX window
Transfers the callsign into the Entry window
Can be used in a Dxpedition situation where your TX frequency is fixed and you want to work
stations anywhere in your receive range

With Dxpedition mode on and NET on (this is not possible in FSK RTTY), clicking on a callsign in either
the text stream or the callsign box in a browser channel:

Moves the main RX and TX cursors to the frequency of that channel
Transfers the last 80 characters from that channel into the main RX window
Transfers the callsign into the Entry window
Can be used for normal S&P operating. After switching to the frequency of the selected channel,
you can click on the Align button to center that channel in your receiver’s filter bandpass

Clear menu – clears the browser window

Setting Up the Digital Interface

The setup dialog is for both MMTTY and MMVARI, this means that some settings are only for MMVARI, MMTTY or both.
When selecting ‘Setup | Settings’ in the Digital Interface window a dialog wil be shown which is both for MMTTY and MMVARI.
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Please check the setup information in the Digital Setup chapter.

MMVARI Example

Select ‘Window > Digital Interface’ in the Entry window to open the Digital Interface and the Waterfall/Spectrum window.
The Digital Interface dialog can be positioned and resized on your monitor as desired
Left clicking on a call will grab the callsign. Right clicking on the RX and TX window will pop a menu (S&P mode) or
send the Exchange function key in Running mode, depending on your choice for te Rt. Click option in the DI Window’s
menu
Pressing Insert will Grab the highlighted call and sends His call followed by the Exchange button
Double clicking on a callsign in the callsign box from the Digital Interface sends that call to the Entry window
A callsign is automatically highlighted if recognized by the program. For that to happen it needs to have a space before
and a space after the callsign

Digital – Fldigi for Sound Card Modes
The Fldigi interface

The Fldigi sound card interface is based on the fldigi code by Dave Freese, W1HKJ.

Fldigi supports a wide variety of digital modes, including not only AFSK RTTY and PSK, but also other less common modes
such as MFSK, MT63, Olivia, Throb, etc.

Fldigi is a stand alone application, so you can also use it separately from N1MM Logger. Note that the configurations for Fldigi
stand-alone and within the Logger are separate, i.e. changes made to the stand-alone configuration will not be applied to the
configuration within the Logger, and vice versa.

Fldigi does not support keying outputs on serial or parallel ports, as used by N1MM Logger for CW and FSK keying. Fldigi can
be used from the Logger for AFSK RTTY or for PSK31 or other digital modes, but not for transmitting RTTY using FSK unless
you use an external hardware circuit to convert audio output from Fldigi to an on-off keying signal for FSK. It can also be used
as a CW receive-only decoder, but not for transmitting CW. For transmitting CW, use one of the CW interfacing methods
detailed in the “Basic Interfacing – Radio, CW, PTT” chapter. You must not check the Digital check box on a port that will be
used for CW keying while the DI window or the CW Reader window is open.

Download and Configure Fldigi

Download Fldigi

Download the current release of fldigi from the W1HKJ website at http://www.w1hkj.com/ . You can find a copy of the
full installer for the current version of fldigi at that website. This file is a self-extracting executable, similar to the N1MM
Logger installer. Download the installer file to a temporary folder and then execute it. It is recommended that you install
fldigi in its own program folder and not in the N1MM Logger+ program folder. By default, the installer will install fldigi to
C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the fldigi version number.
If you are using Windows Vista, 7, or later, and you want to run fldigi from inside N1MM Logger+, you must use a copy
of fldigi.exe that is located in its own folder outside the Program Files (or Program Files(x86)) folder. You can, for
example, create a folder for fldigi inside your N1MM Logger+ user files area, then make a copy of fldigi.exe from the
original installation location and copy it into the new folder. The only file you need to copy is the exe file; it will create
whatever other files it needs the first time it is run.

Fldigi Initial Configuration

After fldigi has been downloaded and installed, open the Configurer and set up the path to fldigi.exe under the Digital Modes
tab. After closing the Configurer, choose a contest in N1MM Logger that supports digital modes, select the Window > Digital
Interface menu item from the Entry window, and then in the Digital Interface window, select the Interface > Fldigi menu item.

When you first open the fldigi interface from the Logger, and also any time you install fldigi into a different location, such as
separate locations for the two digital interface windows or for the DI window and the CW Reader window, you will be prompted
to fill in some configuration information by the fldigi configuration wizard, as follows:

Operator information – You do not need to fill in any of this information; N1MM Logger+ handles logging and all
related information
Audio devices – Under the Devices tab, check the PortAudio box and select the sound card input and output you are
using for Capture and Playback. Click Next
Transceiver control – In fldigi version 4.1.02 and newer, do not select any method of rig control in fldigi. In older
versions, select the XML-RPC tab, check the Use XML-RPC Program box, and click the Initialize button. Do NOT
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select flrig, RigCAT, Hamlib, or MemMap for rig control; none of those will work with N1MM Logger+
You can let N1MM Logger handle PTT, in which case you do not need to configure PTT in fldigi. This is the simplest
(recommended) configuration. However, if you do not use PTT in other modes and you want to use hardware PTT
controlled by fldigi, you can select the Hardware PTT tab, check the Use separate serial port PTT checkbox, select
the appropriate COM port in the Device: window, and check either Use RTS or Use DTR, depending on which one your
hardware setup uses. If the label on the Initialize button is red, click on the button. Note that a COM port that is used
by fldigi cannot be used simultaneously by the Logger for other purposes. If you are time-sharing a serial port between
fldigi in digital modes (not including CW) and the Logger in CW or SSB, check the Digital check box beside the COM
port in the Configurer to ensure that the Logger will not try to use this port while the Digital Interface is open

If you intend to use fldigi as a receive-only CW decoder, be aware that you cannot use fldigi to transmit CW.
Also, you cannot control PTT from fldigi on the same port that N1MM Logger+ uses for CW keying; do not check
the Digital check box beside this port, and do not configure it within fldigi as a PTT port

Click Finish

The fldigi configuration wizard does not automatically save its settings. After you have exited the configuration wizard and the
main fldigi interface window has opened, you must save the configuration settings using the fldigi Configure > Save Config
menu item. If you don’t do this, then every time you open the fldigi window you will have to go through the configuration wizard
steps again. Similarly, any time you make a subsequent change to the fldigi configuration you must explicitly save the new
configuration if you want the change to be remembered.

Newer versions of fldigi may default to requiring confirmation from the user before you shut them down. If that shutdown is
initiated by shutting down N1MM Logger+, instead of by shutting down the DI windows and engines first, this can result in
fldigi continuing to run after the Logger has shut down. This will cause problems the next time you start up the Logger. To
prevent this from happening, you need to make a change in the fldigi configuration file. In each folder that fldigi is run from,
find the file called fldigi_def.xml. (Note: this file is created the first time fldigi is run from this location, i.e. it will not exist until
after you have run that copy of fldigi at least once). Right-click on the file name, select Open with… and then select Notepad
or Wordpad as the program to open the file with. Look for a line that reads < CONFIRMEXIT > 0 < /CONFIRMEXIT > or <
CONFIRMEXIT > 1 < /CONFIRMEXIT > . If you see a 1 between the two keywords, change it to a 0 and save the file. Repeat
this for each and every copy of fldigi you use from within N1MM Logger+ (DI1, DI2, additional RX-only digital windows, CW
Reader 1 and/or CW Reader 2).

The Fldigi Interface Window

Menu
File

Exit – closes the Fldigi window
Op Mode

CW – This configures Fldigi to decode CW (receive-only)
PSK – select BPSK-31 for normal PSK31, BPSK-63 for PSK63, etc.
RTTY – select RTTY-45 for normal 45 baud AFSK RTTY
Other selections can be used for other modes – see the fldigi help for details

Configure
Waterfall – under the Display tab, you can select whether to show audio or RF frequencies in the scale
at the top of the waterfall, and whether to display transmitted as well as received signals
Rig control – you can use the Hardware PTT tab to change the PTT settings for a separate hardware
PTT port
Sound card – you can select the sound card to be used by Fldigi under the Devices tab
Modems – this is where you make configuration changes that apply to specific modes only (e.g. PSK-
specific changes, or RTTY-specific changes)
Save Config – use this to save the new configuration any time you make changes

View
PSK Browser – opens a browser window that can display up to 30 signals within the waterfall
simultaneously (PSK only). To configure this browser window, use Fldigi’s Configure > Modems > PSK >
Viewer configuration window to set the number of channels, the starting (lowest) audio frequency
(channel separation is 100 Hz), and various other parameters
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Most Fldigi menu items not mentioned above are either not used by N1MM Logger, or perform advanced functions that are not
needed for basic operation. See the fldigi help at the W1HKJ web site for more details (there is a link to the Fldigi-Help page
from the download page at
http://www.w1hkj.com/download.html).

Note also that when the Fldigi engine is selected, additional buttons appear in the Logger’s Digital Interface window:

Align – for retuning the radio so that the desired signal is aligned on a pre-configured frequency
Lock – to lock the transmit frequency at the present position in the waterfall while allowing the receive frequency to
vary (for operating split)
Rev – in sideband-sensitive modes like RTTY, reverses the tones

Unlike the other digital engines used in the Logger, Fldigi assumes the rig will be in USB for RTTY. If you are
using LSB, you will need to use the Rev button to tell Fldigi to reverse the tones. If you have tuned in a signal
but all you see in the receive text window is garble, try clicking the Rev button once or in some cases, twice
(sometimes you may find it necessary to toggle the Rev state off and back on to get it to “take”)

Note that older versions of Fldigi only use the left channel on input; for that reason, in most SO2V installations these older
versions of Fldigi can only be used from Entry Window 1. Starting with Fldigi version 3.22.06, Fldigi is now capable of using
either sound card channel for input. In any copy of Fldigi that you want to use with the right channel of the sound card, use the
Configure > Sound Card menu item in the Fldigi window to open the Fldigi configuration window. Select the Right channel tab,
and near the bottom under Receive Usage, check the Reverse Left/Right channels check box to switch Fldigi to use the right
channel on RX. Click on Save to save the configuration change, and then close the configuration window.

Digital – External TNC Support
The Digital Interface will not only work with MMTTY, MMVARI and external TNC’s like the PK232, HAL DXP38 but with ANY
TNC.
This is because (with the special-case exception of the HL DXP-38) the commands for the TNC are not hard coded into the
program. This has to be done by the user of the program.

Information about the following external TNCs can be found below but as already stated ANY TNC that uses serial
communication can be used with N1MM Logger.

The Digital Interface

The Digital Interface can be used with any external TNC.

Using a TNC will show an interface like the one above.

Setting Up the TNC in the Configurer

1. Start the N1MM Logger application
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2. On the Logger Main Window select >Config >Configure Ports, Telnet Address, Other >Digital Modes tab
3. In Digital Setup

1. Choose Other for Interface (for any TNC except for the HAL DXP-38; for the DXP-38, see separate instructions
below)

2. Set other parameters accordingly (Example settings: Com 4 ,9600 ,8 ,N ,1, RST-Xon)
3. Save the configuration [OK]

4. Load the Digital Interface from the Window menu
5. Program the RX, TX and Abort macros by opening the Digital Setup window (Setup > Settings menu item in the DI

window), selecting the Macro Setup tab, selecting the “Other” digital macro set, and then right-clicking on each of the
TX, RX and Esc buttons at the right side of the window and programming them with the appropriate codes to put your
TNC into transmit, to put it into receive at the end of a message, and to abort a message, respectively. Once you have
done this, the {TX} and {RX} macros will work in function-key messages and the other DI button messages, and the
Esc key can be used at any time to abort a transmission.

Make sure your interface is set to copy RTTY at 45 baud and 170 Hz shift. If necessary, you can type the TNC command(s)
for this in the transmit window so it will be sent to the TNC, or (better) you can program it into one of the DI message buttons.

Test Your External TNC

Test stand-alone
See the separate sections for the PK-232, KAM, HAL etc. If your TNC is not mentioned please set it up like the other
mentioned TNC’s

Make sure your radio and TNC work on your computer’s serial port by testing them with an existing terminal program. Connect
your TNC/Radio into your computers serial port. The Hyperterm terminal program is included with Windows and works well.
Make sure you note all COM port parameters. You should be able to tune in a RTTY signal and print it using the Hyperterm
program. The Windows Hyperterm is geared toward modem communications and is not especially intuitive for direct COM port
use. As stated previously, you can use any number of terminal emulator programs. For example, the Tera Term Pro 3.1.3 by
Ayera Technologies is a small, open source, free terminal emulator that is available for download.

The interface has been tested with the three mentioned TNC’s below and works fine with them. Any other TNC should also
work as long as you place the right commands for that TNC in the macros.

Additional Macros for the External TNC Interface

The Digital Interface will accept all of the Macro keywords that can be used in the Packet window and other places in the
Logger and will also accept the following: {CTRL-A} – {CTRL-Z}, {ESC}, {ENTER}.

These macro keywords can be used in any of the DI message buttons or the Logger function keys in the Entry window.

The TX window will accept all control key commands except for the Esc key, which must be sent as a Shift+Escape
combination.

Remember that when setting up a message key that is not a TNC command you will need to include the {TX} macro (or the
equivalent TNC command) to key the TNC before it sends. If a message does not start with the {TX} macro, your TNC will
think it is a command being sent to it instead of message text, and it will not know how to process it. Before using the {TX} and
{RX} macros in messages, you need to initialize them with the correct commands for your TNC, by opening the Digital Setup
window, selecting the Macro Setup tab, selecting the “Other” Digital Macro Set, and then programming the TX, RX and Esc
buttons with the correct command sequences for your TNC.

To use free form typing in the TX window you need to first key your TNC (e.g. using the TX button after it has been
programmed correctly for your TNC). Click the TX button to start transmitting and then click in the TX window. Whatever you
type in the TX window now will be sent out. After you have finished typing, click on the RX button to return to receive mode.

HAL DXP38 Setup

The HAL DXP-38 is supported as one of the possible interfaces. Setup for the DXP-38 is different from setup for other TNCs.

There is a selection for the DXP-38 interface type in the Configurer under the Digital Modes tab, TU type.

Hardware Setup

It is a good idea to get the DXP38 running with WF1B, HAL or another known software package before trying to set it up for
the first time in N1MM Logger. Doing this eliminates the need to troubleshoot both hardware and software simultaneously
when configuring N1MM Logger. Hardware setup:
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1. Connect the PTT and FSK lines to the rig
2. Connect the COM port (1 for HAL software) to the TNC
3. Connect audio input to the DXP-38
4. Connect the power
5. Connect AFSK output to the rig (AFSK only)
6. Consult the DXP-38 manuals for the details. The rig must be setto FSK RTTY (LSB) or LSB for AFSK

Software Setup in N1MM Logger

Port configuration – The COM port used for the DXP38 port should have a check mark in the Digital check box in the
Configurer.

Under the port settings (Set button), DTR/RTS should be set to Always On. Set the DigWNdNr to the digital window number
that the DXP38 will be used with (1 or 2, for DI window #1 or #2).
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Digital configuration – In the Configurer under the Digital Modes tab, in the left side for the digital interface window that the
DXP38 will be used with (Digital Interface 1 or 2), the port settings should be 9600 baud, N,8,1 and no handshaking:

Command macros to control the DXP38

Most of the useful DXP38 features can be controlled from the DI Setup window under the Dxp-38 Setup tab. However, you
may also use DXP38 macros in the DI window buttons (but NOT in the Entry window function keys). To program one or more
of these buttons, you can right-click on one of the buttons to open the editing screen. The HAL command set is documented in
the DSP4100 technical documentation at the HAL website. The HAL macros are in the form of two hexadecimal bytes, the first
of which is a hex 80. To program a command whose second byte is xy (where x and y are hexadecimal digits), include a
macro in the form {H80xy} in the message button. You miust follow this exact template: the macro is surrounded by curly
braces and starts with an H, followed by four hexadecimal digits (8, 0 and the two digits corresponding to the desired HAL
command). Once you have edited one of more of the message buttons, you can save the entire file in the Dxp38 macro button
set using the Save Macros button in the edit window.
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RTTY messages

Your contesting and other RTTY messages can be either in the Entry window function keys (F1-F12, e.g. for use from the
keyboard or with ESM) or in some of the DI window buttons (for auxiliary messages that are only used occasionally, by
clicking on them with the mouse). These messages work the same way with the DXP38 as for other digital interfaces. Start
each message with {TX} and end it with {RX}. Note that message buttons that are programmed in the DI window set with
Dxp38 selected as the interface type will be stored in the Dxp38 macro set, i.e. they will be saved separately from message
buttons that you set up for MMTTY or for MMVARI.

First time startup

Start up N1MM logger first
After the program loads, make sure focus is on the TNC received text screen. Then turn on the DXP38. If the
data link is OK , an @ will be printed on the screen. It takes about 20-30 seconds for the DXP to initialize after
the @ appears in the RX window.

Subsequent startups
Turn on the DXP38. Start N1MM logger. After the DXP38 initializes, you should see a text rendition of the
initialization process on the screen. The following screen shot is from the classic (pre-Logger+) version of the
Logger, so yours may look slightly different, but you should see the same initialization messages in the RX
window (the DXP-38 tuning indicator has been enabled in this screen shot, but none of the 24 message buttons
in the DI window has been programmed yet):

Configuring a DXP-38 in one of the additional RX windows

The DXP-38 can be configured to be used in one of the additional RX-only windows. To do so, use the Setup > Open Add. RX
Window menu item in the Digital Interface window. If this is the first time this window has been opened, the Setup window will
open, otherwise you may have to use the Setup menu item in the RX window:
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Select Dxp38 as the window type. The MMTTY Setup section is not used for the DXP-38. Under TNC Setup, select the COM
port used for the DXP-38 and set the other parameters to 9600, N, 8, 1, no flow control, DTR and RTS both Always On. Once
you click the Save button to save the configuration, close and reopen the RX window. The following screen shot is from an
older version of the Logger, so yours may not look exactly like this, but you should see the same initialization messages on
startup:

HAL ST-8000 Setup (not supported)

The HAL ST-8000 TNC is not supported and will not work with N1MM Logger as the baud rate used by the HAL is 45 baud
and the serial port control in N1MM will only go as low as 110 baud…
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KAM Setup

Launch Hyperterm and set its parameters to 9600 bps, 8 databits, no-parity, 1 stopbit and no flow control
Connect the KAM to the port configured in Hyperterm
Turn on the KAM
When you see the message ‘Press (*) to set Baud Rate, press the “*” button’
Then set your callsign as prompted
To place the unit into RTTY mode type “RTTY”
Also make sure the unit is set up for software handshaking XFLOW = ON
Once you are communicating with the KAM and have it in the RTTY mode, you can also tune in a RTTY signal and it
will decode and print on the Hyperterm window
Now try to transmit by typing a Ctrl+C and a “T” on the keyboard followed by several characters that you wish to
transmit. To get back to receive, type a Ctrl+C and a “R”
If you have problems, consult your KAM manual
Now exit the Hyperterm program and start Logger

Below are sample RTTY settings for the KAM TNC

AUTOCR 0 AUTOLF ON AUTOSTRT OFF

BKONDEL ON CD SOFTWARE CRADD OFF

DIDDLE ON ECHO ON FILTER OFF

FSKINV OFF INVERT OFF LFSUP OFF

LOWTONES OFF MARK 2125HZ RBAUD 45

SHIFT 170 SPACE 2295HZ USOS ON

XFLOW ON XMITECHO ON – –

There are three parts in setting up N1MM logger to work with the KAM.

1. Port configuration in the Configurer under the Hardware tab:

The serial port used by the KAM should have a checkmark in the Digital check box

2. Digital configuration (Configurer, Digital Modes tab)

Set the TU Type to “Other” and configure the port for 9600 baud, N,8,1 and none

3. Macro Creation required to control the KAM (Digital Interface Setup window, Message Setup tab)

Select the “Other” Digital Message Set
Set the TX macro to: {Ctrl-C}T

this programs the {TX} macro to put the KAM into transmit
Set the RX macro to: {Ctrl-C}E

programs the {RX} macro to return to receive after the message is completed
Set the ESC macro to: {Ctrl-C}R

Use the Esc key to immediately return the system to receive without sending unsent text that may still be in the
transmit buffer

You can now program your messages with the {TX} and {RX} macros, for example
CQ message: {TX} CQ CQ CQ DE W3PP W3PP W3PP KKK {RX}

PK-232 Setup

Make sure the PK-232 autobaud is set and the unit is set to RTTY mode
Launch Hyperterm and set its parameters to 1200 baud, 8-data, no-parity, 2 stop bits, and no flow control
Connect the PK-232 to the port configured in Hyperterm
Turn on the PK-232
Type a few “*” characters so your PK-232 will autobaud to the 1200 baud rate
Now place the PK-232 in the RTTY mode by typing the command “BAUDOT”. It should respond OPMODE now
BAUDOT
Turn the threshold pot full clockwise and make sure the LED is on
Also make sure the unit is set up for software handshaking XFLOW = ON

3/4/25, 5:37 PM N1MM Logger+ Documentation



596

Once you are communicating with the PK-232 and have it in the BAUDOT mode, you can also tune in a RTTY signal
and it will decode and print on the Hyperterm window
Now try a transmit by typing a “X” on the keyboard followed by several characters that you wish to transmit. To get back
to receive, type a Ctrl+C and a “R”
If you have problems, consult your PK-232 manual
Now exit the Hyperterm program and start Logger. In the DI Setup window under the Macro Setup tab, select the
“Other” Digital Macro Set, and program the TX, RX and Esc buttons as follows:

TX: X{ENTER}
RX: {CTRL-D}
Esc: {CTRL-C}R{ENTER}TC{ENTER}

If this has been done correctly, the {TX} and {RX} macros in your messages should now work correctly, and the Esc key
should be able to interrupt (abort) an outgoing message immediately when it is pressed

Setting up the PK-232

By John VK4WPX / VK4CEJ

Setting up the PK-232 for RTTY is very simple and straightforward.

First, open the ‘Configurer’ (On the main logging window click Config, Configure Ports, Telnet addresses, Other)
Click the Hardware tab

Click in the box adjacent to the COM port that you have your PK-232 connected to in the column labeled ‘Digital’
See picture below, the example here shows the PK-232 on COM-2

Next, click on the Digital Modes tab and set up the Digital Interface 1 parameters
The example in the picture below shows that the PK-232 is set for 9600 baud, no parity and 8 data bits
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Setting up macros and the main logging window “F” keys for the PK-232 is also really very simple.

Modify any existing macros that came pre-configured by replacing every instance of ‘ {TX} ‘ with ‘ {Ctrl-C}Xmit{ENTER}
‘

I found that the command did not work every time unless it was followed by the {ENTER}
or, if the macro does not have {TX} or {RX} in it and you want it to start transmitting or go to receive, add those
commands and, replace every instance of {RX} with {Ctrl-D}

Example: F1 “CQ” macro would therefore be ” {Ctrl-C}Xmit{ENTER}CQ CQ CQ DE * * * K{Ctrl-D} “
Example: F5 macro “Hiscall” would be ” {Ctrl-C}Xmit{ENTER}! ”

Which would leave the rig in transmit mode so that you could type more info in the transmit window
To return to receive, press Ctrl+D (hold down the Ctrl key and press D)

SCS PTC Setup

Take the PTC as you use it for other digimode programs e.g. ALPHA (by DH7RG), XPWIN (By KF7XP), LOGGER (by
K4CY)
Set the PTC to SERBAUD 19200 (not AUTO ! ) > switch the PTC OFF
Start N1MMLogger and go to ‘Config | Configure Ports, Telnet Address, Other’, Select the tab ‘Digital Modes’. Set
‘Digital Interface 1 TU Type’ to ‘CW/Other’, set the used serial port to 19200 Baud, N-8-1-none. Set the ‘Digital Interface
2 TU Type’ to ‘None’. Save with ‘OK’
Click on Windows and select Digital Interface
Be sure that the PTC is connected to the right serial port and switch it ON and the start info will appear in the upper
window finished by the prompt cmd: If you can’t see anything check serial port and settings
Click in the lower window, enter with the keyboard ‘Escape+Shift bau 45 ENTER’ the PTC will switch to RTTY (look at
the PTC mode display). Add ‘Escape+Shift term 1 ENTER’ to switch the PTC to echo the transmitted signs in the upper
window. Note : Escape without Shift will switch the cursor to the main window
In the open Digital Interface select ‘File | Settings’ and select Tab: ‘Macro Setup’. Select behind ‘Digital Macro Set’
‘Other 1’. Now three buttons appear with TX, RX and ESC on it. These buttons have to filled with the sequence to put
the PTC in TX and RX and to get a correct function for canceling the AUTO-CQ function or make a break with the ESC-
key on the keyboard

Digital Macro Set: Other 1
TX button: {Ctrl-Y} NB. in capital letters

Now the macro {TX} can be used to switch the TX ON
RX button: {Ctrl-Y} NB. in capital letters
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Now the macro {RX} can be used to switch the TX OFF
ESC button: {ESC}CLR{ENTER}{Ctrl-D}{ENTER}

The macro will reset the PTC-2 to PACTOR, clear the TX buffer and switch the PTC-2 back to RTTY
There are a maximum of 24 extra functionkeys. One of them may be configured to switch the PTC-2 from the default
state PACTOR to RTTY

Name button: RTTY
Contents button: {ESC}clear{ENTER}{ESC}bau 45{ENTER}{ESC}term 1{ENTER}

Every time you start the PTC-2 you may click on this key to start the RTTY-mode. You need ‘term 1’ to get
a delayed echo on the RX-window when your text is transmitted

You may generate more macros with simple QSO texts using the installed N1MMLogger macros as !, *, DATE, TIME
etc
Don’t forget to start a functionkey with {TX} and at the end place {RX} to switch back to receive
See for some macro examples at macros page

TinyFSK by Andy Flowers, K0SM

TinyFSK is a software program written for the Arduino hardware platform that produces FSK RTTY by emulating a traditional
TNC for transmitting. TinyFSK does not have a receive capability, so you use one of the sound card interface choices for
receive. The following configuration can be used with the popular Mortty RTTY interface running the TinyFSK sketch.

TinyFSK In the N1MM Configurer

From the N1MM Logger Entry Window, select >Config >Configure Ports, Mode Control…

In the Configurer Dialog Window, select the >Hardware tab
In the Port column, identify the serial port connected to the Arduino
In the Digi column, check the box adjacent to the Arduino port number
In the Details column, press the adjacent Set button and set DTR = Always On and RTS = Always OFF
Set the Radio Nr to the radio number (1 in SO1R and SO2V, either 1 or 2 in SO2R depending on which radio
the TinyFSK will be keying)
Set the Dig Wnd Nr to correspond with the Digital Interface window the TinyFSK will be associated with and
transmitting from

Preparing to use TinyFSK

These instructions assume that you have connected your Arduino to your computer, uploaded the TinyFSK “sketch”
to the Arduino, installed the hardware keying interface for PTT and FSK from the Arduino to your radio, and that you
know the COM port number that Windows has assigned to the Arduino. For information on how to perform these
preliminary tasks, visit K0SM’s website HERE or google “TinyFSK.” There are many helpful TinyFSK tutorials on the
Internet.



TinyFSK and 2Tone

The instructions in the next two sections should work with any of the sound card digital engines, including 2Tone.
However, if you are using 2Tone as your primary digital engine for receiving in the main Digital Interface window,
there is an alternative method available as well. Unlike the other digital engine programs, 2Tone can support
TinyFSK directly. To use this feature, you would configure the N1MM+ Configurer and Digital Setup windows the
same as if you were using AFSK, except that in 2Tone’s own setup window you tell 2Tone to use TinyFSK, and in the
N1MM+ Configurer under the Mode Control tab, Mode sent to radio, you tell the program you want to put the radio
into RTTY (FSK) mode, not AFSK or SSB mode. Do not configure the FSK serial port in the Configurer under the
Hardware tab, and do not select TinyFSK as the TU type under the Digital Modes tab. Let 2Tone take care of all of
that. Of course, if you then decide to switch from 2Tone to MMTTY as your primary digital engine, you will have to
change the setup in the Configurer as described in the next two sections.
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In the Configurer Dialog Window, select the >Digital Modes tab
Under Digital Interface 1, TU Type

Select TinyFSK, and enter the serial port settings as 9600, N, 8, 1, None
If planning to operate SO2V, under Digital Interface 2, TU Type

Select TinyFSK, and enter the serial port settings as 9600, N, 8, 1, None

3/4/25, 5:37 PM N1MM Logger+ Documentation



600

Note that when you use TinyFSK, you are in effect using a TNC to transmit, but a sound card program such as MMTTY
to receive. Therefore, in addition to configuring the TinyFSK serial port on the left side of this window, you also need to
configure the sound card interface you will be using to receive with on the right side of the window. Since you are only
using the sound card interface to receive, you should configure it for AFSK (even though you are actually transmitting
using FSK), in order to prevent the sound card interface from trying to key FSK in parallel with the TinyFSK. You can
configure the sound card program to use a sound card output that is otherwise unused. Do not configure the sound
card program (e.g. MMTTY) to transmit using FSK, as that could conflict with N1MM+’s use of the TinyFSK for FSK
keying.

In the Configurer Dialog Window, select the >Mode Control tab
On the right side, under Mode sent to Radio, in the row for RTTY set the “Mode sent to radio” to RTTY (to put
the radio into FSK mode when the program is in RTTY mode)

TinyFSK In the Digital Interface (DI)

From the N1MM Logger Digital Interface (DI) Window, select >Setup >Settings

In the Digital Setup Window
Under the General/MMTTY Setup tab, at the right side, set the Preferred RTTY Interface to whichever sound
card program you are using to receive with (if you are using 2Tone, select the MMTTY setting)
Under the Message Setup tab, Digital Message Set, select Other, TinyFSK
Press, in sequence, the three buttons labeled TX, RX, ESC. For each of these verify the following settings

Press TX: Message Text = [{ENTER} , Message Caption = TX
Press RX: Message Text = ]{ENTER} , Message Caption = RX
Press ESC: Message Text = \ , Message Caption = ESC

3/4/25, 5:37 PM N1MM Logger+ Documentation



601

K1EL Winkeyer 3.1 RTTY Interface

Starting with version 3.1, the K1EL Winkeyer can do FSK RTTY keying in addition to CW keying. The Winkeyer does not have
a receive capability, so you use one of the sound card interface choices to receive with.

Winkeyer RTTY in the Configurer

From the N1MM Logger Entry Window, select >Config >Configure Ports, Mode Control…

If you are already using the Winkeyer for CW, skip this paragraph. If not, you must configure a serial port for it the same as if
you were using it for CW (see the instructions for doing this on the Configurer page).

In the Configurer Dialog Window, select the >Digital Modes tab

Under Digital Interface 1, TU Type
Select Winkey

If planning to operate SO2V, under Digital Interface 2, TU Type
Select Winkey

Note that when you use the Winkeyer for RTTY, you are in effect using a TNC to transmit, but a sound card program
such as MMTTY to receive. Therefore, in addition to configuring the Winkeyer for RTTY, you also need to configure the
sound card interface you will be using to receive with on the right side of the window. Since you are only using the
sound card interface to receive, you should configure it for AFSK (even though you are actually transmitting using
FSK), in order to prevent the sound card interface from trying to key FSK in parallel with the WInkeyer. You can
configure the sound card program to use a sound card output that is otherwise unused. Do not configure the sound
card program (e.g. MMTTY) to transmit using FSK, as that could conflict with N1MM+’s use of the Winkeyer for FSK
keying.

In the Configurer Dialog Window, select the >Winkey tab and check the check box called “Enable RTTY Mode using Winkey”.

In the Configurer Dialog Window, select the >Mode Control tab

On the right side, under Mode sent to Radio, in the row for RTTY set the “Mode sent to radio” to RTTY (to put the radio
into FSK mode when the program is in RTTY mode)

Winkeyer RTTY in the Digital Interface

From the N1MM Logger Digital Interface (DI) Window, select >Setup >Settings

Preparing to use the Winkeyer for RTTY

These instructions assume you have connected an FSK keying cable between the Winkeyer and your radio’s FSK
keying input, as described in the Winkeyer 3.1 documentation. Note also that this method is not available with older
versions of Winkeyer.
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In the Digital Setup Window

Under the General/MMTTY Setup tab, at the right side, set the Preferred RTTY Interface to whichever sound card
program you are using to receive with (if you are using 2Tone, select the MMTTY setting)
Under the Message Setup tab, Digital Message Set, select Other, TinyFSK, Winkey
Press, in sequence, the three buttons labeled TX, RX, ESC. For each of these verify the following settings

Press TX: Message Text = [ , Message Caption = TX
Press RX: Message Text = ] , Message Caption = RX
Press ESC: Message Text = \ , Message Caption = ESC
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Single Operator Contesting
2019-03-29

Single Operator Contesting
SO2V and SO2R Operation
Many of the features of N1MM Logger+ work identically for SO2V and SO2R. Features common to both SO2V and SO2R are
discussed in this section; unless specifically indicated, they will work in both SO2V and SO2R.

Single Operator 2 Radio (aka SO2R) is an operating technique that when done properly, can add many extra QSOs and
multipliers to your log. This is accomplished by increasing your efficiency during slow times, for example, when you are CQing
on one radio, but getting few answers. Efficiency is increased by listening on a 2nd radio while you are transmitting on the 1st
radio. On the 2nd radio you are scanning the bands for needed QSOs and multipliers. If you find a new station to work on the
2nd radio, you leave it staged on the 2nd Entry Window until you get a free moment to work this station. Even adding a few
QSOs an hour will greatly boost your score.

The philosophy for SO2R development is to allow any two radios to be used; they do not have to be identical. In its most
simple form, two transceivers feed two separate antennas on two different bands. With sufficient attention to antenna
separation and filtering, it is possible to do this without interference from a transmitting radio to a receiving radio. Many serious
SO2R operators use identical radios to reduce the confusion factor, but having identical radios isn’t necessary.

The receiver on one band is used to locate new contacts during the time that the transmitter on the other band is active. This
can mean that you tune the 2nd radio while N1MM Logger sends CQ on the 1st radio. The most critical requirement for SO2R
is automated transmission — if you have to speak into a microphone or squeeze a paddle while you tune the receiver you will
not make the most of the second radio. It’s easy to reach a level of mental fatigue while operating SO2R that results in an
overall score reduction rather than helping your score.

If your radio is not supported by N1MM Logger, or it’s an older radio with no computer interface, the radio can still be used, but
you just don’t get many of the advantages automated radio control offered by N1MM Logger.

N1MM Logger also supports “Single Operator 2 VFOs”, or SO2V. If your radio simply has 2 VFOs, VFO A/B will be assigned
to each of the two Entry Windows. If you have a radio with a sub-receiver, each of the receivers gets assigned to each of the
Entry Windows.

N1MM Logger’s SO2V interface is essentially identical to the SO2R interface, but with SO2V you are using a single radio. Two
windows can be displayed in SO2V, one for VFO A & B. SO2V makes better use of the 2nd receiver now present in most high-
end radios. With the 2nd receiver, you can be tuning the band while you are listening for a response to your CQ. Since you
cannot listen on the sub-receiver while transmitting, SO2V is not as efficient as SO2R.

A maximum of two radios are supported with N1MM Logger using a single computer. There is a workaround for 2-computer 2-
radio SO2R, explained below.

For the new SO2R operator, we have 3 words for you: practice, practice, practice! SO2R is definitely a learned skill that takes
time to learn, and even longer to master.

Intuitive User Interface

As you will quickly see, N1MM Logger’s SO2R implementation is more intuitive than most other SO2R implementations:

Entry Windows can be arranged to reflect equipment layout
Entry Windows can be used for any function (not dedicated functions like others)

Radio Nr in Configurer
When operating SO2V or SO2R, you also need to change your LPT or Winkeyer keying from Radio 1 (default) to
BOTH. Otherwise, you will not get any keying on VFO B or Radio 2.
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You always know what each VFO or radio is going to send next (when in ESM mode)
Visual cues identifying transmit focus, Run vs. S&P, and more!

Supported Features

N1MM Logger supports all of the features you would expect from any world-class SO2R software. In addition, there are a lot
of unique features:

Two Entry windows are displayed that are fully interchangeable in functionality (windows are not dedicated to a specific
task)
Running and S&P modes are maintained for each SO2R Entry window, such that the 2 windows can be used for

Running / S&P
S&P / Running
S&P / S&P
Running / Running

Entry windows can be arranged on screen as desired: typically left/right, or top/bottom, to represent physical station
layout
Each Entry Window has a frequency readout in the top pane
‘LEDs’ identify which radio has focus. The sending radio has a red LED indicating TX Focus, a green LED identifies the
radio that has RX and Keyboard focus (combined)
Background colors of the entry field change color depending on whether that radio is running or S&P: white = run;
canary = S&P
Ability to change frequency of inactive radio from the active radio. Use the / before entering the frequency in the
callsign field to enter frequency for other radio/VFO
Supports Enter Sends Messages Mode (ESM) on both windows
Typing a call in inactive radio Entry window does not abort sending on the active radio
Hitting Escape stops sending on either VFO or radio, but does not change keyboard focus
Changing transmit focus (for any function) stops sending before switching and sending on alternate radio
Ctrl+function keys and Ctrl+Enter sends messages on alternate radio (Concept is Ctrl = Alternate radio control)
“Hotkey’s” for specific tasks and sending on alternate radio
All Key Assignments work on both radios (unless otherwise specified)
Supports Top Ten DX Doubler, WX0B Station Master, Microham MK2R, YCCC SO2R, and other SO2R controllers.
Support SO2R without interfaced radios.
Dueling CQ’s will send CQ alternately on each radio (Ctrl+B)

If dueling CQ’s is enabled, and CQ sent then both radios become Run radios
Ctrl+F1 or Ctrl+Enter will not start Dueling CQ
Dueling SSB and CW CQ’s (different modes in each Entry window) are supported
When you disable Dueling CQs, the pre-existing SO2R options are restored

A SO2R software radio lockout for preventing both radios from operating on the same band is implemented
CQ-repeat is terminated when a message is sent on the other radio
The macro {JUMPRX} changes the receive focus to the other input window
Supports 2 radios – No support for 3 or more radios
Support SO2R with zero, one or two sound cards (5$ SO2R)
When changing band using Ctrl+PgUp/Down key will skip the other radio’s band

THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!
The sent CW will echo in the status bar of the Entry Window (only when in SO2R)
During VOX operation, in “$5 SO2R” operation the TX audio should will track the TX focus all the time

Entry Windows

Entry windows can be placed anywhere on the screen. Typically people will position them similar to their equipment layout i.e.
if the radios are positioned left/right, the windows are arranged reflect that. For those who stack their equipment top/bottom,
you can position the screens so they logically mirror that radio setup too.

Screen real estate is in short supply. To minimize screen real estate, you can shrink the Entry Windows compared to the
default layout. Below is an example of the default Entry Window and a minimized version. Also the use of two monitors more
screen real estate.
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Full Size Entry Window vs Minimized Entry Window

To launch the 2nd Entry Window, hit the \ button.

Most people who are comfortable with N1MM Logger+ tend to use the reduced size Entry Windows for the second radio or
VFO.

All of the central features that are available to the single radio operator also work in SO2R/SO2V. For example, when tuning
the band with the S&P VFO, spots that are in the bandmap are automatically inserted into each call frame (above the callsign
in the Entry window) when you tune across the frequency of the spot. Hitting the Space bar will pull the callsign from the call
frame into the callsign field. If a station calls you on the run radio, toggling back and forth between Entry Windows with the \
key or Ctrl Left/Right arrows will maintain the all of the information in each Entry Window until the respective stations are
logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is entered into the bandmap (if “QSYing wipes the call
&& spots QSO in bandmap” is implemented).

The SO2R/SO2V Dots (LEDs)

On the Entry Window a green and/or a red dot (LED) will be shown. The LEDs are visual aids that help you easily identify
what is happening on each radio. This is part of N1MM’s continuing philosophy of letting the operator easily know what’s
happening at any give time.

The green LED indicates that the VFO or radio has receive/entry focus and the red LED indicates that VFO has transmit (TX)
focus. In addition, the red TX LED changes between dark red (not transmitting) and yellow (VFO/radio is transmitting).

Dot/LED Colors Used:

Green dot/LED – This VFO/Radio has receive (RX) and entry focus. RX and entry focus are always together.

Receive focus can be toggled between the VFOs/radios by
using a mouse to click on the background of one of the two Entry windows (SO2R only)
pressing the \ key (backslash)

To move both Transmit and Receive focus
Press Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow to move both foci between the left and right radios.

Red dot/LED – This VFO/Radio has transmit (TX) focus. This means that the radio or VFO either is transmitting (a lighter
orange-red color) or was the last to transmit and will be the one that transmits if you transmit by means other than pressing a
function key (darker red color). When the other window has entry focus and you press a function key to send a stored
message, the transmit focus shifts to that radio as soon as the function key is executed.

Pressing Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci between radios. If the foci are split, the first
press of Pause moves the Transmit focus to the radio with the receive focus; thereafter, both foci will move together
each time it is pressed.
When transmitting the TX focus can not be changed.

Key Assignments for SO2R and SO2V

Backslash ( \ ) – Launches a second Entry Window if only one Entry window is open
One radio – Moves RX focus between the 2 VFOs on the radio
Two radios – Moves RX focus between the 2 radios

Ctrl+Enter – Send next ESM state on alternate radio or VFO (assuming ESM turned on)
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Ctrl+F1 to F8 – Send Fn message on alternate radio or VFO.
Ctrl+Left Arrow – In SO2R move both Transmit and Receive/Keyboard focus to left radio, or in SO2V move both TX
and RX/Keyboard focus to VFO A
Ctrl+Right Arrow – In SO2R move both Transmit and Receive/Keyboard focus to right radio, or in SO2V move both
TX and RX/Keyboard focus to VFO B
Pause – Move both TX and RX Keyboard focus to other radio (or other VFO in SO2V). If TX and RX focus are split
when you hit pause, TX focus will move to where the RX focus is
Alt+F5 – Swap radio frequency, mode, and callsigns between VFOs (SO2V) or radios (SO2R). In SO2R, the receive
focus changes to the non-active radio.
Alt+F6 – Identical to Alt+F5 except the receive focus does not change. No effect in SO2V
Ctrl+B (SO2R only) – Toggles dueling CQs on and off. Dueling CQ’s will send CQ alternately on each radio or VFO,
with the RX focus moving to the Entry window that is not transmitting. If Dueling CQ’s is turned on, both radios become
run radios. A delay can be inserted between each CQ by setting the “Set Dueling CQ Repeat Time” under the SO2R
menu. Dueling SSB and CW CQ’s are supported too. An icon denoting Dueling CQs appears in the entry windows
when dueling CQs are actually being transmitted.

Backquote (grave accent or unshifted tilde key (~) – Toggle STEREO mode on/off, or toggle Auto/PTT modes with
modified DXD . Notes: On US keyboards, the key we are talking about is the key just to the left of the number 1 key.
Ctrl+PgUp/Down – When changing band using Ctrl+PgUp/Down will skip the other radio’s band

THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!
Ctrl+Shift+K (SO2R only) – FocusOther, Another method of focus control (Focus on Other Radio), preferred by many
contesters. When FocusOther is active, the RX focus is automatically shifted between the “Run” radio and the “S&P”
radio, depending on whether the Run radio is transmitting. When the Run radio is transmitting, RX focus is shifted to
the S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run radio, unless an unworked
callsign has been entered in the S&P entry window. This allows a callsign to be entered in the S&P radio Entry Window
while CQ is being sent on the Run radio.
Ctrl+Shift+L (SO2R only) – This enables/disables the use of {CTRLFx} in function key macros. {CTRLFx} is a
convenient way to automatically send a function key on the alternate radio. For example, by programming your S&P F4
key to “* {CTRLF1}”, your call will be sent on the S&P radio, immediately followed by your CQ message on the Run
radio.

Bandmap Features

Shift+Click on frequency – Jump to that frequency on the inactive radio, without changing TX or RX focus. This
allows you to be active and sending on one radio and change the frequency on the other radio without making it the
active radio.
Shift+Click on bandmap callsign – Send the frequency to the inactive radio and place the callsign on the other
radio’s callsign frame, without making it the active radio.

Single Operator Two VFO Operation (SO2V)
A number of N1MM users are interested in using the advanced VFO and/or subreceiver capabilities of modern transceivers to
improve their scores by approximating SO2R techniques, but with a single radio. This has led to the definition of an operating
mode called SO2V (Single Operator Two VFOs). This section will deal with the features of N1MM Logger that are designed for
use in this mode.

Advanced SO2V for Radios with Separate Sub-Receivers

Additional SO2V features are available for radios that have dual receivers or Main/Sub receive. The list of such radios
includes: IC-756/Pro/Pro2/Pro3,IC-7600/7610, IC7800/7850/7851, IC-781, Orion/2, K3/K3S, KX3, K4, TS-990, FTdx9000,
FTdx5000, FT2000, FTDX101, FT1000/D/MP/MKV/MPSteppIr, and the Flex Radios.

In SO2V mode, the \ key changes the RX focus to the Sub receiver and enables the Sub audio if necessary (Orion). To use
this feature set the CQ repeat time a little longer than normal and start a repeating CQ using VFOA (Main). If nobody answers,
press the \ key to enable the Sub receiver and tune the band. Pressing \ again will change the RX focus back to VFOA and
turn off the Sub RX if Config > Sub Receiver Always On is not checked. With Icom radios that only have one VFO knob,
pressing the \ key also changes the knob association to the Sub VFO.

Don’t Be Labeled a Lid
The practice of alternating CQs on two frequencies in the same band is undesirable and is outlawed in many
contests, because spectrum space is already scarce enough without multiple stations each taking up two Run
frequencies. If your radio(s) can do it, reserve use of this feature for CQing on two different bands.
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If you do not find someone to call before the CQ timer expires, the program will call CQ again on VFOA. With RX focus on
VFOB (Sub) Entry window, typing a letter will cancel the repeating CQ running on VFOA.

Pressing a function key to call someone or send an exchange will automatically switch the TX focus to the proper VFO prior to
transmitting. Some radios will impose a detectable delay during switching, other radios may switch faster because they require
fewer configuration commands. If the RX focus is on then VFOB (Sub) Entry window and the CQ repeat needs to start again
on VFOA, simply press the CTRL+CQ-Key. The program default for the CQ-key is F1 and this is set in Configurer > Function
Keys tab.

If someone answers your CQ while the RX focus is on VFOB (Sub), press the \ key to change the RX focus prior to entering
the callsign. If you want to change the TX and RX focus together press the PAUSE key.

There is special functionality associated with the Ctrl+Alt+D and Grave accent keystrokes for the SO2V radios. See the
appropriate radio model in the Supported Radios section.

Approximating the Capability with Radios that do not have a Sub-Receiver

Some basic SO2V functionality has been implemented for all VFOA/B radios (those without a sub-receiver).

You may find the CTRL+Shift+Up/Dn command useful. It programs VFOB with the next spot Up or Dn in the Bandmap. When
you have time to listen or call the station, press the PAUSE (or Ctrl+RightArrow) key. To return to your Run frequency, press
the PAUSE (or LeftArrow) key, it won’t change your RUN frequency. Instead, the program will let you know that split is
necessary with a status message at the bottom of the Entry window.

See the Supported Radios section of the manual for radio specific information regarding general and SO2V operation.

Some advice on using SO2V

SO2V is a kind of halfway point between SO2R (single-op two radios) and SO1V (standard single-receiver operation). The
most efficient of the three is SO2R. The main advantage of SO2R over traditional one-radio one-VFO operation (SO1V) is that
you can be listening in one QSO while you are transmitting in a different QSO. Ideally, you could be doing two QSOs at once
on different bands even though you never have more than one transmitted signal at a time, interleaving between the two and
doubling your overall speed (at least when things are going very well). This is simply not possible with only one radio, even if it
has two receivers, but SO2V is an attempt to make use of the second receiver to gain at least some of the advantages of
SO2R.

In SO2V, you are deaf whenever you are transmitting, so the key advantage of SO2V over SO1V is to be able to receive two
signals in parallel. You don’t conduct two QSOs at once, but you can at least determine whether there is someone worth
working on either of two frequencies at once. That would seem to require two receivers, one receiver in each ear, not just two
VFOs. You need to be able to tell which signal is coming from which receiver (e.g. stereo headphones).

I am by no means all that proficient, but the main way I use SO2V is CQing on one frequency while S&Ping elsewhere (in the
same band, or if they radio supports cross-band split, in another band). Again, more to get this out of the way than to describe
SO2V, note that if it’s a good run, people are coming back to you right away and you don’t have time for SO2V techniques. In
fact, what you may need is LOGTHENPOP to cope with multiple callers, and when you are doing this in CW or SSB you don’t
need the distraction of a second receiver. Instead, you would leave the second receiver turned off while things are going this
well.

However, if things slow down, as they often do late at night or late in the contest, then while you are CQing on VFO A and find
you have to send CQ several times before anyone shows up calling you back, you can turn your second receiver on and start
using it to S&P up and down the band while you keep on CQing.

After your transmitter stops at the end of the CQ message, in SO2V you have two receivers both active. One is on your
transmit frequency, listening for someone calling you back. The other one is somewhere else, looking for a station CQing that
you can call.

Suppose: (1) no-one answers your CQ (IMHO your first duty is always to answer someone who answers your CQ); and (2)
you find someone on VFO B that you haven’t worked yet, and they are calling CQ or just about at the end of a QSO. In that
case, what you can do is switch to the VFO B entry window (with the mouse if you are mousing, e.g. in RTTY, or with the \ key
if you are keyboarding) and have (or try to have) a QSO on the VFO B frequency. Once that QSO is completed (or as soon as
the other guy comes back to someone else instead of you), you switch back to VFO A, hope that someone hasn’t taken over
your run frequency while you were away, and send a CQ again to repeat the whole process.

In SO2R, you can keep listening to the other station on the S&P VFO even while you are transmitting on your CQ frequency in
between transmissions on the S&P radio, but in SO2V you have to stay on the S&P frequency for the entire duration of the
S&P QSO, which means you run a significant risk of losing your run frequency. You have to weigh the risk of this happening
against the benefit of picking up the S&P QSO during a dead period on your run frequency.
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You might want to turn autoCQ off while you are doing this. If I leave autoCQ on, inevitably I find that the transmitter fires up at
exactly the wrong time, just before the other station sends his call sign, or when his QSO is ending and it’s time to drop in my
call sign on the VFO B frequency.

You can also use SO2V to S&P with two receivers at once. Tune one up the band and the other down the band at the same
time, and simply decide which one to use based on where you hear a new station to work first. You can use the \ key to jump
back and forth between the two entry windows.

SO2V is more productive if you are in the Assisted class. You can use spots from the cluster or RBN to guide where you tune
with VFO B, instead of just tuning up and down the band. Instead of turning the VFO B tuning knob to find the next station to
work, you can jump VFO B to the next workable spotted station using Ctrl+Shift+Up/Down arrows. This greatly increases the
odds of quickly finding someone to work on VFO B versus just randomly tuning and screening out the ones you have
previously worked.

You can also use the cluster this way in SO1V with only one receiver, but with a significant disadvantage. Once you tune away
from your run frequency after listening for someone calling you back, you then often have to wait some more listening on the
second frequency until the caller is at the right point for you to call him. With two receivers, you can time your CQs on VFO A
so that you don’t have to waste time listening first on VFO A and then on VFO B; you can listen to both at the same time and
line up the times so you either respond to a caller on VFO A if one is there, or else send your call to a CQer on VFO B, in this
way minimizing the time you are away from your run frequency.

To set up for SO2V with a dual-receiver radio, you select the SO2V button in the Configurer, and in the Config menu you
check the “Sub Receiver Always On” menu item. In RTTY, you can set up the two DI windows with two separate interfaces
listening on different channels of the sound card and just leave both receivers on all the time. In CW/SSB, you will probably
want to learn how to use the ` and Ctrl+Alt+D keys (see the documentation on Supported Radios) to turn the second receiver
on and off.

I am probably missing some important things, but this is how I use SO2V with my dual-receiver K3.

SO2V RTTY with MMTTY

Instructions for setting up two copies of MMTTY for use in SO2V (Note: there are more detailed instructions on setting up for
digital modes in the Digital Modes section – this section focuses on the SO2V aspects):

Create two separate folders for the two copies of MMTTY. This allows each copy to have its own configuration. These
folders must be outside the C:\Program Files and C:\Program Files(x86) paths
Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll if you use EXTFSK, or extfsk64.fsk if you use
EXTFSK64) from the main MMTTY program folder into each of the two folders you will use for SO2V
Start N1MM Logger and open the Configurer (Config > Configure Ports, Audio, Mode Control, Other)
Select the Hardware tab

Select the SO2V option
This next step is optional for most users, but mandatory for some. If you are using serial ports for PTT and/or
FSK from MMTTY, and you also use the same serial port(s) for CW or PTT keying from N1MM Logger+ in CW or
SSB modes, then you may need to check the Digital check box beside the ports that are shared the two copies
of MMTTY (for RTTY) and the Logger (for CW and SSB). If the only place you use a port is from MMTTY, you
should skip this step, don’t mention the port at all in the Configurer, and perform all of the setup for this port
within MMTTY

Note that you must use either two serial ports, one for each copy of MMTTY, or no serial ports (AFSK;
PTT controlled either by the main N1MM Logger program or in hardware, e.g. PTT via radio command or
by VOX). If you are using two serial ports, their FSK keying outputs must both be connected to the radio’s
FSK input (e.g. by wire-ORing the keying outputs)
Click on the Set button for the port you will use with VFO A and set the Radio Nr and the Dig Wnd Nr both
to 1
Click on the Set button for the port you will use with VFO B and set the Radio Nr to 1 and the Dig Wnd Nr
to 2

Select the Digital Modes tab
Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital Interface 2
Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your setup and set the MMTTY Path to point
to the copy of MMTTY.exe in the first folder
Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the MMTTY Path to point to the copy of
MMTTY.exe in the second folder (this must be a different copy from the one in the DI-1 MMTTY Setup path)

Close the Configurer
Open the Digital Interface 1 Window (Window > Digital Interface menu item in the main VFO A Entry window). Make
sure the program is in RTTY mode (if necessary, type RTTY into the Entry Window callsign box and press Enter)

If an MMTTY window does not appear (e.g. if you see an MMVARI window instead), then in the DI-1 Window
select the Interface > MMTTY menu item to open the MMTTY window
Select the Setup > Settings menu item in the DI-1 window
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Under Preferred RTTY Interface, select MMTTY
Under Alignment Frequency, enter your Mark audio frequency (e.g. 2125)
Under MMTTY Window Settings, select either Normal or Control Menus, in order to have easy access to
the MMTTY setup window
Click on Save Configuration

In the MMTTY window for the first copy of MMTTY (the title bar reads RTTY Engine 1), select the Option(O) >
Setup(O) menu item

Select the TX tab and set the PTT & FSK port you will be using for the VFO A copy of MMTTY (this is the
port with Dig Wnd Nr = 1 in the Configurer). If you are using AFSK and doing PTT from the main N1MM
Logger program, set this port to None
Select the SoundCard tab (MMTTY version 1.66 or newer) and select the Reception sound card you will
use with VFO A. If you are using AFSK, you must also select the Transmission sound card
Under the Misc tab, select the channel (left or right) under Source (usually the left channel for VFO A )
Close the MMTTY Setup window

Check the Config > Sub Receiver Always On option in the main Entry Window to ensure that both receivers will be on
If the second Entry window is not open, open it by pressing the Pause key, the backslash (\) key or Ctrl+Right Arrow
Open the Digital Interface 2 Window (Window > Digital Interface menu item in the VFO B Entry window). Make sure the
program is in RTTY mode for VFO B (if necessary, type RTTY into the VFO B Entry Window callsign box and press
Enter)

If an MMTTY window does not appear (e.g. if you see an MMVARI window instead), then in the DI-2 Window
select the Interface > MMTTY menu item to open the MMTTY window
In the MMTTY window for the second copy of MMTTY (the title bar reads RTTY Engine 2), select the Option(O)
> Setup(O) menu item

Select the TX tab and set the PTT & FSK port you will be using for the VFO B copy of MMTTY (the port
with Dig Wnd Nr = 2 in the Configurer); this must be a different COM port from the one that is used for
VFO A. If you are using AFSK and doing PTT from the main N1MM Logger program, set this port to None
Select the SoundCard tab (MMTTY version 1.66 or newer) and select the Reception sound card you will
use with VFO B. If you are using AFSK, you must also select the Transmission sound card (in SO2V this
will likely be the same as the Transmission sound card used for VFO A)
Under the Misc tab, select the channel (left or right) under Source (usually the right channel for VFO B )
Close the MMTTY Setup window

SO2R – Single Operator Two Radio Operation
Using SO2R Key Assignments

Backslash ( \ ) – Once you have launched your second Entry Window, the \ key will likely be your most widely used key in
SO2R. The \ key will move RX and Entry focus between Entry Windows A & B (often referred to as Radio 1 & Radio 2
respectively). When using the \ key to control RX focus, you really don’t have to worry where TX focus is. By using the \ key to
control only RX focus, when you hit a Fn key or Enter (using ESM), the TX focus will move to where the RX focus is, and send
the corresponding message.

Example: You are CQing on Radio 1, and S&Ping on Radio 2. Both RX and TX focus start off in your Run Entry Window
(Radio 1 in this example). You are S&Ping on Radio 2, and you hear someone on the S&P radio you want to look up in your
Check Window. Hit the \ key to move RX focus to the S&P Entry Window. You type in the call, and you need it, and are just
waiting for a good time to send your call. If no one is answering your CQ on the Run Radio, just hit the Enter Key (assuming
you are using ESM), and the TX focus will move from the Run Radio to the S&P radio (Radio 2), and send your callsign
(actually the first ESM message in the S&P sequence). If the station comes back to you, then hit Enter again to send your
exchange, and you just completed a S&P QSO. Now move the RX focus with the \ key to the Run radio, or just leave it in the
S&P Entry Window if S&P is more productive.

Now let’s assume in the middle of the S&P QSO, someone answers your CQ on Radio 1. Your exchange just happens to be
sending on the S&P radio. To copy the call on the Run Radio (while your exchange is being sent on the S&P radio), hit the \
key to move RX focus to the Run Radio, and type his call in the Run Entry Window. Assuming your exchange is finished
sending on Radio 2, just hit Enter again, and the TX focus will move back to the Run Radio, and the program will send his call
and your exchange on the Run Radio. You now have QSOs going on both radios! Just move RX focus as needed to
send/copy on what ever radio you need. This is easier said, than done during a contest !

Tracking TX Focus
In the above examples, you never have to control where TX focus is, since TX focus always moves automatically to
where the RX focus is when Fn or Enter (ESM) is used. This should be your standard operating mode, as you only
need to worry about using a single key to do most of your navigation between the two Entry Windows.
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Ctrl+Enter, or Ctrl+Fn – Using these commands will send the corresponding message on the alternate radio; with the
alternate radio defined as the radio that does not have RX focus. Using Ctrl+Fn (or Ctrl+Enter) will only move the TX focus to
send the message – RX focus will stay in it’s current location. Once the message is sent, TX focus will remain on the alternate
radio. This is done by design.

The most common scenario would be if you are CQing on Radio 1, but you are not getting callers. You hit the \ key to copy a
callsign on the S&P radio. Without moving the RX focus from the S&P radio, at some point you will probably want to send
another CQ on the Run Radio. You do this by hitting Ctrl+F1 or Ctrl+Enter. You will also likely use these commands if you
have a QSO in progress at the same time on both the Run and S&P radio. The easiest way to send a message at the right
time on the other radio is to use these commands, and leave RX focus where it is. Alternatively, you can program function
keys with the {CTRLFx} macro to send messages to the other radio.

Pause Key – If both TX and RX focus are in the same Entry Window, hitting Pause will move both TX and RX focus to the
other radio. If TX and RX focus are split between the Entry Windows, the pause key will move TX focus to where RX focus is.
Mostly you will use this key in order to get your foci back in sync.

Ctrl+Right Arrow and Ctrl+Left Arrow – These commands will force both TX and RX focus to the right or left radio.

Ctrl+B – Toggle Dueling CQ’s.

{CTRLFn} macro – This macro allows the user to send on the other radio.

Make sure that “Toggle {CTRLFx}” macro is checked on in the Configurer SO2R submenu (or use Ctrl-Shift-L to
enable/disable the use of {CTRLFx} macros. When disabled, the {CTRLFx} macro is ignored.
Thus, a CW Button might look like: “tu EXCH{CTRLF9}” Where F9 on the other radio is set to send a CQ.
Example: If your entry focus is on the S&P radio and you manually press Ctrl+F1, the program will send F1 on the
OTHER radio. That’s all the {CTRLFx} macro does. For a simple test, modify your S&P F4 key to read *{CTRLF1}.
Now, when you press that key, the program sends your call on the S&P radio and then sends the contents of F1 on the
Run radio. In a practical situation, you would probably not want to send a full-length CQ while trying to work someone
on the S&P radio, because that will nearly always require you to interrupt it before it is done. So the idea of {CTRLFx} is
that you can stash a short CQ (like “N1MM test”} in, for example, Run F12. Then make S&P F4 read “* {CTRLF12}.
Now when you press F4 on the S&P radio, it will send your call, and immediately switch to the Run radio and send F12,
that very short CQ. Should help hold your frequency.
Another way to use this: Make your S&P F2 read, for example, 5NN14{CTRLF1}. Then when you press F2 or Enter to
send your exchange and/or log the S&P QSO, the program will automatically begin a CQ on the Run radio as soon as
that is done.

Mouse Assignments

Left mouse and Right mouse buttons_
On an empty space in one of the two Entry windows, these mouse buttons change the Receive focus to that
radio/VFO

SO2R Menu

SO2R
Dueling CQ’s (Ctrl+B) – SO2R feature that alternates sending CQ on each radio in turn, listening on one while
transmitting on the other. Supported for both CW and SSB. Changing either radio in frequency more than 200 Hz
will terminate Dueling CQ.
Set Dueling CQ Repeat Time (msec) – Adjusts time in milliseconds after CQ ends on one radio before it starts
on the other (default 100 msec).
Set Radio Swap Transmit Tail Time (msec) – Time delay after a radio has stopped transmitting, before
initiating transmission on another band. Typically used to interrupt a CQ on one radio to S&P on the other radio.
Set Radio Swap Transmit Lead Time (msec) – Time delay when swapping radios, whether or not the radio is
transmitting. Typically used to allow station accessories to detect that the active radio has been changed.
Focus on Other Radio – A method of focus control preferred by many contesters. When FocusOther is active,
the RX focus is automatically shifted between the “Run” radio and the “S&P” radio, depending on whether the
Run radio is transmitting. When the Run radio is transmitting, RX focus is shifted to the S&P radio. When the
Run radio stops transmitting, RX focus shifts back to the Run radio, unless an unworked callsign has been
entered in the S&P entry window. This allows a callsign to be entered in the S&P radio Entry Window while CQ is
being sent on the Run radio.
FocusOther Always Swap – Used in conjunction with Focus on Other Radio. Focus always switches to the
other radio when one radio is transmitting, and always switches back to the original radio when transmission is
completed.
Toggle CTRLFx Macro – This enables/disables the use of {CTRLFx} in function key macros. When enabled and
present in one of the function key definitions, the {CTRLFx} macro executes Fx (Function key definition x) on the
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opposite radio. An example is TU{CTRLF1} in Radio 2’s F3 slot, which sends TU and then sends the other
radio’s F1, used to get quickly back to the Run radio and call CQ after finishing an S&P QSO on Radio 2.
Toggle Stereo/OTRSP Macro (Ctrl+~) – Can be used to enable/disable all {STEREOOFF}/{STEREOON} and
{OTRSP RX}/{OTRSPOTHER RX} macros temporarily. Used to disable stereo switching if only one
EntryWindow is being used temporarily.
Two Keyboards – Enables the use of two keyboards, one for each Entry window. Plug in two keyboards before
starting N1MM Logger+. The first keyboard you type in after starting the program will control the left (Radio 1)
Entry Window. The other keyboard will control the right (Radio 2) Entry Window. The pause key is disabled,
since you no longer need to be able to switch Entry windows from a single keyboard. The \ key moves keyboard
focus to the Entry Window associated with that keyboard without actually sending any keyboard commands to
that window. Note that the use of keyboard remapping software, such as AutoHotKey, may not work correctly
with two keyboard operation.
TX Lockout ((Digital) – Select a lockout item (Digital modes only)

Multi-TX – This is the default setting. Start CQ on radio A, start CQ on radio B, both are active (no
lockout)
First one wins – Start CQ on radio A, pause, start CQ on radio B. The radio B CQ is ignored since radio
A is already active, so if you press a F-key for the second radio while radio1 is transmitting, the radio B F-
key is ignored
Last one wins – Start CQ on radio A (CQ starts), pause, start CQ on radio B. The CQ on radio A will be
aborted and the CQ on radio B will start so if you press a F-key for the second radio while radio A is
transmitting, the radio A transmission is interrupted and radio B transmits

Software Setup

Setting up SO2R and SO2V starts in the Config menu:

Config > “Configure Ports, Telnet Address, Other” > Hardware Tab

If SO2R If SO2V

Set up radios Set up radio

Set up keying if necessary (Serial port, LPT port or
Winkeyer)

Set up keying if necessary (Serial port, LPT port or
Winkeyer)

Click SO2R button Click SO2V button

Click OK to close out Click OK to close out

Launch N1MM Logger, set up contest etc Launch N1MM Logger, set up contest etc

If 2nd Entry Window is not shown, hit the \ key (backslash
key)

If 2nd Entry Window is not shown, hit the \ key (backlash
key)

There’s No Substitute for A Hardware Lockout

Software lockouts are inherently less reliable than hardware systems, because of the vagaries of networking, RFI,
etc. We urge you not to rely solely on software lockouts to prevent rule violations or hardware damage.



“Sticky” options
The Focus Other (Ctrl+Shift+K) and Ctrl+Fx settings, whether controlled through keyboard shortcuts or through the
SO2R sub-menu of the Configurer, are “sticky” – that is they are remembered the next time the program is opened.
This can surprise you if you don’t remember having set them.
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Selected mode Radios attached Choices Selection

SO2R none SO2R – Left Manual, Right Manual Automatically selected

SO2R 1
(Kenwood)

sO2R – Left Manual, Right Kenwood Com1
SO2R – Left Kenwood Com1, Right Manual Select one

SO2R 2
(Kenwood & FT847)

SO2R – Left Kenwood Com 1, Right FT847 Com 2
SO2R – Left FT847 Com1, Right Kenwood Com 2 Select one

SO2V 1
(Kenwood) SO2V – Kenwood Automatically selected

LPT Keying

When operating SO2V, and using LPT port keying, the Radio Nr in the LPT port configuration must be set to Both.

When operating SO2R, and using a single LPT port for keying, the Radio Nr in the LPT port configuration must be set to Both.
This configuration will require an external box to switch the keying line between the two radios. The external box can be
controlled using LPT pin 14.

When operating SO2R and using a separate LPT port for each radio, the Radio Nr in each LPT port configuration must be set
to The corresponding radio, 1 or 2.

Winkeyer and WinkeyerUSB keying

When operating SO2R, and using Winkeyer, the Radio Nr in the Winkeyer COM port configuration must be set to Both.

When operating SO2R, and using a single Winkeyer port for keying and PTT, the Radio Nr in the Winkeyer COM port
configuration must be set to Both. This configuration will require an external box to switch the keying line between the two
radios. The external box can be controlled using LPT pin 14.

When operating SO2R and using Winkeyer’s 2nd CW and PTT Outputs (available in later models), the Radio Nr in the
Winkeyer COM port configuration must be set to Both.

SO2R Radio Support

All supported radios will work with SO2R. N1MM Logger will allow you to use any combination of computer controlled and
non-computer controlled radios. If you use a radio that is not supported or has no radio control, do not set up a radio COM
port. You only set up that information when you have a computer controlled radio.

Using External SO2R Controllers

N1MM Logger is compatible with most older hardware SO2R controllers using the LPT port such as the Top Ten Devices “DX
Doubler”, and the Array Solutions “SO2R Master”. These products will automatically switch keying, PTT and audio lines
between radios. New products like the microHAM MK2R can be fully controlled via USB or via an LPT port. The EZmaster
from Ham Radio Solutions is only supported using its LPT port and not its USB port.

Controllers using the LPT port will require a straight-through DB-25 cable from your LPT port of your computer to the input
DB-25 connector.. For hooking up the rest of the keying and audio lines, consult their respective manuals. All products use the
same pin-outs on the LPT port.

To get N1MM Logger to correctly key and control these devices, you need to set up your keying as follows:

LPT Keying with External SO2R Controllers Using LPT Port

Open Config >Configure Ports, Mode Control, Other >Hardware tab
Check LPT keying box – check only one LPT box unless using another one for antenna selection control
Click on the corresponding “Set” button for the LPT port
Click on “Radio Nr” drop down box and select “Both”
Click on OK to set configuration
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Using Winkeyer and WinkeyerUSB

The original Winkeyer, used a RS-232 COM port, and is not a USB device. Winkeyer has an internal pin 3 output, which is
normally CW for 1 radio, and an internal pin 5 which is normally PTT for a single radio. Under N1MM Logger software control,
pin 3 can set for Radio 1 CW output and Pin 5 can be set for Radio 2 CW output. The virtual serial port assigned to the
Winkeyer USB device should have the “Hardware” tab “Set” and Winkeyer checked and Radio Nr set to ‘Both’. Then go to the
“Winkeyer” tab and set Pin 5 function to “2nd CW”

The “K” output on the Winkeyer board goes to Radio 1 CW and the “P” output goes to Radio 2 CW. N1MM Logger takes care
of all the switching provided you activate the proper radio.

The WinkeyerUSB (sometimes called “Winkeyer 2”) has separate CW and PTT outputs for each radio. The 2nd radio CW is
enabled from the Winkeyer tab “Use 2nd Output”.

SO2R Using the DX Doubler

Setting Internal DXD Jumpers to Enable Stereo Feature

Thanks to W4NZ, long-time N1MM and DXDoubler user, for the following:

Here is my baseline configuration – the one that has been working for me in contests for quite a while. This is also compatible
with all the SO2R features in N1MM. Control of the DXD is from a hardware LPT port.

Jumper 1: 2-3
Jumper 2: 5-6
Jumper 3: 9-10

Coincidentally, these are the same as the jumper settings for the “NA” software as shown in the DXDoubler manual.

If you change the jumper settings to those shown in the DXD manual for CT/TR/WL,

Jumper 1: 1-2
Jumper 2: 4-5
Jumper 3: 8-9

then testing the SO2R features, N1MM Entry window focus moves to the correct radio just as it should but the DXD does not
automatically switch radios (RX audio/TX focus) to follow the window focus. However, the DXD can be switched manually by
using the PAUSE key or CONTROL + Left/Right Arrow. The Backslash key (\) also moves focus without switching the DXD.

With the NA jumper settings, now you can use the “tilde” key (~/`) to toggle stereo audio (Left radio-left ear/Right radio-right
ear) on and off.

You can use the macros {STEREOON} {END} {STEREOOFF} in Function Key Messages) to switch the audio automatically
according to the operator’s preference. Refer to this page for more details.

Example for F1 – CQ Message: {STEREOON} CQ TEST * * TEST {END} {STEREOOFF}. This sequence will turn on Stereo
during transmission of the CQ so that you can listen on the second radio, and then go back to both ears on the CQing radio
when the CQ finishes. Note that the {END} macro is required, because otherwise the {STEREOOFF} macro will be executed
before the CW is sent.

LPT Port Basic SO2R Controller Design

A basic SO2R controller design … it’s about as simple as there is but it works well with N1MM (or Writelog) in LPT mode. I
decided to add support for CW from the LPT – the PTT relay can be replaced with a SPDT relay if CW is taken from two COM
ports or Winkeyer USB is used (better). Joe, W4TV – 5/30/2009 – Revision 1.0

3/4/25, 5:37 PM N1MM Logger+ Documentation

https://n1mmwp.hamdocs.com/setup/function-keys/#macros


614

Basic SO2R LPT Port – Receive Interface

Basic SO2R LPT Port – Transmit Interface
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Focus on Other Radio (FocusOther)

A method of focus control, preferred by many contesters. When FocusOther is active, the RX focus is automatically shifted
between the “Run” radio and the “S&P” radio, depending on whether the Run radio is transmitting. When the Run radio is
transmitting, RX focus is shifted to the S&P radio. When the Run radio stops transmitting, RX focus shifts back to the Run
radio, unless an unworked callsign has been entered in the S&P entry window. This allows a callsign to be entered in the S&P
radio Entry Window while CQ is being sent on the Run radio.

SO2R and MMTTY

Instructions for setting up two copies of MMTTY for use in SO2R (Note: there are more detailed instructions on setting up for
digital modes in the Digital Modes section – this section focuses on the SO2R aspects):

Create two separate folders for the two copies of MMTTY. This allows each copy to have its own configuration
Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll if you use EXTFSK, or extfsk64.fsk if you
use EXTFSK64) from the main MMTTY program folder into each of the two folders you will use for SO2R

Start N1MM Logger+ and open the Configurer (Config > Configure Ports, Audio, Mode Control, Other)
Select the Digital Modes tab

Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital Interface 2
Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your setup and set the MMTTY Path to point
to the copy of MMTTY.exe in the first folder
Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the MMTTY Path to point to the copy of
MMTTY.exe in the second folder

Select the Hardware tab
Select the SO2R option
This next step is optional for many users, but mandatory for some. If you are using serial ports for PTT and/or
FSK from MMTTY, you may need to check the Digital check box beside the ports used by the two copies of
MMTTY. This step is necessary if you use the same port for CW or PTT keying from N1MM Logger in CW or
SSB modes; if the only place you use a port is from MMTTY, this step is unnecessary

Click on the Set button for the port you will use with Radio 1 and set the Radio Nr and the Dig Wnd Nr
both to 1
Click on the Set button for the port you will use with Radio 2 and set the Radio Nr and the Dig Wnd Nr
both to 2

Close the Configurer
Open the Digital Interface 1 Window (Window > Digital Interface menu item in the main or Radio 1 Entry window)

If an MMTTY window does not appear (e.g. if you see an MMVARI window instead), then in the DI Window
select the Interface > MMTTY menu item to open the MMTTY window
Select the Setup > Settings menu item

Under Preferred RTTY Interface (lower left), select MMTTY
Under Alignment Frequency (lower right), enter your Mark audio frequency (e.g. 2125)
Click on Save Configuration

In the DI Window, select the Setup > Setup MMTTY menu item
Select the TX tab and set the PTT & FSK port you will be using for the Radio 1 copy of MMTTY
Select the SoundCard tab (MMTTY version 1.66 or newer) and select the Reception sound card you will
use with Radio 1. If you are using AFSK, you must also select the Transmission sound card
Under the Misc tab, select the channel (left or right) under Source. If you are using an older version of
MMTTY, you may also have to set the Device numbers (this is not necessary if you have selected the
sound card using the SoundCard tab)
Close the MMTTY Setup window

If the second Entry window is not open, open it by pressing the Pause key, the backslash (\) key or Ctrl+Right Arrow. In
this window, select the Window > Digital Interface menu item to open the second Digital Interface window. Repeat the
above steps using the COM port, sound card device and channel you will use with Radio 2

SO2R RTTY with 1 Soundcard

If you have a two-channel sound card and the necessary cabling to send audio output from both radios to the line input of the
same sound card (left radio on the left channel, right radio on the right channel), you may be able to use a single sound card
for SO2R RTTY. Just set both MMTTY instances to the same card, and in the configuration for each copy of MMTTY select
the appropriate channel for that radio. Note that for AFSK transmit, MMTTY only uses the left channel regardless of which
channel it is using on receive. Therefore if you are using AFSK for transmitting you will have to route the audio output from the
left channel of the sound card to the audio inputs on both radios and rely on the SO2R switching to control which radio gets
PTT.

If your sound card does not support separate inputs for the two channels, such as a laptop sound card with only a mono mic
input, you won’t be able to do this and you will have to use two sound cards for SO2R.
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Two-Computer SO2R

Some operators, particularly on RTTY, prefer to use separate computers for SO2R. This is not explicitly supported by N1MM
Logger, but there is a way.

First, be sure both computers are running the same version of N1MM Logger. Turn on Networked-Computer mode (Config
>Networked-Computer Mode), and configure the network between your computers as explained in the manual pages for the
Network Status Window. Then set up your contest class as Multi-One.

Set your lockout style under the Network Status Window’s Options tab as explained in the Network Status Window
documentation:

First One Wins
Make sure both stations are designated as “Run” stations
Check the “Block my transmitter with M1 & M2 contest rules” checkbox

Last One Wins
Make sure both stations are designated as “Run” stations
Check the “Block my transmitter with M1 & M2 contest rules” checkbox
Check the “Stop my station from transmitting to prevent other station block” checkbox

Note that these are not band lockouts; they are only transmitter lockouts. They are not intended to prevent damage from
operating both radios on the same band. They are intended only to prevent both radios from transmitting at the same time in
violation of contest rules. Also, they are dependent on the reliability of networking. Network dropouts or high network latency
can cause them to fail and allow overlaps between transmissions on the two radios.

Please note that a number of N1MM Logger’s advanced SO2R features cannot be used in this style of SO2R operation,. The
list includes Ctrl+Fx (send Fx on the opposite radio), {CtrlFx} (the same option implemented as a macro), dueling CQs, and
FocusOther. All of these require both radios to be connected to the same computer. Serial numbering, if used, will conform to
the Multi-Single rules for the contest in question.

Don’t forget to change your entry class back to Single Op or Single Op Assisted in the Contest Setup window before you
generate your Cabrillo file.

Two Band Split Interleaved QSO (2BSIQ) with the YCCC Controller

This description of a sample 2BSIQ configuration posted to the N1MM+ reflector by Steve N2IC on 2019-05-30:

First of all, let me make it clear – there is nothing easy about doing 2BSIQ. I feel exhausted after just a few hours. I
have huge respect for guys like KL9A, N6MJ, 8P5A (W2SC), CT1BOH, N4YDU, etc. that strive to stay in 2BSIQ
mode for 48 hours. I couldn’t do it. Also, my way is not the only way to do it with N1MM+. I encourage folks to
experiment and see what works best for them.
Settings:In SO2R menu: Two Keyboards, Toggle Stereo/OTRSP Macro. Nothing else checked.Configurer, Function
Keys – set Again Key to F7.ESM (of course !)All radio sidetones muted.

In the YCCC SO2R Box settings, Headphones Normal. No latch or split stereo.

Make sure that two keyboards are activated – type one character on the left keyboard, it should appear in the left
entry window. Type one character on the right keyboard, it should appear in the right entry window. Two keyboard
mode is now activated.

I do all CQing manually by pressing the Enter key on each keyboard when needed. No dueling CQ or other
automation. One hand on each keyboard. Yes, it has taken lots of practice to be able to use only one hand on each
keyboard. Breaks all rules about touch typing that you might have learned.

Here’s the .mc file I used for WPX CW.

Users Please Note
Please be aware that the developers will not implement Feature Requests or respond to Bug Requests that result
from 2-computer SO2R’s not conforming to single-computer SO2R expectations.



1
2
3

F1 Cq,cq test *{OTRSPOTHER RX}{END}{STEREOON}
F2 Exch,5nn|||#{OTRSPOTHER RX}{END}{STEREOON}
F3 Tu,tu *{CLEARRIT}{OTRSPOTHER RX}{END}{STEREOON}
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The CQ is kept very short to match the duration of the callsign you are receiving on the other radio. The F11
{STEREOTOGGLE} is wired to a footswitch. You often want to quickly get out of stereo to focus on one radio.
Pressing the footswitch is faster than searching for the ~ key.
Here’s an ideal 2BSIQ sequence. Each line represents events happening at the same time. The —- separates left
and right entry window actions.

CQ enter key left keyboard—-(nothing done on right keyboard).
Station answers, type call on left EW—-CQ Enter key right keyboard (press the CQ enter immediately after the left
CQ has completed).
Send run exchange enter key left keyboard—- Station answers, type call on right EW.
Receive exchange, typing on left keyboard—- Send run exchange enter key right keyboard.
Send TU enter key left keyboard—- Receive exchange, typing on right keyboard.
Station answers, type call on left EW—- Send TU enter key right keyboard.

There – you have just completed two QSO’s, simultaneously (and a third QSO is just getting started on the left
EW). Ideally, you don’t have guys sending to you simultaneously on both radios. Ideally, you don’t have to make the
other station wait while you are sending on the other radio. Real life is not ideal as you will quickly discover.

It is very important to be constantly looking at the echo’d CW characters at the bottom of the entry windows, so you
know where you are in the flow.

That should get you started.
73, Steve, N2IC (and sometimes WK5T)

Single Operator Split Operation
Split operation is when you transmit on a frequency different from the one where you are listening. This is often used when
stations have huge pileups like some DXpeditions, or when frequency allocations do not allow people in different countries or
IARU regions to make contact on the same frequency. An example is 40 meter SSB between Europe and the USA. Many
European stations operate below 7.125 MHz, the bottom edge of the US allocation. When N1MM Logger is controlling a
transceiver with split capability, the program enables you to split and “unsplit”, to change frequencies, and perform other useful
operations.
When used in this manual, the term “split frequency” always refers to the transmitting frequency. The assumption is that you
will listen first, either to identify a station to call or a clear listening frequency to use while running, and then set your transmit
frequency.

Am I Transmitting Split?

There are a number of ways that the program tells you whether you are in Split mode, which can avoid some embarrassing
moments or potentially, a citation for out-of-band operation. In the Entry window Split is displayed in the title bar. The receive

4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

F4 {MYCALL},*
F5 His Call,!
F6 ?,?
F7 NR,#
F8 LOGIT,{LOG}
F9 nr?,nr
F10 Call?,cl?
F11 STERTOG,{STEREOTOGGLE}
F12 RX Ant Toggle,{ANTRX1TOGGLE}
#S&P ———-, Search and Pounce Messages begin here —————————–
F1 Qrl?,cq test *
F2 Exch,5NN|||#
F3 Tu,tu
F4 {MYCALL},*{CTRLF7}{END}{STEREOON}
F5 His Call,!
F6 Repeat,{SENTRSTCUT} {EXCH} {EXCH}
F7 NR,#
F8 LOGIT,{LOG}
F9 nr?,nr
F10 Call?,cl?
F11 STERTOG,{STEREOTOGGLE}
F12 RX Ant Toggle,{ANTRX1TOGGLE}
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frequency is always displayed first, and the transmit frequency in parentheses, as in this example.

In the Bandmap, there are two sets of indicators, shown in this example.

You’ll notice that the receive frequency is shown in bold blue letters at the top of the Bandmap, and the transmit frequency is
shown below it in smaller type. You are also reminded by the indicators for your receive frequency (always blue) and your
separate transmit frequency (always red).
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Clicking on either the receive or transmit frequencies in the top part of the Bandmap will toggle split operation.

Setting Split Transmit Frequencies Manually

The easiest way to set a split transmit frequency is to type the desired frequency in kHz into the Callsign textbox in the Entry
window, and then hit Ctrl+Enter. Another alternative is to use Alt+F7 to open the Split dialog, type the transmit frequency, and
hit Enter. The split frequency may be entered either in full (e.g. 7027), as a difference from the lower band edge (e.g. 27), or
as a positive or negative difference from the receive frequency (e.g. +2) . Decimals are allowed (7032.3, or 7032,3 if your
regional preferences in Windows use the comma as the decimal separator).

Split Mode and Frequencies Set Automatically from Cluster Spots

If you click on a station in the Bandmap which was spotted with a QSX (transmit) frequency specified — in the format “DX
PA1T 7095 QSX 7130”), the radio will be put into split mode and the frequencies set automatically. You will be set up to
transmit on 7130 (in this example).

Resetting to Non-Split Mode

Resetting to non-split mode is done by moving to another frequency or band, using the program to do so. Simply turning the
VFO on your transceiver will not do it. You can:

Click on another spot or frequency in the Bandmap
Click on a non-split spot in the Packet/Telnet window
Click on the transmit frequency or receive frequency in the top part of the Bandmap
Click on a band button in the Available Mult’s & Q’s window to change bands
Press Ctrl+PgUp or Ctrl+PgDn (which also changes bands)

Split Operation Key Assignments

Alt+F7 – Set split frequency or offset from current frequency for the active radio. When hitting Enter or click OK with nothing
on the line split will be cleared. Press ESC or click Cancel to exit.

Alt+S – When your rig is in Split mode, Alt+S will reset the receive frequency back to your transmit frequency, but the split
mode is preserved. This is used to run a pileup with the rig in split mode. With a radio which has VFO A/B they use the 2nd
VFO as an RIT. This is done since many RIT knobs are small or hard to get at, while some find it more natural to use the main
VFO to tune in a caller rather than use the RIT. By running split, you can use the main knob to tune in the caller, while your TX
frequency doesn’t change. The Alt+S acts like an “RIT clear” when you are running split.

This operates on VFO-A only. With Main/Sub radios like the Icom 756/7800 series you can not RX on SUB without receiving
on both VFOs. In this case put RX on Main and TX on SUB for Alt+S to work.

“Reset RX freq when running split”, an option found on the Entry window’s Config menu, is a way of automating the Alt+S
function. When this option is checked, the program will automatically do an Alt+S as you log each QSO. This gives you an
automated “RIT clear” after every QSO when you are running split.

Ctrl+S – When not in split mode, the first press of this combination puts the radio and program into Split mode. After that
Ctrl+S will toggle the RX frequency between the split RX frequency and the RX/TX frequency while maintaining split mode.
Application: This was designed primarily to help SSB operators run on 40 or 80mM where split operation is widely used. For

Running While Split
Some people prefer to be in Split mode while running, in order to use the main tuning knob to tune in calling stations
that are off frequency. One drawback is that if you tune your receive frequency outside the tuning tolerance set on
the “Other” tab in Config > Ports,Other, the program switches from Run mode to S&P. The way to avoid this is to use
Alt+F11 to temporarily lock the program in the current mode. That is, if you press Alt+F11, the program will not
automatically change modes when you tune. Press Alt+F11 again to return to normal operation.



Icom Precautions
Icom radios can’t report VFO B without being set to VFO B, and don’t report whether the radio is in Split mode. To
operate split successfully, you need to set and cancel splits solely from the computer. Use Ctrl+Enter or Alt+F7, as
above. Only turn Split on/off from the keyboard/program and not on the radio, to make sure it stays in sync with the
program.
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example, “CQ CQ de N1MM listening on this frequency (7183) and 7068”. Use the Ctrl+S key to toggle between 7183 and
7068 to check for both USA or DX callers.

Ctrl+Alt+S – Toggle Split mode on the radio. ‘Split’ will be shown in the Entry window.

Ctrl+Enter – Entering a frequency or offset in the callsign with Ctrl+Enter will set a split frequency.

Split mode vs. SO2V

With a dual-receiver radio, the difference between Split mode and dual receive operation can be tricky. If both receivers are
on, the radio is set up exactly the same way for split from the VFO A Entry window (listen to the other station on VFO A,
monitor your transmit frequency on VFO B, transmit on VFO B ) and for SO2V with the Entry window focus on VFO B
(conduct a simplex QSO on VFO B while monitoring the VFO A receiver somewhere else on the band). However, although
these two situations are identical on the radio, they are quite different in the logging software. In the split operation scenario,
the QSO is logged from the VFO A Entry window, with different RX (VFO A ) and TX (VFO B ) frequencies in the log. In the
SO2V scenario, the QSO is logged from the VFO B Entry window with the RX and TX frequencies the same (both from VFO B
).

By changing the transmit VFO from VFO B to VFO A, you can switch to either one of two new situations – split from the VFO
B Entry window (listen to the other station on VFO B, monitor your transmit frequency and transmit on VFO A ) or SO2V with
the Entry window focus on VFO A (conduct a simplex QSO on VFO A while monitoring the VFO B frequency somewhere else
on the band). Again, these two are the same on the radio, but different in the logging software – split logged from the VFO B
Entry window with different RX and TX frequencies in the log vs. SO2V logged from the VFO A Entry window.

Because there are four possible logging scenarios but only two different radio configurations, you cannot depend on making
adjustments from the radio to get QSOs logged correctly. By default, in SO2V mode with both receivers active, N1MM Logger
will assume you are operating in one of the two SO2V modes and will log QSOs using the callsign and exchange from the
active Entry window and logging both TX and RX frequencies from the active Entry window’s VFO.

It is possible to work and log split mode QSOs in SO2V mode, but it takes care and practice to get it right. In order to work and
log QSOs in split while the Logger is in SO2V mode, you must tell the Logger that you are operating split. Since you cannot do
this from the radio, you must turn Split on or off from the keyboard/program, using Ctrl+S and Ctrl+Alt+S. You need to take
care to do this from the correct entry window (the one whose VFO you are receiving the other station on), and to be aware at
all times of which frequency you are transmitting on.

Single Operator Call Stacking

Call Stacking Overview

Single Operator Call stacking allows a CQing operator to enter multiple call signs that are received in response to a CQ
message, and work them one after the other sequentially without re-entering a new call sign for each QSO. Macros and
keystrokes used for call stacking include {SOCALLSTACK}, {STACKANOTHER}, CTRL+ALT+G, {LOGTHENPOP},
{LOGTHENNEXT}, ALT+G, and ALT+D. The first three are used to place calls onto the stack and the others are used to take
calls off the stack.

The macros only operate in RUN mode. Stacked callsigns appear in a small CallStack window that appears immediately
above the Entry window the first time a call is stacked. You can move this window to another location on your display with the
mouse, or dismiss it with the X in the title bar, in which case the next time it appears it will be above the Entry window again.

Using Split – Some Hints
Click on a spot in the Bandmap or Available window. Then look at the Bandmap or the Entry window title bar to see if
you are going to transmit out-of-band. If you SINGLE-click on a spot on 40 or 80, and don’t see the split indicator,
then wait for the station to announce his listening frequency. If he says “listening 214.5”, type 214.5 in the Callsign
textbox and press Ctrl+Enter – you are then ready to call him.
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This window contains a stack of clickable call signs colored according to their multiplier status, a button labelled “C” that can
be used to clear the stack, a font sizer, and a “Help” menu item that opens a Help window listing the following
keyboard/mouse commands:

Left-click on a call sign to select it
The selected call sign can be deleted using the Delete key

Right-click on a call sign to delete it from the stack
Double-click on a call sign to move it to the top of the stack
Ctrl+Alt+G moves the call sign in the Entry Window call sign box to the top of the stack
Alt+G replaces the call sign currently in the Entry Window with the call sign at the top of the stack
Alt+D deletes the call sign at the top of the stack

Single Operator Call Stacking is functional in CW, phone, and digital modes and is compatible with manual key operation or
ESM. It can also be used in SO1V, SO2V and SO2R modes and in multi-station environments.

{SOCALLSTACK} or {STACKANOTHER} or CTRL+ALT+G
The operator can stack a full callsign or a partial callsign that may include a “?” that will be highlighted when that callsign is
removed from the stack. In CW and SSB, callsigns that are new multipliers are prioritized over non-multiplier callsigns.
Callsigns that are dupes are ignored. In Digital modes, there are options to control the stack priority in the Setup menu in the
Digital Interface window.

The operation of the {SOCALLSTACK} and {STACKANOTHER} macros differ slightly:

{STACKANOTHER} or the keystroke short cut, CTRL+ALT+G, simply pushes callsigns onto the stack and clears the Entry
Window callsign box.

{SOCALLSTACK} functions as a single level stack macro. The first execution of {SOCALLSTACK} stacks the first callsign and
clears the Entry Window callsign line. When a second callsign is entered and {SOCALLSTACK} is executed again, the two
callsigns are exchanged. If the callsign window is empty when {SOCALLSTACK} is executed, the callsign is removed from the
stack and placed into the callsign Entry Window. The user can thus control which call sign will be worked first, whereas with
{STACKANOTHER} the last call sign entered is the first one to be worked.

If you have {SOCALLSTACK} programmed to an F-key, pressing it once at any time will exchange the current callsign with the
next callsign on the stack. If there is no callsign on the stack, then it stacks the call and gives you an empty callsign window to
enter one. Pressing the F-key again will reverse them again.

{LOGTHENPOP}, {LOGTHENNEXT}, ALT+G, ALT+D
The stacked callsigns can be removed from the stack by using ALT+G or the Spacebar to replace the callsign currently in the
callsign box in the Entry window with the callsign at the top of the stack without logging a QSO; by using {LOGTHENPOP} or
{LOGTHENNEXT} to log the current QSO and unstack the next callsign into the callsign box; or the stacked callsign can be
simply deleted from the stack with the keystroke ALT+D. The ALT+D keystroke is useful if a callsign appears on the stack via a
telnet spot and is not one of the ones you want to work. The next callsign on the stack is displayed in the On Deck box in the
CallStack window. Using the {LOGTHENPOP} or {LOGTHENNEXT} macro method, the next QSO can be started immediately
without giving the pileup time to restart.

ESM Automation
The Configurer, Function Key tab, Next Call Key is used to select the function key that contains the {LOGTHENPOP} macro
along with the message string for ESM automation. If a Next Call Key has been specified and that key contains a
{LOGTHENPOP} macro, then when Enter is pressed to finish a QSO and there is another call sign on the callsign stack, the
Next Call Key will be sent instead of the TU(F3) Key. The last option in the drop down menu for the Next Call Key allows the
ESM SO Call stacking automation to be disabled. Alternatively, the {LOGTHENNEXT} macro can be used instead of
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{LOGTHENPOP} in order to disable this part of the ESM Enter key automation while still allowing the operator to use the
capability manually by pressing the function key.

If the exchange for the current QSO has not yet been sent, or if the received exchange is invalid, the {LOGTHENPOP} and
{LOGTHENNEXT} macros are disabled in order to prevent logging an incomplete QSO.

SOCALLSTACK ESM Example
Program F9 key to: {STACKANOTHER} or {SOCALLSTACK}
Program F10 key to: {LOGTHENPOP}TU NW {F5} {F2}
(Note: Do NOT use ! in place of {F5}, and in a serial number contest, do NOT use # in the {LOGTHENPOP} message.)

For SSB, an appropriate SSB wave file can be inserted into the F10 message in place of the ” TU NW” letters above.

Set >Config >Function Key tab >”Next Call Key” to F10

Select RUN mode and turn ESM on. For this example two stations are calling, N2IC and K3CT
Type K3CT, press F9, type N2IC and press Enter
Copy N2IC’s report and press Enter. This will log N2IC, and then instead of F3 it will invoke F10, which will send the TU,
unstack K3CT, and send the exchange

SOCALLSTACK Non-ESM Example
Program the function keys as listed above.
Select RUN mode.
Type K3CT, press F9, type N2IC and press the exchange key programmed in Configurer, usually “;”. This key is programmed
to F5 & F2.

Copy N2IC’s report and press F10. This will log N2IC, unstack K3CT, and send the exchange.

If multiple callsigns are stacked, ESM will continue to unstack the callsigns. The same is true in non-ESM mode as the Next
Call key (F10) is pressed. Should a logging error occur such as a bad call, the sequence will be interrupted until the error is
corrected. When no calls remain on the stack, the normal TU message is sent (if not using ESM, you would normally press F3
instead of F10 at this point). If there are multiple callsigns on the stack, the order that they are removed or exchanged with
{SOCALLSTACK} depends on the internal sorting order and not necessarily the order they were stacked. In CW and SSB,
multipliers will be unstacked before non-multipliers.

Additional SOCALLSTACK Information

If a callsign was placed on the callsign stack but you want to remove it without working it, use the ALT+D keystroke to remove
it without popping it off the stack into the Entry window.

Single Operator Call Stacking and multi-operator call stacking work similarly. Multi-operator call stacking is the program
feature that allows a second operator to listen on the run frequency and send calls to the run operator’s Entry Window.

Digital Call Stacking
In digital modes there are two different ways to work stations one after the other in series when more than one station
responds to your CQ. The first method is based on the Single Operator Call Stacking described in the previous sections,
adapted to use the features of the DI window. The second method, using the Grab list, is unique to digital modes.

LOGTHENPOP: To use this, you must program a function key using the {LOGTHENPOP} macro, e.g.:
{TX} ! {LOGTHENPOP} TU NW {F5}{F2} {RX}
When this function key is pressed or clicked on at the end of a QSO instead of the normal TU key, it will log the previous
contact, pull the next call sign off the single operator call stack in the CallStack window, and send the exchange to the new
station. If you designate this function key as the Next Call Key in the Configurer under the Function Keys tab, ESM will
automatically select this key instead of the TU key at the end of a QSO whenever there is an unworked call sign remaining on
the call stack in the CallStack window. Note that you must use two different function keys for the TU and Next keys; do not put
{LOGTHENPOP} into the TU key. Don’t use ! in place of {F5}, and don’t program the exchange (e.g. # in a serial number
contest) directly into the Next Call key; use the {F5} and {F2} macros to call up your regular exchange message, as in the
example above. Using ! or # in the Next Call key will send the wrong callsign or serial number.

How do you get call signs into the CallStack? You can do this effectively in digital modes by selecting the Setup > Digital Call
Stacking menu item in the Digital Interface window’s menu bar. This enables an efficient way to place call signs on the single
operator call sign stack. You have three choices, depending on which order you want calls to be popped off the stack ready to
be worked: Enable using First In First Out (FIFO – the first call to be worked will be the one that was placed on the stack first);
Enable using Last In First Out (LIFO – the first call to be worked will be the one that was most recently placed on the stack);
and Enable using FIFO Mults First (callsigns will be taken off the stack in order of their multiplier value. In those contests
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where one QSO can yield 2 or 3 mults, the higher-mult calls will be taken first. Among calls with the same multiplier value, the
first call to be worked will be the one that was placed on the stack first).

When Digital Call Stacking is enabled and you are in Run mode:

If there is already a call sign in the call sign box in the Entry window when you mouse-click on another call sign in the
RX window, clicking on the new call sign in the RX window will either put the new call sign directly on the stack (FIFO),
or else (LIFO) it will move the call sign that was formerly in the Entry window onto the stack in the CallStack window,
and will bring the new call sign into the Entry window
Alt+left-clicking on a call sign in the RX window will move that call sign directly onto the stack in the CallStack window
without changing the call sign in the call sign box in the Entry window. You can place any number of call signs on the
stack ready for working one after the other
Instead of clicking directly on a call sign, you can also use {GRAB} or Alt+G to pull the highlighted call sign off the Grab
list into the Entry window. The call sign that was formerly in the Entry window will be moved onto the stack
Instead of using {GRAB} or Alt+G, you can use {STACKANOTHER} or Ctrl+Alt+G to move that call sign from the Grab
list directly onto the stack without changing the call sign in the call sign box in the Entry window

When Digital Call Stacking is enabled, left-click, Alt+left-click, {GRAB}/Alt+G and {STACKANOTHER}/Ctrl+Alt+G give you a
variety of ways to choose which call signs you want to place onto the call sign stack and into the Entry window. Once there are
one or more call signs on the call sign stack, after working the first station in the Entry window, the Next Call key (automated
with ESM) lets you work the call signs from the stack rapidly one after the other.

LOGTHENGRAB: There is a separate method that uses the Grab list in the DI window with the {LOGTHENGRAB} macro.
You do not need to enable Digital Call Stacking to use this method. You can use any method you wish to get the first call sign
into the Entry window so you can work that station. At the end of the QSO with the first station, if you want to work the call sign
that is highlighted in the Grab list, you can use an F-key or message button that contains:
{TX} ! {LOGTHENGRAB} TU NW {F5}{F2} {RX}
This will log the contact with the first station, then grab the highlighted call sign from the Grab list and send the exchange to
that station. You can repeat this for as long as there are workable call signs being highlighted in the Grab list. If the next
highlighted call sign in the Grab list is invalid or not workable, you should press or click on the normal TU key instead, in order
to avoid attempting to work a bad call sign. You can also program a {DELSEL} macro into an unused function key or DI
message button for use in removing unwanted call signs from the Grab list. Don’t program the exchange (e.g. # in a serial
number contest) directly into the function key that has the {LOGTHENGRAB} macro in it (the # macro in this key will send the
wrong serial number); use the {F2} macro to call up your regular exchange message, as in the example above, to get the
correct exchange sent to the second station. Likewise, don’t use ! in place of {F5} in the {LOGTHENGRAB} function key
message; doing this will send the wrong callsign.

Using this method, the Grab list is populated automatically, but you have to decide manually whether to use the normal TU
function key or the message key containing the {LOGTHENGRAB} macro. This is because of the possibility of unwanted or
incorrect call signs in the Grab list – it is up to you to decide whether the next call in the Grab list is one you want to work
using {LOGTHENGRAB}, or whether you just want to end the QSO with a normal TU message. Do not put a
{LOGTHENGRAB} macro in your normal TU function key, or in the Next Call function key if you are using one with ESM.
{LOGTHENGRAB} must be in a separate function key or in one of the DI message buttons. Also, if you have enabled the Next
Call key in the Configurer, do not put a {LOGTHENGRAB} macro in the Next Call key message; the correct macro to use in
the Next Call key is {LOGTHENPOP}.

Here is a sample generic function key message file using both {LOGTHENGRAB} and {LOGTHENPOP}, with the Next Call
key for ESM set to F12:

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18

F1 CQ,{TX}{ENTER} CQ * * CQ {RX}{CLEARRIT}
F2 Exch, {TX} (SENTRST) {EXCH} ! {RX}
F3 TU,{TX}{ENTER} TU * CQ {RX}{CLEARRIT}
F4 My Call,{TX} * {RX}
F5 His Call,{TX} ! {RX}
F6 Call?,{TX} UR CALL? {RX}
F7 Rpt Exch,{TX}{ENTER} {EXCH} {EXCH} {RX}
F8 Agn?,{TX} AGN? {RX}
F9 Now,{TX}{ENTER} ! {LOGTHENGRAB}TU ..NOW {F5}{F2}{RX}
F10 Grab,{GRAB}
F11 Stack,{SOCALLSTACK}
F12 Next,{TX}{ENTER} ! {LOGTHENPOP}TU ..NOW {F5}{F2}{RX}
F1 QRL?,{TX}{ENTER} QRL? * {RX}{CLEARRIT}
F2 Exch,{TX}{ENTER} TU {SENTRST} {EXCH} {RX}
F3 Spare, 
F4 Call Him,{TX} * * {RX}
F5 His Call,{TX} ! {RX}
F6 My Call,{TX} * {RX} 
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19
20
21
22
23
24

F7 Rpt Exch,{TX}{ENTER} {EXCH} {EXCH} {RX}
F8 Agn?,{TX} AGN? {RX}
F9 Spare, 
F10 Grab,{GRAB}
F11 Spare, 
F12 Spare, 
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Multi-Computer and Multi-Op Contesting
2019-03-29

Multi-Computer and Multi-Op Contesting
Introduction

The purpose of Multiple Computer Networking is to support logging of QSOs on multiple computers. This is accomplished with
application-defined data replication. Each computer will have its own copy of ALL the QSOs and N1MM+ will synchronize the
data so that it is the same on each computer. This approach is used because contesters usually operate in a high-RF
environment and using a single database would not be as reliable as having each computer log its own QSOs and replicate
them on all the other computers. The station that logged the QSO, as indentified by its NetBios name is the keeper of that
data. When data is out-of-sync, the QSOs on each computer will be replaced with QSOs from the computer that logged them.
NEVER, EVER REPLACE A COMPUTER IN A NETWORK AND USE THE SAME NetBios NAME while in multiple-computer
network mode. You risk losing ALL the QSOs from the computer you are replacing. Likewise, do not shut down networking
and modify QSOs. When you bring the network back up, the system will replace your changes with the originals from the
owner’s computer. You can log with the network down, but you are confined to the QSOs that you own and that you add.

There are major changes in N1MM Logger+ networking, as compared with N1MM Logger Classic, which will affect both multi-
op contesting and those operators who network multiple computers for single-op categories, particularly on digital modes.
.

You no longer need to enter computer names and IP addresses when networking on a typical LAN. When networking is
turned on, N1MM Logger+ detects the presence of computers on the same subnet that are running the same version of
N1MM Logger+, and automatically connects to them. You will be warned if there are discrepancies in contest or multi-
op class among the computers, so that you can correct them.

The Network Status Window is brand new in N1MM Logger+.

All network-related options and actions except for informational functions such as received Talk messages and
band-change status have been moved to this new window. Those remain in the Info window.

A full explanation of this window and each of its functions is found here.

Key Features

Use of standard network interface cards (NIC’s) and wireless interfaces
Point to point or broadcast Talk capability between networked stations
Automatic time synchronization (if non-master stations are Run as Administrator)
Pass frequencies displayed at all stations
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DX Spots distributed by master station to all connected computers
Spotting commands can be sent by any station on the network

Extensive error trapping and diagnostics
Auto resync when a station comes on-line

The Simplest Multi-Op

The simplest form of multi-operator contesting involves a single radio and a single computer, i.e. it is just like single-operator
contesting except that two or more operators take turns, spelling each other. Of course, you have to ensure the correct entry
class is entered in the Contest Setup dialog. From there on, if you wish to keep track of which contacts were made by which
operator, you should use Ctrl+O, or the OPON direct entry command in the Entry window, and enter the call sign of the
incoming operator every time the operator is changed. N1MM Logger+ will keep track of which operator made each contact,
and that information will be displayed in the Log window. For the simplest setups, including CW and RTTY, and SSB without
voice keying messages, this is almost all there is to it.

Multiple Radios and Multiple Computers

Most multi-operator setups will involve more than one radio and/or more than one networked computer. The details of how to
set up a networked computer system are in the Network Status window section of this manual.

Stored Voice Messages in a Multi-Op (Any multi-op)

If you are using stored voice messages in a phone contest and you change operators while using the same stored voice
messages, the voices heard over the air could vary during a single QSO between recorded messages and live voicing. This
can be very confusing to the other station. To avoid this, it is best to have each operator record a separate complete set of
voice keyer messages. To do this, create a separate subfolder for each operator within your wav files folder, labelled with that
operator’s call sign. Make sure the paths to your wav files in your function key messages includes the {OPERATOR} macro,
as in “{OPERATOR}\CQ.wav”. Before the contest, have each operator enter his or her call sign with Ctrl+O or OPON and then
record all of the voice keyer messages in his or her own voice. Once the messages are all set up, the Logger will use the
operator call sign entered during the contest with Ctrl+O or OPON to select which set of recorded messages to use.

If your multi-op uses multiple computers, and if any individual operator will use more than one of these computers during the
course of the contest, that operator will need to create and populate a subfolder with his personal wav files on each of the
computers that he or she will be using.

“Distributed” Multi-Ops (IARU Headquarters stations, for example)

N1MM can be configured to allow some or all of the other stations outside your LAN to communicate over the internet.
Possible uses for this feature are: Headquarters (HQ) stations in the IARU contest and distributed special event stations.
There are two basic methods for configuring external network stations on your N1MM multi-op network: direct IP addressing of
of external stations; and using a VPN (Virtual Private Network) to which all of the stations would connect. The website’s
>Downloads >Additional Support Files gallery contains instructions for installing and operating a VPN – two using freeware
software and describing setup for the IARU (but can be applied to networks); and another using a commercial VPN. See:

IARU – VPN Client- and Server-side WAN setup instructions by VU2PTT.zip
VPN-IARU-SoftEther-2020-05-23.pdf
Distributed Multi-Op Contesting using N1MM+ with a Hamachi VPN.pdf

Footswitch Lockout Support Distributed Multi-Op Networks

Footswitch lockout support has been added for multiple distributed stations.

CAUTION about Software Lockouts
The “Block my transmitter …” and “Stop my station from transmitting ...” items on the Options tab of the
Network Status window are software lockouts. They are subject to network latencies and cannot be guaranteed to
prevent simultaneous transmitting. Because of network latencies, lost packets, network dropouts or network failures
there could be short overlaps in transmissions, or even complete failure of the lockout. For protection against
damage from simultaneous transmitting, and/or to be absolutely certain that contest rules forbidding simultaneous
transmissions are obeyed at all times, you must use a dependable hardware lockout system (or in the case of
distributed stations, strictly-applied procedural lockouts to prevent violation of contest rules). Do not depend on
software lockouts to prevent equipment damage and do not expect software lockouts to give you an
ironclad guarantee of compliance with contest rules!
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In the IARU contest a headquarters station is allowed to use multiple stations located within one IARU zone, but the rule of
one signal per band/mode is still in effect. So there could be 2 (one running station and another looking for multiplier) or more
stations on the same band and same mode and they should keep only one TX signal on this band at any time. Now you can
hook up a footswitch to the LPT port 15 (the LPT port must be enabled even if it is not being used for other purposes. There is
no special check box to turn the footswitch feature on/off). If the station is not in multi-multi operator category the footswitch
will directly control PTT just like Alt+T. If it is a multi-multi station (connected to other stations on LAN or via the Internet in
Multi User mode) it will prevent two stations on the network from both transmitting on the same band/mode combination.

This is a software lockout only, and is subject to network latencies. As such, it should be considered a backup. Multiple
stations on the same band/mode should always coordinate operations (with the help of message passing over the network
from the Info window), and not depend on software lockout to ensure compliance with contest rules.

Multi-Operator Capabilities and Techniques

N1MM Logger+ attempts to simplify and streamline important multi-operator functions. These are collected here to help the
new multi-op participant quickly learn how to use N1MM logger+ effectively in this context.

Messaging – “Chat” for Multi-Ops

Frequently, in a multi-op situation, there is a need to communicate to other operators without shouting across the room. For
this purpose, N1MM+ has a Talk function, which can send Messages to all stations or only one station. Talk can be invoked
several ways:

<ctrl>+E shortcut key, or from Window >Network Status> Actions >Talk. This assumes you want to send a Message to
all stations, indicated by the “*” (asterisk)  in the bottom panel
To send a Message to only one station, from within the Network Status window >Stations list, right-click on the
destination station name and select >Talk

Typing your mesage: Click in the lower panel of the Talk window, check that there is a space following the “*” (or the
destination station name), and type your Message. Press <enter> to send.

After pressing <enter>, the program automatically returns focus to the N1MM+ Entry Window. By default the Message window
remains open, but you can change that behavior by right-clicking and choosing from “Enter moves focus to Entry Window”
(the default); or ““Enter moves focus to Entry Window and minimizes Talk.”

Passing

Passing – referring stations you have worked to the operator on one or more other bands – is an essential tool for optimizing
multiplier counts and total scores in a multi-op. There are two basic forms that this can take:

You are running, and you pass someone you work to another band where your station is also running.
You are running, and you pass someone you work to a specified frequency on another band. This might be useful, for
example, if your station’s operator on that band is searching and pouncing.

Some basics – if the station on a given band is in Run mode, then his pass frequency will be his running frequency. If that
station is in S&P mode, then he will want to set a pass frequency – perhaps somewhere high in the band he is on. To set a
pass frequency, click on the Actions tab of the Network Status window, then click on “Set Your Pass Frequency.” A dialog will
open, where you can enter a frequency, or 0 (zero) to clear your pass frequency. If you switch from S&P to Run mode, your
pass frequency will change automatically to your current frequency. Don’t leave a zero in your pass frequency while you are in
S&P mode, or other stations will not be able to pass to you. If you are not using an interfaced radio, be sure to enter your
current frequency in the callsign field of the Entry window.

You can pass the station currently in your Entry window, or the one you worked last, in one of two ways:

Right click on the station you want to pass to, in the Network Status window, and click on Pass Current/Last QSO.
Right click on the Band Button in the Entry window corresponding to where you want to pass the station. For example,
if you’ve told him, “Please go to [your 20M station’s Run or Pass Frequency]”, then right-click the 20M Band Button.

Either way, a pass message will be sent, in red to get the other operator’s attention, and a message will be entered in black in
your Info window confirming that it was sent.
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In addition to telling the operator at the other station on the network that you are passing someone, you also need to tell the
station you are passing what frequency he should go to on the new band. The {LASTPASSEDFREQ} macro has been
created for this purpose.

To use this, you can program a function key with a request to QSY, for example:
F7 Pass, {LOG} TU ! PSE QSY {LASTPASSEDFREQ} *
During the QSO, you check the multiplier and worked status of that station on other bands by looking at the colors of the band
buttons in the Band Panel in the Entry window. If you decide you want to ask the other station to QSY, then at the end of the
QSO, instead of pressing Enter to log the contact, you would first right-click on the band panel button for the band you want to
pass the station to, and then press the function key containing the {LASTPASSEDFREQ} macro (F7 in this example). This will
log the contact (because of the {LOG} macro) and ask the other station to QSY to the pass frequency on the new band. A
message will be sent to the networked station you are passing to, the callsign of the station being passed will appear on his
Bandmap at his Pass (or Run) frequency, and a note will be placed in the log to enable you to assess the effectiveness of your
passing strategy post-contest, with the help of the View > Notes menu item.

Passing – How-To… Example

Passing NH7T from 20m to 10m:

For this to work, the station being passed to (the 10m station in this example) must have set a Pass frequency. If the station is
in Run mode, this happens automatically (the Pass frequency is the CQ frequency). If the station is in S&P mode, the operator
can use the Alt+Z hotkey to set a Pass frequency to pass stations to.

The station doing the passing (the 20m station in this example) can see the other station’s Pass frequency in the Network
Status window. If the Pass frequency shows 0.00, the station has not set a Pass frequency and is not ready to have callers
passed to them:
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Now on the passing (20m) station with the callsign to be passed (NH7T in this example) in the Entry window callsign box (for
example, just before logging the contact), first check the Band Panel buttons to see whether the station has already been
worked on the new band.

The color of the Band Panel buttons indicates the worked/multiplier/dupe status of the station on each band. No color
indicates a Dupe (no points); green is a double-mult; red is single-mult; and blue is just a normal QSO. In the example below,
the 10m Band Panel button is green indicating double-mult status. Right-click on the 10m band button to send a message to
the 10m operator that you are passing a station to them.

After the right click on the band button, you will see a message in the 20m Info window:

Avoid unwanted band changes when clicking on Band Panel buttons
Note that if the left-click option to QSY using band panel buttons has been enabled, a left click will QSY the radio to
the new band. You probably do not want that, so to avoid problems caused by inadvertently left-clicking instead of
right-clicking, it is a good idea to uncheck the “Band Button Left Click Enabled” option in the Entry window’s right-
click menu. Losing the fast band change from the Button Panel is a small price to pay for the ability to pass stations
easily and safely.
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At the same time, the 10m operator will see a message in their Info window “Passing NH7T on 28040”, the Talk window on the
10m station will open with the same message, and the passed callsign will appear in the 10m Bandmap on the CQ-Frequency.

After the right-click, the 20m operator can use the {LastPassedFreq} macro in a function key message in order to ask the
target station (NH7T) to QSY to the Pass frequency. The {LastPassedFreq} macro in a function key will be replaced by the
most recently-used Pass frequency. In this example, the F6 message is designed to be used instead of the regular F3 (TU)
message key to log the contact:

F6 Pass, {Log} Pse QSY {LastPassedFreq}

If the operator doesn’t want to use a function key to send the QSY message, they can always just look at at the Info window
for the 10m pass frequency and send it to the target station manually. This method is often used in SSB contests, unless
voicing of letters and numbers is being used.

The 10m operator can click on the callsign in the Bandmap to enter it into the Entry window. When the 10m station is running,
this would be done if and when the target station is heard responding to a CQ. When the 10m station is S&Ping, they may
need to QSY to their designated Pass frequency to try to work the target station. If the target station is not heard or chooses
not to accept the invitation to QSY, the 10m operator will simply carry on as before.
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In the log, the QSO comment for the 20m QSO will contain a note indicating that the 20m operator passed the target station to
the 10m station.

All Notes can be viewed after the contest with View > Notes. You can see which operators passed stations and check in the
log whether the pass was successful.

Partner Mode and Call Stacking

Partner mode is an extension of the single-operator call stacking functionality to allow one or more partners to listen on the run
operator’s frequency and stack callsigns for the run operator to work. It is enabled automatically when two or more networked
computers are on the same frequency.

Stacked callsigns appear in a small CallStack window that appears immediately above the Entry window the first time a call is
stacked. The run operator or partner(s) can add calls to the callstack window with the {STACKANOTHER} macro or by
pressing Ctrl+Alt+G.

The Run operator can use a function key message with the {LOGTHENNEXT} or {LOGTHENPOP} macro to log the current
contact, pop the next callsign off the stack and send the exchange, or else use the ESM Next key automation to invoke the
Next key containing the {LOGTHENPOP} macro when the Enter key is pressed. This is described more fully in the Single-
Operator Contesting section.

The following hotkeys and mouse actions can be used in the CallStack window:

Ctrl+Alt+G adds the callsign in the Entry window in that computer to the callstack on all computers (alternatively,
partner operators may use a function key containing the {SOCALLSTACK} macro to push the callsign in the Entry
window onto the stack on all computers)
Alt+G wipes the Entry window and grabs the top callsign from the callstack only on that computer; however, it is
recommended that the Run operator should use the automation provided by the {LOGTHENPOP} or
{LOGTHENNEXT} macros instead, with or without the Next key feature in ESM, in order to prevent the pileup from
starting up again and drowning out the start of the next QSO
Right-clicking on a callsign in the callstack window deletes the callsign from all callstack windows
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Alt+D deletes the callsign at the top of the stack from all callstack windows
Left-clicking on a callsign in the callstack window selects the callsign

Pressing the Delete key deletes the callsign from all callstack windows
Double-clicking on a callsign in the callstack window moves the callsign to the top of the stack only on that computer
Clicking on the “C” (Clear) button in the callstack window clears all callsigns from the window only on that computer

If a callsign that exists in the callstack is logged, it is removed on all computers. If a callsign that is a new multiplier is on the
stack and the run operator works another station in the same multiplier the color of the calls in the stack will change when that
QSO is logged. If a partner attempts to stack a callsign that is a dupe, the callsign will not be stacked. If the callstack window
is not open or the callstack contains no calls and the callsign in the Entry Window is a dupe, the
{LOGTHENPOP/LOGTHENNEXT} and {SOCALLSTACK} macros do nothing. In ESM if the exchange has not been sent or
the received exchange has an error, the {LOGTHENPOP/LOGTHENNEXT} macros are disabled. This prevents logging an
incomplete QSO.

Since function key contents and the ESM Next key option are saved by operator, each operator can choose which macros to
use and whether or not to use the ESM automation (e.g. one operator could use {LOGTHENPOP} to start the next QSO
automatically when Enter is pressed, while another operator could use {LOGTHENNEXT} to retain manual control over the
operation).

Managing A Multi-Op Station

A smooth, trouble-free multi-op contest requires a good deal of systematic management. This section attempts to provide
checklists for Before, During and After a contest.

Setting Up the Network

Verify that all of the computers you intend to use are running, and that Windows networking is functional. It is a very
good idea to have a “hot spare” on the network, just in case.
Install the same version of N1MM Logger+ on all of the computers.
Run N1MM Logger+ on each machine, using the right-click option to Run as Administrator on all machines except
the one you will be designating as “master”. This will enable the “master” station to keep all the other computer clocks
in sync with Internet time. Alternatively, if all of the computers have Internet access,you can disable the built-in
Windows Internet time synchronization (which is not accurate enough for this purpose) and install more accurate time
synchronization software (such as the Meinberg NTP client or Dimension 4) on all of the computers in the network to
ensure that they are all synchronized.
Create a new empty database on each machine.
Start a new log for the contest on each machine, making sure to set the contest, operator category and transmitter
category correctly.
Configure external interfaces at each operating position (radio control, CW, PTT, etc.)
Set up Function Key Messages on each computer. If using operator-specific wav files for SSB, make sure that each
operator has his or her own wav file sub-folder on every computer that he or she will be using.
Make sure that Master.SCP and wl_cty.dat files are up to date (on the Tools menu) on all computers
Turn off Windows Sounds (in SSB contests) to prevent transmitting odd noises (Control Panel – Sounds – Scheme: No
Sounds)
Set N1MM+’s Networked Computer mode on – from the Network Status Window on each machine

At this point you should see the names of all the computers running on the network. Initially, i.e. for the first several
seconds or so, they may display various red warning flags .
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This will only persist until the network finishes connecting, at which time the red flags will disappear, unless you have
something wrong, such as a mismatch between N1MM+ versions, between the contests on the different computers, or
between operator categories or transmitter categories. In this case, the red flag will remain on the Messages tab in the
Network Status window, and you will find an explanation there of what needs to be fixed.

Now it’s time to make some test QSOs. Verify that when a given station makes a QSO, the QSO appears on all of the
networked computers. Repeat this process with each computer on the network, including the master, even if you do not
anticipate making QSOs with it during the actual contest, in order to verify that network communications are working correctly.

just before the contest start, have each operator type WIPELOG in the callsign field and press the Enter key. This will remove
all the test QSOs. Then have the starting operator use Ctrl+O to set his or her callsign for the first session.

Make sure that…
* You are running the same version of the program on all computers

You have set up the same contest and same operator and transmitter categories on all computers
All computers have the same version of wl_cty.dat installed
All computers have the same time zone and daylight savings offset
All computers have the same regional settings for numbers, dates, etc, and the same short and long date and
time formats



Multiple networks
There are some situations in which there may be more than one network active at the same time on the same
computer(s). One such situation might be one where the N1MM Logger+ network is a wired network (perhaps
because some of the computers on the network do not have wireless adapters), but where there is a wireless
network operating at the same location. On any computer where there are two network adapters connected and
active, N1MM Logger+ will not be able to reliably detect which adapter you intend to use for the N1MM+ network,
and 50% of the time it will guess wrong. A work-around for this is to temporarily disable the other network while you
are starting up N1MM+ and connecting to the N1MM+ network, in order to ensure that the N1MM+ network
connection uses the correct network adapter. Once the N1MM+ network connection is established, you can re-
enable the other network on any computers that need it (for example, if the Internet gateway is on the other network,
the Master computer will need to be connected to both networks).
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VHF and Up Contesting
2019-03-29

VHF and Up Contesting
N1MM logger has some features which will be appreciated especially by VHF and up contesters. The program supports bands
up to the SHF bands 10, 24, 47, 76, 142 and 241 GHz

VHF Options

Frequency display

The frequency is shown in the Bandmap and in the Entry window. When the frequency is above 1 GHz the band will be shown
in cm, not the exact frequency in the Entry window. When entering QSOs it’s easy this way to recognize the band in which you
log.

Multiplier by Band Window

The Multiplier by Band window includes a Grid Square option. Start the program, open a VHF contest, use the Window >
Multipliers > Grid Square Map menu item. You’ll see the following display, centered on your grid square – the one entered on
your Station Data window.

The Grid Square display has a few additional features, in a right-click menu. Click somewhere in the grid array and the
following menu appears:
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Show Calls Worked and Spots Available – Grid squares you have already worked are colored blue, and grid squares
that have been spotted but not yet worked are colored red.
Turn Antenna – Right-click on a grid square, left click on this option, and if you have a rotator interfaced with the
program, the antenna will be turned to the correct bearing.
Set Rover QTH – If your station category is Rover, you can right-click on a grid square, select this option to set this grid
square as your new RoverQTH
Edit Expected Multipliers List – Use this menu item to edit a list of expected multipliers which will be marked in brown
on the grid square map until they have been worked
Clear Expected Multiplier List
Export Mults & Bands from this Contest – use this option to export a list of grid squares worked on each band to a
text file. By default, the file will be stored in the GoalFiles folder in your N1MM Logger+ user files area.
Set Grid Square Map Center – Right-click on the grid square you wish to place in the center of the display, and then
left-click on this option
Show Beam Heading to Grid Center – Right-click on a grid square, left-click on this option, and a window will open
displaying the bearing and distance from your QTH to the center of the square.
Help – display the Help page for the Multipliers window

In addition to the Grid Square Map window described here, there is also a simpler Grid Squares multiplier window, available
from the Windows > Multi[pliers menu, which simply shows a list of grid squares worked by band.

Gridsquare Key Assignments (VHF and up)

Alt+equal (=) – Search entered info from both the Callsign field and the Gridsquare field in the call history table
The results will be shown in the Check window

Alt+minus (-) – Toggle through call history and entered grid squares (max 3) in the grid square entry field
When no grids are found in the call history there is nothing to toggle

Call History Lookup

More information about this can be found here.

This feature is very useful in VHF contests. Lookup examples are lookups for names (Friends file in RTTY contests),
gridsquares for VHF contests, ages in All Asian DX contests etc. With the importing and exporting options the call history table
can be updated.

Call history lookup is enabled with the option >Config >Call History Lookup. If enabled, it will look up in VHF contests: Grid
Square (max 2) and Name.

Updating the Call History File

There is a function to export the log file to (update) the call history table under >Tools >Update Call History with current log’.
This function will fill the call history table with the contents of the currently selected log.

Transverter Support

N1MM logger has transverter support in the form that per band an offset frequency can be set. Right click on the Bandmap
window and select >Set Transceiver Offset Frequency. The offset value is saved by the program so after a restart the offset is
still there.
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Band (kHz) – enter the transmit frequency of the transverter
IF Freq (kHz) – the frequency used between the radio and the transverter

An offset can also be added to adjust the transverter or radio to the exact frequency (like when the oscillator is a bit off).
See the 432000.12 example where a correction is being made of 120 Hz. Great to have to be right on the packet cluster
spots!

Bandup/Banddown

If you have a radio that has 160-2m, and you want to use bandup/banddown, you’ll need to put entries in for bands that you
do not have transverters for, if there are gaps in bands that the radio/transverters cover. You would really have to put a lot of
transverters offsets in if you want the frequencies to “wrap”.

It does not work if your radio does not accept the calculated frequency. For example, set up for Band: 144000 and IF
freq: 28000 and you put in 146100 and your radio can’t go to 30100, you will get strange results
Remember to enter the frequency of the transceiver and not that of the transverter when going into split mode (Alt+F7).

VHF Beacons

N1MM logger is capable to show beacons in the bandmaps for a defined period of time. Normally every spot in the bandmaps
will disappear after the ‘Packet Spot Timeout’ which is valid for every spot in the bandmap. The same for beacons coming in
as spots. So an extra import option has been added for beacons with where the spot timeout can be set to a much higher
value (like days or even weeks).

Importing beacons and showing them in the bandmaps for the bands can be done by importing a text file in a specific format.
Enter the text BEACONS in the Entry window callsign field and a file selection dialog will open where a .txt file (with beacons in
the correct format) can be imported. An example beacons text file can be found in the N1MM logger program directory (called
Beacons.txt). In the beacons text file lines with a # are remarks, the first line in the text is the timeout for all beacons in hours.
Every line with a beacon must contain callsign, frequency (in kHz) and grid locator (4 or 6 digit). The frequency may be in
either US (50000.25) or European (50000,25) format. A comment per beacon is optional. Note the ; as separator (don’t forget
one or it won’t import). Below an example beacons.txt file.

Next Offset Band
If the next band is not defined as offset to a frequency that my radio can handle and bandup/down is used, it goes to
an HF frequency (without offset).



1
2
3
4
5
6
7
8

# Hours to stay in bandmap (mostly > 24 or > 48)
60
# Call beacon;Frequency;Grid;Comments
OZ7IGY/B;144471,1;JO55WM;
PI7CIS/B;144416,2;JO22DC;Should always be heard
DL0PR/B;144486,3;JO44JH;Switches power!
GB3VHF/B;144430.4;JO01DH;QRG with a .
ON0VHF/B;144418,5;JO20;4 digit grid
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A file with beacons in the correct format for Europe (Region I) can be found on the N1MM website under ‘Other Files’ in the
‘Download’ menu.

Example Contest Setup

Additions are welcome!

Create (Days Before the Contest)

New master.scp file
Use the Tools > Download and Install Latest Check Partial File (master.scp) menu item

Create ‘N1MM logger.ini’ to use during the contest
Set up all the program settings and place the windows as you like them during the contest (on the computer to
use)
Don’t forget the tab ‘Mode Control’ in the Configurer.
After closing the program it has created a file called ‘N1MM logger.ini ‘with all the settings
Copy ‘N1MM logger.ini’ (not .init) to ‘ VHFsettings.ini’.

Text file with contents Function keys for SSB/CW
As a start:

‘File | Export | Export Function Keys to file… | SSB Function Keys’
Give a name like: VHFssbfunctionkeys.mc

‘File | Export | Export Function Keys to file… | CWFunction Keys’
Update these text files if needed

Check possible macros in the Macros chapter
Packet/Telnet button text file

As a start: >File >Export >Export Packet/Telnet Buttons to file…’
Update this text file if needed
Give a name like: VHFpacketbuttons.txt
Check possible macros in the Macros chapter like {GRIDSQUARE}

Lookup database text file for the VHF contests to use
Create a text file with callsign, name, locators etc.
Give a name like: VHFlookup.txt
See info about CallHist file

SSB: Wav files for CQ, rst, exchange etc.
Create wav files for all operators
See {OPERATOR} macro in the Macros chapter

Download up to date country file (cty.dat)
mostly a country file is not used for VHF and up contesting but the program gives information in the Info window
about the logged callsign so download the latest version

Check if the selected contest is still ok, make some test QSOs
This should be done weeks before the contest!

….

Before Starting the Program

Copy the created master.dta file in the N1MM logger program directory
Copy the wav files from all operators in the WAV directory
Turn off Windows sounds if using WAV files

Windows >Control Panel >Sounds – Scheme: No Sounds
Rename ‘ VHFsettings.ini’. to ‘N1MM logger.ini’ and copy it into the program directory

The program will start using the settings as set up days before the contest

After Starting the Program

Select/Check if correct database is used
>File >Open Log in Database, select VHF database’.

Import
This has to be done only once if every time the same database is used!

The NCDXF/IARU Beacon Network
No need to add the NCDXF/IARU Beacon Network on 14.100, 18.110, 21.150, 24.930 and 28.200. They are already
incorporated in the program and the beacon transmitting at that time (when your PC clock is correct) will be shown in
the Entry window statusbar when you are listening on one of these frequencies.
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Each database can handle many contests and thousands of QSOs, don’t use a database for every contest!
Updated files (like the lookup file) have to be imported before every contest.

The function keys macros (SSB/CW)
>File >Import >Import Function Keys to file… >SSB Function Keys. Use file created above
(Example: VHFssbfunctionkeys.mc)
>File >Import >Import Function Keys to file… >CW Function Keys. Use file created above
(Example: VHFcwfunctionkeys.mc)

The packet/telnet buttons
>File >Import >Import Packet/Telnet Buttons from file… Use file created above (Example:
VHFpacketbuttons.txt)

Lookup file
>File >Import >Import Call History File. Use file created above (Example: VHFlookup.txt)

Country file
>Tools >Import country list from downloaded file. Use file downloaded/updated above

Check Station dialog (>Config >Change your Station Data)
The locator from this dialog is used for distance calculation so needs to be entered!

Check contest ( >File >Choose Which Contest to Log)
Check if entered information is correct.
Enter Sent Exchange (this is contest specific, see Setup Contests chapter)

Setup configuration (Rig control, PTT, CW)
Check Configurer >Mode Control tab

When using a transverter, enter offset for bandmap A and bandmap B
….

Have fun during the contest!
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The User Defined Contest (UDC) Editor
2019-04-18

The User Defined Contest (UDC) Editor
Where to Find UDC Materials
There are more than to 200 User Defined Contests available from the website’s Supported Contests page. The contests are
listed on the Supported Contests List page, described on the Supported Contests Setup page, and available for download in
the >Downloads >User Defined Contests folder.

UDC Editor Overview
Enabling users of a contest logger to define their own contests has always been a very difficult thing to do. With the
proliferation of contests, often with (ahem) innovative rules, it has gotten harder in recent years. Normally, it requires someone
with knowledge of the programming language to create a contest “module”, and even then the rules may defy incorporation.

In an effort to help with this problem, Nick, NA3M has written a very clever User Defined Contest (UDC) module in the Logger.
This module uses a text file in a predefined format, called a User Defined Contest (.udc) file. These files may be created either
with a text editor or with Nick’s UDC Editor program, which can be downloaded from the website’s >User Defined Contests
(UDC) folder.

The description of how to use this editor program is found both here and in the file named _UDC_Help.txt which contains
information in different languages selectable from the UDC File Editor. New features are added to the UDC capability from
time to time, and when this happens the Help file in the UserDefinedContests folder may be more up-to-date than this page in
the manual. The Help file can be opened from the UDC File Editor by clicking its HELP button or by double-clicking a specific
contest parameter line. Notepad will automatically start and display the Help file. Resize windows so you can see both the
UDC Editor window and the Notepad window at the same time. Double-clicking on a parameter is particularly useful
because Notepad then goes directly to that parameter in the Help file. The first time you call for help during an editing
session, you will be asked to select the language. This selection stays in memory until you close the editor. If the wrong
language was selected, you will have to close and restart the UDC Editor.

There are three ways that you can take advantage of the User Defined Contest feature: build your own UDC using the UDC
Editor; use a text editor to build a UDC file, starting from a previous UDC file as a template; or download a UDC that was built
by another ham and contributed to the N1MM Logger+\UserDefinedContests folder.

Regardless of which method you use, the drop-down list of available contests in N1MM Logger+’s Contest Setup dialog will
only list UDCs that have been copied to the UserDefinedContests folder in the N1MM Logger+ user files area
at Documents\N1MM Logger+\UserDefinedContests\.

If you have developed and thoroughly tested a UDC file for a particular contest, please share it with other users by uploading it
to the Files Section of the N1MMLoggerPlus group on groups.io . But please remember – UDC files are USER-defined, and
bug fixes or feature improvements are the responsibility of the user who created the UDC, not the N1MM
Development Team.

The UDC Editor
The UDC Editor is quite simple. Download and unzip the file, _UDCeditor.ZIP, from the >Downloads >User Defined Contests
folder. When you open the Editor you will first be asked to select a User Defined Contest file. You’ll note that these files all

Limitations
While UDC files give a user extensive options for adapting N1MM Logger+ to the rules of many contests, they
cannot provide the same control that a programmer has, or that may be required to fully implement them. Also, in
many contests the rules are different for contestants from one area than for those from another – a good example
is QSO parties with different rules for in-state and out of state participants. In those cases, it may make sense to
create two UDC contests, for use by in-area and out-of-area contestants.
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have the extension “.udc”), and are stored in the UserDefinedContests sub-folder in the N1MM Logger+ user files folder,
at Documents\N1MM Logger+\UserDefinedContests\. You will find a starter UDC file “_Template.udc” on page 1 of the
UDC Gallery.

When you open an existing contest file, you will be warned to do a “Save As…” unless you intend to edit the file you have
opened. This is because any changes are saved immediately to the file you have opened. You have to be careful not to
damage the existing User Defined Contest file that you are going to use as a starting point for your new contest file. Therefore
is is recommended that you save the file with a new name, then use the editor to edit that new file, leaving the original file
unchanged.

Here is an example of a contest created by a user during testing, as viewed in the UDC Editor.
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To change a contest parameter, click once on it. You’ll note that the parameter and its value appear in the gray pane to the
right. Change the value in the Value field. Click on Set Value for Key to save it. This will save it in the file immediately. That is
why the Editor does not have a Save button. When you are done editing a contest just exit, and your contest file will have all
changes saved.

Once the new (or modified) .udc file is ready to test, save it one last time into the Documents\N1MM
Logger+\UserDefinedContests\ folder and start N1MM Logger+. Go to File > New Contest in Database, and you should be
able to see your new contest in the list of available contests. Test it to make sure everything works as you planned. If there is
something wrong, you can edit the .udc file and save it. You can keep .udc file edit window open. To test any changes you will
have to restart N1MM Logger+.

If you want to help with this project and add one more language – simply add your translation to an empty [Language…]
section in the UDC help file and send the file to na3m@arrl.net, Please use UNICODE encoding when saving the file.

Editing Tips

The UDC Editor will not allow you to delete parameter names but you can erase or omit the value in the gray pane, in which
case the default value will be used (these are marked with * in the list of values for each parameter). You should only use
values mentioned below. At the moment, there is no check for correctness of the value supplied for a parameter. An invalid
value for a parameter may cause unpredictable N1MM Logger+ behavior, such as display of warning messages with the name
of the wrong parameter.

By default, the UDC editor does not show “empty” parameters, for which N1MM Logger+ will be using default values. You can
see the full list of parameters by clicking on the “Show Default” check box, and edit them by assigning a non-default value. Do
not attempt to remove “empty” parameters – they may be needed in case this file is later used as a template for another
contest.

Keep your .udc files in the Documents\N1MM Logger+\UserDefinedContests folder. If you define a UDC and store it in the
database, but subsequently remove its .udc file from the folder, then the next time you try to open that contest, a warning
message will be displayed and the contest will not work. You can make editing of UDC files faster by right-clicking on a udc file

3/4/25, 5:37 PM N1MM Logger+ Documentation



643

name, selecting “Open with…”, selecting the UDC Editor and checking the box that says “Always use this program to open
this kind of file”. Subsequently, double-clicking on a .udc file name will automatically open it with the UDC Editor.

Running a User Defined Contest

User defined contests appear in the drop-down list of contests in the Select Contest dialog, just like those programmed at the
factory.

The UDC File
Note: it is not recommended to use any language other than English for contest parameters. Take a look at the sample UDC
files using a text editor, if you want to understand the file format, but we recommend you use the UDC Editor to edit or create
a new file.

File Format with Explanations

This is based on the English-language text from the UDC Editor help file, describing how to configure a User Defined Contest
for N1MM logger. Versions in Portuguese, Spanish, Russian can be found in the _UDC_HELP.txt file that is downloaded with
every Latest Update.

The most convenient way to use this information is to open the _UDC_HELP.txt file from the UDC Editor, by pressing its HELP
button or by double clicking on a contest parameter line. You will be asked to select a language. This selection stays in
memory until you close the Editor. If a language is selected that is not there, you will have to restart the Editor. Assuming you
choose one of the languages that is there, Notepad will automatically start and open the Help file.

It’s best to resize the Notepad window so you can see both the UDC Editor window and the Notepad window at the same
time.

To change a parameter in the UDC Editor, click once on it and change its value in the Value field. Click on Set Value for Key to
save it. This will save it in the file immediately. That is why the UDC Editor does not have a Save button. When you are done
editing, all you have to do is exit, and your contest file will have all your changes saved.

Because of this, if you use an existing UDC file as a starting point for your new one, you will have to be careful not to damage
it. Open it with the UDC Editor, and click the Save File As… button. Give your new contest file a name that positively identifies
it (preferably its short name, like ARRLDXCW).

Once the new (or modified) UDC file is ready, copy it into the N1MM Logger+/UserDefinedContests folder and start the
Logger. You should be
able to see your new contest in the list of contests in the Contest Setup Dialog.. Test it to make sure everything works as you
planned. If there is something wrong – you can keep editing it even while it is loaded in the Logger. Once you make a change
to a parameter of the UDC file simply reload the contest (select “File” and then your contest name in the drop down menu).
Note: this will not work if you change the name of the contest while editing.

If you decide to help with this project and add another language – simply add your translation to an empty section
[Language..] and send the
file to na3m@arrl.net so it can be included in the next update of this program. Note: Be sure to use UNICODE encoding
when saving the file.

The UDC Editor will not allow you to delete parameters, but you can set a parameter to “nothing”. If you do this, the default
value will be used marked with * in this file). You should only use values listed in this file. There is no check for correctness of
the value in this Editor at the moment. A wrong value may cause unpredictable Logger behavior. Some wrong values may
cause Logger to display warning messages with the name of the wrong parameter.

By default, the UDC Editor does not show “empty” parameters. Logger will be using default values for them. You can see them
by clicking on the “Show Default” check box. After that you will be able to edit them by assigning non-default values. Do not
remove “empty” parameters – they may be needed in case this file is used as a template for another contest.

Keep your .UDC files in the Documents\N1MM Logger+\UserDefinedContests folder if you are planning to use contests
defined by those files. If you try to load some previously used (and stored in the current database) User Defined Contest and
the .udc file for it is not in the folder, Logger will not start the contest, and there will be a warning message displayed.

Don’t worry about messing up
One of the nice things about the UDC Editor is that you can’t do much damage if you mess up. The only thing you
are editing is the .udc file, and if it doesn’t work and you can’t fix it, you can always just delete it from the UDC
folder and start over.
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To start the UDC Editor by clicking on a .udc file, right-click on one of them, select “Open with”, “Choose program” and select
“UDCeditor.exe” as the “Recommended Program” for this type of files.

[Author] section

_AuthorName_ = Put your name here. Users should know who will be able to help them with this contest file.

/Callsign/= your callsign

/Email/= your email

[File] section

/Revision/ = Start with 1.0.0 It is recommended that you increment this every time you modify the UDC file.

/LastUpdate/ = Will be automatically filled with the current date if you create a new file (using Save File As…) or edit the
current file.

/Description/ = Short description of the contest type (one line). Example: “Finnish Domestic VHF Contest”

[Contest] section

/Name/ = This is the short name that will be used in the Contest Setup dialog. 10 Characters maximum, no spaces, upper
case only. Example: ARRLDXCW. RTTY contests must have RTTY somewhere in the name; VHF contest names must start
with VHF.

/DisplayName/ = Your choice, spaces allowed (50 characters maximum). Example: ARRL DX CW

/CabrilloName/ = Your choice, 15 characters maximum, no spaces allowed. Example: ARRL- DX-CW This name will be used
in the Cabrillo file header

/Mode/ = Valid modes are: CW SSB BOTH RTTY (default = CW; use BOTH if all modes are allowed in the contest)

/DupeType/ = Dupe-checking parameter for QSOs (not multipliers). Defines what combination of band, mode and callsign
constitute a duplicate entry. Valid values are 1, 2, 3 , 4 – default is 2
1 = All bands (stations may be worked only once in the contest)
2 = Each band (stations may be worked once on each band – default value)
3 = Each band & mode (stations may be worked on each band/mode combination, e.g. 40 SSB, 40 CW, 40 RTTY)
4 = no check (stations may be worked multiple times per band/mode)

Also used in the Multiplier window to show modes (when 2 or 3) in the Section window.

/Multiplier1Name/ = See table below

/Multiplier2Name/ = See table below (or N/A if the contest recognizes only one multiplier type)

/Multiplier3Name/ = See table below (or N/A if the contest recognizes only one multiplier type)

CountryPrefix = Each country is a multiplier Example: DL, PA etc (uses WL_CTY.DAT)
WPXPrefix = Each Prefix is a multiplier
Sect = Each Section is a multiplier (Need a *.sec file loaded with button “Import Section File” in the Contest Selection window.
The MultWindowType below should match the name of .sec file and Type value in the first line of that file). The length of .sec
file name and MultWindowType parameter should not be more than 9 characters.
ZN = Each CQ Zone is a multiplier (max. 40)
MiscText = Each misc. text is a multiplier
Continent = Each continent is a multiplier
GridSquare = Each GridSquare is a multiplier
Comment = Each Comment is a multiplier
N/A = There is NO multiplier (mostly only IsMultiplier2 and/or IsMultiplier3)

/MultSqlString/ = See table below

/MultSqlString2/ = See table below (or N/A if the contest recognizes only one multiplier type)

/MultSqlString3/ = See table below (or N/A if the contest recognizes only one multiplier type)

MultSqlString = CountryPrefix (new country will be counted as multiplier). EU_Country, AS_Country, NA_Country, SA_Country,
AF_Country are allowed to limit multipliers to one continent
MultSqlString = Section (new section will be counted as multiplier)
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MultSqlString = WPXPrefix (new WPXPrefix will be counted as multiplier)
MultSqlString = N/A (no multipliers)
MultSqlString = Grid (new 4 char. GridSquare will be counted as multiplier)
MultSqlString = CallSign (new CallSign will be counted as multiplier). NOTE – uses MiscText to store callsign
MultSqlString = SGrid (new 6 char. GridSquare will be counted as multiplier)
MultSqlString = FirstQSO (first QSO on every band (mode) will be counted as multiplier)
MultSqlString = CallHist (count callsigns in CallHistory file as multiplier), make sure to import proper Call History file and turn
Call History Lookup on.
MultSqlString = Misc (new value in MiscText will be counted as multiplier)
MultSqlString = Exchange (new value in Exchange will be counted as multiplier)
MultSqlString = CQZONE (new CQ Zone will be counted as multiplier)
MultSqlString = IARUZONE (new IARU Zone will be counted as multiplier). MiscText should be used to enter and keep IARU
Zone for every QSO.
MultSqlString = 2LPREFIX (new 2-letter prefix will be counted as multiplier). MiscText will be used to keep 2-letter prefix for
every QSO. Only works with some prefixes in CountMultOnlyFor.
MultSqlString = LASTLETTER (new last callsign letter will be counted as multiplier). MiscText will be used to keep last callsign
letter for every QSO.
MultSqlString = FIELD First two characters of Grid or Locator will be counted as a Multiplier

/Period/ = How many days is the contest (not used at the moment). Options are 1 or 2, currently always 2

/PointsPerContact/ = Default 1. May be any integer.
You can put several parameters in one line. Separate each with a comma: For example OH, 5, SM, 5, MyCountry, 1,
SameContinent, 2, OtherContinent, 3 (will award 5 points for QSOs with OH or SM, 1 point for contacts in your own country,
etc. (NOTE: country prefixes should match those that are in wl_cty.dat file and be the first in line if used)
Another example: SSB, 2, CW, 3, DIGI, 4, RTTY, 4, PSK, 5, FM, 2
(2 points for SSB, 3 points for CW, 4 for RTTY and so on)
And yet another: 160m, 5, 80m, 4, 40m, 3( 5 points for QSO on 160m and so on). In this type of entry, the allowed bands are
160m, 80m, 40m, 20m, 15m, 10m, 6m, 4m, 2m, 1.25m, 70cm, 33cm, 23cm, 13cm, 9cm. The values for this parameter can be
mixed, but if the QSO meets two or more criteria (for example, 160m and OH), then priority order will be: band, mode,
continent, country.
IsMisc, 3 – number of points to give if there is any value in MiscText
IsComment, 4 – number of points to give if there is any value in Comment
NOTE: for VHF contests the numeric value will be used as the multiplier, i.e. KM*multiplier.
Exchange, * – use numeric value entered in Exchange as Points (do not replace *, just use “Exchange, *”)
Misc, * – use numeric value entered in Misc as Points (do not replace *, just use “Misc, *”)
Exch, 3 – if anything in Exchange, give the number of points specified (3 in this example)
ExchIsNum, 4 – if numeric value in Exchange, give the number of points specified
MiscIsNum, 4 – if numeric value in Misc, give the number of points specified
ExchIsNotNum, 5 – if value in Misc is not numeric, give the number of point specified
/P, 5 – if portable station, give the number of points specified (can use /A, /M, /AM, /MM, /QRP, /QRPP as well)
EU, 10 – give the specified number of points (10 in this example) for EU station (can use AF, AS, AN, SA, NA, OC as well)
SectIs_xxx, nnn – xxx is a set of characters (maximum 10) and nnn is the number of points to give (e.g. SectIs_TB, 7 – award
7 points for TB section). NOTE: If there are several parameters for PointsPerContact, SectIs_xxx must come first.

ExchIs_xxx, nnn or ExchIs_xxx, +nnn where xxx is a string of characters (up to 10) and nnn is the number of points to be
allocated if xxx matches what is in Exchange1Text.
MiscIs_xxx, nnn or MiscIs_xxx, +nnn where xxx is a string of characters (up to 10) and nnn is the number of points to be
allocated if xxx matches what is in MiscText.
MyGrid, nnn – give nnn points for Q’s with the same Grid as mine (for VHF/UHF contests only).
For (VHF or not) contests KM distance can be converted into points using table. For example: /PointsPerContact/ = 1/600/10;
601/1200/13; 1201/1800/16; will convert distance from 1 to 600 km into 10 point, from 601 to 1200 km – into 13 points and so
on.
NOTE: use “;” instead of “,” to separate each 3 numbers group from each other. Make sure to put at least one character “;” to
make it work.
MyCQZone, n – if CQ zone is the same as mine give n points (number of points can be different, does not work for VHF
contests)
MyIARUZone, n – if IARU zone is the same as mine give n points (number of points can be different, does not work for VHF
contests)
ExchIs_Empty, nnn or ExchIs_Empty, +nnn where nnn is the number of points (can be 0) to be allocated if Exchange1Text
field is empty. Should be first in line if other arguments for this parameter are used.
ExchIsxxx, nnn or ExchIsxxx, +nnn where xxx is a string of characters (up to 10) and nnn (or +nnn if bonus points should be
added to other points) is the number of points to be allocated if xxx was found in Exchange1Text string of characters.
Example: PointsPerContact = ExchIs*OB, 15; QSO with any station from RDA OB01-OB53 will be awarded with 15 points
SAMECONTINENT+80, n or SAMECONTINENT+40, n – add n points for QSO on 80 or 40m with the same continent
OTHERCONTINENT+80, n or OTHERCONTINENT+40, n – add n points for QSO on 80 or 40m with other continent
MyExchange, nnn – give nnn points for Qs with stations with the same Exchange as mine
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/PointsMultAtTimeLocal/ = 0000, 2359, n
Points for QSOs made from 00:00 to 23:59 LOCAL time will be multiplied by n (default 2). Note: 24 hours format should be
used (no AM or PM) but do not use 24:00, use 23:59 instead.

/PointsMultAtTimeGMT/ = 0000, 2359, n
Points for QSOs made from 00:00 to 23:59 GMT time will be multiplied by n (default 2). Note: 24 hours format should be used
(no AM or PM) but do not use 24:00, use 23:59 instead.

/PointsMultByMode/ = CW, 3, USB, 2, LSB, 2
Points for QSOs made in specific mode will be multiplied by corresponding number. Supported modes are: CW, USB, LSB,
DIGI, RTTY, PSK, FM, AM

/PointsMultByBand/ = 1.8, 4, 3.5, 3, 7, 2 (band1, multiplier1, band2, multiplier2, …)
Points for QSOs made on specific band will be multiplied by corresponding number. Supported bands are: 1.8, 3.5, 7, 14, 21,
28, 50, 70, 144, 222, 420, 902, 1240, 2300, 3300,…
WARC band are also supported.

/PointsMultByContinent/ = MyContinent, 1, OtherContinent, 2
Points for QSOs with specific continent(s) will be multiplied by corresponding number. Supported arguments are:
MyContinent, OtherContinent, AS, AF, EU, SA, NA, OC

/PointsMultByCountry/ = SV5, 3, SV9, 3
Points for QSOs with specific country(s) will be multiplied by corresponding number. Supported arguments are all countries
from wl_cty.dat file

/PointsMultByCategory/ = QRP, 2
Points for QSOs with /QRP or /QRPP stations will be multiplied by corresponding number. Supported arguments are: QRP,
QRPP

/ShowMyCountryStations/ = True(default) or False
True Yes show My Country stations in the bandmap (normal)
False No don’t show them in the bandmap

/ShowWarcBands/ = True or False(default)
True Yes show the WARC bands (only for general logging (DX)
False No don’t show WARC bands (all contests)

/ZoneType/ = CQ(default) or IARU
CQ* CQ type zones should be shown (for most contests)
IARU IARU zones should be shown

/MultWindowType/ = see table below (default is Section)

State = US states
StateProvince = US states and Canadian Provinces are both valid entries
Province = Canadian Provinces (or 13P)
Section = ARRL sections (or 48S14P, 48SDC14P, 49S8P, 50S8P, 50S10P, 50S13P, 50S13PCY0, 50S14P, 50SDC14P,
50SDC10P, 71SEC13WB, 50SDC13P, 50S13RAC, 50S9P, 50S11P, 50SNOLAB, 50S14PNT… see StatesAndProvinces.sec
file for more options)
Provincie = Netherlands Provinces (for PACC Contest)
DOK = DOK letters letters: A to Z not Q for WAG contest
UBA = ON contest
Oblast = Russian oblasts
AnyName = Prepare AnyName.sec file with the list of sections (look at any *.sec for sample). NOTE: This NAME should not be
longer than 9 characters!

/CQZoneMultContest/ = True or False(default)
True Contest uses CQ zones as a second multiplier e.g. CQWW
False It doesn’t! (Mostly)

/NumMults/ = 0, 1 (default), 2 or 3
0 for Field Day or other contests with no multiplier
1 for most contests
2 for CQWW (i.e. Country and Zone)
3 if three multipliers

/BonusPoints/ =
Several bonus callsigns, DXCC entities, /P, /M or /QRP stations are allowed, use comma to separate bonus call from bonus
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points. Leave empty
if no bonus station(s) or countries.
Example: RM1DZ, 20, RA1DZ, 20, DL, 25, /M, 4, /P, 2, /QRP, 5,IsComment,6, IsMult1,10
IsComment, n: give n points if there is anything in the Comment field
IsComment,*: give the number of points in the Comment field (if there are several numbers in the Comment field, only the first
one will be used)
If IsMult1(2,3) is used it will work for all QSOs except the last one in the log. The last QSO in the log will give BonusPoints
after manual rescore only.
ExchIs_xxx, nnn where xxx is a string of characters (up to 10) to be matched from the Exch field and nnn is the number of
points to be allocated.
MiscIs_xxx, nnn where xxx is a string of characters (up to 10) to be matched from the Misc field and nnn is the number of
points to be allocated.
NOTE: During final points calculation if BonusPoints are not 0 then PointsPerContact value will be ignored.
If you would like bonus points to be added to PointsPerContact add “+” character in front of the value like this: BonusPoints
=F, +25, F4GVZ, +105, IsComment, +10, IsMult1, +50.
If you would like bonus points to be multiplied by some factor, add “*” character in front of the value
To add points from the Comment field to PointsPerContact, use IsComment, +*; to add points from ExchIs, use ExchIs, +nnn.
To multiply points from the Comment field by PointsPerContact, use IsComment, ** .

If IsMult1(2,3) is used it will work for all QSOs except the last one in the log. The last QSO in the log will give BonusPoints
after manual rescore only.
ExchIs_xxx, nnn or ExchIs_xxx, +nnn where xxx is a string of characters (up to 10) and nnn (or +nnn if bonus points should be
added to other points) is the number of points to be allocated if xxx matches what is in Exchange1Text.
MiscIs_xxx, nnn or MiscIs_xxx, +nnn where xxx is a string of characters (up to 10) and nnn (or +nnn if bonus points should be
added to other points) is the number of points to be allocated if xxx matches what is in MiscText
ExchIsNum, n or ExchIsNum, +n – give n (or +n) points if there is any numeric value in Exchange1.
ExchIsNotNum, n or ExchIsNotNum, +n – give n (or +n) points if there is not numeric value in Exchange1.
ExchIs_Empty, nnn or ExchIs_Empty, +nnn where nnn is the number of points to be allocated (can be 0) if Exchange1Text
field is empty. Should be first in line if other arguments for this parameter are used.
Modes can be used in this parameter: for example SSB, +2, CW, +3, DIGI, +4, RTTY, +10, PSK, +5, AM, +3, FM, +4
ExchIsxxx, nnn or ExchIsxxx, +nnn where xxx is a string of characters (up to 10) and nnn (or +nnn if bonus points should be
added to other points) is the number of points to be allocated if xxx was found in Exchange1Text string of characters.
Example: PointsPerContact = ExchIs*OB, 15; QSO with any station from RDA OB01-OB53 will be awarded with 15 points

/BonusPoints2/ = points, filename
This allows using a file with a number of Callsigns that give bonus points.
Parameter format: BonusPoints2 = 5, BonusPoints.txt (points, file name). Filename can be any name with the extension *.txt
but the file must be in the main Logger folder. Every callsign in the file should have a comma at the end, including the last one:

< file starts >
Call1,
Call2,
Call3,
…,
LastCall,
< file ends >

or

< file starts > Call1, Call2, Call3, … LastCall, < file ends >

BonusPoints2 extends BonusPoints but has higher priority. In other words, if the callsign is found in the BonusPoints string
and also in the file
BonusPoints.txt, then the bonus point assigned for BonuPoints2 will be used. If you would like bonus points to be added to
PointsPerContact add “+” character in front of the value like this: /BonusPoints2/ = +5, BonusPoints.txt

To give specific number of points for the grid use BonusPoints2 = (+)1, Grids.txt. File Grids.txt should be placed into
C:\Users{user}\Documents\N1MM Logger+\SupportFiles folder and it should have one or several lines of text:

Grid1, points1
Grid2, points2
Grid3, points3
…

NOTE: Grid1, Grid2, Grid3… – 4-letter GridSquare.
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/DoNotCountMeAsMult/ = True or False (default)
True Do not count Multiplier1 for my Country, Section or WPX prefix (depends on what was set as MultSqlString)
False Count Multiplier1 for my Country, Section or WPX prefix.

/DoNotCountMeAsMult2/= True or False (default)
True Do not count Multiplier2 for my Country, Section or WPX prefix (depends on what was set as MultSqlString2)
False Count Multiplier2 for my Country, Section or WPX prefix.

/DoNotCountMeAsMult3/= True or False (default)
True Do not count Multiplier3 for my Country, Section or WPX prefix (depends on what was set as MultSqlString3)
False Count Multiplier3 for my Country, Section or WPX prefix.

/CountMultOnlyFor/ =
Default value is empty. Set it to one or several countries from the wl_cty.dat file to make the multiplier work for those countries
only.
Example: CountMultOnlyFor =G, GW, GM, GI, GD, GU, GJ. Do not use too many countries here – it may stop working if the
line is too long and also will slow down the computer .

/CountMultOnlyFor2/ =
Same as for /CountMultOnlyFor/ but will be applied for Multiplier2

/CountMultOnlyFor3/ =
Same as for /CountMultOnlyFor/ but will be applied for Multiplier3

/DoNotCountMultOnlyFor/ =
Default value is empty. Set it to one or several countries from the wl_cty.dat file to make the multiplier not work for those
countries only. Example: DoNotCountMultOnlyFor =G, GW, GM, GI, GD, GU, GJ. DO not use too many countries here – it
may stop working if the line is too long and also will slow down the computer.

You can also use continents abbreviations (NA, SA, EU, AF, OC, AS)

/DoNotCountMultOnlyFor2/ =
Same as for /DoNotCountMultOnlyFor/ but will be applied for Multiplier2

/DoNotCountMultOnlyFor3/ =
Same as for /DoNotCountMultOnlyFor/ but will be applied for Multiplier3

/CountMultOnlyForSec/ =
Default value is empty. Set it to one or several sections from the .sec file to make the multiplier work for those sections only.
Example: CountMultOnlyForSec = MA, MO. Do not use too many sections here – it may stop working if the line is too long
and also will slow down the computer.

/CountMultOnlyForSec2/ =
Same as for /CountMultOnlyForSec/ but will be applied for Multiplier2

/CountMultOnlyForSec3/ =
Same as for /CountMultOnlyForSec/ but will be applied for Multiplier3

/MultiplierBands/ = 1 (default), 2, 3 or 4
1 All HF Contest Bands
2 All HF Bands
3 All HF Contest Bands plus 6 meters and 2 meters
4 All VHF Bands

/QsoErrorString/ = The exchange field will be checked according to this setting before logging QSO
Numeric – only numbers allowed (like serial number) 12 characters max, empty field will be accepted.
Numeric_not_Empty – as above, but empty field will not be accepted.
Any – both numbers and letters allowed (12 characters max), empty field will be accepted.
Any_not_Empty – as above, but empty field will not be accepted.

NOTE: The above properties apply only to the fields EXCHANGE1TEXT, MISCTEXT, COMMENTTEXT and
NAMETEXT. 

Note2: for RcvNrText only “Any_Not_Empty” or “Any” can be used
For more flexibility you can put more than one value (separated with comma !) like this: Exchange1Text_Any_not_Empty,
CommentText_Any, MiscText_Numeric …
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Grid – Grid Square Text, 4 or 6 characters, empty field will not be accepted.
If none of the above, put in some text (“XXXX” for example) in order that only exchanges listed in XXXX.sec file will be
accepted (maximum of 9 characters in XXXX).
Add _or_Empty (e.g. Sect_or_Empty) to allow empty fields as well as exchanges listed in the .sec file.
If this parameter is left empty, then do not check (anything including empty field will be accepted, 12 characters max)

/EntryWindowInfo/ = List of EntryWindow items from the table below, each followed by a number indicating the field width

Example: SNTText, 500, SntNrText, 700, RCVText, 500, Exchange1Text, 500

The following table shows possible EntryWindow Items, followed by the width normally used.

Name Width Max.Length Comment
SNTText 450 10 Sent exchange field
RCVText 450 15 Received exchange field (default 59 or 599)
NameText 855 20 Name field, only letters allowed
CommentText 1695 60 Comment field, space allowed so SPACE as tab does not work here!!
SntNrText 625 5 Sent following number field, autonumber by program
RcvNrText 625 5 Received following number field, only numbers are allowed!!
Exchange1Text 615 12 Exchange field, both numbers and letters allowed. (Must be used for Section, recommended for Zone,
see note for FrameText below)
GridSquareText 600 6 textbox for Grid squares
MiscText 600 15 Misc. textbox
SectText 600 15 Sect. textbox

/FrameText/ = SntRpt SntNR RcvRpt NR
These are the names displayed on top of each field of Entry Window, except for the callsign. Adjust the field names and
spacing for the frame text by adding/deleting spaces in this line. Any names allowed.

Note: If you would like to prefill proper zone from wl_cty.dat file (it will show up in Exchange1Text field), use “CQ” or “IARU” in
the ZoneType parameter (example: ZoneType =CQ) and put “CQZone” or “IARUZone” in FrameText (example: FrameText
=SntRST RcvRST CQZone).

/LogInfo/ = List of Log Window items from the list below, each followed by a number indicating the field width

SentReport, SentNR, ReceiveReport, NR, IsMultiplier1, IsMultiplier2, CountryPrefix, GridSquare, Exchange1, MiscText,
Points, opname, Comment, SectionText

Example: SentReport, 500, SentNR, 500, ReceiveReport, 500, NR, 500, Points, 500

Comment: adjust the field names and spacing for the log window by adding/deleting relevant name and length (only names in
the list are allowed)

/DefaultContestExchange/ = (default is 001)
This will show up in the contest selection window for editing. It may have two or three parts like this: “001 Prov”, “001 NA123”.
If the first part is 001 the logger will generate a serial number for every QSO and the second part will be sent by F2 with the
number unchanged

Last2L – to set sent exchange = RS(T) + Last 2 letters of previous call (anything after “/” will be ignored). Use {SENTRST} in
F2 macro to send RST and last 2 letters. Add GridSquareText in EntryWindowInfo parameter to display RS(T) + Last 2 letters
on the screen (may be useful in SSB mode). Note: {SENTRSTCUT} will not send cut numbers in RST when using this
exchange.
LastCallSuff – to set sent exchange = RS(T) + suffix of previous call (anything after “/” will be ignored). Use {SENTRST} in F2
macro to send RST and suffix of previous call. Do not use GridSquareText in EntryWindowInfo parameter to display suffix on
the screen , as this will break ESM. Note: {SENTRSTCUT} will not send cut numbers in RST when using this exchange.

Do not add GridSquareText in EntryWindowInfo parameter to display suffix on the screen – this will break ESM.
it can be combined with serial number, i.e. DefaultContestExchange = 001 LastCallSuff can be used; DO NOT use {EXCH} in
Macro files.

/IsWorkable/ = choose from list below (default is Any)
Any, MyContinentOnly, NAonly, SAonly, EUonly, ASIAonly, AFonly, OConly, MyCountryOnly, ExceptMyCountry, or a list of
countries (prefixes from wl_cty.dat file) separated by comma: UA2, UA, UA9. In the last case make sure you are using correct
prefixes

/SpecialInstructions/ =
Special Instructions. Any text terminated by CR/LF This message will show up after Cabrillo file was generated – use
it for a note to the operator. Leave it empty if not needed.
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/DupeSqlString/ = 0(default), 1, 2, 3 or 4
Select clause that will uniquely identify a dupe:
0- turns it off,
1 – use Section,
2 – use whatever is in ExchangeText,
3- use mode (this will allow QSO with same station but different modes (CW, SSB, FM, AM)
4- use GridSquare; This is needed for qso parties where you can have mobile stations in different counties.

/StartOfContest/ = see below
Example 7, 1.5
First number – day of week (Saturday=1, Sunday=2, Monday=3,….., Friday=7) Second number – offset in hours (1.5 = 1 hour
and 30 minutes) relative to GMT time, i.e. if it starts at 00.00 GMT the offset should be 0. This will be used to calculate OFF
times.

/EndOfContest/ = 1, 1.5 Same format as for StartOfContest. This will be used to calculate OFF times

/IsMultPer/ = 0(default), 1, 2, 3 or 4
0 NoMults
1 OncePerBand
2 OncePerMode
3 OncePerBandAndMode
4 OncePerContest

/IsMult1Per/ = as above, but affects Multiplier 1 only
/IsMult2Per/ = as above, but affects Multiplier 2 only
/IsMult3Per/ = as above, but affects Multiplier 3 only

/MinimumOffTime/ = Min. Off time in minutes (default = 30)

/UsesWAECountries/ = True or False (default)
Answer whether this contest uses the WAE countries list (countries with ‘*’ in cty.dat). For example, for CQWW it should be
True

/SetSentTimeForContact/ = True or False (default)
Used to set Sent Time in contests that require it. See CBARGT for use

/ScoreSummaryMultNames/ = Sec, Cty or Grd
Used to set title of Mult column in Score Summary

/WebAddress/ = Web address for the contest rules (CURRENTLY NOT WORKING)
Example: http://www.srr.ru/CONTEST/cup_raem_engl_08.php

/CabrilloFormat/ = 0, 1(default), 2, 3, 4, 5 or 99
0 = Cabrillo is not supported
1= standard format
2 = NAQP format
3 = NASPRINT format
4 = SS (Sweepstakes) format
5 = RFC (Russian Federation Cup) format
99 = handcoded, uses CabrilloString (see below)

/CabrilloString/ =
Format: value1 name, value1 width, value2 name, value2 width, …
Will work with: SNT, SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, Name, SentExch, SentExchPart1,
SentExchPart2, SentExchPart3
Example: SNT, 4, SentNr, 4, CallSign, 13, RCV, 4, RcvNr, 4, Comment, 40

To add some number of spaces use Space, N (N – number of spaces)

/GenericPrintString/ = This will configure Generic file output that can be used instead of Cabrillo.
Format: value1 name, value1 width, value2 name, value2 width, …
Will work with: SNT, SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, Name, Points, SentExch,
SentExchPart1, SentExchPart2, SentExchPart3, Multiplier1, Multiplier2, Multiplier3.
Example: SNT, 4, SentNr, 0, CallSign, 15, RCV, 4, RcvNr, 0, Comment, 12

/GenericPrintStringHeader/ = header text
Adjust the names and number of spaces here according to the values in GenericPrintString (above)
Example: Date Time Freq Mode MyCall RST Snt Call RST Rcvd Comment
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/QsoNumbersByBand/ = 0(default), 1 or 2
0 = Use a single sequence of QSO numbers (default)
1 = QSO Numbers by Band for all categories
2 = QSO Numbers by Band for Multi-Multi category only

/DigitalModeSqlString/ = True or False(default)
True Used to merge RTTY and PSK into one digital contest mode

/MultipleSessions/ = multiple session information
Leave it empty if the contest time is not broken into sessions
Examples: 0000/30 – starting at 00:00 UTC, sessions = 30 minutes 0000/60 – starting at 00:00 UTC, sessions = 60 minutes
0000/200 – starting at 00:00 UTC, sessions = 2.00 hours It is OK to use 0000 for contest start time if it starts in the beginning
of any other hour and sessions are less than or equal to 60 minutes. Dupes will be allowed when new session starts. Dupes
will be allowed when new session starts and the Multiplier window will be cleared upon first contact in the new session.
Minimum session length is 10 minutes.

NOTE: TOUR command – A very few contests allow for multiple sessions in which you can work the same station in every
session for QSO credit.
You can enter TOUR into the Entry window in place of a call sign to reset dupe checking at any time before or during the
contest.
This command has 2 required parameters that are entered into the Sent RST field, separated by a forward slash “/”. The first
parameter is the time when the current session begins (GMT)
and the second parameter is the duration of the session. The format for both parameters is hhmm. For example, 1200/30
means the session starts at 1200Z and has a duration of 30 minutes.
The minimum value for the duration parameter is 5 (5 minutes). If the TOUR command is entered without any parameters, the
current values of the start time and duration will be displayed.
The default values are 0000/00. At the beginning of each session the start time and duration will be displayed in the status
field at the bottom of the Entry Window.
After the first QSO has been logged during the new session you should see the Multiplier window reset and dupes will be
reset for this new session as well.
Most of the contests supported by the Logger do not need this command but some (mostly Russian and Ukrainian) have it
built into the contest module and do not require it entered manually.
If you are planning on using TOUR command with other contests, keep in mind that settings for it will be lost when the Logger
is restarted.
If the Snt (sent RST) field is not displayed in the Entry window, you should be able to use MiscText, Exchange1Text,
SectionText and NameText fields in EW.

/ResetMultsEverySession/ = 0 (default) or 1
When MultipleSessions is used, this parameter will allow multipliers to be reset in the beginning of every new time session, if
set to 1.

/ResetSNEverySession/ = 0 (default) or 1
When MultipleSessions is used, this parameter will allow serial numbers to be reset in the beginning of every new time
session, if set to 1.

/CabrilloVersion/ = 2.0 (default) or 3.0
When set to 3.0 the log file will be saved using version 3.0 of Cabrillo format. Also new fields will show up in the contest
configuration window. Any other value or if left empty will turn on Cabrillo version 2.0

/MultMult/ = 0 or 1(default)

/MultMult2/ = 0 or 1(default)

/MultMult3/ = 0 or 1(default)

When any of these 3 values is changed to 0, the multiplier will not be used for score calculation. This is useful when you need
to use multipliers for display purposes only (Band Maps and Available windows).

/BandChangesPerPeriod/ = limit on number of band changes per session (default 10000)
–THIS IS NO LONGER USED. REPLACE IT WITH NEW PARAMS FOR BAND CHANGE TIMER/COUNTER LISTED
BELOW –
When set to a smaller number (for example 5) there will be a reminder at the bottom of Entry Window about number of band
changes approaching the limit. Also at any time you can check how many band changes were already made if you move
cursor over the Exchange frame (located to the right of the Callsign frame). Internal BandChange counter gets reset in the
beginning of every time period set by /MultipleSessions/ parameter. Setting the /MultipleSessions/ parameter is not required
for this parameter to work. In this case the whole contest time will be used to count band changes. Note: the internal band
change counter gets reset every time the logger restarts.
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/SingleOpCountableBandChange/ = True or False (default)
If set to TRUE Band Change Counter in the Info window will be enabled for Single Op categories.

/MultiOpCountableBandChange/ = True or False (default)
If set to TRUE Band Change Counter in the Info window will be enabled for Multi Op categories.

/CountBandOrModeChange/ = True or False (default)
If set to TRUE Band Change Counter in the Info window will be counting both band and mode changes.

/SOBandChangeCountMax/ = Number of band changes allowed for Single Op categories (default 0 = no limit imposed).
If CountBandChangesPerContest or CountBandChangesPerPeriod are not set to TRUE, band changes will be counated per
clock hour.

/MOBandChangeCountMax/ = Number of band changes allowed for Multi Op categories (default 0 = no limit imposed).
If CountBandChangesPerContest or CountBandChangesPerPeriod are not set to TRUE, band changes will be counted per
clock hour.

/CountBandChangesPerContest/ = True or False (default)
If set to TRUE Band Change Counter will never be reset during the whole contest time.

/CountBandChangesPerPeriod/ = True or False (default)
If set to TRUE Band Change Counter will be reset for every contest period/session (see MultipleSessions parameter).

/SOBandChangeTimerDuration/ = Number of minutes Single Op station must stay on a new band (default 0 = no time limit).
If >0, band change timer will show up in Info window.

/MOBandChangeTimerDuration/ = Number of minutes Multi Op station must stay on a new band (default 0 = no time limit).
If >0, band change timer will show up in Info window.

NOTE: Counter will show up in Info window only if xxxxCountableBandChange param is set to true AND
xxBandChangeCountMax is set a value > 0.
Timer will show up in Info window when it is set to a value > 0.To see a new value in the Counter or Timer you should make a
QSO on the new band, that is how both Counter and Timer are getting initiated. The Timer will count down to tell operator how
much time he/she will have to stay on this new band and Counter will count all band changes changing it’s background color
based on its value (if it is max-1, it will be yellow and if it is = max, it will be red).

/UsesLASTEXCHmacro/ = True or False (default False)
Answer whether this contest uses {LASTEXCH} in .mc files (it should be True if you are planning to use macro {LASTEXCH}).
Note: use MiscText in the Entry Window for received exchange, and LastExch with Misc in the CabrilloString (see
FRN_CN_US.udc as an example)

/DupeQSOMinutesAgo/ = AllowableTime, CompareToSecond, IgnoreBand, InfoStatus, ThisMode (example:
DupeQSOMinutesAgo = 10, True, False, True, False)

AllowableTime (number), QSO with the same station is allowed after this amount of minutes (0 will disable this UDC
parameter)
CompareToSecond (default = True), if set to False compute time since last QSO based on minutes discarding seconds.
IgnoreBand (default = False), if set to True search for a Dupe QSO regadless of the band.
InfoStatus (default = True), if set to True the attemp to make a QSO too early will display this message in the Info window:
“CallSign worked nn minutes ago”.
ThisMode (default = False), if set to False search for a Dupe QSO regadless of the mode.
Note: /DupeType/ should be set to 4 to get this parameter working properly. Spots in the BandMaps are scanned every 30
seconds to repaint Callsigns (change Grey color to Blue or Red) is station can be worked again.

/PowerMult/ = QRPP, 5, QRP, 3, LP, 2, HP, 1 (this is an example, numbers can be different)

Multiplies the score by specified multiplier depending on the station power category selected in the contest configuration
window.

/OverlayCategory/ = “”*

Adds non-standard name to Overlay category to drop-down menu in the contest setup window.

/SelfSpotAllowed/ = False

This parameter allows using {SPOTME} macro in UDCs when set to True
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Third Party Software
2019-03-29

Third Party Software
All programs below are freeware programs, except as noted.

Stream Deck
A Stream Deck is a customizable control device sold by Elgato designed to streamline workflows for content creators,
streamers, and other professionals. It features a grid of physical buttons, each of which has an LCD screen underneath. The
screens can display custom icons and labels, and the buttons can be programmed to perform a wide variety of tasks. These
buttons can be used with N1MM+ to simulate key presses, send commands to connected radios and automate keystroke
sequences.

Key Features of Stream Deck:

1. Customizable Buttons:
Each button can launch applications, execute commands, or control software (e.g., starting/stopping streams,
switching scenes, or adjusting audio in OBS Studio).
You can assign multiple functions to a single button, including macros and multi-step actions.

2. LCD Screens:
The buttons have small, bright LCD screens that display custom images or icons, making it easy to identify their
function.

3. Profiles and Folders:
You can set up different profiles for specific workflows or applications.
Folders allow one button to access multiple submenus, expanding functionality.

4. Stream Decks come in different models with varying numbers of buttons (e.g., Mini, Standard, XL) and knobs to suit
different needs.

5. In the samples below, I pinned “Main” across all pages to implement a two level menu structure where “Main” returns
you to the first screen shown. You pin by right clicking on a button and choosing “Pin”
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Sample Screens from a Stream Deck
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Recommended plugins for Stream Deck and how to use them:

Command Sender – with command sender you can send data directly to N1MM+ port 13064 via UDP. XML is used to
format the command and Key Mapping functionality can be used to perform multiple keystrokes & macros for a Stream
Deck button press. e.g.
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The ip address is usually set to 127.0.0.1 which is the address of the local machine. You can also set it to another ip address
running N1MM+. In the case of a computer on your LAN, this would be something like 192.168.1.43 – this ip address can be
found by running ipconfig in a cmd prompt on the target machine. You could also send it to a remote computer by opening a
port on the remote router to allow 13064 UDP messages through, or by mapping another port to 13064. There is no security
provided when you do this, so don’t leave it open all the time, or find a way to secure remote connections.

The command format is: <RCmd Cmd=”xxx” Nr=”n”></RCmd>

xxx is the payload for the command. It can be text to send in CW or digi, a macro (like in the screen shot above), or a string
preceded by KeyMap that will be interpreted using the rules for N1MM+ Key Mapping.

n is the Entry Window number – 0, 1 or 2, that you want to process the command. 0 will send the command to the Entry
Window that is in focus. If Nr is omitted, it will default to 0.

Using Command Sender is more complex than using an Stream Deck Hotkey, but does not require N1MM+ to be in focus.
Many commands that you send to N1MM+ will bring N1MM+ into focus, saving you from needing to use multi-access hotkeys.

Examples:
<RCmd Cmd=”KeyMap N1MM” Nr=”1″></RCmd> Send the literal string “N1MM”
<RCmd Cmd=”KeyMap F4″ Nr=”1″></RCmd> Press the F4 key sending its contents
<RCmd Cmd=”{F4}” Nr=”1″></RCmd> Interpret the macro {F4} sending the F4 key contents
<RCmd Cmd=”KeyMap Alt+J”></RCmd> Turn the rotor to the location of the call in the callsign textbox of the
EW in focus
<RCmd Cmd=”KeyMap Alt+W” Nr=”1″></RCmd> Wipe the callsign textbox via a keymap
<RCmd Cmd=”{wipe}” Nr=”1″></RCmd> Wipe the callsign using a macro
<RCmd Cmd=”CQ de N1MM”></RCmd> Send cq on radio of the EW with focus

Super Macro – I haven’t used this much, but looks like it has potential for more complex actions including displaying
the clipboard, reading files, and updating button text.

Touch Portal

Stream Deck vs. Touch Portal: A Comparison

Both Stream Deck and Touch Portal (touch-portal.com) are tools designed to enhance workflows for streamers, content
creators, and other professionals and both can be used with N1MM+. While they share similar functionality, they differ in form,
cost, and user experience.
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1. Hardware vs. Software

Stream Deck:
A physical device with tactile buttons. It is thus more suitable for local control of functions like function keys for
messages.
Each button is an LCD screen that can display customizable icons.
Models with different button counts (Mini, Standard, XL).
Requires a USB connection to a PC or Mac.

Touch Portal:
A software-based solution that turns a smartphone, tablet, or other touch devices into a customizable control
panel.
No physical buttons; it relies on a touchscreen interface.
Available as an app for Android and iOS. This makes it much more portable than a Stream Deck, since you can
operate it from your smartphone.
Wi-Fi or USB connection is required for operation.

2. Cost

Stream Deck:
Higher upfront cost for the hardware.
Prices vary based on the model (e.g., Mini is cheaper; XL is the most expensive).
No ongoing subscription costs.

Touch Portal:
Significantly cheaper since it uses existing devices (smartphone or tablet).
Free version available with limited features.
Pro version (one-time purchase) unlocks advanced features, such as unlimited buttons and deeper integrations.

3. User Interface and Customization

Stream Deck:
Physical, tactile buttons provide navigation without looking.
Buttons are backlit LCDs with dynamic, customizable icons.
Supports folders and profiles for organizing commands.

Touch Portal:
Fully customizable touchscreen grid; the layout is limited only by the screen size.
Custom buttons can include images, text, and animations.
Offers flexibility in arranging buttons and adjusting layouts dynamically.

AutoHotKey – AHK

Description

(Consider using built in Key Mapping capability – Key Assignments – Key Mapping rather than AHK)

Autohotkey is extraordinarily powerful scripting and keyboard remapping freeware. You can remap keyboard, joystick, and
mouse and run simple or very complex multi-step scripts. Virtually any key, button, or combination can become a hotkey.

AutoHotKey has no detectable performance impact on the operation of N1MM Logger+.

Once you have AutoHotkey installed, you create a script file in Notepad, name it with an .ahk extension, and double-click it.
Windows knows that you want to run AHK, so an AHK logo for the script will appear in the system tray, and stay there until you
actually exit from it. You can edit the script, read the help file, and reload the script from right-clicks on that logo. Each time
you edit the script you need to reload it – also through the right-click on the logo.

Examples

Any of the following scripts can be copied verbatim and pasted into Notepad, then modified or saved with a new filename and
an .ahk suffix.

Consider using KeyMapper instead of AHK
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Simple key remapping

NumpadEnter::F10 ;Remap the number pad Enter key to F10

Using one key to send any multi-key combination

#UseHook
#SingleInstance force
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is active. This works because the word
Spot occurs only in that window.
SetNumlockState, AlwaysOn
Numpad7::Send !{F9} ; Numeric key 7 – toggle antennas for a band
Numpad4::Send ^b ; Numeric key 4 – toggle dueling CQs
Numpad9::Send !r ; Numeric key 9 – toggle repeat CQs
Numpad5::Send ^{F1} ; Numeric key 5 – send CQ on radio that does not have entry focus
Numpad6::Send !w ; Numeric key 6 – wipe
Numpad0::Send {ESC}\“ ; Numeric key 0 – return from S&P to work station calling on run radio
Numpad1::Send \“; Numeric key 1 – go back to S&P on opposite radio

Using one key to send multiple keys at the same time

Numpad1:: ; Pressing number pad 1 invokes F5 and Pause
Send {F5}
Send {Pause}
return

Add more functionality to an existing key

$Pause:: ;Changes the Pause key to first do F5, then do the N1MM Pause key function. The $ keeps the script from calling
itself.
Send {F5}
Send {Pause}
return

For SO2R, place a call in the inactive radio EntryWindow, emulating the TRLog Alt-D function

!d:: ;Alt-D
InputBox call
Send {\}
Send ^w
Sleep 200
Send %call%
Send {\}
return

Automate some of your hotkeys or other actions within the program

For example, to activate either EntryWindow, you can use these expressions:
WinActivate, ahk_exe N1MMLogger.net.exe, EntryWindow1
WinActivate, ahk_exe N1MMLogger.net.exe, EntryWindow2

Activate and set focus to N1MM+ if it is currently running

AHK is a complex but powerful key mapping facility. N1MM+ has recently added KeyMapper capability that handles
most users needs for mapping. Try it first before using AHK.

N1MM+ Key Mapping



Special Characters in AutoHotKey Definitions

Text after a semicolon is comments, and is not executed. The symbol “^” denotes the [Ctrl] key, and “!” denotes the
[Alt] key. When one of those symbols is combined with a key (such as ^i), the effect is to send Ctrl+i (i.e., both keys
pressed simultaneously). See the AutoHotKey help file and tutorials for further details.
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#UseHook
#SingleInstance force ; Force this script to replace the currently running script
SetTitleMatchMode, 2 ; Match on partial text like VFO and EntryWindow below
#IfWinExist VFO ,EntryWindow ; Is N1MM+ running?
{
#WinActivateForce
ScrollLock::
WinActivate , ahk_exe N1MMRotor.Net.exe
WinRestore, ahk_exe N1MMLogger.Net.exe
WinActivate , ahk_exe N1MMLogger.Net.exe
winset, Top , , ahk_exe N1MMLogger.Net.exe
winset, Bottom , , ahk_exe N1MMLogger.Net.exe, EntryWindow1
winset, Top , , ahk_exe N1MMLogger.Net.exe, EntryWindow1
WinActivate , ahk_exe N1MMLogger.Net.exe
WinActivate , ahk_exe N1MMLogger.Net.exe, EntryWindow1
return
}

ScrollLock::WinActivate ; Yes. Activate the last used Entry Window

Set the numeric pad 8 & 2 keys to jump multipliers in the bandmap (normally a 3-finger combination)

#SingleInstance force ; Force this script to replace the last one, not append
SetNumlockState, AlwaysOn
#ifWinActive,,S&pot It ; Look for the spot button on the entry window to see if entry window has focus
Numpad8::sendinput, !^{up}
Numpad2::sendinput, !^{down}

Using single keys to grab multipliers on VFO A and B

#UseHook
#SingleInstance force
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is active. This works because the word
Spot occurs only in that window.
SetNumlockState, AlwaysOn
Numpad7::Send ^!{Up} ; Numeric key 7 – VFO A Go to next multiplier up the bandmap
Numpad1::Send ^!{Down} ; Numeric key 1 – VFO A Go to next multiplier down the bandmap
Numpad9::Send ^!{Up} ; Numeric key 9 – VFO B Go to next multiplier up the bandmap
Numpad3::Send ^!{Down} ; Numeric key 3 – VFO B Go to next multiplier down the bandmap

Press a Bandmap Button via Numeric Keyboard (good for additional cw messages)

#UseHook
#SingleInstance force
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is active. This works because the word
Spot occurs only in that window.
SetNumlockState, AlwaysOn

NumPad0::Send ^+!0
NumPad1::Send ^+!1
NumPad2::Send ^+!2
NumPad3::Send ^+!3
NumPad4::Send ^+!4
NumPad5::Send ^+!5
NumPad6::Send ^+!6
NumPad7::Send ^+!7
NumPad8::Send ^+!8
NumPad9::Send ^+!9

Send a canned CW message from a non-Fkey

#UseHook
#SingleInstance force
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is active. This works because the word
Spot occurs only in that window.
SetNumlockState, AlwaysOn
Numpad1::Send ^k testing?^k ; Send a CW message from a designated hotkey (Numeric key 1 in the example).You’ll see the
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Ctrl+K keyboard window appear and quickly disappear, but the CW continues to be sent until it is done (unless you hit ESC to
interrupt it)

Tune your radio’s VFO with the mouse wheel

Script written by K8UT, with revisions by KU1T

;next two lines are for testing the definition. uncomment them to make them work
;WheelDown::MsgBox You turned the wheel DOWN
;WheelUP::MsgBox You turned the wheel UP

;This script works, but you lose the Bandmap zoom mouse wheel feature. Use the keypad + and – keys instead

#UseHook
#SingleInstance force
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is active. This works because the word
Spot occurs only in that window.
SetNumlockState, AlwaysOn

Numpad9::Send {Up} ; Numeric key 9 – toggle repeat CQs

;— x10 large frequency shift – hold down Left Shift, numeric pad 9 = 10 keypresses
LShift & Numpad9::Send {Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}

Numpad6::Send !w ; Numeric key 6 – wipe

Numpad3::Send {Down} ;

;— x10 large frequency shift – hold down Left Shift button, Numeric pad 3 = 10 keypresses
LShift & Numpad3:: Send {Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down}

;and finally wheel works
WheelUp::Send {Up} ; spin wheel forward, frequency moves UP
WheelDown::Send {Down} ; spin wheel backward, frequency moves DOWN
;— x10 large frequency shift – hold Left SHift button, spin wheel = 10 keypresses
LShift & WheelUp::Send {Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up} ;
LShift & WheelDown:: Send {Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down} ;

Use extra mouse buttons for common keystrokes

; Special keys using the Microsoft model 1007 mouse which has two additional aux buttons
; Send N1MM common keystrokes from the mouse
; Facilitates RTTY operation entirely from the mouse
MButton:: Send {Enter} ; press wheel sends [Enter] for ESM
XButton1:: Send {Enter} ; press wheel sends [Enter] for ESM
XButton2:: Send {Esc} ; aux mouse button2 sends [Escape]
Return

PowerToys
PowerToys from Microsoft has some of the features of AHK, but is easier to set up, but less capable. If you have simple
keystroke mapping requirements, this might be a better solution. It is able to restrict its mapping to a single program. For use
with N1MM+, specify N1MMLogger.net.exe as the application.

Download at: https://learn.microsoft.com/en-us/windows/powertoys/install

(Consider using built in Key Mapping capability – Key Assignments – Key Mapping rather than PowerToys)

CC User (formerly AR Cluster User)
CC User by Lee, VE7CC is a full featured Telnet and TNC program for use with AR Cluster, CC cluster or DX Spider Nodes.
It has telnet and RS-232 outputs for logging and contest programs like N1MM logger. Runs under Windows 95 to Windows 8
and can auto reconnect and automatically gets missed spots. It can be used with telnet and TNC’s.
The program can receive spots both in connected and unconnected modes, this means it also recognizes spots when NOT
connected to any packet node, just monitoring the RF channel where other users are receiving spots is good enough.
CC User greatly simplifies the process of setting up spot filters at the cluster node.
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Setting up CC User with N1MM logger

Settings CC User
Connect to your packet node with CC User
Go to Configuration – Ports/Logger Program
Check “Telnet” Logging Program Connection, Apply for both the Node Connection and the Logging Program
Connection

Open N1MM Logger
Open the Telnet window, click on the Clusters tab and look at the pulldown list of cluster nodes for CC User, (or
LocalHost or 127.0.0.1)

If there isn’t already an entry, add CC User
Use 127.0.0.1:7300 if CC User and N1MM are on the same computer
Check the CC User website for instructions on using multiple computers

Connect to CC User from the Telnet window
You should see spots flow into N1MM Logger from CC User

Check out the the CC User website.

2Tone (by David, G3YYD)
2Tone is a drop-in replacement for MMTTY using different decoding and encoding algorithms. It can be used in any of the
Digital Interface or Additional RX digital windows in N1MM Logger+ in place of MMTTY. Many users have found that it
decodes more accurately than MMTTY under difficult conditions.

To obtain a copy, you must join the N1MMLoggerplus user group at groups.io . Go to the groups.io web page for the group,
select the Files page, find the folder named “G3YYD”, and look in that folder for the latest version. Download the zip file
containing the most recent version and unzip it into a suitable folder (NOT within the C:\Program Files or C:\Program Files
(x86) paths). Read the 2Tone documentation that is included in the zip file for installation and operating instructions. Note that
when configuring any of N1MM Logger+’s digital windows to use 2Tone, you set up the window as if you were using MMTTY,
except that the fully qualified filename in the setup ends with “2Tone.exe” instead of “MMTTY.exe”. For more detailed
information see the Downloading and Installing 2Tone section in the Digital Setup chapter of the manual.

2Tone offers four different decoders for different propagation conditions. By far the two most commonly used ones are
Selective and Flutter. The best way to use 2Tone is with two copies of 2Tone (in different folders) open at the same time with
one set for Selective and the other set for Flutter.

In transmit 2Tone must be used in the main DI window and can be set for AFSK, DOOK (a narrower and slightly higher
performing version of AFSK), pseudo FSK requiring special hardware, TinyFSK using an Arduino via a COM port, or FSK via a
COM port RTS, DTR or TxD line. In the AFSK/DOOK modes the left or right stereo output of the sound card can be used so
SO2R can be used with one stereo sound card, with 2Tone on DI1 set up to use the left channel and another copy of 2Tone
on DI2 set up to use the right channel of the sound card.

Notifications of 2Tone updates are sent out on the N1MMLoggerplus groups.io user group.

QSOrder (by Vasily, K3IT)
QSOrder is a QSO recording program written by Vasily, K3IT, to enable N1MM Logger users to record contest QSOs on the fly
and replay them. QSOs are stored individually in folders labelled with the contest name.

Download QSOrder as a zip file from the QSOrder project area at GitHub. Create a folder in which you will store the contest
recording folders (e.g. a Contest Recordings folder within your N1MM Logger+ user files folder) and unzip the contents of the
zip file into that folder.

QSOrder uses N1MM Logger’s UDP broadcasts. Follow the instructions in the downloaded readme.txt file to use the
Configurer, Broadcast Data tab to include broadcasts of contact information from N1MM Logger to QSOrder. Note that the
default port in the instructions is 12060. If you use other plugins that rely on UDP broadcasts from N1MM Logger, you may
need to change the port number used by QSOrder in order to avoid conflicts. If you wish to use a different port number,
change the port number used for contact broadcasts in Configurer, Broadcast Data tab, “Contacts” and use QSOrder’s PORT
command-line flag to tell it to use the port number you have chosen (e.g. -P 12061).

To use QSOrder for a particular contest, start the QSOrder program and run it at the same time as N1MM Logger. Each time a
QSO is logged in the Logger, a UDP broadcast will trigger QSOrder to save a recording of that QSO. Recordings are saved in
a sub-folder named by contest-name and year, and each QSO is saved in a file whose name includes the callsign of the
station worked, the name of the contest, the date, time and band. The length of each recording is determined by the buffer
length option, and the recordings are set to run until a specified delay time after the contact is logged; both of these time
parameters are configurable using command-line flags. To use one of these command-line flags, insert it into the Target: line
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in the desktop shortcut you use to start QSOrder with, e.g. Target: “C:\Users\User\Documents\N1MM
Logger+\QSOrecording\QSOrder.exe” “-P 12061” (the program name and each command-line flag should be enclosed in a
separate set of quotation marks).

Athena Log Analyzer by PC5M (SK)
Athena is a very powerful analysis tool which integrates a N1MM+ log to show graphically contest data in real-time. Either
individual bands, or an all-band total can be displayed. Selection can be made to show QSO’s, Multipliers, Points or
Multi*Points.

Existing contest logs may be used to produce “goal files” which can be compared against live progress. Athena can
automatically adjust the time and date before creating these files to match the current contest timing.

Athena V1.2.0.0 supports N1MM+ logs

Athena archive kindly hosted by Anthony Luscre K8ZT http://www.k8zt.com/contesting

Posting courtesy Stewart G3RXQ

Real-time Log Backup – TRNMirror (by Larry, K8UT)
TRN_Mirror monitors the N1MM Logger transaction log files and maintains a shadow copy of your contest log in a second
location.
Updated: v1.3 2018-07-01

Features

Provides a log recovery mechanism in the event of a hard drive or computer crash
Automatically tracks new transaction files from new logs and new contests
Creates mirror files on a second hard drive in the PC, a USB thumbdrive, a networked drive, or cloud storage
Copies the N1MM Logger TRN file based on events (when the TRN file changed) or time (after n minutes since last
copy)
Avoids any file access errors that can occur when accessing the live contest database
Efficiently makes a mirror file only when the TRN file has changed
Creates n versions of the transaction file, based on configuration settings
Renames the mirror files using version numbers (filename(1).trn, filename(2).trn, filename(3).trn…)
Stores latest settings and mirror version counts in INI files

Documentation and download instructions: https://www.k8ut.com/file-gallery/programs

Multiplier Map Display – Mult Chaser (by Patrick, NA0N)
Mult Chaser is a free add-on program for N1MM Logger that displays contest multipliers on a map of North America as they
are worked. The program reads from the specified N1MM Logger database after each contact, provided that Mult Chaser and
N1MM Logger are both configured appropriately. Mult Chaser supports contests with ARRL/RAC sections as multipliers
(Sweepstakes, Field Day, ARRL 160), contests with states/provinces as multipliers (NAQP, ARRL RTTY), contests with grid
squares as multipliers (Stew Perry), and US State QSO parties.

Documentation: https://sites.google.com/site/korkowp1/mult-chaser-help

Downloads: https://sites.google.com/site/korkowp1/mult-chaser-downloads

R8 Brain – Audio File Resampler
Sample rate and bit resolution converter for audio recording .wav files.
It includes a batch mode to modify all .wav files.

Download: https://www.voxengo.com/product/r8brain

3/4/25, 5:37 PM N1MM Logger+ Documentation

http://www.k8zt.com/contesting
http://www.k8ut.com/file-gallery/programs
https://sites.google.com/site/korkowp1/mult-chaser-help
https://sites.google.com/site/korkowp1/mult-chaser-downloads
https://www.voxengo.com/product/r8brain


663

Customizing the DXCC List
2019-03-29

N1MM Logger+ uses the country file WL_CTY.DAT from http://www.country-files.com/ which has extra CQWW zone
information for several countries including: Canada, Australia, and China. Because each of these countries is allocated a
multitude of prefixes, but the CQWW zone is determined by the call area regardless of prefix, a very large number of entries
would be necessary to spell out all the combinations. Instead, WL_CTY.DAT contains special “macro” commands that indicate
how the CQWW zones are determined for that country. This file can be downloaded and installed from the Tools > Download
and install latest country file (wl_cty.dat) (Internet) menu item in the main Entry window. This should be done regularly, as
the country file is updated frequently, especially before major contests. Access to the Internet is required in order to perform
this operation.

There are some special situations where the country file may need to be customized. The Tools > Import country list from
downloaded file menu item may be used to import a customized country file from the SupportFiles subdirectory in the N1MM
Logger+ user files area. If you do this for a particular contest, remember to restore the normal country file before starting
another contest.

Occasionally the country file may need to be edited, for example in order to add a special call sign that was not caught in the
regular file. In 95% of such cases, all you need to do is download and install the latest file, but occasionally you may need to
edit the file to add a call sign. The file is a text file and can be edited with a text editor.

You can override the continent, zone etc. on a prefix-by-prefix basis.
Primary prefixes preceded by an * are only valid for the CQWW and WAE contests. The logging program will ignore
these lines otherwise. When updating the country file please don’t remove the *.
The logging program doesn’t handle prefixes such as FR5ZQ/J correctly. Listing FR/J as a prefix for Juan de Nova in
the country file doesn’t work unless a station signs “FR/J” as his callsign. If you work one of these islands, you’ll have to
add the callsign of the worked station to the country file manually before it is counted as the right country.
When updating the WL_CTY.DAT file use a text editor, not a word processor. Notepad is fine, watch out for WordPad
etc., always save as a text file!
After updating the WL_CTY.DAT file it has to be reloaded. Reload the file via Tools/Import country list from downloaded
file menu item.
After a Reload the prefixes are imported into the database which you are using. When changing to another database
you have to do a reload again to be sure that you use the most recent country file for that database (or the one you
want).
When a database is copied, also the country list in it will be copied. So if the country file was updated in the original file
after a copy you don’t have to import the country list again.

Note on KG4 stations: When a KG4 callsign is a 2×2 callsign it is assumed to be Guantanamo otherwise it is K (2×1 or 2×3).
When the exact callsign appears in the loaded cty.dat the associated country will be used (K or KG4 are then not
automatically assumed).

Examples

Netherlands: an easy example with nothing special. The program will assign all calls starting with PA, PB, PC, etc. to the
country Netherlands in CQ zone 14, ITU zone 27 and EU as continent. PA will be the the prefix shown in the multiplier window.
Netherlands: 14: 27: EU: 52.40: -4.90: -1.0: PA:
PA,PB,PC,PD,PE,PF,PG,PH,PI;

Greenland: Normally only stations with OX are counted as Greenland. The callsign XP1AB has been added which normally
belongs to Denmark (OZ). XP1AB will be valid as Greenland with standard Greenland parameters i.e. zones, continent etc.
Greenland: 40: 05: NA: 62.50: 45.00: 3.0: OX:
OX,XP1AB;

African Italy: This is an example where a * is added before the primary prefix which means that the country only counts in CQ-
sponsored contests.
African Italy: 33: 37: AF: 35.40: -12.50: -1.0: *IG9:
IG9,IH9,IQ9L,IZ9;

Wl_cty.dat macro example.
The macro starts with # and ends with the next ; It means that for all the prefixes in China the zones are determined by the call
area and first letter of the suffix.
China: 24: 44: AS: 40.00: -116.40: -8.0: BY:

1. BY: BY3G(23),BY3H(23),BY3I(23),BY3J(23),BY3K(23),BY3L(23),
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BY9A(23),BY9B(23),BY9C(23),BY9D(23),BY9E(23),BY9F(23),BY9G(23),
BY9H(23),BY9I(23),BY9J(23),BY9K(23),BY9L(23),BY9T(23),BY9U(23),
BY9V(23),BY9W(23),BY9X(23),BY9Y(23),BY9Z(23),BY0(23);
3H,3I,3J,3K,3L,3M,3N,3O,3P,3Q,3R,3S,3T,3U,BG,BT,BW,BY,BZ,XS;
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Technical Information
2019-03-29

Technical Information
N1MM Logger+ is a contest program written in Microsoft Visual Basic .NET. It uses an SQLite database for storing
information. Writing and retrieving data to and from the database is done with SQL (Structured Query Language).
Running the program needs no more programs or files than supplied in the installation package and the program update
(NewExeVx.x.x).

Do you need all the information given below to use the program? NO

Directory Structure
The program itself is installed under C:\Program Files in 32-bit Windows systems, or C:\Program Files (x86) in 64-bit
Windows systems, but none of the files it writes to are stored there. All user files (databases, ini files, error logs, mc files, wav
files, ADIF files, Cabrillo files, UDC files, call history files, etc.) are stored in dedicated subfolders in a Logger+ user files area,
which by default is installed inside your personal Documents folder. The full name of the user files area on your computer is
probably something like c:\users\<Windows ID>\Documents\N1MM Logger+ or Documents\N1MM Logger+. The installer
offers the capability to change either of these locations. If you are using OneDrive or may decide in the future to use it, it is
suggested that you change the second location so as to move the user files area outside your Documents folder, for example
by installing it in a location such as C:\HamRadio\N1MM Logger+. This is to avoid problems caused by OneDrive, which can
(a) corrupt database files if it backs up, restores or syncs them while the program is running; and (b) move the user files area
to a location in the cloud, where Windows Explorer can find them but the N1MM+ program unfortunately cannot.

Digital engine files (MMTTY, 2Tone, Fldigi) have not been set up to accommodate this two-folder structure, and need to be
stored outside the C:\Program Files and C:\Program Files (x86) paths in Windows Vista, 7, 8, 10 and 11. One solution is to

Warning to Anyone Tempted to Directly Edit N1MM’s Database Files

We recommend not to change any data in the database or any other files unless you are very sure what you are
doing. It is possible to change the behavior of the program and get erroneous results. If you have changed the
contents of the database and the program behaves strangely, go back to the original (unaltered) version of the
database.

No support will be given to users who change the database structure or contents. The same goes for changing
other files used by the program.

You are on your own!

Don’t make changes if you are not very sure what you are doing. Second and last warning!



Note about scoring

After changing QSO information always do a rescore! Multiplier information and QSO points will be updated after a
rescore so any changes made to these directly in the database will be lost.



Adding new contest types

It is not possible to add a contest to the program by editing the database. Contests can be added using the User
Defined Contest method.
For contests other than those in UDC files, contest rules etc. are in the main program file (N1MM logger.net.exe) and
are not stored in the database or any other files!
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place them in a directory outside the normal pre-defined Windows paths (e.g. under C:\Hamradio\MMTTY or C:\MMTTY or
…); a second solution is to create a folder inside your N1MM+ user file folder for digital engines. Either way works.

The SQLite Databases
Information that does not change between contests is kept in a database called N1MM Admin.s3db. Contest QSOs and
related information are in databases that may be created or switched from the File menu. All of these databases are stored in
the Databases subdirectory in the N1MM Logger+ user files area.

The “N1MM Logger.ini” file
The N1MM Logger.ini file is in the N1MM Logger+ user files directory (which you can access from the Help > Open Explorer
on User Files Directory menu item). Everything in the “N1MM Logger.ini” file should be settable through the program’s user
interface. An item may not appear in the “N1MM Logger.ini” file if its value is left at the default.

Removing the ‘N1MM Logger.ini’ file will cause the program to start with default settings and will require all configuration items
to be re-entered. In some cases where data in the file has become corrupted, this may be necessary. Before doing that, it is
worthwhile to try renaming a recent backup from before when the problems started. There are up to seven backups retained in
the main N1MM Logger+ user files directory, one for each day of the week, as in N1MM Logger.ini.Monday.bak, etc.

To Revert to a Previous INI BAK file

Close N1MM Logger
Rename the current “N1MM Logger.ini” file to something else, for example “N1MM Logger.ini.CURRENT”
Make a copy of one of the backup files, based on when the program was last working properly. When you make that
copy in Windows Explorer, it will add the word Copy. For example, the copy of “N1MM Logger.ini.Friday.bak” will be
called “N1MM Logger.ini.Friday – Copy.bak”
Rename that copy “- Copy.bak” file to the active ini file name. For example rename “N1MM Logger.ini.Friday –
Copy.bak” to “N1MM Logger.ini”
Launch N1MM+ and see if your previous configuration is working properly.

ADIF Fields
N1MM Logger+ complies with the ADIF standard. Standard ADIF fields exported to ADIF include CALL, QSO_DATE,
TIME_ON, TIME_OFF, BAND, STATION_CALLSIGN, FREQ, CONTEST_ID, FREQ_RX, MODE, RST_RCVD, RST_SENT,
OPERATOR, STX, PFX, and may also include NAME, COMMENT, CQZ, ITUZ, TX_PWR, SUBMODE, STATE, ARRL_SECT,
IOTA, and possibly others, depending on the contest exchange and other circumstances.

In addition, there is information stored in the N1MM Logger+ database that can not be included by using only standard ADIF
tags. A number of N1MM Logger application-specific tags have been added so that when exporting an ADIF file and importing
it again all information from the DXLOG table will be restored. A rescore will update the fields not imported and may be
needed to get the score and multipliers to be shown correctly on the screen. These application-specific fields include:

APP_N1MM_EXCHANGE1 – content of the Exchange1 field
APP_N1MM_POINTS – content of the Points field
APP_N1MM_MULT1 (and MULT2 and MULT3) – content of the Multiplier fields
APP_N1MM_RADIO_NR – content of the RadioNr field (SO2R or SO2V)
APP_N1MM_MISCTEXT – content of the MiscText field (if used)
APP_N1MM_CONTINENT – content of the Continent field
APP_N1MM_CONTACTTYPE – content of the ContactType field (e.g. D for dupe)
APP_N1MM_ISRUNQSO – 0 for contacts made while in S&P mode, 1 for contacts made while in Run mode
APP_N1MM_RUN1RUN2:1 – content of the Run field. 1 means radio 1 was the Run radio, 2 means radio 2 was the Run
radio.
APP_N1MM_RADIOINTERFACED – indicates whether a radio was interfaced for radio control(1) or not (0)
APP_N1MM_ISORIGINAL – True or False (identifies whether this computer is the “owner” of this QSO in a multi-computer
networked environment)
APP_N1MM_NETBIOSNAME – the NetBIOS name of the computer on which the contact was originally logged
APP_N1MM_ID – a 32-hex-digit unique record identifier

Do_Not_Use_or_Erase.s3db File
There is a special database file called Do_Not_Use_or_Erase.s3db in the Databases directory – do not erase
this file, and do not name it as your log database!
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APP_N1MM_RoverQTH – Rover QTH (if used)
APP_N1MM_ROVERCNTY – contains the rover county value from RoverQTH if the station is a rover and the contest type is
QSO Party.

Note that some fields in the database are used for different purposes in different contests, and may be exported/imported with
different ADIF tags in different contests. For example, the Zone field in the database usually contains a CQ zone (CQZ tag in
ADIF), but in some contests such as the IARU HF Championship, it contains the ITU zone (ITUZ tag in ADIF) instead. The
Section and Misc database fields are likewise often used for different purposes in different contests and may be exported or
imported using different ADIF tags depending on what the fields were used for in that particular contest.

In the WAE contests, QTCs are not exported to or imported from ADIF. Exporting a WAE contest to ADIF and importing it into
a different database will lose all information about QTCs exchanged during the contest. In order to copy QTC as well as QSO
data, you must either use the File > Copy This Contest to Another Database menu item, or else import the TRN file created
with the original contest log into a new empty database.

Callsign Checking in the Digital Interface
Below describes how callsign checking is done in the Digital Interface windows.

It first checks to see if the callsign is of the right length (More than 2 less than 11). It then checks to see if someplace in the
first 6 characters there is a number. 3rd it checks to see if there are no invalid characters in it. Then if it all that passes it goes
through the Busted Call Checker. If the Busted Call Checker returns an Error message then the call is invalid. Anything else
from the Busted Call Checker makes it a valid call.

As text comes into the Receive screen of the Digital Interface it gets printed to the window and placed in a temp buffer. When
a space or a CR or LF is encountered the program will send the text in the temp buffer to the check callsign routines. Iif it
comes back as a valid callsign it is sent to another routine that looks back thru the last 25 characters of the Receive screen
and colors them accordingly. At the time the space is encountered the temp holding buffer is cleared and things get sent there
all over again. The whole process above takes just over a millisecond to complete.

Unlike other software DE before the call is not required,it looks for space mostly after callsign.

Take a look at this sequence it explains how it picks up callsigns in the RX window:

A QWSCFGTWA5TTT WA5TTT UR 599 XXXXXXXXXX

The program sees the space between the TTT and the WA so it looks into its previous holding buffer which contains
“QWSCFGTWA5TTT” that string does not equal a valid callsign even though there is one in it. So because it encountered the
space the buffer is cleared and the next string starts being placed into it. When it hits the third space it goes back and checks
the buffer again this time it finds WA5TTT and it says it is a valid call. The program now looks back 25 characters and any
time it finds WA5TTT it will color it accordingly and also place it in the grab window.

As for the clicking on callsigns it follows the same rule except there is a routine that looks to see the characters that are under
the mouse. If it is a valid call then it gets sent through the routines to place it in the entry window. There is a ltrs/figs line of text
that shows the actual text that is being converted. This will give you an idea of what text is getting selected etc.

Problems will happen if the rules change in various countries and the rules in the Busted Call Checker can’t keep up with the
country changes so you get callsigns that do not come out of it OK. The main reason to add the Busted Call Checker routines
in there is to cut down on a lot of garbage that would be getting colored that passed all of the check routines but were not
really callsigns

Routers and Firewalls
A router provides your principal defense against the wild, wooly Internet. Everyone who connects to a broadband Internet
service should only do so through a router.

A software firewall (like the Windows XP firewall, Zone Alarm, etc.) provides protection from the other computers behind your
router. It’s probably okay to turn off the Windows Firewall in a contest station.

Routers provide an important function called network address translation (NAT). If you look at your computer’s IP address and
see 192.168.x.y (or 10.x.y.z), then you’re golden. The 192.168.x.y (and 10.x.y.z) address ranges are defined as local only and
cannot be routable across the Internet. If your PC has one of these addresses, it’s as if you’re behind a telephone switchboard
and do not have a direct dial number. That’s a good defense.

Software firewalls protect you from other computers behind your router. So if you take your laptop around with you and use
various wireless networks, you absolutely need a software firewall. The other computers at Starbucks may be full of viruses,
and you need a software firewall to protect you from them. Also, if you have a computer in your house that may be used for
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some less-than-safe surfing, you should have a software firewall. Kids may have permitted access for online gaming, peer-to-
peer file sharing, or may have downloaded software that has spyware, etc. Protect your PC by running a software firewall.
Finally, if you have a wireless network, make sure you control who access it. If your neighbor can access your network and
has a bunch of malware on his machine, your machines could get infected, too.

Robert K5PI.

Adding N1MM to the Windows Firewall

When you do not want to turn off the Windows Firewall you can leave your windows firewall on even though you are behind a
router. Add N1MM to your exceptions list and better yet add the local subnet (usually 192.168.1.0 (255.255.255.0)) to the port
exceptions.
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Translation Technical Information for Developers
2020-03-18

There is a certain amount of effort required to enable a form for localization. The effort required is tiny and one-time only for
localizing controls. Text strings embedded within code need to be handled in a specific way, but that handling is only required
for strings that need localization. Try…Catch constructs that display errors using only the exception object or
exception.message property will automatically display based on the operating system language setting.  Any application errors
that are NOT intended for the user to interpret should be left in English so that the development team does not need to do
extra work to figure out what the error is when it is reported to us.

Additional Properties

The following properties need to be added to any form that is to support localization:

This property returns and sets the ToolTipText for any control that does not support the ToolTip property directly (which is
pretty much everything EXCEPT MenuItems). Note that the ToolTip component on the form that enables these must either be
named ToolTip1 OR you must change the code above to the correct name. If no ToolTips are coded on the form, omit the
property routine altogether.

These properties support string lookup and substitution for inline messages, e.g. anything destined for a MsgBox or
StatusStrip. The variable dict is a dictionary whose structure and purpose will be described below.

Additional Events

1
2
3
4
5
6
7
8

Property ToolTipText(c As Control) As String
    Get
        ToolTipText = Me.ToolTip1.GetToolTip(c)
    End Get
    Set(Value As String)
        ToolTip1.SetToolTip(c, Value)
    End Set
End Property

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16

Property Msg(keyy As String) As String
    Get
        Try
            'Debug.Print(keyy)
            If Microsoft.VisualBasic.Strings.Left(keyy, 1) = ChrW(157) Then
                keyy = Strings.Right(keyy, Len(keyy) - 1)
            End If
            Msg = dict(keyy).ToString
        Catch
            Msg = "Invalid key - " & keyy & " - is missing from translation dictionary. Please c
        End Try
    End Get
    Set(Value As String)
        dict(keyy) = Value
    End Set
End Property

1
2
3
4
5

ReadOnly Property GetMsgDict() As Dictionary(Of String, String)
    Get
        GetMsgDict = dict
    End Get
End Property

1
2
3

Private Sub Station_LanguageChanged() Handles stn.LanguageChanged
    Call SetLocalStrings(Me, True)
End Sub
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This causes the form to be redrawn with the new language if the language is changed in the Configurer form.

NOTE: The optional parameter in the call to SetLocalStrings (True in the above example) is used to force the conversion of
strings to English when called. Normally if the selected language is English (the default) the routine does nothing further and
returns immediately. If the language is changed from something other than English back to English then the routine must look
up the English strings in the database and use those for the event handler to do anything meaningful. Otherwise, the
application needs to be closed and reopened to redisplay in English.

Mandatory Calls

Add the following call to the form load event:

Supported Controls

The following controls are currently supported by the localization code.

Label – Text property and ToolTip, if present
CheckBox – Text property and ToolTip, if present
RadioButton – Text property and ToolTip, if present
Button – Text property and ToolTip, if present
ListView – ColumnHeaders Text property
GroupBox – Text property and all descendant controls
GroupBoxEx – Text property and all descendant controls
TableLayoutPanel – Text property and all descendant controls
Panel – Text property and all descendant controls
TabControl –All descendant controls, including Tab Pages
StatusStrip – All ToolStripStatusLabels descendant controls
MenuStrip (and descendant objects, i.e. MenuItems) – Text and ToolTip properties
N1MMNumericUpDown – Ignored (no “Object not handled yet”)  message
AxN1MMWave– Ignored (no “Object not handled yet”)  message
ComboBox – ToolTipText property, if present
TextBox – ToolTipText property, if present
RichTextBox – ToolTipText property, if present
PictureBox – ToolTipText property, if present
NumericUpDown – ToolTipText property, if present
HScrollBar – ToolTipText property, if present
DateTimePicker – Ignored, no properties to set
ListBox – Ignored, no properties to set
TrackBar – Ignored, no properties to set
AxXMMVView – Ignored, no properties to set
AxXMMVLvl – Ignored, no properties to set
DataGridView – Column header text and tool tips. Note that only predefined static column header text can be translated
currently. Dynamically set text elements can be implemented via the dictionary.
AxXMMVBtn – Text property

The following controls exist in N1MM+ but are not currently supported:

ShapeContainer
SplitContainer
Chart

Note that a number of controls are containers for other elements. TabPages are an obvious example. Some controls such as
the ListView have no direct text element properties that can be set but their descendent children (e.g. column headers) do. In
these cases a database entry is made for the control with the text value field left blank. The purpose of the entry is to maintain
the hierarchy of controls needed to alter the children via the Parent database field.

Dictionary

In order to implement the translation of inline strings, a dictionary is created in each form to be enabled for translation. This
dictionary is only necessary to hold the English placeholders for strings to be translated. I created a tool to extract the string,
create an associated compile time dictionary declaration and insert an appropriate reference in the string statement being
enabled. This worked for me, YMMV. It can be tedious to enable a large form for the first time. The effort required to add a
new string once a dictionary is included is pretty trivial.

1 Call SetLocalStrings(Me)
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Again, remember the Pareto Principle and do not go crazy with this. I mostly left the EntryWindow MsgBox headers (if
present) in English so that it would be easier to identify the specific error message if translated and sent to the development
team by a user. You can skip it altogether (along with the associated properties, above) if you decide to disallow any
translations on these strings.
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DX Clusters
2019-03-29

There are several types of DX clusters used during contests. Most of them have the same type of basic commands (SH/DX
style by the original from AK1A), but advanced commands such as filters differ between cluster types. Below is a summary of
the most used DX cluster types with some sample commands. For more information read the Help from the cluster you are
using.

Overview

Cluster AR-
Cluster CLX DXnet DXSpide

r
Wincluste

r Clusse PacketCluster(t
m)

By (author) AB5K DJ0ZY and
DL6RAI F5MZN G1TLH KH2D OH7LZB AK1A

Operating
System

Windows
32 bits Linux

Linux,
Dos
Windows

Linux
Windows

Windows
32 bits Dos Dos

Command Set SH/DX SH/DX SH/DX SH/DX SH/DX Own SH/DX

Version used
for overview – 5.04 4.3b9 1.51 2.3.8 1.0 not found

Still supported Yes Yes Yes Yes Yes No No

Freeware $$$ Freeware Freeware Freeware $$ Freewar
e $$

Multilingual ? ? Yes Yes No Yes ?

Website Website Website Website Website Website Website No

Help file Web Web not found

Web
help
PDF
help
from
FRC

not found not
found not found

Help on DX
spots Web Web not found Web not found not

found not found

Table of cluster types
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Commands

Action AR-Cluster CLX DXnet DXSpider Wincluster Clusse

General command set SH/DX SH/DX SH/DX SH/DX SH/DX List

Show users SH/USERS SH/USERS SH/USERS SH/USERS SH/USERS –

Show WWV SH/WWV SH/WWV SH/WWV SH/WWV SH/WWV –

Configuration network – – SHow/Conf – – –

Show Filters show/filters show/filters SHow/Filter show/filter – –

Set Filter set/filter [..] set/filter 5 – – – –

Reset Specific Filter – set/nofilter 1 – clear/spots 1 – –

Reset All Filters set/nofilter set/nofilter SET/NOFilter clear/spots all – –

Set number of lines to 0 – – – – SET/PAGE 0 –

Show DX S – SHOW/DXDEDX – – – –

SH/DX command set

SET/FILTER
SHow/Filter
SET/NOFilter
SET/DX_announcements
SET/NODx_announcements
SET/Announcements
SET/NOAnnouncements
SET/nodx – You do not get spots from the cluster but you can send them out on the network (i.e for SO unassisted
stations)

Filter and other examples/features
Setting band/mode type filters are not recommended as they will often block split frequency operations on the low bands.

Filter examples AR-Cluster and DX-spider by the Yankee Clipper Contest Club(YCCC).

AR-cluster

For full details see: http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm

You only want stateside generated spots and announces? Use: set/filter k/pass

set/filter k,ve/pass – You will only see DX spots from spotters in the United States (K) and Canada (VE).

set/filter dxbm/reject vhf,uhf – VHF and UHF spots will be suppressed.

Remove all filters with: set/nofilter

Examine your settings with: show/filters

CLX

For full details see: http://clx.muc.de/user/english/html/userman.html

SET/FILTER < nr1,nr2,..,nrX >

This command lets you set reject filters as defined by your sysop. You first should look up which filters are defined at your CLX
node. This is the default list:
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Filter Meaning

——————–

1 VHF 144.000 MHz and up

2 HF 30.000 MHz and down

3 TOP 1.800-2.000 MHz

4 all the CW band segments

5 all the SSB band segments

6 all the RTTY band segments

7 all the WARC bands

——————–

Your sysop may or may not have defined further filters. You can find out by using the SHOW/FILTERS command. After you
have decided which filters you would like to switch in, you use the command as follows: SET/FILTER 4,6

This turns on the CW and RTTY filters, so will leave you only with SSB spots. To further narrow the filter settings, you can add
more filters: SET/FILTER 1,3

The setting is now 1,3,4 and 6 which eliminates all spots except SSB spots on the HF bands from 80 to 10 meters, including
the WARC bands.

SET/DXDEDX and SET/NODXDEDX

This command is used to turn off so-called Internet spots. DX spots originating from specific WAZ zones are not forwarded to
you when you have issued a SET/NODXDEDX command. This flag is saved in your user record so you will only have to
specify it once to turn these (for you) annoying messages of. The default is to send all DX spots.For example, your sysop
could have defined zones 03, 04, 05 and 25 as DX zones. If you then turn on the NO-DX-de-DX filter, you will never again
receive any spots from these areas although other users probably will.

To look up, which zones were being defined as DX zones, use the command SHOW/DXDEDX.
When you have previously disabled DX spots from other continents with SET/NODXDEDX, you can re-enable them with
_SET/DXDEDX__.

SET/DX_ANNOUNCE and SET/NODX_ANNOUNCE

This command turns the reception of DX spots on or off. This could, for example be used if you were reading a lengthy
message and did not want DX spots in between the lines. This command is permanent, it will enable or disable the sending of
DX spots. To enable the sending of DX-spots use SET/DX_ANNOUNCE

SET/LOGIN_ANNOUNCE

Set to see user logins and logouts locally. For each login or logout, a message is sent to you from the system. On a busy node
this will generate a lot of traffic.

Login at 1929Z: DL6RAI

Logout at 1930Z: DK2OY

DXSpider

For full details see: http://www.dxcluster.org/main/usermanual.html or download it as PDF file (from FRC) at:
http://n1mmwp.hamdocs.com/wp-content/uploads/attachments/dxspider.pdf

A great PDF file on User Configurable Spot Filters in DXSpider by Jim Samuels – W3BG can be found at:
http://n1mmwp.hamdocs.com/wp-content/uploads/attachments/Filter Primer.pdf

SET/USSTATE is a feature where the US STATE is automatically added before or behind the time field. The information is
taken from the FCC database.

The basic format for a spot filter is:

3/4/25, 5:37 PM N1MM Logger+ Documentation

http://www.dxcluster.org/main/usermanual.html
https://n1mmwp.hamdocs.com/wp-content/uploads/attachments/dxspider.pdf
https://n1mmwp.hamdocs.com/wp-content/uploads/attachments/Filter%20Primer.pdf


675

accept/spots < pattern >
reject/spots < pattern >

As you can see, there are fundamentally two broad classes of filter… accept & reject. A different way of looking at them is:

accept – bandpass filter, as in, “Pass these spots to me”

reject – bandreject filters, as in, “I don’t want to see spots like this”

The < pattern > has many, many different combinations. For now, I’m going to address just two classes… “by” and “call”. “By”
means that the spot is “by someone” as in a spot “by k1xx” or “by a VE” or “by someone in Maine”

The exact syntax is:

by_zone – spotter in the CQ Zones, 1-40

by_dxcc – spotter is a W or VE or F or G

by_state – spotter is in ME, CT, RI, NH

Remember, spots “by” means callsign of the station doing the spotting, the spotter.

“Call” on the other hand refers to the call, zone, state of station being spotted, the spottee. The syntax here is:

call_zone – the spottee’s zone

call_dxcc – the spottee’s country

call_state – the spottee’s state

Now, on to some simple examples.

accept/spots by_dxcc w,ve – spots only by W & VE stations

accept/spots by_zone 5 – spots only by stations in Zone 5

accept/spots by_state me – spots only by stations in Maine…slow weekend

reject/spots call_dxcc G – I don’t want to see G stations spotted

reject/spots call_zone 14 – No spots of stations in Zone 14

reject/spots call_state md – Please, no more spots of Maryland stations

With the following command I only get spots with “RTTY” in the comment field. This is nice during RTTY contests.

accept/spot 0 info rtty – Only show spots with “RTTY” in the comment field

If you want to get rid of a filter, use: clear/spots all

Spot filters remain on a DXSpider node until you clear them out. No need to re-enter the same filter each time you log in.

Just a couple words about frequency. You can combine frequency on the same line as an accept/reject filter. For example:

accept/spots by_dxcc w,ve and on 10m – only 10 meter spots by W & VEs

reject/spots call_zone 25 and on 160m – I don’t want more spots of JAs on 160 meters

Links
DX PacketCluster WebNet http://www.dxcluster.info/

Webclusters and other useful information http://hamgallery.com/clusters/

OH2AQ WebCluster (DX-Summit) http://oh2aq.kolumbus.com/dxs/
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Telnet’s Cluster Reporting & Rating Feature
2020-03-18

The traditional method for selecting a Packet Cluster in the Telnet Window’s >Cluster tab involves choosing from a static list of
251 links stored in tables on the local computer. Many sites in that list disappeared over time, and new users were particularly
frustrated when trying to connect to an available packet cluster.

An alternative method delivers a dynamic list of cluster sites whose availability and performance is reported by participating
N1MM+ users.

FAQ – Full Disclosure

This list of FAQs will grow as questions arrive on the groups.io reflector

The Live Cluster Announcement – March 14, 2020
Next Tuesday’s N1MM+ Update contains production code that enables live cluster data collection and reporting
from a database on the N1MM+ website. When you install the update, you will be greeted with a dialog window
that allows you to Opt-In or Opt-Out of this feature.

WHAT DATA GETS COLLECTED? The cluster report contains five data elements: the name of the cluster site;
the URL/IP address of the cluster site; the result of your attempt to connect (succeed? or fail?); your geographic
Continent; and your CQ Zone (as listed in the Station Information settings). No personal or user-identifiable
information is collected on the server.

WHEN ARE CLUSTER SETTINGS REPORTED? The code sends a cluster report upon opening the Telnet
Window, and if / when you select a different cluster site.

HOW IS THE DATA BEING USED? The reports are aggregated by continent and presented in a summary list of
live cluster sites meeting certain criteria.

WHAT IS THAT SELECTION CRITERIA? For a site to be included in the list for each continent it must have at
least 10 successful connections and at least a 75% success -to- fail connection rate.
HOW “LIVE” IS THE LIVE CLUSTER DATA? A fresh Cluster Rating summary is generated in real-time upon
opening the Telnet window and clicking on the Live Cluster List.

HOW LONG IS THE DATA RETAINED? As each new report is submitted, the oldest report is deleted (assuming
the database has max’ed out at 50,000 records). Based on our observations, the oldest report in the system will
probably never be more than three weeks old.

CAN USERS OPT-OUT OF THIS CLUSTER REPORTING? Yes. Users who opt-in will be able to use the new
Live Cluster and the traditional Stored Cluster selections. Users who opt-out will only be able to use the
traditional Stored Cluster selection.

WHAT HAPPENS TO MY STORED CLUSTER LIST AND CURRENT CHOICE? Your current cluster and stored
list will not be affected. You will still be able to use them as you have in the past.

WHY ARE WE TELLING YOU THIS? Lest we be accused of “snooping” on our users, the Dev Team members
felt that Full Disclosure was warranted.

As the author of this code, I’ll answer any further questions you might have – either here or in direct email.
-larry (K8UT)

RATINGS – This is described as Cluster Ratings. I don’t see any ratings!
We did not want to directly rate the clusters against each other, because of the risk of everyone overwhelming the top-ranked
site at the expense of all other sites. Instead, we established a set of parameters that we consider to be the line between
acceptable and unacceptable performance.

We do not poll any servers
You send anonymous telnet connection results to a website database, which is throttled at 50,000 reports
That raw database is “fresh” in that it is always the most recent reports submitted by N1MM users
When you open the >Clusters tab of the Telnet Dialog Window and press the Live Cluster List down-arrow, the server
generates a summary for you in real-time
That real-time summary analyzes the raw data by continent, and for each continent gives you an alphabet list of sites
that have 1) at least 10 reports of successful connections and 2) a success/fail ratio of at least 75%
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Each cluster is listed with its rating values in parenthesis ( ). The first number is the total reported successful
connections. The second number is the percentage of reported successful connections versus failed connections.

CONTINENTS – These clusters are not located on the indicated continent.
The continent is NOT the location of the cluster server. The continent is the location of the hams who are reporting that they
use a specific cluster. Thus when you see the NA listings, these are clusters – wherever they may be – that North American
hams are using successfully.
For example, scroll through the list and look for DXFUN.COM. I have no idea where DXFUN is located, but Hams in NA, EU
and SA are connecting to it and meeting the 10@75% criteria.
If you think about it – you don’t really care where a cluster is located, you only care that folks around you are using it.

DYNAMIC DATA – How real-time is the Live Cluster list?
The size of the server database has been intentionally limited to 50,000 records, which are the most recent cluster reports
from N1MM users. Typically the oldest records are about three weeks old.

A fresh Live Cluster list is created for you in real-time when you open the N1MM Telnet Window, select the >Cluster tab, and
click the drop-down arrow. To avoid burdening the server each time you press the drop-down arrow, your real-time list is not
refreshed until you close the Telnet Window and repeat the process of opening the Telnet window, selecting the >Clusters tab,
and pressing the drop-down arrow.

SELECTION CRITERIA – How does a site qualify to be on this Live Cluster List?
To be included in the list, a cluster site must have at least 10 reports of successful connections. This could be 10 users
connecting 1 time, or 1 user connecting 10 times. Along with these successful connections, there must be fewer than 25%
failed connections compared to successful connections. In other words, if users report 100 connection attempts to cluster site
www.DonaldDuck.com, there must be fewer than 25 failed connections.

OPT-IN – Is N1MM+ snooping on me? Does my PC report any personal or identifiable information?
The members of the N1MM Development Team have strong feelings about collecting user information, and there were lively
discussions within the group as this feature was being developed. Here are a few details about how the Live Cluster reporting
feature works

Live Cluster reporting is only active when: 1) you are running N1MM+ and 2) you have the Telnet Window running, and 3) you
have opted-in to this feature.

Live Cluster reporting does not collect any information that would identify you individually

Live Cluster reporting collects five data elements: the name of the cluster site; the URL/IP address of the cluster site; the
result of your attempt to connect (succeed? or fail?); your geographic Continent; and your CQ Zone (as listed in the Station
Information settings)

OPT-OUT – Why is the Live Cluster list disabled when I opt-out?
The value provided by the Live Cluster list is directly proportional to the number of N1MM+ users who are contributing. To
encourage participation, we have taken a “pay to play” approach in which you must contribute in order to get the benefits.

NEW SITES – How do I get my cluster site on your list?
There is no way to manually add a new site to the Live Cluster List. If you are a cluster site administrator your site will
automatically appear when it meets the Selection Criteria described above.
So, tell all your friends to start using your cluster and it will magically appear in the Live Cluster list.

THE FAVORITES LIST – How to edit/trim a large list
You can use the Favorites List like bookmarks to identify a few sites that you use regularly. Do you sometimes switch between
sites when running a local contest versus an international contest? Or maybe you change sites when operating phone, CW or
digital contests? Just click the [Add to Favorites] button.

If your N1MM+ Favorites still includes the huge list from previous versions of the program, here’s how to trim those unwanted
records:

In the Telnet Windows >Clusters tab, click the [Edit List] button
In the Edit Telnet List dialog window, select >File >Export
Export the stored list to a local text (txt) file, by default into the ExportFiles subdirectory in your N1MM+ user files
directory.
Use a text editor (Notepad.exe?) to open the file. Delete everything except those that you use. Save the file.
Back in the Edit Telnet List dialog window, select >File >Import and choose the file you just edited. Press the [OK]
button to exit the Telnet List dialog window.

Done!
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External UDP Messages
2019-03-29

External UDP Messages pass information from N1MM Logger+ about the contest in progress to various third-party software
programs. UDP Messages can be sent to remote addresses, provided the receiving computer can be reached through it’s
local router. You cannot send broadcasts (like xx.xx.xx.255) to remote subnets.

There are additional UDP Messages built into N1MM Logger+, which are sent by default, but (except as noted) they are not
very useful for general users. One example is the real-time score reporting application.

To enable external UDP Messages select >Config >Config Ports… >Broadcast Data.

A note to software developers
Vasily K3IT has found that if both SO_BROADCAST and SO_REUSEADDR options are used when a UDP port is
opened, it is opened in a ‘non-exclusive’ mode. This allows multiple applications to share the same port, as long as
they all follow this method. Using these flags helps avoid port conflict issues.
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Selecting which UDP Messages to Send

Check
box Explanation

Applica
tion
Info

Sends information about the station and the current contest (station name, contest database, contest name…)
when the program launches, when a new contest is opened, or when a different contest is selected in the Contest
Dialog window. See full field list below

Radio Sends radio information (mode, frequency, antenna, operator…) at least every 10 seconds or when radio
frequency or mode change. See full field list below

Contac
ts

Sends contact information (time, callsign, mode, frequency, exchange…) when a new contact (QSO) is added to
the log, when an existing contact is edited in the log, or when an existing contact is deleted from the log. See full
field list below

All
Compu
ters

Sends all contact info from all stations on a network from this station. This command is useful only in Networked
Computer mode. When enabled (together with Contact) at any station, that station will resend every contact that it
receives to the UDP port specified. The XML format is the same as for Contact except that IsOriginal will be set
false. CAUTION: Multiple, misconfigured stations with All QSOs enabled could result in a circular network storm
of contact packets

Spots Sends info about spots as they are processed (added or deleted). Spots may originate from telnet (including
RBN), from logging QSOs, or from local spots stored in the Bandmap

Score Can be used for score reporting within the local network. To report scores to online score reporting databases,
use the Score Reporting tab in the Configurer

Extern
al
Callsig
n
Lookup

Used to send LookupInfo packets to a third party application such as a general-purpose logging program prior to
completing the contact. See the description of the LookupInfo packets below

Setting the Destination IP Addresses
The Application, Radio, and Contact packets will be addressed to destinations indicated in this dialog window. To send them to
a program running on this PC, use the address 127.0.0.1. To send them to another PC on this subnet, enter its IP on the
corresponding line. To send them to all PCs on this subnet, enter 255 as the last number (octet) of this subnet’s address. For
example: if PCs on this subnet have the address 192.168.1.n, use 192.168.1.255 to send the packets to all of the PCs on this
network. Separate multiple destination IP address from each other with a space. Do not specify 255 in the higher order octets,
or you will risk broadcasting to the internet. While eventually the packets will be discarded by internet routers, it will not endear
you to your ISP.

Setting the Destination IP Port Numbers
The recommended default port number for N1MM Logger applications is 12060. Destination port numbers are defined by
adding a colon “:” to the IP address, followed by the port number. For example, to send packets at port 12060 to this PC and
to all other PCs on this subnet: 127.0.0.1:12060 192.168.1.255:12060

Other UDP Message Settings
Optional External Message statements allow different external message types to be sent to different IP addresses, multiple IP
addresses, and multiple port numbers. Refer to the instructions for those applications for confuguration details about adding
their packet addressing information to the N1MM Logger.INI file.

Interface Developers – XML Packet Descriptions
Formatted XML text of the following packets is available in the Downloads section of the website under Additional
Support Files.
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XML Schema and Message Field Lists

Application Info

NOTE: contestnr is a unique number assigned to this contest in this database. Do not expect the same contestnr to be
assigned to another computer running the same contest name.

Contact

Contact Info UDP packet

1
2
3
4
5
6
7
8

<?xml version="1.0" encoding="utf-8"?>
<AppInfo>
    <app>N1MM</app>
    <dbname>N8SL_FIELDDAY.s3db</dbname>
    <contestnr>2</contestnr>
    <contestname>ARRL-FIELD-DAY</contestname>
    <StationName>80M-TENT</StationName>
</AppInfo>

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45

<?xml version="1.0" encoding="utf-8"?>
<contactinfo>
    <app>N1MM</app>
    <contestname>CWOPS</contestname>
    <contestnr>73</contestnr>
    <timestamp>2020-01-17 16:43:38</timestamp>
    <mycall>W2XYZ</mycall>
    <band>3.5</band>
    <rxfreq>352519</rxfreq>
    <txfreq>352519</txfreq>
    <operator></operator>
    <mode>CW</mode>
    <call>WlAW</call>
    <countryprefix>K</countryprefix>
    <wpxprefix>Wl</wpxprefix>
    <stationprefix>W2XYZ</stationprefix>
    <continent>NA</continent>
    <snt>599</snt>
    <sntnr>5</sntnr>
    <rcv>599</rcv>
    <rcvnr>0</rcvnr>
    <gridsquare></gridsquare>
    <exchangel></exchangel>
    <section></section>
    <comment></comment>
    <qth></qth>
    <name></name>
    <power></power>
    <misctext></misctext>
    <zone>0</zone>
    <prec></prec>
    <ck>0</ck>
    <ismultiplierl>l</ismultiplierl>
    <ismultiplier2>0</ismultiplier2>
    <ismultiplier3>0</ismultiplier3>
    <points>l</points>
    <radionr>l</radionr>
    <run1run2>1<run1run2>
    <RoverLocation></RoverLocation>
    <RadioInterfaced>l</RadioInterfaced>
    <NetworkedCompNr>0</NetworkedCompNr>
    <IsOriginal>False</IsOriginal>
    <NetBiosName></NetBiosName>
    <IsRunQSO>0</IsRunQSO>
    <StationName>CONTEST-PC</StationName>
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NOTES

IsOriginal indicates that this is the station on which this contact was initially logged – to differentiate from another
station that may be forwarding the contact record. StationName is the netbios name of the station that sent this packet,
not necessarily the name of the station that logged this contact.
”power”, “name” and “qth” refer to information about the station being worked in this contact. In a contest where
transmit power is part of the exchange, “power” will contain the received power exchange from the other station.
“run1run2” refer to the run radio number is a multi-2 arrangement.
“band” is composed of 2 or 3 characters that may include localized delimiters. For example, 80 meters may be “3.5” or
“3,5”; 160 meters as “1.8” or “1,8” The user’s Windows setting will determine which delimiter is present in the band tag
ID is a 32 byte unique GUID identifier for each contact in the log. Note that it is sent as 2 hex characters per byte.
IsClaimedQso will default to “1” for all contacts and set to “0” when a contact is declared to be an X-QSO
oldtimestamp and oldcall are used in contactreplace packets to indicate the time and callsign that were originally
logged before editing, in case either was changed. In contactinfo packets they are the same as timestamp and call
respectively
SentExchange is the contents of the Sent Exchange box in the contest setup dialog window. This is not necessarily
the same as the actual exchange sent during the QSO; there is no signal report, the serial number (# or 001) is a
placeholder for the actual serial number (sntnr), and there is no guarantee that what is in the Sent Exchange box is the
same as what was in the function key message
ADIF fields in ContactInfo – It may be tempting to assume that there is a one-to-one correspondence between fields
in the contactinfo messages and similar fields in the ADIF specification, but this is not always the case. The best
example is the Section field in the contactinfo message; this means whatever the rules for the particular contest define
it to mean. In a few contests, the Section field is the same as the ADIF ARRL_SECT; in many more contests and for
most geographical locations, it may be the same as STATE in ADIF. However, in some contests for some geographical
locations (e.g. Alaska, Hawaii, the District of Columbia, the Canadian Atlantic provinces, Canadian northern territories)
the section identifier specified in the contest rules might not match either ADIF field. Another example is the Zone field,
which often means the same as CQZ in ADIF, but in some contests it means the same as ITUZ. Yet another example is
the frequency field, which is not in the same format as in ADIF; in the contact info and radio info message, the
frequency is exported in units of 10 Hz.

Contact Replace

The Contact Replace packet contains the same fields as Contact Info above, but with <contactreplace > XML tags.

Contact Delete

46
47
48
49
50
51

    <ID>f9ffac4fcd3e479ca86e137df1338531</ID>
    <IsClaimedQso>1</IsClaimedQso>
    <oldtimestamp>2020-01-17 16:43:38</oldtimestamp>
    <oldcall>W1AW</oldcall>
    <SentExchange>XYZ NY</SentExchange>
</contactinfo>

1
2
3
4
5
6
7
8
9
10
11

<?xml version="1.0" encoding="utf-8"?>
<contactreplace>
    <app>N1MM</app>
    <contestname>CWOPS</contestname>
    <contestnr>73</contestnr>
    <timestamp>2020-01-17 16 :43:38</timestamp>
    <mycall>W2XYZ</mycall>
    .
    .
    .
</contactreplace>

IMPORTANT NOTE TO DEVELOPERS:
When a user edits an existing contact record, the program will send a pair of UDP packets: A < contactdelete >
packet, followed by a < contactreplace > packet. The < contactdelete > packet will contain the existing record’s
callsign and timestamp, in the event that the < contactreplace > packet includes a new timestamp or callsign for this
record. (The need for this has now been eliminated with the addition of the oldcall and oldtimestamp fields.)



1
2

<?xml version="1.0" encoding="utf-8"?>
<contactdelete>
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LookupInfo

NOTE: The LookupInfo UDP packet structure is identical to the ContactInfo packet described previously. The purpose of the
LookUp packet is to advise a third-party application (usually a general purpose logging program) of the intention to work a
station. The difference between the two packets is the timing of their transmission. The LookupInfo packet is sent after
entering a callsign in the Entry Window and pressing the [spacebar], but before the callsign is logged in the N1MM
database. In contrast, the ContactInfo packet is sent after a new record has been added to a contest log. LookupInfo and
ContactInfo are two separate functions and each needs to be configured in N1MM+’s Configurer >Broadcast Data tab. The
default port for LookupInfo packets is 12060.

Radio Info

Radio Info Notes:

app is a short name of the logger sending the packet. Examples: “N1MM”, “DXLab”, “Logger32”, “UcxLog”, “Log4OM”
StationName is the NetBios name of the computer that is sending these messages. It is the name used in Multi-
Computer networking. Windows limits it to 15 characters. If the computer name is greater than 15 characters long, the
first 15 characters will be used.

3
4
5
6
7
8
9

    <app>N1MM</app>
    <timestamp>2020-01-17 16 :43:38</timestamp>
    <call>WlAW</call>
    <contestnr>73</contestnr>
    <StationName>CONTEST-PC</StationName>
    <ID>a1b2c3d4e5f6g7h</ID>
</contactdelete>

1
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<?xml version="1.0" encoding="utf-8"?>
<lookupinfo>
    <app>N1MM</app>
    <contestname>CWOPS</contestname>
    <contestnr>73</contestnr>
    <timestamp>2020-01-17 16 :43:38</timestamp>
    <mycall>W2XYZ</mycall>
    .
    .
    .
</lookupinfo>
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<?xml version="1.0" encoding="utf-8"?>
<RadioInfo>
    <app>N1MM</app>
    <StationName>CW-80m</StationName>
    <RadioNr>1</RadioNr>
    <Freq>352211</Freq>
    <TXFreq>352211</TXFreq>
    <Mode>CW</Mode>
    <OpCall>W1ABC</OpCall>
    <IsRunning>False</IsRunning>
    <FocusEntry>204626</FocusEntry>
    <EntryWindowHwnd>275678</EntryWindowHwnd>
    <Antenna>8</Antenna>
    <Rotors></Rotors>
    <FocusRadioNr>1</FocusRadioNr>
    <IsStereo>False</IsStereo>
    <IsSplit>False</IsSplit>
    <ActiveRadioNr>1</ActiveRadioNr>
    <IsTransmitting>False</IsTransmitting>
    <FunctionKeyCaption></FunctionKeyCaption>
    <RadioName></RadioName>
    <AuxAntSelected>-1</AuxAntSelected>
    <AuxAntSelectedName></AuxAntSelectedName>
    <IsConnected></IsConnected>
</RadioInfo>

3/4/25, 5:37 PM N1MM Logger+ Documentation



683

RadioNr is the radio number associated with a specific XML packet – in other words, the source of the information in
that packet. When in SO2V or SO2R mode, N1MM+ sends two packets every ten seconds – one packet each from
RadioNr1 and RadioNr2
Freq is the receive frequency represented as values to the tens digit with no delimiter. For example: 160 meters:
181234; 40 meters: 712345; 10 meters: 2812345; 6 meters: 5012345
TXFreq is the transmit frequency represented as values to the tens digit with no delimiter. For example: 160 meters:
181234; 40 meters: 712345; 10 meters: 2812345; 6 meters: 5012345
Mode could be any one of the following: CW, USB, LSB, RTTY, PSK31, PSK63, PSK125, PSK250, QPSK31, QPSK63,
QPSK125, QPSK250, FSK, GMSK, DOMINO, HELL, FMHELL, HELL80, MT63, THOR, THRB, THRBX, OLIVIA,
MFSK8, MFSK16
OpCall is the callsign entered by the operator after OPON (or Ctl-O). Defaults to the station call
IsRunning represents the value of the RUN versus S&P radio buttons in the Entry Window. If you are on your CQ
frequency, IsRunning will be True
FocusEntry is the Windows assigned handle of the Entry Window with program focus
EntryWindowHwnd allows external software to send commands to a specific EntryWindow (i.e. using AHK to send F1
to EW2 etc.)
Antenna is the currently selected antenna for this radio (0-63), from the Antenna tab in the Configurer
Rotors is the name of the currently selected rotor from the Antenna table in the Configurer
FocusRadioNr Receive Radio Focus – the Green Dot in the Entry Window. Enables signal switching for SO2R
operation – facilitating the routing of Microphone, Audio, PTT, CW signals to/from the selected radio. FocusRadioNr
toggles between 1 and 2 when the program, a mouse click, or the \ key selects the opposite Entry Window
IsStereo enables audio switching for SO2R operation.The ` key (backquote) toggles its value between True and False
ActiveRadioNr Transmit Radio Focus – the Red Dot in the Entry Window. Enables signal switching for SO2R operation
– facilitating the routing of Microphone, Audio, PTT, CW signals to/from the selected radio. ActiveRadioNr toggles
between 1 and 2 when the program or pressing the [Pause] key selects the opposite Entry Window
IsSplit Transceiver is in Split VFO mode (for example: vfoA=Rx, vfoB=Tx). Not available on all – especially older – rigs
IsTransmitting Program is in transmit (True) or receive (False) mode. See IsTransmitting warning, below
FunctionKeyCaption The label of the Function Key that was pressed to initiate this transmission
RadioName The name of the radio, as shown in the Entry Window (i.e. “TS-590”)
AuxAntSelected is normally “-1”, until the user presses an Entry Window function key containing the {auxantsel}
macro. A UDP packet containing the selected antenna number is sent once per keypress, after which
<AuxAntSelected> reverts to “-1”
AuxAntSelectedName is normally blank, until the user presses an Entry Window function key containing the
{auxantsel} macro. A UDP packet containing the selected antenna name is sent once per keypress, after which
<AuxAntSelectedName> reverts to a blank field
IsConnected indicates whether a radio is connected. It may take some time for a disconnection (False) to be
registered

The program sends Radio Info packets at 10 second intervals, or immediately after an event where any of the information in
one of these fields changes (for example: user changes bands, spins the VFO dial, switches from Run to S&P, or selects
VFOb).

Transmitting with <IsTransmitting> = False
The IsTransmitting tag in RadioInfo only displays as True when N1MM+ has initiated a transmission. When a
transmission is initiated external to N1MM+ – for example, a microphone PTT button or CW paddle key –
IsTransmitting will still be displayed as False. Be careful when using IsTransmitting to control external devices that
need to know when the radio is in Tx or Rx.



RadioInfo broadcasts in SO2V
Using RadioInfo broadcasts when the Logger is in SO2V mode may require special consideration. In SO2V, packets
in which RadioNr and ActiveRadioNr are different from each other should not be relied upon for information about the
transmit frequency.

Explanation: N1MM+ treats the two VFOs in SO2V similarly to the way it treats the two radios in SO2R. Broadcasts
with RadioNr = 1 relate to VFO A (the main receiver in most dual-receiver radios), and broadcasts with RadioNr = 2
relate to VFO B (the subreceiver in radios so equipped). In each of these broadcasts, the exported value of TxFreq is
normally the same as the receive frequency (Freq), regardless of which VFO is active (as if RadioNr 1 and RadioNr 2
were two separate radios). The exception is the special case when the program is in Split mode. In this case (and
only in this case) TxFreq will indicate the frequency in the other VFO to reflect the Split mode status.

What this means is that programs receiving RadioInfo broadcast packets and requiring knowledge of the transmit
frequency or band (such as programs controlling amplifiers or antenna switches) must take the ActiveRadioNr into
account. In SO2V mode, the TxFreq reported in packets in which RadioNr is not the same as ActiveRadioNr will
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Rotator Control

Messages to operate the separate Rotator Control program are sent automatically when the user selects >Tools >Turn Rotor
(alt+J), and do not require configuration settings or modifications to the N1MM Logger.ini file. The messages are always sent
on port 12040. See the Rotator Control chapter for more information.

Spot Data

The Spot Data packet contains all spots processed by the program whether from Telnet (including RBN), Logging QSOs, or
local spotting.
The values for action are:

add
delete

The values for status are:

busy – marked by N1MM user as a frequency to note
bust – a busted call (when CT1BOH tags are present)
cq – the cq frequency on this band (last place F1 was pressed)
dupe – duplicate contact
qtc – a WAE qtc
single mult – this spot is a single multiplier in this contest
double mult – this spot is a double (or more) mult in this contest
new qso – a logged qso (this is now a dupe by definition)

Spot UDP Packet:

StationName – the callsign shown in the station dialog
dxcall – the station that is spotted
spottercall – the station that spotted the call (StationName for stations worked, or spotted locally)
comment – the comment from the spot
action – whether this spot was added or deleted (spots are deleted when they move within a band)
status – dupe, mult etc. See above for values
timestamp – the time of the spot

Score Reporting

Navigate to the Configurer >Config >>Configure ports… >Score Reporting tab to send contact info to the online score
reporting websites.

generally not be the actual transmit frequency. This is not likely to be a major problem when the two VFOs are on the
same band, but if the two VFOs are on different bands, the TxFreq reported in these inactive radio packets will be
misleading. To determine the correct transmit frequency, when N1MM+ is in SO2V such programs should only use
TxFreq from packets in which RadioNr and ActiveRadioNr have the same value.

1
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<?xml version="1.0" encoding="utf-8"?>
<spot>
    <app>N1MM</app>
    <StationName>CONTEST-PC</StationName>
    <dxcall>AL3CDE</dxcall>
    <frequency>7061.2</frequency>
    <spottercall>K2PO/7-#</spottercall>
    <timestamp>2O20-Ol-l7 17:19:37</timestamp>
    <action>add</action>
    <mode>CW</mode>
    <comment>CW 9 DB 18 WPM CQ AK </comment>
    <status>single mult</status>
    <statuslist>single mult</statuslist>
</spot>

1
2
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<?xml version="1.0"?>
<dynamicresults>
    <contest>ARRL-FIELD-DAY</contest>
    <call>K8UT</call>
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Sending Spectrum Data to N1MM+
N1MM+ receives spectrum data from SDR receivers on port 13064. Follow this XML layout:
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    <ops>VA5DX</ops>
    <class power="HIGH" assisted = "ASSISTED" transmitter="UNLIMITED"
        ops="MULTI-OP" bands="ALL" mode="MIXED" overlay="N/A">
    </class>
    <club></club>
    <qth>
        <dxcccountry>K</dxcccountry>
        <cqzone>4</cqzone>
        <iaruzone>8</iaruzone>
        <arrlsection>MI</arrlsection>
        <stprvoth>MI</stprvoth>
        <grid6>EN82BK</grid6>
    </qth>
    <breakdown>
        <qso band="20" mode="CW">156</qso>
        <point band="20" mode="CW">312</point>
        <qso band="20" mode="ALL">15</qso>
        <point band="20" mode="ALL">30</point>
        <qso band="20" mode="PH">385</qso>
        <point band="20" mode="PH">384</point>
        <qso band="15" mode="CW">19</qso>
        <point band="15" mode="CW">38</point>
        <qso band="15" mode="ALL">14</qso>
        <point band="15" mode="ALL">28</point>
        <qso band="15" mode="PH">30</qso>
        <point band="15" mode="PH">30</point>
        <qso band="10" mode="CW">6</qso>
        <point band="10" mode="CW">12</point>
        <qso band="10" mode="ALL">3</qso>
        <point band="10" mode="ALL">6</point>
        <qso band="80" mode="CW">24</qso>
        <point band="80" mode="CW">48</point>
        <qso band="80" mode="ALL">75</qso>
        <point band="80" mode="ALL">150</point>
        <qso band="80" mode="PH">136</qso>
        <point band="80" mode="PH">136</point>
        <qso band="0.7" mode="PH">l</qso>
        <point band="0.7" mode="PH">2</point>
        <qso band="6" mode="CW">l</qso>
        <point band="6" mode="CW">2</point>
        <qso band="6" mode="ALL">54</qso>
        <point band="6" mode="ALL">108</point>
        <qso band="6" mode="PH">9</qso>
        <point band="6" mode="PH">9</point>
        <qso band="40" mode="CW">625</qso>
        <point band="40" mode="CW">1250</point>
        <qso band="40" mode="ALL">2</qso>
        <point band="40" mode="ALL">4</point>
        <qso band="40" mode="PH">746</qso>
        <point band="40" mode="PH">746</point>
        <qso band="total" mode="ALL">2301</qso>
        <point band="total" mode="ALL">3295</point>
    </breakdown>
    <score>3295</score>
    <timestamp>2020-01-17 17:33:37</timestamp>
</dynamicresults>
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<?xml version="1.0" encoding="utf-8"?>
<Spectrum>
    <app>WaterfallBandmap</app>
    <Name>NlMM SDR1</Name>
    <LowScopeFrequency>14000</LowScopeFrequency>
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Notes:

Name is the name of your source. It will be shown in the N1MMPlus UI
LowScopeFrequency is lowest frequency represented by the signal levels in SpectrumData
HighScopeFrequency is highest frequency represented by the signal levels in SpectrumData
ScalingFactor is a number that converts your 0-N data in SpectrumData to dB for display in the UI
DataCount is the number of signal levels sent in SpectrumData
SpectrumData is comma separated signal level values. Icom uses a range from 0-160. We can accept integer values
from 0-65535.
Spectrum Window help can be found at: Spectrum Window Help

To show this data in N1MM+:

Open a Spectrum Display window (Windows/Spectrum Display).
Right-click and change Spectrum Source to “Source Name”.
Set the source name to the Name you are sending in the message above.

We’ve tried to minimize the development effort from your side by only requiring six pieces of meta data and your level
information in the same fashion that you display level data on your UI. Icom provides this data about 3x per second and that
seems adequate. We wouldn’t want more than 5x to 10x per second to avoid overloading the users machines, since so many
users have older processors.
In addition to the xml data, you would need to allow your users to specify an IP address to send the data to. You will probably
want to allow your users to name the source, in the event there is more than one spectrum display on their networks.

If you would like to see what the spectrum UI looks like, I have prepared a 4 minute video at: Spectrum Video

Setting N1MM’s Frequency from an External Program
You can send a QSY command to N1MM (and therefore your connected radio) using the Radio_SetFrequency packet. The
packet encoding must use UTF8, and the port set for 13064. Note that mouse button <Left>=Radio 1, and when running
SO2V/R <Right>=Radio 2.

6
7
8
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    <HighScopeFrequency>14055</HighScopeFrequency>
    <ScalingFactor>0.3125</ScalingFactor>
    <DataCount>475</DataCount>
    <SpectrumData>0,0,0,1,0,0,0,0,1,0,0,0,0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,0,1,0,0,0,1,
    0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,1,0,0,0,0,1,0,0,0,0,0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0,0,0,
    </SpectrumData>
</Spectrum>
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<?xml version="1.0" encoding="utf-8"?>
<radio_setfrequency>  
    <app>WaterfallBandmap</app>
    <radionr>1</radionr>
    <frequency>14053.284</frequency>
    <mousebutton>Left</mousebutton>
</radio_setfrequency>

Using Two Rig Control Programs Simultaneously

You will encounter port errors when two programs – like N1MM+ and WSJT-X – try to access the same com ports in
Windows. The solution requires some form of serial port sharing. You have many choices: VSPE, com0com, LP-
Bridge, Win4K3… We do not plan to be prescriptive – use whichever one you can get to work or is included with your
general logging program.
OR
If you are going to be running a dedicated JT65 / FT8 operation with WSJT-X and just using N1MM+ as a back-end
contest database, you can create a custom INI file that launches N1MM+ without enabling its CAT interface. This
prevents any of the serial port complications. See the documentation about using a custom INI file and launching
N1MM+ with custom INI settings enabled here, in the section called Multiple ini files.

Frankly, though, if at all possible it would probably be better to use the integration between WSJT-X and N1MM+
described here (in the description of the WSJT Decode List window). This method in effect allows both programs to
share rig control by having WSJT-X do its rig control via sending commands to N1MM+ instead of directly to the
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radio. This method does not use UDP port 2333; instead, it communicates with WSJT-X using the protocol defined in
WSJT-X (and not described here) on port 2237.
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Off Topic, But Nice to Know
2019-03-29

This chapter gives general information about contesting coming from discussions on the N1MM Logger reflector. Should this
be placed in a help/manual for a contest program? We don’t know but as the title says: Off topic, but nice to know. We thank
the authors for their approval so we could add this to the help/manual.

RFI, Grounding, Shielding and All That
As our radios, computers, and other peripheral equipment become more and more interconnected, it seems as if many calls
for help on the reflector are traceable to system problems of this sort. RFI gets into computers, radio control, keyers, and other
equipment. Equipment is needlessly damaged by EMP (electro-magnetic pulse) from lightning nearby. The list goes on.

We can’t solve these problems here. Following are two links to the extensive work of two experts in the field. Read, try and
see for yourself.

A Ham’s Guide to RFI, Ferrites, Baluns, and Audio Interfacing by Jim Brown, K9YC

Common Mode Chokes by Chuck Counselman, W1HIS

Work Dupes or Not?
In paper log days you used to get penalized for too many dupes that weren’t marked as such in the log. I don’t know of any
contest that has ever penalized you for working too many dupes as long as you marked them in your log and didn’t try to claim
points for them.

Its kind of ironic that the Cabrillo log format has no way to mark dupes, the sponsor’s log processing software automatically
rescores all the logs so you don’t have to worry about even recognizing dupes or worrying about not claiming points for them.

On your specific question. You log by2a but 6y2a properly logs on5zo… 6y2a would get credit because the log checking
software would properly match up the one-off call by2a with their log entry of on5zo. If there really is a by2a and they send in a
log you would lose credit for a confirmed not-in-log. If there is no such callsign as by2a issued you would lose credit and
penalty and lose the multiplier (assuming you didn’t work any other by) as a bad call. If there is a by2a but they didn’t send in
a log you might get to keep the credit if the log checking software and manual checkers don’t recognize the busted call.

Lets take it one step further. Say you really screwed up and logged by2et so the log checking software can’t figure out that it
was really 6y2a that you worked… now 6y2a loses qso credit and penalties for being not in the on5zo log. You may or may not
lose credit as above based on the by2et log and callsign status…. now, later on you hear 6y2a and call them again. If they
recognize you are a dupe and come back ‘qso b4’ and refuse to work you, THEY LOSE! They will never get credit for on5zo
and will lose the penalty points. If instead they ignore the dupe and work you again the original not-in-log doesn’t matter as
they are now in your log and everyone gets credit… so NOT logging the dupe is bad.

The same holds for other combinations of them busting your call, or both of you busting each other, etc. It is always better to
just log the dupe and move on. There is actually less of a chance you will get penalized if you work the dupe than if you don’t.

David Robbins, K1TTT

e-mail: k1ttt@arrl.net

web: http://www.k1ttt.net

Types of Operating
Running

– In this mode you normally only want to only see new multipliers so the Check spot window serves well. You can set the
filters to only see new multipliers so you can easily go grab them and get right back to your run frequency.

Search and Pounce

– The traditional S&P mode. In this mode you dial up the band checking each signal you hear. In this mode the bandmaps
work well as they can help you quickly identify each station you hear and determine their status as a new QSO or multiplier or
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dupe.

The ‘New’ Packet Assisted S&P Mode

– In this mode you start at one end of the band and quickly go from spot to spot and work all the new stuff on a band. With
today’s high spotting rates you often find that almost every station you would hear doing the traditional S&P is already in the
band map so for an operator in a hurry to work out a band and move on this could be very useful. Also for an operator working
a 2nd VFO while still running, or running SO2R to tune one band while CQing on another one this could be useful as you
typically have less time to spend figuring out who someone is and would rather have a screen full of new stuff than a screen
full of dupes to tune through.

David Robbins, K1TTT

A QSO Speedup Tip (How is Your Typing Speed?)
Being raised as a contester using CT, I was taught this trick (drill exercises on PED CT trainer, tnx to my contesting elmer
ON5YR). By pressing “Insert” to send RST (CT uses “insert” to send call+RST).

I type the prefix, copy suffix in head, start sending RST while typing the suffix.

Saves a lot of time and the calling station does not have to wait that extra split second, as soon as his TRX goes from TX to
RX, he hears me coming back to him already.

So although I use ESM a lot, whenever I use this trick I still press “Insert”, works FB!

Try it, it works FB in combination with ESM.

73 es CU in contest!

Franki ON5ZO

NB. N1MM logger can be set up to send call+rst when pressing ‘Insert’.

GMT is GMT, or Not?
Not quite. Some of Bill Gates’ boys didn’t know the difference between Greenwich Mean Time and the local time in
Greenwich, England. In some versions of Windows, one of the choices for time zone is labeled (GMT) Greenwich Mean Time :
Dublin, Edinburgh, Lisbon, London, but unfortunately, despite what the time zone list says this setting is NOT repeat NOT
Greenwich Mean Time; it’s local time in Greenwich (and Dublin, Edinburgh, Lisbon and London), which in the summer is
daylight savings time, i.e. GMT + 1:00 .

There’s an often published workaround. If you absolutely gotta put your computer on GMT because you’re tired of resetting
some old DOS software that doesn’t know any better, you can set the computer for (GMT) Casablanca, Monrovia. Those
places never go on daylight savings time, so their local time really is the same as GMT all year round, not like Greenwich.

But you know what? If you’re using Windows software like N1MM Logger, it’s a lot easier to set your computer to your own
local time zone and let the operating system take care of all that time zone and daylight savings time stuff automagically.

73, Rich VE3IAY

Which Monitor to Choose
I have also been evaluating choices for more screen real estate. A couple of pointers that may be of interest.

Once you get into the bifocal stage of life, pixel size ends up being as important as screen resolution, if not more-so. You will
find that most 17″ and 19″ monitors are at 1280 by 1024 resolution. The difference between 17″ and 19″ is not more real
estate but the size of the pixels. Both 17″ and 19″ monitors will show the same number of pixels, but with the smaller pixels on
the 17″ monitor, you may end up having to increase font sizes to make the text readable, so you end up with less effective
screen real estate. I recommend 19″ over 17″ monitors for this reason.

As far as economics is concerned, the wide angle format monitors appear to generally be the best bang for your buck. But
keep in mind that a widescreen 19″ monitor which is 1680 by 1050 resolution will have smaller pixels than a 19 inch 1280 *
1024 resolution monitor. If you are considering a widescreen monitor, make sure your video card can drive it. The video card
in my almost two year old Dell box can’t!
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Prices start to go up rapidly once you get into 1600 * 1200 resolution, which becomes available in the 20″ and 21″ sizes. At
this size and bigger, there are also wide screen versions. Again, make sure the resolution is supported by your video card.

Another thing to consider is whether or not you are going to be using an analog or digital interface. I find that driving a 1280 *
1024 monitor in analog mode gives very fine lines and makes text difficult to read. Using the same monitor with a digital
interface usually gives better results. Microsoft’s ClearType software also helps somewhat in this regard.

To summarize, for our application, you want to look for displays with big (0.27mm) pixels. For me, that narrows the choices
down to the following, in order of increasing cost/pixel for monitors:

Two 19″ 1280 * 1024 monitors

One 20″ or 21″ 1600 * 1200 monitor

One large 22″ and up widescreen monitor

Gerald Boutin, VE6WA
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